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What’s New

Want to know what’s new in PADS 9.4? 

• See the details of new enhancements, features, and functionality in the Release 
Highlights on SupportNet:

English

http://supportnet.mentor.com/docs/201201028/release_docs/PADS_rh.pdf

Japanese

http://supportnet.mentor.com/docs/201201028/release_docs/PADS_rh_ja.pdf

• For a list of defect fixes, see the Release Notes: 

http://supportnet.mentor.com/docs/201201028/release_docs/PADS_rn.pdf

http://supportnet.mentor.com/docs/201201028/release_docs/PADS_rh.pdf 
http://supportnet.mentor.com/docs/201201028/release_docs/PADS_rh_ja.pdf 
http://supportnet.mentor.com/docs/201201028/release_docs/PADS_rn.pdf
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Chapter 1
PADS Layout QuickStart

Welcome to PADS Layout, a powerful yet easy to use layout application.

To get up and running quickly, perform the following steps:

Step 1 - Create a Board Outline

Step 2 - Import a Netlist and Disperse Parts

Step 3 - Setup Design Rules

Step 4 - Set Grids

Step 5 - Place Parts

Step 6 - Route and Unroute Traces

Step 7 - Create Plane Layers

Step 8 - Check for Rule Violations

Step 9 - Annotate the Design

Step 10 - Generate Reports

Step 11 - Output the Design
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Step 1 - Create a Board Outline
Board outlines are created using the drafting tools. The drafting tools are located in the Drafting 
toolbox.

To create a board outline:

1. In the Welcome screen, click Start a new design.

2. Click the Drafting Toolbar button.

3. On the Drafting toolbar, click the Board Outline and Cut Out button.

4. Right-click and select your shape preference.

5. Draw an outline using the pointer, making a series of clicks.

6. Click to complete a rectangular or circular outline. Double-click to complete a 
polygonal outline.

Step 2 - Import a Netlist and Disperse Parts
Typically, net and part design data originate in a schematic capture application and are 
transferred to a layout application via an ASCII netlist. Use the Import command to import 
ASCII files into your design.

To import a netlist:

1. On the File menu, click Import.

Tip: Save the design when you are prompted to.

2. In the File Import dialog box, click the file type to import from the Files of type list.

3. Navigate to the file to import, and click Open to import the file.

4. Review any errors or warnings, in the ascii.err file, that may result from the import 
process. 

After you import nets and parts into your design, disperse the parts around the outside of the 
board using the Disperse components command.

To disperse parts:

1. On the Tools menu, click Disperse Components. 

2. Click Yes to confirm the dispersion of the parts.
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Step 3 - Setup Design Rules
Setup all design rules, including clearance, routing, high-speed and others, within the design 
rule dialog boxes.

To setup design rules:

1. Setup menu > Design Rules.

2. Click the Default button. 

Result: The Default Rules dialog box appears. Use this dialog box to select the type of 
default rule to enter. See the table below for more information.

3. Click the Clearance button to enter default clearance rules. 

4. Click in any one of the boxes in the matrix to change its value. 

5. Click OK to apply the clearance rule changes.

6. Click any other button to set default rules for the associated type. 

7. Click Close to close the Default Rules dialog box.

8. Click Close to close the Rules dialog box.

Table 1-1 lists and describes the rules types: 

Table 1-1. Design Rules Types 

Rules Type Includes rules or preferences for

Clearance Minimum clearance, minimum same net clearance, trace width, drill-
to-drill and part body-to-part body minimum clearances.

Routing Trace topology, copper sharing, layer bias, via bias, and trace 
protection level.

High Speed Parallelism, shielding, and thresholds for trace length, delay 
capacitance, and impedance.

Fanout Fanout construction (used in PADS Router only).

Pad Entry Trace patterns at pad entries and exits (used in PADS Router only).

Conditional Overriding unique conditions when specific design objects are 
adjacent to other specific design objects. The rules include minimum 
clearances and parallelism.

Differential 
Pairs

Net length and topology of differential pairs.
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Step 4 - Set Grids
Several grid settings are available in PADS Layout. Set grids in the Options dialog box or using 
the grid modeless command.

To set a design grid:

• Type the g modeless command followed by the grid values, and press Enter.

Example: Type g50 and press Enter to set a .050” design grid.

To set a via grid:

• Type the gv modeless command followed by the grid value, and press Enter.

Example: Type gv50 and press Enter to set a .050” via grid.

To set a display grid:

• Type the gd modeless command followed by the grid value, and press Enter.

Example: Type gd50 and press Enter to set a .050” display grid.

Tip: Setting a grid with a single value sets that value for x and y. You can set independent 
values for x and y by entering them as g <x value> <y value>. For example, type g 25 50 to set 
a .025” x and .050” y design grid.

Table 1-2 lists and describes the grid types: 

Table 1-2. Grid Types

Grid Type Used for 

Design General placement of all objects

Via Placement of vias

Display Visual aid



PADS Layout QuickStart
Step 5 - Place Parts

PADS Layout User’s Guide and Reference Manual, PADS 9.4 77

Step 5 - Place Parts
The placement commands are located on the Design Toolbar.

Result: You enter move component mode. 

To place parts:

1. Design Toolbar button > Move button.

2. Click a part to begin moving it.

3. Right-click and choose other commands to rotate the part 90 degrees, flip it to the 
opposite side of the PCB or spin the part at .001 degree resolution.

4. Click in the new location to place the part.

Other placement commands exist that help you place parts including Radial Move, Rotate, and 
Spin. 

Step 6 - Route and Unroute Traces
In PADS Layout, you convert unroutes to traces using any one of several routing commands. 
You can route traces with on-line checking of design rules to eliminate rule violations as you 
create traces.

To route traces using the basic route editor:

1. Design Toolbar button > Add Route button.

Result: You enter basic route mode.

2. Click an unroute or component pin to start routing. 

Result: A new trace is started with the end point attached to the pointer.

3. Move the pointer and click to add new trace corners, or Shift+click to add new vias.

4. Move the pointer over the completion point of the unroute, such as a component pin, and 
click to complete it.

To route traces using the dynamic route editor:

1. Enable on-line design rule checking by typing drp and pressing Enter.

2. On the Design toolbar, click the Dynamic Route button.

3. Click an unroute or component pin to start routing. 

Result: A new trace is started with the end point attached to the pointer.
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4. Move the pointer in the direction of the completion point. New corners are added for 
you.

5. Move the pointer and click to add additional trace corners, or Shift+click to add new 
vias.

6. Move the pointer over the completion point of the unroute, such as a component pin, and 
click to complete it.

To route using the dynamic autorouter:

1. Enable on-line design rule checking by typing drp and pressing Enter.

2. On the Design toolbar, click the Auto Route button.

3. Click an unroute or component pin to start the dynamic autoroute command. A new 
trace is added.

Tip: The dynamic autorouter is a single layer autorouter. It is limited to completing traces not 
requiring a via.

You can also reroute and unroute trace segments. 

Step 7 - Create Plane Layers
There are two types of plane layers in PADS Layout —CAM and Split/Mixed. CAM plane 
layers are processed using the CAM commands and are strictly intended for whole layer planes 
without routing. Split/Mixed are planes containing multiple plane areas, with or without 
routing.

To create a CAM plane:

1. Setup menu > Layer Definition.

2. Click a layer in the layer list to set as a CAM plane.

3. In the Plane type area, select CAM Plane.

4. Click Assign Nets. 

5. In the Plane Layer Nets dialog box, select a net and click Add to add it to the assigned 
nets list and assign it as a plane layer for the net.

6. Click OK to close the dialog box and complete the layer definition.

To create a split/mixed plane:

1. Click a layer in the layer list to set as a split/mixed plane.

2. In the Plane type area, click Split/Mixed Plane.
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3. Click Assign Nets. 

4. In the Plane Layer Nets dialog box, select one or more nets and click Add to add it to the 
assigned nets list and assign it as a plane layer for the selected nets.

5. Click OK to close the dialog box and complete the layer definition.

You can also create plane areas on split/mixed plane layers and split a plane area polygon.

Step 8 - Check for Rule Violations
Use Verify Design to check for clearance, connectivity, high speed, plane connection, test point, 
fabrication, and other rule violations.

To check a design for rule violations:

1. Tools menu > Verify Design.

2. In the Check area, click the type of check to perform.

3. Click Setup to set checking options.

4. Click Start to start the checking.

5. Violations are marked with graphical error markers at their location in the design and 
details are provided in the Verify Design dialog box.

Table 1-3 lists and describes the rule violation checks: 

Table 1-3. Rule Violation Checks 

This check Checks 

Clearance For violations of minimum clearance rules with options for checking 
other design features including same net minimum clearance, drill-to-
drill, trace width, and part-to-part minimum clearances.

Connectivity For trace continuity errors resulting from incomplete routing, pins not 
connected plane layers, and drill size greater than pad size.

High Speed Specified nets for threshold violations of capacitance, impedance, 
delay, parallelism, and track length. It also checks for trace loops and 
stubs. 

Plane For conditions that prevent a pin or via from connecting to a plane 
layer. These conditions include:· A pin or via has a pad size on a 
plane layer greater than the drill size.· A pin or via has plane thermal 
status turned off and is not connected to the plane by some other 
means.· A pin is isolated from the plane due to discontinuities in 
plane shape (opens).
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Step 9 - Annotate the Design
You add dimensions to your design using the dimensioning tools.

To dimension automatically:

1. Dimensioning toolbar button > Auto button.

Result: You enter Auto mode.

2. Click a line segment, route segment, or round pad. The dimension attaches to the 
pointer.

3. Click to place the dimension.

To dimension by selection:

1. Click a button associated with a type of dimensioning.

2. Right-click and select any snap and edge preferences you want to use. Snap and edge 
preferences determine where the dimension text snaps to and what alignment it will use.

3. Click the first object.

4. Click the second object. The dimension is attached to the pointer.

5. Click to place the dimension.

Step 10 - Generate Reports
Reports are generated in two ways within PADS Layout. You can use the Reports command to 
generate several standardized reports or you can generate custom reports using Basic scripting.

Test Points For violations of test point rules and preferences including minimum 
test point clearances, preferred side, minimum pad size, test points 
per net, and others.

Fabrication For conditions that result in fabrication errors including acid traps, 
slivers, silkscreen over pad, minimal annular ring, solder bridges, and 
others.

Latium Design 
Verification

For violations of rules not verified in PADS Layout, including vias 
under SMDs and differential pairs, using a PADS-Router-based 
clearance rules check.

Wire Bonds All die parts for violations of wire bond length, width, maximum 
angle, and minimum wire bond to pad rules.

Table 1-3. Rule Violation Checks (cont.)

This check Checks 
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To generate a standardized report:

1. On the File menu, click Reports. 

2. In the Report dialog box, click the report to run, and click OK to generate the report.

To generate a Basic report:

1. On the Tools menu, point to Basic Scripts, and then click Basic Scripts. 

2. In the Basic Scripts dialog box, click the script to run, and click Run to execute the 
script and generate the report.

Step 11 - Output the Design
All of the typical outputs required for getting a design fabricated and assembled are generated in 
the CAM tool. Each output is defined as a document in the CAM document manager.

1. File menu > CAM.

2. Click Add to define a document. 

3. In the Add Document dialog box, type a document name.

Example: Photo plot layer 1

4. In the Document Type list, select a document to create. 

Result: The Layer Association dialog box may appear. It will not appear for custom, 
NC drill, or Verify photo document types.

5. In the Layer list, select a layer and click OK.

6. Type an Output File name or accept the default name.

7. In the Customize Document area, click the Layers button to select which items to 
include in the output. Click the Options button to set other options including 
positioning, drill symbols, name suppression, etc.

8. In the Output Device area, click the button that represents the output device to use. The 
device type should correspond with the document type.

9. Click OK.

10. Select the CAM document to process, and click Run.
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Chapter 2
Managing Licensed Options

Installed Options Dialog Box
Use the Installed Options dialog box to verify and configure your PADS Layout licensing 
information (that is, the licensing options that are available for your system and your license file 
or status).

• Help menu > Installed Options.

To use the two tabs available on the Installed Options dialog box:

• Use the Options tab to display the status of your licensing options. If you are using 
floating licensing, use this tab to view or control the availability of different options 
from the floating license server (that is, to check different options and their associated 
modules in or out). If you are using node-locked licensing, you generally use this tab to 
verify the list of licensing options tied to your hardware key. 

• Use the License File tab to select and then view license file information, either the actual 
license file (for node-locked licensing) or the feature usage status associated with a 
server license (for floating licensing). 

Checking Licensing Options In and Out
Use the Options tab to configure your licensing information. You generally need to check 
individual licensing options in or out if you are using floating licenses. The configuration is 
stored in the powerpcb.ini file. 

Tip: For node-locked licensing, all of the licensed options are available and checked out. For 
floating licensing, the first person logged in controls the available options.

• Help menu > Installed Options > Options tab.

To check all available licensing options in and out:

1. Make sure that the Check Out All Available Options check box is checked.  If this box 
is not checked and all options are not checked in the Option list, you can check out all 
available options by choosing Select All or by checking the Check Out All Available 
Options check box.

2. Click OK. 
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To select the individual options associated with individual PADS Layout modules and 
optionally select a database limit:

1. Clear the Check Out All Available Options check box.

2. Optionally, click Select None to clear all of the options before selecting individual 
options. This is helpful if you want to start with a clean slate. 

3. Select options by doing one of the following:

• In the check boxes to the left of the options in the Options list, check each option you 
want to use.

• In the Modules area, select the predefined set of options associated with one or more 
PADS Layout modules. 

Tip: If more than one module sets a particular option, turning off one of the modules 
does not turn off that shared option. The option is only turned off when all of the 
modules that use it are turned off. Also, some individual options control other options. 
For example, clearing the Advanced Packaging Toolkit option clears BGA options.

4. Optionally, select the database limit that is appropriate for your licensing scheme in the 
Database Limit area. The database limit is associated with the number of connections 
(pin pairs) you can have: 1500 for the Standard Database and 6250 for the Expanded 
Database. Select Standard, Expanded, or Unlimited for the database limit and verify the 
availability of the selected limit, per your license. 

5. When you are done checking out your options, click OK to apply your selections. 

Tips:

• If PADS Layout can check out the options in the modules, the Status is Available. If you 
can't check out the module, either because it isn't part of your PADS Layout package or 
because the licenses are already in use, the Status is Not Available.

• When the options associated with a particular module are Not Available, you will not be 
able to access the options in PADS Layout (that is, the feature will be grayed out). For 
example, if Assembly Variants has a status of Not Available, the PADS Layout Tools 
menu will show Assembly Variants as grayed out.

Related Topics

Installed Options Dialog Box

Viewing a License File or License Status 

License File Definition 
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Viewing a License File or License Status
If you are using node-locked licensing, you can view the contents of a license file.  If you are 
using floating licenses, you cannot view the actual license file, but you can view the status of the 
features associated with a server license.

• Help menu > Installed Options > License File tab.

For node-locked licenses 
To view a license file:

1. Select the license file that you want to view from your list of license files. 

2. Click View and the bottom portion of the screen displays the contents of the selected 
file. 

For floating licenses 
To view the status of the features associated with a server license:

1. Select the server license file for which you want to display feature status. 

2. Click Status. The feature usage information appears in the bottom portion of the screen. 

Related Topics

Installed Options Dialog Box

Checking Licensing Options In and Out

License File Definition 

Checking Out Suite Licenses
Use the PADS Suite Configuration dialog box to manage which suite licenses you consume.

Restriction

This functionality is applicable only if the following is true:

• You have floating licenses

AND

• On your license server you have: 

• A mix of different PADS Suite licenses
Example: PADS LS/padsls_c and PADS ES/padses_c
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Or

• One or more PADS Suite license 
Example: PADS ES/padses_c 
AND 
One or more PADS Kit license 
Example: pwrshell and other similar features, as part of PADS Layout 065 Kit

Warning: To use this functionality it is imperative that you remove any FlexNet Options files 
and/or batch script customization; otherwise it will not work correctly.

Procedure

1. Help menu > Installed Options > Suite Configuration button.

2. The check the status of all listed licenses, click Check status.
Tip: To see which license features are being consumed for each of the product options, 
see the Installed Options dialog box.

3. Select the Control suite license checkout and select from the following list check 
box.
Tip: Click to clear the Control suite license checkout and select from the following list 
check box to have your licensing consumption work as it did in PADS 9.3.1 and earlier 
versions.

4. Select one or more licenses from the list.

Tips: 

• If you select a specific Suite license for check out, it does not impact your ability to 
also check out other option licenses using the Installed Options dialog box. For 
example, you can still check out pwradvrules for Advanced Rules.

• To check out Kit licenses only (also known as atomic or unbundled licenses), for 
example "pwrshell" for PADS Layout, select the Control suite license checkout and 
select from the following list check box and click Select none.

5. To check to see which Suite licenses are being used each time you start PADS Layout, 
select the Show this dialog box on program startup and Automatically check license 
status on dialog box startup check boxes.

6. To copy what you’ve done to PADS Logic and/or PADS Router, select the product in 
which you want to copy to.
Warning: Copying your selections may make the other PADS products open in 
demonstration mode.

Tip: If you make a change in one PADS product and Copy to one or more of the other 
PADS products, the change is immediate in the PADS product you make the change in, 
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but NOT for the other products(s) that may be open.  The change will go into effect for 
the other PADS product the next time you open it or if you go click Apply on the Suite 
Configuration dialog box.

7. Click OK.

Related Topics

PADS Suite Configuration Dialog Box

License File Definition
This section describes the license file and the options enabled within that file. All installed 
options appear in the Installed Options Dialog Box. The lines in this example license file 
include most available options. Because all license files differ based on the options you 
purchase, you may not have all of the following lines in your license file.

Options
INCREMENT pwradvedtrf mgcld \

Provides access to the following commands: Add from DXF in the Decal Editor, the Via 
Patterns tab in Options, Add Via Shield for nets and pin-pairs, Via Stitch and Via Stitch Mode 
for coppers and hatch outlines, and Create Copper Path and Convert to Copper Paths for pin-
pairs.

This feature is listed as Advanced Editing/RF on the Installed Options dialog box.

INCREMENT pwradvpkgtool mgcld \

Provides access to BGA functions. If you do not have this option installed, the BGA toolbar 
button is disabled, as are all BGA functions. 

This feature is listed as Advanced Packaging Toolkit on the Installed Options dialog box.

INCREMENT pwradvrules mgcld \

Expands the design rules hierarchy to include access to Group, Pin Pairs, Decal, Component, 
Conditional Rules, and Differential Pairs buttons in the Design Rules dialog box.

This feature also provides High Speed Checking, or electrodynamic checking, on the Verify 
Design dialog box and related functionality.

This feature is listed as Advanced Rules on the Installed Options dialog box.

INCREMENT pwranalog mgcld \
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Provides access to analog objects. Allows custom control of teardrop shape, length, and width 
in the Teardrops Options dialog box. Also enables the Jumpers dialog box to let you add 
jumpers when adding wires during routing or route editing. 

This option is listed as Analog on the Installed Options dialog box.

INCREMENT pwrautoconn mgcld \

Provides access to the BGA Route Wizard. This option is listed as Auto-connect on the Installed 
Options dialog box.

INCREMENT pwrautoplace mgcld \

Provides access to the Cluster Placement dialog box.  If you do not have this option, automatic 
placement functions are disabled. 

This option is listed as Auto-placement on the Installed Options dialog box.

INCREMENT pwrbgafanout mgcld \

Provides access to BGA fanout features. This affects the BGA Fanouts tab and the BGA 
Fanouts checkbox of the Connections tab in the BGA Route Wizard dialog box.

This option is listed as BGA Fanout on the Installed Options dialog box.

INCREMENT pwrbgarouter mgcld \

Provides access to BGA routing.  If you do not have this option, the Routing tab and the 
Generate Connections and Route radio button are disabled. This option is listed as BGA Router 
on the Installed Options dialog box.

INCREMENT pwrbndpadfanout mgcld \

Provides access to the Substrate Bond Pad Fanout (SBP) checkbox of the Connections tab in the 
BGA Route Wizard dialog box. If you do not have this option, the Substrate Bond Pad Fanout 
checkbox of the Connections tab in the BGA Route Wizard dialog is disabled. 

This option is listed as Bond Pad Fanout on the Installed Options dialog box.

INCREMENT pwrcam mgcld \

Provides access to the Define CAM Documents dialog box from the CAM item on the File 
menu. CAM allows creation and modification of plot definitions and allows creation of CAM 
output. 

This option is listed as CAM on the Installed Options dialog box.

INCREMENT pwrcam350 mgcld \
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Provides access to the CAM350 dialog box and related functionality, as well as to the external 
CAM350 support executable (for design output) and the CAM350 Link functionality. This 
affects the CAM350 item on the Tools menu.

This option is listed as CAM350 Link on the Installed Options dialog box.

INCREMENT pwrcamplus mgcld \

Provides access to the CAM Plus dialog box, which enables automatic assembly and pick and 
place machinery interface. If you do not have this option, the CAM Plus item on the File menu 
is disabled.

This option is listed as CAM Plus on the Installed Options dialog box.

INCREMENT pwrcluplace mgcld \

Provides manual and automatic cluster creation and modification and manual union creation 
and modification. Also provides the Cluster Manager dialog box and Build Clusters and Place 
Clusters in the Automatic Cluster Placement dialog box.  If you do not have this option, the 
Cluster Manager item on the Tools menu is disabled.

This option is listed as Cluster Placement on the Installed Options dialog box.

INCREMENT pwrcopperflood mgcld \

Provides access to the flooding functionality (for example, Flood All and Fast Flood on the Pour 
Manager dialog box). Also provides Flood in the Drafting toolbar and the Flood command in 
the shortcut menus. 

This option is listed as Copper Flood on the Installed Options dialog box.

INCREMENT pwrdieflag mgcld \

Secures access to the BGA Die Flag Wizard in the BGA toolbar. This option is listed as Die 
Flag Wizard on the Installed Options dialog box.

INCREMENT pwrdrafting mgcld \

Provides access to auto-dimensioning functions and drafting (and related 2D line functionality). 
If you do not have this option, all auto-dimensioning functions (the Auto-dimensioning toolbar) 
and all drafting editing functions (the Drafting toolbar) are disabled. 

This feature is listed as Drafting Editing on the Installed Options dialog box.

INCREMENT pwrdre mgcld \

Provides access to dynamic routing. If you do not have this option, Dynamic Route, Quick 
Route, Bus Route, and Smooth commands are disabled. This feature provides dynamic routing 
on the shortcut menus and provides Dynamic Route and Sketch Route on the Design toolbar. 
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This option is listed as Dynamic Route Editing on the Installed Options dialog box.

INCREMENT pwrdxf mgcld \

Provides importing and exporting of AutoCAD® DXF® format files. 

This option is listed as DXF on the Installed Options dialog box.

INCREMENT pwreco mgcld \

Provides the ECO toolbar and related functionality. If you do not have this option, you cannot 
run PADS Layout in the ECO mode. 

This option is listed as ECO on the Installed Options dialog box.

INCREMENT pwrgds2 mgcld \

Provides access to the GDSII file import feature. This option is listed as GDS-II/Die Import on 
the Installed Options dialog box.

INCREMENT pwrgenedit mgcld \

Provides access to the following:

• Auto Route on the Design toolbar and related functionality as well as autorouting 
features on the shortcut menus. This option secures access to Dynamic Autorouting. If 
you do not have this option, the Auto Route button on the Design toolbar is disabled, as 
are the Auto Route entries on the Pin and Pin Pair menus.

• File New, File Save, File Save As commands.

• On-line Design Rule Checking (DRC) options on the Design Options dialog box. 

• Move, rotate, spin, flip, disperse, nudge, and align components. Also provides Move 
Part, Rotate Part, Spin Part, and Swap Part on the Design toolbar. 

• Route modifying commands (Move, Stretch, Split, Route Loop, Add Corner, and Add 
Via) on the shortcut menus. Also provides Add Corner, Split, and Add Route in the 
Design toolbar. 

• Break Reuse

This feature is listed as General Editing on the Installed Options dialog box. It does not control 
DRE. 

INCREMENT pwridf mgcld \

Provides importing and exporting of IDF format files. This option is listed as IDF Interface on 
the Installed Options dialog box.

INCREMENT pwrlibedit mgcld \
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Provides access to the PCB Decal Editor, the Library Manager, and related functionality 
including Save to Library on the shortcut menus. This option is listed as Library Editor on the 
Installed Options dialog box.

INCREMENT pwrplatingtails mgcld \

Provides access to the Plating Tails pass of the BGA route. This option is listed as Plating Tails 
on the Installed Options dialog box.

INCREMENT pwrradialplace mgcld \

Provides access to Radial Move, Radial Move Setup, and Create Array in the Layout Editor, 
and Radial and Polar Step and Repeat and Radial Move Setup in the PCB Decal Editor. This 
option is listed as Radial Placement on the Installed Options dialog box.

INCREMENT pwrreuse mgcld \

Provides physical design reuse operations including Create, Add, Make Like, and Properties 
functions. Specifically, this option affects the following commands and dialog buttons:

• Make Reuse

• Add Reuse

• Move Reuse

• Save To Lib

• Reset Origin

• OK and Apply buttons in the Reuse Properties dialog

This option is listed as Physical Design Reuse on the Installed Options dialog box.

INCREMENT pwrshell mgcld \

Provides the graphical user interface. If you do not have this option, PADS Layout runs in 
Demo mode.

INCREMENT pwrspecctralink mgcld \

Provides the SPECCTRA translator. If you do not have this option, the SPECCTRA selection 
on the Tools menu is disabled. 

This option is listed as SPECCTRA Link on the Installed Options dialog box.

INCREMENT pwrsplitplanes mgcld \

Provides the Plane Connect command in the Pour Manager, flooding of plane layers by any 
other means, the C modeless command, DRC on split/mixed plane layers, the automatic update 
of thermal status and unroute visibility, verify design for planes, ability to define a split/mixed 
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plane area, and access to the Split Planes on the Options dialog box. This option is listed as 
Split/Mixed Plane on the Installed Options dialog box.

INCREMENT pwrdbexp, pwrdbstd, or pwrdbunl mgcld \

These options set design connection limits as follows:

• Expanded sets the limit to 6250 connections. 

• Standard sets the limit to 1500 connections.

• Unlimited allows the removal of connection limitations from the database. 

Without one of these licensing options in place, the connection limit is 100. If you open a design 
or modify a design to exceed your database limits, various functions throughout the program are 
disabled. This option is controlled on the Database Limit area of the Installed Options dialog 
box.

INCREMENT pwrvariants mgcld \

Provides access to Assembly Variants from the Tools menu and the Assembly Variants 
supporting features within Reports and CAM (for example, the Assembly Option checkbox in 
the Report dialog box). This feature is listed as Assembly Variants on the Installed Options 
dialog box.

INCREMENT pwrverify mgcld \

Provides access to the Verify Design dialog box (accessible from the Tools menu). This option 
is listed as Verify Design on the Installed Options dialog box.

PADS Router-only options
INCREMENT blzadvrulesstd, blzadvrulesexp, or blzadvrulesunl mgcld \

Secures access to the use of (and the design verification of) Extended Rules (Net Classes, Pin 
Pair Groups, Pin Pair, Component, Decal, Differential Pair rules, Conditional Rules, and all 
Matched Length rules). These consist of the following:

• The New, Delete, and Rename shortcut menu entries for Net Class, Pin Pair Groups, and 
Conditional Rule items in the Project Explorer Window

• The OK and Apply buttons on the Net Class, Pin Pair Group and Conditional Rule 
dialog boxes

• The design verification of all the rules mentioned above.

This option is listed as Extended Rules on the Installed Options dialog box in PADS Router.

INCREMENT blzanyangle mgcld \
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Provides access to any-angle routing. This consists of securing the Any Angle radio button in 
the Routing tab of the Options dialog.

If your design already has any-angle specified and you do not have this option, you are notified 
and asked if you want to route with Diagonal instead. If you choose to route with Diagonal, the 
design is changed to this setting. This option is listed as Any Angle on the Installed Options 
dialog box in PADS Router.

INCREMENT blzautoroute mgcld \

Allows access to the following automatic routing functions:

• Miters pass type (add miters sub-type) on the Strategy tab of the Options dialog box. 

• Optimize pass type (via minimize and smooth sub-types) on the Strategy tab of the 
Options dialog box. 

• Route pass type on the Strategy tab of the Options dialog box. 

This option is listed as Route in the Installed Options dialog box in PADS Router.

INCREMENT blzdbstd, blzdbexp, or blzdbunl mgcld \

Controls access to reading designs up to the pin pair limit. This limit only applies to reading a 
design, not saving it. If PADS Router creates new pin pairs (thus exceeding the pin pair limit), 
you are warned when you save the design. This option is listed as Database on the Installed 
Options dialog box in PADS Router.

These options set pin-pair limits as follows:

• Expanded sets the limit to 6250. 

• Standard sets the limit to 1500.

• Unlimited allows the removal of pin-pair limits from the database. 

Without one of these licensing options in place, the pin-pair limit is 100.

INCREMENT blzdft mgcld \

Controls access to the use of test points. This option is listed as Test Point on the Installed 
Options dialog box in PADS Router.

Tip: This feature also affects the Run button on PADS Layout's DFT Audit dialog box. 

INCREMENT blzdrestd, blzdreexp, or blzdreunnl mgcld \

Controls access to the Dynamic Routing functionality, such as: follow the pointer while 
avoiding obstacles and adhering to design rules, automatically keeping good pad entries, 
plowing, smoothing, Quick Route, and local Complete command. This option is listed as 
Dynamic Route Editing on the Installed Options dialog box in PADS Router.
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INCREMENT blzgenedit mgcld \

Allows access to the general modifying functions on all menus and toolbars including the Save 
command, and the Undo, Redo, Move, and Delete commands. This option also controls access 
to online Design Rule Checking (DRC). When this option is disabled, PADS Router works in 
viewer mode and online DRC checking is disabled.

This option is listed as General Editing on the Installed Options dialog box in PADS Router.

INCREMENT blzhsdauto mgcld \

Controls access to the routing to the Advanced Rules, such as: Minimum and maximum length, 
Net Class and Pin Pair groups, Matched Length Net groups, Matched Length Pin Pair groups, 
differential pairs, and tune all nets attached to a component. This option is listed as High-speed 
Routing (auto) on the Installed Options dialog box in PADS Router. This option requires both 
the advanced rules and high-speed DRE options; if you do not acquire both of these options, 
you cannot select the interactive High-speed Routing (auto) option.

INCREMENT blzhsddre mgcld \

Controls access to the interactive routing to the high-speed rules (minimum and maximum 
length, net class and pin pair groups, matched length net and pin pair groups, differential pairs, 
tune trace length at completion of interactive routing, tune nets that are interactively pushed and 
shoved), advanced trace length monitor, matched length monitor, and interactive addition of 
accordions).  This option is associated with the PADS Router advanced rules option. If you do 
not acquire the advanced rules option, you cannot select the interactive High-speed Routing 
(manual) option.

INCREMENT blzlayers2, blzlayers4, blzlayers8, or blzlayersunl mgcld \

Controls the number of routable design layers (2, 4, 8, or unlimited). Each layer limit 
corresponds to a limit licensing option. Any time your design exceeds the limit (either at File 
Open or because you changed layer routing enable), you are notified, and all routing functions 
are disabled. This option is controlled by the Routing Layers limit on the Installed Options 
dialog box in PADS Router.

INCREMENT blzshell mgcld \

If you do not have this option, PADS Router runs in Demo mode.

INCREMENT blzverify mgcld\

Controls access to the use of the basic Design Verification functionality, such as all object 
clearance, which includes the Placement Outline and Via at SMD checks. This option is listed 
as Verify Design on the Installed Options dialog box in PADS Router.

Tip: This feature also affects Test Point checking and Latium Design Verification in PADS 
Layout's Verify Design dialog box.
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Chapter 3
User Interface

This section teaches you how to start up PADS Layout and discusses various Start-up options. 
There is also a comprehensive list of Modeless Commands - shortcut keys for common 
commands. Some modeless commands are commands that are not found elsewhere. A couple of 
Modeless Commands are used to activate start-up options.

Learn how to use the Project Explorer window, and learn how to customize the default software 
settings. Learn how to quickly see the design contents within the window.

Starting PADS Layout
You can start PADS Layout from the Windows Start menu or from shortcut icons.

• Start > Programs > Mentor Graphics SDD > PADS <latest_release> > Design 
Layout & Routing

Tip: The installation program automatically creates a shortcut on the Windows desktop to 
PADS Layout.

Start-up Options
You can use start-up options, known as command line switches, to control the initial PADS 
Layout configuration. Use command line switches to enable different options, to open a file, 
start macros, and record a PADS Layout session. You can type multiple command line options.

You add start-up options to the PADS Layout program folder or to the PADS Layout shortcut 
icon.

Table 3-1 lists and describes the command line options you can start when you start PADS 
Layout.

Table 3-1. PADS Layout Command Line Options 

Option Description

file name Opens the specified design file when you start PADS Layout. Type the 
full folder path and file name. Use quotation marks for folders or file 
names with spaces.
Example: “C:\PADS Projects\Samples\preview.pcb”
Restriction: Do not use a forward slash ( / ) before the file name in the 
command line.
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/BMW[=initials] ( [ ] represents optional text.)
Opens the Basic Media Wizard. Use the Basic Media Wizard to start 
recording a session log or to convert the previous session log to media that 
can be replayed by Basic Log Test. To create session media files for the 
current PADS Layout session, use the BMW modeless command.
To use the BMW command line switch, type /BMW or /BMW=xx, where 
xx is your initials, in the command line. Note the capitalization.
This option is associated with another modeless command, BLT. BLT is 
the Log Test; it finds and runs the session media created by BMW to play 
back a recorded PADS Layout session. 
See also: Typing Modeless Commands

/DoTest Runs the integrity test on every file open.

/l Opens the last file you had open when you start PADS Layout.

/mmacro name Runs the specified macro in the default macro file. For example, to run the 
macro MyMacro, type /mMyMacro.

/Mmacro file Specifies the file to use as the default macro file. For example, to run the 
macro MyMacro contained in the file user1.mcr, type /Muser1.mcr 
/mMyMacro. Note the required capitalization.
Requirement: Macros must be in the \PADS Projects folder.

/nc Starts PADS Layout without displaying the splash screen that includes 
copyright information.

/NTL Disables true layer associations. When you use Flip Side, the layer 
attributes will not move to the new layer with the component. Type /NTL 
to disable true layer associations. Note the required capitalization.
TrueLayer is enabled by default and moves mask layer definitions with a 
part that is placed on the opposite side of the board. It also correctly plots 
paste masks of documentation-level pad shapes in CAM. The layer that 
the definitions move to is set in the Component Layer Associations dialog 
box. 
See also: Add or Edit a CAM Document, Associating Component and 
Documentation Layers

/sXXX Starts a Basic script when you start PADS Layout. Use quotation marks 
for file names with spaces.
Example: “/sC:\PADS 
Projects\Samples\Scripts\Layout\Unsupported\Attributes to Excel.bas”

Table 3-1. PADS Layout Command Line Options (cont.)

Option Description
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Adding Start-up Options to a New PADS Layout Program 
Folder Item

The PADS Layout program folder item created during installation is read-only and you cannot 
add start-up options to it. However you can create a new program folder item and add PADS 
Layout start-up options to it.

To add start-up options to a new program folder item:

1. Right-click over the Windows Start button and click Explore All Users. Windows 
Explorer opens.

2. Navigate to the Programs\Mentor Graphics SDD\PADS<latest_release>\PCB Layout 
start menu folder under the All Users login name.

Example: C:\Documents and Settings\All Users\Start Menu\Programs\Mentor 
Graphics SDD\PADS<latest_release>\PCB Layout.

3. In a blank area on the right side of Windows Explorer, right-click, point to New, and 
then click Shortcut.

4. Browse to powerpcb.exe. Do not click Next.

Example: PADS Layout is typically installed to 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\powerpcb.exe.

5. Click in the box, press End, press Spacebar, and then type the command line switch 
you want to use. Click Next.

Example: To start PADS Layout with preview.pcb, the command line should read: 
“C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\powerpcb.exe” 
“C:\PADS Projects\Samples\preview.pcb”.

Requirement: Enclose with double quotes " " each string that contains a space.

Restriction: When specifying a file to start, do not use a / before the file name.

Tip: You can specify multiple command line switches.

6. Type in the box the name of the program folder item to create, and then click Finish.

7. To start PADS Layout using the start-up options, close PADS Layout if it is running, 
and then click the new program folder item.



PADS Layout User’s Guide and Reference Manual, PADS 9.498

User Interface
Checking for PADS Updates

Adding Start-up Options to a New PADS Layout Desktop 
Shortcut Icon

The PADS Layout desktop shortcut icon created during installation is read-only and you cannot 
add start-up options to it. However you can create a new shortcut and add PADS Layout start-up 
options to it.

To add start-up options to a new desktop shortcut:

1. Right-click over an empty area of the desktop, point to New, and then click Shortcut.

2. Browse to powerpcb.exe. Do not click Next.

Example: PADS Layout is typically installed to 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\powerpcb.exe.

3. Click in the box, press End, press Spacebar, and then type the command line switch 
you want to use. Click Next.

Example: To start PADS Layout with preview.pcb, the command line should read: 
“C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\powerpcb.exe” 
“C:\PADS Projects\Samples\preview.pcb”.

Requirement: Enclose with double quotes " " each string that contains a space.

Restriction: When specifying a file to start, do not use a / before the file name.

Tip: You can specify multiple command line switches.

4. Type in the box the name of the shortcut to create and click Finish.

5. To start PADS Layout using the start-up options, close PADS Layout if it is running, 
and then double-click the shortcut.

Checking for PADS Updates
The PADS products automatically check for a new software version when you launch an 
application. If a new version is detected, a tooltip is displayed in the system tray.

Requirement

An internet connection is required for the check.

Procedure - Downloading the Update

Once the new version is detected, you can download the update.

1. Right-click the icon in the system tray.

2. Click Open download page.
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3. Follow the instructions on the download page.

Procedure - Disabling the Check for Updates

If you don’t want to automatically check to see if there is a new version available, you can 
disable the Check for Updates. You can enable the check at any time in the future, or you can 
manually check for updates at any time.

1. Help > Check for updates.

2. In the Check for Updates dialog box, select Disable “Check for Updates” 
functionality.

Procedure - Checking for Updates Manually

There is no need to check for updates manually unless you’ve disabled the automatic check.

1. Help > Check for updates.

2. In the Check for Updates dialog box, click Check for Updates.

Switching to PADS Router
To quickly move your design to work in PADS Router, use the Route button on the main 
toolbar. Depending on your settings, this will either open PADS Router with your design 
displayed, or enter Synchronization mode.

Tips: 

• You must enable Synchronization mode and then restart PADS Layout before 
Synchronization modes takes effect.

• To turn off the display of licensing warnings when switching between PADS Layout and 
PADS Router, type the following text in the Blazerouter.ini file:

[Security]
DisplayWarnings=0

(You don’t need to restart PADS Router.)

Synchronization Mode
Synchronization Mode links PADS Layout and PADS Router. As you work in PADS Router, 
you’ll see the changes reflected in PADS Layout and vice versa; if PADS Layout is the active 
program, changes made there are reflected in PADS Router. When you’re in Synchronization 
mode, you can instantly switch between the two programs. If an unsupported command is 
performed or an unsupported option is changed, the inactive program will become out of sync.
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Tip: You must enable Synchronization mode and then restart PADS Layout before 
Synchronization modes takes effect.

Procedure

• Main toolbar > Route button

Result

PADS Router opens and your design is loaded. PADS Layout is switched to DRC Off mode and 
is now the inactive program. As you work in PADS Router, you’ll see the changes reflected in 
PADS Layout. You can quickly switch back forth between the two programs and continue to be 
in Synchronization mode. If an unsupported command is performed or an unsupported option is 
changed, the inactive program will become out of sync.

Tips:

• Most menu items and commands are disabled or are read-only for the inactive program.

• Look at the status bar to quickly determine which mode the program is in: Active, 
Inactive, or Out of sync.

• Automation can still be used; however, most Automation methods will not return any 
valuable results and will not make any changes in the database.

• To switch back to PADS Layout, use the Layout button on the main toolbar in PADS 
Router.

Enabling Synchronization Mode
You must enable Synchronization mode to link PADS Layout and PADS Router correctly.

Procedure

1. Tools menu > Options.

2. In the Options Dialog Box, click the Synchronization page.

3. In the Layout and Router Synchronization area, click Enable.

4. To restore the DRC mode when you switch back to PADS Layout to what you had 
before switching to PADS Router, click Restore DRC Mode on return.
Tips: 

• Switching to PADS Router automatically places your design in PADS Layout in 
DRC Off mode; the DRC mode in PADS Router is not affected.

• Depending on the size of your design, restoring the DRC mode may take a few 
minutes; therefore, it is recommended to not restore your DRC mode upon return.
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5. To receive a warning about being placed into DRC Off mode when you switch to 
Synchronization mode, click Warn about switching to DRC Off mode.

6. Click OK.

7. Restart PADS Layout.

Unsupported Actions in Synchronization Mode
There are a few commands and options that are not supported in Synchronization mode. If you 
perform one of these commands, or change one of the options, PADS Layout and PADS Router 
will become out of sync.

Tip: To re-synchronize the two programs, click the Layout button on the main toolbar in PADS 
Router if PADS Router is active; or click the Route button on the main toolbar in PADS Layout 
if PADS Layout is active.

Unsupported commands

• Changing a drafting object: copper, copper pour, text, 2D lines, keepouts, labels, board 
outlines, dimensioning
Exception: When drafting objects are attached to a component and the component is 
moved, it will not cause the programs to become out of sync.

• Changing rules

• Changing padstacks or layer definitions

• Importing ASCII files (or any other import)

• Verifying the design

• Changing reuses and clusters

• ECO or BGA operations

• Updating from the library

• Using the Decal Editor

• Inserting an OLE object

• Any operation that clears the Undo buffer including Autorouting and large group moves

Unsupported option changes

• DFF

• DFT

• Verify Design
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• Drafting

• Split/Mixed Plane

• Thermals

• ECO Options

• Via Patterns

Exiting Synchronization Mode
To exit Synchronization mode, close one of the applications. For example, if you want to 
continue working in PADS Layout, but no longer want to be in Synchronization mode, close 
PADS Router.

Typing Modeless Commands
You can set or change some settings and functions at any time using a shortcut key for the 
command called a modeless command. There are also many modeless commands that are not 
available anywhere else.

Procedure

1. Click in empty space in the design area.

2. Type the modeless command (shortcut key) for the command you want. 

Restriction: Use a space between the command and the argument. For example: N 
GND or GD 50.

3. Click Enter.

Related Topics

Modeless Command Dialog Box

Modeless Commands

Shortcut Keys

Project Explorer
• Click the Project Explorer button.

The Project Explorer shows a hierarchical structure for the objects in your design. It provides 
access to objects and rules. When you update your design, the hierarchical structure is 
automatically updated to reflect the changes you make.

Tip: The Hierarchical structure is available only when a design is open.
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Restriction: The Project Explorer is not available in the PCB Decal Editor.

In this topic:

• Selecting Objects

• Zooming to Selection

Selecting Objects
You can select an object in the Project Explorer and have it automatically selected in the 
workspace. 

To select an item in the workspace:

• Right-click and click Allow Selection.

Zooming to Selection
You can zoom to the item you select in the Project Explorer.

To zoom to the selection:

• Right-click and click Zoom to Selection.

Output Window
Use the Output window for displaying reports and session logs, macro editing and debugging.

• To display the Output window, click the Output Window button.

The Output window is located in the lower left section of the display window. You can dock or 
float the Output window. You can also display or hide the Output window.

See the following sections for more information:

Working with the Status tab
• Managing Session Logs

Working with the Macro tab
• Creating Macros

• Managing Macros

• Playing Back Macros
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• Debugging Macro Scripts

• Using Command Line Switches with Macros

Related Topics

• Output Window in the Concepts Guide

Managing Session Logs
The following topics describe managing session logs:

Session Log
A session log, which appears in the Status tab of the Output window, contains all program 
output for the current session, including names of open and saved files, integrity test results.

The session log presents different types of information in different colors. Underlined items are 
links. Text colors representations are shown in the following table:

Navigating Pages in the Status Tab
Using the Status tab toolbar buttons in the Output window, you can navigate to the previous 
page, the next page, and refresh a display of reports and other pages. You can also stop updates 
to pages, and return to the session log display.

• Session Log

• Navigating Pages in the Status Tab

• Filtering the Status Tab Display

• Searching Text in the Status Tab

• Printing Session Log Messages

• Displaying and Printing Reports

• Saving a Session Log to File

• Clearing the Session Log Display

Table 3-2. Session Log Text Color Representations

Color Meaning

Red Errors

Green Warnings

Black Messages

Blue Links to files, Web pages, and database objects
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To perform these functions, use the following Status tab toolbar buttons:

Filtering the Status Tab Display
The session log file messages in the Status tab are color coded by subject. You can choose to 
view any combination of the color coded messages.

To filter the display in the Status tab:

1. Right-click in the Output window and point to Filter. The Filter submenu appears and 
contains the following commands:

2. Click one of the submenu commands to filter the view. Check marks indicate which 
messages are turned on. Turn off message displays by clearing the check marks.

Searching Text in the Status Tab
Similar to searching in a document, you can search text in the Status tab. To find text in the 
Status tab:

1. Right-click and click Find.

2. In the Find dialog box, type the text you want to find in the dialog box and complete any 
other dialog box options.

3. Click Find Next. The tab scrolls to the occurrence of the word, highlighting the word.

Table 3-3. Status Tab Toolbar Buttons 

Command Description

Back Displays the previous page.

Forward Displays the next page.

Stop Stops page updates.

Refresh Refreshes the display of reports and other pages.

Home Returns to the session log.

Table 3-4. Filter Submenu Commands

Command Description

Error Displays error messages.

Warning Displays warning messages.

Message Displays messages.

Show all Displays all messages (error, warning, and message).
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Printing Session Log Messages
You can print a hard copy of the session log for review purposes. To print the session log:

1. Right-click and click Print.

2. In the Windows standard Print dialog box, change any Print dialog box options as 
needed.

3. Click OK.

Displaying and Printing Reports
The session log contains links to reports that you can view and print. The links are in blue and 
underlined.

To display the report:

• Click the link to view the report. The report appears replacing the session log as the 
active page in the Status tab.

To print the report:

1. Right-click and click Print. 

Alternative: On the Status tab toolbar, click the Print button.

2. In the Windows standard Print dialog box change any Print dialog box options as 
needed.

3. Click OK.

Saving a Session Log to File
You can save the session log for future reference.

• Click the Log to File button.

Result: If a session log file already exists, new information is appended. If a session log 
file does not exist, a new file is created. The default path (\PADS Projects) for the 
session log file is set in the .ini file when you install the program.

Clearing the Session Log Display
You can clear the session log display each time you open a file. This prevents you from 
accidentally viewing information from a previously opened file. It does not delete the log file.

• Right-click and click Clear.
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Related Topics

• Session Log in the Concepts Guide

Creating Macros
You can create macros to simplify redundant activities. You can record any set of procedural 
steps for replay as a single action. You can also nest macros.

Tip: Dialog box actions are recorded as results rather than actions, so when you replay, you 
don't see the dialog boxes in the replay process. Because of this you can't create a macro that 
stops on an open dialog box; it must follow through to some result or action. For example, you 
can create a macro that selects Open on the File menu, selects a file, and selects OK. The macro, 
when played back, opens a file.

The following descriptions are included in this topic:

• Creating a New Macro

• Recording Mouse Movements

• Saving a Macro

Creating a New Macro
To create a new macro:

1. Click the Output Window button.

2. On the Macro tab, click the New button. New macros are given a name of Macro#, 
where # is a numeric sequence such as Macro1 or Macro2.

3. You can click the Compress mouse moves and/or Relative mouse moves buttons. See 
Recording Mouse Movements for more information.

4. On the Macro tab toolbar, click the Record button.

5. Perform the keystrokes, commands, and mouse clicks to include in the macro.

6. On the Macro tab toolbar, click the Stop button.

You can also script a macro instead of recording mouse actions. 

Recording Mouse Movements
Mouse movements are recorded in macros. You can record compressed or uncompressed mouse 
movements and relative or absolute movements.

Compress Mouse Mode—Compress mouse mode records only the start point and endpoint of a 
mouse movement. It does not record any of the intermediate coordinates between the start and 
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end points. Compression is recommended under most circumstances because it significantly 
reduces the size of your macro file. Recording intermediate mouse movements increases the file 
size, but documents coordinate information if required for a special application.

Relative Mouse Mode—Relative mouse mode records the start point and endpoint of a 
movement in incremental coordinates instead of absolute coordinates.

Saving a Macro
1. Click the Save button.

2. In the standard Windows Save As dialog box, enter a filename, if desired, and click 
Save.

Related Topics

• Using Command Line Switches with Macros

• Macros in the Concepts Guide

Managing Macros
This following descriptions are included in this topic:

• Opening an Existing Macro File

• Viewing Multiple Open Macros

• Editing a Macro

• Saving the Macro

Opening an Existing Macro File
Macros are created in and stored in macro files that have a .mcr extension. To open an existing 
macro file (.mcr), you can use the menus or the toolbar.

1. Click the Output Window button and then click the Macro tab.

2. Click the Open button.

3. In the Open File dialog box, select the macro file to open and click Open.

You can open multiple macros in the macro editor. The macro editor also supports nested 
macros.

Viewing Multiple Open Macros
You can open multiple macros in the macro editor. To switch between these open macros:
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• Click the macro you want to view in the List of Open Macros area of the Macro tab.

The macro script appears in the edit area.

Editing a Macro
You can copy or cut selected text to the Clipboard. You can also paste the selection from the 
Clipboard into the text window. You can paste text from the Clipboard into other applications. 
You can also switch between open macros to edit multiple macros.

To copy or cut and paste text in a macro:

1. Select the text you want to copy or cut.

2. On the Macro tab toolbar, click the Copy or Cut buttons.

3. On the Macro tab toolbar, click the Paste button. You will see that your selection has 
been pasted in the Output window at the insertion point.

Alternative: Right-click in the Output window and click Copy, Cut, or Paste. 

If you chose Notepad as the default text editor, longer macro files may not be loaded because of 
size constraints in Notepad. 

To access large files using Edit, you must install an ASCII text editor with a suitable file size 
capacity. To change the default text editor:

1. Open the powerpcb.ini file in a text editor.

2. Modify the [GENERAL] section, specifying a new text editor executable name. Include 
the drive and folder if the new editor is not in your Windows folder.

3. Save the .ini file and close the text editor.

4. Proceed with editing a macro.

Saving the Macro
1. Click the Save button.

2. In the standard Windows Save As dialog box, enter a filename, if necessary, and click 
Save.

Related Topics

• The Macro Language in the Reference Guide

• Macros in the Concepts Guide
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Playing Back Macros
You can play back an existing macro using Run. Run also resumes the playback of a paused 
macro. When you play a macro, you cannot use the mouse in the workspace.

The following descriptions are included in this topic:

• Playing Back a Macro

• Pausing a Playing Macro

• Stopping a Playing Macro

Playing Back a Macro
To play back a macro:

1. On the Macro tab, click the Open button and open a macro (.mcr) file. Recent macros 
can be found on the Tools menu > point to Macros > Macros menu.

2. On the Macro tab toolbar, click the Run button. 

Alternative: Right-click in the Macro tab and click Run.

Pausing a Playing Macro
You can pause a playing macro at any time.

• On the Macro tab toolbar, click the Pause button. 

Tip: Click the Play button to play the macro again.

Stopping a Playing Macro
You can stop the playback of a macro at any time. However, you cannot resume the playback of 
the macro once you have stopped it. When you click Run, the macro starts from the beginning.

• Right-click and click Stop.

Alternative: On the Macro tab toolbar, click the Stop button.

Related Topics

• Macros in the Concepts Guide

Debugging Macro Scripts
When playing back a macro, you can run it step-by-step, or to a certain location in the script. To 
perform these debugging tasks, insert breakpoints in the macro at the points at which you want 
the macro to stop.
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The following descriptions are included in this topic:

• Setting or Removing Breakpoints

• Debugging the Macro Scripts

• Correcting Run-Time Errors

Setting or Removing Breakpoints
The ability to set or remove breakpoints is useful when you debug a macro. If the macro engine 
encounters a breakpoint when playing back a macro, it pauses the macro.

To set a breakpoint in a macro:

1. Place the cursor on the line in which to add a breakpoint.

2. Right-click in the Macro tab and click Toggle Break. This inserts a breakpoint at the 
current cursor location. A breakpoint marker appears in the gutter area.

Alternative: On the Macro tab toolbar, click the Toggle Breakpoint button.

When the macro engine encounters a breakpoint while playing back a macro, it pauses the 
macro. The next line in the macro is marked with the instruction pointer.

Debugging the Macro Scripts
Once breakpoints are inserted, you can debug macros using the following tasks.

To play a single line of the macro:

• Right-click in the Macro tab and click Step Over.

Alternative: On the Macro tab toolbar, click the Step over button.

To perform a subroutine call on the current line:

• Right-click in the Macro tab and click Step Into.

Alternative: On the Macro tab toolbar, click the Step into button. 

To return from the subroutine to the point from which it was called:

• Right-click in the Macro tab and click Step Out.

Alternative: On the Macro tab toolbar, click the Step out button.

To play back a macro to a point:

• Right-click in the Macro tab and click Step to Cursor.

Alternative: On the Macro tab toolbar, click the Step to cursor button.
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To continue the execution from the current point:

• Right click in the Macro tab and click Run.

Alternative: On the Macro tab toolbar, click the Run button. 

Correcting Run-Time Errors
If run-time errors occur, the macro debugger switches to step-by-step mode and displays a 
detailed message on the status bar. The instruction pointer is set on the line that produced the 
error. After fixing the error, you can resume playback of the macro.

Related Topics

• Macros in the Concepts Guide

• The Macro Language in the Reference Guide

Using Command Line Switches with Macros
Using command line switches, you can record your session, load and run a macro, or record a 
macro to a specific file and location when you start PADS Layout.

The following descriptions are included in this topic:

• Recording a Session

• Recording Log Files to a Specific File and Location

• Running a Macro When You Start the Program

Recording a Session
1. In the Start menu, navigate to the shortcut for PADS Layout.

2. Right-click the shortcut and click Properties.

3. Click the Shortcut tab and click in the Target box.

4. At the end of the existing shortcut, type: -log. Make sure to type a space between 
"powerpcb.exe" and the "-log" command.

5. Click OK. When you run the program, a log is created.

Recording Log Files to a Specific File and Location
1. In the Start menu, navigate to the shortcut for PADS Layout.

2. Right-click the shortcut and click Properties.

3. Click the Shortcut tab and click in the Target box.
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4. At the end of the existing shortcut, type: -log:[path and file name]. For example: -
log:C:\PADS Projects\mylog.txt. Make sure to type a space between "powerpcb.exe" 
and the "-log" command.

5. Click OK. When you run the program, a log is created in the specified location using the 
specified name.

Running a Macro When You Start the Program
You can run a macro at start-up when you start PADS Layout from a shortcut (on your desktop 
or from the Start menu).

1. In the Start menu, navigate to the shortcut for PADS Layout.

2. Right-click the shortcut and click Properties.

3. Click the Shortcut tab and click in the Target box.

4. At the end of the existing shortcut, type:

-run=[path and file name]

For example:

-run=C:\PADS Projects\Samples\mymacro.mcr

Requirement: Make sure to type a space between "powerpcb.exe" and the "-run" 
command. 

Alternative: You can use a / instead of the hyphen (for example, /run=mymacro.mcr).

5. Click OK. When you run the program, the specified macro runs as soon as the program 
starts.

Related Topics

• Macros in the Concepts Guide

• Creating Macros

Opening a File That is Already in Use
The PADS products help you avoid making changes to a file that is already opened by another 
user.

The first user to open a file in a shared location becomes the owner of the file for the duration 
the file is open; the file is locked to all other users. If you try to open a file that someone else has 
already opened, you will get a warning message letting you know the current owner and the 
name of the computer from where the file is locked. You have the option to view a read-only 
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version of the file but you will not be able to update it while the owner still has it open. You can 
save the file with another name using Save As.

Migrating User Settings
You can use the PADS User Settings Migration tool to extract your settings from one 
installation of PADS Logic, Layout, and Router and import them into another installation or 
version. For information on how to do this, see User Settings Migration in the PADS User 
Settings Migration Guide.

Customizing PADS Layout Default Settings
Several settings are used to define the default ASCII parameters of operation of PADS Layout. 
You can customize the user interface by modifying these system settings and saving the files. 

In this topic:

• PADS Layout Default Settings

• Changing the PADS Layout Default Startup Conditions

• Changing the PADS Layout Default Startup File

PADS Layout Default Settings
The file DEFAULT.ASC contains Layout mode settings, and the file DECALEDT.ASC 
contains Decal Editor mode settings. In addition, you can create your own startup files and save 
them with the .stp extension.

Use the Save As Start-up File and Set Start-up File menu options to enable Layout mode and 
Edit Decal mode to work with startup files. Use the Set Start-up File dialog box to set the 
options you want to save in the file.

Changing the PADS Layout Default Startup Conditions
To change the default startup conditions for PADS Layout:

1. On the Tools menu, click Options.

2. Use the Options dialog box to change the design units, grids, and default font, etc.

3. Click OK to save the changes.

4. On the Setup menu, click Layer Definition.

5. Use the Layers Setup dialog box to change layer mode, number of electrical layers, layer 
associations, etc.
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6. On the Setup menu, click Design Rules.

7. Use the Rules dialog box to change any rules for the design.

8. On the File menu, click Save as Start-up File. Then set the folder 
to C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Settings.

9. Select the appropriate *.stp file from the list of files, or type a new name in the 
File name area if it does not exist.

10. Click Save. The Save as Start-up File dialog box displays.

11. In the Start-up File Output dialog box, click Select All or leave already selected options 
unchanged.

12. Leave other options unchanged and click OK.

Tip: You can add comments to the start-up file.

Changing the PADS Layout Default Startup File
To change the default start-up file for PADS Layout:

1. On the File menu, click Set Start-up File

2. In the Set Start-up File dialog box, select the appropriate file in the list of Start-up 
designs, and click OK.

To Zoom to Board Extents
To fit the board to the view press Home on the numeric keypad.

Customizing the PADS Interface
You can customize the PADS interface to suit your work style and design work. You can 
determine which toolbars are displayed, add items to toolbars and menus, and create custom 
toolbars, menus and shortcut keys.

To make customizations, use the Customize dialog box. You can invoke the dialog box in two 
ways:

• From the PADS interface, select Tools menu > Customize. All customizations you 
make are applied to the main view of the PADS tool.

• In a window of the interface (for example, the Output Window), right-click and select 
Customize. You customizations apply only to that window.

Your customizations are saved with your current workspace so that all of the changes you make 
to toolbars, menus, and shortcut keys are present when you work in that workspace again.
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Related Topics:

• Customizing Toolbars

• Creating a Custom Menu

• Customizing Shortcut Keys

• Customizing the Appearance of the Screen

Customizing Toolbars
Use the Toolbars and Menus tab on the Customize dialog box (Tools menu > Customize > 
Toolbars and Menus tab) to create custom toolbars and shortcut menus.

• Creating a Custom Toolbar

• Resetting Toolbars to Defaults

• Deleting a Custom Toolbar

• Renaming a Custom Toolbar

Tip: To create a custom main menu, use the Commands tab on the Customize dialog box. See 
Creating a Custom Menu.

Related Topics

Moving Items on Toolbars and Menus

Creating a Custom Toolbar
To create a custom toolbar, you create a new empty toolbar and add items (commands) to it.

To create a custom toolbar:

1. Tools menu > Customize > Tools and Menus tab.

2. In the Toolbars box, click the New button.

3. Type the name for the toolbar and click OK.

Results:

• The new (empty) toolbar appears on the PADS interface.

• The Toolbars and Menus tab lists the new toolbar, showing it as selected and 
enabled for display (the check box to the left of its name is selected).

4. Drag the toolbar to the place on the PADS interface where you want it.

5. To add items (commands) to your new toolbar, click the Commands tab. 
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6. In the Categories list, select a menu or toolbar name to display commands specific to 
that menu or toolbar. Or select All Commands.

Restriction: If you are working in a special mode in PADS Layout or PADS Logic (for 
example, the Decal Editor in PADS Layout), some categories of commands are not 
available for customization.

7. In the Commands list, select the command you want and drag it to the toolbar.

8. When you have finished adding commands, click Close.

Related Topics

• Deleting a Custom Toolbar

• Adding Items to Toolbars and Menus

• Removing Items from Toolbars and Menus

Showing or Hiding a Toolbar
To increase space in the PADS interface, you can show the toolbars you need to use and hide 
others.

To show or hide toolbars:

1. Tools menu > Customize > Toolbars and Menus tab.

2. In the Toolbars list, select the toolbar.

3. To display the toolbar in the interface, select the check box to the left of its name. To 
hide the toolbar, clear the check box.

4. Click Close.

Tip: For information on other ways you can customize the appearance of toolbars and menus, 
see Customizing the Appearance of the Screen.

Deleting a Custom Toolbar
You can delete a custom toolbar (a toolbar you created).

Restriction: You cannot delete a system toolbar.

To delete a custom toolbar.

1. Tools menu > Customize > Toolbars and Menus tab.

2. In the Toolbars list, select a custom toolbar. Then click the Delete button.
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Related Topics

• Adding Items to Toolbars and Menus

• Removing Items from Toolbars and Menus

• Showing or Hiding a Toolbar

Renaming a Custom Toolbar
You can rename a custom toolbar (a toolbar you created).

Restriction: You cannot rename a system toolbar.

To rename a custom toolbar:

1. Tools menu > Customize > Toolbars and Menus tab.

2. In the Toolbars list, select a custom toolbar and click the Edit button.

3. In the Toolbar Name dialog box, type the new name and click OK.

Related Topics

• Showing or Hiding a Toolbar

• Deleting a Custom Toolbar

Resetting Toolbars to Defaults
You can reset one or all system toolbars to their default buttons.

To reset a specific toolbar to its default settings:

1. Tools menu > Customize > Toolbars and Menus tab.

2. In the Toolbars list, select the toolbar.

3. Click Reset.

Tip: To reset all system toolbars to defaults, click Reset All.

Customizing Commands and Menus
You can customize commands that you can then use as selections on menus or as buttons on 
toolbars and you can customize Menus.

• Creating a Custom Command

• Defining Properties for a New Command

• Editing a Custom Command
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• Deleting a Custom Command

• Creating a Custom Menu

Creating a Custom Command
You can create a custom command from:

• A command that already exists as a menu item or toolbar button. To create this kind of 
command, you select an existing command on which to base your new command. Then 
you define the properties of your new command.

• A macro command file. See Creating Commands from Macro Command Files.

To create a custom command from an existing command:

1. Tools menu > Customize > Commands tab.

2. In the Categories list, click a menu or toolbar name to display items (commands) 
specific to that menu or toolbar. Or click All Commands.

Tip: If you made macro commands (on the Macro Files tab) available as commands, the 
Categories list includes the Macro category and the Commands list includes the macros. 
For more information, see Creating Commands from Macro Command Files.

3. In the Commands list, select the command on which you want to base your custom 
command. Then click the New button.

4. In the Add Command dialog box, specify the properties of your new command:

a. In the Command name box, type the name of the command.

b. In the Arguments box, type arguments for the command. Use a space to separate 
arguments. If an argument contains a space, enclose the argument in quotation marks 
(““).

c. In the Description box, type a description of the custom command.

d. If an image was associated with the original command, select Use Default Image to 
use that same image with your custom command. Select Select User-Defined 
Image to use a different image, edit an image, or create a new image.

e. Click OK to close the Add commands dialog box and return to the Customize dialog 
box. 

5. If you are finished with all customizations, click Close.

Tip: To add the command to a toolbar or menu, click the command and drag it from the 
Commands list to the toolbar or menu.
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Related Topics

• Adding Items to Toolbars and Menus 

• Creating Commands from Macro Command Files 

• Resetting Toolbars to Defaults 

Defining Properties for a New Command
To define properties for a new command:

1. Tools menu > Customize > Commands tab.

2. In the Commands list, click New, then click the new button. The Add command dialog 
box opens.

3. In the Command name box, type the name of the new command.

4. Optionally, in the Based on box, type the name of the command on which the new 
command is based.

5. In the Arguments box, type space delimited arguments for the new command.

Requirement: If an argument contains a space, enclose it in quotation marks.

6. In the Description box, edit the command description, for example, to represent the 
argument values you added.

7. If an image was associated with the original command, select Use Default Image.

or

Select Select User-defined Image, then select a image, edit an image, or create a new 
one.

8. Click OK to close the Add Command dialog box and return to the Customize dialog 
box.

Related Topics

Customizing Commands and Menus 

Editing a Custom Command
Restriction: You can edit only custom commands (commands you created). You cannot edit 
system commands.

To edit a custom command:

1. Tools menu > Customize > Commands tab.
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2. In the Categories list, click a menu or toolbar name to display items (commands) 
specific to that menu or toolbar. Or click All Commands.

3. In the Commands list, select a command and click the Edit button.

4. In the Edit commands dialog box, change the properties of your custom command:

a. In the Command name box, type the name of the command.

b. In the Arguments box, type arguments for the command. Use a space to separate 
arguments. If an argument contains a space, enclose the argument in quotation marks 
(““).

c. In the Description box, type a description of the custom command.

d. If an image was associated with the original command, select Use Default Image to 
use that same image with your custom command. Select Select a User-Defined 
Image to use a different image, edit an image, or create a new image.

e. Click OK to close the Edit commands dialog box and return to the Customize dialog 
box. 

5. When you are finished with all customizations, click Close.

Click OK to close the Edit commands dialog box and return to the Customize dialog. 

Deleting a Custom Command
Restriction: You can delete only custom commands (commands you created). You cannot 
delete system commands.

To delete a command:

1. Tools menu > Customize > Commands tab.

2. In the Categories list, click a menu or toolbar name to display items (commands) 
specific to that menu or toolbar. Or click All Commands.

3. In the Commands list, select a command and click the Delete button.

4. Click Close.

Creating a Custom Menu
To create a custom menu, you first create a new empty menu and then add items (commands) to 
it:

To create the new menu:

1. Tools menu > Customize > Commands tab.
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2. In the Categories list, select New Menu.

3. In the Commands list, select New Menu and drag it to the location you want.

• To create a top-level menu, drag the new menu to the Menu Bar.

• To create a submenu, drag it over an existing menu name.

4. Click your new menu to select it. Then right-click and select Button Appearance.

5. In the Button text field, type the name for the menu and click OK. Leave the Customize 
dialog box open.

6. To add items (commands) to your new menu, click the Commands tab. 

7. In the Categories list, select a menu or toolbar name to display commands specific to 
that menu or toolbar. Or select All Commands.

Restriction: If you are working in a special mode in PADS Layout or PADS Logic (for 
example, the Decal Editor in PADS Layout), some categories of commands are not 
available for customization.

8. In the Commands list, select the command you want and drag it to the menu.

9. When you have finished adding commands, click Close.

Controlling Toolbar and Menu Content
You can modify the items on Toolbars and Menus.

• Adding Items to Toolbars and Menus

• Moving Items on Toolbars and Menus

• Removing Items from Toolbars and Menus

Adding Items to Toolbars and Menus
To add a button to a toolbar or an item to a menu:

1. Tools menu > Customize > Commands tab.

2. In the Categories list, select a toolbar or menu name to display commands specific to 
that menu or toolbar. Or select All Commands.

Restriction: If you are working in a special mode in PADS Layout or PADS Logic (for 
example, the Decal Editor in PADS Layout), some categories of commands are not 
available for customization.

3. In the Commands list, select the command you want and drag it to the toolbar or menu.
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Tip: To remove an item from a toolbar or menu (while the Customize dialog box is 
open), click the item and drag it outside the toolbar or menu.

4. When you have finished adding commands, click Close.

Related Topics

Creating a Custom Command

Creating Commands from Macro Command Files

Removing Items from Toolbars and Menus

Moving Items on Toolbars and Menus

Moving Items on Toolbars and Menus
You can rearrange items on a menu or buttons on a toolbar. You can also move or copy an item 
from one menu or toolbar to another.

Moving Buttons on Toolbars

The method you use for moving toolbar buttons depends on whether the Customize dialog box 
is open:

If the Customize dialog box is open:

• Click the toolbar button and drag it to a new place on the same toolbar or to a different 
toolbar.

Tip: Instead of moving a button, you can copy it and move the copy. Press and hold the 
Ctrl key while dragging the button.

If the Customize dialog box is closed:

• Press and hold the Alt key. Drag the toolbar button to a new place on the same toolbar or 
to a different toolbar.

Moving Items on Menus

Restriction: To move menu items, the Customize dialog box must be open.

To move a menu item:

1. Tools menu > Customize.

2. In the main window of the PADS tool, display the menu containing the item you want to 
move.

3. Click the menu item and drag it to its new location on the same menu or to a different 
menu.
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Tip: Instead of moving a menu item, you can copy it and move the copy. Press and hold 
the Ctrl key while dragging the item.

4. Click Close.

Related Topics

• Customizing Commands and Menus

• Adding Items to Toolbars and Menus 

• Resetting Toolbars to Defaults

Removing Items from Toolbars and Menus
You can remove a menu item or toolbar button. The method to use depends on whether the 
Customize dialog box is open.

If the Customize dialog box is open: 

• Drag the item outside the toolbar or menu. Then close the Customize dialog box.

If the Customize dialog box is closed:

• Press and hold Alt. Then drag the item outside the toolbar or menu.

Tip: You can reset a toolbar or shortcut menu back to its default list of items. See Resetting 
Toolbars to Defaults.

Related Topics

Adding Items to Toolbars and Menus

Customizing Shortcut Keys
You can create and customize shortcut keys by using the Keyboard and Mouse tab of the 
Customize dialog box (Tools menu > Customize > Keyboard and Mouse tab).

• To generate a report of available shortcut keys, see Listing Available Shortcut Keys.

• To create a shortcut key or reassign an existing shortcut, see Creating a New Shortcut 
Key.

• To assign a shortcut key to a macro command, Assigning Shortcut Keys to Macros.

• To delete an existing shortcut key, see Deleting a Shortcut Key.

• To reset all shortcut keys to their default settings, see Resetting Default Shortcut Keys.
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Creating a New Shortcut Key
You create shortcuts that apply in any mode. Thus, the same shortcut key may have different 
functionality depending on the mode in which you are working.

To create a shortcut key:

1. Tools menu > Customize > Keyboard and Mouse tab.

2. In the Mode box, select the mode to which you want to apply the shortcut. The available 
commands for that mode appear in the Commands box.

3. In the Commands box, select the command for which you want to create a new shortcut. 
If a shortcut already exists, it appears in the Current shortcuts box.

Tip: To replace an existing shortcut, click Delete to remove the existing shortcut, and 
create a new shortcut for the command.

4. Above the Current shortcuts box, click the New button to open the Assign shortcut 
dialog box. 

5. Select one of the following types of shortcut:

• To assign shortcut keys, select Press new shortcut key(s), and then press the keys 
that you want to use. For detailed information about rules and restrictions for 
creating shortcut keys, see Rules and Restrictions for Key Sequences.

Tip: As you enter the new shortcut, similar shortcuts appear in the Similar shortcuts 
assigned to other commands box. This helps you to avoid creating a new shortcut 
that conflicts with an existing shortcut.

• To create a mouse action, select or select a pointer event, and then select a 
combination of list box options, mouse button events, and modifier keys.

6. Click OK to close the Assign shortcut dialog box.

Result: The new shortcut appears in the Current shortcuts box on the Customize dialog 
box.

Rules and Restrictions for Key Sequences
The first character may consist of the following, plus Alt, Ctrl, or Shift modifiers:

• All printable characters including Space and Tab

• All function keys

• Extended keys: Up, Down, Left, Right, Insert, Delete, Home, PageUp, PageDown, End

• Numerical keypad keys (when Num Lock is off): Up, Down, Left, Right, Insert, Home, 
PageUp, PageDown, Del, End, /, *, +, -
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• Mouse pointer events: Click, Double-click, RotateForward, RotateBackward

Restriction: Mouse pointer events cannot be combined with key sequences, although 
the Ctrl, Alt, and Shift modifiers are allowed.

Subsequent characters may consist of the following:

• Alphanumeric (a-z0-9)

Exception: Some combinations, like Alt+Tab, are intercepted by Windows and thus are not 
available.

Related Topics

Customizing Commands and Menus

Resetting Default Shortcut Keys

Listing Available Shortcut Keys

Resetting Default Shortcut Keys

Listing Available Shortcut Keys
You can create a table of commands and the shortcuts assigned to them in an HTML file, letting 
you share the information over the Web with other members of the design team.

To create an HTML file containing the available shortcut keys:

1. Tools menu > Customize > Keyboard and Mouse tab.

2. Click Report and then select or type the HTML file name, then click Save.

Result: A hyperlink to the file appears in the Output window, under the Status tab.

Related Topics

Customizing Commands and Menus

Creating a New Shortcut Key

Resetting Default Shortcut Keys

Resetting Default Shortcut Keys
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Expressions in Shortcut Keys
You can substitute a regular expression for characters in shortcut key command arguments, see 
Table 3-5. 

The following table shows examples of regular expressions used in command arguments using 
the preview.pcb design, see Table 3-6. 

Deleting a Shortcut Key
Delete shortcuts you no longer want to use, or as the first step to changing an existing shortcut. 

Table 3-5. Expressions in Shortcut Keys 

Expression Use to 

* Match any number of characters.

? Match any one character.

[set] Match any character in the specified 
set.
Tip: A set is composed of characters 
or ranges.
A range has the form: Character 
Hyphen Character, such as A-Z or 0-
9.
The minimum set of characters 
supported in a set consists of [0-9a-
zA-Z_].

[!set] or [^set] Match any character not in the 
specified set.

\ To suppress the special syntactic 
significance of the characters ` [ ] * ? 
! ^ - \ ' within a set, and to match the 
character exactly.

Table 3-6. Shortcut Key Expression Examples 

Shortcut key Result

H A* Highlights all nets starting with A, such as A00, A01, A02.

H +?? Highlights all nets starting with +, having two digits or characters 
after 0, such as +5V.

H A?0 Highlights all nets starting with A, ending with 0, and with any 
character in between, such as A00 and A10.

H [C-D]* Highlights all nets starting with C or D, such as CLKIN, D00.

H [!C-D]* Highlights all nets not starting with C or D, such as A00, GND.
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To delete a shortcut:

1. Tools menu > Customize > Keyboard and Mouse tab.

2. In the Mode box, select the mode for the shortcut you want to delete. The available 
commands for that mode appear in the Commands box.

3. In the Commands list, select the command whose shortcut you want to delete.

4. In the Current shortcuts list, select the shortcut you want to delete.

5. Click the Delete button.

Related Topics

Creating a New Shortcut Key

Resetting Default Shortcut Keys

Resetting Default Shortcut Keys
You can restore all shortcut keys to the default settings.

1. Tools menu > Customize > Keyboard and Mouse tab.

2. Click Reset All.

3. On the confirmation dialog box, click Yes.

Assigning Shortcut Keys to Macros
You can create a shortcut key that executes a macro.

Tip: In order to assign a macro to a shortcut key, the macro command file (.mcr) must already 
exist. You can create a macro by recording it in a PADS tool or scripting it in Macro language. 
For more information, see Creating Macros.

To assign a shortcut key to a macro:

1. Tools menu > Customize > Macro Files tab.

2. In the Macro Command Files area, click the New button.

3. In the Open macro file dialog box, select the macro file you want. Then click Open. The 
PADS tool loads the macro and makes it available for use as a command (the check box 
to the left of the macro name is selected).

Tip: To close the macro file or make it unavailable in the Customize dialog box, clear 
the check box next to the macro name.

4. To assign the macro to a shortcut key, click the Keyboard and Mouse tab.
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5. In the Mode list, select All modes.

6. In the Commands area, double-click Macros to display a list of available macros. Then 
select the macro you want.

7. In the Current Shortcuts area, click the New button. The PADS tool displays the Assign 
shortcut dialog box.

8. Select one of the following types of shortcut:

• To assign shortcut keys, select Press new shortcut key(s), and then press the keys 
that you want to use. For detailed information about rules and restrictions for 
creating shortcut keys, see Rules and Restrictions for Key Sequences.

Tip: As you enter the new shortcut, similar shortcuts appear in the Similar shortcuts 
assigned to other commands box. This helps you to avoid creating a new shortcut 
that conflicts with an existing shortcut.

• To create a mouse action, select or select a pointer event, and then select a 
combination of list box options, mouse button events, and modifier keys.

9. Click OK to close the Assign shortcut dialog box.

Result: The new shortcut appears in the Current shortcuts box on the Customize dialog 
box.

Creating Commands from Macro Command Files
You can create commands from macro files and add them to toolbars and menus.

Tip: To create a command from a macro command file, the macro command file (.mcr) must 
already exist. You can create a macro by recording it in a PADS tool or scripting it in Macro 
language. For more information, see Creating Macros.

To make a macro file available:

1. Tools menu > Customize > Macro Files tab.

2. Click the New button.

3. In the Open macro file dialog box, select the macro file you want to use as a command. 
Then click Open. the PADS tool loads the macro and makes it available for use as a 
command (the check box to the left of the macro name is selected).

Tip: To close the macro file, or make it unavailable in the Customize dialog box, clear 
the check box next to the macro name.

4. You can use the macro as you would any other command, for example, to create a 
Commands list for the Macros category.)
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Related Topics

Adding Items to Toolbars and Menus

Adding a Macro to a Menu

Adding a Macro to a Menu
To add a macro to a menu, you create the macro and add the macro command as an item on a 
menu or a button on a toolbar.

Tip: To add macro to a menu, the macro command file (.mcr) must already exist. You can 
create a macro by recording it in a PADS tool or scripting it in Macro language. For more 
information, see Creating Macros.

To add a macro to a menu:

1. Tools menu > Customize > Macro Files tab.

2. In the Macro Command Files area, click the New button.

3. In the Open macro file dialog box, select the macro file you want to use as a command. 
Then click Open. The PADS tool loads the macro and makes it available for use as a 
command (the check box to the left of the macro name is selected).

Tip: To close the macro file or make it unavailable in the Customize dialog box, clear 
the check box next to the macro name.

4. To add the macro to the menu, click the Commands tab. 

5. From the Categories list, select Macros.

6. In the Commands list, select the macro and drag it to the menu.

7. When you finish adding macros, click Close.

Tip: You can use the same steps to add macros to shortcut menus and toolbars.

Customizing the Appearance of the Screen
You can customize the PADS interface by changing the appearance of menus and toolbars. Use 
the Options tab of the Customize dialog box (Tools menu > Customize > Options tab)

To customize display of toolbars:

• To display ToolTips for toolbar buttons, select the Show ToolTips on toolbars check 
box.

• To display shortcut key information in ToolTips, select the Show shortcuts in ToolTips 
check box.
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• To display large icons, select the Large Icons check box.

Tip: To show or hide a toolbar in the PADS interface, use the Toolbars and Menus tab. See 
Showing or Hiding a Toolbar.

To customize display of menus:

• To change the way a menu is displayed, select an animation from the Menu animations 
list. For example, Unfold displays part of the menu and an arrow you can click to display 
the rest.

• To show shadows on menu items, select the Menu shadows check box.

• To display your recent menu selections before other menu items, select the Show recent 
commands first check box.

• If menus display recent commands first, you can display the full list of menu items after 
a delay. Select the Show full menus after delay check box.

• If you have a shortcut made up of a number of keys, you can delay its execution until 
you press the Enter key. Select the Wait until enter before executing long shortcut 
check box.

• To delete the record of commands you’ve used and restore the default set of commands 
to the menus and toolbars, click Reset my usage data. This option does not undo any 
explicit customizations you made.

Resizing the Layers List
To change the width of the Layers list on the Standard toolbar:

1. Tools menu > Customize.

2. On the Standard toolbar of the PADS Interface, select the Layers list box.

3. Resize as needed.

4. Click Close.

Restriction: You cannot use the Alt key to resize the Layers list.

Organizing Windows
You can customize the way windows appear in your workspace in the following ways:

• Showing Windows

• Hiding Windows

• Detaching Windows from the Current View
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• Attaching Windows to the Current View

• Embedding Windows within Other Windows

Showing Windows
When you first start the application, several windows display. You can show, hide, and 
automatically hide any of the windows in the application.

To open windows:

• On the View menu, click the name of the window you want to show.

Your choices may include Output Window, Project Explorer, and Shortcut Dialog.

Hiding Windows
When the application opens, several windows are open in addition to your workspace. You can 
close some of these windows or hide them automatically in order to maximize your design 
space.

Closing Windows
To close a visible window:

1. Move your pointer to the title bar of the window you want to hide.

2. Click the small downward pointing arrow  on the right side of the window's title bar.

3. In the resulting menu, click Hide.

Result: The window closes. 

Hiding Windows Automatically
You can also set a window to hide automatically so that it appears when you hover the pointer 
near it, and automatically minimizes when you move the pointer away from it. 

To hide a window automatically:

1. Move your pointer to the right side of the title bar in the window you want to hide.

2. Click the thumbtack  in the window's title bar.

Result: The thumbtack picture changes to point sideways . A new bar appears on the 
side of the interface. The side on which the bar appears depends on the location of the 
window. For example, if the Project Explorer is located on the left side of the user 
interface, when you click the Auto Hide setting from the menu, the new bar appears on 
the left side of the interface.
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The new bar contains a tab that has the same name as the window.

3. Hover over the tab in the new bar. 

Result: The window reappears, covering the application.

4. Move the pointer away from the window.

Result: The window minimizes to a tab.

Tip: To turn off the Auto Hide feature, hover over the tab in the new bar so the window 
reappears. Then repeat steps 1-2 in reverse.

Detaching Windows from the Current View
You can detach a window from the current view. This is called floating. A floating window is 
not attached to the current view; instead, it hovers, blocking the view to anything below it.

Restriction: You cannot float a window that is currently set to hide automatically. Turn off the 
Auto Hide feature before floating a window.

To float a window:

• Double-click the window's title bar.

Result: The window detaches and you can move it to any part of the screen.

Tip: To undo the floating, see Attaching Windows to the Current View.

Attaching Windows to the Current View
You can attach a window to the current view. This is called docking. A docked window is 
attached to the current view, and therefore does not block the view to anything below it. You 
can dock a window in its last docked location, or dock a window to a different location.

Docking to the Last Location
To dock a window to its last docked location:

• Double-click the window's title bar.

Result: The window reattaches to the interface.

Docking to a New Location
To dock a window to a new location:

1. Using the title bar, drag the window.
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Result: When you start dragging the window, additional graphics appear in the user 
interface. At the edges of the user interface, arrows containing graphics appear, as 
shown in Figure 3-1: 

Figure 3-1. Window Dragging Graphic

Tip: A similar group of arrows appears in a group near the center of the screen. Ignore 
that group of arrows for this procedure.

2. While dragging the window, hover over one of the arrows on the edge of the user 
interface. For example, hover over the arrow on the left side of the user interface.

Result: A transparent colored block appears along the side of the user interface to which 
you are pointing. This block indicates where the window will be docked when you 
release the mouse button. For example, if you hover over the arrow on the left side of the 
user interface, a block appears along the left side of the screen, as shown in Figure 3-2. 
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Figure 3-2. Docking a Window

3. Release the mouse button while hovering over the arrow that indicates where you want 
to dock the window.

Result: The window docks to the user interface, and the other windows in the user 
interface resize.

Embedding Windows within Other Windows
In addition to attaching a window to a side of the user interface, you can embed a window 
within another window, so that it shares the window space with the original window, or 
becomes a tab within the original window.
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Two Windows Sharing One Window Space

To embed a window within another window's space:

1. Using the title bar, drag a window into another window.

Result: When you start dragging a window, additional graphics appear in the user 
interface. A group of arrows containing graphics appears in the center of the window 
you are dragging, as shown in Figure 3-3. Depending on the window you are dragging, 
the group of arrows may also have a tab graphic in the center.

Figure 3-3. Dragging a Window—Arrow Group

Tip: A similar group of arrows appears at the sides of the user interface. Ignore those 
arrows for this procedure.

2. While dragging the window, hover over one of the arrows. For example, hover over the 
left arrow.

Result: A transparent colored block appears along the side of the window you are 
dragging, as shown in Figure 3-4. This block indicates where the window will be docked 
when you release the mouse button. For example, if you hover over the left arrow, a 
block appears along the left side of the Project Explorer.

Figure 3-4. Dragging and Docking a Window
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3. Release the mouse button while hovering over the arrow that indicates where you want 
to dock the window. 

Result: The window is embedded within another window, both sharing the space the 
original window occupied.

Tip: To maximize your workspace, try setting these embedded windows to hide automatically. 
Ctrl+click the thumbtack in one of the window's title bars, and all of the windows within the 
original window frame hide automatically.

Creating Tabs within Windows

1. Using the title bar, drag a window into another window.

Result: When you start dragging a window, additional graphics appear in the user 
interface. A group of arrows containing graphics appears in the center of the window 
you are dragging, as shown in Figure 3-5. Depending on the window you are dragging, 
the group of arrows may also have a tab graphic in the center.

Figure 3-5. Dragging and Docking a Window—Arrow Commands

Tip: A similar group of arrows appears at the sides of the user interface. Ignore those 
arrows for this procedure.

2. While dragging the window, hover over the tab graphic.

Result: A transparent colored block appears over the window you are dragging, as 
shown in Figure 3-6. This block indicates where the window will be docked when you 
release the mouse button. For example, if you hover over the tab in the Project Explorer 
window, a block appears over the Project Explorer. 



PADS Layout User’s Guide and Reference Manual, PADS 9.4138

User Interface
Organizing Windows

Figure 3-6. Dragging a Window—Transparent Block

3. Release the mouse button while hovering over the tab.

Result: The window is embedded as a tab within a window, as shown in Figure 3-7. 
You can click each tab to access each window.

Figure 3-7. Window Embedded as a Tab

Tip: To maximize your workspace, try setting these embedded windows to hide automatically. 
Ctrl+click the thumbtack in one of the window's title bars, and all of the windows within the 
original window frame hide automatically.
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Managing Window Tabs
Some of the windows in the user interface contain tabs. However, you may decide you do not 
like the organization or grouping of the tabs. You can create additional tabs by embedding 
windows within other windows.

See also: Embedding Windows within Other Windows

This topic discusses the following:

• Rearranging Tabs in a Window

• Moving Tabs Between Windows

• Converting Tabs to Windows

Rearranging Tabs in a Window

Restriction: You can only rearrange tabs that you created by embedding a window within one 
of the docking windows. You cannot rearrange regular tabs, such as those in the Output 
window.

To change the order of the tabs in a window:

• Drag the tab to a new position within the row of tabs.

Moving Tabs Between Windows

Restriction: You can only move tabs that you have embedded in other windows. In windows 
that have tabs by default such as the Output Window, you cannot move the tabs. You can only 
rearrange them. For information on rearranging tabs, see the previous section.

See also: Embedding Windows within Other Windows

To move tabs:

1. Drag the tab to a new window.

Result: When you start dragging, the tab automatically behaves like a window.

2. Place the tab as you would a window.

See also: Organizing Windows

Converting Tabs to Windows

To create a new window from a tab:

1. Drag the tab.
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Result: When you start dragging, the tab automatically behaves like a window.

2. Release the mouse button. Make sure the pointer is not over any arrow graphics.

Result: You now have a floating window.

3. Place the tab as you would any floating window.

See also: Organizing Windows
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Chapter 4
Managing Libraries and Library Data

In this section you learn how to create and modify libraries, set searchability, manage library 
attributes, import and export libraries, report on contents, and use search parameters.

• Converting Older PADS Libraries to the Current Format

• Creating a Library

• Displaying Items in a Library

• Modifying Library Data

• Setting Library Availability and Search Options

• Managing Library Attributes

• Transferring Library Data

• Importing and Exporting Libraries

• Creating Library Reports

• Wildcards and Expressions

The parts, decals and other items you use to lay out a design in PADS reside in one or more 
PADS libraries. A single PADS library consists of 4 files, each containing items of a specific 
type identified by the file’s extension, as follows:

For information on creating CAE decals, see Creating a New CAE Decal in the PADS Logic 
User’s Guide. For information on creating line graphics, see Adding Drafting Items from a 
Library in this manual.

Table 4-1. PADS Library Files

File Extension File Contents

.pt Part Types

.pd PCB Decals

.ld CAE Decals

.ln Line graphics
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Converting Older PADS Libraries to the Current 
Format

For information on how to convert your older PADS libraries to the current PADS format, see 
Converting Older PADS Libraries in the PADS Library Converter User’s Guide.

Creating a Library
You create a new library to start a new empty library. You can also add an existing library - for 
more information, see Adding Libraries to the Library List.

Procedure

1. File menu > Library.

2. Click Create New Lib.

3. In the New Library dialog box, specify the folder and library file name, and then click 
Save.

4. Click Close.

Result

Your library is added to the bottom of the Library list which is also the last library in the search 
order. To move your library up in the library list and search order, see Setting the Library List 
Order.

Displaying Items in a Library
You can display the items of a library in the Library Manager dialog box.

Procedure

1. File menu > Library.

2. In the Library Manager dialog box, select a library in the Library list or select All 
Libraries.

3. Click one of these buttons to display categories of items in the library:

• Decals—PCB decals (component footprints)

• Parts—Parts

• Lines—Drafting objects
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• Logic—CAE decals (schematic symbols)
Tip: Use PADS Logic to edit CAE decals

4. To filter the list, type wildcards or expressions in the Filter box, and then click Apply.

Tip: An empty filter box yields no results. If you don’t want to restrict the results with a 
filter, but display all items, type * (asterisk) and click Apply.

Result

Library item names are displayed in the PCB Decals, Part Types, Line Items, or CAE Decals 
list. (The list name changes based on the Filter you’ve selected.) The preview window displays 
a graphic of the library object.

Restriction: Since library Parts have no visual representation, the preview window displays the 
first PCB decal associated with the part.

Related Topics

Creating a Report of the Parts in a Library

Creating a Report of Decals, Lines or Logic Symbols in a Library

Modifying Library Data
In this section:

• Adding Items to a Library

• Deleting Items from a Library

• Copying a Library Item

• Editing Items in a Library

• Deleting All Items in a Library

• Transferring Library Data

Adding Items to a Library
You can add new items to a library using the Library Manager dialog box.

Procedure

1. File menu > Library.

2. In the Library Manager dialog box, select a library in the Library list.

Restriction: If you select (All Libraries), the New button is unavailable.
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3. Click one of these buttons to display categories of items in the library:

• Decals—PCB decals (component footprints)

• Parts—Parts

• Lines—Drafting objects

• Logic—CAE decals (schematic symbols). Unavailable. Use PADS Logic to add 
schematic decals to a library.

4. Click the New button.

• Decals—Opens the PCB Decal Editor on a new decal.
See also: Creating a New Decal

• Parts—Opens the Part Information dialog box on an unnamed part.
See also: Creating a New Part Type

• Lines—New and Edit are unavailable. There is no special library lines editor. Use 
drafting tools to create or edit lines and save them to the library.
See also: Creating a Drafting Object, Saving a Drafting Item to a Library

• Logic—New is unavailable. Use PADS Logic to create CAE decals.
See also: Creating a New CAE Decal

Related Topics

Copying a Library Item

Deleting Items from a Library
You can delete one or more selected items from a library.

Procedure

1. File menu > Library.

2. In the Library Manager dialog box, select a library in the Library list.

Restriction: If you select (All Libraries), the Delete button is unavailable.

3. Click the one of these buttons to display categories of items in the library:

• Decals—PCB decals (component footprints)

• Parts—Parts

• Lines—Drafting objects

• Logic—CAE decals (schematic symbols)

4. To filter the list, type wildcards or expressions in the Filter box, and then click Apply.
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Tip: An empty filter box yields no results. If you don’t want to restrict the results with a 
filter, but display all items, type * (asterisk) and click Apply.

5. Select one or more items in the PCB Decals, Part Types, Line Items, or CAE Decals list. 
(The list name changes based on the Filter you’ve selected.)

Tip: Use Ctrl+click to select multiple non-sequential items. Use Shift+click or drag the 
cursor to select a range of items.

6. Click Delete.

Related Topics

Deleting All Items in a Library

Copying a Library Item
You can copy a selected item to another name or another library.

Procedure

1. File menu > Library.

2. In the Library Manager dialog box, select a library in the Library list.

Restriction: If you select (All Libraries), the Copy button is unavailable.

3. Click one of these buttons to display categories of items in the library:

• Decals—PCB decals (component footprints)

• Parts—Parts

• Lines—Drafting objects

• Logic—CAE decals (schematic symbols)

4. To filter the list, type wildcards or expressions in the Filter box, and then click Apply.

Tip: An empty filter box yields no results. If you don’t want to restrict the results with a 
filter, but display all items, type * (asterisk) and click Apply.

5. Click Copy.

6. In the dialog box that opens, select another library to receive the item, and/or type a new 
item name, and then click OK.

• Decals—Opens the Save PCB Decal to Library dialog box

• Parts—Opens the Save Part Type to Library dialog box

• Lines—Opens the Save Drafting Item to Library dialog box
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• Logic—Opens the Save CAE Decal to Library dialog box

Related Topics

Importing and Exporting Libraries

Editing Items in a Library
You can use the Library Manager to edit items in a library.

Procedure

1. File menu > Library.

2. In the Library Manager dialog box, select a library in the Library list.

Restriction: If you select (All Libraries), the Edit button is unavailable.

3. Click the one of these buttons to display categories of items in the library:

• Decals—PCB decals (component footprints)

• Parts—Parts

• Lines—Drafting objects

• Logic—CAE decals (schematic symbols)

4. To filter the list, type wildcards or expressions in the Filter box, and then click Apply.

Tip: An empty filter box yields no results. If you don’t want to restrict the results with a 
filter, but display all items, type * (asterisk) and click Apply.

5. Click Edit.

• Decals—Opens the PCB Decal Editor with the selected decal.
See Editing a Library Decal

• Parts—Opens the Part Information dialog box on a selected part.
See Creating and Modifying Part Types

• Lines—Unavailable. There is no special library lines editor. Use drafting tools to 
create or edit lines and save them to the library.
See Creating a Drafting Object, Saving a Drafting Item to a Library

• Logic—Unavailable. Use PADS Logic to create CAE decals.
See Creating a New CAE Decal
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Deleting All Items in a Library
When you delete all items in a library using the following method, you actually replace the 
existing library with a new empty one of the same name. This ensures that there aren't any 
leftover items in your library.

Restriction: You cannot delete the contents of a read-only library.

Procedure

1. File menu > Library.

2. Click Create New Lib. The New Library dialog box appears.

3. Select the library file whose contents you want to delete, click Save, and then click Yes 
when prompted.

4. Click Close.

Related Topics

Deleting Items from a Library

Transferring Library Data
You can transfer library objects from one library to another.

Tip: To copy over single items, see Copying a Library Item.

Procedure - Multiple Items

1. Follow the steps to export library data from the library.

2. Then follow the steps to import the library data to another library.

Setting Library Availability and Search Options
Use the Library List dialog box to specify the libraries available to the design, library search 
order, and other search-related options. Operations in this dialog box affect the contents of the 
Library list in the Library Manager dialog box.

In this section:

• Adding Libraries to the Library List

• Removing Libraries from the Library List

• Setting the Library List Order

• Sharing a Library Across a Network
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• Controlling Library Search Access

• Protecting Library Files

• Sychronizing with PADS Logic

Adding Libraries to the Library List
You add libraries to the library list in order to make their contents available. The library must be 
listed in the Library Manager in order to search it and use its parts, decals, or line items in your 
design.

Procedure

1. File menu > Library > Manage Lib. List button.

2. In the Library List dialog box, click Add.

3. In the Add Library dialog box, specify the folder and file name of the library to add, and 
then click Open.

Result

The library is added beneath the currently selected library in the Library list.

Removing Libraries from the Library List
You remove libraries from the library list in order to prevent their contents from being used in 
the design.

Procedure

1. File menu > Library > Manage Lib. List button.

2. In the Library List dialog box, in the Library list, select one or more libraries, and then 
click Remove.

Tip: The library files are not deleted from the computer.

Setting the Library List Order
You can specify the order in which libraries are searched.

Procedure

1. File menu > Library > Manage Lib. List button.

2. In the Library List dialog box, in the Library list, select the library, and then click Up or 
Down as needed.
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Result

With each click, the library moves up or down one place in the library list. The libraries are 
searched top to bottom.

Related Topics

Library Search Order in the Concepts Guide

Sharing a Library Across a Network
You can share a library across a networked environment, to allow more than one user to 
simultaneously access the library.

Procedure

1. File menu > Library > Manage Lib. List button.

2. In the Library List dialog box, in the Library list, select the library.
Tip: You can select multiple libraries using the Shift and Ctrl keys.

3. Select the Shared check box.

Result

More than one user can access the library file at the same time.

Controlling Library Search Access
You can enable or disable the searching of a particular library when performing operations that 
involve libraries, such as adding parts.

Procedure

1. File menu > Library > Manage Lib. List button.

2. In the Library List dialog box, in the Library list, select the library.
Tip: You can select multiple libraries using the Shift and Ctrl keys.

3. Select the Allow Search check box.

Protecting Library Files
The Read Only check box is only a status indicator. It is always shaded and unavailable. You 
can set library read-only status only in the Microsoft Windows File Manager. The system 
administrator who owns the files is the only one who can control this process; this ensures file 
protection.
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Procedure

1. In Windows Explorer, locate your library files. 

Tip: By default, libraries installed with the software are located at 
C:\MentorGraphics\<version>\SDD_HOME\Libraries

2. Select all four library files, right-click and click Properties.

3. In the Properties dialog box, on the General tab, select the Read-only check box.

4. Click OK.

Result

The library Read-Only check box in the Library List dialog box will not update until you reopen 
the dialog box.

Related Topics

Creating a Library

Sychronizing with PADS Logic
You can enable or disable the synchronizing of library settings between PADS Logic and PADS 
Layout. When the Synchronize with PADS Logic check box is checked in PADS Layout, all 
changes made in the libraries within PADS Layout are pushed to PADS Logic. 
Tip: To ensure a round-trip synchronization, select the same check box in PADS Logic.

Procedure

1. File menu > Library > Manage Lib. List button.

2. In the Library List dialog box, select the Synchronize with PADS Logic check box.

Managing Library Attributes
Use the Manage Library Attributes dialog box to manage attributes on a library-by-library basis. 
You can add, delete, and rename attributes for all parts or decals in an individual library or in all 
libraries. You can also display all the attributes in a library, whether the attributes apply to all 
items or to individual items.

In this section:

• Adding an Attribute to Multiple Library Items

• Deleting Attributes from Library Items

• Renaming Attributes of Library Items
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Tip: The Manage Library Attributes dialog box does not manage attributes in the design. Use 
the Attribute Dictionary to manage attributes in the design. For more information, see Using the 
Attribute Dictionary

Adding an Attribute to Multiple Library Items
You can add an attribute to all parts and decals, or just to parts or decals individually, in one or 
all libraries.

Restriction

This process will yield no result or warning if the library you are working with is read-only. 
Check the status of the library in the Library List dialog box.

Procedure

1. File menu > Library > Library Manager dialog box > Attr Manager button.

2. In the Manage Library Attributes dialog box, in the Select Library list, select an 
individual library or (All Libraries).

3. In the Item Types list, choose whether to apply the new attribute to All Items, or only 
either Part Types or PCB Decals.

4. Click Add Attr. The Add New Attribute to Library dialog box appears.

5. For the Attribute Name, either:

• Type an attribute name into the box.

or

• Click Browse Lib. Attr to search all libraries for an existing attribute name.

6. Optional: Type a value in the Attribute Value box.

7. Click OK. The Attribute Name appears in the Attributes in Library list.

8. Click Close.

Result

Your new attribute is added. Check for the new attribute in the Decal Attributes dialog box (for 
PCB decals) or on the Attributes tab of the Part Information dialog box (for Part Types).

Related Topics

Setting Library Availability and Search Options
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Deleting Attributes from Library Items
You can delete one or more attributes from all parts and decals, or just from parts or decals 
individually, in one or all libraries.

Restriction

This process will yield no result or warning if the library you are working with is read-only. 
Check the status of the library in the Library List dialog box.

Procedure

1. File menu > Library > Library Manager dialog box > Attr Manager button.

2. In the Manage Library Attributes dialog box, in the Select Library list, select an 
individual library or (All Libraries).

3. In the Item Types list, choose whether to delete the attribute(s) from All Items, or from 
either Part Types or PCB Decals.

4. In the Attributes in Library list, select one or more attributes to delete, and then click 
Delete Attrs.

5. In the prompt that appears, click OK.

6. Click Close.

Result

Your attribute(s) is deleted. Check for the deleted attribute in the Decal Attributes dialog box 
(for PCB decals) or on the Attributes tab of the Part Information dialog box (for Part Types).

Renaming Attributes of Library Items
You can rename an attributes of all parts and decals, or just of parts or decals individually, in 
one or all libraries.

Restriction

This process will yield no result or warning if the library you are working with is read-only. 
Check the status of the library in the Library List dialog box.

Procedure

1. File menu > Library > Library Manager dialog box > Attr Manager button.

2. In the Manage Library Attributes dialog box, in the Select Library list, select an 
individual library or (All Libraries).
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3. In the Item Types list, choose whether to rename the attribute(s) from All Items, or from 
either Part Types or PCB Decals.

4. In the Attributes in Library list, select one or more attributes to rename, and then click 
Add.

5. Double-click in the New Name cell, type the name, and then click Rename Attrs.

Tips: 

• To display all existing attributes in the library, click Browse Lib. Attr.

• You can specify the name of an existing attribute. No error message appears when 
you do this. The only time this may have an adverse effect is if both attributes are 
assigned to a single item, in which case the error is reported in the error file and the 
rename is not performed for those items where there are conflicts.

6. Click Close.

Result

Your attribute is renamed. Check for the renamed attribute in the Decal Attributes dialog box 
(for PCB decals) or on the Attributes tab of the Part Information dialog box (for Part Types).

Importing and Exporting Libraries
Use the Library Manager dialog box to import or export library data in ASCII format.

In this section:

• Importing Library Data

• Exporting Library Data

Importing Library Data
You can import library data from a previously-exported library ASCII file.

Tip: Beginning with PADS 9.0, die parts and flip chips are no longer identified by their family 
designations (DIE or FLP), but instead by the Special Purpose settings in the General tab of the 
Part Information dialog box. When you import an ASCII file created by a previous PADS 
version, these Special Purpose settings are automatically set for parts having the logic family 
DIE or FLP. The part’s family designation remains the same.

Procedure

1. File menu > Library.



PADS Layout User’s Guide and Reference Manual, PADS 9.4154

Managing Libraries and Library Data
Importing and Exporting Libraries

2. In the Library Manager dialog box, in the Library list, select the library to receive the 
library data.

3. To import one of the four file types, you must select the matching filter:

• If the file type is .c, select the Logic filter. This ASCII file contains CAE decals 
(logic symbols).

• If the file type is .l, select the Lines filter. This ASCII file contains drafting objects.

• If the file type is .d, select the Decals filter. This ASCII file contains PCB decals 
(component footprints).

• If the file type is .p, select the Parts filter. This ASCII file contains part types.

4. Click Import.

Tip: Import fails if the library to receive imported items is read-only.

5. In the Library Import File dialog box, specify the folder and the file name, and then click 
Open.

Related Topics

Transferring Library Data

Exporting Library Data
You can export library data into an ASCII file for importing into a library.

•
• Processing Decals (Cells) with Library Services

•

Procedure

1. File menu > Library.

2. In the Library Manager dialog box, in the Library list, select the library whose data you 
want to export.

3. Click any of the following:

• Decals—to export PCB decals (component footprints)

• Parts—to export Components

• Lines—to export drafting objects
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• Logic—to export CAE decals (schematic symbols)

4. To filter the list, type wildcards or expressions in the Filter box, and then click Apply.

Tip: To display all items in the library, type asterisk * and click Apply.

5. Select one or more items in the list, and then click Export.

6. In the Library Export File dialog box, specify the folder, type the file name, and then 
click Save.

Results

• The Special Purpose settings of any die parts and flip chips are cleared.

• Die parts and flip chips having a family designation other than DIE and FLP lose their 
die part or flip chip special purpose and become normal parts.

• Any normal parts that have the DIE or FLP family designation are treated as die parts or 
flip chips in the previous PADS version.

Related Topics

Creating a Library

Creating Library Reports
You can create reports from the Library Manager to list any number of library objects. The Parts 
report can be configured to also list the values of attributes that you choose to include in the 
report.

In this section:

• Creating a Report of the Parts in a Library

• Creating a Report of Decals, Lines or Logic Symbols in a Library

Creating a Report of the Parts in a Library
From the Library Manager, you can generate a report about the parts in a single library or all 
libraries. The report (an ASCII file) lists each part and its associated attributes. You can specify 
the attributes you want reported. To see examples of parts reports, see Figure 4-1and Figure 4-2.

Procedure

1. Select File menu > Library.

2. In the Library manager dialog box, select a library from the Library list. Or select All 
Libraries.



PADS Layout User’s Guide and Reference Manual, PADS 9.4156

Managing Libraries and Library Data
Creating Library Reports

3. In the Filter area, click Parts. A list of parts in the library (or in all libraries) appears in 
the Part Types area.

Tip: To refine the list, use the filter field. Type a part name in the field or use wildcards 
(*) to specify a group of parts. Then click Apply.

4. When you have the list of parts you want to report on, click List to File.

5. In the Report Manager dialog box, specify the part attributes you want to include in the 
report. In the Available attributes list, click an attribute to select it. The click Include>>. 
The attributes appear in the Selected attributes list.

To remove attributes from the Selected attributes list, select them and click Exclude>>.

6. Optionally, you can refine the list of parts to report on. In the Part Filter field, type a part 
name in the field or use wildcards (*) to specify a group of parts. Then click Apply.

7. Click Run.

8. In the Library List File dialog box, select a folder and file format for the report. You can 
select either of two formats:

• Library List format (lst): Information is formatted in columns for viewing or 
printing. (See Figure 4-1.)

• Comma-separated values format (csv): format recognized by MS Excel. (See 
Figure 4-2.)

9. Click Save.

10. In the Report Manager dialog box, click Close.

Result

The Report Manager generates the report and displays a link to it in the Output window. To 
view or print the report, click the link. Notepad opens and displays the report.

Figure 4-1. Parts Report in .lst Format
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Figure 4-2. Parts Report in .csv Format

Related Topics

Report Manager Dialog Box

Creating a Report of Decals, Lines or Logic Symbols in a Library

Managing Libraries and Library Data

Creating a Report of Decals, Lines or Logic Symbols in a 
Library

From the Library Manager, you can generate a report listing the decals, lines, or logic symbols 
in a single library. The report is an ASCII file listing each item’s name and the date and time the 
item was modified. For more information, see Creating a Report of the Parts in a Library.

Procedure

1. Select File menu > Library.

2. In the Library manager dialog box, select a library from the Library list. 

Restriction: The List to File button is unavailable for Decals, Lines, and Logic Symbols 
if you select All Libraries.

3. In the Filter area, click the filter you want. A list of parts in the library appears in the 
Part Types area.

Tip: To select one or more specific item, use the filter field. Type an item name in the 
field or use wildcards (*) to specify a group of items. Then click Apply.

4. When you have the list you want to report on, click List to File.

5. In the Library List File dialog box, specify a folder and file name for the report and click 
Save.

Result

Notepad appears, displaying a list of the item names and the date and time when each was last 
modified. You can print the list from Notepad.
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Related Topics

Creating a Report of the Parts in a Library

Managing Libraries and Library Data

Wildcards and Expressions
You can use wildcards and expressions to filter the information that is displayed. The filter 
supports the wildcards and expressions listed in Table 4-2. Table 4-3 gives examples of 
wildcard usage. 

Table 4-2. Wildcards and Expressions 

Expression: Use to:

* Match any number of characters.

? Match any one character.

[set] Match any character in the specified set.
Tip: A set is composed of characters or a range of characters; for 
example, A-Z or 0-9 or a-z.

[!set] or [^set] Match any character not in the specified set.

\ Match a special syntactic character exactly, suppressing the special 
character's syntactic significance.
Tip: The following characters need the \ before them: `[]*?!^-\' 

Table 4-3. Usage Examples of Wildcards and Expressions 

Expression: Results in all items that:

74* start with 74: 7404, 74LS04, 74622.

74?? start with 74 followed by any two characters: 7404, 74T2, 74TP.

74??08 start with 74, followed by any two characters, and end with 08: 
74LS08, 74HC08, 744608.

*08 start with any number of characters and end with 08: 2146108, 5408, 
54HCT08, 744608.

*08* start with any number of characters, followed by 08, and end with 
any number of characters: 5408, 5408BE, 54HCT08AE, 
74ABT08CE2, 941M70839.

[57]* start with 5 or 7 with any number of characters after: 54HCT244, 
5968BAE4, 74ACT44.

[5-7]* start with 5 or 6 or 7 followed by any number of characters: 54LS08, 
6225BE, 69TF77, 74ALS02.
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[57]4HCT?? start with 5 or 7, followed by 4HCT, and end with any two 
characters: 54HCT04, 54HCT74, 74HCT27, 74HCT84.

74A[CH]* start with 74A, followed by C or H, and end with any number of 
characters: 74AC244, 74AHCT27.

74A[!C-H]* start with 74A, followed by any character except the letters C 
through H, and end with any number of characters: 74ABT44, 
74ALS244, 74ABF365.

[\\]*08 start with the character \, followed by any number of characters, and 
end with 08: \LS08, \HCT08, \ABT08.

Table 4-3. Usage Examples of Wildcards and Expressions (cont.)

Expression: Results in all items that:
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Chapter 5
Creating and Editing PCB Decals

A PCB decal is a software representation of the outline, terminals and attributes of an electrical 
component, and is used in placement and routing of the component during the design layout 
process.

You use the PCB Decal Editor to create new decals or to modify existing ones.

In this section:

• Setting Up the PCB Decal Editor

• Setting Colors of Objects in the Decal Editor

• Creating a New Decal

• Editing a Decal

• Decal Editing Tasks

• Working with Solder and Paste Masks

• Updating a Design from the Library

Setting Up the PCB Decal Editor
You can modify the Decal Editor’s layers, colors, rules, editor options and Decal Wizard 
options.

Procedure

1. Change the layer stackup in the Layers Setup dialog box. 
( Setup menu > Layer Definition )

Tip: If you need to add objects to specific layers, etc., do so.

2. Change the colors of objects or layers in the Display Colors Setup dialog box. 
( Setup menu > Display Colors )

Tip: As you work on a decal, you may find it useful to apply different colors to objects 
or layers to visually differentiate them.

Restriction: You can modify the colors of objects and layers in the decal editor, but 
when the decal is used by a component in the design, it uses the colors set for the design.
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3. Change the options in the Options dialog box. 
( Tools menu > Options )

4. Change the decal rules in the Decal Rules dialog box. 
( Setup menu > Decal Rules )

Restriction: Rules set at this level of the rules hierarchy are used only by PADS Router.

Creating a New Default Decal Editing Environment
There is a default (start-up) decal editing environment that opens when you start the Decal 
Editor from the Tools menu. This decal editing environment has its own layers, colors, rules, 
and editor options settings. These settings are very generic in the out-of-box default 
environment.

You can modify and save the default environment’s settings to create a new default that is more 
appropriate for the decals you typically make. This will make it easier and quicker for you to 
create new decals.

Procedure

1. Tools menu > PCB Decal Editor. The default decal opens in the Editor.

2. Set options and settings appropriately for the decals you typically make. See Setting Up 
the PCB Decal Editor.

3. File menu > Save as Start-up File.

4. In the Start-up File Output dialog box, select the appropriate check boxes in the Sections 
area, and click OK.

Result

When you immediately click File > New, you will see the new default settings.

Setting Colors of Objects in the Decal Editor
As you work on a decal, you can customize display colors to make it easier to see objects as you 
place them. Using the Display Colors Setup dialog box, you can:

• Set and change the color of objects on a per layer or per object type basis.

• Make objects visible or invisible in the display (also on a per layer or per object type 
basis).

• Customize the palette of color selections.

• Save your customizations in a configuration file. 
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Procedure

1. Decal Editor Setup menu > Display Colors.

2. In the Display Colors Setup Dialog Box, set the color(s) you want:

a. To set the color for one object, in the Selected Color area, click a color tile. Then in 
the Layers/Object Types table, click the tile for the object type in the correct layer 
row.
Tip: To change the palette of colors from which you can select, click Palette. 
See also: To Change the Color Palette

b. To make all objects on a layer the same color, click the layer number to select the 
entire row, and then click the color tile in the Selected Color area.

c. To make an object the same color on all layers, click the object name to select the 
entire column, and then click the color tile in the Selected Color area.

d. To make an object type invisible, set its tile to the background color. You can 
make multiple objects invisible (for example, all objects on the same layer). 
See also: Making Objects Invisible in the Display.

Tip: To make an object type the same color on all layers, click the Assign All 
button and use the Assign Color to All Layers dialog box.

3. Click Apply.

Tips:

• You can save display color settings you commonly use as you work on a design. See To 
Save Color Assignments to a File.

• Color configurations saved in PowerPCB versions 2.1 and lower cannot be used in 
PowerPCB versions 3.0 and higher.

Related Topics

Creating a New Default Decal Editing Environment

Creating a New Decal
You can create a decal automatically, using the Decal Wizard, or manually, using the buttons on 
the Drafting toolbar of the PCB Decal Editor. See Creating a Basic Decal Automatically and 
Creating a Decal Manually for information on how to perform these tasks. 

Creating a Basic Decal Automatically
Use the Decal Wizard to automatically create common decal types based on settings you 
provide in the Decal Wizard dialog box. To display the Decal Wizard dialog box, click
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Tools menu > PCB Decal Editor > Drafting Toolbar button > Wizard button

There are two main methods to using the decal wizard. In order to create a decal, you need to 
begin with the package dimensions and enlarge the decal to the appropriate material condition.

Method 1

You manually calculate the decal dimensions required for the package and enter the dimensions 
into the decal wizard to create the new decal.

Method 2

You enter the package dimensions into the Decal Calculator area of the dialog box (where it’s 
available) and let the Decal Calculator generate the decal according to preset standards of 
material conditions.

After you create the basic decal, you can edit it to add other items, such as labels, attributes, 
keepouts, solder mask relief, height values, and hard breakouts/fanouts. See Decal Editing 
Tasks.

Creating a Decal Manually
If you can’t create a decal using the decal wizard, you can create it manually using the Decal 
Editor Drafting Toolbar buttons. The general procedure for creating a decal manually is as 
follows:

1. Tools menu > PCB Decal Editor (Opens the default (start-up) decal.)

Alternative: You don’t have to start with the default decal when creating a new 
decal. If the new decal you want to create will be similar to an existing decal, you can 
edit that decal and save it under a new name to create the new decal.

2. Set the decal origin.

3. Add and place the terminals.

4. Create any copper shapes, such as copper associated with terminal pads.

5. Define the terminal pad stacks.

6. Create the Assembly, Silkscreen and Placement part outlines.

7. Add other items, such as labels, attributes, keepouts, solder mask relief, height values, 
and hard breakouts/fanouts. See Decal Editing Tasks.

Tips: 

• You cannot edit the default “Name” and “Type” labels that appear when you create a 
new decal; these “placeholder” labels are automatically populated with the correct 
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reference designator and part type name, respectively, when a part using the decal is 
added to a design.

• You can add other “placeholder” labels to a decal. See Creating Placeholder 
Attribute Labels.

8. Using File menu > Save As, name the new decal and save it to a library.

Editing a Decal
You can edit a library decal, or the decal of a component in a design.

Editing a Library Decal
To edit a library decal:

1. Tools menu > PCB Decal Editor

2. Click the Open button. The Get PCB Decal from Library dialog box opens.

3. From the Library list in the Filter area, select the library that contains the decal.

4. If you want to filter the PCB Decals list, type a wildcard or expression in the Items box 
and click Apply.

Requirement: The Items box must contain at least the asterisk (*) to get any search 
results. An asterisk displays all parts in the list.

5. Select the decal from the PCB Decals list. The preview area displays a graphic of the 
decal. 

6. Click OK.

Tip: If the decal is assigned to any part types in the PADS libraries, the Part Type List 
for Decal <name> dialog box opens. 

7. Edit the decal. (See Decal Editing Tasks for information on how to edit a PCB decal.)

8. Click File menu > Save to save the decal.

Checking for Errors Between Part Types and Assigned PCB 
Decals

For the decal you have opened, in the Part Type List for Decal dialog box, you can check to 
ensure that the pins match the pins listed in the Part Type > Pins tab table, or when pin mapping 
exists - on the Part Type > Pin Mapping tab.

• Alternatively, in the PCB Decal Editor, on the Tools menu, click Part Types to open the 
Part Type List for Decal dialog box.
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Sorting the Table

You can sort the table by a given column by clicking the column header.

Fixing Logical Errors

1. Select a line item with a logical error.

2. Click the Show Errors button to create and open a report with details of the errors.

3. Click the Edit Part button to open the Part Type.

4. In the part type, fix the errors and then click OK.

5. The Part Type List for Decal dialog box will update the Error Status.

Fixing Mismatched Pins Errors

1. Select a line item with a mismatched pin error.

2. Click the Show Errors button to create and open a report with details of the errors.

3. In the PCB Decal Editor, correct the error.

4. In the Part Type List for Decal dialog box, click Refresh, to update the dialog box.

Tip: You can click the Check Decal button to check the decal against all associated part types to 
show all mismatched pin number errors.

Related Topics

Part Information Dialog Box, Pins Tab

Part Information Dialog Box, Pin Mapping Tab

Editing the Decal of a Component in the Design
You can edit the decal used by one or more components selected in a design, and apply the 
changes to those components alone, or to all the components in the design using that decal.

You can also save the changes to the existing decal in the library, or create a new decal.

To edit a design component decal from the design editor:

1. Select the component(s). The selected components must all use the same decal.

2. Right-click and select Edit Decal to open the PCB Decal Editor.

3. Edit the decal. (See Decal Editing Tasks for information on how to edit a PCB decal.)

4. If you want to save changes to the library:

i. File menu > Save Decal As
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ii. In the Save PCB Decal to Library dialog box, set the Library and Name of PCB 
Decal fields to save the changes to a new decal. If you want to save the changes 
to the existing decal, leave the fields as they are.

iii. Click OK.

5. File menu > Exit Decal Editor

6. In the Apply Decal Changes dialog box, Click Selected to apply the changes to the 
selected components only, or All to apply the changes to all components using that decal 
in the design.

Tip: If:

• You have a design open in default layer mode, and

• You open the Decal Editor to edit the decal of a component in the design, and 

• You attempt to change the decal to increased layer mode,

the message “You will not be able to apply decal changes to the design. Continue?” appears.

Either click Cancel to return to the Layers Setup Dialog box without changing the decal to 
increased layer mode, or press OK to proceed to the Increase Maximum Layer Number dialog 
box, where you can save the decal changes to the library; then exit the PCB Decal Editor 
without applying changes. Then switch the current design to increased layer mode and update 
the decal.

Decal Editing Tasks

Editing the Properties of a Decal Item
You can edit the properties of decal items, including terminals, labels, text and 2D items.

Procedure

1. In the Decal Editor, select an item, right-click, and click Properties.

Tip: You can also Double-click on the item, or select the item and click the Properties 
button on the toolbar. 

2. In the displayed dialog box, edit the decal name properties.

3. Click OK.

Setting the Decal Origin
The location of a decal’s origin affects how decals attach to the cursor when you move a 
component in the Move by Origin mode. It also affects how pick and place machines populate 



PADS Layout User’s Guide and Reference Manual, PADS 9.4168

Creating and Editing PCB Decals
Decal Editing Tasks

the board with components. Typically, through-hole devices have their origin at Pin 1, and 
surface-mount devices at the geometric center of the component; other devices may have other 
origin requirements.

When you’re creating a new decal, you can define the origin whenever it’s most convenient. For 
example, if you’re creating a through-hole device decal:

• You could create Pin 1 on the default origin, and build the rest of the decal around that.

• You could build the entire decal anywhere, and then move the origin to Pin 1.

From the Decal Editor, to set the origin of a decal:

1. Setup menu > Set Origin

2. Click where you want the new origin to be.

You can also set the origin of a decal after it has been created.

1. Select the decal.

2. Type the modeless command SO <x> <y>.
Tip: Type SO for relative coordinates, SOA for absolute coordinates.

Working with Terminals
In this section:

• Adding Terminals

• Assigning JEDEC Pinning

• Modifying Terminal Properties

• Modifying Terminal Number Properties

• Moving a Terminal

• Moving a Terminal Number

Adding Terminals
Terminals are the pads or pins associated with a decal. 

Procedure

1. PCB Decal Editor > Drafting button > Terminal button.

2. In the Add Terminals dialog box, in the Start pin number area, type values in the Prefix 
and/or Suffix boxes for the pin numbering. A preview of pin numbers based on your 
input is displayed below the boxes.
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Tips: 

• Alphabetic and numeric values can be used in either box. For example, A1 or 1A.

• For a single numeric, use either Prefix or Suffix box, and void the other box.

3. In the Increment options area, choose what to increment by clicking either Increment 
prefix or Increment suffix.

4. In the Step value box, type a positive or negative number by which to increase or 
decrease the pin numbers with consecutive or stepped values.

5. If using alphanumerics, you can select the Use JEDEC pin numbering check box to 
ensure that legal alphanumeric values are used.

Tip: This option only ensures that valid alpha and numeric combinations are used. To 
arrange rows and columns according to JEDEC, use the Assign JEDEC Pinning option 
on the Tools Menu.

6. Click to indicate a position for the new terminal. Repeat as necessary.

Tip: You can also add terminals by replicating an existing terminal using Step and Repeat. 

See also: Creating Copper in the Decal, Associating Copper with Terminals

Using Step and Repeat

1. Select an existing object, right click and select Step and Repeat.

2. In the Step and Repeat dialog box, click the tab of the type of array to create: Linear, 
Polar, or Radial, and set the options for the array.

3. If the object selection contains text or a terminal, you can also automatically increment 
the text or pin number. See also: Incrementing Texts and Pin Numbering

4. Click OK to create the array.

Tips: 

• Terminals are replicated with associated coppers.

• Settings in the Step and Repeat tabs are saved when you close the dialog box and when 
you exit the Decal Editor.

Assigning JEDEC Pinning
You can assign pin numbers to rows and columns of terminals according to the JEDEC 
standard.

Procedure

1. PCB Decal Editor > Open button.
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2. To filter the decals, in the Filter area, type a wildcard or expression in the Items box and 
click Apply.

3. Click to indicate the decal to which you want to assign JEDEC pinning and click OK.

4. Click Assign JEDEC Array Pinning from the Tools menu. The JEDEC Array Pinning 
dialog box appears.

5. Click the Decal type: Component or Substrate.

6. Click OK.

7. On the File menu, click Save.

Modifying Terminal Properties

Procedure

1. PCB Decal Editor > select a terminal > right-click > Properties.

2. Modify any of the following information:

• Terminal x,y coordinates.

• Terminal pin number. You can change the pin number of the selected terminal.

3. Click Pad Stacks to open the Pad Stack Properties dialog box. Use this dialog box to 
modify one or more selected pad stacks.

4. You can clear the Associated Copper check box to unassociate copper from the 
terminal.

5. Click Apply to apply your modifications or Cancel to cancel the changes.

If you select another terminal while the dialog box is open, the information is updated for the 
selected terminal.

Tip: You can use any alphanumeric characters except
brackets { }, asterisks *, commas (,), question marks (?), or spaces.

Related Topics

To Align Objects

Customizing Pad Stacks of Decal Pins

Modifying Terminal Number Properties
1. PCB Decal Editor > select a terminal number > right-click > Properties.

2. Modify any of the following information:

• Coordinates—You can also move the terminal number using coordinates.
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• Pin Number—You can change the pin number.

If you select another terminal number while the dialog box is open the information is updated 
for the selected terminal number.

Moving a Terminal

Procedure

1. In the PCB Decal Editor, select the terminal to move. You can select more than one at a 
time.

2. Drag the terminal. The terminal remains attached to the pointer.

3. Click to complete the move.

You can also use the arrow keys to control movement: each press of an arrow key moves 
the selected terminal to the next point on the grid. Using the Terminal Properties dialog 
box, you can type a new X,Y location.

You can also use Radial Move to manually place decal terminals. 

See also: To Use Radial Move

Moving a Terminal Number

Procedure

1. In the PCB Decal Editor, select the terminal number to move. You can select more than 
one at a time.

2. Drag the terminal number and release the mouse button. The terminal number 
dynamically attaches to the pointer.

3. Click to indicate a new location to complete the move.

You can also use the arrow keys: each press of the arrow key moves the selected terminal 
number to the next point on the grid. Using the Terminal Number Properties dialog box, you 
can type a new X,Y location.

Swapping Terminal Numbers

Procedure

1. In the PCB Decal Editor, select the terminals you want to swap.

2. Right-click and click Swap. The terminal numbers switch.
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Renumbering a Terminal
You can renumber terminals in the PCB Decal Editor by clicking each pin in the decal, or using 
the Pin Number dialog box.

In the decal editor, you can renumber a group of terminals in ascending order. 

Renumbering by Clicking Terminals

In the decal editor, you can renumber terminals in ascending order by selecting the starting 
terminal and clicking consecutive terminals. 

Procedure

1. PCB Decal Editor > select a starting terminal > right-click > Renumber Terminals.

Tip: Renumber Terminals is not available if more than one terminal is selected.

2. In the Start pin number area, type values in the Prefix and/or Suffix boxes. A preview of 
pin numbers based on your input is displayed below the boxes.

Tips: 

• Alphabetic and numeric values can be used in either box. For example, A1 or 1A.

• For a single numeric, use either Prefix or Suffix box, and clear the other box.

3. In the Increment options area, choose what to increment by clicking either Increment 
prefix or Increment suffix.

4. In the Step value box, type a positive or negative number by which to increase or 
decrease the pin numbers with consecutive or stepped values.

5. If using alphanumerics, you can select the Use JEDEC pin numbering check box to 
ensure that legal alphanumeric values are used.

Tip: This option only ensures that legal alphanumeric combinations are used. To 
arrange rows and columns according to JEDEC, use the Assign JEDEC Pinning option 
on the Tools Menu.

6. Click OK.

Result: The terminal is highlighted, and the pointer changes to a small cross. The 
pointer dynamically attaches to the renumbered terminal. The message “Renumbering… 
Next New Number: #” also attaches to the pointer.

Tip: If you have duplicate numbers during the renumbering process, the duplicate 
numbers appear with a tilde (~) next to them.

7. Select another terminal to assign the next available number. 
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Tip: If you have renamed all available pins, the message “Renumbering... New 
Numbers Exhausted!” appears. In other words, the message appears if you renumber all 
eight terminals on a decal with eight pins. 

8. You can back up in the numbering process. Right-click and click Back to undo the last 
assigned number.

9. Right-click and click Complete when you finish reassigning terminal numbers.

Renumbering Using the Pin Numbers Dialog Box

You can use the Pin Numbers dialog box to interactively renumber the terminals in the design 
area. Selecting pin numbers in the dialog box selects the matching pins in the design area and 
selecting pins in the design area selects the matching pins in the dialog box.

• On the Setup menu, click Pin Numbers.

You can modify the pin numbers listed in the dialog box, by editing individual cells, by copying 
and pasting, or by using the Renumber Pins dialog box.

Tip: Pin number changes on the decal will not be updated until you click Apply or OK.

Editing Individual Pin Numbers

Procedure

1. Double click a Number cell, or select a number cell and click the Edit button.

2. Type a new pin number.

Copying and Pasting Pin Numbers

You can copy selected table data from the Pin Numbers dialog or from Microsoft Excel and 
paste it into the Numbers list. The selected cell in the table is the paste origin. Data is pasted 
below the paste origin.

Procedure

1. In Excel, select data and use the Excel Copy command in Excel. Or in the Pin Numbers 
dialog, select data and click the Pin Numbers dialog box Copy button.

2. Select the cells into which you want to paste the data. 

Restriction: Data will only paste into selected cells.

3. Click the Paste button to paste the data into the table starting at the paste origin.

Editing Pin Numbers Using the Renumber Pins dialog box

You can efficiently edit the pin numbers of numerous pins using the Renumber Pins dialog box.
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See also: Renumbering by Clicking Terminals

Deleting a Terminal

Procedure

1. In the PCB Decal Editor, select the terminal to delete. You can select more than one at a 
time.

2. Press Delete.

The remaining terminals are automatically renumbered. The alphanumeric labels remain 
unchanged.

Moving a Decal Name

Procedure

1. In the PCB Decal Editor, select the decal name to move.

2. Drag the decal and release the mouse button. The decal name dynamically attaches to 
the pointer.

3. Click to indicate a new location to complete the move.

You can also use the arrow keys to control movement: each press of an arrow key moves the 
decal to the next point on the grid.

Related Topics

To Rotate an Object

Creating Copper in the Decal
You can create copper in the decal and associate it with a pin to create a custom pad shape or 
heat sink. You can also create unassociated copper heat sink or shielding shapes that move with 
the decal in the design.

Requirement

• You must select a layer for placement of the copper. You cannot create a copper shape 
on all layers (layer number zero). If you need the same copper shape on multiple layers, 
copy the shape to the other layers.

Procedure 

1. Click the Drafting Toolbar button.

2. On the Drafting toolbar, select the Copper button.
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3. Select a layer on which to place the copper.

4. Right-click and click a command to change the values of the drafting object. See also: 
Setting Values Before Creating a Drafting Object.

5. Create the shape using one of the following:

• Creating a Circle Drafting Object

• Creating a Polygon or Path Drafting Object

• Creating a Rectangle Drafting Object

6. Once you complete the shape, it becomes a filled shape.

Result

Is the resulting shape what you expected?

• If the shape edges are not correct, see Edge Precision of Drafting Shapes.

• If the shape is on the wrong layer or needs to be modified, see Modifying Drafting 
Object Properties.

• If you want to start over, see Deleting a Drafting Segment or Object.

Related Topics

Associating Copper with Terminals

Creating a Copper Cut Out

Generating Drafting Shapes from Terminals

Creating a Custom Pad Shape
You can create odd shaped (irregular shaped) pads by drawing a copper shape and associating it 
to the pad while editing the decal. For more information, see Associating Copper with 
Terminals.

Associating Copper with Terminals
You can associate a drawn copper shape with a terminal/pad. This assigns the copper shape the 
same net connection as the terminal/pad. You use associated copper to create custom pad 
shapes. 

Restriction: Routing is only completed to the center of the pad and any thermal connections are 
made to the pad only and not the associated copper shape.
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Procedure

1. Draw the copper shape. For more information, see Creating Copper in the Decal.

Tip: You can create multiple copper shapes.

2. PCB Decal Editor > select a terminal > right-click > Associate.

3. Select the copper item to associate with the terminal. This electrically connects the 
copper item with the terminal. You may want to physically connect the terminal and 
copper item by overlaying part or all of the terminal.

4. If you are using the associated copper to create an odd shaped pad, maximize the pad 
shape inside the overlapping associated-copper shape. The underlying pad is still the 
routing target and also the connection point for thermals if this pad will ever be 
connected to a copper pour or plane area. If associated copper surrounds the terminal pin 
by a large amount it could prevent thermal spokes from being generated.

Restriction: When routing to a decal pad with associated copper in the design editor, 
the trace is flagged as a partial connection if you route only to the associated copper, and 
not to the center of the decal pad itself. Note, however, that though the connection is 
flagged as partial, it will result in a functional connection on the finished board.

Result

CAM interprets terminals differently when associated with copper. See Working with 
Associated Copper.

Unassociating Copper from Terminals
You can remove the association between a copper item and a terminal.

Procedure

1. In the Decal Editor, select the copper item.

2. Right-click and click Unassociate.

Alternative: In the Terminal Properties, you can clear the Associated Copper check 
box to unassociate copper from the terminal.

Customizing Pad Stacks of Decal Pins
You can customize the pad stacks of the pins in your decal. You can choose to customize one 
pin, or multiple pins simultaneously.
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Restriction

• If you’re working in the PCB Decal Editor, you must have a decal open in the editor. 
The terminals (pins) must exist in your decal before you can modify their default pad 
stacks.

• If you’re working in the Design Editor, the decal you want to edit must exist in the 
design.

Procedure

1. On the Setup menu, click Pad Stacks.

2. In the Pad Stack Properties dialog box, ensure that your decal is selected in the Decal 
name list.

3. Under the Pin: Plated: list, select the pin to customize. If you don’t want to customize 
all the pins simultaneously, you can add one or more specific pin numbers to the list.

See also: Add Pin Dialog Box

4. Under the Sh: Sz: Layer: list, select the layer of the pad you want to customize.

See also: Pad Stack Default Layers, Control of Solder Mask and Paste Mask

5. In the Parameters area, specify the settings for all three Pad, Thermal, and Antipad pad 
styles if needed. The style of pad used is selected automatically in the design depending 
on the situation. The thermal and antipad styles are used when the pin is located within a 
plane.

See also: Design Rule Versus Pad Stack - Thermals and Antipads, Creating Thermals in 
the Pad Stacks, Creating Antipads in the Pad Stacks, and Customizing Design Rule 
Thermals.

6. Below the Parameters area, set the options that apply to the pads on all layers for the 
selected pin(s).

7. If you need to customize other pins in the decal, return to step 3.

8. Click OK to save all the pad stack customizations.

Result

Are your custom thermals not showing up in CAM plane plots? You must select the Use 
Custom Thermal Settings check box in the Plot Options dialog box and ensure that the photo 
plotter format is RS-274-X. Custom thermals for CAM planes are not supported by RS-274-D.

Related Topics

Assigning Plane Thermal Attributes
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Creating Thermals in the Pad Stacks
Thermals are set up wherever pad stacks can be created or modified. Create thermals on 
split/mixed plane layers and CAM negative planes (for RS-274-X output).

Restrictions: 

• Pad stack thermals work only in plane areas; they do not work in copper pours.

• In the PCB Decal Editor, thermals can't be created in the Pad Stack Properties for Pin 
dialog box. Instead, on the Setup menu click Pad Stacks to use the Pad Stacks Properties 
dialog box.

Tip: The Sh: Sz: Layer: area of these dialog boxes contains one global listing for inner layers, 
listed as <Inner Layers>. Setting a thermal definition for this inner layer modifies the photoplot 
output for CAM planes and split/mixed planes. If you want a unique thermal on a particular 
layer, add the new layer, and define the specific thermal setting.

Procedure

1. Select a layer. 

2. In the Pad Style list, select Thermal. 

3. Click the appropriate pad shape to enable the size and shape controls for thermals.

Tip: The pad stack thermal settings use oval and rectangular shapes for slotted holes as 
well as for oval and rectangular pads.

4. Change the default thermal values in the fields provided.

Restriction: No pad stack thermal will be used if the Use design rules for thermals and 
antipads check box is selected in the Split/Mixed Plane options. See also Customizing 
Design Rule Thermals.

Exception: CAM planes are negative images compared to other layers. When you set thermals 
for CAM plane layers, you must select the Use Custom Thermal Settings check box in the Plot 
Options dialog box. Make sure you are also using RS-274-X output format in the Photo Plotter 
Advanced Setup dialog box.

Related Topics

Customizing Pad Stacks of Decal Pins

Creating Antipads in the Pad Stacks
Antipads are set up wherever pad stacks can be created or modified. Create antipads on 
split/mixed plane layers and CAM negative planes (for RS-274-X output).

Restrictions: 
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• Pad stack antipads work only in plane areas; they do not work in copper pours.

• In the PCB Decal Editor, antipads can't be created in the Pad Stack Properties for Pin 
dialog box. Instead, on the Setup menu click Pad Stacks to use the Pad Stacks Properties 
dialog box.

Tip: The Sh: Sz: Layer: area of these dialog boxes contains one global listing for inner layers, 
listed as <Inner Layers>. Setting an antipad definition for this inner layer modifies the photoplot 
output for CAM planes and split/mixed planes. If you want a unique antipad on a particular 
layer, add the new layer, and define the specific antipad setting.

Procedure

1. Select an inner layer. 

Tip: Antipads are not found when using the generic Mounted Side and Opposite side 
layers. If you want a custom antipad for the top and bottom layers, you need to add the 
specific layer.

2. In the Pad Style list, select Antipad. 

3. Click the appropriate pad shape to enable the size and shape controls for antipads.

Tip: The pad stack antipad settings use oval and rectangular shapes for slotted holes as 
well as for oval and rectangular pads.

4. Change the default antipad value in the field provided.

• Restriction: No pad stack antipad will be used if the Use design rules for thermals and 
antipads check box is selected in the Split/Mixed Plane options. See also Customizing 
Design Rule Antipads of Copper Pours and Customizing Design Rule Antipads of Plane 
Areas.

Exception: CAM planes are negative images compared to other layers. When you set antipads 
for CAM plane layers, you must select the Use Custom Thermal Settings check box in the Plot 
Options dialog box. Make sure you are also using RS-274-X output format in the Photo Plotter 
Advanced Setup dialog box.

Related Topics

Customizing Pad Stacks of Decal Pins

Editing Pad Stacks
Pad information for the selected decal is listed by pin number to the right of the Setup/Pad Stack 
form. A typical decal uses one pad stack description for all its pins. There are common 
exceptions, for example, pin 1 of through-hole components is usually designated by a square 
pad. 

To edit a pad stack for a decal:
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1. Setup menu > Pad Stacks.

2. Set the pad stack type to Decal or Via.

3. Click the decal or via name from the Decal Name list.

4. Make your changes.

5. To save your changes click OK.

6. When you are prompted to save changes to all or the selected parts click the appropriate 
button:

• All to assign the decal name to the part type and for all part types in the design using this 
decal to assume the new pad stack definition.

• Selected to rename the individual component's decal using a suffix letter; for example a 
DIP16 with a local pad stack edit becomes DIP16A. This decal name becomes the only 
decal listing, primary or alternate, for this particular reference designator. 

See also: Customizing Pad Stacks of Decal Pins

Editing a Pad Stack in the PCB Decal Editor
Edit a pad stack in the PCB Decal Editor to change the pad stack of a single pin or to make pad 
stack changes and save them to the library before adding parts to the design. 

To change pad stack definitions for selected pins:

1. Tools menu > PCB Decal Editor.

2. Open a decal.

3. Select the pin or pins for which you want to change the pad stack.

4. Right-click and click Pad Stacks. The Pad Stack Properties for Pin dialog box appears.

5. From Pin Name, click the pin you want to change, and from Shape/Size/Layer, click 
the layer on which you want to change the pad stack information.

6. Make the pad stack modifications.

7. Click Assign to All Pins to apply the modifications to all of the selected pins. Selected 
pins appear in the Pin Name list.

8. Click OK. The pad stack changes are applied to every selected pin.

Tips:

• To save the changes, save the decal. 

• To work with pad stacks on library parts before they are added to the design enter the 
PCB Decal Editor through the Library Manager. This lets you include decal names in 
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the part's alternate decals, ensuring smoother operation if you refresh a part type in the 
design with a definition from the library.

See also: Part Information Dialog Box, PCB Decals Tab

Saving Pad Stack Changes to the Decal Library
Changing the pad stack definition for a single part or for all parts does not change the decal in 
the part's library definition. Use the Library Manager to include any new decal names in the 
part's alternate decals. This ensures a smoother operation if you ever refresh the part type in the 
design with a new definition from the library.

To save the pad stack changes to the parts library:

1. Select the part.

2. Right-click and click Save to Library. The Save Part Types and Decals dialog box 
shows the selected part type and all of its alternate decals as of the last time it was read 
or refreshed.

If you created a new suffixed decal, meaning you changed the pad stack for one 
component only, the new decal also appears.

3. Highlight either the decal you changed or the new decal and the library where you keep 
the decals.

Using Slotted Holes
You can create slotted holes using the Pad Stacks Properties dialog box or the Pad Stacks 
Properties for Pins dialog box. 

Slotted holes have orientation and offset properties, but have the same unit and range as the 
associated pad's orientation and offset. You can use slotted holes with only round, square, oval, 
or rectangular pad shapes. Therefore, you can only define slotted holes for component pins. All 
pads in the pad stack should be oval or rectangular; the pad shape is checked on the mounted 
side. You can also create a thermal or antipad definition for slotted holes. 

Tip: Control the line width for slotted holes using Line Width in the Drill Drawing Options 
dialog box.

Related Topics

Creating Slotted Holes in Decals

Creating Slotted Holes in Pins

Using Slotted Holes in CAM350 in the Concepts Guide

Customizing Pad Stacks of Decal Pins
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Pad Stack Properties for Pin Dialog Box

Setting Drill Drawing Options

Creating Slotted Holes in Decals

Procedure

1. Tools menu > Decal Editor > Setup menu > Pad Stacks.

2. In the Pad Stacks Properties dialog box, set any pad stack options you want, such as 
plated, size, shape, and layer.

3. Select the Slotted check box to add a slotted hole to the decal.

4. Set the length, orientation, and offset of the slotted hole.

5. Click OK.

6. Choose whether to keep existing attributes on the pin (Keep Attributes), and then 
choose whether to apply the pad stack changes to all decal types (All) or to just the 
selected component (Selected). You can also to cancel the slotted hole creation 
(Cancel).

Creating Slotted Holes in Pins

Procedure

1. Select a pin > right-click > Properties.

2. Click Pad Stack.

3. Select the Slotted check box to add a slotted hole.

4. Set the length, orientation, and offset of the slotted hole.

5. Click OK.

6. Choose whether to keep existing attributes on the pin (Keep Attributes), and then 
choose whether to apply the pad stack changes to all decal types (All) or to just the 
selected component (Selected). You can also choose to cancel the slotted hole creation 
(Cancel).

Creating Assembly Drawing Decal Objects
The assembly outline and assembly refes are used on the assembly drawing to define the exact 
outline and identify the body of the part. It shows where the part is to be placed during the board 
assembly process.
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Procedure

1. Tools menu > PCB Decal Editor

2. On the Assembly Drawing Top layer, draw the outline.

• Drafting Toolbar button > 2D line button. See Creating a Drafting Object for 
information on drawing 2D shapes.

Tip: If you flip a part to the other side of the board, the assembly outline flips with it. 
Even though you create the outline on the Assembly Top layer, it automatically flips to 
the Assembly Bottom layer when you flip the component from the mounted side to the 
opposite side.

3. Add a second reference designator label on the Assembly Outline Top layer. The 
reference designator label should be large and located inside the outline. For more 
comprehensive procedures than what is listed below, see Creating Attribute Labels in 
the PCB Decal Editor.

a. Click the Add New Label button.

b. In the Add New Decal Label dialog box, in the Attribute list, select the Ref.Des. 
attribute.

c. In the Layer list, select the assembly drawing top layer.

d. Click OK. The label appears with the value “Name”. 

e. Right-click and click Move.

f. Position the new label.

Tip: You can also create assembly layer reference designators globally in the design 
editor. See Generating a Second Set of Reference Designators for Assembly Drawings.

Result

If a 2D item does not appear after you draw it, the color set for Lines on the layer is probably the 
same as the background color. Set a different color for Lines in the Display Colors Setup dialog 
box.

Creating Silkscreen Decal Objects
The silkscreen outline is printed on the board, and remains visible on the board after the part has 
been placed. This outline, along with its reference designator, pin number and polarity labels, 
identifies the part and its pins to persons assembling, testing, or servicing the board. The 
silkscreen also serves as a nudge outline if no actual nudge outline exists on Layer 20.

Procedure

1. Tools menu > PCB Decal Editor
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2. On the Silkscreen Top layer, draw the outline.

• Drafting Toolbar button > 2D line button. See Creating a Drafting Object for 
information on drawing 2D shapes.

Tip: If you flip a part to the other side of the board, the silkscreen outline flips with it. 
Even though you create the outline on the Silkscreen Top layer, it automatically flips to 
the Silkscreen Bottom layer when you flip the component from the mounted side to the 
opposite side.

3. Move the silkscreen refdes to the Silkscreen Top layer. The silkscreen refdes label is 
automatically added at the creation of the new decal. But by default it is added to the 
Top (Mounted) layer.

a. Double-click the “Name” label in the decal.

b. In the Decal Label Properties dialog box, in the Layer list, select the silkscreen top 
layer.

c. Click OK.

4. Add pin number, and polarity labels if needed. The labels should be located outside the 
outline, where they can be seen after the part is placed. For more comprehensive 
procedures than what is listed below, see Creating Attribute Labels in the PCB Decal 
Editor.

Tip: Silkscreens for large components with many pins often have miniature dots and pin 
numbers, in order not to have to count the pins when trying to locate a pin on the board. 
If you use text in the decal for these, they will not be movable when the component is 
placed in the design. Use labels instead; labels can be moved or deleted in the design if 
necessary.

a. Click the Add New Label button.

b. In the Add New Decal Label dialog box, in the Attribute box, type a name for the 
new attribute.

Restriction: The value can only be assigned once the decal is used in the design.

c. In the Layer list, select the silkscreen top layer.

d. Click OK. The label appears with the attribute name you typed.

e. Right-click and click Move. 

f. Position the new placeholder.

Result

If an item does not appear after you add it, the color set for the item is probably the same as the 
background color. Set a different color in the Display Colors Setup dialog box.



Creating and Editing PCB Decals
Decal Editing Tasks

PADS Layout User’s Guide and Reference Manual, PADS 9.4 185

Exceptions: The refdes (Name label) is controlled by the Pin Num column and the part type 
(Type label) is controlled by the Type column.

Creating a Placement (Nudge) Decal Outline
The placement (nudge) outline (sometimes called a “courtyard”) defines the boundary where 
nudging of the part is initiated when another part is moved against it. Some parts need 
additional spacing compared to others to allow for machine-placement on the physical board. 
You can use a larger outline on layer 20 to ensure that your design placement is correct even 
though you apply the same body-to-body clearance for all components.

Procedure

1. Tools menu > PCB Decal Editor

2. On layer 20 (120 in max layers mode) draw the 2D line item(s) defining the nudge 
outline.

• Drafting Toolbar button > 2D line button. See Creating a Drafting Object for 
information on drawing 2D shapes.

Tip: The outline doesn’t have to be a contiguous shape enclosing the part. It can be 
made up of multiple 2d items--any object placed on the Placement layer is 
considered part of the “outline”.

Result

The outline is considered by the software as part of the component body. Whenever it is 
encountered, the body-to-body clearance rule is invoked.

If a 2d item does not appear after you draw it, the color for Lines on layer 20 is probably the 
same as the background color. Set a different color for Lines in the Display Colors Setup dialog 
box.

Importing RF Shapes in DXF Format
You can import specialized shapes of DXF format into your decal or into the design using the 
AutoCAD 2004 DXF format.

Restriction: DXF import only supports the following geometries: POINT, LINE, ARC, 
CIRCLE, ELLIPS, TRACE, SOLID, 3DFACE, POLYLINE, LWPOLYLINE (AutoCAD R14), 
and BLOCKS with hierarchy.

1. Click the Drafting Toolbar button.

2. On the Drafting Toolbar, click the Import DXF File button.
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Tip: The DXF import functionality of the Import DXF File button is optimized for 
importing RF shapes as 2D lines or copper. For more DXF import functionality use the 
File > Import method.

3. In the File Import dialog box, browse for the DXF file and then click Open.

4. In the DXF Import dialog box, in the DXF-File Unit list, select the units used in the 
DXF file.

5. For each layer you want to include in the import:

a. Select the Add check box.

b. In the PCB Layer column, double-click a layer box and select the PCB layer to use 
for the items of that DXF Layer.

c. In the Type column, double-click a type box and select either 2D Line or Copper 
for the DXF items of that layer.

Restriction: A PCB layer set to <All Layers> cannot be imported as copper. You 
cannot have copper items on <All Layers> in a PCB decal.

6. Click OK.

Result

The geometries are added to the design or the decal in the PCB Decal Editor. If you need your 
imported geometries to be single objects, but they have been imported as multiple line items, 
see Joining and Closing 2D Lines and Copper Shapes.

Related Topics

Importing DXF Files

DXF Format in the Concepts Guide

Creating Attributes in the PCB Decal Editor
Attributes can be added automatically to the Attribute Dictionary when returning from the PCB 
Decal Editor.

You can use attributes in the PCB Decal Editor, but they differ in concept from attributes in the 
Layout Editor: The only attributes you can create in the PCB Decal Editor are decal attributes, 
which are associated with the physical decal.

The Attribute Dictionary doesn't exist in the PCB Decal Editor; therefore, attributes in the PCB 
Decal Editor are text strings only. They don't have properties, types, hierarchies, and other 
settings that attributes in the Attribute Dictionary have.
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When you use Edit Decal to enter the PCB Decal Editor, upon exit, you are asked whether to 
apply the changes you made. If you apply the changes when you return to the Layout Editor, 
any attributes you added in the PCB Decal Editor are added to the Attribute Dictionary. The 
attributes are added at the Decal level of the attribute hierarchy and assigned to the appropriate 
objects.

Exception: When you enter PCB Decal Editor using the Tools menu command, any attributes 
you create in the PCB Decal Editor are not added to the Attribute Dictionary.

If you created an attribute in the PCB Decal Editor that exists in the Attribute Dictionary, the 
existing attribute in the dictionary is maintained. The attribute is assigned to the part that uses 
the decal. If a label for the attribute exists, it is associated with the attribute in the Attribute 
Dictionary.

If you created an attribute in the PCB Decal Editor that does not exist in the Attribute 
Dictionary, a non ECO-Registered attribute is created with the Free Text type. The attribute is 
then assigned to the part that uses the decal. If a label for the attribute exists, it is associated with 
the attribute created in the Attribute Dictionary.

Procedure

1. PCB Decal Editor > Edit menu > Attribute Manager.

2. Click Add.

3. Do one of the following:

• Type an attribute name in the new Attribute cell, and press Enter. Attribute names 
are not checked in the PCB Decal Editor.

• Select the new Value cell and click Edit.

• Type an attribute value, and press Enter. You can also type units for the value. If 
you don't specify units, PADS Layout uses the same units as the decal.

4. Click Close.

Tip: You can also add attributes using the Browse Lib. Attr. button.

See also: Control of Solder Mask and Paste Mask

Modifying an Attribute
To modify an attribute:

1. PCB Decal Editor > Edit menu > Attribute Manager.

2. Select the Attribute cell or the Value cell for the attribute.

3. Click Edit.
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4. Type a new name or value, and press Enter.

5. Click Close.

Creating Attribute Labels in the PCB Decal Editor
Use attribute labels in the PCB Decal Editor exactly as you use labels in the Layout Editor. 
Labels in the PCB Decal Editor offer you greater flexibility; you can display either decal 
attributes or an attribute from an object that uses the decal. For example, you can create a label 
for the part attribute Cost. Since Cost is not a decal attribute, you create the attribute in the 
Attribute Dictionary in the Layout Editor, and assign a placeholder label in the PCB Decal 
Editor. 

See also: Creating Placeholder Attribute Labels

When you create labels, they may not be visible. Turn on the visibility of labels using the 
Display Colors Setup dialog box. Here, you can set the color for reference designators, part 
type, and attribute labels.

Tip: Pre-version 3.0 labels for part names, reference designators, and terminal numbers are 
converted to labels for version 3.0 and higher when you open the part in the Decal Editor.

Procedure

1. Tools menu > PCB Decal Editor > with a decal open > Drafting button > Add New 
Label button.

2. In the Add New Decal Label dialog box, in the Attribute list, select the attribute you 
want. 

Alternative: 

a. In the Attribute list click Browse Lib. Attr. to pick from the list of all library 
attributes.

b. In the Browse Library Attributes dialog box click the attribute and click OK. The 
dialog box closes and the attribute name appears in the Attribute list in the Add New 
Decal Label dialog box. 

Restrictions: 

• If you are creating labels for jumpers, Reference Designator is the only available 
attribute. 

• Hidden attributes do not appear in the Attribute list unless the attribute was selected 
for the label before it was set as a hidden attribute.

3. The Value box lists the value of the selected attribute. Accept this value, or type a new 
one. This box is unavailable if you selected Reference Designator or Part Type from the 
Attribute list, if the attribute is read-only, or if you open the Properties dialog box for 
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labels of different attribute types. However, if the labels you select belong to attributes 
of the same type, you can edit this box.

Tips:

• If the attributes have different values, the box is blank. You can type a new value in 
the box to apply it to all of the selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-registered and PADS Layout is not 
in ECO mode. 

4. In the Show list, select the value you want to control the visibility of the label. You can 
choose to turn the label off, to display only the label name, to display only the label 
value, to display the name and value, or to display the full name and value (when 
labeling a structured attribute).

Tip: Labels are invisible regardless of this setting unless you use the Display Colors 
Setup dialog box to change the color of labels to a color different from that of the 
background.

5. In the Font list, select the font you want to use. 

Tips: 

• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any combination of styles: 
B for bold, I for italic, or U for underlined.

6. In the Layer list, select the layer on which you want the decal label.

7. In the Position and sizes area, select the Relative to check box to place the label at the X 
and Y location relative to the component or the jumper. If you clear this check box, the 
label is placed at the X and Y location relative to the design origin.

8. In the X,Y location boxes, type new values to place the decal label in a specified 
location.

9. In the Rotation box, type a rotation angle to specify the rotation of the label.

10. In the Size box, type the size you want.

11. For stroke font, type the line width you want.

12. Select the Mirrored check box if you want to flip the label. When Mirrored is checked, 
text is considered readable from the bottom side of the board.

13. In the Justification area, set the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, size, or width change.

Tips: 
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• For vertical justification, click Left, Center, or Right. For horizontal justification, 
choose Up, Center, or Down. 

• Optionally, set justification by selecting the text, then right-clicking and clicking 
Justify Horizontally, and then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then clicking Up, Center, or Down.

14. The Right reading area controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click the None, Orthogonal, or Angled button to 
indicate the direction of reading you want.

15. Click OK.

Creating Placeholder Attribute Labels
A placeholder label is a label for an attribute that doesn't exist. Two practical uses for 
placeholder labels are:

• To predefine label positions in the decal and use them in the Layout Editor. This method 
also lets you create labels for non-decal attributes.

• To create a label for an attribute that will be created in the Layout Editor, but doesn't 
exist yet.

Procedure

1. When you create a label in the PCB Decal Editor, in the Add New Decal Label dialog 
box, in the Attribute list, click new user attr. UserAttribN appears in the Attributes list, 
where N is 1, 2, 3, or the next available number.

2. Type the name of an attribute for which you want to create a label.

3. Continue to define the label.

Once you create a placeholder label, you can easily associate it with an existing attribute in the 
Attribute Dictionary when you return to the Layout Editor.

Modifying Decal Label Properties
Use the Decal Label Properties dialog box to modify a decal label or to change the attribute the 
label displays.

See also: Creating Attribute Labels in the PCB Decal Editor

Tip: If you select multiple labels, settings in this dialog box apply to all selected labels.

Procedure

1. PCB Decal Editor > Select a decal label > right-click > Properties.
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2. In the Decal Label Properties dialog box, in the Attribute list, select the attribute you 
want. If you are creating or modifying labels for jumpers, Reference Designator is the 
only available attribute.

Tip: Hidden attributes do not appear in the Attribute list unless the attribute was 
selected for the label before it was set as a hidden attribute.

3. The Value box lists the value of the selected attribute. Accept this value, or type a new 
one. This box is unavailable if you clicked Reference Designator or Part Type from the 
Attribute list, if the attribute is read-only, or if you open the Properties dialog box for 
labels of different attribute types. However, if the labels you select belong to attributes 
of the same type, you can edit this box.

Tips:

• If the attributes have different values, the box is blank. You can type a new value in 
the box to apply it to all of the selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-registered and PADS Layout is not 
in ECO mode.

4. In the Show list, click the value you want to control the visibility of the label. You can 
choose to turn the label off, to display only the label name, to display only the label 
value, to display the name and value, or to display the full name and value (when 
labeling a  structured attribute).

Tip: Labels are invisible regardless of this setting unless you use the Display Colors 
Setup dialog box to change the color of labels to a color different from that of the 
background.

5. In the Font list, select the font you want to use. 

Tips: 

• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any combination of styles: 
B for bold, I for italic, or U for underlined.

6. In the Layer list, select the layer on which you want the decal label.

7. In the Position and sizes area, select the Relative to Component check box to place the 
label at the X and Y location relative to the component or the jumper. If you clear this 
check box, the label is placed at the X and Y location relative to the design origin.

8. In the X,Y location boxes, type new values to move the decal label to a specified 
location.

9. The Rotation box shows the current rotation angle of the label. Type a new rotation 
angle if you want to change the rotation of the label.

10. In the Size box, type the size you want.
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11. For stroke font, type the line width you want.

12. Select the Mirrored check box if you want to flip the label. When Mirrored is checked, 
text is considered readable from the bottom side of the board.

13. In the Justification area, set the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, size, or width change.

Tips: 

• For vertical justification, click Left, Center, or Right. For horizontal justification, 
choose Up, Center, or Down. 

• Optionally, set justification by selecting the text, then right-clicking and clicking 
Justify Horizontally, and then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then clicking Up, Center, or Down.

14. The Right reading area controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click the None, Orthogonal, or Angled button to 
indicate the direction of reading you want.

15. Click OK.

Creating Keepout Areas in the PCB Decal Editor
Create a keepout to define areas where design objects cannot be placed. You can create keepout 
areas using closed polygons (with or without arcs), circles, or rectangles. The current angle 
mode and design grid settings determine the placement of the lines.

You can create keepouts in both the Layout Editor and the PCB Decal Editor. User interaction is 
the same for either; the only difference is the type of objects you can restrict.

Procedure

1. With a decal open in the Decal Editor, Drafting Toolbar button > Keepout button.

2. Right-click and click a draw mode for the type of shape to create.

3. Create a closed shape to define the keepout area. The Drafting Properties dialog box 
automatically appears when you close the shape.

4. In the Add Drafting Dialog Box, select restrictions.

5. Click the layer on which to place the keepout.

Tips: 

• When you choose layer assignments, restrictions not available for that layer are 
unavailable.
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• When defining keepouts in the PCB Decal Editor, you can also assign keepouts to an 
<Opposite Side> layer. You can’t do this in the Layout Editor.

6. Click OK. The keepout is created. If you create other keepouts, they use the restrictions 
you set here as the default.

Modifying Decal-level Keepouts
Once you create a decal-level keepout, you must use the PCB Decal Editor to modify any of the 
keepout properties. You can change the size of a keepout just as you would any other drafting 
object: move an edge or corner, or change the diameter of a circle. You can also copy a keepout 
to another location and change its restrictions or layer assignments.

Procedure

1. Select an edge > right-click > Select Shape

2. Right-click and click Properties.

3. Turn restrictions on or off and modify the layer settings. See also: Modifying Drafting 
Object Properties

4. Click OK.

Tip: You can't modify a keepout that is part of a physical design reuse. If you try to, the 
message “Reuse elements cannot be modified. Break the reuse first” appears. Click OK to 
cancel the operation.

Generating Drafting Shapes from Terminals
You can use the outline of a terminal as the basis to create new drafting shapes.

Procedure

1. Select one or more terminals.

2. Right-click and click Generate Drafting Shape.

3. In the Generate Drafting Shape dialog box, select the type of drafting item from the 
Type list. The valid drafting types are 2D Line, Copper, Copper Cut Out, and Keepout.

4. In the Layer list, select the Layer on which to place the new drafting shape.

5. In the Width box, type a line width for the new shape.

6. In the Oversize/Undersize value box, do one of the following:

• To create a new drafting shape larger than the terminal outline by the typed value, 
type a positive number.
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• To create a new drafting shape equal in size to the terminal, type 0 (zero).

• To create a new drafting shape smaller than the terminal outline by the typed value, 
type a negative number.

7. Click Complete to close the dialog box and create a new shape or click Create to keep 
the dialog box open for creating more shapes.

Working with Solder and Paste Masks
You can create custom openings in the top and bottom solder mask and paste mask layers for 
individual pad stacks, for decals, or for components. You do this in the Decal Editor, or in the 
pad stack.

See:

Creating Solder Mask Openings in the Decal Editor

Creating Solder Mask Openings in the Pad Stack

Creating Paste Mask Openings in the Decal Editor

Creating Paste Mask Openings in the Pad Stack

Related Topics

Control of Solder Mask and Paste Mask

Creating Solder Mask Openings in the Decal Editor
There are two ways to create custom solder mask openings in the Decal Editor. You can:

• Copy a pad shape, over- or undersize it, and save it as copper on the Top or Bottom 
solder mask layer.

• Draw the mask opening shape in copper on the Top or Bottom solder mask layer.

Procedure1—Copy a Pad Shape

1. Open the decal from the library or the design.

2. With nothing selected, right-click > Select Terminals.

3. Select the terminal you want to copy, then right click > Generate Drafting Shape.

4. In the dialog box, select copper from the Type list.

5. Select Solder Mask Top or Solder Mask Bottom from the Layer list.

6. Set Width and Oversize as desired.
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7. Select Create.

8. Select Complete.

Results

To see the new opening shape(s):

1. In the Display Colors Setup Dialog Box, assign a color to the Top or Bottom solder 
mask layer.

2. Make the layer active by selecting it from the Layer List.

Procedure2—Draw the Opening Shape

Tip: You can also use this procedure to create gang relief of solder mask.

1. Open the decal from the library or the design.

2. Select the Solder Mask Top or Solder Mask Bottom layer.

3. Click the Drafting Toolbar button.

4. Click the Copper button.

5. Create the new opening shape.

Results

To see the new opening shape(s):

1. In the Display Colors Setup Dialog Box, assign a color to the Top or Bottom solder 
mask layer.

2. Make the layer active by selecting it from the Layer List.

Related Topics

Control of Solder Mask and Paste Mask

Creating Solder Mask Openings in the Pad Stack
You can create custom solder mask openings for individual pins or components in the pad stack.

Tip: Solder Mask openings in the pad stack have priority over all other solder mask opening 
values. See Control of Solder Mask and Paste Mask.

Procedure

1. With nothing selected, right-click > Select Components.
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2. Select the component whose pin(s) you want to create solder mask openings for.

3. Right-click > Properties

4. In the Component Properties dialog box, select the Pad Stack button. 

5. In the Pad Stacks Properties dialog box, if you want to create an opening for only a 
single pin, select the Add button under the Pin: Plated: list, and select the pin. If not, go 
to Step 6.

6. Select the Add button under the Sh; Sz: Layer: list, and add the Solder Mask Top or 
Solder Mask Bottom layer.

7. Select the appropriate pad shape, and set the Width;, Length: and Orientation values for 
the new solder mask opening.

8. Click OK.

Results

To see the new opening shape(s):

1. In the Display Colors Setup Dialog Box, assign a color to the Top or Bottom solder 
mask layer.

2. Make the layer active by selecting it from the Layer List.

Related Topics

Control of Solder Mask and Paste Mask

Creating Paste Mask Openings in the Decal Editor
There are two ways to create custom paste mask openings in the Decal Editor. You can:

• Copy a pad shape, over- or undersize it, and save it as copper on the Top or Bottom 
paste mask layer.

• Draw the mask opening shape in copper on the Top or Bottom paste mask layer.

Procedure 1—Copy a Pad Shape

1. Open the decal from the library or the design.

2. With nothing selected, right-click > Select Terminals.

3. Select the terminal you want to copy, then right click > Generate Drafting Shape.

4. In the dialog box, select copper from the Type list.

5. Select Paste Mask Top or Paste Mask Bottom from the Layer list.
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6. Set Width and Oversize as desired.

7. Select Create.

8. Select Complete.

Results

To see the new opening shape(s):

1. In the Display Colors Setup Dialog Box, assign a color to the Top or Bottom paste mask 
layer.

2. Make the layer active by selecting it from the Layer List.

Procedure 2—Draw the Opening Shape

1. Open the decal from the library or the design.

2. Select the Paste Mask Top or Paste Mask Bottom layer.

3. Click the Drafting Toolbar button.

4. Click the Copper button.

5. Create the new opening shape.

Results

To see the new opening shape(s):

1. In the Display Colors Setup Dialog Box, assign a color to the Top or Bottom paste mask 
layer.

2. Make the layer active by selecting it from the Layer List.

Related Topics

Control of Solder Mask and Paste Mask

Creating Paste Mask Openings in the Pad Stack
You can create custom paste mask openings for individual pins or components in the pad stack.

Tip: Paste Mask openings in the pad stack have priority over all other paste mask opening 
values. See Control of Solder Mask and Paste Mask.

Procedure

1. With nothing selected, right-click > Select Components.
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2. Select the component whose pin(s) you want to create paste mask openings for.

3. Right-click > Properties

4. In the Component Properties dialog box, select the Pad Stack button. 

5. In the Pad Stacks Properties dialog box, if you want to create an opening for only a 
single pin, select the Add button under the Pin: Plated: list, and select the pin. If not, go 
to Step 6.

6. Select the Add button under the Sh; Sz: Layer: list, and add the Paste Mask Top or Paste 
Mask Bottom layer.

7. Select the appropriate pad shape, and set the Width, Length and Orientation values for 
the new paste mask opening.

8. Click OK.

Results

To see the new opening shape(s):

1. In the Display Colors Setup Dialog Box, assign a color to the Top or Bottom paste mask 
layer.

2. Make the layer active by selecting it from the Layer List.

Related Topics

Control of Solder Mask and Paste Mask

Updating a Design from the Library
In PADS Layout, when you import a netlist into a design, a copy of the library content for the 
parts is written into the design. Over time, however, as updates are made to the library, the parts 
in the design can become out of sync with newer versions in the library.

Use Update from Library (UFL) to create a report of any part differences between the current 
design and the library, and to update the design to reflect the current state of the library. You 
can compare or update:

• Part types

• PCB decals and decal rules

• Attributes and labels



Creating and Editing PCB Decals
Updating a Design from the Library

PADS Layout User’s Guide and Reference Manual, PADS 9.4 199

Since each item in your design is linked to its library counterpart by name only, unconsidered 
updating can have unforeseen and unintended consequences. Before you update any design, you 
should always ascertain how updating will affect it. Either generate a comparison report and 
determine what differences exist between the design and library (and thus what changes will 
occur during the update,) or make a copy of the design and check/test the updated copy for 
unwanted changes or behavior.

Tip: To find differences between the library and design in the comparison report, search for 
“different”.

Caution
Design changes resulting from updating can cause existing associated nets to be 
truncated, split, or deleted altogether. It can also cause existing associated nets to be 
extended, or new associated nets to be created if the refdes prefixes of updated 
components are specified in the Associated Nets dialog box. For more information, see 
the Associated Nets chapter in this manual.

Procedure

Tip: UFL searches libraries for part types using the library order shown in the Library List 
dialog box (File Menu > Library > Manage Lib. List button). If necessary, verify that the 
library order is correct before executing this procedure.

From the design editor:

1. If you want to compare/update only specific components, select them. Otherwise, UFL 
selects all components in the design by default.

2. Tools menu > Update from Library

3. Modify the settings in the Update from Library Dialog Box.

4. Click OK.

Results

When the comparison or update operation is completed, the update report is opened for 
viewing, and a link to the report file is written to the Output Window.

Undoing an Update
If at least one item is updated during an update operation, the update process creates an undo 
checkpoint. So you can undo any changes made to the design to the last-saved checkpoint using 
Edit menu > Undo.

Caution
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Tip: If nothing is updated, UFL does not create a new undo checkpoint and preserves undo data 
and undo checkpoints created by previous commands.

Preventing Undo Buffer Overruns
The data required to undo an update is stored in the undo buffer. To prevent overflows of this 
buffer when updating very large designs, UFL estimates the amount of undo data being 
generated, and if there is risk of a buffer overflow, displays this prompt:

Respond with one of the following actions:

• Click OK to clear the undo buffer and disable undo creation for this update. The update 
operation will continue, and you will be unable to undo the updates.

• Click Cancel to cancel the update and return to the UFL dialog. Undo data and undo 
checkpoints created by previous commands are preserved.

Related Topics

The Compare/Update Process

Update from Library Dialog Box

How to Read the Update Report

The Compare/Update Process
The update process begins with a comparison of the design content with the library content. 
When design content is found to be different from the library content, the design content is 
updated according to the options set in the Update From Library dialog box, and the results 
documented in the report file. The compare process is the same, except that the design is not 
updated.

General Rules
In comparing and updating, the following general rules apply for all items:

• Matching items — For each part type and decal listed in the Design items area of the 
Update from Library dialog box, all available libraries are searched to find a matching 
named entry, and the first matching entry found is used. If no match is found, 
comparison of the item is skipped, and a “not found” entry is made in the report file. 

Tips: 

• Libraries are searched in the order shown in the Library List dialog box( File menu > 
Library > Manage Lib. List button ). You can use this dialog box to change the 
search order.
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• Libraries that have the Allow Search property turned off are ignored.

• Timestamps —Each part type and decal in the design and library has a timestamp. 
Depending on the options chosen in the UFL dialog box, comparison of the timestamps 
can determine what is compared/updated. See Update from Library Dialog Box.

Tip: Designs created with PADS Layout versions prior to 9.1 do not have timestamps. 
See Older Designs for information on how to handle these designs.

What is Compared
Table 5-1 lists the content compared and reported for each item selected for comparison or 
update.

Table 5-1. Compared and Reported Part Structures

Item Item Component What is Compared & Reported

Part Type Timestamp, Logic Family, ECO Registered (y n), Special 
Purpose flag, gates count, gate pins count, signal pins 
count, connector pins count, attributes count, pin 
mappings count, decals count, associated decals list

For each gate Pin count, gate swap ID

For each gate pin Pin number, pin name, pin type, pin swap ID

For each signal pin Pin number, name

For each connector 
pin

Pin number

For each attribute Attribute value

For each pin 
mapping

Pin number value

PCB Decal Timestamp, terminals count, padstacks count, attributes 
count, body outline pieces count, free coppers count, 
keepouts count, text items count, labels count, dimensions 
count, associated coppers count, decal rule set count

For each terminal Terminal number, associated padstack, location (x y), 
associated copper list

For each padstack Drill diameter, drill plated (y n), drill slotted(y n), drill 
length, drill offset, drill orientation, pad count, plus:
• For each normal pad: Layer, pad shape and size, 

corner style, offset, orientation
• For each thermal pad: Layer, thermal shape and size, 

spoke count, spoke width, spoke angle
• For each antipad: Layer, antipad shape and size

For each attribute Attribute value
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For each decal rule Rule value

For each body 
outline piece

Layer, shape (OPEN, CLOSED, or CIRCLE), origin (First 
Corner location) (x y), line width, plus:
• If shape is OPEN or CLOSED: geometry corner count, 

geometry arc count, plus:
• For each corner: location (x y)
• For each arc: arc center and radius

• If shape is CIRCLE: circle radius

For each free 
copper

Layer, shape (OPEN, CLOSED, or CIRCLE), origin (First 
Corner location) (x y), line width, associated cutout count, 
plus:
• If shape is OPEN or CLOSED: geometry corner count, 

geometry arc count, plus:
• For each corner: location (x y)
• For each arc: arc center and radius

• If shape is CIRCLE: circle radius
• For each associated cutout: shape (OPEN, CLOSED, 

or CIRCLE), origin (First Corner position) (x y), line 
width, plus:
• If shape is OPEN or CLOSED: geometry corner 

count, geometry arc count, plus:
• For each corner: location (x y)
• For each arc: arc center and radius
• If shape is CIRCLE: circle radius

For each keepout Shape (OPEN, CLOSED, or CIRCLE), origin (First 
Corner location) (x y), line width, restrictions, plus:
• If shape is OPEN or CLOSED: geometry corner count, 

geometry arc count, plus:
• For each corner: location (x y)
• For each arc: arc center and radius

• If shape is CIRCLE: circle radius

For each text item Layer, text string, font, text height, line width, mirror 
(y n), location (x y), rotation, justification (horizontal 
vertical).

For each label Associated attribute, layer, font, text height, line width, 
mirror (y n), location (x y), rotation, justification 
(horizontal vertical), right reading, visibility

Table 5-1. Compared and Reported Part Structures

Item Item Component What is Compared & Reported
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Older Designs

Designs created with PADS Layout versions prior to 9.1 do not have timestamps. When one of 
these designs is opened, the timestamps on all part types and decals in the design are set to “Jan 
01 00:00:00 1970” (UTC). To find out whether the content of the part types and decals in the 
design is in sync with the library, compare the design and library with the Hide identical results 
check box selected.

Related Topics

Updating a Design from the Library

Update from Library Dialog Box

How to Read the Update Report

How to Read the Update Report
Every time you update a design from the library or generate a comparison report, the results of 
the operation are written to a new UpdateFromLibrary_Layout_Report.txt file in C:\PADS 

For each associated 
copper

Terminal ID, Layer, shape (OPEN, CLOSED, or 
CIRCLE), origin (First Corner position) (x y), line width, 
associated cutout count, plus:
• If shape is OPEN or CLOSED: geometry corner count, 

geometry arc count, plus:
• For each corner: location (x y)
• For each arc: arc center and radius

• If shape is CIRCLE: circle radius
• For each associated cutout: shape (OPEN, CLOSED, 

or CIRCLE), origin (First Corner location) (x y), line 
width, plus:
• If shape is OPEN or CLOSED: geometry corner 

count, geometry arc count, plus:
• For each corner: location (x y)
• For each arc: arc center and radius
• If shape is CIRCLE: circle radius

For each dimension Type, layer, origin (x y), textfont, text, piece count, plus:
• For the text: Layer, font, text height, line width, 

mirror, location (x y), rotation, justification (horizontal 
vertical)

• For each piece: piece type, geometry corner count, 
geometry arc count, plus:
• For each arc: arc center and radius

Table 5-1. Compared and Reported Part Structures

Item Item Component What is Compared & Reported
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Projects. The Update Report gives you information about the items selected for comparison or 
update, including:

• Whether the timestamp of an item in the design is older, newer, or the same as the item’s 
timestamp in the library.

• Whether the content of an item in the design is the same as or different from the item’s 
content in the library.

• The differences between the compared items.

Update Report Examples
The Update Report is divided into a header and six sections—Report Options, Results 
Summary, Part Types Summary, PCB Decals Summary, Part Type Comparison Details, and 
PCB Decal Comparison Details. Examples of each section are given in the following figures:

• Report Options section—Lists the options selected for this operation in the Update 
from Library dialog box. Example:  
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• Results Summary section—Gives a statistical summary of comparison and update 
results. Example: 

• Part Types Summary section—Lists all the selected part types and decals, and gives 
comparison/update information about each. Example:  

• PCB Decals Summary section—Lists all the PCB Decals associated with the selected 
part types and gives comparison/update information about each. Example:  
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• Part Type Comparison Details section—Lists compared part types, showing detailed 
comparison results. Example:  
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• PCB Decal Comparison Details section—Lists compared decals, showing detailed 
comparison results. Example:  
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Update Report Messages
Table 5-2 lists and describes the messages returned for compared/updated items in the Update 
Report.

Table 5-2. Update Report Messages—Part Type and Decals Summaries

Appears in Column: Message Means

Part Types Summary and PCB Decals Summary Messages

Design Timestamp older than in library Design version is older 
than Library version.

identical Design and library 
versions have identical 
timestamps.

newer than in library Design version is newer 
than Library version.

not checked Timestamps were not 
compared because the 
item was not found in the 
library.

Compared Content same Compared item content 
in the design and library 
are the same. (Does not 
apply to any item content 
that is not compared 
because the comparison 
is turned off in the 
Update from Library 
dialog box.)

different Compared item content 
in the design and library 
are different.

not checked Content was not 
compared because the 
item was not found in the 
library.

Update Status updated Design item has been 
updated with content 
from the library.
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not touched Design item (part 
type/decal) was not 
updated because:
• UFL was run in 

Compare mode, or 
• The item was not 

found in the library.

update failed The item could not be 
updated. Some possible 
causes are:
• Lost connection to 

library file
• Mismatch of pin 

counts between 
design and library 
items

• The library part type 
has no decal 
assigned.

• Decal not found in 
library when 
updating part type 
and decal

skipped Items are skipped if:
• They don’t qualify 

for Compare/Update 
(for example, items 
with identical 
timestamps), or 

• The item was not 
found in the library.

Part Type Comparison Details & PCB Decal Comparison Details Messages

Comparison same Item content in the 
design and library are the 
same. (Order can be 
different.)

Table 5-2. Update Report Messages—Part Type and Decals Summaries

Appears in Column: Message Means
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Related Topics

Updating a Design from the Library

Update from Library Dialog Box

The Compare/Update Process

different Item content in the 
design and library are 
different. 
Tip: A design that has 
been exported to ASCII 
and reimported may 
show differences in 
graphical data resulting 
from optimizations made 
during ASCII export.

not found in library Item does not exist in the 
library.

not found in design Item does not exist in the 
design.

Library
Design

none Item has no Special 
Purpose flag. 

< no value > Attribute exists but has 
no value assigned.

< no attribute > Attribute not found.

Table 5-2. Update Report Messages—Part Type and Decals Summaries

Appears in Column: Message Means
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Chapter 6
Creating and Modifying Part Types

In this chapter:

• Creating a New Part Type

• Modifying Part Types

• Saving Modified Decals and Parts to Libraries

Creating a New Part Type
There are five different component types that require specific instructions to create the part 
type:

• It’s an electrical part, and the logical and physical pin numbering is the same--both 
numeric, or both alphanumeric. See Creating a Part Type with Identical Schematic and 
Layout Pin Numbering.

• It’s an electrical part, and the logical and physical pin numbering is different--the logical 
is alphanumeric and the physical is numeric. See Creating a Part Type with Different 
Schematic and Layout Pin Numbering.

• It’s a connector. See Creating a Connector Part Type.

• It will not be ECO registered. See Creating a Non-ECO-Registered Part Type.

• It’s a non-electrical part—such as a mounting screw or locating post—that is not 
connected to any net. See Creating a Non-Electrical Part Type.

Creating a Part Type with Identical Schematic and Layout 
Pin Numbering

Use this procedure to create a part type that uses the same logical and physical pin numbering. 
The schematic-to-layout pin numbering can be either alphanumeric-to-alphanumeric or 
numeric-to-numeric.

Requirement

Your PCB decal(s) must exist to use this procedure. See Creating a New Decal.
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Procedure

1. File menu > Library

2. In the Library Manager dialog box, select a library for the new part.

3. Click the Parts button, and then click the New button.

4. On the General tab of the Part Information dialog box, select the logic family; this sets 
the refdes prefix.

5. Select the ECO Registered Part check box.

6. On the PCB Decals tab, assign one or more decals to the part.
See also: Assigning PCB Decals to Part Types

7. On the Gates tab, add at least one gate. (Add multiple gates if you want to be able to 
swap them.)
See also: Assigning CAE Decals to Gates

8. On the Pins tab, you must fill out the Pin Group and Name columns; the other columns 
are optional. 
See also: Editing Pins Table Data.

9. On the Attributes tab, add attributes as necessary.
See also: Defining Default Attributes for New Parts

10. Click OK.
See also: Part Type Error Checking

11. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics

Creating a New Part Type

Creating a Part Type with Different Schematic and Layout 
Pin Numbering

Use this procedure to create a part type that uses alphanumeric numbering for the logical pins 
and numeric numbering for the physical pins. 

Requirement

Your PCB decal(s) must exist to use this procedure. See Creating a New Decal.

Procedure

1. File menu > Library

2. In the Library Manager dialog box, select a library for the new part.
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3. Click the Parts button, and then click the New button.

4. On the General tab of the Part Information dialog box, select the logic family; this sets 
the refdes prefix.

5. Select the Define mapping of Part Type pin numbers to PCB Decal check box.

6. Select the ECO Registered Part check box.

7. On the PCB Decals tab, assign one or more numeric decals to the part.
See also: Assigning PCB Decals to Part Types

8. On the Gates tab, add at least one gate. (Add multiple gates if you want to be able to 
swap them.)
See also: Assigning CAE Decals to Gates

9. On the Pins tab:

a. Change the pin numbers to alphanumerics to match the schematic alphanumerics. 
See also: Renumbering Pins in the Pins Table.

b. Fill out the Pin Group and Name columns; the other columns are optional. 
See also: Editing Pins Table Data.

10. On the Attributes tab, add attributes as necessary.
See also: Defining Default Attributes for New Parts

11. On the Pin Mapping tab, map the unmapped logical pins (alphanumeric) to the physical 
decal pins (numeric). 
See also: Mapping Alphanumeric Pin Numbers to Numeric Decals.

12. Click OK.
See also: Part Type Error Checking

13. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics

Creating a New Part Type

Creating a Non-ECO-Registered Part Type
Use this procedure to create a non-ECO-registered part type. A non-ECO-registered part—such 
as a mounting-hole, for example—is not transferred during forward or backward annotation.

Requirement

Your PCB decal(s) must exist to use this procedure. See Creating a New Decal.



PADS Layout User’s Guide and Reference Manual, PADS 9.4214

Creating and Modifying Part Types
Creating a New Part Type

Procedure

1. File menu > Library

2. In the Library Manager dialog box, select a library for the new part.

3. Click the Parts button, and then click the New button.

4. On the General tab of the Part Information dialog box, select the logic family; this sets 
the refdes prefix.

5. Clear the ECO Registered Part check box.

6. On the PCB Decals tab, assign one or more decals to the part.
See also: Assigning PCB Decals to Part Types

7. On the Gates tab, add at least one gate. (Add multiple gates if you want to be able to 
swap them.)
See also: Assigning CAE Decals to Gates

8. On the Pins tab, you must fill out the Pin Group and Name columns; the other columns 
are optional. 
See also: Editing Pins Table Data.

9. On the Attributes tab, add attributes as necessary.
See also: Defining Default Attributes for New Parts

10. Click OK.
See also: Part Type Error Checking

11. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics

Creating a New Part Type

Creating a Non-Electrical Part Type
Use this procedure to create a non-electrical part type—such as a mounting screw or locating 
post—for adding to a parts list.

Requirement

Your PCB decal(s) must exist to use this procedure. See Creating a New Decal.

Procedure

1. File menu > Library

2. In the Library Manager dialog box, select a library for the new part.
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3. Click the Parts button, and then click the New button.

4. On the General tab of the Part Information dialog box, select the logic family; this sets 
the refdes prefix.

5. Clear the ECO Registered Part check box.

6. On the PCB Decals tab, assign a non-electrical (no pin terminals) decal to the part.
See also: Assigning PCB Decals to Part Types

7. On the Attributes tab, add attributes as necessary.
See also: Defining Default Attributes for New Parts

8. Click OK.
See also: Part Type Error Checking

9. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics

Creating a New Part Type

Creating a Connector Part Type
Use this procedure to create a connector part type, which enables a feature in PADS Logic that 
splits the connector into multiple pin decals, making each pin its own gate.

Requirement

Your PCB decal(s) must exist to use this procedure. See Creating a New Decal.

Procedure

1. File menu > Library

2. In the Library Manager dialog box, select a library for the new part.

3. Click the Parts button, and then click the New button.

4. On the General tab of the Part Information dialog box, select the logic family; this sets 
refdes prefix.

5. Select the ECO Registered Part check box.

6. Select the Special Purpose check box, and click Connector.

7. On the PCB Decals tab, assign one or more decals to the part.
See also: Assigning PCB Decals to Part Types
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8. On the Pins tab, you must fill out the Pin Group and Name columns; the other columns 
are optional. 
See also: Editing Pins Table Data.

9. On the Attributes tab, add attributes as necessary.
See also: Defining Default Attributes for New Parts

10. On the Connector tab, add pin decals to be used in the schematic. 
See also: Assigning Special Symbols to a Connector.

11. Click OK.
See also: Part Type Error Checking

12. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics

Creating a New Part Type

Modifying Part Types
You use the Part Information dialog box to modify the properties of an existing part type. 

Accessing

• File menu > Library > select a Library > Parts button > select part > Edit button

When you have finished modifying the properties, click OK to save the changes.

See the following topics for more information:

• Assigning PCB Decals to Part Types

• Assigning CAE Decals to Gates

• Modifying the Pins Table Information

• Part Type Error Checking

• Adding and Modifying Part Type Attributes

• Assigning Special Symbols to a Connector

• Mapping Alphanumeric Pin Numbers to Numeric Decals

Assigning PCB Decals to Part Types
Filter your library search for decals and assign a decal and then alternates if desired.
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Procedure

1. On the PCB Decals tab, to filter the contents of the Unassigned Decals list, use any of 
the following:

a. In the Library list, select an individual library (or select All Libraries).

b. In the Filter box type wildcards.

Tip: Type asterisk * in the Filter box to display all decals.

c. Type a number in the Pin Count box, and then click Apply.

Tip: Delete all numbers in the Pin Count box to display all decals. This box is 
always available as a filter to allow decals of differing pin counts to be assigned.

d. Click the Show only Decals with pin numbers matching Part Type check box to 
filter out decals that do not have pin numbers matching existing gate and signal pins 
on the Pins tab, or the physical pin numbers on the Pin Mapping tab.

2. To assign one or more decals, select a decal in the Unassigned Decals list and click 
Assign. Assigned PCB decals can have a different number of pins.
To assign a decal that does not exist in a library, click Assign New. In the Assign New 
PCB Decal dialog box, type the name and then click OK.

Restrictions: 

• You can only assign up to 16 PCB decals to a part.

• You must assign a decal with enough pins for all the defined gate pins and signal 
pins on the Pins tab.

• Only decals with sequential numerical pin numbers can be used with pin mapping.

3. To change the order of decals in the Assigned Decals list, select the decal, and then click 
Up or Down.

Tip: The decal at the top of the list is the default decal and is used when you add the part 
to the design.

Related Topics

Creating a New Part Type

Assigning CAE Decals to Gates
Type the name of a CAE Decal or use the Assign Decal to Gate dialog box to assign default and 
alternative CAE decals to gates.
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Procedure

1. Select the cell under CAE Decal 1 and click the Edit button or double-click the cell 
under CAE Decal 1.

2. Type a decal name in the CAE Decal box or click the “...” Browse button to search for a 
decal from a library. 

3. The Browse button opens the Assign Decal to Gate dialog box. To filter the contents of 
the Unassigned Decals list, use any of the following:

a. In the Library list, select an individual library (or select All Libraries).

b. In the Filter box, type wildcards.

Tip: Type asterisk * in the Filter box to display all decals.

c. Type a number in the Pin Count box, and then click Apply. This box is read-only 
after a decal is assigned.

Tip: Delete all numbers in the Pin Count box to display all decals. This box is 
always available as a filter to allow decals of differing pin counts to be assigned.

4. To assign one or more decals, select a decal in the Unassigned decals list and click 
Assign.
To assign a decal that does not exist in a library, click Assign New. In the Assign New 
Gate Decal dialog box, type the name and then click OK.

Restrictions:

• You can assign up to four CAE decals to a part.

• Assigned decals must have the same number of pins.

5. To change the order of decals in the Assigned Decals list, select the decal, and then click 
Up or Down.

Tip: The decal at the top of the list is the default decal and is used when you add the part 
to the schematic.

6. Assign Gate pins on the Pins tab.

Related Topics

Creating a New Part Type

Modifying Gates in Parts in the Library in the Concepts Guide

Modifying the Pins Table Information
In this section:
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• Adding a Series of Pins to the Pins Table

• Editing Pins Table Data

• Renumbering Pins in the Pins Table

Adding a Series of Pins to the Pins Table
You can use the Add Pins dialog box to add a series of pins the Pins table instead of adding one 
pin at a time.

Procedure

1. On the Pins tab of the Part Information dialog box, click the Add Pins button.

2. In the Add Pins dialog box, type the number of pins to add in the Number of pins box.

Tip: Total pins for the part can not exceed 32,767 pins.

3. In the Start pin number area, type values in the Prefix and/or Suffix boxes. A preview of 
pin numbers based on your input is displayed below the boxes.

Tips: 

• Alphabetic and numeric values can be used in either box. For example, A1 or 1A. If 
you type alphanumerics and the decal uses numerics, you must use the Pin Mapping 
tab to map the alphanumerics onto the decal.

• For a single numeric, use either Prefix or Suffix box, and void the other box.

4. In the Increment options area, choose what to increment by clicking either Increment 
prefix or Increment suffix.

5. In the Step value box, type a positive or negative number by which to increase or 
decrease the pin numbers with consecutive or stepped values.

6. If using alphanumerics, you can select the Use JEDEC pin numbering check box to 
ensure that legal alphanumeric values are used.

Related Topics

Creating a New Part Type

Editing Pins Table Data
You can click a cell in the row of the pin you are editing to edit the cell contents, or select one or 
more cells of the same column and click the Edit button.
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Procedure

1. Click the Pin Group cell and in the list, choose from gate, signal pin, or unused pin. 
Gates listed in the Pin Group cell list are added using the Gates tab. Signal pins require a 
signal name in the Name cell.

2. Click the Number cell and type a pin number for the pin.

Requirement: The pin number must match the PCB decal. For example, alphanumeric 
to alphanumeric.

Tip: Pin numbers can be either numeric or alphanumeric. Prior to PADS2007, 
alphanumeric pin numbers were not legal on the PCB decal but overlaid the numeric 
decal numbers, and were stored within the Part Type. You can continue to keep numeric 
PCB decals and use the Pin Mapping tab to overlay different pin numbers onto the 
numeric PCB decal pin numbers.

3. Click the Name cell and type a pin signal or function name. For example, “Clock” or 
“CLK.” A pin name is not required. The Name column is not used for unused pins. 

Restriction: Gate pin names can contain up to 40 characters, while signal pin names can 
contain up to 47. All alphanumeric characters are accepted. You cannot use special 
characters such as question marks ?, curly braces { }, asterisks *, periods ., commas , , or 
spaces.

4. Click the Type cell and in the list, choose a pin type. The type column is only used with 
gate pins.

5. Click the Swap cell and type a swap number, or use the up/down arrows.

Tip: You swap pins within gates to uncross connections and facilitate routing. Pins with 
like numbers can swap within a gate. Type 0 to disable swapping.

6. Click the Sequence (Seq.) cell and type the gate sequence number. The sequence 
number determines the mapping of CAE gate pins to PCB decal pins. The sequence is 
automatically shared with alternate CAE decals. For example, it shows how pin numbers 
appear on the CAE gate decal; therefore, in Gate A, sequence number 1 could be pin 1, 
but in Gate B, sequence number 1 would be pin 4.

Exception: When editing pin data for connectors, only the Pin Group and Number columns are 
relevant. Data entered in other columns is rejected. Connectors don’t have gates, so the Pin 
Group column just indicates whether a pin is a connector pin or an unused pin.

Related Topics

Creating a New Part Type

Renumbering Pins in the Pins Table
You can renumber pins in the Pin tab table.
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1. Select one or more cells in the Number column.

2. Click the Renumber button. In the Renumber Pins dialog box, the Number of pins box 
displays the number of pins selected for renumbering.

3. In the Start pin number area, type values in the Prefix and/or Suffix boxes. A preview of 
pin numbers based on your input is displayed below the boxes.

Tips: 

• Alphabetic and numeric values can be used in either box. For example, A1 or 1A.

• For a single numeric, use either Prefix or Suffix box, and void the other box.

4. In the Increment options area, choose what to increment by clicking either Increment 
prefix or Increment suffix.

5. In the Step value box, type a positive or negative number by which to increase or 
decrease the pin numbers with consecutive or stepped values.

6. If using alphanumerics, you can select the Use JEDEC pin numbering check box to 
ensure that legal alphanumeric values are used.

Related Topics

Creating a New Part Type

Part Type Error Checking
When you click Check Part, OK, Save As, or when you click a different tab, validation occurs 
and checks for the following error conditions:

• Empty pin numbers or pin numbers with embedded spaces or illegal characters. 
Duplicated Pin numbers

• Empty, duplicated, or non-sequential sequence numbers within a single gate

• Non-empty Type cells for signal pins or unused pins, or empty Type cells for gate pins

• Pin names with illegal characters for gate pins, net names with illegal characters for 
signal pins, non-empty name for unused pins, empty name for signal pins. Blank pin 
names are permitted for gate pins.

• Empty pin swap for gate pins, non-empty pin swap for signal and unused pins. Pin swap 
values for gate pins outside of the range 0 to 100.

Related Topics

Creating a New Part Type
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Adding and Modifying Part Type Attributes
In this section:

• Adding Attributes to a Part Type

• Adding Height Information to Library Parts

• Defining Default Attributes for New Parts

Adding Attributes to a Part Type
You can add attributes to a part type.

Procedure

1. In the Part Information dialog box, click the Attributes tab.

2. Click Add to add a new attribute row.

3. Type the new attribute name and value.

Alternative: Click the Browse Lib Attr button to select an existing attribute from a 
list.

4. Repeat Steps 2 and 3 to add additional attributes.

Adding Height Information to Library Parts
You can add height information to part types. Height information is used to prevent components 
being placed in height-constrained areas. It is also used when a design is exported to a 3-
dimensional modeling application.

Procedure

1. In the Part Information dialog box, click the Attributes tab.

2. Click Add to add a new attribute row.

3. For the new attribute name type Geometry.Height.

Alternative: Click the Browse Lib Attr button to select Geometry.Height from a 
list.

4. Type the value in current design units.

Defining Default Attributes for New Parts
You can save a default set of attributes to automatically use for each new part.

Restriction: Attribute names but not values are saved in the default attribute list.
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Procedure

1. In the Part Information dialog box, click the Attributes tab.

2. Once the list of attributes is correct, click Save As Default.

Result

The default attribute list is saved to 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Settings\defaultattribute.txt, which is 
shared between PADS Logic and PADS Layout.

Related Topics

Managing Library Attributes

Creating a New Part Type

Assigning Special Symbols to a Connector
Use the Browse for Special Symbols dialog box to assign one or more pin decals, or Special 
Symbols, to a connector. This allows you to use any of the special symbols as alternate pins of 
the connector. Instead of being displayed as a single symbol, the connector is broken up into 
individual pin symbols in the schematic. You can place the pins all together, or wherever you 
like on a single page or even across multiple pages.

Procedure

1. Part Information for Part dialog box > Connector tab.

2. To filter the Gate Decals list, select a library in the Library list, type wildcards in the 
Filter box, and then click Apply.

Tip: To display all items, type asterisk * and click Apply.

3. Select the item in the list.

4. Click OK.

Related Topics

Creating a Connector Part Type

Creating a New Part Type

Mapping Alphanumeric Pin Numbers to Numeric Decals
There are several ways to complete the pin mapping.
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Procedure

1. In the decal list above the preview window, select the assigned decal to which you want 
to map alphanumeric pins.

2. Map the pins using one of the following methods

• Using the Unmapped Pins list—In the Unmapped Pins list, select one or more 
alphanumerics. Select one or the starting row in the Part Type column if you have a 
consecutive list to map. Click Map.

• Using the Part Type column—Select a cell in the Part Type column and click the 
Edit button, or simply double-click the cell. Then type a pin number. The pin 
number is removed from the Unmapped pins list.

• Using the Preview Window—Select an alphanumeric in the Unmapped Pins list 
and double click the pin in the decal preview window to map the alphanumeric to the 
pin. The next row in the Unmapped Pins list becomes the next selected alphanumeric 
for mapping.

Tip: In the preview window, you can click and drag to define a zoom box, or use 
Shift+click or Shift+right-click to zoom in or out by a factor of two. You can zoom 
in up to 16X the original scale. The preview window will only zoom out to fit the 
decal entirely in the view.

• Using a Spreadsheet Application—Click Copy Map to copy both columns of the 
mapping table. Paste the mapping table into Excel. Make mass edits. Copy the data 
from Excel and click Paste Map on the Pin Mapping tab.

Restrictions: Copy Map and Paste Map only work with the whole pin mapping table 
and not selective rows.

3. Repeat as necessary.

Related Topics

Creating a Part Type with Different Schematic and Layout Pin Numbering

Creating a New Part Type

Saving Modified Decals and Parts to Libraries
Use the Save Part Types and Decals to Library dialog box to save modified decals or parts to 
libraries.

Procedure

1. Modify the decal or part in the PCB Decal Editor, and then return to the Layout Editor.

2. Select the components, right-click, and then click Save to Library.
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3. Select items in the Part Types and Decals lists.

Tip: If you created a new suffixed decal, meaning you changed the pad stack for one 
component only and the decal name has a unique suffix, the new decal also appears in 
the Decals list.

4. Select libraries to receive the information in the Part Type Library and Decal Library 
lists.

5. Click OK.

Related Topics

Creating a Basic Decal Automatically

Creating a Library

Importing and Exporting Libraries
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Chapter 7
Working with the BGA Toolkit

To Add a BGA Pin Label
Use the Add BGA Pin Labels dialog box to label the die part's substrate bond pad. Usually 
labels match the name of the BGA pin to which they are connected.

Tips: 

• You can select the pads individually, by group, or by die part. 

• Selecting a die part lists all pins in the Connection multicolumn list.

• The substrate bond pad of the selected die part is highlighted in the Die Pin# column. 
The BGA pin labels are listed in the BGA Pad column.

To add a BGA pin label to a die part's substrate bond pad:

1. BGA Toolbar button > Wire Bond Diagram button > select a BGA pin.

2. Select the Show only pins connected to multiple BGA pads check box to display only 
die pins that are connected to multiple BGA pin pads in the Connection multicolumn 
list.

3. In the Font list, select the font you want to use. 

Tips:

• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any combination of styles: 
B for bold, I for italic, or U for underlined.

4. In the Layer list, select the layer on which you want the BGA pin label.

5. In the Size box, type the size you want to use.

6. For stroke font, type the line width you want to use.

7. Click OK.

To Add Wire Bonds
You can add individual wire bonds only in the Wire Bond Editor. See “Using the Wire Bond 
Editor” for more information. You can add wire bonds to your design at any time, but you 
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cannot place a wire by itself without bond pads. The bond pads must exist before you create a 
new wire bond.

Restriction: This information applies only to the BGA toolkit.

To add a new wire bond between pads:

1. Select Add WB on the shortcut menu when nothing is selected, or when a substrate or 
component bond pad is selected. The new wire bond dynamically attaches to the cursor.

2. Indicate the location at which to place the new wire by clicking on one substrate bond 
pad and one component bond pad.

Tip: You can attach more than one substrate bond pad to a component bond pad, and vice versa.

To create wire bonds and substrate bond pads for a new die, use the Wire Bond Wizard. 

See also: Wire Bond Wizard Dialog Box

To Add Component Bond Pads
You can add component bond pads only in the Wire Bond Editor.

Restriction: This information applies only to the BGA toolkit.

See also: Using the Wire Bond Editor

To add a component bond pad:

1. With nothing selected, select Add CBP on the shortcut menu. The Add Component 
Bond Pad dialog box appears. 

2. Enter the values for the new bond pad and click Add. The new bond pad dynamically 
attaches to the cursor. 

3. Indicate the location at which to place the new pad.

To Add a Connection in BGAs
You can add connections manually or automatically. To automatically add connections, see 
Using the PADS Layout Route Wizard.

Restriction: This information applies only to the BGA toolkit.

To manually add a connection between pin pairs:

1. BGA Toolbar button > Add Connection button.
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2. Select the first pin in the connection.

3. Select the second pin in the connection.

If this pin is part of a different net or Derive Net Name from Pin Function is on, a 
prompt asks you to provide a new name for the combined nets.

See also: Predefined Netnames in the Concepts Guide

4. Type a new name for the combined nets, if necessary.

To Add Die Parts from LIQ
Restriction: This information applies only to the BGA toolkit.

To add die parts from Library IQ:

1. BGA Toolbar button > Add Die Parts button

The Add Die Parts dialog box appears.

2. Type the path to the folder where the die parts are located or use Browse to search for 
the folder. Select the die part on the Die Part list box. The die part appears in the 
preview area. The filename, modification date, number of chip bond pads, number of 
substrate bond pads, and number of wire bonds appear to the right of the preview area.

3. Click Add. The die part appears in the Die Part Type column.

4. Repeat steps 2 and 3 to add additional die parts.

5. Set the Die Data options as required.

6. Click OK.

To remove a die part from the Die Part Type column:

1. Select the die part in the Die Part Type column.

2. Click Remove.

For information on exporting die component data to Library IQ, see “To Synchronize Die Parts 
with LIQ.”

To Add a Fanout
Adding a fanout adds a new substrate bond pad to the design and automatically connects it to 
the component bond pad with a wire bond.

Restriction: This information applies only to the BGA toolkit.

To add a fanout in the Wire Bond Editor:
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1. Select a component bond pad > right-click > Add Fanout.

2. Enter the values for the new bond pad and click Add on the dialog box. The new wire 
bond and bond pad dynamically attaches to the cursor. (Add Fanout simultaneously 
creates a new wire bond and a new substrate bond pad.)

3. Indicate the location at which to place the new fanout.

To Add a Part in the BFA Toolkit
Restriction: This information applies only to the BGA toolkit.

To import and add a new component to a design:

1. BGA Toolbar button > Add Component button.

2. In the Get Part Type From Library dialog box select the part name in the Part Types list 
and click Add. The component attaches to the pointer.

3. Click Close to close the dialog box.

4. Move the part to the new location and indicate the new position. The new part is 
automatically annotated with the next available reference designation.

To Add Substrate Bond Pads
You can add substrate bond pads only in the Wire Bond Editor.

Restriction: This information applies only to the BGA toolkit.

See also: Using the Wire Bond Editor

There are two methods that you can use to add a substrate bond pad to your design:

Method 1

1. Select Add SBP on the shortcut menu when nothing is selected. The Add Substrate 
Bond Pad dialog box appears. 

2. Enter the values for the new bond pad and click Add on the dialog box. The new bond 
pad dynamically attaches to the cursor. 

3. Indicate the location at which to place the new pad.

Method 2

1. Select Add Fanout on the shortcut menu when a component bond pad is selected. The 
Add Substrate Bond Pad dialog box appears. 
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2. Enter the values for the new bond pad and click Add on the dialog box. The new wire 
bond and bond pad dynamically attaches to the cursor. (Add Fanout simultaneously 
creates a new wire bond and a new substrate bond pad.)

3. Indicate the location at which to place the new fanout.

Adding Routes in BGAs
Restriction: This information applies only to the BGA toolkit.

Note: When routing while the BGA toolbar is open, the pointer changes to a bull's-eye when it 
is near any eligible completion point, regardless of the net.

To manually enter routes that add to or change the current netlist:

1. BGA Toolbar button > Add Route button.

2. Select the pin on which to start the trace.

3. Add corners and vias as described in “Routing Manually.”

4. Select the pin on which to end the trace.

If this pin is part of a different net or Derive Net Name from Pin Function is on, a 
prompt asks you to provide a new name for the combined nets.

See also: Predefined Netnames in the Concepts Guide

If this pin is not part of the same net or has no netlist, all items are considered obstacles. 
To connect to the pin, right-click and click Select Target and select the pin on which 
you want to end the trace.

5. Netnames are automatically generated for each newly created connection or route.

Type a new name for the combined nets, if necessary.

Note: You can also add routes automatically using the BGA Route Wizard.

To Adjust Focus for a Substrate Bond Pad
Adjusting focus realigns the substrate bond pad to the component bond pad after a move or 
rotation.

Restriction: This information applies only to the BGA toolkit.

To adjust focus for a substrate bond pad in the Wire Bond Editor:

1. Select the SBP. 

2. Right-click to display the shortcut menu.
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3. Select Adjust Focus.

To Assign CBPs to Rings
Restriction: This information applies only to the BGA toolkit.

To assign a component bond pad or pads to a ring or rings:

1. In the Assign CBPs to Rings dialog box, select the component bond pads that you want 
to assign to rings.

2. In the Assign to list, check the ring or rings to which you want to assign the selected 
component bond pad or pads.

3. Click Apply.

To Cancel the Connection Function
Restriction: This information applies only to the BGA toolkit.

To cancel the connection function when using Add Connection on the BGA toolbar:

1. Right-click to display the shortcut menu.

2. Click Cancel.

Checking Wire Bond Rules
Restriction: This information applies only to the BGA toolkit.

If in DRC On mode, the wire bond rules are checked along with other design rules (pad to pad, 
pad to trace, etc.). In case of DRC errors, a message appears on the status bar.

Most of the die modification operations, such as moving bond pads or adding wire bonds, check 
wire bond rules on-the-fly. During an operation, any unsatisfied rule results in a violation, and 
error marker appears at the cursor's current location.

Additionally, you can run wire bond rule batch checking at any time. 

See also: Verify the Design

To Copy Component Bond Pads
You can copy component bond pads only in the Wire Bond Editor.

Restriction: This information applies only to the BGA toolkit.
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See also: Using the Wire Bond Editor

To make a copy of an existing bond pad:

1. Select the bond pad to copy.

2. Select Copy on the Edit menu, or press Ctrl+C.

Or

Select Copy on the shortcut menu. The copy of the bond pad attaches to the cursor.

3. Indicate the position of the new bond pad.

The new bond pad is automatically annotated with the next available pin name.

Tip: Creating a copy of an existing substrate bond pad is not considered an engineering change 
and therefore does not require ECO mode.

To Copy Substrate Bond Pads
You can copy substrate bond pads only in the Wire Bond Editor.

Restriction: This information applies only to the BGA toolkit.

See also: Using the Wire Bond Editor

To make a copy of an existing bond pad:

1. Select the bond pad to copy.

2. Select Copy on the Edit menu, or press Ctrl+C.

Or

Select Copy on the shortcut menu. The copy of the bond pad attaches to the cursor.

3. Indicate the position of the new bond pad.

The new bond pad is automatically annotated with the next available pin name.

To Copy and Paste a Route in BGAs
You can reproduce repetitive routing patterns by creating a segment pattern, copying it, and 
pasting it on any similar connections. Layer changes and vias in the route are included in the 
selection. Memory patterns or SMD fanouts are ideal applications for copied routes.

Restriction: This information applies only to the BGA toolkit.

To copy and paste a route:
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1. Select a segment or pin pair > Edit menu > Copy.

Result: All included segments and vias are copied and attached to your pointer in Move 
mode.

2. Use the shortcut menu commands to rotate or flip the copy.

3. To place the copy, position it so that it joins the pins you want to paste to and click. A 
copy is pasted and another copy remains attached to the pointer so you can continue 
pasting.

The pointer automatically snaps to a point the same distance, and in the same direction, 
as the last placement. This makes it easy to install repetitive route patterns.

4. When you finish pasting, press Esc.

See also: To Copy and Paste Trace Patterns

Copying Routes Creates New Netnames
Any time a route pattern is copied and the end points of the copied route terminate on 
unconnected pins, a pin pair is created between the pins. A new netname is automatically 
assigned in the format $$$1 or $$$2. You can also assign predefined net names using the gate 
pin name assigned to the part. 

See also: Predefined Netnames in the Concepts Guide

To Create a BGA Design
Restriction: This information applies only to the BGA toolkit.

The following steps outline the basic workflow for creating a BGA design:

1. Use the Die Wizard to create a die and add it to the design.

See also: To Create a New Die

2. Create and add a BGA decal using the PCB Decal Editor and the BGA/PGA tab in the 
Pin Wizards dialog box. Click Substrate Decal Type.

See also: BGA/PGA Tab, Pin Wizard

3. Add the ball grid array to the design. You must add the BGA part to the BGA design. 

See also: To Add a Part in the BFA Toolkit

4. Create a substrate outline by clicking the Board Outline and Cut Out button on the 
Drafting toolbar.

5. Use the Wire Bond Wizard to define rings, establish wire bond rules, assign chip bond 
pads, and generate a wire bond fanout.
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See also: Wire Bond Wizard Dialog Box, To Define Wire Bond Rules, To Assign CBPs 
to Rings, and To Create a Wire Bond Fanout

6. Reposition any die component's substrate bond pads or edit the die part's objects using 
the Wire Bond Editor.

See also: To Move Bond Pads, To Edit Component Bond Pads, and To Edit Substrate 
Bond Pads

7. Check the wire bonds for conformance to wire bond rules.

See also: Checking Wire Bond Rules

8. Add the traces between the die part's substrate bond pads and the BGA pin pads using 
Add Route on the BGA toolbar or the BGA Route Wizard.

See also: Adding Routes in BGAs, Using the BGA Route Wizard

9. Create the die flag and power rings information using the Die Flag Wizard.

See also: To Create a Die Flag and Rings

10. Add BGA pin labels to a die part's substrate bond pads using Wire Bond Diagram on 
the BGA toolbar.

See also: To Add a BGA Pin Label

Related Topics

BGA Operations in the Concepts Guide

The BGA Tutorials. Click Help menu > Tutorial > PADS Layout Advanced Packaging Tutorial

To Create a Die Flag and Rings
Restriction: This information applies only to the BGA toolkit.

The die flag serves the following conductive and bonding functions for the die:

• Connecting to the back-based die, typically the ground

• Providing a heat sink and a pathway for heat dissipation

• Mounting the die to the substrate

One or more rings that typically provide power connections may surround the die flag. The 
rings may also have other purposes, for example, serving as ground connections or signal rings.

To create a die flag and rings:

1. Click the BGA Toolbox button on the toolbar.

2. Click Die Flag on the BGA toolbar.
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3. Select a die component.

4. Make the appropriate selections as found in Die Flag Wizard Dialog Box.

5. Click Create to create the die flag and exit the Die Flag Wizard.

See also: Die Flag Wizard in the Concepts Guide

To Create a New Die
Restriction: This information applies only to the BGA toolkit.

To create a new die:

1. BGA Toolbar button > Die Wizard button.

2. In the Create Die dialog box, click either From Text File, Parametrically, or From 
GDSII File to begin creating a die.

3. For the procedure to create:

• A die by importing a text (.csv) file, see “To Create a Die from a Text File.”

• A die from specifications you enter, see “To Create a Die Parametrically.”

• A die by importing a GDSII file, see “To Create a Die from a GDSII File.”

To Create a Die from a Text File
Restriction: This information applies only to the BGA toolkit.

To create a die from a text file:

1. BGA Toolbar button > Die Wizard button.

2. Click From Text File to display the Die Wizard-Create from Text File dialog box.

3. Click Browse and select a text (.csv) file to open.

4. Optionally:

• In Die Part Type, change the name of the type of die part you want to use to create 
the die.

• Select Flip Chip to select the IC die for facedown mounting. Flip chip components 
contain only pins (SBPs).

• Select Mirror Shapes (if you clicked Flip Chip) to mirror, or flip, the shapes (die 
geometrical data) on the die display.

• Set preview colors.
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5. Add or modify data on the five tabs. See:

• To Define a Die Outline for the Die Data from a Text File.

• To Modify CBP Shapes from a Text File.

• To Modify the Numbering of CBPs from a Text File.

• To Define Functions for Pads from a Text File.

• To Define Preferences for Die Component Creation.

To Create a Die Parametrically
Restriction: This information applies only to the BGA toolkit.

To create a die parametrically:

1. BGA Toolbar button > Die Wizard button.

2. Click Parametrically to display the Die Wizard-Create Parametrically dialog box.

3. In Die Part Type, type the name of the type of die part you want to use to create the die.

4. Optionally:

• Select Flip Chip to select the IC die for facedown mounting. Flip chip components 
contain only pins (SBPs).

• Select Mirror Shapes (if you clicked Flip Chip) to mirror, or flip, the shapes (die 
geometrical data) on the die display.

• Select the global unit type to use to convert system units into a commonly used set of 
measurements. All values are expressed on the die display in the units you choose. 
Available unit types are: 

Mils — Expressed in mils (1mil = 2.54*10^-5 m). 

Metric — Expressed in millimeters (1mm = 1.0*10^-3 m). 

Inches — Expressed in inches (1" = 2.54*10^-2 m).

Tip: You cannot choose Microns to use as system units. Use Metric if the values in 
the imported file are expressed in microns.

• Set the preview colors.

5. Add or modify data on the five tabs. See:

• To Define a Die Outline Parametrically.

• To Define a Set of CBPs Parametrically.

• To Define the Numbering of CBPs Parametrically.
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• To Define Functions for Pads Parametrically.

• To Define Preferences for Die Component Creation.

To Create a Die from a GDSII File
Restriction: This information applies only to the BGA toolkit.

To create a die from a GDSII file:

1. BGA Toolbar button > Die Wizard button.

2. Click From GDSII File to display the Die Wizard-Create from GDSII File dialog box.

3. Click Browse and select a GDSII (.gds) file to open.

4. Optionally:

• Change the size of GDS units (microns).

Tip: Because GDSII files come in different “flavors,” you may need to adjust the 
unit settings in the file.

• In Die Part Type, change the name of the type of die part you want to use to create 
the die.

• Select Flip Chip to select the IC die for facedown mounting. Flip chip components 
contain only pins (SBPs).

• Select Mirror Shapes (if you clicked Flip Chip) to mirror, or flip, the shapes (die 
geometrical data) on the die display.

• Select the global unit type to use to convert system units into a commonly used set of 
measurements. All values are expressed on the die display in the units you choose. 
Available unit types are:

Mils — Expressed in mils (1mil = 2.54*10^-5 m). 

Metric — Expressed in millimeters (1mm = 1.0*10^-3 m)

Inches — Expressed in inches (1" = 2.54*10^-2 m).

Tip: You cannot choose Microns to use as system units. Use Metric if the values in 
the imported file are expressed in microns.

• Set your preview colors.

5. Add or modify data on the five tabs. See:

• To Define a Die Outline from a GDSII File.

• To Define a Set of CBPs from a GDSII File.
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• To Define the Numbering of CBPs from a GDSII File.

• To Define Functions for Pads from a GDSII File.

• To Define Preferences for Die Component Creation.

To Create a Wire Bond Fanout
Use the Wire Bond Wizard to create a wire bond fanout. 

Restriction: This information applies only to the BGA toolkit.

See also: Wire Bond Wizard in the Concepts Guide

1. Select a die component > Wire Bond Wizard button.

2. Use the Wire Bond Wizard dialog box to define settings for creation of the wire bond 
fanout. 

See also: Wire Bond Wizard Dialog Box

The settings you define include:

• Geometry of the SBP Guides.

See also: SBP Guides in the Concepts Guide

• Assignment of component bond pads to SBP rings 

• Wire bond preferences for the SBP rings, wire bond width, and substrate bond pad 
offset 

• Preferred spacing for the substrate bond pad and the wire bond to substrate bond pad 
spacing

3. To preview the wire bond fanout that corresponds to your settings, click Preview 
Fanout.

4. When you are satisfied with the fanout design, click Create Fanout to save the fanout in 
the design.

To Create a Wire Bond Report
You can create a report of connections between a die part's substrate bond pads and the BGA 
pads using a Basic script provided with PADS Layout.

Restriction: This information applies only to the BGA toolkit.

• Open the Basic Scripting dialog box and click Wire Bond Report.

See also: Basic Scripts Dialog Box
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To Cycle a Bond Pad
Restriction: This information applies only to the BGA toolkit.

To cycle, or select a bond pad on a different layer, in the Wire Bond Editor:

1. Select the bond pad.

2. Right-click to display the shortcut menu.

3. Select Cycle.

To Cycle Through Wire Bonds
Restriction: This information applies only to the BGA toolkit.

To cycle through wire bonds in close proximity in the Wire Bond Editor:

1. Select the wire bond. 

2. Right-click to display the shortcut menu.

3. Select Cycle.

To Define a Die Outline for the Die Data from a 
Text File 

The text file format does not contain the description of the die outline. After the Die Wizard 
obtains all the data from the text file, the die outline is calculated automatically as an extent box 
that covers all of the CBPs from the text file. You can modify this automatically-generated die 
outline using the Die Size tab.

Restriction: This information applies to only the BGA toolkit.

To define a die outline for the die data from a text file:

1. Follow the directions in “To Create a Die from a Text File.”

2. Type or change values in the following fields:

Die Size Length — The length of the die, which corresponds to the X size.

Die Size Width — The width of the die, which corresponds to the Y size.

Die Size Height — The height of the die, which defines the thickness of the die.

Die Outline Base Point — The die point (center, lower left, upper left, upper right, or 
lower right) for which you want to specify the coordinates for the base point, as 
expressed in X and Y.
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X — The die point along the x-axis you want as the base point for X.

Y — The die point along the y-axis you want as the base point for Y.

3. Add or modify data on the remaining tabs, if necessary. See:

• To Modify CBP Shapes from a Text File.

• To Modify the Numbering of CBPs from a Text File.

• To Define Functions for Pads from a Text File.

• To Define Preferences for Die Component Creation.

4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Define a Die Outline from a GDSII File
Restriction: This information applies only to the BGA toolkit.

To define a die outline from a GDSII file:

1. Follow the directions in “To Create a Die from a GDSII File.”

2. Select the Die Size tab and either set the die size and die outline position manually, or 
Select a GDS shape representing the die outline.

Tip: You can modify the Height control when you click Select from GDS Shape, but 
you cannot modify the other parameters in the Set Size area. 

• To set the die outline manually, click Set Size. Type or select values in the following 
fields:

Die Size Length — The length of the die, which corresponds to the X size.

Die Size Width — The width of the die, which corresponds to the Y size.

Die Size Height — The height of the die, which defines the thickness of the die.

Die Outline Base Point — The die point (center, lower left, upper left, upper right, 
or lower right) for which you want to specify the coordinates for the base point, as 
expressed in X and Y.

X — The die point along the x-axis you want as the base point for X.

Y — The die point along the y-axis you want as the base point for Y.

• If you click Select from GDS Shape, specify the shape from the GDSII file to use as 
the die outline by selecting values in the following fields:

GDS Layer — Shows the layers defined in the GDSII file. Use to select the layer on 
which the die outline shape is located.
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GDS Shape — Shows the names of all the GDS shapes available for selection as the 
die outline shape. Only closed, filled shapes from the GDSII file that are also on the 
selected layer in the GDS Layer list appear.

The shapes appear in the die display area using the Shapes on Selected Layer color. 
The die display adjusts dynamically as you choose values, to help you select the 
proper shape.

3. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Set of CBPs from a GDSII File. 

• To Define the Numbering of CBPs from a GDSII File. 

• To Define Functions for Pads from a GDSII File. 

• To Define Preferences for Die Component Creation. 

4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Define a Die Outline Parametrically
Restriction: This information applies to only the BGA toolkit.

To define a die outline parametrically:

1. Follow the directions in “To Create a Die Parametrically.”

2. Type or change values in the following fields on the Die Size tab:

Die Size Length — The length of the die, which corresponds to the X size.

Die Size Width — The width of the die, which corresponds to the Y size.

Die Size Height — The height of the die, which defines the thickness of the die.

Die Outline Base Point — The die point (center, lower left, upper left, upper right, or 
lower right) for which you want to specify the coordinates for the base point, as 
expressed in X and Y.

3. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Set of CBPs Parametrically. 

• To Define the Numbering of CBPs Parametrically. 

• To Define Functions for Pads Parametrically. 

• To Define Preferences for Die Component Creation. 

4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”
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To Define a Set of CBPs from a GDSII File
Use the CBP tab to filter the GDS shapes you want to become the CBP shapes. You can filter 
shapes by size, by layer, and by position relative to the die outline.

Restriction: This information applies only to the BGA toolkit.

Tip: Only closed, filled shapes from the GDSII file (BOUNDARY and RECT GDS types) are 
available.

To define a set of CBPs from a GDSII file:

1. Follow the directions in “To Create a Die from a GDSII File.”

2. Type or select data in the following fields:

Min Size — Sets the minimum size you want to use to filter GDS shapes for CBPs, 
expressed in the current system units.

Max Size — Sets the maximum size to use to filter GDS shapes for CBPs.

GDS Layer — Shows the layers defined in the GDSII file. Select the layer on which the 
die outline shape is located.

3. Click Shapes Inside Outline to include only the shapes found inside the die rectangle for 
the filtering.

4. Select the pad shape.

Depending on the Pad Shape value (rectangular or oval), the circumscribed shape is 
used to derive the CBP shape from the GDS shape.

5. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline from a GDSII File. 

• To Define the Numbering of CBPs from a GDSII File. 

• To Define Functions for Pads from a GDSII File. 

• To Define Preferences for Die Component Creation. 

6. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Define a Set of CBPs Parametrically
Restriction: This information applies only to the BGA toolkit.

To define a set of CBPs parametrically:
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1. Follow the directions in “To Create a Die Parametrically.”

2. Do one of the following on the CBP tab:

• Specify the total pad count and allocate a fixed percentage of the pads as ground and 
power pads in GND % and PWR %, as follows:

Total — Type or select the total pad count for the die. If you modify the total pad 
count, the pads are evenly distributed along the four sides.

GND % — Type or select the percentage of the total pin count to allocate as ground 
pads. If you modify the value, the ground pads for each side are derived from the 
Total count.

PWR % — Type or select the percentage of the total pin count to allocate as power 
pads. If you modify the value, the power pads for each side are derived from the 
Total count.

• Enter the total pad count for each side and allocate a number of pads for each side as 
ground or power pads.

Total Pads — View or double-click to change the total number of pads for each side 
of the die. If you modify a value, the values in Total, GND %, and PWR % adjust 
accordingly.

GND — View or double-click to change the total number of ground pads for each 
side of the die. If you modify a value, the values in Total, GND %, and PWR % 
adjust accordingly.

PWR — View or double-click to change the total number of power pads for each 
side of the die. If you modify a value, the values in Total, GND %, and PWR % 
adjust accordingly.

3. Type or select data in the following fields:

Pad Pitch — Defines the distance between pads. The distance is measured from the 
left side of one pad to the left side of the next adjacent pad.

Row Pitch — Defines the distance between rows to control creation of staggered 
row patterns. For a single row in a straight line around the sides of the die, enter 0. 
To create staggered row patterns, enter a specific positive or negative number.

Distance from Die Edge — Defines the distance between the row of the pads and 
the die edge.

Pad Shape — Defines the shape of the pads: rectangle or oval.

Pad Length — Type or select the value for the pad length.

Pad Width — Type or select the value for the pad width. 

4. Add or modify data on the remaining tabs, if necessary. See:
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• To Define a Die Outline Parametrically. 

• To Define the Numbering of CBPs Parametrically. 

• To Define Functions for Pads Parametrically. 

• To Define Preferences for Die Component Creation. 

5. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Define Functions for Pads from a GDSII File 
You can import pad functions from a text file or from the GDS text on a layer.

Restriction: This information applies only to the BGA toolkit.

To define functions for pads from a GDSII file:

1. Follow the directions in “To Create a Die from a GDSII File.”

2. Select either From Text File or From GDS Texts on Layer to indicate which one you 
want to use to assign functions.

If you select From Text File, click Browse to select the file you want to use to assign 
pad functions.

If you select From GDS Texts on Layer, click the GDS layer you want to use to get the 
GDS text items which specify pad functions.

3. Click Assign to assign the pad functions.

4. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline from a GDSII File. 

• To Define a Set of CBPs from a GDSII File 

• To Define the Numbering of CBPs from a GDSII File. 

• To Define Preferences for Die Component Creation. 

5. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Define Functions for Pads from a Text File
Restriction: This information applies only to the BGA toolkit.

To define the functions for pads from a text file:
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1. Follow the directions in “To Create a Die from a Text File.”

2. Optionally, select the Pad Functions tab and change function names by double-clicking 
the one you want to change and typing the new name. 

3. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline for the Die Data from a Text File.

• To Modify CBP Shapes from a Text File.

• To Modify the Numbering of CBPs from a Text File.

• To Define Preferences for Die Component Creation.

4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”
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To Define Functions for Pads Parametrically
On the Pad Functions tab, the pads will obtain the following functions by default:

• Ground pins: <GND Pad Function>

• Power pins: <PWR Pad Function>

• Signal pins: <Signal Function Prefix><Pad #>

Restriction: This information applies only to the BGA toolkit.

To define functions for pads parametrically:

1. Follow the directions in “To Create a Die Parametrically.”

2. Optionally, on the Pad Functions tab, to edit the function of an individual pad, change 
function names by double-clicking the one you want to change and typing the new 
name. 

3. Optionally, to redefine functions for all pads, assign different function names to Signal 
Function Prefix, GND Pad Function, or PWR Pad Function using the Assign Functions 
area of the tab. Assign names as follows:

Signal Function Prefix — Type or view the function prefix you want to use to derive 
the signal pad names.

GND Pad Function — Type or view the function name you want to use for the ground 
pads.

PWR Pad Function — Type or view the function name you want to use for the power 
pads.

If you change the default signal function prefix or the power or ground function, click 
Assign to assign the new names to all pads.

4. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline Parametrically. 

• To Define a Set of CBPs Parametrically. 

• To Define the Numbering of CBPs Parametrically. 

• To Define Preferences for Die Component Creation. 

5. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”
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To Define Preferences for Die Component 
Creation

Restriction: This information applies only to the BGA toolkit.

To define preferences for creating die components from a text file:

1. Follow the directions in either To Create a Die from a Text File, To Create a Die 
Parametrically, or To Create a Die from a GDSII File.

2. Select the Die Prefs tab and select either Add Part to Design or Save to Library.

• To add the part to the design currently open, select Add Part to Design and type the 
part name. The part name is the reference designator that is automatically assigned 
to the new die component in the design. To change the reference designator, click on 
the part name and enter a new name.

• To add the part to a library, select Save to Library, then select the library in which 
you want to save the part.

3. Select the layer for the die outline and pads.

4. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline for the Die Data from a Text File.

• To Modify CBP Shapes from a Text File.

• To Modify the Numbering of CBPs from a Text File.

• To Define Functions for Pads from a Text File.

To Define the Numbering of CBPs from a GDSII 
File

Restriction: This information applies only to the BGA toolkit.

To define the numbering of CBPs from a GDSII file:

1. Follow the directions in “To Create a Die from a GDSII File.”
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2. Select the Pad # tab and select either circular or JEDEC numbering:

If you select Circular Numbering, select values for the following:

• Direction::

• Pad 1 Side:1

• Pad 1 Location:

3. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline from a GDSII File. 

• To Define a Set of CBPs from a GDSII File. 

• To Define Functions for Pads from a GDSII File. 

Circular Circular numbering

JEDEC JEDEC numbering
Pin rows are lettered from top to bottom starting with A 
and pin columns are numbered from left to right starting 
with 1. The letters I, O, Q, S, X, and Z are not used. For 
arrays with more than 20 rows, row 21 is designated AA 
and subsequent rows are designated AB, AC, etc.

Clockwise Numbering begins with pad 1 and continues in a 
clockwise direction.

CCW Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Left Places pad 1 on the left side of the design.

Top Places pad 1 on the top of the design.

Right Places pad 1 on the right side of the design.

Bottom Places pad 1 on the bottom of the design.

Center Numbers the center pad of the specified side of the design 
as pad 1.

Left Numbers the leftmost pad of the specified side of the 
design as pad 1.

Right Numbers the rightmost pad of the specified side of the 
design as pad 1.

Specify Numbers the pad you select on the specified side of the 
design as pad 1. Type or select the pad number you want 
to use for pad 1.
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• To Define Preferences for Die Component Creation. 

4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Define the Numbering of CBPs 
Parametrically 

Restriction: This information applies only to the BGA toolkit.

To define the numbering of CBPs parametrically:

1. Follow the directions in “To Create a Die Parametrically.”

2. Select the Pad # tab, then select either circular or JEDEC numbering:

If you select Circular Numbering, select values for the following:

• Direction::

• Pad 1 Side:1

• Pad 1 Location:

Circular Circular numbering

JEDEC JEDEC numbering
Pin rows are lettered from top to bottom starting with A 
and pin columns are numbered from left to right starting 
with 1. The letters I, O, Q, S, X, and Z are not used. For 
arrays with more than 20 rows, row 21 is designated AA 
and subsequent rows are designated AB, AC, etc.

Clockwise Numbering begins with pad 1 and continues in a 
clockwise direction.

CCW Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Left Places pad 1 on the left side of the design.

Top Places pad 1 on the top of the design.

Right Places pad 1 on the right side of the design.

Bottom Places pad 1 on the bottom of the design.

Center Numbers the center pad of the specified side of the design 
as pad 1.
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3. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline Parametrically. 

• To Define a Set of CBPs Parametrically. 

• To Define Functions for Pads Parametrically. 

• To Define Preferences for Die Component Creation. 

4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Define Wire Bond Rules
Each die part in a design has its own separate set of wire bond rules. If a rule is not set for the 
current die, the rule is not checked. Use the Wire Bond Rules Dialog Box to define wire bond 
rules for a die part.

Restriction: This information applies only to the BGA toolkit.

You can set wire bond rules for a die both in Layout Editor and in the Wire Bond Editor.

To set wire bond rules for the current die part in the Wire Bond Editor:

1. With nothing selected, select Wire Bond Rules on the shortcut menu. The Wire Bond 
Rules dialog box appears.

2. Enter values for the minimum and maximum length, maximum angle, and clearance or 
import the rule values from a Library IQ preset file.

To set wire bond rules for a die part in Layout Editor:

1. Select a substrate bond pad of a die and select Wire Bond Rules on the shortcut menu. 
The Wire Bond Rules dialog box appears.

2. Enter values for the minimum and maximum length, maximum angle, and clearance or 
import the rule values from a preset file.

Tip: Wire bond rules are saved with the design file. Also, if you save a die part to the library, 
the wire bond rules for the die part are saved for use in other designs.

Left Numbers the leftmost pad of the specified side of the 
design as pad 1.

Right Numbers the rightmost pad of the specified side of the 
design as pad 1.

Specify Numbers the pad you select on the specified side of the 
design as pad 1. Type or select the pad number you want 
to use for pad 1.
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To Delete a Bond Pad
Restriction: This information applies only to the BGA toolkit.

To delete a bond pad in the Wire Bond Editor:

1. Select the bond pad.

2. Right-click to display the shortcut menu.

3. Select Delete.

To Delete a Connection in BGAs
Use the Delete Connections button to delete a pin pair, disconnect a pin from a net, or split a 
net into two different nets. This also deletes any test point vias that belong to the deleted 
connection.

Restriction: This information applies only to the BGA toolkit.

To delete connections in a BGA:

1. BGA Toolbar button >Delete Connection button.

Tip: Test point vias that belong to the deleted connection are also deleted.

2. The following operations are available:

Note: The maximum netname length is 47 characters. You can use any alphanumeric characters 
except brackets {}, asterisks *, spaces, question marks, or commas.

To Delete a Net in BGAs
Restriction: This information applies only to the BGA toolkit.

Delete Pin Pair Select the connection or trace between the pin pair to 
delete it. If the net contains only one pin pair, selecting 
either pin deletes the pin pair.

Disconnect a Pin Select the pin to disconnect. If a net contains more than 
one pin pair, a prompt appears to confirm the 
disconnection, along with a check box to delete the route 
segment going to the pin.

Split a Net Select the connection between the pin pair where the net 
should be split.
If a Color by Net setting exists for a net that is split, the 
new net will use the same color setting.
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To delete all pin pairs and remove all pins from a net:

1. BGA Toolbar button > Delete Net button.

2. Select a pin, unrouted pin pair, trace, or via in the net to delete. A confirmation prompt 
appears.

3. Click Yes to proceed with the delete.

Test point vias that belong to the deleted net are also deleted.

To Delete a Wire Bond
Restriction: This information applies only to the BGA toolkit.

To delete a wire bond in the Wire Bond Editor:

1. Select the wire bond.

2. Right-click to display the shortcut menu.

3. Select Delete.

To Derive Net Name from Pin Function
The Derive Net Name from Pin Function command on the Add Connection shortcut menu is 
a toggle. When selected, it uses a pin's function as a basis for naming a new net when you are 
adding connections manually.

Restriction: This information applies only to the BGA toolkit.

To select or clear Derive Net Name from Pin Function when using Add Connection on the 
BGA toolbar:

1. Right-click to display the shortcut menu.

2. Select Derive Net Name from Pin Function to toggle the setting.

To Display Die Pins
Restriction: This information applies only to the BGA toolkit.

To display die pins that are connected to multiple BGA pin pads in the Connection 
multicolumn list:

1. BGA Toolbar button > Wire Bond Diagram button.
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2. Select the die part's substrate bond pad to which you want to add a BGA pin label. Select 
the pads individually, by group, or by die part. The Add BGA Pin Labels dialog box 
appears.

3. Double-click in the box next to the die pin number for which you want to view pad 
labels. The “…” Browse button appears.

4. Type the new label or click Browse. The Pads for Die Pin dialog box appears.

5. In the BGA Pad list, select the labels that you want to use.

6. Click OK. You return to the Add BGA Pin Labels dialog box.

7. Click OK.

To Edit Component Bond Pads
You can edit component bond pads only in the Wire Bond Editor. 

Restriction: This information applies only to the BGA toolkit.

See also: Using the Wire Bond Editor

Edit component bond pads using the CBP Properties dialog box or the shortcut menu.

To edit component bond pads:

1. Select the bond pad.

2. Right-click and click Properties. 

3. Modify the properties of the component bond pad, or Wire Bond rules, as needed.

To Modify a Decal in BGAs
Use Edit Decal to modify the decal of a selected part in the design.

Restriction: This information applies to only the BGA toolkit.

To modify the decal of a selected part:

1. Select a part > right-click > Edit Decal.

2. Modify the decal.

3. Click Exit Decal Editor from the File menu. The message “Do you want to apply the 
changes to all components with decal TMP or just the selected components?” appears in 
the dialog box.

4. Click All to replace all decals or Selected to replace selected decals.



Working with the BGA Toolkit
To Edit Substrate Bond Pads

PADS Layout User’s Guide and Reference Manual, PADS 9.4 255

To Edit Substrate Bond Pads
You can edit substrate bond pads using the SBP Properties dialog box or the shortcut menu.

Restriction: This information applies only to the BGA toolkit.

You can use the SBP Properties dialog box in Layout Editor and in the Wire Bond Editor.

To edit substrate bond pads:

1. Select the bond pad.

2. Right-click and click Properties. 

3. Modify the properties of the substrate bond pad, or the Wire Bond rules, as needed.

To Edit the Die Size
You can edit the size (outline) of a die only in the Wire Bond Editor.

Restriction: This information applies only to the BGA toolkit.

See also: Using the Wire Bond Editor

To edit the size of a die:

1. While in the Wire Bond Editor and with nothing selected, select Edit Die Size on the 
shortcut menu. The Edit Die Size dialog box appears.

2. Adjust the die size by typing or selecting values in Length, Width, and Height.

3. Click OK to apply the changes and close the dialog box.
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Editing Wire Bonds
You can edit wire bonds only in the Wire Bond Editor. 

Restriction: This information applies only to the BGA toolkit.

See also: Using the Wire Bond Editor

To Generate Connections
Restriction: This information applies only to the BGA toolkit.

See also: BGA Route Wizard dialog box

To generate connections only, or generate connections and routes:

1. BGA Toolbar button > Route Wizard button.

2. To generate connections only, click Generate Connections from the Action area of the 
BGA Route Wizard dialog box.

To generate connections and routes, click Generate Connections and Route from the Action 
area of the BGA Route Wizard dialog box.

1. If generating connections only, set strategy parameters and preferences on the 
Connections tab.

If generating connections and routes, set strategy parameters and preferences on the 
Routing tab.

2. On the Select Pads tab, set the pads to include in processing.

3. On the BGA Fanouts tab set the BGA fanout options.

4. Click Run to begin processing.

Result: When processing completes, the BGA Route Wizard report (brw_report.lst) appears.

You can interrupt processing by pressing Esc. If you interrupt processing, the message “Do you 
want to interrupt processing?” appears. You can:

• Click Undo changes to undo the changes made up to this point.

• Click to clear Undo changes to retain the current changes, but remove temporary single 
pin nets from the design.

• Click Open BGA Route Wizard Dialog to open the BGA Route Wizard when you 
click OK.

• Click Cancel to continue processing from the point at which you stopped.
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Related Topics

BGA Route Patterns in the Concepts Guide

To Import the SBP Functions
Restriction: This information applies only to the BGA toolkit.

Follow these steps to copy the values that you imported from the netlist file into the SBP 
Function column of the SBP Properties dialog box.

1. Click Derive from Netlist on the SBP Properties dialog box.

2. When the Load Netlist ASCII File dialog box appears, specify an input file for the 
substrate bond pad functions.

3. In the Derive SBP Function from Netlist dialog box, select a component from the Select 
Component list.

4. Click OK.

See also: Exporting an ASCII File

To Import Wire Bond Rules
Restriction: This information applies only to the BGA toolkit.

To import wire bond rules from Wire Bond Wizard:

1. On the Wire Bond Rules dialog box, click Import. This Imports wire bond rules saved in 
the Wire Bond Wizard dialog box from the Wire Bond Wizard Setup file, and assigns 
the values as rules for the currently open die part when you click OK in the Wire Bond 
Rules dialog box.

2. Select the rules file (.wbw file) you want to use.

To List All BGA Pin Labels
Restriction: This information applies only to the BGA toolkit.

To list all BGA pin labels in the Add BGA Pin Labels dialog box:

1. BGA Toolbar button > Wire Bond Diagram button.

2. Select the die part's substrate bond pad to which you want to add a BGA pin label. Select 
the pads individually, by group, or by die part. The Add BGA Pin Labels dialog box 
appears.
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3. Double-click the BGA Pad column of the Connection list and click the selection 
button.

4. In the Pads for Die Pin dialog box, select Apply to All.

5. Click Select All.

To List Specific BGA Pin Labels
Restriction: This information applies only to the BGA toolkit.

To list specific BGA pin labels in the Add BGA Pin Labels dialog box:

1. BGA Toolbar button > Wire Bond Diagram button.

2. Select the die part's substrate bond pad to which you want to add a BGA pin label. Select 
the pads individually, by group, or by die part. The Add BGA Pin Labels dialog box 
appears.

3. Double-click the BGA Pad column of the Connection list and click the selection 
button.

4. In the Pads for Die Pin dialog box, select Apply to All.

5. Select the pad positions in BGA Pad.

To Modify CBP Shapes from a Text File
Restriction: This information applies only to the BGA toolkit.

To modify CBP shapes from a text file:

1. Follow the directions in “To Create a Die from a Text File“

2. Either leave the pad shape as it is or change it on the CBP tab.

To change the pad shape, click Override Pad Shape, then type or change values in any or 
all of the Pad Shape, Pad Length, or Pad Width fields.

Tip: You cannot modify the shape of an individual CBP. The pad shape you choose on 
the CBP tab will apply to all CBPs.

3. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline for the Die Data from a Text File.

• To Modify the Numbering of CBPs from a Text File.

• To Define Functions for Pads from a Text File.

• To Define Preferences for Die Component Creation.
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4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Modify the Numbering of CBPs from a Text 
File

Restriction: This information applies only to the BGA toolkit.

To modify the numbering of CBPs from a text file:

1. Follow the directions in “To Create a Die from a Text File.”

2. Either leave the pad numbers as they are or change them on the Pad # tab. 

To change the pad numbers, click Override Pad Numbers.

Select either circular or JEDEC numbering:

If you select Circular Numbering, select values for the following:

• Direction::

• Pad 1 Side:1

• Pad 1 Location:

Circular Circular numbering

JEDEC JEDEC numbering
Pin rows are lettered from top to bottom starting with A 
and pin columns are numbered from left to right starting 
with 1. The letters I, O, Q, S, X, and Z are not used. For 
arrays with more than 20 rows, row 21 is designated AA 
and subsequent rows are designated AB, AC, etc.

Clockwise Numbering begins with pad 1 and continues in a 
clockwise direction.

CCW Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Left Places pad 1 on the left side of the design.

Top Places pad 1 on the top of the design.

Right Places pad 1 on the right side of the design.

Bottom Places pad 1 on the bottom of the design.

Center Numbers the center pad of the specified side of the design 
as pad 1.
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3. Add or modify data on the remaining tabs, if necessary. See:

• To Define a Die Outline for the Die Data from a Text File.

• To Modify CBP Shapes from a Text File.

• To Define Functions for Pads from a Text File.

• To Define Preferences for Die Component Creation.

4. Optionally, select colors that help you preview your die design. See “To Set Die 
Preview Colors.”

To Move Bond Pads
You can move substrate bond pads in the Layout Editor and in the Wire Bond Editor.

See also: To Move a Die Component Substrate Bond Pad

You can move component bond pads only in the Wire Bond Editor. 

See also: Using the Wire Bond Editor

You can move component or substrate bond pads whether DRC is on or off. However, with 
DRC on you cannot place a bond pad if the attached wire bonds violate any design rules, 
including wire bond rules.

Restriction: This information applies only to the BGA toolkit.

To move a bond pad:

1. Select the bond pad to move.

2. Select Move on the shortcut menu.

Tip: Right-click and select a command to edit the selected bond pad, to set the pad 
pitch, or select WB Rules to adjust the wire bond rules.

3. Indicate a new location for the bond pad.

Left Numbers the leftmost pad of the specified side of the 
design as pad 1.

Right Numbers the rightmost pad of the specified side of the 
design as pad 1.

Specify Numbers the pad you select on the specified side of the 
design as pad 1. Type or select the pad number you want 
to use for pad 1.
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To Move a Die Component Substrate Bond Pad
In the Layout Editor, a substrate bond pad is considered a pin. To select a substrate bond pad, 
turn on the Pins option in the selection filter.

Restriction: This information applies to only the BGA toolkit.

See also: Using the Selection Filter

To move a substrate bond pad in the Layout Editor:

1. Select a die substrate bond pad and select Move SBP on the shortcut menu. The bond 
pad dynamically attaches to the cursor.

Tip: Right-click to edit the selected bond pad, adjust the wire bond rules associated with 
the die part, or adjust the focus, rotate, or spin the bond pad before placing it.

If Keep Focus is selected, the rotation angle of the substrate bond pad is automatically 
adjusted to match the direction of the wire bond during the move operation.

The following actions will occur if the mentioned selections are chosen (Die Component 
Tab > Options dialog box):

• If Snap SBP to Guide is selected, the position of the SBP will automatically snap to 
the nearest SBP Guide if it is within the distance specified in Snap Threshold. This 
enables snap-to-guide mode when you are moving substrate bond pads. Select or 
type, in Snap Threshold, the number of units that defines the threshold below 
which snap to guide operates.

See also: SBP Guides in the Concepts Guide

The threshold value applies to all SBP guides for all die components in the design.

If you are moving multiple SBPs, each SBP is snapped to the nearest guide 
independently.

• If Show SBP Clearance is selected, the clearance outline is added to the display, 
showing the clearance area that must exist between two SBPs. This shows the SBP 
clearance outline around moved substrate bond pads when you are moving, adding, 
spinning SBPs, or adding fanouts. The clearance value is derived as follows:

• If the SBP is not part of a design net, or if its net and pin pair do not have specific 
rules defined, then the SMD to SMD clearance is used from the Default Rules 
hierarchy.

• If the SBP layer has a specific clearance rule set under layer rules, then the specific 
SMD to SMD rule is used.

See also: The Formatting for Conditional Clearance Rules in the ECO File
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• If the SBP is part of a design net, and the related net class, net, group, or pin pair has 
a specific clearance rule set, then the specific SMD to SMD rule is used.

• If the net class, net, group, or pin pair has a layer-specific clearance rule set, then the 
clearance assigned to the SBP layer is used.

The SBP clearance outline appears in both DRC On and DRC Off modes. 

See also: Design Rule Checking in the Concepts Guide

• If Show Wire Bond Length and Angle is selected, the length of the wire bond and 
the size of the wire bond angle appear on the display as WB Length and WB Angle, 
and change dynamically when you move the SBP. This shows the wire bond length 
and angle when you are moving, adding, spinning SBPs, or adding fanouts or wire 
bonds.

• If you are moving multiple SBPs, WB Length and WB Angle appear only for the 
first selected SBP.

If the SBP has no attached wire bond, the text does not appear. If the SBP has 
several wire bonds, the displayed values apply only to the first wire bond in the 
database.

WB Length and WB Angle appear in both DRC On and DRC Off modes.

2. Indicate the new bond pad location.

Tip: Move SBP is available only for pins of die parts created by the BGA tools in PADS 
Layout. For pins of other parts, Move SBP is unavailable.

Related Topics

Design Rule Checking in the Concepts Guide

To Remove (Backup) the Last Added Connection
The Backup command on the Add Connection shortcut menu removes the last connection you 
added. Repeat this command to continue removing connections.

Restriction: This information applies to only the BGA toolkit.



Working with the BGA Toolkit
To Rename a Net in BGAs

PADS Layout User’s Guide and Reference Manual, PADS 9.4 263

To remove the last added connection when using Add Connection on the BGA toolbar:

1. Right-click to display the shortcut menu.

2. Select Backup.

To Rename a Net in BGAs
Restriction: This information applies to only the BGA toolkit.

To change the name of a net:

1. BGA Toolbar button > Rename Net button.

2. Select a pin, unrouted pin pair, trace, or via in the net to rename.

3. A prompt asks for the new name. Type in the name, and click OK.

Tip: The maximum netname length is 47 characters. You can use any alphanumeric characters 
except brackets {}, asterisks *, spaces, question marks, or commas.

To Rename the Current Net
The Rename Current Net command on the Add Connection shortcut menu renames the net 
currently selected.

Restriction: This information applies to only the BGA toolkit.

To rename the currently selected net when using Add Connection on the BGA toolbar:

1. Right-click to display the shortcut menu.

2. Select Rename Current Net to display the Rename Net dialog box.

3. Enter the new name for the current net.

To Rotate a Substrate Bond Pad 90 Degrees
Restriction: This information applies only to the BGA toolkit.

To rotate a substrate bond pad 90 degrees in the Wire Bond Editor:

1. Select the SBP.

2. Right-click to display the shortcut menu.

3. Select Rotate 90.
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To Select a Component Bond Pad 
Restriction: This information applies only to the BGA toolkit.

To select one or more component bond pads in the Wire Bond Editor:

1. Right-click the die component to display the shortcut menu.

2. Select Select CBPs.

3. Select the CBP.

Tip: Ctrl+click to select more than one CBP.

To Select a Substrate Bond Pad
Restriction: This information applies only to the BGA toolkit.

To select one or more substrate bond pads in the Wire Bond Editor:

1. Right-click the die component to display the shortcut menu.

2. Select Select SBPs.

3. Select the SBP.

Tip: Ctrl+click to select more than one SBP.

To Select a Wire Bond
Restriction: This information applies only to the BGA toolkit.

To select one or more wire bonds in the Wire Bond Editor:

1. Right-click the die component to display the shortcut menu.

2. Select Select WBs.

3. Select the wire bond.

Tip: Ctrl+click to select more than one wire bond.

To Select Any Die Component
Restriction: This information applies only to the BGA toolkit.

To select any die component in the Wire Bond Editor:

1. Right-click the die component to display the shortcut menu.
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2. Select Select Anything.

3. Select the die component.

Selecting Die Part Items
When you start the Wire Bond Editor, the selection filter for this mode replaces the standard 
Pads Layout selection filter.

Restriction: This information applies only to the BGA toolkit.

The Wire Bond Editor's selection filter confines selection to component bond pads, substrate 
bond pads, and wire bonds. Choose whether to select any one or all of these object types (Select 
Anything) on the shortcut menu. 

See also: To Edit Substrate Bond Pads, To Edit Component Bond Pads

Select one or more substrate bond pads, component bond pads, or wire bonds within the die to 
perform editing on these object types. Only items in the currently selected die part can be 
selected. 

You can also edit the die size. 

See also: To Edit the Die Size

To Set Die Preview Colors
Restriction: This information applies only to the BGA toolkit.

To set die preview colors, which help you see the die display more clearly:

1. Click Preview Colors in the Die Wizard to display the Preview Colors dialog box.

2. Set a color by clicking it, then click the tile to the right of the area or item you want to 
color.

You can set colors for any or all of the following:

Background — Sets the background color in the die display area.

Highlight — Sets the highlight color in the die display area.

Die Outline — Sets the color of the die outline in the die display area.

CBP — Sets the color of the CBPs in the die display area.

CBP # — Sets the color of the CBP numbers in the die display area.



PADS Layout User’s Guide and Reference Manual, PADS 9.4266

Working with the BGA Toolkit
To Set Pad Pitch for a Substrate Bond Pad

All Shapes — Sets the color of all GDS shapes in the die display area. The GDSII 
shapes area of the dialog box is active only when you are creating a die from a GDSII 
file.

Shapes on Selected Layers — Sets the color of the GDS shapes in the GDSII file that 
appear on the selected GDS Layer, in the die display area. The color appears only when 
the Die Size tab or the Pad Functions tab is active.

The GDSII shapes area of the dialog box is active only when you are creating a die from 
a GDSII file.

To Set Pad Pitch for a Substrate Bond Pad 
Restriction: This information applies only to the BGA toolkit.

To set the pad pitch for a substrate bond pad in the Wire Bond Editor:

1. Select the SBP. 

2. Right-click to display the shortcut menu.

3. Select Set Pad Pitch to open the Set Pad Pitch dialog box.

4. Type the distance to use for spacing pads uniformly along their guides. The pad pitch 
spacing is center-to-center.

To Set SBP Names
Restriction: This information applies only to the BGA toolkit.

1. Click SBP Names on the Wire Bond Wizard dialog box.

2. In the SBP Properties Dialog Box make selections for substrate bond pads and their 
functions.

3. To import the SBP functions from a netlist file, click Derive from Netlist.

See also: Exporting an ASCII File

To Spin a Substrate Bond Pad
Restriction: This information applies to only the BGA toolkit.

To spin, or freely rotate, a substrate bond pad in the Wire Bond Editor:

1. Select the SBP.

2. Right-click to display the shortcut menu.
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3. Select Spin. Cross hairs appear intersecting the center of the bond pad.

4. Indicate the new pad position.

To Start the Wire Bond Editor
Restriction: This information applies only to the BGA toolkit.

1. To start the Wire Bond Editor, click the Wire Bond Editor button on the BGA toolbar 
and select a die component: a substrate bond pad, a component bond pad, or a wire 
bond. Once you select a die component, the Wire Bond Editor mode box appears. 

2. Begin modifying the die part items.

To modify a die part item, select the item (substrate bond pad, component bond pad, or 
wire bond) and select an action on the shortcut menu.

3. To exit the Wire Bond Editor and return to the Layout Editor, click Exit Wire Bond 
Editor on the mode box.

Tip: You can undo edits made in the Wire Bond Editor, even if you have exited the mode.

To Step and Repeat a Route
Restriction: This information applies to only the BGA toolkit.

To step and repeat a copied route:

1. Select a segment or pin pair > Edit menu > Copy.

Result: All included segments and vias are copied and attached to your pointer in Move 
mode.

2. Use the shortcut menu commands to rotate or flip the copy.

3. To place the copy, position it so it joins the pins you want to paste to and click. A copy 
is pasted and another copy remains attached to the pointer so you can continue pasting.

4. Right-click and click Repeat.

5. Type a repetition amount and click OK.

The route is copied and pasted the specified number of times. Each pasted route is 
spaced the same distance, and in the same direction, as the initial copied route.

Tip: New netnames may be created. See Copying Routes Creates New Netnames.

6. When you finish pasting press Esc.

See also: Step and Repeat Dialog Box
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To Swap Pins in BGAs
Restriction: This information applies to only the BGA toolkit.

To swap the nets on two pins:

1. BGA Toolbar button > Swap Pin button.

2. Select a pin. All candidates for swapping are highlighted. Candidates with a nonzero 
swap ID that matches the selected pin's swap ID are highlighted in the highlight color. 
Candidates with different or undefined swap IDs are highlighted in a complementary 
color.

3. Select one of the highlighted pins to swap with. If you select a pin that has a matching, 
nonzero swap ID, the swap is performed.

Tips:

• You cannot swap pins owned by a pin pair with rules.

• If Stretch Traces During Component Move is selected in the Design page of the Options 
dialog box, traces attached to the swapped pins are rerouted. Otherwise, trace segments 
are unrouted before the swap is performed.

To Synchronize Die Parts with LIQ
Restriction: This information applies to only the BGA toolkit.

Use Synchronize Die Part to:

• Update die parts in Pads Layout with die part data from Library IQ.

• Update die parts in Library IQ with die part data from Pads Layout.

• Export LIQ data to an .liq file that Library IQ can read. See “Using the Synchronize Die 
Part Dialog Box” for more information.

Note: Beginning with PADS 9.0, die parts and flip chips are identified by the Special Purpose 
settings in the Part Type rather than by the DIE and FLP logic families. With this change, any 
reference designator (logic family) can be assigned to a die part or flip chip. If you export a 
design to LIQ, and you have die parts or flip chips of a family other than DIE or FLP in your 
design, remember that all parts lose their family designation when exported to LIQ, and are 
assigned either the DIE or FLP family when imported back into Pads Layout; so the original 
family designation (and reference designator) of these parts is lost in the export/import process.

To Update Die Parts in BGAs
Restriction: This information applies to only the BGA toolkit.
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To update die part data in Pads Layout with die part data from Library IQ:

1. BGA Toolbar button > Synchronize Die Part button

The Synchronize Die Part dialog box appears.

2. Select the Library IQ die part to synchronize from the Die Part list box.

3. In the Design list box, click Part Type and choose the die part to update with the 
selected Library IQ die part data, or click Component and select the component 
reference designator to update with the selected Library IQ die part data.

4. Click Update Design.

If you selected Part Type in step 3, the message “Update selected Part Type(s) from LIQ 
Part Type XXXX?” appears. If you selected Component in step 3, the message “Change 
Part Type of the selected component(s) to the LIQ Part Type XXXX?” appears.

5. Click OK to update the die part. Click Cancel to cancel the update.

Tip: Updating Die Parts in Pads Layout is allowable only for DRC Off. If DRC On is set, the 
message “Updating Die Part in Design is allowable only for DRC Off. Switch to DRC Off?” 
appears. Click OK to turn DRC off and update the die part in Pads Layout. Click Cancel to 
cancel the update.

Creating Die Information
For background on creating a die, see Creating Die Information in the Concepts Guide.

If you import an ASCII file to create the die part definition, see Die Data ASCII File Format in 
the Concepts Guide.

Restriction: This information applies only to the BGA toolkit.

For information on how to create a die, see:

• To Create a Die from a Text File

• To Create a Die Parametrically

• To Create a Die from a GDSII File

Selecting Component Bond Pads
Restriction: This information applies only to the BGA toolkit.

Use any of the following methods to select a component bond pad to edit:
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• With nothing selected, choose Select Anything or Select CBPs on the shortcut menu, 
and select the component bond pad. 

• Select Select CBPs on the shortcut menu and area select to edit multiple bond pads.

• With a substrate bond pad or wire bond selected, click Select CBP on the shortcut 
menu.

• Select the substrate bond pad to which the component bond pad is connected. Right-
click and click Properties. Click CBP.

• Select the wire bond to which the component bond pad is connected. Right-click and 
click Properties. Click CBP.

Selecting Substrate Bond Pads
When in the Layout Editor, a substrate bond pad is considered a pin. To select a substrate bond 
pad, turn on the Pins option in the selection filter and select the substrate bond pad.

Restriction: This information applies only to the BGA toolkit.

When in the Wire Bond Editor, use any of the following methods to select a substrate bond pad 
to edit:

• With nothing selected, click Select Anything or Select SBPs on the shortcut menu, and 
select the substrate bond pad. 

• Select Select SBPs on the shortcut menu and area select to edit multiple bond pads.

• With a component bond pad or wire bond selected, click Select SBP on the shortcut 
menu.

• Select the component bond pad to which the substrate bond pad is connected. Right-
click and click Properties. Click SBP.

• Select the wire bond to which the substrate bond pad is connected. Right-click and click 
Properties. Click SBP.

Using the Define Name of New Net Dialog Box
Use the New Net dialog box to add a new net name to the Net list. The Die Flag Wizard adds the 
new net to the design after you click Create.

Restriction: This information applies only to the BGA toolkit.
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Wire Bond Report
Wire bond reports provide information on wire bond rules violations or compliance. When you 
check wire bond rules, a wire bond report is automatically saved to a file named wbr_report.lst. 
The default location for the file is 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Settings. The report appears in 
Notepad (or in the default text editor chosen during installation).

Restriction: This information applies only to the BGA toolkit.

The following is an example of a wire bond report:

Wire Bond Rule Checking Report - previewbgadieflag.pcb - Wed Feb 09 14:01:45 2000

Checking Die Part U1 <MWG122160ECG> <MWG122160ECG> ...
Wire Bond Rules
Min Length: 30
Max Length: 175
Max Angle: 45.00
WB to WB Clearance: 1
WB to SBP Clearance: 1
Die Part U1: NO errors found 

Tip: The value “Not Set” appears for rules that are not set in the Wire Bond Rules dialog box.

To Update Die Parts in Library IQ
Restriction: This information applies to only the BGA toolkit.

To manually update die part data in Library IQ with die part data from Pads Layout:

1. BGA Toolbar button > Synchronize Die Part button

The Synchronize Die Part dialog box appears.

2. In the Design list box, click Part Type and select the die part to synchronize, or click 
Component and select the reference designator of the die part to synchronize.

3. In the Die Part list box, select the die part to update with the selected die part data.

Tip: A die part can be updated from only one part in the design. If you choose multiple 
design parts, the first part selected is used to update the Die Part.

4. Click Update LIQ. The Confirm Update LIQ dialog box appears.

5. Click Save Backup to save a copy of the die part before the update.

6. Use Browse to navigate to a different folder in which to save the backup file.

7. Click OK to update the die part. Click Cancel to cancel the update.
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Tip: You can also export LIQ data to an .liq file that Library IQ can read. 

See also: Synchronize Die Part Dialog Box

Action

• BGA fanouts are generated. This is performed on double-sided designs only.

• Serpentine routes and plating tails are generated.

• SBPs are logically assigned to the ends of serpentine traces and logical connections 
between die pins, and BGA pins are generated.

• SBP fanouts and any-angle coupling traces are generated.

The BGA Route Wizard generates route patterns on die and BGA layers only. The BGA 
layer contains only BGA fanouts. All other parts of route patterns (serpentine routes and 
plating tails, SBP fanouts and any-angle coupling traces) are created on the die layer.

See also: BGA Route Patterns in the Concepts Guide

BGA Reference Designator
Displays the BGA reference designator when you open the BGA Route Wizard dialog box for 
the first time (per design), based on the logic families in the current design.

The BGA Route Wizard looks for a BGA logic family. If no die with this logic family is found, 
a component is selected randomly. If more than one die has this logic family, one of the dies in 
that logic family is randomly selected.

BGA Route Wizard Report
Displays information on the connection made during processing, the number of pins selected for 
connection per side or quadrant, and new netlist information.

Generate Connections Generates logical connections between die and BGA 
component pins. Connections are not routes; however, 
BGA fanouts and SBP fanouts are generated if specified 
in the Connections tab.

Generate Connections 
and Route

Generates logical connections between component pins 
and creates trace patterns to route them. During 
processing, the following occurs:
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Die Reference Designator
Displays the die reference designator when you open the BGA Route Wizard dialog box for the 
first time (per design). 

The BGA Route Wizard looks for a die part or flip chip. If more than one of these is found, one 
of them is randomly selected. If neither is found, a component is randomly selected. 

Select Sides/Select Quadrants
The available partitioning type depends on whether the Generate Connections or Generate 
Connections and Route option is selected in the Action area.

Use the partition check boxes to select partition sets. The available Side partition sets are Right, 
Left, Top, and Bottom. The available Quadrant partition sets are Top Left, Top Right, 
Bottom Left, and Bottom Right. 

Only the pins from selected sets appear in the Substrate Bond Pad and BGA Pins lists.

See also: BGA Operations in the Concepts Guide

Undo Last Run
Returns the design to its state prior to route processing. Undo Last Run is unavailable until you 
run the routing process. 

Using the BGA Route Wizard
The BGA Route Wizard provides automated features that reduce repetitive, and often tedious, 
design tasks including creating connections between BGAs pads and SBPs, creating BGA 
fanouts, routing die-to-BGA connecting traces, and generating plating tails.

When you click the BGA Route Wizard button on the BGA toolbar, the BGA Route Wizard 
dialog box appears. Use the BGA Route Wizard dialog box to generate connections only, or 
generate connections and routes.

Restriction: This information applies to only the BGA toolkit.

To Use the Dynamic Route Tool in BGAs
Restriction: This information applies to only the BGA toolkit.

To start the Dynamic Route tool:
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1. Set On-line Design Rules Checking to Prevent Errors in the On-Line DRC area on 
the Design page of the Options dialog box.

2. Make sure you are on the correct layer for the preferred direction.

3. Select a segment or pin, as you would using the Routing Manually.

4. Right-click and click Dynamic Route. The trace attaches to the pointer.

5. Guide the pointer through the items you want to bypass without entering corners. You 
can enter corners with a right-click if you want to; these act as tacked corners to prevent 
preceding segments from moving.

Tip: Avoid unnecessary mouse movements since corners are added at all mouse 
locations. To remove unwanted corners, slowly move the pointer back over the 
unwanted traces.

As you route, the guard band appears whenever the head of the trace meets a clearance 
obstacle that it cannot shove. The dynamic route tool won't allow you to complete the 
trace without changing the clearance rules or removing the obstacle. The pointer 
changes to a bull's-eye when it is close enough to the finishing pad to complete the route.

Tip: Use Transparent Mode, modeless command T, to view obstacles that may lie under 
traces on the active layer.

See also: To Reroute with Route or Dynamic Route, Routing Dynamically

Routing in DRC Prevent Mode
When you route a trace between pins that are not part of the same net or that have no netlist, all 
items not belonging to the current net are considered obstacles. To connect to a pin:

• Right-click and click Select Target and select the pin on which you want to end the 
trace.

Using the Wire Bond Editor
In the Layout Editor, only substrate bond pads are available for selection and modification. The 
Wire Bond Editor opens (explodes) a selected die part, which allows you to move, add, delete, 
and edit individual component bond pads and wire bonds in addition to substrate bond pads.

Restriction: This information applies only to the BGA toolkit.

You can edit the die size by selecting Edit Die Size on the Wire Bond Editor's shortcut menu. 

See also: To Edit the Die Size

The Wire Bond Editor is available only for die parts designed in the BGA Toolkit. You can edit 
only one die part at a time.
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Tip: You cannot edit the die outline by selecting it using the Wire Bond Wizard.

To Use Graphical Selection Mode
Result: The BGA Route Wizard dialog box appears.

As an alternative to using the Substrate Bond Pads and BGA Pins lists to select pins for 
processing, you can use Graphical Selection mode to select pins with the mouse.

Restriction: This information applies to only the BGA toolkit.

To use Graphical Selection mode:

1. BGA Toolbar button > Route Wizard button.

2. Click the Select Pads tab.

3. Click Select Graphically. The BGA Route Wizard temporarily closes and the Select 
Graphically dialog box appears.

4. Click either Select Pins to Include or Select Pins to Exclude.

5. Select the SBP pins and BGA pads you want to include or exclude. Use standard 
selection procedures to select pins.

While in Graphical Selection mode you can use standard zooming features to zoom and 
pan the work area. All other functionality is unavailable while you are in this mode.

Tip: If Existing Nets on the Connections tab or Routing tab is cleared, you can select 
only pads that are not currently part of a predefined connection.

6. Click OK on the Select Graphically dialog box to complete your pin selection and 
return to the BGA Route Wizard. The Substrate Bond Pads and BGA Pins lists on the 
Select Pads tab reflect the inclusions and exclusions you made.

Wire Bond Fanout Workflow
Restriction: This information applies only to the BGA toolkit.

To create a wire bond fanout for a selected die:

1. Use the Wire Bond Wizard dialog box to define substrate bond pad rings and their 
properties.

See also: Wire Bond Wizard Dialog Box

2. Use the Rules dialog box to set design rules and the Wire Bond Rules dialog box to set 
wire bond rules for creating the wire bond fanouts.
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See also: Design Rule Hierarchy in the Concepts Guide, Wire Bond Rules Dialog Box

3. Use the Assign CBPs to Rings dialog box to specify which component bond pad to wire 
bond onto which ring.

See also: Assign CBPs to Rings Dialog Box

Tip: For each CBP you assign to a ring, an SBP and a wire bond are created. New SBPs 
are automatically preplaced on the guide of the specified ring or rings.

4. Preview the fanout that corresponds to the current settings by clicking Preview Fanout.

Based on the previewed fanout, you can modify SBP Guides properties, component 
bond pad assignments, and other properties until the wire bond fanout pattern satisfies 
the rules you have set.

5. Create the wire bond fanout by clicking Create Fanout, which stores the fanout pattern 
in the design.
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Chapter 8
File Operations

In this chapter:

• Creating New Files

• Importing a Schematic Design Netlist

• Creating Start-up Files

• Specifying the Start-up File

• Opening Files

• Replacing Fonts

• Saving Files

• To Save As

• Archiving Your Design

Creating New Files
You use the New command to create a new design file.

To create a new file:

1. File menu > New.

2. In the Set Start-up File dialog box, select the start-up file.

Tip: A start-up file contains global settings such as layer definitions, grids, clearance 
rules, the attribute dictionary, and so on.

3. If you want to use this file for all new design files, select the Don't Display Again check 
box.

4. Click OK.

Related Topics

Creating Start-up Files
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Importing a Schematic Design Netlist
The process of laying out a design in PADS Layout typically begins with importing a netlist file 
containing all the schematic information for the design, including a list of all the parts and their 
decals. During the import process, all the parts are sourced from the library, and their decals are 
stacked at the origin, ready for placement.

Requirement

For a netlist import to succeed, all of the parts and decals listed in the netlist must exist in your 
library. If any are missing, the import operation writes an ascii.err file listing the missing 
parts/decals. To import the netlist successfully, you must add these components to your library, 
either by adding a library which contains the missing components to your library list, or by 
creating the missing part types and missing decals.

Procedures

The procedure you use to import a netlist depends on which schematic tool you are using. For 
product specific instructions, see one of the following topics:

• Creating a New PCB Layout from a DxDesigner Design

• Creating a New PCB Design from a PADS Logic Netlist

• Creating a New PCB Design from an OrCAD Netlist

Creating a New PCB Design from an OrCAD Netlist
When you lay out a new PCB design, you typically start by importing a netlist created in a 
schematic capture application. This topic explains how to import a netlist created in ORCAD.

Prerequisites

The ORCAD netlist file must exist. 

Procedure

1. Change the filename extension of the netlist created by OrCAD from .net to .asc. PADS 
Layout only imports netlist files with .asc extensions.

2. In a text editor, open the netlist file and examine the header of the file. The header is the 
first line of text in the file. This can be a problem in the OrCAD netlist depending on the 
.dll file you use to create the netlist. It must be a compatible PADS header. If necessary, 
replace the header with a header from a current PADS .asc file. To get a current PADS 
ascii header:

a. Open PADS Layout and click File menu > Export.
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b. In the File Export dialog box, type a name for the exported file and note its location, 
then click Save. In the ASCII Output dialog box, in the Sections area, select the Text 
checkbox. (You need to select at least one of the checkboxes to output an ascii file.)

c. Click OK.

d. Using a text editor, open the .asc file you created. Copy the header from the sample 
.asc file you created and paste it into your OrCAD netlist file, replacing the original 
header. The following is an example of a header from the 2007 series software.

!PADS-POWERPCB-V2007.0-BASIC! DESIGN DATABASE ASCII FILE 1.0

3. In PADS Layout, click File menu > Import.

4. In the File Import dialog box, in the Files of type list, click ASCII Files (*.asc). Browse 
for and select the OrCAD netlist file, and then click Open.

5. If an ascii.err file is produced, perform the following steps:

a. Close the design into which you just imported the netlist. Click No when you are 
prompted to save the design.

b. Add any missing components listed in the ascii.err file to your library, either by 
adding a library which contains the missing components to your library list, or by 
creating the missing part types and decals. (See Adding Libraries to the Library List, 
Creating and Modifying Part Types, and Creating and Editing PCB Decals for 
information on how to do these tasks.)

c. Resolve any other errors found in the ascii.err file.

d. When all the errors have been resolved, repeat this procedure.

Result

The import process sources all the part types and decals from the library and stacks the decals at 
the origin. You can then use the Tools menu > Disperse Components command to spread out 
the components.

Cross-Probing
You can cross-probe with PADS Logic or DxDesigner to simplify importing the netlist and 
placing the parts.

Procedures

The procedure you use to cross-probe depends on which schematic tool you are using. For 
product specific instructions, see one of the following topics:

• Cross-probing Between PADS Products in the PADS Logic User’s Guide
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• Cross-Probing with DxDesigner

Creating Start-up Files
You use the Start-up File Output dialog box to create a start-up file that contains global settings 
such as layer definitions, grids, clearance rules, the attribute dictionary, and so on. You can 
create different start-up files and specify which one to use when creating a new design file. This 
capability enables you to save setup time when creating a new design by reusing global settings 
that you saved in the start-up file.

See also: Specifying the Start-up File

Procedure

1. In the current design, specify the options and preferences you want to include in the 
start-up file.

2. On the File menu, click Save As Start-up File.

3. In the Save As dialog box, specify the start-up file name and click Save. The Start-up 
File Output dialog box appears.

4. In the Sections area, select the check box for any of the following settings you want to 
include in the start-up file:

• PCB Parameters—Global information, such as colors, layer definitions, and grids

• Vias—Via information, such as default via type, jumpers, padstack definitions and 
locations

• Layer Data—Layer information specified in the Layers Setup dialog box, such as 
number of layers, layer names, routing direction for the layer, electrical type, and 
associations

• Rules—Rules information, such as clearance, routing, and high-speed

• CAM—CAM information related to the plot file configurations

• Attributes—Attribute information, such as the attribute dictionary, all attributes 
assigned to objects in the design, and attribute status (read only, system, ECO 
registered, or hidden). Values in the attribute hierarchy are not saved. 

See also: Modifying Default Attributes

Tip: If you want to select all the check boxes, click the Select All button.

5. In the Units list, select the units you want to use in the start-up file.

Tip: Current units provide more information than Basic units, such as grid positions.
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6. In the Start-up File Description box, type a brief description of the global settings you 
are saving. The description appears when you select the start-up file in the Set Start-up 
File dialog box, and should help remind you of the settings in the start-up file.

7. Click OK.

Result: The start-up file is written to the 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Settings folder. Start-up files have a 
.stp file extension.

Related Topics

Specifying the Start-up File

Start-up Files in the Concepts Guide

Specifying the Start-up File
You use the Set Start-up File dialog box to select the start-up file to use for new design files. A 
start-up file contains global settings such as layer definitions, grids, clearance rules, the attribute 
dictionary, and so on.

The start-up file affects only new designs and specifying a new start-up file does not affect 
existing designs.

Procedure

1. File menu > Set Start-up File.

2. In the Set Start-up File dialog box, select the start-up file and click OK.

Tip: If you want to use the selected start-up file for all new design files, select the Don't Display 
Again check box.

Related Topics

Creating Start-up Files

Start-up Files in the Concepts Guide

Opening Files
PADS Layout can open the following file types:

Native Design Files, *.pcb PADS Layout binary format

Reuse Files, *.reu A physical design reuse type, known as the reuse 
definition
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When you open a file, PADS Layout may convert the data to current formats.

Restriction: Files opened by another user are locked to any edits. 

Tip: Improvements in thermal relief definition in PADS 9.2 may cause changes in thermal pad 
appearance, flooding results and CAM output (for CAM Plane layers) when a design from a 
previous version is opened in PADS 9.2. If incompatibilities are found when such a file is 
opened, a warning prompt is displayed and the incompatibilities are written to the 
Powerpcb.Rep file.

Procedure

1. File menu > Open.

Result: The File Open dialog box shows files in the default \PADS Projects folder. The 
list of files includes those created in PADS Layout. 

2. On the File Open dialog box, select the file and click Open.

Related Topics

File Open Conversions in the Concepts Guide

Replacing Fonts
You can set up text strings and labels in your designs to use stroke font or the system fonts that 
are installed on your system.

When you open a design created with fonts that are not installed on your system, the Font 
Replacement dialog box opens automatically.

Tip: If the design uses fonts or character sets that are not installed on your system, empty boxes 
will appear where you expect to find text or symbols. Once the font replacement process 
completes, the symbols display properly.

There are three types of font replacement:

• Automatic Font Replacement

• Manual Font Replacement

• Skipping Font Replacement

Tips:

Old Binary Files, *.job PADS Perform V6 and PADS Work V7 format .job 
files
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• You can select some fonts for automatic replacement, select others for manual 
replacement, and choose that other font replacements be skipped entirely.

• You can have a combination of stroke font and system fonts within the same design.

• You must set up fonts for each text string and/or label you create in your design. Once 
you set up fonts for a text string or label, you can then use the Properties dialog to apply 
a font and font characteristics to all objects that you select for modification with the 
Properties dialog box.

Restrictions:

• If the design uses fonts or character sets that are not installed on your system, a font 
substitution process begins automatically when the file is loaded. During this process, 
you are asked to choose fonts to substitute for those that are missing from your system.

• System font text is supported in RS274X Gerber format when Fill mode is on. System 
font text is output to Gerber format as a set of filled polygons.

• System fonts are not supported in the RS-274D CAM output format. If you attempt to 
use this format with system fonts, the program displays a warning message. If you 
proceed, system fonts will not be output. Instead, you should use the 274X format with 
system fonts.

• Type 1 fonts are not supported.

Automatic Font Replacement 
To replace fonts automatically:

1. In the Font Replacement dialog box, select Automatic to use standard Windows font 
substitution.

Tip: The Missing font column lists the fonts used in the design that are not installed on 
your system.

2. In the Replace with font column, select the fonts you want to use as replacements for 
those fonts you identified for replacement.

3. Click OK.

Manual Font Replacement
To replace fonts manually:

1. In the Font Replacement dialog box, select Manual to select font substitutions 
manually. 

2. In the Missing font column, select the name of the font you want to replace.
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3. In the Replace with font column, select the fonts you want to use as replacements for 
those fonts you identified for replacement.

4. Click OK.

5. Click OK again to confirm that the font replacement process should begin.

Skipping Font Replacement
• In the Font Replacement dialog box, select Skip in the Mode column to preserve the 

original font settings in the design. 

Tip: When you skip font replacement, clearances for text strings are preserved in the design; 
these objects display as empty text boxes.

Related Topics

Finding Fonts

Saving Files
To save changes you made to a design information file:

• Click Save from the File menu. You can create native format, binary design files (*.pcb 
files). 

Restriction: Files opened by another user are locked to any edits. 

You can also save by clicking the Save button from the standard toolbar.

You cannot save .job format files with PADS Layout. Also, flooding and hatching are not saved 
with files. You must flood or hatch again the next time you open the file. 

Related Topics

To Save As

To Create a Test Point ASCII File

To Save As
To write design information to a different file name or folder:

1. Click Save As from the File menu.

2. You can change the file name or folder.

3. To change the file name, type the new file name.



File Operations
Archiving Your Design

PADS Layout User’s Guide and Reference Manual, PADS 9.4 285

4. To select a different folder to which to save the file, use the options at the top of the 
dialog box.

Related Topics

Saving Files

To Create a Test Point ASCII File

Archiving Your Design
You can create a folder, a PDF, and/or a zip file that contains all of your design files and 
supporting files. This includes the design itself, a schematic file, libraries, and any additional 
files or folders you want. You choose what to archive; all fields are optional.

Tip: As an alternative to the PADS Layout Archiver, you can use the Archive Navigator to 
archive your projects. .

Procedure

1. Open the design you want to archive.

2. File menu > Archive.

3. Select the files and folders you want in the Archiver dialog box.

4. Click OK.

Results

An archive folder that contains the design and/or schematic files, the libraries, and any 
additional files and folders you’ve indicated is created.
Exception: If you chose to compress the files, the .zip file is the only file in this folder.

If you chose to create a PDF, the file is created using the design name and placed in the archive 
folder.

If you chose to compress the files using the zip format, a zip file is created having a filename of 
the following format:

<project_name>YYYYMMDDHHMMSS.zip

Where YYYY is the year, MM is the month, DD is the day, HH is the hour - in military time, 
MM is the minute, and SS is the second of the exact time you created the file. The file contains 
the same folder structure as the archive folder.
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Chapter 9
Archive Navigator

Use the Archive Navigator to create, organize and manage your PCB project archives. You can:

• Organize archives into three levels of storage—vaults, folders and projects.

• Store successive numbered archives of a project with identifying data, including a text 
description.

• Restore any project archive from the vault to a working directory, make changes, and 
store the modified project as a new archive.

• Create archive templates to simplify customized archiving.

Tip: As an alternative to the Archive Navigator, you can use the PADS Layout Archiver to 
archive your projects. See Archiving Your Design.

This chapter contains the following topics:

Setup and Vault Management
You can organize your Archive Navigator storage to suit your situation. If you have only a few 
projects, you can store them at the top level of the Archive Navigator vault. If you have a larger 
number of projects, you may want to create folders within your vault to organize them. If you 
have very many projects, you may want to create multiple vaults, each containing multiple 
folders containing multiple projects.

To begin archiving a PCB project you must:

• Create a vault.

Setup and Vault Management Setting Display Options in the Vault View

Creating a Vault Working with Archives

Adding a Project Container to the Vault Adding an Archive to the Vault

Creating a Vault Folder Creating an Archive Template

Changing Vaults Restoring an Archive to the Working Folder

Deleting Items from the Vault Viewing the Contents of an Archive

Reorganizing the Vault Finding Projects or Archives in the Vault

Viewing and Editing Properties of a Vault Item
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• Create an empty Project container in the vault, and associate it with a working folder 
containing the PCB project files.

In this section:

• Creating a Vault

• Adding a Project Container to the Vault

• Creating a Vault Folder

• Changing Vaults

• Deleting Items from the Vault

• Viewing and Editing Properties of a Vault Item

• Setting Display Options in the Vault View

Creating a Vault
To begin using the Archive Navigator, the first thing you must do is create a vault.

Tip: You can create more vaults later if you need them.

Procedure

1. Vault view > Select Vault button

Tip: Click Tools menu > Archive Navigator to open the Archive Navigator.

2. In the Select Vault dialog box, click Create New Vault.

3. In the Browse for Folder dialog box, select an empty folder in which to place the new 
vault, and click OK.

Tip: If you haven’t already created an empty folder, click Make New Folder to create 
one.

4. Click OK in the Select Vault dialog box.

Result

You can now add an empty project to the vault and link it to your working folder.

Adding a Project Container to the Vault
To begin archiving a PCB project in the Archive Navigator, you must create an empty Project 
container for it in the vault, and associate the Project container with a working folder containing 
the PCB project.
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Tip: If you have a pcb file open in Layout when you create a new Project container, the working 
folder is automatically set to the location of the open file.

Procedure

1. In the Vault view, right-click a vault or a folder, and click Create Empty Project.

2. In the Create Empty Project dialog box, type a name and description for the new project, 
and click OK.

3. Right-click on the new project and click Set Working Folder.

4. In the Browse for Folder dialog box, select the folder containing your PCB project.

Tip: If you don’t yet have the PCB project files, you can click Make New Folder to 
create a new folder to put your PCB project in later.

5. Click OK.

Result

The new Project container is created and associated with a working folder. Now you can add an 
archive to the vault.

Creating a Vault Folder
If you work with multiple PCB projects, you may want to organize project archive storage into 
separate folders. Use the following procedure to create a new folder in the vault.

Procedure

1. In the Vault tree, right-click the vault or a folder, and click Create Folder.

2. In the Create folder dialog box, type a name for the new folder, and click OK.

Result

The new folder is added to the vault, or to the folder you selected.

Changing Vaults
Use the following procedure to close the current vault and open another one.

Procedure

1. Vault view > Select Vault button

2. In the Select Vault dialog box, click the “…” Browse button to browse for the vault you 
want to open, or type in the pathname.
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3. Click OK.

Result

The current vault is closed, and the selected vault is opened.

Deleting Items from the Vault
You can delete folders, projects and archives from the vault.

Procedure

1. In the Vault view, right-click the item and click Delete.

Reorganizing the Vault
After you have been using a vault for awhile, you may want to reorganize it. To do this, you can 
move and copy folders and project containers to new locations in the vault.

Procedure

1. In the Vault view, right-click the item and select Copy to or Move to.

2. In the Copy to or Move to window, select the new location for the item, and click OK.

Viewing and Editing Properties of a Vault Item
You can view and edit the properties of projects, folders and archives.

Procedure

1. In the Vault view, right-click the item and click Properties.

2. (Optional) Edit the properties as described in the Project and Folder Properties Dialog 
Box topic or the Archive Properties Dialog Box topic.

Related Topics

Finding Projects or Archives in the Vault

Setting Display Options in the Vault View
Use the following procedure to set filtering, display format and display order options that 
control how archives are displayed in the Vault view.
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Procedure

1. In the Vault view, Click the Options button.

2. In the Options Dialog Box, set the Archive display format, Archive filters, and Archive 
order controls.

Working with Archives
In this section:

• Adding an Archive to the Vault

• Creating an Archive Template

• Restoring an Archive to the Working Folder

• Viewing the Contents of an Archive

• Finding Projects or Archives in the Vault

Adding an Archive to the Vault
When you add an archive to the vault, it is an archive of the current contents of the working 
folder.

Tip: In the vault view, the archive currently restored to the working folder (the base archive) is 
shown in green. The archive you are adding will be identified as a sub-archive of this archive. 
For instance, if the archive currently restored to the working folder is Archive 9, the ID of the 
new archive will be Archive 9.1.

Procedure

1. In the Working Folder view, click the Add Archive to Vault button.

Restriction: The Add archive to Vault button is available only when a project or archive 
is selected in the Vault tree.

2. In the Add Archive toVault dialog box:

a. In the Schematic project file box, browse for or type the name of the DxDesigner 
project (.prj) file.

b. In the Layout project files box, click the New (Insert) button to browse for or type 
the names of the .pcb file(s).

Tip: You can also use the keyboard Insert and Delete keys to add and delete files 
from the list.
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c. In the Additional files and folders box, click the New (Insert) button to type or 
browse for the names of any additional files to include in the archive.

Tip: You can also use the keyboard Insert and Delete keys to add and delete files 
from the list.

d. In the Name box, type a name for the archive.

Tip: Create a name you can search for with the Find in Vault tool.

e. In the Description box, type a description of the archive.

Tip: Create a description you can search for with the Find in Vault tool.

Tip: As an alternative, you can set all these fields using a template. To do this, click 
Select from the Templates drop-down menu, select a template in the Templates Dialog 
Box Templates list, and click Select. (See Creating an Archive Template for information 
on creating templates.)

a. Click OK.

Related Topics

Restoring an Archive to the Working Folder

Creating an Archive Template
You can create customized archive templates to make it easier to add new archives.

Tip: Templates are created and saved for a specific project.

Procedure

1. In the Working Folder view, click the Add Archive to Vault button.

2. In thethe Add Archive to Vault dialog box, select New from the Templates drop-down 
list.

3. In the Templates Dialog Box, set the Schematic project file, Layout project files, 
Additional files and folders, Name, and Description fields by browsing for or typing the 
appropriate content.

Tip: You can enter the variable “<projectname>” in any of these fields to have the 
template enter the project name in the matching field of the Add Archive to Vault dialog 
box. For example, if you enter “<projectname>.pcb” in the Layout project files field of 
the Templates dialog box, when you use this template to archive the Processor project, 
“Processor.pcb” will appear in the Add Archive to Vault dialog box; and when you use 
it to archive the Timer project, “Timer.pcb” will appear.

4. Click Save.
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Result

The new template is created and stored in the vault project.

Restoring an Archive to the Working Folder
You can select any archive in the vault and restore it to the working folder.

Warning: Archive files will overwrite files of the same name in the working folder.

Procedure

1. In the Vault view, right-click the archive and click Restore.

2. When you are prompted to confirm the restore operation, click Yes.

Result

The archive is restored to the working folder, and the archive’s icon turns green to indicate that 
it is the currently restored archive.

Viewing the Contents of an Archive
Use the following procedure to view a listing of an archive’s content.

Procedure

1. In the Vault view, right-click on the Archive you want to view, and click View Content.

Result

The listing is displayed in your default text editor.

Finding Projects or Archives in the Vault
Use the following procedure to search the entire vault for projects or archives.

Procedure

1. In the Vault view, Click the Find in Vault button.

2. In the Find in Vault Dialog Box, from the Items list select All, Projects, Archives or 
Folders to specify what you want to search for.

3. Specify the search criteria, as follows:

a. In any or all of the Name, User, and Description fields, provide a character string to 
search for. 
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Tips: 

• Searches are not word-based; a search for the string ic will find Iceland, 
picnicking, and alphanumeric.

• Wild cards are not supported.

• Searches are not case-sensitive.

• A null string in a field returns items with any value.

• Items must match all fields to satisfy the search criteria.

• Both the Name and ID attributes of items are searched for the search string 
specified in the Name field.

b. Set the Created from and to checkboxes and date/time fields as follows:

i. Select the Created from checkbox to return all items created after the date/time 
specified in the field.

ii. Select the to checkbox to return all items created up to the date/time specified in 
the field.

iii. Check both checkboxes to return all items created between the dates specified in 
the two fields.

4. Click Find.

Result

The items found are listed in the Find results list box. Double-click any item in the list to 
highlight it in the Vault tree.
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Chapter 10
Working with DxDesigner

In this chapter:

• Creating a New PCB Layout from a DxDesigner Design

• Cross-Probing with DxDesigner

• Comparing the PCB Layout Against the DxDesigner Design

• Forward Annotating from DxDesigner to PADS Layout

• Back Annotating from PADS Layout to DxDesigner

• Working with Variants

Creating a New PCB Layout from a DxDesigner 
Design

There are two ways to create a new PCB design from a DxDesigner design.

Restriction

Importing a netlist without rules information does not turn on the plane thermals for CAM or 
Split/Mixed Planes.

Choosing a Method

Method 1—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method is the simplest. You need to open the PCB configuration file in a text editor 
to make changes. 

Method 2—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method provides the most control of the process. You can use the the tabbed screens 
in DxDesigner’s PCB Interface to make basic changes to the PCB configuration file and control 
the constraints.

Method 3—Use if you don’t have DxDesigner on your computer and the netlist files are sent to 
you from the schematic engineer.
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Method 1—Automated New PCB Design Using the 
DxDesigner Link

Use the DxDesigner Link to connect DxDesigner to PADS Layout and bring forward the whole 
design from the schematic to the layout.

Requirement

You must have both DxDesigner and PADS Layout on the same computer.

Procedure

1. In PADS Layout with the default startup design or a template design open, on the Tools 
menu, click DxDesigner.

Result: In the DxDesigner Link, on the Documents tab, the pathname of your design 
appears in the PADS Layout Design box and the Connect button has changed to a 
Disconnect button since you are connected to the PADS Layout design.

2. In the DxDesigner Project File box, accept the file shown or browse for the 
corresponding schematic. Once your DxDesigner project pathname is in the box, click 
Connect.

3. If there are multiple designs available in the DxDesigner project, select the design you 
want from the Design Name list.

4. In the Forward/Backward configuration file area, click Browse to locate the 
pads<latest_version>.cfg file to use for forward or backward annotation between the 
two applications. 

Tip: Create a copy of the default configuration file and put it in your DxDesigner project 
directory. Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

5. If you need to modify the config file settings, click Edit to modify the file in your 
default text editor.

See also: PCB Interface Configuration Files chapter in the DxDesigner PCB Interfaces 
User Guide.

6. On the Library tab, select an import mode for Library Parts and choose a library.

Tip: You can click New Library to create a new PADS library. By default, libraries are 
located at C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Libraries. The new 
library is added at the bottom of the library list and search order.
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7. On the Documents tab, click Forward to PCB.

8. In the Forward Annotation dialog box, select Create PCB.

9. In the Data to pass to PCB area, select the schematic data to send to the PADS Layout 
design.

Requirement: To include design rules in the forward annotation operation, select the 
Design Rules option, even if you already selected Compare Design Rules on the 
Preferences tab.

Optional: Select the Pause before Updating PCB Design check box. Selecting this 
option gives you the chance to check any library import errors before importing the .asc 
file into PADS Layout. Then you can click Continue to proceed with the process.

10. Click OK.

11. In the Process Indicator dialog box, after the forward process if finished, click Close.

Method 2—Automated New PCB Design Using 
DxDesigner’s PCB Interface Script

Use the DxDesigner PCB Interface to set basic options in the configuration file and use the 
command line script to automate the import of the DxDesigner design into PADS Layout. 

Requirement

You must have both DxDesigner and PADS Layout on the same computer.

Procedure

1. DxDesigner Tools menu > PCB Interface.

2. In the PCB Interface dialog box, on the Basic tab, click Create Netlist for Layout.

3. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

4. Make necessary settings on the Advanced and Constraints tabs of the dialog box 
according to the requirements of your design.

5. If other modifications to the configuration file are needed, open the file in a text editor 
and make them.
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6. Select the Run command line after processing check box. For more infomation on the 
script, see Using the PCB Interface PADS layout Script.

7. Click OK.

Result: The PCB Interface creates the netlisting files and the DxDesigner To PADS 
Layout dialog box appears.

8. In the DxDesigner To PADS Layout dialog box:

a. Click Create New PCB design.

b. If you want to use a template select the Start with Template PCB Design and in the 
in the Template PCB Design Filename (*.pcb) box, type the pathname or browse for 
your PCB design.

c. Click Next.

9. In the Library Import Options dialog box if you want to transfer part types from 
DxDesigner to PADS Layout, select the Update Part Types in Library check box. If 
not, clear the check box and click Next.

a. Browse for the Part Type ASCII File if it’s not already listed. This .p file, along with 
the rest of the netlist files, is created in your DxDesigner Project folder by the PCB 
Interface prior to running this script.

b. In the Import to Library box, select the PADS Layout library to which you want to 
add the DxDesigner parts.

Tip: You can click New Library to create a new PADS library. By default, libraries 
are located at C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Libraries. 
The new library is added at the bottom of the library list and search order.

c. Set the Import Mode for Library Parts.

10. Click Finish.

Method 3—Manual Create a New PCB Design
Use the DxDesigner PCB Interface to set basic options in the configuration file and output the 
netlist files. Import the part file (.p) into the library, and import the .asc file into the design.

Procedure

1. DxDesigner Tools menu > PCB Interface.

2. In the PCB Interface dialog box, on the Basic tab, click Create Netlist for Layout.

3. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
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configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

4. Make necessary settings on the Advanced and Constraints tabs of the dialog box.

5. If other modifications to the configuration file are needed, open the file in a text editor 
and make them.

6. Clear the Run command line after processing check box.

7. Click OK.

Result: The PCB Interface creates the following netlisting files: *.asc, *.fdc, *.ndc, *.p, 
*.db.

8. PADS Layout File menu > Library.

9. In the Library Manager dialog box, select the library into which you want to import the 
DxDesigner parts.

10. Click the Parts button.

11. Click Import.

12. In the Library Import File dialog box, browse for the .p file and then click Open.

13. Close the Library Manager.

14. File menu > Import.

15. In the File Import dialog box, browse for the .asc file and then click Open.

Result

All component decals (footprints) appear in PADS Layout stacked on the origin. 

If there are errors during the .asc file import, an ascii.err file will open in your default text 
editor. All errors must be fixed, and you must repeat the process until there are no errors. No 
errors file is generated if no errors are found. The following are reported in the errors report file:

• Library issues

• Single or zero pin nets

• Totally floating connections or subnets

• Unnamed dangling connections (one end floating)

• Power and Ground symbols used on nets whose name is different from the default name 
on the symbol
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• Multiple subnet nets where one or more subnets is missing an off-page symbol

• Single subnet nets with an off-page symbol (lonely subnet warning)

• User named subnets that have no visible net name label

Related Topics

Passing Attributes in the Concepts Guide.

Cross-Probing with DxDesigner
Use the DxDesigner Link to connect DxDesigner to PADS Layout and cross-probe.

Requirements

• You must have both DxDesigner and PADS Layout on the same computer.

• Ensure that cross-probing is turned on in DxDesigner; click Setup > Cross Probing. If 
there is a check mark to the left of Cross Probing, this option is already turned on.

Procedure

1. In PADS Layout with your layout design open, on the Tools menu, click DxDesigner.

Result: In the DxDesigner Link, on the Documents tab, the pathname of your design 
appears in the PADS Layout Design box and the Connect button has changed to a 
Disconnect button since you are connected to the PADS Layout design.

2. In the DxDesigner Project File box, accept the file shown or browse for the 
corresponding schematic. Once your DxDesigner project pathname is in the box, click 
Connect.

3. If there are multiple designs available in the DxDesigner project, select the design you 
want from the Design Name list.

4. If necessary, resize the windows so you can see the DxDesigner Link dialog box and 
both applications.

5. On the Selection tab in the Selection Passing area, select both the DxDesigner to PADS 
Layout and PADS Layout to DxDesigner check boxes to enable bi-directional 
selection.

6. Besides selecting components in PADS Layout, you can also zoom to selections or keep 
your own zoom level and pan to selections. In the PADS Layout list, choose from None, 
Zoom to Selected, or Pan to Selected. 

7. If you are using cross-probing to place parts on the PCB, you can identify which parts 
are placed and which parts are unplaced, using the Placement tab. 



Working with DxDesigner
Comparing the PCB Layout Against the DxDesigner Design

PADS Layout User’s Guide and Reference Manual, PADS 9.4 301

Tip: Parts are considered placed when they are located within the board outline.

Result

Selections can now be passed back and forth. Cross-probing can also be used for placing 
components on the PCB based on schematic sheet selections.

Related Topics

Managing the Selection List in the Concepts Guide

Comparing the PCB Layout Against the 
DxDesigner Design

There are three ways to compare a DxDesigner schematic design against a PADS Layout design 
to obtain a differences report.

Choosing a Method

Method 1—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method is the simplest and is controlled from PADS Layout.

Method 2—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method requires more steps and is controlled from DxDesigner.

Method 3—Use if you don’t have DxDesigner on your computer and the netlist files are sent to 
you from the schematic engineer.

Method 1—Using the DxDesigner Link
Use the DxDesigner Link to connect DxDesigner to PADS Layout and generate a differences 
report.

Requirement

You must have both DxDesigner and PADS Layout on the same computer.

Procedure

1. In PADS Layout with your layout design open, on the Tools menu, click DxDesigner.

Result: In the DxDesigner Link, on the Documents tab, the pathname of your design 
appears in the PADS Layout Design box and the Connect button has changed to a 
Disconnect button since you are connected to the PADS Layout design.
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2. In the DxDesigner Project File box, accept the file shown or browse for the 
corresponding schematic. Once your DxDesigner project pathname is in the box, click 
Connect.

3. If there are multiple designs available in the DxDesigner project, select the design you 
want from the Design Name list.

4. If necessary, resize the windows so you can see the DxDesigner Link dialog box and 
both applications.

5. On the Preferences tab, select items to be compared.

6. On the Documents tab, click Compare Designs.

Result

DxDesigner Link generates and displays three files:

• A differences file (.dif) that reports the differences between the schematic and layout 
design files.

• An error report (.err).

• An Engineering Change Order file (.eco). The forward and backward annotation 
operations use this file to synchronize the layout design and the schematic files.

Method 2—Using DxDesigner’s PCB Interface Script
Use the script of the DxDesigner PCB Interface to generate a differences report. 

Requirement

You must have both DxDesigner and PADS Layout on the same computer.

Procedure

1. DxDesigner Tools menu > PCB Interface.

2. In the PCB Interface dialog box, on the Basic tab, click Create Netlist for Layout.

3. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.
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4. Make necessary settings on the Advanced and Constraints tabs of the dialog box 
according to the requirements of your design.

5. If other modifications to the configuration file are needed, open the file in a text editor 
and make them.

6. On the Basic tab, select the Run command line after processing check box. For more 
infomation on the script, see Using the PCB Interface PADS layout Script.

7. Click OK.

Result: The PCB Interface creates the netlisting files and the DxDesigner To PADS 
Layout dialog box appears.

8. In the DxDesigner To PADS Layout dialog box:

a. Click Compare Schematic with existing PCB design.

b. If your design pathname doesn’t appear in the PCB Design Filename (*.pcb) box, 
type the pathname or browse for your PCB design.

c. Select the Generate Differences Report check box and clear the Update check 
boxes.

d. Click Next.

9. In the Library Import Options dialog box clear the Update Part Types in Library 
check box.

10. Click Next.

11. In the ECO Compare Options dialog box, set the comparison options you need.

12. Click Finish.

Result

The following files are created and located in the DxDesigner project folder:

• A differences file (powerpcb.rep) that reports the differences between the schematic and 
layout design files.

• An error report (ecogen.err).

• An Engineering Change Order file (*.eco). The forward and backward annotation 
operations use this file to synchronize the layout design and the schematic files.

Method 3—Manual Comparison
Use the DxDesigner PCB Interface to set basic options in the configuration file and output the 
netlist files. Use the Compare/ECO Tools to compare the designs and create a differences 
report.
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Procedure

1. DxDesigner Tools menu > PCB Interface.

2. In the PCB Interface dialog box, on the Basic tab, click Create Netlist for Layout.

3. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

4. Make necessary settings on the Advanced and Constraints tabs of the dialog box.

5. If other modifications to the configuration file are needed, open a text editor and make 
them.

6. Clear the Run command line after processing check box.

7. Click OK.

Result: The PCB Interface creates the following netlisting files: *.asc, *.fdc, *.ndc, 
*.p, *.db.

8. In PADS Layout, on the Tools menu, click Compare/ECO.

9. In the Compare/ECO Tools dialog box, on the Documents tab, if you know which 
design is older and which is newer, choose the appropriate design for both the Original 
Design to Compare and Update, and New Design with Changes areas. If you don’t know 
which design is older and which is newer then do the following:

• In the Original Design to Compare and Update area, browse for the .asc netlist file in 
your DxDesigner project directory.

Tip: Don’t forget to change the Files of type from PADS Layout Files (*.pcb) to 
ASCII Files (*.asc).

10. In the Output Options area, select the Generate Differences Report check box. Clear 
the other Output Options check boxes.

11. On the Comparison tab, set the comparison options.

12. On the Update tab, clear all check boxes.

13. Click Run.

14. In the Process Status dialog box, click Show Report.
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Result

The following files are created and located in the PADS Layout working folder:

• A differences file (layout.rep) that reports the differences between the schematic and 
layout design files.

• A log file (layout.log).

Forward Annotating from DxDesigner to PADS 
Layout

When laying out a design, there may be changes in the schematic that you want to import into 
the design. This process is called forward annotation. There are three ways to forward annotate 
design changes from DxDesigner to PADS Layout.

Tip: To avoid unexpected changes during forward annotation, consider comparing data before 
you forward-annotate. For more information, see Comparing the PCB Layout Against the 
DxDesigner Design.

Choosing a Method

Method 1—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method is the simplest. This method requires you to open the PCB configuration file 
in a text editor to make changes to it.

Method 2—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method provides the most control of the process. You can use the the tabbed screens 
in DxDesigner’s PCB Interface to make basic changes to the PCB configuration file and control 
the constraints.

Method 3—Use if you don’t have DxDesigner and PADS Layout on your computer and the 
netlist files are sent to from the schematic engineer to the layout designer.

Method 1—Automated Foward Annotation Using the 
DxDesigner Link

Use the DxDesigner Link to connect DxDesigner to PADS Layout and forward-annotate design 
changes from the schematic to the layout. Forward annotation compares data from a newer 
DxDesigner schematic to an older PADS Layout design file and updates the PADS Layout 
design to match the schematic.

Requirement

• You must have both DxDesigner and PADS Layout on the same computer.
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Procedure

1. With your design open in PADS Layout, on the Tools menu, click DxDesigner.

Result: In the DxDesigner Link, on the Documents tab, the pathname of your design 
appears in the PADS Layout Design box and the Connect button has changed to a 
Disconnect button since you are connected to the PADS Layout design.

2. In the DxDesigner Project File area, accept the file shown or browse for the 
corresponding DxDesigner project file (*.prj). Once your DxDesigner project pathname 
is in the box, click Connect.

3. If there are multiple designs available in the DxDesigner project, select the design you 
want from the Design Name list.

4. In the Forward/Backward configuration file area, click Browse to locate the 
pads<latest_version>.cfg file to use for forward or backward annotation between the 
two applications. 

Tip: Create a copy of the default configuration file and put it in your DxDesigner project 
directory. Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

5. If you need to modify the config file settings, click Edit to modify the file in your 
default text editor.

See also: PCB Interface Configuration Files chapter in the DxDesigner PCB Interfaces 
User Guide.

6. On the Library tab, select an import mode for Library Parts and choose a library.

Tip: You can click New Library to create a new PADS library. By default, libraries are 
located at C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Libraries. The new 
library is added at the bottom of the library list and search order.

7. On the Preferences tab, select items to be compared during forward annotation.

Tip: DxDesigner Link stores your preferences for future operations. You need to 
perform this step only if you want to change the preferences you selected previously.

8. On the Documents tab, click Forward to PCB.

9. In the Forward Annotation dialog box, select Update PCB.

10. In the Data to pass to PCB area, select the schematic data to send to the PADS Layout 
design.
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Requirement: To include design rules in the forward annotation operation, select the 
Design Rules option, even if you already selected Compare Design Rules on the 
Preferences tab.

Optional. Select the Pause before Updating PCB Design check box. Selecting this 
option gives you the chance to review the ECO file containing changes that the update 
will make to the PADS Layout design. Then you can click Continue to update the layout 
or cancel it.

11. Click OK.

12. In the Process Indicator dialog box, after the forward process if finished, click Close.

Result

DxDesigner Link compares the data in the schematic to the existing layout design and updates 
the layout design with changes.

Related Topics

Cross-Probing with DxDesigner

Method 2—Automated Foward Annotation Using 
DxDesigner’s PCB Interface Script

Use the DxDesigner PCB Interface to set basic options in the configuration file and use the 
command line script to automate the forward annotation between DxDesigner and PADS 
Layout. Forward annotation compares data from a newer DxDesigner schematic to an older 
PADS Layout design file and updates the PADS Layout design to match the schematic.

Requirement

You must have both DxDesigner and PADS Layout on the same computer.

Procedure

1. DxDesigner Tools menu > PCB Interface.

2. In the PCB Interface dialog box, on the Basic tab, click Create Netlist for Layout.

3. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.
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4. Make necessary settings on the Advanced and Constraints tabs of the dialog box 
according to the requirements of your design.

5. If other modifications to the configuration file are needed, open a text editor and make 
them.

6. Select the Run command line after processing check box. For more infomation on the 
script, see Using the PCB Interface PADS layout Script.

7. Click OK.

Result: The PCB Interface creates the netlisting files and the DxDesigner To PADS 
Layout dialog box appears.

8. In the DxDesigner To PADS Layout dialog box:

a. Click Compare Schematic with existing PCB design.

b. If your design pathname doesn’t appear in the PCB Design Filename (*.pcb) box, 
type the pathname or browse for your PCB design.

c. Set the remaining options to the requirements of your design.

d. Click Next.

9. In the Library Import Options dialog box if you want to transfer part types from 
DxDesigner to PADS Layout, select the Update Part Types in Library check box. If 
not, clear the check box and click Next.

a. Browse for the Part Type ASCII File if it’s not already listed. This .p file, along with 
the rest of the netlist files, is created in your DxDesigner Project folder by the PCB 
Interface prior to running this script.

b. In the Import to Library box, select the PADS Layout library to which you want to 
add the DxDesigner parts.

Tip: You can click New Library to create a new PADS library. By default, libraries 
are located at C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Libraries. 
The new library is added at the bottom of the library list and search order.

c. Set the Import Mode for Library Parts.

d. Click Next.

10. In the ECO Compare Options dialog box, set the options to the requirements of your 
design.

11. Click Finish.

Result

The .eco file is generated and imported by PADS Layout. If there are errors during the import, 
an ascii.err file will open in your default text editor. All errors must be fixed, and you must 
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repeat the process until there are no errors. No errors file is generated if no errors are found. The 
following are reported in the errors report file:

• Library issues

• Single or zero pin nets

• Totally floating connections or subnets

• Unnamed dangling connections (one end floating)

• Power and Ground symbols used on nets whose name is different from the default name 
on the symbol

• Multiple subnet nets where one or more subnets is missing an off-page symbol

• Single subnet nets with an off-page symbol (lonely subnet warning)

• User named subnets that have no visible net name label

Method 3—Manual Foward Annotation
Use the DxDesigner PCB Interface to set basic options in the configuration file and output the 
netlist files. Use the Compare/ECO Tools to compare the differences to the PCB design and 
import the changes into PADS Layout. Forward annotation compares data from a newer 
DxDesigner schematic to an older PADS Layout design file and updates the PADS Layout 
design to match the schematic.

See also: Comparing the PCB Layout Against the DxDesigner Design

Procedure

1. DxDesigner Tools menu > PCB Interface.

2. In the PCB Interface dialog box, on the Basic tab, click Create Netlist for Layout.

3. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

4. Make necessary settings on the Advanced and Constraints tabs of the dialog box.

5. If other modifications to the configuration file are needed, open a text editor and make 
them.

6. Clear the Run command line after processing check box.
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7. Click OK.

Result: The PCB Interface creates the following netlisting files: *.asc, *.fdc, *.ndc, 
*.p, *.db.

8. In PADS Layout, on the Tools menu, click Compare/ECO.

9. In the Compare/ECO Tools dialog box, on the Documents tab, in the New Design with 
Changes area, clear the Use Current PCB Design check box. Browse for the .asc netlist 
file in your DxDesigner project directory. 

Tip: Don’t forget to change the Files of type from PADS Layout Files (*.pcb) to ASCII 
Files (*.asc).

10. In the Original Design to Compare and Update area, select the Use Current PCB 
Design check box.

11. In the Output Options area, select the Generate ECO File check box. Clear the other 
Output Options check boxes.

12. On the Comparison tab, set the options according to the needs of your design.

13. On the Update tab, in the Update Options area, select the Update Original Design 
check box.

Alternative: If you don’t use this option, you need to import the .asc after you update 
the library with the .p file.

14. In the Library area, select the Update Part Types in Library check box. In the Part 
Type ASCII File box, browse for the .p netlist file in your DxDesigner project directory.

Alternative: If you don’t use this option, you need to import the .p file into the library 
using the Library Manager.

15. Choose the library to use and set the Import Mode.

Tip: You can click New Library to create a new PADS library. By default, libraries are 
located at C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Libraries. The new 
library is added at the bottom of the library list and search order.

16. Click Run.

Result

The .p file is imported into the library and the .eco file is generated and imported by PADS 
Layout. If there are errors during the import, an ascii.err file will open in your default text 
editor. All errors must be fixed, and you must repeat the process until there are no errors. No 
errors file is generated if no errors are found. The following are reported in the errors report file:

• Library issues

• Single or zero pin nets
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• Totally floating connections or subnets

• Unnamed dangling connections (one end floating)

• Power and Ground symbols used on nets whose name is different from the default name 
on the symbol

• Multiple subnet nets where one or more subnets is missing an off-page symbol

• Single subnet nets with an off-page symbol (lonely subnet warning)

• User named subnets that have no visible net name label

Back Annotating from PADS Layout to 
DxDesigner

When laying out a design, you may make engineering changes and want to update the schematic 
with those changes. This process is called backward annotation. There are three ways to back 
annotate design changes from PADS Layout to DxDesigner.

Tip: To avoid unexpected changes during back annotation, consider comparing data before you 
back-annotate. For more information, see Comparing the PCB Layout Against the DxDesigner 
Design.

Caution
Make sure you record ECO changes in an .eco file as you make them. For more details, 
see Recording ECO Changes. Recording ECO changes ensures the best results when 
compared to generating and ECO file by comparing the designs. For more details on the 
differences of these methods, see Recording Versus Generating an ECO File in the 
Concepts Guide.

Choosing a Method

Method 1—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method is the simplest. This method requires you to open the PCB configuration file 
in a text editor to make changes to it.

Method 2—Use if you have both DxDesigner and PADS Layout on your computer. This 
automated method provides the most control of the process. You can use the the tabbed screens 
in DxDesigner’s PCB Interface to make basic changes to the PCB configuration file and control 
the constraints.

Method 3—Use if you don’t have both DxDesigner and PADS Layout on your computer and 
the netlist files are sent from the layout designer to the schematic engineer.
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Method 1—Automated Backward Annotation Using the 
DxDesigner Link

Use the DxDesigner Link to connect DxDesigner to PADS Layout and back-annotate design 
changes from the layout to the schematic. Back annotation compares data from an older 
DxDesigner schematic to a newer PADS Layout design file and updates the DxDesigner 
schematic to match the layout design.

Requirement

• You must have both DxDesigner and PADS Layout on the same computer.

Procedure

1. With your design open in PADS Layout, on the Tools menu, click DxDesigner.

Result: In the DxDesigner Link, on the Documents tab, the pathname of your design 
appears in the PADS Layout Design box and the Connect button has changed to a 
Disconnect button since you are connected to the PADS Layout design.

2. In the DxDesigner Project File area, accept the file shown or browse for the 
corresponding DxDesigner project file (*.prj). Once your DxDesigner project pathname 
is in the box, click Connect.

Result: The DxDesigner window becomes active and may have covered the 
DxDesigner Link dialog box. Return to the DxDesigner Link.

3. If there are multiple designs available in the DxDesigner project, select the design you 
want from the Design Name list.

4. In the Forward/Backward configuration file area, click Browse to locate the 
pads<latest_version>.cfg file to use for forward or backward annotation between the 
two applications. 

Tip: Create a copy of the default configuration file and put it in your DxDesigner project 
directory. Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

5. If you need to modify the config file settings, click Edit to modify the file in your 
default text editor.

See also: PCB Interface Configuration Files chapter in the DxDesigner PCB Interfaces 
User Guide.

6. On the Preferences tab, select items to be compared during forward annotation.
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Tip: DxDesigner Link stores your preferences for future operations. You need to 
perform this step only if you want to change the preferences you selected previously.

7. On the Documents tab, click Backward from PCB.

8. In the Backward Annotation dialog box, choose one of the ECO preferences.

9. In the Data to pass to PCB area, select the layout data to send to the PADS Layout 
design.

Requirement: To include design rules in the forward annotation operation, select the 
Design Rules option, even if you already selected Compare Design Rules on the 
Preferences tab.

Optional. Select the Pause before Updating PCB Design check box. Selecting this 
option gives you the chance to review the ECO file containing changes that the update 
will make to the PADS Layout design. Then you can click Continue to update the layout 
or cancel it.

10. Click OK.

11. In the Process Indicator dialog box, after the forward process if finished, click Close.

Result

DxDesigner Link compares the new data in the layout to the older schematic design and updates 
the schematic design with changes. The pcb.err file opens to display any errors, warnings, or 
notes regarding the update.

Related Topics

Cross-Probing with DxDesigner

Method 2—Automated Backward Annotation Using 
DxDesigner’s PCB Interface Script

Use the DxDesigner PCB Interface to set basic options in the configuration file and use the 
command line script to automate the back annotation between PADS Layout and DxDesigner. 
Back annotation compares data from an older DxDesigner schematic to a newer PADS Layout 
design file and updates the DxDesigner schematic to match the layout design.

Requirement

You must have both DxDesigner and PADS Layout on the same computer.

Procedure

1. DxDesigner Tools menu > PCB Interface.
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2. In the PCB Interface dialog box, on the Basic tab, click Back Annotate Information 
From Layout to Schematic.

3. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

4. Make necessary settings on the Advanced and Constraints tabs of the dialog box 
according to the requirements of your design.

5. If other modifications to the configuration file are needed, open a text editor and make 
them.

6. Select the Run command line before processing check box. For more infomation on 
the script, see Using the PCB Interface PADS layout Script.

7. Click OK.

8. In the PADS Layout To DxDesigner dialog box.

9. Ensure your .pcb file is listed in the PCB Design Filename (*.pcb) box.

10. Choose an ECO File Option.

• If you selected Create ECO File Using Netlist Comparison, you must click Next and 
in the ECO Compare Options dialog box, set the options to the requirements of your 
design.

11. Click Finish.

Result

The script generates the .asc and .eco files required for back annotation and then the PCB 
Interface back annotates the files into DxDesigner.

Method 3—Manual Backward Annotation
Use the Compare/ECO Tools in PADS Layout to compare the differences between the new 
PCB design and the older schematic design and generate a .asc and .eco file. Use the 
DxDesigner PCB Interface to set basic options in the configuration file and process the .asc and 
.eco file from PADS Layout to create the .baf file and update the schematic design to match the 
layout design.

See also: Comparing the PCB Layout Against the DxDesigner Design
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Procedure

1. PADS Layout Tools menu > Compare/ECO.

2. In the Compare/ECO Tools dialog box, on the Documents tab, in the New Design with 
Changes area, select the Use Current PCB Design check box.

3. In the Original Design to Compare and Update area, clear the Use Current PCB Design 
check box. Browse for the original .asc netlist file output from the DxDesigner design.

Tip: Don’t forget to change the Files of type from PADS Layout Files (*.pcb) to ASCII 
Files (*.asc).

4. In the Output Options area, select the Generate ECO File check box and type a 
pathname or browse for the location to save the file.

5. Select the Generate ASCII File for Back Annotation to Schematic check box and 
type a pathname or browse for the location to save the file.

6. On the Comparison tab, set the options according to the needs of your design.

7. On the Update tab, clear the Update Part Types in Library check box.

8. Click Run.

9. In the Process Status dialog box, click Close.

10. Move the .asc and .eco file to the DxDesigner Project directory and ensure the name of 
the files matches the name of the DxDesigner project. 

Tip: Rename the original .asc file from the schematic so that you don’t overwrite it with 
the one being used for back annotation.

11. DxDesigner Tools menu > PCB Interface.

12. In the PCB Interface dialog box, on the Basic tab, click Back Annotate Information 
From Layout To Schematic.

13. Clear the Run command line after processing check box.

14. Create a copy of the default configuration file and put it in your project directory.

Tip: Default configuration files are located at 
C:\MentorGraphics\<latest_version>PADS\SDD_HOME\standard. There are often 
configuration files for several versions. Use the latest version. You copy the 
configuration file to your DxDesigner project directory to customize the configuration 
file for your local project and to prevent overwriting the master copy that came with the 
software.

15. On the Advanced tab, select the Automatically Back Annotate Changes to Schematic 
check box.
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16. Make any other necessary settings on the Advanced and Constraints tabs of the dialog 
box.

17. If other modifications to the configuration file are needed, open the file in a text editor to 
make the changes.

18. If your changes in the PCB Interface dialog box have changed the configuration file, 
click Save Pcb Configuration.

19. Click OK.

Working with Variants
• Importing Variant Data to PADS Layout

• Importing Variant Data to PADS Layout Manually

• Exporting Variant Data to DxDesigner

• Comparing Variant Data Files

Importing Variant Data to PADS Layout
Using the DxDesigner Link, you can import Variant Manager data into the PADS Assembly 
Variants feature.

Requirements

• Both the DxDesigner design and PADS Layout design must be open.

• Before you can transfer variant data, the DxDesigner design and PADS Layout design 
must be synchronized. In other words, the reference designators must match in both 
designs. If not, you must perform regular forward or backward annotation to 
synchronize the design.

Procedure

1. On the Tools menu, click DxDesigner.

2. In the DxDesigner Link, on the Documents tab, connect to the DxDesigner Project File.

3. On the Variants tab, click the Create DxD AV file button. This creates the 
<project_name>_DxDVariants.asc and adds the path to the DxDesigner AV ASCII file 
field in preparation for the next step.

Alternative: Using a more manual process, you can create the .asc file from 
DxDesigner and then type or browse for the path in the Variants tab DxDesigner AV 
ASCII file field. For more information, see the Variant Manager Users Manual for the 
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Export data to PADS button. This method could be used if your setup does not allow a 
direct connection between DxDesigner and PADS using the DxDesigner Link.

4. Optionally, click the Show DxD Variants button to preview the assembly variant data 
file.

5. Click Import AV to PADS Layout to import the assembly variant data into the 
Assembly Variants feature.

Checking the Result

You can check to ensure the variant data imported properly.

1. On the Tools menu, click Assembly Variants.

2. In the Name list, select a variant.

3. In the list of reference designators, check the status of components and compare the 
results to Variant Manager in DxDesigner.

Related Topics

DxDesigner Dialog Box, Variants Tab

DxDesigner’s Variant Manager Users Manual

Importing Variant Data to PADS Layout Manually

Exporting Variant Data to DxDesigner

Comparing Variant Data Files

Importing Variant Data to PADS Layout Manually
You can import variant data manually by exporting and then importing the data file.

Requirements

• Before you can transfer variant data, the DxDesigner design and PADS Layout design 
must be synchronized. In other words, the reference designators must match in both 
designs. If not, you must perform regular forward or backward annotation to 
synchronize the design.

Procedure

1. Open the design in DxDesigner, and open Variant Manager.

2. On the Variant Manager toolbar, click the Export data for PADS button.

3. Open the design in PADS Layout, and on the File menu, click Import.
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4. In the Import dialog box, browse for the location of the 
<project_name>_DxDVariants.asc file. It is located in the same folder as the .prj file of 
the DxDesigner project.

5. Import the file.

Checking the Result

You can check to ensure the variant data imported properly.

1. On the Tools menu, click Assembly Variants.

2. In the Name list, select a variant.

3. In the list of reference designators, check the status of components and compare the 
results to Variant Manager in DxDesigner.

Related Topics

DxDesigner Dialog Box, Variants Tab

DxDesigner’s Variant Manager Users Manual

Importing Variant Data to PADS Layout

Exporting Variant Data to DxDesigner

Comparing Variant Data Files

Exporting Variant Data to DxDesigner
Using the DxDesigner Link, you can export Assembly Variants data into the DxDesigner 
Variant Manager.

Requirements

• Both the DxDesigner design and PADS Layout design must be open.

• Before you can transfer variant data, the DxDesigner design and PADS Layout design 
must be synchronized. In other words, the reference designators must match in both 
designs. If not, you must perform regular forward or backward annotation to 
synchronize the design.

Procedure

1. On the Tools menu, click DxDesigner.

2. In the DxDesigner Link, on the Documents tab, connect to the DxDesigner Project File.
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3. On the Variants tab, click the Create PADS AV file button. This creates the 
<project_name>_PADSVariants.asc and adds the path to the PADS Layout AV ASCII 
file field in preparation for the next step.

4. Optionally, click the Show PADS Variants button to preview the assembly variant data 
file.

5. Click Import AV to DxDesigner to import the assembly variant data into DxDesigner’s 
Variant Manager.

Checking the Result

You can check to ensure the variant data imported properly.

• In DxDesigner, in Variant Manager, check the status of components and compare the 
results to the Assembly Variants feature in PADS Layout.

Related Topics

DxDesigner Dialog Box, Variants Tab

DxDesigner’s Variant Manager Users Manual

Importing Variant Data to PADS Layout

Importing Variant Data to PADS Layout Manually

Comparing Variant Data Files

Comparing Variant Data Files
In the DxDesigner Link, you can compare the DxDesigner assembly variant data file from 
Variant Manager with the PADS Layout assembly variant data file from Assembly Variants.

Requirement

In the DxDesigner Link, you must be connected to at least one or both of DxDesigner or PADS 
Layout to enable the Variants tab.

Procedure

1. On the Tools menu, click DxDesigner.

2. In the DxDesigner Link, click the Variants tab.

3. Add the path to the DxDesigner assembly variant data file into the DxDesigner AV 
ASCII file field.

4. Add the path to the PADS assembly variant data file into the PADS Layout AV ASCII 
file field.
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5. Click the Compare AV ASCII button.

Result: The VariantCheck.txt report file opens.

Related Topics

DxDesigner Dialog Box, Variants Tab

DxDesigner’s Variant Manager Users Manual

Importing Variant Data to PADS Layout

Importing Variant Data to PADS Layout Manually

Exporting Variant Data to DxDesigner
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Chapter 11
Working with PADS Logic

In this chapter:

• Creating a New PCB Layout from a PADS Logic Design

• Cross Probing with PADS Logic

• Forward-Annotating Design Changes from PADS Logic

• Backward Annotating from PADS Layout to PADS Logic

• Backward Annotation Results

Creating a New PCB Layout from a PADS Logic 
Design

There are two ways to create a new PCB design from a PADS Logic design.

Caution

Forward annotation of changes to an existing design requires a different process. See Forward-
Annotating Design Changes from PADS Logic.

Restriction

Transferring non ECO registered parts and non electrical parts is constrained by settings in the 
Options. See the Options dialog box, Design page in PADS Logic for details.

Choosing a Method

Method 1—Use if you have both PADS Logic and PADS Layout on your computer. This 
automated method is the simplest. It uses the PADS Layout Link within PADS Logic. For more 
information, see Method 1—Automatic Netlist Process Using the PADS Layout Link in the 
PADS Logic User’s Guide.

Method 2—Use if you don’t have both PADS Logic and PADS Layout on your computer. This 
manual method requires you to manually export the netlist from PADS Logic and then import it 
into PADS Layout.
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Method 2—Importing the PADS Logic Netlist

Requirement

This is a continuation of a process started in PADS Logic. You must have the netlist (*.asc) file. 
For more information, see Method 2—Manual Netlist Process Between PADS Logic and PADS 
Layout in the PADS Logic User’s Guide.

Procedure

1. In PADS Layout, click File menu > Import.

2. Select ASCII Files (*.asc) in the Files of type box.

3. Navigate to the location of the netlist file created from the PADS Logic design, select it, 
and click Open.

Result

The import process sources all the part types and decals from the library and stacks the decals at 
the origin. You can then use the Tools menu > Disperse Components command to spread out 
the components.

If an errors report file (ascii.err) is generated and errors are found in the netlist, see 
Toubleshooting the Netlist Process for more information.

Toubleshooting the Netlist Process
If errors are found in the netlist import process, an errors report file (ascii.err) is generated, and 
the error report file is displayed in a Notepad window. No errors file is generated if no errors are 
found. The following are reported in the errors report file:

• Library issues

• Single or zero pin nets

• Totally floating connections or subnets

• Unnamed dangling connections (one end floating)

• Power and Ground symbols used on nets whose name is different from the default name 
on the symbol

• Multiple subnet nets where one or more subnets is missing an off-page symbol

• Single subnet nets with an off-page symbol (lonely subnet warning)

• User named subnets that have no visible net name label

If an ascii.err file is generated, perform the following steps:
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1. PADS Layout File menu > New

2. Click No when you are prompted to save the design.

3. Add any missing components listed in the ascii.err file to your library, either by adding a 
library which contains the missing components to your library list, or by creating the 
missing part types and decals. (See Adding Libraries to the Library List, Creating and 
Modifying Part Types, and Creating and Editing PCB Decals for information on how to 
do this.)

4. Resolve any other errors found in the ascii.err file.

5. When all the errors have been resolved, repeat the procedure you used to pass the netlist 
from PADS Logic to PADS Layout.

Related Topics

Creating a New PCB Layout from a PADS Logic Design

Cross Probing with PADS Logic
Cross probing with PADS Logic is controlled using the PADS Layout Link within PADS 
Logic. For instructions, see Cross-probing Between PADS Products in the PADS Logic User’s 
Guide.

Forward-Annotating Design Changes from PADS 
Logic

You can import design changes from PADS Logic into PADS Layout. The ECO file, containing 
the design changes, is created by comparing the schematic and the layout design. There are 
three ways to bring forward design changes from the PADS Logic design.

Tip: If you’re creating a new PCB by importing a netlist for the first time, see Creating a New 
PCB Layout from a PADS Logic Design.

Caution
Design changes resulting from forward-annotating can cause existing associated nets to 
be truncated, split, or deleted altogether. It can also cause existing associated nets to be 
extended or new associated nets to be created if the refdes prefixes of updated 
components are specified in the Associated Nets dialog box. For more information, see 
the Associated Nets chapter in this manual.

Restrictions

• During design comparison, a reuse definition is ignored and actual elements in the 
physical design reuse are used in the comparison.
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• Transferring non-ECO-registered parts and non-electrical parts is constrained. See the 
override settings in the Design page of the PADS Logic Options.

Choosing a Method

• Use Method 1 if you have both PADS Logic and PADS Layout on your computer. This 
automated method is simpler and faster.

• Use Method 2 if you don’t have both PADS Logic and PADS Layout on your computer, 
and you want to compare the designs in PADS Layout to generate the .eco file. This 
method is somewhat quicker than Method 3 since the Compare/ECO tool in PADS 
Layout can automatically import the file after the designs are compared.

• Use Method 3 if you don’t have both PADS Logic and PADS Layout on your computer, 
and you want to compare the designs in PADS Logic to generate the .eco file.

Method 1—Automated Forward Annotation Process
See Method 1—Automated Forward Annotation Process in the PADS Logic User’s Guide. This 
process is controlled entirely by the PADS Layout Link within PADS Logic.

Method 2—Generate the ECO File in PADS Layout
This is a continuation of the procedure Method 2—Generate the ECO File in PADS Layout in 
the PADS Logic User’s Guide. You receive an updated netlist file from PADS Logic and 
compare it to the current PCB layout to generate an .eco file that you import to update the PCB 
layout.

Requirement

You must acquire an updated schematic netlist (.asc) file, and have the PCB design open in 
PADS Layout.

Procedure

Tip: There is no undo after an .eco file import. If you think you might want to revert to the 
state of the design before the import, you should save a copy of the PCB layout.

1. PADS Layout Tools menu > Compare/ECO

2. In the Compare/ECO dialog box, click the Documents tab.

3. In the Original Design to Compare and Update area, select the Use Current PCB 
Design check box.

Tip: If the check box is unavailable, clear the check box in the New Design with 
Changes area.
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4. In the New Design with Changes area, browse for the updated schematic netlist (asc.) 
file.

5. Click the Comparison Tab, and select the options you want to use for design 
comparison.

6. Optional: If you want to check the design differences before creating the ECO file, 
select only the Generate Differences Report check box in the Documents tab, and 
click Run.
The netlist and PCB files are compared and differences written to Layout.rep in the 
\PADS Projects folder. To see the differences, click Show Report in the Process Status 
dialog box.

7. Select the Generate ECO File check box, and verify the ECO Filename. 
Tip: Give the file a unique name to avoid overwriting any existing ECO files.

8. Click the Update Tab, and select the Update Original Design check box.

Tip: This saves you from manually importing the generated ECO file.

9. Set the other options for updating.

10. Click Run. Output files are written to the \PADS Projects folder.

Tip: In addition to the files listed above, messages or errors that occur during 
comparison are also written to Layout_Session.log and Layout.err in the \PADS Projects 
folder. 

Results

The files generated are:

     <pcb_name>mine.eco The ECO file. Contains ECO commands 
that describe the changes needed to update 
the original design to match the new 
design. Generated when you select 
Generate ECO File from the 
Compare/ECO Tools Documents Tab.
See also: ECO File Format in the 
Concepts Guide.

     Layout.rep The Differences Report file. Describes the 
differences between the “old” and the 
“new” compared files. Generated when 
you select Generate Differences Report 
from the Compare/ECO Tools Documents 
Tab.
See also: Differences Report in the 
Concepts Guide.
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Method 3—Import the ECO File from PADS Logic
This is the PADS Layout portion of the procedure Method 3—Generate the ECO File in PADS 
Logic in the PADS Logic User’s Guide. You import the .eco file of design changes into PADS 
Layout.

Tip: As long as the PCB design hasn’t undergone engineering changes, the last .asc file from 
PADS Logic can be compared to the current design in PADS Logic to generate the .eco file of 
the engineering changes in the design. If the last exported .asc file is lost, you can export a .asc 
file from PADS Layout to compare against the current schematic to generate the .eco file that 
gets imported into PADS Layout to update the PCB layout. The same effect is created using 
Method 2 and the process is semi-automated by automatically importing the .eco file.

Requirement

You must acquire an .eco file, and have the PCB design open in PADS Layout.

Procedure

Tip: There is no undo after an .eco file import. If you think you might want to revert to the state 
of the design before the import, you should save a copy of the PCB layout.

1. File menu > Import.

2. On the File Import dialog box, select the ECO Files (*.eco) file type.

3. Browse to the file to import and click Open.

Result

If there are errors during the import, an eco.err file will open in your default text editor. No 
chnages are made to the PCB layout until the .eco file is imported without errors. A link to the 
ECO Import errors file, is also written to the Output window.

Backward Annotating from PADS Layout to 
PADS Logic

You can export your PCB layout changes “back” to the schematic. This process is called 
backward annotation. There are three methods to backward annotate design changes.

     ecogtmp0.asc
    ecogtmp1.asc

temporary copy of the “old” netlist
temporary copy of the “new” netlist

     ecogtmp[ 0|1 ].err Generated only if errors are found in the 
netlist. A link to this file is displayed in the 
Output Window.



Working with PADS Logic
Backward Annotating from PADS Layout to PADS Logic

PADS Layout User’s Guide and Reference Manual, PADS 9.4 327

You can backward annotate part, gate, pin, net, and attribute changes. For details, see Backward 
Annotation Results.

Restrictions

• Transferring non-ECO-registered parts and non-electrical parts is constrained. See 
Options dialog box, Design page for details.

• During design comparison, a reuse definition is ignored and actual elements in the 
physical design reuse are used in the comparison.

• You cannot perform backward annotation between PADS Logic and PADS Router 
because PADS Router does not export ECO files.

Choosing a Method

• If you have both PADS Logic and PADS Layout on your computer, you can use Method 
1. While this automated method is the simplest and fastest, this method is not 
recommended since it generates its own .eco file by design comparison. You should use 
Method 2 to record the .eco file in PADS Layout and manually import it into PADS 
Layout for the best results. For more information, see Recording Versus Generating an 
ECO File in the Concepts Guide.

• If PADS Layout is on another computer and you want the layout designer to generate the 
ECO file, use Method 2. This is the most accurate method. You must manually import 
the .eco file into the PADS Logic design.

• If PADS Layout is on another computer and you must compare the designs and generate 
the ECO file within PADS Logic use Method 3. This method is not recommended since 
you are generating the .eco file by design comparison. You should use Method 2 to 
record the .eco file in PADS Layout and manually import it into PADS Layout for the 
best results. For more information, see Recording Versus Generating an ECO File in the 
Concepts Guide.

Method 1—Automated Backward Annotation Process
If PADS Logic and PADS Layout are on the same computer, you can use the PADS Layout 
Link dialog box to compare a newer PCB design with an older schematic and update the older 
schematic from the newer PCB design. You can also create a differences report.

Caution
This method generates a new .eco file and does not use a recorded .eco file. Recording the 
exact changes in an .eco file gives the best back annotation results. Use Method 2 for the 
best results. For more information, see Recording Versus Generating an ECO File in the 
Concepts Guide.
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Requirement

You must have the older schematic open in PADS Logic, and the newer PCB design open in 
PADS Layout. 

Procedure

1. PADS Logic Tools menu > PADS Layout

Tip: If PADS Layout is not open, the Connect to PADS Layout dialog box appears. 
Click Open to open the PCB design you want to annotate from in PADS Layout. In the 
File Open dialog box, select the .pcb file and click Open.

2. In the PADS Layout Link dialog box, click the Design Tab.

3. Optional: If you want to check the design differences before updating, click the 
Compare PCB button
The two versions are compared and differences written to Logic.rep in the \PADS 
Projects folder. To see the report, click the logic.rep link in the Output Window.

4. On the Preferences Tab, set the appropriate options.

5. On the ECO Names Tab, set the appropriate options.

6. On the Design Tab:

a. If needed, check the Compare Design Rules and Show Net List errors report 
check boxes.

b. Click the ECO From PCB button.

Related Topics

Cross-probing Between PADS Products

Method 2—Creating the ECO File in PADS Layout
Create the .eco file of design changes using PADS Layout and then import it into the PADS 
Logic design.

This procedure only documents recording the .eco file as you made engineering changes to your 
design since it creates a perfect before and after record of changes. Generating an .eco file by 
comparing designs will be electrically correct but it does not create a perfect before and after 
record of components that are exactly identical in their part types and connections. For more 
information, see Recording Versus Generating an ECO File in the Concepts Guide.

If you neglected to record the .eco changes and you must generate the .eco file by comparing 
two designs, see Creating an ECO File by Comparing Two Versions of a Design.
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Procedure

1. Record the engineering/netlist changes in an .eco file. For more details, see Recording 
ECO Changes.

2. PADS Logic Tools menu > Options > Design page

3. Set the Allow overwriting of attribute values in design with blank values from 
library attributes check box appropriately to allow or prevent overwriting of non-
blank attribute values with blank (“placeholder”) values from the library.

4. With your design open in PADS Logic, on the PADS Logic File menu, click Import.

5. In the File Import dialog box, in the Files of Type: list, select ECO Files (*.eco).

6. Browse for and select the ECO file to import.

7. Click Open. If no errors occur, the schematic is updated. If errors occur, the schematic is 
not updated, and the errors, along with a link to the ECO Import errors file, are written to 
the Output window.

Method 3—Creating the ECO File in PADS Logic
Acquire the layout design in a .asc file format and compare it to the schematic design with the 
PADS Logic Compare/ECO tools and then import .eco file of design changes into the PADS 
Logic schematic design.

Caution
This method generates a new .eco file and does not use a recorded .eco file. Recording the 
exact changes in an .eco file gives the best back annotation results. Use Method 2 for the 
best results. For more information, see Recording Versus Generating an ECO File in the 
Concepts Guide.

Requirement

You must have a .asc file exported from PADS Layout. For more details, see Exporting an 
ASCII File.

Procedure

1. PADS Logic Tools Menu > Options >Design page

2. Set the Allow overwriting of attribute values in design with blank values from 
library attributes check box appropriately to allow or prevent overwriting of non-
blank attribute values with blank (“placeholder”) values from the library.

3. PADS Logic Tools menu > Compare/ECO

4. In the Compare/ECO dialog box, click the Documents Tab.
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5. In the Original Design to Compare and Update area, select the Use Current Schematic 
Design check box.

6. In the New Schematic Design with Changes area, browse for the new .asc file exported 
from PADS Layout.

7. Click the Comparison Tab, and select the options you want to use for design 
comparison.

8. Optional: If you want to check the design differences before creating the ECO file:

a. Select the Generate Differences Report check box in the Documents tab.

b. Clear the Generate ECO File check box.

c. Click Run.
The netlist and PCB files are compared and differences written to Logic.rep in the 
\PADS Projects folder. To see the differences, click Show Report in the Process 
Status dialog box.

9. Select the Generate ECO File check box, and verify the ECO Filename. 
Tip: Give the file a unique name to avoid overwriting any existing ECO files.

10. Click Run. Output files are written to the \PADS Projects folder.

Tip: In addition to the files listed above, messages or errors that occur during 
comparison are also written to Logic_Session.log and Logic.err in the \PADS Projects 
folder. 

11. PADS Logic File menu > Import

12. In the File Import dialog box, in the Files of Type: list, select ECO Files (*.eco).

13. Browse for and select the ECO file to import.

14. Click Open. If no errors occur, the schematic is updated. If errors occur, the 
schematic is not updated, and the errors, along with a link to the ECO Import errors file, 
are written to the Output window.

Related Topics

Backward Annotation Results

Backward Annotation Results
This section describes what happens to layout changes that are back-annotated to the schematic.

• Attribute Level Backward Annotation

• Part Level Backward Annotation

• Gate Level Backward Annotation
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• Net Level Backward Annotation

• Pin Level Backward Annotation

Attribute Level Backward Annotation
You can backward annotate new attributes and deleted attributes.

New Attributes

A new attribute in a part updates all parts of the same type. If the attribute name does not exist, 
it is added with the assigned value. 

An error is created if the part does not exist.

Tip: Unsupported attribute types, such as net or net class, are ignored.

Deleted Attributes

Deleting an attribute for a part-type deletes the attribute on all parts of that type in the design. 

An error message is generated if the part or attribute name does not exist.

If the attribute command specifies an object type not supported for general attributes, such as 
net or net class, the attribute command is ignored.

Related Topics

Method 2—Creating the ECO File in PADS Layout

Part Level Backward Annotation
You can backward annotate added parts, changed parts, deleted parts, and the reference 
designator name.

Added Parts

A new sheet is created and all new parts are added to the sheet. Parts are placed on a grid so that 
parts of a medium size do not overlap. No attempt is made to avoid overlapping of larger parts.

An error message is generated if the reference designator of the newly added part already exists 
or if the part does not exist in the Library.

Tip: The part is not added to the schematic if the reference designator already exists.

If the part contains Signal Pins, these pins are included in the add pin function. Backward 
annotation does not currently support signal pins so an error message is created.
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Changed Parts

If the changed part is a multigate part, all gates are updated to the new part type.

An error message is generated if the new part does not exist in the design or in the Library, or if 
the gate or pin count is incompatible.

Deleted Parts

If the deleted part is a multigate part, all gates are deleted.

An error message is generated if the part is still connected to a net or the part does not exist.

Reference Designator Name

If the part being renamed is a multigate part, all gates are updated. An error message is 
generated if the old reference designator does not exist.

Related Topics

Method 2—Creating the ECO File in PADS Layout

Gate Level Backward Annotation
You can backward annotate swapped gates.

PADS Logic creates an offpage symbol at each swapped gate. An error message is created if the 
gate does not exist.

Related Topics

Method 2—Creating the ECO File in PADS Layout

Net Level Backward Annotation
You can backward annotate joined nets, nets created by splitting an existing net, and renamed 
nets.

Joined Nets

The first net is renamed to be the same name as the second net.

Nets Created by Splitting an Existing Net

A Delete Pin from Net operation is performed to remove them from the existing net, followed 
by an Add Pin to Net operation to add the pin to the new net.
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Renamed Nets

All subnets of the old net on all sheets are renamed. If any of the subnets contain Power or 
Ground symbols without netnames, netnames are added to these symbols.

An error message is created if the new net already exists.

Related Topics

Method 2—Creating the ECO File in PADS Layout

Pin Level Backward Annotation
You can backward annotate swapped pins, pins added to a net, and pins disconnected from a 
net.

Swapped Pins

PADS Logic creates an offpage symbol at each swapped pin.

Pins Added to a Net

A pin can be added only if it is not already connected to another net. If the pin is a gate pin (a 
visible terminal pin on the gate symbol), an offpage symbol is created. 

An error is created if pin is already connected or the pin is a signal pin already assigned to a net.

Pins Disconnected from a Net

If the pin is a gate pin, the connection is deleted if it connects to a tie-dot or offpage symbol. If 
the connection goes to another gate pin, the connection is broken and, an offpage symbol is 
added.

This command generates an error message if the pin is not connected to the net in question.

Related Topics

Method 2—Creating the ECO File in PADS Layout
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Chapter 12
Setting up the Design Environment

Panning
The most efficient ways to pan are using the middle mouse button, or using the mouse wheel. 
But there are also many alternatives.

Panning Using the Middle Mouse Button
To center and pan the workspace:

1. Point in the workspace to where you want to locate the new center.

2. Middle-click. The screen repaints the design with the point you chose at the center of the 
screen.

Panning Using the Wheel
You can pan horizontally and vertically with the wheel in the workspace.

To pan vertically:

• Rotate the wheel.

Tip: To scroll up, rotate the wheel away from you. To scroll down, rotate the wheel 
toward you.

To pan horizontally:

• Press Shift and rotate the wheel.

Tip: To scroll to the left, rotate the wheel button up. To scroll to the right, rotate the 
wheel button down.

Alternative Panning Methods
There are many ways to pan around the design without using the mouse.

• Use the scroll bars to pan the view.

• To move the view, in the Status window click on the part of the postage stamp that 
represents the area you want to view. The center of view pans to that area. 
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• To pan the viewing window, moving one-half the screen width in the direction of the 
arrow use the arrow keys with NumLock On.

• To move the pointer on grid unit use the arrow keys with NumLock Off. Moving the 
pointer off the viewable area pans the view.

• To center the view at the current pointer location without zooming, press Ins on the 
numeric keypad.

Zooming to Specific Views
You can zoom to the board outline, the extents of all design items, or a selected item.

Zooming to the Board
This command zooms to and centers the board outline in the workspace.

• Press Ctrl+B.

Alternatives: 

• On the standard toolbar, click the Board button.

• On the View menu, click Board.

Zooming to the Extents
This command zooms to fit all objects, including those outside the board outline, into the 
workspace.

• Press Ctrl+Alt+E.

Alternatives: 

• On the standard toolbar, click the Extents button.

• On the View menu, click Extents.

Zooming to the Selection

Specific Object Zoom
Any object you select becomes the center view in the workspace.

1. Select an object.

2. Press Alt+Z.
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Alternative: On the View menu, click Selection.

In the Project Explorer
You can also zoom to the selection when you select an object in the Project Explorer. 

1. Right-click in the Project Explorer, and click Allow Selection.

Tip: This option may already be selected, if you click it again, you will turn it off.

2. Right-click again, and click Zoom to Selection.

Tips:

• This option may already be selected, if you click it again, you will turn it off.

• If Zoom to Selection is already enabled, when you right-click an object, that object 
becomes the center view in the workspace.

3. Select an object.

Zooming Using the Mouse
You can zoom using the middle mouse button or using a combination of toolbar button and 
mouse buttons, or keyboard key and the wheel.

Using the Middle Mouse Button
You can use the middle mouse button to zoom. Zoom in magnifies the design view. Zoom out 
shrinks the design view.

To magnify the design view, zoom in:

1. With the cursor in the workspace, hold down the middle mouse button.

2. Drag the cursor diagonally up across the design, indicating both the horizontal and 
vertical limits of the bounding box that defines your next view.

3. When the area of the design you want to magnify is within the bounding box, release the 
middle mouse button.

Alternative: Instead of zooming from the center as in the above, you can also zoom 
from the corner by holding down the Shift key while you drag the cursor.

To shrink the design view, zoom out:

1. With the cursor in the workspace, hold down the middle mouse button.

2. Drag the cursor diagonally down across the design, indicating both the horizontal and 
vertical limits of the bounding box that defines your next view. The line that expands 
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from the box represents the new view size in proportion to the old. The zoom-out ratio 
also appears with the cursor.

3. When the area you want to shrink is within the bounding box, release the middle mouse 
button.

Alternative: Instead of zooming from the center as in the above, you can also zoom 
from the corner by holding down the Shift key while you drag the cursor.

Zooming Using the Zoom Button
You can activate a zoom mode with the Zoom button and zoom incrementally with the left and 
right mouse buttons.

1. On the standard toolbar, click the Zoom button. This button is a toggle.

2. Position the cursor at the desired view center.

3. Click the left mouse button to zoom in, or click the right mouse button to zoom out.

4. Press Esc to exit zoom mode and return the mouse to its normal functionality.

Alternative: You can also click the Zoom button again to exit zoom mode.

Zooming Using the Wheel
You can zoom using the wheel button in combination with the Ctrl key.

• Press and hold down Ctrl and rotate the wheel button:

Tips: To zoom in, rotate the wheel button up. To zoom out, rotate the wheel button 
down.

Zooming Using Keyboard Keys
• To draw a zoom rectangle, press 5 on the numeric keypad with NumLock on. When you 

zoom out, a solid box shows at the pointer. This represents the current view size. The 
thin line that expands from the solid box represents the new view size in proportion to 
the old. The zoom-out ratio also displays with the pointer.

• To zoom in centered at the pointer location press Pg Up on the numeric keypad.

• To zoom out centered at the pointer location press Pg Dn on the numeric keypad.
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Pan and Zoom Shortcuts
Table 12-1 provides a list of pan and zoom shortcut keys.  

Table 12-1. Pan and Zoom Shortcut Keys 

PADS Logic 
Command/Ope
ration

PADS Layout 
Command / 
Operation

Accelerator 
Keys

Common 
Keyboard/ 
Mouse

PADS 
Router 
Command/ 
Operation

Comments

Auto Pan 
Display On/Off

Auto Pan 
Display On/Off

Ctrl & Alt A Auto Pan 
display 
On/Off

View Sheet View Board Ctrl B View Board

Zoom Selection Zoom Selection Alt Z Zoom 
Selection

Status Status Ctrl & Alt S

Zoom Mode 
on/off

Zoom Mode 
on/off

Ctrl W Zoom Mode 
on/off

View Sheet View Board Home View Board

Zoom in at 
cursor (Zoom 
mode only)

Zoom in at 
cursor (Zoom 
mode only)

Spacebar Zoom in at 
cursor (Zoom 
mode only)

Zoom in Zoom in PgUp Zoom in at 
cursor

Zoom out Zoom out PgDn Zoom out at 
cursor

Move Cursor Up 
1 Grid Unit

Move Cursor Up 
1 Grid Unit

Up Arrow Move Cursor 
Up 1 Grid 
Unit

Move Cursor 
Down 1 Grid 
Unit

Move Cursor 
Down 1 Grid 
Unit

Down 
Arrow

Move Cursor 
Down 1 Grid 
Unit

Move Cursor 
Left 1 Grid Unit

Move Cursor 
Left 1 Grid Unit

Left Arrow Move Cursor 
Left 1 Grid 
Unit
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Move Cursor 
Right 1 Grid 
Unit

Move Cursor 
Right 1 Grid 
Unit

Right 
Arrow

Move Cursor 
Right 1 Grid 
Unit

Center View at 
Cursor

Center View at 
Cursor

KeyPad0 Center View 
at Cursor

Redraw Redraw KeyPad1 Redraw

Pan Down Pan Down KeyPad2 Pan Down NumLock 
On

Move Cursor 
Down 1 Grid 
Unit

Move Cursor 
Down 1 Grid 
Unit

Move Cursor 
Down 1 Grid 
Unit

NumLock 
Off

Zoom Out at 
Cursor

Zoom Out at 
Cursor

KeyPad3 Zoom Out at 
Cursor

Pan Left Pan Left KeyPad4 Pan Left NumLock 
On

Move Cursor 
Left 1 Grid Unit

Move Cursor 
Left 1 Grid Unit

Move Cursor 
Left 1 Grid 
Unit

NumLock 
off

Zoom Area 
In/Out

Zoom Area 
In/Out

KeyPad5 Pan to Center 
of Board

NumLock 
On

Unassigned in 
PADS Logic

Unassigned in 
PADS Layout

Unassigned 
in PADS 
Router 

NumLock 
Off

Pan Right Pan Right KeyPad6 Pan Right NumLock 
On

Move Cursor 
Right 1 Grid 
Unit

Move Cursor 
Right 1 Grid 
Unit

Move Cursor 
Right 1 Grid 
Unit

NumLock 
Off

Zoom Sheet Zoom Board KeyPad7 Zoom Board

Table 12-1. Pan and Zoom Shortcut Keys (cont.)

PADS Logic 
Command/Ope
ration

PADS Layout 
Command / 
Operation

Accelerator 
Keys

Common 
Keyboard/ 
Mouse

PADS 
Router 
Command/ 
Operation

Comments
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Pan Up Pan Up KeyPad8 Pan Up NumLock 
On

Move Cursor Up 
1 Grid Unit

Move Cursor Up 
1 Grid Unit

Move Cursor 
Up 1 Grid 
Unit

NumLock 
Off

Zoom in at 
Cursor

Zoom in at 
Cursor

KeyPad9 Zoom in at 
Cursor

Zoom from 
Window corner

Zoom from 
Window corner

KeyPad 
Decimal

No 
equivalent in 
PADS Router

NumLock 
On

Delete Selected Delete Selected No 
equivalent in 
PADS Router

NumLock 
Off

Zoom in at 
Cursor (Zoom 
Mode Only)

Zoom in at 
Cursor (Zoom 
Mode Only)

LMButton 
click

Zoom in at 
Cursor 
(Zoom Mode 
Only)

Center View 
(Do not move 
cursor)

Center View 
(Do not move 
cursor)

MMButton 
click

Center View 
(Do not move 
cursor)

Dynamic Pan Dynamic Pan Alt MMButton 
drag

Dynamic Pan 
(Was 
shift+MMB 
click)

New 
Assignment

Zoom from 
Window Corner 
(Alternate 
Zoom)

Zoom from 
Window Corner 
(Alternate 
Zoom)

Shift MMButton 
drag

Zoom from 
Window 
Corner 
(Alternate 
Zoom)

New 
Assignment

Zoom Area 
In/Out

Zoom Area 
In/Out

MMButton 
drag

Zoom Area 
In/Out

Zoom Out at 
Cursor (Zoom 
Mode)

Zoom Out at 
Cursor (Zoom 
Mode)

RMButton 
click

Zoom Out at 
Cursor 
(Zoom 
Mode)

Table 12-1. Pan and Zoom Shortcut Keys (cont.)

PADS Logic 
Command/Ope
ration

PADS Layout 
Command / 
Operation

Accelerator 
Keys

Common 
Keyboard/ 
Mouse

PADS 
Router 
Command/ 
Operation

Comments
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Controlling views

Defining a Specific View Area
• To define a specific view area, hold the mouse button down, move the mouse to define 

the view rectangle, and release the mouse button.

Redrawing a View
• To redraw the current view press End on the numeric keypad.

Zoom in at 
Cursor

Zoom in at 
Cursor

Ctrl Wheel 
forward

Zoom in at 
Cursor

Zoom out at 
Cursor

Zoom out at 
Cursor

Ctrl Wheel 
back

Zoom out at 
Cursor

Scroll up one 
line

Scroll up one 
line

Wheel 
forward

Scroll up one 
line

Scroll down one 
line

Scroll down one 
line

Wheel 
back

Scroll down 
one line

Scroll left one 
line

Scroll left one 
line

Shift Wheel 
forward

Scroll left 
one line

Scroll right one 
line

Scroll right one 
line

Shift Wheel 
back

Scroll right 
one line

Scroll up 1 pixel Scroll up 1 pixel Ctrl &Alt Wheel 
forward

Scroll up 1 
pixel

Scroll down 1 
pixel

Scroll down 1 
pixel

Ctrl &Alt Wheel 
back

Scroll down 1 
pixel

Scroll left 1 
pixel

Scroll left 1 
pixel

Shift & Alt Wheel 
forward

Scroll left 1 
pixel

Scroll right 1 
pixel

Scroll right 1 
pixel

Shift & Alt Wheel 
back

Scroll right 1 
pixel

Table 12-1. Pan and Zoom Shortcut Keys (cont.)

PADS Logic 
Command/Ope
ration

PADS Layout 
Command / 
Operation

Accelerator 
Keys

Common 
Keyboard/ 
Mouse

PADS 
Router 
Command/ 
Operation

Comments
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Saving a View
You can save a work area view:

1. Arrange the work area to the view you want to capture. 

2. On the View menu click Save View. The Save View dialog box appears.

3. Click Capture.

4. Type a name in the Capture a New View box and Click OK.

You can create up to nine views. The view names appear at the bottom of the View menu.

Tip: Capture is not available in the PCB Decal Editor.

Restoring a View
To restore a previously captured view:

1. On the View menu, select the name of the captured view.

2. Click Apply.

Tip: When you change the view, PADS Layout automatically saves the previous view. Use 
Previous View on the View menu to restore this view.

Creating a Board Outline
Use the Board Outline and Cut Out button on the Drafting toolbar to create a board outline. You 
can create only one board outline per design.

Procedure

1. Drafting Toolbar button > Board Outline and Cut Out button.

2. Right-click and click the shape of your board outline. 

3. Draw your outline. 
See also: Creating a Rectangle Drafting Object, Creating a Circle Drafting Object, 
Creating a Polygon or Path Drafting Object

4. To change the color of the board outline, click Setup menu > Display Colors. Then 
set the color in the Other area.
Tip: Any cut outs you create will be the same color.

Result

The board outline is created.
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Related Topic

Importing a Board Outline and Cut Out from AutoCAD

Reusing a Board Outline

Creating a Board Cut Out
Use the Board Outline and Cut Out button on the Drafting toolbar to also create a board cut out. 
You can create only one board outline per design, so the same command and creation process is 
used for creating cut outs.

Restriction

You cannot create a notch using a board cut out. Edit the board outline instead.

Requirement

The board outline must exist before you can create a cut out.

Procedure

1. Drafting Toolbar button > Board Outline and Cut Out button.
Tip: If a board outline already exists, the message “Board Outline exists. Would you 
like to create a Board Cut Out?” appears. Click Yes to continue.

2. Right-click and click the shape of your board cut out. 

3. Draw your cut out. 
See also: Creating a Rectangle Drafting Object, Creating a Circle Drafting Object, 
Creating a Polygon or Path Drafting Object

4. To change the color of the board cut out, click Setup menu > Display Colors. Then 
set the color in the Other area using the Board Outline tile.
Warning: Changing the color of the cut out changes the color of board outline.

Result

The board cut out is created.

A board cut out cannot intersect another cut out or the board outline. If intersections occur, the 
message “Selected point is outside the board area” appears in the Status Bar. If you move a cut 
out and it intersects another cut out or the board outline, the message “Board cut out intersects 
the board outline” appears.
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Importing a Board Outline and Cut Out from 
AutoCAD

You can import a board outline from AutoCAD, but it must be created according to the 
following procedure.

Procedure

1. Create a layer within AutoCAD entitled BOARD_OUTLINE_00.

2. Draw your board outline using the Polyline button in AutoCAD. Make sure you close 
the Polyline shape, and assign a real width to the closed polyline.

Restriction: Only one polyline object can be used for the board outline since PADS 
Layout only allows a single board outline shape.

If you did not create the board outline shape on the new layer, you can select the board 
outline, and within the Properties of AutoCAD, assign the shape to the 
BOARD_OUTLINE_00 layer.

3. If you do not require a cut out, simply save the file as a DXF format file and import into 
a blank PADS Layout design file. If you have a cut out(s), proceed with the next steps.

4. Create a layer within AutoCAD entitled BOARD_CUTOUT_00.

5. Draw your cut out(s) using a closed Polyline for each cutout.

If you did not create the board cutout shape on the new layer, you can select the cut 
out(s), and within the Properties of AutoCAD, assign the cut out(s) to the 
BOARD_CUTOUT_00 layer.

6. Select the board outline and cut out(s), and make a Block out of them. In the Block 
Definition dialog box, name the block BOARD_1.

7. Save the file in AutoCAD as a DXF format file and import into a blank PADS Layout 
design file.

Result

• Did the board outline or cutout import as a 2D line? If so, it wasn’t assigned to the 
correct layer. In AutoCAD, go into the object’s properties and assign it to the correct 
layer.
You can determine if the object imported as a board outline or a 2D line by its color. 
Check the color of the object against the color set for the Board Outline in the Display 
Colors Setup dialog box. (The color set for the Board Outline must be different than the 
color set for Lines.)

• If the import of the board and cutout does not proceed correctly, explode the block in 
AutoCAD, recreate it and save a new DXF file.



PADS Layout User’s Guide and Reference Manual, PADS 9.4346

Setting up the Design Environment
Reusing a Board Outline

• Are you getting an error about a polyline that isn’t closed? In AutoCAD, edit the 
polyline and close it.

Related Topic

Creating a Board Outline

Creating a Board Cut Out

Reusing a Board Outline

Reusing a Board Outline
To reuse a board outline, export the outline and then import it into a new design.

Procedure

1. Create a board outline.
Tip: If you have a design with a board outline you like, you can use this design; remove 
any extra line items so they are not included in the export in Step 2.

2. Export to an ASCII file.
Tip: In the ASCII Output dialog box, select the Lines check box only.

3. Import the saved ASCII file into a new design.

Result

The board outline is in the new design.

Moving a Board Cut Out
When you move a board cut out, the Move Preference is important; if the move preference is set 
to Move by Origin, the cut out may snap off screen. The pointer snaps to the origin of the board 
outline and not the cut out. 

Procedure

1. Tools menu > Options > Design page.

2. In the Move Preference area, select either Move by cursor location or Move by 
midpoint.

3. Click OK.

4. Select the cut out.

5. Right-click and click Move.
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Result

The cut out attaches to the pointer so you can place it where you want.

If you move a cut out and it intersects another cut out or the board outline, the message “Board 
cut out intersects the board outline” appears.

Related Topic

Creating a Board Cut Out

Setting the Design Origin
There are two ways to set your Design Workflow Origin: click-to-set or precise.

Setting the Origin by Click
Use the Set Origin command to use your mouse to click the location you want the Design 
Workspace origin.

Procedure

1. Setup menu > Set Origin.

2. Click where you want the new origin to be.

Setting a More Precise Origin Location
If you want a more precise location, you can set the origin to any of the following: a component 
origin, a pin, a drawing corner, a via, text, the center of a circle, or a line (or arc) Intersection.

Procedure

1. Select the object with the point you want the new origin to be.

2. Setup menu > Set Origin.
Alternative: Use the SO Modeless command

Examples

The following are examples of line (or arc) intersections.
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Chapter 13
Importing and Exporting

Importing Files
The Import command inserts design data from various formats into a .pcb file. 

• File menu > Import.

PADS Layout supports the formats listed in Table 13-1. 

Table 13-1. PADS Layout Import Data Formats 

Format Extension Description

ASCII .asc PADS-ASCII format text
Restriction: PADS Layout no longer 
imports Perform 6 ASCII format files.

Data eXchange Format, or 
DXF

.dxf A graphical information format used by 
AutoCAD 2004 and other CAD systems.

Engineering Change Order .eco Contains forward annotation or backward 
annotation information generated in 
schematic capture package, concerned 
with logic changes to the design.
See also: Working with PADS Logic, 
Working with DxDesigner

Intermediate Data Format, 
or IDF

.emn Import data from IDF 2.0 and 3.0 format.
You must have the IDF Interface option 
in PADS Layout to import IDF files.
See also: Intermediate Data Format in the 
Concepts Guide

OLE .ole PADS Layout allows you to embed files 
from other applications as OLE objects in 
your design using Insert New Object. 
Once you have an OLE object in your 
design, you can export the object as a 
singular item to an .ole file using File 
Export. You can then import the OLE file 
into other PADS Layout designs. 
See also: Inserting OLE Objects in PADS 
Layout
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Exporting Files
The Export command selectively extracts data from the open .pcb file and saves it into other 
formats. 

• File menu > Export.

PADS Layout supports the formats listed in Table 13-2.

Collaboration .clb, .cle Import markups in the collaboration file 
(.clb) and encrypted collaboration file 
(.cle) formats.

Protel 99SE design database .ddb Protel 99 design files in the binary format 
as well as in the ASCII format.

Protel PCB98 design .pcb Protel 98 design files in the binary format 
as well as in the ASCII format.

Protel DXP / Altium 
Designer design

.pcbdoc Altium DXP/2004/2006/Altium Designer 
design files in the binary format as well as 
in the ASCII format.

P-CAD design .pcb P-CAD design files in binary and ASCII 
formats generated in P-CAD 2001, 2002, 
2004, 2006.

CADSTAR PCB design .pcb CADSTAR design files in binary format 
generated in CADSTAR 5.0, 6.0, 7.0, or 
8.0.

CADSTAR PCB archives .cpa CADSTAR files in ASCII format 
generated in CADSTAR 5.0, 6.0, 7.0, or 
8.0.

OrCAD Board .max OrCAD Layout design files in binary 
generated in OrCAD Layout 9.X, 10.X.

Allegro Board .brd Cadence Allegro design files.

Table 13-2. PADS Layout Export Data Formats 

Format Extension Description

ASCII Export .asc PADS-ASCII format text
Restriction: PADS Layout does not export 
Perform 6 ASCII format files.

Data eXchange Format, or 
DXF

.dxf A graphical information format used by 
AutoCAD 2004 and other CAD systems.

Table 13-1. PADS Layout Import Data Formats (cont.)

Format Extension Description
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Intermediate Data Format, 
or IDF 

.emn and 

.emp
Export data to IDF 2.0 and 3.0 format.
You must have the IDF Interface option in 
PADS Layout to export IDF files.
See also: Intermediate Data Format in the 
Concepts Guide

OLE .ole You can embed files from other 
applications as OLE objects in your design 
using Insert New Object. Once you have an 
OLE object in your design, you can export 
the object as a singular item to an .ole file 
using Export. You can then import the .ole 
file into other PADS Layout designs.

HyperLynx HYP .hyp You can export the .hyp file if you only 
want the exported file.
Tip: You can also create .hyp, or 
HyperLynx files during the process of 
translating the design to BoardSim using 
Tools menu > Analysis > Signal/Power 
Integrity.

IPC-D-356 or IPC-D-356a .ipc Export your data to IPC-D-356 or IPC-D-
356 revision A formats.

ODB++ .tgz Export your data to an ASCII open format. 
This format is self-contained and can be 
transferred between computers without any 
loss of data.

Collaboration Files .cle Export markups in the encrypted 
collaboration file format for use in 
collaboration software.

CCE Files .cce Export the design in compressed (.cce) 
format for use in design review and 
collaboration software. For example, 
CAMCAD, visECAD, or visEDOC.

CAM350 File .cam Launch the CAM350 link to export the file 
or to open the file in CAM350 if it’s 
installed.

SPECCTRA .do Launch the Specctra Translator to create 
the .do file for the Specctra autorouter.

Table 13-2. PADS Layout Export Data Formats (cont.)
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Importing an ASCII File
You can import an ASCII file created with previous versions of PADS Layout. If format or 
other changes, such as the addition of an attribute dictionary, are needed to update your data to 
the current PADS release, they are made. If the ASCII file contains test points, PADS Layout 
removes the test points that are not accessible and lists them in the report file. Physical design 
reuses are preserved when you import an ASCII file.

Restriction

You cannot import the ASCII file if any of the following conditions are true:

• The design is in default layer mode and the ASCII file is in increased layer mode. Use 
the Layers Setup dialog box to change the design to increased layer mode.

• The ASCII file that has fewer electrical layers than the current design. Use the Layers 
Setup dialog box to increase the electrical layer count to match the number in the 
imported ASCII file.

• Perform 6 ASCII created the ASCII file.

Notes: 

• Improvements in thermal relief definition in PADS 9.2 may cause changes in thermal 
pad appearance, flooding results and CAM output (for CAM Plane layers) when an 
ASCII file from a previous version is imported into PADS 9.2. If incompatibilities are 
found when such a file is imported, a warning prompt is displayed and the 
incompatibilities are written to the ascii.err file.

• Beginning with PADS 9.0, die parts and flip chips are no longer identified by their 
family designations (DIE or FLP), but instead by the Special Purpose settings in the 
General tab of the Part Information dialog box. When you import an ASCII file created 
by a previous PADS version, these Special Purpose settings are automatically set for 
parts having the logic family DIE or FLP. The part’s family designation remains the 
same.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the ASCII Files (*.asc) file type.

3. Browse to the file to import and click Open.

Result

Import process information is written to ascii.err, located in the \PADS Projects folder.
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Related Topics

Importing and Exporting Files in the Concepts Guide

Exporting an ASCII File

Exporting an ASCII File
You can use ASCII files to exchange design data between PADS Layout and external 
translators or previous versions of PADS Layout.

Tips: 

• Improvements in thermal relief definition in PADS 9.2 may cause changes in thermal 
pad appearance, flooding results and CAM output (for CAM Plane layers) when an 
design is exported from PADS 9.2 to a previous version. If incompatibilities are found 
when the design is exported, a warning prompt is displayed and the incompatibilities are 
written to the Powerpcb.Rep file.

• Beginning with PADS 9.0, die parts and flip chips are no longer identified by their 
family designations (DIE or FLP), but instead by the Special Purpose settings in the 
General tab of the Part Information dialog box. With this change, the following changes 
occur in a design when you export it to an ASCII file of a previous PADS version:

• The Special Purpose settings of any die parts and flip chips are cleared.

• Die parts and flip chips having a family designation other than DIE and FLP lose 
their die part or flip chip special purpose and become normal parts.

• Any normal parts that have the DIE or FLP family designation are treated as die 
parts or flip chips in the previous PADS version.

Procedure

1. File menu > Export.

2. On the File Export dialog box, select the ASCII Files (*.asc) file type.

3. Specify the file to export and click Save.

4. On the ASCII Output dialog box, specify the items that you want to write to the ASCII 
file by doing one of the following:

• Select the check boxes for the items. For information about each item, see Exported 
Item Descriptions.

• Click Select All.

5. In the Format list, select the format version.
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Warning: Exporting to older formats will result in the loss of newer software 
features not supported by older formats.

Tips:

• Use PowerPCB V3.0 to export to both PowerPCB and PowerBGA V3.0 ASCII 
formats.

• PADS Layout does not export to PADS-Perform 6 ASCII format.

6. In the Units list, select the units to export.

Tip: If you plan to use the ASCII file for an external translator or another ASCII-
reading program, select Current. If you plan to re-import the ASCII file and save it as a 
.pcb database, select Basic. Basic units represent how values are stored in the software. 
They do not use standard units of measure, but they record precise positioning values for 
database items.

7. If you want to export attributes assumed from higher levels in the attribute hierarchy, 
select the Parts and Nets check boxes as needed.

8. Click OK.

Result

The .asc file is created. An export status log file— ascii.err—and an export report file—
Powerpcb.Rep—are created in the \PADS Projects folder. Physical design reuse information, if 
any, is retained.

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing an ASCII File

Importing OLE Files
You can import an .ole file (containing OLE objects) into the design. This is useful when 
another design contains OLE objects that you want to include in the current design.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the OLE Files (*.ole) file type.

3. Browse to the file to import and click Open.

Result: The OLE objects import into the current design.
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Related Topics

Importing and Exporting Files in the Concepts Guide

Exporting OLE Files

Exporting OLE Files
You can export OLE objects to an .ole file. This is useful when the current design contains OLE 
objects that you want to include in another design.

Procedure

1. Select an OLE object > File menu > Export.

2. On the File Export dialog box, select the OLE Files (*.ole) file type.

3. Specify the file to export and click Save.

Result: The .ole file is created.

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing OLE Files

Importing DXF Files
You can import DXF files of the AutoCAD 2004 DXF format.

Recommendation: There are two interfaces to import DXF files. This procedure uses an 
interface designed for advanced import of any and all design objects. It imports the design 
objects from specially named block and layers names in AutoCAD. This mapping is hard-coded 
and can’t be changed.
If you need to simply import RF shapes into the decal or into the design, see Importing RF 
Shapes in DXF Format.

Restriction: You cannot import a DXF file to a design if the design is in default layer mode and 
the DXF file is in increased layer mode. Use the Layers Setup dialog box to change the design 
to increased layer mode.

Procedure

1. On the File menu, click Import.

2. In the File Import dialog box, in the file type list, select DXF Files (*.dxf).

3. Browse to the file to import and click Open.
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4. In the DXF Import dialog box, in the Layer Selection area, select layers from which to 
import information. 

Tip: To add individual layers, select the layer names in the Available list and click the 
Add button. To remove individual layers, select the layer names in the Selected list and 
click the Remove button.

5. In the Select Input Items area, specify the items that you want to import by doing one of 
the following:

• Select the check boxes for the items.

• Click All Items.

6. In the DXF-File Unit list, select the units to use in the DXF file.

Tip: This list is unavailable if it is not necessary to set the units.

7. In the Mode Area, click an import mode.

8. Click OK.

Result

The .dxf file is imported and opened in PADS Layout.†

If you need your imported geometries to be single objects, but they have been imported as 
multiple line items, see Joining and Closing 2D Lines and Copper Shapes.

Warning: Nets bridged with copper are not supported in the .dxf file format. If you are 
importing a file previously exported with bridged coppers, they will import as regular copper 
shapes.

Related Topics

Importing a Board Outline and Cut Out from AutoCAD

DXF Format in the Concepts Guide

Importing and Exporting Files in the Concepts Guide

Exporting DXF Files
You export DXF files to transfer design elements to AutoCAD 2004. For example, you can 
export the design with component height information in order to create a 3D model.

Procedure

1. On the File menu click Export.

2. In the File Export dialog box, in the Save as type list, select DXF Files (*.dxf).
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3. Browse to overwrite a file or type a new file name. Click Save.

4. On the DXF Export dialog box, in the Export Type area, choose between standard and 
flat output. 
Restriction: If you select flat output, the setup of DXF drill sizes and symbols is 
unavailable.

5. In the Layer Selection area, select layers from which to export information. 

Tip: To add individual layers, select the layer names in the Available list and click the 
Add button. To remove individual layers, select the layer names in the Selected list and 
click the Remove button.

6. In the Select Input Items area, specify the items that you want to export by doing one of 
the following:

• Select the check boxes for the items.

• Click All Items.

7. In the DXF-File Unit list, select the units to use in the DXF file.

Tip: This list is unavailable if it is not necessary to set the units.

8. To define DXF drill sizes and symbols, click Setup and do the following on the Setup 
DXF Drill Size and Symbols dialog box (unavailable if exporting a flat type file):

a. If you want to specify a drill size for a 2D line library item, click Add, type a value 
into the Drill Size box, and then type the library item name into the Library 
Equivalent box. 

Tip: If you do not associate a drill size to a 2D line library item, the default drill 
symbol is exported for that item.

b. If you want to remove a drill size for a 2D line library item, select the item in the 
Drill Size and Library Equivalent area, and then click Delete.

c. Click OK.

d. If you want to change symbol units, select the units from the System Units list.

e. If you want to change the appearance of the default drill symbol, which appears in 
the DXF file as a plus sign +, type the length/width of the plus sign into the Symbol 
Size box, and then type the plus sign line width into the Line Width box.

9. Click OK.

Result

The .dxf file is created.
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Warning: Nets bridged with copper are not supported in the .dxf file format and will export as 
regular copper shapes.

Related Topics

Importing and Exporting Files in the Concepts Guide

DXF Format in the Concepts Guide

Specifying DXF Drill Sizes and Symbols
Use the Setup DXF Drill Size and Symbols dialog box to specify drill sizes for 2D line library 
items that you export to DXF.

Procedure

1. File menu > Export > save as DXF type > Export dialog box > Setup button.

2. If you want to specify a drill size for a 2D line library item, click Add, type a value into 
the Drill Size box, and then type the library item name into the Library Equivalent box. 

Tip: If you do not associate a drill size to a 2D line library item, the default drill symbol 
is exported for that item.

3. If you want to remove a drill size for a 2D line library item, select the item in the Drill 
Size and Library Equivalent area, and then click Delete.

4. If you want to change symbol units, select the units from the System Units list.

5. If you want to change the appearance of the default drill symbol, which appears in the 
DXF file as a plus sign +, type the length/width of the plus sign into the Symbol Size 
box, and then type the line width of the plus sign into the Line Width box.

6. Click OK.

Related Topics

Setup DXF Drill Size and Symbols Dialog Box

DXF Export Dialog Box

Importing IDF Files
You can use IDF files to exchange design data between PADS Layout and a mechanical design 
system. You can import an IDF file to import board outlines, keepouts, components, and holes 
from a mechanical design system. PADS Layout cannot import the information in the .emp 
library file.
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Some of the components you import are mechanical objects that are not ECO registered, such as 
board mounting holes and card guides.

See also: Importing Holes and Adding Components During Importing in the Concepts Guide

Requirement: Before importing an IDF file into PADS Layout, first export IDF files from the 
mechanical design system.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the IDF Files (*.emn) file type. You can import 
IDF 2.0 or 3.0 .emn files.

3. Browse to the file to import and click Open.

4. On the IDF Import dialog box, in the Select Import Items area, specify the items that you 
want to import by doing one of the following:

• Select the check boxes for the items.

• Click All Items.

See also: IDF Import Dialog Box

5. Click OK.

Result: The .emn board file imported and opened in PADS Layout. A status log file is 
written to C:\PADS Projects\idfimport.sts.

Related Topics

Importing and Exporting Files in the Concepts Guide

Exporting IDF Files

Exporting IDF Files
You can use IDF files to exchange design data between PADS Layout and a mechanical design 
system. You can export IDF files to export board outlines, keepouts, components, and holes to a 
mechanical design system.

Tip: Set any IDF-specific part height information, drilled hole information, or part outline 
information for a more accurate IDF export.

Procedure

1. File menu > Export.

2. On the File Export dialog box, select the IDF Files (*.emn, *.emp) file type.
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3. Specify the file to export and click Save.

4. On the IDF Export dialog box, in the Shape Layer list, select the layer containing the 
outline information for the decals in your design that you want to send to the mechanical 
design system.

5. In the Format list, select the IDF version to use.

6. In the Select Export Items area, specify the items that you want to export by doing one 
of the following:

• Select the check boxes for the items.

• Click All Items.

7. Specify the minimum height of components you want to export by typing the minimum 
part heights in the Top and Bottom boxes.

Tip: Components less than these heights are not exported. If a part is not exported 
because of a minimum height value, a message is written to the status log file.

8. Click OK.

9. If the Geometry.Height attribute does not exist or is set to zero height for any exported 
part type and decal pairs, the Missing Height dialog box appears for each pair. If you 
want to specify height information prior to exporting the part type and decal pair, type 
the height into the Height box.

Tip: If you do not specify the height, the mechanical design system may prompt you to 
enter a height when importing the IDF files.

Result: The .emn (board and placement) and .emp (part library) files are created. A status log 
file is written to C:\PADS Projects\idfexport.sts.

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing IDF Files

To Set Part Outlines for IDF Export
The IDF library file requires part outline information for all parts.

Procedure

1. Tools menu > PCB Decal Editor.

2. Open the decal for which you want to define an outline.

3. Click the layer on which to define the outline. For IDF, you must use the same layer in 
each decal to define all part outlines.
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4. Define the part outline.

The outline must be a single, special kind of closed curve that is either a circle or a 
sequence of non-self-intersecting arcs and contiguous line segments.

5. Save the decal.

Related Topics

Part Outline Information in the Concepts Guide

To Add Drill Hole Information to IDF Files
Using the HOLE part attribute, you can enable the export of drill hole information for single-pin 
parts to IDF files. Vias and multiple-pin parts do not use the HOLE attribute, even though they 
are displayed as drilled holes in the mechanical design system.

Mechanical design systems interpret drill holes as board drills.

Procedure

1. File menu > Library.

2. On the Library Manager dialog box, select and edit the single-pin part for which you 
want to add drill hole information.

Tip: If you use the same part type for holes and nonholes, but use different decals, set 
the HOLE attribute in the part type.

3. Add the HOLE part attribute using the Attributes tab on the Part Information dialog box.

4. Save your changes.

Related Topics

Exporting Holes in the Concepts Guide

Exporting Part Height Information to IDF Files
To export part heights to IDF:

• Assign the Geometry.Height attribute at the Decal or Part Type hierarchy level. 

Related Topics

Working with Object Attributes

Using the Attribute Manager

Part Height Information in the Concepts Guide
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Importing Protel 99SE Design Database Files
You can import a .ddb file directly into PADS Layout.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the Protel 99SE design database (*.ddb) file 
type.

3. Browse to the file to import and click Open.

Result: The .ddb file is imported and opened in PADS Layout. The resulting PADS Layout file 
is saved in the same folder as the original file with the suffix _pads. For example, if the original 
file name is ProtelTest.ddb, the new filename will be ProtelTest_pads.pcb. 

If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, ProtelTest_pads_1.pcb, ProtelTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing Protel PCB98 Design Files
You can import a Protel .pcb file directly into PADS Layout.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the Protel PCB98 Design (*.pcb) file type.

3. Browse to the file to import and click Open.

Result: The .pcb file is imported and opened in PADS Layout. The resulting PADS Layout file 
is saved in the same folder as the original file with the suffix _pads. For example, if the original 
file name is ProtelTest.pcb, the new filename will be ProtelTest_pads.pcb. 

If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, ProtelTest_pads_1.pcb, ProtelTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 
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Related Topics

Importing and Exporting Files in the Concepts Guide

Importing Protel DXP / Altium Designer Design 
Files

You can import a .pcbdoc file directly into PADS Layout.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the Protel DXP / Altium Designer design 
(*.pcbdoc) file type.

3. Browse to the file to import and click Open.

Result: The .pcbdoc file is imported and opened in PADS Layout. The resulting PADS Layout 
file is saved in the same folder as the original file with the suffix _pads. For example, if the 
original file name is ProtelTest.pcbdoc, the new filename will be ProtelTest_pads.pcb. 

If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, ProtelTest_pads_1.pcb, ProtelTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing P-CAD Design Files
You can import a .pcb file directly into PADS Layout.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the P-CAD design files (*.pcb) file type.

3. Browse to the file to import and click Open.

Result: The .pcb file is imported and opened in PADS Layout. The resulting PADS Layout file 
is saved in the same folder as the original file with the suffix _pads. For example, if the original 
file name is PCADTest.pcb, the new filename will be PCADTest_pads.pcb. 
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If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, PCADTest_pads_1.pcb, PCADTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing CADSTAR PCB Design Files
You can import a .pcb file directly into PADS Layout.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the CADSTAR PCB design files (*.pcb) file type.

3. Browse to the file to import and click Open.

Result: The .pcb file is imported and opened in PADS Layout. The resulting PADS Layout file 
is saved in the same folder as the original file with the suffix _pads. For example, if the original 
file name is CADSTARTest.pcb, the new filename will be CADSTARTest_pads.pcb. 

If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, CADSTARTest_pads_1.pcb, CADSTARTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing CADSTAR Archives
You can import a .cpa file directly into PADS Layout.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the CADSTAR archive (*.cpa) file type.

3. Browse to the file to import and click Open.
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Result: The .cpa file is imported and opened in PADS Layout. The resulting PADS Layout file 
is saved in the same folder as the original file with the suffix _pads. For example, if the original 
file name is CADSTARTest.cpa, the new filename will be CADSTARTest_pads.pcb. 

If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, CADSTARTest_pads_1.pcb, CADSTARTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing OrCAD Board Files
You can import a .max file directly into PADS Layout.

Procedure

1. File menu > Import.

2. On the File Import dialog box, select the OrCAD Board files (*.max) file type.

3. Browse to the file to import and click Open.

Result: The .max file is imported and opened in PADS Layout. The resulting PADS Layout file 
is saved in the same folder as the original file with the suffix _pads. For example, if the original 
file name is OrCADTest.max, the new filename will be OrCADTest_pads.pcb. 

If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, OrCADTest_pads_1.pcb, OrCADTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 

Related Topics

Importing and Exporting Files in the Concepts Guide

Importing Allegro Board Files
You can import a prepared Allegro .brd file directly into PADS Layout. The file must be 
prepared by running a SKILL script.
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Procedure

1. Prepare the Allegro file as described in Migrating Allegro Designs to PADS Layout in 
the Allegro to PADS Translator User’s Guide.

2. File menu > Import.

3. On the File Import dialog box, select the Allegro Board files (*.brd) file type.

4. Browse to the prepared Allegro file to import and click Open.

Result: The .max file is imported and opened in PADS Layout. The resulting PADS Layout file 
is saved in the same folder as the original file with the suffix _pads. For example, if the original 
file name is OrCADTest.max, the new filename will be OrCADTest_pads.pcb. 

If a file with the new name already exists in the folder, a sequential number is added to the file 
name. For example, AllegroTest_pads_1.pcb, AllegroTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \PADS Projects folder 
by default. 

Related Topics

Importing and Exporting Files in the Concepts Guide

Exporting ODB++ Files
You can export an entire design to an ODB++ job, which can be transferred from computer to 
computer without any loss of data.

Warning: ODB++ export is based on the CAM documents for your design. If you do not create 
the CAM documents and proceed without them, a default set of CAM documents will be 
generated and used for the ODB++ export. The default CAM documents may not be similar to 
what you would create.

Procedure

1. File menu > Export

2. In the File Export dialog box, select the location for the job from the Save in list.

3. In the Save as type list, select ODB++ (*.tgz).

Requirement: 

• If you have copper pours or plane areas that are not filled, they are poured 
automatically when the CAM documents are being generated.

• If you haven’t created all the required CAM documents for your design you are 
prompted with a list of missing documents. You can cancel the operation and create 
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those documents, or you can continue and use CAM documents created using some 
default settings.

• If you haven’t created any of the required CAM documents for your design you are 
prompted to generate the default documents.

4. Make appropriate settings in the ODB++ Export dialog box.

5. Click Save.

Result

The ODB++ job, consisting of a .tgz file and associated report file (_odbppExport.rep), is 
created and placed in the location indicated in step 2. For example, if your file is preview.pcb, 
the resulting files will be preview.tgz and previewodbpp_Export.rep in the same directory. 

Exporting CCE Files
You can export design elements in CCE (formerly CC/CCZ) Files for import to CAMCAD, 
visECAD, and visEDOC.

Procedure

1. File menu > Export.

2. In the File Export dialog box, in the Save as type list, select CCE Files (*.cce).

3. Browse to overwrite a file or type a new file name.

4. Click Save.

5. In the CCE Export dialog box, specify the Solder Mask and Paste Mask options.

6. Choose the output file format.

7. Click OK.

Related Topics

CCE Export Dialog Box

Creating HyperLynx BoardSim - HYP Files
You can export the current design to a HYP file to perform high-speed analysis in BoardSim. 
You can also launch and open the file in BoardSim from the Tools menu if you have it installed. 
For information about the format of the HYP file and creating a “BoardSim-friendly” design, 
see the HyperLynx online Help.
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PADS Layout passes the Value, Tolerance, Voltage, HyperLynx, and PowerGround attributes 
to the HYP file. BoardSim uses these attributes to obtain values for resistors and capacitors, and 
to transfer information about fixed voltage nets.

Procedure

1. There are two methods to start the process:

• If you have HyperLynx BoardSim installed, on the Tools menu, point to 
Analysis and click Signal/Power Integrity. This opens the BoardSim Dialog Box.

• If you don’t have HyperLynx BoardSim installed, on the File menu, click Export. In 
the File Export dialog box, in the Save as type list, select HYP Files (*.hyp). 
Browse to overwrite a file or type a new file name. Click Save. This opens the HYP 
Export Dialog Box.

2. In the BoardSim or HYP Export dialog box, in the Output area, specify the information 
that you want to export.

3. If you selected the Unrouted check box, do the following:

a. In the Assumed Layer list, select the layer on which to implement the unrouted nets.

b. In the Percent Excess over Manhattan Length box, type a value to estimate the 
routing lengths.

Tip: This value adds a percentage of the Manhattan length to the route length, to 
account for indirect routing paths. Net lengths are based on the Manhattan distance 
between pin pairs, which is Delta X plus Delta Y.

4. Click OK.

Result

If you used the BoardSim dialog box, BoardSim will start up and open the file. If you used the 
HYP Export dialog box, the .hyp file is created. If you selected the .REF IC Automapping file 
option, the .ref file is created and has the same location and name as the .hyp file.

Warning: Nets bridged with copper are combined when you export the design into the .hyp 
(HyperLynx) file format.

Related Topics

BoardSim Dialog Box

HYP Export Dialog Box

Exporting an IPC-D-356 Netlist
You can export either an IPC-D-356 netlist or an IPC-D-356 Revision A netlist.
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Procedure

1. On the File menu, click Export.

2. In the File Export dialog box, in the Save as type list, select IPC356 Files (*.ipc).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the IPC Export dialog box, select one of the two netlist formats.

5. Click OK.

Result

Warning: Nets bridged with copper are combined when you export the design into the .ipc 
(IPC356) file format.

Related Topics

The IPC-D-356 Netlist
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Chapter 14
Design and Editing Basics

In this chapter:

• Selection

• Using the Selection Filter

• Running the Selection Report

• Finding Objects

• To Highlight Objects

• To Use Transparent View Mode

• To Use Outline View Mode

• Measuring

Selection

Selecting Items
Most design work involves editing the database and adding, modifying, and deleting items. 
There are two ways to edit items. You can first select the object to edit and then select the 
command, select mode; or you can first select the command and then select the object to edit, 
verb mode.

Verb mode attaches a command to the pointer and performs that command on any items 
subsequently selected. The advantage of using verb mode is that it automatically sets the 
selection filter to items that respond to the active command.

To Select Using Select Mode
To select the object and perform a command:

1. Point to the object and click. The selected item highlights.

2. Use one of the following:

3. Right-click to open a menu of commands that are appropriate for the selected item.

4. Click a menu command.
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5. Click a toolbar button to start a command.

Advantages: Convenient for objects that are already selected.

To Select Using Verb Mode
To perform a command and select the object:

1. Open one of the four toolbars by clicking one of the following buttons on the main 
toolbar. Each toolbar provides a specific set of additional buttons.

Figure 14-1. Toolbar Buttons

2. Click one of the buttons on the newly opened toolbar. The command attaches to the 
pointer and the message line displays the command name. Now you can apply the 
command to objects that you select. When you move the pointer off the toolbar, a small 
V appears on the pointer to show that the selected command is active.

3. Select objects on which to perform the active command. An object is one discreet item 
in the design, such as a route segment or part. Click the Select button to cancel the 
command.

Example:

From the Routing toolbar, click the Spin button. The small V attaches to the pointer. 
Select a component. The component is in Spin Mode. Indicate a new orientation or press 
Esc to cancel the spin.

Tip: Press Esc before you click a button to make sure nothing is selected. If something is 
selected when you click a button, the command acts on the selected item.

To select all objects in an area, hold the mouse button down and drag a selection rectangle 
around one or more objects; start at one corner of the area and drag to the diagonally opposite 
corner.

When you release the button, all objects contained within the rectangle are selected.

You can add additional objects to the selection or remove objects from the selection by pressing 
Ctrl while you click.

Tip: The Drag Moves area in the Global tab of the Options dialog box can affect your ability to 
area select in dense designs. If a selected object starts to move when you area select, click 
Cancel from the shortcut menu and try starting in a different area. To disable drag moves, set the 
Drag Moves area to No Drag Moves.
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To Select a Single Object
To select a single object, point to the object and click. The object becomes selected and 
highlighted. Any previously selected objects are no longer selected. If you click over empty 
space, all previously selected objects are no longer selected. If you try to select an object in a 
dense or crowded area, use the Selection Filter to disable other items for selection.

To Select Multiple Objects
To select multiple objects, press and hold Ctrl while you click over each item in sequence.

If an object was not previously selected, it is added to the set of selected objects. If an object 
was previously selected, it is removed from the set of selected objects.

Using the Selection Filter
Sometimes you cannot easily select the object you want because there are several objects at the 
same location. Use the Selection Filter to help solve this problem. Use the Selection Filter to 
specify objects on certain layers that you can or cannot select. The Selection Filter has two tabs, 
the Object tab and the Layer tab.

Tip: You can also set the Selection Filter using a shortcut menu. With nothing selected, right-
click, then set the filter.

To Select Using the Selection Filter Object Tab
To select using the Selection Filter Object tab:

1. Edit menu > Filter.

2. Select the design and drafting items in the Selection Filter Object tab by clicking the 
appropriate check box.

3. Use the Anything or Nothing buttons as necessary.

4. To select layers, click on the Layer tab and make your selections. 

5. Click Close.

To Select Using the Selection Filter Layer Tab
To select using the Selection Filter Layer tab:

1. Edit menu > Filter.

2. Click on the Layer tab.
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3. Select the layers from the layer list by clicking on the appropriate check box.

4. Use the Anything or Nothing buttons as necessary. 

5. Click Close.

Related Topics

To Cycle Pick

To Cycle Pick
When you cannot easily select the object you want because several objects occupy the same 
location use cycle picking:

1. Move the pointer over the object to select, and left-click.

2. If you did not select the correct object, you can either:

• Click the Cycle Pick button from the standard toolbar.

or

• Click Cycle on the Edit menu.

or

• Press Tab.

or

• Right-click and click Cycle.

Any of these actions deselects the currently selected object and selects a new object 
at the same location.

3. You can continue to click the Cycle Pick button to cycle the current selection through 
all objects at the pointer location.

Related Topics

Using the Selection Filter

Selecting Stitching Vias
When you are working with vias in a design, you may want to select all of the stitching vias in a 
shape in order to modify them. You can select all stitching vias contained by a copper, copper 
pour, or hatch outline.

To select all stitching vias in a shape:

1. Select the copper, copper pour or hatch outline.
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2. Right-click and click Select Stitching Vias.

Selecting Isolated Stitching Vias
An isolated stitching via is not connected to any hatch outline or copper area. You can locate 
such vias by selecting them. You can select all isolated stitching vias in the entire design or just 
those associated with a specific net. 

To select isolated stitching vias in the entire design:

• With no object selected, right-click in the design area and click Select Isolated 
Stitching Vias.

To select isolated stitching vias associated with a net:

1. Select a net.

2. Right-click and click Select Isolated Stitching Vias.

Restriction: The search for isolated stitching vias ignores connections to CAM plane layers.

Tip: When you verify your design, you can find isolated stitching vias by performing a 
Connectivity Check; however, you first need to set up that check. For information, see Setting 
Up Checking for Isolated Stitching Vias.

Running the Selection Report
The selection report is a quick way to determine everything you have selected in your design. 
This report is a great way to ensure that you are moving and editing exactly what you want.

Tip: The Selection Report is available only when at least two objects of different types are 
selected in your design.

Procedure

• Select more than one type of object, right-click and click Selection Report.

Or

• Select more than one type of object, View menu > Selection Report.

Result

report.rep opens in your default text editor and displays everything you have selected in your 
design at this moment.
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Finding Objects
Use Find to find and select single or multiple objects by reference designator, part type, line 
width, or other attributes. 

Find works two ways, depending on your selection mode:

• Select mode — Find ignores the Selection Filter settings and selects whatever you ask it 
to.

• Verb mode — Find only looks for items that are logical for verb mode.

Commands for Find By
A few of the Find By commands present more complex commands for finding. Those 
commands are:

• Find by Attribute

• Find by keepout

• Find by fonts

• Find by physical design reuse

• Find by test point types

• Find by thermal attributes

• Find by pour area and isolated pour

To Find By Attribute
You can find by attribute name or attribute value.

1. Edit menu > Find.

2. Click Attribute from the Find By list, a list of attributes in the design appears in the 
Attribute list box.

3. To filter the attributes, select an attribute in the Attribute list or type a wildcard or 
expression in the Value box and click Apply.

4. Click an attribute, attribute values appear in the list box on the right.

Because the list box on the right allows multiple selections, you can find by multiple values.

To Find By Keepout
1. Edit menu > Find.



Design and Editing Basics
Finding Objects

PADS Layout User’s Guide and Reference Manual, PADS 9.4 377

2. Click Keepouts from the Find By list, a list of keepout restrictions in the design appears 
in the list box on the left.

3. To filter the keepouts, type a wildcard or expression in the Value box and click Apply.

4. If you select a Component Height restriction, a list of available heights appears in the list 
box on the right.

Finding Fonts
Use the Find dialog box to find fonts in labels and text strings in your design. Then use the 
Properties dialog box to set up new fonts and font styles for:

• Finding Label Fonts

• Finding Text Fonts

Finding Label Fonts

1. Edit menu > Find.

2. Select Label Fonts from the Find by list.

3. In the Text fonts area, click the font to find. The list includes all fonts in the design.

Tip: Once you select a text font, the Styles area is populated with the list of font styles 
used in the design.

4. In the Styles area, click the style to find. The list includes all font styles in the design.

5. Click OK. All labels with the chosen font characteristics are selected.

6. Use the Properties dialog box to apply a new font and/or style to the highlighted 
selections.

Finding Text Fonts

1. Edit menu > Find.

2. Select Text Fonts from the Find by list.

3. In the Text fonts area, click the font to find. The list includes all fonts in the design.

Tip: Once you select a text font, the Styles area is populated with the list of font styles 
used in the design.

4. In the Styles area, click the style to find. The list includes all font styles in the design.

5. Click OK. All text strings with the chosen font characteristics are selected.

6. Use the Properties dialog box to apply a new font and/or style to the highlighted 
selections.
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See also: Replacing Fonts

To Find By Physical Design Reuse
You can find by reuse type or by reuse name.

1. Edit menu > Find.

2. Click Reuse Type from the Find By list, a list of reuse types in the design appears in the 
list box on the left.

3. To filter the reuse, type a wildcard or expression in the Value box and click Apply.

4. Click a reuse type, a list of reuse names (names for each instance of the type) appears in 
the list box on the right.

To Find By Test Point Types
1. Edit menu > Find.

2. Click Test Point Types in the Find By list.

3. Click to search by Via, Component pin, or Net in the Test Point Types list. The 
contents of the list box at the right of the dialog box changes depending on what you 
select. Table 14-1 shows what the List Box displays for each of the available selections 

4. To filter the test points, type a wildcard or expression in the Value box and click Apply.

Tip: Find treats jumper pins as component pins.

Table 14-1. Test Point Types List 

Selection List Box Contents

Via Lists and sorts, in order, all types for test points on vias.

Component pin Lists and sorts, in order, all nets containing test points on 
component pins. Jumper pins are treated as component pins by 
Find.
If the design has at least one unused component pin with a test 
point attribute, the name Unused Pins appears at the bottom of 
the list box.
All unused pins with the test point attribute are also searched 
for test points.

Nets Lists all nets with test points, either on component pins or vias.
If the design has at least one unused component pin with a test 
point attribute, the name Unused Pins appears at the bottom of 
the list box.
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The search differs depending on which list box has the current selection, the Test Point Types 
list or the one to the right of it. If the list on the right is active, Find searches only for test points 
from selected nets. Otherwise, Find searches for all test points of selected types from all nets.

To Find by Thermal Attributes
1. Edit menu > Find.

2. Click Thermal Attributes from the Find By list.

3. To filter the attributes, type a wildcard or expression in the Value box and click Apply.

The list on the left lists thermal data by inner pad size. The list on the right lists a breakdown of 
thermals using the following format: outer/number of spokes/spoke width/rotation format.

To Find By Pour Area and Isolated Pour
The Find By list box contains two commands for handling copper pour: Pour Area and Isolated 
Pour.

Pour Area

Selects copper pour based on area size. Type the size in the Value field. All copper pour areas of 
equal size or less are selected. Press Delete to delete them.

Isolated Pour

Locates areas of copper pour that have been isolated from the main pour area, but are still part 
of the same netname. Cleared obstacles that are too close to the edge of the pour outline usually 
cause isolated copper pour.

After you select the isolated copper areas, press Delete to delete them.

Tip: Pour areas not assigned a netname are not considered isolated; they are excluded from this 
operation.



PADS Layout User’s Guide and Reference Manual, PADS 9.4380

Design and Editing Basics
To Highlight Objects

Figure 14-2. Isolated Pour

Related Topics

Find Dialog Box

Using the Find Dialog Box During Placement

To Highlight Objects
You can highlight an object without performing an operation on it.

1. Select the objects to highlight.

2. Click Highlight from the Edit menu to show the object as highlighted. Subsequent edit 
operations do not apply to these highlighted objects.

3. Click Unhighlight from the Edit menu to remove highlighting from all objects.

To Use Transparent View Mode
Use Transparent Mode to view traces on several layers simultaneously. Transparent mode can 
show you obstacles that may be hidden directly under the current active layer.

To turn on and off transparent view mode:
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• Use the Modeless Command T.

Related Topics

To Use Outline View Mode

Viewing Protected Routes with Outline Mode

To Use Outline View Mode
Use Outline mode to speed redraw time by displaying traces and pads as outline objects instead 
of filled objects. Traces appear as two parallel lines, separated by the established trace width. 
Pads appear as outlines of their shapes.

To turn on and off outline view mode:

• Use the Modeless Command O.

Related Topics

To Use Transparent View Mode

Viewing Protected Routes with Outline Mode

Measuring
You can measure clearance distances or objects in your design using two modeless commands.

Using Quick Measure
Use the Q modeless command to measure using a dynamic ruler or measuring stick.

Restriction: This modeless command is restricted by the Snap to Design Grid setting. To 
get the most accurate measurement, do not snap to the design grid.

1. Locate your pointer at the starting location of your measurement. Without further 
movement of the pointer, type the Q modeless command and then type Enter.

2. Move the pointer in any direction and a line will be drawn indicating the span of your 
measurement. Three measurement values are displayed as you move the mouse pointer.

• dx - displays the delta measurement along the x axis.

• dy - displays the delta measurement along the y axis.

• d - displays the delta of the euclidean measurement between the start and end point.

3. When finished, type Esc to exit the Quick Measure mode.
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Using Quick Length
Use the QL modeless command to measure route objects you’ve selected in the design.

1. Select a net, pin pair, or one or more routed segments in the design.

2. Type the QL modeless command and then type Enter.

The measurement of the selected route objects is given in a Layout.err report file which 
opens. The Output Window also logs a link to the report file for easy return-access.

Related Topics

Modeless Commands

Clearances and Keepouts

Using the Trace Length Monitor
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Chapter 15
Setting Up Layers

Use the following steps to set your layers up. Based on your needs, you may or may not need to 
do every step.

Procedure

1. Setup menu > Layer Definition.

2. Set the number of layers for the design.

• Increase the total number of layers available to the design.

• Designate that this is a single-sided board.

• Change the number of electrical layers.

3. Set up the outer layers.

4. Set up the inner layers.

5. Determine the visibility of non-electrical layers.

6. Define layer and substrate thickness.

Increasing the Maximum Number of Available 
Layers

PADS Layout supports two layer modes, default layer mode and increased layer mode.
See also: Layer Modes in the Concepts Guide

When you switch a design to increased layer mode, you cannot return to default layer mode.

Requirements

You must set the proper number of electrical layers in PCB Decal Editor before switching layer 
mode.

Procedure

1. Setup menu > Layer Definition.

2. Click Max Layers. The Increase Maximum Layer Number dialog box opens.

3. Click OK to switch to increased layer mode.
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Designating a Board as Single-sided
You can only designate a board as single-sided if there are no more than two electrical layers. 

Procedure

1. Setup menu > Layer Definition.

2. Click Single-sided Board.

3. Click OK.

Result

• Connectivity checking no longer reports connectivity errors for component pins with 
non-plated drill holes. Components and jumpers placed on the top layer are considered 
as connected to pads on the bottom layer with solder joints.

• In CAM output, all through-hole pins and vias are treated as non-plated regardless of the 
definition in pad stacks.

Modifying the Number of Electrical PCB Layers
You can change the number of electrical layers in a design in either default layer mode or 
increased layer mode.

Requirement

Before changing the number of electrical layers, delete all partial vias and their definitions from 
your design. Also, you can't modify the layer definition for electrical layers if a physical design 
reuse exists on the board.

Procedure

1. In the Layers Setup dialog box, click Modify. The Modify Electrical Layer Count dialog 
box opens.

2. Type the new number of electrical layers in the Modify Electrical Layer Count within 
the specified range.

3. Click OK. The Reassign Electrical Layers dialog box opens.

4. If necessary, reassign the electrical information on any existing electrical layer to a new 
layer. The new electrical layers are created in the database with default parameter 
values. 
See also: Reassigning Electrical Layers

5. Click OK to return to the Layers Setup dialog box.



Setting Up Layers
Setting Up an Outer Layer

PADS Layout User’s Guide and Reference Manual, PADS 9.4 385

Tip: If you increase your electrical layer count, and intend to use partial vias, you should also 
update your drill pairs layer settings.

Setting Up an Outer Layer
The outer layers of your design are the Top and Bottom layers. You can designate an outer layer 
to have components or not.

Procedure

1. In the Layers Setup dialog box, select an outer layer. For example, select Top.

2. In the Name box, type the name of the layer.
Tip: By default, PADS Layout assigns the outer layer names as Top and Bottom. 
Rename the layer to something that lets you know what the layer is; for example, Top 
Component Layer 1.

3. In the Electrical Layer Type area, click Component if you want to allow components on 
the layer; otherwise click Routing. If you select Component, you can change the layer 
associations:

a. Click the Associations button.

b. In the Component Layer Associations dialog box, set the associations for each 
documentation layer type.

c. Click OK to close the dialog box.

Tip: When a top or bottom layer is set as a component layer, you can associate, or 
otherwise map, which documentation layers go with the selected layer.

Whatever layer associations are made here are used by CAM routines for output. For 
example, when you output a silkscreen for the top, any items on the documentation 
layer you associated for silkscreen are automatically added to the CAM document. 

4. In the Layers Setup dialog box, click the Plane Type you want. If you select CAM or 
Split/Mixed Plane, you must assign the plane net(s) to the layer:

a. Click the Assign Nets button.

b. Click a net from the All Nets list.

c. Click Add to move the net to the Assigned Nets list.

d. You can associate additional nets if the layer is a Split Mixed Plane type.

e. Click OK to close Plane Layer Nets dialog box.

You can assign a net to as many layers as required. 

5. In the Layers Setup dialog box, click the Routing Direction you want.
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Tip: You must assign a primary routing direction to all electrical layers. Nonelectrical 
layers are not assigned a routing direction. The routing direction affects the manual and 
autorouting performance. For example, if you select Horizontal but most of the traces on 
the layer need to be vertical, route editing performance is slow. Also, selecting Any can 
adversely affect route editing performance.

6. Click OK.

Related Topics

Drawing a Plane or Using a CAM Plane

Setting Up an Inner Layer

Setting Up a Documentation Layer

Associating Component and Documentation Layers in the Concepts Guide

Setting Up an Inner Layer
The inner layers of your design are always electrical layers.

Procedure

1. In the Layers Setup dialog box, select an inner layer. For example, select Ground Plane.

2. In the Name box, type the name of the layer.
Tip: By default, PADS Layout assigns the layer number as its name; for example, Inner 
Layer 2. Rename the layer to something that lets you know what the layer is; for 
example, Inner Signal Layer 2.

3. Click the Plane Type you want. If you select CAM or Split/Mixed Plane, you must 
assign the plane net(s) to the layer:

a. Click the Assign Nets button.

b. Click a net from the All Nets list.

c. Click Add to move the net to the Assigned Nets list.

d. You can associate additional nets if the layer is a Split Mixed Plane type.

e. Click OK to close Plane Layer Nets dialog box.

You can assign a net to as many layers as required. 

4. In the Layers Setup dialog box, click the Routing Direction you want.

Tip: You must assign a primary routing direction to all electrical layers. Nonelectrical 
layers are not assigned a routing direction. The routing direction affects the manual and 
autorouting performance. For example, if you select Horizontal but most of the traces on 
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the layer need to be vertical, route editing performance is slow. Also, selecting Any can 
adversely affect route editing performance.

5. Click OK.

Related Topics

Drawing a Plane or Using a CAM Plane

Setting Up an Outer Layer

Setting Up a Documentation Layer

Setting Up a Documentation Layer
PADS Layout assigns layers 21 to 30 (in default layer mode) as default documentation layers 
for manufacturing plot types, including two for silkscreen: top and bottom. 

Procedure

1. In the Layers Setup dialog box, select a documentation layer. 
Tip: Documentation layers are listed after all electrical layers. A quick way to tell if a 
layer is a documentation layer is the absence of a letter in the Direction (dir) column.

2. In the Name box, type the name of the layer.
Tip: By default, PADS Layout assigns the layer number as its name; for example, 
Layer_3. Rename the layer to something that lets you know what the layer is; for 
example, Gold Mask.

3. Click the Fab. Assembly and Documentation Layer Type you want.
Tip: If you click SilkScreen, Paste Mask, Solder Mask, or Assembly, this layer is 
available for association with component layers.

4. Click OK.

Related Topics

Associating Component and Documentation Layers in the Concepts Guide

Setting Up an Inner Layer

Setting Up an Outer Layer

Component Layer Associations dialog box

Hiding or Displaying Non-electrical Layers
Default PADS Layout designs come with many layers. If your design only uses a few layers, 
there might be a large number of layers that are unused. You can hide those layers from view to 
shorten the list of layers wherever they’re displayed - for example, the Layer list of the standard 
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toolbar, the Layers Setup and Display Colors dialog boxes. You can set the visibility for non-
electrical layers only. 

Tip: The best use of this feature is if you never intend to use the layer; if you need to use a layer, 
but want to switch the visibility of it, use the Display Colors Setup dialog box instead.

Procedure

1. In the Layers Setup dialog box, click Enable/Disable.

2. Select the appropriate check box in the Enabled column to either enable or disable a 
layer.

Tip: While the Enabled column is the only editable column, you can sort the displayed 
layers by any other column. You can click a column heading to sort by that column's 
values. Click the same column heading again to sort in the reverse order.

3. Click OK to return to the Layers Setup dialog box.

Setting Layer Thickness
Use the Layer Thickness dialog box to define electrical layer and dielectric material layer 
thickness and dielectric constant information. When you verify your design, the electrodynamic 
check uses this information.

Traces on high-speed printed circuit boards can act like transmission lines that “broadcast” 
interference to adjacent conductors. Using the high-speed rules module, you can use Rules to set 
clearances on a net class, net, or pin to pin connection basis; then use high-speed checking to 
report on properties such as impedance, delay, track length, daisy chaining, and parallel routing. 
These issues cause interference and create costly problems in prototyping. You can run checks 
against the entire board or against specific nets.

Requirements

• Set these definitions before you run an electrodynamic check.

• You must specify your plane layers in the Layers Setup dialog box before you run an 
electrodynamic check. For a two-layer board, temporarily identify one of the layers as a 
plane layer.

Procedure

1. In the Layers Setup dialog box, click the Thickness button. The Layer Thickness dialog 
box opens.

2. For each dielectric material layer, double-click the Type cell to select whether the 
“layer” is a Prepreg or Substrate layer.
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3. For each layer, double-click the Thickness cell and type a value.

Tip: If no coating is required, set thickness to zero.

4. For dielectric material layers, double-click the Dielectric cell and type a dielectric 
constant value.

5. To view and edit copper thicknesses by ounces per square foot, click Weight (oz). 
Otherwise, click Design (") to view and edit in the same unit of measure as the current 
database.

Tip: Board Thickness is the total value of material and layer thicknesses in the current design 
units. 

Related Topics

Verify the Design

Setting Up High Speed (Electrodynamic) Checking

Setting Up EDC Parameters

Unassigning a Netname from a Plane Layer

Procedure

1. In the Layers Setup dialog box, select a layer defined as a CAM Plane or a Mixed Plane.

2. Click Assign Nets. The Plane Layer Nets dialog box opens.

3. Click the netname from the Assigned Nets list.

4. Click Remove. The netname is moved back to the All Nets list.

Reassigning Electrical Layers
When reassigning layers, component keepouts are ignored. They remain on the layer on which 
you created them. Also, you can't modify the layer definition for electrical layers when a 
physical design reuse exists on the board. 

Be careful when you reassign a layer. If a route is attached to a pad that is not available on the 
new layer, such as a surface mount pin or a partial via, the program places a zero-length unroute 
from the end of the trace to the component pin.

Procedure

1. In the Layers Setup dialog box, click Reassign. The Reassign Electrical Layers dialog 
box opens.

2. Click the number of the layer you want to reassign from the Old list.
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3. Type the layer number you want to assign it to in the New Layer # box. You cannot 
merge items from an old to a new layer, but you can swap layers. Additionally, the target 
layer must be empty.

4. The following information moves from the old layer to the new layer:

• Traces and vias

• Drafting objects

• Layer name, layer type, routing direction, and component/plane layer parameters

5. If you decrease the number of layers and the selected layer has no data, you can remove 
the layer. To remove it, click Delete.

6. Click OK. You return to the Layers Setup dialog box.
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Chapter 16
Via Setup

In this section, you learn how to create, edit, and delete vias. You also learn how to set up Drill 
Pairs and tent vias.

• Creating a Drill Pair

• Creating a Through-hole Via

• Creating a Partial Via

• Editing a Via

• Deleting a Via

• Tenting Vias With Solder Mask

Creating a Drill Pair
Layers are expressed as a pair of numbers, or a drill pair. Define drill pairs first to prevent 
defining or installing partial vias that cross layers that don't drill together. 

You must create a drill pair for each partial via in your design. If you are using through-hole 
vias in addition to partial vias, you must also create an “all-layers” drill pair; once you create a 
partial via, PADS Layout no longer assumes you are using the through-hole via default.

Procedure

1. Setup menu > Drill Pairs. The Drill Pairs Setup dialog box opens.

2. Click Add to add a line to the Drill Pairs list.

3. Select the starting layer from the Starting Layer list. The layer number is automatically 
indicated to the left of the list.

4. Select the ending layer from the Ending Layer list. The layer number is automatically 
indicated to the left of the list.

5. Click OK to save the drill pairs.

You can edit the starting or ending layer for a drill pair, and you can delete drill pairs.

Tip: You can use up to 30 electrical layers when adding a partial via in default layer mode. You 
can use up to 64 electrical layers when adding a partial via in increased layer mode.
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Related Topics

Creating a Partial Via

Creating a Through-hole Via

Drill Pairs Setup Dialog Box

Creating a Through-hole Via
You can create a through-hole via or a partial via.
See also: Creating a Partial Via

Requirements

• If you are using partial vias in addition to through-hole vias, you must create an “all-
layers” drill pair; once you create a partial via, PADS Layout no longer assumes you are 
using the through-hole via default.
See also: Creating a Drill Pair

Procedure

1. Setup menu > Pad Stacks. The Pad Stacks Properties dialog box opens.

2. In the Pad Stack Type area, select Via.

3. Click Add Via to add a line to the Decal name list.
Tip: A list of all previously defined vias appears in the Decal Name list.

4. In the Vias area, type the name of the via in the Name box.

5. Click Through to indicate that this is a Through-hole via.

6. Select the layer of the pad you want to customize from the Sh: Sz: Layer: list.

See also: Pad Stack Default Layers, Control of Solder Mask and Paste Mask

7. In the Parameters area, specify the settings for all three Pad, Thermal, and Antipad pad 
styles if needed. The style of pad used is selected automatically in the design depending 
on the situation. The thermal and antipad styles are used when the pin is located within a 
plane.

See also: Design Rule Versus Pad Stack - Thermals and Antipads

8. Click OK to save the via pad stack.

Related Topics

Pad Sizes and Pad Stacks

Editing a Via
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Creating a Drill Pair

Creating a Partial Via

Pad Stacks Properties Dialog Box

Creating a Partial Via
You can create a through-hole via or a partial via. Partial vias are also called blind via or buried 
via depending on how visible they are. 
See also: Creating a Through-hole Via

Requirements

• You must first create a drill pair for each partial via.
See also: Creating a Drill Pair

• If you are using partial vias in addition to through-hole vias, you must create an “all-
layers” drill pair; once you create a partial via, PADS Layout no longer assumes you are 
using the through-hole via default.

Procedure

1. Setup menu > Pad Stacks. The Pad Stacks Properties dialog box opens.

2. In the Pad Stack Type area, select Via.

3. Click Add Via to add a line to the Decal name list.
Tip: A list of all previously defined vias appears in the Decal Name list. 

4. In the Vias area, type the name of the via in the Name box.

5. Click Partial to indicate that this is a blind or buried via.

6. Select the starting and ending layers from the Start Layer and End Layer lists.

7. Select the layer of the pad you want to customize from the Sh: Sz: Layer: list.

See also: Pad Stack Default Layers, Control of Solder Mask and Paste Mask

8. In the Parameters area, specify the settings for all three Pad, Thermal, and Antipad pad 
styles if needed. The style of pad used is selected automatically in the design depending 
on the situation. The thermal and antipad styles are used when the pin is located within a 
plane.

See also: Design Rule Versus Pad Stack - Thermals and Antipads

9. Click OK to save the via pad stack.
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Troubleshooting

If you are unable to use the new partial via, check the following in the Default Routing Rules:

• Is your new via in the Selected vias list and available for use in the design?

• Are both the from and to layers listed in the Selected layers list and available for 
routing?

Related Topics

Editing Pad Stacks

Editing a Via

Creating a Drill Pair

Creating a Through-hole Via

Pad Stacks Properties Dialog Box

Editing a Via
To edit a via pad stack and apply the changes to the part you selected or all parts:

1. Select a via > right-click > Properties > Pad Stack button.

2. Click the via type to edit in the Decal Name list.

3. Change via settings as needed.

4. When you finish making changes, click OK.

5. Click Yes to change all vias of the selected type.

Tip: Use the Parameters and Drill Size areas to reset the size and shape options.

Related Topics

Editing Pad Stacks

Creating a Through-hole Via

Creating a Partial Via

Pad Stacks Properties Dialog Box

Deleting a Via
1. Setup menu > Pad Stacks.

2. Click Via in the Pad Stack Type area.
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3. Click a via name in the Decal Name list.

4. Click Delete Via.

5. Click OK.

Related Topics

Editing Pad Stacks

Creating a Through-hole Via

Creating a Partial Via

Pad Stacks Properties Dialog Box

Tenting Vias With Solder Mask
You can cover vias with solder mask (a process known as “tenting” the via.) 

Choosing a Method
Method 1—You use the Pad Stacks dialog box to add a custom solder mask shape to the solder 
mask layer. Use this method if you want to be able to see the various sizes of solder mask 
shapes in the design.

Method 2—You use the Object Attributes dialog box to add an attribute that controls the solder 
mask openings. This is the quickest method, but you will be unable to see the shapes in the 
design--you have to create a CAM document to see them.

Warning: If a solder mask shape exists in the solder mask layer of the pad stack, and a via has 
an assigned CAM.Solder mask.Adjust value, and both values are used in the CAM document, 
they will be combined. See Mask Hierarchy in the PADS Layout Concepts Guide.

Method 1 Procedure

1. Setup > Pad Stacks

2. In the Pad Stack Type area of the Pad Stacks Properties Dialog Box, click the Via radio 
button.

3. Add a solder mask layer to the via you want to be tented, as follows:

a. In the Decal name list click the name of the via.

b. In the Vias area Name box, append _OPEN to the via name.

c. In the Sh: Sz: Layer area, click Add, and from the Add Layer dialog box select either 
Solder Mask Top or Solder Mask Bottom. 
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d. With the new Solder Mask layer selected, set the pad diameter to the oversize 
required for the via.

e. If you need to add the other solder mask layer, repeat steps c and d.

4. Create a duplicate of the via you want to be tented, as follows:

a. With the <VIA_NAME>_ OPEN via selected, click the Add Via button.

b. In the Vias area, type <ORIGINAL_VIA_NAME>_TENTED.

c. In the Sh: Sz: Layer area, click Add, and from the Add Layer dialog box select either 
Solder Mask Top or Solder Mask Bottom. 

d. With the new Solder Mask layer selected, set the pad diameter to zero.

e. If you need to add the other solder mask layer, repeat steps c and d.

f. Click OK to save the settings and close the dialog box.

5. Tent the vias in the design, as follows:

a. In the design, select the vias you want to be tented.

b. Right-click > Properties

c. From the Via Name list of the Via Properties Dialog Box, select the name of the new 
tented via.

d. Click OK.

Results

To verify your results:

1. File > CAM

2. In the Define CAM Documents Dialog Box, click the Add button.

3. In the Add/Edit CAM Document Dialog Box, from the Document Type list, select 
Solder Mask.

4. In the Layer Association dialog box, select the top/bottom layer.

5. Click the Layers button.

6. In the Select Items Dialog Box Selected list, select Solder Mask Top.

7. In the Items on Primary area, select the Vias check box.

8. Click the Preview button. The output will show openings for the “open” vias, but the 
“tented” vias will not appear.
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Method 2 Procedure

1. In the design, select the vias you want to be tented.

2. Right-click > Attribute 

3. In the Object Attributes Dialog Box, click the Add button.

4. From the drop-down list in the Attribute column, select CAM.Solder mask.Adjust.

5. Double-click in the edit box under the Value header, type a negative value that 
represents the via pad size, and press Enter. For example, enter -20 to tent a 20 mil via 
pad. 

6. Click Close.

Results

To verify your results:

1. File > CAM

2. In the Define CAM Documents Dialog Box, click the Add button.

3. In the Add/Edit CAM Document Dialog Box, from the Document Type list, select 
Solder Mask.

4. In the Layer Association dialog box, select the top/bottom layer.

5. Click the Layers button.

6. In the Select Items Dialog Box Selected list, select Solder Mask Top.

7. In the Items on Primary area, select the Vias check box.

8. Click the Preview button. The output will show openings for the “open” vias, but the 
“tented” vias will not appear.
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Chapter 17
Associated Nets

You can associate an array of nets joined by discrete components, creating an associated net, to 
which you can apply rules as you would to a single net. The length of an associated net is the 
combined lengths of the nets and discrete components of which it is composed. The following 
figure shows an example of an associated net.

Figure 17-1. Associated Net Components and Nets

Length, differential pair and matched length rules can be applied to an associated net as though it 
were a single net. 

There are three ways to create and modify your associated nets; 

• By net
Select nets and associate them, either by settings in the Net Properties dialog box or by 
popup commands.

• Manually by component
Select discrete components and associate their attached nets, either by settings in the 
Component Properties dialog box or by popup commands.

• Automatically by refdes prefix
Specify the refdes prefixes of the components whose nets you want to associate in the 
Associated Nets dialog box.

By default these methods are independent of each other (that is, you can use any of the methods 
by itself), because the commands/properties by which they interact are defaulted to allow you to 
choose one method to use, and ignore the others. Choosing one method and sticking with it is 
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the simplest course. If you mix methods in your design, you will need to understand how the 
methods interact, described in Conditions Governing Associated Net Creation.

The following topics describe the creation and management of associated nets:

Creating Associated Nets
There are three methods you can use to create associated nets:

• By net

• Manually by component

• Automatically by component refdes prefix

General Restrictions

The following restrictions apply to all 3 net association methods.

• A plane net cannot be part of an associated net. 

• A net having more pins than the limit specified in the Maximum non-plane-net pin count 
field of the Associated Nets dialog box is considered a plane net, and cannot be part of 
an associated net. (See General Prerequisite (Recommended) below.)

• An associated net that would have more nets than the limit specified in the Maximum net 
count per associated field of the Associated Nets dialog box is not created. (See General 
Prerequisite (Recommended) below.)

• Components through which an associated net passes must be either discrete two-pin 
components, or multiple pin components that conform to the following conditions:

• All the pins must connect to a gate.

• Each gate must have exactly two pins.

Creating Associated Nets Creating a Matched Length Group of 
Associated Nets

Deleting Associated Nets Creating a Differential Pair of Associated Nets

Excluding Nets from Net Association Creating Associated Net Design Rules

Excluding Components from Net Association Modifying Associated Net Design Rules

Cancelling Net Association for Nets 
Associated by the Net Method

Clearing Associated Net Rules

Cancelling Net Association for a Component 
Associated by the Component Method
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No component that does not conform to these conditions can be an associating 
component, that is, no associated net can go through it.

General Prerequisite (Recommended)

This prerequisite applies to all 3 net association methods.

Before you begin creating associated nets, you should make sure that the Maximum net count 
per associated net and Maximum non-plane-net pin count fields in the Associated Nets dialog 
box are set appropriately for your design. These fields set limits on the number of nets allowed 
in an associated net, and on the number of pins allowed in a single net included in an associated 
net. If these values are set inappropriately for your design, associated nets that would otherwise 
be created are not created, or are created differently than you expect, as follows:

• If the potential associated net exceeds the Maximum net count per associated net limit, it 
is not created.

• If any net in the potential associated net exceeds the Maximum non-plane-net pin count 
limit, the associated net can be split, truncated, or not created at all, depending on the 
location of the faulty net.

For more information, see Conditions Governing Associated Net Creation.

Method 1—Net Association by Net
Use this method if you want to create associated nets by selecting nets and associating them.

Tip: Whenever associated nets are created, deleted or changed, all associated nets in the design 
are regenerated. So you should always verify that the results of an associated nets action are 
what you expected by reading the messages in the Output Window.

Procedure

1. In the workspace, select the nets you want to associate.

2. Right-click > Associate Nets

Alternative: In the Net Properties dialog box, check the Associate net checkbox.

Results

The selected nets are associated, and the Net Properties Associate net checkbox is set for all the 
selected nets.

Are the results different from what you expected?

• An expected associated net might have been split or truncated, or not created at all, 
because one or more of its nets or components did not conform to the General 
Restrictions for creating associated nets.
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• Some nets cannot be associated; for example, two selected nets from opposite sides of 
the board will have the Associate net checkbox checked, but no associated net will be 
created.

• Mixed-method restriction: If a component to which one of the selected nets is attached 
has been excluded from net association, it cannot be an associating component, that is, 
no associated net can go through it. (A component or net is excluded from net 
association if its Associate nets and Allow net association... checkboxes are both 
cleared.)
For more information, see Conditions Governing Associated Net Creation.

Related Topics

Cancelling Net Association for Nets Associated by the Net Method

Excluding Nets from Net Association

Method 2—Net Association by Component
Use this method if you want to create associated nets by selecting components and associating 
their nets.

Tip: Whenever associated nets are created, deleted or changed, all associated nets in the design 
are regenerated. So you should always verify that the results of an associated nets action are 
what you expected by reading the messages in the Output Window.

Procedure

1. In the workspace, select the components whose nets you want to associate.

2. Right-click > Associate Nets

Alternative: In the Component Properties dialog box, check the Associate nets checkbox.

Results

The nets attached to the selected components are associated, and the Component Properties 
Associate nets property is set for all the selected components.

Are the results different from what you expected?

• An expected associated net might have been split or truncated, or not created at all, 
because one or more of its nets or components did not conform to the General 
Restrictions for creating associated nets.

• Mixed-method restriction: If a net attached to a selected component is excluded from 
net association, it cannnot be included in an associated net. (A component or net is 
excluded from net association if its Associate nets and Allow net association... 
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checkboxes are both cleared.)
For more information, see Conditions Governing Associated Net Creation.

Related Topics

Excluding Components from Net Association

Cancelling Net Association for a Component Associated by the Component Method

Method 3— Automatic Net Association by Refdes Prefix
Use this method if you want to create associated nets automatically by specifying the refdes 
prefixes of the associating components in the Associated Nets dialog box.

Tip: Whenever associated nets are created, deleted or changed, all associated nets in the design 
are regenerated. So you should always verify that the results of an associated nets action are 
what you expected by reading the messages in the Output Window.

Prerequisite (Recommended)

This procedure creates associated nets for all components that have the specified refdes 
prefixes, and conform to the General Restrictions for creating associated nets.

So you will want the refdes prefix of any set of components you plan to group into associated 
nets to be unique.

Procedure

1. Setup menu > Associated Nets

2. In the Maximum net count per associated net box, enter the maximum number of nets 
to be allowed in associated nets.

3. In the Maximum non-plane-net pin count box, enter the maximum number of pins 
allowed in nets belonging to associated nets. Nets that would have pin counts higher 
than this maximum are considered plane nets, and are not included in associated nets.

4. In the Discrete component prefixes area, enter the refdes prefixes of the components 
you want to be associating components in associated nets. 

5. Tip: The text entry field names are only for convenience; prefixes for any type of 
component can be entered in any field.

Results

When you click OK or Apply, associated nets are regenerated based on the new or changed set 
of specified refdes prefixes. 
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Rules (min/max length, matched length groups, differential pairs) for associated nets that are 
unchanged in the regeneration are kept. Associated nets that are changed (including changes to 
the set of components they pass through), or deleted:

• Lose their rules

• Are removed from matched length groups, and 

• Diff pairs containing them are removed.

Are the results different from what you expected?

• An expected associated net might have been split or truncated, or not created at all, 
because one or more of its nets or components did not conform to the General 
Restrictions for creating associated nets.

• Mixed-method Restriction: If any of the selected components, or any net attached to a 
selected component, has been excluded from net association, it cannot be included in an 
associated net. (A component or net is excluded from net association if its Associate nets 
and Allow net association... checkboxes are both cleared.)

For more information, see the Conditions Governing Associated Net Creation.

Related Topics

Deleting Associated Nets

Excluding Nets from Net Association

Excluding Components from Net Association

Deleting Associated Nets
You can delete associated nets manually, or automatically if they have been created 
automatically in the Associated Nets dialog box.

Deleting Associated Nets Manually
Tips: 

• Deleting an associated net deletes only the association, not the nets.

Procedure

1. In the workspace, select the associated nets you want to delete.

2. Right-click > Delete Associated Net
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Results

The Associate Nets checkbox is cleared for all the nets of the selected associated nets. If any 
nets have also been associated by component (including by refdes prefix), for those nets the 
Allow net association by component checkbox is cleared as well.

Related Topics

Cancelling Net Association for Nets Associated by the Net Method

Excluding Nets from Net Association

Deleting Associated Nets “Automatically”
You can “automatically” delete a group of associated nets which you have created by the refdes 
prefix method.

Tip: Whenever associated nets are created, deleted or changed, all associated nets in the design 
are regenerated. So you should always verify that the results of an associated nets operation are 
what you expected by reading the messages in the Output Window.

Procedure

1. Setup menu > Associated Nets 

2. Delete the refdes prefixes of the associating components.

3. Click Apply or OK.

Results

The associated nets associated by components having the specified refdes prefix are deleted, 
split or truncated.

Are the results different from what you expected?

• Mixed-method restrictions:

• If a component having the deleted refdes prefix has the Associate nets checkbox 
checked, the nets of that component will remain associated.

• If a component having the deleted refdes prefix has the Allow net association by 
refdes prefix and by net checkbox checked, and both nets attached to a two-pin 
component (or to a single gate of a multiple-pin component) have the Associate net 
checkbox checked, those nets will remain associated. 

For more information, see Conditions Governing Associated Net Creation.
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Related Topics

Creating Associated Nets

Excluding Components from Net Association

Excluding Nets from Net Association
You can exclude individual nets from inclusion in any associated net.

Tips: 

• This procedure clears both the Net Properties Associate net checkbox and the Allow net 
association by component checkbox, removing the selected nets from any current net 
association, and preventing net association by component (including by refdes prefix). 
For more information, see Conditions Governing Associated Net Creation.

• Whenever associated nets are created, deleted or changed, all associated nets in the 
design are regenerated. So you should always verify that the results of an associated nets 
operation are what you expected by reading the messages in the Output Window.

Procedure

1. In the workspace, select the net(s) you want to exclude from net association.

2. Right-click > Disable Net Association

Alternative: In the Net Properties dialog box, clear both the Associate net and Allow net 
association by component checkboxes.

Results

The selected nets are removed from existing associated nets, and the Net Properties Associate 
net and Allow net association by components checkboxes are cleared for all the selected nets.

Related Topics

Conditions Governing Associated Net Creation

Excluding Components from Net Association

Cancelling Net Association for Nets Associated by the Net Method

Excluding Components from Net Association
You can prevent an individual component from being an associating component, that is, a 
component through which an associated net passes. If you exclude a component that is not 
already part of an associated net, it cannot become part of an associated net created by net or by 
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refdes prefix. In addition, if the component is already part of an associated net, it is removed 
from the associated net.

Tips: 

• This procedure clears both the Component Properties Associate nets and Allow net 
association... checkboxes, preventing the selected components from being associating 
components. For more information, see Conditions Governing Associated Net Creation.

• Whenever associated nets are created, deleted or changed, all associated nets in the 
design are regenerated. So you should always verify that the results of an associated nets 
operation are what you expected by reading the messages in the Output Window.

Procedure

1. In the workspace, select the components you want to exclude from net association.

2. Right-click > Disable Net Association

Alternative: In the Component Properties dialog box, clear both the Associate nets and Allow 
net association by refdes prefix or by net checkboxes.

Results

The selected components are excluded from net association. If a component is part of an 
existing associated net, it is removed, that is, the associated net no longer goes through it. 
Removing a component from an associated net splits, truncates, or deletes the associated net, 
depending upon its configuration and the position of the removed component.

Are the results different from what you expected?

• Nets attached to the excluded component may still be associated through other 
components.

Related Topics

Conditions Governing Associated Net Creation

Excluding Nets from Net Association

Cancelling Net Association for Nets Associated by the 
Net Method

You can cancel the net association of nets associated by the net method. 

Tip: Whenever associated nets are created, deleted or changed, all associated nets in the design 
are regenerated. So you should always verify that the results of an associated nets operation are 
what you expected by reading the messages in the Output Window.
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Procedure

1. In the workspace or Project Explorer, select the nets you want to remove from 
associated nets.

2. Right-click > Properties

3. In the Associated Nets area, clear the Associate Net checkbox.

Tip: If you want to exclude the nets from net association altogether, also clear the Allow 
net association by components checkbox.

Results

The selected nets are removed from existing associated nets.

Are the results different from what you expected?

• Mixed-method restriction: Nets that are also associated by the component and/or the 
refdes prefix method remain associated.

Related Topics

Conditions Governing Associated Net Creation

Cancelling Net Association for a Component Associated 
by the Component Method

You can cancel the net association of a component associated by the component method. 

Tip:Whenever associated nets are created, deleted or changed, all associated nets in the design 
are regenerated. So you should always verify that the results of an associated nets operation are 
what you expected by reading the messages in the Output Window.

Procedure

1. In the workspace or Project Explorer, select the components whose net association you 
want to cancel.

2. Right-click > Properties

3. In the Associated Nets area, clear the Associate nets checkbox.

Tip: If you want to exclude the components from net association by any method, also 
clear the Allow net association by refdes prefix and by net checkbox.

Results

Net association by the selected component is cancelled.
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Are the results different from what you expected?

• Mixed-method restriction: Nets that:

• Are attached to selected components, and

• Are also associated by the net and/or the refdes prefix method

remain associated through the selected components.

Selecting Associated Nets

Procedure

1. In the workspace, select one of the nets in the associated net you want to select.

2. Right-click > Select Associated Net

Creating a Matched Length Group of Associated Nets

Procedure

1. Setup menu > Design Rules > Associated Nets button

2. In the Associated Net Rules dialog box, select the associated nets you want to include in 
the matched length group, and click the HiSpeed button.

3. Make appropriate settings in the HiSpeed Rules dialog box, and click OK.

Creating a Differential Pair of Associated Nets

Procedure

1. Setup menu > Design Rules > Differential Pairs button

2. In the Differential Pairs dialog box, select the Associated Nets tab.

3. Select the associated nets to make up the diff pair:

a. Select the first associated net from the Available list, and click the top Select button.

b. Select the second associated net from the Available list, and click the bottom Select 
button.

4. Click Add.

5. Set the properties of the diff pair as appropriate, and click OK.
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Creating Associated Net Design Rules
Use the Associated Net Rules dialog box to set or modify associated nets design rules.

Tip: By default, associated nets have no rules (that is, the default is no rules). If you do not 
specify rules for an associated net, it has none.

Procedure

1. You can assign rules to one or more associated nets at a time. There are two ways to 
select the associated net(s) before accessing the rule categories.

• Select associated nets in the design:

i. In the design area, select one of the nets in the associated net to which you want 
to apply rules.

Tip: You can also use the Find dialog box to find nets and use wildcards in the 
Value field to filter the selection.

ii. Right-click and click Select Associated Net.

iii. Right-click and click Show Rules.

• Select associated nets from the list in the Associated Net Rules dialog box:

iv. Setup menu > Design Rules > Associated Nets button.

v. In the Associated Net Rules dialog box, in the Associated Nets box, click one or 
more associated nets.

Tip: To display all associated nets, clear the Show Associated Nets with Rules check 
box.

2. Click the HiSpeed button, and specify Length and/or Matching rules for the selected 
associated net(s).

Result

After you define rules, , HiSpeed Rules indicators (H) appear beside the selected associated nets 
in the Associated Nets list.

Modifying Associated Net Design Rules
Follow the procedure in the topic Creating Associated Net Design Rules.

Clearing Associated Net Rules
You can clear the rules for selected associated nets.
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Tip: By default, associated nets have no rules (that is, the default is no rules). If you do not 
specify rules for an associated net, it has none.

Procedure

1. Setup menu > Design Rules > Associated Nets button.

2. In the Associated Net Rules dialog box, select one or more associated nets in the 
associated Nets list, click Default, and then click Yes.

Tip: The Default button is unavailable if the selected associated net has no rules 
assigned to it.

Result: You know you’ve successfully reset the net rules if the HiSpeed Rules indicator 
(H) is removed, and the Default button is no longer available.

3. Close all rules dialog boxes to return to the design.

Conditions Governing Associated Net Creation
Associated net creation is controlled by the following dialog box settings:

• The Associate net and Allow net association by components checkboxes in the Net 
Properties dialog box.

• The Associate nets and Allow net association by refdes prefix or by net checkboxes in 
the Component Properties dialog box.

• Refdes prefixes you specify in the Associated Nets dialog box.

• The Maximum net count per associated net and Maximum non-plane-net pin count fields 
in the Associated Nets dialog box.

The default settings for these checkboxes are:

• The Associate nets checkboxes, which create associated nets, are cleared by default for 
all nets and components. So by default, no nets are associated.

• The Allow net association... checkboxes, which allow the selected net or component to 
be associated by other methods, are set by default for all nets and components. So by 
default, you can associate any net or component by any of the three methods.

• The Maximum net count per associated net default value is 5.

• The Maximum non-plane-net pin count default value is 25.

A discrete component and its attached nets become part of an associated net only if the 
following conditions 1 and 2 are true:

1. The component and net properties are set so as to meet one of the following conditions:
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• COMPONENT Associate nets is set and neither attached net is excluded from net 
association (A component or net is excluded from net association if its Associate 
nets and Allow net association... checkboxes are both cleared.)

• NET Associate net is set for both nets and the component is not excluded from net 
association (A component or net is excluded from net association if its Associate 
nets and Allow net association... checkboxes are both cleared.)

• COMPONENT Allow net association...is set and no attached net is excluded from 
net association and the component’s refdes prefix is specified in the Associated Nets 
dialog box. (A component or net is excluded from net association if its Associate 
nets and Allow net association... checkboxes are both cleared.)

2. The component, its nets, and the potential associated net it will be a part of, conform to 
the General Restrictions for creating associated nets.



Setting Colors
Setting Colors

PADS Layout User’s Guide and Reference Manual, PADS 9.4 413

Chapter 18
Setting Colors

In this chapter:

• Setting Colors

• Setting Colors of Objects in the Display

• To Change the Color Palette

• Making All Objects Visible

• Making Objects Invisible in the Display

• Making Pin Numbers and Net names Visible or Invisible

• To Assign Colors to Objects on Different Layers

• To Save Color Assignments to a File

• Making Permanent Changes to the Display Colors

Setting Colors
There are four different ways to set colors in PADS Layout: In the Design Editor, to individual 
nets, in the Decal Editor, and when you want to produce a CAM document.

Restriction: You can change colors in the Decal Editor; however, the colors remain for the 
duration of your editing session with the decal only. When you change the decal, it reverts back 
to the defaults. 

• Design—Use the Display Colors Setup dialog box to set colors to objects on each layer.

• Nets—Use the View Nets dialog box to set colors to individual nets.

• Decal—Use the Display Colors Setup dialog box within the Decal Editor.
Important: Once you bring the decal into a design, the decal assumes the design colors.

• CAM—Use the Select Items dialog box to set colors to objects in CAM before printing 
the CAM document.
Restriction: You must have a color printer for the colors to appear in the Select Items 
dialog box.
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Setting Colors of Objects in the Display
As you work on a layout design, you can customize display colors to make it easier to see 
objects as you place them. Using the Display Colors Setup dialog box, you can:

• Set and change the color of objects on a per layer or per object type basis.

• Make objects visible or invisible in the display (also on a per layer or per object type 
basis).

• Customize the palette of color selections.

• Save your customizations in a configuration file. 

Procedure

1. Setup menu > Display Colors.

2. Set the color(s) you want:

a. To set the color for one object, in the Selected Color area, click a color tile. Then in 
the Layers/Object Types table, click the tile for the object type in the correct layer 
row.
Tip: To change the palette of colors from which you can select, click Palette. 
See also: To Change the Color Palette

b. To make all objects on a layer the same color, click the layer number to select the 
entire row, and then click the color tile in the Selected Color area.

c. To make an object the same color on all layers, click the object name to select the 
entire column, and then click the color tile in the Selected Color area.

d. To make an object type invisible, set its tile to the background color. You can 
make multiple objects invisible (for example, all objects on the same layer). 
See also: Making Objects Invisible in the Display.

Tip: To make an object type the same color on all layers, use the Assign Color to 
All Layers dialog box.

3. Click Apply.

Result: The display reflects your color settings. When you save the design, PADS Layout stores 
the settings with design data.

Tips:

• You can save display color settings you commonly use as you work on a design. See To 
Save Color Assignments to a File.

• You can use modeless commands to make pin numbers and net names visible or 
invisible. See Making Pin Numbers and Net names Visible or Invisible.
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Color configurations saved in PowerPCB versions 2.1 and lower cannot be used in PowerPCB 
versions 3.0 and higher.

Related Topics

To Change the Color Palette

To Save Color Assignments to a File

Display Colors Setup Dialog Box

To Change the Color Palette
You can change the colors that appear in the color palette.

Procedure

1. Setup menu > Display Colors.

2. In the Selected Color area, click the color tile that you want to change.

3. Click Palette.

4. In the Color dialog box, click the color value you want to use.

Tip: You can also create a custom color. Refer to the Windows Help for more 
information on changing the Windows color palette.

5. Click OK to return to the Display Colors Setup dialog box.

Result

The new color appears in the tile you selected.

Related Topics

Setting Colors of Objects in the Display

Creating a New Default Decal Editing Environment

To Save Color Assignments to a File

Display Colors Setup Dialog Box

Making All Objects Visible
To make objects visible:

1. Setup menu > Display Colors.

2. Click Assign All to open the Assign Color to All Layers dialog box.
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3. Click Automatically Make Objects Visible.

4. Select one of the following:

• One Color Per Object Type assigns color for a certain object type, which is 
currently set to the background color, on all layers,

• One Color for a Layer assigns color for all objects, which are currently set to the 
background color, on the same layer,

• Selected Color assigns a color you select from the Display Colors Setup dialog box 
color matrix to all objects, which are currently assigned the background color, on all 
layers.

5. Click OK. You return to the Display Colors Setup dialog box.

You can also make objects invisible. See Making Objects Invisible in the Display.

Making Objects Invisible in the Display
When you are placing or routing components in a layout design, it can be helpful to have certain 
objects visible in the display and others invisible. For example, you might want to make objects 
on the power, ground, and bottom layers invisible when you are routing on the top layer.

To make all objects invisible:

1. Setup menu > Display Colors.

2. Use the method that matches what you want to do.

• To make one object type invisible, set its tile to the background color.

Tip: When you are working in the design, you can make pin numbers or net names 
invisible (or visible again) using modeless commands. See Making Pin Numbers and 
Net names Visible or Invisible.

• To make all objects on a layer invisible, clear the check box to the right of the 
layer name. To make all objects on a layer visible, select the check box.

• To make an object type invisible on all layers, clear the check box above the 
column for that object type. To make an object type visible on all layers, select the 
check box.

• To make all objects invisible, change their colors on all layers to the background 
color. You might use this option as a quick way to clear the display of objects except 
for board outline and connections, whose colors are set in the Other area.

Click Assign All. On the Assign Colors to All Layers dialog box, click Assign 
Background Color to All Objects.
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Tip: Make sure you save your color configuration so you can revert to the design 
colors you were using.

• To list only the layers with visible objects, select the Visible only check box.

3. Click Apply.

Making Pin Numbers and Net names Visible or 
Invisible

While working in a layout design, you can use the following modeless commands to turn 
display of net names and pin numbers on or off:

Related Topics

Typing Modeless Commands

Setting Pin Number and Net Name Display Options

PN Toggles pin number display on/off.
Tip: This command toggles the Pin Num. column check box in the 
Display Colors Setup Dialog Box.

NN Enables/disables the settings of the NNP, NNT, and NNV commands. 
That is:
• When net name display is turned off with the NN command, no net 

names are displayed, irrespective of the NNP, NNT and NNV 
settings.

• When net name display is turned on with the NN command, net 
names are displayed or not displayed, according to the NNP, NNT 
and NNV settings.

Tip: This command toggles the Pin Num. check box in the Display 
Colors Setup Dialog Box.

NNP Toggles display of net names on pins on/off.
Tip: This command toggles the Net names on...Pins check box in the 
Display Colors Setup Dialog Box.

NNT Toggles display of net names on traces on/off.
Tip: This command toggles the Net names on...Traces check box in the 
Display Colors Setup Dialog Box.

NNV Toggles display of net names on vias on/off.
Tip: This command toggles the Net names on...Vias check box in the 
Display Colors Setup Dialog Box.
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Setting Pin Number and Net Name Display 
Options

Use the Display page of the Options dialog box to set the text size of displayed net names and 
pin numbers, and the maximum allowable gap between net names on traces.

To Assign Colors to Objects on Different Layers
You can assign various colors to different objects on different layers. You can assign colors for 
pads and component pins, pin numbers, net names, traces, vias, lines (nonelectrical drawn 
items), text, copper and copper pour, errors, labels (reference designator, part type, and attribute 
labels), keepouts, and outlines (top and bottom). 

Procedure

1. Setup menu > Display Colors.

2. Click a color from the Selected Color area.

3. Click a tile in an item column and a layer row. The color for that object changes for that 
layer.

4. To make all objects on a layer invisible, click to clear the check box to the right of the 
layer name. Click the check box to view the objects.

5. To make an object type invisible on all layers, click to clear the check box on top of the 
column for the object type. Click the check box to view the objects.

Tip: You can't set up colors per attribute type, only by layer.

Related Topics

To Change the Color Palette

To Save Color Assignments to a File

Setting Colors of Objects in the Display

Display Colors Setup Dialog Box

To Save Color Assignments to a File
You can save color assignments you have specified in the Display Colors Setup dialog box to a 
file.

Procedure

1. Setup menu > Display Colors.



Setting Colors
Making Permanent Changes to the Display Colors

PADS Layout User’s Guide and Reference Manual, PADS 9.4 419

2. Set the color assignments you want.

3. Click Save in the Configuration area.

4. Type the configuration name in the Save Configuration dialog box. The current color 
settings are saved under the new name. Configurations are saved in the 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Settings folder as the saved 
name with a .ccf extension. To change the default display colors setup, name the color 
configuration default.ccf. The Save Configuration dialog box appears.

Warning: You are not prompted if you overwrite an existing color configuration.

To use a previously saved configuration, select the configuration name from the Configuration 
list.

To save the current color settings under an existing configuration, select the configuration name 
from the configuration list and click Save. Name the new configuration with the old file name. 
The file is overwritten.

To delete a configuration, select the configuration in the list and click Delete.

Related Topics

Setting Colors of Objects in the Display

Display Colors Setup Dialog Box

Making Permanent Changes to the Display 
Colors

The Display Colors of the Design Editor and the PCB Decal Editor only change for the current 
Design or Decal. To make permanent changes to the colors, you must create a new default start-
up file for the Design Editor or the PCB Decal Editor.

For the Design Editor, see Customizing PADS Layout Default Settings

For the PCB Decal Editor, see Creating a New Default Decal Editing Environment
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Chapter 19
Setting Options

In this chapter:

• Creating a Backup File

• To Set the Display Grid

• To Set the Design Grid

• DRC and the Via Stitching and Shielding Operations

• Setting Via Shielding Options

• Setting Shape Stitching Options

Creating a Backup File
PADS Layout automatically backs up your files based on the settings you choose.

Procedure

1. Tools menu > Options > Global > Backups page.

2. In the Interval box, type the time in minutes between backups.

3. In the Number of Backups box, type the quantity (1-9) of different backup files to create.

Tip: Backup files are named <design_name>.#, where # is a sequential number. For 
example, Layout1.pcb, Layout2.pcb, and so on.

4. If you want to change the folder or name of the backup file, click Backup File.

Result: The Backup File dialog box appears. Browse to the folder, type the file name, 
and then click Save.

5. Select the Use design name in backup file name check box to use the design name 
instead of the product name as the file name.

Example: preview_Layout1.pcb, preview_Layout2.pcb instead of layout1.pcb, 
layout2.pcb.

6. Select the Create backup files in design directory check box to place all of your 
backup files in the same directory as the design.

Tip: Click to clear if you want your backup files in one, common backup directory.
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Results

To Set the Display Grid

Procedure

1. Tools menu > Options > Grids tab.

2. Use the Grids page of the Options dialog box to set the display grid.

Tip: The fastest and most convenient way to change a grid is to use the Modeless Command; 
type GD <x> <y> and press Enter.

To Set the Design Grid
To set or reset the design grid:

• Use the Modeless Command; type GR <x> <y> and press Enter.

Tip: You can also change the design grid and the via grid by typing G <x> <y> and pressing 
Enter.

DRC and the Via Stitching and Shielding 
Operations

The Design Rule Checking (DRC) setting determines whether the Via Stitch and Add Via 
Shield operations can add vias. The DRC setting works with these operations in the following 
ways:

• Even when the DRC setting is Off, the Via Stitch and Add Via Shield operations do not 
add vias that violate clearance rules for pins, coppers, keepouts, texts, and board outline. 
However, the operations may create violations with traces if the DRC setting is Off.

Table 19-1. Backup File Creation

If this is selected: The Backup File is Saved

Create backup 
files in design 
directory

Use design Name 
in backup file 
name

in one common directory without the design name.

X X in the design directory using the design name.

X in the design directory without the design name.

X in one common directory using the design name.
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• If the DRC setting is Prevent Errors, DRC prevents the via stitching and shielding 
operations from placing any via that violates design rules, including traces.

• If the DRC setting is Warn Errors, when the stitching and shielding operations place vias 
that violate design rules, DRC displays the warning “Clearance violations detected. 
Permit?”

Related Topics

See the On-line DRC setting on the Design page of the Options dialog Box.

Setting Via Shielding Options
Use options in the When Shielding area of the Via Patterns tab to specify the via type for vias 
used for shielding.

Requirement: You must have a design open in order to set Via Patterns options.

Tip: See for a description of each option, see the Via Patterns page.

Procedure

1. Tools menu > Options > Via Patterns.

2. In the When Shielding area, from the Add vias from net: list, select the net you want to 
associate with the vias used in shielding. Then select a Via type. (Design rules determine 
available via types.)

3. In the Shielding spacing area, specify the distance from the shielding vias to the trace or 
shape they shield. 

Select Use design rules to have design rules determine the distance or select either Via 
to edge or Via to ground edge and specify a value. (For information on these options, 
see the Via Patterns page.)

4. In the Via Spacing box, specify a distance between vias (center to center).

Note: The value you specify applies to both Via Stitch and Add Via Shield operations.

5. To glue each via added by the Add Via Shield or Via Stitch operation, select Glue vias 
as they are added.

6. Make sure that the Ignore Via Grid check box is selected; otherwise vias snap to the 
grid.

7. Click OK.

Tips: 

• Set Via Patterns options before using Add Via Shield or Via Stitch commands.
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• PADS Layout stores your settings in the design for future operations; you need to set 
them again only if you want to change the settings.

• The Add Via Shield and Via Stitch operations do not move traces in order to make room 
for the vias. For best results, you should add via shielding or via stitching early in design 
layout when your design has fewer traces.

Related Topics

Adding a Via Shield

Setting Shape Stitching Options
Use options in the When stitching shapes area of the Via Patterns tab to specify the via type for 
stitching a copper shape for a given net.

Requirement: You must have a design open in order to set Via Patterns options.

Procedure

1. Tools menu > Options > Via Patterns tab.

2. In the When stitching shapes area, click Add to add a new line to the Nets/Via Type list.

3. Select a net for stitching and then select a via type.

Tip: Design rules determine available via types.

4. In the Pattern area, select the mode for placing vias in a shape.

• Fill—Choose the Aligned or Staggered pattern.

• Perimeter

Result: The Preview area displays your selections.

5. In the Via to shape box, specify the distance from the edge of the shape to the edge of 
the via pattern used in stitching the shape.

6. Select the Fill selected hatch outline option to fill only a selected hatch outline or clear 
the check box to fill all hatch outlines in the shape.

7. In the Via Spacing box, specify a distance between vias (center to center).

Note: The value you specify applies to both Via Stitch and Add Via Shield operations.

8. To glue each via added by the Via Stitch or Add Via Shield operation, select Glue vias 
as they are added.

9. To have Via Stitch and Add Via Shield operations ignore the via grid setting, select the 
Ignore Via Grid check box. To have vias snap to the grid, clear the check box.

10. Click OK.
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Tips: 

• Set Via Patterns options before using Add Via Shield or Via Stitch commands.

• PADS Layout stores your settings in the design for future operations; you need to set 
them again only if you want to change the settings.

• The Add Via Shield and Via Stitch operations doe not move traces in order to make 
room for the vias. For best results, you should add via shielding or via stitching early in 
design layout when your design has fewer traces.

Related Topics

Filling a Shape with a Pattern of Vias

Placing Vias Inside the Perimeter of a Shape
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Chapter 20
Controlling Attributes

In this chapter:

• Using the Attribute Dictionary

• Setting Attribute Properties

• Using the List Attribute Type

• Using the Measure Attribute Type

• Using the Number or Decimal Number Attribute Type

• Using the Objects Tab

• Using the Attribute Manager

• Showing Attributes in the Attribute Manager

• Working with Object Attributes

• Modifying Default Attributes

• Customizing Units for Attributes

Using the Attribute Dictionary
Although you can add new attributes to design objects using the Object Attributes dialog box 
(select object > right-click > Attribute), you must use the Attribute Dictionary to set the 
properties for attribute values. It is recommended that you use the Attribute Dictionary to create 
new attributes for, or to edit and delete attributes in, your design. You can also use the Attribute 
Dictionary to assign attributes for the design, or remove attributes from objects.

In this topic:

• Creating Attributes for the Design

• Modifying Design Attribute Properties

• Deleting Design Attributes

• Working with Pre-3.0 Designs
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Creating Attributes for the Design
PADS Layout provides default attributes that are applied to every new design you create. 
Although the attributes are provided, they are not assigned to any objects.

See also: Default Attributes in the Concepts Guide 

To create an attribute:

1. Edit menu > Attribute Dictionary. 

2. Click New.

3. Add the attribute and set up the attribute properties following the steps in Setting 
Attribute Properties.

4. When you finish setting attribute properties, click OK to return to the Attribute 
Dictionary dialog box.

5. Repeat Steps 2 to 4 for each new attribute you want to create.

6. Click Close.

Modifying Design Attribute Properties
Use the Attribute Dictionary to modify design attribute properties.

Requirement: If an attribute is ECO-Registered, you must be in ECO mode to modify the 
attribute.

1. Edit menu > Attribute Dictionary.

2. You can select an attribute group from the Group list. This list acts as a filter and allows 
you to view only a select group of attributes. Attributes are grouped if you they are 
structured attributes.

Tip: If you select the Show Hidden check box, you can view attribute groups that have 
no visible attributes. You set whether an attribute is hidden on the Objects tab of the 
Attribute Properties dialog box.

3. Click the attribute to modify from the list. Default attributes and the design attributes are 
listed.

Tip: You can modify the default attributes; however, it is not recommended.

4. Click Properties. The Attribute Properties dialog box appears.

5. Modify the attribute properties following the steps in Setting Attribute Properties.

6. When you finish setting attribute properties, click OK to return to the Attribute 
Dictionary dialog box.
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7. Repeat Steps 2 to 5 for each attribute you want to modify.

8. Click Close.

Deleting Design Attributes
Use the Attribute Dictionary to delete attributes in your design. If you delete a decal attribute, 
any labels associated with it are now associated with non-decal attributes.

1. Edit menu > Attribute Dictionary.

2. You can select an attribute group from the Group list. This list acts as a filter and allows 
you to view only a select group of attributes. Attributes are grouped if you they are 
structured attributes.

3. Clear the Show Hidden check box. Only attribute groups that contain at least one 
visible attribute appear in the list.

4. Click the attribute to delete from the list. 

Tip: You can delete the default attributes; however, it is not recommended. Because the 
default attributes are only provided for your design and not assigned to objects, you do 
not need to delete these attributes.

5. Click Delete. The message “Are you sure you want to delete attribute type XXX?” 
appears.

Exception: If you select a hidden attribute, this button is unavailable.

6. Click Yes to delete the attribute.

Working with Pre-3.0 Designs
Designs created in PADS software before version 3.0 will not list any provided Default 
Attributes. 

• In the Update from lib. area, click Load Now to automatically load attributes for part 
types and decals from the current libraries to the Attribute Dictionary.

• Click AutoLoad for pre-3.0 Designs, and then open (load) a design file; the attributes 
are updated as soon as the file loads.

Setting Attribute Properties
Use the Attribute Properties dialog box to set the properties of attribute values. Properties are 
assigned to attributes, not to objects; therefore attributes cannot have properties that change 
depending on the object. Attribute properties include the type of value you want the attribute to 
have, whether values are case sensitive, and the objects to which you want to apply the attribute.
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If the attribute is a system attribute, all of the options in this dialog box are unavailable, except 
the System attribute option on the Objects tab (which you would use to turn off the system 
attribute flag - not recommended).

In this topic:

• Adding a New Attribute

• Modifying Attribute Properties

• Using the Free Text Attribute Type

• Using the Yes/No Attribute Type

• Using Other Attribute Types

Adding a New Attribute
1. Edit menu > Attribute Dictionary > click New.

2. Type the name of the new attribute to create in the Attribute box.

Tips: Attributes names can be 255 characters long. You can use any printable character, 
including spaces, in an attribute name. A space, however, cannot be the first or last 
character, or the character after a dot in the attribute name (for example, xxx. xxx is 
illegal). Attribute names are not case sensitive, and they are defined for the entire 
design, not per object.

3. On the Type tab, assign a type to the attribute and assign settings to the type if 
applicable. The default type is Free Text. Choose from:

Free Text—Allows you to type a text string as the attribute value.

Yes/No—Creates a list box with Yes and No as the attribute values.

Number—Allows you to type a number as the attribute value.

Decimal Number—Allows you to type a decimal number for the attribute value. 

Measure—Allows you to determine a measurement for the attribute value. It is a 
physical value associated with units. 

List—Allows you to create a list from which you choose the value. 

4. On the Objects tab, assign settings and hierarchy to the objects to which you want to 
apply the attribute.

5. Click OK to return to the Attribute Dictionary.
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Modifying Attribute Properties
Attribute properties include the type of value you want the attribute to have, whether values are 
case sensitive, and the objects to which you want to apply the attribute. Properties are assigned 
to attributes, not to objects; therefore, attributes cannot have properties that change depending 
on the object. 

To set attribute properties:

1. Edit menu > Attribute Dictionary.

2. Click an attribute for which to set properties from the list.

3. Click the Properties button. The Attribute Properties dialog box appears.

4. Click the Types tab, and click the type for the attribute. Choose from:

Free Text—Allows you to type a text string as the attribute value.

Yes/No—Creates a list box with Yes and No as the attribute values.

Number—Allows you to type a number as the attribute value.

Decimal Number—Allows you to type a decimal number for the attribute value. 

Measure—Allows you to determine a measurement for the attribute value. It is a 
physical value associated with units. 

List—Allows you to create a list from which you choose the value.

If you use the design unit Mil, assign the attribute at the board level. Otherwise the unit 
will not change when you change units for the design (using the Global / General page 
of the Options dialog box).

5. Click the Objects tab, and click the objects you want to restrict. You can't assign the 
attribute to a restricted object. For example, if you are defining the properties for a 
Manufacturer attribute, you may want to restrict nets so they can't have this attribute. 
Therefore, you would disable the Net object for the Manufacturer attribute.

6. To use the default hierarchy, click Use Default Hierarchy. If you choose not to use the 
default hierarchy, you can modify it. Modifying the hierarchy is considered an advanced 
procedure. 

See also: Using the Objects Tab

7. If you want to enable ECO Registration of the attribute, click ECO Registered. If you 
enable ECO Registration, changes made to the attributes are recorded in the ECO file. 
Enabling ECO Registration also restricts you to modifying attributes while the ECO 
toolbar is active (ECO mode).

8. Click OK when you finish setting attribute properties to return to the Attribute 
Dictionary dialog box.
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Using the Free Text Attribute Type
You can select the Free Text attribute type to use any text as the attribute value. This is the 
default. Free text is not “intelligent.” You can type the name of the net as an attribute, but the 
attribute will not update if you rename the net. With the Free Text type you can select the Case-
sensitive parameter to preserve the letter case of Free Text entries. This setting affects sorting 
and matching in the Find dialog box and the Attribute Manager dialog box.

Using the Yes/No Attribute Type
You can select the Yes/No attribute type to create a list where you can select Yes or No as the 
attribute value.

Using Other Attribute Types
You can select other attribute types which require additional parameters. See the following 
topic for specific information regarding the other attribute types. See also: Using the List 
Attribute Type, Using the Measure Attribute Type, Using the Number or Decimal Number 
Attribute Type



Controlling Attributes
Using the List Attribute Type

PADS Layout User’s Guide and Reference Manual, PADS 9.4 433

Using the List Attribute Type
Use this tab to set the attribute type.

In this topic:

• Selecting the List Type

• Adding List Entries

• Deleting List Entries

Selecting the List Type
You can select the List attribute type to create a list of options for the value. For example, you 
can create a list of all of your part manufacturers that is used every time you assign the attribute. 

Adding List Entries
You can create a list of entries as options for the attribute value.

1. Type an attribute value in the box.

2. Click Set to add the item to the list.

3. Repeat steps 1 and 2 as necessary.

4. You can select the Case-sensitive check box to preserves the letter case of List entries. 
This setting affects sorting and matching in the Find dialog box and the Attribute 
Manager dialog box.

Result: The List box contains the items you entered as possible values for attributes. The items 
in the list appear as a list from which you can click a value in the Object Attributes or Attribute 
Manager dialog boxes.

Deleting List Entries
You can click Clear or Clear All to delete an item or all items from the list.

Using the Measure Attribute Type
Use this tab to set the attribute type.

In this topic:

• Selecting the Measure Type

• Using a Listed Set of Units
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• Adding a New Set of Units

• Setting Limits for the Measure Attribute Type

• Deleting a Set of Units

Selecting the Measure Type
You can select the measure attribute type to set measurement parameters for the attribute value. 
It is a physical value associated with units. You can set up the unit of measurement and set a 
minimum and maximum for the value. You can click a unit of measure from the predefined list 
or you can add a new unit to the list. You can also customize units. You can either use an 
existing measurement unit or add a new measurement unit to the design.

Attribute values for the Measure type properties are automatically converted during the ECO 
process. 

Using a Listed Set of Units
All of the default units (and unit prefixes) of measurement appear in the list.

• In the Measure list, select a measurement unit. The abbreviation appears in the Abbr 
box, the unit in the Unit box, and the measure or quantity in the Quantity box.

Adding a New Set of Units
You can also permanently change the default units that appear in this list.

To add a new unit to the list:

1. In the Abbr box, type the abbreviation to use for the unit. 

2. In the Unit box, type the name of the unit.

3. In the Quantity box, type the quantity, or what it measures.

4. Click Set.

Tip: If you use the unit Mil, assign the attribute at the board level. Otherwise the unit will not 
change when you change units for the design (using the global / General page of the Options 
dialog box).

Setting Limits for the Measure Attribute Type
You can specify a range for the Measure attribute type. Type in the Min and Max boxes to set 
the range. PADS Layout checks against the Limits area values. Therefore, if an attribute has the 
Number, Decimal Number, or Measure type property, PADS Layout checks the attribute value 
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against this property. Leading zeros are removed, trailing zeros after the decimal point are 
removed, and numbers greater than 6 characters are rounded.

• Type a minimum value in the Min box and/or a maximum value in the Max box.

Deleting a Set of Units
You can click Clear or Clear User to delete an item or all user items from the list. Clear User 
deletes only user-defined units from the list. The default units remain in the list.

Related Topics

Default Units in the Concepts Guide

Customizing Units for Attributes in the Concepts Guide

Using the Number or Decimal Number Attribute 
Type

Use this tab to set the attribute type.

In this topic:

• Selecting the Number or Decimal Number Type

• Setting Limits for the Measure Attribute Type

Selecting the Number or Decimal Number Type
You can type an integer number (Number) or a number with decimal or floating point numbers 
(Decimal Number) for the attribute value. Attribute values for the Number or Decimal Number 
type properties are automatically converted during the ECO process.

Setting Limits for the Number or Decimal Number Type
You can specify a range for the Number or Decimal Number attribute type. Type in the Min and 
Max boxes to set the range. PADS Layout checks against the Limits area values. Therefore, if 
an attribute has the Number or Decimal Number type property, PADS Layout checks the 
attribute value against this property. 

Number—you can type any number between -232 and 232 -1. Leading zeros are removed. 
Numbers with more than 6 zeros may be converted to scientific notation.

Decimal Number—you can type any number between 1.7E +/- 308. Leading zeros are 
removed, trailing zeros after the decimal point are removed, and numbers greater than 6 
characters are rounded.
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• Type a minimum value in the Min box and/or a maximum value in the Max box.

See also: Number/Decimal Number Attribute Values and ECO in the Concepts Guide

Using the Objects Tab
Use the Objects tab to assign the attribute to objects and set up the hierarchy for the attribute.

If the attribute is a system attribute, all of the options in this dialog box are unavailable, except 
the System attribute option on the Objects tab (which you would use to turn off the system 
attribute flag).

In this topic:

• Applying the Attribute to Objects

• Changing the Default Attribute Hierarchy

• Selecting ECO-Registered Status

• Selecting System Status

• Selecting Read-Only Status

• Selecting Hidden Status

Applying the Attribute to Objects
You can apply or restrict the attribute by selecting design objects to which you want to apply the 
attribute.

1. Edit menu > Attribute Dictionary > click New or [or select an attribute > Properties].

2. Type the name of the new attribute in the Attribute box. If you are not creating a new 
attribute, ensure the attribute name of the attribute you are modifying appears in the 
Attribute box. You can use the Browse Lib Attr button to select an attribute from the 
Attribute Dictionary list of library attributes.

3. On the Objects tab, in the Objects list, select the check box beside objects to which you 
want to make available the new attribute. 

Tip: The Part object is the component in the design. The PCB object is the PCB design as a 
whole. If you select the Via check box, the ECO Registered check box is unavailable.

Changing the Default Attribute Hierarchy
You can change the default hierarchy of attribute values. For example, an attribute value can be 
assigned to a decal, part type, and to the component in the design. A component level value 
overrides a part type value which in turn, overrides a decal level value. If you assign attributes 
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to multiple levels and then delete an attribute, the attribute from the highest possible hierarchy 
level is assumed.

1. Edit menu > Attribute Dictionary > click New or [or select an attribute > Properties].

2. Clear the Use Default Hierarchy check box.

Requirement: You must have selected enough objects in the objects list to activate a 
hierarchy. The order of the objects in the Objects list shows the default hierarchy.

3. Select an object in the Objects list. 

4. Click the hierarchy level you want to move.

5. Click Up or Down to move the hierarchy level. The object at the top of the list has the 
highest priority.

Restriction: Hierarchy modification is restricted. PADS Layout automatically sets a certain 
logical hierarchy. For example, you cannot place Net Class above Net in the hierarchy because 
a net cannot usually be derived from a Net Class. PADS Layout automatically places Net above 
Net Class in the hierarchy.

Selecting ECO-Registered Status
Allows you to specify if the attribute is ECO registered. If so, changes to the attribute are 
registered in the ECO file. If this check box is clicked, you can only modify attributes when the 
ECO toolbar is open (ECO mode).

• Edit menu > Attribute Dictionary > click New or [or select an attribute > Properties].

ECO registration of attributes is not forward or backward annotated. The value of an attribute is 
backward annotated only if the attribute is ECO registered; turn on ECO Registered for 
attributes to backward annotate. When forward annotating, a report automatically appears in 
your default text editor indicating the ECO Registration of imported attributes. If an attribute 
does not exist in the Attribute Dictionary, it is added with ECO Registered turned off. If the 
attribute already exists in the dictionary, the existing attribute and ECO Registered status in the 
dictionary are used.

Exceptions:

• If you click the Via object check box only, the ECO Registered check box is 
unavailable.

• Attributes modified using Automation are never registered in the ECO file, regardless of 
this setting.
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Selecting System Status
Shows whether the attribute is a system attribute. System attributes are used by PADS Layout, 
an external program, or an Automation script (such as Sax Basic). The System check box 
prevents you from modifying an attribute that is internally set by, and critical to, PADS Layout 
operation.

• Edit menu > Attribute Dictionary > click New or [or select an attribute > Properties].

Exceptions: Automation ignores this setting and can change a system attribute. This setting is 
also ignored in the PCB Decal Editor and the library. This setting does not effect opening .pcb 
files, importing .asc files, importing .dxf files, importing .eco files, or interactive ECO 
operations (such as Add Part from Library, Update Part from Library, or Change Part).

The System check box is automatically selected if an attribute requires a specific type for 
processing. You can also turn on the System check box to prevent accidental modification of an 
Attribute Dictionary entry, which may be useful if external programs use the attribute. 

You can modify the value of a system attribute. You cannot modify the Attribute Dictionary 
entry of a system attribute. For new attributes, the System check box is turned off by default.

Warning: Do not modify the properties or Attribute Dictionary entry of a system attribute. 
Severe program or script errors can occur.

Selecting Read-Only Status
Shows whether the attribute value is read-only, which means it cannot be changed outside of the 
library. However, you can modify the attribute properties. If you want to modify the attribute 
value, do so in the library.

• Edit menu > Attribute Dictionary > click New or [or select an attribute > Properties].

Exceptions: Automation ignores this setting and can change a read-only attribute. This setting 
is also ignored in the PCB Decal Editor and the library. This setting does not effect opening .pcb 
files, importing .asc files, importing .dxf files, importing .eco files, or interactive ECO 
operations (such as Add Part from Library, Update Part from Library, or Change Part).

If you are responsible for setting attribute values, you may find the Read-Only status useful 
because it prevents other users from changing a value. The Read-Only check box can also 
protect part and decal library attribute data from modification.

For new attributes, this option is cleared by default. The Read-Only check box is unavailable if 
the Hidden check box is clicked because you cannot edit the value of a hidden attribute.

Selecting Hidden Status
Hides the attribute, so that it is not visible or editable. It will not appear in any dialog boxes.
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• Edit menu > Attribute Dictionary > click New or [or select an attribute > Properties].

Hidden attributes may be useful in the design, in a schematic program, or to an external 
program or script (such as Automation, ASCII, or ECO).

Exceptions: Automation ignores this setting and can change a hidden attribute. This setting is 
also ignored in the PCB Decal Editor and the library. This setting does not effect opening .pcb 
files, importing .asc files, importing .dxf files, importing .eco files, or interactive ECO 
operations (such as Add Part from Library, Update Part from Library, or Change Part).

See also: Attribute Hierarchy in the Concepts Guide 

Using the Attribute Manager
Use the Attribute Manager to view all of the attributes on all objects in the design. The Attribute 
Manager provides a spreadsheet view of all the attributes in the design. You can use the 
Attribute Manager to add, edit, and delete attribute values on multiple object types. You can 
also create value summaries of an attribute that is based on every value of the attribute assigned 
to objects of the same type. In other words, summaries are applied per attribute and apply to all 
objects on the same tab.

Exceptions: Rows in the multi-column list are unavailable if the attribute is read-only. Rows 
are also unavailable if the attribute is ECO-registered and PADS Layout is not in ECO mode. 
Hidden attributes do not appear in the list. All objects appear in the multi-column list, regardless 
of whether they have attributes assigned to them. Objects that do not have attributes assigned to 
them have <none> in the cell under the attribute name. Objects that have attributes assigned to 
them, but not values, have blank cells under the attribute name.

Recommendation: You can avoid DRC violations or shorts by placing attributes on 
Documentation layers if used in the design. If an attribute is displayed in the design, and placed 
on an Electrical layer it will show up as copper in the manufacturing documents. Place free text 
and attribute values on the Silkscreen Top layer or another documentation layer.

In this topic:

• Listing Design Objects

• Listing Object Attributes

• Interpreting the Hierarchy Level

• Sorting Column Cells

• Adding Attribute Values

• Modifying Attribute Values Using the Attribute Manager

• Deleting Attribute Values
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• Applying an Attribute Value to All Other Objects

• Enabling Attribute Summaries

• Changing Summary Types

Listing Design Objects
The multi-column list of the Attribute Manager catalogs design objects and the attributes 
assigned to them. Objects appear in the left column and their attribute names appear in the 
column headers.

1. Edit menu > Attribute Manager.

2. In the View area, click a view option:

Selected—Lists attributes from the objects selected in the design. If you select objects in 
the design and then click Attribute Manager from the Edit menu, selected objects 
appear on their appropriate tab. If you do not select objects of a certain type, the tab is 
unavailable. To view other objects, use the Filter.

Filter—Lists attributes from all of the objects in your design. This view option allows 
you to view attributes assigned to non-selectable objects, such as Decals and Part Types. 
When using the filter, type the first characters of the objects to view, type an asterisk 
after the character, and then click Apply Filter. The objects appear on the appropriate 
tab in the multi-column list.

Listing Object Attributes
The multi-column list of the Attribute Manager catalogs design objects and the attributes 
assigned to them. Objects appear in the left column and their attribute names appear in the 
column headers. The rows show the attribute setting for each specific object. Use the Show and 
Hide buttons to control which attributes appear for design objects.

Showing Attributes
You can select which attributes you want to view in the multi-column list.

To show attribute columns:

1. Edit menu > Attribute Manager > click Show. 

2. Use the Show Attributes dialog box to select which attributes you want to view in the 
list.

3. Click OK.
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Hiding Attributes
You can remove a selected attribute from view in the multi-column list.

To hide attributes in the Attribute Manager dialog box:

1. Edit menu > Attribute Manager.

2. Select a cell in the column of the attribute you no longer want to view.

3. Click Hide. The attribute is no longer displayed.

Interpreting the Hierarchy Level
You can view the source of the attribute value in the Attribute Manager. For example, an 
attribute value can be assigned to a decal, part type, and to the component in the design. A 
component level value overrides a part type value which in turn, overrides a decal level value.

1. Edit menu > Attribute Manager.

2. Select a cell in the multi-column list with an attribute value and view the Hierarchy 
Level.

Tip: If you assign attributes to multiple levels and then delete an attribute, the attribute from the 
highest possible hierarchy level is assumed.

See also: Attribute Hierarchy in the Concepts Guide

Sorting Column Cells
You can sort the rows of the Attribute Manager.

1. Edit menu > Attribute Manager.

2. Click on the column header (name of the attribute) to sort the column in ascending 
order. Click on it again to sort in descending order.

Adding Attribute Values
In the Attribute Manager, you can add an attribute and value to an object that does not already 
have the attribute assigned to it. You can add values to cells with <none> in it, which means the 
attribute is available to the design but is not assigned to the object.

Restrictions: You cannot add a hidden attribute, read-only attribute, or ECO-registered 
attribute while not in ECO mode.

1. Edit menu > Attribute Manager.
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2. Select a cell with <none> in it.

3. Click Add.

4. Type a value in the cell and press Enter.

Tips: You can only add attribute values to a design object for attributes that are available to the 
design. To create a new attribute for use with design objects, see Creating Attributes for the 
Design. You can include a unit with the value. PADS Layout also provides a default set of units 
(and unit prefixes) that are accepted as input and used as output. See also: Default Units in the 
Concepts Guide

Modifying Attribute Values Using the Attribute Manager
In the Attribute Manager, you can edit blank attribute value cells or cells with a value. If a cell is 
blank, it means that the attribute is assigned to the object, but has no value.

Restrictions: You cannot edit a read-only attribute, or an ECO-registered attribute while not in 
ECO mode.

1. Edit menu > Attribute Manager.

2. Select a blank cell or a cell with a value.

3. Click Edit.

4. Type a value in the cell and press Enter.

Tip: You can include a unit with the value. PADS Layout also provides a default set of units 
(and unit prefixes) that are accepted as input and used as output. See also: Default Units in the 
Concepts Guide

Deleting Attribute Values
In the Attribute Manager, you can delete an attribute and value from a design object.

Restrictions: You cannot delete a read-only attribute, or an ECO-registered attribute while not 
in ECO mode.

1. Edit menu > Attribute Manager.

2. Select a cell with a value.

3. Click Delete. The message “Are you sure you want to delete attribute value <attribute 
name>: <attribute value>?” appears.

4. Click Yes to delete the value.

Result: The attribute and value are removed from the object and the cell value is <none>.
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Applying an Attribute Value to All Other Objects
In the Attribute Manager, you can apply an attribute value from one object to all other objects of 
the same type. In other words, you can set the same attribute value for all objects of the same 
type. Any existing values are changed.

1. Edit menu > Attribute Manager.

2. Click the cell whose attribute value you want to apply to the other objects on the tab.

3. Click Fill Column. The “Are you sure you want to fill <name of attribute> for all 
objects by <selected value>?” message appears.

4. Click Yes to apply the value. The attribute and its value are applied to the other cells in 
that column, except for Summary cells.

Enabling Attribute Summaries
In the Attribute Manager, you can create and modify summaries for attributes that are based on 
every value of the attribute assigned to objects of the same type. In other words, summaries are 
applied per attribute and apply to all objects in the same tab of the multi-column list. You can 
also change the summary type.

1. Edit menu > Attribute Manager > click Show.

2. Follow the procedures in Show Attributes to enable a summary.

Summaries appear in the last rows of the multicolumn list, and they are only available for 
Number, Decimal Number, and Measure attribute types. See Setting Attribute Properties for 
information on attribute properties.

Once you create one summary, it is easy to create others for other attributes without using the 
Show Attributes dialog box.

1. In another qualified attribute column, double-click in the cell of the first summary row 
(the summary title).

2. Click a summary from the list, and press Enter. The new summary information appears.

Changing Summary Types
In the Attribute Manager, you can change the type of summary listed at the bottom of an 
attribute column without using the Show Attributes dialog box.

1. Edit menu > Attribute Manager.

2. Double-click in the cell of the summary you want to change. You can only modify the 
first of the two summary rows.
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3. Click a different summary type from the list, and press Enter. The new summary 
information appears.

Related Topics

Using Attribute Values in the Concepts Guide

Default Units in the Concepts Guide

Showing Attributes in the Attribute Manager
Use the Show Attributes dialog box to choose which attributes to view in the Attribute Manager 
dialog box and to choose which summaries to view, if any.

Restriction: Hidden attributes are not available to the Attribute Manager and are not listed in 
the Show Attributes dialog box.

See also: Using the Attribute Manager

In this topic:

• Selecting Attributes to List in the Attribute Manager

• Creating a Summary

Selecting Attributes to List in the Attribute Manager
Use the Show Attributes dialog box to select attributes to list in the multi-column list of the 
Attribute Manager.

1. Edit menu > Attribute Manager > click Show.

2. Select an attribute group in the Group list or <all> for all attributes.

Tip: Use the Group list to filter the Attributes list. You can choose an attribute group to 
view.

3. In the Attributes list, select the check box next to the attribute name to view the attribute 
in the Attribute Manager dialog box.

Tip: You can use the Select All or Unselect All buttons to select all or clear all check boxes.

Creating a Summary
You can create summaries of every value of an attribute assigned to a particular objects type. In 
other words, summaries will appear at the bottom of attribute columns. 
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Restriction: Summaries are only available for Number, Decimal Number, and Measure 
attribute types. The type is an attribute property. See Setting Attribute Properties for 
information.

1. Edit menu > Attribute Manager > click Show.

Requirement: An attribute must be selected for viewing in the Attribute Manager. See 
Selecting Attributes to List in the Attribute Manager for information. 

2. Select an attribute in the Attributes list.

3. Click the check box for the summary type you want to create. You can select more than 
one summary. Choose from:

Sum—Creates a summary that shows the total of the attribute values. The summary 
applies to the attribute you select in the Attributes list. The summary displays in the 
Attribute Manager dialog box.

Max—Creates a summary that shows the maximum value used by the attribute. The 
summary applies to the attribute you select in the Attributes list box. The summary 
displays in the Attribute Manager dialog box. To create a summary that is the range of 
attribute values, click both the Min and Max check boxes.

Min—Creates a summary that shows the minimum value used by the attribute. The 
summary applies to the attribute you select in the Attributes list box. The summary 
displays in the Attribute Manager dialog box. To create a summary that is the range of 
attribute values, click both the Min and Max check boxes.

Average—Creates a summary that shows the average of the attribute values. The 
average is the sum of all attribute values divided by the number of values assigned. The 
summary applies to the attribute you select in the Attributes list. The summary displays 
in the Attribute Manager dialog box.

4. Click OK to return to the Attribute Manager dialog box. The summary you created 
appears in the last two rows of the multi-column list. If you enabled more than one 
summary, the second summary appears in the two rows following the first summary. 
You can modify the summary row containing the summary name; you cannot modify 
the summary row containing the summary calculation.

Tip: You can change summary types and copy summaries to other attributes without returning 
to the Show Attributes dialog box. See Enabling Attribute Summaries and Changing Summary 
Types.

Working with Object Attributes
Use the resizable Object Attributes dialog box to add, modify, or remove attributes of single 
objects or multiple objects of the same type.
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Restrictions: Rows in the multicolumn list are unavailable if the attribute is read-only. Rows 
are also unavailable if the attribute is ECO-registered and PADS Layout is not in ECO mode.

Recommendation: You can avoid DRC violations or shorts by placing attributes on 
Documentation layers if used in the design. If an attribute is displayed in the design, and placed 
on an Electrical layer it will show up as copper in the manufacturing documents. Place free text 
and attribute values on the Silkscreen Top layer or another documentation layer.

In this topic:

• Assigning Attributes

• Modifying Attribute Values

• Removing Attributes

• Removing Attribute Values

Assigning Attributes
You can assign attributes to an object or objects of the same type using the Object Attributes 
dialog box. For example, this means that you can select multiple parts and assign attributes, but 
you cannot select parts and vias and assign attributes. The Object Attribute dialog box only 
shows attributes that are applicable to the objects you select. 

1. Select the object(s) to which you want to assign an attribute. You can only select objects 
of the same type.

2. Right-click and click Attribute. The Object Attributes dialog box opens.

See also: Assigning Attributes in the Concepts Guide

3. From the Groups list click an attribute group to view. If you assign multiple attributes 
and some of those are structured attributes, this list acts as a filter and allows you to 
choose the attribute group to view.

4. From the Attributes For list, select the attribute hierarchy level for which you want to 
assign an attribute. The hierarchy levels change, depending on the object you selected in 
step 1. 

See also: Attribute Hierarchy in the Concepts Guide

Restriction: You cannot select a hierarchy level if you have multiple objects selected. 
The attribute is assigned at the current level; for example, if you select multiple parts, 
attributes are assigned at the Component level.

5. Click Add. A new, blank attribute line appears in the Attribute list. The pointer appears 
in the blank cell in the Attribute column. This cell is also a list that contains the 
attributes that apply to the object type you selected in step 1. This list is based on entries 
in the Attribute Dictionary.
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See also: Using the Attribute Dictionary

6. Click an attribute from the Attribute list, or type the name of a new attribute in the 
blank cell. You cannot add a hidden or read-only attribute. Lists the name of the 
attribute. Attributes names can be 255 characters long. You can use any printable 
character, including spaces, in an attribute name. A space, however, can't be the first or 
last character in the attribute name. Attribute names are not case sensitive, and they are 
defined for the entire design, not per object.

Tip: When you add a new attribute to the design, it is also added to the Attribute 
Dictionary.

7. Double-click in the blank cell in the Value column (next to the attribute you just added). 
Assign the value for the attribute. You can include a unit with the value. PADS Layout 
also provides a default set of units (and unit prefixes) that are accepted as input and used 
as output. The Level column lists the hierarchy level where the attribute is assigned. In 
other words, the attribute is inherited from the level that appears in this column. It takes 
its value from the Attributes For list.

See also: Default Units in the Concepts Guide

Tip: If you use the design unit Mil, assign the attribute at the board level. Otherwise the 
unit will not change when you change units for the design (using the Global tab of the 
Options dialog box).

8. Click Close to close the Object Attributes dialog box.

Tip: You can add the same attribute multiple times, as long as you add it to different levels of 
the attribute hierarchy.

See also: Creating Attributes for the Design, Control of Solder Mask and Paste Mask

Modifying Attribute Values
You can modify the attribute values of an object or objects of the same type using the Object 
Attributes dialog box. When you select multiple objects to modify attributes, the Attributes list 
displays the union of all attribute names. In other words, it lists all attributes that belong to all of 
the selected objects. When you add an attribute, it is added to all selected objects, and when you 
delete a value, it is deleted from all objects with that attribute. You can edit the value of a 
selected attribute if the attribute is defined on the current level. In other words, if the text in the 
Level column matches the text in the Attribute For list, you can edit the value. If the attribute is 
not defined on the current level (the text in the Level column does not match the text in the 
Attributes For list), then a new attribute is added for the current level that matches the attribute 
you want to edit. You can then edit the value in the new attribute. You cannot edit the name of 
an attribute. You can either delete the attribute entirely, using the Attribute Dictionary, or add a 
new attribute with the correct attribute name.
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Procedure

1. If the attribute is ECO-registered, enter ECO mode. To enter ECO mode, click the ECO 
Toolbar button. If you don't enter ECO mode first, a message appears, informing you 
that you need to enter ECO mode.

Tip: You cannot modify read-only attributes.

See also: ECO Options Dialog Box 

2. Select the object(s) to modify.

3. Right-click and click Attribute. Attribute information about the selected object(s) 
appears in spreadsheet form in the list.

4. From the Groups list click an attribute group to view. If you assign multiple attributes 
and some of those are structured attributes, this list acts as a filter and allows you to 
choose the attribute group to view.

5. From the Attributes For list, click the attribute hierarchy level for which you want to 
assign an attribute. The hierarchy levels change, depending on the object you selected in 
step 1. 

See also: Attribute Hierarchy in the Concepts Guide

Restriction: You cannot click a hierarchy level if you have multiple objects selected. 
The attribute is assigned at the current level; for example, if you select multiple parts, 
attributes are assigned at the Component level.

6. Click the cell (in the Value column) of the attribute value to modify. If a cell is blank, it 
means that the attribute is assigned to the object, but has no value. It can also mean that 
the values differ for the selected objects.

7. Click Edit.

Type or click the new attribute value and press Enter. The new value is added to the 
objects. 

See also: Using Attribute Values in the Concepts Guide

You can include a unit with the value. PADS Layout provides a default set of units (and 
unit prefixes) that are accepted as input and used as output. 

See also: Default Units in the Concepts Guide 

Tip: If attribute values are not the same, the value for that attribute is blank. If you modify that 
value, the new value applies to all objects with that attribute. You can also remove values from 
attributes (assign the attribute with no value). 

See also: Removing Attribute Values
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Removing Attributes
You can remove an attribute of an object or objects of the same type using the Object Attributes 
dialog box. You can only delete attributes on the current level. If you delete an attribute and a 
value is defined for attribute at a higher level in the hierarchy, it is applied to the current level. 
To delete the attribute entirely from the design, use the Attribute Dictionary.

1. If the attribute is ECO-registered, enter ECO mode. To enter ECO mode, click the ECO 
Toolbar button. The ECO Options dialog box appears. If you don't enter ECO mode 
first, a message appears, informing you that you must enter ECO mode.

Tip: You cannot edit read-only attributes.

2. Select the object(s) to edit.

3. Right-click and click Attribute. The Object Attributes dialog box appears. Attribute 
information about the selected objects appears in spreadsheet form in the list.

4. From the Groups list click an attribute group to view. If you assign multiple attributes 
and some of those are structured attributes, this list acts as a filter and allows you to 
choose the attribute group to view.

5. Click the cell whose attribute value you want to delete.

6. Click Delete. 

Result: The attribute is removed from the objects.

Removing Attribute Values
You can remove an attribute value of an object or objects of the same type using the Object 
Attributes dialog box.

1. If the attribute is ECO-registered, enter ECO mode. To enter ECO mode, click the ECO 
Toolbar button. The ECO Options dialog box appears. If you don't enter ECO mode 
first, a message appears, informing you that you must enter ECO mode.

Tip: You cannot edit read-only attributes.

2. Select the object(s) to edit.

3. Right-click and click Attribute. The Object Attributes dialog box appears. Attribute 
information about the selected objects appears in spreadsheet form in the list.

4. From the Groups list click an attribute group to view. If you assign multiple attributes 
and some of those are structured attributes, this list acts as a filter and allows you to 
choose the attribute group to view.

5. Click the cell from which you want to remove values.

6. Click Edit.
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7. Press the Spacebar and press Enter. The attribute is still assigned to the objects, but it 
has no value.

Modifying Default Attributes
You can edit the default attribute dictionary. You may want to change the default dictionary so 
it matches your library attributes. The list of default attributes is stored in two ASCII files, both 
stored in the C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Settings folder.

The appropriate ASCII file automatically imports when you create a new file or import an older 
file. 

See also: Using the Attribute Dictionary, File Open Conversions in the Concepts Guide

Procedure

1. File menu > New.

2. If you want to edit the default attributes to use with older files, click Import from the 
File menu and import the file DefaultAttributeDictionary.asc.

3. Click Attribute Dictionary from the Edit menu.

4. Modify the existing attributes or add attributes as needed. 

See also: Modifying Design Attribute Properties

5. Click OK to close the dialog box.

6. To overwrite the existing file, click Export from the File menu. Do this to change the 
default.asc or the DefaultAttributeDictionary.asc files. If you want to create a new start-
up file to use with only new files, go to Step 10.

Tip: Back up the existing default.asc file before overwriting it.

7. Click ASCII as the file type and click Save. The ASCII Output dialog box appears.

8. Click Attributes in the Sections list.

9. Click OK. The default attribute dictionary is replaced.

10. To create a new start-up file, follow the steps described in Creating Start-up Files. Make 
sure you select the Attributes check box in the Start-up File Output dialog box. A new 
start-up file is created. You can use this start-up file with all new designs.

Default.asc Used for new designs. 

DefaultAttributeDictionary.asc Used for older (pre-version 3.0) designs. If this file is 
not found, an attribute dictionary is not loaded with 
older designs.
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Customizing Units for Attributes
You can customize (enable or disable) the supported units by modifying the powerpcb.ini file in 
the C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs folder. 

To customize the .ini file:

1. Open the .ini file in a text editor, such as Notepad.

2. Add a new attribute unit section by typing the header [SI Units].

3. Make modifications as described in the “Enabling Units” and “Disabling Units” sections 
below.

4. Save the .ini file.

Enabling Units
To enable units, delete the ignore; variable from the line. Example: The line for the Gram unit 
reads:

Gram=ignore;u,m,,k 

Modify the line so it reads:

Gram=u,m,,k

See also: .ini File Format for Units in the Concepts Guide

Disabling Units
To disable units, add the ignore; variable to the line. For example, the line for the Farad unit 
reads:

Farad=p,n,u,m

Modify the line so it reads:

Farad=ignore;p,n,u,m

It is recommended that you leave the unit prefixes intact even when disabling the unit. This 
makes it easier to enable the unit later because you will not have to specify prefixes again. 

See also: Customizing Units for Attributes in the Concepts Guide
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Adding Attributes to Design Objects
Restrictions: You cannot add a hidden attribute, read-only attribute, or ECO-registered 
attribute while not in ECO mode.

Procedure

1. Select the object in the design.

2. Right-click > Attribute

3. In the Object Attributes dialog box, click the Add button.

4. Type a new attribute name, or select one from the list.

5. Enter a value.

6. Click the Close button.

Adding Attribute Values to Multiple Design Objects
Instead of selecting multiple objects one-at-a-time to add attribute values, you can add them 
more quickly using the spreadsheet in the Attribute Manager. You can add values to cells with 
<none> in them, which means the attribute is available to the design but is not assigned to the 
object.

Restrictions: You cannot add a hidden attribute, read-only attribute, or ECO-registered 
attribute while not in ECO mode.

Procedure

1. Edit menu > Attribute Manager.

2. In the Attribute Manager dialog box, select a cell with <none> in it.

3. Click Add.

4. Type a value in the cell and press Enter.

Tips: You can only add attribute values to a design object for attributes that are available to the 
design. To create a new attribute for use with design objects, see Creating Attributes for the 
Design. You can include a unit with the value. PADS Layout also provides a default set of units 
(and unit prefixes) that are accepted as input and used as output. See also: Default Units in the 
Concepts Guide
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Adding Height Information to Design Components and 
Jumpers

Height information is used to prevent components being placed in height-constrained areas. It is 
also used when a design is exported to a 3-dimensional modeling application.

Tip: To quickly add height information to multiple objects, use the procedure in Adding 
Attribute Values to Multiple Design Objects.

Procedure

1. Select the object in the design.

2. Right-click > Attribute

3. In the Object Attributes dialog box, click the Add button.

Restriction: Some attributes require you to be in ECO Mode.

4. Type Geometry.Height, or select it from the list.

5. Enter a value.

6. Click the Close button.
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Chapter 21
Setting Rules and Using Keepouts

In this chapter:

• Transferring Design Rules

• Creating Rules for Your Design

• Creating a Report of the Design Rules

• Turning on Design Rule Checking

• Checking Design Rules

• Restricting Heights on Component Layers

• Restricting Heights in Areas of Component Layers

• Using Keepouts

Transferring Design Rules
Design rules are stored in schematic and design files. Design rules you set up in PADS Logic 
and DxDesigner are automatically transferred when you import the netlist into PADS Layout. 
Design rules you set up in PADS Layout are automatically available when you open the design 
in PADS Router.

Tip: PADS Logic supports only default, class, and net rules.

Importing and Exporting Design Rules
You can export and import design rules in order to reuse them in a future design that requires 
the same constraints.

• To export design rules, follow the instructions to export an ASCII file, but in the ASCII 
Output dialog box, select only the Rules check box.

• To import the design rules, follow the instructions to import an ASCII file.



PADS Layout User’s Guide and Reference Manual, PADS 9.4456

Setting Rules and Using Keepouts
Creating Rules for Your Design

Related Topics

Design Checking in the Concepts Guide

Checking Design Rules

Creating Rules for Your Design
There are many different levels of rules in the rules hierarchy. Follow the links below to 
procedures for creating rules at each level of the hierarchy.

Tip: The links below are in hierarchical order from lowest to highest priority. For more 
information, see Design Rule Hierarchy in the Concepts Guide.

Default Rules

• Creating Default Rules

• Creating Default Clearance-Rules for a Specific Layer (Conditional Rule)

Class Rules

• Creating Class Design Rules

• Creating Class Clearance-Rules for a Specific Layer (Conditional Rule)

Net Rules

• Creating Net Design Rules

• Creating Net Clearance-Rules for a Specific Layer (Conditional Rule)

Group Rules

• Creating Group Design Rules

• Creating Group Clearance-Rules for a Specific Layer (Conditional Rule)

Pin Pair Rules

• Creating Pin Pair Design Rules

• Creating Pin Pair Clearance-Rules for a Specific Layer (Conditional Rule)

Class Against... Rules

• Creating a Class Against Class Design Rule (Conditional Rule)
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• Creating a Class Against Class Design Rule for a Specific Layer (Conditional Rule)

Net Against... Rules

• Creating a Net Against Class Design Rule (Conditional Rule)

• Creating a Net Against Class Design Rule for a Specific Layer (Conditional Rule)

• Creating a Net Against Net Design Rule (Conditional Rule)

• Creating a Net Against Net Design Rule for a Specific Layer (Conditional Rule)

Group Against... Rules

• Creating a Group Against Class Design Rule (Conditional Rule)

• Creating a Group Against Class Design Rule for a Specific Layer (Conditional Rule)

• Creating a Group Against Net Design Rule (Conditional Rule)

• Creating a Group Against Net Design Rule for a Specific Layer (Conditional Rule)

• Creating a Group Against Group Design Rule (Conditional Rule)

• Creating a Group Against Group Design Rule for a Specific Layer (Conditional Rule)

Pin Pair Against... Rules

• Creating a Pin Pair Against Class Design Rule (Conditional Rule)

• Creating a Pin Pair Against Class Design Rule for a Specific Layer (Conditional Rule)

• Creating a Pin Pair Against Net Design Rule (Conditional Rule)

• Creating a Pin Pair Against Net Design Rule for a Specific Layer (Conditional Rule)

• Creating a Pin Pair Against Group Design Rule (Conditional Rule)

• Creating a Pin Pair Against Group Design Rule for a Specific Layer (Conditional Rule)

• Creating a Pin Pair Against Pin Pair Design Rule (Conditional Rule)

• Creating a Pin Pair Against Pin Pair Design Rule for a Specific Layer (Conditional 
Rule)

Decal Rules

• Creating Decal Design Rules

Component Rules

• Creating Component Design Rules
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Differential Pair Rules

• Creating Differential Pair Design Rules

Creating Default Rules
Each new design already has a default set of rules or constraints from the PADS Layout 
default.asc template file, or they are imported from the schematic design. Customize the default 
rules to the requirements of your design. You can also create default clearance rules for a 
specific layer.

Procedure

1. Setup menu > Design Rules.

2. In the Rules dialog box, click Default.

3. In the Default Rules dialog box, click any of the five rule category buttons (Clearance, 
Routing, HiSpeed, Fanout, Pad Entry) to customize the rules from their default values 
and settings.

4. After you’ve customized the rule categories, close all Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Default Clearance-Rules for a Specific Layer
You can create a unique set of default rules on a specific layer that take precedence over the 
default rules which apply to all layers.

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click All.

3. In the Against rule object area, with Layer type already selected, select the layer from 
the list.

4. In the Current rule set area, click Clearance.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.
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7. In the Object to object box, type a value to apply to all objects or click the Matrix button 
to enter the Clearance Rules dialog box to apply different values between objects. You 
must click OK in the Clearance Rules dialog box to accept the changes.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Class Design Rules
A class is a collection of nets to which you can assign a common set of design rules. You must 
first create a class and assign nets to the class before you can assign rules to the class. You 
create the class either by selecting nets in the design, or by selecting them from a list in the 
Class Rules dialog box. But you can only use the Class Rules dialog box to define its design 
rules.

Procedure

1. Create a new class using one of the following two methods:

• Select nets in the design:

i. In the design area, select the nets you want to add to the class.

Tip: You can also use the Find dialog box to find nets and use wildcards in the 
Value field to filter the selection.

ii. Right-click and click Make Class.

iii. In the Add Net to Class dialog box, click Create New Class, type the class name 
in the Add to Class box, and then click OK.

• Select nets from the list in the Class Rules dialog box:

iv. On the Setup menu, click Design Rules, then click the Class button.

v. In the Class name box, type the class name, and then click Add.

vi. In the Nets area, in the Available list, double-click to quickly add the net to the 
class, or select multiple nets and click Add>>.

Tips: 

• Nets cannot exist in more than one class. The Available list in the Class Rules dialog 
box displays only nets that have not been assigned to a class.
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• The maximum class name length is 15 characters. You can use any alphanumeric 
characters except brackets {}, asterisks *, or spaces.

2. In the Class Rules dialog box (Setup menu > Design Rules > Class button), select the 
class in the Class box.

3. Click any of the three rule category buttons (Clearance, Routing, HiSpeed) to customize 
the rules from their default values and settings.

4. After you’ve customized the rule categories, click OK to accept the changes and close 
the Class Rules dialog box.

Result

After you customize a rule category for the class, non-default rules indicators appear in the 
dialog box.

Related Topics

Creating Net Design Rules

Adding Nets to an Existing Design Rule Class

Design Rule Hierarchy in the Concepts Guide

Deleting a Design Rule Class
Use the Class Rules dialog box to delete classes.

Procedure

1. Setup menu > Design Rules > Class button.

2. In the Class Rules dialog box, in the Class box, select one or more classes, and then click 
Delete.

Tip: To display all classes in the Class box, clear the Show Classes with Rules check 
box.

3. Click OK to accept the changes and close the Class Rules dialog box.

4. Click Close in the Rules dialog box.

Adding Nets to an Existing Design Rule Class
You can add nets to an existing class design rule.
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Procedure

1. Add nets to an existing class using one of the following two methods:

• Select nets in the design:

i. In the design area, select the nets you want to add to the class.

Tip: You can also use the Find dialog box to find nets and use wildcards in the 
Value field to filter the selection.

ii. Right-click and click Make Class.

iii. In the Add Net to Class dialog box, click Add to Existing Class, and select the 
class in the Existing Classes list.

iv. Click OK.

• Select nets from the list in the Class Rules dialog box:

v. Setup menu > Design Rules > Class button.

vi. In the Class Rules dialog box, in the Class box, select the class to which you 
want to add a net.

Tip: To display all classes in the Class box, clear the Show Classes with Rules 
check box.

vii. In the Nets area, in the Available list, double-click to quickly add the net to the 
class, or select multiple nets and click Add>>.

Tip: Nets cannot exist in more than one class. The Available list in the Class Rules 
dialog box displays only nets that have not been assigned to a class.

2. Click OK to accept the changes and close the Class Rules dialog box.

Removing Nets from a Design Rule Class
Use the Class Rules dialog box to remove nets from a class.

Procedure

1. Setup menu > Design Rules > Class button.

2. In the Class Rules dialog box, in the Class box, select the class.

Tip: To display all classes in the Class list, clear the Show Classes with Rules check 
box.

3. Select the nets for removal in the Selected list, and then click <<Remove.
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4. Click OK to accept the changes and close the Class Rules dialog box.

5. Click Close in the Rules dialog box.

Modifying Class Design Rules
You can modify the rules of a class of nets.

Procedure

1. Setup menu > Design Rules > Class button.

2. In the Class Rules dialog box, in the Class box, select the class.

3. Click any of the three rule category buttons (Clearance, Routing, HiSpeed) to modify the 
values and settings.

4. After you’ve customized the rule categories, click OK to accept the changes and close 
the Class Rules dialog box.

5. Click Close in the Rules dialog box.

Renaming a Design Rule Class
Use the Class Rules dialog box to rename a class.

Procedure

1. Setup menu > Design Rules > Class button.

2. In the Class Rules dialog box, in the Class box, select a class.

Tip: To display all classes in the Class list, clear the Show Classes with Rules check 
box.

3. In the Class name box, type the new class name.

4. Click Rename.

5. Click OK to accept the changes and close the Class Rules dialog box.

6. Click Close in the Rules dialog box.

Resetting Class Rules to Default Rules
With the click of a button, you can reset the class rules to the same as the default rules.
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Procedure

1. Setup menu > Design Rules > Class button.

2. In the Class Rules dialog box, select one or more classes in the Class list, click Default, 
and then click Yes.

Tip: The Default button is unavailable if the class already has only default rules 
assigned to it.

Result: You know you’ve successfully reset the class rules if all the icons below the rule 
categories (Clearance, Routing, HiSpeed) return to the Default icon, and the Default 
button is no longer available.

3. Click OK to accept the changes and close the Class Rules dialog box.

4. Click Close in the Rules dialog box.

Displaying the Nets of a Class Design Rule
If you want to know what nets are assigned to a class you can view them in the Class Rules 
dialog box.

Procedure

1. Setup menu > Design Rules > Class button.

2. In the Class Rules dialog box, in the Class list, click the name of the class.

Result: Nets in the class appear in the Selected list.

3. After you’ve viewed the nets, click Cancel to close the Class Rules dialog box without 
saving any changes.

4. Click Close in the Rules dialog box.

Creating Class Clearance-Rules for a Specific Layer
You can create a unique set of class rules on a specific layer that take precedence over the class 
rules which apply to all layers.

Requirement

The Class of nets must already exist. See also: Creating Class Design Rules
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Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Classes 
and then select a class in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Layer and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click the Matrix button 
to enter the Clearance Rules dialog box to apply different values between objects. (You 
must click OK in the Clearance Rules dialog box to accept the changes.)

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Net Design Rules
Use the Net Rules dialog box to customize the design rules that apply to nets. Unless you 
customize the design rules for a net, it assumes the Default design rule values and settings.

Procedure

1. You can assign rules to one or more nets at a time. There are two ways to select the 
net(s) before accessing the rule categories.

• Select nets in the design:

i. In the design area, select the net or nets to which you want to apply rules.

Tip: You can also use the Find dialog box to find nets and use wildcards in the 
Value field to filter the selection.

ii. Right-click and click Show Rules.

• Select nets from the list in the Net Rules dialog box:

iii. Setup menu > Design Rules > Net button.

iv. In the Net Rules dialog box, in the Nets box, click one or more nets.

Tip: To display all nets, clear the Show Nets with Rules check box.
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2. Click any of the three rule category buttons (Clearance, Routing, HiSpeed) to customize 
the rules from their default values and settings.

3. After you’ve customized the rule categories, close all rules dialog boxes to return to the 
design.

Result

After you customize a rule category for the net(s), non-default rules indicators appear in the 
dialog box.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Modifying Net Design Rules
Follow the procedure in the topic Creating Net Design Rules.

Resetting Net Rules to Default Rules
With the click of a button, you can reset the net rules to the same as the default rules.

Procedure

1. Setup menu > Design Rules > Net button.

2. In the Net Rules dialog box, select one or more nets in the Nets list, click Default, and 
then click Yes.

Tip: The Default button is unavailable if the net has only default rules assigned to it.

Result: You know you’ve successfully reset the net rules if all the icons below the rule 
categories (Clearance, Routing, HiSpeed) return to the Default icon, and the Default 
button is no longer available.

3. Close all rules dialog boxes to return to the design.

Creating Net Clearance-Rules for a Specific Layer
You can create a unique set of net rules on a specific layer that take precedence over net rules 
which apply to all layers.
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Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Nets and 
then select a net in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Layer and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click the Matrix button 
to enter the Clearance Rules dialog box to apply different values between objects. (You 
must click OK in the Clearance Rules dialog box to accept the changes.)

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Group Design Rules
A group is a collection of pin pairs to which you can assign a common set of design rules. You 
must first create a group and assign pin pairs to the group before you can assign rules to the 
group. You create the group either by selecting pin pairs in the design, or by selecting them 
from a list in the Group Rules dialog box. But you can only use the Group Rules dialog box to 
define its design rules.

Procedure

1. Create a new group using one of the following two methods:

• Select pin pairs in the design:

i. In the design area, select the pin pairs you want to add to the group.

Tip: You can also use the Find dialog box to find pin pairs and use wildcards in 
the Value field to filter the selection.

ii. Right-click and click Make Group.

iii. In the Add Pin Pairs to Group dialog box, click Create New Group, type the 
group name in the Add to Group box, and then click OK.

• Select pin pairs from the list in the Group Rules dialog box:
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iv. Setup menu > Design Rules > Group button.

v. In the Group Rules dialog box, in the Group name box, type the group name, and 
then click Add.

vi. In the Connections area, in the Available list, double-click to quickly add the pin 
pair to the group, or select multiple pin pairs and click Add>>. You can also 
filter the display of Available pin pairs to a single net by selecting the net in the 
From net list.

Tips: 

• Pin pairs cannot exist in more than one group. The Available list in the Group Rules 
dialog box displays only pin pairs that have not been assigned to a group.

• The maximum group name length is 15 characters. You can use any alphanumeric 
characters except brackets {}, asterisks *, or spaces. These characters are 
automatically replaced with an underscore.

2. In the Group Rules dialog box (Setup menu > Design Rules > Group button), select the 
group in the Group box.

3. Click any of the three rule category buttons (Clearance, Routing, HiSpeed) to customize 
the rules from their default values and settings.

4. After you’ve customized the rule categories, click OK to accept the changes and close 
the Group Rules dialog box.

Result

After you customize a rule category for the group, non-default rules indicators appear in the 
dialog box.

Related Topics

Creating Pin Pair Design Rules

Adding Pin Pairs to an Existing Design Rule Group

Design Rule Hierarchy in the Concepts Guide

Deleting a Design Rule Group
Use the Group Rules dialog box to delete a group of pin pairs.

Procedure

1. Setup menu > Design Rules > Group button.
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2. In the Group Rules dialog box, in the Group box, select one or more groups, and then 
click Delete. The group name is deleted from the Group box.

Tip: To display all groups in the Group box, clear the Show groups with rules check 
box.

3. Click OK to accept the changes and close the Group Rules dialog box.

4. Click Close in the Rules dialog box.

Adding Pin Pairs to an Existing Design Rule Group
You can add pin pairs to an existing group design rule.

Procedure

1. Add pin pairs to an existing group using one of the following two methods:

• Select pin pairs in the design:

i. In the design area, select the pin pairs you want to add to the group.

Tip: You can also use the Find dialog box to find pin pairs and use wildcards in 
the Value field to filter the selection.

ii. Right-click and click Make Group.

iii. In the Add Pin Pairs to Group dialog box, click Add to Existing Group, and 
select the group in the Existing Groups list.

iv. Click OK.

• Select pin pairs from the list in the Group Rules dialog box:

v. Setup menu > Design Rules > Group button.

vi. In the Group Rules dialog box, in the Group box, select the group to which you 
want to add a pin pair.

Tip: To display all groups in the Group box, clear the Show groups with rules 
check box.

vii. In the Connections area, in the Available list, double-click to quickly add the pin 
pair to the group, or select multiple pin pairs and click Add>>. You can also 
filter the display of Available pin pairs to a single net by selecting the net in the 
From net list.

Tip: Pin Pairs cannot exist in more than one group. The Available list in the Group 
Rules dialog box displays only pin pairs that have not been assigned to a group.
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2. Click OK to accept the changes and close the Group Rules dialog box.

Removing Pin Pairs from a Design Rule Group
Use the Group Rules dialog box to remove pin pairs from a group.

Procedure

1. Setup menu > Design Rules > Group button.

2. In the Group Rules dialog box, in the Group box, select the group.

Tip: To display all groups in the Group list, clear the Show groups with rules check box.

3. Select the pin pairs for removal in the Selected list, and then click <<Remove.

4. Click OK to accept the changes and close the Group Rules dialog box.

5. Click Close in the Rules dialog box.

Modifying Group Design Rules
You can modify the rules of a group of pin pairs.

Procedure

1. Setup menu > Design Rules > Group button.

2. In the Group Rules dialog box, in the Group box, select the group.

3. Click any of the three rule category buttons (Clearance, Routing, HiSpeed) to modify the 
values and settings.

4. After you’ve customized the rule categories, click OK to accept the changes and close 
the Group Rules dialog box.

5. Click Close in the Rules dialog box.

Renaming a Design Rule Group
Use the Group Rules dialog box to rename a group.
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Procedure

1. Setup menu > Design Rules > Group button.

2. In the Group Rules dialog box, in the Group box, select a group.

Tip: To display all groups in the Group list, clear the Show groups with rules check box.

3. In the Group name box, type the new group name.

4. Click Rename.

5. Click OK to accept the changes and close the Group Rules dialog box.

6. Click Close in the Rules dialog box.

Resetting Group Rules to Default Rules
With the click of a button, you can reset the group rules to the same as the default rules.

Procedure

1. Setup menu > Design Rules > Group button.

2. In the Group Rules dialog box, select one or more groups in the Group list, click 
Default, and then click Yes.

Tip: The Default button is unavailable if the class already has only default rules 
assigned to it.

Result: You know you’ve successfully reset the group rules if all the icons below the 
rule categories (Clearance, Routing, HiSpeed) return to the Default icon, and the Default 
button is no longer available.

3. Click OK to accept the changes and close the Group Rules dialog box.

4. Click Close in the Rules dialog box.

Displaying the Pin Pairs of a Design Rule Group
If you want to know what pin pairs are assigned to a group you can view them in the Group 
Rules dialog box.

Procedure

1. Setup menu > Design Rules > Group button.
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2. In the Group Rules dialog box, in the Group list, click the name of the group.

Result: Pin pairs in the group appear in the Selected list.

3. After you’ve viewed the pin pairs, click Cancel to close the Group Rules dialog box 
without saving any changes.

4. Click Close in the Rules dialog box.

Creating Group Clearance-Rules for a Specific Layer
You can create a unique set of group rules on a specific layer that take precedence over the 
group rules which apply to all layers.

Requirement

The Group of pin pairs must already exist. See also: Creating Group Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Groups 
and then select a group in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Layer and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click the Matrix button 
to enter the Clearance Rules dialog box to apply different values between objects. (You 
must click OK in the Clearance Rules dialog box to accept the changes.)

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Pin Pair Design Rules
Use the Pin Pair Rules dialog box to create design rules for one or more pin pairs.
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Procedure

1. You can assign rules to one or more pin pairs at a time. There are two ways to select the 
pin pair(s) before accessing the rule categories.

• Select pin pairs in the design:

i. In the design area, select the pin pair(s) to which you want to apply rules.

Tip: You can also use the Find dialog box to find pin pairs and use wildcards in 
the Value field to filter the selection.

ii. Right-click and click Show Rules.

• Select nets from the list in the Pin Pair Rules dialog box:

iii. On the Setup menu, click Design Rules, then click the Pin Pairs button.

iv. In the Pin Pair Rules dialog box, in the Connections box, click one or more pin 
pairs.

Tips: 

• To display pin pairs for a specific net, select the net in the From Net list.

• If you want to display all pin pairs, clear the Show pin pairs with rules check 
box.

2. Click any of the three rule category buttons (Clearance, Routing, HiSpeed) to customize 
the rules from their default values and settings.

3. After you’ve customized the rule categories, close any rules dialog boxes to return to the 
design.

Result

After you customize a rule category for the pin pair(s), non-default rules indicators appear in the 
dialog box.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Modifying Pin Pair Design Rules
Follow the procedure in the topic Creating Pin Pair Design Rules.

Resetting Pin Pair Rules to Default Rules
With the click of a button, you can reset the pin pair rules to the same as the default rules.
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Procedure

1. Setup menu > Design Rules > Pin Pairs button.

2. In the Pin Pair Rules dialog box, select one or more pin pairs in the Connections list, 
click Default, and then click Yes.

Tip: The Default button is unavailable if the pin pair has only default rules assigned to 
it.

Result: You know you’ve successfully reset the pin pair rules if all the icons below the 
rule categories (Clearance, Routing, HiSpeed) return to the Default icon, and the Default 
button is no longer available.

3. Close any rules dialog boxes to return to the design.

Creating Pin Pair Clearance-Rules for a Specific Layer
You can create a unique set of pin pair rules on a specific layer that take precedence over pin 
pair rules which apply to all layers.

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin pairs 
and then select a pin pair in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Layer and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click the Matrix button 
to enter the Clearance Rules dialog box to apply different values between objects. (You 
must click OK in the Clearance Rules dialog box to accept the changes.)

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide
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Creating a Class Against Class Design Rule
You can create clearance or high speed rules that apply between the same class or two different 
classes of nets.

Requirement

Both Classes of nets must already exist. See also: Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Classes 
and then select a class in the list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Classes and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Class Against Class Design Rule for a Specific 
Layer

You can create clearance rules that apply between the same class or two different classes of nets 
on a specific layer. This also takes precedence over class against class clearance rules that apply 
to all layers.

Requirement

Both Classes of nets must already exist. See also: Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.
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2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Classes 
and then select a class in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Classes and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Net Against Class Design Rule
You can create clearance or high speed rules that apply between a net and a class of nets.

Requirement

The Class of nets must already exist. See also: Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Nets and 
then select a net in the list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Classes and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.
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Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Net Against Class Design Rule for a Specific 
Layer

You can create clearance rules that apply between a net and a class of nets on a specific layer. 
This also takes precedence over net against class clearance rules that apply to all layers.

Requirement

The Class of nets must already exist. See also: Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Nets and 
then select a net in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Classes and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Net Against Net Design Rule
You can create clearance or high speed rules that apply between the same net or two different 
nets.
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Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Nets and 
then select a net in the list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Nets and then select a net from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Net Against Net Design Rule for a Specific 
Layer

You can create clearance rules that apply between the same net or two different nets on a 
specific layer. This also takes precedence over net against net clearance rules that apply to all 
layers.

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Nets and 
then select a net in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Nets and then select a net from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.
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Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Group Against Class Design Rule
You can create clearance or high speed rules that apply between a group of pin pairs and a class 
of nets.

Requirement

The Group of pin pairs and the Class of nets must already exist. See also: Creating Group 
Design Rules, Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Groups 
and then select a group in the list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Classes and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Group Against Class Design Rule for a 
Specific Layer

You can create clearance rules that apply between a group of pin pairs and a class of nets on a 
specific layer. This also takes precedence over group against class clearance rules that apply to 
all layers.
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Requirement

The Group of pin pairs and the Class of nets must already exist. See also: Creating Group 
Design Rules, Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Groups 
and then select a group in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Classes and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Group Against Net Design Rule
You can create clearance or high speed rules that apply between a group of pin pairs and a net.

Requirement

The Group of pin pairs must already exist. See also: Creating Group Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Groups 
and then select a group in the list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Nets and then select a net from the list.

5. Click Create.
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6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Group Against Net Design Rule for a Specific 
Layer

You can create clearance rules that apply between a group of pin pairs and a net on a specific 
layer. This also takes precedence over group against net clearance rules that apply to all layers.

Requirement

The Group of pin pairs must already exist. See also: Creating Group Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Groups 
and then select a group in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Nets and then select a net from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide



Setting Rules and Using Keepouts
Creating Rules for Your Design

PADS Layout User’s Guide and Reference Manual, PADS 9.4 481

Creating a Group Against Group Design Rule
You can create clearance or high speed rules that apply between the same group of pin pairs or 
two different groups of pin pairs.

Requirement

The Group(s) of pin pairs must already exist. See also: Creating Group Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Groups 
and then select a group in the list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Groups and then select a group from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Group Against Group Design Rule for a 
Specific Layer

You can create clearance rules that apply between the same group of pin pairs or two different 
groups of pin pairs on a specific layer. This also takes precedence over group against group 
clearance rules that apply to all layers.

Requirement

The Group(s) of pin pairs must already exist. See also: Creating Group Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.
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2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Groups 
and then select a group in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Groups and then select a group from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Pin Pair Against Class Design Rule
You can create clearance or high speed rules that apply between a pin pair and a class of nets.

Requirement

The Class of nets must already exist. See also: Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Classes and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.
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Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Pin Pair Against Class Design Rule for a 
Specific Layer

You can create clearance rules that apply between a pin pair and a class of nets on a specific 
layer. This also takes precedence over pin pair against class clearance rules that apply to all 
layers.

Requirement

The Class of nets must already exist. See also: Creating Class Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Classes and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Pin Pair Against Net Design Rule
You can create clearance or high speed rules that apply between a pin pair and a net.
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Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Nets and then select a net from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Pin Pair Against Net Design Rule for a Specific 
Layer

You can create clearance rules that apply between a pin pair and a net on a specific layer. This 
also takes precedence over pin pair against net clearance rules that apply to all layers.

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Nets and then select a net from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.
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7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Pin Pair Against Group Design Rule
You can create clearance or high speed rules that apply between a pin pair and a group of pin 
pairs.

Requirement

The Group of pin pairs must already exist. See also: Creating Group Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Groups and then select a group from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide
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Creating a Pin Pair Against Group Design Rule for a 
Specific Layer

You can create clearance rules that apply between a pin pair and a group of pin pairs on a 
specific layer. This also takes precedence over pin pair against group clearance rules that apply 
to all layers.

Requirement

The Group of pin pairs must already exist. See also: Creating Group Design Rules

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Groups and then select a group from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Pin Pair Against Pin Pair Design Rule
You can create clearance or high speed rules that apply between the same pin pair or two 
different pin pairs.
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Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance or High Speed.

4. In the Against rule object area, click Pin Pairs and then select a pin pair from the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating a Pin Pair Against Pin Pair Design Rule for a 
Specific Layer

You can create clearance rules that apply between the same pin pair or two different pin pairs on 
a specific layer. This also takes precedence over pin pair against pin pair clearance rules that 
apply to all layers.

Procedure

1. Setup menu > Design Rules Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Source rule object area, click Pin Pairs 
and then select a pin pair in the list.

Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, click Pin Pairs and then select a pin pair from the list.
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Tip: You can also filter the list of pin pairs to a single net by selecting the net in the 
From net list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Decal Design Rules
Use the Decal Rules dialog box to define design rules that apply to all instances of a decal 
within the design. You can assign rules to one or more decals at a time.

Restriction

You can define Decal Rules in PADS Layout; however, these rules are used in PADS Router 
only.

Procedure

1. Setup menu > Design Rules > Decal button.

2. In the Decal Rules dialog box, in the Decals box, click one or more decals.

Tip: To display all decals, clear the Show decals with rules check box.

3. Click any of the four rule category buttons (Clearance, Routing, Fanout, Pad Entry) to 
customize the rules from their default values and settings.

4. After you’ve customized the rule categories, close any rules dialog boxes to return to the 
design.

Result

After you customize a rule category for the class, non-default rules indicators appear in the 
dialog box.
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Related Topics

Design Rule Hierarchy in the Concepts Guide

Modifying Decal Design Rules
Follow the procedure in the topic Creating Decal Design Rules.

Resetting Decal Rules to Default Rules
With the click of a button, you can reset the decal rules to the same as the default rules.

Procedure

1. Setup menu > Design Rules > Decal button.

2. In the Decal Rules dialog box, select one or more decals in the Decals list, click Default, 
and then click Yes.

Tip: The Default button is unavailable if the decal has only default rules assigned to it.

Result: You know you’ve successfully reset the decal rules if all the icons below the 
rule categories (Clearance, Routing, Fanout, Pad Entry) return to the Default icon, and 
the Default button is no longer available.

3. Close any rules dialog boxes to return to the design.

Creating Decal Design Rules in the PCB Decal Editor
Use the Decal Rules dialog box to define design rules for the decal. The design rules are saved 
with the decal in the library and become active whenever the decal is used in a design.

Restriction

You can define Decal Rules in PADS Layout; however, these rules are used in PADS Router 
only.

Procedure

1. In the PCB Decal Editor, on the Setup menu, click Decal Rules.

2. In the Decal Rules dialog box, click any of the four rule category buttons (Clearance, 
Routing, Fanout, Pad Entry) to customize the rules from their default values and 
settings.

3. Close any rules dialog boxes to return to the design.
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Result

After you customize a rule category for the decal(s), non-default rules indicators appear in the 
dialog box.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Component Design Rules
Use the Component Rules dialog box to create design rules for one or more components.

Restriction

• You can define Component Rules in PADS Layout; however, these rules are used in 
PADS Router only.

•

Procedure

1. You can assign rules to one or more components at a time. There are two ways to select 
the component(s) before accessing the rule categories.

• Select components in the design:

i. In the design area, select the component(s) to which you want to apply rules.

Tip: You can also use the Find dialog box to find components and use wildcards 
in the Value field to filter the selection.

ii. Right-click and click Show Rules.

• Select components from the list in the Component Rules dialog box:

iii. Setup menu > Design Rules > Component button.

iv. In the Component Rules dialog box, in the Components box, select one or more 
components.

Tips: 

• To display components using a specific decal, select the decal in the Using decal 
list.

• To display all components in the list, clear the Show components with rules 
check box.

2. Click any of the four rule category buttons (Clearance, Routing, Fanout, Pad Entry) to 
customize the rules from their default values and settings.
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3. Close any rules dialog boxes to return to the design.

Result

After you customize a rule category for the pin pair(s), non-default rules indicators appear in the 
dialog box.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Modifying Component Design Rules
Follow the procedure in the topic Creating Component Design Rules.

Resetting Component Rules to Default Rules
With the click of a button, you can reset the component rules to the same as the default rules.

Procedure

1. Setup menu > Design Rules > Component button.

2. Select one or more components in the Components list, click Default, and then click 
Yes.

Tip: The Default button is unavailable if the component has only default rules assigned 
to it.

Result: You know you’ve successfully reset the component rules if all the icons below 
the rule categories (Clearance, Routing, Fanout, Pad Entry) return to the Default icon, 
and the Default button is no longer available.

3. Close any rules dialog boxes to return to the design.

Creating Via Routing Rules in the Decal Editor
Use the Routing Rules dialog box to specify which vias may be used with the decal.

•
• When you open the Routing Rules dialog box from the Decal Editor, only options in the 

Vias area are available.

Procedure

1. Decal Editor > Setup menu > Decal Rules > Routing button.
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2. In the Routing Rules dialog box, in the Vias area, click Via definition.

3. In the Setup Via dialog box, specify vias to use for routing rules in the Decal Editor:

a. To add a via, type the via name into the box, and then click Add.

b. To rename a via, select the via in the vias list, and then click Rename.

c. To delete vias, select the vias in the Vias list, and then click Delete.

d. Click OK.

Tip: The Setup Via dialog box does not know about via padstacks in the design. Use this 
dialog box to set up only via names, not the internal structure of the pad stacks. These 
via names should reference the real vias in your design, where the internal padstack 
structure is defined.

4. In the Routing Rules dialog box, do any of the following:

• To make vias available to the Decal Editor, select the vias and click Add.

• To make vias unavailable to the Decal Editor, select the vias and click Remove.

Related Topics

Routing Rules Dialog Box

Design Rule Hierarchy in the Concepts Guide

Creating and Editing PCB Decals

Deleting a Conditional Rule
You can delete conditional rules that have been set up in the Conditional Rule Setup dialog box.

Procedure

1. Setup menu > Design Rules > Conditional Rules button.

2. In the Conditional Rule Setup dialog box, in the Existing rule sets list, select one or more 
rules to delete.

3. Click the Delete button.

Modifying a Conditional Rule
You can make changes to an existing conditional rule.

1. Setup menu > Design Rules > Conditional Rules button.
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2. In the Conditional Rule Setup dialog box, in the Existing rule sets list, select the rule to 
modify.

Result: In the Current rule set area, the rule set type enables either the clearance or high-
speed value options. 

3. Modify the Clearance or High speed rule values.

Tips:

• For reporting purposes, nets and pin pairs in the Source rule object list are identified 
as aggressors. If a class is in the Source rule object list, all nets in the class are 
identified as aggressors.

• Rules specified in this dialog box override high-speed rules specified in the HiSpeed 
Rules dialog box.

4. Close all open rules dialog boxes.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Creating Differential Pair Design Rules
You can define differential pair rules for nets or pin pairs that behave electrically as differential 
pairs.

•
• You can define differential pair rules in PADS Layout or PADS Router; however, these 

rules are used in PADS Router only. To verify differential pairs in the design, you must 
check them in latium checking.

Procedure

1. Setup menu > Design Rules > Differential Pairs button.

2. In the Differential Pairs dialog box, choose the Net or Pin pairs tab.

3. In the Available list, double-click the first net, and then double-click the second net.

Tips: 

• Double-clicking is a shortcut instead of clicking the Select>> button.

• Nets or pin pairs cannot exist in more than one differential pair. The Available list 
displays only items that have not been assigned to a differential pair.

4. Click Add.

5. Set the Properties of the pair.
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6. Click OK.

7. Close the Rules dialog box.

Deleting a Differential Pair Design Rule
Use the Differential Rules dialog box to delete a differential pair rule.

Procedure

1. Setup menu > Design Rules > Differential Pairs button.

2. In the Differential Pairs dialog box, choose the Net or Pin pairs tab.

3. Select the differential pair in the Pairs list, and then click <<Remove.

4. Click OK.

5. Close the Rules dialog box.

Creating a Report of the Design Rules
Use the Rules Report dialog box to create a report of some, or all design rules. You can then 
print the report of the design rules.

Procedure

1. Setup menu > Design Rules > Report button.

2. In the Rules Report dialog box, in the Rule Types area, enable any of the rule types.

3. In the Pin pairs, Groups, Components, Nets, Classes, and Decals areas, do one of the 
following:

• Select the check box to report all objects.

• Select one or more items in the list to report only specific objects.

Tip: In the Pin pairs area, you can filter the contents of the Pin pair list by selecting a net 
in the Net list.

4. If you want to report the default rules for each enabled rule type in the Rules Types area, 
select the Default Rules check box.

5. In the Output area, click one of the following options:

• Rule Sets—Report all rules that are different from the default rules
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• Rule Values—Report the values of all rules, even if they match the default rules 
values

6. Click OK.

Result

The report is written to C:\PADS Projects\rules.rep and displayed by the default text editor.

Turning on Design Rule Checking
You can enable live design rule checking as you work on your design. It prevents or reports 
design rule violations during interactive placement or routing. This is called On-line DRC. 
Unless you constrain your actions using DRC, you can make design errors. And although you 
can check and find errors at any time by running the Verify Design tool, you risk significant 
redesign when you ignore design rule checking and compound design errors.

Restriction

There are many design rules that are not checked by On-line DRC. Some are only checked by 
PADS Router (for example, Maximum number of vias) and others can only be checked as a post 
process by the Verify Design tool (for example, net Capacitance). Check the documentation and 
test the rule to ensure it works with On-line DRC.

Procedure

There are two methods to control On-line DRC.

• Using the Options dialog box:

i. On the Tools menu, click Options.

ii. In the Options dialog box, click the Design page.

iii. In the On-line DRC area, select a setting.

• Using one of the Design Rule Checking modeless commands (drp, drw, dri, or dro).

Checking Design Rules
You can check design rules during interactive place and route operations, or after place and 
route operations are complete.

See also: Turning on Design Rule Checking

Use Verify Design to check for design rule violations after placement or routing, and report any 
violations in the work area and in a text file.
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See also: Verify the Design

Restricting Heights on Component Layers
You can create a board height restriction to limit the height of components placed on the board.

Tips:

• You cannot use a height restriction of 0 (zero) to prevent placement on a layer. A height 
restriction of 0 specifies that there is no restriction. To prevent placement of all 
components on a layer, make the layer a Routing layer instead of a Component layer in 
the Layers Setup dialog box.

• If you want to have a visual cue that a board has a height restriction, use the procedure in 
Restricting Heights in Areas of Component Layers to create a keepout area over the 
entire layer.

Restriction

• A board height restriction won’t prevent placement of a decal that has no 
geometry.height attribute.

• No warning is given if you create a restriction after a component that is taller than the 
height restriction has been placed. The violation will be caught, however, when you run 
a clearance check in Verify Design.

Procedure

1. Tools menu > Options > Drafting tab

2. In the Board component height restriction area, enter the height restriction for the Top 
and/or Bottom layer.

3. Click OK.

Results

You will be unable to place components whose geometry.height attribute value is greater than 
the specified height restriction.

Related Topics

Restricting Heights in Areas of Component Layers
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Restricting Heights in Areas of Component 
Layers

You can create a board height restriction to limit the height of components placed in an area of 
the board.

Restrictions

• A board height restriction won’t prevent placement of a decal that has no 
geometry.height attribute.

• No warning is given if you put a keepout over an already-placed component that is taller 
than the height restriction. The violation will be caught, however, when you run a 
clearance check in Verify Design.

Procedure

1. In the Layer list of the standard toolbar, select a component layer.

2. Create a keepout in the area of the board where you want to restrict component 
height.

3. In the Restrictions area of the Add Drafting dialog box that appears after you create the 
keepout, select the Placement and the Component height checkboxes.

4. Type the height restriction in the box.

5. Click OK.

Results

You will be unable to place components whose geometry.height attribute value is greater than 
the specified height restriction.

Related Topics

Restricting Heights on Component Layers

Using Keepouts
Keepouts prevent the placement of design items within a specified area. Keepouts appear as one 
pixel-width lines that are used during interactive placement, cluster placement, routing, and 
other operations. The outer edge of design objects and board outlines/cutouts are used for 
clearance calculations against keepouts. Online Design Rule Checking and Verify Design 
recognize keepouts as obstacles. 

You can create keepouts in both the Layout Editor and the PCB Decal Editor. User interaction is 
the same for either; the only difference is the type of objects you can restrict. 



PADS Layout User’s Guide and Reference Manual, PADS 9.4498

Setting Rules and Using Keepouts
Using Keepouts

Restriction: The three component type keepouts can only be created in the Layout Editor.

In this topic:

• Creating Keepout Areas

• Modifying a Keepout

Creating Keepout Areas
Create a keepout to define areas where design objects cannot be placed. You can create keepout 
areas using closed polygons (with or without arcs), circles, or rectangles. The current angle 
mode and design grid settings determine the placement of the lines.

Procedure

1. Drafting Toolbar button > Keepout button.

2. Right-click and click a draw mode for the type of shape to create.

3. Create a closed shape to define the keepout area.

4. In the Add Drafting dialog box that appears, select restrictions.

5. Click the layer on which to place the keepout.

Tip: When you choose layer assignments, restrictions not available for that layer are 
unavailable. For example, if you choose a non-placement layer, the Placement check 
box will not be available.

6. Click OK. The keepout is created. If you create other keepouts, they use the restrictions 
you set here as the default.

Modifying a Keepout
You can change the size of a keepout just as you would any other drafting object: move an edge 
or corner, or change the diameter of a circle. You can also copy a keepout to another location 
and change its restrictions or layer assignments.

Procedure

1. Select the keepout by selecting an edge and right-clicking and clicking Select Shape.

2. Right-click and click Properties.

3. Turn restrictions on or off and modify the layer settings. See also: Modifying Drafting 
Object Properties

4. Click OK.
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Tip: You can't modify a keepout that is part of a physical design reuse. If you try to, the 
message “Reuse elements cannot be modified. Break the reuse first” appears. Click OK to 
cancel the operation.

Related Topics

Modifying Drafting Object Properties

Restricting Heights on Component Layers

Attribute Dictionary in the Concepts Guide
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Chapter 22
Part Placement

Component Placement Process
Parts are initially located overlaying at the origin on the top layer. Before placing components: 
create a board outline, set up the layers of the design, set the grid values, and set up the 
clearance design rules - specifically those that apply to component placement. Many commands 
are available to place your components. You can:

• Switch to PADS Router and use it to do all of your placements.

See also: Switching to PADS Router

• On the Tools menu, click Disperse Components to disperse all the components around 
the board outline.

Tip: On the View menu, click Extents after you disperse components to bring all design 
objects into view.

• Move components in the design.

See also: To Move Components, To Move with Drag and Attach, To Move with Drag 
and Drop

• Orient parts radially on a polar grid.

See also: To Set Up a Polar Grid

• Move multiple components sequentially.

See also: To Use Move Sequential

• Flip components to the bottom layer.

See also: Modifying Board-Side Location of Components

• Array components.

See also: To Create a Component Array

• Align edges or centerlines of multiple components.

See also: To Align Objects

• Rotate objects in 90 degree increments or at any angle.

See also: To Rotate an Object, To Spin an Object
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• Swap the locations of two parts.

See also: To Swap Parts

• Automatically nudge overlapping components into positions that agree with the 
clearance rules. If you disable design rule checking, you can place parts into positions 
that disagree with your design rule clearances. 

See also: To Nudge Overlapping Parts 

Setting the Origin of an Object
Set the origin of an object to move it or place it. You can set the origin of a board outline, 2-D 
line, decal shape (in the PCB Decal Editor), copper shape, keepout shape, and dimension shape.

Procedure

To set the origin of an object using the Dimensioning Shape or Drafting Shape shortcut menus:

1. Select the whole shape.

Tip: Use the right-click Select Shape, Select Documentation, or Select Board Outline 
selection shortcuts to select the whole shape. As an alternative, you can Shift and select 
the a segment - this selects the shape rather than a segment or corner.

2. Right-click and click Set Origin.

3. Click to set the new origin point. A message appears to confirm the origin point.

4. Click Yes to change the origin point or click No to use the previous origin point.

Tip: To exit Set Origin mode, press Esc.

To Minimize Length
Before you begin placement, consider setting the topology types you want to use. When you run 
a length minimization, it does not change the netlist, it just finds better places to make the same 
connections the netlist specifies, based on the topology types you set.

• Tools menu > Length Minimization

Related Topics

Placement and Length Minimization in the Concepts Guide

Topology type in the Routing Rules dialog box
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Using the Find Dialog Box During Placement
If you imported parts using the .asc format, the placement process usually begins with design 
parts overlaying at the design origin. You can use the Find dialog box to break out and select 
certain parts, or groups of a package type. The dialog box can also attach parts to your pointer 
for individual placement.

To Move Components

In Verb Mode
To move a component in Verb Mode:

1. Design Toolbar button > Move button.

2. Select a component. The component attaches to your pointer.

3. Click to indicate a new location to complete the move.

In Object Mode
Use one of the following methods:

Move Command
1. Select the component to move.

2. Right-click and click Move.

Tip: Right-click and click command view properties or edit the selected object. You can 
rotate, flip to the other outside layer, or spin the object while it is attached to your 
pointer.

3. Click to indicate a new location for the object.

Dynamic Drag Methods
Use Drag and Attach and Drag and Drop to automatically invoke the Move command for 
selected components. 

See also: The Drag moves setting on the Global / General page of the Options dialog box.

Tips:

• If you move a component with a pin that is a locked test point, a Warning appears. 

See also: Troubleshooting
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• When you move a group, an error may appear in one of the Trace Copy dialog boxes.

See also: Trace Copy Dialog Box

• If you try to move a component that is part of a physical design reuse, the message 
“Reuse elements cannot be modified. Break the reuse first” appears. Click OK to cancel 
the move.

To Move with Drag and Attach
To move with Drag and Attach:

1. Select the component to move.

2. Place your pointer over the selected component and left-click holding the left mouse 
button down. Move the pointer to initiate a drag move.

3. Release the left mouse button. The component remains dynamically attached to the 
pointer.

4. Click to indicate a new location to complete the move.

Tips:

• If you move a component with a pin that is a locked test point, a Warning appears. 

See also: Troubleshooting

• When you move a group, an error may appear in one of the Trace Copy dialog boxes. 

See also: Trace Copy Dialog Box

• If you try to move a component that is part of a physical design reuse, the message 
“Reuse elements cannot be modified. Break the reuse first” appears. Click OK to cancel 
the move.

To Move with Drag and Drop
To move with Drag and Drop:

1. Select the component to move.

2. Place your pointer over the selected component and left-click holding the left button 
down. Move the pointer to initiate a drag move.

3. Move the pointer to the object's new location and release the left mouse to complete the 
move.

Tips:
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• If you move a component with a pin that is a locked test point, a Warning appears. 

See also: Troubleshooting

• When you move a group, an error may appear in one of the Trace Copy dialog boxes.

See also: Trace Copy Dialog Box

• If you try to move a component that is part of a physical design reuse, the message 
“Reuse elements cannot be modified. Break the reuse first” appears. Click OK to cancel 
the move.

To Set Up a Polar Grid
Before you can use Radial Move, you need to set up a polar grid and the move options.

Procedure

1. Tools menu > Options > Grids tab.

2. Click Radial Move Setup.

3. In the Radial Move Setup Dialog Box, set up options and click OK. You can now use 
Radial Move.

Tip: Use the modeless command GP to make the polar grid visible in the design. You can use 
Setup menu > Set Origin to change the location of the polar grid origin, but you must Redraw to 
see the change.

Related Topics

Defining Arrays in the Concepts Guide

To Use Radial Move
Use Radial Move to adjust the orientation of objects. This command supports creation of 
circular decals and circular boards. You can also use Radial Move with text and reference 
designators.

Requirement: You must set up a Polar Grid.

1. Select single or multiple components or unions. In the PCB Decal Editor, select single 
or multiple terminals.

2. Click the Design toolbar button on the standard toolbar. The Design toolbar appears.

3. Click the Radial Move button on the Design toolbar. The Radial Move Setup dialog 
box appears. The status bar displays the current polar radius and polar angle position in 
addition to the angular and radial increments.
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See also: Radial Move Setup Dialog Box

4. If you did not previously set up the polar grid, the Radial Move Setup dialog box 
appears.

Set up the polar grid and move options and click OK. PADS Layout saves these settings 
to apply to any future use of Radial Move in the current session. 

See also: Polar Grid and Radial Move Example in the Concepts Guide 

The polar grid appears and the selected objects attach to the pointer.

5. Move the selected objects to an eligible site.

6. Click to indicate a location on the polar grid for the selected objects.

Radial Move in Verb Mode
To use Radial Move in Verb Mode:

1. Click the Design toolbar button on the standard toolbar. The Design toolbar appears.

2. Click the Radial Move button on the Design toolbar. The Radial Move Setup dialog 
box appears.

See also: Radial Move Setup Dialog Box

3. Set up the polar grid and click OK.

4. Select a single component or union. In the PCB Decal Editor, select a single terminal. 
The polar grid appears and the selected object attaches to the pointer.

5. Move the selected object to an eligible grid site.

6. Click to indicate a location on the polar grid for the selected object.

Tip: When you exit Radial Move the polar grid is turned off. Use the GP modeless command to 
turn the polar grid on and off independently of Radial Move.

In the PCB Decal Editor, you can only use Radial Move with terminals.

To Use Move Sequential
After selecting a predetermined set of components, you can use Move Sequential to sequentially 
place components on your pointer for placement in the design.

Procedure

1. Edit menu > Find.

2. Set Find By to Reference Designator or Part Type.
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Alternative: Instead of using the Find dialog box, you can also select components in the 
Project Explorer window or the design area, then right-click in the design area and click 
Move Sequential.

3. Use the resulting list to identify and highlight all the parts you want in the selection.

4. Click Move Sequential in the Action list and click Apply. 

When all parts are selected, a single part attaches to the pointer and “Proceed with next object?” 
appears. You can select:

• Yes to select part after part, but prompt every time after a placement.

• Yes to All to select part after part, but no prompt after a placement.

• No to skip this part, go to next.

• Cancel to cancels the command. You return to the Find dialog box.

When a part attaches to the pointer, you can use any Move command on the shortcut menu. You 
can also click Move Sequential from the following shortcut menus: component, union, cluster, 
or mixed component, union, and cluster. You can only use Move Sequential with Radial Move 
if you turn the polar grid on using the GP modeless command.

Tips:

• You can use Move by Midpoint with Move Sequential when moving components, 
unions, and clusters.

• If a part selected for Move Sequential has a pin that is a test point, a Warning dialog box 
appears informing you of changes you are making to the test point. 

See also: Troubleshooting

You can also use the S, search modeless command, to position the pointer exactly. Type S, the 
X,Y coordinates you want the pointer to move to, and press Enter. The pointer moves to the 
coordinates, taking the part, by the origin, with it.

The parts are all selected and can be queried or moved away from the origin. If you've separated 
a group of package types, use Find to select the reference designators individually. Once an 
individual part is selected, you can drag it.

Related Topics

Commands for Find By

To Create a Component Array

Using the Cluster Placement Dialog Box

Find Dialog Box

Using the Find Dialog Box During Placement
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Modifying Board-Side Location of Components
Use Flip Side to move a part or parts to the opposite side of the board. The flipped part moves to 
the opposite side in a hinging motion, pivoting on a vertical axis through the part origin. Text is 
mirrored so it always appears in the proper orientation. Use Flip Group to flip a component or 
components around an origin point you specify. 

When you flip a component to the opposite side, layer associations change with the component. 
To turn off moving layer associations with components, set the /NTL switch before using Flip 
Side or Flip Group.

Warning: Use associated copper rather than free copper in decals in the solder or paste mask. 
Results are unexpected when TrueLayer is on and you use free copper.

To Flip a Component
To move a component to the opposite side of the board using its origin as the mirror point:

1. Select the components to move to the opposite side.

2. Right-click and click Flip Side.

Or 

Click Properties. Select a different layer in the Layer list in the Properties dialog box.

Tip: If DRC is on and the system encounters a clearance violation, the flip is canceled. Test 
points flip with the flipped component.

To Flip a Group
Move a group of components to the opposite side of the board by specifying the mirrored 
location:

• Select the components > right-click > Flip Group.

• Click to indicate the mirror location.

Using the /NTL Switch
Layer associations automatically switch with a component when you flip it to another side. Set 
the /NTL switch before starting PADS Layout to turn TrueLayer associations off. 

See also: Start-up Options
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To Create a Component Array
You can arrange parts by creating arrays. A component array is a union with members placed on 
sites of a user-defined matrix. You can create either planar arrays or circular arrays.

To create a component array:

1. Select the components you want > right-click > Create Array.

2. Click the tab that represents the array you want to create: Planar Array or Circular 
Array.

3. Set the options for the array and click OK. A prompt appears asking you for an array or 
union name.

See also: Defining Arrays in the Concepts Guide. 

4. Type a name for the array or accept the default name and click OK. By default, arrays 
are sequentially named with an ARR_ prefix; for example, the first array in your design 
is named ARR_1, the second array is named ARR_2, and so on.

The array is created and attaches to your pointer.

5. Click to indicate a location for the array.

Tips:

• You can use Move shortcut menu commands; such as Flip, Spin, and Rotate; while 
placing the array.

• If you move a component with a pin that is a locked test point, a warning appears. 

See also: Troubleshooting

• If you try to move a component that is part of a physical design reuse, the message 
“Reuse elements cannot be modified. Break the reuse first” appears. Click OK to cancel 
the move.

To Modify a Component Array
Using Modify Array, you can rearrange the components in an array after placing the array, or 
you can modify a union.

Requirements: 

• You must select Unions in the Selection Filter to select arrays and unions.

• You can only modify one array or union at a time.

To modify an array or union:
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1. select an array or union > right-click > Modify Array

Results:

• If you are modifying an array, the Modify Array dialog box appears with the tab and 
the options used to create the array.

• If you are creating an array from a union, a prompt appears asking whether to 
dissolve the union to create an array. Click Yes to create the array from the Union. 
The Create Array dialog box appears.

2. Modify array options as necessary.

3. Click OK. The array is modified or created from the union.

4. If Online DRC or DRC Warn is selected, click to indicate a new position for the 
modified array.

Tips:

• Modify Array does not enter Move mode as Create Array does.

• Modify Array does not warn against nor prevent placement violation unless Online 
DRC or DRC Warn is selected.

• If you modify the location of an array that contains a component with a pin that is a 
locked test point, a warning appears. 

See also: Troubleshooting

To Align Objects
Once objects are roughly in position, you can select several objects and automatically align 
them. The alignment command aligns all selected objects with the last one selected. You can 
use Align with pins (and align components by those pins), reference designators, unions in the 
Layout Editor, and terminals and terminal numbers in the PCB Decal Editor.

Procedure

1. Using Ctrl+click, select the objects you want to include in the alignment ensuring that 
you select the master object last.

2. Right-click and click Align. The Align Parts dialog box appears in the Layout Editor. 
The Align Pins dialog box appears in the PCB Decal Editor.

3. Click the alignment scheme you want to use. The objects are automatically aligned 
according to the position of the last one selected.

Tip: Automatic alignment does not guarantee minimum spacing if online DRC is not 
selected, but you can use Nudge to accomplish this interactively. If DRC is set to 
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Prevent or Warn, Align does not perform the alignment if it causes a violation. 
Violations are reported in the status bar.

Restriction: You can't align elements in a physical design reuse. Align becomes unavailable 
when you select physical design reuse elements.

To Rotate an Object
1. Select the object to rotate. You can select more than one object at a time.

2. Right-click and click Rotate 90. The selected object rotates 90 degrees 
counterclockwise.

3. Repeat step 2 to continue rotating the objects.

To use Rotate 90 in Verb Mode, click Rotate on the Design toolbar and then select the part to 
rotate.

Tips:

• If you rotate a component with a pin that is a locked test point, a warning appears. 

See also: Troubleshooting

• When you rotate a group, an error may appear in one of the Trace Copy dialog boxes. 

See also: Trace Copy Dialog Box

• If you try to rotate a component that is part of a physical design reuse, the message 
“Reuse elements cannot be modified. Break the reuse first” appears. Click OK to cancel 
the operation.

To Spin an Object
1. Select the object to spin.

2. Right-click and click Spin. The part attaches to the pointer. As you move the pointer, the 
part follows, changing the rotation angle.

You can multiple-select and rotate a group of parts in the same way; each turns on its 
own axis.

3. Click to indicate a new angle.

To use Spin in Verb Mode, click Spin on the Design toolbar, and then select the part to spin. 
click to indicate a new angle.

Tips:
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• To view the angle of rotation as you spin the part, right-click and click Properties. The 
current angle appears in the Rotation box.

• If you spin a component with a pin that is a locked test point, a warning appears. 

See also: Troubleshooting

• If you try to spin a component that is part of a physical design reuse, the message “Reuse 
elements cannot be modified. Break the reuse first” appears. Click OK to cancel the 
operation.

To Swap Parts
Sometimes simply switching neighboring parts' positions can improve connection length. You 
can swap the position of two parts anywhere on the board using Swap Part. When online DRC is 
selected, the swap is examined for placement violations.

Using Object Mode
To swap parts:

1. Select a first part > Design Toolbar button > Swap Part button.

2. Select the second part to switch. The X + Y connection lengths before and after the swap 
appear so you can see whether the lengths improve.

3. Click Yes to complete the swap. Parts are swapped origin-to-origin.

Using Verb Mode
To swap parts in Verb Mode:

1. Design Toolbar button > Swap Part button.

2. Select the first part to switch.

3. Select the second part to switch. The X + Y connection lengths before and after the swap 
appear so you can see whether the lengths improve.

4. Click Yes to complete the swap. Parts are swapped origin-to-origin.

To Nudge Overlapping Parts
Use Nudge to move overlapping parts. The manner in which Nudge operates is dependent on 
the current DRC setting. 

See also: Nudging Parts in the Concepts Guide
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Nudging All Components
• On the Tools menu, click Nudge Components. All components are automatically 

nudged according to the design rules.

Nudging Single Parts
1. Select a part.

2. Right-click and click Nudge. 

See also: Nudge Parts and Unions Dialog Box

3. Click the nudge direction and the direction to move overlapping parts: Automatic, Left, 
Right, Up, or Down.

4. Click Run to perform the nudge. Click Undo in the Nudge dialog box to reverse the 
move.

Often, several parts are adjusted to accommodate the moved part. Nudge identifies these parts, 
and allows for further adjustments, by displaying them in a specific color:

• Select color—All parts affected by the Nudge routine.

• Highlight color—The part to move in the next pass of Nudge.

Tips:

• Nudge does not move glued parts or parts outside the board outline. Parts inside the 
board outline are not nudged outside the outline.

• Nudge considers test points to be glued objects.

• You can't nudge elements in a physical design reuse. All component elements are 
considered glued. Nudge is unavailable when you select physical design reuse elements.

To Change Part Outline Width
To change the part outline width:

1. Select a component > right-click > Properties.

2. Type a width (between 0 and 250) in the Part Outline Width box.

3. Click OK.

4. To update all parts that have the same decals as the selected parts with the new part 
outline width click Continue. Click Cancel to cancel changing the part outline width to 
all parts that have the same decals, including the selected parts.

Tips:
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• This change is reflected in the design only; the library is not updated.

• Alternate decals in use are modified; alternate decals not in use are not modified.

• Online DRC Body to Body checking and Verify the Design look at the part outline when 
checking.

Modifying Component Properties
To edit component properties:

1. Select a component.

2. Right-click and click Properties. The Component Properties Dialog Box appears. 

Tip: Several of the options on the dialog box are unavailable when the component is part of a 
physical design reuse.

Creating a Label
You can create labels using the Labels tab in the Component Properties dialog box.

1. Click <new> from the Label list and click the Label button. 
See also:Adding a New Part Label 

2. From the Attribute list, click the attribute for which you want to create a label. When 
you click an attribute, the value for the attribute appears in the Value box.

Tip: The only attribute available for jumpers is the reference designator.

3. Accept the current value or type a new value.  If you click Reference Designator or 
Part Type from the Attribute list, you cannot change the value.

This box is unavailable if the attribute is read-only. This box is also unavailable if the 
attribute is ECO-registered and PADS Layout is not in ECO mode.

4. Set the visibility status and the placement information for the label.

5. Set the justification, right-readability, height, and width of the label.

6. Click the layer on which to place the label, and click OK to create the label.

Tips:

• If you don't set visibility information (such as in steps 5, 6, and 7), default positions are 
used. 

See also: Label Defaults in the Concepts Guide

• Labels are not checked for clearance violations. If you want to output labels from CAM 
as metal or copper, such as on a Routing layer, check your label placement carefully.
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Editing a Label
The Label List contains existing labels for reference designator, part type, and attributes. To edit 
an existing label:

• Click a label in the list and click the button in this tab. A label is selected instead of the 
component, and the corresponding Part Label Properties dialog box appears where you 
can modify the label.

Tips:

• When modifying the Properties of a jumper name, Reference Designator is the only 
available label.

• When the current color for labels is set to the background color, this option is 
unavailable. To activate Label, assign a non-background color to labels in the Display 
Colors Setup dialog box.

Related Topics

Component Properties Dialog Box

Unions

Managing Unions
Unions are user-created part associations that have a strict relationship with each other, such as 
distance, rotation angle, top, or bottom side. A common example is placing a filter capacitor to 
reside on top of an IC. When a selected union is moved or placed, the physical relationship 
between the parts, or union members, remains unchanged.

This topic discusses the following:

• Creating a New Union

• Creating Like Unions

• Selecting Unions

• Adding a Part to a Union

• Modifying Unions

• Deleting Unions and Members

Creating a New Union
1. Select and position the parts that you want to make a union in a specific pattern. Leave 

the parts selected.
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2. Right-click and click Create Union. The Union Name Definition dialog box appears 
with a default name.

3. Use the default name or type a new name for the union, and click OK.

Creating Like Unions
You can use a union as an example to automatically create other unions of the same 
configuration.

To automatically create other unions which match an existing union, or base part:

1. Select a union > right-click > Create Like Unions.

2. Click Yes to continue. A message appears prompting whether to disperse the new 
unions.

3. Click Yes to disperse the newly created unions around the board outline.

If you click No to disperse parts, the message “Keep Base?” appears. This message asks 
whether to position the members of the new unions to match the union used for creation. Click 
Yes to reposition the new unions exactly like the base part; click No to leave the new unions in 
their current position.

Tip: Create Like Unions ignores parts with test points.

Selecting Unions
There are two ways to establish filter settings for selecting unions:

• Select a union from a union member:

a. Select a member of a union.

b. Right-click and click Select Union.

• Automatically select a union when one of its members is selected.

a. Edit > Filter

b. Click both the Parts and Unions options.

See also: Selecting Objects Among Others

Adding a Part to a Union
1. Set the filter to select the entire union when you select a member.

See also: Selecting Objects Among Others

2. Use multiple selection, Ctrl+click, to select the parts to add.
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3. Right-click and click Create Union. The message “Break union and include its parts in 
new?” appears.

4. Click Yes to add the new parts.

5. Click Yes to use the same union name.

Modifying Unions
The Union Modification Flag setting which prevents you from modifying unions is 
automatically set when you start PADS Layout.

To disable this setting:

1. Select a member of any union.

2. Right-click and click Modify Union Member. This option remains active for the entire 
PADS Layout session. Click the option again to deactivate it.

Deleting Unions and Members
You can remove a part from the union or remove the entire union.

To remove a part from a union:

1. Select the part to remove.

2. Right-click and click Break From Union.

To remove an entire union:

1. Select the union.

2. Right-click and click Break.

Tip: Use the Break Like Unions and Break All Unions options to remove all like unions or 
remove all unions.

Related Topics

Union Properties Dialog Box

Cluster Placement
With Cluster Placement you can create associations, or groupings, of connected parts. Cluster 
Placement works with the following two object types:

• Unions — User-created part associations that have a strict relationship with each other.
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• Clusters — Collections of individual parts, unions, and other clusters, based on 
connectivity.

In this topic:

• Creating New Clusters

• Modifying Existing Clusters

• Cluster View Mode

• Display Parts in Cluster View Mode

• Moving Clusters Interactively

• Deleting a Cluster

• Collapsing Clusters

• Collapsing All Clusters

• Collapsing Cluster Members

Creating New Clusters
To manually create new clusters:

1. Select the parts, unions, and other clusters to include in the cluster.

2. Right-click and click Create Cluster. The cluster parts are erased and replaced by a 
circle with all connections originating from its center. This circle represents the cluster.

Modifying Existing Clusters
You can add parts and clusters to another cluster manually, semi-automatically, or 
automatically. You can only remove parts from existing cluster manually.

1. Select the clusters to change.

2. Right-click and click:

Edit Manual—Click Add to Cluster to add to the selected cluster. The item appears in 
the current Highlight color. Click Remove from Cluster to remove a highlighted item 
from the cluster. Click Complete from the shortcut menu to finish modifying the 
cluster.

Grow Incremental—Opens the Cluster Grow Incremental dialog box which contains 
information on the highlighted cluster plus the following buttons:

Accept Adds the highlighted item to the selected cluster.
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Grow Automatic—Opens the Cluster Size Limit Definition dialog box which displays 
the current size of the cluster, or the number of cluster members, plus a text window 
containing the recommended number of cluster members. Click OK to accept the new 
value, or type a higher value to add additional parts to the cluster. 

Tip: Use the Cluster Manager to modify existing clusters using a dialog box.

Cluster View Mode
PADS Layout automatically switches to Cluster View Mode any time you create or modify 
clusters, unless you are using Cluster Manager. Click Clusters from the View menu to switch 
between Cluster View and normal view.

In Cluster View Mode, several commands and options are unavailable or limited.

Display Parts in Cluster View Mode
To display parts belonging to a cluster while in Cluster View Mode:

1. Edit menu > Filter.

2. Click Clusters.

3. Select the cluster.

4. Right-click and click Show Contents. The parts appear in the current Highlight color.

5. To return the cluster to cluster view mode right-click and click Cancel.

Moving Clusters Interactively
To reposition a cluster:

1. Select a cluster > right-click > Move.

2. Move the cluster to a new location and click. The cluster moves to the new location and 
the members of the cluster collapse.

You can set PADS Layout so that clusters do not collapse after moving. For more information 
see “Collapsing Clusters.”

Tip: Autoplacement features ignore components that are part of a physical design reuse.

Skip Skips this item and highlights the next.

Stop Adds the items identified through the Accept button and 
completes the operation.

Cancel Cancels the operation without modifying the selected 
cluster.
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Deleting a Cluster
To remove a cluster:

1. Select the cluster. You can make multiple selections.

2. Right-click and click Break.

To remove all clusters:

1. Select any cluster.

2. Right-click and click Break All Clusters.

Collapsing Clusters
Collapse relocates the members of a cluster to the center of the cluster. The Place Parts process 
of Cluster Placement eliminates overlaps created when you collapse a cluster. You can also 
move each part manually. Collapse operations ignore glued objects or unions containing glued 
objects.

Tip: To switch between viewing parts and viewing clusters click Clusters on the View menu.

Collapsing All Clusters

Procedure

1. With nothing selected, right-click and click Select Clusters.

2. Right-click and click Select All.

3. Right-click and click Collapse Members.

Collapsing Cluster Members
After moving a cluster, PADS Layout collapses the cluster. This is the default setting. To turn 
this option off use Collapse Cluster Members from the shortcut menu. You must be moving a 
cluster to access this command from the shortcut. 

Tip: Collapse Cluster Members is set to on each time you start PADS Layout.

Related Topics

Cluster and Union Placement in the Concepts Guide

Cluster Information Properties Dialog Box

Cluster Properties Dialog Box

Build Clusters Setup Dialog Box
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Cluster Manager Dialog Box

Cluster Placement Dialog Box

Place Clusters Setup Dialog Box

Place Parts Setup Dialog Box

Using the Cluster Placement Dialog Box
Use the Cluster Placement dialog box to build new clusters, place clusters within the board 
outline, and place parts within the board outline.

In this topic:

• Preparing for Automatic Placement

• Placing Parts Automatically

• Cluster Placement Status Dialog Box

Preparing for Automatic Placement
This topic discusses basic automatic placement procedures that will accommodate the average 
digital design. Use the following procedures to prepare your design for automatic placement 
and begin the automatic placement process.

After creating a board outline and importing a netlist that places all parts at the origin follow 
these steps:

1. Set the Design Grid to accommodate the parts you want to place. In English units a 
common grid is 100 or 50 mils for ICs and 50 mils for discrete parts. Start with a grid 
that is the most common denominator for your ICs.

2. Place all parts that should be in a fixed location, such as connectors, mounting holes, and 
so on. Select these parts.

3. Click the Properties button. 

4. Select the Glued check box in the Properties dialog box to prevent Automatic 
Placement from moving the parts.

5. Click Disperse Components on the Tools menu to move all unglued components 
outside and around the board outline. Disperse arranges parts around the board outline 
based on height and length.

Tip: Disperse ignores components that are part of a physical design reuse.

6. Click the Component Keepout button in the Drafting toolbar to create areas where 
parts should not be placed during automatic placement.
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7. Use Rotate and Flip to arrange parts that should be placed at an angle or reside on the 
bottom side of the design.

Placing Parts Automatically
To place parts:

1. Tools menu > Cluster Placement.

2. Click the Place Parts button. To modify the automatic placement options, click the 
Setup button below the button. For more information see Place Parts Setup Dialog Box.

3. Click Run. A status dialog box appears to show placement progress. For more 
information see “Using the Cluster Placement Dialog Box.”

Using the Cluster Manager Dialog Box
Use Cluster Manager to display and manage cluster members and unions. You can move cluster 
members and unions from one cluster to another and break, or delete, clusters. Cluster Manager 
works similarly to the Microsoft Windows Explorer; with it you can view items at the top level 
or at any level of the hierarchy.

The main elements of the Cluster Manager dialog box are two list boxes showing all clusters, 
unions, and components that exist in the design.

In this topic:

• Adding a Component to a Cluster

• Making Members of One Cluster Part of Another

Adding a Component to a Cluster
To add components to an existing cluster:

1. Tools menu > Cluster Manager.

2. In one list box, view the hierarchy of the cluster you want to add to.

3. In the other list box, select the components you want to add to the cluster.

4. Click the Move arrow.

Making Members of One Cluster Part of Another
To make members of one cluster part of another:

1. Tools menu > Cluster Manager.
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2. View the hierarchy of the cluster to add to in either list.

3. In the other list, view the hierarchy of the cluster containing the members to merge.

4. Highlight the members you want to move.

5. Click the Move arrow.

Removing all members from a cluster empties the cluster, but does not delete the cluster name 
until you click OK to end the session. Before clicking OK, you can add members to this empty 
cluster by double-clicking it and repeating the above steps for the members to add.
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Chapter 23
Working With Labels

You can create attribute, reference designator, and part type labels for components and jumpers. 
You can control the visibility of, justification, right-readability, and alignment of labels. When 
you create labels, they may not be visible. Turn on the visibility of labels using the Display 
Colors Setup dialog box, where you can set the color for reference designators, part type, and 
attribute labels.

Unlike free text, when you add a label, there is no invisible bounding rectangle around the label 
itself.

In this section:

• Adding a New Part Label

• Selecting a Label

• Deleting a Label

• Justifying a Label

• Modifying Part Label Properties

• Modifying Labels using the Component Properties Dialog Box

Adding a New Part Label
Use the Add New Part Label dialog box to create attribute labels, part type labels, and reference 
designator labels for components or jumpers. 

Tips:

• Reference designator is the only label available for use when you are creating labels for 
jumpers.

• If you don't set visibility information, default positions are used. 

See also: Label Defaults in the Concepts Guide

• Unlike free text, when you add a label, there is no invisible bounding rectangle around 
the label itself.

Procedure

1. Select a part > right-click > Add New Label
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2. In the Attribute list, select the attribute you want. If you are creating labels for jumpers, 
Reference Designator is the only available attribute.

Tip: Hidden attributes do not appear in the Attribute list unless the attribute was selected 
for the label before it was set as a hidden attribute.

3. The Value box lists the value of the selected attribute. Accept this value, or type a new 
one. This box is unavailable if you clicked Reference Designator or Part Type from the 
Attribute list, if the attribute is read-only, or if you open the Properties dialog box for 
different attribute types. However, if the labels you select belong to attributes of the 
same type, you can edit this box.

Tips:

• If the attributes have different values, the box is blank. You can type a new value in 
the box to apply it to all of the selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-registered and PADS Layout is not 
in ECO mode. 

4. In the Show list, click the value you want to control the visibility of the label. You can 
choose to turn the label off, to display only the label name, to display only the label 
value, to display the name and value, or to display the full name and value (when 
labeling a structured attribute).

Tip: Labels are invisible regardless of this setting unless you use the Display Colors 
Setup dialog box to change the color of labels to a color different from that of the 
background.

5. In the Font list, select the font you want to use. 

Tips:

• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any combination of styles: 
B for bold, I for italic, or U for underlined.

6. In the Layer list, select the layer on which you want the part label.

7. In the Position and sizes area, select the Relative to Component check box to place the 
label at the X and Y location relative to the component or the jumper. If you clear this 
check box, the label is placed at the X and Y location relative to the design origin.

8. In the X,Y location boxes, type new values to move the part label to a specified location.

9. The Rotation box shows the current rotation angle of the label. Type a new rotation 
angle if you want to change the rotation of the label.

10. In the Size box, type the size you want.

11. For stroke font, type the line width you want.
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12. Select the Mirrored check box if you want to flip the label. When Mirrored is checked, 
text is considered readable from the bottom side of the board.

13. In the Justification area, set the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, size, or width change.

Tips: 

• For vertical justification, click Left, Center, or Right. For horizontal justification, 
choose Up, Center, or Down. 

• Optionally, set justification by selecting the text, then right-clicking and clicking 
Justify Horizontally, and then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then clicking Up, Center, or Down.

14. The Right reading area controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click the None, Orthogonal, or Angled button to 
indicate the direction of reading you want.

15. Click OK.

Selecting a Label
To select labels using the Selection Filter:

1. Edit menu > Filter.

Result: The Selection Filter dialog box appears.

2. On the object tab, select the Labels check box.

3. Click Close.

4. Select the label.

Deleting a Label
To delete a label:

1. Select the label to delete. Use the selection filter if you need help selecting the label.

2. Press Delete or click Delete from the Edit menu.

Justifying a Label
You can justify free text and attribute, reference designator, or part type labels. You can set 
justification options when you create the label.

To justify text and labels after you create them:
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1. Select the label or free text.

2. Either:

• Right-click and click Justify Horiz. Then click Left, Center, or Right, and right-
click and click Justify Vert. Then click Up, Center, or Down.

Or

• Right-click and click Properties to open the Properties dialog box for the object and 
set the appropriate justification setting.

You can also set justification options when you spin or move labels and text. For more 
information, see To Move Text and Labels and To Rotate an Object

Related Topics

Adding a New Part Label

Component Properties Dialog Box

Display Colors Setup Dialog Box

Labels in the PCB Decal Editor in the Concepts Guide

Modifying Part Label Properties
Use the Part Label properties dialog box to modify a label and to change the attribute the label 
displays. 

Tip: If you select multiple labels, settings in this dialog box apply to all selected labels.

Procedure

1. Select a part label > right-click > Properties.

2. In the Attribute list, select the attribute you want. If you are creating or modifying labels 
for jumpers, Reference Designator is the only available attribute.

Tip: Hidden attributes do not appear in the Attribute list unless the attribute was selected 
for the label before it was set as a hidden attribute.

3. The Value box lists the value of the selected attribute. Accept this value, or type a new 
one. This box is unavailable if you clicked Reference Designator or Part Type from the 
Attribute list, if the attribute is read-only, or if you open the Properties dialog box for 
labels of different attribute types. However, if the labels you select belong to attributes 
of the same type, you can edit this box.

Tips:

• If the attributes have different values, the box is blank. You can type a new value in 
the box to apply it to all of the selected attribute labels and their parent objects.
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• Value is also unavailable if the attribute is ECO-registered and PADS Layout is not 
in ECO mode. 

4. In the Show list, click the value you want to control the visibility of the label. You can 
choose to turn the label off, to display only the label name, to display only the label 
value, to display the name and value, or to display the full name and value (when 
labeling a structured attribute).

Tip: Labels are invisible regardless of this setting unless you use the Display Colors 
Setup dialog box to change the color of labels to a color different from that of the 
background.

5. In the Font list, select the font you want to use. 

Tips:

• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any combination of styles: 
B for bold, I for italic, or U for underlined.

6. In the Layer list, select the layer on which you want the label.

7. In the Position and sizes area, select the Relative to Component check box to place the 
label at the X and Y location relative to the component or the jumper. If you clear this 
check box, the label is placed at the X and Y location relative to the design origin.

8. In the X,Y location boxes, type new values to move the part label to a specified location.

9. The Rotation box shows the current rotation angle of the label. Type a new rotation 
angle if you want to change the rotation of the label.

10. In the Size box, type the size you want.

11. For stroke font, type the line width you want.

12. Select the Mirrored check box if you want to flip the label. When Mirrored is checked, 
text is considered readable from the bottom side of the board.

13. In the Justification area, set the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, size, or width change.

Tips: 

• For vertical justification, click Left, Center, or Right. For horizontal justification, 
choose Up, Center, or Down. 

• Optionally, set justification by selecting the text, then right-clicking and clicking 
Justify Horizontally, and then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then clicking Up, Center, or Down.

14. Click the Component button if you want access to the component associated with the 
part label.
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15. The Right reading area controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click the None, Orthogonal, or Angled button to 
indicate the direction of reading you want.

16. Click OK.

Modifying Labels using the Component 
Properties Dialog Box

You can modify labels from the Component Properties dialog box.

1. Select a component > right-click > Properties.

2. Click the Labels tab.

3. Click the label to modify from the Label list and click the Label button. The Part Label 
Properties dialog box appears.

For information on deleting labels, see “Deleting a Label.”
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Chapter 24
Reusing Designs or Parts of Designs

In this chapter:

• To Create a Physical Design Reuse

• To Add a Physical Design Reuse

• Adding an Existing Reuse

• Using the Make Like Reuse Command

• To Select a Physical Design Reuse

• Modifying a Physical Design Reuse Block

• To Save a Physical Design Reuse

• To Break a Physical Design Reuse

• To Delete a Physical Design Reuse

• To Move a Physical Design Reuse

• Creating a Physical Design Reuse Report

To Create a Physical Design Reuse
To create a physical design reuse:

1. Select the objects you want to include in the physical design reuse. You must select the 
entire object. Partial selections are not included. If you intend to create a reuse for 
cloning (using Make Like Reuse), set your Selection Filter to Pin Pairs and Parts. 

See also: Using the Selection Filter

You can select routing objects in different ways. If you want to select traces to include in 
the physical design reuse, you can select trace segments, tacks, and trace corners. 

2. Right-click and click Make Reuse.

The selection is parsed for eligible items. Selected tacks and trace corners are replaced 
with appropriate trace segments. Selected pin pairs are replaced with trace segments, 
vias, and jumpers (if pin pair is fully or partially routed). Unrouted pin pairs are removed 
from the selection. Other ineligible items are also removed from the selection. Then the 
Make Reuse dialog box appears.
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If none of the items you selected are valid physical design reuse elements, the message 
“Selection does not include items valid for inclusion into a reuse. Retry your selection” 
appears. Click Report to open a deselection report, in the default text editor, that lists 
items not valid for inclusion in a reuse. When you close the report, you return to the 
error message. Click OK and repeat Step 1.

3. In the Make Reuse dialog box, type a reuse type up to 255 characters long, in the Reuse 
Type box.

Restriction: Illegal characters are slashes (\ /), colon (:), asterisk (*), question mark (?), 
quotation marks ("), less than and greater than signs (< >), and pipe (|).

4. Type a reuse name, up to 15 characters long, in the Reuse Name box. The default reuse 
name is based on the reuse type.

Restriction: Illegal characters are comma (,), brackets ({ }), asterisk (*), period (.), and 
space.

5. If you want to save the physical design reuse to a file, click Save to File. Save it as a file 
to use the physical design reuse in other designs.

6. To view the Selection or Deselection report, click the appropriate button.

7. Click OK. The OK button remains unavailable until you provide a reuse type and name.

If the reuse type is already assigned to another physical design reuse in the design, the 
message “A reuse type in the design already exists with the name XXX. Reuse type 
names cannot be duplicated in the design” appears. Click OK and specify another reuse 
type.

If the reuse name is already assigned to another physical design reuse in the design, the 
message “Reuse name <name> already exists. Reuse names cannot be duplicated in the 
design” appears. Click OK and specify another reuse name.

When the reuse name and type are accepted, the physical design reuse is created. If you 
selected the Save to File check box, the Reuse Save As dialog box appears.

8. Type a physical design reuse file name and specify a location in which to save the file. 
The default physical design reuse file name is the reuse type name with a .reu file 
extension. The default folder is \PADS Projects\Reuse.

9. Click Save. If you specified a reuse file name that is different from the reuse name used 
in the design, the message “Do you want to change reuse type name to XXX?” appears.

10. Click Yes to change the reuse type in the design to match the file name you specified, 
click No to ignore the change, or click Cancel to cancel the Save to File process.
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To Add a Physical Design Reuse
Once you create a physical design reuse, you can add it to other designs. You can also add a 
copy of a reuse that already exists in the design. 

Requirement: To add or copy a reuse, you must be in ECO mode; therefore, all components, 
pin pairs, and nets added to the design are recorded in the .eco file using standard ECO 
commands. 

Tip: You cannot add a reuse to a design if the design is in default layer mode and the reuse to 
add is in increased layer mode. Use the Layers Setup dialog box to change the design to 
increased layer mode.

To add the first instance of a physical design reuse to a design:

1. Click the ECO Toolbar button.

2. Turn Design Rules Checking off by typing DRO and pressing Enter. You must turn 
DRC off to add or copy a reuse. If DRC is not turned off, a prompt appears that allows 
you to turn DRC off.

3. Click the Add Reuse button on the ECO toolbar. The Add Reuse dialog box appears.

4. Select the reuse file to add and click Open. The Reuse Properties dialog box appears.

If the reuse file you select to add already exists in the design, the message “Reuse type 
XXX already exists in the design. OK to make a copy of this reuse type?” appears. Click 
OK to add a copy of the selected physical design reuse from the design or click Cancel.

5. Set the reuse name and reference designator preferences.

6. Click Net Properties. The Net Properties dialog box appears.

7. Resolve net conflicts, if any, and click OK. You return to the Reuse Properties dialog 
box.

8. Click OK. The reuse file is compared against the current design to detect possible 
reference designator, layer, decal, and netname conflicts, and to detect other errors and 
warnings.

See also: Adding a Physical Design Reuse in the Concepts Guide

The results of this comparison are recorded in the Layout.err report file in the 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs folder.

9. If errors are found, the message “Adding this reuse to the design resulted in xxx errors 
and xxx warnings. The Add Reuse command was aborted. Show report file?” appears. 
Click Yes to view the report file in the default text editor; otherwise click No and return 
to step 3.
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If errors are not found, but warnings are, the message “Adding this reuse to the design 
resulted in 0 errors and xxx warnings. Show report file?” appears. Click Yes to view the 
report file in the default text editor; otherwise click No and proceed to step 10.

If no errors or warnings are found, the message “Reuse added without warnings or 
errors. Show report file?” appears. Click Yes to view the report file in the default text 
editor; otherwise click No and proceed to Step 10.

10. When all physical design reuse elements are successfully added to the design, the 
physical design reuse dynamically attaches to the pointer. Click to indicate the location 
of the physical design reuse.

Result

If you have bridge copper in your reuse block, you should ensure that it has retained its bridge 
status and assigned nets.

Related Topics

To Add an Existing Reuse in Verb Mode

Adding a Physical Design Reuse in the Concepts Guide

Adding an Existing Reuse
You can add a copy of an existing physical design reuse to your design in one of three ways: in 
Verb mode, in Object mode, or by using copy and paste.

To Add an Existing Reuse in Object Mode
Requirement: You must be in ECO mode to add or copy a reuse.

Procedure

1. Click the ECO Toolbar button.

2. Turn Design Rules Checking off by typing DRO and pressing Enter. You must turn 
DRC off to add or copy a reuse.

3. Select an existing physical design reuse in the design as described in “To Select a 
Physical Design Reuse.”

4. Click the Add Reuse button on the ECO toolbar. The Reuse Properties dialog box 
appears.

5. Modify the physical design reuse properties as described in tabularTo Add a Physical 
Design Reuse.”
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6. Click OK. The physical design reuse dynamically attaches to the pointer. Click to 
indicate the location of the copied physical design reuse.

Result

If you have bridge copper in your reuse block, you should ensure that it has retained its bridge 
status and assigned nets.

To Add an Existing Reuse in Verb Mode
Requirement: You must be in ECO mode to add or copy a reuse.

Procedure

1. Click the ECO Toolbar button.

2. Turn Design Rules Checking off by typing DRO and pressing Enter. You must turn 
DRC off to add or copy a reuse.

3. Click the Add Reuse button from the ECO toolbar. The Add Reuse dialog box appears.

4. Click the reuse file you want to add and click Open. The Reuse Properties dialog box 
appears.

If the reuse type already exists in the current design, the message “Reuse Type XXX 
already exists in the design. OK to make a copy of this reuse type?” appears.

5. Click OK to continue, or click Cancel to abort the Add Reuse process.

6. Modify the physical design reuse properties as described in “To Add a Physical Design 
Reuse.”

7. Click OK. The physical design reuse dynamically attaches to the pointer. Click to 
indicate the location of the copied physical design reuse.

Result

If you have bridge copper in your reuse block, you should ensure that it has retained its bridge 
status and assigned nets.

To Copy and Paste an Existing Reuse
Requirement: You must be in ECO mode to add or copy a reuse unless you are pasting a 
physical design reuse that contains only drafting items

Procedure

1. Click the ECO Toolbar button.
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2. Turn Design Rules Checking off by typing DRO and pressing Enter. You must turn 
DRC off to add or copy a reuse.

3. Select an existing physical design reuse in the design as described in To Select a 
Physical Design Reuse.

4. Click Copy from the Edit menu.

Tip: You can only copy one reuse at a time.

5. Click Paste from the Edit menu. The Reuse Properties dialog box appears.

6. Modify the physical design reuse properties as described in To Add a Physical Design 
Reuse

7. Click OK. A copy of the physical design reuse dynamically attaches to the pointer. 
Click to indicate the location of the copied physical design reuse.

Result

If you have bridge copper in your reuse block, you should ensure that it has retained its bridge 
status and assigned nets.

Tip: When you copy a physical design reuse and paste it into a different design, the reuse file is 
compared against the current design to detect possible reference designator, layer, decal, and 
netname conflicts. 

See also: Adding a Physical Design Reuse in the Concepts Guide

Using the Make Like Reuse Command
Make Like Reuse clones a selected physical design reuse using existing components and their 
logical interconnects as the elements for the physical design reuse. All other physical design 
reuse elements; such as traces, vias, coppers, 2D lines, and text are created.

To Make a Like Reuse in Object Mode
You can add a physical design reuse in one of the three ways: in Verb mode, in Object mode, or 
by using the shortcut menu command.

Procedure

1. Turn Design Rules Checking off by typing DRO and pressing Enter. You must turn 
DRC off to make a like reuse.

2. Select an existing physical design reuse in the design as described in “To Select a 
Physical Design Reuse.”

3. Click the Design Toolbar button. The Design toolbar appears.



Reusing Designs or Parts of Designs
Using the Make Like Reuse Command

PADS Layout User’s Guide and Reference Manual, PADS 9.4 537

4. Click the Make Like Reuse button from the Design toolbar. If a match is found, the 
new physical design reuse dynamically attaches to the pointer. If no match is found, the 
message “No match found in unrouted components for this reuse definition” appears.

Tip: You cannot add a physical design reuse if the design is in default layer mode and 
the reuse to add is in increased layer mode. Use the Layers Setup dialog box to change 
the design to increased layer mode.

5. Click to indicate a location for the new physical design reuse.

Result

If you have bridge copper in your reuse block, you should ensure that it has retained its bridge 
status and assigned nets.

To Make a Like Reuse in Verb Mode
You can add a physical design reuse in one of the three ways: in Verb mode, in Object mode, or 
by using the shortcut menu command.

Procedure

1. Turn off Design Rules Checking by typing DRO and pressing Enter. You must turn 
DRC off to make a like reuse. 

2. Select the group of components you want to include in the new reuse. If you do not 
select a specific group of components, all components are included in making the like 
reuse. The group of components you select can be larger than required for the reuse; any 
useless components are ignored. You cannot select both the reuse and the group of 
components. If you want to select a particular group of components, save your reuse 
definition before making a like reuse.

3. Click the Design Toolbar button. The Design toolbar appears.

4. Click the Make Like Reuse button on the Design toolbar. The Open Reuse File dialog 
box appears.

5. Click a reuse file and click Open. If a match is found, the new physical design reuse is 
attached to the pointer. If no match is found, the message “No match found in unrouted 
components for this reuse definition” appears.

Tip: You cannot add a reuse to a design if the design is in default layer mode and the 
reuse to add is in increased layer mode. Use the Layers Setup dialog box to change the 
design to increased layer mode.

6. Click to indicate the location of the new physical design reuse.
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Result

If you have bridge copper in your reuse block, you should ensure that it has retained its bridge 
status and assigned nets.

To Make a Like Reuse Using the Shortcut Menu 
Command

You can add a physical design reuse in one of the three ways: in Verb mode, in Object mode, or 
by using the shortcut menu command.

Procedure

1. Turn Design Rules Checking off by typing DRO and pressing Enter. You must turn 
DRC off to make a like reuse. If DRC is not turned off, a prompt appears that allows you 
to turn DRC off.

2. Select an existing physical design reuse in the design as described in “To Select a 
Physical Design Reuse.”

3. Right-click and click Make Like Reuse. If a match is found, the new physical design 
reuse dynamically attaches to the pointer. If no match is found, the message “No match 
found in unrouted components for this reuse definition” appears.

Tip: You cannot add a physical design reuse if the design is in default layer mode and 
the reuse to add is in increased layer mode. Use the Layers Setup dialog box to change 
the design to increased layer mode.

4. Click to indicate a location for the new physical design reuse.

Result

If you have bridge copper in your reuse block, you should ensure that it has retained its bridge 
status and assigned nets.

To Select a Physical Design Reuse
To select a physical design reuse:

1. Select any element in the physical design reuse.

2. Right-click and click Select Reuse. The physical design reuse is selected.

Tip: You can set the Selection Filter to Reuse or the Find dialog box to Reuse type to select 
physical design reuse blocks. 

See also: Using the Selection Filter, Find Dialog Box
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Modifying a Physical Design Reuse Block

To Edit a Physical Design Reuse Definition
After you open a physical design reuse, you can then edit its definition and update the reuse file.

Tip: The reuse definition is the master copy of the physical design reuse that is saved to a file. 
The saved version of the physical design reuse is the version you should use in other designs. 
All resulting instances of the physical design reuse are based on this file.

To edit a physical design reuse:

1. Open the physical design reuse file:

a. File menu > Open.

b. Click PADS Layout Reuse Files (*.reu) as the file type.

c. Navigate to the appropriate folder and click the reuse file to open.

d. Click Open.

2. If necessary, select the physical design reuse. The physical design reuse should be 
selected after you open it.

3. If necessary, break the physical design reuse by right-clicking and clicking Break 
Reuse. You can edit the design rules without breaking the physical design reuse. 

4. Edit the physical design reuse, as necessary.

5. Recreate the physical design reuse by selecting all of the components and right-clicking 
and clicking Make Reuse. The Make Reuse dialog box appears. 

See also: Reusing Designs or Parts of Designs

6. Click Save to File.

7. In the Reuse Save As dialog box, click the name of the reuse file you just modified and 
click Save. The message “xxx.reu already exists. Do you want to replace it?” appears.

8. Click Yes to overwrite the existing file. The physical design reuse definition is updated.

Modifying Physical Design Reuse Properties
You can modify a physical design reuse, but you can't modify the elements within the physical 
design reuse. More modification options are available to you in ECO mode. When in ECO 
mode, any component or netnames you modify in the Reuse Properties dialog box are recorded 
in the .eco file using standard ECO commands.

To edit physical design reuse properties:
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1. Select a physical design reuse > right-click > Properties.

2. Modify the location, rotation, glued status, and reuse name, if necessary.

3. Modify the reference designator preferences or net properties, if necessary.

4. Click OK.

If you changed the reference designator preferences or net properties, the component 
elements and private nets are renamed.

To Reset the Origin of a Physical Design Reuse
Every physical design reuse has an origin. The default origin is the component pin with the 
lowest X and Y values. The origin marker is square, rather than round, to differentiate it from 
the design and component origin markers. The physical design reuse origin marker is visible 
only when you reset the origin.

To reset a physical design reuse origin:

1. Select the physical design reuse whose origin you want to reset as described in “To 
Select a Physical Design Reuse.”

2. Right-click and click Reset Origin. The reuse origin marker appears.

3. Click to indicate the new position of the origin. A message appears indicating the 
coordinates of the new origin and asks if you want to use this as the origin. 

4. Click Yes to use the new origin. Click No to choose another origin.

To Save a Physical Design Reuse
You can save a physical design reuse to a file at any time. The saved version of the physical 
design reuse is called the reuse definition.

See also: To Select a Physical Design Reuse

To save a physical design reuse:

1. Select a physical design reuse > right-click > Save to File.

2. Type a reuse type name and a path in which to save the selected physical design reuse. 
The default physical design reuse file name is the reuse type name with a .reu file 
extension. The default folder is \PADS Projects\Reuse.

3. Click Save. If you specified a reuse file name, the message “Do you want to change 
reuse type name to XXX?” appears.

4. Click Yes to change the reuse type file name, click No to ignore the change, or click 
Cancel to abort the Save to File process.
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If the name in the Reuse Type box is already assigned to another physical design reuse 
in the reuse folder, the message “XXX.reu already exists. Do you want to replace it?” 
appears.

5. Click Yes to overwrite the reuse file or Click No to specify another type.

To Break a Physical Design Reuse
The Break Reuse command disassembles the physical design reuse and returns its elements to 
normal design data. When you break a physical design reuse, elements are returned to their pre-
reuse state; therefore, route protection and other settings are maintained. You do not need to be 
in ECO mode to breaking a physical design reuse.

To break a physical design reuse:

1. Select the physical design reuse you want to break as described in “To Select a Physical 
Design Reuse.”

2. Right-click and click Break Reuse. The message “OK to Break Reuse(s)?” appears.

3. Click Yes to break the physical design reuse.

Tips:

• You must break a physical design reuse before you can edit the elements within it.

• Reuses are automatically broken when you import an .eco file.

To Delete a Physical Design Reuse
To delete a reuse, you must be in ECO mode; therefore, all components, pin pairs, and nets 
deleted to the design are recorded in the .eco file using standard ECO commands.

Requirement: You must be in ECO mode to delete a reuse.

To delete a physical design reuse:

1. Click the ECO Toolbar button.

2. Select the physical design reuse you want to delete.

See also: “To Select a Physical Design Reuse“

3. Click Delete from the Edit menu, or press Delete. The confirmation message appears.

4. To maintain routes connected to the physical design reuse, click to clear Delete Routes.
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Tip: It is not always possible to maintain traces connected to physical design reuse 
components. Delete Routes is clicked by default, meaning routes are deleted with the 
physical design reuse.

5. Click OK to delete the physical design reuse.

Tip: You can't delete physical design reuses that contain glued components or protected routes.

To Move a Physical Design Reuse
When you move a physical design reuse, traces are stretched, similarly to moving a group. 

To move a physical design reuse:

1. Turn Design Rules Checking off by typing DRO and pressing Enter. You must turn 
DRC off to move a physical design reuse.

2. Select the physical design reuse as described in “To Select a Physical Design Reuse.”

3. Right-click and click Move.

4. Click to indicate a new location for the physical design reuse. You can right-click and 
click Cancel to cancel the move.

Creating a Physical Design Reuse Report
You can create a report that contains the following information of the selected physical design 
reuse: name, type, and elements.

Procedure

1. Select the physical design reuse. 

See also: To Select a Physical Design Reuse

2. Right-click and click Report Contents.

Result

The report is written to C:\PADS Projects\rules.rep and is displayed by the default text editor.
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Chapter 25
Drafting Operations

Creating a Drafting Object
All drafting objects are created in the same manner. These instructions apply to creating 2D 
lines, copper, copper cut outs, copper pour areas, copper pour cut outs, board outlines, board 
outline cut outs, keepouts, plane areas, and plane area cut outs.

Procedure

1. After you click a button on the Drafting toolbar, right-click to set any values before 
creating the drafting object.

2. Right-click and choose a shape to draw. 

3. Draw the:

• Circle

• Polygon or Path

• Rectangle

• Chamfered path (copper only)

Setting Values Before Creating a Drafting Object
Use the Drafting toolbar to add drafting objects, such as copper shapes, keepouts, and non-
electrical drawn items generally not associated with placement and routing. After you click the 
button for the type of item to add, but before you place the drafting object, you can set various 
values.

Procedure

1. Type W<nn>, where <nn> is the width value, or right-click and click Width to specify 
the width of the drafting object boundary.

Tip: The default widths for each object type are defined using the Drafting / Text and 
Lines page of the Options dialog box.

2. Right-click and click Layer. Choose one of the following:

• Type L<n>, where <n> is a layer number, or click Layer to specify the layer where 
you want to place the Drafting object.
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• Specify the layer using the Layer box on the Toolbar.

3. Right-click and click Auto Miter to miter all added corners. Define the miter type and 
size in the Design page of the Options dialog box.

4. Right-click and click Orthogonal to add strictly horizontal or vertical segments.

5. Right-click and click Diagonal to add 45-degree segments.

6. Right-click and click Any Angle to add segments at any angle.

Related Topics

Creating a Circle Drafting Object

Creating a Polygon or Path Drafting Object

Creating a Rectangle Drafting Object

Deleting a Drafting Segment or Object

Creating a Polygon or Path Drafting Object
Use the Drafting toolbar to add drafting objects such as copper shapes, keepouts, and non-
electrical drawn items generally not associated with placement and routing.

Procedure

1. Click the button for the type of item to add: 2D Line, Copper, Cut Out, Pour Keepout, or 
Board Outline. The add command for that object type attaches to your pointer.

2. Right-click and set your drafting values.

3. To start the drafting object and finish each segment or place each corner, use one of the 
following:

• Locate each coordinate with the pointer, and click to start and indicate consecutive 
corners.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the starting point 
and consecutive corners.

• Type SR<x>, <y> if you want to specify relative coordinate values for each point 
and corner.

Tips: 

• Right-click and click Add Arc to add an arc instead of a straight-line segment.

• Press BackSpace to remove the last corner.

• Press Esc to cancel the operation.
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4. Double-click or right-click and click Complete to end the shape. Polygons are 
automatically closed; paths are terminated at the last-defined corner.

Related Topics

Creating a Circle Drafting Object

Creating a Rectangle Drafting Object

Deleting a Drafting Segment or Object

Setting Values Before Creating a Drafting Object

Creating a Circle Drafting Object
Use the Drafting toolbar to add drafting objects such as copper shapes, keepouts, and non-
electrical drawn items generally not associated with placement and routing.

Procedure

1. Click the button for the type of item to add: 2D Line, Copper, Cut Out, Pour Keepout, or 
Board Outline. The add command for that object type attaches to your pointer.

2. Right-click and set your drafting values.

3. Click to indicate the location of the circle's center.

Alternative: Instead of using the pointer, you can type the coordinates using the 
following methods.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the starting and 
ending point.

• Type SR<x>, <y> if you want to specify relative coordinate values for the starting 
and ending point.

Tip: Press Esc to cancel the operation.

4. Click to indicate the circle's radius to complete the circle definition.

Related Topics

Creating a Polygon or Path Drafting Object

Creating a Rectangle Drafting Object

Setting Values Before Creating a Drafting Object

Creating a Rectangle Drafting Object
Use the Drafting toolbar to add drafting objects such as copper shapes, keepouts, and non-
electrical drawn items generally not associated with placement and routing.
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Procedure

1. Click the button for the type of item to add: 2D Line, Copper, Cut Out, Pour Keepout, or 
Board Outline. The add command for that object type attaches to your pointer.

2. Right-click and set your drafting values.

3. Click to indicate one corner of the rectangle.

Alternative: Instead of using the pointer, you can type the coordinates using the 
following methods.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the starting and 
ending point.

• Type SR<x>, <y> if you want to specify relative coordinate values for the starting 
and ending point.

Tip: Press Esc to cancel the operation.

4. Click to indicate the location of the diagonally opposite corner.

Related Topics

Creating a Circle Drafting Object

Creating a Polygon or Path Drafting Object

Deleting a Drafting Segment or Object

Setting Values Before Creating a Drafting Object

Text
In this section:

• Adding Free Text

• Modifying Text Properties

• To Mirror Text

• To Move Text and Labels

Adding Free Text
You can add single lines of free text (text not belonging to an object) to a design. When you add 
text, there is an invisible bounding rectangle or outline box around the text itself. Type the X 
modeless command to toggle the outline box on or off.

Tip: To add multiple lines of text to a design, see Embedding a Text Document.
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Procedure

1. Drafting Toolbar button > Text button.

2. In the Add Free Text dialog box, type the text string you want to use in the Text box.

Tip: There is a maximum of 128 characters per text string.

3. In the Font list, select the font you want to use.

Tips:

• The default font name and style appear in the Font box when the dialog box opens.

• Select a stroke font or a system font.

• For system fonts, you can also click a font style button or any combination of 
buttons: B for bold, I for italic, or U for underlined. 

4. In the Layer list, select the layer on which you want the text.

5. In the X,Y location boxes, type values to move the text string to a specified location. If 
not specified, the text string attaches to your pointer for placement.

6. The Rotation box shows the current orientation of the text string. Type a new value to 
change the degree of rotation.

7. The Size box shows the current size used for display or CAM output of the text string. 
Type a new value to change the size.

8. For stroke font, type the line width you want.

9. Select the Mirrored check box if you want to flip the text. When Mirrored is checked, 
text is considered readable from the bottom side of the board.

10. In the Justification area, set the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, size, or width change.  

Tips: 

• For vertical justification, click Left, Center, or Right. For horizontal justification, 
choose Up, Center, or Down. 

• Optionally, set justification by selecting the text, then right-clicking and clicking 
Justify Horizontally, and then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then clicking Up, Center, or Down.

11. Click OK to close the dialog box. 

Tip: If you did not type coordinates to place the text, the text dynamically attaches to the 
pointer. Click to indicate the location for the text. After you place the text, the Add Free 
Text dialog box reappears so you can create additional strings. 
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Recommendation: Place free text and attribute values on the Silkscreen Top layer to avoid 
DRC violations or shorts.

Related Topics

Modifying Text Properties

Combining Line and Text Objects

To Mirror Text

To Move Text and Labels

Modifying Text Properties
Use the Text Properties dialog box to modify free text. You can change the font, font style, layer 
assignment, orientation, rotation, size, line width, if it is mirrored, and justification. You can 
also access the parent object if the text string is combined with a drafting object.

To modify text properties:

1. Select a text string > right-click > Properties.

2. The Text box displays the selected text string. Modify the existing text string, or type a 
new text string.

3. In the Font area, select the font you want to use. 

Tips: 

• Select stroke font or a system font.

• For system fonts, you can also click a font style button or any combination of 
buttons: B for bold, I for italic, or U for underlined. 

4. In the Layer area, select the layer on which you want the text.

5. In the X,Y location boxes, type new values to move the text string to a specified 
location.

6. The Rotation box shows the current orientation of the text string. Type a new value to 
change the degree of rotation.

7. The Size box shows the current size used for display or CAM output of the text string is 
shown. Type a new value to change the size.

8. For stroke font, type the line width you want.

9. Select the Mirrored check box if you want to flip the text. When Mirrored is checked, 
text is considered readable from the bottom side of the board.

10. In the Justification area, set the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, size, or width change.  
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Tips: 

• For vertical justification, click Left, Center, or Right. For horizontal justification, 
choose Up, Center, or Down. 

• Optionally, set justification by selecting the text, then right-clicking and clicking 
Justify Horizontally, and then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then clicking Up, Center, or Down.

11. Click the Parent button if you want to access the parent object for a text string that is 
combined with a drafting object.

12. Click OK. 

Tips: 

• If you select another text object before closing the dialog box, the text information is 
updated.

• Several options in this dialog box are unavailable if the text is part of a physical 
design reuse.

Related Topics

Text

To Mirror Text

To Move Text and Labels

To Mirror Text
To mirror text objects:

1. Select the object.

2. Right-click and click Mirror.

Related Topics

Text

Modifying Text Properties

Combining Line and Text Objects

To Move Text and Labels

To Move Text and Labels
To move text and labels:

1. Select a text or label > right-click > Move.



PADS Layout User’s Guide and Reference Manual, PADS 9.4550

Drafting Operations
Modifying Copper Chamfered Paths Properties

Result: The object attaches to the pointer.

2. You can open the Properties dialog box, rotate, spin, mirror, or justify the selected text 
or label while it is attached to your pointer.

3. Click to complete the move.

You can also move text and labels with drag and drop operations or using the Move button in 
the Design toolbar. You still have the same editing abilities while moving the text or label. You 
can use the arrow keys while in Move Verb mode, but you do not have the same editing 
abilities.

Tips:

• If you move a text object that is combined with other drafting objects, all the combined 
objects move.

• If you click Drag and Drop in the Global / General page of the Options dialog box, the 
text object does not attach to your pointer when you release the left button.

• You can't modify text that is part of a physical design reuse. If you try to, the message 
“Reuse elements cannot be modified. Break the reuse first” appears. Click OK to cancel 
the operation.

Related Topics

Text

Modifying Text Properties

Combining Line and Text Objects

To Mirror Text

Modifying Copper Chamfered Paths Properties
You can select the copper chamfered paths of a net to change its properties.

1. Select a net in the design.

2. Right-click and click Select Chamfered Paths.

3. Right-click and click Properties.

Related Topics

Modifying Drafting Object Properties

Modifying Drafting Objects
In this section:
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• To Move a Drafting Object

• Modifying Drafting Edge Properties

• Modifying Drafting Corner Properties

• Modifying Drafting Object Properties

• To Move a Miter

• Pulling an Arc from a Drafting Segment/Corner

• Deleting a Drafting Segment or Object

• Deleting an Item

To Move a Drafting Object

Procedure

1. Select the drafting object to move.

2. Move the object by positioning the pointer over your selection, clicking, moving the 
mouse to drag, and releasing. The drafting object remains attached to the pointer.

3. You can open the Properties dialog box, rotate, or spin the selected drafting object while 
it is attached to your pointer. You can also temporarily disable On-line DRC for this 
move by right-clicking.

4. Click to complete the move.

Tips:

• If you move a drafting object that is combined with other drafting objects, all the 
combined objects move.

• If you click the Move button in the Design toolbar, a click attaches the drafting object to 
your pointer.

• If you click Drag and Drop in the Global / General page of the Options dialog box, the 
drafting object is not attached to your pointer when you release the left button.

• If you click Move By Origin in the Design page of the Options dialog box, the drafting 
object attaches to the pointer at its origin.

• You can't modify, move, or delete a polygon of any type (2D line, copper, or pour) that 
is part of a physical design reuse. You can, however, flood pour outlines for copper pour 
and split planes. If you try to otherwise modify a polygon, the message “Reuse elements 
cannot be modified. Break the reuse first” appears. Click OK to cancel the operation.
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Modifying Drafting Edge Properties
1. To select an edge, click on it once.

2. Right-click and click Properties. The Drafting Edge Properties dialog box opens; 
showing you what type of drafting object the item is and rules information.

Tip: Several of the options in this dialog box are unavailable if the edge is part of a physical 
design reuse.

Modifying Drafting Corner Properties
To modify drafting corner properties:

1. Select a drafting corner > right-click > Properties.

2. In the X and Y boxes, type the X and Y location of the drafting corner.

3. Click Net to modify settings for the net to which the drafting corner belongs.

4. Click Parent to modify drafting object to which the corner belongs.

Tip: Several of the options in this dialog box are unavailable if the corner is part of a physical 
design reuse.

Related Topics

Modifying Net Properties

Modifying Drafting Object Properties

To Delete a Corner

To Move a Corner

Modifying Drafting Object Properties
You can select and edit drafting shapes in pieces or as whole items. The properties you can 
modify depend on whether you select a corner of the drafting object, an edge of the drafting 
object, or the whole, or parent object of a 2D line, copper, or text.

Exception: Several of the options in this dialog box are unavailable if the object is part of a 
physical design reuse.

In this section:

• Converting Shapes

• Changing Line Widths

• Scaling
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• Setting the Arc Approximation Error

• Rotating

• Setting Object Options

• Changing Net Properties of Assigned Objects

• Changing Layers

• Assigning Nets

• Assigning Nets by Clicking Design Objects

• Setting Keepout Restrictions

Converting Shapes
You can convert a drafting object to another shape. In the Layout Editor, you can convert any 
drafting object to a 2D line, board outline, board cut out, copper, copper cut out, keepout, 
copper pour, plane area, or plane area cut out. In the PCB Decal Editor, you can convert any 
drafting object to a 2D line, copper, copper cut out, or keepout.

Tip: Convert shapes without scaling, using a Scale Factor of 1 to maintain the shape size.

Restrictions: 

• If there is no board outline in the design, the Board Cut Out type does not appear in the 
Drafting Properties dialog box Type list. 

• If there is a board outline in the design, the Board Outline option does not appear in the 
dialog box.

To Convert to a new shape type:

1. Select a drafting item > right-click > Properties.

2. In the Type list, select a new shape type. 

Changing Line Widths
You can change the line width of drafting object outlines and fill lines if it applies.

1. Select a drafting item > right-click > Properties.

2. In the Width box, type a value.

Exceptions: 

• Some drafting object line widths can't be changed. 
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• Like any other line width, the chamfered path does not appear as the correct width if 
the Minimum display width option for the design is larger than the Polygon outline 
width of the path. The path appears more narrow by the value of the Polygon outline 
width.

Scaling
Create a scale model of the objects on one or more nonelectrical layers that won't be plotted in 
CAM. We recommend using a 1:10 scale for the model. The scale model lets you work with 
arcs in a coordinate range that PADS Layout allows.

To scale:

1. Select a drafting item.

2. If necessary, right-click and click Set Origin to set the origin of the scale model.

3. Right-click, and click Properties.

4. In the Properties dialog box, set scale options and click OK. 

Tip: Enter a floating-point number greater than 0. Fractions are not supported.

Exceptions:

• If the new shape type is copper pour and the layer is a split/mixed plane layer, then 
the new shape is a plane area shape and the Assign Net to Selected Polygon dialog 
box appears. Click the net to assign to the scaled shape and click OK. The shape is 
scaled.

• If scaling changes a dimension, select the dimension, right-click, and click Reset 
Measurement to update the dimension measurement.

Setting the Arc Approximation Error
• Select a drafting item > right-click > Properties.

In the Arc Approximation Error box, type the allowable approximation error for scaling arcs. 
Arcs are converted to a set of straight-line segments that approximate the arc. The 
approximation error is the perpendicular distance from the approximation segment to the actual 
arc. 
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Rotating
You can change the rotation of drafting objects.

1. Select a drafting item > right-click > Properties.

2. In the Rotation box, type the rotation angle of the drafting shape.

Exception: Some drafting object line widths can't be changed.

Filling a Shape with Solid Copper
Copper is filled using the settings of the Copper Hatch Grid and the Drafting Default width. 
You can ignore these settings and fill a shape with solid copper. When you create chamfered 
paths, they are created with solid copper.

• Select the Solid Copper check box.

Tip: The Solid Copper check box forces copper to use trace clearance rules.

Setting Object Options
You can access additional options for certain drafting objects.

1. Select a drafting item > right-click > Properties.

2. Click the Options button. 

Changing Net Properties of Assigned Objects
You can access the Net Properties of an assigned object.

1. Select a drafting item > right-click > Properties.

2. Click the Net button to modify settings for the net to which the drafting object belongs.

Exception: You can assign clearance rules for copper on the net level only: group and pin pair 
assignments are invalid.
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Changing Layers
You can change the layer on which the drafting object exists.

1. Select a drafting item > right-click > Properties.

2. In the Layer list, select the new layer.

Tip: Moving assigned copper to a nonelectrical layer removes the connection from the copper 
shape. Place the copper back on an electrical layer to reassign the connections.

Assigning Nets
You can assign nets to electrical drafting objects.

1. Select a drafting item > right-click > Properties.

2. In the Net Assignment area, select a netname from the Net list and then click Apply to 
assign an existing netname to a copper shape.

Assigning Nets by Clicking Design Objects
You can assign nets to electrical drafting objects by clicking objects in the design. You can click 
objects such as a pin, via, trace, net, copper, or unroute to assign the netname of the object to the 
copper shape.

1. Select a drafting item > right-click > Properties.

2. Click the Assign Net by Click button and then select a design object.

3. Click the Assign Net by Click button again to cancel the object selection and return to 
the dialog box.

Alternative: If a drafting object does not yet have a net assigned, in the design, right-click and 
click Assign Net by Click. You do not have to open the Properties dialog box. 

Setting Keepout Restrictions
You can select restrictions for keepout areas. 

Tip: When defining keepouts in the PCB Decal Editor, you can also assign keepouts to an 
<Opposite Side>. You can’t do this in the Layout Editor.

• Select a drafting item > right-click > Properties.

o Component Height restricts components with heights greater than the specified 
height. This check box is unavailable unless you turn on the Placement check box.

o Component Drill restricts components that contain drilled through holes.
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o Click Select All to select all restrictions except Component Height.

o Copper Pour and Plane Area restricts copper pours from flooding and split/mixed 
planes from plane connection.

Restrictions:

• If you set a layer before assigning restrictions, there are restrictions that are not 
available.

• Placement, Component Height, and Component Drill check boxes are unavailable in 
the PCB Decal Editor.

Related Topics

Modifying Net Properties

Using Keepouts

Selecting Drafting Objects

To Move a Miter
You can expand or contract a miter or arc on a drafting segment with the Move Miter command.

1. Select a miter segment or arc > right-click > Move Miter.

Result: The object dynamically attaches to your pointer.

2. Move the pointer to expand or contract the object.

3. Click to indicate the new miter position to finish.

Indicate a location outside the point of intersection of the two lines to convert the arc or miter 
back to a corner.

Tips:

• Use the Stretch command to modify an arc or miter on a route.

• You can't modify, move, or delete a polygon of any type (2D line, copper, or pour) that 
is part of a physical design reuse. You can, however, flood pour outlines for copper pour 
and split planes. If you try to otherwise modify a polygon, the message “Reuse elements 
cannot be modified. Break the reuse first” appears. Click OK to cancel the operation.

Related Topics

Pulling an Arc from a Drafting Segment/Corner
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Pulling an Arc from a Drafting Segment/Corner
Use the Pull Arc command to convert a drafting segment or corner into an arc. The starting 
points of the drafting segment become the start and stop angle for the new arc. 

Procedure

1. Select a segment or corner > right-click > Pull Arc.

2. The segment or corner attaches to your pointer and changes to an arc.

3. Click to indicate the new position for the arc.

Use the Move Miter command to modify the radius of a created arc or miter.

Tip: You can't modify, move, or delete a polygon of any type (2D line, copper, or pour) that is 
part of a physical design reuse. You can, however, flood pour outlines for copper pour and split 
planes. If you try to otherwise modify a polygon, the message “Reuse elements cannot be 
modified. Break the reuse first” appears. Click OK to cancel the operation.

See also: To Create Miters, To Create Arcs

Deleting a Drafting Segment or Object
To delete drafting segments or objects:

1. Select the segment or object. See Selecting Drafting Objects

2. Click the Delete button or on the Edit menu click Delete.

Tip: You can't modify, move, or delete a polygon of any type (2D line, copper, or pour) that is 
part of a physical design reuse. You can, however, flood pour outlines for copper pour and split 
planes. If you try to otherwise modify a polygon, the message “Reuse elements cannot be 
modified. Break the reuse first” appears. Click OK to cancel the operation.

Related Topics

Creating a Circle Drafting Object

Creating a Polygon or Path Drafting Object

Creating a Rectangle Drafting Object

Setting Values Before Creating a Drafting Object

Deleting an Item
Use Delete to remove a selected item from the design.

1. Select the item you want to delete.
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2. Click Delete from the Edit menu.

The item is removed from the design.

Combining Drafting Objects
In this section:

• Combining Line and Text Objects

• Exploding Combined Objects

• Uncombining Drafting Objects

Combining Line and Text Objects
You can combine text objects and line objects to form one group. When you combine objects, 
you can select and move them as one item and save it to the library. When you move an object 
that is combined with other objects, all the combined objects move. You can use Combine in the 
Layout Editor and in the Decal Editor.

Procedure

1. Use Shift-click to select the entire drafting shape that you want to combine.

2. When the shape is highlighted, use Ctrl+click to select the text to combine.

3. Right-click and click Combine. You can't combine text objects without including a 
drafting object.

Result

Once you combine objects, selection characteristics change for each object. When you Shift-
click a shape, the whole shape and the text are selected for action. You can reposition the 
combined objects or save them to the library as one unit. If you select the text, however, only 
text is highlighted for editing or repositioning.

You can remove an object from the combination using Uncombine from the shortcut menu. 
You can uncombine the entire combination using Explode from the shortcut menu.

Related Topics

Exploding Combined Objectss

Uncombining Drafting Objects
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Exploding Combined Objects
Use Explode to remove all items from a combined object. Combined objects are made of 
multiple drafting and text objects that were combined using the Combine command. You can 
use Explode in the Layout Editor and in the PCB Decal Editor.

To remove all objects from a combination:

1. Select the combination.

2. Right-click and click Explode.

Related Topics

Combining Line and Text Objects

Uncombining Drafting Objects

Uncombining Drafting Objects
Use Uncombine to remove a single item from a combined object. Combined objects are made of 
multiple drafting and text objects that have been combined with the Combine command. You 
can use Uncombine in the Decal Editor.

To remove any object from a combination:

1. Select the combination.

Tip: To select a combination, select any part of the combination, right-click, and click 
Select Shape.

2. Right-click and click Uncombine.

3. Select the object.

A quicker way to remove a text object from a combination is:

1. Select the text object.

2. Right-click and click Uncombine.

Related Topics

Combining Line and Text Objects

Exploding Combined Objects
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Joining and Closing 2D Lines and Copper 
Shapes

Use Join and Close to connect 2D lines and copper shapes to create single objects that you can 
then change the properties of; for example, you can create a closed 2D line and then change its 
properties to copper pour. 

Tip: These commands are especially useful for after you’ve imported a dxf file.

You can use Join and Close when the line ends are “near enough”: meaning: touching, crossing 
slightly, or perfectly matched. If the lines are not touching or crossed too far, Join and Close 
will not work.

Examples of Near Enough

Join and Close will work on any of the following examples:
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Examples of Not Near Enough

Join and Close will NOT work on either of the following examples:

Limitations

You cannot join or close when the selection includes:

• Objects that are not 2D lines (for example, a keepout)

• 2D Line shapes on different layers

• 2D Lines that are part of a reuse

• 2D Lines that are closed or a circle

• More than one connection available with the same distance
Exception: The connection is available if both ends aren't already connected with a 
smaller distance.

• Shapes that cannot be joined or closed into single shape. For example, you cannot do a 
multiple Join or Close 

In this section:

• Joining 2D Lines and Copper Shapes

• Closing 2D Lines and Copper Shapes

• Breaking an Object

Joining 2D Lines and Copper Shapes
Use Join to connect any 2D lines or copper shapes that are “near enough.”
See: Joining and Closing 2D Lines and Copper Shapes
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Joining two ends is completed in one of two ways:

• If two segments cross near enough to their ends, the two segments are shortened and the 
cross point is the point where they are joined

• If the segments don’t cross, an additional segment is added

Procedure

1. Select the two 2D lines or copper shapes you want to join.
Requirement: The objects must be near enough.

2. Right-click and click Join.

Result

If the command worked, you’ll see “2D Line” in the Status bar. You can now select the entire 
joined object.

If the command did not work, you’ll see the error message: “Join command aborted” in the 
Output Window. 

Closing 2D Lines and Copper Shapes
Use Close to create a closed (and joined) shape that has contiguous lines. The objects must be 
“near enough.”
See: Joining and Closing 2D Lines and Copper Shapes

Procedure

1. Select the 2D lines or copper shapes you want to close.
Requirement: The objects must be near enough.

2. Right-click and click Close.

Result

If the command worked, you’ll see “2D Line” in the Stats bar. You can now select the entire 
closed object.

If the command did not work, you’ll see the error message: “Close command aborted” in the 
Output Window. 

Breaking an Object
Any 2D Line or copper shape that is not a single straight line or a single arc can be broken into 
multiple 2D Lines. The Break command creates a “break point” at every corner of the shape.
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Exception: You cannot break a circle or elements that belong to a reuse.

Procedure

1. Select the object you want to break.

2. Right-click and click Break.

Result

If the command worked, you’ll see “Multiple Selection” in the Stats bar. You can now select 
each segment separately.

Saving a Drafting Item to a Library
Add drafting items to your library so you can reuse them in this design or any other design. All 
of these objects are stored with the Lines filter in the Library.

Procedure

1. Press Shift and select the item to select the whole shape rather than a segment or corner 
of the shape.
Tip: You can select a board outline, 2-D lines, copper objects, keepout objects, and 
dimension objects.

Restriction: You cannot save text alone to the library. Text must be combined with a 
2D line in order to save it to the library.

2. Right-click and click Save to Library.

3. In the Save to Library dialog box, select the library you want, and type the name of the 
item.

4. Click OK.

Result

The drafting item is in the Library. Use the Lines filter in the Library Manager to find the item 
for future use.

Related Topics

Adding Drafting Items from a Library

Adding Drafting Items from a Library
You can add a drafting item into your design from the library.
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Procedure

1. Drafting Toolbar button > From Library button.

2. In the Get Drafting Item from Library dialog box, select an item from a library.
Tip: Use the Library list to view drafting items in all libraries or in a specific library. 
Use wildcards in the Filter to limit the objects that appear in the Drafting Items list.

3. Click OK. The item attaches to your pointer. 

4. Move the item to where you want and click to place the item.

Tips:

• You cannot add a drafting object to a design if the design is in default layer mode and 
the object is in increased layer mode. Use the Layers Setup dialog box to change the 
design to increased layer mode.

• You can place a board outline, copper object, or keepout object from a library only while 
on-line DRC is off.

Related Topics

Saving a Drafting Item to a Library

Changing Trace or Drafting Object Width
There are two methods to change the current width of traces or drafting objects.

1. To change the width of a segment, pin pair, or net once it is routed:

a. Select the item.

b. Right-click and select Properties.

2. To find all traces of a similar width:

a. On the Edit menu click Find.

b. Select the traces, and change them to a new width.

Drawn Line Width
This is the width applied when you begin to draw a shape.

You set the default width of drawn lines differently from that of route widths. Use the Drafting / 
Text and Lines page in the Options dialog box to set the default width for drawn lines. To 
change the width of an existing shape, select the shape and right-click and click Properties. Use 
the Find dialog box to search for and change all lines of a similar width.
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Setting the Pointer Location for Items in the 
Paste Buffer

The default origin for the paste buffer contents is the lower left corner of the area that 
encompasses all information in the buffer. You can set the origin at a specific location.

Procedure

1. Tools menu > Options > Design page.

2. In the Move preference area, click Move by Cursor Location and then click OK.

3. In the design, place the pointer at the new origin location.

4. Select the information to cut or copy and press Ctrl+X (for Cut) or Ctrl+C (for Copy).

5. Press Ctrl+P. The image appears on the pointer with the origin as the point where the 
image was selected.

6. Find the new location and click to place the object.

Selecting Drafting Objects
Drafting objects are made up of the line segment outlines and sometimes fill. At times you want 
to select a segment and at other times you need to select the whole outline with the fill included. 

Selecting Drafting Object Outlines
You select the outlines of a drafting object in order to move the outline to change the shape of 
the object.

1. Right-click and click Select Anything.

2. Click the outline of the Shape.

3. Right-click and click a command to alter the segment as needed.

Selecting Whole Drafting Objects
You select the outlines and fill of a drafting object in order to move the object or change the 
properties of the whole object. There are several ways to select the whole drafting object. 

• With nothing selected, right-click and click Select Shapes. Click the object.

While designing, you may find yourself frequently using the Select Anything filter mode and 
only entering a more specific filter because of design density. Here are some methods to select 
drafting objects in Select Anything mode.
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• Shift-click along the outline of the object.

• Drag a selection box over an outline segment.
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Chapter 26
Cut, Copy, and Paste

In this chapter:

• To Cut Objects

• To Copy Objects

• To Copy a Bitmap

• To Paste Objects

To Cut Objects
Use Cut to remove a selected item from the design and place it into the Windows paste buffer.

1. Select the item you want to cut.

2. Click Cut from the Edit menu.

The item is removed from the design and placed in the Windows paste buffer.

To Copy Objects
Use Copy to place a copy of a selected item from the design into the Windows paste buffer.

1. Select the item you want to copy.

2. Click Copy from the Edit menu.

The item is placed in the Windows paste buffer.

To Copy a Bitmap
You can use Capture Area to define a rectangular area to copy graphics information as a bitmap 
image. Then you can switch to another application, Microsoft Word for example, and use the 
Paste command to insert the bitmap into a document.

To create a bitmap:

1. View menu > Copy as Bitmap.
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2. Area select the area to copy. The area is automatically saved to the Windows copy 
buffer. All items in the rectangle including the background, dot grid, and color, are 
copied.

3. Open the application in which you want to place the bitmap and use the Paste command 
to place the image.

Tip: In addition to generating a bitmap of the defined area, the entire work area is copied as a 
picture that you can insert with the Paste Special command in products that support this feature.

To Paste Objects
Use Paste to place the contents of the Windows paste buffer (what you copies or moved there) 
anywhere on the design. You can also open a different design to paste into. You can paste the 
same copy repeatedly: the copy remains in the buffer until you overwrite it with a new cut or 
copy action.

1. Cut or copy an item to place it in the Windows paste buffer.

2. Click Paste from the Edit menu.

The item is pasted into your design.
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Chapter 27
Clearances and Keepouts

In this chapter:

• To View the Clearance Between Nets

• To View the Clearance Between Items

• To View the Clearance Between a Net and an Item

To View the Clearance Between Nets
Use Net-to-Net Clearance to detect the minimum clearance for specified nets during PCB layout 
design. You can use minimum clearance to spread busses of traces or differential pairs.

To show the minimum clearance between two nets:

1. View menu > Clearance > Net to Net button.

2. To center the minimum clearance marker in the workspace, select Min Clearance.

3. Select two nets. A minimum clearance marker displays the minimum clearance location. 

Tip: If the minimum clearance marker is not visible in the workspace, the minimum clearance 
box remains blank.

To View the Clearance Between Items
Use Item-to-Item clearance to annotate a PCB layout design with dimensioning that indicates 
critical or problem clearances. Annotate your design after you complete layout.

To show the minimum clearance between two items: 

1. Go to the layer on which the items are placed. If you are not on the correct layer, you 
will not get a true clearance.

2. Click Clearance on the View menu. The View Clearance dialog box appears.

3. Click the Item to Item button.

4. Select the two items. Supported item types are pads, vias, jumpers, traces, 2D lines, 
copper, and component outlines.
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Information about the items appears in the Selected Items area of the View Clearance 
dialog box. Line extensions and arrows appear on the design showing the location and 
size of the minimum clearance.

5. To place the dimensions in the design move the pointer to where you want the 
dimensions and right-click. If you do not want the dimensions in the design, press 
Cancel.

Clearances are measured on the current layer. When one or both selected items are not on the 
current layer, the clearance is measured to the centerline of the item that is not on the current 
layer.

To View the Clearance Between a Net and an 
Item

Use Net-to-Item Clearance to detect the minimum clearance for a specified net during PCB 
layout design. You can use minimum clearance to spread busses of traces or differential pairs.

To show the minimum clearance between a net and its surrounding items:

1. View menu > Clearance > Net to Item button

2. To center the minimum clearance marker in the workspace, select Min Clearance.

3. Select a net. A minimum clearance marker displays the minimum clearance location. 

Tip: If the minimum clearance marker is not visible in the workspace, Minimum Clearance 
remains blank.
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Chapter 28
Copper Operations

In this chapter:

• Creating a Copper Shape

• Creating Copper Chamfered Paths

• Setting Chamfered Path Parameters

• Bridging Nets with Copper

• Assigning a Unique Netname to a Copper, Copper Pour, or Plane Area

• Creating a Copper Cut Out

Creating a Copper Shape
Copper is used, for example, as heat sinks, shielding, or bridging nets. Nets can be assigned to 
copper shapes.

Requirements

• Ensure you select a layer for placement of the copper. You cannot create a copper shape 
on all layers (layer number zero). If you need the same copper shape on many layers, 
copy the shape to other layers.

• Copper must be created with On-Line Design Rule Checking in the Off mode since 
copper objects cover any and all other electrical objects. If you need a copper shape that 
avoids objects other than the net to which it is assigned, use the copper pour feature. See 
also: Creating a Copper Pour Area.

Procedure

1. Click the Copper button from the Drafting toolbar.

2. Right-click and click a command to change the values of the drafting object. See also: 
Setting Values Before Creating a Drafting Object.

3. Create the shape using one of the following:

• Creating a Circle Drafting Object

• Creating a Polygon or Path Drafting Object

• Creating a Rectangle Drafting Object
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4. Once you complete the shape, it becomes a filled shape, and the Add Drafting Properties 
dialog box appears. 

5. In the Add Drafting properties dialog box, you can make changes to the copper 
properties.

• For example, in the Net Assignment area, you can assign a net by selecting the net 
name in the Net list or you can click the Assign Net by Click button and click a 
design object attached to the net. See also: Modifying Drafting Object Properties.

Result

Is the resulting shape what you expected?

• If the fill is not correct, see The Fill of Copper, Copper Pour and Plane Shapes.

• If the shape edges are not correct, see Edge Precision of Drafting Shapes.

• If the shape needs to be modified, see Modifying Drafting Object Properties.

• If you want to start over, see Deleting a Drafting Segment or Object.

Related Topics

Creating a Copper Cut Out

Assigning Existing Copper to a Net

Routing To and From a Copper Shape

Creating Copper in the Decal

Bridging Nets with Copper

Creating Copper Chamfered Paths
Because some designs, for example RF designs, require specialized trace corner geometries, 
you can add chamfered copper to your design as an alternative for regular traces. Using 
Chamfered Path, orthogonal corners are square or chamfered, wide angle corners can be 
chamfered, and acute corners are chamfered. And since copper is created with an outline and a 
fill, you can specify a very narrow outline width to achieve very sharp corners. All Chamfered 
Paths are created with a Solid Copper fill. 

Restriction: This feature requires the Advanced Editing/RF license option.

1. Drafting Toolbar > Copper button.

• If you have Online Design Rule Checking enabled, in the prompt that appears, click 
OK to switch off Design Rule Checking.

2. Right-click and click Chamfered Path.
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3. In the Add Chamfered Path dialog box, set the Chamfered Path Parameters and then 
click OK.

4. Click to start the copper.

5. Move the pointer, then do one of the following:

• Click to place a corner.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the next corner.

• Type SR<x>, <y> if you want to specify relative coordinate values.

Tip: Right-click and click Add Arc to add an arc instead of a straight-line segment.

6. Continue adding copper and corners as necessary.

7. To back up and remove the last corner, press BackSpace.

8. To cancel the operation, press Esc.

9. To end the copper, either double-click or right-click and click Complete.

10. In the Properties dialog box, you can assign a net and modify other settings.

Tip: If you create a chamfered path pin pair, unroutes will update when you add the 
copper in the same way as a trace is placed between pads - from and to the center (or Pin 
Position) of the pads and when you assign the net to the copper. You can also convert 
traces to chamfered copper paths which automatically assigns the net and unroutes 
would also update with the original trace connection. See Converting a Trace to a 
Copper Chamfered Path.

Exception: The chamfered path does not appear as the correct width if the Minimum display 
width option for the design is larger than the Polygon outline width of the path. The path 
appears more narrow by the value of the Polygon outline width.

Related Topics

Setting Chamfered Path Parameters

Restoring Traces After Conversion to Copper Chamfered Paths

Setting Chamfered Path Parameters
The Add Chamfered Path dialog box opens upon selection of the Chamfered Path - copper 
shape. You set Chamfered Path parameters before you add the copper to the design.

1. In the Polygon outline width box, type a width value for the copper outline.

Tip: Since copper is created with an outline and a fill, you can specify a very narrow 
outline width to achieve very sharp corners. Decrease the value for sharper corners and 
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increase the value for more blunt corners. All corners are rounded with a radius equal to 
one half of the outline width.

2. In the Chamfered path width box, type a width value for the overall width of the copper 
path.

3. In the Corner chamfer width ratio box, type a value specifying the ratio of the chamfered 
corner width to the chamfered path width. If the ratio is 1.0, the width of the chamfered 
corner is the same as the chamfered path. Reduce the ratio for a more narrow chamfered 
corner.

4. Clear the Chamfer corners with angles less than or equal to check box to only 
chamfer angles less than 90 degrees.
or
Select the Chamfer corners with angles less than or equal to check box to specify an 
angle between 90 and 180 degrees as the upper limit beneath which all angles are 
chamfered. Outside corners less than 90 degrees are always chamfered.

5. Click OK.

Bridging Nets with Copper
You can create a physical connection between objects of two different nets with design rule 
checking enabled.

Restrictions

• You can not create bridge copper in the decal.

• Bridge copper saved to the library loses its bridge status.

Procedure

1. Use one the following methods.

• If the copper already exists, select the copper shape, and then right-click and click 
Properties.

• If the copper doesn’t already exist, Create the copper shape.

2. In the Add Drafting or Drafting Properties dialog box, select the Bridge check box.

3. Click the Nets to bridge button.

4. In the Net Association dialog box, add two or more nets to bridge from the Available 
nets list.

5. Click OK in the Net Associations dialog box.

6. Click OK in the Add Drafting dialog box.
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Results

You can use this copper to bridge objects of the assigned nets without getting an online design 
rule checking error.

When you run a connectivity check, it will only report an error if no physical connection exists 
between the bridge copper and a net associated to it.

When you run a clearance check, it will only report an error if you use any non bridge-copper 
object to bridge the nets. This is also prevented by online DRC.

Tip: You can use the Find dialog box to search for Nets with bridges. Results display the nets 
and list the bridge coppers associated with them.

Restriction: You can copy bridge coppers and they retain their bridge status, but their net 
associations are removed. See also: Copying Bridge Copper in ECO Mode

Warning: Bridged nets are combined when you export the design into the .hyp (HyperLynx), 
.ipc (IPC356), and .tgz (ODB++) file formats.

Assigning a Unique Netname to a Copper, 
Copper Pour, or Plane Area

You can assign a unique netname to a copper, copper pour or plane area., which lets you assign 
rules and properties to the copper shape independently of the netlist.

Procedure

1. Select a shape > right-click > Add Net.

2. To specify a custom netname, click Typed New Name and type the netname in the 
Name of New Net box.

Alternative: Click Autogenerated New Name to use the default netname.

Result: The new name is added to the netlist.

Tips:

• The maximum netname length is 47 characters. You can use any alphanumeric 
characters except braces { }, asterisks *, spaces, question marks, or commas.

• Because this action does not affect the schematic logic, the new netname is not recorded 
as an ECO operation.

• To assign an existing netname to a selected copper shape, use the Drafting Properties 
dialog box.
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Related Topics

Creating a Copper Pour Area

To Find By Pour Area and Isolated Pour

Flooding a Copper Pour Area

Assigning Copper to a Net

Creating a Copper Cut Out
Copper cut outs are used for creating cut outs or voids inside copper shapes. Creating a cut out 
involves combining the fixed copper shape with the copper cut out.

Restriction: A cut out does not create a void in the outline of the copper shape. Create the cut 
out as a polygon shape to create features in the outline. 

Requirement

• You must put the cut out on the same layer as the copper.

Procedure

You can create the cut out before the copper or the copper before the cut out.

1. Drafting Toolbar > Copper Cut Out button.

2. Create one or more cut out areas for the copper. See Creating a Drafting Object for more 
information.

3. Set the selection filter to select shapes by right-clicking and clicking Select Shapes.

Tip: If you cannot see a cut out within the copper shape, use the Drafting tab in the 
Options dialog box to set the hatch view to No Hatch. See the Hatch options on the 
Drafting / Hatch and Flood page of the Options dialog box.

4. Drag a box to group-select the copper and cut out(s).

Alternative: Some circumstances don’t allow for dragging a group selection box. 
Instead, click to select the cut out. Typically, the copper is selected first. Click the Cycle 
button to cycle to selecting the cut out. If you have multiple cut outs, use Ctrl+click to 
select the copper then click the Cycle button to select another cut out. As you select 
additional cut outs, previous cut outs do not retain the selection color but remain 
selected. Finally, Ctrl+click to select the copper.

5. Right-click and click Combine. Copper inside the cut out area is automatically 
removed.

Result

Is the result what you expected?
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• Do you need to move or edit a cut out? You’ll need to uncombine it first. See 
Uncombining Drafting Objects.

• Do you need to move or edit the copper? Any modifications you make to the copper 
shape (move, rotate, miter, etc.,) also affect the combined cut out(s).

Creating Nested Copper
You can create a copper shape within another, “outer”, copper shape. To do this, you create a 
copper cut out inside the outer shape, combine it with the outer shape, and then create the new 
nested copper shape inside the copper cutout.

Procedure

1. In the outer copper shape, Create a copper cut out of appropriate size and shape, and 
combine it with the outer shape.

2. Create the new nested copper shape within the copper cut out.

Results

You should see the new nested copper shape inside the cut out in the outer shape.
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Chapter 29
Copper Pour Operations

In this chapter:

• Customizing Design Rule Thermals

• Customizing Design Rule Antipads of Copper Pours

• Creating a Copper Pour Area

• Creating a Copper Pour Area Cut Out

• Creating Nested Copper Pour Areas

• Assigning Copper to a Net

• Assigning Copper to a Net

Customizing Design Rule Thermals
You can customize the default thermals that are created on pins and vias within copper pour 
areas and plane areas. Default thermals are created based upon the Thermals Options for spoke 
settings and the Copper-to-Pad or Copper-to-Via clearance rule value for the clearance between 
the pin pad or via pad and the copper.

Restriction

Default thermals are the only thermals available to copper pour areas. Plane areas can also use 
custom thermals created in pin or via pad stacks.

Procedure

1. Open the Thermals Options. There are separate settings for Drilled (Through-hole) and 
Non-Drilled (surface mount) pads.

2. Set the width of the spokes in the Width box.

3. Set the minimum allowed number of spokes in the Min. spoke box.

4. For each pad shape, set the orientation of the spokes. 

Tip: If you only want to flood over vias, you can enable an option in the properties of 
the copper pour or plane area. See Flood and Hatch Options Dialog Box for the Flood 
over vias check box.
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5. If you want to allow routed pads to also have thermal connections, select the Routed pad 
thermals check box.

Restriction: This option applies only to copper pour areas and not to plane areas.

6. Open the Design Rules. In any applicable level of the hierarchy of the design rules, in 
the Clearance rules, set the Copper-to-Pad and Copper-to-Via value according to the 
needs of your design.

Results

• Once you fill the copper pour or plane area, a therm.err report is generated if any pads 
receive fewer spokes than the Min. spoke value. For example, if the pad intersects the 
boundary of a copper pour, it may not be possible to create all four spokes.

• Did a pad not receive a thermal even though the Routed pad thermals option wasn’t 
enabled? Use the Selection Filter to check for trace stubs at the pad. Small left-over trace 
segments attached to a pad prevent a pad from receiving thermals if the Routed Pad 
Thermals option is not enabled. Set the Selection Filter to Traces, Corners, and Tacks to 
select and remove trace segments attached to the pad.

Related Topics

Design Rule Hierarchy

Customizing Design Rule Antipads of Copper Pours

Customizing Design Rule Antipads of Copper 
Pours

You can customize the default antipads that are created around pins, vias, or drill holes within 
copper pour areas. Default antipads are created based upon the Copper-to-Pad, Copper-to-Via, 
or Copper-to-Drill clearance rule value. You can apply the clearance rule value to either the net 
of the copper or the net of the pad/via or both - unless the pin is a no-connect. You can use the 
clearance rules at any level of the rules hierarchy.

Restriction

The antipads created in copper pour areas do not remove the unused pads. Plane areas are 
capable of automatically removing the unused pads.

Procedure

• Open the Design Rules. In any applicable level of the hierarchy of the design rules, in 
the Clearance rules, set the Copper-to-Pad, Copper-to-Via, and Copper-to-Drill values 
according to the needs of your design.
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Example

By applying the clearance to the net of the copper rather than the pads, you can affect all pads 
vias and drills within the copper pour area. But by applying the clearance to the net of pads and 
vias rather than the copper, you can achieve different antipad spacings. Or you can use a 
combination - apply a general minimum clearance to the net of the copper pour and apply a 
larger clearance to nets of objects that need larger antipads.

Results

• When you’re dealing with antipads, there are two nets involved. If you’re not getting the 
results you expect, ensure that the clearance values of the other net involved aren’t 
conflicting with the values you’ve already changed. Larger clearance values always 
have precedence.

• With through hole pins and vias, the copper-to-drill value also applies. Although this 
clearance value will typically be less than the value of copper-to-pad or copper-to-via, it 
can still take precedence if it is larger.

Related Topics

Customizing Design Rule Thermals

Design Rule Hierarchy

Creating a Copper Pour Area
Use copper pour to create a copper area that avoids objects not connected to net assigned to the 
pour, but makes thermal connections to objects that are connected to that net. 

Poured copper provides a plane of connectivity that is insulated from traces or pins that do not 
share the netname. You can flood a copper pour outline to create isolation areas around 
intersecting pins and traces automatically. Fixed copper is used for electrical items not found in 
traces or pads. PADS Layout does not automatically create isolation areas around intersecting 
pins and traces.

See Also: Differences Between Copper, Copper Pour, and Plane Areas.

Procedure

1. Click the Copper Pour button from the Drafting toolbar.

2. Right-click and click a command to change the values of the drafting object. See also: 
Setting Values Before Creating a Drafting Object.

3. Create the shape using one of the following:

• Creating a Circle Drafting Object
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• Creating a Polygon or Path Drafting Object

• Creating a Rectangle Drafting Object

4. In the Add Drafting properties dialog box that appears:

a. Assign a net by selecting the net name in the Net list; or you can click the Assign Net 
by Click button and click a design object attached to the net. 

b. Make any other appropriate changes to the copper pour properties.

5. Click OK.

6. Flood the copper pour.

Result

Is the resulting shape what you expected?

• If the gap between the pad and the copper for thermals or antipads is incorrect, see 
Customizing Design Rule Thermals or Customizing Design Rule Antipads of Copper 
Pours

• If the fill is not correct, see The Fill of Copper, Copper Pour and Plane Shapes.

• If the shape edges are not correct, see Edge Precision of Drafting Shapes.

• If the shape needs to be modified, see Modifying Drafting Object Properties.

• If you want to start over, see Deleting a Drafting Segment or Object.

Related Topics

Creating a Copper Pour Area Cut Out

To Find By Pour Area and Isolated Pour

Assigning Copper to a Net

Creating a Copper Pour Area Cut Out
Copper pour cut outs are used for creating cut outs or voids inside copper pour areas. Creating a 
cut out involves combining the copper pour shape with the copper pour cut out shape.

Restriction: A cut out does not create a void in the outline of the copper pour area. Create the 
outline as a polygon shape to create features in the outline. 

Requirement

• You must put the cut out on the same layer as the copper pour area.

Procedure

You can create the cut out before the copper pour or the copper pour before the cut out.
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1. Drafting Toolbar > Copper Pour Cut Out button.

2. Create one or more cut out areas for the copper pour. See Creating a Drafting Object for 
more information.

3. Set the selection filter to select shapes by right-clicking and clicking Select Shapes.

Tip: If you cannot see a cut out within the copper pour shape because the shape is 
flooded, type the modeless command PO to return the copper pour area to pour outline 
display mode. You will need to re-flood the plane once you’ve combined the cut out 
with the copper pour area.

4. Drag a box to group-select the copper pour and cut out(s).

Alternative: Some circumstances don’t allow for dragging a group selection box. 
Instead, use Ctrl+click to select the copper pour and the cut out.

5. Right-click and click Combine. 

6. Flood the copper pour. Copper pour inside the cut out area is automatically removed.

Result

Is the result what you expected?

• Do you need to move or edit the copper pour or the cut out? Any modifications you 
make to the copper shape (move, rotate, miter, etc.,) also affect the combined cut out(s). 
You’ll need to uncombine it first. See Uncombining Drafting Objects.

Creating Nested Copper Pour Areas
You can create a copper pour area within another, “outer”, copper pour area. To do this, you 
create a copper pour cut out inside the outer area, combine it with the outer copper pour, and 
then create the new nested copper pour are inside the copper pour cut out.

Procedure

1. In the outer copper pour area, Create a copper pour area cut out of appropriate size and 
shape, and combine it with the outer pour area.

2. Create the new nested copper pour area within the copper pour cut out.

Results

You should see the new nested copper shape inside the cut out in the outer shape.

Assigning Copper to a Net
You can assign copper to a net by using any of the following methods:
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• Assigning existing copper to a net

• Assigning existing copper to a different net

• Assigning new copper to a net, before starting drafting

• Assigning new copper to a net, before completing drafting

Warning: Moving a copper assigned to a net to a non-electrical layer removes the net 
connection from the copper. Place the copper on an electrical layer to reassign the net 
connection.

Assigning Existing Copper to a Net
To assign existing copper to a net: 

1. Create the copper shape or create the pour on a specific routing layer.

2. Select one or more coppers, right-click, and then click Assign Net By Click.

Tip: If any of the coppers has already been assigned to a net, Assign Net By Click is 
unavailable.

3. Click a design object, such as a pin, via, trace, net, copper, or unroute, with the netname 
you want to assign to the copper.

Result: The status bar displays the netname assigned to the copper.

Assigning Existing Copper to a Different Net
To assign existing copper to a different net:

1. Select one or more coppers, right-click, and then click Properties.

2. Click the Assign Net By Click button, and then click a pin, via, trace, net, copper, or 
unroute, with the netname you want to assign to the copper.

Alternative: In the Net list, select a net.

3. Click OK.

Assigning New Copper to a Net Before Starting Drafting
To assign new copper to a net, before starting drafting:

1. Select a single design object, such as a pin, via, trace, net, copper, or unroute, on the net 
you want to assign to the copper.

2. Right-click, and then click Add Copper Area or Add Copper Pour.
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Tip: If you select multiple design objects, Add Copper Area and Add Copper Pour are 
unavailable.

3. Create the copper shape or create the pour on a specific routing layer.

Result: The copper inherits the netname from the selected object.

Assigning New Copper to a Net Before Completing 
Drafting

To assign new copper to a net, before completing drafting:

1. Begin creating the copper shape or creating the pour on a specific routing layer.

2. Right-click and click Complete. The Add Drafting dialog box appears.

Tip: If you do not want the Add Drafting dialog box to appear when completing the 
copper, clear the Prompt for Net Name at Completion of Copper check box on the 
Drafting / Hatch and Flood page on the Options dialog box.

3. Click the Assign Net By Click button, and then click a pin, via, trace, net, copper, or 
unroute, with the netname you want to assign to the copper.

Alternative: In the Net list, select a net.

4. Click OK.
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Chapter 30
Plane Operations

In this chapter:

• Creating a Plane Area

• Customizing Design Rule Antipads of Plane Areas

• To Associate a Net to a Plane Area

• Assigning Nets to Split/Mixed Plane Layers

• Controlling the Display of Thermals in Plane Areas

• System-prompted Plane Area Filling

• Troubleshooting Plane Area Fills

• Troubleshooting Thermal Results

• Creating Split Planes

• Automatically Separating Plane Areas

• To Create an Embedded Plane

• Creating a Plane Area Cut Out

• Assigning Plane Thermal Attributes

• To Create Flood-over Pads

• Discarding Plane Data on Save

• Displaying Connections for Pads Connected to a Plane

• Converting Old Designs to Split Plane Designs

Creating a Plane Area
A plane area is a closed, non-self-intersecting polygon that provides access to universally 
necessary nets, like power and ground. One design may use several plane areas. Planes are 
usually located on inner layers that are dedicated to the plane only, although you can place them 
on outer layers. The plane area can occupy all or part of the layer it is on. Two or more partial 
planes can occupy one layer, each servicing a different net. These are called split planes.
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Plane areas defined with Copper Pour may have insulated traces and vias passing across the 
plane area, as long as the traces do not divide the plane to break connectivity.

You can create plane areas manually using the drafting tools or automatically using Create 
Plane Area, using the board outline as a guide. After identifying a layer as a split/mixed plane 
layer and assigning nets to the plane, you can add plane areas.

See also: Differences Between Copper, Copper Pour, and Plane Areas, and Split Planes in the 
Concepts Guide.

Restriction

You can only create a plane area on a layer set as a split/mixed plane layer and the net you want 
to assign to the shape must also be assigned to the layer.in the Layers Setup dialog box.

To Manually Create a Plane Area
You create plane areas the same way you create 2D paths with the drafting tools: define each 
corner of the area. To manually create a plane area using the Plane Area button from the 
Drafting toolbar:

1. Set the active layer to a split/mixed plane layer in the Layer list on the toolbar.

2. Click the Plane Area button from the Drafting toolbar.

3. Click to indicate a starting location for the plane area.

4. Continue indicating corners to define the plane.

5. Double-click the starting location again to create a closed area.

To Automatically Create a Plane Area
You can create a plane area by copying the shape of the board outline. A shape is generated 
proportionally smaller than the outline and includes miters or small notches existing in the 
board outline. To automatically create a plane area using the board outline as a guide:

1. Set the active layer to a split/mixed plane layer in the Layer list on the toolbar. 

2. Select the board outline.

3. Right-click and click Create Plane Area. 

4. Click a net to associate with the plane area in the Assigned Net to Selected Polygon 
dialog box. You can also click None and associate a net later. 

You can create plane area polygons for assigned nets when assigning or you can wait 
until later. If you create them when assigning, pads associated with these nets will get 
thermal indicators if they are inside the appropriate polygons.
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Tip: When you use Create Plane Area, you can receive an error message indicating a self-
intersecting polygon. The generated plane area is proportionally smaller than the outline. Small 
miters and/or notches in the board outline can be impossible to create smaller using the 
specified line width. This error can be corrected most often by reducing the distance between 
the board outline and the plane. Type a larger gap for the Auto Separate Gap setting in the 
Split/Mixed Plane tab of Options. Alternatively, you can use a smaller line width for the plane 
area. This is not preferred since you also need to reduce the copper hatch grid to match in order 
to maintain a solid fill for the plane. Generating more fill lines consumes more memory and 
could slow operations if the line width is greatly reduced.

Customizing Design Rule Antipads of Plane 
Areas

You can customize the default antipads that are created around pins, vias, or drill holes within 
plane areas. Default antipads are created based upon the Copper-to-Pad, Copper-to-Via, or 
Copper-to-Drill clearance rule value for the clearance between the pin pad, via pad, or drill hole 
and the copper. You can apply the clearance value to either the net of the plane or the net of the 
pad/via.

Procedure

• Open the Design Rules. In any applicable level of the hierarchy of the design rules, in 
the Clearance rules, set the Copper-to-Pad, Copper-to-Via, and Copper-to-Drill values 
according to the needs of your design.

Example

By applying the clearance to the net of the plane rather than the pads, you can affect all pads, 
vias, and drills within the plane area. But by applying the clearance to the net of pads and vias 
rather than the plane, you can achieve different antipad spacings. Or you can use a combination 
- apply a general minimum clearance to the net of the plane and apply a larger clearance to nets 
of objects that need larger antipads.

Results

• When you’re dealing with antipads, there are two nets involved. If you’re not getting the 
results you expect, ensure that the clearance values of the other net involved aren’t 
conflicting with the values you’ve already changed. Larger clearance values always 
have precedence.

• With through hole pins and vias, the copper-to-drill value also applies. Although this 
clearance value will typically be less than the value of copper-to-pad or copper-to-via, it 
could still take precedence if it was larger.

• The Split/Mixed Plane options Remove unused pads and Use design rules for thermals 
and antipads both affect the clearance of the antipad.
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Related Topics

Customizing Design Rule Thermals

To Associate a Net to a Plane Area
Use the Net Properties dialog box to associate a net to a plane if:

• You created a plane area before you assigned nets to the plane in the Layer Setup dialog 
box.

• You chose None from the Assign Net to Selected Polygon dialog box when you split a 
plane area.

• You want to associate a different net to a plane area.

To Associate a net to a plane area:

1. Select the plane area outline.

2. Right-click and click Properties.

3. Click a net from the Net list.

4. Click OK.

Assigning Nets to Split/Mixed Plane Layers
Use Assign Nets in the Layers Setup dialog box to assign one or more nets to the split/mixed 
plane.

1. Setup menu > Layer Definition > select a split/mixed plane layer > Assign Nets button.

2. Select a net from the All Nets list.

3. Click Add to move the net to the Assigned Nets list box.

4. Repeat Steps 2 and 3 to associate additional nets.

5. Click OK to close Plane Layer Nets dialog box.

6. Click OK to close the Layer Setup dialog box. 

You can create plane area polygons for assigned nets when assigning or you can wait until later. 
If you create them when assigning, pads associated with these nets will get thermal indicators if 
they are inside the appropriate polygons.

You can assign a net to as many layers as required.
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Related Topics

Creating a Plane Area

Creating Split Planes

Controlling the Display of Thermals in Plane 
Areas

Use the Split/Mixed Plane page in the Options dialog box to control the display of thermal 
information. You can display all thermal information to view the plane in a flooded state or just 
display the thermal indicators. 

See also: Assigning Plane Thermal Attributes

Use the Active Layer Comes to Front check box in the Global / General page to view more 
detail for the thermal and antipad clearances. When this check box is on, a small outline in the 
shape of the pad or via is visible when the current layer is a split/mixed plane layer. If the 
thermal display properties are correctly set, thermal graphics appear at all pins and vias 
belonging to the plane net.

System-prompted Plane Area Filling
There are times when the system will prompt you to fill a plane area.

Verify Design

When you use Tools menu > Verify Design and you perform a Plane Check and select the 
Check clearance and connectivity option in the Setup, it checks for proper setup, creates the 
plane area (if only one net is assigned), if necessary; and prompts to fill the plane automatically. 

See also: Verify the Design

Run CAM

When you run CAM on a split/mixed plane layer, it checks for proper setup; creates the plane 
area if necessary; and prompts to fill the plane automatically. 

See also: Creating the Outputs

Troubleshooting Plane Area Fills
The following situations can prevent a plane area from filling.

1. No pads of the assigned net are located within the plane area. Ensure that at least one 
pad of the net assigned to the plane area is within the shape.
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2. No drilled pads are located within the plane area. Typically, the default for non-drilled 
pads is to not have the Plane Thermal property enabled. Enable the Plane Thermal 
property for non-drilled pads to allow them to connect to the plane with thermals. Select 
the pad(s), right-click and click Properties. In the Pin Properties dialog box, select the 
Plane Thermal check box. This causes the system to re-check which pins should get 
plane thermals based on the layers and nets.

3. No pads or vias located within the plane area have the Plane Thermal property enabled. 
Enable the Plane Thermal property for pads and vias to allow them to connect to the 
plane with thermals. Select the pad(s), right-click and click Properties. In the Pin 
Properties dialog box, select the Plane Thermal check box. This causes the system to re-
check which pins and vias should get plane thermals based on the layers and nets. 
Repeat the process for the via(s).

4. The layer on which you created the plane is not defined as a Split/Mixed plane layer 
and/or the net you assigned to the plane area is not a net assigned to that layer. Ensure 
the Layer is defined as a Split/Mixed plane layer, and assign the net to the layer.

5. No plane area is defined. Ensure you can see the outline of the plane.

6. Multiple plane areas are intersecting or defined on top of each other. One of the planes 
must take priority and you must create a cutout of the other plane. You might benefit 
from enabling the Create cutouts around embedded planes option found on the Tools 
menu > Options > Split/Mixed Plane page. For information about giving a plane a flood 
priority, see the Flood Priority setting in the Flood and Hatch Options dialog box. The 
Flood Priority numbers should be lowest for inner nested planes and greatest for the 
outer planes.

7. You’ve modified the plane outline while the plane area is filled. Return the plane area to 
the basic plane outline using the modeless command SPO before modifying the shape of 
the outline.

8. You have embedded/nested planes. You must create the largest plane first, then the 
smaller inner plane(s) next. (As long as you select the Tools menu > Options > 
Split/Mixed Plane tab > Create cutouts around embedded planes check box, this 
automatically assigns the correct flood priority and creates the required plane area cutout 
within the larger split plane.)
If you neglected to select the Create cutouts around embedded planes option or you 
simply created the inner plane area first, the plane areas have conflicting flood priority 
values and are unable to fill. You must decide the order in which the plane areas should 
be filled and adjust their flood priorities accordingly. For information about giving a 
plane a flood priority, see the Flood Priority setting the Flood and Hatch Options dialog 
box. If you have only one inner plane, there is a quicker way to give it the higher flood 
priority. Use the SPO modeless command to return the plane to outline mode. Select the 
plane area shape, right-click and click Bring to Front. The system recognizes the new 
flood priority and fills the plane areas.
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9. You created the plane area with the copper pour tool. You must create plane areas with 
the Plane Area tool.

10. Traces or pins block the fill from connecting with any pads of the same net. You must 
free up space for the fill at the current width and grid setting to flow and contact at least 
one pad of the same net with thermals.

11. Your minimum hatch area setting is too large. In the Drafting Options, check the 'Min. 
Hatch Area' and ensure the value entered is not larger than the plane area size.

12. Your keepout is restricting the plane area. Assign a color to Keepouts for all layers and 
ensure they do not restrict copper pour and plane areas for the location and layer.

13. You’ve hidden the fill. Ensure the fill is visible. In the Drafting Options, in the Hatch 
View area, click Normal instead of No Hatch.

14. You’ve set Thermal options to no connect. Ensure that drilled and non-drilled pads have 
orthogonal, diagonal, or flood over settings in the Thermals Options.

15. You’ve already routed to all available pads of the same net located within the plane area. 
If nets of the same name as the pour or plane are already routed, ensure that the Routed 
Pad Thermals check box is selected in the Thermals Options.

16. The plane area is defined on a non split/mixed layer. Ensure the plane area is located on 
a split/mixed layer.

Tip: The preferred method for flooding Split Planes is to use the Plane Connect tab of the Pour 
Manager.

Troubleshooting Thermal Results
When you fill (flood/pour) a Plane area, a Thermal Relief Errors Report (therm.err) might 
appear in your default text editor. This file appears when pads within the plane area did not 
receive the minimum number of spokes according to your Tools menu > Options > Thermals 
tab settings.

The Thermal Relief Errors Report

Report sections state whether there is less than 100% or even 50% thermal extensions. Below 
each section there is a listing of the reference designator with pin number (if a component pad), 
pad coordinate location and the actual number of thermal spokes that were generated. For 
example:

Drilled pads with
less than 50% thermal extensions

Report of Thermal Spokes Generator

On Primary Component Side:

J1.5 (455, 650) # = 2
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This indicates that pin 5 of reference designator J1, at coordinates 455, 650 has only 2 thermal 
spokes that were generated. The required thermal spokes for this would be 4 or more. There 
could be a variety of reasons why the number of thermal spokes is reduced such as a clearance 
issue where as a trace is too close to a pad, or the copper pour or plane area outline width and 
hatch grid are too large for the copper to flood between the component pins, etc.

Interpreting Thermal Results

• If a large number of pads and/or vias have zero thermal spokes being generated, there 
may be a plane area that is not filling. See Troubleshooting Plane Area Fills.

• If there are only a few pads or vias that have zero thermal spokes and yet there is no 
obvious obstruction to their creation, you might have a situation where those pads or 
vias do not have the Plane Thermal property enabled. Enable the Plane Thermal 
property for those pads and vias to allow them to connect to the plane with thermals. 
Select the pad(s), right-click and click Properties. In the Pin Properties dialog box, select 
the Plane Thermal check box. This causes the system to re-check which pins and vias 
should get plane thermals based on the layers and nets. Repeat the process for the via(s).

Creating Split Planes
You can create more than one plane area on a split/mixed plane layer. There are three 
recommended methods to split a plane:

• Create multiple plane areas.
See also: Creating a Plane Area

• Use the Auto Plane Separate tool to split a plane that covers the whole layer or a large 
area into two or more plane areas.
See also: Automatically Separating Plane Areas

• Embed a plane area within another plane area.
See also: To Create an Embedded Plane

Automatically Separating Plane Areas
Use the Auto Separate button to divide a plane area into two new plane areas. Using Auto 
Separate, you draw a path from one side of a plane area to another side of the same area. This 
path defines the center of the separation between the two new plane areas and divides the plane 
area into two distinct shapes.

Use the Auto Separate Gap option in the Split/Mixed Plane page to define the distance between 
the two planes.
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Requirements

• You must start and end the separation within the same plane area polygon.

• You must have multiple nets assigned to the Split/Mixed Plane layer.

Procedure

1. On the Standard toolbar in the Layer list, click a split/mixed plane layer.

2. Use one of the following:

• For object mode, right-click and click Select Anything. Select the starting point of 
the split on a segment of the plane area. Right-click and click Auto Separate.

• For verb mode, on the Standard toolbar, click the Drafting toolbar button. On the 
Drafting toolbar, click the Auto Separate button. Click to indicate a starting 
location somewhere on the perimeter of the plane area polygon.

3. Click to indicate corners, if any, to define the line of separation.

4. Double-click at the ending point on the plane area outline to complete the Auto Separate 
command. The Assign Net to Selected Polygon dialog box appears and automatically 
selects one of the new plane areas.

5. Click a net to assign to the selected plane from the Choose Existing Net area. This 
assigns the net, deselects the plane area, and selects the other area. Click a net for the 
other area. This assigns the net, deselects the plane area and closes the dialog box.

Tips:

• You must have at least two corners each lying on an edge of the polygon or the message 
“Too few corners” appears.

• No corners of the auto-separate path may be outside of the polygon or the message “All 
corners must be within the plane area polygon” appears.

• No segments of the auto-separate path may be outside of the polygon or the message 
“All segments must be within the plane area polygon” appears.

• If the message “Can't shrink polygon #1” or “Can't shrink polygon #2” appears, reduce 
each of the new polygons by one-half of the line width. An error occurred during this 
operation (probably self-intersection).

To Create an Embedded Plane
You can embed planes (or create a plane area within another plane area) using one of the 
following methods:
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• Work from the outermost area to the innermost area. This ensures that all the areas will 
flood as expected.

a. Create the outermost plane area by drawing a plane area as described in “Creating a 
Plane Area.”

b. Create the inner plane area using the Plane Area button in the Drafting toolbar. 

c. Continue nesting plane areas until you define all the embedded planes for the layer.

Tip: The embedded planes are automatically brought to the front so they are flooded 
correctly. To assign different flood priorities, see the Flood and Hatch Options dialog 
box.

• If the innermost planes were drawn before the outmost plane areas, correct flooding is 
not ensured. You must assign flood priorities and then create plane area cut outs around 
the perimeter of all embedded planes. You must also combine these cut outs with the 
outer plane area.

The following steps ensure correct plane flooding:

a. Select the embedded plane, right-click and click Bring to front.

b. Create a plane area cut out on the outside perimeter of all embedded plane areas.

See also: Creating a Plane Area Cut Out

c. Select the Cut out polygon shape.

d. Press Ctrl and select the next outer plane area.

e. Right-click and click Combine.

Creating a Plane Area Cut Out
A plane cut out is a closed, non-self-intersecting polygon that defines a void within a plane area. 
Creating a cut out involves combining the plane area shape with the plane area cut out shape.

Restriction: A cut out does not create a void in the outline of the plane area. Create the outline 
as a polygon shape to create features in the outline. 

Requirement

• You must put the cut out on the same layer as the plane area.

Procedure

You can create the cut out before the plane area or the plane area before the cut out.

1. Drafting Toolbar > Plane Area Cut Out button.
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2. Create one or more cut out areas for the plane. See Creating a Drafting Object for more 
information.

3. Set the selection filter to select shapes by right-clicking and clicking Select Shapes.

Tip: If you cannot see a cut out within the plane shape because the shape is flooded, 
type the modeless command SPO to return the plane area to plane polygon display 
mode. You will need to re-flood the plane once you’ve combined the cut out with the 
plane area.

4. Drag a box to group-select the plane and cut out(s).

Alternative: Some circumstances don’t allow for dragging a group selection box. 
Instead, use Ctrl+click to select the plane area and the cut out.

5. Right-click and click Combine. 

6. Flood the plane area. The plane area inside the cut out area is automatically removed.

Result

Is the result what you expected?

• Do you need to move or edit the plane area or the cut out? Any modifications you make 
to the plane shape (move, rotate, miter, etc.,) also affect the combined cut out(s). You’ll 
need to uncombine it first. See Uncombining Drafting Objects.

Assigning Plane Thermal Attributes
When you specify a layer as a split/mixed plane layer, all pad stacks in the design are 
automatically assigned a thermal setting. Use the Plane Thermal check box in the Pin 
Properties, Via Properties, and Jumper Pin Properties dialog boxes to determine whether the pad 
stack is an eligible thermal candidate. Turn the Plane Thermal check box off if you don't want 
any type of thermal relief on any layer of the pad stack.

Tips:

• The plane thermal attribute for pads determines whether or not a pad on a plane is a 
candidate for a thermal. Unroutes are not used for this purpose for split/mixed planes. 
Each pad has a separate thermal attribute for each layer.

• Copper pour shapes continue to use unroutes to determine if a pad is a thermal 
candidate. Use Plane Area polygons on split/mixed planes to control thermals using the 
plane thermal attribute. 

See Also: Thermal Generation in the Concepts Guide 

Related Topics

Controlling the Display of Thermals in Plane Areas
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To Create Flood-over Pads
To create flood-over pads for component pads on split/mixed plane layers:

1. Setup menu > Pad Stacks.

2. Select a decal in the Decal Name list, and click Thermal from the Pad Style list.

3. Select the inner layer identified as a split/mixed plane layer from the Shape, Size, Layer 
list.

4. Click a shape from the buttons, either round or square.

5. Set equal Inner Diameter and Outer Diameter values (for example, 50 mils).

6. Click Yes to apply this update to the selected component or all components with this 
decal.

7. Repeat the above steps for other decals for which you want flood-over pads.

For via and jumpers pads, flood-over settings are stored per type. Create a new via type if 
required for flood-over definition, then follow the directions above.

Tip: You can flood-over vias in copper pour or split/mixed plane areas using the Flood and 
Hatch Options dialog box.

Discarding Plane Data on Save
To discard plane data:

1. Tools menu > Options > Split/Mixed Plane tab.

2. Click Plane Polygon Outlines in the Save to PCB File area and click OK.

3. Click Pour Manager from the Tools menu to flood or connect the plane areas.

4. Save the design. The Discard Plane Data dialog box appears.

5. Click Proceed to save only the plane polygons. Click Save All to save all plane data and 
change the option for future saves.

Displaying Connections for Pads Connected to a 
Plane

You can hide the connection lines (ratsnest or unroute connections) of nets assigned to a plane. 
Plane nets are typically power or ground and hiding them can help to clear the design space and 
reduce the connections to ones that require more difficult routing. Plane net connections can be 
made by through-hole pins connecting directly to the plane, or through fanout (short trace 
ending with a via) connections. These nets don't usually require long traces and are often not 



Plane Operations
Converting Old Designs to Split Plane Designs

PADS Layout User’s Guide and Reference Manual, PADS 9.4 601

important in the strategic placement of the part - unless the plane to which they are attached is 
only in a certain area of the board. You can use the View Nets dialog box to hide the unroute 
connections of any or all nets in the design.

See also: View Nets Dialog Box

Converting Old Designs to Split Plane Designs
If you defined split planes using old methods, you can easily convert them to PowerPCB 2.0 or 
later split/mixed planes. The method of conversion is slightly different depending on your 
original method of creation. Choose the method you used from the following list to find the 
appropriate conversion technique:

• Converting Planes Separated by 2D Line or Copper Line

• Converting Planes Defined Using Copper Polygons on Plane Layers

• Converting Planes Defined With Copper Pour Polygons

Converting Planes Separated by 2D Line or Copper Line
If you defined your planes by adding line objects to the layer to represent the separation 
between plane areas, create split plane polygons as follows:

1. Assign the layer as split/mixed plane layer type.

2. Verify your plane net assignments.

3. Define plane polygons.

4. Delete the existing 2D or copper lines if they are no longer required.

To Assign the Layer as Split/Mixed Plane Layer Type

Change the layer type for the split plane layer to a Split/Mixed plane layer.

1. Click Layer Definition from the Setup menu. The Layers Setup dialog box appears.

2. Click the layer in the Layer list, and click Split/Mixed from the Plane Type area.

To Verify Your Plane Nets Assignments

Check your plane net assignments for each split/mixed plane layer.

1. In the Layers Setup dialog box, click the split/mixed layer in the list and click Assign 
Nets.

2. Click nets from the All Nets list and click Add to associate them as required.

3. Click OK to close the Plane Layer Nets dialog box and apply the changes.
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4. Click OK to close the Layer Definition dialog box and apply the changes.

To Define Plane Polygons

Create new split/mixed plane polygons equivalent to the areas defined by the original separation 
using the commands described in Creating a Plane Area and Automatically Separating Plane 
Areas.

Converting Planes Defined Using Copper Polygons on 
Plane Layers

If you defined your planes by creating copper polygons associated with the plane nets, use the 
following steps to convert them to plane polygons:

1. Assign the layer as split/mixed plane layer type.

2. Verify your plane net assignments.

3. Define plane polygons.

To Assign the Layer as Split/Mixed Plane Layer Type

Change the layer type for the split plane layer to a Split/Mixed plane layer.

1. Click Layer Definition from the Setup menu. The Layers Setup dialog box appears.

2. Click the layer in the Layer list, and click Split/Mixed from the Plane Type area.

To Verify your Plane Nets Assignments

Check your plane net assignments for each split/mixed plane layer.

1. In the Layers Setup dialog box, click the split/mixed layer in the list and click Assign 
Nets.

2. Click nets from the All Nets list and click Add to associate them as required.

3. Click OK to close the Plane Layer Nets dialog box and apply the changes.

4. Click OK to close the Layer Definition dialog box and apply the changes.

To Define Plane Polygons

Create new split/mixed plane polygons by tracing the outline with a new plane polygon using 
the commands described in Creating a Plane Area and Automatically Separating Plane Areas.

Converting Planes Defined With Copper Pour Polygons
If you defined your planes using multiple polygons of copper pour, you can easily convert them 
to split/mixed plane polygons using the following steps:
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1. Assign the layer as split/mixed plane layer type.

2. Verify your plane net assignments.

Assign the Layer as Split/Mixed Plane Layer Type

Change the layer type for the split plane layer to a Split/Mixed plane layer.

1. Click Layer Definition from the Setup menu. The Layers Setup dialog box appears.

2. Click the layer in the Layer list, and click Split/Mixed from the Plane Type area.

Verify your Plane Net Assignments

Check your plane net assignments for each split/mixed plane layer.

1. In the Layers Setup dialog box, click the split/mixed layer in the list and click Assign 
Nets.

2. Click nets from the All Nets list and click Add to associate them as required.

3. Click OK to close the Plane Layer Nets dialog box and apply the changes.

4. Click OK to close the Layer Definition dialog box and apply the changes.
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Chapter 31
Routing The Design

There are many ways to route your design in PADS Layout. You can also send your design to 
PADS Router for autorouting and advanced interactive routing. 

See also: Switching to PADS Router

Requirements

• Set the routing direction for all layers.

• Set your grids: design, via, and display.

• Set your design rules and enable DRC.

PADS Layout Routing Tools

Use one of the following tools to route your design:

• Add Route—Click to indicate each corner in the trace. You can route manually or in 
Verb mode. This type of routing works in any DRC mode.

• Dynamic Route—An interactive autorouter that follows the direction of your pointer as 
you move it, seeking optimal paths and installing corners as the trace progresses. 
Dynamic Routing is available only in Prevent Errors DRC mode.

• Auto Route—A pin-to-pin autorouter that automatically adds traces between pin pairs. 
Other routes are moved as required. Auto Routing is available only in Prevent Errors 
DRC mode.

• Bus Route—A dynamic router that creates data lines, memory arrays, or similar 
connections where several routes need to flow together from one set of parts to another. 
Bus Routing is available only in Prevent Errors DRC mode.

• Autoroute using PADS Router—Set up a routing strategy and options; indicate whether 
to autoroute with PADS Router in the background or foreground.

Related Topics

During Routing

After Routing
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Routing Manually
You can manually route using the Add Route button on the Design toolbar. Click to indicate 
each corner in the trace. You can route manually or in Verb mode. This type of routing works in 
any DRC mode. 

Tips: 

• You can set Route to start automatically when you double-click an unrouted path 
(connection): select Add Route in the Routing tab of the Options dialog box.

• Set your grids: design, via, and display.

Procedure

1. Design toolbar > Add Route button.

2. Select an object to route. 
Tips: 

• The trace begins on the layer on which the object resides. If the object is on multiple 
layers, for example, a through-hole pin or via, the trace begins on the active layer. 

• When you start routing from a trace, a tack appears at the selection point.

3. Use the pointer to move the end of the trace you are drawing from grid point to grid 
point.
Tip: The trace can move in one of the three Angle Modes: Orthogonal, Diagonal, or 
Any Angle.
See also: Options Dialog Box, Design Page

4. Click to indicate a corner.

5. To change layers, right-click and click Add via.
See also: Adding a Via While Routing

6. Proceed to your destination until you see the target shape over a pad, trace, or via. 

7. Click to complete the trace.

Routing Dynamically
The Dynamic Route tool is an interactive autorouter that follows the direction of your pointer as 
you move it, seeking optimal paths and installing corners as the trace progresses. Dynamic 
Routing is available only in Prevent Errors DRC mode.

Tips: 
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• You can set Dynamic Route to start automatically when you double-click an unrouted 
path (connection): select Dynamic Route in the Routing tab of the Options dialog box.

• Set your grids: design, via, and display.

• Each layer has a preferred routing direction, be sure to route on a layer that is set in the 
direction you need.
See also: Layers Setup Dialog Box

Requirement

• You must be in Design Rule Prevent mode (drp modeless command) to route 
dynamically.

See also: Turning on Design Rule Checking, Design Rule Checking in the Concepts 
Guide

Procedure

1. Design toolbar > Dynamic Route button.

2. Select an object to route. 
Tips: 

• The trace begins on the layer on which the object resides. If the object is on multiple 
layers, for example, a through-hole pin or via, the trace begins on the active layer. 

• When you start routing from a trace, a tack appears at the selection point.

3. Guide the pointer through the items you want to bypass without creating corners.
Tip: The trace can move in one of the three Angle Modes: Orthogonal, Diagonal, or 
Any Angle.
See also: Options Dialog Box, Design Page

4. Click to indicate a corner; these act as tacked corners to prevent preceding segments 
from moving.

5. To change layers, right-click and click Add via.
See also: Adding a Via While Routing

6. Proceed to your destination until you see the target shape over a pad, trace, or via. 

7. Click to complete the trace.

Tips: 

• To remove unwanted corners, slowly move the pointer back over the unwanted traces.

• As you route, the guard band appears whenever the head of the trace meets a clearance 
obstacle that it cannot shove. The dynamic route tool won't complete the trace without 
changing the clearance rules or removing the obstacle. 
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• Use Transparent Mode, T modeless command, to view obstacles that may lie under 
traces on the active layer.

Related Topics

To Reroute with Sketch Route

Auto Routing
The auto router activates a single-layer, pin-to-pin autorouter for a selected connection or pin 
pair. 

Restrictions 

• The auto router operates on one layer only; it will not add vias. 

• The auto router follows the current design grid. 
Tip: Set your grids: design and display.

• Each layer has a preferred routing direction, the auto router works only in the preferred 
routing direction.
See also: Layers Setup Dialog Box

Requirement

• You must be in Design Rule Prevent mode (drp modeless command).

See also: Turning on Design Rule Checking, Design Rule Checking in the Concepts 
Guide

Procedure

1. Design toolbar > Auto Route button.

2. Select an object to route. 

Result

The router makes three attempts to find a path, shoving existing traces in the process to create 
new channels for the route. If the router can't complete the route, the routine aborts.

Bus Routing
Use Bus Route to dynamically route similar connections where several routes need to flow 
together from one set of parts to another. 

Tips: 
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• Set your grids: design, via, and display.

• Each layer has a preferred routing direction, be sure to route on a layer that is set in the 
direction you need.
See also: Layers Setup Dialog Box

Requirement

• You must be in Design Rule Prevent mode (drp modeless command) to route 
dynamically.

See also: Turning on Design Rule Checking, Design Rule Checking in the Concepts 
Guide

Warning: If the Smooth bus route traces option is enabled, the Smooth command is applied to 
all Bus Route traces once they are complete.

Procedure

1. Design Toolbar button > Bus Route button.

2. Select multiple objects to route by holding the mouse button down and dragging a 
selection rectangle around them. 
Result: A route segment for the first connection, or guide route, attaches to the pointer 
(and follows pointer movement). 

Tip: To use a different connection for the guide route, right-click and click Next Guide 
(or Previous Guide) to cycle through all of the connections.

3. As you move the pointer, you route in a dynamic route mode where corners are added 
automatically.

Tips: 

• The trace can move in one of the three Angle Modes: Orthogonal, Diagonal, or Any 
Angle.
See also: Options Dialog Box, Design Page

• For best results, click to lock down a corner and use the inside connection as the 
guide since the guide does not take into account space required by the follow routes 
to turn around obstacles. After you indicate a corner, the guide route is reattached to 
the pointer.

• To add a corner to the guide route only, right-click and click Add Corner to Guide 
(or Alt+Click). The follow routes follow the guide route after you indicate the next 
corner.

• The spacing of the routes is constrained by trace to trace clearances and snaps to the 
Design grid regardless of the snap to grid setting. You can vary the results of the bus 
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routes by changing the grid spacing. For example, set the x and y coordinates of the 
grid to zero and then try 10.

• The follow routes pattern is based on the direction of the last segment added for the 
guide route. For example, if the last guide route segment is horizontal, then all 
follow routes are added as horizontal with a vertical set of end points.

Result: The other bus connections, or follow routes, are routed following the guide 
route's path only after you add a corner or a via, end a trace, or complete the connection. 
If the bus router cannot create follow routes automatically, it switches to a manual bus 
route mode where you create each corner interactively. The bus router analyzes the new 
route and routes the other connections if possible, or it returns to manual mode. In 
manual mode, entering corners is the same as when you route dynamically. When you 
complete a connection in manual mode, the next connection becomes the new guide 
route.

4. To change layers for all connections at once:

a. Right-click and select Via Pattern Mode, then click the pattern you want.

b. Move the pointer to where you want to add the via pattern.

c. Right-click and click Add Vias.

Troubleshooting: If DRC violations are detected, the message “Bus Router failed. Add 
vias for the current connection manually” appears on the status bar. Try Add Vias again 
allowing more room for the via placement using the current pattern. Otherwise, proceed 
to the next step to add the vias one at a time.

Tips: 

• The spacing between vias is based on the via size, the via grid, and the widths and 
clearances of the traces. 

• If the via pattern you just added isn’t quite right, you can right-click and click Cycle 
Via Pattern to see if a different pattern will improve placement of the vias. Patterns 
that do not fit into the current area are skipped and next pattern is used.
Restriction: The Cycle Via Pattern menu item is only available if Add Vias or Add 
Via to Guide was the last command used.

See also: Via Pattern Mode in the Concepts Guide

5. If Add Vias failed, change the layers one connection at a time:

a. Move the pointer to where you want to add the via.

b. Right-click and click Add Via to Guide. A via is added to the current guide route 
and the next connection becomes the new guide route.

Tips: The spacing between vias is based on the via size, the via grid, and the widths and 
clearances of the traces.
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See also: Adding a Via While Routing

6. To end the trace short of the target (leaving a dangling connection, or ending at a via or 
testpoint):

a. Right-click, point to End Via Mode, and then click an End mode.
See also: Using End Via Mode

b. Move the pointer to where you want to add the tack or via.

c. Right-click and click End. 

Troubleshooting: If DRC violations are detected, the message “Bus Router failed. End 
bus manually” appears on the status bar. Try ending the bus again allowing more room. 
Otherwise, end the routes individually clicking End Guide.

Tip: The spacing between vias is based on the via size, the via grid, and the widths and 
clearances of the traces. 

7. To complete the bus route, proceed to the final destination and do one of the following:

• Right-click and click Complete.

• To incrementally complete each connection in the bus, move the guide route to its 
final connection point and click. The pointer changes to a target shape at the correct 
connection point. The next connection in the bus becomes the new guide route. 
Repeat this process until you route all connections.

Shortcuts
You can become very proficient with the bus router when you make use of the keyboard 
shortcuts shown in Table 31-1.

Table 31-1. Bus Router Shortcuts 

Command Shortcut

Next Guide Tab

Previous Guide Shift+Tab

Add Corners Click

Add Corners to Guide Alt+Click

Add Vias Shift+Click

Add Vias to Guide Shift+Alt+Click

End Ctrl+Click

End Guide Ctrl+Alt+Click

Complete Double-click
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Examples
Listed below are examples of basic bus router operations:

• Moving the pointer before indicating a corner: only the guide route appears.

• Indicating a corner point for the bus: the other bus connections or follow routes, are 
routed following the guide route's path. After you indicate a corner, the guide route is 
attached to the pointer. Continue indicating corners for the bus.

• Bus routing in progress.

Tip: For best results when adding corners, use the inside connection as the guide.

Back Up Backspace

Cancel Esc

Table 31-1. Bus Router Shortcuts (cont.)

Command Shortcut
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Related Topics

Setting a Via Type

Selecting Routing Objects
Several route objects exist that you can select for routing. You can also confirm selected 
information.

To select an object to route, click the object. Objects you can route are: connections, pins, 
traces, vias, and tacks.

Tips:

• If you have trouble selecting the object, select the object name in the Selection Filter 
dialog box. 
See also: Using the Selection Filter

• For rectangular and oval pins, or pads, click in the center of the object or use area select. 
See also: Selecting Items

• If PADS Layout placed the tack, the tack is attached to the trace and you must select the 
trace. The layer on which the trace with the tack exists is the active layer.

Confirming Selected Information
To confirm basic information for a selected object, you can do one of the following:

• Open the status window by pressing Ctrl+Alt+S. For more complete information about 
a specific object, select it and then right-click and click Properties.

• When you select a connection, right-click and click Select Net to select the entire net.

• Use Transparent Mode (T modeless command) to view obstacles that may lie under 
traces on the current active layer.
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For a visual aid set your dot grid to the same spacing as your routing grid. Use the GD modeless 
command and the grid value to do this. You can route on the polar grid as well.

See also: Typing Modeless Commands

To Assign Colors to Nets
To assign colors to nets:

1. View menu > Nets.

2. Add the net to which you want to assign color to the View List.

3. Select that net from the View List.

4. Select a color for the net from the Color by Net area. The Display Colors dialog box 
determines colors in this area. If you select None, the net does not have a color 
assignment and it appears as it normally does. All nets are assigned None by default.

5. Click OK or Apply. The color change takes place.

Tip: You cannot assign a color to net Default.

Related Topics

Modifying Net Properties

Net Properties Dialog Box

View Nets Dialog Box

To Find a Net
To quickly locate a specific net on a dense board:

1. Type the modeless command, N.

2. Type the netname and press Enter. The net appears in the color you chose in Display 
Colors. The net is not selected: you have to select a segment to start routing. The 
highlighting turns off when you complete the route or when you select the net or a pin 
pair and click Unhighlight from the Edit menu.

To search for and select a net, or several nets, use the Find dialog box. Finding by nets finds and 
either highlights or selects nets whether they are routed or not.

See also: Find Dialog Box

To View by Color
To globally hide or display connections:
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• Click Display Colors from the Setup menu. If you change the connection color to the 
background color, the connections are effectively hidden.

You can also use the Highlight/Unhighlight command to make a particular unrouted connection 
or net stand out on the design:

1. Select the connection or net.

2. Click Highlight on the Edit menu. The net appears in the highlight color you set in the 
<Display Colors Setup dialog box>. The pair or net is not selected; you can select it as 
you would an unhighlighted item.

To turn the highlight off, reselect the item and click Unhighlight from the Edit menu. 
The highlight is also canceled when the connection is routed.

To View by Netname
Use View Nets to hide or show connections by netname. You can change the appearance of 
nets, net classes, and nets with rules.

• To selectively hide or display connections, click View Nets from the View menu.

Routing To and From a Copper Shape
You can route to and from a copper shape. However, there are restrictions when routing from a 
copper shape. We recommend you route to the copper shape whenever possible.

Requirements

• You must assign a net to the copper shape before you can route to it. See also: Assigning 
Copper to a Net 

• The net you are routing must be the same as the net assigned to the copper.

• If you are routing to pin copper, the copper must be associated to the pin in the decal in 
order to router to it. See also: Associating Copper with Terminals

Procedure –To Copper

Unlike routing to a pad where you must route to the center of the pad to complete the 
connection, you only need to route to the edge of the copper.

1. As you are routing a net, guide the trace to the copper. 

2. Choose an end point inside the perimeter of the copper. A target-like shape indicates that 
you have connected with the copper.

Alternative: If you are routing on another layer, you can end the trace with a via into the 
copper. See also: Using End Via Mode
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3. Click to finish.

Procedure –From Copper

There are limitations in routing from the copper. You must always select an area where a 
connection (unroute) emanates from the copper to start the routing process. Because of this, we 
recommend that you route to the copper whenever possible for more flexible connection points.

1. While in a routing mode, locate the point where a connection (unroute) is emanating 
from the copper.

Alternative: You can route and add a via within the copper if you need to immediately 
change layers.

2. Click to begin the trace.

3. Route your trace.

Restriction: While in ECO Add Route mode, you cannot terminate a newly created connection 
on copper. The connection must go between two component pins.

Result

After routing, the ratsnest connection continues to exist in the design between the copper and 
other unrouted objects of that net. The connection disappears after all objects associated with 
that net are connected.

Setting a Via Type
Use the Vias dialog box to determine what kind of via to install when you change layers during 
routing. When you choose a via type, that type is used with the Add Vias and Add Vias to Guide 
commands. You can also change the via type during routing.

See also: To Change the Via Type While Routing

Procedure

• Type one of the following modeless commands:

VA (automatic via selection) - PADS Layout chooses from all vias, through or partial, 
that can handle the particular layer change. If PADS Layout finds partial vias dedicated 
to the layer change, it chooses from them. If PADS Layout can't find a dedicated partial 
via, it selects any through vias for a through or partial layer change. It then checks the 
Routing Rules dialog box for vias that are allowed for the net you are routing. If more 
than one via still passes, PADS Layout installs the one with the smallest drill diameter or 
smaller pad size. Automatic allows only vias that begin and end on the Layer Pair shown 
on the Routing tab of the Options dialog box.

Requirement: To use automatic via mode, the layer pair for routing and the layer pair 
for the partial via definition need to match. For example, if you have a partial via set up 
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for layers 1 through 4, and the layer pair for routing is set for layers 1 through 8, 
automatic mode will not insert a via.

VP (partial via) - The automatic via selection still occurs, but it is limited to the partial 
vias only.

VT (through via) - The list of through vias becomes active. Click the via you want to use 
as the default and click Apply. This is the via which is installed every time you change 
between layer pairs.

Or

• Type the V modeless command and press Enter to open the Vias dialog box where you 
can select the via mode you want.

The via must not create a clearance violation according to the default clearance rules or the 
clearance rules attached to the net you are routing, whichever takes precedence. If you set DRC 
to Prevent Errors, a layer change won't complete if the trace or via creates a clearance problem.

Once you install a via, you can change it to another type using the Via Properties dialog box. 

See also: Via Properties Dialog Box

Using End Via Mode
To end a trace with vias, tacks, or test points use the End Via Mode command from the End 
Via Mode menu in the shortcut menu. The available modes are listed in Table 31-2. The 
selected mode is on until you select a different one or exit PADS Layout. 

Tip: If you try to add a test point to an area defined as a test point keepout area when DRC 
mode is set to Prevent Errors, the message “Test point keepout violation” appears and the test 
point is not added.

Related Topics

Bus Routing

Table 31-2. End Via Modes

Mode Description

End No Via Ends the connection with a tack. End No Via is the default 
setting.

End Via Ends the connection with a via.

End Test Point Adds a test point via. 
See also: Placing Test Points, Setting Test Point Properties
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Using the Layer Pair
If you're working extensively between two layers, set them as the default layer pair, and while 
routing, right-click and click Layer Toggle, or shift-click to install a via and change to the other 
layer.

Set the layer pair in the Routing / General page of the Options dialog box. You can also use the 
modeless command PL. Separate the modeless command and each layer number with a space.

To change layers outside the layer pair, use the L modeless command or right-click and click 
Layer.

Related Topics

To Change the Layer While Routing

Using Teardrops
Teardrops enhance connectivity between traces and pins. You can set PADS Layout so that it 
automatically creates teardrops as you route or you can insert teardrops after you route. You can 
set options for teardrops on new traces, or you can modify teardrops on existing traces.

In this section:

• Creating Teardrops

• Remove All Teardrops

• Disable the Display of Teardrops

• Selectively Disabling Teardrops

• Teardrop Restrictions

• Teardrops in CAM

• Modifying Teardrop Properties

• Checking Teardrops

Creating Teardrops
In the Options dialog box, use the Routing tab option to generate teardrops. Use the Teardrops 
tab to set options for teardrops on new traces. Any changes you make apply to new traces that 
you route. These settings are saved with the design.

To generate teardrops on existing pads:

1. Tools menu > Options > Routing / General.
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2. In the Options area, select the Generate Teardrops check box. Teardrops are 
automatically added when you add a trace segment that enters or leaves a pad.

3. Click OK. Teardrops are enabled.

Exception: Teardrops may not appear on all existing pads if the traces going in to the 
pads are not centered. Re-route the traces from the pads to the first corners to fix these 
exceptions.

If you haven't set a teardrop option in a previous PADS Layout session, PADS Layout uses the 
Default teardrop shape. You can set more specific options for teardrops if you have the 
additional teardrop functionality using the Routing / Teardrops page in the Options dialog box. 

Tip: If you don't want a teardrop on a specific trace you are routing, click Ignore Teardrop 
from the shortcut menu after you click Route from the shortcut menu. A teardrop will not 
appear on the trace you are routing, but will on subsequent routes.

Remove All Teardrops
You can remove all teardrops by reversing the process for creating teardrops.

1. Tools menu > Options > Routing / General.

2. In the Options area, clear the Generate Teardrops check box.

Disable the Display of Teardrops
You can also temporarily disable the display of teardrops without removing them from the 
design.

1. Tools menu > Options > Routing / Teardrops.

2. In the Parameters area, clear the Display Teardrops check box.

Selectively Disabling Teardrops
You can selectively turn teardrops off at the pin level.

1. Select a pin > right-click > Properties.

2. Clear the Teardrops check box in the Pin Properties dialog box.

To clear multiple pins, set the Selection Filter to Pins only, and draw a selection rectangle to 
select multiple pins. As long as all the selected pins are teardrop-enabled, you can open the 
Properties dialog box to disable teardrops.
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Teardrop Restrictions
Teardrops have the following placement restrictions:

• You cannot place default-shaped teardrops on square pads.

• You cannot place teardrops on traces when a trace corner is inside the pad or via or if the 
segment is too short. Use the additional teardrop option Auto Adjust to solve this. This 
option is in the Teardrops tab of the Options dialog box. Use Auto Adjust to set a custom 
length and width ratio. With Auto Adjust selected, PADS Layout attempts to adjust the 
length of the teardrop on traces where the trace corner is inside the pad or via or the 
segment is too short to contain the specified length ratio.

Teardrops in CAM
When you plot teardrops, the line width used is the same as the track width. If the teardrop is on 
an annular-shaped pad, PADS Layout uses the difference between the outer pad radius and the 
inner pad radius as the line width if that amount is less than the track width.

Related Topics

Modifying Teardrop Properties

Teardrop Properties on Traces Dialog Box

Modifying Teardrop Properties
You can modify the teardrop shape, length ratio, and width ratio for any selected teardrop, 
teardrops on all layers, or all teardrops. You can also remove an individual teardrop from a 
design.

To modify teardrop properties:

1. Select the trace to which the teardrop is attached. If you select in the middle of a trace 
with teardrops at each end, both teardrops are edited. Select the trace near the teardrop 
you want to modify to edit only one teardrop.

2. Right-click and click Properties.

3. Click the Teardrop button. The Teardrop Properties on Traces dialog box appears.

Exceptions:

• If you select multiple traces and modify teardrops on those traces, only existing 
teardrops are modified. You cannot apply teardrop settings to a trace. Newly created 
teardrops always use the settings in the Teardrop tab of the Options dialog box. 
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• If you select Layer or All from the Apply To area, Auto Adjust changes to a third state, 
neither on nor off. This occurs because Auto Adjust reads the Auto Adjust setting for 
more than one trace and they can vary. You can still change Auto Adjust.

• You cannot preview teardrops when you select Layer or All.

Related Topics

Using Teardrops

Teardrop Properties Dialog Box

Checking Teardrops
Use this dialog box to check for and view teardrop errors. The error location, layer, and a short 
explanation of the error are reported.

Requirement: You must enable teardrops before you can check them. Tools menu > Options > 
Routing tab > select Generate Teardrops check box > click OK.

In this topic:

• Running a Teardrop Check

• Checking Teardrop Error Results

• Saving and Printing Error Results

• Changing Default Teardrop Report File Names

Running a Teardrop Check
1. Tools menu > Options > Teardrops tab.

2. Click the Check button.

3. Click Start to run the check.

4. After the check process completes, a message window might open with the number of 
errors found. Click OK.

Checking Teardrop Error Results

Reading Error Details

Error results are listed in the Location box. Listed errors, contain their (X,Y) location, layer, and 
error type.

1. Select an error from the list.
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2. In the Explanation box, view the more specific, detailed information about the error 
selected in the Location list. The explanation includes information about any conflicting 
object.

Tip: The current error list remains whether the dialog box is open or closed. The error markers 
remain until you click Clear Errors, which clears the markers, not the errors.

Viewing Errors in the Design

You can view error markers in the design.

Requirement: Colors must be assigned properly in the Display Colors dialog box in order to 
see error markers. Errors in the design area appear in the color of the Errors check boxes per 
layer of the Display Colors dialog box. When an error is selected in the Location box, the error 
in the design area appears in the Highlight color.

• Select an error from the list.

Result: The design window pans to the area of the error (unless Disable Panning is selected). 
This is more obvious if you are zoomed into your design.

Tips:

1. You can prevent the design area from panning to errors when you select them if you 
select the Disable Panning dialog box.

2. Error markers are not erased from the design until you click Clear Errors which clears 
the error markers, not the actual errors. You must correct the error in the design.

Saving and Printing Error Results
You can alternatively view the current error results in your default text editor.

• To view the most recently run report results in the default text editor, click View 
Report. You can print or save the results from your default text editor.

Changing Default Teardrop Report File Names
When you run a Teardrop check, a report file is created with a unique name for each check type.

• To specify the file name, click Report File.

Result: Opens the Save As dialog box where you can name the report if you don't want 
to use the default. 

Tips:

• If you do not give the report a unique name, it is always saved to the default file 
name.
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• If you assign it a name, that name is the default for the report type until you change it 
again.

Managing Tacks
This topic discusses the following:

• Adding a Tack Manually

• Deleting Tacks Manually

Adding a Tack Manually
You can add tacks manually to lock a corner or prevent rerouting when using the dynamic route 
or bus route tool.

To add the tack:

1. Select a trace.

2. Right-click and click Add Tack. The new tack is dynamically attached to your pointer 
and you can place it like a trace corner.

3. Move the pointer to where you want the tack and click to place the tack.

Verb Mode

4. Click the Design toolbar button on the toolbar.

5. Click a routing button from the Design toolbar. The interactive router starts when you 
click an object.

Object Mode

6. Select connections, pins, existing traces, or manually added tacks.

7. Click a routing button from the Design toolbar.

Deleting Tacks Manually
• To delete a manually added tack select it and press Delete.

When the tack is not required for a route direction change, pressing Delete removes the corner 
beneath the tack and moves the tack to the next “U” point in the route.

Tip: The selection filter contains an option for tacks so you can set the filter to select only tacks.
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Managing Jumpers

Using Jumpers
You can place jumpers in a trace either while routing or after you finish routing. PADS Layout 
considers jumper pins as vias. The space between the jumper pins does not have electrical 
properties. Jumper pins are checked for Design Rule clearances as vias.

Tip: PADS Router can load and autoroute jumpers.

In this topic:

• Add Jumpers

• Set Up Jumpers

• Jumper Limitations

• Creating Jumper List Reports

Add Jumpers
To add a jumper while routing:

1. Right-click at the point where you want the first pin of the jumper to appear and click 
Add Jumper. The first pin of the jumper appears.

2. Move the mouse to stretch the jumper. You can stretch between Minimum Length and 
Maximum Length jumper settings at a preset increment. The angle mode also applies.

3. Click to complete the jumper. Regular routing continues. When you place a jumper, it is 
checked for Design Rule clearances if DRC is active.

To add a jumper to a trace:

1. Select the trace to which you want to add a jumper at the point where you want the first 
pin of the jumper to appear.

2. Right-click and click Add Jumper. The first pin of the jumper appears.

3. Move the mouse to stretch the jumper. You can stretch between Minimum Length and 
Maximum Length jumper settings at a preset increment. The angle mode also applies.

4. Click to complete the jumper. Regular routing continues. When you place a jumper, it is 
checked for Design Rule clearances if DRC is active.

Note: You must enter the second pin on a trace in the same net.

Any Angle mode does not work when adding jumpers to a trace.
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Set Up Jumpers
When you add a jumper to the design, the default jumper is used. You can change the default 
jumper settings or change the settings for a specific jumper in the design. The attributes of the 
default jumper are saved in the powerpcb.ini file. To change the setting of a specific pin in the 
design, open the pin Properties.

To change jumper settings:

• Click Jumpers from the Setup menu. The Jumpers dialog box appears. Use this dialog 
box to change the settings for jumpers to create and for jumpers existing in a design.

Jumper Limitations
• Jumpers do not follow the Body to Body Default Design Rule in batch and On-line 

DRC.

• Jumper silkscreens are not user configurable.

• You cannot use Find to search for jumpers.

• Cluster Place ignores jumpers.

• For CAM output, you must enable Component Outlines for the layer on which the 
jumper resides before jumper silkscreen outlines will plot. The outline for jumpers is set 
at 10 mils; you cannot modify this setting.

Creating Jumper List Reports
You can use the Reports dialog box to create a report containing information about all jumpers 
in the design.

To create a jumper list report:

1. File menu > Reports.

2. In the Select Report Files for Output list, select Jumper List.

3. Click OK.

Result: The report is written to C:\PADS Projects\report.rep and displayed in the default 
text editor.

Related Topics

Reports
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Setting Up Jumpers
When you add a jumper to the design, the Default jumper is used. You can change the Default 
jumper settings or change the settings for a specific jumper in the design. The attributes of the 
default jumper are saved in the powerpcb.ini file. To change the setting of a specific pin in the 
design, open the pin properties.

Use the Jumpers dialog box to set up and modify jumpers and jumper pad stacks. You can 
create and modify SMD jumpers (single layer jumpers) on the top or bottom mounting layer. 

In this topic:

• Setting Up the Default Jumper

• Setting Up a Design Jumper

• Setting Up Jumper Pad Stacks

Setting Up the Default Jumper
You can change the settings of the Default jumper. The settings are saved in the powerpcb.ini 
file.

1. Setup menu > Jumpers.

2. In the Apply to area, click Default.

3. In the Jumper Sizes area, in the Min. Length and Max. Length boxes, type the 
minimum and maximum length of the Default jumper.

4. In the Jumper Sizes area, in the Increment box, type the increment, at which you can 
stretch the jumper between the minimum and maximum lengths.

5. Set up the pad stacks.

6. In the Drill Size box type the drill size if the jumper is a through hole jumper. Type a 
drill size of zero if you want a surface mount jumper with round pads.

7. Select the Display Silk check box to display the silkscreen outline for the jumper.

Tips:

• For CAM output, you must enable Component Outlines for the layer on which the 
jumper resides before jumper outlines will plot.

• The outline for jumpers is set at 10 mils; you cannot modify this setting.

Setting Up a Design Jumper
You can change the settings of existing jumpers in the design.
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1. Setup menu > Jumpers.

2. In the Apply to area, click Design.

3. Select a jumper name in the Reference Name list.

4. Set up the pad stacks.

5. In the Drill Size box type the drill size if the jumper is a through hole jumper. Type a 
drill size of zero if you want a surface mount jumper with round pads.

Restriction: Jumper Sizes and Display Silk settings are unavailable for Design Jumpers. To 
modify this information, use the Jumper Properties.

Setting Up Jumper Pad Stacks
You can set up pad stack information for jumpers or individual jumper pins.

1. In the Pin list, select the jumper (All) or the pin to change. 

Tip: You can add individual pins of the jumper to the list for customizing. Use the Add 
or Delete button to maintain the Pin list.

2. In the Shape/Size/Layer list select a layer on which to make jumper pad stack changes.

Exceptions: When modifying Design jumpers, you can add individual layers of the 
design to the list for customizing the design jumper. Use the Add or Delete button to 
maintain the Shape/Size/Layer list.

3. In the Pad Parameters area, select the type of pad from the Pad Style list. Choose from 
(normal) pad, thermal (pad), or antipad.

Restriction: You cannot create antipads on outer layers. When you select an outer layer 
(<Start> or <End>) in the Size/Shape/Layer list, Antipad is unavailable.

4. Select a Pad Shape. Choose from: Round, Square, Annular, or Odd.

Restriction: Annular and Odd shapes are only available for the normal pad style.

5. In the Diameter box, type the diameter for the pad style.

Exception: Thermals require additional settings. Read Design Rule Versus Pad Stack - 
Thermals and Antipads for details.

6. (Square pads only.) Select the Corner type and enter the Radius.

Tips:

• You can click Use Global Defaults to set the Thermal and Antipad shapes, of a layer and 
pin, to the default shapes specified by the design rules and the design Options > 
Thermals tab. This button is only available when the Pad Style list is set to Thermal or 
Antipad.



PADS Layout User’s Guide and Reference Manual, PADS 9.4628

Routing The Design
Managing Jumpers

• Thermal and Antipad display configuration controls the size and shape of thermals and 
antipads used on split/mixed layers and CAM negative planes (for RS-274X output). 

• You can select the Pad Size Relative to Drill Size check box to display inner and outer 
pad values relative to the drill size.

• You can view the effect of your pad settings in the Pad Preview display.

Related Topics

Modifying Jumper Properties

Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Using Jumpers

Jumper Properties Dialog Box

Jumper Name Properties Dialog Box

Jumper Pin Properties Dialog Box

Modifying Jumper Properties
To modify jumper properties:

1. Select a jumper pin > right-click > Properties.

2. Click the Jumpers button. The Jumper Properties dialog box appears.

Alternatives:

• If you selected the Display Silk check box in the Jumpers dialog box, you can select 
the outline of a jumper, right-click and click Properties to access the Jumper 
Properties dialog box.

• You can click in the middle of the jumper to select it. Both jumper pins and the 
jumper name appears in the Selections color. Right-click and click Properties. The 
Jumper Properties dialog box appears.

• You can select the jumper name and then right-click and click Properties. Click the 
Jumper button to open the Jumper Properties dialog box.

Related Topics

Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Using Jumpers

Jumper Properties Dialog Box
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Jumper Name Properties Dialog Box

Jumper Pin Properties Dialog Box

Modifying Jumper Name Properties
To modify jumper name properties:

1. Select a jumper reference designator > right-click > Properties.

2. In the Jumper Name Properties dialog box, make edits.

Alternative: Select the jumper. Right-click and click Properties. The Jumper 
Properties dialog box appears. Select the name to modify from the Label list. Click the 
Label button. The Jumper Name Properties dialog box appears.

Related Topics

Modifying Jumper Pin Properties

Modifying Jumper Properties

Using Jumpers

Jumper Properties Dialog Box

Jumper Name Properties Dialog Box

Jumper Pin Properties Dialog Box

Modifying Jumper Pin Properties
You can display the following information for the jumper pin: the net the jumper pin is part of, 
the reference designator, pin number, connection to which the jumper pin is attached, and the 
jumper pin coordinates. 

To modify jumper pin properties:

1. Select the jumper pin.

2. Right-click and click Properties. The Jumper Pin Properties dialog box appears.

Note: If you change the pad stack of a jumper pin that is a locked test point, the Warning: Test 
Point Locked dialog box appears.

Related Topics

Modifying Jumper Name Properties

Modifying Jumper Properties

Using Jumpers

Jumper Properties Dialog Box
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Jumper Name Properties Dialog Box

Jumper Pin Properties Dialog Box

During Routing

Using the Trace Length Monitor
The trace length monitor calculates and shows trace length as you route. As you move the 
pointer and route traces, the routed and unrouted length of nets or pin pairs and associated rules 
are shown near the pointer and on the status bar. 

The trace length monitor is available for the following commands:

Route/Add Route
Dynamic Route
Move Segment
Move Corner
Move Via

Procedure

To turn the trace length monitor on:

1. Tools menu > Options > Routing tab.

2. Select the Show Trace Length check box.

3. Click OK.

Tip: You can also use the shortcut key Ctrl+PageUp to turn the trace length monitor on or off. 
Turning the trace length monitor on or off does not end the current routing command; you can 
continue to route. 

This turns the display of the trace length monitor on or off at the pointer only. The trace length 
monitor always displays on the status bar.

Related Topics

Trace Length Monitor in the Concepts Guide

Changing the End of the Connection You’re Routing
When you start routing, PADS Layout automatically chooses the end from which you start. If 
you want to start from the opposite end of the connection, use Swap End. Also at any point 
while you are routing, you can preserve what you’ve already routed and switch to the opposite 
end of the connection to continue routing.
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Restriction: Swap End is available only in Add Route and Dynamic Route modes.

Procedure

• While routing, right-click and click Swap End.

To Select a Starting Layer for a Trace
To set the current routing layer before you start routing, do one of the following:

• Click the layer from the Layer list on the standard toolbar. A layer's current direction 
setting appears next to its entry in the Layer list. 

Or

• Change the current layer by typing the L modeless command, typing the layer number, 
and pressing Enter.

You can change the layer's current direction setting by typing the LD modeless command. 
When you select a connection and select a routing mode, the route begins on that layer. When 
you end a route on a different layer than where you began it, the layer you ended on becomes 
the active layer and appears in the Layer list box. The next connection you select starts on this 
active layer.

Adding a Via While Routing
Add a via while routing to either continue routing on another layer or to connect to a plane area.

Requirements

• You must have created a via for use with your design. For more information, see 
Creating a Through-hole Via, Creating a Partial Via.

• The via must be available for use, and both source and destination layers must be 
available for routing according to the applicable Routing Rules.

Procedure

Use one of the following three methods while routing:

• Right-click and click Add Via to continue routing on another layer.

• Click to place a tack and then change to the desired new layer to continue routing.

Result: The via is added automatically in the location of the tack.

• Right-click, point to End Via Mode, and then click End Via to set the mode. Right-
click and click End to end the trace with a via. 
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Result: The trace ends with a Via. If there is a plane area on the path of the via, it 
will either connect with a thermal connection if necessary or add an antipad if it 
shouldn’t connect.

Troubleshooting

• If the via is a restricted via, ensure the requirements to this procedure are in place.

• If a violation is detected, the via grid or a clearance rule could be preventing the 
placement of the via. Also, the layer you are routing to could be unavailable for routing. 
Ensure the requirements to this procedure are in place.

Related Topics

Troubleshooting Routing on Another Layer

Setting a Via Type

Using End Via Mode

Using the Layer Pair

To Create Arcs
To enter arced corners during routing: 

1. While the trace is in progress, right-click and click Add Arc. The segment extending 
from the last corner is converted to an arc.

2. Move the pointer to adjust and indicate the radius. 

3. Click to complete the arc. Routing continues from this point.

See also: To Stretch an Arc or Miter

To Create Miters
You can accomplish a smaller, smoother arced effect by mitering a routed corner.

To create a mitered corner:

1. Tools menu > Options.

2. Set the Miter type to Arc in the Design page of the Options dialog box. 

3. Set the Ratio. 

Ratio is the ratio of the arc radius to the trace width; for example, for a 12-mil trace, a 
ratio of 1 produces a radius of 12; a ratio of 2 produces a radius of 24. 

4. To apply the miter, select the corner, right-click, and click Add Miter. 
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Auto Miter
To automatically miter corners of drafting shapes as you create them, select Auto Miter in the 
Design page of the Options dialog box. The Miters field determines the size and shape of the 
miter. You can also select or clear auto-miters from the shortcut menu while a drafting 
command is active.

Use the Convert to Arc command to create arcs from straight-line segments.

See also: To Stretch an Arc or Miter

To Change the Layer While Routing
To change layers while routing, use the L modeless command while the trace is active:

• Type L, the new layer number, and press Enter.

PADS Layout installs a via at the last corner and move your trace to the selected layer. The type 
of via placed is determined by the Via Type selection dialog box settings. The trace color 
changes accordingly and the new layer appears in the Layer list box. 

You can also right-click and click Layer. If you are changing repeatedly between two layers, 
you can set a layer pair and use the layer toggle command F4.

Related Topics

Using the Layer Pair

To Change the Via Type While Routing
To change the via used while routing:

1. Right-click and click Via Type. The Vias dialog box appears.

2. Click a new via type from the Via Mode area.

3. If the via is a through hole, click the via to use in the Via List list.

4. Click OK. The new via type is used until you change it. 

If you click automatic, PADS Layout selects a via based on:

• Which vias are allowed for the net in the Routing Rules dialog box.

• Which vias are legal for the layer change according to the Drill Pairs Setup dialog box.

If more than one via qualifies on both counts, the product uses the smaller drill diameter and/or 
smaller pad size.
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Other options are:

To Change the Trace Width While Routing
When you change the trace width, the current routing width changes from the last corner, 
leaving segments before the last corner at their original width. All subsequent segments draw at 
the new width, until you reach the next pin in the net. The width stays associated with the 
connection until you change it. 

The new width becomes the effective width for the rest of the connection, but it does not change 
the Recommended Trace Width setting for the net. If you end with a partial route and use it 
later, the width you set separately is still in effect.

To change the width of a route in progress:

1. Type the W modeless command.

2. Type the new width and press Enter. The line width area on the status bar changes 
accordingly.

You can also use the Grid/Width dialog box to change the width on the trace you are currently 
routing.

To change the width of a trace once it is routed:

1. Select the item.

2. Right-click and click Properties. You can also use Find from the Edit menu to find all 
traces of a similar width, select them, and change them to a new width.

See also: To Change the Width of an Existing Trace

Troubleshooting Routing on Another Layer
You can use a via to switch to another layer while routing. But there are many rules or settings 
than can prevent you from routing on another layer. If you have trouble, here is a list of things to 
check:

• Is the via type in the Selected layers list? In the Routing rules at each level of the 
hierarchy, you can disable a via for routing by keeping it out of the Selected vias list.

Partial Automatic search is limited to partial vias.

Through List of through vias becomes active. Select a via for the default installed 
when you change layers.
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• Is the layer in the Selected layers list in the Layer biasing? In the Routing rules at each 
level of the Rules hierarchy, you can disable a layer for routing by keeping it out of the 
Selected Layers list in the Layer biasing area.

• Is the layer check box cleared in the Selection Filter? In the Selection Filter, on the 
Layer tab, you can clear the check box of a layer. Nothing on that layer is selectable - 
including the pad of the via from which you are trying to route.

• Is the active layer not coming to the front? In the Global Options, you can select the 
Active layer comes to front check box to bring the layer forward. Then you can select 
items on that layer more easily.

• Is there a conditional rule which prevents this net from routing on this layer, or near 
these components?

Ending a Trace on a Different Net
To end a trace on a segment with a different netname, use the ECO toolbar routing command. 
PADS Layout assumes you are intentionally joining two nets to make one, and consider it an 
ECO. It is recorded in the database as such. You must assign a new netname: either use one of 
the names from the nets you just combined or use a third name. 

See also: Adding a Connection in ECO Mode, Adding a Route in ECO Mode

Selecting Objects Among Others
You can use additional selection filter shortcuts after selecting a design object. Right-click and 
click a selection shortcut.

In this topic:

• Selecting Nets From an Electrical Object

• Selecting Pin Pairs From an Object

• Selecting Classes from Nets

• Selecting Groups from Pin Pairs

• Selecting Drafting Objects from Segments/Corners

Selecting Nets From an Electrical Object
You can select an assigned net of an electrical object quickly. Electrical objects include trace 
objects, pins, copper objects, planes, and unroutes.

To select an entire net, including routes, connections, and pins:
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1. Select an object.

2. Right-click and click Select Nets, or press F6.

Selecting Pin Pairs From an Object
To select all pin pairs attached to a pin, trace segment, corner, tack, or via:

1. Select an object.

2. Right-click and click Select Pin Pairs, or press F5.

Selecting Classes from Nets
A class is a collection of nets with a common set of design rules. You can define classes 
graphically or by using the Class Rules dialog box.

See also: Design Rule Hierarchy in the Concepts Guide

If you have created net classes, you can quickly select all items such as pins, traces, and 
unrouted pin pairs within them, or determine the class of a net:

1. Select a net.

2. Right-click and click Select Class.

Selecting Groups from Pin Pairs
A group is a collection of pin pairs with a common set of design rules. You can define groups 
using the Group Rules dialog box.

See also: Design Rule Hierarchy in the Concepts Guide

To select all pin pairs in a group:

1. Select a pin pair of a group.

2. Right-click and click Select Group.

Selecting Drafting Objects from Segments/Corners
To select the entire drafting object from one of its segments or corners:

1. Select the drafting segment or corner.

2. Right-click and click Select Shape.
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After Routing
The following section details tools to help you clean up or modify routed trace patterns, 
completely reroute, or protect routes from further modifications. 

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation. 
You can, however, copy trace patterns from a physical design reuse.

To view obstacles that may lie under traces on the current active layer use Transparent Mode, 
modeless command T.

To Protect Routes
To protect a route you must select the object and use the Properties dialog box to enable 
protection. You can set protection, for fully routed connections and the routed portion of partial 
routes, at the pin pair or net level. 

See also: Route Protection in the Concepts Guide 

Protecting Trace Segments
1. Select a trace segment or unroute > right-click > Select Pin Pair > right-click > 

Properties.

2. Select the Protect Routes check box.

3. Click OK.

Protecting Entire Nets
1. Select a trace segment or unroute > right-click > Select Net > right-click > Properties.

2. Click Protect Routes.

3. Click OK.

To Protect Unroutes
To protect unroutes you select the object and use the Properties dialog box to enable protection. 
You can set protection, for fully unrouted connections and the unrouted portion of partial 
routes, at a pin pair or net level. 

See also: Route Protection in the Concepts Guide 

Tip: You cannot protect the unrouted portion of a partial route unless you first protect the 
routed portion.
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To protect an unroute segment:

1. Select an unroute.

2. Right-click and click Properties. 

See also: Pin Pairs Properties Dialog Box 

3. To protect a fully unrouted connection click Protect Unroutes. If the net contains 
partial routes this option is unavailable. 

To protect the unrouted portion of a partial route, click Protect Routes and then click 
Protect Unroutes.

4. Click OK.

To protect an entire unrouted net:

1. Select an unroute.

2. Right-click and click Select Net.

3. Right-click and click Properties.

See also: Net Properties Dialog Box

4. Click Protect Unroutes.

5. Click OK.

Moving a Trace Segment to Another Layer
Instead of rerouting an entire trace, you can move a trace segment to another layer and have the 
vias added automatically.

Procedure

1. Select one or more trace segments.

2. Right-click and click Properties.

3. In the Trace Properties dialog box, select the layer you want from the Layer list.

4. Click OK.

Result

The trace segment moves to the selected layer and vias are automatically placed at the segment 
end points.

Tip: If nothing happens, design rules may have been violated. For example, there may not be 
enough room for a via.
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To Reroute with Route or Dynamic Route
You can reroute traces by starting and ending a new replacement trace anywhere along the 
existing trace. You can start and end reroutes on segments, pins, and vias. You must, however, 
meet two conditions:

• The existing and new traces must have the same netname.

• The net must be enabled for copper sharing.

To enable copper sharing, use the Routing Rules dialog box for the net and select 
Copper Sharing. To enable sharing for all nets, click Default in the Design Rules 
dialog box and select Copper Sharing in the Routing area.

To reroute a route starting on a segment:

1. Select the segment to reroute.

2. Right-click and click Route. The new trace begins at the selection point.

You can end on a trace when the pointer changes to a bull's-eye as you move the route in 
progress over the segment into which you want to T. If you have created a connection 
loop, the “Delete Loop?” message appears. Click OK to delete the highlighted segment 
or click Next to cycle through the other segments in the loop. Click OK to delete the 
highlighted segment.

3. To complete the route, double-click or right-click and click Complete.

Tips:

• If you reroute a segment that has a via or jumper pin that is a locked test point, the 
locked test point is not deleted. The test point remains connected by an unroute.

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing 
operation.

Use Transparent Mode, modeless command T, to view obstacles that may lie under traces on 
the current active layer.

To Reroute with Sketch Route
Use Sketch Route, when using Dynamic Route, to reroute a set of trace segments between two 
pins. A pin in this case may be a component pin, via, or tack.

Remember that Sketch Route cannot move a tack, so most traces that travel in the wrong 
direction, or have tacks for any other reason, are ineligible for Sketch Rerouting. 

To reroute a trace using sketch:
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1. Click Prevent Errors in the On-Line DRC area of the Design page (Options dialog 
box). 

See also: Design Rule Checking in the Concepts Guide

2. Select the first segment of the series you want to edit.

3. Right-click and click Sketch. A thin dotted line appears that moves with the pointer. 
Use this line to mark the general location of the new trace. You don't have to enter any 
corners. 

4. Click to indicate the end of the sketched route. This completes the trace, routing through 
the defined path.

Sketch in Verb Mode

The Sketch Route button in the Design toolbar provides the same rerouting functionality, but 
uses a different set of procedures to start the rerouting process:

1. Click Prevent Errors in the On-Line DRC area of the Design page (Options dialog 
box). 

2. Click the Sketch Route button.

3. Select the trace to edit. A thin dotted line appears that moves with the pointer. Use this 
line to mark the general location of the new trace. You don't have to enter any corners.

4. Click to indicate the end of the sketched route. This completes the trace, routing through 
the defined path.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

Using Smoothing Controls
Use smoothing options to smooth trace patterns (removing unneeded corners and segments and 
centering trace patterns between route obstacles), to protect traces for controlled length nets, to 
perform smooth operations after bus routing, and to smooth pad entry and exit. 

These options, which are located on the Routing / General page of the Options dialog box, 
affect the results of the Smooth, Autoroute, and Bus Route commands.

To Smooth Trace Segments
Smoothing removes unnecessary segments from a trace and converts ninety-degree corners to 
forty-five degree corners whenever possible. This option is only available when you use 
Dynamic Routing. 

To smooth trace segments:
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1. Set the On-line DRC setting to Prevent Errors.

2. Select a trace segment.

3. Right-click and click Smooth.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

To Change the Pad Entry Angle
The Trace/Line Angle setting in the Design page of the Options dialog box determines the angle 
of pad entry when you complete a trace. You can also use Trace/Line Angle in the Status 
window. After the trace completes, you can change the pad entry angle into the pin.

1. Select the segment.

2. Right-click and click Pad Entry. The final segment changes its orientation and adjusts 
the attached segments accordingly if possible.

If the new pad entry causes a clearance error, the process is canceled.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

To Copy and Paste Trace Patterns
You can reproduce repetitive routing patterns by making one example of a segment pattern, 
copying it, and pasting it on any similar connections. Layer changes and vias in the path are 
included in the selection. Memory patterns or SMD fanouts are ideal applications for copied 
routes.

To copy and paste a route:

1. Select a segment or pin pair.

2. Click Copy from the Edit menu, or press Ctrl+C. All included segments and vias are 
animated, or copied and attached to your pointer in Move mode.

3. If necessary, use the shortcut menu commands to rotate or flip the copy.

4. Indicate the location so it joins the pins to which you want to paste. A copy is pasted and 
another copy remains attached to the pointer so you can paste it again.

The pointer then snaps automatically to a point the same distance from and in the same 
direction as the last placement. This makes it easy to install repetitive route patterns.

5. Press Esc to cancel further copies.
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A copied trace only pastes to a valid electrical connection: you cannot paste to empty space. If 
the copied traces are shorter than the target pin pair, a connection is created from the end of the 
copy to the other pin of the pair.

Related Topics

To Copy and Paste a Route in BGAs

Cut, Copy, and Delete in the Concepts Guide

To Create Route Loops
You can reroute from point to point along the same net without deleting the previous path. This 
causes the new route to branch off the existing route, creating a loop.

Procedure

1. Indicate the location on the route segment where you want the branch to occur.

2. Right-click and click Route Loop. A new route starts at the selection point.

3. Indicate the location for each corner of the new route.

4. Indicate the location where the loop branches back into the existing route.

You can also start Route Loop using the Ctrl+J shortcut keys.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

To Move a Trace Segment
To move a trace segment:

1. Select the trace segment.

2. Use one of these methods to start the move.

• Right-click and click Move.

• Press Ctrl+E.

• Select the trace segment and drag. Use the Global / General page of the Options 
dialog box to click a drag and drop method, or to prohibit pointer-drag moves.

The selection attaches to the pointer.

3. Click to indicate the route location.
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“Shove” When Moving
If you use the Dynamic Route tool, you can use the shortcut menu to enable or disable trace 
shoving, or moving, when you move traces. If you want to move traces aside, temporarily 
creating overlaps, right-click and click Shove (to remove the check mark) when the trace is in 
Move mode.

Tips:

• If you set DRC to Prevent or Warn, you can't create a clearance violation when you 
relocate the trace.

• If you move a trace that is attached to a via or pin that is a locked test point, a Warning 
dialog box appears informing you of changes to the test point and giving you options. 

See also: Troubleshooting

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing 
operation.

Use Transparent Mode, the modeless command T, to view obstacles that may lie under traces 
on the current active layer.

To Delete a Trace Segment
To delete a trace segment:

1. Select the segment.

2. Press Del, or click Delete from the Edit menu.

When you delete a trace segment, a connection line is restored.

Tips:

• If you delete a trace that is attached to a via that is a test point, the via is automatically 
deleted with the trace unless the test point is locked. If the test point is locked, it remains 
connected by an unroute.

• If you try to delete a segment that is part of a physical design reuse, the message “The 
command cannot be applied to reuse elements” appears in the status bar.

To Unroute a Segment Attached to a Pin
You can unroute the first segment attached to each pin of a component. Use Unroute Attached 
Segments to reroute each connection that terminates at the part. When segments are unrouted, 
tacks appear at the end of the connection where it meets the route. If the unrouted segment ends 
at a via, a connection is created between the via and the unrouted pin.
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To unroute a segment attached to a pin:

1. Select the component from which you want to unroute attached segments.

2. Right-click and click Unroute Attached Segments. The first segments are unrouted and 
tacks appear at the end of the routes.

Tip: If you try unroute segments that are part of a physical design reuse, the message “The 
command cannot be applied to reuse elements” appears on the status bar.

To Change the Width of an Existing Trace
You can change the width for routed traces at the segment, pin pair, or net level, using the 
Properties dialog box.

Modifying the width of a segment
1. Select a segment > right-click > Properties.

2. Type the new width in the Width field and click Apply or OK.

Modifying the width of pin pair or net
1. Select a segment > right-click > Select Pin Pair or Select Net.

2. When the pin pair or net is highlighted, right-click and click Properties or click the 
Properties button on the toolbar. The Pin Pair Properties or Net Properties dialog box 
appears.

See also: Pin Pairs Properties Dialog Box

3. Type the new width in the Width box and click Apply or OK.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

To Convert a Trace Corner to an Arc
Use Convert to Arc to create an arc from two intersecting route segments. The Angle box in the 
Miters area of the Options Dialog Box, Design page controls which trace corners will be 
converted to arcs. For example, if the Angle box is set to 90 degrees, then only trace corners that 
form angles less than or equal to 90 degrees can be converted to arcs.

To convert trace corners to arcs:

1. Select the corner of a route.

2. Right-click and click Convert to Arc. 
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3. Move the pointer to adjust the radius of the new arc and click to finish.

Use Stretch from the routing shortcut menu to adjust the radius of a created arc or to convert the 
arc back to a corner.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

Related Topics

To Create Miters 

To Stretch an Arc or Miter
Use Stretch to expand or contract a miter or arc on a route segment. 

To adjust an arc or miter:

1. Select the miter segment or arc.

2. Right-click and click Stretch. The object attaches to your pointer.

3. Move the pointer to expand or contract the object.

4. Click to finish.

Click outside the point of intersection of the two lines to return the arc or miter to a corner.

Tips:

• If you move or stretch a route that is attached to a via or pin that is a locked test point, a 
Warning dialog box appears informing you of changes to the test point and giving you 
options.

See also: Troubleshooting

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing 
operation.

Using Stretch to Move a Route Segment
You can also use Stretch to move a straight route segment that has corners at the end points. The 
corner angles are maintained and the length of the segment is adjusted during the stretch.
Exception: If you stretch a segment so that it reaches another segment’s corner, corner angles 
may change.

Restriction: You cannot use Stretch to move a straight route segment with an arc at its end 
point.
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Tip: Use the Pull Arc and Move Miter commands to modify arcs and miters for all drafting 
objects.

Related Topics

To Create Arcs

To Create Miters

To Move a Corner
You can move any corner on a trace or drafting object:

1. Select the corner to move.

2. Drag the corner using the mouse.

3. To convert the corner to an arc, right-click and click Convert To Arc. The corner 
becomes an arc and remains attached to your pointer. Move the arc to the desired 
position, and click to complete.

4. To shove other routes as you move the selected corner, right-click and click Shove.

5. To limit the via or tack to horizontal or vertical segments, right-click and click 
Orthogonal.

6. To allow 45 degree segments, right-click and click Diagonal.

7. To allow segments of any angle, right-click and click Any Angle.

8. To ignore clearance rules regardless of the On-line DRC setting in the Design page in 
the Options dialog box, right-click and click Ignore Clearance.

Tips:

• If you click the Move button in the Design toolbar, a click attaches the corner to your 
pointer.

• If you select Keep Traces Attached After Move Component in the Design page of the 
Options dialog box, the segment attaches to your pointer when you release the button.

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing 
operation.

Related Topics

To Delete a Corner

Modifying Drafting Corner Properties
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To Move a Via or Tack
To move a via or tack:

1. Select the via or tack.

2. Drag the via or tack using the pointer.

3. To shove other routes as you move the selected corner, right-click and click Shove.

4. To limit the via or tack to horizontal or vertical segments, right-click and click 
Orthogonal.

5. To allow 45 degree segments, right-click and click Diagonal.

6. To allow segments of any angle, right-click and click Any Angle.

7. To ignore clearance rules regardless of the On-line DRC setting in the Design page in 
the Options dialog box, right-click and click Ignore Clearance.

Tips:

• If you move a via that is a locked test point, a Warning dialog box appears informing 
you of changes you are making to the test point and giving you options.

See also: Troubleshooting

• If you move a via that is a test point into an area defined as a test point keepout area, and 
DRC mode is ON, a message appears and the test point is cleared.

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing 
operation. 

Deleting Dangling Routes
Dangling routes are stubs or spurs off of traces that are not tied to any pin by a ratsnest. By 
contrast, partial routes are uncompleted routes where the ratsnest flightline is still visible.

In PADS Layout you can end the route on a test point by choosing End Test Point from the 
Route shortcut menu. This creates a dangling via and dangling route. If you later want to 
remove the dangling via, right-click and click Select Dangling Routes. PADS Layout allows 
you to select all of these route types on the board. 

You can selectively unroute or delete the dangling via and dangling route.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the modifying operation.
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To Split a Trace
The Split command divides a selected line segment into two segments.

To split a segment:

1. Select the segment to split.

2. Right-click and click Split. The segment dynamically attaches to the pointer.

3. Click to indicate where to split the segment. The segment is divided into two segments.

Split in Verb Mode

4. Click the Split button from the Design toolbar.

5. Select the trace to split. The segment dynamically attaches to the pointer.

6. Click to indicate where to split the segment. The segment is divided into two segments.

Swapping Segment Sides while Splitting

While splitting a trace, you can switch the trace side that is attached to the pointer.

1. Before completing the split, right-click and click Swap. The pointer attaches to the other 
end of the segment.

The current Angle Mode setting effects the movement of the attached segments.

2. Continue to split the segment as described in the previous section.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

To Add a Corner to a Trace Segment
Add Corner divides the selected line segment into two segments.

To add a corner:

1. Select the segment to which to add a corner.

2. Right-click and click Add Corner. The segment dynamically attaches to the pointer.

3. Click to indicate the location for the new corner. The segment is divided into two 
segments.

Add Corner in Verb Mode

4. Click the Add Corner button from the Design toolbar. 

5. Select the trace to add the corner to. The segment dynamically attaches to the pointer.
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6. Click to indicate the location for the new corner. The segment is divided into two 
segments.

Tips:

• The current Angle Mode setting effects movement of the attached segments.

• When On-line DRC is set to Prevent Errors and errors occur, (guard band appears), the 
corner is added at the closest legal position to the indicated point.

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing 
operation.

Adding Vias to an Existing Trace
The Add Via command adds a feed-through to the selected trace at the selection point location. 
This action does not change the current layer setting.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the modifying operation.

Using Stitching Vias
Use stitching vias to interconnect copper areas of nets including copper pour, split planes, or 
CAM planes. Stitching vias are not considered orphaned vias and are not deleted during routing 
optimization.

Exception: While any number of vias can be added to a trace segment, corner, or end point, it is 
not considered a stitching via.

In this topic:

• Add Stitching Vias

• Select Stitching Vias

• Change Stitching Via Types

• Delete Stitching Vias

• Convert Routing Vias into Stitching Vias 

Add Stitching Vias
Stitching vias must be associated with a net. They are added to the design through the net 
selection of an object in the design.

To add a stitching via:
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1. With nothing selected, right-click and click Select Nets.

2. Select a net object.

Tip: Net objects include trace segments, vias, pins, unroutes, copper, copper pours, and 
split planes.

3. Right-click and click Add Via. The new via is attached to the pointer.

4. Click to place the stitching via. Another stitching via attaches to the pointer. You can 
place vias repeatedly.

Tip: If unroutes are visible for the selected net, a new unroute will connect to the 
stitching via.

5. Right-click and click Cancel to stop adding stitching vias.

Result: When you add a via to an unroute, the result is a via with a Stitching setting enabled. 
When you add a via to a trace segment or trace corner, the result is a plain via (unglued). By 
default, stitching vias added to the design are always given the Stitching setting as they are 
added. Vias added to traces are not.

Warning: You can prevent the deletion of stitching vias during ECO operations such as Delete 
Component, Delete Connection, and Delete Pin, as well as during a Change Part or an Unroute 
operation. To preserve stitching vias select the Keep Stitching Vias check box in the Group 
Editing area on the Design page of the Options dialog box.

Select Stitching Vias
You must enable the selection of stitching vias before you can select a stitching via.

To select a stitching via:

1. With nothing selected, right-click and click Filter.

2. In the Selection Filter, on the Object tab, click Stitching. It is a subset of Vias.

3. Click Close.

4. Select a stitching via.

Change Stitching Via Types
You can use any via type, including SMD, through-hole, or partial as a stitching via. If the 
default via is not the correct via, you can modify the via type.

1. Select one or multiple stitching vias.

2. Right-click and click Properties.

3. In the Via Name list, select the correct via.
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Tip: You can use the Pad Stacks dialog box to create new vias. 

Delete Stitching Vias
1. Select the stitching via to delete.

2. Press Delete.

Convert Routing Vias into Stitching Vias
Vias added to a trace segment, corner, or end point, are not considered stitching vias. Like 
stitching vias, these routing vias can be used to interconnect areas of a net, but they are 
considered plain vias. You enable the Stitching setting for a routing via to make it a stitching 
via.

To convert a via into a stitching via:

1. Select one or multiple vias.

2. Right-click and click Properties.

3. Select the Stitching check box.

4. Click OK.

Related Topics

To Glue a Via

Adding Stitching Vias in the Concepts Guide

To Add a Test Point
You can manually add a test point along an existing segment or trace of a route. Test points, by 
default, are not glued and are accessible from the bottom.

To add a test point to an existing segment or trace:

1. Select a trace segment or corner. You cannot use multiple selection when adding test 
points to a route.

2. Right-click and click Add Test Point. A test point is added to the route. The via inserted 
is the type that you click in the Options tab of the DFT Audit dialog box.
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Tip: When the via or pin is flagged as a test point, and Show Test Points is checked on the 
Routing tab of the Options dialog box, an arrow is drawn on it in the design:

In Verb Mode

You can also add test points in Verb mode:

1. Click the Design toolbar button.

2. Click the Add Test Point button on the Design toolbar.

3. Select any trace segment or corner to which you want to add a test point. A test point is 
added to the route. The via inserted is the type that you click in the Options tab of the 
DFT Audit dialog box.

Tips:

• You can also make an existing via or pin a test point.

See also: Via Properties Dialog Box, Pin Properties Dialog Box, Jumper Pin Properties

• If you try to add a test point in an area defined as a test point keepout area and DRC 
mode is set to Prevent Errors, the message “Test point keepout violation” appears and 
the test point is not added.

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing 
operation.

• Tip: When the via or pin is flagged as a test point, and Show Test Points is checked on 
the Routing tab of the Options dialog box, an arrow is drawn on it in the design:

To Delete a Corner
To delete a trace or drafting corners:

1. Select the corner.

2. Click Delete from the Edit menu. The two segments joined at the corner become one 
segment.
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Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

Related Topics

To Move a Corner

Modifying Drafting Corner Properties

To Delete a Via
To delete a via:

1. Select the via.

2. Click Delete on the Edit menu. The via is deleted. The layers of the attached segments 
are changed if necessary.

Tip: If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK to cancel the editing operation.

To Glue a Via
A copied trace only pastes to a valid electrical connection; you cannot paste to empty space. If 
the copied traces are shorter than the target pin pair connection, the ratsnest is continued from 
the end of the copy to the other pin of the pair.

To fix a via against movement for any reason:

1. Select a via > right-click > Properties.

2. Select the Glued check box.

3. Click Apply or OK.

You can fix a via's location to establish it as a test point on the fabricated board. The points of a 
bed of nails test apparatus are matched to the test point locations. So if you redesign and 
remanufacture the board, the glued test points prevent the vias from moving in the new design, 
thus preventing costly retooling of the test equipment.

If you click Test Point, you include the via's location in a report file in a Test Point section. The 
Test Point check box also indicates if the via was automatically installed and glued as a test 
point by an autorouter. Installing test points this way returns test points from the router with 
checked Glue and Test Point check boxes.

To Delete a Miter From a Path
A miter is a diagonal segment or arc that replaces a corner. You can delete all miters from one 
or more routed pin pairs, drafting paths, or polygons:
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1. Select the routed pin pairs, drafting paths, or polygons.

2. Right-click and click Delete Miters. All miters in the selected path are deleted and 
replaced by a 90-degree corner.

To Delete a Route from a Pin Pair
To delete all traces and vias in a routed pin pair:

1. Select the pin pair.

2. Press Del, or click Delete from the Edit menu. A ratsnest line between the two pins 
replaces the routed pin pair.

Connecting a Net with a Plane
Establishing a plane area and connecting the appropriate nets to it is usually one of the first 
routing tasks in the design process. The following two methods establish plane areas:

• Define a Layer as a Plane Type

Use Layer Definition to set an entire layer to Plane type. Use Net Associations to define 
one or more netnames to connect to this layer with thermal reliefs. 

• Draw a Copper Pour Area

Use this method when you want insulated traces passing through the plane area. The 
copper pour area does not require you to define its layer as a plane layer. Instead, assign 
the netname of the net to which you want to connect to the copper pour outline. 

See also: Connecting a Net with a Plane in the Concepts Guide

To Connect SMD Pads to Planes
Routing an SMD pad to a plane involves placing a via to the plane under or somewhere near the 
pad. When vias are in plane nets, they receive a thermal relief pad for the plane layer based on 
the pad outer diameter for the layer, defined in the via's pad stack.

To set the display and connect the SMD pads:

1. View menu > Nets.

2. Select Default in the View List list.

3. Select Traces Plus the Following Unroutes, if necessary, and set View Details to 
None.

4. Click Apply. This removes all the unrouted connections from the display.
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5. Locate your plane nets in the Net List list and add them to the View List list.

6. Select the plane nets and set View Details to All Except Connected Plane Nets. This 
shows full pin-to-pin connections and partially routed copper traces, but not partial 
connections.

7. Click Apply. Now only the plane net connections are visible.

When you install the via, either under the pad or a short distance away, the connection for that 
pin-to-pin connection disappears if you route the connection to the plane layer.

See also: Checking the Plane Connection for Continuity

Converting a Trace to a Copper Chamfered Path
You can convert traces to chamfered copper. Converting traces to a copper chamfered path has 
two advantages over simply creating a copper chamfered path. You can also use the more 
powerful interactive router to initially route the trace and when you convert the trace to a 
chamfered path, the net assignment is automatically made.

1. Select a pin pair, multiple pin pairs, or a net.

Restriction: Unrouted or partially routed pin pairs, or pin pairs belonging to reuse 
blocks, are excluded from selection.

2. Right-click and click Convert to Chamfered Paths.

3. In the Convert Pin Pairs to Chamfered Paths dialog box, select the pins pairs desired. 
Use Ctrl+click, Shift+click, or the Select All and Unselect All buttons as shortcuts.

Restriction: Only the pins pairs selected in the design appear in the Selected pin pairs 
list.

4. In the Conversion parameters area, in the Polygon outline width box, type a width value 
for the width of the copper outline.

Tip: Since copper is created with an outline and a fill, you can specify a very narrow 
outline width to achieve very sharp corners. Decrease the value for sharper corners and 
increase the value for more blunt corners. All corners are rounded with a radius equal to 
one half of the outline width.

5. Select the Use trace width check box to use the trace width as the width of the 
chamfered path. Where multiple trace widths exist, the actual trace widths are used. The 
Selected trace widths value at the top of the Conversion parameters area displays the 
range of trace widths of the items in the Selected pin pairs list.

or

Clear the Use trace width check box and enter a value in the Converted path width box.
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6. In the Corner chamfer width ratio box type a value specifying the ratio of the chamfered 
corner width to the chamfered path width. If the ratio is 1.0, the width of the chamfered 
corner is the same as the chamfered path. Reduce the radio for a more narrow chamfered 
corner.

7. Clear the Chamfer corners with angles less than or equal to check box to chamfer 
only angles less than 90 degrees (acute angles). 

or

Select the Chamfer corner with angles less than or equal to check box to specify an 
angle between 90 and 180 degrees as the upper limit beneath which all angles are 
chamfered. Outside corners less than 90 degrees are always chamfered.

8. Click OK.

Result: The trace is converted to a chamfered path and original trace segments are 
unrouted. Existing vias are retained and are glued.

Related Topics

Creating Copper Chamfered Paths

Restoring Traces After Conversion to Copper Chamfered Paths

Modifying Drafting Object Properties

Restoring Traces After Conversion to Copper 
Chamfered Paths

Original traces are unrouted after conversion to copper. You must re-route traces to replace 
chamfered paths.

1. Use the Select Nets selection filter to select the net.

2. Right-click and click Select Chamfered Paths.

3. Press Delete.

4. Re-route the pin pair, pin pairs, or net.

Restriction: Vias in the chamfered path are not deleted since they are glued during 
conversion from trace to chamfered path.

Editing Properties of Routing Objects
In this section:

• Modifying Net Properties
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• Modifying Pin Properties

• Modifying Pin Pair Properties

• Modifying Trace Corner or Tack Properties

• Modifying Via Properties

• Modifying Trace Segment Properties

Modifying Net Properties
To modify net properties:

1. Select a pin pair > right-click > Select Net > right-click > Properties.

2. Modify settings in the dialog box, if necessary.

3. Click OK when finished.

Tip: Several of the options in this dialog box are unavailable if the net is part of a physical 
design reuse.

Related Topics

Net Properties Dialog Box

View Nets Dialog Box

Modifying Pin Properties
To modify pin properties:

1. Select a pin.

2. Right-click and click Properties. The Pin Properties dialog box appears. You can 
modify the pad stack for the via.

Tips:

• If you modify a pin that is a locked test point, a Warning dialog box may appear 
informing you of changes you are making to the test point and giving you options. 

See also: Troubleshooting

• Several of the options in this dialog box are unavailable if the pin pair is part of a 
physical design reuse.

Modifying Pin Pair Properties
To modify pin pair properties:
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1. Select a pin pair.

2. Right-click and click Properties. The Pin Pair Properties dialog box appears.

3. Modify the settings in the dialog box, if necessary.

4. Click OK when finished.

Related Topics

Pin Pairs Properties Dialog Box

Modifying Trace Corner or Tack Properties
To modify trace corners properties:

1. Select a trace corner > right-click > Properties.

2. In the Connection area, select the connection to which the trace corner belongs.

3. In the X and Y boxes, type the X and Y locations.

4. Click the Pin Pair button to modify settings for the pin pair to which the trace corner 
belongs.

5. Click the Net button to modify settings for the net to which the trace corner belongs.

6. Click the Rules button to modify the pin pair rules for the trace corner.

7. The other areas of the dialog box provide information about the trace corner:

• Net—Shows the net to which the trace corner belongs.

• Protect Status—Shows whether the net (to which the trace corner belongs) is 
protected.

• Layer—Shows the layer on which the trace corner is located.

• Trc/Trc Clearance—Shows the trace to trace clearance rule.

• Rule Hierarchy—Shows the level of the hierarchy at which the pin pair rules are set.

Tips:

• If you select another trace corner while the dialog box is open, the selected corner 
updates with the information.

• Several of the options in this dialog box are unavailable if the corner is part of a physical 
design reuse.

Related Topics

Modifying Pin Pair Properties

Modifying Net Properties
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Design Rule Hierarchy in the Concepts Guide

Modifying Via Properties
To modify via properties:

1. Select a via.

2. Right-click and click Properties. The Via Properties dialog box appears. You can 
modify the following information about all selected vias:

• The via coordinates. You can also use the Move command.

• The via type.

If you select another trace corner while the dialog box is open, the information updates 
for the selected corner.

Tips:

• If you modify a via that is a locked test point, a Warning dialog box may appear 
informing you of changes you are making to the test point and giving you options. 

See also: Troubleshooting

• Several of the options in this dialog box are unavailable if the via is part of a physical 
design reuse.

Related Topics

Via Properties Dialog Box

Modifying Trace Segment Properties
To modify trace segment properties:

1. Select the trace segment.

2. Right-click and click Properties. The Trace Properties dialog box appears. You can 
modify the following information about all selected segments:

• The segment end point coordinates. You can also use the Move command.

• The segment width.

• The segment layer. If you change the layer, vias are automatically added.

3. Click OK. 

If you select another trace segment while the dialog box is open, the information is updated for 
the selected segment.
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Tip: Several of the options in this dialog box are unavailable if the trace is part of a physical 
design reuse.

Troubleshooting Constraints While Routing
When you’re routing and you’re constrained by the design rules, you can access the rules for a 
design object (class, net, group, pin pair, component, or unroute) by selecting the object in the 
design and showing the rules. For example, if there are specific rules defined for the pin pair 
associated with the unrouted connection, the Pin Pair Rules dialog box appears.

To display the Rules dialog box:

1. Select the object whose rules you want to display.

2. Right-click and click Show Rules.

Viewing Protected Routes with Outline Mode
If your design contains protected routes, you can set them to display with the opposite outline 
pattern of other routes. In other words, if normal routes are solid, protected routes are outlined, 
and visa-versa. 

See also: Route Protection in the Concepts Guide

To display protected routes in the opposite outline:

1. Tools menu > Options > Routing tab.

2. Select the Show Protection check box.

3. Click OK.



Routing The Design
Adding a Via Shield

PADS Layout User’s Guide and Reference Manual, PADS 9.4 661

Adding a Via Shield
A via shield is a collection of stitching vias that surround a routed net, pin-pair or copper area. 
You might use a via shield, for example, to surround a net in order to limit noise susceptibility. 
For example:

To add a via shield:

1. If you have not done so, set the options for shielding on the Via Patterns tab. For 
information, see Setting Via Shielding Options.

Tip: PADS Layout stores your Via Pattern settings for future operations. You need to 
perform this step only if you want to change the settings you selected previously.

2. Select a net, pin-pair or copper area.

Tip: To add a via shield around a differential pair, first set the filter mode to either Net 
or Pin-Pair. Then select the two nets or two pin-pairs that make up the differential pair 
and add a via shield around them. For example:

The shielding operation applies a shield to each net; therefore, unwanted vias may 
appear between differential pair traces. If this result happens, you would need to delete 
those vias.

3. Right-click and click Add Via Shield.
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Result: PADS Layout places the vias around the selected net, pin-pair, or copper.

Exception: If the Design Rule Checking setting is Prevent Errors, the Add Via Shield 
operation does not add any via that violates design rules.

Restriction: When you edit traces, PADS Layout does not update the pattern of vias in the via 
shield. After editing traces, you may need to add the via shield again. If that is the case, delete 
the old via shield before adding the new one.

Related Topics

Vias

Options Dialog Box, Via Patterns Page

Autorouting using PADS Router Link

Autorouting Your Design
The PADS Router Link sets up autorouting options for PADS Router and passes information 
from PADS Layout to PADS Router. Data is stored in the design file. Using the link you can 
either run PADS Router and automatically open the current design file in the foreground, so you 
can view the autorouter's progress, or you can run PADS Router in the background. You can 
also save a .pcb file for further use and route it in PADS Router later.

To set up routing options and autoroute your design in PADS Router from PADS Layout:

1. Tools > PADS Router.

2. In the Action area, Select the action you want to perform. The options are:

Open PADS Router — Opens PADS Router and loads the design file into it. You can 
make changes to the design file in PADS Router (rather than PADS Layout) before 
routing. 

Autoroute in Background — Opens PADS Router and PADS Router Monitor, but 
runs PADS Router in the background. Layout commands are disabled and a wait cursor 
shown until autorouting is completed or the Stop button is selected in the Router 
Monitor. 

Autoroute in Foreground — Opens PADS Router and PADS Router Monitor, and 
runs PADS Router in the foreground making it the active program. 

Save PCB File — Stores the selected routing strategy in the current design. This option 
does not open PADS Router or PADS Router Monitor, but saves a .pcb file that you can 
later open and route in PADS Router.

3. Click Setup in the Routing Strategy area to set the routing strategy.

See also: Setting up a Routing Strategy
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4. In the Options area, click which Options dialog box tab you want to appear when you 
click Setup.

See also: Setting Options

5. Type an output file name or click Save As to select one. Output files to PADS Router 
have the same .pcb extension as other PADS Layout design files.

Tip: You can use only PowerPCB 3.5 and higher files in PADS Router.

6. Click Proceed.

If you clicked Run in Background, the PADS Router Monitor appears, but PADS Router does 
not appear on your desktop.

If you clicked Run in Foreground, the PADS Router Monitor appears. PADS Router also opens 
and automatically autoroutes the current PADS Layout design.

See also: PADS Router Monitor Dialog Box

Setting up a Routing Strategy
Use the Routing Strategy dialog box to define a strategy for autorouting a design. The strategy 
defines the sequential operations to perform during autorouting, including: 

• Passes that the autorouter should run.

• Order in which to autoroute components, nets, net classes, differential pairs, and 
matched length groups.

Use the Routing Strategy dialog to specify which passes to run, routing intensity, whether or not 
to protect the generated traces, whether to pause after a pass completes, and the order in which 
to autoroute components, nets, net classes, differential pairs, and matched length groups for the 
selected pass.

Procedure

1. Tools menu > PADS Router.

2. In the Routing Strategy area, click Setup.

3. In the Routing Strategy dialog box, in the Pass column, select each pass type you want 
to run. You can run any combination of passes. 

4. In the Protect column, select those passes after which to protect the generated traces. 
This protects traces and glues vias that are completed during the corresponding pass 
type.

5. In the Pause column, select the pass after which you want to pause routing. 

Tips: 
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• To continue after a paused pass when autorouting in the foreground, click the 
Resume Autrouting button on the Routing toolbar in PADS Router (or press F10).

• To continue after a paused pass when autorouting in the background, click the Stop 
button in the PADS Router Monitor dialog box.

6. In the Intensity column, select the appropriate intensity. Intensity determines the effort 
and time the router can spend on a pass. 

Restriction: You cannot set an intensity for the Center pass.

7. To set the routing order:

a. Click the field for the Pass Type you want in the Routing Order column.

b. To add items to the routing order, do any of the following:

• To add all nets associated with plane layers, click Plane Nets.

• To add individual objects, select the ones you want to add in the left area 
(Routing order definition), and then click Selected.
Tip: Objects available in this area change depending on what you select in the 
filter list above it.

• To remove all items from the Routing Order list, click Clear. 

c. Use the Routing Order area buttons to delete and move items.

8. Click OK.

Results

The routing strategy is saved in the \PADS projects folder. When you autoroute the 
design, these settings are used. If the dialog box is open, a check mark appears in the 
Done column upon completion of each pass.

Related Topics

Autorouting Pass Types in the Router Concepts Guide

Clearance and Checking After Routing
Trace Clearance is the distance allowed between a trace edge and the edge of another 
conducting item. Assign this property to nets in the Design Rules Clearance dialog box. If you 
use the Extended design rules option, you can assign nondefault clearance on the pin pair, pin 
pair group, net, and net class level.

Use the Verify Design command from the Tools menu to search the design for clearance 
violations. Verify Design marks each violation and enables you to center the view on each 
violation.
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Setting up clearances for traces, as well as pads and vias, is described in Design Rules. 
Checking for errors (spacing errors, airgap errors, and high-speed problems) is discussed in 
Verify the Design.
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Chapter 32
Filling Copper, Copper Pour Areas, and Plane

Areas

In this chapter:

• Flooding a Copper Pour Area

• Hatching a Copper Pour Area

• Setting Flooding Order of Overlapping Copper Pour and Plane Areas

• Flooding Over Pads in a Copper Pour or Plane Area

• Flooding Over Vias in a Copper Pour or Plane Area

• Filling a Shape with a Pattern of Vias

• Placing Vias Inside the Perimeter of a Shape

• Surrounding a Void with Vias

Flooding a Copper Pour Area
Flooding recalculates the pour area and recreates all clearances for the current obstacles within 
the pour outline, observing clearance rules. Use Flood if you change clearance rules, or make 
changes to—or within—a copper pour area that might create clearance violations.

Flooding fills the copper pour area with copper in a hatched or solid pattern, creating isolation 
areas around copper, traces, and pads that are inside the copper pour outline but are not part of 
the same net. It also creates thermal relief connections around pins that belong to the same net. 

The flood operation uses the settings in the Drafting, Thermals, and Grids tabs in the Options 
dialog box, as well as the flood and hatch options.

Tip: If you have overlapping outlines on the same layer having the same flood priority, PADS 
Layout cannot determine which one is the obstacle and which one is the standoff around the 
obstacle. To avoid conflicts, the overlapping or common section is drawn as a non-hatch area.

There are three methods to flood one or more copper pours.

Method 1

1. Select the copper pour area(s).
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2. Right-click and click Flood.

Method 2

1. Drafting toolbar > Flood button

2. Select a copper pour area to Flood.

3. Click and flood other copper pour areas as needed.

Method 3

1. Tools menu > Pour Manager

2. In the Pour Manager dialog box, click the Flood tab.

3. Set the Flood Mode.

4. Click Start to start the flood process.

Results

Is the resulting shape what you expected?

• If the gap between the pad and the copper for thermals or antipads is incorrect, see 
Customizing Design Rule Thermals or Customizing Design Rule Antipads of Copper 
Pours.

• If the fill is not correct, see The Fill of Copper, Copper Pour and Plane Shapes.

• If the shape edges are not correct, see Edge Precision of Drafting Shapes.

• If the shape needs to be modified, see Modifying Drafting Object Properties.

• If you want to start over, see Deleting a Drafting Segment or Object.

Related Topics

Assigning Copper to a Net

Hatching a Copper Pour Area

Hatching a Copper Pour Area
Hatching refills (with hatch lines) existing pour areas for the current session; it does not 
recalculate the pour area. Each time you open a design file, you must hatch the design; the fill is 
not saved. Use Flood if you change clearance rules, or make changes to—or within—a copper 
pour area that might create clearance violations.
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Restriction

You can only hatch a copper pour area that has already been flooded. This converts the pour 
outline to a hatch Outline.

There are three methods to hatch one or more copper pours.

Method 1

1. Select the copper pour area(s).

2. Right-click and click Hatch.

Method 2

1. Drafting toolbar > Hatch button

2. Select a copper pour area to Hatch.

3. Click and hatch other copper pour areas as needed.

Method 3

1. Tools menu > Pour Manager

2. In the Pour Manager dialog box, click the Hatch tab.

3. Set the Hatch Mode.

4. Click Start to start the hatch process.

Results

Is the resulting shape what you expected?

• If the gap between the pad and the copper for thermals or antipads is incorrect, see 
Customizing Design Rule Thermals or Customizing Design Rule Antipads of Copper 
Pours.

• If the fill is not correct, see The Fill of Copper, Copper Pour and Plane Shapes.

• If the shape edges are not correct, see Edge Precision of Drafting Shapes.

• If the shape needs to be modified, see Modifying Drafting Object Properties.

• If you want to start over, see Deleting a Drafting Segment or Object.

Related Topics

Flooding a Copper Pour Area
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Flooding a Plane Area
Flooding recalculates the plane area and recreates all clearances for the current obstacles within 
the plane outline, observing clearance rules. Use Flood if you change clearance rules, or make 
changes to—or within—a plane area that might create clearance violations.

Flooding fills the plane area with copper in a hatched or solid pattern, creating isolation areas 
around copper, traces, and pads that are inside the plane outline but are not part of the same net. 
It also creates thermal relief connections around pins that belong to the same net. 

The flood operation uses the settings in the Drafting, Thermals, Split/Mixed Plane and Grids 
tabs in the Options dialog box, as well as the flood and hatch options.

Tip: If you have overlapping outlines on the same layer having the same flood priority, PADS 
Layout cannot determine which one is the obstacle and which one is the standoff around the 
obstacle. To avoid conflicts, the overlapping or common section is drawn as a non-hatch area.

There are three methods to flood one or more plane areas.

Method 1

1. Select the plane area(s).

2. Right-click and click Flood.

Method 2

1. Drafting toolbar > Flood button

2. Select a plane area to Flood.

3. Click and flood other plane areas as needed.

Method 3

1. Tools menu > Pour Manager

2. In the Pour Manager dialog box, click the Plane Connect tab.

3. Select the layer to flood.

4. Click Start to start the flood process.

Results

Is the resulting shape what you expected?

• If the plane did not fill, see Troubleshooting Plane Area Fills.
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• If the plane filled, but opened a Thermal Relief Errors Report (therm.err), see 
Troubleshooting Thermal Results.

• If the gap between the pad and the copper for thermals or antipads is incorrect, see 
Customizing Design Rule Thermals or Customizing Design Rule Antipads of Plane 
Areas.

• If the fill is not correct, see The Fill of Copper, Copper Pour and Plane Shapes.

• If the shape edges are not correct, see Edge Precision of Drafting Shapes.

• If the shape needs to be modified, see Modifying Drafting Object Properties.

• If you want to start over, see Deleting a Drafting Segment or Object.

Tips: 

• To see the plane data in a negative mode, use the C modeless command. 

• You can use the Split/Mixed Plane tab in the Options dialog box to view only the 
thermals or only the plane polygon outlines. The Mixed plane display setting in the 
Split/Mixed Plane tab is automatically changed to Generated plane data when you flood 
the plane.

See also: Split Planes in the Concepts Guide

Related Topics

Setting Flooding Order of Overlapping Copper Pour and Plane Areas

Setting Flooding Order of Overlapping Copper 
Pour and Plane Areas

To determine which copper pour or plane area should be flooded first, you must set a flood 
priority for each object. An object with a lower priority number will be flooded before an object 
with a higher one. Copper pours or plane areas on different layers are processed independently.

Procedure

1. Right-click > Select Shapes.

2. Select the copper pour or plane area. The area you select cannot be a hatch outline or 
plane hatch outline.

Tip: To quickly give the area the highest priority, bring it to the front (right-click > 
Bring to front; to give it the lowest priority, send it to the back (right-click > Send to 
back).

3. Right-click > Properties
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4. In the Drafting Properties dialog box, click the Options button. If the button doesn’t 
appear, you’ve selected a hatch outline.

5. In the Flood and Hatch Options dialog box, set the flood priority. 0 (zero) is the highest 
priority (that is, it is flooded first and can’t be flooded over), and 250 the lowest. 

Tip: You can also see the new flood priority number in the status bar as P:<number>, 
when you select the area.

6. Click OK to close all open dialog boxes.

Related Topics

Copper Pour and Plane Area Flood Priorities in the Concepts Guide

Using Keepouts

Flooding Over Pads in a Copper Pour or Plane 
Area

You can flood over pads or vias in a copper pour or plane area. This topic describes how to 
flood over pads. To flood over vias, see Flooding Over Vias in a Copper Pour or Plane Area.

There are two ways to flood over pads in a plane area: using the Thermals Options dialog box 
and using a custom thermal in the pad stack. There is only one way to flood over a copper pour: 
using the Thermal Options dialog box.

Using the Thermal Options Dialog Box
Use this procedure to flood over pads in a copper pour or a plane area.

Procedure

1. Tools menu > Options.

2. Click the Thermals tab.

3. In the area you want (drilled or non-drilled) select the pad shape to flood over.

4. Click Flood over.

5. Repeat steps 2 and 3 for each pad shape you need to flood over.

6. Click OK.

7. Re-flood the area.
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Results

The selected area is flooded with copper. All of the pad shapes you chose in Step 2 are flooded 
over.

Using a Custom Thermal in the Pad Stack
Use this procedure to flood over pads in a plane area. Use this procedure if you don’t want to 
flood over every object in a certain shape; you can flood over selected pad stacks.

Procedure

1. Setup menu > Pad Stacks.

2. In the Pad Stacks Properties dialog box, in the Pad Stack Type area, select Decal.

3. Select the decal name in the Decal name list.

4. Select the pin(s) you want from the Pin: Plated list.

5. Choose the layer you want from the Sh: Sz: Layer list.

6. In the Parameters area, select Thermal from the Pad style list.

7. Select the appropriate pad shape button.

8. Select the Flood over check box.

9. Click OK and then click Yes to apply the changes to all components with that decal 
type.

Results

The selected pads stacks are flooded over in the copper area.

Related Topics

Flooding Over Vias in a Copper Pour or Plane Area

Flooding Over Vias in a Copper Pour or Plane 
Area

You can flood over pads or vias in a copper pour or plane area, this topic describes how to flood 
over vias. To flood over pads, see Flooding Over Pads in a Copper Pour or Plane Area.

There are two ways to flood over vias in a plane area: setting the drafting properties of the area 
and using a custom thermal in the pad stack. There is only one way to flood over vias in a 
copper pour: setting the drafting properties of the area.
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Setting the Drafting Properties of the Area

Use this procedure to flood over vias in a copper pour or a plane area.

1. Select the pour or plan area outline.

2. Right-click and click Properties.

3. Click the Options button.

4. In the Flood and Hatch Options dialog box, select the Flood over vias check box.

5. Click OK and then click Yes to proceed with the flood.
Tip: Click No to flood the area later on. 
See also: Flooding a Copper Pour Area.

6. Close the Drafting Properties dialog box.

Results

The selected area is flooded with copper. Any vias connected to the net will be flooded over, 
and there are no longer any thermals on vias.

Using a Custom Thermal in the Pad Stack

Use this procedure to flood over vias in a plane area. Use this procedure if you don’t want to 
flood over every object in a certain shape; you can flood over selected pad stacks.

1. Setup menu > Pad Stacks.

2. In the Pad Stacks Properties dialog box, in the Pad Stack Type area, select via.

3. Select the via name in the Decal name list.

4. Choose the layer you want from the Sh: Sz: Layer list.

5. In the Parameters area, select Thermal from the Pad style list.

6. Select the appropriate pad shape button.

7. Select the Flood over check box.

8. Click OK and then click Yes to apply the changes to all vias of that type.

Results

The selected pads stacks are flooded over in the copper area.

Related Topics

Flooding Over Pads in a Copper Pour or Plane Area
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Filling a Shape with a Pattern of Vias
To fill a shape (such as a flooded copper pour or a hatch outline for a copper pour) with a 
pattern of stitching vias, use the Via Stitch operation in Fill mode. For example:

Figure 32-1. Shape Stitched with Vias

To fill a shape with vias:

1. If you have not done so, set the options for stitching shapes in the Via Patterns Options. 
For information, see Setting Options for Via Patterns.

Set the Pattern setting to Fill on the Via Patterns tab or set it after you select the object. 
(See Step 3.)

Tip: PADS Layout stores your Via Pattern settings for future operations. You need to 
perform this step only if you want to change the settings

2. Select the shape you want to stitch with vias. The shape can be:

• Drawn copper

• A flooded copper pour or a plane area

• A hatch outline for a copper pour or a plane area

Requirement: The copper or hatch outline must be associated with a net.

3. Right-click and click Via Stitch.

Tip: To override the Pattern (Fill or Perimeter) setting in the Via Patterns Options, 
select Via Stitch Mode. Then select the pattern.

Result: PADS Layout fills the selected copper or hatch outline with the pattern of vias.
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Exception: If the Design Rule Checking (DRC) setting is Prevent Errors, the Via Stitch 
operation does not add any via that violates design rules.

Related Topics

Vias

Placing Vias Inside the Perimeter of a Shape

Placing Vias Inside the Perimeter of a Shape
You place vias inside the perimeter of a copper area or a hatch outline by using the Via Stitch 
command in Perimeter mode. For example:

To place vias inside the perimeter of a shape:

1. If you have not done so, set the options for stitching shapes in the Via Patterns Options. 
For information, see Setting Options for Via Patterns.

Set the Pattern setting to Perimeter on the Via Patterns tab or set it after you select the 
object. (See Step 3.)

Tip: PADS Layout stores your Via Pattern settings for future operations. You need to 
perform this step only if you want to change the settings

2. Select the shape you want to stitch with vias. The shape can be:

• Drawn copper

• A flooded copper pour or a plane area

• A hatch outline for a copper pour or a plane area

3. Right-click and click Via Stitch.

Tip: To override the Pattern (Fill or Perimeter) setting in the Via Patterns Options, 
select Via Stitch Mode. Then select the pattern.
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Exception: If the Design Rule Checking (DRC) setting is Prevent Errors, the Via Stitch 
operation does not add any via that violates design rules.

Related Topics

Filling a Shape with a Pattern of Vias

Surrounding a Void with Vias
When you use the Via Stitch operation to place vias inside the perimeter of a shape, by default 
the operation does not place vias around a void within that shape.

Requirement: Exit PADS Layout before you edit the powerpcb.ini file.

To change the default behavior for the Via Stitch operation:

1. In a text editor, open the powerpcb.ini file. The file’s location is:

C;\MentorGraphics\<PADSrelease>\SDD_Home\Programs

2. Change the VS_StitchVoids value to 1. For example:

[ViaShield]
VS_StitchVoids=1

3. Restart PADS Layout.

Result: The Via Stitch operation not only places vias inside the perimeter of a shape but also 
surrounds voids within the shape. For example:

Figure 32-2. Vias Surrounding a Void
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Chapter 33
Reference Designators

In this chapter:

• Generating a Second Set of Reference Designators for Assembly Drawings

• To Move a Reference Designator

• To Move Reference Designators for Silkscreens

• To Hide Reference Designators

Generating a Second Set of Reference 
Designators for Assembly Drawings

You can generate a second set of reference designators, from the components on your board, to 
place on the Assembly Drawing layers. For assembly drawings, you typically place the 
reference designators in the center of the components. But for the silkscreen, you place the 
reference designators outside the component. Instead of moving the reference designators for 
the silkscreen gerber file, and the assembly drawings, you create a second set for the assembly 
drawings. While you can add two sets of reference designators when you create the decal, the 
following procedure assumes you only have one set of reference designators on the silkscreen 
layers, placed optimally for the silkscreen.

Procedure

1. Select all components on the top or bottom layer. You might need to hide the opposite 
mounted layer or set your selection filter to select only objects on the one layer.

2. Right-click and click Add New Label. 

3. In the Add New Part Label dialog box, ensure the Attribute list is set to Ref.Des.

4. In the Layer list, select Assembly Drawing Top or Assembly Drawing Bottom.

5. Use the Position and sizes area to move all reference designators to the origin of 
components. This is a quick way to center reference designators of surface mount 
components and any other components whose origin is at the center and not pin 1.

a. In the Position and sizes area, select the Relative to Component check box.

b. In the X and Y boxes, type 0 (zero).

c. In the Justification area, for both Horizontal and Vertical lists, click Center.
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6. Click OK.

7. You will need to manually center any components with origins not a the center of the 
component. See To Move a Reference Designator.

Related Topics

To Hide Reference Designators

To Move Reference Designators for Silkscreens

Selecting Items

To Move a Reference Designator
Using Object Mode

To move a reference designator:

1. Select a reference designator > Design Toolbar button > Move Reference Designator 
button.

2. Click to indicate a new location for the reference designator.

Using Verb Mode

To move a reference designator:

1. Design Toolbar button > Move Reference Designator button.

2. Select the reference designator that you want to move. The reference designator attaches 
to the pointer.

3. Click to indicate a new location for the reference designator.

To Move Reference Designators for Silkscreens
To move reference designators to silkscreen layers:

1. Click Filter from the Edit menu to open the Selection Filter dialog box and turn on only 
the Labels check box. Click to clear all other check boxes. Close the Selection Filter.

2. Click Display Colors from the Setup menu to open the Display Colors Setup dialog box 
and click to clear all layers except Top and Silkscreen Top. Set a non-background color 
to the Reference Designator column for the Top and Silkscreen Top layers. Close the 
Display Colors Setup dialog box.

3. Using the Layer list on the standard toolbar, click Top as the active layer.
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4. With nothing selected, right-click and click Select All. The reference designator labels 
on the Top layer are selected. If the components do not have reference designator labels, 
create them.

5. Right-click and click Properties.

6. Change the layer for the labels to Silkscreen Top, and click OK. The reference 
designator labels move to the Silkscreen Top layer.

7. Repeat this procedure for labels on the bottom layer, moving them to the Silkscreen 
Bottom layer.

Related Topics

Generating a Second Set of Reference Designators for Assembly Drawings

To Hide Reference Designators

Selecting Items

To Hide Reference Designators
Result: The Part Label Properties dialog box appears.

To hide the display of reference designators:

1. Select a reference designator > right-click > Properties.

2. Click None from the Show list.

3. Click OK. The reference designators are hidden.

Tip: You can hide the display of reference designators by layer using the Display Colors Setup 
dialog box.

Related Topics

Generating a Second Set of Reference Designators for Assembly Drawings

To Move Reference Designators for Silkscreens

Selecting Items
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Chapter 34
Using the ECO Toolbar

Use the ECO Toolbar to:

• Make engineering (netlist) changes to a schematic-driven design.

When laying out a schematic-driven design, you need to record any netlist changes you 
make in order to back-annotate them to the schematic. To do this, you work in ECO 
mode to record your changes, and use the ECO toolbar tools to make the changes, which 
are saved in a text file called the ECO file (.eco). Then you use the ECO file to back-
annotate the changes to the schematic.

Tip: You can also create an ECO file by using the Compare/ECO dialog box (Tools 
menu > Compare/ECO).

• Create a layout-driven design.

In a layout-driven design (with no schematic), you use the tools in the ECO toolbar to 
create the netlist (add parts and make connections). Since there is no schematic to back-
annotate to, you don’t need to save changes in an ECO file.

In this chapter:

• Recording ECO Changes

• ECO Mode Operations (Layout Driven Design Tools)

Recording ECO Changes
If you are working on a schematic-driven design, you will need to back-annotate design changes 
to the schematic. Use the following procedure to record your netlist changes and save them to 
an ECO file.

Procedure

1. Standard Toolbar > ECO Toolbar button. The first time you use the ECO toolbar in a 
session, the ECO Options dialog box appears. If it doesn’t appear, click the ECO 
Options button on the ECO toolbar.

2. Select the Write ECO file check box.

3. Make sure that the pathname of the .eco file in the Filename box is correct.

Tip: If the file doesn’t exist, it is created and recorded changes are written to it. Existing 
.eco files are left untouched.
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4. If the .eco file already exists, specify what to do with it:

• To append ECO changes you make in this session to the existing file, select Append 
to file. 

• To overwrite the existing file with the changes you make in this session, clear 
Append to file.

5. Specify when ECO changes will be saved:

• To be able to save ECO changes incrementally during the session, so you can view 
them in the ECO file, select Write ECO file after closing ECO toolbox. 

• To save ECO changes only when you save the .pcb file, open a new file, or exit 
PADS Layout, clear Write ECO file after closing ECO toolbox.

6. Set the other options as appropriate. See ECO Options Dialog Box.

7. Click OK.

Result

Any netlist changes you make will be recorded. If you have checked the Write ECO file after 
closing ECO toolbox check box, the changes will be written to the ECO file when you close the 
ECO toolbox; otherwise they will be saved when you save the design, open a new file, or exit 
the software. 

If you clear the Write ECO file or the Write ECO file after closing ECO toolbox option 
during a session, all recorded change data, both in memory and in the ECO file, are deleted.

ECO Mode Operations (Layout Driven Design 
Tools)

The topics in this section describe operations you can perform only in ECO mode.

Restriction

A protected route or physical design reuse element can prevent you from making ECO changes. 
You must unprotect the route or break the reuse to proceed. If you are recording changes to an 
ECO file, the action of removing the protection on traces or breaking out reuse elements is not 
saved.

Component Operations

Adding a Component in ECO Mode

Changing the Reference Designators of Multiple Components in ECO 
Mode (Autorenumbering)
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Adding a Connection in ECO Mode
You can create a new pin pair to change the current netlist.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Procedure

1. ECO Toolbar button > Add Connection button.

Changing a Component in ECO Mode

Updating a Part Type from the Library in ECO Mode

Copying a Part in ECO Mode

Deleting a Component in ECO Mode

Changing the Reference Designator of a Component in ECO Mode

Changing the Reference Designator Prefix of Multiple Components in 
ECO Mode

Swapping a Gate Manually in ECO Mode

Swapping All Gates Automatically in ECO Mode

Swapping a Pin Manually in ECO Mode

Swapping All Pins Automatically in ECO Mode

Undoing the Last Swap

Illegal Characters in Netnames and Part Names

Net/Connection Operations

Adding a Connection in ECO Mode

Adding a Route in ECO Mode

Deleting a Connection in ECO Mode

Splitting a Net in ECO Mode

Deleting a Net in ECO Mode

Renaming a Net in ECO Mode

Copying Bridge Copper in ECO Mode

Illegal Characters in Netnames and Part Names
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Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select the first pin in the connection.

Tips: 

• You can rename the net of the current pin. Right-click and click Rename Current 
Net. In the Rename Net prompt type the new name, and click OK. The maximum 
netname length is 47 characters. 
See also: Illegal Characters in Netnames and Part Names

• You can choose to use the pin function as the net name. Right-click and click Derive 
Net Name from Pin Function.

3. Select the second pin in the connection. If you are connecting to a pin of a different net 
(merging two nets), the Define Name of Merged Net dialog box appears. Choose a new 
netname. (Netnames are automatically generated for each newly created connection.)

See also: Predefined Netnames in The PADS Layout Concepts Guide

4. Click another pin to add additional connections, or right-click and click Cancel to stop 
adding connections.

Related Topics

Illegal Characters in Netnames and Part Names

Adding a Route in ECO Mode
You can create routes that add to or change the current netlist, or that end a route on a segment 
with a different netname.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Procedure

1. ECO Toolbar button > Add Route button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select the pin at which to start the trace.

Restriction: With On-line DRC in Prevent errors mode, when routing a trace between 
pins that are not part of the same net or that have no netlist - all items are considered 
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obstacles. To connect to the pin, right-click and click Select Target and select the pin at 
which you want to end the trace.

Tip: During ECO-mode routing, with Online DRC disabled, the pointer changes to a 
bull's-eye when it is near any eligible completion point, regardless of the net.

3. Add corners and vias as described in “Routing Manually.” You can also use the shortcut 
menu to control routing operations.

Tips: 

• You can rename the net of the current pin. Right-click and click Rename Current 
Net. In the Rename Net prompt type the new name, and click OK. The maximum 
netname length is 47 characters. 
See also: Illegal Characters in Netnames and Part Names

• You can choose to use the pin function as the net name. Right-click and click Derive 
Net Name from Pin Function.

4. If you are connecting to a pin of a different net (merging two nets), the Define Name of 
Merged Net dialog box appears. Choose a new netname. (Netnames are automatically 
generated for each new connection.)

See also: Predefined Netnames in the Concepts Guide

5. Right-click and click Cancel to exit Add Route mode.

Related Topics

Illegal Characters in Netnames and Part Names

Adding a Component in ECO Mode
You can add a component and change the netlist of a design.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Procedure

1. ECO Toolbar button > Add Component button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. In the Get Part Type from Library dialog box, to filter the part types, in the filter area, 
type a wildcard or expression in the Items box and click Apply.
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Restriction: The Filter Items box cannot be empty. Add a * (asterisk) to see all items of 
the library in the Part Types list.

3. Select the part name in the Part Types list and click Add. The component attaches to 
the pointer.

• If the selected part type already exists in the design with the specified name, the 
message “Part Type <name> already exists in design. Loading from Library is 
skipped, design's Part Type will be used” appears. Click OK to continue. Go to step 
4.

• If the specified part type does not exist in the design, but the decal name does exist, 
the message “Decal(s) <name> already exists in design. Loading of decal(s) from 
Library is skipped, design's data will be used” appears. This message appears only if 
the number of terminals in the library part and the design part are the same. Click 
OK to continue. Go to step 4.

• If the specified part type does not exist, and the number of terminals in the new decal 
does not match the number of terminals in the existing decal, the message “Decal 
<name> already exists in design. Library decal has different number of terminals 
than decal in design. Aborting Get Part Type from Library” appears. The Add Part 
process cancels in this case.

• If the number of terminals does not match in the alternate decals, the message 
“Library Part Type <library name:part type name> has decals with different number 
of terminals. Aborting Get Part Type from Library” appears. The Add Part process 
cancels in this case.

Tip: You cannot add a decal to a design if the design is in default layer mode and the 
decal to be added is in increased layer mode. Use the Layers Setup dialog box to change 
the design to increased layer mode.

4. Click Close to close the dialog box.

5. Optional: Assign a reference designator. Unless you assign a reference designator, the 
new part is automatically annotated with the next available reference designator. You 
can change the reference designator before placing the new component. 

• Right-click and click Rename Current Part. The Rename Part prompt appears 
asking for a new reference designator. Type the new reference designator, and click 
OK.

6. Move the part to the new location and click to indicate the new position.

Tip: A part must be ECO-registered to be included in the ECO file. You set the ECO 
registration for parts in the Part Information dialog box.

Related Topics

Updating a Design from the Library
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Changing the Reference Designators of Multiple 
Components in ECO Mode (Autorenumbering)

After you complete the final placement of a design, you can renumber the parts to order the 
reference designators in a recognizable pattern, such as top to bottom, left to right. This makes it 
easier to find a component on a fabricated board. 

Autorenumbering is an ECO operation, so you must start ECO mode before you can 
autorenumber parts. The resulting ECO file contains part name changes for backward 
annotation to the associated design file.

Caution
If you are renumbering a schematic-driven design that will be back-annotated to the 
schematic, you must record the autorenumber operation by checking the Write ECO file 
check box in the ECO Options dialog box before you renumber. Recording the exact 
changes in an .eco file gives the best back annotation results. For more information, see 
Recording Versus Generating an ECO File in the Concepts Guide.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Jumpers are excluded from autorenumbering.

Restriction

A protected route or physical design reuse element can prevent you from changing a reference 
designator. You must unprotect the route or break the reuse to proceed. If you are recording 
changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

Procedure

1. ECO Toolbar > Auto Renumber button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. In the AutoRenumber Dialog Box, make sure the reference designation prefixes you 
want to use are selected in Prefix List. You must select at least one prefix.

3. In the Cell Size area, type the matrix size for the renumbering sweep.

4. Make your renumbering choices in the Precedence area:
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• For designs with parts on both top and bottom, select the Continuous numbering 
side to side check box to number all parts sequentially. In Start Renumbering 
From click either Top or Bottom. 

• For the Top and/or Bottom select the Renumber check box and indicate the Start at 
value and the Increment value if applicable. 

• Click a renumbering pattern button for one or both sides.

5. Click OK.

Result

• Are the results not what you expected? You can undo the renumbering and start over.

• Did the board get renumbered properly? Are there unexpected numbering results? See 
AutoRenumber Sweeps.

Related Topic

Recording Versus Generating an ECO File in the Concepts Guide.

Recording ECO Changes

Backward Annotating from PADS Layout to PADS Logic

Back Annotating from PADS Layout to DxDesigner

Changing a Component in ECO Mode
Use Change Component to change the part type of one or more components, or all part types of 
the same name, to the part type of another component in the design or to a part type in the 
library. The updated part type may contain a different decal assignment which can affect routing 
in the design. You can also update the part type with a newer version from the library.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restrictions

• A protected route or physical design reuse element can prevent you from changing a 
component in ECO mode. You must unprotect the route or break the reuse to proceed. If 
you are recording changes to an ECO file, the action of removing the protection on 
traces or breaking out reuse elements is not saved.
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• You cannot add a decal to a design if the design is in default layer mode and the decal to 
add is in increased layer mode. Use the Layers Setup dialog box to change the design to 
increased layer mode.

Procedure

1. ECO Toolbar button > Change Component button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Turn Online DRC (Design Rules Checking) off by typing DRO and pressing Enter.

3. Select the component or components whose part type you want to change. To select a 
single component, click the component in the design area. To select multiple 
components, right-click and click Find to use the Find dialog box. For more 
information, see Find Objects dialog box.

4. Change the component using one of the following:

a. To change the component to a different part type from the design, click the 
component whose part type you want to use as the replacement.

b. To change the component to a part type from the library, right-click and click 
Library Browse. The Get Part Type from Library dialog box appears. To filter the 
part types, in the filter area, type a wildcard or expression in the Items box and click 
Apply. Locate and select the item, and then click Replace.

• If the selected part type already exists in the design with the specified name, the 
message “Part Type <name> already exists in design. Loading from Library is 
skipped, design's Part Type will be used” appears. Click OK to continue.

5. In the Change Component dialog box, you are prompted to confirm the change. Select 
the Keep Attributes check box if you want to retain the attributes of the part in the 
design.

6. If the modified Part Type changes the PCB decal or contains different pin numbers, you 
must map the old decal pin numbers to the new decal pin numbers in the Assign Pin 
Numbers Dialog Box.

Result

• Change Component retains test points if the pin position is the same and the new 
terminal still has pads on the testing side; otherwise the test point is removed.

Related Topics

Updating a Part Type from the Library
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Updating a Part Type from the Library in ECO Mode
You can update part type data from a new version in the library. The updated part type may 
contain a different decal assignment which can affect routing in the design. You can also change 
a component to another part type in the design or in the library.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restrictions

• You cannot add a decal to a design if the design is in default layer mode and the decal to 
add is in increased layer mode. Use the Layers Setup dialog box to change the design to 
increased layer mode.

• A protected route or physical design reuse element can prevent you from updating a part 
type in ECO mode. You must unprotect the route or break the reuse to proceed. If you 
are recording changes to an ECO file, the action of removing the protection on traces or 
breaking out reuse elements is not saved.

Procedure

1. ECO Toolbar button > Change Component button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Turn On-line DRC (Design Rules Checking) off by typing DRO and pressing Enter.

3. Select the component or components whose part type you want to update.

4. Right-click and click Library Browse.

5. In the Get Part Type from Library dialog box, select the Update Part Type from 
Library check box to update the selected part type with a new library definition of the 
same name. The search locates and automatically highlights the library definition for the 
selected part type.

6. Click Replace.

7. If there are additional components with the selected part type that you did not select in 
the design, you are prompted with the message, “Part type <name> will be replaced with 
Library item for ALL parts of this type in the design”. Click OK.

• Restriction: You must update all components which use the same part type.

8. You are prompted to confirm the change. Select the Keep Attributes check box if you 
want to retain attributes.
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9. If the modified Part Type changes the PCB decal or contains different pin numbers, you 
must map the old decal pin numbers to the new decal pin numbers in the Assign Pin 
Numbers Dialog Box.

Result

• Change Component retains test points if the pin position is the same and the new 
terminal still has pads on the testing side; otherwise the test point is removed.

Related Topics

Assign Pin Numbers Dialog Box.

Changing a Component in ECO Mode

Copying a Part in ECO Mode
Creating a copy of an existing part changes the netlist, is considered an engineering change and 
requires ECO mode.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Procedure

1. In the design, select the part to copy.

2. ECO Toolbar button > Add Component button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

Alternative: On the Edit menu, click Copy and then Paste. 

3. The component attaches to the pointer.

4. Optional: Assign a reference designator. Unless you assign a new reference designator, 
the new part is automatically annotated with the next available reference designator. 
You can change the reference designator before placing the new component. 

• Right-click and click Rename Current Part. The Rename Part prompt appears 
asking for a new reference designator. Type the new reference designator, and click 
OK.

5. Move the part to the new location, and click to indicate the new position.
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Deleting a Component in ECO Mode
Deleting a component from the board changes the netlist, is considered an engineering change 
and requires ECO mode.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restriction

A protected route or physical design reuse element can prevent you from deleting a component 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are recording 
changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

Procedure

1. ECO Toolbar button > Delete Component button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Set the selection filter to Select Components.

3. Select one or multiple components to delete.

Tip: You can select multiple components by dragging a box around them.

4. In the Delete Part dialog box, you can optionally select the Delete Routes check box to 
delete routes that are connected to the component.

5. Click OK to confirm the deletion.

6. If the deletion of the component(s) creates single-pin nets, a second Delete Part dialog 
box appears and displays which nets will also be deleted. This is not an optionally step. 
Click Close.

Result

Test points are deleted with the part.

Deleting a Connection in ECO Mode
Use Delete Connection to delete a pin pair, disconnect a pin from a net, or split a net into two 
different nets. This also deletes test point vias belonging to the connection. Deleting a 
connection changes the netlist, is considered an engineering change and requires ECO mode.
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Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restriction

A protected route or physical design reuse element can prevent you from deleting a connection 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are recording 
changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

Procedure

1. ECO Toolbar button > Delete Connection button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Do one of the following:

• Delete Pin Pair—Select the connection or trace between the pin pair to delete it. If 
the net contains only one pin pair, selecting either pin deletes the pin pair.

• Disconnect a Pin—Select the pin to disconnect. If a net contains more than one pin 
pair, the Disconnect Pin dialog box appears with an option to delete the route 
segment(s) going to the pin.

• Split a Net—See Splitting a Net in ECO Mode.

Splitting a Net in ECO Mode
You can split a net by deleting a pin pair in the middle of multi-pin pair net. Splitting a net 
changes the netlist, is considered an engineering change and requires ECO mode.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restriction

A protected route or physical design reuse element can prevent you from splitting a net in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.
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Procedure

1. ECO Toolbar button > Delete Connection button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select the connection between pin pairs where the net should be split.

3. You are prompted with the message, “Delete Pin Pair:<refdes.pin-refdes.pin> from 
net:<name>? Warning: The net will be split. The new net will include the first pin as 
mentioned above.” Click Yes.

The following is an example of the prompt that appears.

4. In the Define Name of New Net dialog box, name the new net or let PADS Layout 
automatically generate the new netname. 

Restrictions:

• The maximum netname length is 47 characters. 

• You can use any alphanumeric characters except brackets { }, asterisks *, commas 
(,), spaces, question marks, or commas.

Result

• Tip: If a Color by Net setting exists for a net that is split, the new net uses the same color 
setting. See also: To Assign Colors to Nets

• Warning: If you split a net associated to bridge copper, the association is removed from 
the copper.

• Test points belonging to the connection are deleted.

Deleting a Net in ECO Mode
You can delete all pin pairs and remove all pin connections from a net. Deleting a net changes 
the netlist, is considered an engineering change and requires ECO mode.
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Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restriction

A protected route or physical design reuse element can prevent you from deleting a net in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

Procedure

1. ECO Toolbar button > Delete Net button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select a pin, unrouted pin pair, trace, or via in the net to delete.

Result

Delete Net also deletes test point vias that belong to the net.

Changing the Reference Designator of a Component in 
ECO Mode

You can change a single component’s reference designator using the Rename Component ECO 
tool. Changing a reference designator changes the netlist, is considered an engineering change 
and requires ECO mode.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restriction

A protected route or physical design reuse element can prevent you from changing a reference 
designator in ECO mode. You must unprotect the route or break the reuse to proceed. If you are 
recording changes to an ECO file, the action of removing the protection on traces or breaking 
out reuse elements is not saved.
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Procedure

1. ECO Toolbar button > Rename Component button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select a single component.

3. In the Rename Part prompt, in the New Name box, type the new reference designator.

4. Click OK.

Related Topics

Recording Versus Generating an ECO File in the Concepts Guide.

Recording ECO Changes

Backward Annotating from PADS Layout to PADS Logic

Back Annotating from PADS Layout to DxDesigner

Changing the Reference Designator Prefix of Multiple 
Components in ECO Mode

You can change the reference designator prefix of multiple design components using the 
Rename Component ECO tool. This changes the netlist, is considered an engineering change 
and requires ECO mode.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restriction

A protected route or physical design reuse element can prevent you from changing a reference 
designator prefix in ECO mode. You must unprotect the route or break the reuse to proceed. If 
you are recording changes to an ECO file, the action of removing the protection on traces or 
breaking out reuse elements is not saved.

Procedure

1. Select multiple components whose reference designator prefix you want to change.

Restriction: All selected components must currently have the same prefix.

2. ECO Toolbar button > Rename Component button.
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Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

3. Choose one of the following:

• Add to the existing prefix—Type the new prefix and then the current prefix.

• Change the existing prefix—Type a new prefix.

4. Click OK.

Related Topics

Recording Versus Generating an ECO File in the Concepts Guide.

Recording ECO Changes

Backward Annotating from PADS Layout to PADS Logic

Back Annotating from PADS Layout to DxDesigner

Renaming a Net in ECO Mode

You can change the name of a net using the Rename Net ECO tool. This changes the netlist, is 
considered an engineering change and requires ECO mode.Restriction

A protected route or physical design reuse element can prevent you from renaming a net in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

Procedure

1. ECO Toolbar button > Rename Net button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select a pin, unrouted pin pair, trace, or via in the net to rename. 

3. In the Rename Net dialog box, type the new name, and click OK. The maximum 
netname length is 47 characters.
See also: Illegal Characters in Netnames and Part Names

Swapping ECL Terminators Automatically in ECO Mode
You can automatically swap ECL terminator assignments, or swap netnames between ECL 
pins.
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Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restriction

A protected route or physical design reuse element can prevent you from swapping ECL 
terminators in ECO mode. You must unprotect the route or break the reuse to proceed. If you 
are recording changes to an ECO file, the action of removing the protection on traces or 
breaking out reuse elements is not saved.

Procedure

1. ECO Toolbar button > Auto Terminator Assign button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

Tip: This command ignores objects that are part of a physical design reuse.

Swapping Gates
You can swap gates manually or automatically.

• Swapping a Gate Manually in ECO Mode

• Swapping All Gates Automatically in ECO Mode

Swapping a Gate Manually in ECO Mode
You can swap a gate with any equivalent gate to optimize routing and/or minimize trace 
lengths. Gates are equivalent when:

• They share the same package.

• They have matching, nonzero Swap IDs.

• They have an equal pin count.

Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.
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Restrictions

• You cannot swap a gate that has any pins from a pin pair with rules.

• A protected route or physical design reuse element can prevent you from swapping gates 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are 
recording changes to an ECO file, the action of removing the protection on traces or 
breaking out reuse elements is not saved.

Procedure

1. ECO Toolbar button > Swap Gate button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select a pin.

All candidates for swapping are highlighted. Candidates with a nonzero Swap ID that 
matches the selected pin's Swap ID are highlighted in the highlight color. Candidates 
with different or undefined Swap IDs are highlighted in a complementary color.

3. Select one of the highlighted pins with which to swap.

Result

If Stretch Traces During Component Move check box is selected (on the Design page of the 
Options dialog box), traces attached to pins of the swapped gates are rerouted. If Stretch Traces 
During Component Move is cleared, trace segments are unrouted before the swap is performed.

Related Topics

Part Information Dialog Box, Gates Tab

Undoing the Last Swap

Swapping All Gates Automatically in ECO Mode
You can swap all gates with any equivalent gates based on shortest total unrouted pin pair 
lengths. Gates are equivalent when:

• They share the same package.

• They have matching, nonzero Swap IDs.

• They have an equal pin count.
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Caution
When you modify or delete design objects, associated nets are regenerated. This can 
cause existing associated nets that include these objects to be truncated, split, or deleted 
altogether.

Restrictions

• You cannot swap a gate that has any pins from a pin pair with rules.

• Objects that are part of a physical design reuse are ignored.

• A protected route or physical design reuse element can prevent you from swapping gates 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are 
recording changes to an ECO file, the action of removing the protection on traces or 
breaking out reuse elements is not saved.

Procedure

1. Click the ECO Toolbar button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Click the Auto Swap Gate button on the ECO toolbar.

Result

If Stretch Traces During Component Move check box is selected (on the Design page of the 
Options dialog box), traces attached to pins of the swapped gates are rerouted. If Stretch Traces 
During Component Move is cleared, trace segments are unrouted before the swap is performed.

Related Topics

Part Information Dialog Box, Gates Tab

Undoing the Last Swap

Swapping Pins
You can swap pins manually or automatically.

• Swapping a Pin Manually in ECO Mode

• Swapping All Pins Automatically in ECO Mode
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Swapping a Pin Manually in ECO Mode
You can swap a pin with any equivalent pin to optimize routing and/or minimize trace lengths. 
Pins are equivalent when they have matching, nonzero Swap IDs.

Restrictions

• You cannot swap a pin that has any pins from a pin pair with rules.

• Connectors that are glued down are not included in the swap.

• A protected route or physical design reuse element can prevent you from swapping pins 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are 
recording changes to an ECO file, the action of removing the protection on traces or 
breaking out reuse elements is not saved.

Procedure

1. ECO Toolbar button > Swap Pin button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Select a pin.

All candidates for swapping are highlighted. Candidates with a nonzero Swap ID that 
matches the selected pin's Swap ID are highlighted in the highlight color. Candidates 
with different or undefined Swap IDs are highlighted in a complementary color.

3. Select one of the highlighted pins with which to swap. 
Tip: If you attempt to swap pins with undefined swap IDs or with different swap IDs, 
the Confirm Pin Swap dialog box appears and you must confirm that the swap is 
legitimate. If these pins should be swappable, the correct process would be to give them 
identical swap IDs in the Pins tab of the Part Information dialog box.

4. Click OK.

Result

If Stretch Traces During Component Move check box is selected (on the Design page of the 
Options dialog box), traces attached to pins of the swapped gates are rerouted. If Stretch Traces 
During Component Move is cleared, trace segments are unrouted before the swap is performed.

Related Topics

Part Information Dialog Box, Pins Tab

Undoing the Last Swap
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Swapping All Pins Automatically in ECO Mode
You can swap all pins with equivalent pins automatically based on shortest total unrouted pin 
pair lengths. Pins are equivalent when they have matching, nonzero Swap IDs.

Restrictions

• You cannot swap a pin that has any pins from a pin pair with rules.

• Connectors that are glued down are not included in the swap.

• Objects that are part of a physical design reuse are ignored.

• A protected route or physical design reuse element can prevent you from swapping pins 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are 
recording changes to an ECO file, the action of removing the protection on traces or 
breaking out reuse elements is not saved.

Procedure

1. Click the ECO Toolbar button.

Tip: The first time you use the ECO Toolbar, the ECO Options dialog box appears. Set 
the options you want and click OK to use the ECO tools.

2. Click the Auto Swap Pins button on the ECO toolbar.

Result

If Stretch Traces During Component Move check box is selected (on the Design page of the 
Options dialog box), traces attached to pins of the swapped gates are rerouted. If Stretch Traces 
During Component Move is cleared, trace segments are unrouted before the swap is performed.

Related Topics

Part Information Dialog Box, Pins Tab

Undoing the Last Swap

Undoing the Last Swap
You can undo your last Swap Pin or Auto Swap Pin command immediately after performing the 
swap.

Procedures

Undo a Swap Pin command

• Right-click and click Undo Last Swap while still in Swap mode, or
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• Exit Swap mode and click Undo on the toolbar.

Undo an Auto Swap Pin command

• Exit Swap mode and click Undo on the toolbar.

Copying Bridge Copper in ECO Mode
When you copy bridge copper in ECO mode and at least one assigned net trace with it, the 
pasted copy retains its bridge status and association to any attached trace(s). According to the 
circumstances of the pasted traces, their net names may be renamed or merged with existing 
net(s).

Illegal Characters in Netnames and Part Names
You can use any alphanumeric character for netnames and part names, with the exceptions 
below.

The following characters are illegal in netnames:

Spaces
Commas (,)
Braces ( { } )
Asterisks (*)
Question marks (?) 

The following characters are illegal in part names:

Spaces
Commas (,)
Braces ( { } )
Asterisks (*)
Question marks (?) 
Periods ( . )
Ampersands (&)
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Chapter 35
Comparing Designs

In this chapter:

• Comparing Two Versions of a Design

• Comparing Designs Using ECOGEN from the Command Prompt

Comparing Two Versions of a Design
You can compare two versions of a design to view their differences or to create an ECO file.

• Creating a Report of Differences Between Two Versions of a Design

• Creating an ECO File by Comparing Two Versions of a Design

Creating a Report of Differences Between Two Versions 
of a Design

You can compare two versions of the design stored in any of the following forms:

• PCB Layout in memory

• PADS-format ASCII netlist file (.asc) representing the schematic or the PCB layout

• PCB layout file (.pcb)

Procedure

1. Tools menu > Compare/ECO

2. In the Compare/ECO dialog box, on the Documents tab, select the designs to compare 
and the files you want to create, as follows:
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• If the older design is in memory, and you want to compare it with a newer .asc or 
.pcb file, use these settings:

• If the newer design is in memory, and you want to compare it with an older .asc or 
.pcb file,, use these settings:

• If neither design is in memory, and you want to compare an older .asc or .pcb file 
with a newer .asc or .pcb file, , use these settings:

3. Select the Generate Differences Report check box.

4. Set the appropriate options on the Comparisonand Update tabs.

5. Click Run to compare the designs. (The Run button becomes available when you select 
an option in the Output Options area on the Documents tab.)
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6. Click the Show Report button in the Process Status dialog box to view the report.

7. Click the Close button.

Creating an ECO File by Comparing Two Versions of a 
Design

You can compare two versions of the design stored in any of the following forms:

• PCB Layout in memory

• PADS-format ASCII netlist file (.asc) representing the schematic or the PCB layout

• PCB layout file (.pcb)

This procedure generates a new .eco file by comparing two designs. If you are trying to forward 
or backward annotate design changes between PADS Layout and PADS Logic or DxDesigner, 
you should record changes into an .eco file as you make them. This gives the best back-
annotation results. For more information, see Recording ECO Changes, Backward Annotating 
from PADS Layout to PADS Logic or Back Annotating from PADS Layout to DxDesigner
For more details on the differences of these methods, see Recording Versus Generating an ECO 
File in the Concepts Guide.

Tip: If PADS Layout and the schematic tool are on the same computer, you can use 
DxDesigner Link in PADS Layout or PADS Layout Link in PADS Logic to both create the 
ECO file and forward or back-annotate the schematic.

• Using DxDesigner: Working with DxDesigner

• Using PADS Logic: Working with PADS Logic

Procedure

1. Tools menu > Compare/ECO

2. In the Compare/ECO dialog box, on the Documents tab, select the designs to compare 
and the files you want to create, as follows:
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• If the older design is in memory, and you want to compare it with a newer .asc or 
.pcb file, use these settings:

• If the newer design is in memory, and you want to compare it with an older .asc or 
.pcb file,, use these settings:

• If neither design is in memory, and you want to compare an older .asc or .pcb file 
with a newer .asc or .pcb file, , use these settings:

3. Optional: Select the Generate Differences Report check box.

4. Select the Generate ECO File check box.

5. Set the appropriate options on the Comparisonand Update tabs.



Comparing Designs
Comparing Designs Using ECOGEN from the Command Prompt

PADS Layout User’s Guide and Reference Manual, PADS 9.4 711

6. Click Run to compare the designs and create the .eco file. (The Run button becomes 
available when you select an option in the Output Options area on the Documents tab.)

7. Click the Show Report button in the Process Status dialog box to view the report, the 
.eco file, and the log file.

8. Click the Close button.

9. To confirm that the updated design matches the new design, generate a differences 
report. If you’ve updated the .pcb design, and differences still exist, use the ECO toolbar 
commands to correct the design.

Result

• If the original design is in memory and you selected Update Original Design on the 
Update tab of the Compare/ECO dialog box, the updates are automatically imported into 
the design when comparison is completed.

• Otherwise, use File > Import to import the .eco file and update the original design.

Tips: 

• Any messages or errors that occur during comparison are written to Layout.err, which is 
stored in the \PADS Projects folder.

• If commands in the ECO file added any parts at the origin in the updated original design, 
be sure to place these parts and route any newly unrouted pin pairs.

• After verification is complete, check the design integrity. On the Tools menu, click 
Verify Design.

Related Topics

Comparing and Updating Designs in the Concepts Guide

Comparing Designs Using ECOGEN from the 
Command Prompt

After you make changes to a design, you can run the ECOGEN executable file from the 
command prompt to:

• Compare the new version of the design to the original

• Create the files needed to update the original design to match the new design

Alternatively, you can use the Compare/ECO Tools dialog box in PADS Layout to compare 
designs.

You should record changes into an .eco file as you make them. This gives the best back-
annotation results. For more information, see Recording ECO Changes. 
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For more details on the differences of these methods, see Recording Versus Generating an ECO 
File in the Concepts Guide.

See also: Comparing Two Versions of a Design

Tip: If you want to compare the schematic to the PCB layout, export a PADS-format ASCII 
netlist file (.asc) from the schematic tool before comparing the designs.

Procedure

1. Open the Windows command prompt.

For Windows 2000, Windows NT, and Windows XP, do the following:

• From the Start menu, select Programs > Accessories > Command Prompt.

2. Change to the folder where the ecogen.exe file resides, for example, 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs.

3. To run ECOGEN, enter the ecogen command using the following format:

ecogen <new_design> <original_design> [<eco_out>] [-u<unused net 
name>] [-e<error file>] [-d<report file>] [-r[a][p]] [-a<attr mask>] 
[-f] [-l <rules mask>] [-n<new_design_title>][-
o<original_design_title>] [-g] [-s] [-m] [-q] [-i <output unit>]

Tips:

• You must enter the newDesign, originalDesign, and ecoFile command-line 
arguments in the given order.

• If an argument contains spaces, enclose the argument with double-quotes " ".

• You can also type ECOGEN@<command_file>, where the command file contains 
all the parameters on one line.

• ECOGEN ignores the reuse definition and uses the actual elements in the physical 
design reuse for comparisons.

Table 35-1 contains the parameter usage. Square brackets [ ] enclose optional parameters. 

Table 35-1. Parameter Usage 

Parameter Specifies

newDesign The design file containing the changes you want to place into the 
original design.

originalDesign The design file that you want to update so that it matches the new 
design.

[eco_out] The ECO command file containing ECO directives. You can 
import this file into the original design to update the original file.
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[-aAttributeMask] Attribute comparison and the attributes to be compared 
(AttributeMask)
This mask selects the object types for which to compare 
attributes. The mask is a string of object types separated by 
commas without spaces. You can specify these object types:
PCB,PART,PARTTYPE,PARTDECAL,NET,NETCLASS,PIN
Specify the AttributeMask as a string of object types separated 
by commas without spaces. for example: -aPART,NET
If you want to ignore all attributes during comparison, do not 
specify the -a switch. If you do not use this switch, existing 
attributes are preserved and no ECO commands are generated for 
attribute modification.
To compare part and net attributes, for example, for a PADS 
Logic schematic, use the -aPART,NET switch value.
To compare board, part, net, and pin attributes, for example, for a 
DxDesigner schematic, use the -aPCB,PART,NET,PIN switch 
value 
To compare the attributes for all object types, use the -a 
PCB,PART,PARTTYPE,PARTDECAL,NET,NETCLASS,PIN 
switch value.

-dReportFile The file containing the differences between the original design 
and the new design.

[-eErrorFile] The file containing ECOGEN status and error messages. 
ECOGEN automatically opens the default editor you chose 
during installation to display the error file.

[-f] Enables comparison of part decal assignment.

Table 35-1. Parameter Usage (cont.)

Parameter Specifies
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[-g], [-q] Tips:
• Do not use either the -g or -q switch if you want to compare 

net names and reference designator names, and rename as 
necessary.

• These switches are best used to minimize changes to routed 
traces. Selecting this option may result in the positional 
swapping of parts.

Example: If routed trace changes are minimized when R1 and 
R12 are swapped, simultaneously rename R12 to R1 and R1 to 
R12, and then reconnect R1 and R12 to the original nets.

Use the -g switch to disable reference designator and net name 
comparison.
Use this switch to compare connectivity and topology (not 
names) and rename as necessary. Compare differences using pin 
names, part type names, and so on.

Use the -q switch to suppress part renames.
Use this switch to compare net names and reference designators, 
but prefer adding or deleting parts to renaming parts. Compare 
differences using reference designators or net names on the basis 
that few reference designators have been renamed, but nets have 
not been renamed.

[-iOutputUnit] Specifies an output unit for dimensional values in the ECO and 
report files. (If you do not specify this switch, ECOGEN uses the 
output unit of the new design.)
You can specify an output unit of: BASIC, MILS, INCHES, or 
METRIC.
If you specify an output unit that ECOGEN does not recognize 
(for example, if you mistype the unit name), the command uses 
BASIC.

Table 35-1. Parameter Usage (cont.)

Parameter Specifies
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For example: 

[-lRulesMask] Specifies rules comparison and the object types, rule types, and 
rule kinds to be compared (RulesMask).
For FulesMask, you can specify:
• Object types: PCB, NET, NETCLASS, PINPAIR, and 

GROUP. If you do not specify any object types, rules for all 
object types are compared.

• Rule types: Clearance, Routing and High Speed (CLR, RT, 
HS). If you do not specify any rule types, all three types are 
compared.

• Rule kinds: General, Conditional, and Differential Pairs 
(GEN, CON, DFP). If you do not specify any rule kinds, all 
three kinds are compared.

Specify the RulesMask as a string of object types separated by 
commas without spaces. For example:

-lNETCLASS,GROUP,CLR
If you do not specify a RulesMask, ECOGEN, compares rules of 
all types and kinds on all object types.

[-m] Enables comparison of part placement. When comparing the 
PCB layout to the schematic, this feature is available only for 
DxDesigner schematics containing placement information 
created by ePlanner.

[-nNewDesignTitle] The string used in the report header for the new design name.

[-oOldDesignTitle] The string used in the report header for the original design name.

[-r[a][p]] Enables comparison of only ECO registered [p]arts or 
[a]ttributes.
Use the -rap switch to compare only ECO registered parts and 
attributes.
Use the -ra switch to compare only ECO registered attributes. 
Via attributes are not ECO registered and cannot be added, 
deleted, or changed during the ECO process.
Use the -rp switch to compare only ECO registered parts.
Do not use the -r switch if you want ECOGEN to compare all 
parts and attributes.
Do not use the -rap or -rp switches if you want to compare 
mechanical or non-electrical parts on the designs.

[-uUnusedNetName] Indicates an unused pins net that contains pins that have no 
logical net association. This net is a result of SPECCTRA 
routing. Use the netname you used in SPECCTRA. The 
maximum netname length is 47 characters. You can use any 
alphanumeric characters except curly braces { }, asterisks *, 
spaces question marks, or commas.

Table 35-1. Parameter Usage (cont.)

Parameter Specifies
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ecogen \ePD\3.1\project\logic.asc C:\PADS Projects\pcb.asc design.eco
-lNET,CLR -uNOT_CONNECTED

In this example, ECOGEN:

• Compares the original design (before changes), logic.asc, with the new design, pcb.asc

• Creates an ECO file, design.eco, which can be used for updating the original design, 
logic.asc

• Compares Clearances Rules for nets

• Specifies that NOT_CONNECTED is an unused pins net as a result of SPECCTRA 
routing.

Limitations of Rules Comparison
• ECOGEN always compares component and decal rules and Fanout and Pad entry rules, 

even if you do not specify the -l switch.

• ECOGEN does not generate change information for layers. For layer-dependent rules 
such as conditional rules, make sure the designs being compared have the same number 
of layers.

Related Topics

Comparing Two Versions of a Design
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Chapter 36
Reports

In this chapter:

• Creating Reports

• Creating Physical Design Reuse Reports

Creating Reports
You can use the Reports dialog box to create reports containing properties or netlist information 
for the design. In addition to several predefined report formats, you can create custom report 
formats.

In this topic:

• Creating a Report

• Creating a Report Using an Assembly Variant

• Adding or Removing Report Formats

Creating a Report
To create a report:

1. File menu > Reports.

2. In the Select Report Files for Output list, select one or more report formats.

Tip: If the report format you want is not available, you can create a custom format. 

3. Click OK or Apply.

Result: The report is written to C:\PADS Projects\report.rep and displayed in the default 
text editor.

Tip: If you selected more than one report format, report.rep contains all the reports.

Creating a Report Using an Assembly Variant
You can create a report based on an assembly variant instead of the base design.

1. File menu > Reports.
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2. In the Select Report Files for Output list, select one or more report formats.

3. Select the Use Assembly Variant check box, and then select a variant from the Name 
list.

Tip: Uninstalled parts are listed as <<Not Installed>> and substituted parts are listed 
with the correct part type. Some data may not reflect the substituted parts data, for 
example, the Unused report reflects the gate assignments for the Default part type, but 
not the gate assignments for the Substituted part. If the Use Assembly Option check box 
is cleared, raw database data is reported.

4. Click OK or Apply.

Result: The report is written to C:\PADS Projects\report.rep and displayed in the default 
text editor.

Tip: If you selected more than one report format, report.rep contains all the reports.

Adding or Removing Report Formats
You can add or remove report formats from the Select Report Files for Output list. If you want 
to add a report format, you first create the format file using Report Generation Language.

See also: Customizable Reports in the Concepts Guide

To add or remove report formats:

1. File menu > Reports.

2. If you want to add to the list a custom report format, or import a report format file, do 
the following:

a. Click Add.

b. In the Report Format File dialog box, browse to the format file and click Open.

Result: The format is added to the list and copied to the 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Settings folder.

3. If you want to remove a report format from the list, select the format and click Delete. 
You cannot delete the Unused, Statistics, and Limits report types.

Result: The format is removed from the list and the file name extension is changed from 
.fmt to .del.

4. Click OK or Apply.

Related Topics

Creating Reports in the Concepts Guide

Creating Jumper List Reports
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Creating Physical Design Reuse Reports
You can create a report that contains the following information of the selected physical design 
reuse: name, type, and elements.

To create a report:

1. Select the physical design reuse. 

See also: To Select a Physical Design Reuse

2. Right-click and click Report Contents.

Result: The report is written to C:\PADS Projects\rules.rep and is displayed by the default text 
editor.
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Chapter 37
Checking a Design for Errors

In this chapter:

• To Compare Test Points

• To Create a Test Point ASCII File

• DFF, Design For Fabrication

• Exporting to CAM350

• Working with Markups

• Using the 3D PCB Viewer

• Running a Thermal Analysis

• Verify the Design

To Compare Test Points
Use Compare Test Points to compare test point settings in ASCII format, between the current 
file and another file. Compare Test Points differs from a complete database integrity check 
because it only compares test point lists.

To compare test points:

1. You need an ASCII file of test points from an older version of the design file. 

See also: To Create a Test Point ASCII File

2. Click Compare Test Points from the Tools menu. The Compare Test Points dialog box 
appears.

3. Locate or type the name of the ASCII test point file to compare against. You do not need 
to type the .asc extension.

4. Click OK. PADS Layout creates an internal ASCII test point list of the open file and 
compares it to the one you specified.

If the ASCII file you compare against is a version earlier than PowerPCB 2.x, or if a test 
point section is not present in the ASCII file, an error message appears. Create another 
file to compare against.

When differences exist, the output error file tpasc.lst opens listing the differences.
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To Create a Test Point ASCII File
To create an ASCII test point list of an older design:

1. Open the .pcb file in PADS Layout.

2. Click Export from the File menu. The File Export dialog box appears.

3. Type a name in the File name box.

4. Click Save. The ASCII Output dialog box appears.

5. Click the PowerPCB V3.0 Format from the list.

6. Click Current from the Units list.

7. Click Select All to select all check boxes.

8. Click OK.

DFF, Design For Fabrication

Process Flow for Using DFF Audit
Requirement: You need the CAM350 Link license option to use this. On the Help menu, click 
Installed Options and on the Options tab, check if the option is available in your license.

Use the following process to resolve any fabrication errors:

1. Lay out the design using PADS Layout and PADS Router.

2. Create CAM documents.

3. Set up Verify Design preferences for fabrication checks.

4. Run Verify the Design.

5. Use the layout editor in conjunction with the Verify Design dialog box to view and 
correct fabrication errors.

6. Repeat steps 3 through 5 until fabrication errors are resolved.

DFF Audit Process Flow using CAM350 Link
Requirement: You need the CAM350 Link license option to use this. On the Help menu, click 
Installed Options and on the Options tab, check if the option is available in your license.

If you use CAM350, use the following process to resolve fabrication errors:

1. Lay out the design using PADS Layout and PADS Router.
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2. Create CAM documents.

3. Output the CAM documents to CAM350.

4. Set up Verify Design preferences for fabrication checks.

5. Run Verify the Design.

6. Use the layout editor in conjunction with the Verify Design dialog box to view and 
correct fabrication errors.

7. Use CAM350 to view errors. Use PADS Layout to correct fabrication errors.

8. Repeat steps 3 through 7 until fabrication errors are resolved.

Performing a Test Point Audit
Use DFT Audit to manage test points used to support In Circuit Testing (ICT) procedures. Test 
points help you meet your ICT requirements early in the design process and can improve your 
productivity by reducing design iterations.

When you run DFT Audit, PADS Layout automatically transfers the design to PADS Router. 
Using options you set in PADS Layout, PADS Router analyzes all nets for accessibility and 
adds test points to routed accessible nets. Note that PADS Router may reroute nets during DFT 
Audit. When PADS Router is done, it transfers the design back to PADS Layout. For nets that 
PADS Router determines to be inaccessible, PADS Layout can optionally add test points, which 
are placed outside the board edge. When DFT Audit finishes, the DFT Audit Board Report 
appears.

Requirement: PADS Router must be installed and licensed for you to run DFT Audit in PADS 
Layout. You can run DFT Audit regardless of the layer limits in the PADS Router license.

Tip: If you are using BGAs, fan out the BGAs before running DFT Audit.

To run DFT Audit:

1. Tools menu > DFT Audit.

2. On the DFT Audit dialog box, click the tab for which you want to modify the test point 
placement options and properties:

• Options

• Properties

• Assignment

3. Modify the properties on the tab as required.

4. Click Run. The automatic audit process starts.
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Tip: DFT Audit honors any test point keepouts defined in the design.

Related Topics

Design for Test in the Concepts Guide

Placing Test Points Automatically in the PADS Router Concepts Guide

Placing Test Points
Several options for placing test points are available to you on the Options tab of the DFT Audit 
dialog box.

Tip: To reduce design iterations, consult with your automated test engineers when setting DFT 
Audit options.

Use the Options tab to:

1. Tools menu > DFT Audit > Options tab.

2. Define how test points are created using options in the Create test points area. You can 
preserve existing via properties and add test point vias to routed, accessible nets.

3. Set probe via test point properties using options in the Probe through area.

4. Place via test points on a grid using options in the Place via points using area.

5. Specify test point nail diameters using options in the Available Nail Diameters area.

6. Set minimum pad areas using options in the Minimum Pad Probing Sizes area. Set 
minimum pad probing sizes for both vias and component pins to ensure that there is 
sufficient pad area for probe contact.

Related Topics

Performing a Test Point Audit

Setting Test Point Properties
Several test point properties are available to you on the Properties tab of the DFT Audit dialog 
box.

Tip: To reduce design iterations, consult with your automated test engineers when setting DFT 
Audit options.

Use the Properties tab to:

1. Tools menu > DFT Audit > Properties tab.

2. Specify the minimum distances between the probe and other design objects using 
options in the Probe Minimum Distances area.
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Tip: The clearances needed between a probe and another design object are mostly based 
on the physical constraints of the Automated Test Equipment (ATE) used by In Circuit 
Testing (ICT) procedures. The probes extending out of the ATE fixture must make 
contact with the PCB without any obstacle. This means that test points must keep a fixed 
distance from component bodies, pads, mounting holes, and board edge, and must also 
have the minimum spacing between them.

3. Specify the maximum length of trace stubs required to make a net accessible to a test 
probe by typing the length into the Stub Length box.

4. Specify zero or more than one nail pins on a net using options in the Multiple Test Point 
Nets area. By default, all nets are set to receive one probe, or nail pin.

If you want to change the number of nail pins for a net to receive, in the Multiple Test 
Point Nets area, type the new value in the Nail Pins cell for the net.

Tips:

• To display only nets with no nail pin or with more than one nail pin, select the Show 
Only Nets with Nail Pins Not Equal to One check box.

• If you do not want any nail pins on a net, double-click the Nail Pins cell for the net 
and type zero (0).

• To sort the list by a different column, click the column header at the top of the list.

Related Topics

Performing a Test Point Audit

Setting Test Point Assignment Eligibility
Use the Assignment tab to prevent or favor assigning test points to components or to via types. 
By default, all pins on a net are available for test pin assignment and are evenly weighted as test 
point candidates.

Tip: To reduce design iterations, consult with your automated test engineers when setting DFT 
Audit options.

Setting test point assignment eligibility for a component or via:

1. Tools menu > DFT Audit > Assignment tab.

2. To prevent use as a test point, select the Exclude check box.

3. To favor use as a test point, select the Prefer check box.

4. To apply even weighting, clear the Exclude and Prefer check boxes.

Tips:



PADS Layout User’s Guide and Reference Manual, PADS 9.4726

Checking a Design for Errors
DFF, Design For Fabrication

• To change the check box value for multiple rows, select the rows and then click a 
check box.

• To sort the spreadsheet by a specific column, click that column's header.

Related Topics

Performing a Test Point Audit

Probing the PCB Top Side Only
To probe the PCB top side only:

1. Create a test point keepout on the bottom side of the board.

2. On the Tools menu click DFT Audit. The DFT Audit dialog box appears.

3. Click the Options tab.

4. In the Probe through area, select the Probe Top Side check box.

5. Click Run.

Result: DFT Audit ignores the bottom side because it has a test point keepout defined. 
Only the top side of the PCB is probed.

Modifying a Jumper Pin that is a Locked Test Point
If you are modifying the pad stack of a jumper pin that is a locked test point, the “One of the 
jumper pins is locked as a test point. Do you want to apply the changes to jumper?” message 
appears. Click one of the following:

• Yes—Applies the change and maintains the locked test point status. 

• No—Cancels the change. 

If you move a jumper pin that is a locked test point, the “Via marked as Test Point. Proceed 
Anyway?” message appears. Click one of the following

• Disable Lock Test Points—Turns the Lock Test Points check box off in the Routing / 
General page of the Options dialog box.

• OK—Allows you to move the jumper pin and maintain the test point status; the jumper 
pin is locked in its new position. 

• Cancel—Cancels the move. 
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Modifying a Pin that is a Locked Test Point
If you are modifying the pad stack of a component pin, the “Do you want to apply the changes 
to all components with decal type xxx or just the selected components?” message appears. Click 
All to apply the change to all decal types. Click Selected to apply the change to the selected 
decal. Click Cancel to cancel the change.

If the component pin is a locked test point, the “Include locked test points in Pad Stack update?” 
message appears when you click All or Selected. Click one of the following:

• Yes—Applies the change and maintains the locked test point status. 

• No—Cancels the change. 

Modifying a Route Attached to a Locked Test Point
If you attempt to move or modify a route that is attached to a via that is a locked test point, the 
“Command causes the move of Via(s) marked as Test Point(s). Continue command ignoring 
Test Points or keep them locked during modification of route?” message appears. Click one of 
the following:

• Disable Lock Test Points—Turns the Lock Test Points check box off in the Routing / 
General page of the Options dialog box.

• OK—Performs the modification and moves the via along with the route, ignoring the 
locked test point setting. The test point will be locked again in its new position. 

• Keep Locked—Performs the modification but does not move the via; the locked test 
point location is maintained. You can modify the route, but the test point via does not 
move. 

• Cancel—Cancels the modification.

Modifying a Via that is a Locked Test Point
If you modify the pad stack of a via, the “Are you sure you want to change all vias of type xxx?” 
message appears. Click Yes to apply the change; click No to cancel the change.

If the via is a locked test point, the “Include locked test points in Pad Stack update?” message 
appears when you click Yes. Click one of the following:

• Yes—Applies the change and maintains the locked test point status. 

• No—Cancels the change. 

If you do not include test points in the update, then the pad stacks for the test points are 
preserved by renaming them with a TP_ prefix; for example, changing the pad stacks for 
STANDARDVIA, the test point pad stack is renamed TP_STANDARDVIA.
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If you modify the Via Name of a via that is a locked test point, the “Command causes change of 
via type for Via(s) marked as Test Point. Proceed Anyway?” message appears. Click one of the 
following:

• Disable Lock Test Points—Turns the Lock Test Points check box off in the Routing / 
General page of the Options dialog box.

• OK—Applies the change and maintains the test point status. 

• Cancel—Cancels the change. 

If you move a via that is a locked test point, the “Via marked as Test Point. Proceed Anyway?” 
message appears. Click one of the following

• Disable Lock Test Points—Turns the Lock Test Points check box off in the Routing / 
General page of the Options dialog box.

• OK—Allows you to move the via and maintain the test point status; the via is locked in 
its new position. 

• Cancel—Cancels the move. 

Move Sequential to Move Components, Unions, or 
Clusters with a Locked Test Point

If a part or union selected for Move Sequential contains a pin that is a locked test point, the 
“Component/Union xxx have pins marked as Test Points. Continue?” message appears. Click 
one of the following:

• Yes—Moves the part although it is a test point. The test point is locked in its new 
position.

• No—Skips the component or union.

• Cancel—Cancels the move sequence.

If a cluster selected for Move Sequential contains a pin that is a locked test point and Collapse 
Mode is on, the “Cluster xxx has members with pins marked as Test Points. Continue?” 
message appears. Click one of the following:

• Yes—Moves the cluster even though it is a test point. The test point is locked in its new 
position.

• No—Skips the cluster.

• Cancel—Cancels the move sequence.
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Moving, Dispersing, or Aligning a Component, Cluster, or 
Union with a Locked Test Point

If you attempt to move a component with a pin that is a locked test point, the “Component pin(s) 
marked as Test Point. Proceed Anyway?” message appears. 

Note: This applies to Rotate 90, Spin, Flip Side, Radial Move, Group Rotate 90, and Flip 
Group. This also applies to Automatic Cluster Placement operations, such as Collapse Cluster, 
and changing the decal of a component. Click one of the following:

• Disable Lock Test Points—Turns the Lock Test Points check box off in the Routing / 
Genearl page of the Options dialog box.

• OK—Performs the modification and moves the component, ignoring the locked test 
point setting. The test point will be locked again in its new position. 

• Cancel—Cancels the modification.

Exporting to CAM350
You can translate a PADS Layout design using CAM350 Link.

Requirement: You need the CAM350 Link license option to use this. On the Help menu, click 
Installed Options and on the Options tab, check if the option is available in your license.

Procedure

1. Create a PADS Layout design.

2. On the File menu, click Export, and in the Save as type list, click CAM350 and then 
click Save. The CAM350 dialog box appears.

3. Either create the CAM350 .cam file only or create the file and automatically launch 
CAM350.

4. Click a layer option for the CAM document.

5. Click an arc approximation tolerance value.

6. Type a file name and location for the .cam file to generate.

7. Click OK.

8. Run your manufacturing process in CAM350.

Result

Once the design file is in CAM350, you can perform DFM analysis on the design. If DFM 
errors exist, you can back-annotate the errors to PADS Layout to identify and correct them. 
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Subsequently, you can generate a new CAM350 database and verify that all DFM errors have 
been corrected. You can then create CAM outputs in either PADS Layout or CAM350.

The processing routines that translate PADS Layout data into CAM350 .cam files detect errors 
and warnings and report them to the standard PADS Layout error file (Layout.err).

Working with Markups
In this section:

• Adding Markups

• Saving Markups

• Exporting Markups

• Importing Markups

• Linking Design Objects to Markup Issues

• Unlinking Design Objects from Markup Issues

Adding Markups
Use the Markups dialog box to log issues concerning the design. You can add 2D line markups 
to issues in order to outline or highlight their location. You can also link design objects to 
markups. You can export the issues alone or export the design and any issues for viewing and 
logging additional information in visECAD.

Requirement

You must create at least one topic section to begin adding issues and 2D line markups.

Procedure

1. On the Edit menu, click Markups.

2. Click the Add Topic button to add a topic.
For example, as you review the design for another designer, you spot several silkscreen 
placement issues. You could name the markup topic - Silkscreen.

3. Click the Add Issue button to add an issue.
For example, your first issue could be the placement of a reference designator beneath a 
component. You could name the markup issue - Placement of R54 refdes.

4. Click the Add Markup button. 

5. Right-click and choose your options before adding the 2D line. 
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Restriction: Line widths or the layer location of your 2D line markers are not 
maintained when exporting and re-importing.

6. Draw a 2D line to highlight the area of concern. 
For example, you could draw a rectangle around the offending refdes.

7. You can also link design items to the markup.

8. Save the Markups.

Result

• Issues are logged against the design and ready to be shared.

• Markups take the color of 2D lines on any given layer.

Related Topics

Importing Markups

Saving Markups
There are two ways to save Markups added to the Markups dialog box. The markups are not 
saved when you use File menu > Save (or the Save button on the dialog box, or Ctrl+S).

You must do one of the following:

• Click the Export button in the Markups dialog box to export the markups into a .cle 
encrypted collaboration file.

• Click File > Save as, to generate a snapshot of the design and create a .cle file to match 
it.

Exporting Markups
You can export markups for use in another software tool like CAMCAD and visECAD. There 
are several ways to export Markups. You can export them from the Markups dialog box or using 
File > Export into a simple .cle file which only contains the markup information. Alternatively, 
you can export a CC file which includes most design elements along with the markups.

Using the Markups Dialog Box

1. On the Markups dialog box, click the Export button.

2. In the Collaboration Data Save As dialog box, type a name for the .cle file.

3. Click Save.
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Using File > Export

1. On the File menu, click Export.

2. In the File Export dialog box, in the Save as type list, click either Collaboration Files 
(*.cle), or CCE Files (*.cce).

3. Type a name for the .cle file or the .cce file. 

4. Click Save.

Result

Markups are exported into the file. If you placed markup lines on different layers in the design, 
this information is ignored and all markups are exported into a single layer in the .cle file.

Related Topics

Exporting CCE Files

Importing Markups
You can import Markups created in another software tool, like CAMCAD or visECAD. There 
are two ways to import Markups. You can import them using the Markups dialog box, or using 
File > Import.

Restriction

• Any markups that exist in the Markups dialog box will be deleted before the new data is 
imported.

Using the Markups Dialog Box

1. On the Markups dialog box, click the Import button.

2. In the Collaboration Data Import dialog box, browse for and select the .clb or .cle file to 
import.

3. Click Open.

Using File > Import

1. On the File menu, click Import.

2. In the File Import dialog box, in the Files of type list, click Collaboration Files (*.clb, 
*.cle).

3. Browse for and select the .clb or .cle file to import.

4. Click Open.
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Result

• The Markups dialog box is populated with the imported collaboration data.

• Some shapes imported from other software have no equivalent in PADS Layout (for 
example, sticky notes). They are represented as accurately as possible with 2D lines in 
PADS Layout. 

• The text that accompanies any imported shapes is not located in the design, but appears 
in the Text box in the Markups dialog box.

Linking Design Objects to Markup Issues
You can link design objects to markups of issues. You can link components, nets, vias and 
drawings (board outline, 2D lines, keepouts).

Procedure

1. In the design, select one or more design objects.

2. In the Markups dialog box, right-click over the markup and click Link Selected.

Result

The design items are listed under each element type in the elements tree of the Markups dialog 
box.

Related Topics

Unlinking Design Objects from Markup Issues

Adding Markups

Unlinking Design Objects from Markup Issues
You can unlink items from being linked to markups and listed in the elements tree of the 
Markups dialog box.

Procedure

• In the Markups dialog box, in the elements tree, right-click over an item and click 
Unlink.

Related Topics

Linking Design Objects to Markup Issues



PADS Layout User’s Guide and Reference Manual, PADS 9.4734

Checking a Design for Errors
Using the 3D PCB Viewer

Using the 3D PCB Viewer
You can send your design to the 3D PCB Viewer to view your design in 3D. You can choose 
between running 3D Viewer in either dynamic view mode or in snapshot (static) view mode. 

Requirement

In order to generate a 3D view of your design, you must have applied values to your design 
elements. For example, you need to set up thickness values in the Layer definition for the layers 
in the 3D view to show a thickness. And you must use the geometry.height attribute to give your 
decals a height value.

Snapshot View

Use Snapshot view to see what the current design looks like in 3D. You can have multiple 
Snapshot windows open.

• View menu > 3D View > Snapshot View

Result: A new instance of 3D PCB Viewer window is opened and it displays the 3D 
image of the current snapshot of PADS Layout design.  Changes made in PADS Layout 
are not passed to the open 3D Viewer window.

Dynamic View

Use Dynamic view to observe the 3D view of changes made in your design. You can have only 
one Dynamic window open.

• View menu > 3D View > Dynamic View

Result: The Dynamic View command opens new 3D Viewer window that will operate 
in dynamic mode. If the dynamic version of 3D Viewer is already open, click the 
Dynamic View command to switch focus to the existing 3D Viewer window. Changes 
made in PADS Layout are passed to the open 3D Viewer window.

Running a Thermal Analysis
You can send your design information directly to HyperLynx Thermal. The .hyp, .emn, and 
.emp files are created and imported into HyperLynx Thermal.

Requirement

You must flood copper pours, and plane areas before exporting the files into HyperLynx 
Thermal.
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Procedure

• On the Tools menu, point to Analysis and then click Thermal Analysis.

Result

As long as all the data is available, the design opens in HyperLynx Thermal ready to be 
analyzed. If copper pours and plane areas are not flooded, you must flood them and try again. If 
all the heights of components are not added to the geometry.height attribute of components, you 
are prompted for their heights.

Related Topics

Missing Height Dialog Box

Verify the Design

Verifying the Design
You can check for individual or all design errors using the Verify Design dialog box. Check for 
the following types of errors: clearance, connectivity, high speed, number of vias, plane 
connection, test point, fabrication, wire bond. It does not check reference designator, part type, 
or attribute labels for clearance violations.

In this topic:

• Running a Design Check

• Checking Design Error Results

• Troubleshooting Errors

• Save and Print Error Results

• Previewing Fabrication Errors in CAM files

Check Type Information
• Tools menu > Verify Design.

Running a Design Check
You can check for individual or all design errors using the Verify Design dialog box:

1. Tools menu > Verify Design.

2. Select a type of check in the Check area.
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3. If the Setup button is available (unavailable for Maximum via count and Test Points 
checks):

a. Click Setup to specify additional settings for the check.

b. Specify settings in the Setup dialog box and then click OK.

4. Click Start to run the check.

5. After the check process completes, a message window might open with the number of 
errors found. Click OK.

Result: Error markers appear in the design at error locations and error details populate the 
Verify Design dialog box. 

See also: Interpreting Error Markers

Checking Design Error Results

Reading Error Details

Error results for a type of check are listed in the Location box. Listed errors, contain their (X,Y) 
location, layer, and error type.

1. Tools menu > Verify Design.

2. Select an error from the list.

Result: The explanation for the error appears in the Explanation box.

3. View the more specific, detailed information about the error selected in the Location 
list. The explanation includes information about any conflicting object.

4. Click Close when you are finished with the Verify Design dialog box.

The current error list remains whether the dialog box is open or closed. The error markers 
remain until you click Clear Errors, which clears the markers, not the errors.

Viewing Errors in the Design

You can view error markers in the design. Error markers in the work indicate the error type.

Requirement: Colors must be assigned properly in the Display Colors dialog box in order to 
see error markers. Errors in the design area appear in the color of the Errors check boxes per 
layer of the Display Colors dialog box. When an error is selected in the Location box, the error 
in the design area appears in the Highlight color.

• Select an error from the list.

Result: The design window pans to the area of the error (unless Disable Panning is 
selected). This is more obvious if you are zoomed into your design.
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Tips:

• You can prevent the design area from panning to errors when you select them if you 
select the Disable Panning dialog box.

• Error markers are not erased from the design until you click Clear Errors which 
clears the error markers, not the actual errors. You must correct the error in the 
design.

The current error list remains whether the dialog box is open or closed. The error markers 
remain until you click Clear Errors, which clears the markers, not the errors.

Interpreting Error Markers

After verifying the design, error markers are inserted in a PADS Layout database as database 
objects. Error objects present in a PADS Layout database transfer into PADS Router and are 
converted into PADS Router error objects during file load. 

Most error objects in PADS Layout are converted to an identical PADS Router error object. The 
exceptions to these conversions are listed in the Notes column of the table below. 

Table 37-1. PADS Layout/Router Error Objects 

Marker Error Notes

 

Testability and 
Connectivity

 

High-speed

 

Fabrication

Minimum/Maximum 
Length

Assembly
(Latium Only)

Component height errors become assembly errors 
in PADS Router. Consequently, PADS Router 
assembly errors in PADS Router are converted to 
PADS Layout keepout errors in PADS Layout 
when the file is saved.
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Drill to Drill Drill to Drill errors in PADS Layout become 
fabrication errors in PADS Router. Consequently, 
drill to drill errors in PADS Router are converted to 
drill to drill errors in PADS Layout when the file is 
saved.
Drill to Drill errors are reported for only one layer 
in a drill pair.

 

Clearance Body to body errors are clearance errors in PADS 
Layout. Body to body checking is not performed in 
PADS Router, only placement outline checking is 
performed as an assembly check. Therefore, body 
to body errors cannot exist in PADS Router. PADS 
Layout body to body errors are converted to 
placement outline errors in PADS Router - 
identified by Assembly error markers. 
Consequently, PADS Router Placement Outline 
errors in PADS Router are converted to PADS 
Layout placement outline errors in PADS Layout 
when the file is saved.
Tip: Body to body errors are not returned from 
PADS Router.

 

Keepout Component height errors become assembly errors 
in PADS Router. Consequently, PADS Router 
assembly errors in PADS Router are converted to 
PADS Layout keepout errors in PADS Layout 
when the file is saved.

 

Board Outline

 

Maximum Angle

Maximum Via 
Number

One marker is added for every net with too many 
vias.

Table 37-1. PADS Layout/Router Error Objects (cont.)

Marker Error Notes
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Tip: Within PADS Router you can assign an error as ignored. An ignored error status makes the 
error marker invisible but leaves the error in the database. PADS Layout supports storage of the 
ignored status on errors; however, ignored status can only be assigned or unassigned within 
PADS Router. In PADS Layout, ignored errors are not invisible. Ignored errors invisible in 
PADS Router saved to a PADS Layout file will be visible when the file is loaded into PADS 
Layout. But ignored errors remain as ignored after a file is saved in PADS Layout and loaded 
PADS Router.

Troubleshooting Errors

Clearance Errors

Clearance errors can report a Same net clearance error with an error explanation of Distance 
between pads too small. Although there is no specific SMD-to-SMD and SMD-to-Pad 
clearances, the SMD-to-Via clearance rule is used.

Subnet Errors

Connectivity checks often report a subnet error. There are several causes of subnet errors.

• An unassigned net—the net is not assigned to the plane area. Open the properties of the 
plane area shape and ensure that a net is assigned to the shape. You can only assign a net 
while the shape is in outline mode.

• A small unroute—turn off all layers in the Display colors dialog box. Assign a bright 
color to Connections and search the design for unroutes. 

Tip: You might find a connection to a pin that is not fully routed to the center of the pad. 
It's also easier to spot these if you assign a different color between pads and traces and 
enable the transparent mode to see the trace “underneath” the pad.

• An unplated component pin—check the pad stack of the component pin and ensure the 
Plated check box is selected.

• A via without a plane thermal—open the Via Properties dialog box and ensure the Plane 
Thermal check box is selected.

Latium Check The Latium error marker indicates that you have 
Latium rules in your design. You can only check 
these rules by using the Latium Design 
Verification check in the Verify Design dialog box. 
Therefore, to be sure you do not have Latium 
errors, run the Latium check.

Table 37-1. PADS Layout/Router Error Objects (cont.)

Marker Error Notes
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Exception: A Full Plane Check with Same Layer Connectivity Check will also display a 
subnet error which is caused only by isolated planes. 
See also: Setting Up Plane Checking

Untied Plane Pin Errors

Plane checks sometimes report untied plane pin errors. There are a few causes of untied plane 
pin errors.

• An unplated pin or via

• A pin with a pad size on a plane layer that is greater than the drill size plus the drill 
oversize

• A pin without the thermal attribute set

Save and Print Error Results
You can alternatively view the current error results in your default text editor.

1. Tools menu > Verify Design.

2. To view the most recently run report results in the default text editor, click View 
Report. You can print or save the results from your default text editor.

Setting Default Report File Names

When you run a Verify Design check, a report file is created with a unique name for each check 
type.

1. Tools menu > Verify Design.

2. To specify the default file name of each report type click Report File.

Result: Opens the Save As dialog box where you can name the report that you will run, 
if you don't want to use the default reference name for the report type. 

Tips:

• If you do not give the report a unique name, it is always saved to the default file 
name.

• If you assign it a name, that name is the default for the report type until you change it 
again.

Previewing Fabrication Errors in CAM files
After you run a Fabrication check that reports errors, you can preview the CAM layer document 
associated with the error. The Preview button is available only when fabrication checking is 
enabled and lists errors.
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Requirement: You need the CAM350 Link license option to use this. On the Help menu, click 
Installed Options and on the Options tab, check if the option is available in your license.

1. Tools menu > Verify Design.

2. Select an error in the Location box.

3. Click Preview.

Result: The CAM Preview dialog box opens.

Tips:

• Since error markers are not added to the CAM document, it helps to zoom into the 
design area before you press Preview. If the CAM Preview doesn't open zoomed into the 
same area, you can press the Workspace button in the Cam Preview window to match 
the workspace view.

• In the CAM Preview window, click Setup to change the preview settings of the specified 
document in the preview area.

Back-annotating CAM350 Files
Backward annotation begins by parsing the specified CAM350 file for DFM errors. For each 
error listed in the file an error marker is added to the PADS Layout database, at the error 
location.

Requirement: You need the CAM350 Link license option to use this. On the Help menu, click 
Installed Options and on the Options tab, check if the option is available in your license.

Tip: Existing DFM error markers in the PADS Layout database are cleared before the CAM350 
file is parsed.

Procedure

1. Perform DFM error analysis in CAM350 and save the file.

2. Open the design file in PADS Layout.

3. On the Tools menu, click Verify Design.

4. In the Verify Design dialog box, in the Check area, click Fabrication.

5. Click Setup. 

6. In the Fabrication Checking Setup dialog box click Annotate DFF Errors.

7. Type the name or browse for the CAM350 file in which DFM errors were saved.

8. Click Start in the Verify Design dialog box. DFM error markers appear wherever errors 
exist in the design. They also appear in the Location list with their location.
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9. Correct existing errors and regenerate the CAM350 database.

Adding Nets or Classes for Specific High-Speed Checks
You can run specific electrodynamic checks on nets or classes.

1. Tools menu > Verify Design > select High Speed check > click Setup > click Add 
Nets or Add Classes

2. Select a net or class and then click OK.

Tips:

• You can select more than one item using Ctrl+click

• You can select a range using Shift+click or by dragging the cursor.

Related Topics

Setting Up High Speed (Electrodynamic) Checking

Setting Up EDC Parameters

Setting Up Clearance Checking
Use the Clearance Checking Setup dialog box to specify which clearances to check during a 
Clearance verification.

1. Tools menu > Verify Design > select Clearance check > click Setup.

2. Select the check box beside any types of clearance checks you want to enable and then 
click OK.

Restrictions: 

• Clearance checking only checks the visible area of the design.

• Reference designator, part type, and attribute labels are not checked for clearance 
violations.

• Clearance checking does not check against 2D lines.

• Clearance checking is not performed on CAM Planes.

Tip: Acute angles create solder bridging between conductive objects during board 
manufacturing.

Related Topics

Verify the Design

Design Rule Hierarchy in the Concepts Guide
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Setting Up Checking for Isolated Stitching Vias
During design verification, you can use the Connectivity Check to report isolated routing vias 
and isolated stitching vias. (An isolated stitching via is a stitching via that is not connected to 
any hatch outline or copper area.) However, to have the check report isolated stitching vias, you 
must first set it up to ignore connections to CAM planes.

To find and report isolated stitching vias:

1. Tools menu > Verify Design.

2. In the Check area, select the Connectivity option and then click Setup.

3. In the Connectivity Checking Setup dialog box, select the Ignore CAM plane 
connection for isolated stitching vias check box.

Result: When you verify the design, the checking operation reports isolated stitching vias as 
errors and marks them in the design, along with the other errors found during checking.

Setting Up Latium Checking
To set up Latium checking:

1. Tools menu > Verify Design > select Latium Design Verification check > click Setup.

2. Select the Net to All check box to check clearance rules on each net or hierarchical level 
against any other obstacle type. 

3. Select the Board Outline check box to check clearance rules for the board outline and 
board cut outs.

4. Select the Off Board Text check box to check for off-board text and to flag all instances 
of off-board text as clearance errors.

5. Select the Keepout check box to check for keepout restriction violations.

6. Select the Same Net check box to check clearances between objects along the same net, 
as specified in the Clearance Rules dialog box. 

See also: Design Rule Hierarchy in the Concepts Guide

7. Select the Drill to Drill check box to check clearances between all drill holes. Pad stack 
drill size plus the drill oversize value calculate the diameter for plated holes.

Tip: Drill to drill errors are reported for only one layer in a drill pair.

8. Select the Trace Width check box to check traces in excess of minimum and maximum 
widths, specified in the Clearance Rules dialog box.

See also: Design Rule Hierarchy in the Concepts Guide

9. Select the Placement Outline check box to:
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• In default layer mode, check outline against outline on layer 20, not on electrical 
layers. 

• In increased layer mode, check outline against outline on layer 120.

Tip: You can create outlines on layer 20 (or 120) that do not exactly match the actual 
component outline. By setting a larger outline on this layer, you can leave an area near a 
component open for other purposes. This check ensures this area is left open.

10. Select the Via at SMD check box to check for via at SMD restriction violations.

See also: Pad Entry Rules dialog box

11. Select the Differential Pairs check box to check for differential pair restriction 
violations.

See also: Creating Differential Pair Design Rules

12. Select the Trace Length check box to check for length restriction violations.

See also: HiSpeed Rules dialog box

13. Select the Test Point check box to check test points on the design. Test Points checks 
for probe clearances, minimum via/pad sizes for probing, SMD pin probing, test points 
on component pin on the component side, test point count per net settings and nail 
diameter settings, and compares the settings against the setting in the DFT Audit 
program. 

See also: Performing a Test Point Audit

Tips:

• Reference designator, part type, and attribute labels are not checked for clearance 
violations.

• Latium design verification performs clearance checking on only the visible area of the 
design. When clearance checking against the board outline, the edge of the object is 
checked against the centerline of the board outline. 

• Drill to Drill errors are reported for only one layer in a drill pair.

• Test point checking is the same whether you enable the checking on the Latium 
Checking Setup dialog box or on the Verify Design dialog box. If you plan to perform 
Latium design verification, you can eliminate an extra design transfer between PADS 
Layout and PADS Router by running test point checking with the other Latium checks.

Related Topics

Verify the Design
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Setting Up Fabrication Checking
Use the Fabrication Checking Setup dialog box to enable fabrication checks, or to load DFF 
errors from a preexisting CAM350 database and annotate into the design.

Requirement: You need the CAM350 Link license option to use this. On the Help menu, click 
Installed Options and on the Options tab, check if the option is available in your license.

In this topic:

• Running Fabrication Checks

o Checking Acid Traps

o Checking Slivers

o Checking Starved Thermals

o Checking Trace Width/Pad Size

o Checking Silkscreen Over Pads

o Checking Annular Ring

o Checking Solder Bridges

• Annotating DFF Errors

Running Fabrication Checks
Requirement: Fabrication checks require certain CAM documents, which are listed in 
Table 37-2. You may consider creating these files before running the Fabrication check. 

• Tools menu > Verify Design > select Fabrication check > click Setup.

Table 37-2. CAM Documents Required for Fabrication Checks 

Check CAM Document Layers Required

Acid Traps All Electrical Layers

Copper Slivers All Electrical Layers

Solder Mask Slivers Top-Bottom Solder Mask Layers

Solder Mask Bridges Top-Bottom Electrical & Solder Mask 

Starved Thermals All Negative CAM Plane Layers

Minimum Annular Rings All Electrical Layers Solder Mask Layers

Silkscreen Over Pads Top-Bottom Solder Mask & Silkscreen
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Checking Acid Traps

Use this check to flag small areas where acid will pool up. The check is run on all visible 
electrical layers as defined in the CAM documents.

1. Select the Acid Trap check box.

2. In the Maximum Size box, type a maximum value of the acid traps to detect. The areas 
of the “pools” that are flagged will be less than this value.

3. In the Maximum Angle box, type a maximum angle for traces, pads, or any other data 
that exists on the layer. Any items that form an angle smaller than this will be flagged as 
an acid trap.

Checking Slivers

Use this check to flag copper sliver and solder mask sliver areas. This compares the top solder 
mask layer against the top electrical layer and the bottom solder mask layer against the bottom 
electrical layer as defined in the CAM documents.

1. Select the Slivers check box.

2. In the Minimum Copper box, type a minimum value for copper slivers. This flags 
slivers with less area than this value.

3. In the Minimum Mask box, type a minimum value for solder mask slivers. This flags 
the slivers with a width less than this value, checking the top and bottom solder mask 
layers if they are visible. 

Checking Starved Thermals

Use this check to flag invalid thermals where adjacent data overlaps the thermal spokes.

Restriction: Starved Thermals are only checked on (negative) CAM planes.

1. Select the Starved Thermals check box.

2. In the Minimum Clearance box type the percentage of the thermal's spoke that can be 
unblocked by another object. Any less of an opening will be considered “starved.”

3. In the Minimum Spokes list, select the minimum allowable number of the thermal's 
spokes that cannot be blocked by another object. Any less will be considered “starved.”

Checking Trace Width/Pad Size

Use this check to flag traces and pads that are too small. Checks all electrical layers as defined 
in the CAM documents.

1. Select the Trace Width/Pad Size check box.
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2. In the Minimum Trace box, type a minimum trace width value. This flags traces with a 
width less than this value. This check runs on all visible electrical layers.

3. In the Minimum Pad box, type a minimum pad size. This flags pads with a diameter of 
less than this value. This check runs on all visible electrical layers.

Checking Silkscreen Over Pads

Use this check to flag silkscreen over pads on top and bottom layers as defined in the CAM 
documents.

1. Select the Silkscreen Over Pads check box.

2. In the Minimum Gap box, type the minimum allowable distance between silkscreen 
features and a region exposed by solder mask.

Checking Annular Ring

Use this series of checks to flag minimum annular rings on top and bottom layers, comparing 
electrical, drill, and mask layers. 

• Select the Annular Ring check box to enable the Pad to Mask, Drill to Mask and Drill 
to Pad checks.

Pad to Mask

Use the Pad to Mask check to flag minimum clearance distances between a pad and its solder 
mask opening. The offset and annular ring is checked against the specified clearance value. This 
compares the top electrical layer against the top solder mask layer or the bottom electrical layer 
against the bottom solder mask layer. 

1. Select the Pad to Mask check box.

2. In the box, type the minimum clearance value.

3. In the Layers list, select the layer to use for checking.

Drill to Mask

Use the Drill to Mask check to flag minimum clearance distances between a drill and its solder 
mask opening. The offset and annular ring is checked against the specified clearance value. This 
compares the top drill layer against the top solder mask layer or the bottom drill layer against 
the bottom solder mask layer.

1. Select the Drill to Mask check box.

2. In the box, type the minimum clearance value.

3. In the Layers list, select the layer to use for checking.
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Drill to Pad

Use the Drill to Pad check to flag minimum clearance distances between a drill and its 
associated pad. The offset and annular ring is checked against the specified clearance value. 
This check is run on each specified layer.

1. Select the Drill to Pad check box.

2. In the box, type the minimum clearance value.

3. In the Layers list, select the layer to use for checking.

Checking Solder Bridges

Use this check to flag solder mask bridging. Solder can bridge and cause a connection to an 
adjacent object within the same mask opening. If the adjacent object is farther from the pad than 
this distance, even if it is exposed by the mask layer, it will not be identified as a bridge. This 
compares the top solder mask layer against the top electrical layer or the bottom solder mask 
layer against the bottom electrical layer as defined in the CAM documents.

1. Select the Solder Bridges check box.

2. In the Minimum Gap box, type the minimum clearance value.

3. In the Layers list, select the layer to use for checking.

Annotating DFF Errors
If you use CAM350 for checking fabrication errors, you can load DFF errors from a CAM350 
file.

• In the CAM350 File Name box, Type a .cam path and file name or click Browse to 
navigate to the location of a file to back-annotate DFF errors into PADS Layout for 
design verification.

Related Topics

Fabrication Checks Definition in the Concepts Guide

Verify the Design

Setting Up High Speed (Electrodynamic) Checking
Use the Electrodynamic Check dialog box to enable high-speed checks for individual nets and 
classes or for the whole design.

Requirement: You must have specified your plane layers in the Layers Setup dialog box before 
you run an electrodynamic check. For a two-layer board, temporarily identify one of the layers 
as a plane layer.
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In this topic:

• Enabling High Speed Checks

• Deleting Tasks

• Setting Electrodynamic Check Parameters

• Setting Design Rules

• Reusing Electrodynamic Check Settings

Enabling High Speed Checks
You can enable checks for the entire design or if you need to make specific checks of certain 
nets or classes, you can add them to the Task List. You can enable different checks for each 
item in the Task List.

1. Tools menu > Verify Design > select High Speed check box > click Setup.

2. If you need to add specific nets or classes to the Task List, click Add Nets or Add 
Classes.

Tip: (N) is added to Task list items that are nets and (C) is added to items that are 
classes.

3. Select an item from the Task List to enable High Speed checks for that item.

4. Select the check boxes for the types of checks you want to enable.

Tips: To define checks for several nets or classes simultaneously, click more than one 
item in the list. If there are conflicting values between two selected items, the check 
boxes are dimmed but can be cleared and selected.

5. Repeat steps 2 and 3 for each remaining item.

Deleting Tasks
You can delete specific nets and classes from the Task List - deleting the custom checks.

1. Tools menu > Verify Design > select High Speed check box > click Setup.

2. Select the task in the Task List and click Delete.

Setting Electrodynamic Check Parameters
You can set up Electrodynamic Check Parameters in addition to activating the Electrodynamic 
checks. Use the Parameters dialog box to enter physical properties of the PCB, to customize 
checks and to request report detail level.

1. Tools menu > Verify Design > select High Speed check box > click Setup.
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2. Click Parameters.

See also: Setting Up EDC Parameters

Setting Design Rules
You can access the design rules from the Electrodynamic check dialog box. Use the Rules 
dialog box to enter high-speed rules such as minimum and maximum lengths, gaps for 
parallelism and tandem checking, and other limits like stub length and daisy chaining.

1. Tools menu > Verify Design > select High Speed check box > click Setup.

2. If you need to edit or assign rules for checking, click the Rules button as a shortcut to 
the Rules dialog box.

See also: Design Rule Hierarchy in the Concepts Guide

Reusing Electrodynamic Check Settings
You can reuse your electrodynamic check settings. You can save the current electrodynamic 
check task, parameter and rules settings.

1. Tools menu > Verify Design > select High Speed check box > click Setup.

2. Click Save or Save As to store your settings to an .edp file.

3. Click Open to retrieve settings from an .edp file.

Related Topics

Setting Up EDC Parameters

Verify the Design

Setting Up EDC Parameters
Use the EDC Parameters dialog box to define global rules like layer thickness and copper 
thickness. You can also specify how detailed a design verification report you want.

In this topic:

• Setting Up Layer Definitions

• Setting Parallelism Check Details

• Setting Daisy Chain Report Details

• Setting Details for Other Checks

• Including Segment Coordinates in Segments Reports



Checking a Design for Errors
Verify the Design

PADS Layout User’s Guide and Reference Manual, PADS 9.4 751

• Listing Violations Only

• Excluding Segments under/within Pads from Calculations

Setting Up Layer Definitions
You may have already set up your layer definitions in the Layers Setup dialog box, but this 
duplicate of the Layer Thickness table allows you to make modifications or to set definitions for 
the first time if needed. Set these definitions before you run an electrodynamic check.

Board Thickness—is the total value of material and layer thicknesses in the current design 
units.

To set layer values:

1. If the layers are not set up properly, use the Layers button to gain easy access to the 
Layers Setup dialog box where you can define layer properties, names, and 
functionality.

Requirement: You must have specified your plane layers in the Layers Setup dialog 
box before you run an electrodynamic check. For a two-layer board, temporarily identify 
one of the layers as a plane layer.

2. For each dielectric material layer, double-click the Type cell to select whether the 
“layer” is a Prepreg or Substrate layer.

Alternative: Although it is a longer process, you can click a box and then click Edit 
instead of using the double-click method.

3. For each layer, double-click the Thickness cell and type a value.

Exception: If no coating is required, set thickness to zero.

4. For dielectric material layers, double-click the Dielectric cell and type a dielectric 
constant value.

Tip: You can view and edit copper thicknesses by weight or design units. Click the copper 
thickness unit you want:

Setting Parallelism Check Details
You can select the extent of checking and reporting for Parallelism and Tandem checks.

1. In the Parallelism area, in the Check Against list, select the extent of checking. Select 
from:

Weight (oz) Weight of copper in ounces, per square foot

Design Units Same unit of measure as the current database unit of measure
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Nets/Pin Pairs—Checks the parallelism and tandem rules against the entire net or pin 
pair.

Segments—Checks the parallelism and tandem rules against only individual segments.

2. In the Parallelism area, in the Report Detail list, select the extent of reporting. Select 
from:

Net Names Only—Displays only net names and violations.

Aggressors/Victims—Displays specific aggressor and victim nets.

Segments—Displays segment coordinates and layers in addition to aggressor and victim 
nets.

Setting Daisy Chain Report Details
You can select the extent of reporting for the Stubs (Daisy Chain) check.

• In the Daisy Chain area, in the Report Detail list, select the extent of reporting. Select 
from:

Net Names Only—Include the number of T points and whether the net is daisy chained.

Stubs—Include the group of pins within each stub, the total stub length for each group, 
the number of T points, and whether or not the net is daisy chained.

Pin Pairs—Include the pin to pin length of all pin pairs, the total pin pair length added 
together to form stubs, the number of T points, and whether the net is daisy chained.

Segments—Include the coordinates and layer of all track corners, the pin to pin length 
of all pin pairs, the total pin pair length added together to form stubs, the number of T 
points, and the nets being daisy chained.

Setting Details for Other Checks
You can set various setting for other checks.

1. In the Other Checks area, in the Check Against list, select the extent of checking of 
Length and Delay rules. Select from:

Nets/Pin Pairs—Check the Length and Delay rules against the entire net or pin pair.

Segments—Check the Length and Delay rules against individual segments.

2. In the Other Checks area, in the Report Detail list, select the extent of reporting for 
capacitance, impedance, delay, and length. Select from:

Nets—Include the starting and ending pins of nets and net values for capacitance, 
impedance, delay, and length.
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Pin Pairs—Include pin-to-pin points, pin pair values, and net values for capacitance, 
impedance, delay, and length.

Segments—Include individual segment coordinates and segment values for 
capacitance, impedance, delay, and length.

3. Select the Include Copper check box to include copper polygons with signal names in 
the capacitance calculations.

4. Select the Use FieldSolver for Calculations check box to calculate electric parameters 
of transmission lines such as: impedance, delay (per unit length), and capacitance (per 
unit length).

See also: the BoardSim User’s Guide.

Including Segment Coordinates in Segments Reports
You can include segment coordinates in reports where Segments has been selected in the Report 
Detail in any one of Parallelism, Daisy Chain, or Other Checks sections.

• Select the Report Segment Coordinates check box.

Listing Violations Only
You can list only items that contain violations in the high-speed report.

• Select the Report Violations Only check box.

Excluding Segments under/within Pads from Calculations
You can exclude trace segments under pads from calculations. When routing, traces are routed 
into the middle of pads. This final segment is excluded.

• Select the Remove Segments under Pads check box.

Related Topics

Verify the Design

Setting Up Plane Checking
Use the Mixed Plane Setup dialog box to set the type of plane checking.

In this topic:

• Checking Thermal Connectivity Only

• Checking Clearance and Net Connectivity
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• Checking Same Layer Connectivity

Checking Thermal Connectivity Only
You can check your design for split/mixed or CAM plane thermal connectivity. Use this check 
to find pins or vias that do not have the thermal attribute set, or to find pins that are not within a 
plane area (thermals will not connect). You can set the thermal attribute in Jumper Pin, Pin, or 
Via Properties dialog boxes.

1. Tools menu > Verify Design > select Plane check > click Setup.

2. Click Check thermal connectivity only.

3. Click OK.

4. Click Start in the Verify Design dialog box to run the check.

Tip: Routed pins without the thermal attribute set are not marked as errors.

See also: Assigning Plane Thermal Attributes

Checking Clearance and Net Connectivity
You can check your design for split/mixed plane clearance and net connectivity errors. If the 
split/mixed plane is not connected in the design, a Plane Connect will be performed before the 
check is run.

Requirement: Before you check for clearance and net connectivity, a plane area for each net 
assigned to the plane layer in the Layers Setup dialog box must be present.

1. Tools menu > Verify Design > select Plane check box > click Setup.

2. Click Check clearance and connectivity.

3. Click Ok.

4. Click Start in the Verify Design dialog box to run the check.

Tip: Pads on plane layers are checked for plating, a pad size on a plane layer that is greater than 
the drill size plus the drill oversize, or connection to a plane net.

Checking Same Layer Connectivity
Ensures that plane areas are continuous on the split/mixed plane layer. Plane areas of a 
particular net must have copper contact with each other without going to another layer.

1. Tools menu > Verify Design > select Plane check box > click Setup.

2. Click Check clearance and connectivity.
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3. Select the Same Layer Connectivity check box.

4. Click Ok.

5. Click Start in the Verify Design dialog box to run the check.

Related Topics

Verify the Design

Troubleshooting Errors 

Setting Up Wire Bond Checking
Use the Wire Bond Checking Setup dialog box to specify which wire bond rules to check during 
a Wire Bonds verification.

1. Tools menu > Verify Design > select Wire Bonds check box > click Setup.

2. Select the check box beside any types of checks you want to enable and then click OK.

Tip: Unchecked rules appear in the wire bond report as “Not Set.”

Restriction: The rule is not checked unless you select it and enter a value.

Related Topics

Wire Bond Rules Dialog Box

Verify the Design

Checking the Plane Connection for Continuity
When you run a continuity check in Verify the Design from the Tools menu, the net checks are 
connected if no errors are found. 

Proper same layer continuity
The two planes are connected by 
thermal spokes and on the same 
layer.

Error condition
Two planes with the same net exist 
but are connected by a pad and a 
trace on a different layer.
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Run the Plane check to see whether a pad exists in the connecting pad stack for the plane level, 
for example; is the pad size more than 0 or does the drill size exceed pad size? For links to SMD 
pads, it checks whether the pad-to-via connection connects to the plane.
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Chapter 38
Dimensioning

Dimensioning Process
The Dimensioning Toolbar contains tools for dimensioning your design. The Dimensioning 
Toolbar is also available in the PCB Decal Editor.

1. Click the Dimensioning Toolbar button. 

2. Set your preferences for dimensions on the Dimensioning tab of the Options dialog box. 
Give specific attention to the Layers where the dimensioning objects are added.

Warning: Text and lines added to electrical layers will be fabricated in copper! Select a 
documentation layer for documentation objects.

See also: Dimensioning Options

3. Before attempting to dimension a design object, set the selection filter to the type of 
object for dimensioning.

See also: Using the Selection Filter

4. Based on the type of object to be dimensioned, select a dimensioning button.

See also: Creating Dimensions

5. If you are creating multiple linear dimensions, different measurement styles are 
available. Right-click and click a measurement style.

See also: Selecting a Dimension Measurement Style

6. Based on the dimension you are creating and line widths of extension lines and objects 
in the design, you may need to select a difference edge preference. Right-click and click 
on of the Edge Preferences.

See also: Setting an Edge Preference

7. Unless you are dimensioning a single basic object, you may need to manually identify 
the points to dimension. Right-click and click one of the Snap Modes.

See also: Snapping Dimensions Points

8. Select the object to dimension and then click to place the dimension.

9. When finished dimensioning, select the Select button to end dimensioning operations. 
The Select button in the standard toolbar closes the open toolbar.

Tip: You can also use the View > Clearance dialog box to add dimensions to your design.
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Related Topics

View Clearance Dialog Box

Creating Dimensions
You can create dimensions automatically and manually with the dimensioning tools. If a design 
object is in a selected state when a dimensioning button is clicked, one item is dimensioned. 
After dimensioning the first item, you select the next data item, and then click the button again. 
Dimensioning modes are sticky, allowing you to select and dimension additional data items. To 
exit a dimensioning mode, click the Select button on the toolbar, or click View > Toolbars > 
Dimensioning Toolbar to close the toolbar.

• Automatic Dimensions Dimensioning with Auto Mode

• Vertical Dimensions

• Aligned Dimensions

• Rotated Dimensions

• Angular Dimensions

• Arc or Circle Dimensions

• Leader Line Dimensions

Automatic Dimensions Dimensioning with Auto Mode
Auto mode automatically establishes the orientation of newly added dimensions. If you select a 
line segment with Auto active, the system measures the length of the line segment and adds a 
dimension line parallel to the selected line. Auto is similar in functionality to Aligned mode 
except that Auto does not allow the selection of individual points. Snap mode is unavailable 
while you use Auto.

Auto dimensions arcs and circles in the same manner; click Auto and select the arc or circle to 
dimension. The advantage to using Auto mode is that you can create dimensions for line 
segments and/or arcs without having to switch modes.

To dimension with Auto mode:

1. Dimensioning Toolbar button > Auto button.

2. Select the line segment or arc you want to dimension. An image of the dimension is 
attached to and moves with the pointer to locate the dimension line.

3. Click to indicate the location for the dimension line.

Restriction: Snap Mode is unavailable for Auto dimensioning since this option only works with 
selected line segments.
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Horizontal Dimensions
Horizontal mode creates dimensions with the dimension line always being in a horizontal 
orientation, X direction. Selected line segments that exist at an angle have their base distance 
measured. Line segments in a pure vertical orientation, Y direction, cause an error message to 
appear. The same orientation rules apply for points entered through the pointer.

To create new dimensions with Horizontal mode:

1. Dimensioning Toolbar button > Horizontal button.

2. Select a Snap Mode and Edge Preference, if necessary.

3. Select the line segment to dimension, or indicate two points. The dimension dynamically 
attaches to the pointer.

4. Click to indicate a location for the dimension line.

You can continue to dimension additional data items.

Vertical Dimensions
Vertical mode creates dimensions with the dimension line always being in a vertical orientation, 
Y direction. Selected line segments that exist at an angle have their height distance measured. 
Line segments in a pure horizontal orientation, X direction, cause an error message to appear. 
The same orientation rules apply for points entered through the pointer.

To create dimensions with Vertical mode:

1. Dimensioning Toolbar button > Vertical button.

2. Select a Snap Mode and Edge Preference, if necessary.

3. Select the line segment to dimension, or indicate two points. The dimension dynamically 
attaches to the pointer.

4. Click to indicate a location for the dimension line.

Vertical remains active, allowing you to dimension additional data items.

Aligned Dimensions
Aligned creates dimensions with the dimension line at the same angle as the selected line or 
points. Aligned is similar to Auto, but in addition to dimensioning selected lines, Aligned 
allows you to indicate two points that identify the measurement locations.

To create an aligned dimension:

1. Dimensioning Toolbar button > Aligned button.
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2. Select a Snap Mode and Edge Preference, if necessary.

3. Select the line segment to dimension, or indicate two points. The dimension dynamically 
attaches to the pointer.

4. Click to indicate a location for the dimension line.

Aligned remains active so you can dimension additional data items.

Rotated Dimensions
Rotated mode creates dimensions similar to Aligned mode, but offers the additional flexibility 
of rotating the entire dimension object by a specified number of degrees. This feature is 
convenient when several dimensions exist in one location, because it allows you to offset some 
dimensions for easy viewing.

When dimensioning in Rotated mode, the system displays a prompt window specifying the 
current angle, with zero being in the positive Y axis (toward the top of the work area). You can 
type a different value to rotate and offset the entire dimension object. Positive values rotate 
counterclockwise; negative values rotate clockwise.

To create dimensions in Rotated mode:

1. Dimensioning Toolbar button > Rotated button.

2. Select a Snap Mode and Edge Preference, if necessary.

3. Select the line segment to dimension, or indicate two points.

4. Type the rotation value you want to use and click OK. The dimension dynamically 
attaches to the pointer.

5. Click to indicate a location for the dimension line.

Rotated remains active, allowing you to dimension additional data items.

Angular Dimensions
Angle mode measures and dimensions an angle in degrees. You can specify this angle by two 
line segments, a line segment and two points, or four points. These settings are controlled by the 
available Snap modes.

To create an angular dimension:

1. Dimensioning Toolbar button > Angular button.

2. Right-click and click a Snap Mode option, if necessary.

3. Select the lines to dimension, or indicate two points to define the angle. The angular 
dimension dynamically attaches to the pointer.
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4. Click to indicate a location for the dimension line.

Angular remains active, allowing you to dimension additional data items.

Arc or Circle Dimensions
Arc creates dimensions that measure and document the size of arcs or circles, with the 
calculation being the radius or the diameter.

To dimension an arc or circle:

1. Dimensioning Toolbar button > Arc button.

2. Right-click and click an Edge Preference, if necessary.

3. Select the arc or circle to dimension. The radial dimension dynamically attaches to the 
pointer.

4. Click to indicate a location for the dimension line.

Arc remains active, allowing you to dimension additional data items.

Tip: Arc mode works best when the Options dialog box is set to Manual Position for text. This 
lets you create a leader line affect for documented arcs and circles.

Leader Line Dimensions
Leader creates a standard pointer to the selected information or point. It is simply a line with an 
arrow at one end and a user-specified text string at the other.

To create a leader line:

1. Dimensioning Toolbar button > Leader button.

2. Right-click and click a Snap Mode if you are creating the leader from a specific point, 
such as the midpoint of the selected line.

3. Select the line to dimension, or click to indicate a point for the arrow. A line with an 
orthogonal corner dynamically attaches to the pointer.

4. Click to add a vertex and anchor the leader line. Double-click to complete the leader 
line.

5. Type a text string for the leader line and click OK.

Related Topics

Dimensioning Process
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Selecting a Dimension Measurement Style
In this Topic:

• Creating Chained Dimensions

• Creating Baseline Dimensions

Creating Chained Dimensions
Continue type dimensioning creates dimensions in a daisy-chained fashion. With Continue on, 
the last entered point becomes the new first point of subsequent dimensions.

To perform Continue type dimensioning:

1. Click the Dimensioning Toolbar button.

2. Click the appropriate dimensioning button on the Dimensioning toolbar, such as 
Horizontal, Vertical, or Aligned.

3. Right-click and click Continue. A check mark appears next to Continue, indicating that 
it is active.

4. Click to indicate the location of the first dimension point. The prompt “Continue. Enter 
second point” appears.

5. Click to indicate the location of the next dimension point.

6. Move the pointer to position the dimension line and click to indicate the first dimension 
object.

7. Repeat steps 4 and 5 for all points.

8. To end dimensioning, right-click and click Continue again. The check mark next to 
Continue is removed.

Creating Baseline Dimensions
Baseline dimensioning defines several measurements from the same starting point. To perform 
baseline dimensioning:

1. Click the Dimensioning Toolbar button.

2. Click the appropriate dimensioning button on the Dimensioning Toolbar, such as 
Horizontal, Vertical, or Aligned.

3. Right-click and click Baseline. A check mark appears next to Baseline, indicating that it 
is active.
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4. Click to indicate the location of the baseline dimension point. The prompt “Baseline. 
Enter second point” appears on the Status Bar.

5. Click to indicate the location of the next dimension point.

6. Move the pointer to position the dimension line and click to indicate the first dimension 
object.

7. Repeat steps 4 and 5 for all points.

8. To end dimensioning, right-click and click Baseline again. The check mark next to 
Baseline is removed.

Setting an Existing Extension Line as the Baseline
You can set an existing extension line as the new baseline:

1. Dimensioning Toolbar button > Select button.

2. Select the extension line to act as the new baseline.

3. Right-click and click Baseline. A check mark appears next to Baseline, indicating that it 
is active.

4. Click a dimension button on the Dimensioning toolbar that matches the selected 
extension line orientation.

5. Click to indicate the location of the next dimension point.

6. Move the pointer to position the dimension line and click to indicate the first dimension 
object.

7. Repeat steps 4 and 5 for all points.

8. To end dimensioning, right-click and click Baseline again. The check mark next to 
Baseline is removed.

Related Topics

Dimensioning Process

Dimensioning Alignment Tool and Arrow Options

Setting an Edge Preference
The Edge Preference enables you to measure and dimension objects from the center of the 
drawn line or from either line edge. The default measures all lines from their physical 
centerline, regardless of the drawn line width. While this would be necessary for a part to part 
dimension, a dimension that documents the design rule spacing between two adjacent routes 
would need the edge preference set to Use Inner Edge.
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1. Dimensioning Toolbar button > click a dimensioning style button.

2. Right-click and click an Edge Preference described in the table below. A check mark 
appears next to the selected mode. 

Tips:

• This mode remains in effect until you select another. Also use the shortcut menu to 
set the snap mode.

• Line length measurements are also affected by the edge preference option. To ensure 
accuracy of standard dimensioning tasks, reset this option to Use Centerline, after 
using one of the alternate settings.

Related Topics

Dimensioning Process

Dimensioning in the Concepts Guide

Snapping Dimensions Points
A Snap mode lets you precisely identify points to dimension from by forcing the pointer to snap 
to a specified part of an object, such as the corner or center.

In this topic:

• Using a Snap Mode

• Adjusting Snap While Dimensioning

Using a Snap Mode
The system defaults to auto-snap mode. In this mode, both endpoints of a selected line segment 
or an entire arc are selected to identify the dimension points. You can select a more manual snap 
mode.

1. Dimensioning Toolbar button > click a dimensioning style button.

2. To disable auto-snap, right-click and click one of the snap modes listed in the table 
below. A check mark appears next to the selected mode.

Table 38-1. Edge Preference Choices

Edge Preference Description

Use Centerline Measures from the center of the object.

Use Inner Edge Measures from the edge closest to the other point.

Use Outer Edge Measures from the edge furthest from the other point.
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Tip: This mode remains active until you select another one, or until you exit PADS 
Layout. 

3. To re-enable auto-snap, right-click and click the snap mode to remove the checkmark 
from the currently-selected mode.

Restriction: Snap modes are unavailable for Auto and Arc type dimensioning styles. These 
styles only support the auto-snap mode because they apply to selected line segments and arcs, 
not selected points.

Adjusting Snap While Dimensioning
You can adjust snap mode while selecting dimensioning points. This capability can be 
important when dimensioning angles.

To adjust snap while dimensioning:

1. Dimensioning Toolbar button > click a dimensioning style button.

2. If needed, right-click and click a snap mode.

Restriction: Snap mode is unavailable for Auto and Arc type dimensioning styles. 
These styles support the auto-snap mode only because they apply to selected line 
segments and arcs, not selected points.

3. Select the first dimensioning point.

4. If needed, right-click and click a snap mode.

5. Select the second dimensioning point.

6. If you selected the Angular dimensioning style, repeat steps 4-5 as needed to select the 
other side of the angle.

Snap Modes

The following table lists the snap modes and their descriptions. 

Table 38-2. Snap Modes 

Snap to: Description

Corner Snaps to the endpoints of a line segment or arc. A corner is where a 
design object changes direction.

Midpoint Snaps to the center point of a line segment or arc. Circles are selected 
at the 180-degree point, left side, since arcs are drawn with the 
starting point on the right.

Any Point Snaps to the closest point on a line segment, arc, or circle.

Center Snaps to the center of the closest circle, arc, or pad.
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Related Topics

Dimensioning Process

Selecting the Parent Dimensioning Object
To select the parent dimension object from a selected dimension element:

1. Select one of the items in the dimension object.

2. Right-click and click Select Parent. The entire dimension is selected.

Related Topics

Dimensioning Modes in the Concepts Guide

Moving Dimensions and Dimension Objects
You can move Dimensions or Dimension Objects using the Move command or by Dynamically 
Dragging Objects.

In this topic:

• Moving an Entire Dimension

• Moving a Dimension Object

• Moving Text to Its Default Location

• Dynamically Drag Objects

• Changing Lengths

Circle/Arc Snaps to the radius point of an arc or circle.

Intersection Snaps to closest point where two or more objects intersect.

Quadrant Snaps to the closest orthogonal point, 0, 90, 180, or 270 degrees, on 
an arc or circle. Arcs must pass through an orthogonal point to be 
selected. 

Do Not 
Snap

Snaps to any grid point.

Table 38-2. Snap Modes (cont.)

Snap to: Description
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Moving an Entire Dimension
To move the entire dimension:

1. Select the dimension object through multiple selection or by using the Select Parent 
command.

2. Right-click and click Move. The dimension object dynamically attaches to the pointer.

3. Click to indicate a location for the object.

The dimension object remains selected for additional moving, if required.

To move dimension objects using keyboard entered coordinates, use the Dimension Object 
Properties dialog box.

Moving a Dimension Object
You can move individual dimension objects, including: arrows (with their lines), text strings, 
extension lines, and leader segments.

To move an dimension object:

1. Select a dimension object.

2. Right-click and click Move.

3. Click to indicate the new location for the dimension object.

Tips: 

• The new position of the text and the location of the arrows are determined by the current 
Option settings.

• If you select and move an extension line, the dimension line and the dimension text are 
both automatically modified to reflect the new measurement. Stretching the extension 
line without changing the measurement is performed with the Change Length command. 
This command works in the same manner as moving arrows, but works with selected 
extension lines.

Moving Text to Its Default Location
1. Click the dimensioning text to select it. If you cannot select the text, check the selection 

filter settings.

2. Right-click and click Default Location.

Tip: To add a new segment to an existing leader, right-click and click Add Corner and Split.
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Dynamically Drag Objects
1. Select an object.

2. Place the pointer over the selected object, then click and hold the left mouse button to 
initiate Drag mode.

3. Move the mouse to the new location for the object and release the left mouse button.

Tip: The above sequence assumes that the Drag option is set in the Global tab of the Tools > 
Options dialog box to Drag and Drop.

Changing Lengths
With an extension line selected, the Change Length command adjusts the position of the 
dimension line and arrows without changing the actual measurement. When used, the 
dimension object is attached to, and moves along with, the pointer, such as when a new 
dimension is created.

1. Select the extension line for which you want to change the length.

2. Right-click and click Change Length. The dimension object dynamically attaches to 
the pointer.

3. Click to indicate the new location for the dimension.

Related Topics

Dimensioning Process

Resetting Dimension Measurements

Selecting the Parent Dimensioning Object

Deleting Dimensions
To delete a dimension element:

1. Select the dimension element to delete using one of the following methods:

• Select one of the dimension's elements. Right-click and click Select Parent.

• Use multiple selection to sequentially select each element belonging to the 
dimension.

• Select the entire dimension with a selection rectangle.

2. Press Delete, or click Delete from the Edit menu.
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Resetting Dimension Measurements
To reset the measurement text:

1. Click the dimensioning text to select it. If you cannot select the text, check the selection 
filter settings.

2. Right-click and click Reset Measurement.

3. Type the new measurement in the Text Value dialog box and click OK.

Specifying Missing Heights During Export to IDF
You use the Missing Height dialog box to specify missing heights when exporting the design to 
IDF. The Missing Height dialog box appears when the Geometry.Height attribute does not exist 
or is set to zero height for any part type and decal pair exported to IDF.

To specify a missing height during export to IDF:

1. In the Height box, type the package and mounting height for the part type and decal pair.

Tip: If you specify the height as zero, the mechanical design system may prompt you to 
enter a height when you import the IDF file.

2. If you want to apply the height for all part type and decal pairs, select the For All Parts 
check box.

3. Click OK.

Result: Export to IDF resumes.

Related Topics

Missing Height Dialog Box

Exporting Part Height Information to IDF Files

Setting Up the CAM350 Link
Use the CAM350 dialog box to set options for, and to generate, a .cam output file.

1. Tools menu > CAM350.

2. In the Mode area, select from:

• Create Files Only to simply produce the .cam file 
or

• Create File and Launch CAM350 to start CAM 350 and load the resulting .cam file.
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3. In the Layer Options area, select an option for the amount of PADS design detail to 
translate to the CAM350 database. Select from:

• CAM Documents (includes Nets and Parts)—Translates CAM documents with 
part and net intelligence. Plot orientation, as specified in the CAM document, is not 
applied. This is useful for verifying net lists and DRCs in CAM350.

Requirement: Before using this option, flood all copper pours and connect all 
split/mixed plane layers. Also, on the Tools > Options > Split/Mixed Plane tab, in 
the Save to PCB File area, click All Plane Data. This allows all pour data to be 
passed to CAM350.

• CAM Documents (Graphics only, Orientations applied)—Translates CAM 
documents with plot orientation, including offset, rotation, mirroring, and scaling. 
This is useful for direct Gerber file translation to CAM350 where no component or 
net information is required.

Requirement: Before using this option, if your PADS Layout photoplot output 
format is set to RS-274D, make sure your CAM350 default units (mils or inches) 
and CAM350 default precision are set to match the units for PADS Layout and the 
precision for PADS Layout File/CAM photoplot output, respectively.

CAM350 Link uses the files pads3.arl (for English units) and pads3m.arl (for Metric 
units) with this option and when Gerber files are in RS274-D format. The *.arl files 
determine how the aperture report file (*.rep) is generated by CAM in PADS Layout 
will be interpreted by CAM350.

• CAD Layers -> CAM Layers (As-Is)—Translates no CAM documents. Translates 
CAD layers as defined in the PADS Layout database. This is useful for legacy CAM 
processes that take advantage of CAD layer translation using the PADS-ASCII 
format import operation in CAM350.

Requirement: Before using this option, flood all copper pours and connect all 
split/mixed plane layers. Also, on the Tools > Options > Split/Mixed Plane tab, in 
the Save to PCB File area, click All Plane Data. This allows all pour data to be 
passed to CAM350.

4. Arcs in polygon shapes, such as copper pour, are approximated using straight edges. In 
the Arc Approximation Tolerance box, type the minimum allowable distance between 
the actual arc path and the approximated straight-line segments. This appears in the 
appropriate design units, which you set on the Global tab.

5. In the CAM350 File Name box, type a .cam path and file name or click Browse to 
navigate to a location. The default file name and path are the same name as the current 
design file name and path.

Related Topics

Annotating DFF Errors
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Chapter 39
CAM Output

Creating CAM Outputs to Manufacture Your PCB
This topic lists the typical gerber files, drill files, assembly coordinate files, and drawings you 
need to manufacture your PCB. Check with your manufacturer for a specific list of 
requirements. Click the links for the procedures to create each file type.

Procedure

For the Top Layer:

1. Create the Conductive Elements gerber-format file for the photo plotter. Choose 
between the following layer types:

• Routing/Split Plane (gerber-format file)

• CAM Plane (gerber-format file)

2. Create the Silkscreen gerber-format file for the photo plotter (gerber-format file)

3. Create the Solder mask gerber-format file for the photo plotter (gerber-format file)

4. Create the Paste mask gerber-format file for the photo plotter (gerber-format file)

5. Create the Assembly Drawing (non-gerber)

For Each Internal Layer:

• Create the Conductive Elements gerber-format file for the photo plotter. Choose 
between the following layer types:

o Routing/Split Plane (gerber-format file)

o CAM Plane (gerber-format file)

For the Bottom Layer:

1. Create the Conductive Elements gerber-format file for the photo plotter. Choose 
between the following layer types:

• Routing/Split Plane (gerber-format file)

• CAM Plane (gerber-format file)

2. Create the Silkscreen gerber-format file for the photo plotter (gerber-format file)
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3. Create the Solder mask gerber-format file for a photo plotter (gerber-format file)

4. Create the Paste mask gerber-format file for a photo plotter (gerber-format file)

5. Create the Assembly Drawing (non-gerber)

For Each Drill Pair

1. Create the Drill Drawing with Drill Table (non-gerber)

2. Create the NC Drill file for the drilling machine (drill file)

Related Topics

Verifying a Gerber File

Creating a Custom CAM Output
You can create a custom CAM output. This setting has no presets. You start with no default 
assigned layers or objects and choose which items to include in the output.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name.

Tip: It’s beneficial to add a description of your custom output in the document name.

4. In the Document Type list, click Custom.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you might send to the manufacturer. Your manufacturer will find it helpful if this 
filename is related to its function and placement in the layer stackup.

6. In the Customize Document area, click the Layers button.

7. In the Select Items dialog box, choose which layers and layer items should appear in 
your output.

Tip: Click the Preview button to check what will be included in the output.

8. Click OK to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options dialog box, in the Positioning area, set the positioning options.

11. Click OK to close the Plot Options dialog box.
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12. In the Output Device area, choose the device and update the Device Setup as needed.

13. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

14. In the CAM Directory list, choose the folder where you want to save the output files. 
You can skip this step if you are sending it to your printer.

15. Select the document(s) you want to output in the Document name list, and then click 
Run.

16. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory (or a subdirectory if you created 
one) if you are not sending the output to your printer.

Creating a Silkscreen Gerber-format File
You create the silkscreen gerber-format file for your manufacturer’s photo plotter to produce 
the silkscreen top, or silkscreen bottom layer.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name such as Silkscreen Top, or 
Silkscreen Bottom

4. In the Document Type list, click Silkscreen and in the Layer Association dialog box that 
appears, choose from the Top or Bottom side of the board.

Tip: The layers may not be named Top or Bottom, but will have the names you chose 
for the top and bottom layer of your design in the Layers Setup dialog box.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function. Name the file silkscreen_top.pho or silkscreen_bottom.pho.

6. In the Customize Document area, click the Layers button.
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7. In the Select Items dialog box, choose which layers and layer items should appear in the 
silkscreen data.

Tips:

• If all your silkscreen elements have been added to the Silkscreen layer, you can 
remove other layers in the Selected list.

• In a typical silkscreen, you want the Component outlines of the layer you are 
working on (Top Mounted or Bottom Mounted), as well as Ref. Des., and Outlines.

• For large components, it’s common to add attributes that add dots at pin 1 and 
numbers around the component to lessen the time it takes to locate a pin. If you’ve 
added such attributes on the Silkscreen layer, you should choose to display the 
Attributes from the Silkscreen layer.

• Click the Preview button to check what will be included in the output.

8. Click OK to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options dialog box, in the Positioning area, set the positioning options.

Tip: It’s important that each gerber-format file, that you output for your design, line up 
exactly with the others. You must use the same Positioning settings for each layer and 
you must ensure that objects on one layer are not offsetting the layer from the 
Justification setting. For example, you’ve chosen to justify the layers by the Top Left. 
And you’ve decided to include the board outline in all your outputs. The board outline 
will be justified at the top left of each output. But if you have a component that extends 
outside the board outline on the left side of the board, it’s possible that your silkscreen 
layer will not be aligned to the other layers you’ve created, since the alignment is to the 
component outline on the left (and the board outline at the top).

11. In the Suppress area, you can suppress the display of some Reference Designators.

Tip: For example, if you have a set of mounting holes that use the Ref Des prefix X, you 
can choose not to include those reference designators in the silkscreen.

12. Click OK to close the Plot Options dialog box.

13. In the Output Device area, click the Photo button if not already selected.

14. Click Device Setup. In the Photo Plotter Setup dialog box, make any necessary changes 
to the settings. 

15. Click the Advanced button. In the Photo Plotter Advanced Setup dialog box, make any 
necessary changes to the settings.

Tip: You may want to use the RS-274X format.

16. Click OK to close the Photo Plotter Advanced Setup dialog box.



CAM Output
Creating CAM Outputs to Manufacture Your PCB

PADS Layout User’s Guide and Reference Manual, PADS 9.4 775

17. Click OK to close the Photo Plotter Setup dialog box.

18. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

19. Repeat these steps again to create the Silkscreen output for the opposite side of the 
board, if applicable.

20. In the CAM Directory list, choose the folder where you want to save the output files.

21. Select the document(s) you want to output in the Document name list, and then click 
Run.

22. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory or a subdirectory if you created one.

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Interpreting the Silkscreen Preview
When looking at the Silkscreen preview, the black lines represent the silkscreen artwork. You 
should typically see component outlines of the layer you are working on (Top Mounted or 
Bottom Mounted), any board identification or version text, company logo, as well as Reference 
Designators outside the component outlines renumbered (from the original netlist import) into 
an easily searchable pattern.
(You use two sets of reference designators, one set on the silkscreen layers for the silkscreen 
artwork positioned outside the components where they won’t be hidden after the component are 
placed and soldered onto the board. And the other set on the assembly drawing layers centered 
on components for the assembly drawing. If you haven’t built this second assembly drawing set 
of reference designators into your library decals, you can quickly add them to your design. See 
Generating a Second Set of Reference Designators for Assembly Drawings.)

Related Topics

Creating a Silkscreen Gerber-format File

Changing the Reference Designators of Multiple Components in ECO Mode 
(Autorenumbering)
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Creating a Solder Mask Gerber-format File
You create the solder mask gerber-format file for your manufacturer’s photo plotter to produce 
the solder mask top, or solder mask bottom layer.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name such as Solder Mask Top, or 
Solder Mask Bottom

4. In the Document Type list, click Solder Mask and in the Layer Association dialog box 
that appears, choose from the Top or Bottom side of the board.

Tip: The layers may not be named Top or Bottom, but will have the names you chose 
for the top and bottom layer of your design in the Layers Setup dialog box.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function. Name the file soldermask_top.pho or soldermask_bottom.pho.

6. In the Customize Document area, click the Layers button.

7. In the Select Items dialog box, choose which layers and layer items should appear in the 
solder mask data.

Tips:

• You need solder mask openings for each pad of each component and perhaps each 
via too.

o If you’ve added these openings in the pad stacks, and all your solder mask 
elements have been added to the Solder Mask layer, you can remove other layers 
in the Selected list.

o If you haven’t added these openings in the pad stacks, there is an easy way to get 
the openings that you need without editing all the pad stacks. You can add the 
top layer to the Selected list and select the Pads check box for that layer. This 
adds openings the exact size of the pads in the solder mask. You’ll only need to 
oversize the Pads in the Plot Options.

• Click the Preview button to check what will be included in the output. When looking 
at the preview, the white area will be the solder mask. Black areas are openings in 
the solder mask.

8. Click OK to accept the changes and close the Select Items dialog box.
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9. In the Customize Document area, click Options.

10. In the Plot Options dialog box, in the Positioning area, set the positioning options.

Tip: It’s important that each gerber-format file, that you output for your design, line up 
exactly with the others. You must use the same Positioning settings for each layer and 
you must ensure that objects on one layer are not offsetting the layer from the 
Justification setting. For example, you’ve chosen to justify the layers by the Top Left. 
And you’ve decided to include the board outline in all your outputs. The board outline 
will be justified at the top left of each output. But if you have a component that extends 
outside the board outline on the left side of the board, it’s possible that your silkscreen 
layer will not be aligned to the other layers you’ve created, since the alignment is to the 
component outline on the left (and the board outline at the top).

11. In the Over(Under)size Pads By box, type a value if you need to globally modify the pad 
size openings.

Tip: If you’re using the pad shapes of an outer layer to create the solder mask openings 
of the solder mask layer, you’ll probably want to add a global oversize here.

12. Click OK to close the Plot Options dialog box.

13. In the Output Device area, click the Photo button if not already selected.

14. Click Device Setup. In the Photo Plotter Setup dialog box, make any necessary changes 
to the settings. 

15. Click the Advanced button. In the Photo Plotter Advanced Setup dialog box, make any 
necessary changes to the settings.

Tip: You may want to use the RS-274X format.

16. Click OK to close the Photo Plotter Advanced Setup dialog box.

17. Click OK to close the Photo Plotter Setup dialog box.

18. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

19. Repeat these steps again to create the Solder Mask output for the opposite side of the 
board, if applicable.

20. In the CAM Directory list, choose the folder where you want to save the output files.

21. Select the document(s) you want to output in the Document name list, and then click 
Run.

22. Click Save.
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Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory or a subdirectory if you created one.

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Control of Solder Mask and Paste Mask

Interpreting the Solder Mask Preview
When looking at the Solder Mask preview, the white area will be the solder mask. Black areas 
are openings in the solder mask. You should typically see solder mask openings for each pad of 
each component and any vias that are not tented (masked).

Related Topics

Creating a Solder Mask Gerber-format File

Creating a Paste Mask Gerber-format File
You create the paste mask gerber-format file for your manufacturer’s photo plotter to produce 
the paste mask top, or paste mask bottom layer.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name such as Paste Mask Top, or 
Paste Mask Bottom

4. In the Document Type list, click Paste Mask and in the Layer Association dialog box 
that appears, choose from the Top or Bottom side of the board.

Tip: The layers may not be named Top or Bottom, but will have the names you chose 
for the top and bottom layer of your design in the Layers Setup dialog box.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function. Name the file pastemask_top.pho or pastemask_bottom.pho.
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6. In the Customize Document area, click the Layers button.

7. In the Select Items dialog box, choose which layers and layer items should appear in the 
paste mask data.

Tips:

• You need paste mask openings for each pad of each surface mount component.

o If you’ve added these openings in the pad stacks, and all your paste mask 
elements have been added to the Paste Mask layer, you can remove other layers 
in the Selected list.

o If you haven’t added these openings in the pad stacks, there is an easy way to get 
the openings that you need without editing all the pad stacks. You can add the 
top layer to the Selected list and select the Pads check box for that layer. This 
adds openings the exact size of the pads in the paste mask. You can oversize or 
undersize the Pads (paste mask openings) in the Plot Options.

• If all your paste mask elements have been added to the Paste Mask Top layer, you 
can remove other layers in the Selected list.

• Click the Preview button to check what will be included in the output. When looking 
at the preview, the black areas are the paste mask openings which become the solder 
paste locations on the board.

8. Click OK to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options dialog box, in the Positioning area, set the positioning options.

Tip: It’s important that each gerber-format file, that you output for your design, line up 
exactly with the others. You must use the same Positioning settings for each layer and 
you must ensure that objects on one layer are not offsetting the layer from the 
Justification setting. For example, you’ve chosen to justify the layers by the Top Left. 
And you’ve decided to include the board outline in all your outputs. The board outline 
will be justified at the top left of each output. But if you have a component that extends 
outside the board outline on the left side of the board, it’s possible that your silkscreen 
layer will not be aligned to the other layers you’ve created, since the alignment is to the 
component outline on the left (and the board outline at the top).

11. In the Suppress area, you can suppress the paste mask openings for components.

Tip: For example, if you have an edge connector, you don’t want to add paste mask 
openings over its pads. If you’re using the pad shapes of an outer layer to create the 
paste mask openings of the paste mask layer, you’ll want to add the reference designator 
of the edge connector to the Suppress box to prevent it from getting solder paste in the 
manufacturing process.
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12. In the Over(Under)size Pads By box, type a value if you need to globally modify the pad 
size openings.

13. Click OK to close the Plot Options dialog box.

14. In the Output Device area, click the Photo button if not already selected.

15. Click Device Setup. In the Photo Plotter Setup dialog box, make any necessary changes 
to the settings. 

16. Click the Advanced button. In the Photo Plotter Advanced Setup dialog box, make any 
necessary changes to the settings.

Tip: You may want to use the RS-274X format.

17. Click OK to close the Photo Plotter Advanced Setup dialog box.

18. Click OK to close the Photo Plotter Setup dialog box.

19. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

20. Repeat these steps again to create the Paste Mask output for the opposite side of the 
board, if applicable.

21. In the CAM Directory list, choose the folder where you want to save the output files.

22. Select the document(s) you want to output in the Document name list, and then click 
Run.

23. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory or a subdirectory if you created one.

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Control of Solder Mask and Paste Mask

Interpreting the Paste Mask Preview
When looking at the Paste Mask preview keep in mind that, unlike solder mask, the paste mask 
is not an artwork layer - it is not a substance that is applied to the board. In this respect it is 
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opposite to the solder mask layer. The black areas are in fact openings in the paste mask layer 
and are the locations where the solder paste will be applied to the board. You should typically 
see paste mask openings (solder paste locations) for each pad of surface mounted components.

Related Topics

Creating a Paste Mask Gerber-format File

Creating an Assembly Drawing
You create the assembly drawing for your manufacturer to reference when assembling the 
components on the board.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name such as Assembly Top, or 
Assembly Bottom

4. In the Document Type list, click Assembly and in the Layer Association dialog box that 
appears, choose from the Top or Bottom side of the board.

Tip: The layers may not be named Top or Bottom, but will have the names you chose 
for the top and bottom layer of your design in the Layers Setup dialog box.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function. Name the file assembly_top.pho or assembly_bottom.pho.

6. In the Output Device area, choose the device and update the Device Setup as needed. 
Typically, you would send the Assembly drawings to your printer or plotter and not 
output them to a gerber file.

Tip: When you activate a printer or plotter as your output, you have the option to apply 
different colors to items in your output document. For example, you could include traces 
and pads in your assembly drawing using a lighter gray color while your component 
outlines and reference designators remained black. This could provide more context 
when manually assembling the board.

7. In the Customize Document area, click the Layers button.

8. In the Select Items dialog box, choose which layers and layer items should appear in the 
paste mask data.

Tips:
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• You can add a set of reference designators to the assembly layers, and center those 
reference designators inside the component outline instead of using the silkscreen 
reference designators which will be scattered around the outside of components. 
This will make the assembly drawing easier to read. For the procedures, see 
Generating a Second Set of Reference Designators for Assembly Drawings.

• You may want to add the Part Types to the assembly drawing also.

• If you’ve added markers in attributes to mark pin 1, it might be beneficial to add 
these to your assembly drawing.

• If all your assembly elements have been added to the assembly layer, you can 
remove other layers in the Selected list.

• Click the Preview button to check what will be included in the output.

9. Click OK to accept the changes and close the Select Items dialog box.

10. In the Customize Document area, click Options.

11. In the Plot Options dialog box, in the Positioning area, set the positioning options.

12. In the Suppress area, you can suppress the display of some Reference Designators.

Tip: For example, if you have a set of mounting holes that use the Ref Des prefix X, you 
can choose not to include those reference designators in the assembly. They’re not a true 
component and you don’t need the assemblers to think it needs to be populated with a 
component.

13. For the assembly bottom drawing, you may want to select the Mirror Image check box 
to mirror the image.

14. Click OK to close the Plot Options dialog box.

15. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

16. Repeat these steps again to create the Assembly drawing for the opposite side of the 
board, if applicable.

17. In the CAM Directory list, choose the folder where you want to save the output files. 
You can skip this step if you are sending it to your printer.

18. Select the document(s) you want to output in the Document name list, and then click 
Run.

19. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.
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Results

Your file(s) appear in the C:\PADS Projects\Cam directory (or a subdirectory if you created 
one) if you are not sending the output to your printer.

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Interpreting the Assembly Drawing Preview
When looking at the Assembly Drawing preview, you typically see component outlines of the 
layer you are working on (Top Mounted or Bottom Mounted), as well as Reference Designators 
centered inside the component outlines renumbered (from the original netlist import) into an 
easily searchable pattern. 
(You use two sets of reference designators, one set on the assembly drawing layers centered on 
components for the assembly drawing, and the other set on the silkscreen layers for the 
silkscreen positioned outside the components where they won’t be hidden after the component 
placement. If you haven’t built this second assembly drawing set of reference designators into 
your library decals, you can quickly add them to your design. See Generating a Second Set of 
Reference Designators for Assembly Drawings.)

Related Topics

Creating an Assembly Drawing

Changing the Reference Designators of Multiple Components in ECO Mode 
(Autorenumbering)

Creating a Routing/Split Plane Gerber-format File
Conductive element layers are separated into two types of outputs. Your layers are either 
routing/split plane layers, or CAM plane layers. You create the routing/split plane gerber-format 
file for your manufacturer’s photo plotter to produce the conductive layer of your PCB.

Restriction

Before you actually create the gerber-format file for this conductive layer, you must ensure that 
all copper pour or plane areas are flooded and filled with copper.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name.
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Tip: It’s beneficial to add not only the usage of the layer in the name, but also the 
placement of the layer in the board layer stackup. For example, Signal 2 - L6.

4. In the Document Type list, click Routing/Split Plane and in the Layer Association 
dialog box that appears, choose your layer from the available layers.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function and placement in the layer stackup.

6. In the Customize Document area, click the Layers button.

7. In the Select Items dialog box, choose which layers and layer items should appear in the 
silkscreen data.

Tips:

• In a typical conductive elements output, you want all the conductive elements of one 
layer. You probably want Pads, Traces, Vias, Copper, and associated pin copper if it 
exists.

• If you add drafting elements to this layer, like lines or text, they will be 
manufactured as copper. You might want to move these items to the silkscreen layer.

• Click the Preview button to check what will be included in the output.

8. Click OK to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options dialog box, in the Positioning area, set the positioning options.

Tip: It’s important that each gerber-format file, that you output for your design, line up 
exactly with the others. You must use the same Positioning settings for each layer and 
you must ensure that objects on one layer are not offsetting the layer from the 
Justification setting. For example, you’ve chosen to justify the layers by the Top Left. 
And you’ve decided to include the board outline in all your outputs. The board outline 
will be justified at the top left of each output. But if you have a component that extends 
outside the board outline on the left side of the board, it’s possible that your silkscreen 
layer will not be aligned to the other layers you’ve created, since the alignment is to the 
component outline on the left (and the board outline at the top).

11. Click OK to close the Plot Options dialog box.

12. In the Output Device area, click the Photo button if not already selected.

13. Click Device Setup. In the Photo Plotter Setup dialog box, make any necessary changes 
to the settings. 
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14. Click the Advanced button. In the Photo Plotter Advanced Setup dialog box, make any 
necessary changes to the settings.

Tip: You may want to use the RS-274X format.

15. Click OK to close the Photo Plotter Advanced Setup dialog box.

16. Click OK to close the Photo Plotter Setup dialog box.

17. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

18. In the CAM Directory list, choose the folder where you want to save the output files.

19. Select the document(s) you want to output in the Document name list, and then click 
Run.

Restriction: If your design has copper pour or plane areas that are not filled with 
copper, you must fill the areas before creating the gerber-format outputs. You will be 
prompted to fill them in order to create the output file.

20. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory or a subdirectory if you created one.

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Interpreting the Routing/Split Plane Preview
When looking at the Routing/Split Plane preview, you typically see in black - only the copper 
items located on the selected layer - all traces, vias, copper, copper pour areas, plane areas. If 
this is a component layer, you’ll also see all the component pads and associated pin copper if it 
exists. The white areas are areas of no copper.

Related Topics

Creating a Routing/Split Plane Gerber-format File
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Creating a CAM Plane Gerber-format File
Conductive element layers are separated into two types of outputs. Your layers are either 
routing/split plane layers, or CAM plane layers. You create the CAM plane gerber-format file 
for your manufacturer’s photo plotter to produce the conductive layer of your PCB.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name.

Tip: It’s beneficial to add not only the usage of the layer in the name, but also the 
placement of the layer in the board layer stackup. For example, GND CAM Plane - L3.

4. In the Document Type list, click CAM Plane and in the Layer Association dialog box 
that appears, choose your layer from the available layers.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function and placement in the layer stackup.

6. In the Customize Document area, click the Layers button.

7. In the Select Items dialog box, choose which layers and layer items should appear in the 
silkscreen data.

Tips:

• In a typical CAM plane output, you probably want Pads, Vias, and Copper. Since 
this is a negative image plane, copper objects will show up as a cut out in the CAM 
Plane.

• If you add drafting elements to this layer, like lines or text, they will be 
manufactured as copper. You might want to move these items to the silkscreen layer.

• Click the Preview button to check what will be included in the output.

Tip: CAM Planes are negative images in the work area and also in the CAM 
Preview. When viewing a routing/split plane layer document type the white areas are 
openings in the copper. But when viewing a CAM plane, the white area is copper.

8. Click OK to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options dialog box, in the Positioning area, set the positioning options.
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Tip: It’s important that each gerber-format file, that you output for your design, line up 
exactly with the others. You must use the same Positioning settings for each layer and 
you must ensure that objects on one layer are not offsetting the layer from the 
Justification setting. For example, you’ve chosen to justify the layers by the Top Left. 
And you’ve decided to include the board outline in all your outputs. The board outline 
will be justified at the top left of each output. But if you have a component that extends 
outside the board outline on the left side of the board, it’s possible that your silkscreen 
layer will not be aligned to the other layers you’ve created, since the alignment is to the 
component outline on the left (and the board outline at the top).

11. In the CAM Plane Layers area, set the settings as necessary.

12. Click OK to close the Plot Options dialog box.

13. In the Output Device area, click the Photo button if not already selected.

14. Click Device Setup. In the Photo Plotter Setup dialog box, make any necessary changes 
to the settings. 

15. Click the Advanced button. In the Photo Plotter Advanced Setup dialog box, make any 
necessary changes to the settings.

Tip: You may want to use the RS-274X format.

16. Click OK to close the Photo Plotter Advanced Setup dialog box.

17. Click OK to close the Photo Plotter Setup dialog box.

18. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

19. In the CAM Directory list, choose the folder where you want to save the output files.

20. Select the document(s) you want to output in the Document name list, and then click 
Run.

21. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory or a subdirectory if you created one.

Related Topics

Creating CAM Outputs to Manufacture Your PCB
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Interpreting the CAM Plane Preview
When looking at the CAM Plane preview, you see a negative image (opposite image) compared 
to the Routing/Split Plane layers. The white area is the copper and the black objects - typically 
only vias or through hole pin locations are areas of no copper. Since this is a negative image, 
you place copper on this layer to create a copper void (an area of no copper). You should see 
these voids if you’ve used them.

Related Topics

Creating a CAM Plane Gerber-format File

Creating an NC Drill File
You can create an NC drill file for each drill pair in your design.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name.

Tip: It’s beneficial to add not only the usage of the file in the name, but also the drill 
pair if using partial vias. For example, NC Drill L1-3.

4. In the Document Type list, click NC Drill.

5. In the Output File box, type a name for the file you are creating.

Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function and the drill pair it represents.

6. In the Customize Document area, click Options.

7. In the NC Drill Options dialog box, set the options for your file.

Tip: If you are using partial vias, you can choose which drill pair this file represents by 
selecting the Partial Vias check box and selecting the Drill Pair.

8. Click OK to close the NC Drill Options dialog box.

9. In the Output Device area with the Drill button automatically selected, click Device 
Setup. 

10. In the NC Drill Setup dialog box, make any necessary changes to the settings. 

11. Click OK to close the NC Drill Setup dialog box.

12. Click OK to add the new file configuration to the Define CAM Documents dialog box.
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Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

13. In the CAM Directory list, choose the folder where you want to save the output files.

14. Select the document(s) you want to output in the Document name list, and then click 
Run.

15. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory or a subdirectory if you created one.

Interpreting the NC Drill File Preview
When looking at the NC Drill File preview, you see drill locations, but this file is not meant to 
be viewed like the other output files. View the Drill Drawing instead.

Related Topics

Creating an NC Drill File

Creating a Drill Drawing with Drill Table
You can create a drill drawing for one or more drill pairs.

Procedure

1. On the File menu, click CAM.

2. In the Define CAM Documents dialog box, click Add.

3. In the Add Document dialog box, type a Document Name.

Tip: It’s beneficial to add not only the usage of the file in the name, but also the drill 
pair if using partial vias. For example, Drill Drawing L1-3.

4. In the Document Type list, click Drill Drawing and in the Layer Association dialog box 
that appears, choose one of the layers in your drill pair. 

Tip: If you are only using through hole vias, any layer will do. If you want to display the 
drill holes of multiple drill pairs in the same drawing, select one of the layers in your 
drill pair. You will add additional layers in a later step.

5. In the Output File box, type a name for the file you are creating.
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Tip: An autogenerated name appears in the Output File box. This is the name of the file 
you will send to the manufacturer. Your manufacturer will find it helpful if this filename 
is related to its function and the drill pair it represents.

6. In the Customize Document area, click the Layers button.

7. In the Select Items dialog box, choose which layers to include.

Tips:

• If you’ve added dimensions to the Drill Drawing layer, you’ll need to enable Lines 
and Text.

• For designs that only use through holes, you’ll only need one electrical layer. For 
designs that use partial vias, you’ll need to add at least one layer that the partial via 
starts on, passes through, or ends on. Even though a layer of each drill pair appears 
in the list, you can use the Drill Drawing Options to restrict the drill holes that 
appear in the drawing.

• Click the Preview button to check what will be included in the output.

8. Click OK to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options dialog box, in the Positioning area, set the positioning options.

11. In the Preview window, notice the position of the magenta-colored rectangle in respect 
to the position of your board outline. This is the current location of the drill chart in the 
drill drawing. Determine where to position the drill chart with reference to the design 
origin. You will need to input a new X,Y location in the Drill Drawing Options dialog 
box to come in a later step.

12. Click the Drill Symbols button.

13. In the Drill Drawing Options dialog box, in the Drill Chart area, type new coordinates 
for the Location of the chart if necessary.

14. If using partial vias, select the Show Through/Partial column check box to allow 
filtering of the drill holes. This allows you to create multiple Drill Drawings and choose 
which drill holes you want to display. You are given access to check boxes for each drill 
symbol and you can turn those symbols on or off as needed. 

15. You might need to Regenerate to update the table data.

16. Click OK to close the Drill Drawing Options dialog box.

17. Check your location of the Drill Chart in the Preview window. If needed, click the Drill 
Symbols button again to correct the location of the drill chart.

18. Click OK to close the Plot Options dialog box.

19. In the Output Device area, choose the device and update the Device Setup as needed.
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20. Click OK to add the new file configuration to the Define CAM Documents dialog box.

Tip: While you can click Run and create the output file from the Add Document dialog 
box, you probably want to add this configuration to the Define CAM Documents dialog 
box in case you need to generate the file again.

21. In the CAM Directory list, choose the folder where you want to save the output files. 
You can skip this step if you are sending it to your printer.

22. Select the document(s) you want to output in the Document name list, and then click 
Run.

23. Click Save.

Tip: If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results

Your file(s) appear in the C:\PADS Projects\Cam directory (or a subdirectory if you created 
one) if you are not sending the output to your printer.

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Interpreting the Drill Drawing Preview
When looking at the Drill Drawing preview, you typically see drill locations with markers and a 
drill chart listing all the drill sizes - based on your assignments in the Drill Drawing Options 
dialog box. Dimensioning measurements for the board are sometimes also displayed on this 
drawing.

Related Topics

Creating a Drill Drawing with Drill Table

Verifying a Gerber File
Use Verify Photo to open .pho (gerber) files for viewing. The Verify Photo is more than just a 
Preview, it looks at the actual Gerber output for its data, rather than taking data from the PCB 
file before the actual photoplot is generated. This allows you to create a hardcopy paper printout 
of your Gerber files to perform visual inspections and keep records of your plot files.

Procedure

1. On the File menu, click CAM.
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2. In the Define CAM Documents dialog box, click Add.

3. In the Document Type list, click Verify Photo.

4. In the Photo plotter output file name dialog box, browse for the gerber file.

5. Select the gerber file and click Open.

Result: The path to the file appears in the Summary area.

6. Click the Preview Selections button.

7. View your gerber file in the CAM Preview window.

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Creating Reusable Fabrication Notes
You can save your fab notes to the library for reuse.

Procedure

1. Create the individual line items of text.
See also: Adding Free Text

2. Since text alone can’t be saved to the library, add an underline to the heading of your fab 
notes using a 2D Line.
See also: Creating a Drafting Object

3. Combine all the text with the line item.
See also: Combining Line and Text Objects.

4. Save your notes to a library.
See also: Saving a Drafting Item to a Library

Defining CAM Documents
Use the Define CAM Documents dialog box to define and store up to 250 CAM documents.

Tip: You must save the design file before the changes made to the CAM documents become 
part of the design file.

In this topic:

• CAM Documents Overview

• Adding a CAM Document Workflow
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• Adding a CAM Document

• Editing a CAM Document

• Previewing a CAM Document

• Reporting Apertures of a Photo-Plot File(s)

• Deleting a CAM Document

• Reordering the List of CAM Documents

• Creating the Outputs

• Viewing CAM Document settings

• Selecting a Folder for the CAM Output Documents

• Saving the CAM Document Configurations

• Exporting and Importing CAM Document Configurations

• Listing the CAM Documents to File

CAM Documents Overview
CAM is an acronym for Computer-Aided Manufacturing. Using the CAM tools, you can 
produce not only “Gerber” or manufacturing outputs, but printouts and plots as well. 

There is no default set of output type when you start a new design - the Define CAM 
Documents dialog box is empty. Different types of designs require unique sets of output files. A 
design with 14 layers requires a larger set of output files than a design with only 2 layers. You 
must define your own list of output-document configurations which you require for each design. 
Your configurations can be saved within the .pcb file, so each file has its own CAM Documents 
list. You can export and then import your document configurations to reuse with a similar 
design.

When you add a CAM document, you are adding a preset output configuration, like a script, 
which you run against your design to create the type of output document required. The preset 
(CAM document) contains the Document Type, visible objects, design positioning, and output 
device. 

When you have a list of document configurations in the Define CAM Documents dialog box, 
you can quickly run the configurations against your current design and create the outputs, 
whether they are printouts or photo plots or both. You can print documents singly or in batch 
mode.

Restriction: You can create a maximum of 250 CAM Document configurations.
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Adding a CAM Document Workflow
1. Define the properties of the document. You must set the CAM document name, 

document type (and fabrication layers if using CAM350 as a post processing tool).

See also:Adding or Editing CAM Documents

2. Assign layers and set the visibility of items in the document.

See also: Making Design Objects Visible in CAM Documents

3. Select plot options - set the positioning of the design in the document, the suppression of 
objects, and CAM Plane Layer options.

4. Assign an output type for the document - to file, to a plotter, or to a printer.

5. Once you have selected the output type, set up the output device.

See also: Printing, Printing PostScript to a File, Setting Up the Photo Plotter Output

Adding a CAM Document
1. File menu > CAM.

2. Click the Add button to add a CAM Document to the list. 

Result: This opens the Add Document dialog box. Create a CAM Document 
configuration and return to the Define CAM Documents dialog box to save the 
configuration and Run the configuration against the design.

Editing a CAM Document
1. File menu > CAM.

2. Select a document in the CAM Documents list and click the Edit button. This opens the 
Edit Document dialog box where you can edit the document settings.

Previewing a CAM Document
You can preview the results of a CAM Document configuration before you run the 
configuration against your design.

1. File menu > CAM.

2. Select a document from the CAM Documents list and click Preview to preview the 
selected document. The CAM Preview dialog box appears.

See also: Previewing CAM Documents
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Reporting Apertures of a Photo-Plot File(s)
You can produce a report of the apertures used in a CAM Document.

Requirement: To produce an aperture report, you must have run the CAM Document(s) photo 
plot configuration against your design. If the CAM Document is set to print, or pen output, it 
will not produce the report.

1. File menu > CAM.

2. Select a CAM document in the CAM Documents list.

3. Click Aperture Report.

4. In the Aperture report file name dialog box, type a name for the report and then click 
Save.

Result: The aperture report opens in the default text editor.

Deleting a CAM Document
1. File menu > CAM.

2. Select a document in the CAM Documents list and click the Delete button.

Reordering the List of CAM Documents
You can change the order of CAM documents in the list if you would like to organize them.

1. Select a document in the CAM Documents list.

2. Click the Up or Down buttons to move the selected document up or down in the list.

Creating the Outputs
You can run single or multiple CAM document configurations against your current design.

1. Select a document configuration in the CAM Documents list. You can also drag or 
Shift+click to select multiple adjacent documents. Select multiple non-adjacent 
documents using Ctrl+click.

2. Click Run.

Result: A prompt window verifies the list of documents to be created. The generated CAM 
outputs are send to print or plot or are written to a file in the CAM Directory.

When you run CAM on a layer that is specified as a mixed plane in the Layers Setup dialog box, 
the message “Split/mixed plane detected. Perform flood and DRC checks?” appears. This 
message appears only once when running CAM on multiple split/mixed plane layers.
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• Click Yes to run the flood operation on the split/mixed plane, perform a Plane Check of 
Verify the Design, and generate split/mixed plane data for the layer. The Plane Check is 
run using the options of the Mixed Plane Setup dialog box.

• Click No to cancel the process. You can run Plane Check from Verify Design manually 
for more information on the errors.

Tips:

• CAM interprets pads and other objects differently when they are associated with copper 
in the PCB Decal Editor. See also: Working with Associated Copper

• For color print outputs, if text is combined with a 2D line or part of a dimension line, 
then a grayscale or preset color will be used for line items. Any free text on the board 
will use what is assigned for text in the Select Items dialog box.

Viewing CAM Document settings
A summary of the settings in any CAM Document configuration can be viewed in the Summary 
box. 

• Select a document in the CAM Documents list and view the settings in the Summary 
box.

Selecting a Folder for the CAM Output Documents
When you run a CAM Document and the output is a file, it is saved in your CAM directory. By 
default, CAM directories are located under the path \PADS Projects\Cam\default which is 
called from the CAMDir entry of powerpcb.ini file.

• To browse for the desired directory and create a new path that will be saved with the 
design, select <Create> in the CAM directory list.

Saving the CAM Document Configurations
You can save the CAM documents you add to the CAM Documents list. The software will be 
saved into the current software session but not yet saved into the .pcb file.

Requirement: You must save the .pcb design file for the changes made to the CAM documents 
to become part of the design file.

• Click the Save button.
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Exporting and Importing CAM Document Configurations
You can reuse your CAM document configurations with other similar designs by exporting 
them and importing them into another design.

• Click Export to saves the configuration to a separate file. If you name the file 
default.cam, it is used as the default CAM configuration for each .pcb file.

• Click Import to recall an exported configuration to use as the CAM configuration for 
the .pcb file.

Listing the CAM Documents to File
You can save a list of the CAM documents, which can also be printed and saved with your 
design documentation.

1. Click Listing.

2. You are prompted with the Listing File Name box to provide a name for the listing. 
Type a name and then click Save.

Result: The listing is saved and the file opens in your default text editor.

Adding or Editing CAM Documents
Use the Add or Edit Document dialog box to define a CAM document.

In this topic:

• Add or Edit a CAM Document

• Selecting an Output Device

• Using TrueLayer Associations

Add or Edit a CAM Document
Define a new CAM Document or edit an existing CAM document using the Add 
Document/Edit Document dialog box.

Tip: If you use the TrueLayer option, see the Using TrueLayer Associations section for 
information on how TrueLayer affects layers and CAM documents.

1. File menu > CAM > Add  button or select a document and click Edit.

Result: Depending on your action, the Add Document dialog box or the Edit Document 
dialog box appears. The process for using either dialog box is the same.



PADS Layout User’s Guide and Reference Manual, PADS 9.4798

CAM Output
Adding or Editing CAM Documents

2. In the Document Name box, type a document name that describes the plot type and 
output device; for example, Silkscreen Top Layer - to Print. If you were outputting this 
document to a file, this is not the filename to which it would be saved; you define that in 
the Output File box.

3. In the Document Type list, select a default plot configuration. When you select a 
document type, the program automatically generates a stock set of layers and items to 
plot. You can use these or customize them. You can view a summary of the settings of 
the default document type in the Summary box.

Exception: If during your selection of a Document Type you are prompted to select a 
Layer Association and the layer does not exist in the list, you may need to revisit your 
Layers Setup. Click Set Layers for a shortcut to the Layers Setup dialog box; otherwise 
you would need to close all CAM dialog boxes to access the Setup menu.

4. In the Output File box, accept the default name, or type your preferred name for the 
output file.

5. If you will be using CAM350 for post processing, select the layer that you will use to 
fabricate the printed circuit board from the Fabrication Layer list. The Fabrication 
Layer is only used during conversion to the CAM350 database using CAM350 Link.

6. Click an output device. For plots and drill drawings, select the printer, pen plotter, or 
photo plotter. The drill device is always selected for NC Drill Output.

• Click Device Setup to open a dialog box that lets you set options associated with the 
selected device type, Printer Setup, Pen Plot Setup, Photo plot Setup, or NC Drill 
Setup.

7. If you approve of the default layers and items chosen by PADS Layout, do nothing 
further. However, you can use the following controls to modify the output further:

• Click Layers to open the Select Items dialog box. You can modify which layers and 
items appear in this document.

• Click Options to gain access to one of the options dialog boxes listed below, 
depending on the plot type with which you're working:

Button Set up

Plot Options Printer, Pen and photo plots

Drill Drawing Options (available 
from the Plot Options dialog box 
only when the Drill Drawing 
document type is selected)

Drill drawings

NC Drill Options NC drill output
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• Click Assembly to open the Select Assembly Variant dialog box. You can choose 
whether to base CAM output on an Assembly Variant and choose the Assembly 
Variant to use. You cannot edit an Assembly Variant in CAM.

Restriction: The Assembly button is unavailable until you create an assembly variant.

See also: Using the Assembly Variants Dialog Box

8. Click Preview Selections to preview Layers and Options settings and check the settings 
against your expectations.

9. Click Run to produce the document you just defined. 

Alternative: Or click OK to load the document configuration into the Define CAM 
Documents dialog box.

10. If you want to save your current settings as the defaults for this CAM document type and 
output device, click Save As Defaults.

Tip: If you manually build your own drill table and want to use this drill table as the 
default drill table, click Save As Defaults. 

11. When you finish, click OK to accept your changes.

Selecting an Output Device
Basically, you can create either printouts or files to send to the manufacturer. You can print the 
file to make sure it's okay, and then send the file to the manufacturer. The only difference is the 
type of output device you select in the Add or Edit Document dialog box. 

There are four types of output devices. They're listed as Print, Pen, Photo, and Drill. Easily 
confused are the two plotter types. One is commonly found in the workplace - a pen plotter; and 
the other is a photo plotter used by manufacturing. So, you can print or plot your outputs on 
paper or you can send a photo plot file to manufacturing. There is another type of output - an 
NC Drill file. This is a file sent to manufacturing like those for the photo plotter, except you 
would input it into a computerized drilling machine to drill all the vias.

Using TrueLayer Associations
By default, when you flip a component, the component attributes flip with it. For example, you 
flip a component from one side to the other in the design. Although the reference designator 
attribute is visible and located on the top silkscreen layer, it automatically flips to the bottom 
silkscreen layer. You are using TrueLayer association. This feature also depends on you 
associating layers correctly in the Layer Setup. 
You can override the TrueLayer functionality by applying a command line switch to the 
software on startup.

See also: Start-up Options
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Making Design Objects Visible in CAM 
Documents

When you are adding a CAM document, you can use the Select Items dialog box to define 
which layers and items should appear in a particular document. You can also define colors for 
layers and items.

In this topic:

• Selecting Layers and Layer Objects to Plot

• Working with Associated Copper

• Selecting Non Layer-Set Objects to Plot

• Applying Colors to Objects

• Applying Colors to Individual Nets

• Previewing the Settings

Selecting Layers and Layer Objects to Plot
You can enable layers and layer objects to be included in your CAM Document.

1. File menu > CAM.

2. Click Add to create a new CAM document, or select a document from the Document 
Name list and click Edit to edit the selected document.

3. Click Layers.

4. Select the layers you want displayed in the Available section.

5. Click Add to add the layers to the Selected box.

Tip: The layers you select are not saved as defaults when you click Save As Defaults on 
the Add Document dialog box. 

6. With the layer selected in the Selected list, select the objects you want in the output. If 
you don't select any objects, nothing from that layer will be displayed in the CAM 
document.

Exceptions:

• CAM does not generate output for attribute labels unless you choose to make the labels 
visible in the design. To display the labels, use the Show list in the Labels Properties 
dialog box.

• Selecting the Test Points check box displays all test points (component pins and vias) 
on the specified layer. By default, test points are located on the bottom side of the board. 
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When creating a solder mask document of the top side of your design, only test points 
marked as Top Access in the Properties dialog box will display in the CAM document. 
For solder mask documents, test points are added by default. This unmasks test points - 
specifically test point vias. Typically, vias are covered in solder mask which appears 
white when previewing the CAM document.

Working with Associated Copper
CAM interprets pads and other objects differently when they are associated with copper in the 
PCB Decal Editor. Associating copper shapes and open copper is one of the methods used to 
create hard breakouts in decals. Interpretation is as follows:

• Terminals are interpreted as vias.

• Closed copper shapes are interpreted as pads.

• Open copper (a path drawn with copper) is interpreted as a trace.

Tip: Using the Vias, Pads, and Traces check boxes along with those in the Pins with Associated 
Copper area will give you total control over what appears in your CAM document.

Additional object visibility options are available in the Pins with Associated Copper area if you 
have decals that were created with associated copper.

1. In the Pins with Associated Copper section, select the Advanced Selection check box to 
enable the selection of the object check boxes. These options allow for selection of 
associated copper items independently of regular options for pads, vias and traces.

2. Select the Pads check box to display pads with associated copper. 

3. Select the Open Copper check box to display the open copper that is associated to pins.

4. Select the Filled Copper check box to display the closed copper shapes that are 
associated to pins.

See also: Associating Copper with Terminals

Selecting Non Layer-Set Objects to Plot
You can also enable objects to be included in your CAM document which are not set per layer.

• In the Other area, select the check box beside an item to include in your CAM 
document. Choose from the board outline (and board cut outs), connections, plated 
slotted holes, and nonplated slotted holes.

• In the Component Outlines area, select the check box beside an item to include in your 
CAM document. Choose from top or bottom mounted component outlines. 
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Applying Colors to Objects
You can apply colors to CAM document objects if you are outputting to a printer or a pen 
plotter. The color palette only shows colors that the printer or plotter can output. If your device 
can only print grayscale, the palette will show grayscale.

• In the Selected Color area, click a color in the palette and click the box beside a design 
object. You can assign colors to the items in the Other, Component outlines, and Items 
on Primary areas.

Requirement: You must select the check box of a design object before the object color 
swatch appears.

Tip: For monochrome output devices (printers/plotters), the only color available is black. You 
can save your selected colors (for items you select under Other, Items on Primary, and/or 
Component outlines) for each document type and use these settings as the defaults for new 
documents of that type. For more information, see Adding or Editing CAM Documents.

Applying Colors to Individual Nets
You can use the colors you have assigned to nets in the View Nets dialog box when you print.

• Select the Color By Net check box to use the View Nets colors in the output.

Previewing the Settings
• Click the Preview button to preview the settings you make in the Select Items dialog 

box.

See also: Previewing CAM Documents

Related Topics

Defining CAM Documents

Applying the Over(Under)size Value to All Layers
You can extend the value of the Over(Under)Size value to non-electrical layers using an 
attribute applied to the PCB level of the attribute hierarchy. 
In PADS2007.1 or later, the attribute is automatically added to all designs when opening the 
design or when importing an ASCII file. Opened designs, created with version PADS2007 have 
the attribute value set to No to only apply the Over(Under)size value to electrical layers. 
Opened designs created with any other version have the attribute set to Yes to apply the 
Over(Under)size value to all layers.
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Procedure

1. In the design, select an object (for example, a component, component pad, or net), right-
click and click Attribute.

2. In the Attributes for list, click PCB PCB.
Tip: This displays any attribute of the PCB at the PCB level of the attribute hierarchy.

3. The CAM.Apply Oversize To All Pads attribute appears in the attribute list. 

4. Use an attribute value of Yes to apply the Over(Under)size value to all layers or use No 
to accept the default of applying the value only to electrical layers.

Result

• Is the Over(Under)size value not being applied correctly? There is a hierarchy of 
settings that apply to Solder Mask and Paste Mask layers, and the Over(Under)size 
value has the lowest priority. For more information, see Control of Solder Mask and 
Paste Mask.

• Is the attribute not listed when viewing the PCB attributes at the PCB level of the 
hierarchy? Add the attribute with the correct value.

Setting Drill Drawing Options
Use the Drill Drawing Options dialog box to set drill drawing legend and marker parameters.

In this section:

• Creating a Drill Drawing Workflow

• Activating and Positioning the Drill Chart

• Specifying Drill Markers

• Sorting Data in the Drill Data Table

• Modifying Drill Table Entries

• Saving Your Selections

Creating a Drill Drawing Workflow
1. Click Add in the Define CAM Documents dialog box. 

2. In the Add Document dialog box, type a name in the Document Name box.

3. Select Drill Drawing in the Document Type list.

4. Select a Layer Association and click OK.

5. Click Options.
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6. In the Plot Options dialog box, click Drill Symbols.

7. Use the controls in the Drill Chart area to enable, and define the position and size of the 
drill chart.

Tip: The representation of the Drill Chart (and Drill Data) values depends upon how 
you set your design unit options (mils, metric, or inches). 

Activating and Positioning the Drill Chart
You can automatically add a drill chart to your drill drawing. The default location of the drill 
chart is at the origin (0,0) of your design which may overlap design objects. You can alter the 
default location of the drill chart in your drill drawing. 

1. In the Drill Chart area, select the Draw Chart check box to includes the legend in the 
plot.

2. In the Letter Height box, set the height of letters in design units.

3. In the Chart Line Width box, set the width of the chart lines in design units.

4. In the Location boxes, set the X,Y location of the drill chart in design units. The 
location is not saved when you click the Save As Defaults button.

Tip: You can click OK and use the Preview in the Plot Options dialog box to check the location 
against the board outline. The board outline is blue and the drill chart outline is pink.

Restriction: The drill chart is only output in the drill drawing CAM document. It is not 
embedded in the design.

Specifying Drill Markers
Use the controls in the Drill Symbol Markers area of the Drill Data area to specify how you 
want markers drawn. A symbol preview box enables you to view the graphical image of a 
selected drill symbol (for example, the plus sign, +).

1. In the Height (Letter) box, set the letter height of the drill symbol marker.

2. In the Line Width box, set the line width for the drill marker symbol and for all text.

3. In the Height (Symbol) box, set the drill marker symbol height.

Sorting Data in the Drill Data Table
You can populate and then sort the data in the drill drawing table by drill size or quantity of the 
holes, and then by plating type. 

Tip: Populate data in the drill drawing table by manually adding entries or by gathering 
information from the design database with Augment or Regenerate.  If you have not saved any 
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new default settings and if no data previously existed in the table, Augment or Regenerate 
populates the table in ascending order of size and then plated holes before non-plated holes.

To Sort the Data in the Drill Drawing Table
1. Click on the appropriate column (Size, Quantity, or Plated) in the drill drawing table. 

2. Click another column heading (Size, Quantity, or Plated) to also sort by that column. 

The final sorting order is determined by the order in which the columns are selected for sorting. 

For example, clicking the Size column first determines whether the data appears in numerical 
ascending or descending order. If you then click the Plated column, the list is reordered with 
plated or non-plated holes first while maintaining the ascending or descending numerical 
sorting order that you previously selected. If you then click the Quantity column, the Quantity 
sorting order overrides the previous selections.

Example

Table 39-1 shows the result of a sort by size (ascending order) and then by plated type. 

Sorting and Augment or Regenerate
The Augment button adds actual design drill sizes to a pre-existing default set of drill sizes. The 
Regenerate button clears all previous data, including any pre-existing defaults, and replaces it 
with the actual design data. Both Augment and Regenerate populate data in the following order 
of sorting precedence:

• If you have sorted data before clicking Augment or Regenerate, the appropriate data is 
formatted in the order currently specified by the open CAM document or the settings 
from the current editing session.

Table 39-1. Example Sort Result 

Symbol Size Quantity Plated Tolerance

+ 0.0135 35 Yes +0.000/0.0135

X 0.02 125 Yes +/-0.003

Rectangle 0.037 62 Yes +/-0.003

Diamond 0.048 X 1.020 44 Yes +/-0.003

Rectangle + 0.056 8 Yes +/-0.003

Rectangle X 0.072 4 Yes +/-0.003

Diamond + 0.11 6 No +/-0.005

Circle + 0.156 4 No +0.005/-0.002
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• If you have not sorted in the current session, but you have saved a set of sorting defaults, 
clicking Augment or Regenerate populates the table in accordance with your saved 
defaults.

Modifying Drill Table Entries
To modify the drill table entries shown in the Drill Data area:

1. To modify the symbol associated with a specific drill entry, double-click the target 
symbol entry in the Symbol column and select a symbol from the list of available drill 
symbols. The next time you click on the entry, the symbol preview window in the Drill 
Symbol Markers area reflects the symbol change. 

Restriction: Symbol usage is exclusive; you cannot save your changes if you create 
duplicate symbol assignments.

2. To specify or change the tolerance value for a specific drill entry, double-click the target 
tolerance entry in the Tolerance column and type a tolerance value. 

Tip: The Tolerance column gives you the flexibility of entering a text string of up to 32 
characters, which enables you to add a fabrication note along with your tolerance value. 
 As a general rule, be careful to type suitable tolerance values. You can copy and paste 
tolerance data between text fields, but you cannot perform multiple cell copy functions.

Restriction: You cannot edit data in the Size, Quantity, or Plated columns.

Saving Your Selections
If you manually build your own drill table, or you want to reuse the contents of the table as the 
defaults for all CAM drill drawings you can save the contents as the default. 

• Click Save As Defaults

Tip: The drill chart location is not saved when you click Save As Defaults.

Result

This creates a cam.defaults file located in the following location (default installation):
C:\MentorGraphics\<version>PADS\SDD_HOME\Settings

Related Topics

Adding or Editing CAM Documents

Defining CAM Documents
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Assembly Variants

Substitute a Component for Assembly Variants
The Variant/Substitute dialog box appears when you choose to substitute a component in an 
assembly variant. When you substitute a component, the substitution is referred to as the active 
component. The original component that you substituted is referred to as the default. The 
default component is what exists in the base option and the raw database.

• Substituting Components

• Interpreting the Component Status

• Displaying Substitution Differences

• Previewing a Variant

Substituting Components
1. Tools menu > Assembly Variants.

2. There are several ways to begin substituting a component:

• Click an Assembly Variant in which you want to substitute the component from the 
Variant Name list, select the component name to change, and click Substituted in 
the Status area. 

Or

• Select a component in the multicolumn list, and click Substitute in the Status area.

Or

• Click Substitute from the Verb Mode list, and select a component in the Layout 
Editor. 

3. Double-click a Part Type in the Active column of the multicolumn list in the 
Variant/Substitute dialog box. The multicolumn list displays the attributes (Value) of the 
component you are substituting, its Default value, and its Active value (the substitution).

4. In the list, select a value you want to use for the  substitution. 

5. Click OK to complete the substitution.

6. Click OK to save and apply the substitutions to the Assembly Variant.

To choose a different part type from a library click Browse.

Restriction: You cannot substitute the Family, Number of Pins, Number of Gates, or Signals 
Pins. This information is updated when you choose a different part type.
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Interpreting the Component Status
The Status area shows the status of the component:

For example, if a component is Installed and you want to Substitute it, Current displays 
Installed because the component was installed in the variant. New reads Substituted because 
you are creating a new substitution for the component.

Displaying Substitution Differences
You can display only the values of the Default and Active component which differ, in the 
multicolumn list. This includes items that you manually change and items that change because 
you select a different part type.

• Select the Show Difference check box.

Previewing a Variant
You can preview your substitutions.

• Click the Preview button. For more information, see Previewing Assembly Variants.

Using the Assembly Variants Dialog Box
Use the Assembly Variants dialog box to create a new variant, review or edit a variant, preview 
variants, delete variants, and create reports for variants.

In this topic:

• Creating Assembly Variants

• Installing, Uninstalling, or Substituting Variant Design Components

• Modifying Assembly Variants

• Modifying Assembly Variants by Component

• Deleting Assembly Variants

• Previewing Assembly Variants

• Creating Assembly Variant Parts Lists

• Creating Assembly Variant Assembly Drawings

Current The state before you click Substituted or Verb Mode.

New The state after you click Substituted or Verb Mode.
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Creating Assembly Variants
To create Assembly Variants:

1. Tools menu > Assembly Variants.

2. Type the name of the new variant, up to 26 characters, in the New variant's name box.

3. Click Create. A new variant is created that contains all the items in the Base Option.

4. Use the Display list to filter the items to view in the multicolumn list.

5. Uninstall, or substitute your design components.

6. When you finish defining the new Variant, click OK or Apply to save the changes to the 
new Variant. The Base Option is also updated based on the new variant.

You can continue to create new Variants.

Installing, Uninstalling, or Substituting Variant Design 
Components

You can install, uninstall, or substitute variant design components using two different methods.

Using the Multicolumn List

You can modify the component status using the multicolumn list and the Status area.

Restriction: Because you cannot directly modify the Status of the Base Option which is based 
on the other variants; modifying the Status is unavailable when you view the Base Option in the 
multicolumn list.

1. Select a variant in the Name list.

2. In the multicolumn list, select the items you want to uninstall from the new Variant and 
click Not Installed.

Tip: Click the column header to sort the multicolumn list.

3. In the multicolumn list, select the items you want to substitute and click Substituted. 
The Variant/Substitute dialog box appears for each item.

4. Make any substitutions you want and click OK. You return to the Assembly Variants 
dialog box.

Using the Design Area/Layout Editor

You can also modify the component status using the Layout Editor. With Verb Mode you can 
decide what action to take and perform it on components in the Layout Editor (outside the 
dialog box).
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1. Select a variant in the Name list.

2. In the Manager area, select Install, Uninstall, or Substitute in the Verb Mode list.

3. Click outside the dialog box. The dialog box remains open, but it is not active.

4. In the design area, select the components, one at a time, to which to perform the action.

Tip: When using the Substitute Verb Mode, the Variant/Substitute dialog box appears 
after each component you select.

5. When you finish selecting components or want to change the Verb Mode, click inside 
the dialog box. The multicolumn list in the dialog box updates to reflect the actions you 
performed on items.

Tip: You cannot modify the BaseOption.

Modifying Assembly Variants
By modifying an Assembly Variants, you can, for example, choose to uninstall or substitute a 
component that is Installed in the variant you click in the Name list.

To change assembly variants:

1. Tools menu > Assembly Variants.

2. In the Name list, click the variant for which you want to view the status.

3. To view all components in the Assembly Variant click All in the Display list. The 
multicolumn list reflects the status of components for that variant.

4. In the multicolumn list, click any components you want to install, uninstall, or substitute 
for the variant.

Tip: Click the column header to sort the multicolumn list.

5. Click Installed, Not Installed, or Substituted.

When you click Substituted, the Variant/Substitute dialog box appears for each variant 
that you select to substitute.

If you change the status of a component from Substituted to Installed, the variant uses 
the Default component.

If a component is already substituted in the variant and you want to change the 
substitution values, select the component in the multicolumn list and click Edit in the 
Status area. The Variant/Substitute dialog box appears.

6. Make any substitutions in the Variant/Substitute dialog box and click OK. You return to 
the Assembly Variants dialog box.

7. Click OK or Apply.



CAM Output
Assembly Variants

PADS Layout User’s Guide and Reference Manual, PADS 9.4 811

Modifying Assembly Variants by Component
This topic describes modifying an Assembly Variants when you click Components in the Type 
list. If the component selected in the Name list is Installed in Options, you can uninstall it from 
or substitute it in Options.

1. Tools menu > Assembly Variants.

2. Click Components from the Type list.

3. In the Name list, click the component whose status you want to view.

4. Click All in the Display list to view the status of the component in all variants.

5. In the multicolumn list, select the variants from which you want to install, uninstall, or 
substitute the component.

If a component is already substituted in the variant and you want to change the 
substitution, select the variant in the multicolumn list and click Edit in the Status area. 
The Variant/Substitute dialog box appears.

Tip: Click the column header to sort the multicolumn list.

6. Click Installed, Not Installed, or Substituted.

When you click Substituted, the Variant/Substitute dialog box appears.

If you change the status of a component from Substituted to Installed, the variant uses 
the Default component.

7. Make any substitutions in the Variant/Substitute dialog box and click OK. You return to 
the Assembly Variants dialog box.

8. Click OK or Apply to save the changes to the variant. Substituted items are removed 
from the Base Option.

Deleting Assembly Variants
1. Tools menu > Assembly Variants.

2. In the Name list, click the variant which you want to delete.

3. Click the Delete button.

Previewing Assembly Variants
You can display Installed components in all of your Assembly Variants. You can view statistics 
about Assembly Variants, such as where component location, how components relate spatially 
to other components in the Assembly Variant, and what components you have created 
substitutes for.
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To display, to not display, or to display components in a different color:

1. Tools menu > Assembly Variants.

2. Select the variant to preview in the Name list.

3. Click Preview. The Preview for <variant> dialog box appears displaying an assembly 
drawing of the variant.

4. Click Variants to open the Preview/Option dialog box. Use the Preview/Option dialog 
box to change the appearance of your preview. The multicolumn list box indicates 
whether objects of a status are currently visible in the preview window for a variant.

5. Double-click in the cell of the component in the Assembly Variant for which you want 
to change visibility.

• Click No to make the components invisible.

• Click Yes to make the components visible.

• Click Color to choose a display component color. The Colors dialog box appears. 
Click a color in which to display selected components and click OK. You return to 
the Preview/Option dialog box appears. The multicolumn list reflects a Yes status 
for the component. If it has a color, it is visible.

6. Click OK. You return to the Preview for Variant dialog box. The preview area reflects 
the visibility status you set.

Creating Assembly Variant Parts Lists
You can create parts lists based on assembly variants. 

• Click the Report button.

For more information, see Creating a Report Using an Assembly Variant.

Creating Assembly Variant Assembly Drawings
You can create assembly drawings from assembly variants. For more information, see Adding 
or Editing CAM Documents and Selecting an Assembly Variant for Assembly Drawings.

Selecting an Assembly Variant for Assembly Drawings
You can create assembly drawings of your assembly variants by selecting a variant in the Select 
Assembly Variant dialog box.

1. In the Add Document dialog box, click Assembly.

Restriction: This button is unavailable unless you select the Assembly document type.
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2. In the Select Assembly Variant dialog box, click the Use Assembly Variant check box 
to use an assembly variant as your design input for the assembly drawing.

Tip: Clear the check box to use all parts in the database, known as the raw database.

3. In the Name list, select a variant.

Related Topics

Defining CAM Documents

Setting CAM Preview Options
Use the CAM Preview Setup dialog box to invert, show plot orientation, or overlay multiple 
CAM Documents - you can change the preview attributes of all documents.

Tip: You must have at least one CAM document defined to use preview setup.

In this topic:

• Overlaying CAM Documents

• Inverting a CAM Document

• Showing Plot Orientation of a CAM Document

Overlaying CAM Documents
You can overlay multiple CAM documents by enabling the visibility of documents.

• Select the Visible check box of each desired document.

Inverting a CAM Document
You can invert the view of a CAM document. You might want to invert the view of CAM Plane 
layers since they are negative layers and will appear different than all other layers.

• Select the Inverse check box of a document.

Showing Plot Orientation of a CAM Document
You can scale and orient the preview data as defined by the CAM document plot options.

• Select the Orient check box of a document.

Related Topics

Defining CAM Documents
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Previewing CAM Documents
During CAM document operations, use the CAM Preview dialog box to preview your output. It 
displays all items that will appear in the final CAM document and their position within the plot 
paper extents.

Tip: You can also use the CAM Preview dialog box after you use Verify the Design from the 
Tools menu to perform fabrication checking and you want to preview the CAM document 
associated with the layer for a selected error.

In this topic:

• Controlling the View

• Viewing a Different Document

• Viewing Multiple Documents

Controlling the View
There are many methods of controlling the view in the CAM Preview dialog box.

• In the Zoom area, use the following buttons:

o Board button—Fits the contents of the selected document into the preview window.

o Extents button—Fits the world, or the whole coordinate system, into the preview 
window.

o Workspace button—Fits the current screen view into the preview window.

• You can also alter the view with the mouse: 

o Right-click to zoom out by a factor of 2, centered on the pointer location.

o Click to zoom in by a factor of 2, centered on the pointer location.

o Click and drag to draw a zoom rectangle centered on the pointer location. Drag the 
pointer towards the top of the screen, diagonally from the indicated pointer locations 
to zoom in. Drag the pointer towards the bottom of the screen, diagonally from the 
indicated pointer locations to zoom out.

• If the preview doesn't appear properly, click Refresh. This occurs when you remove the 
application focus from the CAM Preview dialog box. For example, switch back to the 
preview window from another application and you will need to click Refresh.

Viewing a Different Document
You can switch to previewing any of the CAM Documents you have saved in your session.
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• In the Documents list, select a document to preview.

Viewing Multiple Documents
You can invert, show plot orientation, or overlay multiple CAM Documents.

• Click the Setup button. The CAM Preview Setup dialog box appears and enables you to 
change CAM document attributes.

Related Topics

Defining CAM Documents

Printing
This section describes the following methods to print or plot your design:

• Printing to a Windows Printer

• Printing PostScript to a File

Printing to a Windows Printer
You can print CAM Documents on your printer.

Tip: Test the link between Windows and the printer by clicking Print Topic from the file menu 
in this Help window.

1. File menu > CAM.

2. Select the default folder to which to output your CAM files from the CAM Directory 
list. If you click <Create>, you can create a new folder. The default folder is \PADS 
Projects\Cam\default.

3. Click Add in the CAM Documents area. The Add Document dialog box appears.

4. From Document Type, click the document type you want to use (for example, 
Silkscreen).

5. From the Layer Association dialog box that appears, select the layer you want to use and 
click OK. All associated items, tracks, and vias are added to the Summary area.

6. Under Output Device, click the Print button. This indicates the output device. All 
printing is controlled using the Windows printer properties. For information on setting 
up printers and defining printer properties, see the Microsoft Windows Help (on 
Windows 2000, go to Start and click Help; on Window XP, go to Start and click Help 
and Support Center).



PADS Layout User’s Guide and Reference Manual, PADS 9.4816

CAM Output
Printing

7. Click Device Setup. The Print Setup dialog box appears. In this dialog box, you can 
choose a printer, set printer properties such as resolution and number of copies, and set 
document properties such as orientation. For more information on this dialog box, see 
the Microsoft Windows online help.

When you finish setting printer and document properties, click OK.

8. Under Document Name, type a meaningful name for the document, such as one that 
indicates the document type, the type of output, and the layer. Click OK. Your 
document is added to the CAM Documents list in the Define CAM Documents dialog 
box.

9. Click the Layers button to display the Select Items dialog box. Set the layers to output 
information on and click Add.

10. Establish any color changes. Click the color to use from the Selected Color area, and 
turn on the check boxes of the objects to assign to the color. The new color appears to 
the right of the object. Continue to assign/redefine the colors by clicking the color and 
the check box of the objects.

11. When you finish setting options, click OK. You return to the Add Document dialog box.

12. To print, click Run. The message “Do you wish to generate the following outputs?” 
appears.

13. Click Yes to print.

Related Topics

Printing PostScript to a File

Defining CAM Documents

Printing PostScript to a File
PADS Layout supports PostScript printing to a file through use of the Windows printer 
properties. For information on setting up printers and defining printer properties, see the 
Microsoft Windows Help (on Windows 2000, go to Start and click Help; on Windows XP, go 
to Start and click Help and Support). 

You must set up your printer to print to a file before you create a PostScript file.

In this topic:

• Setting the Printer to Print to a File

• Printing a CAM Document to a File



CAM Output
Printing

PADS Layout User’s Guide and Reference Manual, PADS 9.4 817

Setting the Printer to Print to a File 
1. Locate printer information based on your platform:

• Using your Windows Start menu, locate your Printers and Faxes control panel.

2. Right-click the PostScript printer you want to use to print to a file and then click 
Properties. The Properties dialog box appears.

3. Click the Ports tab.

4. Under Print to the Following Port, in the Port column, select the FILE: check box, 
which has the description Print to File.

Tip: This procedure works with local printers. If you are using network printers, you 
may not have access rights to select or change the port information.

5. Click OK. You can now print to a file.

Printing a CAM Document to a File
1. Complete the steps above to set up the printer to print to a file.

2. Click CAM from the File menu. The Define CAM Documents dialog box appears.

3. Select the default folder to which to output your CAM files from the CAM Directory 
box. If you click <Create>, you can create a new folder. The default folder is \PADS 
Projects\Cam\default.

4. Click Add in the CAM Documents area. The Add Document dialog box appears.

5. From Document Type, click the document type you want to use.

6. From the Layer Association dialog box that appears, select the layer you want to use and 
click OK. All associated items, tracks, and vias are added to the Summary area.

7. Under Output Device, click the Print button.

8. Click the Device Setup button to open the Print Setup dialog box. In this dialog box, 
you can choose a printer and set printer properties. For more information on this dialog 
box, see the Microsoft Windows Help.

Click OK when you finish setting document and printer properties. 

9. Under Document Name, type a meaningful name for the document and Click OK. 
Once you are satisfied with your CAM document definitions and have finished setting 
printing options, you can print as you normally would.

See also: Printing

Tip: For best results, make sure that you have a design loaded before generating the 
output file.
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10. From the Add Document dialog box, click Run. The message “Do you wish to generate 
the following outputs?” appears.

11. Click Yes to print to a file. The Print to File dialog box appears (as long as you have 
selected a printer that is defined to print to a file).

12. Use the dialog box to specify a name (and, optionally, a path) for the output file. The 
default path is \My Documents\PADS Projects\Cam\default, but you may have changed 
this in step 3 above.

13. Click OK. The printer file is created.

Related Topics

Defining CAM Documents

Setting Up the Photo Plotter Output
Use the Photo Plotter Setup dialog box to set up photo plotting and send your output to a plotter

In this topic:

• Maintaining the D-Code list

• Maximum Aperture Count

• Automatic D-Codes

• Manual D-Codes

• Setting Aperture Dimensions

Maintaining the D-Code list
D-Codes contain the apertures required for the Photo Plotter. The D-Code list can be created 
automatically or you can maintain it manually. The D-Code list contains all defined apertures.

Tip: Before you generate your CAM files, regenerate your list of apertures.

Maximum Aperture Count
• In the Aperture Count box, type a value for the maximum aperture count.

Restriction: When you click RS-274-X format in the Photo Plotter Advanced Setup 
dialog box, the aperture count is set to 989 and is unavailable.
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Automatic D-Codes
• To automatically add apertures as you add information to the design, select the 

Augment on-the-fly check box.

• To automatically generate D-codes for items in the design file that are not in the current 
list, click Augment.

Tip: Augment adds oval and rectangular flash apertures for orthogonal orientations 
only.

• To clear the current D-code list and automatically add D-codes for all items in the 
design, click Regenerate.

Tip: Regenerate adds oval and rectangular flash apertures for orthogonal orientations 
only.

Manual D-Codes
• To add a new D-code to the D-Code list, click Add, type a value excluding the “D” 

prefix, and click OK.

• To delete a D-code, select a code in the D-Code list, and click Delete.

Setting Aperture Dimensions
You can customize the aperture dimensions of a selected D-Code.

• To draw lines and flashed items with the same aperture, select the Same Aperture for 
Flashes/Lines check box. 

• To set a flash aperture, click a Flash shape or to set a draw aperture, click a Line shape. 
Line shapes are unavailable if the Same Aperture for Flashes/Lines check box is 
selected.

• To specify a width for square, rectangle, and oval shapes or the outer diameter of round 
and thermal shapes, type a value in the Width box. This box is unavailable if a value is 
not appropriate for the specified shape.

• To specify a height for oval and rectangular shapes, type a value in the Height box. This 
box is unavailable if a value is not appropriate for the specified shape.

• To specify an inner diameter for annular ring shapes, type a value in the Inner Diam 
box. This box is unavailable if a value is not appropriate for the specified shape.

• To specify the width used for shapes to be filled, type a value in the Fill Width box. An 
example shape is a non-orthogonal pad. Larger widths decrease photo plot time but 
provide a less precise approximation of the shape.
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• To specify the width used for hatching of system texts, type a value in the Texts Fill 
Width box. Larger widths decrease photo plot time but provide a less precise 
approximation of the text.

Related Topics

Defining CAM Documents

Analyzing CAM Documents
Once you create your CAM documents, you can analyze them using DFM Analysis.

Accessing

• Tools > DFM Analysis > Start Analysis

Tip: To view help on DFM Analysis, press F1 with the dialog box open.

Setting up DFM Analysis
You can set up the optons you want to use while analyzing your CAM documents.

Accessing

• Tools > DFM Analysis > Setup

Tip: To view help on DFM Analysis, press F1 with the dialog box open.

Using the CAM Plus Assembly Machine Interface
The CAM Plus command generates computer-aided manufacturing (CAM) output files that are 
compatible with a variety of automatic assembly and pick-and-place machines. Before you use 
CAM Plus prepare an information file called part.def.

In this topic

• Creating a Part Definition File

• Setting the CAM Plus Options

• Interpreting Error Messages and Troubleshooting

Creating a Part Definition File
You must manually create a part.def file in order to use the CAM Plus option. Every part that is 
used in the design must be listed in the part.def file. By default, the part definition file is read 
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from the \Libraries folder. For more information, see the Part Definition File topic in the 
Concepts Guide.

Setting the CAM Plus Options
1. File menu > CAM Plus

2. In the Part Definition Filename box, type part.def. The file is read from the \Libraries 
folder by default.

3. In the Setup area:

a. Select a side of the board from the Side list.

b. Select the type of parts to include in the report from the Parts list. Choose from 
SMT, ThruPin, All, and Masked. Masked parts are those that are assigned to the 
machine selected format as an insert class.

c. Select the Read Part Definition check box to add the additional information 
contained in the Part Definition File, part.def, to the parts contained in a design.

This information defines the insertion class for all parts. Read Part Definition scans 
the Part Definition File for information about the parts in the database. When an 
exact match is found between a part type name in the database and a part type name 
in the definition file, the information combines to provide the manufacturing output.

d. Select the Read Value Definition check box to read the Value attributes for each 
part in the PADS Layout design and append the Value attribute to the part type name 
when matching each part type in the Part Definitions file, part.def. 

For example, an R1/4W part type with Value attribute 100K could have an entry in 
the Part Definitions file as follows: 
R1/4W{100K},ins=un6241,bodydiam=200,leaddiam=30,anvil=2

e. Select the Verify File check box to produce an ASCII verification file.

This ASCII file is stored in the \PADS Projects\Cam\<board_file_name> folder. 
This file contains 2D line data that describes the path for the inserted parts. The 
name of the file is the name of the interface program created, with the .asc extension. 
You can read this file into PADS Layout with the ASCII In command. It states the 
insertion path as 2D lines on layer 19. If a Part_Num value for a part is not found, 
Part_Num is set to Missing.

f. Select the Batch Part Def. File check box to run all of the outputs with a single 
command.

For each program you run, an output file is produced with the name suffix bt or bb, 
for example dym318bt.smt or un6241bb.put. If this file already exists, the message 
“Overwrite existing file (Y/N)?” appears. Click either Yes or No. If you click Yes, 
the file is overwritten and placed in the CAM subfolder. Each of the parts in the 
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selected category is added to the file. A report called insert.lst lists each part and the 
machine that inserts it. The Batch command does not create a Verify file.

4. In the Geometry area:

a. Type a value for the Board Offsets to define the offset of the machine’s location 
dowel with regard to the 0,0 system origin board.

These offset values convert the design coordinates to the machine origin. Allowable 
values are from 0 to 10 inches. Offset values are in inches; for example, 1250 is 1.25 
inches. You may need to define a new Board offset for each machine.

b. Type values for the Step/Repeat values to define whether to treat the board as a 
single design when creating the output program file, or to insert a number of boards 
simultaneously.

When you insert a number of boards, you can define the number of steps in the X 
and Y direction and the step and repeat interval to use, as shown in Table 39-2. 
CAM Plus uses current design units for the offset and step and repeat values. Each 
machine has its own units type to which the data is always converted regardless of 
the current design units. CAM Plus generates assembly program files for inserting 
parts on all boards. 

The default is no step and repeat, equivalent to a step of 1 in X and Y.

5. In the Output Format list, select the machine format.

Files are produced for all parts of a selected class: masked, through hole, SMT, top, 
bottom, and so on. All parts in the class are included in this output file, whether or not 
their insert class is defined as belonging to the specific machine.

6. In the Universal Tooling and Universal Axial Output lists select the desired settings if 
applicable. 

Restriction: Universal-specific instructions are available when you select Universal 
machine formats or check Batch Part Def. File.

7. Click Run.

Table 39-2. X and Y Step and Count Options 

Option Description

X Count Number of copies in X direction. The maximum is 20.

Y Count Number of copies in Y direction. The maximum is 20.

X Step The step distance in the X direction between the origin of each board. The 
maximum is 10 inches.

Y Step The step distance in the Y direction between the origin of each board. The 
maximum is 10 inches.
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8. Examine the Status Messages box for the current state of output.

9. Navigate to C:\PadsProjects\CAM\Newfolder(Design Name)\ to examine the output 
file.

Interpreting Error Messages and Troubleshooting
CAM Plus produces and prints error messages in the file padscim.err. 

Related Topics

CAM Plus Assembly Machine Interface in the Concepts Guide
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Chapter 40
Using Scripts

Use the Sax Basic Script and Editor features to design, develop, and run scripts that add to, 
replace, enhance, or customize existing PADS Layout features.

• Creating Scripts

• Managing Scripts

• Debugging Scripts

• Accessing Help on the Basic Language

Creating Scripts
You can create scripts to simplify redundant activities.

The following descriptions are included in this topic:

Creating a Script
To create a script:

1. Tools menu > Basic Scripts > Basic Script Editor.

In PADS Layout and PADS Logic, the SAX Basic Engine dialog box appears.

2. Click the New button.

Inserting an Automation Statement
You can add automation statements to the bottom of a script automatically.

• Creating a Script

• Inserting an Automation Statement

o Using the Object and Procedure Lists

o Using the ActiveX Automation 
Members Dialog Box

• Setting the Next Statement

• Showing the Next Statement

• Saving the Script
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Using the Object and Procedure Lists

Use the Object and Procedure lists to select and insert a statement. These lists contain the most 
commonly used statements.

1. Click the Object list and click an object type. The Object list shows all the objects for 
the current module. The (General) object groups all of the procedures that are not part of 
any specific object.

2. Click the Procedure list and click a non-bold procedure to insert. The Procedure list 
shows all the procedures for the current object. Selecting a procedure that is not bold 
inserts the proper procedure definition for that procedure.

The statement appears at the bottom of the script.

Using the ActiveX Automation Members Dialog Box

• In the Basic Script Editor, right-click and click Debug > Browse.

Use the ActiveX Automation Members dialog box to select and insert a statement. This dialog 
box contains an extensive list of statements.

Tip: If the pointer is on any line in the script other than the bottom line, the line is overwritten.

Setting the Next Statement
You can force a particular line in a script to run next. You can only select statements in the 
current subroutine or function.

To set the next statement:

1. In the Basic Script Editor, put your cursor on the line you want to run next.

2. Right-click and click Debug > Set Next Statement.

An instruction pointer appears next to the selected line. This line, and only this line, will run 
next. If you go to other parts of the script, you can return to this line by clicking Show Next 
Statement.

Showing the Next Statement
• In the Basic Script Editor, right-click and click Debug > Show Next Statement.

An instruction pointer indicates the next statement to run. Pausing a running script or setting a 
statement to run next sets the next statement. You can locate the set statement from anywhere in 
the script.

Saving the Script
1. In the Basic Script Editor, click the Save button.
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2. Enter a file name, if necessary, and then click Save.

Related Topics

• Basic Scripting in the Concepts Guide

Running Scripts
You can run an existing script using Run. Run also resumes the playback of a paused script. 
When you run a script, you cannot use the mouse in the workspace.

The following descriptions are included in this topic:

• Running a Script

• Pausing a Running Script

• Stopping a Running Script

Running a Script
You can run a script from the Basic Scripts dialog box, or you can run a run a script from the 
Basic Script Editor. Running it from the Editor gives you options for pausing and stopping the 
script.

From the Basic Scripts dialog box

1. Tools menu > Basic Scripts > Basic Scripts.

2. Select a script from the list.

If the script you want to run does not appear in the list, click Load File and browse for 
the script to load.

3. Click Run. Scripts are compiled when you run them. You cannot run multiple scripts at 
the same time. 

If the selected script has a compiling error, it automatically opens in the Basic editor for 
correction.

From the Basic Script Editor

1. In the Basic Script Editor, open a script file.

2. Right-click and click Macro > Run.

Alternative: On the Basic Script Editor toolbar, click the Start/Resume button.
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Pausing a Running Script
When running a long script, you may need to pause it to perform some other design activity.

• In the Basic Script Editor, right-click and click Macro > Pause.

Alternative: On the Basic Script Editor toolbar, click the Pause button. 

Tip: If you paused the script, you can also use Run, Step Over, or Step to Cursor to resume 
running the script. Right-click and select Run to resume running the script.

Stopping a Running Script
You can stop a running script at any time. However, you cannot resume running a script once 
you have stopped it. When you click Run, the script starts from the beginning.

• In the Basic Script Editor, right-click and click Macro > End.

Alternative: On the Basic Script Editor toolbar, click the Stop button.

Tip: While a script is running, a third command, Stop scriptname, appears on the Basic 
Scripting submenu (on the Tools menu) along with Basic Editor and Basic Scripts. Click 
Stop scriptname to halt the execution of the currently running script.

Related Topics

• Basic Scripting in the Concepts Guide

Managing Scripts
The following descriptions are included in this topic:

Opening an Existing Script
Scripts are created in and stored in script files that have a .bas extension. The default location 
for .bas files is C:\PADS Projects. To open an existing script:

1. In the Basic Script Editor, click the Open button.

• Opening an Existing Script

• Managing Open Scripts

o Opening #uses Modules

o Closing an Open Script

o Closing all Open Scripts

o Viewing a Particular Script

• Editing a Script

• Editing a User Dialog Box

• Finding an Automation Statement

• Printing a Script

• Saving a Script

• Watching a Variable
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2. Select the script and then click Open.

You can have up to nine scripts open at the same time.

Managing Open Scripts
The commands on the Sheet submenu provide script management methods. Since you can have 
up to nine scripts open at the same time, you can open #uses, close sheets, close multiple sheets, 
and choose scripts to view and edit.

Opening #uses Modules

#Uses modules are Basic scripts that are called from within other scripts. To open these 
secondary scripts:

• In the Basic Script Editor, right-click and select Sheet > Open Uses.

The #uses modules called in the script appear as script sheets in the Basic Script Editor. They 
are assigned a numbered tab and you can edit or run them.

Closing an Open Script

• In the Basic Script Editor, right-click and select Sheet > Close.

Alternatively, you can double-click the script's numbered tab in the gutter.

Closing all Open Scripts

• In the Basic Script Editor, right-click and select Sheet > Close All.

Viewing a Particular Script

If you have multiple scripts open, you can view a particular open script. You can have up to nine 
scripts open at the same time.

To view a particular script:

• Right-click and select Sheet. Then click the script you want to view from the list of open 
scripts on the submenu. Alternatively, you can click the script's numbered tab in the 
gutter.

Editing a Script
You can copy or cut selected text from the Basic Script Editor to the Clipboard. You can also 
paste a selection from the Clipboard into the text window. You can also paste text from the 
Clipboard into other applications.

To copy or cut and paste text in a script:

1. In the Basic Script Editor, select the text you want to copy or cut.
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2. Right-click and click Edit > Copy or Cut.

3. Right-click and select Edit > Paste to paste the script text. Your selection is pasted in the 
Output window at the insertion point.

Alternative: Click the Copy, Cut, and Paste buttons on the Basic Script Editor toolbar.

Editing a User Dialog Box
A UserDialog is defined by a Begin Dialog...End Dialog block. To graphically edit a user 
dialog:

1. In the Basic Script Editor, put your cursor in a UserDialog block of the script.

2. Click the Edit UserDialog button. 

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Finding an Automation Statement
If you are working with a long script, you can search for particular statements.

1. In the Basic Script Editor, click the Object list and select an object type. The Object list 
shows all the objects for the current module. The (General) object groups all of the 
procedures that are not part of any specific object.

2. Click the Procedure list and select a bold procedure. The Procedure list shows all the 
procedures for the current object. Selecting a procedure that is bold locates the 
procedure in the script.

The statement appears in the Basic Script Editor.

Printing a Script
To print a Basic script:

1. Open the script in the Basic Script Editor.

2. On toolbar, click the Print button.

Saving a Script
1. In the Basic Script Editor, click the Save button.

2. Enter a file name, if necessary, and then click Save.
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Watching a Variable
Quick Watch shows the value of the expression under the cursor in the immediate window.

• Right-click and click Quick Watch.

Alternative: In the Basic Script Editor, click the Quick Watch button. 

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Related Topics

• Basic Scripting in the Concepts Guide

Debugging Scripts
When running a script, you can run it step-by-step or to a certain location in the script. To 
perform these debugging tasks, insert breakpoints in the script at the points at which you want 
the script to stop.

This topic discusses the following:

Setting or Removing the Breakpoints
The ability to set or remove breakpoints is useful when you debug a script. If the Basic engine 
encounters a breakpoint when running a script, it pauses the script.

To set a breakpoint in a script:

1. Place the cursor on the line to which to add a breakpoint.

2. On the Basic Script Editor toolbar, click the Toggle Breakpoint button.

Alternative: In the Basic Editor, right-click and click Debug > Toggle Break.

Result: This action inserts a breakpoint at the current cursor location. A breakpoint marker 
appears in the gutter area.

When the Basic engine encounters a breakpoint while running a script, it pauses the script. The 
next line in the script is marked with the instruction pointer.

• Setting or Removing the 
Breakpoints

• Debugging the Scripts

• Removing All Breakpoints in the 
Script

• Correcting Run-time Errors
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Debugging the Scripts
Once breakpoints are inserted, you can debug scripts using the following tasks.

To run a single line of the script:

• On the Basic Script Editor toolbar, click the Step over button. 

To perform a subroutine call on the current line:

• On the Basic Script Editor toolbar, click the Step into button. 

Alternative: In the Basic Script Editor, right-click and click Debug > Step Into.

To return from the subroutine to the point from which it was called:

• On the Basic Script Editor toolbar, click the Step out button. 

To run a script to a point:

• In the Basic Script Editor, right-click and click Debug > Step to cursor.

To continue the execution from the current point:

• On the Basic Script Editor toolbar, click the Run button. 

Alternative: In the Basic Script Editor, right-click and click Macro> Run.

Removing All Breakpoints in the Script
• In the Basic Script Editor, right-click and click Debug > Clear All Breaks.

This removes all breakpoints in the script.

Correcting Run-time Errors
If run-time errors occur, the script debugger switches to step-by-step mode and displays a 
detailed message on the status bar. The instruction pointer is set on the line that produced the 
error. After fixing the error, you can resume running the script.

Related Topics

• Basic Scripting in the Concepts Guide

Accessing Help on the Basic Language
While writing or running scripts, you can access Help that provides information and a sample 
script using the Basic language statements.

To access the Basic Script Editor Help:
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• Select or click in an item in color in the edit area of the Basic Script Editor and then 
press F1.

Help appears for the current statement.

See also: Sax Basic Editor Help. In the Basic Script Editor, right click, point to Help, then click 
Editor Help. 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)
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Chapter 41
OLE in PADS Layout

PADS Layout object embedding capabilities allow design engineers to insert other files or other 
applications as linked or embedded objects within a PADS Layout design. You can insert a 
Microsoft Word document, a Microsoft Excel spreadsheet containing a Bill of Materials, video 
or audio clips, and so forth. PADS Layout does not need to understand the format of the inserted 
object; PADS Layout communicates with the application that created the file and that source 
application tells PADS Layout what information to display and how to display it.

Restriction: The insertion of PADS Logic, Layout or Router files as OLE objects in other files 
(including other PADS files) is not supported. Any PADS Logic, Layout or Router file inserted 
in another file will not behave properly and cannot be edited within the “container” application 
(Visual Editing). 

Inserting OLE Objects in PADS Layout
You can insert a linked or embedded object into your design.

Procedure

1. Edit menu > Insert New Object. The Insert Object dialog box appears.

2. Click whether to Create New or Create from File. Create New inserts a new OLE object. 
Create from File inserts an existing file as an OLE object.

3. If you clicked Create New, click the type of OLE object you want to create. If you 
clicked Create from File, click the file you want to insert as an OLE object.

4. If you clicked Create from File, and you want to link the inserted object to the original 
file, click Link. If you choose not to link the object, it is an embedded object.

5. If you want to display the linked or embedded object as an icon, click Display as Icon.

6. Click OK to insert the linked or embedded object in PADS Layout.

See also: Object Linking and Embedding in the Concepts Guide

Tip: Once you insert an object into a PADS Layout design, you can export it to an .ole file and 
import it into other designs.
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Embedding a Text Document
Using OLE, you can embed a text document in your design to more quickly add multiple lines 
of text since the Text tool on the Drafting toolbar only allows single lines of text. 

Embedding is recommended over linking since the embedded document will reside inside the 
.pcb file and can’t get lost or accidentally deleted as an external file.

You can see a sample of this in the preview.pcb sample design. See the Notes section below the 
board outline. Double-click the text to activate the Microsoft Word document.

Restrictions

• OLE objects can only be printed. They cannot be plotted by a pen or photo plotter.

• Plot OLE objects must be enabled in the Plot Options dialog box to appear in the 
printout, but they will never be visible when viewing the Print Preview.

• OLE objects can only be printed using a zero plot orientation.

Procedure

• Follow the instructions in Inserting OLE Objects in PADS Layout.

Tip: You can resize the object within your design when the object is active for editing.

Related Topics

Adding Free Text

Selecting OLE Objects
Select and manage OLE linked or embedded objects just like you manage nontext Word items. 
Click on the OLE object to select it.

Some limitations exist for selecting OLE objects:

• You cannot select more than one OLE object at a time.

• You cannot use area select to select OLE objects.

• Commands apply to selected OLE objects only, even if you also select PADS Layout 
objects. OLE objects have selection priority over PADS Layout components.

Tip: To select PADS Layout items under an OLE object, move the OLE object.

When you select an OLE object:
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• Right-click to access a shortcut menu that lists all commands that you can apply to the 
OLE object.

• The object is selected just as a nontext object in Word is selected, using a rectangular 
area with sizing handles to indicate that it is selected. (Sizing handles are small, black 
squares that appear at the corners and along the sides of a rectangular area surrounding a 
selected object.) OLE objects do not use the PADS Layout method of highlighting to 
indicate selection state.

Editing OLE Objects in PADS Layout
Editing an OLE linked or embedded object is similar to editing PADS Layout objects. You can 
cut, copy, and paste OLE objects using the Cut, Copy, and Paste commands from the Edit menu.

Tip: You cannot cut, copy, or paste OLE objects when in the PCB Decal Editor.

You can perform the following edits on an OLE linked or embedded object:

• Copy an OLE Object

• Cut an OLE Object

• Paste an OLE Object

• Change the Background Color of an OLE Object

• Move an OLE Object

• Size an OLE Object

• Delete an OLE Object

Warning: Undo and Redo do not effect OLE objects. Since you cannot Undo or Redo actions 
performed on OLE objects, use care when modifying OLE objects.

Copy an OLE Object
To copy an OLE object:

1. Select the OLE object to cut.

2. Click Copy from the Edit menu.

Warning: Undo and Redo do not effect OLE objects. Since you cannot Undo or Redo actions 
performed on OLE objects, use care when editing OLE objects.

Cut an OLE Object
To cut an OLE object:
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1. Select the OLE object to cut.

2. Click Cut from the Edit menu.

Warning: Undo and Redo do not effect OLE objects. Since you cannot Undo or Redo actions 
performed on OLE objects, use care when editing OLE objects.

Paste an OLE Object
Editing an OLE linked or embedded object is similar to editing PADS Layout objects. You can 
cut, copy, and paste OLE objects using the Cut, Copy, and Paste commands from the Edit menu.

Tip: You cannot cut, copy, or paste OLE objects when in the PCB Decal Editor.

To copy an OLE object:

1. Cut or copy the OLE object to place it in the Windows paste buffer.

2. Click Paste from the Edit menu.

The item is pasted into your design.

Warning: Undo and Redo do not effect OLE objects. Since you cannot Undo or Redo actions 
performed on OLE objects, use care when editing OLE objects.

Change the Background Color of an OLE Object
To change the background color of an OLE object:

1. Select the OLE object.

2. Right-click and click White Background. A check next to the command indicates that 
the object will use a white background.

Move an OLE Object
Move OLE linked or embedded objects just as you resize nontext objects in Word.

To move an OLE object:

1. Select the object.

2. Click and hold the left mouse button.

3. Move the pointer to move the object.

4. Release the mouse button once the object is in the correct location.
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Size an OLE Object
Resize OLE linked or embedded objects just as you resize nontext objects in Word.

To size an OLE object:

1. Select the object.

2. Click and hold the left mouse button on one of the sizing handles. Sizing handles are 
small, black squares that appear at the corners and along the sides of a rectangular area 
surrounding a selected object.

3. Move the pointer; the object changes size according to the pointer movements.

4. Release the mouse button when the object is sized correctly.

5. Small, black squares that appear at the corners and along the sides of a rectangular area 
that surround a selected object.

Delete an OLE Object
You can delete OLE linked or embedded objects.

To delete an OLE object:

1. Select the OLE object to delete.

2. Click Delete from the Edit menu, or press Delete. You are asked to confirm the 
deletion.

3. Click Yes to delete the object.

Warning: Undo and Redo do not effect OLE objects. Since you cannot Undo or Redo actions 
performed on OLE objects, use care when editing OLE objects.

Tip: To delete all OLE objects in the design, click Delete All OLE Objects from the Edit menu.

Editing OLE Links
You can edit the link of a linked OLE object. Editing the link allows you to update the link, 
open the original object source, change the original object source, or break the link with the 
object source to make an embedded OLE object. You can also choose to update the object 
automatically or using a manual command.

To edit the link of an OLE object:

1. Click Links from the Edit menu. The Links dialog box appears.

2. Click the link you want to edit from the list.
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3. Click the options you want to use or modify.

4. Click Close to close the Links dialog box. You cannot cancel changes you make in the 
Links dialog box.

Editing an OLE Object’s Content
You can edit an object’s content within PADS Layout (known as in-place visual editing), or in a 
separate window. In either case, you edit its contents as you normally would using all of the 
source application's commands and tools.

In this topic:

• In-place Visual Editing in PADS Layout

• Separate Window Editing In PADS Layout

Tip: See the documentation for the source application for more information on displaying, 
selecting, deleting, and saving PADS Layout objects in container applications.

In-place Visual Editing in PADS Layout
Visual Editing occurs when the source application for a linked or embedded OLE object opens 
within PADS Layout. You can also edit an OLE object by opening the source application and 
editing the object in the environment in which it was created. 

To edit an object within PADS Layout, double-click on the object. 

Click outside of the object to deactivate visual editing. Updates are automatically reflected in 
the object.

Restriction: You cannot edit embedded PADS programs within PADS Logic with visual 
editing.

Tips:

• Linked objects cannot be edited in place: they open in a separate window for editing.

• If the container application does not support in-place visual editing, the object will open 
in a separate window.

Separate Window Editing In PADS Layout
To edit an embedded object outside of the container application:

• Select the PADS Layout object. Click Edit, point to PADS Layout Object, and click 
Edit.
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• Ctrl+double-click the OLE object to edit in the source application. The source 
application opens and you edit the object.

To update the object in the container application:

• Click Update Document from the File menu. This forces a redraw of the object.

• Set an option for PADS Layout OLE objects in the Global tab of the Options dialog box. 
When you click Update on Redraw, the object in the container application will update 
whenever you perform a redraw in the separate editing window.

Turn this option off for best performance.

To return to the container application, click Exit from the File menu and Return to <host>.

Tip: If you want to save the object you edit in the separate window, you can click Save Copy As 
from the File menu. The object is really a copy of the original, and this command lets you save 
this copy. You cannot open other files, create new files, or save original designs in the separate 
window.

Saving OLE Objects
Linked and embedded objects are automatically saved as part of your design when you save a 
PADS Layout design. If you want to save OLE objects separately, use Export to save the objects 
in an .ole file. You can then use Import to import them into other designs.

Procedure

1. File menu > Export.

2. Click OLE Files (*.ole) from the Save as Type list.

3. Type a name for the OLE file you are saving.

4. Click the location for the file.

5. Click Save.
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Chapter 42
Troubleshooting

In this chapter:

• Warning: Test Point Locked Dialog Box

• Recovering from Database Problems

• Database Error Check During File Loading, ASCII, or DXF Import

• Database Integrity Check During Normal Use

• Database Errors During Normal Editing Operation

• To Restore Data if Differences Exist Between the Damaged and the Original Database

• To Correct the Registration File

• To Test Database Integrity Using ASCII

Warning: Test Point Locked Dialog Box
When you modify clusters that contain test points; modify vias, pins, or jumper pins that are 
locked test points; or modify routes that are connected to locked test points, a Warning dialog 
box appears. This warning dialog box performs different functions depending on whether you 
are modifying vias, pins, or routes. The following topics discuss your options for handling 
locked test points during each of the following circumstances:

• Modifying a jumper pin that is a locked test point

• Modifying a pin that is a locked test point

• Modifying a via that is a locked test point

• Modifying a route attached to a locked test point

• Moving, dispersing, or aligning a component, cluster, or union with a locked test point

• Move Sequential to move components, unions, or clusters with a locked test point
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Recovering from Database Problems
When PADS Layout encounters an unrecoverable problem, a warning stating the error code and 
the message “Please read the on-line help topic Recovering From Database Problems” appears.

The following topics outline what to do when you have a database error and how you can 
recover or restore lost data:

Database Errors During Normal Editing Operation

Database Error Check During File Loading, ASCII, or DXF Import

Verifying and Restoring Lost Data
To Test Database Integrity Using ASCII

Comparing Netlists Between a Current and an Original Database

To Restore Data if Differences Exist Between the Damaged and the Original Database

To Test Database Integrity Using ASCII

Related Troubleshooting Topics
Crash Detection, BMW and BLT

Database Error Check During File Loading, 
ASCII, or DXF Import

Whenever you load a file, it undergoes a database integrity check. PADS Layout verifies that 
values and limits for the database are within an acceptable range.

If you encounter problems one of the following happens:

• A dialog box appears asking you to enter an acceptable value.

• You are prompted to confirm an automatic database correction routine.

• The message “Fatal Database Error” appears. In this case, you can still recover your 
data. See Recovering from Database Problems for instructions.

The database correction routine works in two ways:

• Automatically modifying or inserting data to correct a design.

• Deleting erroneous data from a design.
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After you use entered data or the automatic correction routine to fix errors, run a set of 
interactive checks on the new database. These interactive checks should include, but are not 
limited to:

• Clearance checks

• Comparing netlists 

• Check continuity

• Check tie plane

For instructions on how to run these checks see Verify the Design. This data verification 
indicates any differences between the corrected database and the original database.

Database Integrity Check During Normal Use
To run the same database integrity check that occurs during file loading type I, for integrity 
check, and press Enter. PADS Layout verifies that the values in the database are within an 
acceptable range. If problems are encountered, a dialog box appears and either asks you to enter 
an acceptable value or to confirm an automatic database correction routine. For a description of 
the process and corrective action, see “Database Error Check During File Loading, ASCII, or 
DXF Import.“

Database Errors During Normal Editing 
Operation

During normal use, PADS Layout constantly monitors the design in memory. If a serious error 
occurs, the program saves the design to the backup file and a “Fatal Database Error” message 
appears. After an error, do the following to preserve the file:

1. Copy the backup file, Layout.pcb, and the three sequential backups, Layou1.pcb, 
Layou2.pcb and Layou3.pcb, to new names or to a new location on your hard drive.

2. Restart PADS Layout.

3. Load the original Layout.pcb backup file. Depending on the error you may be able to 
reload the file and continue.

4. If you cannot load Layout.pcb, try to load the sequential backup files and use the file 
closest to the time when the error occurred.

Once the file is loaded, follow the steps in “To Test Database Integrity Using ASCII.“

If you can recreate the error, call Technical Support. Inform the technician of:

• The steps to reproduce the problem.
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• Your software and hardware configurations.

• Your registration number.

• Whether you can send the design file for troubleshooting.

To Restore Data if Differences Exist Between the 
Damaged and the Original Database

If the part or connection information differs at all after running Compare Netlist, you can restore 
lost data using one of two methods.

If data loss is minimal:

1. Open the ECO toolbar and use the Route, Add Pin Pair, Add Part, Rename Net, and 
Rename Part commands to correct the design manually.

2. After data is restored, compare netlists to ensure that no differences exist between the 
corrected and the original design.

3. If the Differences Report indicates no differences, run the other PADS Layout Verify 
the Design routines to ensure that spacing, continuity, and plane net data are correct.
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If data loss is extensive:

• Use the ECOGEN program to restore data. ECOGEN runs both inside Windows and as 
a standalone DOS program. ECOGEN compares a new netlist and an old netlist of a 
design. The comparison creates a file containing commands to update the new version of 
the design so that it contains the same part and connection data as the older version.

To Correct the Registration File
The registration file, powerpcb.reg, defines all registry keys required for the proper registration 
of PADS Layout OLE components. Also, other programs acting as clients access the PADS 
Layout OLE Automation server through the registry file. This file is automatically created by 
the Installation program and saved, for reference, in the same folder as the powerpcb.exe. 

Warning: Never change the contents of this file. Incorrect PADS Layout registry entries may 
result, making PADS Layout unable to run.

If the registry file becomes corrupted, you can correct it. To correct the registry:

1. Open the Windows Explorer by clicking Start, pointing to Programs, and clicking 
Windows Explorer.

2. Double-click on the powerpcb.reg file. Explorer passes this file to the Windows Registry 
where the powerpcb.reg entries are updated, or refreshed.

See the “Troubleshooting” topic in the PADS Layout Automation Server Help for more 
information.

To Test Database Integrity Using ASCII
You can save an ASCII version of your binary file from PADS Layout. If you suspect that your 
database contains errors or corrupt data, you can run integrity checks on the database using the 
ASCII format.

When you perform an ASCII Import, the database integrity check runs to determine if your 
database contains proper values. A second check occurs when PADS Layout actually 
reconstructs the binary data in memory. If data is missing, incomplete, or incorrect, the ASCII 
In routines will report it.

To run the integrity check, first create an ASCII file: 

1. Click Export from the File menu. The Export dialog box appears.

2. Type a name for the ASCII file.

3. Click Save.
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4. In the ASCII Out dialog box, click Select All, set the units to Basic, and select the 
correct format. Click OK.

Note: You cannot export the Perform 6 ASCII format from PADS Layout.

When the ASCII export is complete, save your current .pcb design and create a new file. In the 
new file:

1. Click Import from the File menu. The Import dialog box appears.

2. Select the filename of the ASCII file you just created.

3. Click OK. If no errors are found during loading your database is stable.

If problems exist, an error file is generated. See “Database Error Check During File 
Loading, ASCII, or DXF Import.”
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Chapter 43
SPECCTRA Link

In this section:

• Passing Maximum Number of Vias to SPECCTRA

• SPECCTRA Output File Location and Router Settings

• The Interface

• Do Files

• Working with Split Planes

Passing Maximum Number of Vias to SPECCTRA
You can set up the maximum number of vias in PADS Layout, and the SPECCTRA Link 
automatically passes them to SPECCTRA.

Warning: If the maximum number of vias rule is not supported by the set of licensed 
SPECCTRA options you have enabled, SPECCTRA may ignore this rule or even disable 
autorouting.

SPECCTRA Output File Location and Router 
Settings

Use the Setup SPECCTRA Finish dialog box to specify output file locations and to set 
instructions for the SPECCTRA router regarding actions performed when routing is completed, 
such as running the mitering pass, running re-cornering, and insertion of test points.

To specify output file settings and SPECCTRA router instructions for import to PADS Layout 
from the Setup SPECCTRA Finish dialog box:

1. On the File menu, click Export. 

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click DO File.

5. In the SPECCTRA Do File dialog box, click Finish.

6. To indicate the wires file, type or browse to the location in the Wires File box.
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7. To indicate the routes file, type or browse to the location in the Routes File box.

8. To indicate the session file, type or browse to the location in the Session File box.

9. Select the options you want for test points installed by SPECCTRA in the Test Points 
area.

See also: Passing DFT Audit Settings to SPECCTRA in the Concepts Guide, 
“Testpoint” topic in the SPECCTRA Help

10. Select a miter conversion type from the Miter area.

11. Select a recornering option from the Recorner area.

12. To remove crossover and clearance violations, click Delete Conflicts.

13. To eliminate notches and remove extra bends, click Critic.

14. To add extra space if there is room, click Spread and type the spread value in the Extra 
box.

15. Select the type of data you want to include in the report from the Reports area.

16. To indicate the report file, type or browse to the location in the Report File box.

17. Click Apply. The appropriate lines are added to your .do file at the last pointer location.

Tip: To remove a line, select it in the .do file in the Editor area and press Delete on your 
keyboard.

Related Topics

SPECCTRA Help

Interface

Loading In and Out of SPECCTRA Automatically
When you start SPECCTRA from within PADS Layout, the SPECCTRA Link dialog box 
enables you to load in and out of SPECCTRA automatically.

Alternative: If you start SPECCTRA independently of PADS Layout, use the Stand-alone 
SPECCTRA Link dialog box to load in and out of SPECCTRA manually.

To load your design into and out of the SPECCTRA router in batch mode follow these steps:

1. On the File menu, click Export. 

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.
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4. In the SPECCTRA Link dialog box, type or browse for the .DO file you want to use.

5. To create or edit the .DO file, click DO File.

See also: Creating or Editing a .do File

6. To set the SPECCTRA automatic startup information, click Setup.

See also: Setting the SPECCTRA Automatic Startup Information

7. To specify output files (routes file and session file), type in their locations on the Setup 
SPECCTRA Finish dialog box. To access it, click DO File on the SPECCTRA Link 
dialog box, then click Finish on the SPECCTRA Do File dialog box and enter the file 
locations.

See also: SPECCTRA Output File Location and Router Settings

8. To set options for sending via keepout information, passing advanced rules, setting a 
trace arc translation mode, or returning unused pins net, click Options.

See also: Setting SPECCTRA Options

9. Click Continue. The design loads into SPECCTRA and the router runs in batch mode.

When translation completes, the modified design file appears on the screen, loaded into 
a new PADS Layout session (unless Launch Mentor session is cleared in the Setup 
dialog box). The Link starts a new session so it does not interrupt any current sessions. If 
you run the router overnight, you can close the PADS Layout session to save memory.

Loading In and Out of SPECCTRA Manually
If you start SPECCTRA independently of PADS Layout, you can manually control the 
SPECCTRA interface. This gives you more control over how to use SPECCTRA. You can 
import from and export to SPECCTRA, and you can set instructions for the SPECCTRA router 
regarding actions performed when routing is completed (for example, running the mitering pass, 
running re-cornering, and inserting test points).

Alternative: If you start SPECCTRA from within PADS Layout, you use the SPECCTRA Link 
dialog box to load in and out of SPECCTRA automatically.

To run SPECCTRA manually:

1. If you are in PADS Layout, save the .pcb file.

2. Use Windows Explorer to navigate to your PADS program files directory, and double-
click pads2sp.exe. The SPECCTRA Link dialog box appears.

Example: 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\pads2sp.exe

3. To set up the SPECCTRA automatic startup information, click Setup.
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See also: Setting the SPECCTRA Automatic Startup Information

4. To translate the .pcb file to SPECCTRA format click To SPECCTRA. The To 
SPECCTRA dialog box appears.

See also: Translating Design Data from PADS Layout to SPECCTRA

5. To run SPECCTRA, click Start, point to Programs, point to SPECCTRA, and click 
SPECCTRA. 

Tip: You can also launch SPECCTRA by checking the Startup SPECCTRA check box 
on the To SPECCTRA dialog box.

6. Use the File operations in SPECCTRA to load the translated design (.dsn) file.

7. When you're finished with SPECCTRA, to run the Link again to translate the output 
back to a .pcb design file, click From SPECCTRA.

See also: Translating Design Data from SPECCTRA to PADS Layout

8. Load the new .pcb file into PADS Layout.

Translating Design Data from PADS Layout to 
SPECCTRA

Use the To SPECCTRA dialog box to translate a .pcb design file into a SPECCTRA design file.

1. Use Windows Explorer to navigate to your ...\SDD_HOME\Programs directory, and 
double-click pads2sp.exe.

2. In the SPECCTRA Link dialog box, click To SPECCTRA.

3. To indicate the file to send to SPECCTRA, type or browse to the location in the PCB 
File box.

4. To indicate the design file (.dsn) that SPECCTRA inputs, type or browse to the location 
in the Design File box.

5. To indicate the .do file to send to SPECCTRA, type or browse to the location in the DO 
File box. The .do file is the script file that controls SPECCTRA operation.

6. To indicate the output file (.did) that SPECCTRA creates, type or browse to the location 
in the Did File box. This file serves as an input .do file in a subsequent SPECCTRA 
session.

7. To start SPECCTRA after the batch conversion is complete, click Startup 
SPECCTRA.

8. To create or edit the .DO file, click DO File.

See also: Creating or Editing a .do File
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9. To set options for sending via keepout information, passing advanced rules, setting a 
trace arc translation mode, or returning unused pins net, click Options.

See also: Setting SPECCTRA Options

Translating Design Data from SPECCTRA to PADS 
Layout

Use the From SPECCTRA dialog box to translate design data modified by SPECCTRA back 
into a .pcb design file.

1. Use Windows Explorer to navigate to your PADS program files directory, and double-
click pads2sp.exe. 

2. In the SPECCTRA Link dialog box, click From SPECCTRA.

3. To indicate the routing information file that is returned by SPECCTRA after processing, 
type or browse to the location in the SPECCTRA Routes box. Include the command to 
write this file after autorouting at the end of the .do file.

4. To indicate the placement and routing information file, type or browse to the location in 
the Session File box. You do not need to supply this file name if you did not use any of 
the SPECCTRA placement capabilities.

5. To indication the original (source) .pcb file, type or browse to the location in the 
Original PCB File box.

6. To indicate the file to be created from the SPECCTRA file, type or browse to the 
location in the New PCB File box.

7. To set options for sending via keepout information, passing advanced rules, setting a 
trace arc translation mode, or returning unused pins net, click Options.

See also: Setting SPECCTRA Options

Setting SPECCTRA Options
The Options dialog box appears when you click the Options button on the SPECCTRA Link 
dialog box, the TO SPECCTRA dialog box (stand-alone), or the FROM SPECCTRA dialog box 
(stand-alone). 

This dialog box controls options for sending via keepout information, passing advanced rules to 
SPECCTRA, setting a mode for trace arc translation, and returning the unused pins net from 
SPECCTRA. 

See also: Unused Pins Net in the Concepts Guide

1. On the File menu, click Export. 
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2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click Options.

5. To send via keepout areas from your decals to SPECCTRA, select the layer you want 
from the Layer Containing Via Keepout Shapes list.

Tip: PADS Layout fully supports keepouts in the Layout Editor. The preferred method 
to create a via keepout is to define keepouts in your decals.

6. To pass default Selected Layer and Selected Via rules to SPECCTRA, click Pass 
Default Advanced Rules. These rules require the Advanced Rules option in 
SPECCTRA. Turn this option on if you have this SPECCTRA option; otherwise, leave 
this option off.

See also: PADS Layout to SPECCTRA Rules Conversion in the Concepts Guide.

7. Select from one of three modes to perform trace arc translation:

To Single Segment—Replaces each trace arc with a single segment. This is the default 
mode.

To Multiple Segments—Replaces a trace arc with multiple segments. The original 
trace arc is divided into smaller arcs (equal to approximately 5 degrees) and then each 
smaller arc is replaced by a single segment. The result is a polyline of multiple segments 
instead of the arc.

To Quarter Arcs (QARCs)—Breaks existing arcs into quarter arcs and other segments. 
(Quarter arcs are arcs whose start and end points are exactly 0–90, 90–180, 180–270, 
and 270–360 degrees.) The quarter arcs are translated to the SPECCTRA QARC 
structure. The remaining parts of arcs are translated to polylines. 

8. To return unused pin and fanout information to PADS Layout, click Return 
UNUSED_PINS routing to PADS Layout. Type the name of the net in the PADS 
Layout design that will contain the unused pins. Provide a new name if you do not want 
to use the default. 

Clear this option to ignore unused pin and fanout information when returning to PADS 
Layout.

Tip: SPECCTRA names the unused pins net +UNUSED_PINS+ while previous versions 
named it *UNUSED_PINS*. The SPECCTRA Link interprets both names.

The maximum netname length in PADS Layout is 47 characters. You can use any alphanumeric 
characters except for brackets{ }, asterisks *, or spaces.

Setting the SPECCTRA Automatic Startup Information
Use the SPECCTRA Setup dialog box to set SPECCTRA automatic startup information.
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1. On the File menu, click Export. 

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click the Setup button.

5. To indicate the executable needed to run SPECCTRA, type or browse to the location in 
the Executable box.

6. To indicate the password file needed to run SPECCTRA, type or browse to the location 
in the Password/Server box.

Tip: For teal key node-locked or floating licensing, point to your license server in the 
standard port@host format. For example, 7508@myserver.

7. To indicate the SPECCTRA message output file, type or browse to the location in the 
Message Output box.

8. To indicate the SPECCTRA status file, type or browse to the location in the Status box.

9. To indicate the SPECCTRA color mapping file, type or browse to the location in the 
Color Mapping box.

10. To disable the SPECCTRA graphic display and make SPECCTRA run faster, click No 
Graphics.

11. To close SPECCTRA after it processes the .do file commands, click Quit After Do.

12. To delete all prerouted traces before entering SPECCTRA, click No Preroutes.

13. To ignore copper without net assignments, which have no net association in 
SPECCTRA, click Don't Strip Orphan Shapes.

14. To convert one-inch square, or smaller, polygons to simple rectangles, click Simplify 
Polygons.

15. Select the licensing type you want: Floating, Node-locked with Flexid Key, or Node-
locked with SSI key.

16. To reload the routed design back into PADS Layout after it processes the .do file 
commands, click Launch PADS Layout session.

Passing Keepouts to SPECCTRA
You can define various types of keepouts in PADS Layout, such as placement, trace, and via 
keepouts. The SPECCTRA Link passes them to SPECCTRA automatically: placement keepout 
(as place_keepout), trace keepout (as wire_keepout), and via keepout (as via_keepout).
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Creating or Editing a .do File
The .do file is an editable batch script file, which controls SPECCTRA operation. You can add 
or edit command lines in a .do file. When you start the editor, the .do file you specify in the 
SPECCTRA Link dialog box is read for editing.

To create or edit a .do file:

1. On the File menu, click Export. 

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, do one of the following:

• To create a new file, type the name of the new .do file in the DO File Name box and 
click DO File.

• To edit an existing file, type or browse to the name of the .do file in the DO File 
Name box and click DO File.

5. The contents of the Setup and All areas change according to the options you select in the 
Setup area. Select the options you want and then click Apply to Editor to write the 
information to the .do file. The commands appear in the Editor area.

• Order -change the original net ordering and control whether nets are routed in 
daisy-chain or starburst fashion.

See also: “Order” and “Choosing Starburst or Daisy-Chain Wiring” topics in the 
SPECCTRA Help

• Action - control wire rerouting, net routing, and the availability of connections, vias, 
and layers for autorouting.

See also: “Protect/Unprotect”,” “Fix/Unfix,” and “Select/Unselect” topics in the 
SPECCTRA Help

• Cost - control routing costs and override the autorouter internal cost table.

See also: “Cost,” “Limit,” “Tax,” and “Using Standard Autorouting Commands” 
topics in the SPECCTRA Help

If you click Cost in the Cost area and Layer in the All area, options in the Type area 
appear.

See also: “Type,” “Length,” “Way (Cost),” and “Way (Limit)” topics in the 
SPECCTRA Help



SPECCTRA Link
Do Files

PADS Layout User’s Guide and Reference Manual, PADS 9.4 857

• Test Point Rule - control passing DFT Audit test point placement options to 
SPECCTRA for its test point placement routine.

See also: Passing DFT Audit Settings to SPECCTRA in the Concepts Guide and the 
“Testpoint” and “Testpoint Antennas” topics in the SPECCTRA Help. 

Table 43-1. SPECCTRA Link Dialog Box Options 

Option Function

Insert Test Points Allows insertion of test points and makes the 
options in the Test Points area available.

Allow Points at Pins Allows placement of test points on component 
pins.
There is no equivalent in DFT Audit; test 
points are always allowed on pins.

Allow Antennas Allows antennas. Set a length.
There is no equivalent in DFT Audit.

Max Length Sets the length restriction for antennas. The 
default maximum length is negative one (-1), 
no length restriction.

Center to Center The distance between the centers of test points. 

Center to Comp Edge The distance between the center of the test 
point and the component outline.

Image Outline Clearance The clearance between the component outline 
and the test point carrier (via or component 
pin). If the Image Outline Clearance is 
negative, a zero (0) is set. 

Test Side Searches the specified side for test point 
placement.

Use Via Uses vias as test points.
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• All area - Limits actions to certain selected objects. The content of this area changes 
depending on the options you select in the Setup area.

• Only area - Limits actions to certain selected objects.

6. Use the Routing area to set fanout rules: direction, pin type, and maximum length, and 
to set the Bus direction and enter the number of passes for each type.

7. To autoroute your design based on how your design is converging, click Smart Route. 
For more information see the SPECCTRA Help.

8. To write the commands to the .do file click Apply to Editor. The command appears in 
the Editor area.

9. Click Startup to set the startup information.

See also: Setting the SPECCTRA Automatic Startup Information

10. Click Finish and set the parameters in the Setup SPECCTRA Finish dialog box.

See also: SPECCTRA Output File Location and Router Settings

11. Click Apply to save the parameters.

12. Click Save As to save the file and enter a name for the file. This is optional.

13. Click Continue to start the conversion and loading process.

Setting up SPECCTRA .do File Startup Options
Use the Setup SPECCTRA Startup dialog box to include a line referencing previously entered 
routes, saved in Wires or Best Save files, in your .do file. SPECCTRA refers to these files upon 
startup. You can also include the name of the status file and parameters for Via at SMD, Seed 
Via, and Seed Via minimum distance.

For details on these files and functions see the SPECCTRA Design Language Reference PDF 
file spdlr.pdf in the SPECCTRA group.

1. On the File menu, click Export. 

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click DO File.

Grid X, Y The test point grid.
See also: Grid Options

Table 43-1. SPECCTRA Link Dialog Box Options (cont.)

Option Function
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5. In the SPECCTRA DO File dialog box, click Startup.

6. To indicate the wires file, type or browse to the location in the Wires File box.

7. To indicate the status file, type or browse to the location in the Status File box.

8. To indicate the Best Save file, type or browse to the location in the Best Save box.

9. To allow vias at SMD pads, select On in the Via at SMD area. To ensure that the via is 
on a grid point select On in the Grid area. To ensure that the via fits within the pad, 
select On in the Fit area.

10. To break up two-pin connections that are larger than a certain length, click Seed Via and 
type the length value in the Distance box.

11. Click Apply.

Related Topics

SPECCTRA help

Working with Split Planes

SPECCTRA and Split/Mixed Planes
If you plan to use SPECCTRA to fanout or otherwise route your power nets to their associated 
plane area polygons, read this important information before you define your plane polygons in 
PADS Layout.

During the development of the split/mixed plane features in PADS Layout, certain operational 
details were discovered about the way that SPECCTRA routing commands respect plane 
polygons. To achieve proper attachment of power nets to plane polygons in SPECCTRA, use 
one of the following split plane definition procedures. Following these steps will ensure the 
highest possible quality routing results from SPECCTRA.

• If you typically define split planes after you route your designs in SPECCTRA, see 
Defining Split Planes After Routing in SPECCTRA.

• If you typically define split planes before you route your designs in SPECCTRA, see 
Defining Split Planes Before Routing in SPECCTRA.

Split/mixed plane layers without routing, named copper, or plane polygons are translated as 
power layers in SPECCTRA. Power layers are not considered routing layers by SPECCTRA; 
therefore, SPECCTRA cannot route on these layers. This minimizes the layer count passed to 
the router. For example, you can route a four-layer design with two power layers in a 
SPECCTRA configuration licensed for two routing layers.
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SPECCTRA regards the entire plane as the area in which to connect component pins to all plane 
nets. The SPECCTRA fanout and route commands connect SMD component pins by routing 
short traces from the pins to vias to satisfy a connection to the plane.

For best results:

• Perform a multipass fanout of power pins before you execute multiple route passes by 
inserting the number of fanout passes in the command. For example, change “fanout 
(pin_type power)” to “fanout 5 (pin_type power).”

• Select the proper fanout options as defined in Creating or Editing a .do File.

• Avoid assigning design rules to nets that are associated with split/mixed plane layers. 
The design will not open in SPECCTRA if design rules are present. The SPECCTRA 
Link automatically removes or ignores design rules associated with split/mixed plane 
layers.

Related Topics

Creating or Editing a .do File

Defining Split Planes Before Routing in SPECCTRA
When you can define your split planes before routing, you can use the advanced functionality of 
PADS Layout and SPECCTRA to quickly route your split plane designs. Use the following 
steps to take advantage of this functionality:

1. Assign layers as split/mixed layer type: Before you can add split plane nets and data to a 
layer, you must assign the layer as split/mixed. 
See also: Layers Setup dialog box, Plane Layer Nets Dialog Box

For best results, limit the assignment of split/mixed to internal, embedded plane players. 
Assigning external routing layers as split/mixed layers may produce unexpected results.

2. Define the plane polygons: Create split plane polygons for each net assigned to the plane 
layer using the steps described in “Creating a Plane Area” and “Auto Separate.”

With PADS Layout you can define overlapping plane polygons, but Plane Connect 
detects overlaps and automatically adjusts the plane fill area to eliminate overlaps. 
SPECCTRA does not offer features to automatically adjust overlapping polygons and 
may produce unexpected results when large numbers of overlapping polygons are 
translated.

For best results:

• Define your planes using the Auto Separate command only. This eliminates the 
possibility of overlapping plane areas or plane area cutouts.
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• If you prefer to create planes as polygon rectangles and circles, create the smaller 
polygons first and then add polygons around them rather than creating a larger 
polygon and embedding a smaller polygon within it.

3. Route the design in SPECCTRA: Once you assign the proper layer and net data for the 
plane layer, you can transfer the design to SPECCTRA. 

See also: Loading In and Out of SPECCTRA Automatically

4. Flood the split/mixed plane polygons: After routing is completed in SPECCTRA and the 
design returns to PADS Layout, flood the plane polygons.

5. Verify plane net continuity: After flooding the planes, verify the continuity of the plane 
nets. This process scans the plane polygons and route data and reports portions of nets 
disconnected from the plane polygons. To do this, see “Verifying the Design”, “Setting 
Up Plane Checking”, “Creating a Plane Area” and “Setting Up Plane Checking.”

Defining Split Planes After Routing in SPECCTRA
When your design process involves splitting planes after you route the design in SPECCTRA, 
use the following steps in PADS Layout:

1. Assign layers as Split/Mixed Plane Layer Type: Before you can add split plane nets and 
data to a layer, you must assign the layer as split/mixed. 
See also: Layers Setup dialog box, Plane Layer Nets Dialog Box

For best results:

• Do not define a plane area polygon for the split/mixed layer prior to autorouting in 
SPECCTRA. SPECCTRA considers that the entire plane layer belongs to all nets 
and provides short fanout traces for SMD pins connected to the plane nets.

• Limit the assignment of split/mixed to internal, embedded plane layers. Assigning 
external routing layers as split/mixed layers may produce unexpected results.

2. Route the design in SPECCTRA: Once you assign the proper layer and net data for the 
plane layer, you can transfer the design to SPECCTRA. 

See also: Loading In and Out of SPECCTRA Automatically

3. Define the plane polygons: Create split plane polygons for each net assigned to the plane 
layer using the steps described in “Creating a Plane Area and “Auto Separate.”

Tip: If you want to pass this design to SPECCTRA again after you define split/mixed 
planes, see the information below. Also see Routed Traces on PADS Layout 
Split/Mixed Plane Layers in the Concepts Guide.

With PADS Layout you can define overlapping plane polygons, but Plane Connect 
detects overlaps and automatically adjusts the plane fill area to eliminate overlaps. 
SPECCTRA, however, does not offer features to automatically adjust overlapping 



PADS Layout User’s Guide and Reference Manual, PADS 9.4862

SPECCTRA Link
Working with Split Planes

polygons. SPECCTRA may produce unexpected results when large numbers of 
overlapping polygons are translated.

For best results:

• Define planes using Auto Separate only. This eliminates the possibility of 
overlapping plane areas or plane area cutouts.

• If you prefer to create planes as polygon rectangles and circles, create the smaller 
polygons first and then add polygons around them rather than creating a larger 
polygon and embedding a smaller polygon within it.

4. Flood the split/mixed plane polygons: After routing is completed and the design returns 
to PADS Layout, flood the plane polygons.

5. Verify the plane net continuity: After flooding the planes, verify the continuity of the 
plane nets. This process scans the plane polygons and route data and reports portions of 
nets disconnected from the plane polygons. To do this, see “Verifying the Design”, 
“Setting Up Plane Checking”, “Creating a Plane Area” and “Setting Up Plane 
Checking.”
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Chapter 44
Crash Detection, BMW and BLT

Crash Detected Dialog Box
The Crash Detected dialog box opens at a crash and allows you to save a report of the PADS 
environment as well as pertinent files into a compressed PADS Dump File. You can then submit 
this file to Mentor Customer Support. You can attach feedback to this report, and optionally, the 
BMW media and project files.

Accessing

• This dialog box is inaccessible unless the software crashes and crash detection is 
enabled in the software .ini file.

Enabling/Disabling the Crash Detected Dialog Box

This functionality is turned off by default and is controlled by a switch in the .ini file. 

• If no switch exists in the .ini file or if, in the [General] section of the .ini file, the switch 
exists with a value of 0 (zero), then crash detection is turned off. No report is created of 
the environment at the time of the crash.

• If, in the [General] section of the .ini file, the CrashDetection switch exists with a value 
of 1, then crashes are detected and the Crash Detection dialog box appears.

BMW and BLT
BMW (Basic Media Wizard) and BLT (Basic Log Test) are tools that you can use to record and 
play back PADS Logic, PADS Layout and PADS Router sessions. They are particularly useful 
as a means of supplying information to PADS Technical Support engineers trying to identify 
and resolve any problematical behavior you may encounter.

If you report problematical behavior for one of the PADS tools to PADS Technical Support, 
Tech Support engineers may ask you to use BMW to record session playback media 
documenting the actions that caused the problem. PADS tech support engineers can then replay 
the session with BLT to help them identify and resolve the problem.
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Creating Session Playback Media With BMW
To create session playback media, BMW session logging must be enabled when the problem 
occurs. If session logging was not enabled when you encountered the problem, you must 
recreate the actions that caused the problem in a new session with session logging enabled.

Also, depending on whether the problem you want to document caused the PADS tool to crash, 
you can create session playback media based on either the current or the immediately previous 
PADS tool session.

The following table specifies which of the procedures described below you must use to create 
session playback media.

Creating Session Playback Media For a Normal Session
Use this procedure when the session you are recreating did not cause a PADS tool crash.

To create session playback media from the current session:

1. Start the PADS tool.

2. Type the modeless command BMW ON and press Enter to enable session logging. 
Logging remains enabled for this and all future sessions until you disable it with the 
BMW OFF command.

Tip: You must enable session logging before you open the file.

3. Open the file in which you encountered the problematical behavior.

4. Perform the series of actions that produced the problematical behavior. The series of 
actions, as well as changes to the board or to the configuration, are stored in the Session 
Log Files for the current session.

5. Type the BMW modeless command and press Enter. 

6. In the Media Wizard dialog box, click Create Media from Current Session. 

Was logging 
enabled?

Did the PADS
tool crash? Then use this procedure.

Yes No Creating Session Playback Media For a Normal Session

No No Creating Session Playback Media For a Normal Session

Yes Yes Automatically Creating Session Playback Media for a 
Crashed Session

No Yes Manually Creating Session Playback Media For a 
Crashed Session
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7. Type your initials in the User Initials box. (They are included in the playback media 
filenames to identify the files as yours.)

8. To delete all entries in the session log file between the first Open and the last Save 
command, click Delete Actions Before Last Save. You can do this to eliminate any 
actions you may have performed before beginning the series of actions that produced the 
problematical behavior. This makes it easier for the Tech Support engineer to identify 
the problem.

9. Click OK to create the Session Media Files.

Automatically Creating Session Playback Media for a Crashed 
Session

Use this procedure when the session you are recreating caused the PADS tool to crash, and none 
of the listed restrictions applies.

Restrictions:

• This procedure works only if:

• The previous (crashed) session started with BMW logging already enabled.

• Logging remained enabled throughout the session.

• This procedure does not give useful results if any additional instance of the PADS tool 
ran concurrently (for any period) with the previous (crashed) session.
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To automatically create session playback media from the previous session:

1. Start the PADS tool.

2. Type the modeless command BMW ON and press Enter to enable session logging. 
Logging remains enabled for this and all future sessions until you disable it with the 
BMW OFF command.

Tip: You must enable session logging before you open the file.

3. Open the file in which you encountered the problematical behavior.

4. Perform the series of actions that produced the problematical behavior. The series of 
actions, as well as changes to the board or to the configuration, are stored in the Session 
Log Files for the current session.

5. After the crash, restart the PADS tool. A dialog box is displayed asking if you want to 
save media files for the crashed session. Click Yes to create the Session Media Files.

Manually Creating Session Playback Media For a Crashed 
Session

Use this procedure when the session you are recreating caused the PADS tool to crash, and the 
automatic procedure described in Automatically Creating Session Playback Media for a 
Crashed Session cannot be used due to one of the restrictions listed in that section.

To manually create session playback media from the previous session:

1. Start the PADS tool.

2. Type the modeless command BMW ON and press Enter to enable session logging. 
Logging remains enabled for this and all future sessions until you disable it with the 
BMW OFF command.

Tip: You must enable session logging before you open the file.

3. Open the file in which you encountered the problematical behavior.

4. Perform the series of actions that produced the problematical behavior. The series of 
actions, as well as changes to the board or to the configuration, are stored in the Session 
Log Files for the current session.

5. After the crash, restart the PADS tool.

6. Type the shortcut BMW and press Enter. 

7. In the Media Wizard dialog box, click Create Media from Previous Session. 

8. Type your initials in the User Initials box to identify your session playback media files.

9. Click OK to create the Session Media Files.
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Session Log Files
Whenever BMW session logging is enabled, two sets of session log files are maintained in the 
\PADS Projects folder. These logs record actions performed in the current session, and in the 
immediately previous session.

BMW names these files as follows:

Tip: These files are dynamic; each time you start a session, the current session log files are 
renamed as the previous session log files, and new current session log files are created. The 
contents of the old previous session log files are lost.

Whenever you elect to create session media files for a session, the appropriate set of these log 
files is saved in a permanent location, as described in Session Media Files.

Note: You may see a log file named <pads_tool>_Session.log listed in the \PADS Projects 
folder. This file is unrelated to the session playback media created by BMW. 

Session Media Files
Each time you create session playback media, BMW creates a new session media folder in the 
\PADS Projects folder, and copies into it:

• The .pcb or .sch file for which you are recording the session

• The Session Log Files for the session. BMW then renames these files based on the 
session media folder name.

The session media folder is named <month><day><initials><sequential letter>, where:

• <month><day> is the date.

• <initials> are letters you type in the Media Wizard dialog box to personalize the media 
files.

• <sequential letter> is a letter automatically assigned to sequence the directories created 
on a specific date.

Example: \PADS Projects\0530jsb represents a session media folder created on May 30, using 
the initials js, and that was the second session media folder created on that day.

Current Session Log Files            Previous Session Log Files

<pads_tool>_Next.log
<pads_tool>_Next.reg
<pads_tool>_Next.ini

<pads_tool>_NextBak.log
<pads_tool>_NextBak.reg
<pads_tool>_NextBak.ini
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Replaying Session Playback Media with BLT

When creating the session playback media, the following files are written to the session media 
folder:

Replaying Session Playback Media with BLT
Use BLT to replay session playback media created by BMW. 

To replay a session:

1. Type the BLT modeless command, and press Enter.

2. Select the session playback media from the Media Directories list and click OK.

Result: The session is replayed.

Tip: To personalize the media folder and session playback media file names, select a media 
session from the Media Directories list, type the new name into the New name box, and then 
click Rename.

The /BMW Command Line Switch
If you want BMW to automatically prompt you to create media from the previous session each 
time you start a PADS tool, open the PADS tool using the /BMW command line switch. Or use 
/BMW-xx (where xx represents your initials, which are used in folder and file names to identify 
them as yours).

Restriction: When you use BMW as a command line option, it only creates media of the 
previous session; use the BMW modeless command to create media of your current session.

<folder_name>.log The session log

<folder_name>.reg The program-specific settings in the Windows registry

<folder_name>.ini The  configuration file (.ini file)

<folder_name><sl>.pcb     (if needed)
<folder_name><sl>.sch     (if needed)
Where <sl> is a sequential letter for 
multiple files.

Files related to <folder_name>.log. These files are 
automatically renamed and added to the session media 
folder.
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Chapter 45
PADS Layout GUI Reference

The section contains information on all of the GUI elements in PADS Layout.

Add Archive to Vault Dialog Box
Use the Add Archive to Vault dialog box to configure an Archive Navigator archive and save it 
to the vault.

Tip: From this dialog box you can also access the Templates dialog box, where you can define 
customized archive templates.

Accessing

• Working Folder view > Add Archive to Vault button 
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Figure 45-1. Add Archive to Vault Dialog Box
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Related Topics

Adding an Archive to the Vault

Add BGA Pin Labels Dialog Box
Use the Add BGA Pin Labels dialog box to label the die part's substrate bond pad. Usually 
labels match the name of the BGA pin to which they are connected.

Tips: 

Table 45-1. Add Archive to Vault Dialog Box contents 

Name Description

Project location in Vault The project in the vault view tree where the new archive will 
be created.

Base archive The existing archive that the new archive will be based on, that 
is, the archive currently restored to the working folder.
Tip: In the vault view, the archive currently restored to the 
working folder is shown in green.

Working folder The pathname of the current working folder.

Schematic project file Specifies the DxDesigner .prj file to be stored in the new 
archive.

Layout project files Specifies the PADS Layout .pcb files to be stored in the new 
archive.

Additional files and folders Specifies other files and folders to be stored in the new 
archive.

Name Specifies a description attribute for the new archive.
Tip: Create a name you can search for with the Find in Vault 
tool.

Description Specifies a description attribute for new archive.
Tip: Create a name you can search for with the Find in Vault 
tool.

Templates Click the down arrow to select from a list of choices:
Select—Opens the Templates dialog box, where you can 
select a fileset configuration for the new archive from a list 
of existing templates.
New—Opens the Templates dialog box, where you can 
create a new archive configuration template.
Edit—Opens the Templates dialog box, where you can edit 
a template.
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• You can select the pads individually, by group, or by die part. 

• Selecting a die part lists all pins in the Connection multicolumn list.

• The substrate bond pad of the selected die part is highlighted in the Die Pin# column. 
The BGA pin labels are listed in the BGA Pad column.

Accessing

• BGA Toolbar button > Wire Bond Diagram button > select a BGA pin

Figure 45-2. Add BGA Pin Labels Dialog Box

Table 45-2. Add BGA Pin Labels Dialog Box contents 

Name Description

Die Component Displays the component name.

BGA Component Lists the BGA components available.

Connection list • Die Pin #—Displays the substrate bond pad of the selected 
die part.

• BGA Pad—Lists the BGA pin labels.
Tip: Double-click to edit the label.
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Related Topics

To Add a BGA Pin Label

Opens the Pads for Die Pin Dialog Box.
Restriction: Available only after double-clicking in the BGA 
Pad cell of the Connection list.

Show only pins 
connected to multiple 
BGA pads

Specifies to display only die pins that are connected to multiple 
BGA pin pads in the Connection list.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, or 

any combination of styles: B for bold, I for italic, or U for 
underlined.

Layer The layers available to you on which to place the text.

Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for system 
fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Table 45-2. Add BGA Pin Labels Dialog Box contents (cont.)

Name Description
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Add/Edit CAM Document Dialog Box
Use the Add or Edit Document dialog box to define a CAM document. The only difference 
between the two dialog boxes is that the Edit CAM Document dialog box opens populated with 
the information from the selected document, while the ADD CAM Document dialog box opens 
empty.

Accessing

• File Menu > CAM > Add button

or

• File Menu > CAM > Select a document name > Edit button

Figure 45-3. Add/Edit Document Dialog Box

Table 45-3. Add/Edit Document Dialog Box contents 

Name Description

Document Name The name of the CAM document.
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Document Type When you add a CAM document, you must select the type of 
CAM document that you want to create. Each CAM document 
type has a specific set of options.
Tip: The default settings of the CAM document types may not 
suit your decal layer usage. Always verify the document in the 
CAM Preview window to ensure that all necessary design 
elements are displayed for the type of document you are 
generating.
• Custom—Create your own definition for a document. Use 

the Select Items Dialog Box to specify which objects 
appear in the document.

• CAM Plane—Document CAM Plane layers. CAM planes 
are always solid copper planes in PADS Layout. To 
improve visibility in the work area, CAM planes are 
negative images and take on the background color of 
PADS Layout. In the CAM Preview window options, you 
can invert the negative image of the CAM document. By 
default, conductive elements appear white in the CAM 
Preview window. Layer 25 (125 in extended layer mode) is 
frequently used for CAM plane objects where added 
copper is the opposite - not copper (negative layer). Layer 
25 can also be used for defining the oversize of thermals 
and antipads (an old method), however, the CAM Plane 
custom thermal setting in the Plot Options dialog box is a 
better method. Use the Select Items Dialog Box to add 
layer 25 if needed.

• Routing/Split Plane—Document layers that contain plane 
areas and/or routing. Use this type for Split/Mixed and No 
Plane layers. Conductive elements appear black in the 
CAM Preview window.

• Silkscreen—Document top and bottom silkscreen layers. 
Layer 20 (120 in extended layer mode) is frequently used 
for placement/nudge outlines as an alternative to the 
silkscreen layer outline. Use the Select Items Dialog Box to 
add layer 20 if needed. Silkscreen items appear black in the 
CAM Preview window.

• Paste Mask—Document top and bottom paste mask 
layers. Black areas are paste locations. White is the paste 
mask. Paste is only used for surface mount components. 
Pads of through-hole components are not shown.

• Solder Mask—Document top and bottom solder mask 
layers. Black areas are solder locations. White is the solder 
mask. 

Table 45-3. Add/Edit Document Dialog Box contents (cont.)

Name Description
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Document Type (con’t) • Assembly—Document assembly drawings. Component 
outlines may have been created on the top layer, silkscreen 
layer, and/or layer 20. Use the Select Items Dialog Box to 
add the layers you need. Assembly items appear black in 
the CAM Preview window.

• Drill Drawing—Document drill locations. A drill table is 
added automatically and appears at a location specified in 
the Drill Drawing Options dialog box.

• NC Drill—Generate an NC Drill file. This document is not 
intended for viewing. It contains the x and y location and 
drill size of each hole required in the design. 

• Verify Photo—View and verify any existing CAM 
document. The document to be viewed can be from a 
different design. Verify Photo supports the macros, 
aperture selection, and fill area commands of PADS 
Layout Gerber outputs. Verify Photo plots can only process 
RS-274-X Gerber files created by PADS Layout.

Output File Specifies the name of the CAM output file. Accept the default 
name, or type your preferred name for the output file.

Fabrication Layer The layer on which you will be using CAM350 for post 
processing.
Tip: The Fabrication Layer is only used during conversion to 
the CAM350 database using CAM350 Link.

Summary Displays a summary of the selected CAM document.

Layers button Opens the Select Items Dialog Box.

Options button Opens a dialog box where you can set plot options depending 
on the plot type with which you're working:
• Plot Options—Printer, Pen and photo plots
• Drill Drawing Options—Drill drawings

Restriction: Available from the Plot Options Dialog Box 
only when the Drill Drawing document type is selected.

• NC Drill Options—NC drill output

Assembly button Opens the Select Assembly Variant Dialog Box.

Print button Specifies that you want the document to go to a printer when 
you click Run.

Pen button Specifies that you want to use the Pen Plotter as your output 
when you click Run.

Photo button Specifies that you want to use the Photo Plotter as your output 
when you click Run.

Drill button Specifies that you want to want to use the Drill

Table 45-3. Add/Edit Document Dialog Box contents (cont.)

Name Description
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Related Topics

Creating CAM Outputs to Manufacture Your PCB

Add Chamfered Path Dialog Box
The Add Chamfered Path dialog box opens upon selection of the Chamfered Path - copper 
shape. You set Chamfered Path parameters before you add the copper to the design.

Accessing

• Drafting Toolbar > Copper button > Right-click > Chamfered Path

Tip: You may need to click OK to switch off Design Rule Checking.

Figure 45-4. Add Chamfered Path Dialog Box

Preview Selections 
button

Opens the CAM Preview Dialog Box.

Device Setup button Opens a dialog box where you can set options associated with 
the selected device type, Printer Setup, Pen Plot Setup, Photo 
plot Setup, or NC Drill Setup.

Save As Defaults button Specifies to save your current settings as the defaults for this 
CAM document type and output device.
Tip: This option is useful if you manually build your own drill 
table and want to use this drill table as the default drill table.

Run button Produces the document you just defined.

Set Layers button Opens the Layers Setup Dialog Box.

Table 45-3. Add/Edit Document Dialog Box contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.4878

PADS Layout GUI Reference
Add Class Tasks Dialog Box

Related Topics

Creating Copper Chamfered Paths

Setting Chamfered Path Parameters

Add Class Tasks Dialog Box
See: Add Net Tasks/Add Class Tasks Dialog Box

Add/Edit Command Dialog Box
Use the Add Command dialog box to create commands that you can then use as selections on 
menus or as buttons on toolbars.

Accessing

• Tools menu > Customize > Commands tab > New or Edit button

Table 45-4. Add Chamfered Path Dialog Box contents 

Name Description

Polygon outline width Specifies the width value for the copper outline.
Tip: Since copper is created with an outline and a fill, you can 
specify a very narrow outline width to achieve very sharp 
corners. Decrease the value for sharper corners and increase 
the value for more blunt corners. All corners are rounded with 
a radius equal to one half of the outline width.

Chamfered path width Specifies the width value for the overall width of the copper 
path.

Corner chamfer width 
ratio

Specifies the ratio of the chamfered corner width to the 
chamfered path width. If the ratio is 1.0, the width of the 
chamfered corner is the same as the chamfered path. Reduce 
the ratio for a more narrow chamfered corner.

Chamfer corners with 
angles less than or equal 
to

Specifies an angle between 90 and 180 degrees as the upper 
limit beneath which all angles are chamfered. Outside corners 
less than 90 degrees are always chamfered.
Tip: Click to clear the check box to only chamfer angles less 
than 90 degrees.
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Figure 45-5. Add Command Dialog Box

Table 45-5. Add Command Dialog Box Contents

Name Description

Command name The name of the new command.
Tip: Type an ampersand before the letter you want to use 
as the Alt keyboard shortcut.

Based on The command on which you want to base the new 
command.

Arguments Any arguments for the new command.
Tip: Use a space to separate arguments. If an argument 
contains a space, enclose the argument in quotation marks 
(““).
Restriction: PADS Router only.

Description Lists what the new command does.

Use Default Image Use the recommended image.

Select User-defined Image Select or create your own image to associate with the new 
command.

New Open the Edit Button Image Dialog Box.

Edit Open button in the Edit Button Image Dialog Box.
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Related Topics

Add Component Bond Pad Dialog Box
Use the Add Component Bond Pad dialog box to create new bond pads in your design.

Restriction: This information applies only to the BGA toolkit.

Accessing

• BGA Toolbar button > Wire Bond Editor button > click the BGA > Right-click > 
Add CBP

Figure 45-6. Add Component Bond Pad Dialog Box

Creating a Custom Command

Creating a Custom Menu

Table 45-6. Add Component Bond Pad Dialog Box contents 

Name Description

Pad # Assigns a number to the currently selected component bond 
pad. By default, it is the same number as the substrate bond 
pad to which it is connected.

Function Defines the function of the currently selected bond pad.

Shape list Assigns a shape to the currently selected bond pad. Select 
Rectangle or Oval.

Length Assigns a physical length, in current design units, for the 
currently selected bond pad.
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Related Topics

To Add Component Bond Pads

Add Die Parts Dialog Box
Use the Add Die Parts dialog box to import die parts from Library IQ into PADS Layout.

Restriction: This information applies to only the BGA toolkit.

Accessing

• BGA Toolbar button > Add Die Parts button

Figure 45-7. Add Die Parts Dialog Box

Width Assigns a physical width, in current design units, for the 
currently selected bond pad.

Add button Dynamically attaches the substrate bond pad and wire bond to 
the cursor for placement.

Table 45-6. Add Component Bond Pad Dialog Box contents (cont.)

Name Description
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Related Topics

To Add Die Parts from LIQ

Add Drafting Dialog Box
See: Drafting Properties Dialog Box

Table 45-7. Add Die Parts Dialog Box contents 

Name Description

Preview Area Displays the Library IQ die part selected in the Die Part list.

File The die part filename.

Modified The last modification date.

Chip Bond Pads The number of chip bond pads in the die part.

Substrate Bond Pads The number of substrate bond pads in the die part.

Wire Bonds The number of wire bonds in the die part.

Flip Chip The Flip Chip identification for the die part.

Die Part list Lists all Library IQ die parts in the current folder.

Look in Displays the die part search folder.
Tip: Click Browse to search for the die part folder.

Apply button Sets the die part search folder.

Add >> button Adds the selected Library IQ die parts to the DIE Part Type 
table.

<< Remove button Removes the selected DIE Part from the DIE Part Type table.

Die Part Type column The Library IQ die part to add.

Part Name column The reference designator that is automatically assigned to the 
die part type. To change the reference designator, double-click 
on the part name and type a new name.

Die Outline and Pads Sets the layer on which the die outline and pads appear. Select 
a layer from the list.

Wire Bonds Sets the layer on which the wire bonds appear. Select a layer 
from the list.

Create Nets from Die 
Pad Function Name

Automatically creates nets for pins with matching pin name 
when you add die parts to PADS Layout. The net name 
matches the pin function.
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Add Free Text Dialog Box
Use the Add Free Text dialog box to add free text; text not belonging to another object. When 
you add text, there is an invisible bounding rectangle around the text itself. 

Restriction: Text can only be added one line at a time. See the following topic for a tip on 
saving multiple lines of text to the library for reuse, Creating Reusable Fabrication Notes.

Accessing

• Drafting Toolbar button > Text button

Figure 45-8. Add Free Text Dialog Box

Table 45-8. Add Free Text Dialog Box contents 

Name Description

Text The text string you want to use.
Tip: There is a maximum of 128 characters per text string.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, or 

any combination of styles: B for bold, I for italic, or U for 
underlined.
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Layer The layers available to you on which to place the text.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for system 
fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom 
side of the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to 
ensure proper positioning between objects when text, attribute 
values, size, or width change.
Tips: 
• For vertical justification, click Left, Center, or Right. For 

horizontal justification, choose Up, Center, or Down. 
• Optionally, set justification by selecting the text, then right-

clicking and clicking Justify Horizontally, and then 
clicking Left, Center, or Right; and by right-clicking and 
clicking Justify Vertically, and then clicking Up, Center, 
or Down.

Defaults Restores the PADS Layout default settings.

Clearance Specifies clearance values between the text and objects around 
it.

Table 45-8. Add Free Text Dialog Box contents (cont.)

Name Description
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Related Topics

Adding Free Text

Add Net Tasks/Add Class Tasks Dialog Box
You can run specific electrodynamic checks on nets or classes.

Accessing

• Tools menu > Verify Design > High Speed check > Setup button > Add Nets button

or

• Tools menu > Verify Design > High Speed check > Setup button > Add Classes 
button

Figure 45-9. Add Net Tasks/Add Class Tasks Dialog Box

Related Topics

Adding Nets or Classes for Specific High-Speed Checks

Add Net to Class Dialog Box
Use the Add Net to Class dialog box to create a collection of nets to which you can assign a 
common set of design rules.

Table 45-9. Add Net Tasks/Add Class Tasks Dialog Box contents 

Name Description

Nets/Classes list Lists the nets or classes available in the design.
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Accessing

• Select one or more nets > Right-click > Make Class

Figure 45-10. Add Nets to Class Dialog Box

Related Topics

Creating Class Design Rules

Add New Attribute to Library Dialog Box
Use the Add New Attribute to Library dialog box to set name and value properties when adding 
new attributes to libraries.

Accessing

• File menu > Library > Library Manager dialog box > Attr Manager button > Add 
Attr button

Table 45-10. Add Nets to Class Dialog Box 

Name Description

Create New Class Specifies to make a new class for the selected nets.

Add to Existing Class Specifies to add the selected nets to an existing class.

Selected Nets Lists all nets selected in the design.

Add to Class: Specifies the name of the new class.
Tip: This is unavailable if Add to Existing Class is selected.

Existing Classes: Lists the classes available in which to add the selected nets.
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Figure 45-11. Add New Attribute to Library Dialog Box

Related Topics

Add New Decal Label Dialog Box
Use the Add New Decal Label dialog box to create attribute labels for decals.

Accessing

• Tools menu > PCB Decal Editor > Drafting button > Add New Label button > select 
a decal

Table 45-11. Add New Attribute to Library Dialog Box Contents 

Name Description

Browse Lib. Attr Opens the Browse Library Attributes Dialog Box.

Attribute Name The name of the new attribute.

Attribute Value The value of the new attribute.

Adding an Attribute to Multiple Library Items

Library Manager Dialog Box

Part Information Dialog Box, Attributes Tab
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Figure 45-12. Add New Decal Label Dialog Box

Table 45-12. Add New Decal Label Dialog Box Contents 

Name Description

Attribute The attributes available to you. If you are creating labels 
for jumpers, Reference Designator is the only available 
attribute.
Tip: Hidden attributes do not appear in the Attribute list 
unless the attribute was selected for the label before it was 
set as a hidden attribute.
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Value for The value of the selected attribute. 
Tips:
• Unavailable if you selected Reference Designator or 

Part Type from the Attribute list, if the attribute is 
read-only, or if you open the Properties dialog box for 
labels of different attribute types. However, if the 
labels you select belong to attributes of the same type, 
you can edit this box.

• If the attributes have different values, the box is blank. 
You can type a new value in the box to apply it to all 
of the selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-
registered and PADS Layout is not in ECO mode. 

Show Controls the visibility of the label. 
• None—Turns visibility off.
• Value— Displays only the label value.
• Name and Value—Displays the name and value.
• Full Name and Value—When labeling a  structured 

attribute, displays the full structured name and value.
Tip: Labels are invisible regardless of this setting unless 
you use the Display Colors Setup Dialog Box to change 
the color of labels to a color different from that of the 
background.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, 

or any combination of styles: B for bold, I for italic, or 
U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the 
component or the jumper. If you clear this check box, the 
label is placed at the X and Y location relative to the 
design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Table 45-12. Add New Decal Label Dialog Box Contents (cont.)

Name Description
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Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for 
system fonts
Size (mils): This is font character height and appears for 
stroke fonts. The size refers to the height of the tallest 
characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the 
bottom side of the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to 
ensure proper positioning between objects when text, 
attribute values, size, or width change.
Tips: 
• For vertical justification, click Left, Center, or Right. 

For horizontal justification, choose Up, Center, or 
Down. 

• Optionally, set justification by selecting the text, then 
right-clicking and clicking Justify Horizontally, and 
then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then 
clicking Up, Center, or Down.

Right reading Controls whether labels are readable (from left to right, or 
from bottom to top if the label is rotated). Click the None, 
Orthogonal, or Angled button to indicate the direction of 
reading you want.

Table 45-12. Add New Decal Label Dialog Box Contents (cont.)

Name Description
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Related Topics

Creating Attribute Labels in the PCB Decal Editor

Add New Part Label Dialog Box
Use the Add New Part Label dialog box to create attribute labels, part type labels, and reference 
designator labels for components or jumpers. 

Tips:

• Reference designator is the only label available for use when you are creating labels for 
jumpers.

• If you don't set visibility information, default positions are used. 

See also: Label Defaults

• Unlike free text, when you add a label, there is no invisible bounding rectangle around 
the label itself.

Accessing

• Select a part > Right-click > Add New Label
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Figure 45-13. Add New Part Label Dialog Box

Table 45-13. Add New Label Dialog Box Contents 

Name Description

Attribute The attributes available to you. If you are creating labels 
for jumpers, Reference Designator is the only available 
attribute.
Tip: Hidden attributes do not appear in the Attribute list 
unless the attribute was selected for the label before it was 
set as a hidden attribute.
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Value for The value of the selected attribute. 
Tips:
• Unavailable if you selected Reference Designator or 

Part Type from the Attribute list, if the attribute is 
read-only, or if you open the Properties dialog box for 
labels of different attribute types. However, if the 
labels you select belong to attributes of the same type, 
you can edit this box.

• If the attributes have different values, the box is blank. 
You can type a new value in the box to apply it to all 
of the selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-
registered and PADS Layout is not in ECO mode. 

Show Controls the visibility of the label. 
• None—Turns visibility off.
• Value— Displays only the label value.
• Name and Value—Displays the name and value.
• Full Name and Value—When labeling a  structured 

attribute, displays the full structured name and value.
Tip: Labels are invisible regardless of this setting unless 
you use the Display Colors Setup Dialog Box to change 
the color of labels to a color different from that of the 
background.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, 

or any combination of styles: B for bold, I for italic, or 
U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the 
component or the jumper. If you clear this check box, the 
label is placed at the X and Y location relative to the 
design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Table 45-13. Add New Label Dialog Box Contents (cont.)

Name Description
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Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for 
system fonts
Size (mils): This is font character height and appears for 
stroke fonts. The size refers to the height of the tallest 
characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the 
bottom side of the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to 
ensure proper positioning between objects when text, 
attribute values, size, or width change.
Tips: 
• For vertical justification, click Left, Center, or Right. 

For horizontal justification, choose Up, Center, or 
Down. 

• Optionally, set justification by selecting the text, then 
right-clicking and clicking Justify Horizontally, and 
then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then 
clicking Up, Center, or Down.

Right reading Controls whether labels are readable (from left to right, or 
from bottom to top if the label is rotated). Click the None, 
Orthogonal, or Angled button to indicate the direction of 
reading you want.

Table 45-13. Add New Label Dialog Box Contents (cont.)

Name Description
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Related Topics

Adding a New Part Label

Add Pin Dialog Box
Use the Add Pin dialog box to select specific pins to add to the Pin: Plated: list in the Pad 
Stacks Properties dialog box.

Accessing

• Setup menu > Pad Stacks > select a Decal or Via > click the Add button under the Pin: 
Plated: box.

Figure 45-14. Add Pin Dialog Box
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Add Pin Pairs to Group Dialog Box
Use the Add Pin Pairs to Group dialog box to create a collection of pin pairs with a common set 
of design rules. 

Accessing

• Select pin pairs > Right-click > Make Group

Figure 45-15. Add Pin Pairs to Group Dialog Box

Table 45-14. Add Pin Dialog Box Contents

Name Description

Pin list Select the specific pin(s) you want to add to the Pin: 
Plated: list in the Pad Stacks Properties Dialog Box. The 
pins will be listed individually and can be deselected once 
added to the Pin: Plated: list if you choose not to give 
them the all the same pad stacks.
• Ctrl+Click multiple items
• Shift+click for a range of items
• Click and drag for a range of items

Select odd/Select even You can use these buttons as a shortcut to select all the 
odd or even pins in the Pin List.

Table 45-15. Add Pin Pairs to Group Dialog Box 

Name Description

Create New Group Specifies to make a new group for the selected pin pairs.

Add to Existing Group Specifies to add the selected pin pairs to an existing group.
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Related Topics

Creating Group Design Rules

Add Pins Dialog Box
Use the Add Pins dialog box to add pins to a part type. 

Accessing

• File menu > Library > select a Library > Parts button > New button > Pins tab > Add 
Pins button

or

• File menu > Library > select a Library > Parts button > select a part > Edit button > 
Pins tab > Add Pins button

Figure 45-16. Add Pins Dialog Box

Selected Pin Pairs Lists all pin pairs selected in the design.

Add to Group: Specifies the name of the new group.
Tip: This is unavailable if Add to Existing Group is selected.

Existing Group: Lists the groups available in which to add the selected pin 
pairs.

Table 45-15. Add Pin Pairs to Group Dialog Box (cont.)

Name Description
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Related Topics

Adding a Series of Pins to the Pins Table

Add Substrate Bond Pad Dialog Box
Use the Add Substrate Bond Pad dialog box to create new bond pads in your design.

Restriction: This information applies only to the BGA toolkit.

Accessing

• BGA Toolbar button > Wire Bond Editor button > click the BGA > Right-click > 
Add SBP

Table 45-16. Add Pins Dialog Box Contents 

Name Description

Number of pins Specifies the number of pins to add using the Add Pins 
dialog box.

Prefix The prefix you want for your pins.
Tips: 
• Alphabetic and numeric values can be used. For 

example, A1 or 1A.
• For a single numeric, use either Prefix or Suffix box, 

and void the other box.

Suffix The suffix you want for your pins.
Tips: 
• Alphabetic and numeric values can be used. For 

example, A1 or 1A.
• For a single numeric, use either Prefix or Suffix box, 

and void the other box.

Pin numbers A preview of pin numbers based on your input in the 
Prefix and Suffix boxes.

Increment prefix/Increment 
suffix

Indicates whether you want the prefix or the suffix to 
increment.

Step value A positive or negative number by which to increase or 
decrease the pin numbers with consecutive or stepped 
values.

Verify valid JEDEC pin 
numbering

Ensures that legal alphanumeric values are used.
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Figure 45-17. Add Substrate Bond Pad Dialog Box

Related Topics

To Add Substrate Bond Pads

Add/Rename SBP Ring Dialog Box
Use the Add SBP Ring dialog box to add a ring for the substrate bond pads.

Table 45-17. Add Substrate Bond Pad Dialog Box contents 

Name Description

Pin Name Assigns a pin name to the currently selected substrate bond 
pad. 

Function Defines the function of the currently selected bond pad.

Layer list Lists all the electrical layers for creating SBPs, so you can 
create an SBP on a specific layer. 

Length Assigns a physical length, in current design units, for the 
currently selected bond pad.

Width Assigns a physical width, in current design units, for the 
currently selected bond pad.

Add button Dynamically attaches the substrate bond pad and wire bond to 
the cursor for placement.
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Figure 45-18. Add SBP Ring Dialog Box

Add Terminals Dialog Box
Use the Add Terminals dialog box to associate pads or pins with a decal. 

Accessing

• Tools menu > PCB Decal Editor > Drafting Toolbar button > Terminals button

Figure 45-19. Add Terminals Dialog Box

Table 45-18. Add SBP Ring Dialog Box Contents

Name Description

Text box Enter the name of the ring as you want it to appear in the Wire Bond 
Wizard dialog box.
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Related Topics

To Add a Terminal

Align Parts Dialog Box
Use the Align Parts dialog box to align selected objects along the left side, right side, vertical 
center, top, bottom, or horizontal center. 

Accessing

• Select the parts you want to align > right-click > Align

Table 45-19. Add Terminals Dialog Box Contents 

Name Description

Prefix The prefix you want for your pins.
Tips: 
• Alphabetic and numeric values can be used. For 

example, A1 or 1A.
• For a single numeric, use either Prefix or Suffix box, 

and void the other box.

Suffix The suffix you want for your pins.
Tips: 
• Alphabetic and numeric values can be used. For 

example, A1 or 1A.
• For a single numeric, use either Prefix or Suffix box, 

and void the other box.

Pin numbers A preview of pin numbers based on your input in the 
Prefix and Suffix boxes.

Increment prefix/Increment 
suffix

Indicates whether you want the prefix or the suffix to 
increment.

Step value A positive or negative number by which to increase or 
decrease the pin numbers with consecutive or stepped 
values.

Use JEDEC pin numbering Ensures that legal alphanumeric values are used.
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Figure 45-20. Align Parts Dialog Box

Related Topics

To Align Objects

Archive Navigator Options Dialog Box
Use the Options dialog box to set the display format and display order of the archives in the 
Vault view.

Table 45-20. Align Parts Dialog Box 

Name Description

Aligns selected items vertically along the left edge.

Aligns selected items vertically through the middle.

Aligns selected items vertically along the right edge.

Aligns selected items horizontally across the top.

Aligns selected items horizontally through the middle. 

Aligns selected items horizontally across the bottom.



PADS Layout GUI Reference
Archive Navigator Options Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 903

Accessing

• Vault view > Options button

Figure 45-21. Archive Navigator Options Dialog Box

Table 45-21. Archive Navigator Options Dialog Box Contents

Name Description

Archive display format Specifies how archives should be listed in the vault view tree, 
as follows:
• Select Archive Id to display only the assigned archive ID 

(Archive 1, Archive 2, ...).
• Select Archive Id - Name to display the archive ID and the 

optional archive Name.
• Select [Creation Date/Time] Archive Id to display the 

archive creation date & time and the archive ID.
• Select [Creation Date/Time] Archive Id - Name to 

display the archive creation date & time, the archive ID, 
and the optional archive Name.
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Related Topics

Setting Display Options in the Vault View

Archive Navigator Window
Use the Archive Navigator window to:

• Create, organize and manage your PCB project archives.

• Work with the files in an archive. 

The Archive Navigator window has two views:

• The Vault view, where you view and manage vaults, folders, projects and archives.

• The Working Folder view, where you view and work with the files in the current 
working folder.

Accessing

• Tools menu > Archive Navigator

Archive filters Specifies which archives should be displayed in the Vault 
view, as follows:
• User drop-down list—Select a user to display all archives 

whose User attribute contains that user name. If no user is 
selected, archives with any user name are returned.

• Created from—Select this checkbox and specify a 
date/time to display all archives created after the specified 
date/time.

• Created to    —Select this checkbox and specify a 
date/time to display all archives created up to the specified 
date/time.

Archive order Specifies the order in which archives are displayed in the Vault 
view, as follows:
• Archive Id—Orders by assigned archive ID (Archive 1, 

Archive 2, ...).
• Creation Date/Time ascending—Orders by creation 

date/time, most recent at the bottom.
• Creation Date/Time descending—Orders by creation 

date/time, most recent at the top.

Table 45-21. Archive Navigator Options Dialog Box Contents

Name Description
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Related Topics

Adding a Project Container to the Vault

Archive Navigator Vault View
Use the Archive Navigator Vault view to view and manage vaults, folders, projects and 
archives.

Figure 45-22. The Archive Navigator Vault View
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Vault View Operations
You can perform the following operations on items in the vault view tree:

Table 45-22. Archive Navigator Vault View Contents 

Name Description

  Find in Vault
Opens the Find in Vault dialog box, where you can search the 
vault for projects and archives.

  Options
Opens the Options dialog box, where you can specify how 
archives are displayed in the vault view tree.

  Refresh Vault
Redisplays the current contents of the vault.

  Select Vault
Opens the Select Vault dialog box, where you can select a 
different vault, or create a new one.

Name
Created
User
Description

Displays the attributes of the item selected in the vault view 
tree:

Name—The system generated archive ID (and optionally 
the user-supplied archive name)
Created—The date and time when the archive was created
User—The user who created the archive
Description—The user-supplied description of the archive

Vault View tree area Displays the vault’s hierarchy of projects, folders, and 
archives.
Tip: The archive currently restored to the working folder is 
highlighted in green.

Vaults Create a new vault. See Creating a Vault.

Create a new empty project in the 
vault.

Select vault, right-click > Create Empty 
Project

Create a new folder in the vault. Select vault, right-click > Create folder

Filter the display of archives in the 
vault.

See Setting Display Options in the Vault 
View.

Set the display order and format of 
archives in the vault.

See Setting Display Options in the Vault 
View.

Folders Create a new empty project in the 
folder.

Select folder, right-click > Create Empty 
Project

Create a new folder in the folder. Select folder, right-click > Create Folder

Move or copy a folder to a new 
location in the vault.

Select folder, right-click > Move to or 
Copy to
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Related Topics

Creating a Vault

Adding a Project Container to the Vault

Creating a Vault Folder

Changing Vaults

Deleting Items from the Vault

Viewing and Editing Properties of a Vault Item

Setting Display Options in the Vault View

Viewing the Contents of an Archive

Finding Projects or Archives in the Vault

Archive Navigator Working Folder View
Use the Working Folder window to view and work with the files and folders in the current 
working folder.

Delete the folder from the vault. Select folder, right-click > Delete

Projects Set or clear the working folder for 
the project.

Right-click the working folder > Set 
Working Folder or Clear Working Folder

Delete the project from the vault. Select project, right-click > Delete

Move or copy a project to a new 
location in the vault.

Select project, right-click > Move to or 
Copy to

Edit a project’s templates. Select project, right-click > Edit 
Templates

View the properties of the project. Right-click the project > Properties

Archives View the contents of an archive. Right-click the archive > View Content

Restore an archive to the working 
folder.

Right-click the archive > Restore

Delete an archive from the vault. Right-click the archive > Delete

View the properties of an archive. Right-click the archive > Properties
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Figure 45-23. Archive Navigator Working Folder View

Related Topics

Adding a Project Container to the Vault

Adding an Archive to the Vault

Creating an Archive Template

Restoring an Archive to the Working Folder

Table 45-23. Archive Navigator Working Folder View Contents 

Name Description

 Add archive to Vault
Opens the Add Archive to Vault dialog box, where you define 
and save an archive of the current state of the working folder.

  Refresh working Folder
Redisplays the working folder list, showing the current 
contents.

  Folder up
Opens the parent folder of the folder currently open.
Restriction: You cannot go above the working folder.

List area Displays the contents of the working folder. Double-click on 
any item to open it, as follows:
• Folders are opened in the Working Folder view.
• .pcb files are opened in the current PADS Layout instance.
• Other files are opened in the application associated with the 

file type.
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Archive Navigator Status Bar
The Status Bar displays the state of the Archive filters and Archive order controls in the Options 
Dialog box. 

Figure 45-24. Archive Navigator Status Bar

See the Archive Navigator Options Dialog Box topic for a description of these settings.

Archive Properties Dialog Box
Use the Archive Properties dialog box to view and edit an Archive Navigator archive’s 
properties.

Accessing

• In the Archive Navigator Vault view, right-click an archive, and click Properties.

Figure 45-25. Archive Properties Dialog Box
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Archiver Dialog Box
Use the Archiver dialog box to create archives of your designs, projects, files and folders, and 
libraries. 

Accessing

• File menu > Archive

Table 45-24. Archive Properties Dialog Box Contents

Name Description

Id The system-generated archive ID

Name Specifies a name attribute for the archive.
Tip: Create a name you can search for with the Find in Vault 
tool.

Created The date/time when the archive was created

User The user who created the archive

Description Specifies a description attribute for the archive.
Tip: Create a description you can search for with the Find in 
Vault tool.
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Figure 45-26. Archiver Dialog Box

Table 45-25. Archiver Dialog Box 

Name Description

PCB Design Specifies the location and name of the PCB design you want to 
archive. This is automatically populated with the information 
from the current design. To change the design, or if no design 
was opened, type the location or click the Browse button.

Select Create PDF to create a PDF file of the PCB design.
Restriction: This is unavailable if the file you chose is 
different from the current design.
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Related Topics

Archiving Your Design

Archiver: Additional Files Dialog Box
Use the Archiver: Additional dialog box to add files and folders to the design you want to 
archive.

Accessing

• File menu > Archive > Additional Files check box > Browse button

Schematic Specifies the location and name of the schematic file you want 
to archive. To choose the file you want, type the location or 
click the Browse button.

Select Create PDF to create a PDF file of the schematic file.
Restriction: This is only available if you chose a DxDesigner 
file; it is unavailable if you chose a PADS Logic file.

Add libraries Specifies that you want to include libraries in the archive.
• All—Add all of your libraries to the archive.
• Select—Add only the libraries you specify. 

Click the Browse button to open the Archiver: Libraries 
dialog box.

Additional files Specifies that you want to include other files and folders in 
your archive. Click the Browse button to open the Archiver: 
Additional Files dialog box.

Target folder Specifies where you want the archive to be located. Type the 
path or click the Browse button.
Restriction: If the Compress using zip format checkbox is 
unchecked, the target folder must be empty.

Compress using zip 
format

Specifies to create a zip file. The filename will be in the 
following format:

<project_name>YYYYMMDDHHMMSS.zip

Where YYYY is the year, MM is the month, DD is the day, 
HH is the hour - in military time, MM is the minute, and SS is 
the second of the exact time you created the file.

Table 45-25. Archiver Dialog Box (cont.)

Name Description
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Figure 45-27. Archiver: Additional Files Dialog Box

Related Topics

Archiving Your Design

Archiver: Libraries Dialog Box
Use the Archiver: Libraries dialog box to add libraries to the design you want to archive.

Accessing

• File menu > Archive > Add libraries check box > Select > Browse button

Table 45-26. Archiver: Additional Files Dialog Box 

Name Description

Additional files list Lists the files and folders you want to include in your archive.

Add File button Opens the Additional File dialog box where you can select 
individual files you want to add to the Additional files list.

Add folder button Opens the Browse for Folder dialog box where you can select 
an entire folder to add to the Additional files list.

Remove button Removes the selected file or folder from the Additional files 
list.

Remove All button Removes all of the files and folders from the Additional files 
list.
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Figure 45-28. Archiver: Libraries Dialog Box

Related Topics

Archiving Your Design

Arrow Properties Dialog Box
The Arrow Properties dialog box displays coordinate information for the selected arrow and 
provides several areas for modifications.

Table 45-27. Archiver: Libraries Dialog Box 

Name Description

Available libraries Lists all of the libraries available for you to add to the archive.
Restriction: If your library is not listed in the Library 
Manager, it will not appear in this list.

Add >> button Moves the selected library from the Available libraries list to 
the Selected libraries list.

<< Remove button Moves the selected library from the Selected libraries list to the 
Available libraries list.

Add all >> button Moves all of the libraries from the Available libraries list to the 
Selected libraries list.

<< Remove all button Moves all of the libraries from the Selected libraries list to the 
Available libraries list.
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The Arrow Properties dialog box remains open until you click OK or Cancel. Selecting another 
arrow while the dialog box is open updates the information for the selected object.

Accessing

• Select an arrow > right-click > Properties.

Figure 45-29. Arrow Properties Dialog Box

Table 45-28. Arrow Properties Dialog Box contents 

Name Description

X and Y values Displays the X and Y coordinate locations of the selected 
object(s).

Parent button Opens the Dimension Properties Dialog Box for the dimension 
object with which the selected object is associated.

Layer list Lists the current working layer. Select a new layer from the list 
to change it.

Tail Length Specifies the current minimum length of the arrow tail, which 
is the line extending beyond the arrow. Type a new value to 
change the tail length.

Indicates the current arrow type. Click an alternate button to 
modify.

Text Gap Specifies the current spacing between the tail and the 
measurement text. Type a new value to change the spacing.

Line Width Lists the current line width of the tail and arrow lines. Type a 
new value to change the line width.
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Related Topics

Moving Dimensions and Dimension Objects

ASCII Output Dialog Box
You can use ASCII files to exchange design data between PADS Layout and external 
translators or previous versions of PADS Layout.

Accessing

• File menu > Export > Select ASCII Files type > Save

Figure 45-30. ASCII Output Dialog Box

Arrow Size Lists the current arrow width, which is the height of the arrow. 
Type a new value to change the width.

Arrow Length Lists the current arrow length, which is the measurement 
between the arrow tip and the end of the arrow. Type a new 
value to change the arrow length.

Table 45-28. Arrow Properties Dialog Box contents (cont.)

Name Description
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Exported Item Descriptions
The following table provides descriptions for each item in the Sections area of the ASCII 
Output dialog box: 

Table 45-29. ASCII Output Dialog Box Contents 

Name Description

File The name of the file you are exporting.

Sections Specifies the sections of the ASCII file you want to 
export.
See also: Exported Item Descriptions

Select All Selects all items in the Sections list.

Unselect All Unselects all items in the Sections list.

Format Specifies the format of the ASCII file.
Tips:
• Use PowerPCB V3.0 to export to both PowerPCB and 

PowerBGA V3.0 ASCII formats.
• PADS Layout does not export to PADS-Perform 6 

ASCII format.

Units Specifies the units to export.
Tip: If you plan to use the ASCII file for an external 
translator or another ASCII-reading program, select 
Current. If you plan to re-import the ASCII file and save it 
as a .pcb database, select Basic. Basic units represent how 
values are stored in the software. They do not use standard 
units of measure, but they record precise positioning 
values for database items.

Parts Specifies that you want to export attributes assumed from 
higher levels in the attribute hierarchy.

Nets Specifies that you want to export attributes assumed from 
higher levels in the attribute hierarchy.

Table 45-30. ASCII Output Item Descriptions 

Item Exported information

PCB 
Parameters

Global design information, such as units and colors

Reuse Elements in, and the definition of, a physical design reuse

Text Text



PADS Layout User’s Guide and Reference Manual, PADS 9.4918

PADS Layout GUI Reference
ASCII Output Dialog Box

Related Topics

Exporting ASCII Files

Importing and Exporting Files

Lines Two-dimensional (2D) lines

Clusters Clusters and unions

Vias Vias (including dangling vias), jumpers, and padstacks

Decals Footprints

Packages Electrical information

Parts Component instances

Jumpers Jumpers
Tip: If you plan to export to the PowerPCB V1.1 ASCII format, you 
cannot output complete jumper information. This is because PADS 
Layout considers jumper pins as vias and jumpers are exported as vias 
when you select the Vias check box.

Connections Unrouted pin pairs

Routes Traces, including route loops

Teardrops Teardrops
Tip: If you plan to export to the PowerPCB V1.1 ASCII format, you 
cannot output teardrops.
Requirement: You must export routes to export teardrops.

Miscellaneou
s

Information not included in other items

Rules Clearance, routing, and high-speed rules

CAM Information related to plot file configurations generated using CAM

Pour Copper pours

Assembly 
Options

Assembly variants

Test Points Test points and the test side (top, bottom, or both)

Attributes Attribute Dictionary and all individual attributes and value assignments 
in the design.
Status of attributes (read-only, system, ECO-registered, or hidden).
Attributes are exported to the extent possible for formats previous to 
V3.0. Previous versions do not support all of the default attributes.
Tip: Values through the attribute hierarchy are not exported.

Table 45-30. ASCII Output Item Descriptions (cont.)

Item Exported information
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Assembly Variants Dialog Box
Use the Assembly Variants dialog box to create a new variant, review or edit a variant, preview 
variants, delete variants, and create reports for variants.

Accessing

• Tools menu > Assembly Variants

Figure 45-31. Assembly Variants Dialog Box

Table 45-31. Assembly Variants Dialog Box contents 

Name Description

Type list Specifies what displays in the table: Assembly Variants or 
Components.

Display list Filters the Variant table based on your selection: All, Installed, 
No Installed, Substituted.

Verb mode Specifies what action to take and perform on components in 
the Layout Editor (outside the dialog box): Install, Uninstall, 
Substitute, No.

Name Specifies the name of the Assembly Variant or the Component 
you want listed in the table.
Tip: Changes depending on the selection made in the Type 
list. 

New Variant’s name Specifies the name of the new variant, up to 26 characters.



PADS Layout User’s Guide and Reference Manual, PADS 9.4920

PADS Layout GUI Reference
Assign CBPs to Rings Dialog Box

Related Topics

Using the Assembly Variants Dialog Box

Assign CBPs to Rings Dialog Box
Restriction: This information applies only to the BGA toolkit.

Use this dialog box to specify which component bond pads to wire bond to which ring. You can 
view this placement in preview mode.

Accessing

• BGA Toolbar button > Wire Bond Wizard button > Assign CBPs button

Status area Specifies the status for the selected variant: Installed, Not 
installed, Substituted. 
Tip: If you click Substituted, the Variant/Substitute Dialog 
Box opens.

Edit button Opens the Variant/Substitute Dialog Box.
Restriction: Unavailable unless the component has already 
been substituted.

Preview button Opens the Preview for dialog box.

Create button Creates a new variant and adds it to the Name list.

Delete button Removes the selected variant from the Name list.

Reports button Opens the Reports Dialog Box.

Variant/Components 
table

Lists the name and status of the variants or components 
selected in the Name list.
Tip: Changes depending on the selection made in the Type 
list. 

Table 45-31. Assembly Variants Dialog Box contents (cont.)

Name Description
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Figure 45-32. Assign CBPs to Rings Dialog Box

Table 45-32. Assign CBPs to Rings Dialog Box contents 

Name Description

View by Select an option for viewing the component bond pad data in 
the CBP list: CBP, CBP Function, SBP Function.

Show Only Unassigned 
CBPs

Displays only the unassigned component bond pads in the CBP 
list.

Show Only CBPs for 
Selected Sides

Displays only component bond pads specified in the Generate 
Fanout for area of the Wire Bond Wizard Dialog Box. If you 
do not select this option, the list displays all component bond 
pads, no matter what the current settings are in the Generate 
Fanout for area.
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Related Topics

To Assign CBPs to Rings

Assign Color to All Layers Dialog Box
Use the Assign Color to All Layers dialog box to make objects visible, or make objects 
invisible, in a design.

Accessing

• Setup menu > Display Colors > Assign All button

CBP column Displays the CBP number.
Restriction: Displayed only when CBP is selected from the 
View by list.

CBP Function column Component bond pad function.
Restriction: Displayed only when CBP or CBP Function is 
selected from the View by list.

SBP Function column Substrate bond pad function.
Restriction: Displayed only when CBP or SBP Function is 
selected from the View by list.

CBP Count The component bond pad count for each bond pad function.
Restriction: Displayed only when CBP Function or SBP 
Function is selected from the View by list.

Select All button Selects all component bond pads in the CBP list to assign to 
the currently selected rings.

Invert Selected button Inverts all selections currently in the list. If one item is 
currently selected, this button will deselect that one item and 
select all other items instead.

Assign to area Use to select the ring or rings to which you want the selected 
component bond pad or pads assigned. You can select multiple 
rings at a time for component bond pad assignment.

Apply button Applies your settings for assigning component bond pads to 
rings. Also clears the selections in the Assign to list. It does not 
close the Assign CBPs to Rings Dialog Box, so you can 
continue to make assignments.

Table 45-32. Assign CBPs to Rings Dialog Box contents (cont.)

Name Description
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Figure 45-33. Assign Color to All Layers Dialog Box

Table 45-33.  Assign Color to All Layers Dialog Box Contents 

Name Description

Automatically Make 
Objects Visible

Specifies to make objects visible.

Color Preference Specifies the way you want to make objects visible in a 
design.:
• One Color per Object Type—Assigns color for a 

certain object type, when it is currently set to the 
background color, on all layers. The program assigns 
color according to the color set in the immediately 
adjacent tile, or, if no adjacent tile exists, according to 
color palette order.

• One Color for a Layer—Assigns color for all objects, 
when they are currently set to the background color, on 
the same layer. The program assigns color according 
to the color set in the immediately adjacent tile, or, if 
no adjacent tile exists, according to color palette order.

• Selected Color—Assigns the color you select from 
the Display Colors Setup dialog box color palette to all 
objects, which are currently set to the background 
color, on all layers.

Update Visibility Check 
Boxes

Specifies that the visibility check boxes surrounding the 
color matrix are selected if data exists on a layer, and clear 
if no data exists on a layer.

Update Enabled Status Specifies color assignment based on layer settings in the 
Enable/Disable Layer dialog box. When you select this 
option, nonelectrical layers that do not contain data are 
disabled.
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Related Topics

Setting Colors of Objects in the Display

Assign Decal to Gate Dialog Box
Use the Assign Decal to Gate dialog box to assign default and alternative CAE decals to gates.

Tip: This dialog box works similarly to the PCB Decals tab on the Part Information dialog box, 
except that it deals with logic decals instead of PCB decals.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Gates tab > double-click CAE Decal cell > Browse button

Figure 45-34. Assign Decal to Gate Dialog Box

Assign Background Color 
to All Objects

Specifies to make all objects on all layers invisible by 
changing the color of all objects, on all layers, to the 
current background color.

Table 45-34. Assign Decal to Gate Dialog Box Contents 

Name Description

Library list Lists all libraries available to you.

Table 45-33.  Assign Color to All Layers Dialog Box Contents (cont.)

Name Description
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Related Topics

Assigning CAE Decals to Gates

Assign New Gate Decal Dialog Box
Use the Assign New Gate dialog box to assign a new gate decal when it doesn’t yet exist in the 
Library.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Gates tab > double-click CAE Decal cell > Browse button > Assign New

Filter Narrows down your Unassigned decals list. 
Tip: You can use wildcards in this box.

Pin Count Lists the pin count for the selected gate.

Apply Executes the filter arguments.

Preview area Shows the selected Decal.

Unassigned Decals list Lists all unassigned decals available to assign to the 
selected gate in the selected library.

Assign New Opens the Assign New Gate Decal Dialog Box, where you 
can enter the name of the new decal for the gate.

Assign >> Moves the selected decal from the Unassigned Decals list 
to the Assigned Decals list.

<< Unassign Moves the selected decal from the Assigned Decals list to 
the Unassigned Decals list.

Assigned Decals list Lists all assigned decals to the selected gate in the selected 
library.

Up/Down Moves the selected Decal up or down.

Table 45-34. Assign Decal to Gate Dialog Box Contents (cont.)

Name Description
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Figure 45-35. Assign New Gate Decal Dialog Box

Assign New PCB Decal Dialog Box
Use the Assign New PCB Decal dialog box to assign a new PCB Decal when it doesn’t yet exist 
in the Library.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > PCB Decals tab > Assign New

Figure 45-36. Assign New PCB Decal Dialog Box

Table 45-35. Assign New Gate Decal Dialog Box Contents

Name Description

Text box Enter the name of the new gate decal you intend to add to the library.

Table 45-36. Assign New PCB Decal Dialog Box Contents

Name Description

Text box Enter the name of the new PCB decal you intend to add to the library.
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Assign Pin Numbers Dialog Box
If you update a part type from the library and there is a change in pin numbers, you must 
reassign connections to the new decal pin numbers. Use the Assign Pin Numbers dialog box to 
correctly map old decal connections to new decal connections.

Accessing

• This dialog box opens when you perform a task that can change the number of pins, such 
as changing a component or updating a part type from the library.

Figure 45-37. Assign Pin Numbers Dialog Box

Table 45-37. Assign Pin Numbers Dialog Box contents 

Name Description

Net name column Displays the net connected to the existing decal pin numbers - 
listed in the Old column.

Old Displays the existing pin number connected to the net.
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Related Topics

Updating a Part Type from the Library in ECO Mode

Changing a Component in ECO Mode

Assign Shortcut Dialog Box
Create a new shortcut key with using the Assign Shortcut dialog box.

Accessing

• Tools menu > Customize > Keyboard and Mouse tab > New button

New Specifies the new pin number connected to the net.
Tip: If a pin has a signal assigned to it in the part type, the 
signal will be shown after the pin name, in brackets. New decal 
pin numbers are matched where possible. If no match exists, 
the cell in the New column will be empty and/or a pin number 
will be listed in the Unassigned Pins list.

Unassign Moves the selected new pin(s) to the Unassigned Pins list

Assign Moves the selected unassigned pin(s) to the selected new pin 
cell(s). Assignment of pin numbers begins with the first 
selected cell in the New column.

Unassigned Pins list Lists all unassigned pins associated with this component.
Tip: If a pin has a signal assigned to it in the part type, the 
signal will be shown after the pin name, in brackets.

Use current pin map for 
other components

Specifies to use this pin mapping for all other components. If 
you clear this check box, you are prompted to change the pin 
mapping for other selected components in the design. You may 
not cancel without canceling the entire operation.

Table 45-37. Assign Pin Numbers Dialog Box contents (cont.)

Name Description
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Figure 45-38. Assign Shortcut Dialog Box

Associated Net Rules Dialog Box

Use the Associated Net Rules dialog box to select a list of associated nets and:

• Assign HiSpeed rules to them, or

• Clear all rules defined for them.

Accessing

• Setup menu > Design Rules > Associated Nets button
or
Select an associated net > right-click > Show Rules

Table 45-38. Assign Shortcut Dialog Box Contents

Name Description

Press new shortcut key Type the shortcut you want to use.

Select a pointer event Set a pointer event shortcut

Similar shortcuts list Lists the shortcut keys already assigned to other 
commands.
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Figure 45-39. Associated Net Rules Dialog Box

Associated Nets Dialog Box

Accessing

• Setup menu > Associated Nets

Table 45-39. Associated Net Rules Dialog Box 

Name Description

Associated Nets list Lists the associated nets in the design.
Tip: (H) identifies associated nets 
having existing rules.

HiSpeed button Opens the HiSpeed Rules Dialog 
Box, where you can define min/max 
length rules and create matched 
length groups for the selected 
associated nets.

Show associated nets with rules Lists only the associated nets that 
have rules.

Default button Removes all rules from the selected 
associated nets.
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Figure 45-40. Associated Nets Dialog Box

Table 45-40. Associated Nets Dialog Box Contents

Name Description

Maximum net count per 
associated net

When creating associated nets, it’s possible that associated 
nets containing an unreasonable number of nets could be 
created. 
To prevent this, specify the maximum number of nets to 
allow in an associated net. Associated nets having more 
than this limit are not created.
Tip: This limit also applies to the creation of associated 
nets manually by component and by net.
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Attribute Dictionary Dialog Box
Although you can add new attributes to design objects using the Object Attributes dialog box 
(select object > right-click > Attribute), you must use the Attribute Dictionary to set the 
properties for attribute values. It is recommended that you use the Attribute Dictionary to create 
new attributes for, or to edit and delete attributes in, your design. You can also use the Attribute 
Dictionary to assign attributes for the design, or remove attributes from objects.

Accessing

• Edit menu > Attribute Dictionary

Maximum non-plane-net 
pin count

When creating associated nets, it’s possible that nets that 
are potential plane nets could be included in an associated 
net. (Plane nets are not allowed in associated nets.)
To prevent this, specify the maximum pin count for nets 
included in associated nets.
Tip: This limit also applies to the creation of associated 
nets manually by component and by net.

Discrete component 
prefixes

Specify the refdes prefixes of the associating components 
to create new associated nets. Examples:
R        specifies all R<num> components, where <num>
           is a non-empty number.
#R      specifies all <num1>R<num2> components;
           <num1> can be empty.
#_R    specifies all <num1>_R<num2> components,
           where <num1>and <num2> are non-empty 
           numbers.

Tips: 
• The discrete type categories are only for convenience; 

prefixes for any type of component can be entered in 
any field.

• If a selected component has more than two pins, the 
following conditions must apply, or the component 
cannot be an associating component, that is, the 
associated net can’t go through the component:
• All pins must connect to a gate.
• Each gate must have exactly two pins.

Delete refdes prefixes of existing associating components 
to remove them from associated nets.

Table 45-40. Associated Nets Dialog Box Contents

Name Description
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Figure 45-41. Attribute Dictionary Dialog Box

Table 45-41. Attribute Dictionary Dialog Box Contents 

Name Description

Attribute The name of the attribute selected in the Attribute list.

Group Filters the Attribute list by showing only the selected group.

Attribute list Lists all available attributes

Show Hidden Specifies to show attribute groups that have no visible 
attributes. 
Tip: You set whether an attribute is hidden on the Objects tab 
of the Attribute Properties dialog box.

New Opens the Attribute Properties dialog box.

Delete Removes the selected attribute.
Tip: You can delete the default attributes; however, it is not 
recommended. Because the default attributes are only provided 
for your design and not assigned to objects, you do not need to 
delete these attributes.

Properties Opens the Attribute Properties dialog box.
Requirement: If an attribute is ECO-Registered, you must be 
in ECO mode to modify the attribute.
Tip: You can modify the default attributes; however, it is not 
recommended.
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Related Topics

Using the Attribute Dictionary

Attribute Manager Dialog Box
Use the Attribute Manager to view all of the attributes on all objects in the design. The Attribute 
Manager provides a spreadsheet view of all the attributes in the design. You can use the 
Attribute Manager to add, edit, and delete attribute values on multiple object types. You can 
also create value summaries of an attribute that is based on every value of the attribute assigned 
to objects of the same type. 

Accessing

• Edit menu > Attribute Manager

Figure 45-42. Attribute Manager Dialog Box

Auto Load for pre-3.0 
Designs

Specifies to automatically update attributes as soon as the 
design is loaded.

Load Now Automatically loads attributes for part types and decals from 
the current libraries to the Attribute Dictionary

Table 45-41. Attribute Dictionary Dialog Box Contents (cont.)

Name Description
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Related Topics

Using the Attribute Manager

Attribute Properties Dialog Box, Objects Tab
Use the Objects tab to assign the attribute to objects and set up the hierarchy for the attribute.

If the attribute is a system attribute, all of the options in this dialog box are unavailable, except 
the System attribute option on the Objects tab (which you would use to turn off the system 
attribute flag).

Accessing

• Edit menu > Attribute Dictionary > Select attribute > Properties button > Objects 
tab

or

Table 45-42. Attribute Manager Dialog Box Contents 

Name Description

View area Specifies what to show in the spreadsheet tabs.
• Selected—Shows the attributes selected in the design.
• Filter—Narrows down your unassigned decals list.

Tip: You can use wildcards in this box.
Tip: Attributes are shown in the spreadsheet only after you’ve 
selected the ones to show from the Show Attributes dialog box.

Apply Filter Executes the filter arguments.

Show Opens the Show Attributes dialog box.

Hide Hides the selected column from the spreadsheet tabs.

Hierarchy level The order in which attribute values have priority. The object at 
the top of the list has the highest priority.

Spreadsheet tabs Lists attributes based on selections made in the View area, the 
attribute area, and which tab you’re on: Components, Net 
Classes, Nets, Decals, Part Types, Pins, and Vias.

Add Adds an attribute to the selected cell.

Delete Removes the attribute from the selected cell.

Edit Makes the selected cell available for editing.

Fill Column Populates all cells in a column with what you’ve added to one 
cell in that column.
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• Edit menu > Attribute Dictionary > New button > Objects tab

Figure 45-43. Objects Tab

Table 45-43. Objects Tab Contents 

Name Description

Attribute The name of the attribute.

Browse Lib Attr Opens the Browse Library Attributes dialog box.

Objects The list of objects you can make available to the attribute.
NetClass—refers to a net class created in the Class Rules 
dialog box.
Part—refers to a component in the design.
PCB—refers to the design as a whole.
See also: Assigning Attributes in the Concepts Guide.

Hierarchy The order in which attribute values have priority. The object at 
the top of the list has the highest priority.
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Related Topics

Attribute Properties Dialog Box, Types Tab

Setting Attribute Properties

Attribute Properties Dialog Box, Types Tab
Use the Type tab to set the attribute type.

Accessing

• Edit menu > Attribute Dictionary > Select attribute > Properties button

or

• Edit menu > Attribute Dictionary > New button

Up/Down Moves the object hierarchy up or down. The object at the top 
of the list has the highest priority.

Use Default Hierarchy Click to clear if you want to change the default hierarchy.
Restriction: Hierarchy modification is restricted. PADS 
Layout automatically sets a certain logical hierarchy. For 
example, you cannot place Net Class above Net in the 
hierarchy because a net cannot usually be derived from a Net 
Class. PADS Layout automatically places Net above Net Class 
in the hierarchy.

ECO Registered Allows you to specify if the attribute is ECO registered. If so, 
changes to the attribute are registered in the ECO file. If this 
check box is clicked, you can only modify attributes when the 
ECO toolbar is open (ECO mode).

System Shows whether the attribute is a system attribute. System 
attributes are used by PADS Layout, an external program, or 
an Automation script (such as Sax Basic). The System check 
box prevents you from modifying an attribute that is internally 
set by, and critical to, PADS Layout operation.

Read-Only Shows whether the attribute value is read-only, which means it 
cannot be changed outside of the library. However, you can 
modify the attribute properties. If you want to modify the 
attribute value, do so in the library.

Hidden Hides the attribute, so that it is not visible or editable. It will 
not appear in any dialog boxes.

Table 45-43. Objects Tab Contents (cont.)

Name Description
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The Types tab controls change depending on what you have selected. The major differences are:

• Figure 45-44: Types Tab - Number

• Figure 45-45: Types Tab - Measure

• Figure 45-46: Types Tab - List

Figure 45-44. Types Tab - Number
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Figure 45-45. Types Tab - Measure
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Figure 45-46. Types Tab - List

Table 45-44. Types Tab Contents 

Name Description

Attribute The name of the attribute.

Browse Lib Attr Opens the Browse Library Attributes dialog box.

Free Text Allows you to type a text string as the attribute value.

Yes/No Creates a list box where you can select Yes or No as the 
attribute value.

Number Allows you to type a number as the attribute value.

Decimal number Allows you to type a decimal number for the attribute value.

Measure Allows you to determine a measurement for the attribute value. 
It is a physical value associated with units.

List Allows you to create a list from which you choose the value.
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Related Topics

Attribute Properties Dialog Box, Objects Tab

Setting Attribute Properties

Auto Placement Prompt
Use the Auto Placement prompt to control the interruption of the cluster placement process.

Accessing

• Tools menu > Cluster Placement > Place Clusters > Run > Interrupt

Figure 45-47. Auto Placement Prompt

Case-sensitive preserves the letter case of List entries. 
Tip: This setting affects sorting and matching in the Find 
dialog box and the Attribute Manager dialog box.

Limits Min/Max Specifies a range for the Measure attribute type. Type in the 
Min and Max boxes to set the range. PADS Layout checks 
against the Limits area values. 

Abbr Abbreviation to use for the unit.

Unit The name of the unit.

Quantity The quantity, or what it measures.

List list Specifies a user-defined list for the attribute.

Set Adds the item to the list.

Clear Removes the selected item from the list.

Clear All Removes all items from the list.

Clear User Removes all user-defined units from the list. All default units 
remain in the list.

Table 45-44. Types Tab Contents (cont.)

Name Description
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Related Topics

Cluster Placement Status Dialog Box

Cluster Placement Dialog Box

AutoRenumber Dialog Box
Once you complete the placement of a design, you can renumber the parts to make the reference 
designators follow a specific pattern. This helps you find components on the fabricated board. 
AutoRenumbering reassigns the reference designators to one of the eight provided patterns.

Accessing

• On the ECO toolbar, click Auto Renumber.

Table 45-45. Auto Placement Prompt Contents

Name Description

Abort Quits the Cluster Placement process. You are promted to allow the 
adjusted placement where clicking No will undo any placement.

Proceed Continues with the original cluster placement process.

Resume You are prompted to allow the process to proceed based on the already 
adjusted placement.
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Figure 45-48. AutoRenumber Dialog Box

Table 45-46. Contents of AutoRenumber Dialog Box

Field or Button Description

Prefix List Lists the standard prefix for each part in the design. You 
can select individual prefixes to renumber associated 
parts. You can use the Shift+click, Ctrl+click, or click and 
drag shortcuts to select multiple items.

Select All The Select All button changes to Unselect All when 
prefixed are selected. You can renumber all parts by 
clicking the Select All button or clear all prefixes by 
clicking Unselect All.

Cell size Enter the cell size of the cell for the part-numbering 
sweep. Renumbering sorts and renumbers parts one cell at 
a time starting at the corner indicated by the Directional 
Pattern setting. For circular board outlines, an invisible 
bounding box determines the location of the first cell. The 
board outline width is taken into account when the 
reference point for positioning user-specified cells is 
calculated. Cells are counted from the outer edge of the 
board outline.
See also: AutoRenumber Sweeps
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Related Topics

Changing the Reference Designators of Multiple Components in ECO Mode 
(Autorenumbering)

AutoRenumber Sweeps

Continuous numbering side 
to side

Controls numbering between sides. Select this option to 
number all parts sequentially beginning with the Start 
Renumbering from layer and continuing to the opposite 
side. Clear the check box to if you want to specify a 
separate start at number and increment value for each 
side of the board.

Start Renumbering from Indicate the side on which to start renumbering the parts. 
Restriction: This feature is unavailable when parts are 
only on one side of the board or if the Continuous 
numbering side to side check box is cleared

Renumber (Top or Bottom) Select the check box to renumber the corresponding side 
of the board.
Restriction: This feature is unavailable when parts are not 
on the layer.

Start at (Top or Bottom) Specify the starting number for renumbering for the 
corresponding side of the board. Renumbered parts 
maintain their alphabetic prefix and are assigned a 
numeric suffix beginning with this value.
Restriction: This feature is unavailable when Continuous 
numbering side to side is enabled and it is not the selected 
layer of the Start Renumbering from setting.

Increment (Top or Bottom) Specify the value by which to increment the reference 
designators.
Restriction: This feature is unavailable when Continuous 
numbering side to side is enabled and it is not the selected 
layer of the Start Renumbering from setting.

Directional patterns (Top or 
Bottom)

Select the button that shows the starting location and 
direction in which you want to renumber the board.
See also: AutoRenumber Sweeps

Table 45-46. Contents of AutoRenumber Dialog Box

Field or Button Description
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Backward Annotation Dialog Box
In DxDesigner Link, backward annotation sends data from a PADS Layout design file to a 
DxDesigner schematic and updates the schematic to match the PADS Layout design.

Use the Backward Annotation dialog box to specify the layout design data to use in backward 
annotation.

Tip: To avoid unexpected changes during backward annotation, consider comparing data 
before you back-annotate.

Accessing

• Tools menu > DxDesigner > Backward From PCB button

Figure 45-49. Backward Annotation Dialog Box

Table 45-47. Backward Annotation Dialog Box contents 

Name Description

ECO preference area • Use existing ECO file—Specifies to use an exiting ECO 
file.
Tip: The backward annotation operation first searches for a 
file with the same name as the layout design but with an 
.eco extension. If the operation does not find such a file, 
you can select an ECO file.

• Create ECO file using Netlist comparison—Specifies to 
have DxDesigner compare the PADS Layout design to the 
schematic and create a new ECO file.
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Basic Script Editor Dialog Box

Related Topics

Back Annotating from PADS Layout to DxDesigner

Basic Script Editor Dialog Box
Basic is a simple scripting language. Like many Windows applications, such as Microsoft Word 
and Excel, PADS applications include Basic capabilities to allow users to customize their 
applications using a standard scripting language.

You can use the Basic Script Editor to create, edit, run, and troubleshoot Basic scripts from 
PADS applications. 

Accessing

• Tools menu > Basic Scripts > Basic Script Editor.

Data to pass to 
Schematic area

Specifies the data to send to the DxDesigner schematic. You 
can send:
• Parts, netlist, and attributes names and values
• Design rules

Tip: To include design rules in the forward annotation 
operation, select the Design Rules option, even if you already 
selected Compare Design Rules on the Preferences tab.

Pause before Updating 
Schematic

Specifies that you want to review the ECO file containing 
changes that the update will make to the DxDesigner 
schematic.

Table 45-47. Backward Annotation Dialog Box contents (cont.)

Name Description
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Figure 45-50. Basic Script Editor

Related Topics

Basic Scripts Dialog Box
Use the Basic Scripts dialog box to access your scripts. In this dialog box, you can load and run 
your most commonly used scripts. You can also unload those scripts you don't use often. This 
dialog box runs only existing sample scripts. 

Accessing

• Tools menu > Basic Scripts > Basic Scripts

Managing Scripts Debugging Scripts

Creating Scripts The Macro Language

Running Scripts Router Basic Scripting

Basic Scripting
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Basic Scripts Dialog Box

Figure 45-51. Basic Scripts Dialog Box

Table 45-48. Basic Scripts Dialog Box contents 

Name Description

Script lists Lists the loaded scripts. The Script dropdown list and the 
Script list are synchronized

When you click the X button, the lower half of the dialog box 
“disappears”; leaving only the top left corner of the dialog box 
for interaction. When in reduced mode, click a script from the 
list and press Enter, or double-click on a script in the list.

In Menu Adds scripts to the Basic Scripting submenu from the Tools 
menu, where you can run often-used scripts directly from the 
menu without opening the Basic Scripts dialog box.

Run Runs the currently selected script. 

Edit Opens the Sax Basic Engine dialog box where you can edit the 
selected script.

Load File Loads scripts into the list. You can load up to 32,767 scripts. 
Scripts are not compiled when they are loaded; they are 
compiled when you run them.
This list of scripts you load into this dialog box is saved in the 
VBScripts.ini file, so these scripts load every time you open 
the Basic Scripts dialog box.

Unload File Unloads the selected script from the dialog box.
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Related Topics

Basic Script Editor Dialog Box

BGA Route Wizard Dialog Box
When you select the BGA Route Wizard button on the BGA toolbar, the BGA Route Wizard 
dialog box appears. Use the BGA Route Wizard dialog box to generate connections only, or 
generate connections and routes.

Restriction: This information applies to the BGA toolkit only.

When you open the BGA Route Wizard dialog box for the first time (per design) the Die Ref 
Des and BGA Ref Des drop down list boxes automatically display reference designators based 
on the logic families in the current design.

Tip: For die reference designators, the BGA Route Wizard looks for parts having either 
a die part or flip chip special purpose setting. If more than one of these are found, one is 
randomly selected. If none is found, a component is randomly selected. 

Tip: For BGA reference designators, the BGA Route Wizard looks for a BGA logic 
family. If no die with this logic family is found, a component is selected randomly. If 
more than one die has this logic family, one of the dies in that logic family is randomly 
selected.

When you click either Run or OK, the selections you make in the BGA Route Wizard dialog 
box are stored in the design.

The Die Wizard has 4 tabs:

• Connections

• Routing

• Select Pads

• BGA Fanouts

The availability of tabs depends on whether you select Generate Connections or Generate 
Connections and Route from the Action area. 

• If you select Generate Connections, the Routing tab grays. 

• If you select Generate Connections and Route, the Connections tab grays.

• If you are creating a single-sided design, the BGA Fanouts tab grays.

Accessing

• BGA Toolbar button > Route Wizard button
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BGA Route Wizard Dialog Box

Figure 45-52. BGA Route Wizard Dialog Box

Table 45-49. BGA Route Wizard Dialog Box contents 

Name Description

Die Ref Des list Displays the die reference designator when you open the BGA 
Route Wizard dialog box for the first time (per design), based 
on the logic families in the current design. 
The BGA Route Wizard looks for parts having either a die part 
or flip chip special purpose setting. If more than one of these 
are found, one is randomly selected. If none is found, a 
component is randomly selected.
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BGA Ref Des list Displays the BGA reference designator when you open the 
BGA Route Wizard dialog box for the first time (per design), 
based on the logic families in the current design.
The BGA Route Wizard looks for a BGA logic family. If no 
die with this logic family is found, a component is selected 
randomly. If more than one die has this logic family, one of the 
dies in that logic family is randomly selected.

Action area • Generate Connections—Generates logical connections 
between die and BGA component pins. Connections are 
not routes; however, BGA fanouts and SBP fanouts are 
generated if specified in the Connections tab.

• Generate Connections and Route—Generates logical 
connections between component pins and creates trace 
patterns to route them. During processing, the following 
occurs:
• BGA fanouts are generated. This is performed on 

double-sided designs only.
• Serpentine routes and plating tails are generated.
• SBPs are logically assigned to the ends of serpentine 

traces and logical connections between die pins, and 
BGA pins are generated.

• SBP fanouts and any-angle coupling traces are 
generated.

• The BGA Route Wizard generates route patterns on die 
and BGA layers only. The BGA layer contains only 
BGA fanouts. All other parts of route patterns 
(serpentine routes and plating tails, SBP fanouts and 
any-angle coupling traces) are created on the die layer.

tabs • Connections
• Routing
• Select Pads
• BGA Fanouts

Save Setup button Saves the selections you make in the BGA Route Wizard 
dialog box and stores them in a text file with a .brw extension. 
This file is stored in the \PADS Projects folder.

Load Setup button Opens .brw files that contain BGA Route Wizard settings.

Run button Runs the routing process based on the selections made in the 
BGA Route Wizard dialog box. 

Undo Last Run button Returns the design to its state prior to route processing. Undo 
Last Run is unavailable until you run the routing process. 

Table 45-49. BGA Route Wizard Dialog Box contents (cont.)

Name Description
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BGA Route Wizard Dialog Box

Figure 45-53. BGA Route Wizard, Connections tab
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Table 45-50. Connections tab contents 

Name Description

Existing Nets Controls predefined connections processing.
• When this option is selected, predefined connections are 

processed so BGA and SBP fanouts are generated for them.
• When this option is cleared, Die and BGA pins that already 

belong to signals are excluded from processing. BGA 
fanout and SBP fanout processing, if specified in the 
Connections tab, are also not performed for existing 
connections.

The BGA Wizard interprets pins as obstacles and routes 
around them. If a new trace interferes with an existing trace, no 
shorts are placed and the new connection is unrouted. If a BGA 
or SBP pin has an existing fanout, it is used during processing.
Tip: You can exclude some predefined connections using the 
Select Pads tab.

Substrate Bond Pad 
Fanouts

Creates SBP fanouts during connection generation. Specify the 
escape length and trace width in the SBP Fanout area.

BGA Fanouts Creates BGA fanouts during connection generation. This 
option is available only for double-sided packages.

Partitioning area Controls the pad partitioning displayed in the Select Pads tab; 
creating sets of die pads and BGA pads to connect.:
• Side—Die is partitioned by sides so that pad sets are: 

Right, Left, Top, and Bottom.
• Quadrant—Die is partitioned into quadrants: Top Left, 

Top Right, Bottom Left, and Bottom Right.
See also: Partitioning a Die

Derive Net Name from 
Pin Function

Controls new net name generation. Select this option to use a 
pin's function as a basis for naming a new net. 
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BGA Route Wizard Dialog Box

Net Name Preferences 
area

• Join Pads Having Same Net Name—Combines die pads 
with the same function name into a single net.

• Iterate Net Name—Generates separate nets for each die 
pad with the same name; for example, several GND die 
pads would have nets named GND1, GND2, and so on.

Net name preferences are shared between the Connections tab 
and the Routing tab. If you change net name preferences in one 
tab, the same changes occur in the other tab.

Trace Length Defines the SBP fanout trace length. The trace length is 
measured from the edge of the pad to the end of the trace. 
If a value of zero is entered the trace is not created. The BGA 
Route Wizard also takes the SMD to Corner rule into account 
when generating this trace. This rule can make the BGA Route 
Wizard generate a longer trace than requested in the Trace 
Length box.

Trace Width Defines the SBP fanout trace width. The trace width must 
adhere to the minimum and maximum rule set in the Clearance 
Rules dialog box.
See also: Design Rule Hierarchy

Table 45-50. Connections tab contents (cont.)

Name Description
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Figure 45-54. BGA Route Wizard, Routing tab

Table 45-51. Routing tab contents 

Name Description

Coupling Routes and 
SBP Fanouts

Sets the trace width rules during route pattern creation for SBP 
fanouts and any-angle coupling routes.
Type a value into the Minimum and Recommended boxes. 
Values must be between the Minimum and Maximum trace 
width values defined in the Clearance Rules dialog box.
The BGA Route Wizard uses the Recommended value 
whenever possible, and uses the Minimum value only for 
connections that it cannot route using the Recommended 
value.

Serpentine Routes and 
Plating Tails

Sets the trace width rules during route pattern creation for 
serpentine patterns and plating tails.
Type a value into the Minimum and Recommended boxes. 
Values must be between the Minimum and Maximum trace 
width values defined in the Clearance Rules dialog box.
See also: Design Rule Hierarchy
The BGA Route Wizard uses the Recommended value 
whenever possible and uses the Minimum value only for 
connections that it cannot route using the Recommended 
value.
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BGA Route Wizard Dialog Box

Rules button Opens the Default Rules dialog box.

Existing Nets Controls predefined connections processing.
• When this option is selected, predefined connections are 

processed so BGA and SBP fanouts are generated for them.
• When this option is cleared, Die and BGA pins that already 

belong to signals are excluded from processing. BGA 
fanout and SBP fanout processing, if specified in the 
Connections tab, are also not performed for existing 
connections.

The BGA Wizard interprets pins as obstacles and routes 
around them. If a new trace interferes with an existing trace, no 
shorts are placed and the new connection is unrouted. If a BGA 
or SBP pin has an existing fanout, it is used during processing.
Tip: You can exclude some predefined connections using the 
Select Pads tab.

Plating Tails Specifies to create plating tails for serpentine traces.

Derive Net Name from 
Pin Function

Controls new net name generation. Select this option to use a 
pin's function as a basis for naming a new net. 

Net Name Preferences 
area

• Join Pads Having Same Net Name—Combines die pads 
with the same function name into a single net.

• Iterate Net Name—Generates separate nets for each die 
pad with the same name; for example, several GND die 
pads would have nets named GND1, GND2, and so on.

Net name preferences are shared between the Connections tab 
and the Routing tab. If you change net name preferences in one 
tab, the same changes occur in the other tab.

Table 45-51. Routing tab contents (cont.)

Name Description
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Tail Length Defines the length of the plating tail wire from the outside row 
of a BGA (single-sided package) or from a BGA fanout via 
(double-sided package) to the end point of the plating tail. 
On single-sided packages the wire length is measured from the 
center of the BGA pad to the end of the plating tail, even if a 
test point via is added.

On double-sided packages the wire length is measured from 
the center of the BGA via to the end of the plating tail, even if 
a test point via is added.

Tip: The BGA Route Wizard extends plating tails through the 
board outline, if necessary, without generating an error in the 
BGA Route Wizard Report. However, Clearance Checking 
will produce errors in this circumstance.

End with Test Point Creates a test point at the end of each new plating tail.
Tip: On the File menu, click Reports. Run the DFT Extended 
test point report to check that all traces have a plating tail.

Via Type list Defines the via type to use for the test point. The list contains 
the vias that are defined in the PCB Decal Editor for each part.

Table 45-51. Routing tab contents (cont.)

Name Description
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BGA Route Wizard Dialog Box

Figure 45-55. BGA Route Wizard, Select Pads tab

Table 45-52. Select Pads tab contents 

Name Description

Select Sides/Select 
Quadrants

The available partitioning type depends on whether the 
Generate Connections or Generate Connections and Route 
option is selected in the Action area.
Use the partition check boxes to select partition sets. The 
available Side partition sets are Right, Left, Top, and Bottom. 
The available Quadrant partition sets are Top Left, Top Right, 
Bottom Left, and Bottom Right.
Only the pins from selected sets appear in the Substrate Bond 
Pad and BGA Pins lists.
See also: BGA Operations

Select Graphically 
button

Opens the Select Graphically dialog box.
See also: To Use Graphical Selection mode

Substrate Bond Pads 
area

Lists the substrate bond pads to include in or exclude from 
processing.
Tip: Die and BGA pads that already belong to signals are 
excluded from processing unless Existing Nets on the 
Connections tab is selected.
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Figure 45-56. BGA Route Wizard, BGA Fanouts tab

BGS Pins list Lists the BGA pins to include in or exclude from processing.
Tip: Die and BGA pins that already belong to signals are 
excluded from processing unless Existing Nets on the 
Connections tab is selected.

Exclude button Removes selected pins from the Included list and adds them to 
the Excluded list.

Include button Removes selected pins from the Excluded list and adds them 
to the Included list.

Number of Included 
Pads

Displays the number of pads currently listed in the Included 
list.

Table 45-52. Select Pads tab contents (cont.)

Name Description
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BGA Route Wizard Dialog Box

Related Topics

Using the BGA Route Wizard

To Create a Wire Bond Fanout

Table 45-53. BGA Fanout tab contents 

Name Description

Fanout Style list Sets the fanout pattern. The available fanout styles depend on 
the grid array geometry. Herringbone and Diagonal are 
available for regular (non-staggered) arrays. Vortex and 
Double Vortex are available for staggered arrays. 

Direction area • Out—Turns BGA fanouts to the outside of the design.
• In—Turns BGA fanouts to the inside of the design.
• Clockwise—Turns BGA fanouts in a clockwise direction.
• Counterclockwise—Turns BGA fanouts in a 

counterclockwise direction.
If either Orthogonal for Outside Row or Orthogonal for 
Inside Row is selected, the direction options only affect BGA 
fanouts within the central rows when more than two rows of 
BGA pads exist. 

Orthogonal for Outside 
Row

Turns BGA fanouts on the outside row outward at an 
orthogonal angle with respect to the die. If this option is 
selected, the Direction options have no effect on the outside 
row. 

Orthogonal for Inside 
Row

Turns BGA fanouts on the inside row inward at an orthogonal 
angle in respect to the die. If this option is selected, the 
Direction options have no affect on the inside row.

Trace Width Defines the trace width to use for BGA fanouts. The trace 
width must adhere to the minimum and maximum rule set in 
the Clearance Rules dialog box.
See also: Design Rule Hierarchy

Via Type list Defines the via type to use for BGA fanouts. The list contains 
the vias that are defined using Pad Stacks on the Setup menu 
for this design.

Preview Window Shows the fanout pattern defined by the current settings on the 
BGA Fanouts tab. In this window you can see that pads 
excluded from processing on the Select Pads tab do not receive 
a fanout pattern.
Tip: If Existing Nets on the Connections tab or Routing tab is 
selected, all pads, including pads that are not currently part of a 
predefined connection, are assigned a fanout pattern.
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BGA Operations

BoardSim Dialog Box
Use the BoardSim dialog box to export the design in the form of a HYP file and open it in 
BoardSim. For information about the format of the HYP file and creating a “BoardSim-
friendly” design, see the HyperLynx online Help. PADS Layout passes the Value, Tolerance, 
Voltage, HyperLynx, and PowerGround attributes to the HYP file. BoardSim uses these 
attributes to obtain values for resistors and capacitors, and to transfer information about fixed 
voltage nets.

Restrictions

• Only HyperLynx v8.0 or newer can open the file that is exported by this dialog box. The 
.hyp file that is created is a v2.34 format file.

• You would use this dialog box only if you have HyperLynx BoardSim installed since 
it’s the quickest method. If you don’t have it installed and you still need to create the file 
to send it to another computer, use the File > Export method of only producing the .hyp 
file. See HYP Export Dialog Box.

Accessing

• Tools menu > point to Analysis > click Signal/Power Integrity

Figure 45-57. BoardSim Dialog Box
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BoardSim Dialog Box

Related Topics

HYP Export Dialog Box

Table 45-54. BoardSim Dialog Box Contents 

Name Description

Output area

Attributes for Nets and Net 
Classes

Specifies to export attributes for nets and net classes.

Attributes for Power and 
Ground nets

Specifies to export attributes for power and ground nets.
Restriction: This check box is only available if a net has 
both the PowerGround attribute set to Yes, and the 
Voltage attribute with a value.

.REF IC Automapping file Specifies to create a HyperLynx .ref file, which maps IC 
reference designators in the design to the BoardSim 
models that represent the ICs. BoardSim uses the 
mappings to automatically load IC models when you 
select a net for simulation.
Restriction: This check box is only available if a 
component has the HyperLynx.Model attribute with a 
value.

Unrouted Specifies to export unrouted nets.

Plane Areas and Copper 
Pours

Specifies to export plane areas and copper pours.
• Export hatch outlines for pours and plane areas—

Specifies to export hatch outlines for pours and plane 
areas.
Requirement: This setting creates extra constructs in 
the .hyp file and is required for power-integrity 
analysis.

• Export pour and plane area outlines—Specifies to 
export pour and plane area outlines.

Unroutes Options area
Tip: Available only if Unrouted is selected in the Output area.

Assumed Layer Specifies the layer on which to implement the unrouted 
nets.

Percent Excess over 
Manhattan Length

Specifies the value to estimate the routing lengths.
Tip: This value adds a percentage of the Manhattan length 
to the route length, to account for indirect routing paths. 
Net lengths are based on the Manhattan distance between 
pin pairs, which is Delta X plus Delta Y.
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Creating HyperLynx BoardSim - HYP Files

Browse for Special Symbols Dialog Box
Use the Browse for Special Symbols dialog box to assign one or more CAE decals, or Special 
Symbols, to a pin type. Special Symbols indicate the function of the connector pin in PADS 
Logic.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Connector tab > Double-click Special Symbol cell > Browse button

Figure 45-58. Browse for Special Symbols Dialog Box

Table 45-55. Browse for Special Symbols Dialog Box Contents 

Name Description

Preview area Shows the item selected in the Gate Decals list.

Gate Decals List of available Gate Decals.

Library list Lists all libraries available to you.

Items Narrows down your Gate Decals list. 
Tip: You can use wildcards in this box.

Apply Executes the filter arguments.
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Browse Library Attributes Dialog Box

Related Topics

Part Information Dialog Box, Connector Tab

Creating a Connector Part Type

Assigning Special Symbols to a Connector

Browse Library Attributes Dialog Box
Use the Browse Library Attributes dialog box to select an attribute from a list of all part and 
decal attributes available to the design.

Accessing

• File menu > Library > Library Manager dialog box > Attr Manager button > Browse 
Lib. Attr button

• File menu > Library > Library Manager dialog box > Attr Manager button > Add 
Attr button > Browse Lib. Attr button

• Attribute Properties dialog box > Browse Lib. Attr. button

Figure 45-59. Browse Library Attributes Dialog Box
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Related Topics

Build Clusters Setup Dialog Box
Use the Build Clusters Setup dialog box to create new clusters from parts and unions. Creation 
is based on connectivity.

Accessing

• Tools menu > Cluster Placement > Build Clusters button > Setup button

Figure 45-60. Build Clusters Setup Dialog Box

Table 45-56. Browse Library Attributes Dialog Box Contents 

Name Description

Attribute Displays the selected attribute.

Group Filters the attribute list. (Includes structured attributes.)

Refresh Manually updates the attribute list if you change the list of 
libraries in the Library Manager.

Renaming Attributes of Library Items

Table 45-57. Build Clusters Setup Dialog Box Contents 

Name Description

Unlimited Specifies unrestricted parts per cluster.
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CAM Plus Dialog Box

Related Topics

Using the Cluster Placement Dialog Box

CAM Plus Dialog Box
The CAM Plus command generates computer-aided manufacturing (CAM) output files that are 
compatible with a variety of automatic assembly and pick-and-place machines. Before you use 
CAM Plus prepare an information file called part.def.

Accessing

• File Menu > CAM Plus

Max. Parts Per Cluster 
box

Sets the maximum number of parts allowed in one cluster.

Minimum Top Level 
Count

Sets the minimum number of top-level clusters allowed. A top-
level cluster is a cluster not contained within another cluster. If 
you set this to a low number and set Maximum Parts Per 
Cluster to Unlimited, all parts are grouped into one large 
cluster.

Create New Clusters Allows you to create new clusters. Clear the check box to 
modify only previously created clusters.

Unglued Parts Number 
box

Displays current number of unglued parts in the design. The 
box remains unavailable for editing.

Build Mode area Clusters are identified as either open or closed:
Rebuild Open Clusters—You can delete or replace an open 
cluster during automatic cluster creation. Automatically 
created clusters default to open.
Maintain Open Clusters—You cannot delete or replace a 
closed cluster during automatic cluster creation. Manually 
created clusters default to closed.

Table 45-57. Build Clusters Setup Dialog Box Contents (cont.)

Name Description
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Figure 45-61. CAM Plus Dialog Box

Table 45-58. CAM Plus Dialog Box contents 

Name Description

Part Definition Filename The name of the Part Definition file. The file, part.def, is read 
from the \Libraries folder by default.

Side The side of the board on which you want to report: Top or 
Bottom.

Parts The type of parts to include in the report: SMT, ThruPin, All, 
and Masked. 
Tip: Masked parts are those that are assigned to the machine 
selected format as an insert class.
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CAM Plus Dialog Box

Read Part Definition Specifies to add the additional information contained in the 
Part Definition File, part.def, to the parts contained in a design.
This information defines the insertion class for all parts. Read 
Part Definition scans the Part Definition File for information 
about the parts in the database. When an exact match is found 
between a part type name in the database and a part type name 
in the definition file, the information combines to provide the 
manufacturing output.

Read Value Definition Specifies to read the Value attributes for each part in the PADS 
Layout design and append the Value attribute to the part type 
name when matching each part type in the Part Definitions file, 
part.def. 
Example: An R1/4W part type with Value attribute 100K 
could have an entry in the Part Definitions file as follows: 
R1/4W{100K},ins=un6241,bodydiam=200,leaddiam=30,anvil
=2

Verify File Specifies to produce an ASCII verification file.
This ASCII file is stored in the 
\PADS Projects\Cam\<board_file_name> folder. This file 
contains 2D line data that describes the path for the inserted 
parts. The name of the file is the name of the interface program 
created, with the .asc extension. You can read this file into 
PADS Layout with the ASCII In command. It states the 
insertion path as 2D lines on layer 19. If a Part_Num value for 
a part is not found, Part_Num is set to Missing.

Batch Part Def. File Specifies to run all of the outputs with a single command.
For each program you run, an output file is produced with the 
name suffix bt or bb, for example dym318bt.smt or 
un6241bb.put. If this file already exists, the message 
“Overwrite existing file (Y/N)?” appears. Click either Yes or 
No. If you click Yes, the file is overwritten and placed in the 
CAM subfolder. Each of the parts in the selected category is 
added to the file. A report called insert.lst lists each part and 
the machine that inserts it. The Batch command does not create 
a Verify file.

X-/Y-Offset Defines the offset of the machine’s location dowel with regard 
to the 0,0 system origin board.
These offset values convert the design coordinates to the 
machine origin. Allowable values are from 0 to 10 inches. 
Offset values are in inches; for example, 1250 is 1.25 inches. 
You may need to define a new Board offset for each machine.

Table 45-58. CAM Plus Dialog Box contents (cont.)

Name Description
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Related Topics

Using the CAM Plus Assembly Machine Interface

CAM Preview Setup Dialog Box
Use the CAM Preview Setup dialog box to invert, show plot orientation, or overlay multiple 
CAM Documents - you can change the preview attributes of all documents. 

X-/Y-Count and 
X-/Y-Step

define whether to treat the board as a single design when 
creating the output program file, or to insert a number of 
boards simultaneously.
When you insert a number of boards, you can define the 
number of steps in the X and Y direction and the step and 
repeat interval to use, as shown below. CAM Plus uses current 
design units for the offset and step and repeat values. Each 
machine has its own units type to which the data is always 
converted regardless of the current design units. CAM Plus 
generates assembly program files for inserting parts on all 
boards. 
• X-Count—Number of copies in X direction. The 

maximum is 20.
• Y-Count—Number of copies in Y direction. The 

maximum is 20.
• X-Step—The step distance in the X direction between the 

origin of each board. The maximum is 10 inches.
• Y-Step—The step distance in the Y direction between the 

origin of each board. The maximum is 10 inches.
The default is no step and repeat, equivalent to a step of 1 in X 
and Y.

Output Format Specifies the machine format.
Files are produced for all parts of a selected class: masked, 
through hole, SMT, top, bottom, and so on. All parts in the 
class are included in this output.

Universal Tooling and
Universal Axial Output

Specifies the desired settings, if applicable. 
Restriction: Universal-specific instructions are available 
when you select Universal machine formats or check Batch 
Part Def. File.

Status Messages Displays the current state of output. Populated after you click 
Run.

Run Generates the output file.

Table 45-58. CAM Plus Dialog Box contents (cont.)

Name Description
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CAM350 Link Dialog Box

Tip: You must have at least one CAM document defined to use preview setup.

Accessing

• File menu > CAM > Select a document > Preview button > Setup button

Figure 45-62. CAM Preview Setup Dialog Box

Related Topics

Setting CAM Preview Options

CAM350 Link Dialog Box
Use the CAM350 dialog box to set options for, and to generate, a .cam output file.

Table 45-59. CAM Preview Setup Dialog Box contents 

Name Description

Document Displays the document name.

Visible Specifies the documents you want to see; you can overlay 
multiple CAM documents.

Inverse Specifies to invert the view of a CAM document. You might 
want to invert the view of CAM Plane layers since they are 
negative layers and will appear different than all other layers.

Orient Specifies to scale and orient the preview data as defined by the 
CAM document plot options.
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Accessing

• File menu > Export > select CAM350 Files > Save

Figure 45-63. CAM350 Link Dialog Box

Table 45-60. CAM350 Link Dialog Box contents 

Name Description

Mode area Specifies the CAM350 mode you want:
• Create File Only to simply produce the .cam file 
• Create File and Launch CAM350 to start CAM 350 and 

load the resulting .cam file.

Layer Options area Specifies the amount of PADS design detail to translate to the 
CAM350 database.
• CAM Documents (includes Nets and Parts)—Translates 

CAM documents with part and net intelligence. Plot 
orientation, as specified in the CAM document, is not 
applied. This is useful for verifying net lists and DRCs in 
CAM350.

Requirement: Before using this option, flood all copper 
pours and connect all split/mixed plane layers. Also, on the 
Tools > Options > Split/Mixed Plane tab, in the Save to 
PCB File area, click All Plane Data. This allows all pour 
data to be passed to CAM350.
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CAM350 Link Dialog Box

Related Topics

Exporting to CAM350

Layer Options area
(con’t)

• CAM Documents (Graphics only, Orientations 
applied)—Translates CAM documents with plot 
orientation, including offset, rotation, mirroring, and 
scaling. This is useful for direct Gerber file translation to 
CAM350 where no component or net information is 
required.

Requirement: Before using this option, if your PADS 
Layout photoplot output format is set to RS-274D, make 
sure your CAM350 default units (mils or inches) and 
CAM350 default precision are set to match the units for 
PADS Layout and the precision for PADS Layout 
File/CAM photoplot output, respectively.

CAM350 Link uses the files pads3.arl (for English units) 
and pads3m.arl (for Metric units) with this option and 
when Gerber files are in RS274-D format. The *.arl files 
determine how the aperture report file (*.rep) is generated 
by CAM in PADS Layout will be interpreted by CAM350.

• CAD Layers -> CAM Layers (As-Is)—Translates no 
CAM documents. Translates CAD layers as defined in the 
PADS Layout database. This is useful for legacy CAM 
processes that take advantage of CAD layer translation 
using the PADS-ASCII format import operation in 
CAM350.

Requirement: Before using this option, flood all copper 
pours and connect all split/mixed plane layers. Also, on the 
Tools > Options > Split/Mixed Plane tab, in the Save to 
PCB File area, click All Plane Data. This allows all pour 
data to be passed to CAM350.

Arc Approximation 
Tolerance

Specifies the minimum allowable distance between the actual 
arc path and the approximated straight-line segments. 
Tip: This is shown in the design units you set on the Global 
tab.

CAM350 File Name Specifies the path and name for the CAM350 file. The default 
file name and path are the same name as the current design file 
name and path.
Tip: Click Browse to navigate to a location.

Table 45-60. CAM350 Link Dialog Box contents (cont.)

Name Description
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Annotating DFF Errors

CAM Preview Dialog Box
Use the CAM Preview dialog box to preview your CAM Documents.

Accessing

• File menu > CAM > Preview button

or

• File menu > CAM > Add > Preview Selections

or

• File menu > CAM > Add > Layers > Preview button

Figure 45-64. CAM Preview Dialog Box

Table 45-61. CAM Preview Dialog Box Contents

Name Description

Document list Lists the available documents to preview.

Setup Opens the CAM Preview Setup dialog box.
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CBP Properties Dialog Box

Related Topics

Adding or Editing CAM Documents

CBP Properties Dialog Box
The CBP Properties dialog box displays the pad number, function, position, and dimensions of 
the selected component bond pad. In the Wire Bond Editor, with one or more CBPs selected, 
right-click and click Properties to edit the CBP Properties.

Restriction: This information applies to only the BGA toolkit.

Accessing

• BGA Toolbar button > Wire Bond Editor button > Select a CBP > right-click > 
Properties

Figure 45-65. CBP Properties Dialog Box

Board Zooms the view to the board outline.

Extents Zooms the view to include the extents of the design space.

Workspace Zooms the view to the workspace.

Refresh Refreshes the view from changes in the design.

Table 45-61. CAM Preview Dialog Box Contents

Name Description
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Related Topics

To Edit Component Bond Pads

CCE Export Dialog Box
Using the CCE Export dialog box, you can export design elements to CAMCAD, visECAD, 
and visEDOC.

Accessing

• File menu > Export > select CCE Files > Save

Table 45-62. CBP Properties Dialog Box contents 

Name Description

Pad # Assigns a number to the currently selected component bond 
pad. By default, it is the same number as the substrate bond 
pad to which it is connected.

Function Defines the function of the currently selected bond pad.

Fanout Side list Selects the side of the SBP Guide to which the CBP should be 
wire bonded. The possible values are left, top, right, and 
bottom.

Wirebond Displays the name of the substrate bond pad and the 
component bond pad that are connected by the wire bond.

X and Y Displays the X and Y coordinates of the bond pad. Type new 
values to move the bond pad.

Shape list Assigns a shape to the currently selected bond pad: Rectangle 
or Oval.

Length Assigns a physical length, in current design units, for the 
currently selected bond pad.

Width Assigns a physical width, in current design units, for the 
currently selected bond pad.

SBP button Opens the SBP Properties dialog box for the component bond 
pad connected to the currently selected substrate bond pad. 
This button is unavailable if there is no connected component 
bond pad.

WB button Click WB to open the Wire Bond Properties dialog box for the 
wire bond connected to the currently selected pad. This button 
is unavailable if there is no connected wire bond.
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CCE Export Dialog Box

Figure 45-66. CCE Export Dialog Box

Table 45-63. CCE Export Dialog Box Contents

Name Description

Solder Mask Options

Use unaltered solder mask 
layer data

Select this option to use the solder mask data as it exists in 
the design. No additional pads are added and no 
oversizing or undersizing is applied.

Use CAM-processed data Select this option to accept automatically-generated pads 
copied from the associated top or bottom layer, and 
oversizing or undersizing.
• You are not required to create solder mask shapes in 

each pad stack. During export, pads are copied from 
the outside layer to the solder mask layer for use as the 
solder mask shape.

• Oversizing or undersizing follows a hierarchical 
priority. For more information, see Control of Solder 
Mask and Paste Mask.

Over(Under)size pads by Type a value to apply a global oversize or undersize to all 
solder mask pads.
Tip: This global setting is the lowest of a hierarchy of 
possible values. For more information, see Control of 
Solder Mask and Paste Mask.

Paste Mask Options

Use unaltered paste mask 
layer data

Select this option to use the paste mask data as it exists in 
the design. No additional pads are added and no 
oversizing or undersizing is applied.
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Related Topics

Exporting CCE Files

Change Component Dialog Box
Use the Change Component dialog box to authorize changing a part type in the design and to 
control the retention of the attributes of the part in the design.

Accessing

• select a component > ECO Toolbar > Change Component > right-click > Library 
Browse > select a part type > Replace

Figure 45-67. Change Component Dialog Box

Use CAM-processed data Select this option to accept automatically-generated pads 
copied from the associated top or bottom layer, and 
oversizing or undersizing.
• You are not required to create paste mask shapes in 

each pad stack. During export, pads are copied from 
the outside layer to the paste mask layer for use as the 
paste mask shape.

• Oversizing or undersizing follows a hierarchical 
priority. For more information, see Control of Solder 
Mask and Paste Mask.

Over(Under)size pads by Type a value to apply a global oversize or undersize to all 
paste mask pads.
Tip: This global setting is the lowest of a hierarchy of 
possible values. For more information, see Control of 
Solder Mask and Paste Mask.

CCE The CCE format is a compressed version of the CC file. If 
you want a smaller file size, use the CCE format.

Table 45-63. CCE Export Dialog Box Contents

Name Description
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Check for Updates Dialog Box

Related Topics

Changing a Component in ECO Mode

Updating a Part Type from the Library in ECO Mode

Check for Updates Dialog Box
Use the Check for Updates dialog box to manually check for a new version of PADS, and to 
disable or enable automatic checks.

Accessing

• Help menu > Check for Updates

Figure 45-68. Check for Updates Dialog Box

Table 45-64. Change Component Dialog Box Contents

Name Description

Keep Attributes Select the check box to keep the attributes of the part in the design 
and apply them to the replacement part.

Yes Proceeds with the change of the part(s) in the design.

No Cancels the Replace command and returns you to the Get Part 
Type from Library dialog box.

Cancel Cancels the Change Component

Table 45-65. Check for Updates Dialog Box contents 

Name Description

Check for Updates 
button

Manually checks for a new version of the PADS software.
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Related Topics

Checking for PADS Updates

Check Teardrop Dialog Box
Use the Check Teardrops dialog box to check for and view teardrop errors. The error location, 
layer, and a short explanation of the error are reported.

Requirement: You must enable teardrops before you can check them. Tools menu > Options > 
Routing tab > select Generate Teardrops check box > click OK.

Accessing

• Tools menu > Options > Teardrops tab > Check button

Figure 45-69. Check Teardrops Dialog Box

Disable “Check for 
Updates” functionality

Determines if PADS automatically checks for a new version of 
the software.
Click to stop PADS from automatically checking for a new 
version of the PADS products; click to clear to have PADS 
automatically check for a new version.

Table 45-66. Check Teardrops Dialog Box contents 

Name Description

Location list The location of the teardrop error. 
Tip: Click an error to pan to it in the design.

Table 45-65. Check for Updates Dialog Box contents (cont.)

Name Description
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Class Rules Dialog Box

Related Topics

Modifying Net Properties

Class Rules Dialog Box
Use the Class Rules dialog box to create and manage classes of nets, and to define design rules 
that apply to them.

Accessing

• Setup menu > Design Rules > Class button

Errors Lists the total number of teardrop errors in the design

Explanation list The reason for the error selected in the Location list.

Disable Panning Specifies to not pan to the error selected in the Location list.

Clear Errors Clears the error markers in the design.

Start Runs the teardrop check.

View Report Lists the most recently run report results in your default text 
editor.

Report File Opens the Save As dialog box where you can specify the name 
of the error report and where to save it.

Table 45-66. Check Teardrops Dialog Box contents (cont.)

Name Description
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Figure 45-70. Class Rules Dialog Box

Table 45-67. Class Rules Dialog Box 

Name Description

Class name Specifies the name of the class.

Class list Lists all class names.

Add Adds the class name to the Class list.

Delete Removes the selected class from the Class list.

Rename Renames the class selected in the Class list with the text in the 
Class Name box.

Show Classes with rules Specifies to show only classes that have rules.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

HiSpeed Opens the HiSpeed Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Nets Available list Lists the nets available for this class.
Tip: Nets cannot exist in more than one class. The Available 
list displays only nets that have not been assigned to a class.

Nets Selected list Lists the nets selected for this class.
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Clearance Checking Setup Dialog Box

Related Topics

Creating Class Design Rules

Deleting a Design Rule Class

Adding Nets to an Existing Design Rule Class

Removing Nets from a Design Rule Class

Modifying Class Design Rules

Renaming a Design Rule Class

Resetting Class Rules to Default Rules

Displaying the Nets of a Class Design Rule

Design Rule Hierarchy

Clearance Checking Setup Dialog Box
Use the Clearance Checking Setup dialog box to specify which clearances to check during a 
Clearance verification.

Accessing

• Tools menu > Verify Design > Clearance check > Setup button

Add >> Moves the net from the Available list to the Selected list.

<< Remove Moves the net from the Selected list to the Available list.

Picture below rule 
button

The picture below each type of rule button identifies which 
rules hierarchy level is used for that rule type. The meaning of 
the picture corresponds to the button in the Hierarchy area of 
the Rules dialog box. For example, if you select a class in the 
Class list and a green polygon appears below the Clearance 
button, then the default values apply to the class.
See also: Non-Default Rules Indicators

Default Removes non-default rules from the selected classes, so that 
only default rules apply.

Table 45-67. Class Rules Dialog Box (cont.)

Name Description
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Figure 45-71. Clearance Check Setup Dialog Box

Table 45-68. Clearance Check Setup Dialog Box contents 

Name Description

Net to All Checks clearance rules from all levels of the Rules Hierarchy 
(all nets against all foreign obstacles).

Board Outline Checks clearance rules of net objects against the board outline 
and board cut outs (pins, vias, traces, and copper). When 
clearance checking against the board outline, the edge of the 
object is checked against the centerline of the board outline.
Requirement: You must also select the Body to body check 
box to check component outlines against the Board outline.

Off Board Text Checks for off board text and flags all instances of off board 
text as clearance errors.

Keepout Checks for keepout restriction violations.
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Clearance Checking Setup Dialog Box

Same Net Checks clearances between objects along the same net. Object 
to object checking includes the checks listed below:

• Pad edge to pad edge—

• Pad edge to inside corner of trace—

• SMD edge to pad edge—

• SMD edge to inside corner of trace—

• Acute angle between pad and trace—

Drill to Drill Checks clearances between all drill holes. Pad stack drill size 
plus the drill oversize value calculate the diameter for plated 
holes.
Restriction: Drill to Drill errors are reported for only one layer 
in a drill pair.

Partial Via drills Checks for via configurations that can cause drilling problems 
during fabrication, specifically, configurations where two 
partial vias:
• Are at the same location,
• Have different drill sizes, and
• Share a layer (for example, VIA1-2, VIA2-4)

Restriction: This option is available only when Drill to Drill 
is selected.

Trace Width Checks traces in excess of minimum and maximum widths.

Table 45-68. Clearance Check Setup Dialog Box contents (cont.)

Name Description
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Related Topics

Setting Up Clearance Checking

Clearance Rules Dialog Box
Use the Clearance Rules dialog box at any level of the rules hierarchy to define minimum edge-
to-edge spacing between objects and to define trace widths. Online DRC and design verification 
check and report clearance violations. Object types are checked against other object types as 
well as against themselves, such as traces. Values are in current design units.

Body to Body Checks actual part outline against actual part outline. 
Tip: When used in combination with the Board outline 
check, you can check component outlines against the 
board outline.

The part outline is the furthest extent of any decal object on the 
following layers.
• component layer (top or bottom)
• associated silkscreen layer for component layer (silkscreen 

top or bottom)
• Layer 0 (zero)

Typically, the furthest object is either the silkscreen or the pads 
or a combination of both.
If you have a larger placement outline on Layer 20, see the 
Placement Outline check.
Restriction: This option is not available for Latium design 
checking.

Placement Outline In default layer mode, Placement Outline checks outline 
against outline on layer 20, not on electrical layers.
Tip: Changing from default layer mode to increased layer 
mode increases all nonelectrical layer numbers by 100, so in 
increased layer mode, Placement Outline checks outline 
against outline on layer 120.
You can create outlines on layer 20 (or layer 120) that do not 
exactly match the actual silkscreen component outline. By 
setting a larger outline on this layer you can leave an area near 
a component open for other purposes. Using the Placement 
Outline check, you ensure that this area is left open.
See also: To Nudge Overlapping Parts

Latium Error Markers Shows Latium error markers. A Latium error marker indicates 
that you have Latium rules in your design. You can only check 
these rules by using the Latium Design Verification option in 
the Verify the Design dialog box.

Table 45-68. Clearance Check Setup Dialog Box contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.4986

Clearance Rules Dialog Box

Accessing

• Setup menu > Design Rules > choose a hierarchy level > Clearance button

Figure 45-72. Clearance Rules Dialog Box

Table 45-69. Clearance Rules Dialog Box 

Area Description

Same net Specifies the space that must be maintained between items that are of the 
same net.
• SMD—surface mount pad

Tip: The SMD-to-via value is also used for SMD-to-SMD and SMD-
to-Pad rules

• Corner—first trace bend point
• Pad—through hole pad
• Trace-to-corner—trace and the bend point of another trace. For 

example, a trace splits at a T-junction and one of the two traces has a 
bend point.
Restriction: Trace-to-Corner clearance is only used by PADS 
Router. It is not used in Layout (either by Online DRC or checked by 
the Verify Design tool).

Tip: To set the same value for an entire row, column or the table, click on 
a column heading (such as Corner, Via), row heading (such as Via, 
SMD), or All. Then type a value and click OK to apply the value.
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Tips: 

• You can set default clearance rules on a per-layer basis by creating All-to-Layer 
conditional rules. See also: Conditional Rule Setup Dialog Box

• The BGA Route Wizard uses properties defined in this dialog box. See also: BGA 
Route Wizard Dialog Box

Trace width Specifies the allowed range of trace widths.
• Minimum—Minimum width for interactive routing
• Recommended—Width to use when routing begins
• Maximum—Maximum width for interactive routing

Tip: Routing respects the minimum and maximum values when it varies 
trace width to achieve high-speed routing functions, for example, 
impedance matching.

Clearance Specifies the space that must be maintained between items of different 
nets.
• Trace to Trace—The Gap value set in the Differential Pairs dialog 

box has precedence over this value.
• SMD—surface mount pad
• Corner—first trace bend point
• Pad—through hole pad
• The Copper to Via, Pad, SMD or Drill values are also used to create 

the default thermals and antipads. 
See also: Design Rule Versus Pad Stack - Thermals and Antipads.

Tips: 
• To set the same value for an entire row, column or the whole 

table/matrix, click on a column heading, row heading, or All. Then 
type a value and click OK to apply the value.

• Chamfered path copper uses the Solid Copper property which 
switches the copper to use trace clearances.

Other Specifies the clearances between drill and component body objects.

Delete 
button

Removes non-default clearance rules at the current level of the rules 
hierarchy.
Restriction: You cannot delete the Default clearance rules.

OK button Restriction: This button is unavailable if you are not licensed for the 
advanced rules but you have opened this dialog box to an advanced level 
of the rules hierarchy through the Properties of an object. 
For example, with a pin pair selected, you right-click and click 
Properties. In the Trace Properties dialog box, you click the Rules button 
and in the Pin Pair Rules dialog box, you click Clearance. In the resulting 
Clearance Rules dialog box, the OK button is unavailable.

Table 45-69. Clearance Rules Dialog Box (cont.)

Area Description
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Cluster Information Properties Dialog Box

Related Topics

Design Rule Hierarchy

Cluster Information Properties Dialog Box
The Cluster Information Properties dialog box modifies cluster attributes for the selected 
component or union that belongs to a cluster.

Accessing

• Select a union within a cluster > Right-click > Properties > Cluster Info button

Figure 45-73. Cluster Info Properties Dialog Box

Related Topics

Union Properties Dialog Box

Cluster Manager Dialog Box
Use Cluster Manager to display and manage cluster members and unions. You can move cluster 
members and unions from one cluster to another and break, or delete, clusters. Cluster Manager 
works similarly to the Microsoft Windows Explorer; with it you can view items at the top level 
or at any level of the hierarchy.

Table 45-70. Cluster Info Properties Dialog Box 

Name Description

Seed Identifies a cluster as a base, or top level cluster, during build 
and grow operations. PADS Layout searches outward from 
seed clusters to identify other clusters that you can add to the 
seed cluster.

Skip while Building 
Cluster

Ignores the union or cluster during Grow Incremental and 
Grow Automatic operations.
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Accessing

• Tools menu > Cluster Manager

Figure 45-74. Cluster Manager Dialog Box

Table 45-71. Cluster Manager Dialog Box Contents 

Name Description

Hierarchy Keeps track of the current cluster hierarchy. Top is the default 
level. Expanding a cluster causes the cluster, union, or member 
name to appear, separated by a forward slash (/).

Name Displays the name of the highlighted cluster or union. Rename 
a cluster or union by typing a new name and clicking Rename. 

Rename Renames the selected cluster.

List Boxes Use either of the two list boxes for viewing all clusters, unions, 
and components in the design. The Top Level radio button 
marks the active list. Items within the lists are identified by the 
prefixes shown:
• Clusters—CLU
• Unions—UNI
• Components—com
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Cluster Placement Dialog Box

Related Topics

Using the Cluster Placement Dialog Box

Cluster Placement

Cluster Placement Dialog Box
Use the Cluster Placement dialog box to build new clusters, place clusters within the board 
outline, and place parts within the board outline.

Accessing

• Tools menu > Cluster Placement

Figure 45-75. Cluster Placement Dialog Box

Move area Moves members of a cluster from one list to another.

Expand Changes the contents of the list box to show only the objects in 
the cluster. The Top Level radio button changes to display the 
cluster name.

Collapse Returns to the top-level view, collapsing the hierarchy.

Break Deletes the selected cluster. You must click OK to remove the 
cluster from memory.

Find Opens the Find in hierarchy dialog box where you can find a 
specific cluster, union, or component name within the listed 
hierarchy. If a searched name is part of a cluster or union, it 
expands to show all members.

Table 45-71. Cluster Manager Dialog Box Contents (cont.)

Name Description
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Table 45-72. Cluster Placement Dialog Box Contents 

Name Description

Build Clusters Automatically creates new clusters outside the board outline. 
Automatically created clusters default to open.
Click the Build Clusters Setup button to customize the clusters.
Setup—Opens the Build Clusters Setup dialog box. 
Unavailable till you click the Build Clusters button.

Place Clusters Automatically positions clusters within the board outline, but 
does not actually move their associated parts.
Setup—Opens the Place Clusters Setup dialog box. 
Unavailable till you click the Place Clusters button.

Place Parts Performs automatic placement operations. Click the Place 
Parts Setup button to customize placing clusters.
Setup—Opens the Place Parts Setup dialog box.
Unavailable till you click the Place Parts button.

Run Click to activate one or more function operations; for example, 
you can build clusters, place clusters, and place parts in one 
pass. Starts the operation and displays the Cluster Placement 
Status dialog box.
Restriction: This button is unavailable until you select one of 
the three buttons listed above.
You can activate more than one function for multiple 
operations; you can build clusters, place clusters, and place 
parts in one pass.

Ignore Invisible Nets Excludes any invisible nets from the build or placement 
strategy. To include invisible nets click to clear Ignore 
Invisible Nets.

Ignore Plane Nets Excludes plane layer nets in the build or placement strategy. 
To include plane nets click to clear this option.

Disperse Places unglued components outside the board outline to clear 
the board interior. Dispersion is based on part height and is 
sorted by length. Glued parts are not affected. Clusters are 
dispersed if you are in Cluster View Mode when you use 
Disperse.

Length Minimization Rearranges the pin pairs on the board. The pin pairs are 
calculated based on the minimum length criteria you set up 
using Routing Rules.
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Cluster Placement Status Dialog Box

Related Topics

Using the Cluster Placement Dialog Box

Cluster Placement

Cluster Placement Status Dialog Box
The Cluster Placement Status dialog box displays the percentage of completion for each pass 
that you enable using Setup. The right side of this dialog box displays estimated and elapsed 
time for placement passes.

Figure 45-76. Cluster Placement Status Dialog Box

Nudge Runs a Nudge pass in automatic mode, automatically adjusting 
parts that fail Clearance Checking.
Tips:
• Nudge considers test points as glued objects.
• Nudge ignores components that are part of a physical 

design reuse.

Save Saves the current strategy for all three operations.

Load Opens a saved strategy file.

Table 45-72. Cluster Placement Dialog Box Contents (cont.)

Name Description
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After completion of placement operations, errors appear in the Placement Violations dialog box.

Placement Violations Dialog Box

Figure 45-77. Placement Violations Dialog Box

Double-click an item in the list for information.

Figure 45-78. Placement Violations Info Dialog Box

Related Topics

Using the Cluster Placement Dialog Box

Cluster Placement

Table 45-73. Cluster Placement Status Dialog Box Contents 

Name Description

Interrupt Pauses the placement process and opens the Auto Placement 
Prompt.
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Cluster Properties Dialog Box

Cluster Properties Dialog Box
Use the Cluster Properties dialog box for information on and to modify a selected cluster.

Accessing

• Select a cluster > Right-click > Properties

Figure 45-79. Cluster Properties Dialog Box

Table 45-74. Cluster Properties Dialog Box Contents 

Name Description

Name Name of the currently selected cluster. To rename the cluster, 
type a new name. 

X/Y Coordinates Current coordinates of the cluster. To move the cluster to a 
new location, type new values.

Glued Prevents the cluster from moving through manual or automatic 
placement processes.

Top Area/Bottom Area The area the cluster encompasses based on the area of each 
cluster member.

Members Individual parts that are members of the selected cluster.

Delete Deletes the cluster and converts its members as individual 
parts.
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Cluster Grow Incremental Dialog Box
Use the Cluster Grow Incremental dialog box to cycle through other clusters in the design and 
select which ones to absorb into the current cluster.

Figure 45-80. Cluster Grow Incremental Dialog Box

Seed Toggle Selects parts from which you should start building clusters. 
Analysis for other parts to add to the cluster is based on these 
parts and on connectivity.

Incremental Opens the Cluster Grow Incremental dialog box to 
incrementally add new members to the cluster.
See also: Modifying Existing Clusters

Automatic Opens the Cluster Size Limit Definition dialog box to 
automatically add new members to the cluster. 
See also: Modifying Existing Clusters

Seed Identifies a cluster as a base, or top level cluster, during build 
and grow operations. PADS Layout searches outward from 
seed clusters to identify other clusters that you can add to the 
seed cluster.

Strong Places cluster members as close together as possible during 
placement operations. The minimum distance for placement is 
the same distance for part clearances in Design Rules.

Closed Prevents the cluster from being deleted during the Build 
Clusters pass of Cluster Placement.

Skip while Building 
Cluster

Ignores the cluster during Grow Incremental and Grow 
Automatic operations.

Table 45-74. Cluster Properties Dialog Box Contents (cont.)

Name Description
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Collaboration Data Import Dialog Box

Cluster Size Limit Definition Dialog Box
Use the Cluster Size Limit dialog box to automatically add new members to the cluster based on 
a max number.

Figure 45-81. Cluster Size Limit Definition Dialog Box

Related Topics

Using the Cluster Placement Dialog Box

Cluster Placement

Collaboration Data Import Dialog Box
Use the Collaboration Data Import dialog box to target any imported 2D lines to a specific 
documentation layer. Collaboration data often includes markups that are physically associated 
with the issues. The markups are imported as 2D lines to the documentation layer selected in the 
dialog box.

Accessing

• In the Collaboration Markups dialog box, click the Import button, browse to and 
select a file, then click Open.

Figure 45-82. Collaboration Data Import Dialog Box
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Compare/ECO Tools Dialog Box, Comparison 
Tab

Use the Comparison tab on the Compare/ECO Tools dialog box to specify the elements to 
include in the design comparison.

Tip: During design comparison, PADS Layout ignores the reuse definition and uses the actual 
elements in the physical design reuse.

Accessing

• Tools Menu > Compare/ECO Tools > Comparison tab

Table 45-75. Collaboration Data Import Dialog Box Contents

Name Description

Markups Layer Select a documentation layer from the list, as the location 
for any 2D line markups that might be included in the 
collaboration data.

Change layer name to Select the check box to automatically change the name of 
the layer as listed in the Layers Setup. You can accept the 
default layer name or type a new one.
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Compare/ECO Tools Dialog Box, Comparison Tab

Figure 45-83. Comparison Tab

Table 45-76. Comparison Tab contents 

Name Description

Comparison Options area—if you are testing the effect of these options, you should 
save a copy of your design before you import an .eco file since there is no undo of the .eco 
import.



Compare/ECO Tools Dialog Box, Comparison Tab

PADS Layout User’s Guide and Reference Manual, PADS 9.4 999

Compare only ECO 
Registered Parts

Comparison excludes non-ECO-registered parts. Non-ECO-
registered parts may include mechanical or non-electrical parts 
present in the PCB design and not present in the schematic. To 
include all parts during comparison, clear Compare Only ECO 
Registered Parts.

Compare only ECO 
Registered Attributes

Comparison excludes non-ECO-registered attributes.
Tip: Via attributes are not ECO registered and cannot be 
added, deleted, or changed during the ECO process.

Compare Part Decals Comparison includes part decals.

Compare Part Placement Comparison includes positional differences in component 
placement.

Compare Net 
Scheduling

Comparison includes net scheduling differences. Net 
rescheduling is performed in PADS Router. For more 
information, see Rescheduling Nets in the PADS Router Help.

Name Comparison 
Options area

• Compare Net Names and Reference Designators. 
Rename as Necessary—Compare differences using 
reference designators and net names.
Best used to minimize changes to routed traces. Selecting 
this option may result in the positional swapping of parts. 
For example, if routed trace changes are minimized when 
R1 and R12 are swapped, simultaneously rename R12 to 
R1 and R1 to R12, and then reconnect R1 and R12 to the 
original nets.

• Compare Net Names and Reference Designators. Prefer 
to Add or Delete Parts Instead of Renaming—Compare 
differences using reference designators and net names on 
the basis that few reference designators have been renamed 
and nets have not been renamed.
Best used to minimize the positional swapping of parts, and 
the design disruption that may result.

• Compare Connectivity and Topology (not names). 
Rename as Necessary—Compare differences without 
using reference designators or net names. Compare 
differences using pin names, part type names, and so on.
Best used to compare designs when parts and nets have 
been renamed, and minimal interconnect changes have 
been performed.

Table 45-76. Comparison Tab contents (cont.)

Name Description
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Compare/ECO Tools Dialog Box, Comparison Tab

Ignore the Unused Pins 
Net

Specifies to exclude the unused pins net in the original design.
The unused pins net contains pins that have no logical net 
association. An unused pins net may be created when routing 
with SPECCTRA or with other tools in the PCB design 
process. 
Tip: If you clear this option and you update the PCB layout 
from a schematic or previous PCB layout, the unused pins net 
may be deleted.\

Net Name The name of the unused pins net. The maximum netname 
length is 47 characters. You can use any alphanumeric 
characters except curly braces { }, asterisks *, spaces, 
questions marks, or commas.

Attribute and Design 
Rule Comparison Level 
area

See the Comparing Design Element Attributes table.

Comparison Objects 
area

Lists what you’ve selected in the Attribute and Design Rule 
Comparison Level area

Run Compares the designs. 
Restriction: Available when you select an option in the 
Output Options area on the Documents tab.

Table 45-76. Comparison Tab contents (cont.)

Name Description
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Related Topics

Comparing Designs

Working with PADS Logic

Table 45-77. Comparing Design Element Attributes 

Select With To Compare

Compare 
Attributes

PADS Logic Object Types
Tip: Select this option to 
compare PADS Logic 
netlists that have only parts 
defined.

Only part attributes (parts and nets)
Each part receives attributes from its 
corresponding Decal and Part Type, but 
modification is performed only at the part 
level.

DxDesigner objects
Tip: Select this option to 
compare DxDesigner 
netlists where board, part, 
net, and pin attributes are 
defined.

Board, parts, nets, and pin attributes
Each part receives attributes from its 
corresponding Decal and Part Type. Nets 
assume attributes from any net class to 
which they belong. Part and net 
differences are updated only at the part or 
net level respectively. There is no 
assumed hierarchy for pin attributes.

All Object Types
Tip: Select this option 
when you are comparing 
different versions of a 
PADS Layout design.

All attributes (board, parts, nets, pins, net 
classes, part types, part decals).
No attribute hierarchy is assumed; all 
object types are compared and updated at 
their current level.

Compare 
Design Rules

PADS Logic Object Types Net and net class rules

DxDesigner Object Types • Net and net class rules
• General rules
• Differential pairs rules

All Object Types All design rules

Both 
Compare 
Attributes and 
Compare 
Design Rules

PADS Logic Object Types • Part and net attributes
• Net and Net Class rules
• General and Conditional rules
• Differential Pairs rules

DxDesigner Object Types • Board, part, net, and pin attributes
• Net and Net Class rules
• General rules
• Differential pairs rules

All types of objects • Attributes of all object types
• All design rules



PADS Layout User’s Guide and Reference Manual, PADS 9.41002

Compare/ECO Tools Dialog Box, Documents Tab

Working with DxDesigner

Compare/ECO Tools Dialog Box, Documents Tab
Use the Documents tab on the Compare/ECO Tools dialog box to specify the designs to 
compare and the files to create. 

Accessing

• Tools Menu > Compare/ECO Tools

Figure 45-84. Documents Tab
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Related Topics

Comparing Designs

Working with PADS Logic

Working with DxDesigner

Compare/ECO Tools Dialog Box, Update Tab
Use the Update tab on the Compare/ECO Tools dialog box to specify the types of data to update 
in the original design and to specify whether to update library data. 

Table 45-78. Documents Tab contents 

Name Description

Original Design to 
Compare and Update

• Use Current PCB Design—Specifies to use the current 
design as the original to compare and update.

• Original Design File—Specifies to browse for another 
design to use as the original to compare and update.

Tip: Click to clear Use Current PCB Design to browse for 
another one.

New Design with 
Changes

• Use Current PCB Design—Specifies to use the current 
design as the new design with changes.

• New Design File—Specifies to browse for another design 
to use as the new design with changes.

Tip: Click to clear Use Current PCB Design to browse for 
another one.

Generate Differences 
Report

Specifies to create a report file containing a description of the 
differences between the two design versions. This file is 
named Layout.rep and is stored in the \PADS Projects folder.

Generate ECO File Specifies to create an ECO file. Type or browse to the ECO 
file. The ECO file contains ECO commands that describe the 
changes needed to update the original design to match the new 
design.

Generate ASCII File for 
Back Annotation to 
Schematic

Specifies to create a file that contains information to send back 
to the schematic, click the Generate ASCII File for Back 
Annotation to Schematic box. You must also type the path 
and name of the file to create in the ASCII Filename box.

Run Compares the designs. 
Restriction: Available when you select an option in the 
Output Options area.
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Compare/ECO Tools Dialog Box, Update Tab

Accessing

• Tools Menu > Compare/ECO Tools > Update tab

Figure 45-85. Update Tab
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Related Topics

Comparing Designs

Working with PADS Logic

Working with DxDesigner

Table 45-79. Update Tab contents 

Name Description

Update Original Design Specifies to update the PCB layout in memory to match the 
new design by automatically importing into PADS Layout the 
ECO file resulting from design comparison.
Tip: The Update Original Design option is unavailable unless 
both of the following options are selected:
• Use Current Design in the Original Design to Compare 

and Update area on the Documents tab.
• Generate ECO File on the Documents tab.

Pause Before Updating 
Original Design

Specifies that you want to view the differences report or ECO 
file before automatically importing the ECO file into the 
original PADS Layout design in memory.
Restriction: Available only when Update Original Design is 
checked on the Update tab and Use Current PCB Design is 
checked in the Original Design to Compare and Update area 
on the Documents tab.

Update Part Types in 
Library

Specifies to update the PADS Layout part type library by 
automatically importing the PADS-format ASCII part type file 
(.p) generated with ViewPCB in DxDesigner.

Party Type ASCII File Specifies the ASCII file to use. Type or browse for the file 
name.

Import to Library list Specifies the Library in which you want to import the updates.

New Library button Specifies that you want to create a new library in which to 
import the updates.

Import Mode for Library 
Parts area

Specifies how you want the changes to be imported:
• Do Not Overwrite Existing Parts
• Always Overwrite Existing Parts
• Prompt for Each Part to Overwrite

Run Compares the designs. 
Restriction: Available when you select an option in the 
Output Options area on the Documents tab.
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Component Layer Associations Dialog Box

Component Layer Associations Dialog Box
Use the Component Layer Associations dialog box to associate, or otherwise map, which 
documentation layers go with the selected layer when a top or bottom layer is set as a 
component layer. CAM (Negative) planes should only have one net assigned. Split/Mixed may 
have multiple nets assigned.

The layer associations made in this dialog box are used by CAM routines for output. For 
example, when you output a silkscreen for the top, any items on the documentation layer you 
associated for silkscreen are automatically added to the CAM document. 

Accessing

• Setup menu > Layer Definition > Associations button

Figure 45-86. Component Layer Associations Dialog Box

Table 45-80. Component Layer Associations Dialog Box Contents 

Name Description

Name The name of the layer selected in the Layers Setup dialog 
box. This is the layer you are associating with the 
components.

Silkscreen Specifies which Silkscreen layer you want to associate:
• None
• Silkscreen Bottom
• Silkscreen Top
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Related Topics

Setting Up an Outer Layer

Component Properties Dialog Box
Use the Component Properties dialog box to modify component placement, decal, cluster, and 
label information.

Accessing

• Select a component > Right-click > Properties

Figure 45-87. Component Properties Dialog Box

Paste Mask Specifies which Paste Mask layer you want to associate:
• None
• Paste Mask Bottom
• Paste Mask Top

Solder Mask Specifies which Solder Mask layer you want to associate:
• None
• Solder Mask Bottom
• Solder Mask Top

Assembly Specifies which Assembly layer you want to associate:
• None
• Assembly Drawing Bottom
• Assembly Drawing Top

Table 45-80. Component Layer Associations Dialog Box Contents (cont.)

Name Description
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Component Properties Dialog Box

Table 45-81. Component Properties Dialog Box 

Name Description

Ref. Des. The name of the reference designator of the selected part.

X,Y coordinates Displays the current coordinates of the queried part. Type new 
coordinates to move the part.

Rotation list Displays the current rotation angle of the part. Type a new 
rotation angle to change the rotation of the part.

Layer list Displays the layer on which the part is located. Click a new 
layer from the list to move the component to another layer.

Glued Sets whether the component is glued. Click to select the Glued 
check box to glue the component to the board and prevent 
component movement. Click to clear Glued to unglue a 
component.
If multiple parts are selected, and some of the parts are glued 
and others are not, the Glued check box appears gray (in an 
undefined state). You can click to select the Glued check box 
to glue all selected parts or click to clear the Glued check box 
to unglue all selected parts. 

# of Connections Lists the number of connections attached to the part.

Decal list Lists the current part decal. Click a different decal from the list 
to change the decal.
Caution: You can assign decals using this dialog box outside 
of ECO mode. This allows attribute changes even if the 
attribute is ECO-registered. For example, you can change the 
decal for U1 from a DIP 14 with a Geometry.Height attribute 
set at 200, to a SOIC 14 with a Geometry.Height attribute set at 
100. Since you are not in ECO mode, the change is not 
recorded in the .eco file. 

Part Outline Width Displays the current width of component outlines. PADS 
Layout only changes the part outline widths of selected 
components' decals, not the widths of all decals in the design. 
See also: To Change Part Outline Width

Pad Stack button Opens the component in the Pad Stack Properties dialog box.

Attributes button The Object Attributes dialog box opens to assign attributes and 
values to any selected objects.

Rules button Opens the Component Rules Dialog Box with the selected 
components highlighted in the Components list.
See also: Design Rule Hierarchy
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There are three tabs that change the content of the lower half of the dialog box:

Part Tab
Use the Part tab in the Component Properties dialog box to view all information about the part. 
This is not editable.

Figure 45-88. Part Tab

Cluster Tab
Use the Cluster tab in the Component Properties dialog box to exclude clusters or set one as a 
base cluster. 

Figure 45-89. Cluster Tab

Part Tab Lists all information about the part.

Cluster Tab Exclude clusters or set one as a base cluster.

Labels Tab Set Part Label properties.
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Component Properties Dialog Box

Labels Tab

Figure 45-90. Labels Tab

Related Topics

Modifying Component Properties

Table 45-82. Cluster Tab Contents 

Name Description

Skip While Building 
Cluster

Excludes the component from cluster builds. Click to exclude 
the selected part from cluster build operations.

Seed Identifies a cluster as a base, or top level cluster, during build 
and grow operations. PADS Layout searches outward from 
seed clusters to identify other clusters that you can add to the 
seed cluster.

Table 45-83. Labels Tab Contents 

Name Description

Label list Specifies the label you want to create or edit.

Part Label Properties Opens the Part Label Properties dialog box.
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Component Properties Dialog Box, Associated 
Nets

Use the Component Properties dialog box to modify component placement, decal, cluster, label, 
and associated net information.

Accessing

• Select a component > Right-click > Properties

Figure 45-91. Component Properties Dialog Box, Associated Nets,



PADS Layout User’s Guide and Reference Manual, PADS 9.41012

Component Properties Dialog Box, Associated Nets

Table 45-84. Component Properties Dialog Box, Associated Nets Contents 

Name Description

Ref. Des. The name of the reference designator of the selected part.

X,Y coordinates Displays the current coordinates of the queried part. Type new 
coordinates to move the part.

Rotation list Displays the current rotation angle of the part. Type a new 
rotation angle to change the rotation of the part.

Layer list Displays the layer on which the part is located. Click a new 
layer from the list to move the component to another layer.

Glued Sets whether the component is glued. Click to select the Glued 
check box to glue the component to the board and prevent 
component movement. Click to clear Glued to unglue a 
component.
If multiple parts are selected, and some of the parts are glued 
and others are not, the Glued check box appears gray (in an 
undefined state). You can click to select the Glued check box 
to glue all selected parts or click to clear the Glued check box 
to unglue all selected parts. 

# of Connections Lists the number of connections attached to the part.

Decal list Lists the current part decal. Click a different decal from the list 
to change the decal.
Caution: You can assign decals using this dialog box outside 
of ECO mode. This allows attribute changes even if the 
attribute is ECO-registered. For example, you can change the 
decal for U1 from a DIP 14 with a Geometry.Height attribute 
set at 200, to a SOIC 14 with a Geometry.Height attribute set at 
100. Since you are not in ECO mode, the change is not 
recorded in the .eco file. 

Part Outline Width Displays the current width of component outlines. PADS 
Layout only changes the part outline widths of selected 
components' decals, not the widths of all decals in the design. 
See also: To Change Part Outline Width

Pad Stack button Opens the component in the Pad Stack Properties dialog box.

Attributes button The Object Attributes dialog box opens to assign attributes and 
values to any selected objects.

Rules button Opens the Component Rules Dialog Box with the selected 
components highlighted in the Components list.
See also: Design Rule Hierarchy

Part tab Lists all information about the part.
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Clusters tab Exclude clusters or set one as a base cluster.
• Skip While Building Cluster

Select to exclude the selected part from cluster build 
operations.

• Seed
Identifies a cluster as a base, or top level cluster, during 
build and grow operations. PADS Layout searches outward 
from seed clusters to identify other clusters that you can 
add to the seed cluster.

Labels tab Set Part Label properties.
• Label list

Specifies the label you want to create or edit.
• Part label properties button

Opens the Part Label Properties dialog box.

Associated nets list Name(s) of the associated nets attached to or going through the 
component. 
An associated net’s name is a sorted list of net names separated 
by asterisks (*).

Table 45-84. Component Properties Dialog Box, Associated Nets Contents 

Name Description
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Component Properties Dialog Box, Associated Nets

Associate nets Select the checkbox to associate the component’s nets.
Tip: This checkbox is also set by the Associate Nets popup 
command for selected components.
Restrictions: 
• If a net of a selected component is excluded from net 

association, it cannot be included in an associated net.
(A component or net is excluded from net association if its 
Associate nets and Allow net association... checkboxes are 
both cleared.)

• If a selected component has more than two pins, the 
following conditions must apply, or the component cannot 
be an associating component, that is, the associated net 
can’t go through the component:
• All pins must connect to a gate.
• Each gate must have exactly two pins.

Clear the checkbox to remove the component from net 
association, that is, to prevent an associated net from going 
through it. 
Tip: This checkbox is also cleared by the Disable Net 
Association popup command for selected components.
Restriction: If the Associate net checkbox in the Net 
Properties dialog box is checked for the component’s nets, you 
must also clear the Allow association by refdes prefix and by 
net checkbox.

Clear both checkboxes to prevent the selected components 
from being an associating componentin any associated net 
(that is, to prevent any associated net from going through 
them).

Table 45-84. Component Properties Dialog Box, Associated Nets Contents 

Name Description
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Related Topics

Modifying Component Properties

Component Rules Dialog Box
Use the Component Rules dialog box to define design rules that apply to components.

Restrictions

•
• You can define Component Rules in PADS Layout; however, these rules are used in 

PADS Router only.

Accessing

• Setup menu > Design Rules > Component button
or
Select a component > right-click > Show Rules

Allow net association by 
refdes prefix and by net

Select the checkbox to allow the component’s nets to be 
included in associated nets automatically by specifying the 
component’s refdes prefix in the Associated Nets dialog box, 
or by setting the Associate net checkbox in the Net Properties 
dialog box.

Clear the checkbox to prevent association of the selected 
components’ nets through those components by net or by 
refdes prefix. The nets can still be associated by the other 
components they’re attached to.
Tip: This checkbox is also cleared by the Disable Net 
Association popup command for selected components.
Restriction: Components that have the Associate nets 
checkbox checked are not disabled from association by 
clearing this check box.

Clear both checkboxes to prevent the selected components 
from being an in any associated net (that is, to prevent any 
associated net from going through them).

Discrete length Enter the length to be used for this component when 
calculating associated net length.

Table 45-84. Component Properties Dialog Box, Associated Nets Contents 

Name Description
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Component Rules Dialog Box

Figure 45-92. Component Rules Dialog Box

Table 45-85. Component Rules Dialog Box 

Name Description

Components list Lists all components in the design.

Show components with 
rules

Specifies to show only components that have rules.

Using Decal Specifies to display components for a specific decal.
Tip: Select (All_decals) to display all decals.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

Fanout Opens the Fanout Rules Dialog Box.

Pad Entry Opens the Pad Entry Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule 
button

The picture below each type of rule button identifies which 
rules hierarchy level is used for that rule type. The meaning of 
the picture corresponds to the button in the Hierarchy area of 
the Rules dialog box. For example, if you select a class in the 
Class list and a green polygon appears below the Clearance 
button, then the default values apply to the class.

Selected: Lists the components selected in the Components list.
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Related Topics

Creating Component Design Rules

Modifying Component Design Rules

Resetting Component Rules to Default Rules

Design Rule Hierarchy

Conditional Rule Setup Dialog Box
Use the Conditional Rule Setup dialog box to setup clearance and high-speed rules that come 
into effect only when objects named in the rule are adjacent or on a specific layer. For example, 
the default clearance between nets is X, but when net A is adjacent to net B, the clearance is Y.

Requirement: The Advanced Rules option is required to setup conditional design rules.

Tip: Conditional rules override design rules in the design hierarchy and high-speed rules.

Accessing

• Setup menu > Design Rules > Conditional Rules button

Part type: Lists the part type(s) associated with the component(s) selected 
in the Components list.

Decal: Lists the decal(s) associated with the component(s) selected in 
the Components list.

Default Removes non-default rules from the selected components, so 
that only default rules apply.

Table 45-85. Component Rules Dialog Box (cont.)

Name Description
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Conditional Rule Setup Dialog Box

Figure 45-93. Conditional Rule Setup Dialog Box

Table 45-86. Conditional Rule Setup Dialog Box Contents 

Name Description

Source rule object Specifies the object for which to set the rule.

From net Specifies to display pin pairs for a specific net.
Tip: Select (All_nets) to display all pin pairs.
Restriction: Available only if Pin pairs is selected in the 
Source rule object area.

Against rule object Specifies the object against which to set the rule.
Tip: For pin pair objects, you can display pin pairs for a net by 
selecting the net in the From net list.

From net Specifies to display pin pairs for a specific net.
Tip: Select (All_nets) to display all pin pairs.
Restriction: Available only if Pin pairs is selected in the 
Against rule object area.
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Related Topics

Deleting a Conditional Rule

Modifying a Conditional Rule

Design Rule Hierarchy

See the conditional rules topics listed in the Creating Rules for Your Design topic.

Confirm Pin Swap Dialog Box
Use the Confirm Pin Swap dialog box to confirm and proceed with swapping pins that do not 
have swap IDs or have different swap IDs.

Accessing

• ECO Toolbar > Swap Pin > select pins without a swap ID or with different swap IDs

Apply to layer Specifies to apply the conditional rule to a specific layer.
Tip: Select (All layers) to apply it to all layers.
Restriction: Unavailable if Layer is selected in the Against rule 
object area.

Existing rule sets list Lists all rules previously created.

Clearance Specifies that this is a Clearance rule set. You can set the 
clearance for all objects in the Object to object box. But this 
box is unavailable if there are differing values within the 
Clearance Rules matrix, and you must click Matrix, and enter 
the values within the Clearance Rules dialog box.

Matrix button Opens the Clearance Rules Dialog Box.

High speed Specifies that this is a High Speed rule set. Set the parallel and 
tandem length and gap in the boxes.
Tip: For reporting purposes, nets and pin pairs in the Source 
rule object list are identified as aggressors. If a class is in the 
Source rule object list, all nets in the class are identified as 
aggressors.

Create Creates the rule and displays it in the Existing rule sets list.

Delete Removes the selected rule from the Existing rule sets list.

Table 45-86. Conditional Rule Setup Dialog Box Contents (cont.)

Name Description
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Connectivity Checking Setup Dialog Box

Figure 45-94. Confirm Pin Swap Dialog Box

Related Topics

Swapping a Pin Manually in ECO Mode

Connectivity Checking Setup Dialog Box
During design verification, you can use the Connectivity Check to report isolated routing vias 
and isolated stitching vias. (An isolated stitching via is a stitching via that is not connected to 
any hatch outline or copper area.) However, to have the check report isolated stitching vias, you 
must first set it up to ignore connections to CAM planes.

Accessing

• Tools menu > Verify Design > Connectivity check > Setup button

Figure 45-95. Connectivity Checking Setup Dialog Box

Table 45-87. Confirm Pin Swap Dialog Box Contents

Name Description

Don’t display again Prevents this prompt from appearing the next time you 
swap pins with different or undefined swap IDs.
Tip: This setting is reset when you close and then return 
to the ECO Toolbar.

OK Proceeds with the swap of the pins.
Tip: If these pins are swappable, the correct process 
would be to give them identical swap IDs in the Pins tab 
of the Part Information dialog box.
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Related Topics

Setting Up Checking for Isolated Stitching Vias

Convert Pin Pairs to Chamfered Paths Dialog 
Box

Use the Convert Pin Pairs to Chamfered Paths dialog box to convert traces to chamfered copper. 
Converting traces to a copper chamfered path has two advantages over simply creating a copper 
chamfered path. You can also use the more powerful interactive router to initially route the trace 
and when you convert the trace to a chamfered path, the net assignment is automatically made.

Accessing

• Select a pin pair, multiple pin pairs, or a net > Right-click > Convert to Chamfered 
Paths

Restriction: Unrouted or partially routed pin pairs, or pin pairs belonging to reuse 
blocks, are excluded from selection.

Table 45-88. Connectivity Checking Setup Dialog Box contents 

Name Description

Ignore CAM Plane 
Connection for isolated 
stitching vias

Specifies to report isolated stitching vias as errors and marks 
them in the design, along with the other errors found during 
checking.
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Convert Pin Pairs to Chamfered Paths Dialog Box

Figure 45-96. Convert Pin Pairs to Chamfered Paths Dialog Box

Table 45-89. Convert Pin Pairs to Chamfered Paths Dialog Box contents 

Name Description

Selected pin pairs list Lists the pin pairs you selected in the design.

Select All Selects all items listed in the Selected pin pairs list.

Unselect All Deselects all items listed in the Selected pin pairs list.

Selected trace widths Lists the range of widths for the selected traces.

Polygon outline width Specifies a width value for the width of the copper outline.
Tip: Since copper is created with an outline and a fill, you can 
specify a very narrow outline width to achieve very sharp 
corners. Decrease the value for sharper corners and increase 
the value for more blunt corners. All corners are rounded with 
a radius equal to one half of the outline width.
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Related Topics

Converting a Trace to a Copper Chamfered Path

Copy to and Move to Dialog Boxes
Use the Copy to dialog box and the Move to dialog box to copy or move a project container or 
folder to another location in the vault.

Restriction: You cannot copy or move an item to any of the following locations:

• To the same folder where the folder or project you want to move or copy currently 
resides

• To the same folder that you want to move or copy

• To a folder containing a project or folder with the same name as the folder or project you 
want to move or copy

If you select any of these locations in the dialog box tree, the OK button becomes unavailable.

Accessing

• In the Vault view, right-click a project or folder, and click Copy to or Move to.

Use trace width Specifies to use the trace width as the width of the chamfered 
path. Where multiple trace widths exist, the actual trace widths 
are used. The Selected trace widths value at the top of the 
Conversion parameters area displays the range of trace widths 
of the items in the Selected pin pairs list.
Tip: Click to clear this check box to enter a value in the 
Converted path width box.

Corner chamfer width 
ratio

Specifies the ratio of the chamfered corner width to the 
chamfered path width. If the ratio is 1.0, the width of the 
chamfered corner is the same as the chamfered path. Reduce 
the radio for a more narrow chamfered corner.

Chamfer corners with 
angles less than or equal 
to

Clear the Chamfer corners with angles less than or equal to 
check box to chamfer only angles less than 90 degrees (acute 
angles). 
or
Select the Chamfer corner with angles less than or equal to 
check box to specify an angle between 90 and 180 degrees as 
the upper limit beneath which all angles are chamfered. 
Outside corners less than 90 degrees are always chamfered.

Table 45-89. Convert Pin Pairs to Chamfered Paths Dialog Box contents 

Name Description
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Crash Detected Dialog Box

Figure 45-97. Copy to Dialog Box

Crash Detected Dialog Box
The Crash Detected dialog box opens at a crash and allows you to save a report of the PADS 
environment as well as pertinent files into a compressed PADS Dump File. You can then submit 
this file to Mentor Customer Support. You can attach feedback to this report, and optionally, the 
BMW media and project files.

Accessing

• This dialog box is inaccessible unless the software crashes and crash detection is 
enabled in the software .ini file.
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Figure 45-98. Crash Detected Dialog Box

Table 45-90. Crash Detected Dialog Box Contents

Name Description

Comments box You can describe what you were doing when the error 
occurred or anything else you can think of that might help 
when investigating the crash.

Attach BMW data check box You can include BMW data and your project files. This 
will allow customer support to play back what you were 
doing in your design that led up to the crash. This check 
box is unavailable if the BMW feature is not enabled.
See also: BMW and BLT
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Create Array Dialog Box

Create Array Dialog Box
Use the Create Array dialog box to set options for creating an array.

Figure 45-99. Planar tab

Save button You must click the Save button if you want to create a 
report file. When you click the Save button, you are 
prompted with a Save As dialog box. The file that is 
created is called a PADS Dump File and is compressed in 
the .zip format. This is the file that you must send to 
customer support. It will include the report, the BMW data 
and the project files.

Table 45-90. Crash Detected Dialog Box Contents

Name Description



Create Array Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1027

Figure 45-100. Circular tab

Figure 45-101. Create Array Dialog Box

Table 45-91. Create Array Dialog Box Contents 

Name Description

Row To Row Sets the row-to-row distance in current design units.

Column To Column Sets the column-to-column distance in current design units.

Number of Rows Sets the number of rows in the array.
Type a value equal to or greater than 1. The Number of 
Columns is updated automatically based on this value.

Number of Columns Sets the number of columns in the array.
Type a value equal to or greater than 1. The Number of Rows 
is updated automatically based on this value.
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Create Array Dialog Box

Order by area • Rows—Determines the sequence in which components are 
placed in the planar array. 
When Order by Rows is selected, parts are sorted by 
selection and placed in array sites by rows, starting from 
the bottom row. Parts are placed in rows from left to right. 

• Columns—Determines the sequence in which components 
are placed in the planar array. 
When Order by Columns is selected, parts are sorted by 
selection and placed in array sites by rows, starting from 
the bottom row. Parts are placed in rows from left to right.

Inner Radius Sets the radius of the inner ring of the polar grid or circular 
array in current design units. You cannot use zero or negative 
values.

Delta Radius Sets the radial distance between neighboring rings of the polar 
grid or circular array in current design units.
For Circular Arrays you cannot use zero or negative values.

Start Angle Sets the polar angle, in degrees, of the first grid or circular 
array site. You can type a value between 0.000 and 359.999.

Angle Range Sets the range within which you want to place objects. 360 sets 
a full circle grid or array; smaller values set sector-shaped 
grids or arrays.

Delta Angle Sets the angular distance between neighboring sites within a 
ring.

Sites Per Ring Sets the number of sites for each ring of the grid or array. Type 
a value equal to or greater than 2. You cannot use zero or 
negative values.

Table 45-91. Create Array Dialog Box Contents (cont.)

Name Description
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Locked Controls the automatic adjustment of Angle Range, Delta 
Angle, and Sites Per Ring for Radial Move. Controls the 
automatic adjustment of Count, Angle, and Angle Range for 
Polar Step and Repeat.
The three settings above, Angle Range, Delta Angle, and Sites 
per Ring, are interdependent; each value depends on the values 
in the other two. Set one of the values and lock it. Set one of 
the unlocked values; the other unlocked value automatically 
updates. For example, if you set Angle Range to 360 and Sites 
Per Ring to 36, Delta Angle updates to 10.

Direction Sets how the sites are placed on the grid or circular array: 
Clockwise or Counterclockwise.

Rotate Sets whether to change the orientation of the selected 
components.
To change the orientation select this option and type a value, in 
degrees, in the Orientation box. Clear Rotate to maintain each 
component's current orientation.

Orientation Sets the orientation for the selected components. 
Type in an orientation value, in degrees, for PADS Layout to 
apply to each component in the array.

Sort by Reference 
Designator

Sorts selected items by reference designator when creating or 
modifying an array or during a Radial Move.
When this option is cleared, items are sorted by the order in 
which they were selected.

Align by Determines how to align the components in the array.
• Origin—Snaps the origins of the components to the array 

sites. 
• Midpoint—Snaps the midpoints of the components to the 

array sites.

Calculate Defines an array's parameters so that components are placed as 
closely to each other as possible without violating the Body-to-
Body Clearance Design Rule. You can calculate the following:
• Everything—For planar arrays, calculates Instances, 

Number of Columns, and Number of Rows.
For Circular arrays, calculates all options except Start 
Angle and Direction. Calculate always calculates options 
for a single ring array with an Angle Range of 360 degrees.

• Distances—Calculates Row To Row and Column To 
Column values. Planar arrays only.

• Radius, Delta Radius—Calculates Inner Radius and Delta 
Radius based on all of the other values in the Circular tab. 
Circular arrays only.

Table 45-91. Create Array Dialog Box Contents (cont.)

Name Description
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Create Die Dialog Box

Related Topics

To Set Up a Polar Grid

Defining Arrays

Create Die Dialog Box
Restriction: This information applies only to the BGA toolkit.

Accessing

• BGA Toolbar button > Die Wizard button

Figure 45-102. Create Die Dialog Box

Related Topics

To Create a New Die

Create Empty Project Dialog Box
Before you can begin archiving a PCB project, you must create a Project container in the vault. 
The project will be associated with a working folder containing the PCB project files, and will 
serve as a container for the project’s archives.

Use the Create empty project dialog box to create a project in the vault.

Table 45-92. Create Die Dialog Box contents 

Name Description

From Text File button Opens the Die Wizard - Create from Text File dialog box

Parametrically button Opens the Die Wizard - Create Parametrically dialog box

From GDSII File 
button

Opens the Die Wizard - Create from GDSII File dialog box
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Accessing

• In the Vault view, right-click a vault or a folder, and click Create empty project.

Figure 45-103. Create Empty Project Dialog Box

Related Topics

Adding a Project Container to the Vault

Custom String Dialog Box
Use the Custom String dialog box to create custom header or footer text for PDF outputs.

Accessing

• File menu > Create PDF > in a header or footer position list, select Custom

Table 45-93. Create Empty Project Dialog Box Contents

Name Description

Name
Description

Specify a name and description attribute for the project.
Tip: Create a name and description you can search for with the 
Find in Vault tool.



PADS Layout User’s Guide and Reference Manual, PADS 9.41032

Customize Dialog Box, Commands Tab

Figure 45-104. Custom String Dialog Box

Related Topics

PDF Configuration Dialog Box

Customize Dialog Box, Commands Tab
Use the Commands tab to add commands to menus or toolbars, or to create custom menus.

Accessing

• Tools menu > Customize > Commands tab

Table 45-94. Custom String Dialog Box Contents

Name Description

text box Type your custom text for the selected header or footer position.
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Figure 45-105. Commands Tab

Related Topics

Customize Dialog Box, Keyboard and Mouse Tab
Create and customize shortcut keys using the Keyboard and Mouse tab of the Customize dialog 
box. 

Accessing

• Tools menu > Customize > Keyboard and Mouse tab

Table 45-95. Command Tab Contents

Name Description

Categories list Narrows down the list of commands.

Commands list List of commands available to add to a menu or toolbar.

Add a new command, delete a command you’ve added, or 
rename a command you’ve added.

Creating a Custom Command
Creating a Custom Menu
Defining Properties for a New Command

Editing a Custom Command
Adding Items to Toolbars and Menus
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Customize Dialog Box, Keyboard and Mouse Tab

Figure 45-106. Keyboard and Mouse Tab

Related Topics

Customizing Shortcut Keys

Table 45-96. Keyboard and Mouse Tab Contents

Name Description

Mode list Narrows down the list of commands.

Commands list The list of commands available for which to assign a 
shortcut.

Add a new command (opens the Add Command Dialog 
Box), delete a command you’ve added, or rename a 
command you’ve added (opens the Edit Command dialog 
box).

Current shortcuts list The list of shortcuts assigned to the selected command.

Add a new shortcut (open the Assign Shortcut Dialog 
Box), or delete a shortcut you’ve added.

Description Lists what the selected command does.

Reset Sets the selected toolbar or shortcut menu to the default 
settings.

Report Saves a report of all current shortcut commands.
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Customize Dialog Box, Macro Files Tab
Create commands from macro files and add them to toolbars and menus using the Macro Files 
tab.

Tip: To create a command from a macro command file, the macro command file (.mcr) must 
already exist. You can create a macro by recording it in a PADS tool or scripting it in Macro 
language. For more information, see Creating Macros.

Accessing

• Tools menu > Customize > Macro Files tab

Figure 45-107. Macro Files Tab

Macro Files Tab Contents

Name Description

Macro Command Files list The list of macro files you have opened.

Add a macro to the list (opens the Open Macro dialog 
box), delete a macro from the list, or edit the location of a 
macro you’ve added.

Description Lists what the selected macro does.
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Customize Dialog Box, Options Tab

Related Topics

Creating Macros

Customize Dialog Box, Options Tab
Customize the PADS interface by changing the appearance of menus and toolbars using the 
Options tab of the Customize dialog box.

Accessing

• Tools menu > Customize > Options tab

Figure 45-108. Options Tab

Table 45-97. Options Tab Contents

Name Description

Show ToolTips on toolbars Displays the button name over the toolbar button when 
you hover over it with your pointer.

Show shortcuts in ToolTips In addition to the name in the ToolTip, displays the 
shortcut for the button.

Large Icons Displays icons on the toolbar larger than the default size.

Menu animations list The type of animation for your menus: None, Unfold, 
Slide, or Fade.
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Related Topics

Customizing the Appearance of the Screen

Customize Dialog Box, Toolbars and Menus Tab
Use the Toolbars and Menus tab on the Customize dialog box to create custom toolbars and 
shortcut menus.

Tip: To create a custom main menu, use the Commands tab on the Customize dialog box. See 
Creating a Custom Menu.

Accessing

• Tools menu > Customize > Toolbars and Menus tab

Menu shadows Displays a shadow behind the menu.

Wait until <Enter> before 
executing long shortcuts

Delays the execution of shortcut keys until you press 
Enter.

Show recent commands 
first

Displays your recent menu command selections at the top 
of the list.

Show full menus after delay Displays the full menu after a slight pause.

Reset my usage data Restores the default set of commands to the menus and 
toolbars. 
Tip: This option does not undo any explicit 
customizations you made.

Visual Style Sets the look and feel of your toolbars and title bars.

Interface Language Specifies the language for all dialog boxes and messages 
displayed: English, Japanese, Brazilian Portuguese.

Table 45-97. Options Tab Contents

Name Description
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Customize Dialog Box, Toolbars and Menus Tab

Figure 45-109. Toolbars and Menus Tab

Related Topics

Customizing Toolbars and Shortcut Menus

Table 45-98. Toolbars and Menus Tab Contents 

Name Description

Toolbars list Specify which toolbars to display in the main window.

Add a new toolbar, delete a toolbar you’ve added, or 
rename a toolbar you’ve added.

Show text labels Shows the text label on the button in addition to the icon.

Select shortcut menus Specifies the shortcut menu you want to customize.
Restriction: PADS Router only.

Reset Sets the selected toolbar or shortcut menu to the default 
settings.

Reset All Sets all toolbars or shortcut menus back to their default 
settings.
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Decal Attributes Dialog Box
Use this dialog box to assign decal attributes, such as Geometry.Height. This information 
travels with the decal.

Accessing

• Tools menu > PCB Decal Editor > Edit menu > Attribute Manager

Figure 45-110. Decal attributes Dialog Box

Decal Label Properties Dialog Box
Use the Decal Label Properties dialog box to modify a decal label or to change the attribute the 
label displays. 

Table 45-99. Decal attributes Dialog Box Contents 

Name Description

Attribute table • Attribute column—Lists the attributes assigned to the 
decal.

• Value column—Lists the value of the attributes 
assigned to the decal. You can specify the units for the 
value.

Add Adds a new row to the end of the Attribute table.

Delete Removes the selected row from the Attribute table.

Edit Makes the selected cell available for editing.

Browse Lib. Attr Opens the Browse Library Attributes dialog box.
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Decal Label Properties Dialog Box

Tip: If you select multiple labels, settings in this dialog box apply to all selected labels.

Accessing

• Select a decal label > right-click > Properties

Figure 45-111. Decal Label Properties Dialog Box

Table 45-100. Decal Label Properties Dialog Box Contents 

Name Description

Attribute The attributes available to you. If you are creating labels 
for jumpers, Reference Designator is the only available 
attribute.
Tip: Hidden attributes do not appear in the Attribute list 
unless the attribute was selected for the label before it was 
set as a hidden attribute.
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Value for The value of the selected attribute. 
Tips:
• Unavailable if you selected Reference Designator or 

Part Type from the Attribute list, if the attribute is 
read-only, or if you open the Properties dialog box for 
labels of different attribute types. However, if the 
labels you select belong to attributes of the same type, 
you can edit this box.

• If the attributes have different values, the box is blank. 
You can type a new value in the box to apply it to all 
of the selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-
registered and PADS Layout is not in ECO mode. 

Show Controls the visibility of the label. 
• None—Turns visibility off.
• Value— Displays only the label value.
• Name and Value—Displays the name and value.
• Full Name and Value—When labeling a  structured 

attribute, displays the full structured name and value.
Tip: Labels are invisible regardless of this setting unless 
you use the Display Colors Setup dialog box to change the 
color of labels to a color different from that of the 
background.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, 

or any combination of styles: B for bold, I for italic, or 
U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the 
component or the jumper. If you clear this check box, the 
label is placed at the X and Y location relative to the 
design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Table 45-100. Decal Label Properties Dialog Box Contents (cont.)

Name Description
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Decal Label Properties Dialog Box

Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for 
system fonts
Size (mils): This is font character height and appears for 
stroke fonts. The size refers to the height of the tallest 
characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the 
bottom side of the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to 
ensure proper positioning between objects when text, 
attribute values, size, or width change.
Tips: 
• For vertical justification, click Left, Center, or Right. 

For horizontal justification, choose Up, Center, or 
Down. 

• Optionally, set justification by selecting the text, then 
right-clicking and clicking Justify Horizontally, and 
then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then 
clicking Up, Center, or Down.

Right reading Controls whether labels are readable (from left to right, or 
from bottom to top if the label is rotated). Click the None, 
Orthogonal, or Angled button to indicate the direction of 
reading you want.

Table 45-100. Decal Label Properties Dialog Box Contents (cont.)

Name Description
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Related Topics

Modifying Decal Label Properties

Decal Rules Dialog Box
Use the Decal Rules dialog box to define design rules that apply to decals.

Restrictions

•
• You can define Decal Rules in PADS Layout; however, these rules are used in

PADS Router only.

Accessing

• Setup menu > Design Rules > Decal button

Figure 45-112. Decal Rules Dialog Box

Table 45-101. Decal Rules Dialog Box 

Name Description

Decals list Lists all decals in the design.

Show decals with rules Specifies to show only decals that have rules.
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Decal Rules Dialog Box (Decal Editor)

Related Topics

Creating Decal Design Rules

Modifying Decal Design Rules

Resetting Decal Rules to Default Rules

Creating Decal Design Rules in the PCB Decal Editor

Design Rule Hierarchy

Decal Rules Dialog Box (Decal Editor)
Use the Decal Rules dialog box to define design rules that apply to decals in the Decal Editor.

Restriction

• You can define Decal Rules in PADS Layout; however, these rules are used in PADS 
Router only.

Accessing

• Tools menu > PCB Decal Editor> Setup menu > Decal Rules

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

Fanout Opens the Fanout Rules Dialog Box.

Pad Entry Opens the Pad Entry Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule 
button

The picture below each type of rule button identifies which 
rules hierarchy level is used for that rule type. The meaning of 
the picture corresponds to the button in the Hierarchy area of 
the Rules dialog box. For example, if you select a class in the 
Class list and a green polygon appears below the Clearance 
button, then the default values apply to the class.

Selected: Lists the decal(s) selected in the Decals list.

Components: Lists the component(s) associated with decal(s) selected in the 
Connections list.

Default Removes non-default rules from the selected decals, so that 
only default rules apply.

Table 45-101. Decal Rules Dialog Box (cont.)

Name Description
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Figure 45-113. Decal Rules Dialog Box (Decal Editor)

Related Topics

Creating Decal Design Rules in the PCB Decal Editor

Decal Wizard Dialog Box, BGA/PGA Tab
Use the BGA/PGA wizard to create ball grid array and pin grid array decals. You can create 
decal patterns for full and depopulated matrix BGAs/PGAs, including staggered arrays.

Accessing

• Tools menu > PCB Decal Editor > Drafting Toolbar button > Wizard button > 
BGA/PGA tab

The BGA/PGA tab controls change depending on your Device type selection. The two 
differences are:

• BGA/PGA Tab - Through hole Controls

• BGA/PGA Tab - SMD Controls

Table 45-102. Decal Rules Dialog Box (Decal Editor) 

Name Description

Clearance Opens the Clearance Rules dialog box.

Routing Opens the Routing Rules dialog box.

Fanout Opens the Fanout Rules dialog box.

Pad Entry Opens the Pad Entry Rules dialog box.
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Decal Wizard Dialog Box, BGA/PGA Tab

Figure 45-114. BGA/PGA Tab - Through hole Controls
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Figure 45-115. BGA/PGA Tab - SMD Controls

Table 45-103. BGA/PGA Tab Contents 

Name Description

Decal area 

Device type Specifies whether the device will be a through hole or 
surface mount device. This setting is used to generate the 
correct type of pad stack for the device pins.

Decal type Specifies whether the decal is a component or substrate. 
This setting mirrors the column numbering. Column 
numbering is left to right for component type and right to 
left for substrate type.

Height(H) Specifies the height of the component. This value is added 
to the Geometry.Height attribute.
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Decal Wizard Dialog Box, BGA/PGA Tab

Origin Specifies the origin of the decal: the center of the decal or 
pin 1.

Pins area

Pin count Displays the number of pins in the decal. You cannot edit 
this value; it depends on row count, column count, and the 
stagger pitch value.

Diameter Sets the diameter of the pins in current units

Drill diameter Sets the drill hole diameter in current units.
Restriction: This control is only available when the 
Device type is set to Through hole.

Plated Flags the through holes for plating.
Restriction: This control is only available when the 
Device type is set to Through hole.

Staggered rows Enables staggering of pins. Stagger even rows or odd 
rows.

Assign JEDEC pinning Assigns an alphanumeric name to each pin in an array 
following the JEDEC standard.
Pin rows are lettered from top to bottom starting with A. 
The letters I, O, Q, S, X, and Z are not used. For arrays 
with more than 20 rows, row 21 is designated AA. 
Subsequent rows are designated AB, AC, etc.
Pin columns are numbered starting with 1. Column 
numbering is left to right for component type and right to 
left for substrate type.

Row pitch Specifies the distance between rows of pins in current 
units

Row count Sets the number of pin rows in the decal

Void rows Specifies the number of rows in the decal that will be 
depopulated (void). Void rows are calculated from the 
center of the decal. When you set void rows, you must 
also set void columns.
Tip: If the number of pin rows is an even number, the 
number of void rows should be an even number. If the 
number of pin rows is an odd number, the number of void 
rows should be an odd number. 

Table 45-103. BGA/PGA Tab Contents (cont.)

Name Description



Decal Wizard Dialog Box, BGA/PGA Tab

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1049

Center rows Specifies the number of pin rows in the decal to center 
within void rows. When you set center rows, you must 
also set center columns.
Tip: If the number of void rows is an even number, the 
number of center rows should be an even number. If the 
number of void rows is an odd number, the number of 
center rows should be an odd number.

Column pitch Specifies the distance between columns of pins in current 
units

Column count Sets the number of pin columns in the decal

Void columns Specifies the number of columns in the decal that will be 
depopulated (void). Void columns are calculated from the 
center of the decal. When you set void columns, you must 
also set void rows.
Tip: If the number of pin columns is an even number, the 
number of void columns should be an even number. If the 
number of pin columns is an odd number, the number of 
void columns should be an odd number.

Center columns Specifies the number of pin columns in the decal to center 
within void columns. When you set center columns, you 
must also set center rows.
Tip: If the number of void columns is an even number, the 
number of center columns should be an even number. If 
the number of void columns is an odd number, the number 
of center columns should be an odd number.

Default Sets all decal options to their default settings

Placement outline area 
Restriction: This area is unavailable if you’ve chosen not to create the outline in the 
Decal Wizard Options.

Width Specifies the width of the placement outline. The 
placement outline options are set in the Decal Wizard 
Options.

Height Specifies the height of the placement outline. The 
placement outline options are set in the Decal Wizard 
Options.

Mask over(under)size area 

Table 45-103. BGA/PGA Tab Contents (cont.)

Name Description
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Decal Wizard Dialog Box, Dual Tab

Related Topics

Creating a Basic Decal Automatically

Decal Wizard Dialog Box, Dual Tab
Use the Dual wizard to create both DIP and SMD decals.

Accessing

• Tools menu > PCB Decal Editor > Drafting Toolbar button > Wizard button > Dual 
tab

The Dual tab controls change depending on your Device type selection. The two differences 
are:

Solder Specifies the oversize or undersize of the solder mask. The 
solder mask options are set in the Decal Wizard Options.
Restriction: This area is unavailable if you’ve chosen not 
to create the solder mask outline in the Decal Wizard 
Options.

Paste Specifies the oversize or undersize of the paste mask. The 
paste mask options are set in the Decal Wizard Options.
Restrictions: 
• This control is only available when the Device type is 

set to SMD.
• This area is unavailable if you’ve chosen not to create 

the paste mask outline in the Decal Wizard Options.

Preview area - displays a preview of the decal based on your current settings. The view 
displays what is inside the Placement outline.

View from bottom side Displays the decal from the bottom side in the Preview 
area.

Display Colors Click to open the Display Colors Setup dialog box to 
change the colors of the preview window.

Active layer Specifies the active layer to display in the preview 
window.

Units Specifies whether the decal units are Mils, Metric, or 
Inches.

Wizard Options Opens the Decal Wizard Options Dialog Box.

Table 45-103. BGA/PGA Tab Contents (cont.)

Name Description
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• Dual Tab - Through hole Controls

• Dual Tab - SMD Controls

Figure 45-116. Dual Tab - Through hole Controls
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Decal Wizard Dialog Box, Dual Tab

Figure 45-117. Dual Tab - SMD Controls

Table 45-104. Quad Tab Contents 

Name Description

Decal area 

Device type Specifies whether the device will be a through hole or 
surface mount device. This setting is used to generate the 
correct type of pad stack for the device pins.

Orientation Sets a vertical or horizontal orientation for the decal.

Height(H) Specifies the height of the component. This value is added 
to the Geometry.Height attribute.

Origin Specifies the origin of the decal: the center of the decal or 
pin 1.

Pins area 
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Pin Count Sets the number of pins in the decal.

Diameter Sets the diameter of the pins in current units.
Restriction: This control is only available when the 
Device type is set to Through hole.

Width Sets the width of each pin in current units.
Restriction: This control is only available when the 
Device type is set to SMD.

Pin Pitch Sets the center-to-center spacing between pins, in current 
units.

Row Pitch Sets the center-to-center spacing between rows of pins, in 
current units.
Restriction: This control is only available when the 
Device type is set to Through hole. The area, of the same 
name, that applies to SMD devices is documented below.

Numbering direction Specifies the direction in which to number pins: clockwise 
or counterclockwise (CCW).

Drill Diameter Sets the drill hole diameter in current units.
Restriction: This control is only available when the 
Device type is set to Through hole.

Plated Plates pins.
Restriction: This control is only available when the 
Device type is set to Through hole.

Length Sets the length of each pin in current units.
Restriction: This control is only available when the 
Device type is set to SMD.

Row pitch area 
Restriction: This control is only available when the Device type is set to SMD.

List Specifies the locations used to measure the pitch.
• Center to Center—between centers of pins on opposite 

sides of the decal.
• Inner Edge to Edge—between inner edges of pins on 

opposite sides of the decal.
• Outer Edge to Edge—between outer edges of pins on 

opposite sides of the decal.

Value Specifies the value of the pitch or pin rows.

Pin 1 shape Specifies the shape of pin 1. Values change depending on 
whether the device type is through hole or SMD.

Table 45-104. Quad Tab Contents (cont.)

Name Description
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Decal Wizard Dialog Box, Dual Tab

Pin shape Specifies the shape of all pins except for pin 1. Values 
change depending on whether the device type is through 
hole or SMD.

Square/Rectangular pins area

Corner type Specifies the corner type used when pin shapes are square 
or rectangular.

Radius Specifies the radius used for chamfered or rounded 
corners.
Restriction: This control is not available for 90 Degrees.

Default button Sets all decal options to their default settings.

Placement outline area 
Restriction: This area is unavailable if you’ve chosen not to create the outline in the 
Decal Wizard Options.

Width Specifies the width of the placement outline. The 
placement outline options are set in the Decal Wizard 
Options.

Height Specifies the height of the placement outline. The 
placement outline options are set in the Decal Wizard 
Options.

Mask over(under)size area 
Tip: Half the oversize is added to either side of the pad.

Solder Specifies the oversize or undersize (use a negative value) 
of the solder mask. The solder mask options are set in the 
Decal Wizard Options.
Restriction: This area is unavailable if you’ve chosen not 
to create the solder mask outline in the Decal Wizard 
Options.

Paste Specifies the oversize or undersize (use a negative value) 
of the paste mask. The paste mask options are set in the 
Decal Wizard Options.
Restrictions: 
• This control is only available when the Device type is 

set to SMD.
• This area is unavailable if you’ve chosen not to create 

the paste mask outline in the Decal Wizard Options.

Preview area - displays a preview of the decal based on your current settings. The view 
displays what is inside the Placement outline.

Table 45-104. Quad Tab Contents (cont.)

Name Description
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View from bottom side Displays the decal from the bottom side in the Preview 
area.

Display Colors Click to open the Display Colors Setup dialog box to 
change the colors of the preview window.

Active layer Specifies the active layer to display in the preview 
window.

Decal Calculator area - generates the appropriate decal footprint based on the 
package dimensions. Uses the IPC-7351A standard and parameters that are set in 
the Decal Wizard Options - Package types tab.
Restriction: The decal calculator is not available for through hole devices.

Package type Specifies the type of package and updates the package 
dimension diagram and variables on the parameter 
spreadsheet.

Package dimension diagram Displays the usage of the variables for the package type. 
You can find the variable parameters in the parameter 
spreadsheet and also in various locations in the dialog box. 
For example, the H variable (height) is not found in the 
spreadsheet because it is located at the top of the Decal 
Wizard dialog box. See the Show dimensions area for a 
useful feature to display only those settings in the dialog 
box that are used by the Decal Calculator.

Package parameter 
spreadsheet

Specify the exact package dimensions and tolerances. 
Refer to the dimension diagram to the left of the 
spreadsheet to interpret the spreadsheet variables. Some 
variables are not found in the spreadsheet but are located 
in other parts of the dialog box. For example, the H 
variable (height) is not found in the spreadsheet because it 
is located at the top of the Decal Wizard dialog box.

Protrusion variation Specifies the amount that the decal pins should protrude 
from under the component leads to achieve different 
amounts of solder welding. Choose from the three land 
pattern material conditions: minimum, nominal, and 
maximum. See the Decal Wizard Options - Package types 
tab for settings of these material conditions.

Show dimensions Specify “All” to make all dialog box settings available or 
“Used in calculations” to gray out those settings not used 
by the Decal Calculator.

Table 45-104. Quad Tab Contents (cont.)

Name Description
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Decal Wizard Dialog Box, Polar Tab

Related Topics

Creating a Basic Decal Automatically

Decal Wizard Dialog Box, Polar Tab
Use the Polar decal wizard to create through-hole or SMD decals with pins evenly distributed 
on the array of the specified radius.

Accessing

• Tools menu > PCB Decal Editor > Drafting Toolbar button > Wizard button > Polar 
tab

The Polar tab controls change depending on your Device type selection. The two differences 
are:

• Polar Tab - Through hole Controls

• Polar Tab - SMD Controls

Calculate button Click to generate the decal according to the Decal 
Calculator parameters and settings.
Tip: The orientation is set to vertical, the origin is set to 
center, pin numbering is set to CCW. And the width, 
length, row pitch, placement outline and Mask 
over(under)size are calculated. 

Decal name Displays the generated name for the new decal in 
accordance with the IPC-7351A standard.

Restriction: If the decal name is generated and then you 
change any decal parameter that was used in the name 
generation, the decal name is cleared and you must click 
the Calculate button to regenerate the new, correct name.

Units Specifies whether the decal units are Mils, Metric, or 
Inches.

Wizard Options Opens the Decal Wizard Options Dialog Box.

Table 45-104. Quad Tab Contents (cont.)

Name Description
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Figure 45-118. Polar Tab - Through hole Controls
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Decal Wizard Dialog Box, Polar Tab

Figure 45-119. Polar Tab - SMD Controls

Table 45-105. Quad Tab Contents 

Name Description

Decal area 

Device type Specifies whether the device will be a through hole or 
surface mount device. This setting is used to generate the 
correct type of pad stack for the device pins.

Height(H) Specifies the height of the component. This value is added 
to the Geometry.Height attribute.

Origin Specifies the origin of the decal: the center of the decal or 
pin 1.

Pins area 

Pin count Sets the number of pins in the decal.
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Diameter Sets the diameter of the through hole pins.
Restriction: This control is only available when the 
Device type is set to Through hole.

Width Specifies the width of the surface mount pins.
Restriction: This control is only available when the 
Device type is set to SMD.

Start angle Sets the location, by angle, of the first pin on the circle.

Radius Sets the radius of the circle for the array in current units.
Restriction: This control is only available when the 
Device type is set to Through hole.

Numbering direction Specifies the direction in which to number pins: clockwise 
or counterclockwise (CCW).

Drill diameter Sets the drill hole diameter of the through hole pins.
Restriction: This control is only available when the 
Device type is set to Through hole.

Plated Marks the through holes for plating.
Restriction: This control is only available when the 
Device type is set to Through hole.

Length Specifies the length of the surface mount pins.
Restriction: This control is only available when the 
Device type is set to SMD.

Row pitch area 
Restriction: This control is only available when the Device type is set to SMD.

List Specifies the locations used to measure the pitch.
• Center to Center—between centers of pins on opposite 

sides of the decal.
• Inner Edge to Edge—between inner edges of pins on 

opposite sides of the decal.
• Outer Edge to Edge—between outer edges of pins on 

opposite sides of the decal.

Value Specifies the value of the pitch or pin rows.

Pin 1 shape Specifies the shape of pin 1. Values change depending on 
whether the device type is through hole or SMD.

Pin shape Specifies the shape of all pins except for pin 1. Values 
change depending on whether the device type is through 
hole or SMD.

Square/Rectangular pins area 

Table 45-105. Quad Tab Contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41060

Decal Wizard Dialog Box, Polar Tab

Corner type Specifies the corner type used when pin shapes are square 
or rectangular.

Radius Specifies the radius used for chamfered or rounded 
corners.
Restriction: This control is not available for 90 Degrees.

Default button Sets all decal options to their default settings.

Placement outline area 
Restriction: This area is unavailable if you’ve chosen not to create the outline in the 
Decal Wizard Options.

Diameter Specifies the diameter of the placement outline. The 
placement outline options are set in the Decal Wizard 
Options.

Mask over(under)size area 

Solder Specifies the oversize or undersize of the solder mask. The 
solder mask options are set in the Decal Wizard Options.
Restriction: This area is unavailable if you’ve chosen not 
to create the solder mask outline in the Decal Wizard 
Options.

Paste Specifies the oversize or undersize of the paste mask. The 
paste mask options are set in the Decal Wizard Options.
Restrictions: 
• This control is only available when the Device type is 

set to SMD.
• This area is unavailable if you’ve chosen not to create 

the paste mask outline in the Decal Wizard Options.

Preview area - displays a preview of the decal based on your current settings. The view 
displays what is inside the Placement outline.

View from bottom side Displays the decal from the bottom side in the Preview 
area.

Display Colors Click to open the Display Colors Setup dialog box to 
change the colors of the preview window.

Active layer Specifies the active layer to display in the preview 
window.

Units Specifies whether the decal units are Mils, Metric, or 
Inches.

Table 45-105. Quad Tab Contents (cont.)

Name Description
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Related Topics

Creating a Basic Decal Automatically

Decal Wizard Dialog Box, Quad Tab
Use the QUAD wizard to create packages with leads extending from each of the four sides. For 
example, quad flat packs or plastic leaded chip carriers.

Accessing

• Tools menu > PCB Decal Editor > Drafting Toolbar button > Wizard button > Quad 
tab

Wizard Options Opens the Decal Wizard Options Dialog Box.

Table 45-105. Quad Tab Contents (cont.)

Name Description
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Decal Wizard Dialog Box, Quad Tab

Figure 45-120. Quad Tab

Table 45-106. Quad Tab Contents 

Name Description

Decal area 

Pin 1 location Specify the side and place to locate pin 1.

Height(H) Specifies the height of the component. This value is added 
to the Geometry.Height attribute.

Origin Specifies the origin of the decal: the center of the decal or 
pin 1.

Pins area 

Horizontal pins Sets the number of horizontal pins in each of the two rows.

Vertical pins Sets the number of vertical pins in each of the two rows.
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Width Sets the width of each pin in current units.

Pin Pitch(P) Sets the center-to-center spacing between pins, in current 
units.

Numbering direction Specifies the direction in which to number pins: clockwise 
or counterclockwise (CCW).

Length Sets the length of each pin in current units.

Length 2 Sets the length of pin 1, which is different from the 
other pins.
Restriction: This control is only available for the Quad 
Leadless Ceramic Chip Carrier (with longer pin 1).

Row pitch area 

Measurement type Specifies the locations used to measure the pitch.
• Center to Center—between centers of pins on opposite 

sides of the decal.
• Inner Edge to Edge—between inner edges of pins on 

opposite sides of the decal.
• Outer Edge to Edge—between outer edges of pins on 

opposite sides of the decal.

Horizontal Specifies the pitch of horizontal pins.

Vertical Specifies the pitch of vertical pins.

Pin 1 shape area - Specifies the shape of pin 1.

Pin shape area - Specifies the shape of all pins except for pin 1.

Square/Rectangular pins area 

Corner type Specifies the corner type used when pin shapes are square 
or rectangular.

Radius Specifies the radius used for chamfered or rounded 
corners.
Restriction: This control is not available for 90 Degrees.

Default button Sets all decal options to their default settings.

Placement outline area 
Restriction: This area is unavailable if you’ve chosen not to create the outline in the 
Decal Wizard Options.

Width Specifies the width of the placement outline. The 
placement outline options are set in the Decal Wizard 
Options.

Table 45-106. Quad Tab Contents (cont.)

Name Description
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Decal Wizard Dialog Box, Quad Tab

Height Specifies the height of the placement outline. The 
placement outline options are set in the Decal Wizard 
Options.

Mask over(under)size area 

Solder Specifies the oversize or undersize of the solder mask. The 
solder mask options are set in the Decal Wizard Options.
Restriction: This area is unavailable if you’ve chosen not 
to create the solder mask outline in the Decal Wizard 
Options.

Paste Specifies the oversize or undersize of the paste mask. The 
paste mask options are set in the Decal Wizard Options.
Restriction: This area is unavailable if you’ve chosen not 
to create the paste mask outline in the Decal Wizard 
Options.

Preview area - displays a preview of the decal based on your current settings. The view 
displays what is inside the Placement outline.

View from bottom side Displays the decal from the bottom side in the Preview 
area.

Display Colors Click to open the Display Colors Setup dialog box to 
change the colors of the preview window.

Active layer Specifies the active layer to display in the preview 
window.

Decal Calculator area - generates the appropriate decal footprint based on the 
package dimensions. Uses the IPC-7351A standard and parameters that are set in 
the Decal Wizard Options - Package types tab.

Package type Specifies the type of package and updates the package 
dimension diagram and variables on the parameter 
spreadsheet.

Package dimension diagram Displays the usage of the variables for the package type. 
You can find the variable parameters in the parameter 
spreadsheet and also in various locations in the dialog box. 
For example, the H variable (height) is not found in the 
spreadsheet because it is located at the top of the Decal 
Wizard dialog box. See the Show dimensions area for a 
useful feature to display only those settings in the dialog 
box that are used by the Decal Calculator.

Table 45-106. Quad Tab Contents (cont.)

Name Description
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Related Topics

Creating a Basic Decal Automatically

Decal Wizard Options Dialog Box, Global Tab
Use the Decal Wizard Options Global tab to enable or disable supplemental documentation 
layers and settings.

Package parameter 
spreadsheet

Specify the exact package dimensions and tolerances. 
Refer to the dimension diagram to the left of the 
spreadsheet to interpret the spreadsheet variables. Some 
variables are not found in the spreadsheet but are located 
in other parts of the dialog box. For example, the H 
variable (height) is not found in the spreadsheet because it 
is located at the top of the Decal Wizard dialog box.

Protrusion variation Specifies the amount that the decal pins should protrude 
from under the component leads to achieve different 
amounts of solder welding. Choose from the three land 
pattern material conditions: minimum, nominal, and 
maximum. See the Decal Wizard Options - Package types 
tab for settings of these material conditions.

Show dimensions Specify “All” to make all dialog box settings available or 
“Used in calculations” to gray out those settings not used 
by the Decal Calculator.

Calculate button Click to generate the decal according to the Decal 
Calculator parameters and settings. 
Tip: The the origin is set to center, pin numbering is set to 
CCW. And the width, length, row pitches, placement 
outline and Mask over(under)size are calculated. 

Decal name Displays the generated name for the new decal in 
accordance with the IPC-7351A standard.
Restriction: If the decal name is generated and then you 
change any decal parameter that was used in the name 
generation, the decal name is cleared and you must click 
the Calculate button to regenerate the new, correct name.

Units Specifies whether the decal units are Mils, Metric, or 
Inches.

Wizard Options Opens the Decal Wizard Options Dialog Box.

Table 45-106. Quad Tab Contents (cont.)

Name Description
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Decal Wizard Options Dialog Box, Global Tab

Accessing

• PCB Decal Editor > Tools menu > Wizard Options > Global tab

• PCB Decal Editor > Drafting Toolbar button > Wizard Options button > Global tab

• PCB Decal Editor > Drafting Toolbar button > Wizard button > Wizard Options > 
Global tab

Figure 45-121. Decal Wizard Options Dialog Box, Global Tab

Table 45-107. Decal Wizard Options Dialog Box, Global Tab Contents

Name Description

Silkscreen outline area 

Create Specifies to create the decal silkscreen. 

Line width Specifies the width of the line used to draw the silkscreen.

Layer Specifies the layer on which to draw the silkscreen.
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Minimum spacing from pin 
pads

Specifies the gap between pad edges and the silkscreen 
outline edge.

Notch Specifies to create a notch in rectangular silkscreen 
shapes.

Polar tab Specifies to add a tab to polar (circular) silkscreen shapes.

Polar tab angle Specifies the location of the polar tab in degrees away 
from pin 1.

Assembly outline area 

Create Specifies to create the assembly outline.
Restrictions: 
• The assembly drawing is generated only if you use the 

Decal Calculator to generate the decal.
• The assembly drawing is generated only when you 

click the Calculate button in the Decal Wizard. If you 
change body width or length parameters after you 
click the Calculate button, the assembly drawing won’t 
match the body of the component unless you click the 
Calculate button to generate a new assembly drawing 
with the new parameters.

Line width Specifies the width of the line used to draw the assembly 
outline.

Layer Specifies the layer on which to draw the assembly outline.

Notch Specifies to create a notch in the assembly outline shape.

Placement outline area 
Tips: 
• The placement outline dimensions are defined in this dialog, but the calculation of 

the dimensions happens in the Decal Calculator, which puts the resulting values into 
the corresponding dialog fields.

• The geometry of the placement outline is a rectangle surrounding the component 
with a clearance (the Courtyard excess value of the package type set in the 
Environment area of the Package types tab.) The clearance is calculated from the 
edges of pads or the component body, to the centerline of the placement outline.

Create Specifies to create the placement outline.
Tip: Clearing this checkbox makes the Placement outline 
area unavailable in the Decal Wizard.

Line width Specifies the width of the line used to draw the placement 
outline.

Layer Specifies the layer on which to draw the placement 
outline.

Table 45-107. Decal Wizard Options Dialog Box, Global Tab Contents

Name Description
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Decal Wizard Options Dialog Box, Global Tab

Crosshair at Origin Specifies to create a crosshair geometry at the origin of the 
decal.
Tip: The crosshair is created with the same Line width as 
the placement outline.

Crosshair size Specifies the size of the crosshair.
Tip: The width of the lines used in the crosshair are the 
same as the line width for the placement outline.

Solder mask area 

Create Specifies to create the solder mask.
Tip: Clearing this checkbox makes the Solder field 
unavailable in the Mask over(under)size area of the Decal 
Wizard.

Top Layer Specifies the layer to use for top solder mask.
Restriction: Layers assigned to top and bottom solder 
mask and paste mask may not be the same.

Bottom Layer Specifies the layer to use for bottom solder mask.
Restriction: Layers assigned to top and bottom solder 
mask and paste mask may not be the same.

Gang mask area 

Create when needed Specifies to create gang solder mask when the width of the 
solder mask web becomes less than the minimum web 
width value.

Tip: Gang mask is a copper shape associated with the 
component. The shape of the gang mask takes on the 
shape of the pins. If the pins are oval shaped, the corners 
of the gang shape will be rounded. If one pin is longer than 
others, the gang will only extend beyond the regular pin 
length for the one pin.

Table 45-107. Decal Wizard Options Dialog Box, Global Tab Contents

Name Description
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Minimum web width Specifies the minimum value of solder mask web allowed. 
Gang solder mask is created when the width of the web is 
less than this value and when you select the Create when 
needed check box.

Ask about gang mask Specifies to prompt you upon clicking OK in the Decal 
Wizard, when gang mask conditions exist. You can 
choose to accept the conditions or a gang mask will not be 
created. It will make individual (overlapping) solder mask 
pads.

Paste mask area 

Create Specifies to create paste mask.
Tip: Clearing this checkbox makes the Paste field 
unavailable in the Mask over(under)size area of the Decal 
Wizard.

Layer Specifies the layer on which to create paste mask.
Restriction: Layers assigned to top and bottom solder 
mask and paste mask may not be the same.

Minimum pad to pad 
clearance

Specifies the minimum spacing allowed between decal 
pads.
Tip: Pads are created regardless. But you are given a 
warning that the minimum spacing is violated.

Minimum standoff height to 
avoid pad trimming

Specifies the minimum standoff height - the gap between 
the component body and the board. When this value is 
greater than the Standoff height (H2) value of SOIC and 
QFP type packages, the pads will be trimmed to avoid 
coming in contact with the component body.

Default Resets all Global tab settings to their default values.

Configuration name Specifies the saved configuration to use. When the 
settings of the dialog box are changed, you are prompted 
to save it to a configuration file. Configuration names can 
be a maximum of 30 characters.
Restriction: The Default configuration cannot be 
changed.
Tip: For more information, see the The Decal Wizard 
Options Configuration File in the Concepts Guide.

Table 45-107. Decal Wizard Options Dialog Box, Global Tab Contents

Name Description
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Decal Wizard Options Dialog Box, Package Types Tab

Related Topics

Decal Wizard Options Dialog Box, Package Types Tab

Decal Wizard Options Dialog Box, Package 
Types Tab

Use the Decal Wizard Options Global tab to set the defaults for each of the Package types used 
by the Decal Calculator.

Accessing

• PCB Decal Editor > Tools menu > Wizard Options > Package types tab

• PCB Decal Editor > Drafting Toolbar button > Wizard Options button > Package 
types tab

• PCB Decal Editor > Drafting Toolbar button > Wizard button > Wizard Options > 
Package types tab

Save As Allows you to save the current settings in a configuration 
for reuse. Opens the Save Configuration dialog box. 
Restriction: Configuration names can be a maximum of 
30 characters.
Tip: Configuration files are stored in the “UserDir” folder 
as set in the powerpcb.ini file and has the extension .dwc.
For more information, see the The Decal Wizard Options 
Configuration File in the Concepts Guide.

Units Specify whether the values are Mils, Metric, or Inches.

Reset All Resets both Global and Package types tab (including all 
package types) settings to their default values.

Table 45-107. Decal Wizard Options Dialog Box, Global Tab Contents

Name Description
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Figure 45-122. Decal Wizard Options Dialog Box, Package Types Tab

Table 45-108. Decal Wizard Options Dialog Box, Package Types Tab Contents

Name Description

Package type list Lists all the supported package types (and their pitch 
ranges) available to the Decal Calculator in the Decal 
Wizard. Select a package type from the list to view or 
modify the values used by the Decal Calculator to 
generate the decal.
Tip: If you open this dialog box from the Decal Wizard, 
this list item will correspond to the package type and the 
pitch value you’ve chosen in the Decal Wizard.

Fabrication tolerance Specifies the tolerance of the manufactured component 
and its land pattern.
Caution: If you add a tolerance to your decals, inform 
your manufacturer in case they also compensate by over-
sizing the land area and unnecessarily duplicate the 
tolerance.
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Decal Wizard Options Dialog Box, Package Types Tab

Placement tolerance Specifies the tolerance of the assembly process.

Round-off factor Specifies the factor used to round calculated values.

Solder mask over(under)size Specifies a positive value to oversize or a negative value 
to undersize the solder mask.

Paste mask over(under)size Specifies a positive value to oversize or a negative value 
to undersize the paste mask.

Environment area
Tip: This area changes according to each different package type.

Courtyard excess Specifies the extra clearance to apply to the placement 
outline in excess of the rectangle surrounding the 
component. The clearance is added between the edges of 
pads and the centerline of the placement outline. Specify 
the values for all three material conditions.

Toe Specifies the extra protrusion of the pad beyond the toe of 
the lead. Specify the values for all three material 
conditions.
Restriction: This is replaced by the single Periphery 
parameter for two package types.

Heel Specifies the extra protrusion of the pad beyond the heel 
of the lead. Specify the values for all three material 
conditions.
Restriction: This is replaced by the single Periphery 
parameter for two package types.

Side Specifies the extra protrusion of the pad beyond the sides 
of the lead. Specify the values for all three material 
conditions.
Restriction: This is replaced by the single Periphery 
parameter for two package types.

Periphery Specifies one set of parameters instead of using Toe, Heel 
and Side parameters for both Pull-back Small Outline, No-
Lead and Pull-back Quad Flat, No-Lead package types.

Default for this type Resets the values to the default for the current package 
type listed.

Table 45-108. Decal Wizard Options Dialog Box, Package Types Tab Contents

Name Description
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Related Topics

Decal Wizard Options Dialog Box, Global Tab

Default Rules Dialog Box
Use the Default Rules dialog box to define design rules that apply to all objects in the design, 
except for objects to which you assigned rules with a higher priority.

Accessing

• Setup menu > Design Rules > Default button

Configuration name Specifies the saved configuration to use. When the 
settings of the dialog box are changed, you are prompted 
to save it to a configuration file. Configuration names can 
be a maximum of 30 characters.
Restriction: The Default configuration cannot be 
changed.
Tip: For more information, see the The Decal Wizard 
Options Configuration File in the Concepts Guide.

Save As Allows you to save the current settings in a configuration 
for reuse. Configuration names can be a maximum of 30 
characters.
Tip: Configuration files are stored in the “UserDir” folder 
as set in the powerpcb.ini file and has the extension .dwc.
For more information, see the The Decal Wizard Options 
Configuration File in the Concepts Guide.

Units Specify whether the values are Mils, Metric, or Inches.

Reset All Resets both Global and Package types tab settings to their 
default values.

Table 45-108. Decal Wizard Options Dialog Box, Package Types Tab Contents

Name Description
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Define CAM Documents Dialog Box

Figure 45-123. Default Rules Dialog Box

Related Topics

Creating Default Rules

Design Rule Categories

Design Rule Hierarchy

Define CAM Documents Dialog Box
Use the Define CAM Documents dialog box to define and store up to 250 CAM documents.

Tip: You must save the design file before the changes made to the CAM documents become 
part of the design file.

Accessing

• File Menu > CAM

Table 45-109. Default Rules Dialog Box 

Name Description

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

High Speed Opens the HiSpeed Rules Dialog Box.

Fanout Opens the Fanout Rules Dialog Box.

Pad Entry Opens the Pad Entry Rules Dialog Box.

Report Opens the Rules Report Dialog Box.
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Figure 45-124. Define CAM Documents Dialog Box

Table 45-110. Define CAM Documents Dialog Box contents 

Name Description

Document Name The name of the CAM document.

Fabrication Layer The layer on which you will be using CAM350 for post 
processing.

Add button Opens the Add Document dialog box. Create a CAM 
Document configuration and return to the Define CAM 
Documents dialog box to save the configuration and Run the 
configuration against the design.

Edit button Opens the Edit Document dialog box where you can edit the 
document settings.

Delete button Removes the selected CAM document.

Up button Moves the selected CAM document up one space.

Down button Moves the selected CAM document down one space.

Summary Displays a summary of the selected CAM document.

Run Runs the selected CAM document configurations against your 
current design.

Listing Opens the Listing file name dialog box where you can save a 
list of the CAM documents, which can also be printed and 
saved with your design documentation.



PADS Layout User’s Guide and Reference Manual, PADS 9.41076

Define Name of Merged Net Dialog Box

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Defining CAM Documents

Define Name of Merged Net Dialog Box
You use the Define Name of Merged Net dialog box to rename the net of two pins connected 
using the Add Connection or Add Route ECO tools.

Accessing

• ECO Toolbar button > Add Connection button > click two pins with different 
netnames

• ECO Toolbar button > Add Route button > create a route between two pins with 
different netnames

CAM Directory Specifies the location of the CAM output file. 
Tips: 
• The default location is \PADS Projects\Cam\default.
• To create a new directory, select <Create> from the list.

Aperture Report Produces a report of the apertures used in a CAM Document.
Requirement: To produce an aperture report, you must have 
run the CAM Document(s) photo plot configuration against 
your design. If the CAM Document is set to print, or pen 
output, it will not produce the report.

Import Opens the CAM import file name dialog box where you can 
recall an exported configuration to use as the CAM 
configuration for the .pcb file.

Export Saves the configuration to a separate file that you can later 
import to use for similar .pcb files. 
Tip: If you name the file default.cam, it is used as the default 
CAM configuration for each .pcb file.

Preview Opens the CAM Preview dialog box where you can see the 
results of a CAM Document configuration before you run the 
configuration against your design.

Table 45-110. Define CAM Documents Dialog Box contents (cont.)

Name Description
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Figure 45-125. Define Name of Merged Net Dialog Box

Related Topics

Adding a Connection in ECO Mode

Adding a Route in ECO Mode

Define Name of New Net Dialog Box
You use the Define Name of New Net dialog box to name a new net created by the Delete 
Connection ECO tool or the Die Flag Wizard.

Table 45-111. Define Name of Merged Net Dialog Box Contents

Name Description

Mode of definition area This area allows you to choose the net name of the new 
merged net and provides you with four options. The first 
two options are the names of the two nets prior to their 
merging.
Autogenerate New Name—assigns a new $$$<number> 
name to the merged net.
Type New Name—allows you to type a new name in the 
Name of Net box.

Name of Net Displays the autogenerated new name of the net, or allows 
you to type the name of the merged net.
Restriction: This box is only available if you click Type 
New Name in the Mode of definition area.
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Delete Part Dialog Box

Tip: If you have deleted a connection bridging two pin pairs using the Delete Connection ECO 
tool, a prompt first appears and specifies which of the two pin pairs will be considered the new 
net. See Deleting a Connection in ECO Mode for more info.

Accessing

• ECO Toolbar button > Delete Connection button > click a connection bridging two 
pin pairs.

or

• In the Die Flag Wizard dialog box, click New Net.

Figure 45-126. Define Name of New Net Dialog Box

Delete Part Dialog Box
In ECO mode, use the Delete Part dialog box to delete parts, resulting single-pin nets, and 
optionally any attached traces. Two Delete Part dialog boxes appear in succession. The first 
dialog confirms the deletion and allows you to delete traces that are connected to the 
component, and the second dialog box informs you of any single-pin nets that will be deleted as 
a result from the deletion of the component.

Table 45-112. Define Name of New Net Dialog Box Contents

Name Description

Mode of Definition area This area allows you to choose the net name of the new 
net.
Autogenerate New Name—assigns a new $$$<number> 
name to the merged net.
Type New Name—allows you to type a new name in the 
Name of Net box.

Name of New Net Displays the autogenerated new name of the net, or allows 
you to type the name of the new net.
Restriction: This box is only available if you click Type 
New Name in the Mode of definition area.
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Accessing

• ECO Toolbar button > Delete Component button > select one or multiple components

• ECO Toolbar button > select one or multiple components > press Delete

Example 45-1. Delete Part Dialog Box 1

Figure 45-127. Delete Part Dialog Box 2

Table 45-113. Delete Part Dialog Box 1 Contents

Name Description

Delete Part/Selected Parts Prompts to confirm the deletion of the selected part(s). 
Specifies the reference designator of the part if you’ve 
only selected a single part.

Delete Routes Select the check box to also delete all traces routed to and 
from this component.
Exception: Despite this setting, the traces of any single-
pin nets that result from the deletion of the component will 
always be deleted.
Tip: If you have routed to and from a pad (both traces 
sharing the pad), you will lose both connections. But if 
you keep the traces when the component is removed, the 
connection will be continuous and will show a tack in 
place of the pad.
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Derive SBP Function from Netlist Dialog Box

Related Topics

Deleting a Component in ECO Mode

Derive SBP Function from Netlist Dialog Box
Use the Derive SBP Function from Netlist dialog box to import the SBP functions from a BGA, 
PADS Layout, or PADS Logic netlist ASCII file.

Restriction: This information applies only to the BGA toolkit.

See also: Exporting ASCII Files

Tip: SBP numbers are used as they are currently defined in the SBP Properties dialog box.

Accessing

• BGA Toolbar button > Wire Bond Wizard button > SBP Naming button > Derive 
from Netlist button > open a file

Table 45-114. Delete Part Dialog Box 2 Contents

Name Description

Single-pin net list When the selected component is deleted, single-pin nets 
might result. These nets are always deleted, including both 
unrouted connections and traces.
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Figure 45-128. Derive SBP Function from Netlist Dialog Box

Table 45-115. Derive SBP Function from Netlist Dialog Box contents 

Name Description

Netlist File The name of the file you are using.

Select Component area Displays the reference designator and part type for all 
components in the net list from the imported ASCII file.
Select a die component from the list. After selecting the 
component, the names in the SBP Function column of the 
Preview SBP Function area are updated with the net names 
assigned to pins of the selected components in the imported 
file. 

Preview SBP Function 
area

This area contains a list with the columns SBP and SBP 
Function.
When you select a component in the Select Component area, 
Wire Bond Wizard updates the names in the SBP Function 
column. These names are updated to the net names assigned to 
the pins of the selected component in the imported ASCII file.
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DFT Audit Dialog Box, Assignment Tab

Related Topics

To Import the SBP Functions

DFT Audit Dialog Box, Assignment Tab
Use the Assignment tab to prevent or favor assigning test points to components or to via types. 
By default, all pins on a net are available for test pin assignment and are evenly weighted as test 
point candidates.

Tip: To reduce design iterations, consult with your automated test engineers when setting DFT 
Audit options.

Accessing

• Tools menu > DFT Audit > Assignment tab

Figure 45-129. Assignment Tab
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Related Topics

Setting Test Point Assignment Eligibility

DFT Audit Dialog Box, Options Tab
Several options for placing test points are available to you on the Options tab of the DFT Audit 
dialog box.

Tip: To reduce design iterations, consult with your automated test engineers when setting DFT 
Audit options.

Accessing

• Tools menu > DFT Audit > Options tab

Table 45-116. Assignment Tab contents 

Name Description

Components column Lists the components available to you.

Exclude column Specifies to prevent the use of the component as a test point.
Tip: apply even weighting, clear the Exclude and Prefer 
check boxes.

Prefer column Specifies to favor the use of the component as a test point.
Tip: apply even weighting, clear the Exclude and Prefer 
check boxes.

Via Type column Lists the vias available to you.

Exclude column Specifies to prevent the use of the via as a test point.
Tip: apply even weighting, clear the Exclude and Prefer 
check boxes.

Prefer column Specifies to favor the use of the via as a test point.
Tip: apply even weighting, clear the Exclude and Prefer 
check boxes.

Run button Starts the automatic audit process.
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DFT Audit Dialog Box, Options Tab

Figure 45-130. Options Tab

Table 45-117. Options Tab contents 

Name Description

Create During Routing When using PADS Router Link, select the check box to enable 
PADS Router to create test points when routing nets.
When using PADS Layout, this check box has no function.

Preserve Test Points Prevents existing vias and component pins assigned as test 
points from being reassigned, removed, deleted, shoved, or 
modified. 

Add Test Points to 
Existing Traces

Adds test point vias to inaccessible nets that are already routed. 
The design is automatically passed to PADS Router where it 
places test points and may, for example, plow other traces out 
of the way to make room for a new test point.
Specify the type of via to insert from the Use Test Point Via 
list.
You can also specify whether or not to allow short trace stubs 
when making nets accessible.
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Add Off-board Test 
Points to Inaccessible 
Nets

Adds test point vias to nets that PADS Router cannot make 
accessible. PADS Layout places these test point vias outside 
the board outline and you can manually place them on the 
board.
Specify the type of via to insert from the Use Test Point Via 
list.

Use Test Point Via list Specifies the via type to use for test points. This list is enabled 
when you select any of the following check boxes:
• Add Test Points to Existing Traces
• Add Off-board Test Points to Inaccessible Nets

This setting also determines the via type used by the Add Test 
Point command and End Test Point command. 

Allow Stubs Specifies to allow stubs.

Place Via Points Using 
area

Specifies the grid type to use for via test point placement: Via 
Grid or Test Point Grid. 

PCB Top Side Specifies to probe the board from the top and bottom sides of 
the PCB.
Tip: Pins are always available for probing from the bottom 
side, whether or not the PCB Top Side check box is selected. If 
you want to probe only the top side, see Probing the PCB Top 
Side Only.

Vias Specifies to use vias as test points.
Tip: When the via is flagged as a test point, and Show Test 
Points is checked on the Routing/ General page of the Options 
dialog box, an arrow is drawn on it in the design:

Pins Specifies to use pins as test points.
Tip: When the pin is flagged as a test point, and Show Test 
Points is checked on the Routing/ General page of the Options 
dialog box, an arrow is drawn on it in the design:

Table 45-117. Options Tab contents (cont.)

Name Description
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DFT Audit Dialog Box, Properties Tab

Related Topics

Placing Test Points

DFT Audit Dialog Box, Properties Tab
Several test point properties are available to you on the Properties tab of the DFT Audit dialog 
box.

Unused Pins Specifies to provide access to unused pins during automated 
testing, and then type the net name used for all the unused pins 
in the design.
If the unused pin is an SMD pad, DFT Audit attaches a test 
point via by adding one single pin net to each unused SMD 
pin. If the unused pin is a through hole component pin, DFT 
Audit assigns the unused pin as test point.

Available Nail 
Diameters table

The nail diameters are listed in order of preference, where the 
first entry is the most preferred. You can only use a maximum 
of fifteen integer characters in the nail diameter name.
• Name—Specifies the probe size. The name is used to 

identify unique probe types.
During the placement or assignment of test points, DFT 
Audit assigns values you specify in the Name cell as via or 
pin attributes. When you change these values, attributes for 
all vias and pins with these values are updated.

• Fixture Drill Size—The diameter of the drilled hole in the 
fixture.
Recommendation: Fixture drill size is used to calculate all 
rules relevant to the probe size, and its diameter should 
usually be slightly larger than the probe size.

• Enabled—Specifies whether or not to use the associated 
nail during automated testing.

Add button Adds a row to the bottom of the table.

Delete button Removes the selected row from the table.

Up button Moves the selected row up one.

Down button Moves the selected row down one.

Maximum Pad Probing 
Sizes

Set minimum pad probing sizes for both vias and component 
pins to ensure that there is sufficient pad area for probe 
contact.

Run button Starts the automatic audit process.

Table 45-117. Options Tab contents (cont.)

Name Description
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Tip: To reduce design iterations, consult with your automated test engineers when setting DFT 
Audit options.

Accessing

• Tools menu > DFT Audit > Properties tab

Figure 45-131. Properties Tab
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Die Flag Wizard Dialog Box

Related Topics

Setting Test Point Properties

Die Flag Wizard Dialog Box
Use the Die Flag Wizard dialog box to:

• Define the number of rings to create.

• Make selections that define the layers, shapes, dimensions, net connections, and other 
properties of the die flag and rings that you are creating.

Restriction: This information applies only to the BGA toolkit.

Table 45-118. Properties Tab contents 

Name Description

Probe Minimum 
Distances area

Specifies the minimum distances between the probe and other 
design objects using options in the Probe Minimum Distances 
area.
Tip: The clearances needed between a probe and another 
design object are mostly based on the physical constraints of 
the Automated Test Equipment (ATE) used by In Circuit 
Testing (ICT) procedures. The probes extending out of the 
ATE fixture must make contact with the PCB without any 
obstacle. This means that test points must keep a fixed distance 
from component bodies, pads, mounting holes, and board 
edge, and must also have the minimum spacing between them.

Stub Length Specifies the maximum length of trace stubs required to make 
a net accessible to a test probe.

Multiple Test Point 
Nets table

Displays the Net name, net pins, and net vias. Specifies the nail 
pins.
Tips: 
• If you do not want any nail pins on a net, double-click the 

Nail Pins cell for the net and type zero (0).
• To sort the list by a different column, click the column 

header at the top of the list.

Show Only Nets With 
Pins Not Equal to One

Specifies to display only nets with no nail pin or with more 
than one nail pin in the table.

Run button Starts the automatic audit process.
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Accessing

• BGA Toolbar button > Die Flag Wizard button > select die

Figure 45-132. Die Flag Wizard Dialog Box

Table 45-119. Die Flag Wizard Dialog Box contents 

Name Description

Die Flag and Rings list Lists all currently defined die flag shapes. Shapes have the 
predefined names Die Flag, Ring 1, Ring 2, and so on. These 
names appear only in the dialog box; they are not the names of 
the design copper shapes.
To view or modify settings for a shape, either the die flag or a 
ring, select the shape. Settings that you change in the dialog 
box apply only to the currently selected shape.
To create the selected shape, click the check box. If the shape's 
check box is cleared, Die Flag Wizard does not create that 
shape. It does, however, account for the shape's spacing while 
creating other shapes.
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Die Flag Wizard Dialog Box

Add button Inserts a new ring around the selected shape (die flag or ring). 
The settings for this new ring are the same as for the selected 
shape. There is no limit to the number of rings you can add; 
however, only one die flag is allowed.

Delete button Deletes the currently selected ring from the list of shapes that 
Die Flag Wizard will create.
You cannot delete the die flag.

Layer list Lists all layers in the design. Specify a layer for the currently 
selected shape. 

Shape list Specifies the shape of the die flag or ring:
• Rectangle
• Rounded rectangle
• Chamfered rectangle
• Arced

Spacing Specifies the distance between the inner edge of the die flag 
ring and the die outline. For other rings, this selection specifies 
the distance between the inner edge of the selected ring and the 
outer edge of the ring contained within it.
The value for the spacing can be positive, negative, or zero.

Width Assigns a width, in current design units, for the selected ring 
(including the die flag ring). Enter a width greater than zero.

Arc Height Assigns a height for the arced shape. Enter a value greater than 
or equal to zero.

Net list Lists net names. Select a net name to assign to the currently 
selected shape.

New Net button Opens the Define Name of New Net Dialog Box, where you 
can add the name of a new net to the list of available nets.

Create Solder Mask 
Shapes

Creates a solder mask shape for the selected shape if the box is 
checked.

Solder Mask Layer Selects a layer upon which to create the solder mask.
The Layer list contains the names of the design layers 
associated with a solder mask.

Inside Compensation Defines the size of the overlap with or retraction of the solder 
mask shape from the inside of the conductive shape. To make 
the solder mask overlap the inside of the conductive shape, 
enter a positive value. To make the solder mask retract from 
the inside of the conductive shape, enter a negative value.

Table 45-119. Die Flag Wizard Dialog Box contents (cont.)

Name Description
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Related Topics

To Create a Die Flag and Rings

Die Flag Wizard

Die Wizard - Create from GDSII File Dialog Box
The Die Wizard – Create from GDSII File dialog box adds a new die to the current design or 
library.

Restriction: This information applies only to the BGA toolkit.

Outside Compensation Defines the size of the overlap with or retraction of the solder 
mask shape from the outside of the conductive shape. To make 
the solder mask overlap the outside of the conductive shape, 
enter a positive value. To make the solder mask retract from 
the outside of the conductive shape, enter a negative value.

Number Lists the number of spokes for the die flag. Available 
selections are: 4, 8, 12, and 16.

Width Select the spoke width for the die flag.

Miter Size Select the size of the straight-line segments to miter acute 
angles where the die flag spokes connect to the rings or 
paddles.
The value must be greater than zero. It cannot exceed the 
distance between the outer edge of the center paddle and the 
inner edge of the die flag ring.
Tip: To avoid acid traps, acute angles are not allowed.

Project from Corners Select whether to project the spoke configuration from the 
corner. When Project from corners is cleared, the spokes are 
offset from the corner.

Coverage Defines the size of the die flag's center paddle. It is the ratio of 
the area of the center paddle to the area of the entire die flag. 
The entire die flag encompasses the center paddle, spokes, and 
die flag ring.
Select a value between zero and 100. A value of zero means 
that the center paddle is not generated. A value of 100 means 
that the die flag is generated as one, solid shape without a 
defined center paddle, spoke, or ring.

Create button Creates all shapes that are checked in the list box, saves their 
settings, and closes the Die Flag Wizard dialog box.

Table 45-119. Die Flag Wizard Dialog Box contents (cont.)

Name Description
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Die Wizard - Create from GDSII File Dialog Box

Use the dialog box to:

• Define a die outline from a GDSII file

• Define a set of CBPs from a GDSII file

• Define the numbering of CBPs

• Define the functions for pads from a GDSII file

• Define preferences for die component creation

The Die Wizard has 5 tabs:

• Die Size

• CBP

• Pad #

• Pad Functions

• Die Prefs

Accessing

• BGA Toolbar button > Die Wizard button > From GDSII File button
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Figure 45-133. Die Wizard - Create from GDSII File Dialog Box

Table 45-120. Die Wizard - Create from GDSII File Dialog Box contents 

Name Description

File Displays the name of the text file you want to use to create the 
die.
Tip: Click Browse to open the Open dialog box and chose the 
file you want.

The Size of GDS Units 
(microns) 

Displays the size of the GDS file units in microns. Modify the 
value if necessary.

Die Part Type The name of the type of die part you want to use to create the 
die.

Flip Chip Selects the IC die for facedown mounting. Flip chip 
components contain only pins (SBPs).

Mirror Shapes Mirrors, or flips, the shapes (die geometrical data) on the die 
display.
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Die Wizard - Create from GDSII File Dialog Box

tabs • Die Size
• CBP
• Pad #
• Pad Functions
• Die Prefs

Die Data Status area Displays the die size, number of chip bond pads, and number 
of signals.

Units area Sets the global unit type to use to convert system units into one 
of these commonly used sets of measurements:
• Mils—Expressed in mils (1mil = 2.54*10^-5 m).
• Metric—Expressed in millimeters (1mm = 1.0*10^-3 m).
• Inches—Expressed in inches (1" = 2.54*10^-2 m).

All values are expressed on the die display in the units you 
choose.
Tip: You cannot choose Microns to use as system units. Use 
Metric if the values in the imported file are expressed in 
microns.

Extent button Displays the design in the largest x and y area that is occupied 
by all items within the die definition.

Preview Colors button Opens the Preview Colors dialog box so you can select colors 
that help you preview your design.

Show All When Show All is selected, the die display area contains both 
the shapes that represent the die items, such as the die outline 
and CBPs, and the rest of the shapes from the GDSII file.
When clear, the die display contains only the shapes selected 
as die items.

Preview window Displays the die design. Position the cursor and click to zoom 
in or right-click to zoom out.

Size of Preview Window 
display

Displays the size of the die display in the current unit 
measurement.

Cursor Position display Displays the position of the cursor in the die display.

Table 45-120. Die Wizard - Create from GDSII File Dialog Box contents (cont.)

Name Description
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Figure 45-134. Die Wizard - Create from GDSII File, Die Size tab

Table 45-121. Die Size tab contents 

Name Description

Die Size Tab • Set Size—Select to set the die size and die outline position 
manually.

• Select from GDS Shape—Select to choose a GDS shape 
for the die outline. You can modify the Height control 
when you click Select from GDS Shape, but you cannot 
modify the other parameters in the Set Size area.

Length Type or select the length of the die, which corresponds to the X 
size.

Width Type or select the width of the die, which corresponds to the Y 
size.

Height Type or select the height of the die, which defines the 
thickness of the die.

Die Point list (center, lower left, upper left, upper right, or lower right) for 
which you want to specify the coordinates for the base point, 
as expressed in X and Y.

X Type or select the die point along the x-axis you want as the 
base point for X.

Y Type or select the die point along the y-axis you want as the 
base point for Y.

GDS Layer Shows the layers defined in the GDSII file. Use to select the 
layer on which the die outline shape is located.
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Die Wizard - Create from GDSII File Dialog Box

Figure 45-135. Die Wizard - Create from GDSII File, CBP tab

GDS Shape Shows the names of all the GDS shapes available for selection 
as the die outline shape. Only closed, filled shapes from the 
GDSII file that are also on the selected layer in the GDS Layer 
list appear.
The shapes appear in the die display area using the Shapes on 
Selected Layers color.

Table 45-122. CBP contents 

Name Description

Min Size Sets the minimum size you want to use to filter GDS shapes for 
CBPs, expressed in the current system units.

Max Size Sets the maximum size to use to filter GDS shapes for CBPs.

GDS Layer Use to select the layer on which the GDS shape for CBPs is 
located.

Shapes Inside Outline Includes only the shapes found inside the die outline in the 
filtering.

Pad Shape Defines the shape of the pads: rectangle or oval. 
• Rectangle—CBP shapes are derived from GDS shapes as 

circumscribed rectangles.
• Oval—CBP shapes are derived from GDS shapes as 

circumscribed circles.

Table 45-121. Die Size tab contents (cont.)

Name Description
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Figure 45-136. Die Wizard - Create from GDSII File, Pad # tab

Table 45-123. Pad # tab contents 

Name Description

Numbering Mode • Circular—Circular numbering.
• JEDEC—JEDEC numbering.

Pin rows are lettered from top to bottom starting with A 
and pin columns are numbered from left to right starting 
with 1. The letters I, O, Q, S, X, and Z are not used. For 
arrays with more than 20 rows, row 21 is designated AA 
and subsequent rows are designated AB, AC, etc.

Direction area Specifies the numbering direction you want to use:
Clockwise—Numbering begins with pad 1 and continues in a 
clockwise direction.
CCW—Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Pad 1 Side area Specifies the side of the design to use for the position of pad 1:
Left—On the left side of the design.
Top—On the top of the design.
Right—On the right side of the design.
Bottom—On the bottom of the design.
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Die Wizard - Create from GDSII File Dialog Box

Figure 45-137. Die Wizard - Create from GDSII File, Pad Functions tab

Pad 1 Location area Specifies the location on the side of the design to use for the 
position of pad 1:
Center—Numbers the center pad of the specified side of the 
design as pad 1.
Left—Numbers the leftmost pad of the specified side of the 
design as pad 1.
Right—Numbers the rightmost pad of the specified side of the 
design as pad 1.
Specify—Numbers the pad you select on the specified side of 
the design as pad 1. Type or select the pad number you want to 
use for pad 1.

Table 45-124. Pad Functions tab contents 

Name Description

Pad column Shows each component bond pad number. Click the Pad 
column header to sort by pad number in either ascending or 
descending order.

Function column Shows all function names that correspond to component bond 
pad numbers. Click the Function column header to sort by 
function name in either ascending or descending order. 
Double-click a function to change a function name.

Table 45-123. Pad # tab contents (cont.)

Name Description
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Figure 45-138. Die Wizard - Create from GDSII File, Die Prefs tab

Assign Functions area Specifies how you want to use to assign functions:
• From Text File—After selecting the option, click Browse 

to select the file you want to use to assign pad functions.
• From GDS Texts on Layer—Select the GDS layer you 

want to use to assign pad functions.

Assign button Assigns the new function names to all pads.

Table 45-125. Die Prefs tab contents 

Name Description

Part Type Identifies the die part type to add to the design.

Part Creation Mode area Sets the layer on which the die outline and pads appear. Select 
a layer from the list.
• Add Part to Design—Adds the part to the currently open 

design.
Indicate the reference designator that is automatically 
assigned to the new die component in the design in the Part 
Name box. To change the reference designator, click on the 
part name and enter a new name.

• Save to Library—Saves the part in a specified library.
Select the library in which to save the part.

Die Outline and Pads • Sets the layer on which the die outline and pads appear. 
Select a layer from the list.

Table 45-124. Pad Functions tab contents (cont.)

Name Description
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Die Wizard - Create from Text File Dialog Box

Related Topics

To Create a Die from a GDSII File

Die Wizard - Create from Text File Dialog Box
The Die Wizard – Create from Text File dialog box adds a new die to the current design or 
library.

Restriction: This information applies only to the BGA toolkit.

Use the dialog box to:

• Define a die outline.

• Modify the shapes of CBPs from a text file.

• Define the numbering of CBPs from a text file.

• Modify the functions for pads from a text file.

• Define preferences for die component creation.

The Die Wizard has 5 tabs:

• Die Size

• CBP

• Pad #

• Pad Functions

• Die Prefs

Accessing

• BGA Toolbar button > Die Wizard button > From Text File button
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Figure 45-139. Die Wizard - Create from Text File Dialog Box

Table 45-126. Die Wizard - Create from Text File Dialog Box contents 

Name Description

File Displays the name of the text file you want to use to create the 
die.
Tip: Click Browse to open the Open dialog box and chose the 
file you want.

Imported File Units 
(Metric) 

Displays the size of the imported file units in microns. Modify 
the value if necessary.

Die Part Type The name of the type of die part you want to use to create the 
die.

Flip Chip Selects the IC die for facedown mounting. Flip chip 
components contain only pins (SBPs).

Mirror Shapes Mirrors, or flips, the shapes (die geometrical data) on the die 
display.
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Die Wizard - Create from Text File Dialog Box

tabs • Die Size
• CBP
• Pad #
• Pad Functions
• Die Prefs

Die Data Status area Displays the die size, number of chip bond pads, and number 
of signals.

Units area Sets the global unit type to use to convert system units into one 
of these commonly used sets of measurements:
• Mils—Expressed in mils (1mil = 2.54*10^-5 m).
• Metric—Expressed in millimeters (1mm = 1.0*10^-3 m).
• Inches—Expressed in inches (1" = 2.54*10^-2 m).

All values are expressed on the die display in the units you 
choose.
Tip: You cannot choose Microns to use as system units. Use 
Metric if the values in the imported file are expressed in 
microns.

Extent button Displays the design in the largest x and y area that is occupied 
by all items within the die definition.

Preview Colors button Opens the Preview Colors dialog box so you can select colors 
that help you preview your design.

Preview window Displays the die design. Position the cursor and click to zoom 
in or right-click to zoom out.

Size of Preview Window 
display

Displays the size of the die display in the current unit 
measurement.

Cursor Position display Displays the position of the cursor in the die display.

Table 45-126. Die Wizard - Create from Text File Dialog Box contents (cont.)

Name Description
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Figure 45-140. Die Wizard - Create from Text File, Die Size tab

Table 45-127. Die Size tab contents 

Name Description

Length Type or select the length of the die, which corresponds to the X 
size.

Width Type or select the width of the die, which corresponds to the Y 
size.

Height Type or select the height of the die, which defines the 
thickness of the die.

Die Outline Base Point 
list

Center, lower left, upper left, upper right, or lower right - for 
which you want to specify the coordinates for the base point, 
as expressed in X and Y.

X Type or select the die point along the x-axis you want as the 
base point for X.

Y Type or select the die point along the y-axis you want as the 
base point for Y.
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Die Wizard - Create from Text File Dialog Box

Figure 45-141. Die Wizard - Create from Text File, CBP tab

Table 45-128. CBP tab contents 

Name Description

Override pad shape Overrides the values from the file using the values you enter in 
Shape, Length, and Width to define the shape for all pads.

Shape Defines the shape of the pads: rectangle or oval.

Length Specifies the value for the pad length.

Width Specifies the value for the pad width.
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Figure 45-142. Die Wizard - Create from Text File, Pad # tab

Table 45-129. Pad # tab contents 

Name Description

Override Pad numbers Overrides the values from the file using the values you enter to 
define the pad numbering.

Numbering Mode • Circular—Circular numbering.
• JEDEC—JEDEC numbering.

Pin rows are lettered from top to bottom starting with A 
and pin columns are numbered from left to right starting 
with 1. The letters I, O, Q, S, X, and Z are not used. For 
arrays with more than 20 rows, row 21 is designated AA 
and subsequent rows are designated AB, AC, etc.

Direction area Specifies the numbering direction you want to use:
Clockwise—Numbering begins with pad 1 and continues in a 
clockwise direction.
CCW—Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Pad 1 Side area Specifies the side of the design to use for the position of pad 1:
Left—On the left side of the design.
Top—On the top of the design.
Right—On the right side of the design.
Bottom—On the bottom of the design.



PADS Layout User’s Guide and Reference Manual, PADS 9.41106

Die Wizard - Create from Text File Dialog Box

Figure 45-143. Die Wizard - Create from Text File, Pad Functions tab

Pad 1 Location area Specifies the location on the side of the design to use for the 
position of pad 1:
Center—Numbers the center pad of the specified side of the 
design as pad 1.
Left—Numbers the leftmost pad of the specified side of the 
design as pad 1.
Right—Numbers the rightmost pad of the specified side of the 
design as pad 1.
Specify—Numbers the pad you select on the specified side of 
the design as pad 1. Type or select the pad number you want to 
use for pad 1.

Table 45-130. Pad Functions tab contents 

Name Description

Pad column Shows each component bond pad number. Click the Pad 
column header to sort by pad number in either ascending or 
descending order.

Function column Shows all function names that correspond to component bond 
pad numbers. Click the Function column header to sort by 
function name in either ascending or descending order. 
Double-click a function to change a function name.

Table 45-129. Pad # tab contents (cont.)

Name Description
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Figure 45-144. Die Wizard - Create from Text File, Die Prefs tab

Related Topics

To Create a Die from a Text File

Die Wizard - Create Parametrically Dialog Box
The Die Wizard – Create Parametrically dialog box adds a new die to the current design or 
library.

Restriction: This information applies only to the BGA toolkit.

Table 45-131. Die Prefs tab contents 

Name Description

Part Type Identifies the die part type to add to the design.

Part Creation Mode area Sets the layer on which the die outline and pads appear. Select 
a layer from the list.
• Add Part to Design—Adds the part to the currently open 

design.
Indicate the reference designator that is automatically 
assigned to the new die component in the design in the Part 
Name box. To change the reference designator, click on the 
part name and enter a new name.

• Save to Library—Saves the part in a specified library.
Select the library in which to save the part.

Die Outline and Pads Specifies the layer on which you want to create the die data.
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Die Wizard - Create Parametrically Dialog Box

Use the dialog box to:

• Define a die outline.

• Define a set of CBPs.

• Define the numbering of CBPs.

• Define the functions for pads.

• Define preferences for die component creation.

• Add new die to the current design or to the part library.

On the CBP tab, there are two ways to set up pad counts:

• Set up the total pad count for a die with automatic distribution of pad counts evenly 
along the sides, using Total, GND %, and PWR %.

• Set up a specific pad count for each side of a die, using Side, Total Pads, GND, and 
PWR.

• Define preferences for die component creation

The Die Wizard has 5 tabs:

• Die Size

• CBP

• Pad #

• Pad Functions

• Die Prefs

Accessing

• BGA Toolbar button > Die Wizard button > Parametrically button
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Figure 45-145. Die Wizard - Create Parametrically Dialog Box

Table 45-132. Die Wizard - Create Parametrically Dialog Box contents 

Name Description

Die Part Type The name of the type of die part you want to use to create the 
die.

Flip Chip Selects the IC die for facedown mounting. Flip chip 
components contain only pins (SBPs).

Mirror Shapes Mirrors, or flips, the shapes (die geometrical data) on the die 
display.

tabs • Die Size
• CBP
• Pad #
• Pad Functions
• Die Prefs

Die Data Status area Displays the die size, number of chip bond pads, and number 
of signals.



PADS Layout User’s Guide and Reference Manual, PADS 9.41110

Die Wizard - Create Parametrically Dialog Box

Figure 45-146. Die Wizard - Create Parametrically, Die Size tab

Units area Sets the global unit type to use to convert system units into one 
of these commonly used sets of measurements:
• Mils—Expressed in mils (1mil = 2.54*10^-5 m).
• Metric—Expressed in millimeters (1mm = 1.0*10^-3 m).
• Inches—Expressed in inches (1" = 2.54*10^-2 m).

All values are expressed on the die display in the units you 
choose.
Tip: You cannot choose Microns to use as system units. Use 
Metric if the values in the imported file are expressed in 
microns.

Extent button Displays the design in the largest x and y area that is occupied 
by all items within the die definition.

Preview Colors button Opens the Preview Colors dialog box so you can select colors 
that help you preview your design.

Preview window Displays the die design. Position the cursor and click to zoom 
in or right-click to zoom out.

Size of Preview Window 
display

Displays the size of the die display in the current unit 
measurement.

Cursor Position display Displays the position of the cursor in the die display.

Table 45-132. Die Wizard - Create Parametrically Dialog Box contents (cont.)

Name Description
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Figure 45-147. Die Wizard - Create Parametrically, CBP tab

Table 45-133. Die Size tab contents 

Name Description

Length Type or select the length of the die, which corresponds to the X 
size.

Width Type or select the width of the die, which corresponds to the Y 
size.

Height Type or select the height of the die, which defines the 
thickness of the die.

Die Point list (center, lower left, upper left, upper right, or lower right) for 
which you want to specify the coordinates for the base point, 
as expressed in X and Y.

X Type or select the die point along the x-axis you want as the 
base point for X.

Y Type or select the die point along the y-axis you want as the 
base point for Y.

Table 45-134. CBP contents 

Name Description

Total Type or select the total pad count for the die. If you modify the 
total pad count, the pads are evenly distributed along the four 
sides.
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Die Wizard - Create Parametrically Dialog Box

GND % Type or select the percentage of the total pin count to allocate 
as ground pads. If you modify the value, the ground pads for 
each side are derived from the Total count.

PWR % Type or select the percentage of the total pin count to allocate 
as power pads. If you modify the value, the power pads for 
each side are derived from the Total count.

Side column Lists the sides of the die.

Total Pads column View or double-click to change the total number of pads for 
each side of the die. If you modify a value, the values in Total, 
GND %, and PWR % adjust accordingly.

GND column View or double-click to change the total number of ground 
pads for each side of the die. If you modify a value, the values 
in Total, GND %, and PWR % adjust accordingly.

PWR column View or double-click to change the total number of power pads 
for each side of the die. If you modify a value, the values in 
Total, GND %, and PWR % adjust accordingly.

Pad Pitch Defines the distance between pads. The distance is measured 
from the left side of one pad to the left side of the next adjacent 
pad.

Row Pitch Defines the distance between rows to control creation of 
staggered row patterns. For a single row in a straight line 
around the sides of the die, enter 0. To create staggered row 
patterns, enter a specific positive or negative number.

Distance from Die Edge Defines the distance between the row of the pads and the die 
edge.

Pad Shape Sets the shape of the thermal relief: Round, Square, 
Rectangular, or Oval Pads.

Pad Length Type or select the value for the pad length.

Pad Width Type or select the value for the pad width.

Table 45-134. CBP contents (cont.)

Name Description
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Figure 45-148. Die Wizard - Create Parametrically, Pad # tab

Table 45-135. Pad # tab contents 

Name Description

Numbering Mode • Circular—Circular numbering.
• JEDEC—JEDEC numbering.

Pin rows are lettered from top to bottom starting with A 
and pin columns are numbered from left to right starting 
with 1. The letters I, O, Q, S, X, and Z are not used. For 
arrays with more than 20 rows, row 21 is designated AA 
and subsequent rows are designated AB, AC, etc.

Direction area Specifies the numbering direction you want to use:
Clockwise—Numbering begins with pad 1 and continues in a 
clockwise direction.
CCW—Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Pad 1 Side area Specifies the side of the design to use for the position of pad 1:
Left—On the left side of the design.
Top—On the top of the design.
Right—On the right side of the design.
Bottom—On the bottom of the design.
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Die Wizard - Create Parametrically Dialog Box

Figure 45-149. Die Wizard - Create Parametrically, Pad Functions tab

Pad 1 Location area Specifies the location on the side of the design to use for the 
position of pad 1:
Center—Numbers the center pad of the specified side of the 
design as pad 1.
Left—Numbers the leftmost pad of the specified side of the 
design as pad 1.
Right—Numbers the rightmost pad of the specified side of the 
design as pad 1.
Specify—Numbers the pad you select on the specified side of 
the design as pad 1. Type or select the pad number you want to 
use for pad 1.

Table 45-136. Pad Functions tab contents 

Name Description

Pad column Shows each component bond pad number. Click the Pad 
column header to sort by pad number in either ascending or 
descending order.

Function column Shows all function names that correspond to component bond 
pad numbers. Click the Function column header to sort by 
function name in either ascending or descending order. 
Double-click a function to change a function name.

Table 45-135. Pad # tab contents (cont.)

Name Description
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Figure 45-150. Die Wizard - Create Parametrically, Die Prefs tab

Signal Function Prefix Type or view the function prefix you want to use to derive the 
signal pad names.

GND Pad Function Type or view the function name you want to use for the ground 
pads.

PWR Pad Function Type or view the function name you want to use for the power 
pads.

Assign button Assigns the new function names to all pads.

Table 45-137. Die Prefs tab contents 

Name Description

Part Type Identifies the die part type to add to the design.

Part Creation Mode area Sets the layer on which the die outline and pads appear. Select 
a layer from the list.
• Add Part to Design—Adds the part to the currently open 

design.
Indicate the reference designator that is automatically 
assigned to the new die component in the design in the Part 
Name box. To change the reference designator, click on the 
part name and enter a new name.

• Save to Library—Saves the part in a specified library.
Select the library in which to save the part.

Table 45-136. Pad Functions tab contents (cont.)

Name Description
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Die Wizard Preview Colors Dialog Box

Related Topics

To Create a Die Parametrically

Die Wizard Preview Colors Dialog Box
Use the Die Wizard Preview Colors dialog box to select colors for previewing your die design.

Restriction: This information applies only to the BGA toolkit.

Setting colors on this dialog box does not change the colors you set in the Display Colors Setup 
dialog box.

Accessing

• BGA Toolbar button > Die Wizard button > any button > Preview Colors button

Figure 45-151. Die Wizard Preview Colors Dialog Box

Die Outline and Pads Specifies the layer on which you want to create the die data.

Table 45-137. Die Prefs tab contents (cont.)

Name Description
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Related Topics

To Set Die Preview Colors

Differential Pairs Dialog Box
Use the Differential Pairs dialog box to identify nets, associated nets, or pin pairs that behave 
electrically as differential pairs, and to define differential pair design rules. You can set different 
properties for differential pairs, which affects how they are routed. Differential pair properties 
determine the gap between the traces in the controlled gap area, the minimum and maximum 
trace lengths and widths, and how to respond to obstacles in the controlled gap area.

Restriction: You can define Differential Pairs Rules in PADS Layout, but these rules are used 
in PADS Router only. Layout does, however, respect the diff pair gap as a trace to trace 
clearance.

Accessing

• Setup menu > Design Rules > Differential Pairs

Tip: You can set Differential Pairs rules for Nets, Pin pairs, or Associated Nets, depending on 
the tab you select.

Table 45-138. Die Wizard Preview Colors Dialog Box contents 

Name Description

Selected Color area Select the color you want to apply to one or more items on the 
dialog box.

Background Sets the background color in the die display area.

Highlight Sets the highlight color in the die display area.

Die Outline Sets the color of the die outline in the die display area.

CBP Sets the color of the CBPs in the die display area.

CBP # Sets the color of the CBP numbers in the die display area.

All Shapes Sets the color of all GDS shapes in the die display area. The 
GDSII shapes area of the dialog box is active only when you 
are creating a die from a GDSII file.

Shapes on Selected 
Layers

Sets the color of the GDS shapes in the GDSII file that appear 
on the selected GSD Layer, in the die display area. The color 
appears only when the Die Size tab or the Pad Functions tab is 
active. The GDSII shapes area of the dialog box is active only 
when you are creating a die from a GDSII file.
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Differential Pairs Dialog Box

Figure 45-152. Differential Pairs Dialog Box

Table 45-139. Differential Pairs Dialog Box Contents 

Name Description

Available list Lists the nets, pin pairs, or associated nets available for 
differential pair creation.
Tip: Nets, associated nets, or pin pairs cannot be part of more 
than one differential pair. The Available list displays only 
items that have not been assigned to a differential pair.
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Select>> Use the top and bottom Select buttons to move the first and 
second items making up a diff pair to a holding area, from 
which you can add them to the Pairs list.

<<Unselect Moves the first and second items back to the Available list.

Add>> Moves the selected items to the Pairs list.
Tip: This button is unavailable unless two items are selected 
and in the holding area.

<<Remove Moves the selected pair from the Pairs list back to the 
Available list.

Pairs list Lists the created differential pairs.

Trace length area Specifies the minimum and maximum length for a trace.

Restrict layer changes 
during autorouting 
check box

Forces the selected pair to be routed on a single layer. 
Tip: This setting does not restrict layer changes when routing 
interactively.

Set trace width and gap 
for the pair by layer 
table

Specifies the width and gap per layer.
• Layer—The layer to set width and gap values.

Tips:
• Setting the differential pair width and gap per layer 

enables you to better control impedance.
• If you select multiple differential pairs, and a layer 

setting does not belong to all of the selected pairs, the 
Layer column is unavailable.

• Width—Specifies the width value for differential pairs on 
the specified layer.

• Gap—Specifies the gap value for differential pairs on the 
specified layer.
Important: The Gap also specifies the trace to trace 
clearance. This clearance takes precedence over any other 
trace to trace clearance in the rules hierarchy.

• Add button—Adds a row to the bottom of the table to 
specify width and gap values for another layer.

• Delete button—Removes the selected row from the table.
Restriction: You cannot remove the <All Layers> row.

Table 45-139. Differential Pairs Dialog Box Contents (cont.)

Name Description
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Dimension Properties Dialog Box

Related Topics

Creating Differential Pair Design Rules

Deleting a Differential Pair Design Rule

Dimension Properties Dialog Box
The Dimension Properties dialog box reflects the type of dimension, Vertical, Horizontal, 
Aligned, that is currently selected.

Accessing

• Select a dimension > right-click > Properties.

Obstacles • Allow pair to split around obstacles—Specifies to enable 
routing around an obstacle in the controlled gap area by 
temporarily exceeding the pair routing gap. 
Tip: This setting applies to autorouting and does not 
restrict splitting around obstacles when routing 
interactively.

• Maximum number of obstacles—Specifies the maximum 
number of obstacles to route around in the Maximum 
number of obstacles box. Obstacles in the start zone or end 
zone are not counted.

• Maximum obstacle size—Specifies the maximum spacing 
allowed between traces around obstacles in the Maximum 
obstacle size box. The size applies to the obstacle's longest 
horizontal or vertical dimension. Obstacle size in the start 
zone or end zone is not checked.

Preview area Shows the way in which the differential pairs will split around 
objects based on your selections.

Table 45-139. Differential Pairs Dialog Box Contents (cont.)

Name Description
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Figure 45-153. Dimension Properties Dialog Box

Related Topics

Dimensioning Process

Table 45-140. Dimension Properties Dialog Box contents 

Name Description

Type Displays the type of the selected dimension.

X/Y Specifies the x and y coordinates of the dimension object. The 
coordinates are calculated from the bottom of one of the 
extension lines or from the radius point of an arc. Type a new 
value to change the location.

Text Rotation Specifies the current rotation value. Positive values rotate 
entries in a counterclockwise direction. Negative values rotate 
entries in a clockwise direction. Type a new value to change 
the rotation.

Layer list Specifies the new layer to which to assign the entire dimension 
object, even if different layers were assigned for text and lines 
in the Dimensioning / General page of the Options dialog box.

Circle Dimension Allows modification of radial dimensions to indicate 
measurements from the radius point or diameter. Click one of 
these buttons to change the measurement type:
• Radius—Measures the circle dimension from the radius 

point.
• Diameter—Measures the circle dimension from the 

diameter.
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Dimension Text Properties Dialog Box

Dimension Text Properties Dialog Box
The Dimension Text Properties dialog box displays information about the selected text string 
and provides several areas for modifying the string. It remains open until you click OK or 
Cancel. Selecting another text object while the dialog box is open updates the information for 
the selected object.

After a dimension object is created, you might need to change the location of the text string to 
accommodate existing dimensions. Use either Dynamic Drag or the Move command to move 
the object.

Accessing

• Select dimension text > right-click > Properties

Figure 45-154. Dimension Text Properties Dialog Box

Table 45-141. Dimension Text Properties Dialog Box contents 

Name Description

Text Displays the current content of the selected string. Type in the 
box to modify the text string.
Tip: Modifying the content of the text string does not adjust 
the extension line to accommodate the new text length. Use 
Change Length to modify the position of the extension line and 
update the text string.

Layer list Lists the current working layer. Select a new layer from the 
list.
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Related Topics

Dimensioning Process

Discarding Plane Data Dialog Box
Use the Discarding Plane Data dialog box to control which plane data is saved.

X and Y boxes Lists the X and Y coordinate locations of the text, calculated 
from the lower left corner of the text string. Type new values 
to change the location of the text.

Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for system 
fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Rotation Lists the current rotation value. Positive values rotate in a 
counterclockwise direction. Negative values rotate in a 
clockwise direction. Type a new value to change the rotation.

Mirrored Select to flip the text - text is considered readable from the 
bottom side of the board.

Parent Button Opens the Dimension Properties dialog box for the dimension 
object with which the selected object is associated.

Table 45-141. Dimension Text Properties Dialog Box contents (cont.)

Name Description
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Disconnect Pin Dialog Box

Accessing

The Discarding Plane Data dialog box appears automatically when you save a file in which you 
have plane data, and have set Prompt to discard plane data on the Options dialog box.

Figure 45-155. Discarding Plane Data Dialog Box

Disconnect Pin Dialog Box
Use the Disconnect Pin dialog box to confirm the disconnection of the pin from the net to which 
it’s attached and to delete the route segment(s) that are attached to the pin.

Warning

If you choose not to delete any routes that are attached to the pin, the routes will still appear as 
attached in the design and the gerber output files. Without deleting the routes, the pin is only 
disconnected in the netlist.

Accessing

• select a pin > ECO Toolbar > Delect Connection

Table 45-142. Discarding Plane Data Dialog Box Contents 

Name Description

Don’t notify me next time Specifies to suppress this message for subsequent file 
saves.

Proceed Saves only the plane polygons.

Save All Saves all plane data and changes the option for future 
saves.
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Figure 45-156. Disconnect Pin Dialog Box

Related Topics

Deleting a Connection in ECO Mode

Display Colors Setup Dialog Box
Use the Display Colors Setup dialog box to Set display colors, save them, and restore them; 
Change the color palette; make objects visible; and make objects invisible.

Tip: Changes you make to the color configuration in the Display Colors Setup dialog box do 
not apply to disabled layers.

Accessing

• Setup menu > Display Colors

Table 45-143. Disconnect Pin Dialog Box Contents

Name Description

Delete Routes Select to delete the route segment(s) that are connected to the pin. 
If you don’t delete the routes, the pin will still appear as though 
it’s attached.
Tip: Only the routes of the pin pairs to/from the disconnected pin 
are deleted. All other segments belonging to the net are retained.
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Display Colors Setup Dialog Box

Figure 45-157. Display Colors Setup Dialog Box

Table 45-144. Display Colors Setup Dialog Box Contents 

Name Description

Selected Color area Select a color from the palette to assign to items on a 
layer. Once you select a color here, click the tile in the 
Color by Layer area of the item to which you want to 
assign the color. 
See also: To Change the Color Palette

Palette Opens the Color dialog box where you can choose to use 
new colors or customize colors you want to use. 
See also: To Change the Color Palette

Default Palette Reassigns all colors and settings to the default settings.
Tip: You can change the default settings by saving a 
configuration and naming it default.

Assign All Opens the Assign Color to All Layers dialog box.
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Layers/Object Types matrix—Use this area to assign various colors to different 
objects on different layers.
See also: To Assign Colors to Objects on Different Layers

Layers (rows) The rows of layers lists the layers as you’ve named them 
in the Layers Setup dialog box.
Tips: 
• You can clear the check box of a row to make the layer 

invisible.
• To make all items on a layer one color, click the 

number of the row to select all row objects and then 
click a color tile in the Selected Color area. You can 
also select multiple rows using Shift+click for a range 
or Ctrl+click for a selection.

Object Types (columns) The columns list object types in the design.
Tips:
• You can clear the check box of a column to make the 

objects invisible on all layers.
• To make all of one object type the same color on each 

layer, click the object name in the column header to 
select the object on all layers and then click a color tile 
in the Selected Color area. You can also select 
multiple columns using Shift+click for a range or 
Ctrl+click for a selection.

• Pin Numbers and Net Names—sizing is controlled by 
the settings in the Display Options.

Restriction: Even if the Net Name column check box is 
selected and the tiles on layers are given a color, the 
display of net names is still restricted by the state of the 
Show net names on Traces, Vias, Pins check boxes.

Visible only Lists only visible layers. A layer is visible if at least one 
tile is assigned a non-background color.

Other area Globally assigns colors to other items. Click a color from 
the Selected Color area and click the tile of the item. You 
can globally control the colors for the following objects:
• Background—Setting other objects to this color 

makes them invisible.
• Selections—Objects that are selected for modifying.
• Highlight—Objects that are highlighted but not 

selected for edit operations.
• Board outline—Applies to the board outline and 

board cut outs.
• Connection—Unrouted pin pairs or the “ratsnest.”

Table 45-144. Display Colors Setup Dialog Box Contents (cont.)

Name Description
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Display Colors Setup Dialog Box in the Decal Editor

Related Topics

Display Colors Setup Dialog Box in the Decal Editor

Setting Colors of Objects in the Display

To Save Color Assignments to a File

Display Colors Setup Dialog Box in the Decal 
Editor

Use the Display Colors Setup dialog box to Set display colors, save them, and restore them; 
change the color palette; make objects visible; and make objects invisible.

Restrictions

• Color changes are not permanently saved in the Decal Editor. To make permanent 
changes to the colors, see Creating a New Default Decal Editing Environment.

• Changes you make to the color configuration in the Display Colors Setup dialog box do 
not apply to disabled layers.

Accessing

• Tools menu > PCB Decal Editor > Setup menu > Display Colors

Configuration list The list of saved configurations.

Save Opens the Save Configuration dialog box.

Delete Removes the selected configuration from the 
Configuration list.

Show net names on
Traces, Vias, Pins

Select the check boxes to activate locations where net 
names should be visible.
Requirement: To display net names on these objects, you 
must also select the check box for the Net Names column 
and give colors to color tiles in the column.
Tips: 
• You can use the modeless commands NNT, NNV and 

NNP to toggle these check boxes.
• The sizing and frequency of net name placement is 

controlled by the settings in the Display Options.

Apply immediately Specifies that any change in color or visibility made in this 
dialog box is immediately applied to the design; clicking 
the Apply button is not needed.

Table 45-144. Display Colors Setup Dialog Box Contents (cont.)

Name Description
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Figure 45-158. Display Colors Setup Dialog Box in the Decal Editor

Table 45-145. Display Colors Setup Dialog Box in the Decal Editor Contents 

Name Description

Selected Color area Select a color from the palette to assign to items on a 
layer. Once you select a color here, click the tile in the 
Color by Layer area of the item to which you want to 
assign the color. 
See also: To Change the Color Palette

Palette Opens the Color dialog box where you can choose to use 
new colors or customize colors you want to use. 
See also: To Change the Color Palette

Default Palette Reassigns all colors and settings to the default settings.
Tip: You can change the default settings by saving a 
configuration and naming it default.

Assign All Opens the Assign Color to All Layers dialog box.
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Display Colors Setup Dialog Box in the Decal Editor

Layers/Object Types matrix—Use this area to assign various colors to different 
objects on different layers.
See also: To Assign Colors to Objects on Different Layers

Layers (rows) The rows of layers lists the layers as you’ve named them 
in the Layers Setup dialog box.
Tips: 
• You can clear the check box of a row to make the layer 

invisible.
• To make all items on a layer one color, click the 

number of the row to select all row objects and then 
click a color tile in the Selected Color area.

Object Types (columns) The columns list object types in the design.
Tips:
• Although the Ref. Des. column is not visible as in the 

Layout Editor, it is part of the Pin Num. column.
• You can clear the check box of a column to make the 

objects invisible on all layers.
• To make all of one object type the same color on each 

layer, click the object name in the column header to 
select the object on all layers and then click a color tile 
in the Selected Color area.

Visible only Lists only visible layers. A layer is visible if at least one 
tile is assigned a non-background color.

Color by Layer matrix Use this area to assign various colors to different objects 
on different layers. 
Tip: The layer names that you assigned in the Layers 
Setup dialog box appear along the left side of this area.
See also: To Assign Colors to Objects on Different Layers

Other area Globally assigns colors to other items. Click a color from 
the Selected Color area and click the tile of the item. You 
can globally control the colors for the following objects:
• Background—Setting other objects to this color 

makes them invisible.
• Selections—Objects that are selected for modifying.
• Highlight—Objects that are highlighted but not 

selected for edit operations.

Configuration list The list of saved configurations.

Save Opens the Save Configuration dialog box.

Delete Removes the selected configuration from the 
Configuration list.

Table 45-145. Display Colors Setup Dialog Box in the Decal Editor Contents 

Name Description
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Related Topics

Creating a New Default Decal Editing Environment

Setting Colors of Objects in the Display

To Save Color Assignments to a File

Drafting Corner Properties
Use the Drafting Corner Properties to view an object type, layer assignment, trace clearance, or 
assigned net. You can move a corner by coordinates, access net information, and select the 
parent shape.

Accessing

• Select a drafting edge > Right-click > Properties

Figure 45-159. Drafting Corner Properties Dialog Box

Apply immediately Specifies that any change in color or visibility made in this 
dialog box is immediately applied to the design; clicking 
the Apply button is not needed.

Table 45-145. Display Colors Setup Dialog Box in the Decal Editor Contents 

Name Description
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Drafting Edge Properties Dialog Box

Related Topics

Modifying Drafting Corner Properties

Drafting Edge Properties Dialog Box
Use the Drafting Edge Properties dialog box to view an object type, layer assignment, trace 
clearance, or assigned net. You can move an edge by coordinates or an arc by radius or start/end 
angle, access net information, and select the parent shape. 

Exceptions:

• For circles, you can change only Center Point and Radius.

• For arcs, use the X1,Y1 and X2,Y2 fields as the arc end points. To define an arc, you 
only need a subset of these fields. To redefine the arc, change only one field at a time. If 
you make a change that cannot be interpreted, the command is cancelled.

Accessing

• Select a drafting edge > Right-click > Properties

Table 45-146. Drafting Corner Properties Dialog Box contents 

Name Description

Type Lists the object type.

X,Y Lists the current X,Y location of the corners. Type new values 
in the boxes to move the corner.

Layer Lists the layer on which the object is located.

Track Clearance Specifies clearance values between the corner and objects 
around it.

Net Lists the net associated with the corner.

Net button Opens the Net Properties dialog box.

Parent button Opens the Drafting Properties dialog box for the drafting 
object to which the corner belongs.
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Figure 45-160. Drafting Edge Properties Dialog Box

Table 45-147. Drafting Edge Properties Dialog Box contents 

Name Description

X1,Y1 / X2,Y2 boxes List the current X,Y location of the first and second corners of 
the edge. Type new values in the boxes to move one or both 
corners.

XC, and YC boxes The center coordinate of the arc or circle.

Radius box The radius for circles or arcs. Type a new value for the radius.

Start Angle box The starting angle of the arc. Zero (0) degrees is the positive X 
axis and positive angles are created counterclockwise.

Delta Angle box The number of degrees in the angle. Positive angles are created 
counterclockwise.
Tips:
• For circles, you can only change Center Point and Radius.
• For arcs, use the X1,Y1 and X2,Y2 fields as the arc end 

points. To define an arc, you only need a subset of these 
fields. To redefine the arc, only change one field at a time. 
If you make a change that can't be interpreted, the 
command is canceled.
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Drafting Properties Dialog Box

Related Topics

Modifying Drafting Edge Properties

Drafting Properties Dialog Box
You can select and edit drafting shapes in pieces or as whole items. The properties you can 
modify depend on whether you select a corner of the drafting object, an edge of the drafting 
object, or the whole, or parent object of a 2D line, copper, or text.

Exception: Several of the options in this dialog box are unavailable if the object is part of a 
physical design reuse.

Accessing

• Select a drafting shape > Right-click > Properties

Width Lists the width of the edge.

Length Lists the length of the edge.

Layer Lists the layer on which the object is located.

Track Clearance Specifies clearance values between the corner and objects 
around it.

Net Lists the net associated with the edge.

Net button Opens the Net Properties dialog box.

Parent button Opens the Drafting Properties dialog box for the drafting 
object to which the corner belongs.

Table 45-147. Drafting Edge Properties Dialog Box contents (cont.)

Name Description
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Figure 45-161. Drafting Properties Dialog Box

Figure 45-162. Showing the Nets to Bridge Button
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Drafting Properties Dialog Box

Table 45-148. Drafting Properties Dialog Box contents 

Name Description

Type Converts the selected shape to a new one: 2D Line, Board cut 
out, Copper, Copper cut out, Keep out, Copper pour, Plane 
area, Plane area cut out.
Tip: If your lines appear to be a closed polygon but you 
receive the error, “You cannot convert an open 2D Line into a 
close...”, with your shape selected, right-click and click the 
Close command. Unless there is a physical gap somewhere in 
your lines, your lines will be closed into a single polygon 
shape.
Restrictions: 
• 2D lines that have been combined cannot be change into 

other shapes. First, explode the 2D line combination and 
then try to change to another object.

• 2D lines that are continuous but are not a closed polygon 
can only be changed into a copper path. 

Width Specifies the width of the lines used for the outline and fill of 
the object if it applies.

Scale factor Specifies the scaling of the object.

Arc approximation error Specifies the allowable approximation error for scaling arcs. 
Arcs are converted to a set of straight-line segments that 
approximate the arc. The approximation error is the 
perpendicular distance from the approximation segment to the 
actual arc. 

Rotation Specifies the rotation of the object

Track clearance Displays the clearance value between the drafting object and 
objects around it.

Solid copper Specifies to fill the shape with solid copper despite the Width 
and Copper Hatch grid values which normally dictate the fill 
pattern of copper objects.



Drafting Properties Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1137

Bridge Specifies to make the drafting object a copper to bridge two or 
more nets. Click the Nets to bridge button to associate the 
bridge nets to the copper.
This ensures that with design rule checking (DRC) enabled, 
the bridge copper isn’t flagged as a violation when it is 
physically bridging different nets. Only the bridge copper is 
not flagged by DRC; other objects accidentally connecting the 
nets will be flagged as a violation by DRC and/or caught by a 
Verify Design Clearance check. The Connectivity check also 
catches bridge copper that is not physically connected to its 
assigned nets.
Restriction: This is only available to Copper drafting objects.
See also: Bridging Nets with Copper

Options button Opens the Flood and Hatch Options dialog box.
Restriction: This button is available only for Copper Pour and 
Plane Area drafting objects.

Nets to bridge button Opens the Net Association dialog box in order to select the 
nets to bridge using the copper.
See also: Bridging Nets with Copper

Net button Opens the Net Properties dialog box in order to view and 
change the properties of the net assigned to the drafting object.
Restriction: The net doesn’t function if there is no net 
assigned to the drafting object.

Layer list Specifies the layer on which this object is located.
Restriction: Copper, copper pours and plane areas cannot be 
placed on <All Layers>. If you need the object on all layers, 
you must copy the object to the other layers.
Tip: When defining keepouts in the PCB Decal Editor, you 
can also assign keepouts to an <Opposite Side> layer. You 
can’t do this in the Layout Editor.

Net assignment area Specifies the net to assign to the drafting object.
Alternative: You can also use the Assign Net by Click button 
also found in this dialog box.
Restrictions:
• Available for electrical drafting objects only.
• Not available when the Bridge check box is selected. 

Multiple nets apply when using the copper as a bridge. 
Associate the nets using the Nets to bridge button instead.

Restrictions area
This area is only available to Keepout drafting objects.

Table 45-148. Drafting Properties Dialog Box contents (cont.)

Name Description
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Drafting Properties Dialog Box

Placement Prevents placement of components within the keepout area 
when design rule checking is enabled. When used in 
combination with the Component height check box, it 
prevents placement only of those components with heights 
greater than the Component height value.
Restriction: Unavailable when creating or editing a decal-
level keepout.

Component height Prevents placement of components with heights greater than 
the specified height within the keepout area when design rule 
checking is enabled. Type the maximum height value in the 
box to the right of Component Height. 
See also: Restricting Heights in Areas of Component Layers.
Restrictions:
• Unavailable unless you select the Placement check box.
• Unavailable when creating or editing a decal-level keepout.

Component drill Prevents placement of components that contain drilled through 
holes within the keepout area, when design rule checking is 
enabled. (Allows only surface mount placement.)
Restrictions:
• Unavailable unless you set the Layer list to <All Layers>.
• Unavailable when creating or editing a decal-level keepout.

Select All button Selects all check boxes in the Restrictions area except 
Component drill.

Trace and copper Prevents the placement of traces within the keepout area, when 
design rule checking is enabled.
Restriction: Copper areas are always placed with design rules 
disabled. Placement of copper areas will not be prevented but 
the Verify Design utility will report any copper located within 
the keepout area.

Copper pour and plane 
area

Prevents copper pours and split/mixed planes from flooding 
within the keepout area, when design rule checking is enabled.

Via and jumper Prevents the placement of vias and jumpers within the keepout 
area, when design rule checking is enabled.

Test point Restricts the placement of test points within the keepout area, 
when design rule checking is enabled.

Table 45-148. Drafting Properties Dialog Box contents (cont.)

Name Description
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Related Topics

Modifying Drafting Object Properties

Drill Drawing Options Dialog Box
Use the Drill Drawing Options dialog box to set drill drawing legend and marker parameters.

Accessing

• File Menu > CAM > Add button > Select Drill Drawing from the Document Name 
List > Options button

or

• File Menu > CAM > Select a document name > Edit button > Select Drill Drawing 
from the Document Name List > Options button

Accordions Restricts the placement of accordions within the keepout area, 
when design rule checking is enabled.
Tips: 
• While you can set this option in PADS Layout, it applies to 

PADS Router only.
• Accordion Keepouts should be used for batch and 

interactive routing only. Design Verification does not 
detect accordions that are placed on accordion keepouts.

Assign Net by Click Specifies to assign nets to electrical drafting objects by 
clicking objects in the design. You can click objects such as a 
pin, via, trace, net, copper, or unroute to assign the netname of 
the object to the copper shape.
Alternative: You can also select a net from the list in the Net 
assignment area of this dialog box.
Restriction: Not available when the Bridge check box is 
selected. Multiple nets apply when using the copper as a 
bridge. Associate the nets using the Nets to bridge button 
instead.

Table 45-148. Drafting Properties Dialog Box contents (cont.)

Name Description
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Drill Drawing Options Dialog Box

Figure 45-163. Drill Drawing Options Dialog Box

Table 45-149. Drill Drawing Options Dialog Box contents 

Name Description

Draw Chart Specifies to includes the legend in the plot.

Letter Height Specifies the height of letters in design units.

Chart Line Width Specifies the width of the chart lines in design units.
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X/Y Location Specifies location of the drill chart in design units.
Tip: The location is not saved when you click the Save As 
Defaults button.

Height(letter) Specifies the letter height of the drill symbol marker.

Line Width Specifies the line width for the drill marker symbol and for all 
text.

Height(Symbol) Specifies the drill marker symbol height.

Show Through/Partial 
column

Specifies to show the Through/Partial column in the table.

Drill size units Specifies the units to use for the drill size.

Default tolerance Specifies the tolerance to use in the Tolerance column in the 
table.

Symbol and Size 
columns

Symbols are assigned in the order that the drill sizes are read 
into the table; for a manually created entry, the next available 
symbol is used. Symbol usage is exclusive to a drill size. The 
symbol assignment order for the 64 supported symbols is as 
follows:
• Six of the 12 available graphical symbols are used first (+, 

X, Rectangle, Diamond, Hour Glass, and Bow Tie)
• Letter symbols +A through +Z are assigned
• Six more graphical symbols (Rectangle +, Rectangle X, 

Diamond +, Diamond X, Circle +, and Circle X) are 
assigned

• Rectangle +A through Rectangle +Z are assigned

Quantity column The Quantity column displays the count of each drill size in the 
design.  It may contain a zero value for drill sizes loaded from 
the cam.defaults file, or for alternate drill sizes contained in the 
design database but not currently used in the design. See the 
Save As Defaults button for more information.

Plated column The Plated column displays whether the plating type for each 
drill size is plated (Yes) or non-plated (No). Duplicate drill 
sizes can appear in the table if each has a unique plating type.

Table 45-149. Drill Drawing Options Dialog Box contents (cont.)

Name Description
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Drill Drawing Options Dialog Box

Through/Partial column The check boxes in the Through/Partial column specify 
whether the drills listed in that row are to be output to the 
document (checked) or not output (unchecked). The boxes are 
checked by default.
Tips:
• This column is displayed only if the Show Through/Partial 

column check box in the Drill Data area is selected.
• When this column is displayed, if both through and partial 

drills of a given drill size exist, they are counted separately 
and appear in separate rows. When this column is not 
displayed, through and partial drills of a given size are 
totaled together and appear in a single row.

Tolerance Specifies the tolerance of the drill size.

Add Plated button Adds a specific plated drill size to the drill table. The new 
entry is assigned the next-available drill symbol.
Tip: To manually add a slotted hole to the drill table, use the 
format <width> X <slot_length> (for example, 0.020 X 1.000).

Add NonPltd button Add a specific non-plated drill size to the drill table. The new 
entry is assigned the next-available drill symbol.
Tip: To manually add a slotted hole to the drill table, use the 
format <width> X <slot_length> (for example, 0.020 X 1.000).

Delete button Removes selected drill size entries from the table. 
To remove multiple entries, use Ctrl or Shift and Click to 
select them before you click delete.

Augment button Automatically creates (appends) drill sizes for items in the 
current design file that are not already defined in the list.
Your list could be prepopulated by a set of drill sizes that may 
or may not be in use in the current design. See the information 
for the Save As Defaults button for more information. Using 
Augment will retain any unused hole/drill size listings.
Tip: The drill table reflects entries for slotted holes if they 
exist in the design database after you click Augment.

Regenerate button Clears the drill table and replaces all existing data with the data 
from the design database.
Your list could be prepopulated by a set of drill sizes that may 
or may not be in use in the current design. See the information 
for the Save As Defaults button for more information. Using 
Regenerate clears and creates a list of only the hole/drill sizes 
used in the design.
Tip: The drill table reflects entries for slotted holes if they 
exist in the design database after you click Regenerate.

Table 45-149. Drill Drawing Options Dialog Box contents (cont.)

Name Description



Drill Pairs Setup Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1143

Related Topics

Setting Drill Drawing Options

Creating CAM Outputs to Manufacture Your PCB

Adding or Editing CAM Documents

Drill Pairs Setup Dialog Box
Use the Drill Pairs Setup dialog box to define which layers to drill and plate together during 
manufacturing. Define these layers first to prevent defining or installing partial vias that cross 
layers that don't drill together. 

Accessing

• Setup menu > Drill Pairs

Save As Defaults button If you manually build your own drill table, or you want to 
reuse the contents of the table as the defaults for all CAM drill 
drawings you can save the contents as the default.
This creates a cam.defaults file located in the following 
location (default installation):
C:\MentorGraphics\<version>PADS\SDD_HOME\Settings
Restriction: The drill chart location is not saved when you 
click Save As Defaults.

Table 45-149. Drill Drawing Options Dialog Box contents (cont.)

Name Description
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DxDesigner Link Dialog Box, Documents Tab

Figure 45-164. Drill Pairs Setup Dialog Box

Related Topics

Creating a Drill Pair

DxDesigner Link Dialog Box, Documents Tab
Use the Documents Tab of DxDesigner Link to connect a schematic in DxDesigner with a 
layout design in PADS Layout for bringing data forward and back and cross-probing.
See also: Working with DxDesigner.

Table 45-150. Drill Pairs Setup Dialog Box Contents 

Name Description

# Shows the number of the layer in the drill pair.

Starting Layer Sets the starting layer of the drill pair.

# Shows the number of the layer in the drill pair.

Ending Layer Sets the ending layer of the drill pair.

Add Adds a row to the table.

Delete Removes the selected row.

Edit Makes the selected cell available for editing.
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Requirement: Ensure that cross-probing is turned on in DxDesigner; click Setup > Cross 
Probing. If there is a check mark to the left of Cross Probing, this option is already turned on.

Accessing

• PADS Layout Tools menu > DxDesigner

Figure 45-165. DxDesigner Link Dialog Box, Documents Tab

Table 45-151. Documents Tab contents 

Name Description

PADS Layout Design The name of the PADS Layout design you want to link with 
DxDesigner. Click Browse to locate the file.
Tips:
• If you do not open a layout design, DxDesigner Link 

connects to the default layout design file (default.pcb), 
which you can save under a different name.

• If the pathname lists a design, but you want to use the new 
default design opened in the design space, clear the 
pathname in the dialog box and then click Connect.

Disconnect/Connect 
button

This button changes names depending on if you are connected 
to PADS Layout or not. Click Connect to connect the file; 
Disconnect to disconnect it.
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DxDesigner Link Dialog Box, Documents Tab

Related Topics

Working with DxDesigner

DxDesigner Project File The name of the DxDesigner project file you want to link with 
PADS Layout. Click Browse to locate the file.
Tip: The DxDesigner Schematic field shows the file you last 
selected in DxDesigner Link.

Disconnect/Connect 
button

This button changes names depending on if you are connected 
to DxDesigner or not. Click Connect to connect the file; 
Disjoined to disconnect it.

Design Name Lists the designs in the DxDesigner project file. Select the one 
you want.

Forward/Backward 
configuration file

The name of the configuration file you want to use, usually 
pads<latest_release>.cfg. Click Browse to locate the file.
Tip: A default .cfg file is provided with DxDesigner. For 
PADS releases, it is located in the 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\stan
dard folder. For PADS 9.x, the file name is pads90.cfg.

Edit button Opens the configuration file in a text editor. See Schematic 
Design Help in DxDesigner for more information on editing 
configuration files.
See also: “Configuration File Structure” topic in the Schematic 
Design Help in DxDesigner.

Compare Designs button DxDesigner Link generates and displays three files:
• A differences file (.dif) that reports the differences between 

the schematic and layout design files.
• An error report (.err).
• An Engineering Change Order file (.eco). The forward and 

backward annotation operations use this file to synchronize 
the layout design and the schematic files.

Tip: Select the items you want to compare on the Preferences 
tab first.
See also: Comparing Designs

Forward to PCB button Opens the Forward Annotation dialog box.

Backward from PCB 
button

Opens the Backward Annotation dialog box.

Table 45-151. Documents Tab contents (cont.)

Name Description
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DxDesigner Link Dialog Box, Library Tab
When you update a PADS Layout design with data from the schematic, you may also want to 
pass library parts or updates to library parts. Use the Library tab of the DxDesigner Link dialog 
box to specify how and to which PADS Layout library to save DxDesigner library information.

Accessing

• Tools menu > DxDesigner > Library tab

Figure 45-166. DxDesigner Link Dialog Box, Library Tab

Table 45-152. Library Tab contents 

Name Description

Import modes for 
Library Parts area

Specifies the mode you want for importing library parts:
• Do not overwrite existing Parts—Does not overwrite 

parts in the design library with parts from the schematic.
• Always overwrite existing Parts—Overwrites parts in the 

design library with parts from the schematic.
• Prompt for each Part to overwrite—Prompts you before 

overwriting parts in the design library with parts from the 
schematic.

Library list Specifies the library into which to save DxDesigner parts.
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DxDesigner Link Dialog Box, Placement Tab

Related Topics

Forward Annotating from DxDesigner to PADS Layout

DxDesigner Link Dialog Box, Placement Tab
When cross-probing, you may want to identify which parts are placed and which parts are 
unplaced. This allows you to easily select and place parts. Use the Placement tab of the 
DxDesigner Link dialog box to view the placement of parts in the schematic and design. 

Tip: This tab is only available when DxDesigner Link is connected to both PADS Layout and 
DxDesigner.

Accessing

• Tools menu > DxDesigner > Placement tab

Figure 45-167. DxDesigner Link Dialog Box, Placement Tab

New Library button Click to create a new library for the imported parts from 
DxDesigner. The new library is added to the Library list.
Warning: The library is added to the bottom of the search 
order.

Table 45-152. Library Tab contents (cont.)

Name Description
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Related Topics

Cross-Probing with DxDesigner

DxDesigner Link Dialog Box, Preferences Tab
In DxDesigner Link, both forward and backward annotation operations compare the schematic 
with the PADS Layout design. Forward annotation uses the results of comparison to update the 
PADS Layout design. Backward annotation uses the results of comparison to update the 
DxDesigner schematic. 

In DxDesigner Link, use the Preferences tab to select the items for comparison.

Tips:

• Set preferences before you compare designs or forward/backward annotate.

• DxDesigner Link stores your preferences for future comparison and annotation 
operations. Set the preferences again only if you want to change them.

Accessing

• Tools menu > DxDesigner > Preferences tab

Table 45-153. Placement Tab contents 

Name Description

Show Components 
area

Specifies what type of components you want to show: Placed 
or Unplaced. Components are considered placed once they are 
located within the board outline.

Select in Schematic Specifies to select all components in the schematic that are 
listed in the DxDesigner Components list.

DxDesigner 
Components list

Lists the components in DxDesigner that are placed if you 
selected placed, or unplaced if you selected unplaced.

PADS Layout 
Components list

Lists the components in PADS Layout that are placed if you 
selected placed, or unplaced if you selected unplaced.
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DxDesigner Link Dialog Box, Preferences Tab

Figure 45-168. DxDesigner Link Dialog Box, Preferences Tab

Table 45-154. Preferences Tab contents 

Name Description

Compare only ECO 
Registered Parts

Comparison excludes non-ECO-registered parts, such as 
mechanical or non-electrical parts present in the PCB design 
and not present in the schematic. 
To include all parts during comparison, clear the Compare 
Only ECO Registered Parts check box.

Compare only ECO 
Registered Attributes

Comparison excludes non-ECO-registered attributes.
Tip: Via attributes are not ECO registered and cannot be 
added, deleted, or changed during the ECO process.

Compare Part Decals Comparison includes part decals.

Compare Design Rules Includes design rules in the comparison.
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Related Topics

Forward Annotating from DxDesigner to PADS Layout

Back Annotating from PADS Layout to DxDesigner

Name Comparison 
Options area

Specifies how you want to compare the names of design 
elements.
• Compare Net Names and Reference Designators. 

Rename as Necessary—Compare differences using 
reference designators and net names. 
Best used to minimize changes to routed traces. Selecting 
this option may result in the positional swapping of parts. 
For example, if routed trace changes are minimized when 
R1 and R12 are swapped, simultaneously rename R12 to 
R1 and R1 to R12, and then reconnect R1 and R12 to the 
original nets.

• Compare Net Names and Reference Designators. Prefer 
to Add or Delete Parts Instead of Renaming—Compare 
differences using reference designators and net names on 
the basis that few reference designators have been renamed 
and nets have not been renamed.
Best used to minimize the positional swapping of parts, and 
the design disruption that may result.

• Compare Connectivity and Topology (not names). 
Rename as Necessary—Compare differences without 
using reference designators or net names. Compare 
differences using pin names, part type names, and so on.
Best used to compare designs when parts and nets have 
been renamed and minimal interconnect changes have been 
performed (for example, when only an auto renumber has 
been performed on the design).

Ignore the Unused Pins 
Net

Specifies that you want the design comparison to exclude the 
unused pins net in the PADS Layout design.
Type the name of the unused pins net.
An unused pins net contains pins that have no logical net 
association. Routing with SPECCTRA or other tools in the 
PCB design process can create unused pins nets.
Restriction: You must use a net name of 47 characters or less. 
Use any alphanumeric characters except curly braces {}, 
asterisks *, or spaces.
Warning: If you clear this option and you update the PCB 
design from a schematic or previous PCB layout, the unused 
pins net may be deleted.

Table 45-154. Preferences Tab contents (cont.)

Name Description
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DxDesigner Link Dialog Box, Selection Tab

DxDesigner Link Dialog Box, Selection Tab
When cross-probing, you may want to set up how objects are selected in the two applications. 
Use the Selection tab of the DxDesigner Link dialog box to set up object selection between 
PADS Layout and DxDesigner. 

Tip: This tab is available only when DxDesigner Link is connected to both PADS Layout and 
DxDesigner.

Accessing

• Tools menu > DxDesigner > Selection tab

Figure 45-169. DxDesigner Link Dialog Box, Selection Tab

Table 45-155. Selection Tab contents 

Name Description

DxDesigner to PADS 
Layout

Specifies to allow selection of the PADS Layout object that 
corresponds to the selected DxDesigner object.
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Related Topics

Cross-Probing with DxDesigner

DxDesigner Link Dialog Box, Variants Tab
The Variants tab of the DxDesigner Link dialog box is used to pass assembly variant 
information between DxDesigner’s Variant Manager and PADS Layout’s Assembly Variants 
feature.

Accessing

• On the Tools menu, click DxDesigner and in the DxDesigner Link dialog box, click the 
Variants tab.

Restriction: The Variants Tab is available only once you connect to either the 
DxDesigner or PADS Layout design.

PADS Layout to 
DxDesigner

Specifies to allow selection of the DxDesigner object that 
corresponds to the selected PADS Layout object.

PADS Layout Specifies the zoom level you want to use in PADS Layout:
• None—Does not change the view when selections are 

made in the other application.
• Zoom to Selected—Zooms in on a component when it is 

selected in the other application.
• Pan to Selected—Pans to a component when it is selected 

in the other application.

DxDesigner Selections 
list

Lists the objects that are selected in DxDesigner.

PADS Layout 
Selections list

Lists the objects that are selected in PADS Layout.

Table 45-155. Selection Tab contents (cont.)

Name Description
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DxDesigner Link Dialog Box, Variants Tab

Figure 45-170. DxDesigner Dialog Box, Variants Tab

Table 45-156. Variants Tab Contents

Name Description

DxDesigner AV ASCII file Type the path to the assembly variant ASCII file created 
by DxDesigner or use the Browse button and browse to 
select the file. The file is located at the same location as 
the DxDesigner .prj file.

Create DxD AV file Click to create an assembly variant ASCII file from 
DxDesigner’s Variant Manager. The generated .asc file is 
stored at the same location as the DxDesigner project .prj 
file. The path to the file is also added to the DxDesigner 
AV ASCII file field, but only if an entry is not already in 
the field.
Restriction: This button is only available if you are 
connected to DxDesigner.

Show DxD Variants Click to view the assembly variant .asc file listed in the 
DxDesigner AV ASCII file field.
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Related Topics

DxDesigner’s Variant Manager Users Manual

Importing Variant Data to PADS Layout

Import AV to PADS Layout Click to import the assembly variant information from the 
DxDesigner assembly variant ASCII file into PADS 
Layout.
Restriction: This button becomes available only when the 
DxDesigner Link is connected to DxDesigner and the path 
to the DxDesigner assembly variant ASCII file is added to 
the DxDesigner AV ASCII file field.

PADS Layout AV ASCII file Type the path to the assembly variant ASCII file created 
by PADS Layout or use the Browse button and browse to 
select the file. The file is located at the same location as 
the PADS Layout .pcb file.

Create PADS AV file Click to create an assembly variant ASCII file from the 
PADS Layout’s Assembly Variant feature. The generated 
.asc file is stored at the same location as the PADS Layout 
.pcb file. The path to the file is also added to the PADS 
Layout AV ASCII file field, but only if an entry is not 
already in the field.
Restriction: This button is only available if you are 
connected to PADS Layout.

Show PADS Variants Click to view the assembly variant .asc file listed in the 
PADS Layout AV ASCII file field.

Import AV to DxDesigner Click to import the assembly variant information from the 
PADS Layout assembly variant ASCII file into 
DxDesigner. 
Restriction: The button becomes available only when the 
DxDesigner Link is connected to PADS Layout, and the 
path to the PADS Layout variant ASCII file is added to 
the PADS Layout AV ASCII file field.

Auto regenerate default AV 
ASCII files

Select this check box to automatically regenerate the 
assembly variant file after importing variant information 
to either DxDesigner or PADS Layout.

Compare AV ASCII files Click to compare the DxDesigner assembly variant 
against the PADS Layout assembly variant. A report file 
summarizes the differences.
Restriction: The button is functional when the path to 
both variants are loaded into the AV ASCII file fields 
for both DxDesigner and PADS Layout.

Table 45-156. Variants Tab Contents

Name Description
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DXF Export Dialog Box

Importing Variant Data to PADS Layout Manually

Exporting Variant Data to DxDesigner

Comparing Variant Data Files

DXF Export Dialog Box
Use the DXF Export dialog box to export DXF formatted files to AutoCAD2004.

Tip: PADS DXF export attempts to preserve as much of the PADS information as possible. The 
translator maintains all your defined colors except the background color.

Accessing

• File menu > Export > select DXF Files > Save

Figure 45-171. DXF Export Dialog Box
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Table 45-157. DXF Export Dialog Box Contents 

Name Description

DXF File Name The name of the DXF file you are importing.

Export Type

Standard Select this option to create an intelligent output that creates 
blocks, nested blocks, and an extensive layer setup.
For example, the objects that make up a decal are made into a 
complete block. When you select a part of the decal, the whole 
decal is selected.

Flat Select this option to create an output that creates a flat result with 
no blocks, and a basic layer setup.
For example, the objects that make up a decal are not arranged in 
a block and each object can be moved independently.
Restriction: When you select the flat output option, the Setup 
DXF Drill Size and Symbols dialog box is unavailable.

Layer Selection area—Select layers to export layer definition information and to permit 
the export of items on those Selected layers of your PADS Layout design. Items 
exported from the layer have the PADS Layout layer number appended to its AutoCAD 
layer name. 
For example, if you exported text from the top PCB layer, in AutoCAD it would be 
placed on layer TEXT_01. (Layer 0 or All Layers in PADS Layout is layer 00 in 
AutoCAD. In the PCB Decal Editor, the Opposite Layer maps to -1 in AutoCAD and the 
Inner Layers setting maps to -2 in AutoCAD.)

Available Lists the layers available for export.

Selected Lists the layers selected for export.

Add > Moves the selected layer from the Available list to the Selected 
list.

Add All >> Moves all of the layers from the Available list to the Selected list.

< Remove Moves the selected layer from the Selected list to the Available 
list.

<< Remove All Moves all of the layers from the Selected list to the Available list.

Select Input Items Area—Use these check boxes to select the design items you want to 
export to the layers in the Selected list. These selections are global and apply to all the 
layers in the selected list.

Board Select to export the board outline and cutouts. Standard export 
outputs a polyline outline of real width to layer 
BOARD_OUTLINE_00. Creates a Block called BOARD_1 from 
the outline shapes of the board and any existing cut outs.
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DXF Export Dialog Box

2-D Lines Select to export 2D lines. Standard export outputs polylines of 
real width to layers 2D_LINE_nn (where nn is the layer of origin 
in the PCB design).

Copper Select to export copper objects. Standard export outputs polylines 
of real width to layers COPPER_nn (where nn is the layer of 
origin in the PCB design).
Tip: Copper cut outs are exported as polylines of real width to 
layers COPPER_CUTOUT_nn (where nn is the layer of origin in 
the PCB design).

Copper Pour 
(includes Plane 
areas)

Select this check box to export copper pours from non-
Split/Mixed layers and also Plane area pours from Split/Mixed 
layers. 
This exports either hatch outlines or pour outlines depending on 
the Display mode setting in the Drafting - Hatch and Flood 
options.
• If the Display mode is set to Pour outline, selecting this under 

Standard export outputs copper pour objects as polylines of 
real width to layers POUR_HEADER_nn (where nn is the 
layer of origin in the PCB design).

• If the Display mode is set to Hatch outline, selecting this 
under Standard export outputs hatch outline objects as 
polylines of real width to layers POUR_OUTLINE_nn (where 
nn is the layer of origin in the PCB design).

Export includes the following:
• Global Hatch and Flood Options: Minimum Hatch Area, 

Smoothing Radius, View, and Display Mode.
• Individual custom Flood & Hatch Options settings if they 

exist as Copper Pour attributes: Hatch Grid, Smoothing 
Radius, Hatch Direction, and Flood over Vias.

Tip: Flood data brought in from PADS can be seen by performing 
a Hatch using a solid fill.

Copper Pour Cut Outs (includes Plane area cut outs)
Either Pour outline cut outs or Hatch outline cut outs are exported 
depending on the Display mode setting in the Drafting - Hatch 
and Flood options.
• If the Display mode is set to Pour outline, under Standard 

export, Pour outline cut outs are exported as polylines of real 
width to layers POUR_VOID_nn (where nn is the layer of 
origin in the PCB design).

• If the Display mode is set to Hatch outline, under Standard 
export, Hatch outline cut outs are exported as polylines of real 
width to layers POUR_VOID_nn (where nn is the layer of 
origin in the PCB design).

Table 45-157. DXF Export Dialog Box Contents (cont.)

Name Description
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Text Select to export text objects. Standard export outputs text to layers 
TEXT_nn (where nn is the layer of origin in the PCB design). 
Right-reading text strings are supported. 
See also: Working With Labels

Parts-Top Select to export parts mounted on the top layer of the PCB. 
Standard export outputs blocks with the name PART_TOP_x 
(where x is a consecutive number for each additional part) to layer 
PART_TOP. 
The translator exports height information if the part has either of 
the following properties:
• Geometry.Height general attribute
• Text string on layer 30 of form $height or $height1 height2 

(where height and height1 indicate the component height and 
height2 indicates the component mounting offset)

For details of how keepouts are constructed in AutoCAD, see the 
Keepouts section below.

• Component names—are exported, under Standard export, as 
text on layer PART_NAME_TOP.

• Decal names—are exported, under Standard export, to the 
SYM_NAME layer.

• Drill symbols—are exported, under Standard export, to the 
DRIL_SYMBOL layer.

• Jumper silkscreen—is exported, under Standard export, as a 
polyline on layer JUMPER_BOX.

• Outlines/Text—is exported, under Standard export, as sub 
blocks on layers BODY_nn (where nn is the layer of origin in 
the PCB design).

• Pad Stacks—are exported, under Standard export, as polyline 
outlines of real width on layers PADS_TOP, PADS_INNER, 
PADS_INNER_ANTI, PADS_BOT, 
DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines—are exported, under Standard export, to layers 
PART_TOP_2DLINE_nn (where nn is the layer of origin in 
the PCB design).

• Part types—are exported, under Standard export, as blocks 
on layer PART_INFO

• Part type names—are exported, under Standard export, as 
text on layer PART_TYPE_TOP

• Thermal reliefs—are exported, under Standard export, as 
polyline segments of real width on layers 
POUR_PADTHERM_nn

Table 45-157. DXF Export Dialog Box Contents (cont.)

Name Description
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DXF Export Dialog Box

Parts-Bottom Select to export parts mounted on the bottom layer of the PCB. 
Standard export outputs blocks with the name 
PART_BOTTOM_x to layers PART_BOTTOM. 
The translator exports height information if the part has either of 
the following properties:
• Geometry.Height general attribute
• Text string on layer 30 of form $height or $height1 height2 

(where height and height1 indicate the component height and 
height2 indicates the component mounting offset)

For details of how keepouts are constructed in AutoCAD, see the 
Keepouts section below.

• Component names—are exported, under Standard export, as 
text on layer PART_NAME_BOT

• Decal names—are exported, under Standard export, to the 
SYM_NAME layer

• Drill symbols—are exported, under Standard export, to the 
DRIL_SYMBOL layer

• Jumper silkscreen—is exported, under Standard export, as a 
polyline on level JUMPER_BOX

• Outlines/Text—is exported, under Standard export, as sub 
blocks on layers BODY_nn (where nn is the layer of origin in 
the PCB design).

• Pad Stacks—are exported, under Standard export, as polyline 
outlines of real width on layers PADS_TOP, PADS_INNER, 
PADS_INNER_ANTI, PADS_BOT, 
DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines—are exported, under Standard export, to layers 
PART_BOT_2DLINE_nn (where nn is the layer of origin in 
the PCB design).

• Part types—are exported, under Standard export, as blocks 
on layer PART_INFO

• Part type names—are exported, under Standard export, as 
text on layer PART_TYPE_nn (where nn is the layer of origin 
in the PCB design).

• Thermal reliefs—are exported, under Standard export, as 
polyline segments of real width on layers 
POUR_PADTHERM_nn (where nn is the layer of origin in 
the PCB design).

Table 45-157. DXF Export Dialog Box Contents (cont.)

Name Description
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Routes Select to export Traces and Vias. Standard export outputs traces 
as polylines of real width(s) to layers TRACE_nn (where nn is the 
layer of origin in the PCB design), and vias as blocks to layer 
VIA.

• Connections—are exported, under Standard export, as lines 
on layer LINK_nn (where nn is the layer of origin in the PCB 
design).

• Drill symbols—are exported, under Standard export, to the 
DRIL_SYMBOL layer

• Signals—are exported, under Standard export, as linetype 
with name and information

• Teardrops—are exported, under Standard export, as blocks to 
layers TEAR_nn (where nn is the layer of origin in the PCB 
design).

• Thermal reliefs—are exported, under Standard export, as 
polyline segments of real width on layers 
POUR_VIATHERM_nn (where nn is the layer of origin in the 
PCB design).

Keepout Select to export board keepouts. (Decal keepout are exported with 
Parts.) Standard export outputs keepouts as closed polylines to 
layer KEEPOUT_nn (where nn is the layer of origin in the PCB 
design). Each keepout is also made into a Block with the name 
KEEPOUT_x (where the x is a consecutive number for each 
additional keepout).
Keepouts are also given a Linetype of KEEPOUT_ABCDEFGHx 
to store its Restriction settings (where A=Placement, 
B=Component height, C=Component drill (this can only be used 
if you assign the keepout to All Layers), D=Trace and copper, 
E=Copper pour and plane area, F=Via and jumper, G=Test point, 
H=Accordions, and x=the value for the component height when 
used in conjunction with A & B. The value is set in database 
units. For example 1 mil =3810000 database units. 
Values for ABCDEFGH are either 0 or 1. A value of 0 means a 
cleared check box and a 1 means a selected check box.

The translator uses the Reverse for Keepout Hatch Direction.
The translator uses the Keepout hatch grid setting. 

Table 45-157. DXF Export Dialog Box Contents (cont.)

Name Description
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DXF Import Dialog Box

Mapping of General Objects
• Dimension objects—are exported to layers DIMENSIONx_nn (where x is the object 

number, and nn is the layer of origin in the PCB design).

• General PCB information—is exported as text to layer PCB_PARAMS

• Layer information—is exported as text to layer DBLAYERS (display colors, type of 
layer, thickness, etc.)

Related Topics

Exporting DXF Files

DXF Format in the Concepts Guide

Importing and Exporting Files in the Concepts Guide

DXF Import Dialog Box
You can import specialized shapes of DXF format into your decal or into the design using the 
AutoCAD 2004 DXF format.

Attributes Select to export the attribute dictionary, individual attributes and 
value assignments, attribute labels, and attribute status (read only, 
system, ECO Registered, or hidden). The attribute hierarchy is not 
exported.
Attribute names are exported, under Standard export, to the 
LABEL_INFO layer.
Attribute values are exported, under Standard export, to the 
LABEL_ATTRIBUTE layer.
Tips:
• DXF supports the increase in reference designator length to 15 

characters.
• Import is different - Reference designators, part types, 

attribute labels, and attribute status (read only, system, ECO 
Registered, or hidden). Jumper names are treated as reference 
designator labels.

See also: Working With Labels, Setting Up Jumpers

All Items Toggles all the check boxes of Input Items on or off.

DXF-File Unit The unit that will be used in the DXF file. 

Setup Opens the Setup DXF Drill Size and Symbols Dialog Box.

Table 45-157. DXF Export Dialog Box Contents (cont.)

Name Description
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Recommendation: There are two interfaces to import DXF files. This interface is optimized for 
importing RF shapes and only converts into 2D Lines and Copper objects. It allows you to map 
DXF layers to PADS Layout layers.
If you require more advanced import of any and all design objects, use the other DXF Import 
dialog box. It imports the design objects from specially named block and layers names in 
AutoCAD. But its mapping is hard-coded and can’t be changed.

Restriction: DXF import only supports the following geometries: POINT, LINE, ARC, 
CIRCLE, ELLIPS, TRACE, SOLID, 3DFACE, POLYLINE, LWPOLYLINE (AutoCAD R14), 
and BLOCKS with hierarchy.

Accessing

• Drafting Toolbar button > Import DXF File button > Open a .dxf file

Figure 45-172. DXF Import Dialog Box
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DXF Import Dialog Box

Related Topics

Importing RF Shapes in DXF Format

DXF Format in the Concepts Guide

DXF Import Dialog Box
Use the DXF Import dialog box to import files of the AutoCAD 2004 DXF format into the 
design.

Restriction: Assigning unique colors in AutoCAD may result in translation back to PADS as 
black if the color is not one of the PADS colors.

Recommendation: There are two interfaces to import DXF files. This interface is designed for 
advanced import of any and all design objects. It imports the design objects from specially 
named block and layers names in AutoCAD. This mapping is hard-coded and can’t be changed. 
This allows a whole design, exported from PADS Layout, to be reimported from AutoCAD.
If you need to simply import RF shapes into the decal or into the design, use the other DXF 
Import dialog box. It allows you to map the DXF layers to PADS Layout layers.

Accessing

• File menu > Import > set file type to DXF Files (*.dxf) > select a DXF File > Open

Table 45-158. DXF Import Dialog Box Contents 

Name Description

DXF File Name The name of the .dxf file you opened.

DXF-File Unit The units used in this .dxf file: Mils, Metric, Inches.

DXF Layer Lists the DXF layers available in this .dxf file.

Add Specifies whether to import this layer.

PCB Layer Specifies the PCB Layer to which you want to import the 
DXF items.
Restriction: A PCB layer set to <All Layers> cannot be 
imported as copper. You cannot have copper items on 
<All Layers> in a PCB decal.

Type Specifies the type of item on the layer: 2D line or copper.
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Figure 45-173. DXF Import Dialog Box

Table 45-159. DXF Import Dialog Box Contents 

Name Description

DXF File Name The name of the DXF file you are importing.

Layer Selection area—Select layers to accept imported items. Items exported to the 
layer have the PADS Layout layer number appended to its AutoCAD layer name. 
For example, if you import text to the top PCB layer, in AutoCAD it is placed on layer 
TEXT_01. (Layer 0 or All Layers in PADS Layout is layer 00 in AutoCAD. In the PCB 
Decal Editor, the Opposite Layer maps to -1 in AutoCAD and the Inner Layers setting 
maps to -2 in AutoCAD.)

Available Lists the layers available for import.

Selected Lists the layers selected for import.

Add > Moves the selected layer from the Available list to the Selected 
list.

Add All >> Moves all of the layers from the Available list to the Selected list.

< Remove Moves the selected layer from the Selected list to the Available 
list.

<< Remove All Moves all of the layers from the Selected list to the Available list.
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DXF Import Dialog Box

Select Input Items Area—Use these check boxes to select the design items you want to 
import to the layers in the Selected list. These selections are global and apply to all the 
layers in the selected list.

Board Select to import the board outline and cutouts. Imports a polyline 
outline of real width from layer BOARD_OUTLINE_00. The 
outline shapes of the board and any existing cut outs must be in a 
Block called BOARD_1.
See also: Importing a Board Outline and Cut Out from AutoCAD

2-D Lines Select to import 2D lines. Imports polylines of real width from 
layers 2D_LINE_nn (where nn is the layer of origin in the PCB 
design).

Copper Select to import copper objects. Imports polylines of real width 
from layers COPPER_nn (where nn is the layer of origin in the 
PCB design).
Tip: Copper cut outs are imported as polylines of real width from 
layers COPPER_CUTOUT_nn (where nn is the layer of origin in 
the PCB design).

Copper Pour 
(includes Plane 
areas)

Select this check box to import copper pours from non-
Split/Mixed layers and also Plane area pours from Split/Mixed 
layers.
• Imports pour outline objects from polylines of real width on 

layers POUR_HEADER_nn (where nn is the layer of origin in 
the PCB design).

• Imports hatch outline objects from polylines of real width on 
layers POUR_OUTLINE_nn (where nn is the layer of origin 
in the PCB design).

Import includes the following:
• Global Hatch and Flood Options: Minimum Hatch Area, 

Smoothing Radius, View, and Display Mode.
• Individual custom Flood & Hatch Options settings if they 

exist as Copper Pour attributes: Hatch Grid, Smoothing 
Radius, Hatch Direction, and Flood over Vias.

Copper Pour Cut Outs (includes Plane area cut outs)
Either Pour outline cut outs or Hatch outline cut outs are 
imported.
• Pour outline cut outs are imported from polylines of real width 

on layers POUR_VOID_nn (where nn is the layer of origin in 
the PCB design).

• Hatch outline cut outs are imported from polylines of real 
width on layers POUR_VOID_nn (where nn is the layer of 
origin in the PCB design).

Table 45-159. DXF Import Dialog Box Contents (cont.)

Name Description
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Text Select to import text objects. Imports text from layers TEXT_nn 
(where nn is the layer of origin in the PCB design). Right-reading 
text strings are supported. 
See also: Working With Labels

Parts-Top Select to import parts mounted on the top layer of the PCB. 
Imports blocks with the name PART_TOP_x (where x is a 
consecutive number for each additional part) to layer 
PART_TOP. 
For details of how keepouts are constructed in AutoCAD, see the 
Keepouts section below.

• Component names—are imported from text on layer 
PART_NAME_TOP.

• Decal names—are imported from the SYM_NAME layer.
• Drill symbols—are imported from the DRIL_SYMBOL 

layer.
• Jumper silkscreen—is imported from a polyline on layer 

JUMPER_BOX.
• Outlines/Text—is imported from sub blocks on layers 

BODY_nn (where nn is the layer of origin in the PCB design).
• Pad Stacks—are imported from polyline outlines of real 

width on layers PADS_TOP, PADS_INNER, 
PADS_INNER_ANTI, PADS_BOT, 
DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines—are imported from layers 
PART_TOP_2DLINE_nn (where nn is the layer of origin in 
the PCB design).

• Part types—are imported from blocks on layer PART_INFO
• Part type names—are imported from text on layer 

PART_TYPE_TOP
• Thermal reliefs—are imported from polyline segments of 

real width on layers POUR_PADTHERM_nn

Table 45-159. DXF Import Dialog Box Contents (cont.)

Name Description
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DXF Import Dialog Box

Parts-Bottom Select to import parts mounted on the bottom layer of the PCB. 
Imports blocks with the name PART_BOTTOM_x from layers 
PART_BOTTOM. 
For details of how keepouts are constructed in AutoCAD, see the 
Keepouts section below.

• Component names—are imported from text on layer 
PART_NAME_BOT

• Decal names—are imported from the SYM_NAME layer
• Drill symbols—are imported from the DRIL_SYMBOL layer
• Jumper silkscreen—is imported from a polyline on level 

JUMPER_BOX
• Outlines/Text—is imported from sub blocks on layers 

BODY_nn (where nn is the layer of origin in the PCB design).
• Pad Stacks—are imported from polyline outlines of real 

width on layers PADS_TOP, PADS_INNER, 
PADS_INNER_ANTI, PADS_BOT, 
DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines—are imported from layers 
PART_BOT_2DLINE_nn (where nn is the layer of origin in 
the PCB design).

• Part types—are imported from blocks on layer PART_INFO
• Part type names—are imported from text on layer 

PART_TYPE_nn (where nn is the layer of origin in the PCB 
design)

• Thermal reliefs—are imported from polyline segments of 
real width on layers POUR_PADTHERM_nn (where nn is the 
layer of origin in the PCB design)

Routes Select to import Traces and Vias. Imports traces from polylines of 
real width(s) on layers TRACE_nn (where nn is the layer of 
origin in the PCB design), and vias as blocks to layer VIA.

• Connections—are imported from lines on layer LINK_nn 
(where nn is the layer of origin in the PCB design).

• Drill symbols—are imported from the DRIL_SYMBOL layer
• Signals—are imported from linetypes with name and 

information
• Teardrops—are imported from blocks to layers TEAR_nn 

(where nn is the layer of origin in the PCB design).
• Thermal reliefs—are imported from polyline segments of 

real width on layers POUR_VIATHERM_nn (where nn is the 
layer of origin in the PCB design).

Table 45-159. DXF Import Dialog Box Contents (cont.)

Name Description
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Keepout Select to import board keepouts. (Decal keepout are imported 
with Parts.) Imports keepouts from closed polylines on layer 
KEEPOUT_nn (where nn is the layer of origin in the PCB 
design). Each keepout must also be made into a Block with the 
name KEEPOUT_x (where the x is a consecutive number for 
each additional keepout).
Keepouts are also given a Linetype of KEEPOUT_ABCDEFGHx 
to store its Restriction settings (where A=Placement, 
B=Component height, C=Component drill (this can only be used 
if you assign the keepout to All Layers), D=Trace and copper, 
E=Copper pour and plane area, F=Via and jumper, G=Test point, 
H=Accordions, and x=the value for the component height when 
used in conjunction with A & B. The value is set in database 
units. For example 1 mil =3810000 database units. 
Values for ABCDEFGH are either 0 or 1. A value of 0 means a 
cleared check box and a 1 means a selected check box.

The translator uses the Keepout hatch grid setting. 

Attributes Select to import reference designators, part types, attribute labels, 
and attribute status (read only, system, ECO Registered, or 
hidden). Jumper names are treated as reference designator labels.
Attribute names are imported from the LABEL_INFO layer.
Attribute values are imported from the LABEL_ATTRIBUTE 
layer.
Tips:
• All attributes are imported with ECO registration off. If the 

attribute already exists in the attribute dictionary, it is not 
changed.

• DXF supports the increase in reference designator length to 15 
characters.

• Export is different - Attribute dictionary, individual attributes 
and value assignments, attribute labels, and attribute status 
(read only, system, ECO Registered, or hidden). The attribute 
hierarchy is not exported.

See also: Working With Labels, Setting Up Jumpers

All Items Toggles all the check boxes of Input Items on or off.

DXF-File Unit The unit that will be used in the DXF file. When it is not 
necessary to set the Unit, this list is unavailable.

Mode area

New Specifies to import a DXF file that was exported from PADS 
Layout. Reads PADS Layout layer and via information in the file.

Table 45-159. DXF Import Dialog Box Contents (cont.)

Name Description
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DXF Import Dialog Box

Related Topics

Importing DXF Files

DXF Format in the Concepts Guide

Importing and Exporting Files in the Concepts Guide

Add Specifies to import a native AutoCAD DXF file. Reads 2D line, 
text, keepout, and copper items in the file. You can also use this 
option to ignore layer and via information in a DXF file exported 
from PADS Layout.

Table 45-159. DXF Import Dialog Box Contents (cont.)

Name Description
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ECO Options Dialog Box
Use the ECO Options dialog box to specify whether and how an ECO file will be written when 
you make engineering (netlist) changes to a design using the ECO toolbar.

Accessing

• Tools menu > ECO Options

or

• ECO Toolbar button (when you select it the first time in a session)

or

• ECO Toolbar button > ECO Options button

Figure 45-174. ECO Options Dialog Box

Table 45-160. ECO Options Dialog Box Contents

Name Description

Write ECO File Select to record all ECO operations to a file. You can use this 
file to back-annotate your schematic.
See also: ECO Options - Check Box Combinations



PADS Layout User’s Guide and Reference Manual, PADS 9.41172
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Append To File Select to append ECO operations to the end of an existing .eco 
file named in the Filename box. 
Clear to overwrite an existing .eco file named in the Filename 
box.
If the named file does not exist, a new file is created.
See also: ECO Options - Check Box Combinations

ECO Filename Type a pathname or click the Browse button to select an 
existing file.

Write ECO File After 
Closing ECO toolbar

Select to update the .eco file when you close the ECO toolbar 
to leave ECO mode. This allows you to review the file 
immediately, but clears the undo buffer, so undo capabilities 
are lost.
Clear to continue to have undo capabilities after you close the 
ECO toolbar - until you save the design, when the .eco file is 
written and the undo buffer is cleared. 
See also: ECO Options - Check Box Combinations

Expand Part Attributes Records attributes from higher levels in the design hierarchy, 
such as from the Part Type. It also moves the attributes to the 
highest level readable by a schematic capture program.

Expand Net Attributes Records attributes from higher levels in the design hierarchy, 
such as from the board in the .eco file. It also moves the 
attributes to the highest level readable by a schematic capture 
program.

Output Only ECO 
Registered Parts

Select to specify that objects must be ECO-registered to be 
included in the ECO file. 
See also: ECO Registration in the Concepts Guide

Table 45-160. ECO Options Dialog Box Contents

Name Description
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Output Decal Changes Select to record decal changes to the ECO file. If this option is 
selected and if PADS Layout is not in ECO mode:
• When you try to right-click and click Edit Decal, you get 

the error message “You can modify decals only in ECO 
mode or if ECO option Output Decal Change is off.” You 
must simply open the ECO toolbar to edit the decal.

• When you try to change the Pad stack of a decal through 
the Pin Properties, you get the prompt message “You can 
modify decal pad stacks only in ECO mode. Continue?” 
You can edit the pad stack without needing to open the 
ECO toolbar.

Caution: Decals are switched to alternates using the 
Component Properties dialog box and can be changed 
outside of ECO mode. An .eco file created by the ECO 
toolbar will not contain decal changes to alternates. Use the 
Compare/ECO dialog box to create an .eco file that lists 
changes to alternate decals.

Table 45-161. ECO Options - Check Box Combinations

Check Box Combination Result

Creates a new .eco file according to the pathname in the 
Filename box. Overwrites any existing .eco file with the 
same name at that location. Appends additional ECO 
changes to the .eco file, despite opening or closing the 
ECO toolbar, until the changes are saved to the .eco file 
when:
• (the ECO toolbar is closed) and you Save the .pcb file

or 
• you exit the software or open a new design.

Appends to the .eco file listed in the Filename box. 
Creates a new .eco file if none exists. Appends additional 
ECO changes to the .eco file, despite opening or closing 
the ECO toolbar, until the changes are saved to the .eco 
file when:
• (the ECO toolbar is closed) and you Save the .pcb file

or
• you exit the software or open a new design.

Table 45-160. ECO Options Dialog Box Contents

Name Description
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EDC Parameters Dialog Box

Related Topics

Comparing Designs

Recording ECO Changes

EDC Parameters Dialog Box
Use the EDC Parameters dialog box to define global rules like layer thickness and copper 
thickness. You can also specify how detailed a design verification report you want.

Accessing

• Tools menu > Verify Design > High Speed check > Setup button > Parameters 
button

Creates a new .eco file according to the pathname in the 
Filename box. Overwrites any existing .eco file with the 
same name at that location.
Writes changes to the .eco file only when you:
• close the ECO toolbar

or
• exit the software or open a new design.

Appends to the .eco file listed in the Filename box. 
Creates a new .eco file if none exists.
Writes changes to the .eco file only when you:
• close the ECO toolbar

or
• exit the software or open a new design.

Table 45-161. ECO Options - Check Box Combinations

Check Box Combination Result
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Figure 45-175. EDC Parameters Dialog Box

Table 45-162. EDC Parameters Dialog Box contents 

Name Description

Layer Definitions table • Name—The name of the layer.
• Type—The type of layer: Prepeg or Substrate.
• Thickness—Specifies the required coating.

Exception: If no coating is required, set thickness to zero.
• Dielectric—Specifies the dielectric constant value.

Board Thickness Displays the total value of material and layer thicknesses in the 
current design units.

Edit button Allows you to edit a selected table cell.

Layers button Opens the Layers Setup dialog box.

Copper Thickness Units Specifies the copper thickness unit you want to use:
• Weight (oz)—Weight of copper in ounces, per square foot.
• Design Units—Same unit of measure as the current 

database unit of measure
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Parallelism Check 
Against

Specifies the extent of checking.
• Nets/Pin Pairs—Checks the parallelism and tandem rules 

against the entire net or pin pair.
• Segments—Checks the parallelism and tandem rules 

against only individual segments.

Parallelism Report 
Detail

Specifies the extent of reporting.
• Net Names Only—Displays only net names and 

violations.
• Aggressors/Victims—Displays specific aggressor and 

victim nets.
• Segments—Displays segment coordinates and layers in 

addition to aggressor and victim nets.

Daisy Chain Report 
Detail

Specifies the extent of reporting.
• Net Names Only—Include the number of T points and 

whether the net is daisy chained.
• Stubs—Include the group of pins within each stub, the 

total stub length for each group, the number of T points, 
and whether or not the net is daisy chained.

• Pin Pairs—Include the pin to pin length of all pin pairs, 
the total pin pair length added together to form stubs, the 
number of T points, and whether the net is daisy chained.

• Segments—Include the coordinates and layer of all track 
corners, the pin to pin length of all pin pairs, the total pin 
pair length added together to form stubs, the number of T 
points, and the nets being daisy chained.

Other Checks Check 
Against

Specifies the extent of checking of Length and Delay rules.
• Nets/Pin Pairs—Check the Length and Delay rules against 

the entire net or pin pair.
• Segments—Check the Length and Delay rules against 

individual segments.

Other Checks Report 
Detail

Specifies the extent of reporting for capacitance, impedance, 
delay, and length.
• Nets—Include the starting and ending pins of nets and net 

values for capacitance, impedance, delay, and length.
• Pin Pairs—Include pin-to-pin points, pin pair values, and 

net values for capacitance, impedance, delay, and length.
• Segments—Include individual segment coordinates and 

segment values for capacitance, impedance, delay, and 
length.

Include Copper Specifies to include copper polygons with signal names in the 
capacitance calculations.

Table 45-162. EDC Parameters Dialog Box contents (cont.)

Name Description
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Related Topics

Setting Up EDC Parameters

Edit CAM Document Dialog Box
See: Add/Edit CAM Document Dialog Box

Edit Button Image Dialog Box
Use the Edit Button Image dialog box to create or edit button icons.

Accessing

• Tools menu > Customize > Commands tab > New button > Select User-Defined 
Image > New or Edit

Use FieldSolver for 
Calculations

Specify to calculate electric parameters of transmission lines 
such as: impedance, delay (per unit length), and capacitance 
(per unit length).
See also: the BoardSim User’s Guide.

Report Segment 
Coordinates

Specifies to include segment coordinates in reports where 
Segments has been selected in the Report Detail in any one of 
Parallelism, Daisy Chain, or Other Checks sections.

Report Violations Only Specifies to list only items that contain violations in the high-
speed report.

Remove Segments 
Under Pads

Specifies to exclude trace segments under pads from 
calculations. When routing, traces are routed into the middle of 
pads. This final segment is excluded.

Table 45-162. EDC Parameters Dialog Box contents (cont.)

Name Description
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Edit Die Size Dialog Box

Figure 45-176. Edit Button Image Dialog Box

Edit Die Size Dialog Box
Use the Edit Die Size dialog box to change the size of a die.

Restriction: This information applies only to the BGA toolkit.

Accessing

• BGA Toolbar button > Wire Bond Editor button > click the BGA > Right-click > 
Edit Die Size

Table 45-163. Edit Button Image Dialog Box Contents

Field Description

Colors area Select a color to use with the tools

Tools area Select a tool to draw/edit the picture or icon of the button
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Figure 45-177. Edit Die Size Dialog Box

Related Topics

To Edit the Die Size

Electrodynamic Check Dialog Box
Use the Electrodynamic Check dialog box to enable high-speed checks for individual nets and 
classes or for the whole design.

Requirement: You must have specified your plane layers in the Layers Setup dialog box before 
you run an electrodynamic check. For a two-layer board, temporarily identify one of the layers 
as a plane layer.

Accessing

• Tools menu > Verify Design > High Speed check > Setup button

Table 45-164. Edit Die Size Dialog Box contents 

Name Description

Length Specifies the new length of the die.

Width Specifies the new width of the die.

Height Specifies the physical height of the die, for programs that use 
this value.
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Electrodynamic Check Dialog Box

Figure 45-178. Electrodynamic Check Dialog Box

Table 45-165. Electrodynamic Check Dialog Box contents 

Name Description

Task List Lists the specific checks of certain nets or classes you want to 
check. You can enable different checks for each items in the 
Task list.
Tip: (N) is added to Task list items that are nets and (C) is 
added to items that are classes.

Add Nets button Opens the Add Net Tasks dialog box.

Add Classes button Opens the Add Class Tasks dialog box.

Delete button Removes the task from the Task List.

Check Capacitance A function of line length. Capacitance values change when the 
routed length of a track changes. Use the HiSpeed Rules dialog 
box to specify minimum and maximum capacitance values.

Check Impedance Calculated based on track width and copper thickness. 
Modifying the track width or changing the copper thickness 
changes the Impedance values. Use the HiSpeed Rules dialog 
box to specify minimum and maximum impedance values.

Check Parallelism You can search for tracks on the same layer that may run 
parallel closely enough or long enough to cause cross talk 
problems. Use the HiSpeed Rules dialog box to define the 
maximum permissible parallel lengths, the minimum gap, and 
if a net is an aggressor or a victim.
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Related Topics

Setting Up High Speed (Electrodynamic) Checking

Enable/Disable Layers Dialog Box
Use the Enable/Disable Layers dialog box to specify which nonelectrical layers to enable or 
disable. This shows or hides layers in layer lists - for example, the Layer list on the standard 
toolbar, or the Layers Setup and Display Colors dialog boxes.

Tip: Switching to increased layer mode does not affect the enabled or disabled status of a layer.

Accessing

• Setup menu > Layer Definition > Enable/Disable button

Check Tandem You can search for tracks on different layers that run parallel 
closely enough or long enough to cause crosstalk problems. 
Use the HiSpeed Rules or Conditional Rule Setup dialog box 
to define the maximum permissible tandem lengths, the 
minimum gap, and if a net is an aggressor or a victim.

Check Length You can determine mismatched signal lengths. Use the 
HiSpeed Rules dialog box to specify minimum and maximum 
lengths.

Check Delay Calculated based on track length. The delay value changes 
when the track length changes. Use the HiSpeed Rules dialog 
box to specify minimum and maximum delay values.

Check Stubs Stub length is important to proper line termination. Use the 
HiSpeed Rules dialog box to specify a maximum stub length.

Check Loops A daisy-chained net has no loops or T-junctions.

Parameters button Opens the EDC Parameters dialog box.

Rules button Opens the Rules dialog box.

Open button Opens the File Open dialog box where you can retrieve 
settings from an .edp file.

Save button Stores your settings to an .edp file in the \PADS Projects folder 
using the same name as your design.

Save As button Opens the File Save As dialog box where you can store your 
settings to an .edp file using the location you want and the file 
name you want.

Table 45-165. Electrodynamic Check Dialog Box contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41182

Extension Properties Dialog Box

Figure 45-179. Enable/Disable Layers Dialog Box

Related Topics

Enabling or Disabling Non-electrical Layers

Extension Properties Dialog Box
The Extension Properties dialog box displays coordinate information for the selected extension 
line and provides several areas for modifications. 

Click Apply to apply your modifications or Cancel to cancel the changes.

Table 45-166. Enable/Disable Layers Dialog Box Contents 

Name Description

Enabled Indicates whether the specified layer is enabled.

Has data Indicates whether the specified layer contains data.

Name Indicates the name of the specified layer.

Type Indicates the type of the specified layer.
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The Extension Properties dialog box remains open until you click OK or Cancel. Selecting 
another extension line while the dialog box is open updates the information for the selected 
object.

Accessing

• Select an extension > right-click > Properties

Figure 45-180. Extension Properties Dialog Box

Related Topics

Dimensioning Process

Table 45-167. Extension Properties Dialog Box contents 

Name Description

X and Y Lists the X and Y coordinate locations of the selected object.

Layer list Lists the current working layer. Select a new layer from the 
list.

Line Width Lists the current line width used for the dimension object. 
Type a new value to change the line width.

Pick Gap Lists the current gap between the selection point and the end of 
the extension line. Type a new value to change the gap.

Arrow Offset Lists the current length that the extension line extends beyond 
the arrow. Type a new value to change the length.

Parent button Opens the Dimension Properties dialog box for the dimension 
object with which the selected object is associated.
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Fabrication Checking Setup Dialog Box

Fabrication Checking Setup Dialog Box
Use the Fabrication Checking Setup dialog box to enable fabrication checks, or to load DFF 
errors from a preexisting CAM350 database and annotate into the design.

Requirement: You need the CAM350 Link license option to use this. On the Help menu, click 
Installed Options and on the Options tab, check if the option is available in your license.

Accessing

• Tools menu > Verify Design > Fabrication check > Setup button

Figure 45-181. Fabrication Checking Setup Dialog Box
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Table 45-168. Fabrication Checking Setup Dialog Box contents 

Name Description

Fabrication Checking 
Setup

• Run Fabrication Checks—Specifies to run the fabrication 
checks in PADS Layout.

• Annotate DFF Errors—Specifies to load DFF errors from 
a CAM350 file. Select this if you use CAM350 for 
checking your fabrication errors.

Acid Traps Specifies to flag small areas where acid will pool up. The 
check is run on all visible electrical layers as defined in the 
CAM documents.

Maximum Size Specifies the maximum value of the acid traps to detect. The 
areas of the “pools” that are flagged will be less than this 
value.

Maximum Angle Specifies the maximum angle for traces, pads, or any other 
data that exists on the layer. Any items that form an angle 
smaller than this will be flagged as an acid trap.

Slivers Specifies to flag copper sliver and solder mask sliver areas. 
This compares the top solder mask layer against the top 
electrical layer and the bottom solder mask layer against the 
bottom electrical layer as defined in the CAM documents.

Minimum Copper Specifies the minimum value for copper slivers. This flags 
slivers with less area than this value.

Minimum Mask Specifies the minimum value for solder mask slivers. This 
flags the slivers with a width less than this value, checking the 
top and bottom solder mask layers if they are visible. 

Starved Thermals Specifies to flag invalid thermals where adjacent data overlaps 
the thermal spokes.
Restriction: Starved Thermals are only checked on (negative) 
CAM planes.

Minimum Clearance Specifies the percentage of the thermal's spoke that can be 
unblocked by another object. Any less of an opening will be 
considered “starved.”

Minimum Spokes Specifies the minimum allowable number of the thermal's 
spokes that cannot be blocked by another object. Any less will 
be considered “starved.”

Trace Width/Pad Size Specifies to flag traces and pads that are too small. Checks all 
electrical layers as defined in the CAM documents.

Minimum Trace Specifies the minimum trace width value. This flags traces 
with a width less than this value. This check runs on all visible 
electrical layers.
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Minimum Pad Specifies the minimum pad size. This flags pads with a 
diameter of less than this value. This check runs on all visible 
electrical layers.

Silkscreen Over Pads Specifies to flag silkscreen over pads on top and bottom layers 
as defined in the CAM documents.

Minimum Gap Specifies the minimum allowable distance between silkscreen 
features and a region exposed by solder mask.

Annular Ring Specifies to flag minimum annular rings on top and bottom 
layers, comparing electrical, drill, and mask layers.

Pad to Mask Specifies to flag minimum clearance distances between a pad 
and its solder mask opening. The offset and annular ring is 
checked against the specified clearance value. This compares 
the top electrical layer against the top solder mask layer or the 
bottom electrical layer against the bottom solder mask layer. 

Layers list Specifies the layer to use for checking.

Drill to Mask Specifies to flag minimum clearance distances between a drill 
and its solder mask opening. The offset and annular ring is 
checked against the specified clearance value. This compares 
the top drill layer against the top solder mask layer or the 
bottom drill layer against the bottom solder mask layer.

Layers list Specifies the layer to use for checking.

Drill to Pad Specifies to flag minimum clearance distances between a drill 
and its associated pad. The offset and annular ring is checked 
against the specified clearance value. This check is run on each 
specified layer.

Layers list Specifies the layer to use for checking.

Solder Bridges Specifies to flag solder mask bridging. Solder can bridge and 
cause a connection to an adjacent object within the same mask 
opening. If the adjacent object is farther from the pad than this 
distance, even if it is exposed by the mask layer, it will not be 
identified as a bridge. This compares the top solder mask layer 
against the top electrical layer or the bottom solder mask layer 
against the bottom electrical layer as defined in the CAM 
documents.

Minimum Gap Specifies the minimum clearance value.

Layers list Specifies the layer to use for checking.

Table 45-168. Fabrication Checking Setup Dialog Box contents (cont.)

Name Description
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Related Topics

Setting Up Fabrication Checking

Fanout Rules Dialog Box
Use the Fanout Rules dialog box to specify fanout rules. Use fanouts to make routing easier and 
to ensure that connections are made. PADS Router optimally places fanout vias and routes from 
vias to corresponding pins for ordered components or separate pins. Fanouts are most useful for 
some complex SMDs, like BGAs.

Restrictions

• While you can define these rules in either PADS Layout or PADS Router, the rules are 
used only in PADS Router. 

• In PADS Layout, you can define fanout rules for only SOIC/QUAD type components. 
Use PADS Router to also define fanout rules for BGA and staggered BGA fanout 
patterns. 

Accessing

• Setup menu > Design Rules > Default button > Fanout button

•

CAM350 File Name Specifies the .cam path and file name of a file to back-annotate 
DFF errors into PADS Layout for design verification.
Tip: Click Browse to navigate to the location.

Table 45-168. Fabrication Checking Setup Dialog Box contents (cont.)

Name Description
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Fanout Rules Dialog Box

Figure 45-182. Fanout Rules Dialog Box

Table 45-169. Fanout Rules Dialog Box 

Area Description

Alignment Specify the via placement:
• Aligned—Aligns fanout vias on the PADS Router fanout grid.
• Alternate—Staggers the direction of fanout vias. For example, the 

first pin fans out to the left and the second pin fans out to the right, 
and the pattern repeats.

• Multi-row check box—Specifies to create two rows of vias on each 
side of the component that has pins.

Direction Specify where you want to locate the fanout vias, relative to the 
component outline:
• Inside—All fanout vias are located inside the component outline.
• Outside—All fanout vias are located outside of the component 

outline.
• Both Sides—Fanout vias are located both inside and outside of the 

component outline.
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Tip: Fanning out an entire design is not generally recommended because it creates many vias. 
However on component-dense PCBs requiring many layers, it may be necessary to fan out all 
SMD components.

Related Topics

Design Rule Hierarchy in the Concepts Guide

Via Spacing Specify the fanout via spacing you want:
• Use Grid—Place fanout vias on the fanout grid.
• 1 Trace—Width of one trace. This sets a via grid that enables PADS 

Router to route one wire between adjacent vias.
• 2 Trace—Width of two traces. This sets a via grid that enables PADS 

Router to route two wires between adjacent vias.

Pin Sharing Specify all the connections on the same net that PADS Router can use 
while routing from the pin to the escape via:
• Through pins—Connect to a through pin if the cost is lower than the 

cost to use a via.
• SMD pins—Connect to an SMD pin if the cost is lower than the cost 

to use a via. If this is disabled, PADS Router routes each SMD pad 
directly to a pin or via.

• Vias—Connect to a shared via. If this is disabled, PADS Router 
creates unique vias for each surface-mount pad.

• Trace—Connect to a shared trace, which creates a 
T-Junction.

Nets Specify the types of nets where fanouts can be created:
• Plane—Create fanouts for pins belonging to plane nets.
• Signal—Create fanouts for pins belonging to signal nets.
• Unused pins—Create fanouts for pins that do not belong to signal 

nets or plane nets.

Fanout length Specify whether or not to restrict fanout lengths:
• Unlimited—Specifies that you do not want to restrict fanout lengths.
• Maximum—Specifies the restriction to the fanout length if you clear 

the Unlimited check box.

Preview Shows the fanout layout based on your selections.

Delete button Removes non-default fanout rules at the current level of the rules 
hierarchy.
Restriction: You cannot delete the Default fanout rules.

Table 45-169. Fanout Rules Dialog Box (cont.)

Area Description
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Find Dialog Box

Find Dialog Box
Use Find to find and select single or multiple objects by reference designator, part type, line 
width, or other attributes. 

Find works two ways, depending on your selection mode:

• Select mode — Find ignores the Selection Filter settings and selects whatever you ask it 
to.

• Verb mode — Find only looks for items that are logical for verb mode.

Accessing

• Edit menu > Find

Figure 45-183. Find Dialog Box
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Table 45-170. Find Dialog Box Contents 

Name Description

Object Type list Specifies how you want to search. You can find by:
• reference designators
• nets
• line widths
• part types
• pin pairs
• via types
• decals
• net classes
• groups
• physical design reuses
• clusters
• unions
• pour areas
• isolated pours
• pad sizes
• thermal attributes (custom pad stack thermals)
• jumper vias
• keepouts
• attributes
• label fonts
• text fonts
• nets with bridges
• test point types

Action Specifies the action to perform on items you find.
• Select
• Highlight
• Unhighlight
• Rotate 90
• Flip Side
• Move Sequential

Exception: You cannot use Rotate 90, Flip Side, or Move 
Sequential on test points.
Tip: When you select objects with the Find dialog box, 
the shortcut menus change to the relevant commands for 
modifying the items.

Value Narrows the search by the value you type. You can use 
wildcards or expressions.
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Find Dialog Box

Related Topics

Finding Objects

Using the Find Dialog Box During Placement

Add to Selection Selects the items that you find. Each selected item appears 
in the Selected Items preview area.
Tip: When you select objects with the Find dialog box, 
the shortcut menus change to the commands relevant for 
modifying the items.

Selected Items Preview area Displays the selected items.

Find lists The content and title of these lists change depending on 
what you select from the Find By list. For example, if you 
are finding by reference designator, the first list displays 
reference designator prefixes. When you select a reference 
designator prefix to search by, for example D, the second 
list displays all reference designators with the D prefix. 
You can further limit the search by choosing a specific D 
reference designator prefix to search by, such as D2.

Abort Specifies that you want to cancel the find process if it is 
taking a long time.

Filter Opens the Selection Filter.

Table 45-170. Find Dialog Box Contents (cont.)

Name Description
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Find in Vault Dialog Box
Use the Find in Vault dialog box to search the vault. You can search for projects, archives, 
folders, or all three.

Tip: Click any item in the Find results list to select it in the vault view tree.

Searches
• Searches are not word-based; a search for the string “ic” will find Iceland, picnicking, 

and alphanumeric.

• Wild cards are not supported.

• Searches are not case-sensitive.

• A null string in a field returns items with any value.

• Items must match all fields to satisfy the search criteria.

• Both the Name and ID attributes of items are searched for the search string specified in 
the Name field.

Accessing

• Vault view > Find in Vault button
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Find in Vault Dialog Box

Figure 45-184. Find in Vault Dialog Box

Table 45-171. Find In Vault Dialog Box Contents

Name Description

Items Specifies the type of items to find—Projects, Archives, 
Folders, or All

Name Specifies to find items whose Name and/or ID contains the 
entered search string. 
A null string returns items with any name.
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Related Topics

Finding Projects or Archives in the Vault

Flood and Hatch Options Dialog Box
Use the Flood and Hatch Options dialog box to establish unique display settings for copper pour 
or split/mixed plane areas.

Accessing

Restriction: You must display the pour or plane area's outline before you assign unique display 
settings. For copper pour areas, select the area, use the modeless command PO. For split/mixed 
plane areas, use the modeless command SPO.

• Select edge of pour or plane area > right-click > Select Shape > right-click > Properties 
> Options button

User Select a user to find items whose User contains that user name.
If no user is selected, items with any user are returned.

Description Specifies to find items whose Description contains the entered 
search string.
A null string returns items with any description or none.

Created from ... to Specifies to find items by creation date/time, as follows:
• Created from—Finds items created after the specified 

date/time.
• to—Finds items created before the specified date/time.

If both are specified, finds items created between the two 
dates/times.

Find button Initiates the find operation.

Find results Lists the search results. Double-click an item to close the 
dialog box and select the item in the vault view tree.

Table 45-171. Find In Vault Dialog Box Contents

Name Description
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Flood and Hatch Options Dialog Box

Figure 45-185. Flood & Hatch Options Dialog Box

Table 45-172. Flood & Hatch Options Dialog Box contents 

Name Description

Options area Default check box—Specifies to use the default settings as 
found on the Grids and Drafting / Hatch and Flood pages of the 
Options dialog box. Clear this check box to access the hatch 
settings.
Hatch grid—Specifies the distance between hatch lines.
Smoothing radius—Specifies the resolution of arced corners. 
A high smoothing radius value produces smoother, rounder 
corners.
Hatch direction—Specifies the hatch line orientation.

Flood over vias Specifies to flood over any vias within the copper pour or 
plane area that are part of the same net.
Tips: 
• When this setting is changed and applied to the selected 

object, the changed setting becomes the default for all 
newly-created plane areas and copper pours. Existing 
objects (except the selected one) are not affected.

• When you flood over vias, a Thermal Relief Error report, 
therm.err, is generated and automatically appears in the 
default text editor. The report lists the vias that use 
different flood over settings than those established in the 
Thermals tab.

Ignore board clearance Specifies to ignore the board-to-copper clearance setting and 
have the copper pour flood outside the board area.
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Related Topics

Creating a Copper Pour Area

Creating a Plane Area

Flooding Over Vias in a Copper Pour or Plane Area

Font Replacement Dialog Box
Use the Font Replacement dialog box to manage how missing fonts are replaced in your design.

Accessing

When you open a design created with fonts that are not installed on your system, the Font 
Replacement dialog box opens automatically.

Tip: If the design uses fonts or character sets that are not installed on your system, empty boxes 
will appear where you expect to find text or symbols. Once the font replacement process 
completes, the symbols display properly.

Flood priority Specifies to add a flood priority to the selected object. An 
object with a lower priority number will be flooded before an 
object with a higher one. Copper pour or plane areas on 
different layers are processed independently.
See also: Setting Flooding Order of Overlapping Copper Pour 
and Plane Areas, Copper Pour and Plane Area Flood Priorities 
in the Concepts Guide
Requirements:
• Type a value from 0 to 250.
• If you create an embedded plane, the smaller inner plane 

must have a lower flood priority than the larger outer plane 
or the smaller plane area will be flooded over by the outer 
plane. 
See also: To Create an Embedded Plane

Table 45-172. Flood & Hatch Options Dialog Box contents (cont.)

Name Description
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Font Replacement Dialog Box

Figure 45-186. Font Replacement Dialog Box

Tips:

• You can select some fonts for automatic replacement, select others for manual 
replacement, and choose that other font replacements be skipped entirely.

• You can have a combination of stroke font and system fonts within the same design.

Table 45-173. Font Replacement Dialog Box Contents 

Name Description

Mode Specifies the mode to replace this font.
• Automatic—Specifies to replace the font 

automatically with the one selected by PADS Layout.
• Manual—Specifies to replace the font with one you 

select from the Replace with font list.
• Skip—Specifies to preserve the original font.

Missing font The name of the font in this design that is missing from 
your system.

Replace with font If you chose Manual, lists the fonts available for you to 
replace the missing font.
If you chose Automatic, lists the font PADS Layout chose 
to replace the missing font.
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• You must set up fonts for each text string and/or label you create in your design. Once 
you set up fonts for a text string or label, you can then use the Properties dialog to apply 
a font and font characteristics to all objects that you select for modification with the 
Properties dialog box.

Restrictions:

• If the design uses fonts or character sets that are not installed on your system, a font 
substitution process begins automatically when the file is loaded. During this process, 
you are asked to choose fonts to substitute for those that are missing from your system.

• System font text is supported in RS274X Gerber format when Fill mode is on. System 
font text is output to Gerber format as a set of filled polygons.

• System fonts are not supported in the RS-274D CAM output format. If you attempt to 
use this format with system fonts, the program displays a warning message. If you 
proceed, system fonts will not be output. Instead, you should use the 274X format with 
system fonts.

• Type 1 fonts are not supported.

Related Topics

Replacing Fonts

Finding Fonts

Forward Annotation Dialog Box
In DxDesigner Link, forward annotation sends data from a DxDesigner schematic to a PADS 
Layout design file and updates the PADS Layout design to match the schematic. 

Use the Forward Annotation dialog box to filter the schematic data used in forward annotation.

Accessing

• Tools menu > DxDesigner > Forward to PCB button
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From SPECCTRA Dialog Box

Figure 45-187. Forward Annotation Dialog Box

Related Topics

Forward Annotating from DxDesigner to PADS Layout

From SPECCTRA Dialog Box
Use the From SPECCTRA dialog box to translate design data modified by SPECCTRA back 
into a .pcb design file.

Table 45-174. Forward Annotation Dialog Box contents 

Name Description

Forward Annotation • Create PCB—Specifies that the PCB design in PADS 
Layout is new.

• Update PCB—Specifies that you want to update the 
existing PADS Layout design.

Data to pass to PCB area DxDesigner Link includes the selected data in an ASCII file 
(.asc) and uses it in the forward annotation operation. You can 
send:
• Parts, netlist, and attributes names and values
• Design rules
• Library parts information

Tip: To include design rules in the forward annotation 
operation, select the Design Rules option, even if you already 
selected Compare Design Rules on the Preferences tab.

Pause before Updating 
PCB Design

Specifies that you want to review the ECO file containing 
changes that the update will make to the PADS Layout design.
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Accessing

• Use Windows Explorer to navigate to your ...\SDD_HOME\Programs directory, and 
double-click pads2sp.exe > From SPECCTRA button

Figure 45-188. From SPECCTRA Dialog Box

Related Topics

Translating Design Data from SPECCTRA to PADS Layout

Table 45-175. From SPECCTRA Dialog Box contents 

Name Description

SPECCTRA Routes Specifies the routing information file that is returned by 
SPECCTRA after processing. Include the command to write 
this file after autorouting at the end of the .do file.
Tip: Click Browse to locate the file.

Session File Specifies the placement and routing information file. You do 
not need to supply this file name if you did not use any of the 
SPECCTRA placement capabilities.
Tip: Click Browse to locate the file.

Original PCB File Specifies the original (source) .pcb file.
Tip: Click Browse to locate the file.

New PCB File Specifies the file to be created from the SPECCTRA file.
Tip: Click Browse to locate the file.

Options button Opens the Options dialog box.
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Generate Drafting Shape Dialog Box

Generate Drafting Shape Dialog Box
You can use the outline of a terminal as the basis to create new drafting shapes.

Accessing

• Tools menu > PCB Decal Editor > Select terminal > Right-click and click Generate 
Drafting Shape

Figure 45-189. Generate Drafting Shape Dialog Box

Table 45-176. Generate Drafting Shape Dialog Box Contents 

Name Description

Type Lists the type of drafting shapes available to generate.

Layer Lists the layers available for placement of the shape.

Width sets the line width of the new shape.

Oversize/Undersize value Sets the size of the new shape:
• To create a new drafting shape larger than the terminal 

outline by the typed value, type a positive number.
• To create a new drafting shape equal in size to the 

terminal, type 0 (zero).
• To create a new drafting shape smaller than the 

terminal outline by the typed value, type a negative 
number.

Create Completes this new shape and keeps the dialog box open 
for the creation of new shapes.

Complete Completes this new shape and closes the dialog box.
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Related Topics

Generating Drafting Shapes from Terminals

Get Drafting Item from Library Dialog Box
Use the Get Drafting Item from Library dialog box to add a drafting item into your design from 
the library. You can also save a drafting item to a library. 

Accessing

• Drafting Toolbar button > From Library button

Figure 45-190. Get Drafting Item from Library Dialog Box

Table 45-177. Get Drafting Item from Library Dialog Box contents 

Name Description

Preview area Shows the selected drafting item.

Drafting Items Lists the drafting items in the selected library. The number of 
objects that appear depends on the filter settings.

Library list Specifies the library you want to use.

Items Narrows the search. You can use wildcards or expressions. An 
asterisk (*) displays all parts in the list.

Apply button Searches the library for the specified item.
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Get Part Type from Library Dialog Box

Related Topics

Adding Drafting Items from a Library

Get Part Type from Library Dialog Box
Use the Get Part Type from Library dialog box to Retrieve parts from a library when you add or 
update parts. 

The dialog box is slightly different depending on if you are adding or updating parts.

Accessing

• ECO Toolbar button > Add Component button

Figure 45-191. Get Part Type from Library Dialog Box

or

• ECO Toolbar button > Select a part > Change Component button
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Figure 45-192. Get Part Type from Library Dialog Box - Change Component

Related Topics

Adding a Component in ECO Mode

Table 45-178. Get Part Type from Library Dialog Box contents 

Name Description

Preview area Shows the selected part type.

Part Types Part search results based on the Filter Settings appear in this 
list where you can select the part you want to use. The viewer 
to the left of this window displays the decal of each part as you 
select them.

Add button Adds the selected party type to the design.
Restriction: Available for the Add Part command only.

Replace button Replaces the part type selected in the design with the part type 
selected in the Part Types list.
Restriction: Available for the Change Part command only. 

Update Part Type from 
Library

Updates the part type data for the selected parts based on the 
part types in the library. 
Restriction: Available for the Change Part command only. 

Library list Specifies the library you want to use.

Items Narrows the search. You can use wildcards or expressions. An 
asterisk (*) displays all parts in the list.

Apply button Searches the library for the specified item.
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Get PCB Decal From Library Dialog Box

Changing a Component in ECO Mode

Get PCB Decal From Library Dialog Box
Use the Get PCB Decal from Library dialog box to open the decal you want to edit.

Accessing

• Tools menu > PCB Decal Editor > Open button

Figure 45-193. Get PCB Decal from Library Dialog Box

Related Topics

Editing a Library Decal

Table 45-179. Get PCB Decal from Library Dialog Box Contents 

Name Description

Preview area Shows the item selected in the PCB Decals list.

PCB Decals list Lists the decals available to you in the selected library.

Library list Lists all libraries available to you.

Items Narrows down your PCB Decals list. 
Tip: You can use wildcards in this box.

Apply Executes the filter arguments.
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Grid/Width Dialog Box
Use the Grid/Width dialog box to quickly change grid and width settings.

Accessing

• In the PCB Decal Editor, click Setup menu, then click Grid and Width.

Figure 45-194. Grid/Width Dialog Box

Table 45-180. Grid/Width Dialog Box Contents

Name Description

Design Grid Sets the spacing of the design grid, which controls the 
general placement of parts. The design grid uses positions 
relative to the origin. Type X and Y values for the grid in 
current design units.

Via Grid Sets the spacing of the via grid which controls the 
placement of vias. Type X and Y values for the grid in 
current design units.
Restriction: This section is unavailable in the PCB Decal 
Editor.

Width Sets the current drafting width. 

Snap to Grid Snaps parts from grid point to grid point instead of freely 
and smoothly through the design space as you move or 
place the part. With this check box on, you cannot place a 
part off the current grid.

Radial Move Setup Opens the Radial Move Setup dialog box where you can 
set up the polar grid.
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Group Rules Dialog Box

Group Rules Dialog Box
Use the Group Rules dialog box to add and manage groups of pin pairs, and to define design 
rules that apply to them.

Accessing

• Setup menu > Design Rules > Group button

Figure 45-195. Group Rules Dialog Box

Table 45-181. Group Rules Dialog Box 

Name Description

Group name Specifies the name of the group.

Group list Lists all group names.

Add Adds the group name to the Group list.

Delete Removes the selected group from the Group list.

Rename Renames the group selected in the Group list with the text in 
the Group Name box.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.
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Related Topics

Creating Group Design Rules

Deleting a Design Rule Group

Adding Pin Pairs to an Existing Design Rule Group

Removing Pin Pairs from a Design Rule Group

Modifying Group Design Rules

Renaming a Design Rule Group

Resetting Group Rules to Default Rules

Displaying the Pin Pairs of a Design Rule Group

HiSpeed Opens the HiSpeed Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule 
button

The picture below each type of rule button identifies which 
rules hierarchy level is used for that rule type. The meaning of 
the picture corresponds to the button in the Hierarchy area of 
the Rules dialog box. For example, if you select a class in the 
Class list and a green polygon appears below the Clearance 
button, then the default values apply to the class.

Show groups with rules Specifies to show only groups that have rules.

Default Removes non-default rules from the selected classes, so that 
only default rules apply.

From Net Lists all available nets.

Connections Available 
list

Lists the connections available for this group.
Tip: Connections cannot exist in more than one group. The 
Available list displays only connections that have not been 
assigned to a group.

Connections Selected 
list

Lists the connections selected for this group.

Add >> Moves the connection from the Available list to the Selected 
list.

<< Remove Moves the connection from the Selected list to the Available 
list.

Table 45-181. Group Rules Dialog Box (cont.)

Name Description
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Group Rules Dialog Box
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HiSpeed Rules Dialog Box
Use the HiSpeed Rules dialog box to set up high-speed rules.

Requirement

The Electrodynamic Checking (EDC) licensed option is required to check high-speed rules.

Accessing

• Setup menu > Design Rules > choose a hierarchy level > High Speed button

Figure 45-196. HiSpeed Rules Dialog Box

Table 45-182. HiSpeed Rules Dialog Box 

Area Description

Parallelism • Parallelism—Specifies Length and Gap values for parallelism.
Tip: Parallelism rules specified in the Conditional Rule Setup dialog box 
override rules specified in this dialog box.

• Tandem—Specifies Length and Gap values for tandem.
Tip: Tandem rules specified in the Conditional Rule Setup dialog box 
override rules specified in this dialog box.

• Aggressor—Specifies that objects in this set act as aggressors.
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HiSpeed Rules Dialog Box

Shielding • Shield check box—Specifies to automatically route traces connected to a 
plane layer in order to shield selected nets from electromagnetic 
interference. 
Exception: Shielding rules do not apply when shielding with vias. 
Restrictions: 
• Options in the Shielding area are unavailable if the design has no plane 

layers.
• PADS Layout does not automatically route shielding nets and it does 

not check shielding rules.
• Gap—Specifies the clearance between the shielding and shielded nets.
• Use net list—Lists all nets associated with the plane layer you want to 

implement the shielding traces with.

Rules area

Length Specifies the minimum and maximum length allowed.

Stub length Specifies the maximum distance from the T-Junction to the end of the trace.

Delay (ns) Specifies the minimum and maximum delay allowed. The baseline delay 
calculations use the trace parameters, the board material values you set in 
the Layer Thickness Dialog Box, and require at least one adjacent plane. A 
maximum of two adjacent planes are used in calculations. If the plane layer 
is a split/mixed plane layer, you must have a plane shape on the layer. The 
location and outline of the shape and cutouts of the plane area are all ignored 
in the calculation.
Delay values can be viewed in the Pin Pair Properties and Net Properties 
dialog boxes.
Restrictions: 
• This rule is only verified when you run Tools > Verify Design after you 

set up a High Speed check to check Delay. It is not verified by online 
DRC.

Capacitance 
(pF)

Specifies the minimum and maximum capacitance allowed. The baseline 
capacitance calculations use the trace parameters, the board material values 
you set in the Layer Thickness Dialog Box, and require at least one adjacent 
plane. A maximum of two adjacent planes are used in calculations. If the 
plane layer is a split/mixed plane layer, you must have a plane shape on the 
layer. The location and outline of the shape and cutouts of the plane area are 
all ignored in the calculation.
Capacitance values can be viewed in the Net Properties dialog box.
Restrictions: 
• Capacitance can’t be set for Pin Pairs.
• This rule is only verified when you run Tools > Verify Design after you 

set up a High Speed check to check Capacitance. It is not verified by 
online DRC.

Table 45-182. HiSpeed Rules Dialog Box (cont.)

Area Description
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Tip: Parallelism and tandem rules specified in the Conditional Rule Setup dialog box override 
rules specified in this dialog box.

Related Topics

Design Rule Hierarchy

HiSpeed Rules Dialog Box, Associated Nets
Use the HiSpeed Rules dialog box to assign min/max length rules and create matched length 
groups for associated nets.

Requirement

The Electrodynamic Checking (EDC) licensed option is required to check high-speed rules.

Accessing

• Associated Net Rules dialog box > HiSpeed button

Impedance 
(Ohm)

Specifies the minimum and maximum impedance allowed. The baseline 
impedance calculations use the trace parameters, the board material values 
you set in the Layer Thickness Dialog Box, and require at least one adjacent 
plane. A maximum of two adjacent planes are used in calculations. If the 
plane layer is a split/mixed plane layer, you must have a plane shape on the 
layer. The location and outline of the shape and cutouts of the plane area are 
all ignored in the calculation.
Impedance values can be viewed in the Pin Pair Properties and Net 
Properties dialog boxes.
Restriction—This rule is only verified when you run Tools > Verify Design 
after you set up a High Speed check to check Impedance. It is not verified by 
online DRC.

Matching Some routers can automatically route traces with matched lengths. For 
example, traces for differential pairs have matched lengths in order to avoid 
signal timing skew between the signals.
• Match lengths check box—Specifies to automatically route traces with 

matched lengths.
• Tolerance—Specifies the maximum permissible difference between the 

shortest and longest lengths between traces in the matched-length group.
Restriction: PADS Layout does not check length-matching rules.

Delete 
button

Removes non-default hispeed rules at the current level of the rules 
hierarchy. 
Restriction: You cannot delete the Default High Speed rules.

Table 45-182. HiSpeed Rules Dialog Box (cont.)

Area Description
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HYP Export Dialog Box

Figure 45-197. HiSpeed Rules Dialog Box, Associated Nets

Related Topics

Design Rule Hierarchy

HYP Export Dialog Box
Use the HYP Export dialog box to export the design in the form of a HYP file. For information 
about the format of the HYP file and creating a “BoardSim-friendly” design, see the HyperLynx 
online Help. PADS Layout passes the Value, Tolerance, Voltage, HyperLynx, and 

Table 45-183. HiSpeed Rules Dialog Box, Associated Nets 

Name Description

Length Set the minimum and maximum 
length for the associated nets you 
selected in the Associated Net Rules 
Dialog Box

Match lengths Select this checkbox to make the 
associated nets you selected in the 
Associated Net Rules Dialog Box 
members of a matched length group.
Clear the checkbox to remove the 
selected associated nets from an 
existing matched length group.

Tolerance Set the tolerance value for length-
matching.
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PowerGround attributes to the HYP file. BoardSim uses these attributes to obtain values for 
resistors and capacitors, and to transfer information about fixed voltage nets.

You would use this export functionality only if you don’t have HyperLynx BoardSim installed, 
or if you need to send the file to another computer. If you have it installed, you could use the 
more direct method - use the Tools menu > Analysis > Signal/Power Integrity to export the file 
and open it in HyperLynx BoardSim. See BoardSim Dialog Box.

Restriction

Only HyperLynx v8.0 or newer can open the file that is exported by this dialog box. The .hyp 
file that is created is a v2.34 format file.

Accessing

• File menu > Export > select HYP Files > Save

Figure 45-198. HYP Export Dialog Box

Table 45-184. HYP Export Dialog Box Contents 

Name Description

Output area

Attributes for Nets and Net 
Classes

Specifies to export attributes for nets and net classes.
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IDF Export Dialog Box

Related Topics

BoardSim Dialog Box

Creating HyperLynx BoardSim - HYP Files

IDF Export Dialog Box
U the IDF Export dialog box to exchange design data between PADS Layout and a mechanical 
design system. You can export IDF files to export board outlines, keepouts, components, and 
holes to a mechanical design system.

Attributes for Power and 
Ground nets

Specifies to export attributes for power and ground nets.

.REF IC Automapping file Specifies to create a HyperLynx .ref file, which maps IC 
reference designators in the design to the BoardSim 
models that represent the ICs. BoardSim uses the 
mappings to automatically load IC models when you 
select a net for simulation.
Restriction: This check box is only available if a 
component has the HyperLynx.Model attribute with a 
value.

Unrouted Specifies to export unrouted nets.

Plane Areas and Copper 
Pours

Specifies to export plane areas and copper pours.
• Export hatch outlines for pours and plane areas—

Specifies to export hatch outlines for pours and plane 
areas.
Requirement: This setting creates extra constructs in 
the .hyp file and is required for power-integrity 
analysis.

• Export pour and plane area outlines—Specifies to 
export pour and plane area outlines.

Unroutes Options area
Tip: Available only if Unrouted is selected in the Output area.

Assumed Layer Specifies the layer on which to implement the unrouted 
nets.

Percent Excess over 
Manhattan Length

Specifies the value to estimate the routing lengths.
Tip: This value adds a percentage of the Manhattan length 
to the route length, to account for indirect routing paths. 
Net lengths are based on the Manhattan distance between 
pin pairs, which is Delta X plus Delta Y.

Table 45-184. HYP Export Dialog Box Contents (cont.)

Name Description
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Tip: Set any IDF-specific part height information, drilled hole information, or part outline 
information for a more accurate IDF export.

Accessing

• File menu > Export > Select IDF File > Save

Figure 45-199. IDF Export Dialog Box

Table 45-185. IDF Export Dialog Box Contents 

Name Description

IDF File Names The names of the files you are exporting. The .emn (board 
and placement) and .emp (part library) files are created. 

Shape Layer Specifies the layer containing the outline information for 
the decals in your design that you want to send to the 
mechanical design system.

Format Specifies the IDF version to use.

Pro/ENGINEER Wildfire 
support

Select this check box to convert characters to underscores 
(_) when they are illegal characters to Pro/ENGINEER 
Wildfire.
Clear this check box to allow all characters to export in the 
IDF files.
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IDF Export Dialog Box

Select Export Items area Use these check boxes to select the items you want to 
export to the layer in the Shape Layer list. 
Tip: Click All Items to select everything in this area.
• Board Outline—Board outline, cutouts, and holes.
• Board Drills—Drilled holes associated with mounting 

holes, including drill diameter and plated status.
• Parts-Top—Components mounted on the top of the 

board, including their locations.
• Parts-Bottom—Components mounted on the bottom 

of the board, including their locations.
• Part Drills—Drilled holes associated with a part pin, 

including drill diameter and plated status.
Tip: This option is unavailable for IDF 2.0 or if the 
Parts-Top and Parts-Bottom check boxes are cleared.

• Via Drills—Drilled holes associated with a via, 
including drill diameter and plated status.
Tip: This option is unavailable for IDF 2.0 and during 
import.

• Place Keepouts—Placement keepouts, including 
keepouts with height restrictions, and their locations.
IDF files can contain the following information:
• Board-level placement keepouts
• Top and bottom component height restrictions 

defined for the whole board in the Options Dialog 
Box, Drafting / Text and Lines Page.

• Routing Keepouts—Trace keepouts and their 
locations.
Only trace keepouts on top, bottom, both, inner (IDF 
3.0 only), and All layers are supported. Trace keepouts 
on a single inner layer are not supported.
Restriction: This option is unavailable for IDF 2.0.

• Via Keepouts—Via keepouts and their locations.
IDF supports only via keepouts that apply to all layers. 
Imported via keepouts are always set on all layers.
Restriction: This option is unavailable for IDF 2.0.

Top/Bottom Specifies the minimum height of components you want to 
export.
Tip: Components less than these heights are not exported. 
If a part is not exported because of a minimum height 
value, a message is written to the status log file.

Design Units Specifies the design units for this file.

Table 45-185. IDF Export Dialog Box Contents (cont.)

Name Description
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Related Topics

Exporting IDF Files

IDF Import Dialog Box
Use the IDF Import dialog box to import board outlines, keepouts, components, and holes from 
a mechanical design system. PADS Layout cannot import the information in the .emp library 
file.

Accessing

• File menu > Import > Select IDF File > Open

Figure 45-200. IDF Import Dialog Box

Table 45-186. IDF Import Dialog Box Contents 

Name Description

IDF File Name The name of the file you are importing.
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Increase Maximum Layer Number Dialog Box

Related Topics

Importing IDF Files

Increase Maximum Layer Number Dialog Box
Use the Increase Maximum Layer Number dialog box to increase the number of available 
electrical and documentation layers from 30 to 250.

Select Import Items area Use these check boxes to select the items you want to 
import.
Tip: Click All Items to select everything in this area.
• Board Outline—Board outline, cutouts, and holes.
• Board Drills—Drilled holes associated with mounting 

holes, including drill diameter and plated status.
• Parts-Top—Components mounted on the top of the 

board, including their locations.
• Parts-Bottom—Components mounted on the bottom 

of the board, including their locations.
• Part Drills—Drilled holes associated with a part pin, 

including drill diameter and plated status.
Tip: This option is unavailable for IDF 2.0 or if the 
Parts-Top and Parts-Bottom check boxes are cleared.

• Via Drills—Drilled holes associated with a via, 
including drill diameter and plated status.
Tip: This option is unavailable for IDF 2.0 and during 
import.

• Place Keepouts—Placement keepouts, including 
keepouts with height restrictions, and their locations.
IDF files can contain the following information:
• Board-level placement keepouts
• Top and bottom component height restrictions 

defined for the whole board in the Options Dialog 
Box, Drafting / Text and Lines Page

• Routing Keepouts—Trace keepouts and their 
locations.
Only trace keepouts on top, bottom, both, inner (IDF 
3.0 only), and All layers are supported. Trace keepouts 
on a single inner layer are not supported.
Restriction: This option is unavailable for IDF 2.0.

• Via Keepouts—Via keepouts and their locations.
IDF supports only via keepouts that apply to all layers. 
Imported via keepouts are always set on all layers.
Restriction: This option is unavailable for IDF 2.0.

Table 45-186. IDF Import Dialog Box Contents (cont.)

Name Description
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Accessing

• Setup menu > Layer Definition > Max Layers button

Figure 45-201. Increase Maximum Layer Number Dialog Box

Related Topics

Increasing the Maximum Number of Available Layers

Layer Modes in the Concepts Guide

Installed Options Dialog Box, License File Tab
If you are using node-locked licensing, you can view the contents of a license file.  If you are 
using floating licenses, you cannot view the actual license file, but you can view the status of the 
features associated with a server license.

Accessing

• Help menu > Installed Options > License File tab

Table 45-187. Increase Maximum Layer Number Dialog Box Contents 

Name Description

Maximum number of 
layers will be increased 
to 250

The default layer setup contains a total of 30 layers. There are 
20 electrical and 10 non-electrical (documentation) layers.
You can increase this layer setup to 250 layers. The increase 
would allow up to 64 electrical layers and 186 non-electrical 
layers.

Warning: Layer 
numbers for all 
nonelectrical layers will 
be increased by 100

In the default layer setup, the documentation layers start at 
level 21 - the Solder Mask Top layer. In the increased layer 
setup, this layer becomes layer 121.
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Installed Options Dialog Box, License File Tab

Figure 45-202. Installed Options Dialog Box, License File tab

Table 45-188. License File tab contents 

Name Description

License File column Displays the location of the license file(s) found on your 
computer.

Source column Displays the source of the license.

View button Click to display the contents of the license file in the License 
Information box.
Restriction: Node-locked only.

Status button Click to display the status of this license in the License 
Information box.
Restriction: Floating License only.

License Information box Displays the contents (Node-locked) or the status (Floating) of 
the selected license.

Suite Configuration 
button

Opens the PADS Suite Configuration dialog box.
Restriction: Available only with floating/server-based 
licenses, a mix of different PADS Suites, or a mix of 
unbundled licenses and suites.
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Related Topics

Viewing a License File or License Status

Installed Options Dialog Box, Options Tab
Use the Options tab to configure your licensing information. You generally need to check 
individual licensing options in or out if you are using floating licenses. The configuration is 
stored in the powerpcb.ini file. 

Tip: For node-locked licensing, all of the licensed options are available and checked out. For 
floating licensing, the first person logged in controls the available options.

Accessing

• Help menu > Installed Options > Options tab

Figure 45-203. Installed Options Dialog Box, Options tab
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IPC Export Dialog Box

Related Topics

Checking Licensing Options In and Out

IPC Export Dialog Box
Use this dialog box to choose between IPC-D-356 netlist formats.

Table 45-189. Options tab contents 

Name Description

Check Out All Available 
Options

Specifies to check all available licensing options in and out. 
Click to clear if you want to select individual options 
associated with individual PADS Layout modules and 
optionally select a database limit.

Option column Lists the available options. A check mark indicates you want to 
use this option.

License Consumed 
column

Displays the licensing feature associated with the option listed.

Status column Displays whether the option is available to you.

Modules area Lists the predefined set of options associated with one or more 
PADS Layout modules. 
Tip: If more than one module sets a particular option, turning 
off one of the modules does not turn off that shared option. The 
option is only turned off when all of the modules that use it are 
turned off. Also, some individual options control other options. 
For example, clearing the Advanced Packaging Toolkit option 
clears BGA options.

Database Limit Specifies the database limit that is appropriate for your 
licensing scheme in the Database Limit area. The database 
limit is associated with the number of connections (pin pairs) 
you can have: 1500 for the Standard Database and 6250 for the 
Expanded Database. Select Standard, Expanded, or Unlimited 
for the database limit and verify the availability of the selected 
limit, per your license.

Suite Configuration 
button

Opens the PADS Suite Configuration dialog box.
Restriction: Available only with floating/server-based 
licenses, a mix of different PADS Suites, or a mix of 
unbundled licenses and suites.



JEDEC Array Pinning Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1225

Accessing

• File menu > Export > Select IPC356 Files > Save

Figure 45-204. IPC Export Dialog Box

Related Topic

The IPC-D-356 Netlist

Exporting an IPC-D-356 Netlist

JEDEC Array Pinning Dialog Box
Use the JEDEC Array Pinning dialog box to assign an alphanumeric string to each pin in an 
array following the JEDEC standard. 

Pin rows are lettered from top to bottom starting with A. The letters I, O, Q, S, X, and Z are not 
used. 

Pin columns are numbered starting with 1. For component type, column numbering is left to 
right and for substrate type, right to left. For arrays with more than 20 rows, row 21 is 
designated AA and subsequent rows are designated AB, AC, and so on. 

Accessing

• Tools menu > PCB Decal Editor > Tools menu > Assign JEDEC Array Pinning

Table 45-190. IPC Export Dialog Box Contents

Name Description

IPC-D-356 Select this option to create a bare board test-information netlist in 
the basic 356 format.

IPC-D-356A Select this option to create a bare board test-information netlist in 
the more advanced 356 revision A format.
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Jumper Name Properties Dialog Box

Figure 45-205. JEDEC Array Pinning Dialog Box

Related Topics

To Assign JEDEC Pinning

Jumper Name Properties Dialog Box
Use the Jumper Name Properties dialog box to modify the jumper name and its attributes.

Accessing

• Select a jumper name > Right-click > Properties

Or

• Select a jumper > Right-click > Properties > Label button

Table 45-191. JEDEC Array Pinning Dialog Box Contents 

Name Description

Specify Decal Type Specifies whether the decal is a component or substrate 
type.

Preview area Displays the alphanumeric assignment orientation for 
Component or Substrate decal type.
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Figure 45-206. Jumper Name Properties Dialog Box

Table 45-192. Jumper Name Properties Dialog Box contents 

Name Description

Attribute The attributes available to you. If you are creating labels for 
jumpers, Reference Designator is the only available attribute.
Tip: Hidden attributes do not appear in the Attribute list unless 
the attribute was selected for the label before it was set as a 
hidden attribute.
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Jumper Name Properties Dialog Box

Value for The value of the selected attribute. 
Tips:
• Unavailable if you selected Reference Designator or Part 

Type from the Attribute list, if the attribute is read-only, or 
if you open the Properties dialog box for labels of different 
attribute types. However, if the labels you select belong to 
attributes of the same type, you can edit this box.

• If the attributes have different values, the box is blank. You 
can type a new value in the box to apply it to all of the 
selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-registered 
and PADS Layout is not in ECO mode. 

Show Controls the visibility of the label. 
• None—Turns visibility off.
• Value— Displays only the label value.
• Name and Value—Displays the name and value.
• Full Name and Value—When labeling a  structured 

attribute, displays the full structured name and value.
Tip: Labels are invisible regardless of this setting unless you 
use the Display Colors Setup dialog box to change the color of 
labels to a color different from that of the background.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, or 

any combination of styles: B for bold, I for italic, or U for 
underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the 
component or the jumper. If you clear this check box, the label 
is placed at the X and Y location relative to the design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Table 45-192. Jumper Name Properties Dialog Box contents (cont.)

Name Description
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Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for system 
fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom 
side of the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to 
ensure proper positioning between objects when text, attribute 
values, size, or width change.
Tips: 
• For vertical justification, click Left, Center, or Right. For 

horizontal justification, choose Up, Center, or Down. 
• Optionally, set justification by selecting the text, then right-

clicking and clicking Justify Horizontally, and then 
clicking Left, Center, or Right; and by right-clicking and 
clicking Justify Vertically, and then clicking Up, Center, 
or Down.

Right reading Controls whether labels are readable (from left to right, or 
from bottom to top if the label is rotated). Click the None, 
Orthogonal, or Angled button to indicate the direction of 
reading you want.

Jumper button Opens the Jumper Properties dialog box where you can modify 
the jumper.

Table 45-192. Jumper Name Properties Dialog Box contents (cont.)

Name Description
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Jumper Pin Properties Dialog Box

Related Topics

Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Modifying Jumper Properties

Using Jumpers

Jumper Pin Properties Dialog Box

Jumper Properties Dialog Box

Jumper Pin Properties Dialog Box
Use the Jumper Pin Properties dialog box to display the net to which the jumper pin belongs, the 
reference designator, pin number, connection to which the jumper pin is attached, and the 
coordinates of the selected jumper pin. 

Accessing

• Select a jumper pin > Right-click > Properties

Figure 45-207. Jumper Pin Properties Dialog Box
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Table 45-193. Jumper Pin Properties Dialog Box contents 

Name Description

Signal The designation of the net to which the jumper belongs.

Reference Name The reference designator of the jumper.

Pin Number The number of the pin in the jumper. Pin one is the first pin 
you entered in the jumper.

X/Y The X and Y location of the selected pin. Type in these fields 
to change the pin location.

Connections The connection to which the jumper is attached.

Plane Thermal Determines whether the pin or via is eligible to receive a 
thermal. The status of a thermal is set individually by pin and 
via, and the thermal indicators will appear on plane layers 
only. Click to clear this check box if you do not want the via or 
pin to connect to any plane.
Once a pin or via is eligible, it is not automatically assigned a 
thermal attribute.

Test Point Makes the via or pin a test point. 
See also: Performing a Test Point Audit
This is a three-state check box that depends on the state of the 
selected objects. If all of the selected vias or pins are a test 
point, then it is on. If none of the selected vias or pins are a test 
point, then it is off. If some of the selected vias or pins are a 
test point and some are not, then it is undefined. 
You can make all selected vias or pins test points by turning 
Test Point on and choosing Apply. You can remove the test 
point from all selected vias or pins by turning Test Point off 
and choosing Apply. When you click Apply the pad stack is 
automatically checked to see if the via or pin can be a test 
point; for example, you cannot make buried vias test points 
because a probe cannot access a buried via.
Tip: When the via or pin is flagged as a test point, and Show 
Test Points is checked on the Routing / General page of the 
Options dialog box, an arrow is drawn on it in the design:



PADS Layout User’s Guide and Reference Manual, PADS 9.41232

Jumper Properties Dialog Box

Related Topics

Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Modifying Jumper Properties

Using Jumpers

Jumper Name Properties Dialog Box

Jumper Properties Dialog Box

Connecting a Net with a Plane

Setting Pins and Vias as Thermals

Jumper Properties Dialog Box
Use the Jumper Properties dialog box to modify jumper location, label, and size. 

Top Access Attempts to probe the test point from the top and bottom in 
DFT Audit. The default is bottom; so with Top Access off, 
DFT Audit automatically tries to probe the test point from the 
bottom. 
See also: Performing a Test Point Audit
When you click Apply, the pad stack is automatically checked 
to see if top access is valid; for example, you must assign Top 
Access to partial vias with only top access if you want to use 
the vias as test points.
You can only set the Top Access option if the via or pin is a 
test point (Test Point is on).

Pad Stack button Opens the jumper pin in the Jumper Parameters Properties 
Dialog Box. You can change the pad stacks for individual pins 
in the jumpers. 
See also: Editing a Pad Stack in the PCB Decal Editor

Jumpers button Opens the Jumper Properties dialog box where you can edit the 
settings for the entire jumper.

Attributes button Opens the Object Attributes dialog box and displays attribute 
information for the selected objects. You can view and modify 
nail diameter and nail number pin attributes for component 
pins, vias, and jumper pins, including test point attributes.

Table 45-193. Jumper Pin Properties Dialog Box contents (cont.)

Name Description
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Accessing

• Select a Jumper > Right-click > Properties

Figure 45-208. Jumper Properties Dialog Box

Table 45-194. Jumper Properties Dialog Box contents 

Name Description

Reference Name The reference designator of the jumper.

Signal The designation of the net to which the jumper belongs.

X1/Y1 boxes The X and Y location of pin one. Type in these fields to change 
the location.

Rotation The jumper rotation. Type in this field to change the rotation.

Length The jumper length. Type in this field to change the length. The 
value must be within the minimum and maximum length 
values.

X2/Y2 The X and Y location of pin two. Type in these fields to 
change the location.

Minimum Length Specifies the minimum length of the jumper.

Maximum Length Specifies the maximum length of the jumper.

Increment Specifies the increment at which you can stretch the jumper 
between the minimum and maximum lengths.
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Jumper Properties Dialog Box

Related Topics

Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Modifying Jumper Properties

Using Jumpers

Jumper Name Properties Dialog Box

Jumper Pin Properties Dialog Box

Display Silk Enables the display of a silkscreen outline for the jumper.
Tips: 
• For CAM output, you must enable Component Outlines for 

the layer on which the jumper resides before jumper 
outlines will plot.

• The outline for jumpers is set at 10 mils; you cannot 
modify this setting.

Label Lists existing labels for reference designator, part type, and 
attributes. To edit an existing label, click a label from the list 
and click the button in this tab. A label is selected instead of 
the component, and the corresponding Labels Properties dialog 
box appears where you can modify the label.
To create a new label, click <new> from the list and click the 
button in this tab. The Add New Part Label dialog box appears 
where you can set up the new label.
Tip: When modifying the Properties of a jumper name, 
Reference Designator is the only available label.

Opens the appropriate Label Properties dialog box if an 
existing label is selected in the Label list.
Tip: When the current color for labels is set to the background 
color, this option is unavailable. To activate Label, assign a 
non-background color to labels in the Display Colors Setup 
dialog box.
Opens the Add New Part Label dialog box if <new> is selected 
in the Label list.

Pad Stack button Opens the jumper pin in the Jumper Parameters Properties 
Dialog Box. You can change the pad stacks for individual pins 
in the jumpers. 
See also: Editing a Pad Stack in the PCB Decal Editor

Table 45-194. Jumper Properties Dialog Box contents (cont.)

Name Description
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Jumpers Dialog Box
Use the Jumpers dialog box to set up and modify jumpers and jumper pad stacks. You can 
create and modify SMD jumpers (single layer jumpers) on the top or bottom mounting layer. 

Accessing

• Setup Menu > Jumpers (Jumpers Dialog Box)

• Select a Jumper > right-click > Properties > Pad Stack button (Jumper Parameters 
Properties Dialog Box)

The Jumpers dialog box controls change depending on what you have selected for the Pad Style. 
The three major differences are:

• Figure 45-209: Jumpers Dialog Box - Pad

• Figure 45-210: Jumpers Dialog Box - Thermal

• Figure 45-211: Jumpers Dialog Box - Antipad

Figure 45-209. Jumpers Dialog Box - Pad
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Jumpers Dialog Box

Figure 45-210. Jumpers Dialog Box - Thermal



Jumpers Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1237

Figure 45-211. Jumpers Dialog Box - Antipad

Table 45-195. Jumpers Dialog Box Contents 

Name Description

Apply to Default—Specifies that you are setting up the default 
jumper.
Design—Specifies that you are setting up the jumper for 
this specific design.

Reference Name Lists the available reference names.

Shape, Size, and Layer Lists the layers on which you can make jumper pad stack 
changes.
Exceptions: When modifying Design jumpers, you can 
add individual layers of the design to the list for 
customizing the design jumper. Use the Add or Delete 
button to maintain the Shape/Size/Layer list.

Add Opens the Add Layer dialog box.

Delete Removes the selected shape

Pin list Lists the pins available to you.
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Jumpers Dialog Box

Add Pin Opens the Add Pin dialog box where you can add an 
existing pin to the Pin list.

Delete Pin Deletes the selected pin from the Pin list. 

Min. Length Specifies the minimum length of the jumper.

Max Length Specifies the maximum length of the jumper.

Increment Specifies the increment at which you can stretch the 
jumper between the minimum and maximum lengths.

Use Global Defaults Sets thermal and antipad shapes to those specified in the 
Thermals tab in the Options dialog box.
Restriction: This option is available when the Pad Style 
list is set to Thermal or Antipad. 
See also: Design Rule Versus Pad Stack - Thermals and 
Antipads

Table 45-195. Jumpers Dialog Box Contents (cont.)

Name Description
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Pad Style Specifies the style of pad: normal pad, thermal pad, or 
antipad.
Thermal and Antipad display configuration controls the 
size and shape of thermals and antipads used on 
split/mixed layers and CAM negative planes (for RS-
274X output). 
See also: Design Rule Versus Pad Stack - Thermals and 
Antipads
Tips:
• Beginning with PADS 9.2, the size, shape and 

orientation of thermals for slotted pads are no longer 
derived from the length, drill size and orientation of 
the slotted hole, but are inherited from the normal pad.

• Set the Inner Diam and Outer Diam values to be the 
same for a solid connection to the plane (flood over). 
The current pad diameter is used as the inner diameter 
with the outer diameter set at the default same-net pad 
to corner rule. For antipads, diameters are initially set 
to follow the current default pad to copper design rule. 
If you select Use Design Rules for Thermals and 
Antipads in the Split/Mixed Plane page of the Options 
dialog box, the outer diameter is ignored and the 
clearance rule is used instead, except when the outer 
diameter is less than the inner diameter. Inner and 
outer diameter options always, however, control flood 
over.

The length of an antipad having a non-zero drill size 
equals the slot length minus the drill size, plus the width.
Tip: You cannot create antipads on outer layers. When 
you select an outer layer in the Size, Shape, Layer list, 
Antipad is unavailable.

Shape buttons Assigns a pad shape to the layer selected in the Size, 
Shape, Layers list. You can assign via pads as round, 
square, annular, oval or rectangular, odd.
• Annular lets you specify an inner pad diameter, 

bringing the inner diameter of the pad inside the drill 
outline. A pilot dimple at the center of the copper pad 
appears as an aid to hand fabrication of some 
prototypes.

• Odd is useful for drawn items such as moiré pads or 
registration marks. It is a circular outline only, and is 
usually used for marking areas for airgap checking. 
This setting should not be confused with trying to 
create a custom shaped (odd shaped) pad. See Creating 
a Custom Pad Shape for more information.

Table 45-195. Jumpers Dialog Box Contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41240

Jumpers Dialog Box

Pad size relative to drill size Displays inner and outer pad sizes relative to the drill size.

Flood over Specifies that the pad requires no thermal relief and 
should be flooded over, irrespective of any default 
flooding options for a normal pad of this shape.
Restriction: Available only when Pad style is Thermal 
and a pad shape button is selected.

Pad Parameters area The options for sizing the pad shape vary according to the 
shape you choose.
Round—Diameter (if hole is not slotted), Width (if hole is 
slotted). If the pad style is thermal: Inner Diam, Outer 
Diam, Spokes, Spoke Angle, Spoke Width.
Square—Size, Width (if hole is slotted), Corner type and 
Radius. If the pad style is thermal: Inner Size, Outer Size, 
Spokes, Spoke Angle, Spoke Width.
Annular—Diameter and Inner Diameter 
Odd—Diameter 

Figure 45-212. Radius Examples

Drill Size Specifies the drill size if the jumper is a through hole 
jumper. 
Tip: Type a drill size of zero if you want a surface mount 
jumper with round pads.

Display Silk Specifies to display the silkscreen outline for the jumper.
Tips:
• For CAM output, you must enable Component 

Outlines for the layer on which the jumper resides 
before jumper outlines will plot.

• The outline for jumpers is set at 10 mils; you cannot 
modify this setting.

Pad Preview Shows pad shape and size for the current options.

Negative Changes the preview area to a negative view.
Restriction: Thermal Pad Style only.

Table 45-195. Jumpers Dialog Box Contents (cont.)

Name Description
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Related Topics

Setting Up Jumpers
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Jumpers Dialog Box
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Latium Checking Setup Dialog Box
Use the Latium Checking Setup dialog box to set the rules to check using PADS Router.

Accessing

• Tools menu > Verify Design > Latium Design Verification check > Setup button

Figure 45-213. Latium Checking Setup Dialog Box

Table 45-196. Latium Checking Setup Dialog Box contents 

Name Description

Net to All Checks clearance rules on each net or hierarchical level against 
any other obstacle type. 

Board Outline Checks clearance rules for the board outline and board cut 
outs.

Off Board Text Checks for off-board text and to flag all instances of off-board 
text as clearance errors.

Keepout Checks for keepout restriction violations.

Same Net Checks clearances between objects along the same net, as 
specified in the Clearance Rules dialog box.

Drill to Drill Checks clearances between all drill holes. Pad stack drill size 
plus the drill oversize value calculate the diameter for plated 
holes.
Tip: Drill to drill errors are reported for only one layer in a 
drill pair.
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Layer Association Dialog Box

Related Topics

Setting Up Latium Checking

Layer Association Dialog Box
Use the Layer Association dialog box to specify the layer to use for the CAM Document from 
among all the layers available for the document type that you choose.

Accessing

• Add/Edit CAM Document dialog box > select a document type from the Document 
Type list (not Custom)

Trace Width Checks traces in excess of minimum and maximum widths, 
specified in the Clearance Rules dialog box.

Placement Outline • In default layer mode, check outline against outline on 
layer 20, not on electrical layers. 

• In increased layer mode, check outline against outline on 
layer 120.

Tip: You can create outlines on layer 20 (or 120) that do not 
exactly match the actual component outline. By setting a larger 
outline on this layer, you can leave an area near a component 
open for other purposes. This check ensures this area is left 
open.

Via at SMD Checks for via at SMD restriction violations.

Differential Pairs Checks for differential pair restriction violations.

Trace Length Checks for length restriction violations.

Test Point Checks test points on the design. Test Points checks for probe 
clearances, minimum via/pad sizes for probing, SMD pin 
probing, test points on component pin on the component side, 
test point count per net settings and nail diameter settings, and 
compares the settings against the setting in the DFT Audit 
program. 

Table 45-196. Latium Checking Setup Dialog Box contents (cont.)

Name Description
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Figure 45-214. Layer Association Dialog Box

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Layer Thickness Dialog Box
Use the Layer Thickness dialog box to define electrical layer and dielectric material layer 
thickness and dielectric constant information. When you verify your design, the electrodynamic 
check uses this information.

Traces on high-speed printed circuit boards can act like transmission lines that “broadcast” 
interference to adjacent conductors. Using the high-speed rules module, you can use Rules to set 
clearances on a net class, net, or pin to pin connection basis; then use high-speed checking to 
report on properties such as impedance, delay, track length, daisy chaining, and parallel routing. 
These issues cause interference and create costly problems in prototyping. You can run checks 
against the entire board or against specific nets.

Requirements

• Set these definitions before you run an electrodynamic check.

• You must have specified your plane layers in the Layers Setup dialog box before you 
run an electrodynamic check. For a two-layer board, temporarily identify one of the 
layers as a plane layer.

Accessing

• Setup menu > Layer Definition > Thickness button

Table 45-197. Layer Association Dialog Box Contents

Name Description

Layer Select the layer to use for the CAM Document Type you 
have chosen to create. 
Restriction: This list displays only the layers that are 
available for the type of CAM document you are creating.
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Layer Thickness Dialog Box

Figure 45-215. Layer Thickness Dialog Box

Related Topics

Setting Layer Thickness

Table 45-198. Layer Thickness Dialog Box Contents 

Name Description

Name The name of the layer.

Type Specifies the type of layer. The only layers available for 
edit are dielectric. You have the choice of Substrate or 
Prepeg in this list.

Thickness Specifies the thickness of the layer.
Tip: If no coating is required, set thickness to zero.

Dielectric Specifies the dielectric constant value.

Edit Makes the selected cell available for editing.
Exception: Cells that are grayed out are unavailable for 
editing.

Weight (oz) Specifies to view and edit copper thicknesses by ounces 
per square foot.

Design (") Specifies to view and edit copper thicknesses in the same 
unit of measure as the current database.

Board Thickness The total value of material and layer thicknesses in the 
current design units.
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Layers Setup Dialog Box
Use the Layers Setup dialog box to define each layer.

Accessing

• Setup menu > Layer Definition

Figure 45-216. Layers Setup Dialog Box
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Layers Setup Dialog Box

Table 45-199. Layers Setup Dialog Box Contents 

Name Description

Layers list • Level column—Displays the layer number. Layer one 
and the last electrical layer are used for components 
and routing and are automatically assigned as 
component layers for the top and bottom of the board. 
When you add additional electrical layers the last 
electrical layer becomes the new bottom layer.
See also: Modifying the Number of Electrical PCB 
Layers

Layers in the list below the last electrical layer are 
nonelectrical or documentation layers. Apply text or 
drafting lines for specific purposes like assembly 
drawings or solder or paste mask output to these 
layers.

• Type column—Identifies the layer type:
• CM—Component and No Plane
• RT—Routing and No Plane
• PL—Routing and CAM Plane
• CP—Component and CAM Plane
• CX—Component and Split/Mixed Plane
• RX—Routing and Split/Mixed Plane

• Direction column—Identifies the specified routing 
direction, Horizontal (H), Vertical (V), Any (A), 45 
(/), or -45 (\).

• Name column—Specifies the name of the selected 
layer.

Name The name for the layer which defines its function. You can 
assign a unique name to each layer to identify it. This 
name appears in the Name column of the Layers list and in 
the Layer list in the standard toolbar.



Layers Setup Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1249

Electrical Layer Type area The Component and Routing options are available only 
when you’ve selected a top or bottom layer. If you want to 
place components on the selected outer layer, you must 
select Component. 
• Component—Sets the layer as a placement and 

routing layer. When a top or bottom layer is set as a 
component layer, you can use the Associations button 
to “map” (called associating) which documentation 
layers go with the selected layer. 

• Routing—Sets the layer as a routing layer. If you want 
to prevent the placement of components on an outer 
layer, select Routing; you cannot place components on 
this layer.

Restriction: You can set only the top and bottom layers as 
component layers, indicating they will be used for 
placement; you cannot set inner layers as Component 
layers. 
All electrical layers can be set to routing, plane, or 
split/mixed plane layers. 

Table 45-199. Layers Setup Dialog Box Contents (cont.)

Name Description
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Layers Setup Dialog Box

Plane Type area Assigns a layer type to the layer selected in the Layers list. 
When a layer is selected as a plane or split/mixed plane 
layer, use the Assign Nets button to assign which nets to 
connect to it. The available types are:
• No Plane—Prevents planes from being added to the 

layer. The No Plane layer is available for routing. If 
you select No Plane, you can only create Copper and 
Copper Pour areas on the layer. 

• CAM Plane—Sets the entire layer to be solid copper 
and connected to only one net. The CAM Plane layer 
is a negative image, and the copper does not appear in 
the design as it normally does for all other copper 
objects. You can not manipulate the shape/outline of 
the copper on this layer since it is generated 
automatically and covers the entire layer. This is an 
outmoded layer type. You can not route traces on a 
CAM Plane layer. Copper Pours and Plane areas can 
not be created on CAM Plane layers.

• Split/Mixed Plane—Enables one or more planes on 
the layer, and enables routing on the layer. Routes can 
be placed within or without plane areas. Plane areas 
avoid traces within their outline by a clearance area 
defined in the design rules. Copper Pours can not be 
placed on Split/Mixed layers. Plane areas are created 
on Split/Mixed plane layers and are similar to but 
more feature-packed than Copper Pours.
Tip: If a No Plane layer is changed to a Split/Mixed or 
CAM Plane layer, nets belonging to the new plane are 
excluded from associated nets.

Routing Direction area You must assign a primary routing direction to all 
electrical layers. Choose from:
• Horizontal
• Vertical
• Any
• positive 45 degrees
• negative 45 degrees 

Tip: Nonelectrical layers are not assigned a routing 
direction.
The routing direction affects the manual and autorouting 
performance. For example, if you select Horizontal but 
most of the traces on the layer need to be vertical, route 
editing performance is slow. Also, selecting Any can 
adversely affect route editing performance.

Table 45-199. Layers Setup Dialog Box Contents (cont.)

Name Description
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Related Topics

Setting Up an Outer Layer

Setting Up an Inner Layer

Setting Up a Documentation Layer

Layer Modes in the Concepts Guide

Associations Opens the Component Layer Associations Dialog Box.
Tip: The Associations button appears when you select a 
component layer in the Layers list. 

Assign Nets Opens the Plane Layer Nets dialog box. 
Tip: The Assign Nets button appears when you select the 
Ground or Power layer in the Layers list. 

Single-sided board Specifies the following:
• Connectivity checking will not report connectivity 

errors for component pins with non-plated drill holes. 
Components and jumpers placed on the top layer are 
considered as connected to pads on the bottom layer 
with solder joints.

• In CAM output, all through-hole pins and vias are 
treated as non-plated regardless of definition in pad 
stacks.

Tips: 
• Available only for boards with two electrical layers.
• When selected, Modify button is unavailable.

See also: Designating a Board as Single-sided

Modify Opens the Modify Electrical Layer Count dialog box.
See also: Modifying the Number of Electrical PCB Layers

Reassign Opens the Reassign Electrical Layers dialog box.
See also: Reassigning Electrical Layers

Thickness Opens the Layer Thickness dialog box.
See also: Setting Layer Thickness

Enable/Disable Opens the Enable/Disable Layers dialog box.
See also: Hiding or Displaying Non-electrical Layers

Max Layers Opens the Increase Maximum Layer Number dialog box.
Tip: When you change to increased layer mode, layer 
numbers for all nonelectric layers increase by 100.
See also: Increasing the Maximum Number of Available 
Layers

Table 45-199. Layers Setup Dialog Box Contents (cont.)

Name Description
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Leader Segment Properties Dialog Box

Leader Segment Properties Dialog Box
The Leader Segment Properties dialog box displays coordinate information for the selected 
dimensioning arrow and provides several areas for modifications.

Requirement: You must select the first segment of the leader, the section with the arrow, to 
display this dialog box.

The Leader Segment Properties dialog box remains open until you click OK or Cancel. 
Selecting another leader segment while the dialog box is open updates the information for the 
selected object.

Accessing

• Select a dimensioning leader segment > right-click > Properties

Figure 45-217. Leader Segment Properties Dialog Box

Table 45-200. Leader Segment Properties Dialog Box contents 

Name Description

X and Y Lists the x and y coordinates of the dimension object. The 
coordinates are calculated from the bottom of one of the 
extension lines or from the radius point of an arc. Type new 
values to change the location.

Parent button Opens the Dimension Properties dialog box for the dimension 
object with which the selected object is associated.

Layer list Lists the current working layer. Select a new layer from the 
list.

Line Width Lists the current line width used for the dimension object. 
Type a new value to change the line width.
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Related Topics

Dimensioning Process

Library List Dialog Box
Use the Library List dialog box to specify the libraries available to the design, library search 
order, and other search-related options. Operations in this dialog box affect the contents of the 
Library list in the Library Manager dialog box.

Accessing

• File menu > Library > Manage Lib. List button

Figure 45-218. Library List Dialog Box

Table 45-201. Library List Dialog Box Contents 

Name Description

Library list The libraries currently listed in the Library Manager 
Library list.

Read Only A status indicator only; this box is always unavailable.

Shared Shares the library over the network. This enables more 
than one user to access the library file at the same time.

Allow Search Includes the library when performing operations that 
involves libraries, such as adding parts.

Add Adds a library to the Library list.
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Library Manager Dialog Box

Related Topics

Setting Library Availability and Search Options

Library Manager Dialog Box
Use the Library Manager dialog box to create libraries, to display the contents of libraries, and 
to manage the contents of libraries.

Tips:

• The Library Manager supports up to 65,536 components.

• The picture in the Library Manager dialog box displays the selected item for decals, 
CAE decals, and lines. For parts, the picture displays the first-assigned decal.

Accessing

• File menu > Library

Remove Removes a library from the Library list.

Up/Down Moves the order of the libraries in the Library list.

Synchronize with PADS 
Logic

Specifies to push the library settings from PADS Layout 
to PADS Logic.

Table 45-201. Library List Dialog Box Contents (cont.)

Name Description
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Figure 45-219. Library Manager Dialog Box

Table 45-202. Library Manager Dialog Box Contents 

Name Description

Library list The list of libraries available to you.

Create New Lib Opens the New Library window where you can specify a new 
library name and location.

Manage Lib. List Opens the Library List Dialog Box.

Attr Manager Opens the Manage Library Attributes Dialog Box.

Preview area Shows the item selected in the Filter list.

Filter area Narrows down the Filter list by Decals, Parts, Lines, or Logic. 
You can further narrow the list using wildcards in the Filter box.
Tip: Add an asterisk “*” to the box to display all items. 

Filter list The results from your filter area selections.
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Library Manager Dialog Box

New The action taken is dependent on the filter.
• Decals—Opens the PCB Decal Editor on a new decal.
• Parts—Opens the Part Information Dialog Box, Gates Tab on 

an unnamed part.
• Lines—Unavailable. There is no special library lines editor. 

Use drafting tools to create or edit lines and save them to the 
library.
See also: Drafting

• Logic—Unavailable. Use PADS Logic to create or edit CAE 
decals.

Restriction: This button is unavailable when the Library is set to 
All Libraries.
See also: Adding Items to a Library

Edit The action taken is dependent on the filter.
• Decals—Opens the PCB Decal Editor on the selected decal.
• Parts—Opens the Part Information Dialog Box, Gates Tab on 

the selected part.
• Lines—Unavailable. There is no special library lines editor. 

Use drafting tools to create or edit lines and save them to the 
library.
See also: Drafting

• Logic—Unavailable. Use PADS Logic to create or edit CAE 
decals.

Restriction: This button is unavailable when the Library is set to 
All Libraries.
See also: Editing Items in a Library

Delete Removes the selected item from the library.
Restriction: This button is unavailable when the Library is set to 
All Libraries.
See also: Deleting Items from a Library

Copy Copies the selected item to another name or another library.
Restriction: This button is unavailable when the Library is set to 
All Libraries.
See also: Copying a Library Item

Import Import library data from an ASCII file. The file type is dependent 
on the filter.
Restriction: This button is unavailable when the Library is set to 
All Libraries.
See also: Importing Library Data

Table 45-202. Library Manager Dialog Box Contents (cont.)

Name Description
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Related Topics

Log Test Dialog Box
Use BLT to replay session playback media created by BMW. 

Accessing

• type BLT > press Enter

Tip: If nothing happens, close PADS Layout and restart it.

Export Export library data to an ASCII file. The file type is dependent on 
the filter.
Restriction: This button is unavailable when the Library is set to 
All Libraries.
See also: Exporting Library Data

List to File The action taken is dependent on the filter.
• Decals—Generates a list of PCB Decals in a single library.
• Parts—Generates a list of Parts in a single library or all 

libraries along with chosen attributes.
• Lines—Generates a list of line items in a single library.
• Logic—Generates a list of CAE decals or Logic symbols in a 

single library.
Restriction: When the Library is set to All Libraries, this button 
is unavailable for all but Parts.

Creating a Library Setting Library Availability and Search 
Options

Deleting All Items in a Library Managing Library Attributes

Creating a Report of the Parts in a Library Creating a Report of Decals, Lines or Logic 
Symbols in a Library

Table 45-202. Library Manager Dialog Box Contents (cont.)

Name Description
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Logic Families Dialog Box

Figure 45-220. Log Test Dialog Box

Related Topics

Replaying Session Playback Media with BLT

Logic Families Dialog Box
Use the Logic Families dialog box to add, delete, or edit logic families, and to specify their 
reference designator prefix.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > General tab > Families button

Table 45-203. Log Test Dialog Box contents 

Name Description

Media Directories Lists the session playback media files.

New name Specifies to rename the selected media directory.

Rename Renames the selected media directory to the name in the New 
name box.
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Figure 45-221. Logic Families Dialog Box

Make Reuse Dialog Box
Use the Make Reuse dialog box to specify a reuse type and reuse name for the physical design 
reuse you are creating. 

Accessing

• Select the objects you want to include > Right-click > Make Reuse

Table 45-204. Logic Families Dialog Box Contents 

Name Description

Family The name of the Logic family.
Restriction: The logic family name is limited to 3 
character.

Prefix The prefix of the Logic family. Multiple characters are 
allowed.

Add Inserts a row at the bottom of the list where you can add a 
new Logic family.

Edit Makes the selected cell available for editing.
Tip: You can also double-click a cell to edit the contents.

Delete Removes the selected row.
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Make Reuse Dialog Box

Figure 45-222. Make Reuse Dialog Box

Table 45-205. Make Reuse Dialog Box contents 

Name Description

Reuse Type Describes the physical design reuse and its function. The reuse 
type is similar to a library part type. Type a reuse type, up to 
255 characters long, for the physical design reuse. Illegal 
characters are slashes (\ /), colon (:), asterisk (*), question 
mark (?), quotation marks ("), less than and greater than signs 
(< >), and pipe (|). You can include spaces in the type, but you 
can't use them as the first or last character.
The reuse type is checked to ensure it is not already in use. If it 
is already used, an error message appears and you can specify 
a different type.
Tip: There is no way to display the reuse name and reuse type 
in the design.

Reuse Name Indicates a name that uniquely identifies this instance of the 
physical design reuse. Type a name, up to 15 characters long, 
for the physical design reuse. Illegal characters are comma (,), 
brackets ({ }), asterisk (*), period (.), and space.
The default name is based on the reuse type. For example, if 
the reuse type is Power Supply, the default reuse name is 
Power_Supply_1.
The reuse name is checked to ensure it is not already in use. If 
it is already used, an error message appears and you can 
specify a different name.
Tip: There is no way to display the reuse name and reuse type 
in the design.
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Related Topics

Reusing Designs or Parts of Designs

Manage Library Attributes Dialog Box
Use the Manage Library Attributes dialog box to manage attributes on a library-by-library basis. 
You can add, delete, and rename attributes for all parts or decals in an individual library or in all 
libraries. You can also display all the attributes in a library, whether the attributes apply to all 
items or to individual items.

Accessing

• File menu > Library > Attr Manager button

Save to File Saves the physical design reuse to a file for use in another 
design. The content of the current start-up file is also saved 
with the physical design reuse. 
See also: Creating Start-up Files
If this is selected, the Reuse Save As dialog box appears when 
you click OK. Indicate the folder in which to save the newly 
created physical design reuse. The default folder is \PADS 
Projects\Reuse.
Reuse files have a .reu extension and can be opened by 
clicking Open from the File menu. You must change the file 
type to PADS Layout Reuse Files (*.reu).

Deselection Report Creates the report file report.rep in the 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Pro
grams folder and opens the file in the default text editor. The 
file contains a list of items removed from the selection because 
they were not valid for inclusion in the physical design reuse.
Tip: The deselection report and the selection report are created 
using the same file name. If you want to save this file, do so in 
the default text editor using a different file name.

Selection Report Creates the report file report.rep in the 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Pro
grams folder and opens the file in the default text editor. The 
file contains a list of items included in the physical design 
reuse.
Tip: The deselection report and the selection report are created 
using the same file name. If you want to save this file, do so in 
the default text editor using a different file name.

Table 45-205. Make Reuse Dialog Box contents (cont.)

Name Description
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Manage Library Attributes Dialog Box

Figure 45-223. Manage Library Attributes Dialog Box

Table 45-206. Manage Library Attributes Dialog Box Contents 

Name Description

Select Library list The list of libraries available to you.

Item Types list Filters the type of items in the Attributes in Library list.

Browse Lib. Attr Opens the Browse Library Attributes Dialog Box.

Edit New Name Makes the selected attribute Name editable.
Tip: This is available only when an attribute in the New 
Name column in the Attributes Selected for Rename list is 
selected.

Attributes in Library list The list of attributes in the selected library.
Tip: This is available only when an attribute in the New 
Name column in the Attributes Selected for Rename list is 
selected.

Add >> Adds the selected attribute to the Rename list.

<< Remove Removes the selected attribute from the Rename list.

<< Remove All Removes all of the attributes from the Rename list.

Attributes Selected for 
Rename list

The list of attributes you’ve selected to rename.

Add Attr Opens the Add New Attribute to Library Dialog Box.
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Markups Dialog Box
Use the Markups dialog box to view or log issues concerning the design. You can add 2D line 
markups to issues, to outline or highlight their location. You can also link design objects to 
markups. Then you can export the issues alone or export the design and any issues for viewing 
and logging additional information in visECAD.

Accessing

• Edit menu > Markups

Delete Attrs Deletes the selected attribute from the selected library.

Rename Attrs Renames all of the attributes you gave a new name to in 
the selected library.

Table 45-206. Manage Library Attributes Dialog Box Contents (cont.)

Name Description
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Markups Dialog Box

Figure 45-224. Markups Dialog Box
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Related Topics

Adding Markups

Importing Markups

Exporting Markups

Media Wizard Dialog Box
BMW (Basic Media Wizard) is a tool that you can use to record and play back PADS Logic, 
PADS Layout and PADS Router sessions. It is particularly useful as a means of supplying 

Table 45-207. Markups Dialog Box Contents

Name Description

Add Topic Click to add a new topic to the Collaboration Data tree.

Add Issue Click to add a new issue to the tree under the currently 
active topic

Add Markup Click to add a new markup to the currently active issue.

Delete Delete the active item in the Collaboration Data tree

Import Click to browse for, and Import a collaboration data file 
(*.clb, or *.cle).

Export Click to Export the encrypted collaboration data to a file 
name of your choosing (*.cle).

Collaboration Data Tree This is the top tree in the dialog box and it displays the 
collaboration data in a hierarchical form.

Elements Tree This lists the elements linked to any markup.

User Type your name in this box to associate your name with 
the active Collaboration Tree item.

Date Displays the date and time of creation of the currently 
active collaboration item.

Comment Type to add comments for the currently active 
collaboration item.

Text This displays the text of a markup. This is unavailable in 
PADS Layout, but will display text associated with 
markups created in other software.

File When you export or import a collaboration file, this 
displays the path and filename.
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Media Wizard Dialog Box

information to PADS Technical Support engineers trying to identify and resolve any 
problematical behavior you may encounter.

Accessing

• type BMW > press Enter

Figure 45-225. Media Wizard Dialog Box

Table 45-208. Media Wizard Dialog Box contents 

Name Description

Media Wizard area Specifies what you want the Media Wizard to do:
• Create Media from Current Session—Use this procedure 

when the session you are recreating did not cause a PADS 
tool crash.

• Create Media from Previous Session—Use this 
procedure when the session you are recreating caused the 
PADS tool to crash, and the automatic procedure described 
in Automatically Creating Session Playback Media for a 
Crashed Session cannot be used due to one of the 
restrictions listed in that section.

• Stop Logging—Specifies to stop the Media Wizard from 
logging any further actions.

User Initials Specifies your initials. They are included in the playback 
media filenames to identify the files as yours.

Delete Actions Before 
Last Save

Specifies to delete all entries in the session log file between the 
first Open and the last Save command. You can do this to 
eliminate any actions you may have performed before 
beginning the series of actions that produced the problematical 
behavior. This makes it easier for the Tech Support engineer to 
identify the problem.
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Related Topics

BMW and BLT

Missing Height Dialog Box
Use the Missing Height dialog box to specify missing heights when exporting the design to IDF. 

Accessing

The Missing Height dialog box appears when the Geometry.Height attribute does not exist or is 
set to zero height for any part type and decal pair exported to IDF.

Figure 45-226. Missing Height Dialog Box

Related Topics

Specifying Missing Heights During Export to IDF

Table 45-209. Missing Height Dialog Box contents 

Name Description

Can’t Find Height For 
Part Type

Displays the part type with the missing height.

Using Decal Displays the decal associated with the part type.

Height Specifies the package and mounting height for the part type 
and decal pair.
Tip: If you specify the height as zero, the mechanical design 
system may prompt you to enter a height when you import the 
IDF file.

Design Units Lists the design units.

For All Parts Specifies to apply the height for all part type and decal pairs.
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Mixed Plane Setup Dialog Box

Mixed Plane Setup Dialog Box
Use the Mixed Plane Setup dialog box to set the type of plane checking.

Accessing

• Tools menu > Verify Design > Plane check > Setup button

Figure 45-227. Mixed Plane Setup Dialog Box

Related Topics

Setting Up Plane Checking

Table 45-210. Mixed Plane Setup Dialog Box contents 

Name Description

Type area • Check thermal connectivity only—Specifies to check 
your design for split/mixed or CAM plane thermal 
connectivity. Use this check to find pins or vias that do not 
have the thermal attribute set, or to find pins that are not 
within a plane area (thermals will not connect). You can set 
the thermal attribute in Jumper Pin, Pin, or Via Properties 
dialog boxes.

• Check clearance and connectivity—Specifies to check 
your design for split/mixed plane clearance and net 
connectivity errors. If the split/mixed plane is not 
connected in the design, a Plane Connect will be performed 
before the check is run.

Same Layer 
Connectivity

Ensures that plane areas are continuous on the split/mixed 
plane layer. Plane areas of a particular net must have copper 
contact with each other without going to another layer.
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Modeless Command Dialog Box
You can set or change some settings and functions at any time using a shortcut key for the 
command called a modeless command.

Accessing

• Type the modeless command (shortcut key) for the command you want. 

Figure 45-228. Modeless Command Dialog Box

Modeless Commands
The following is a complete listing of all the modeless commands. In the table:

<X,Y> = coordinates

<s> = text

<n> = number. 

Table 45-211. Modeless Commands 

Shortcut 
key

Description

C Complementary format. Type C and press Enter to change the display to a 
complementary format, which views thermals and antipads on plane layers. 
Type C a second time and press Enter to restore the normal non 
complementary view.

D Display last current layer on/off.

DO Drill outline on/off.

E Cycles through the End Via modes:
• End No Via (where a trace ends in space)
• End Via (where a trace ends with a via)
• End Test Point (where a trace ends with a test point via

I Database Integrity Test.

L <n> Change the current layer to <n>. <n> can be a number or name, for example 
(L 2) or (L top).
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N <s> Highlights nets one by one. To place the highlighted net <s> at the top of the 
stack, repeat the command, for example, N GND.

N- Unhighlights each highlighted net in reverse order.

N Removes all highlighting from the nets.

NN Toggles the visibility of net names.
Tips:
• This command toggles the Net Name check box (object type - column) in 

the Display Colors Setup Dialog Box.
• When the Net Name column check box is enabled, net name visibility is 

still restricted by the color tiles on each layer and the Show net names on 
Traces, Vias, Pins check boxes. See also the NNP, NNT, and NNV 
modeless commands.

• Sizing and frequency of placement is controlled by the settings in the 
Display Options.

NNP Toggles the display of net names on pins.
Tip: This command toggles the Net names on...Pins check box in the Display 
Colors Setup Dialog Box. Sizing is controlled by the settings in the Display 
Options.
Restriction: The display of net names also depends on the Net Name 
visibility check box and the presence of a non-background color tile on the 
layer in the Display Colors Setup Dialog Box.

NNT Toggles the display of net names on traces.
Tip: This command toggles the Net names on...Traces check box in the 
Display Colors Setup Dialog Box. Sizing and frequency of placement is 
controlled by the settings in the Display Options.
Restriction: The display of net names also depends on the Net Name 
visibility check box and the presence of a non-background color tile on the 
layer in the Display Colors Setup Dialog Box.

NNV Toggles the display of net names on vias.
Tip: This command toggles the Net names on...Vias check box in the 
Display Colors Setup Dialog Box. Sizing is controlled by the settings in the 
Display Options.
Restriction: The display of net names also depends on the Net Name 
visibility check box and the presence of a non-background color tile on the 
layer in the Display Colors Setup Dialog Box.

O <r> Toggles outline mode on and off. Displays an outline of pads, traces and all 
lines. Traces are displayed at their true width to the limits of the Minimum 
Display Width setting in the Global / General Options.
See also: To Use Outline View Mode

Table 45-211. Modeless Commands (cont.)

Shortcut 
key

Description
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OH Toggles outline mode with High resolution. Displays all objects with their 
true shape.

OL Toggles outline mode with Low resolution. Displays rounded objects with 
squared corners.

PO Pour outline on/off. This toggles the display mode of copper pours between 
pour outline and hatch outline.
See the SPO modeless command for use with plane areas.

PN Toggles pin number display on/off.
Tip: This command toggles the Pin Num. column check box in the Display 
Colors Setup Dialog Box. Sizing is controlled by the settings in the Display 
Options.

Q Quick Measure with a dynamic ruler. Place the cursor at the starting point 
then type the “q” modeless command. Drag the cursor to create a line 
between the start and end point of your measurement. Snaps to the design 
grid when Snap to grid is on. Measurements are gridless when Grid Snap is 
off. Dynamically reports delta x, delta y, and delta x,y in current design units. 
You can also measure precise Euclidean distances between polar grid nodes 
using this command.
See also: Measuring

QL Quick Length. Area select the route items you want to measure; such as route 
segments, nets, or pin pairs. Type QL; and press Enter. A report of the route 
item lengths for routed, unrouted, and total length appears in the default text 
editor.
See also: Measuring

R <n> Reduce display width to <n>, for example, R 50.

RV Toggles Make Like Reuse operations to compare or ignore value and 
tolerance attributes. 
See also: To Make a Like Reuse in Verb Mode, To Make a Like Reuse in 
Object Mode

SO <x> 
{<y>}

Sets the origin using relative coordinates. 
If a component, pin, drafting corner, text, via, circle, or line intersection is 
selected, SO sets the board origin to the origin of the selected item. If nothing 
is selected, coordinates must be given. For example, SO 25, SO 8.3 or SO 16-
2/3, SO 25 25. The second parameter is optional.
See also: Setting the Design Origin.

SOA <x> 
{<y>}

Sets the origin using absolute coordinates. Coordinates must be given. For 
example, SOA 25, SOA 8.3 or SOA 16-2/3, SOA 25 25. The second 
parameter is optional.

Table 45-211. Modeless Commands (cont.)

Shortcut 
key

Description
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SPD Display generated plane data for split/mixed planes. This command controls 
an option in the Options Dialog Box, Split/Mixed Plane Page.

SPI Display plane thermal indicators. This command controls an option in the 
Options Dialog Box, Split/Mixed Plane Page.

SPO Display plane polygon outlines for split/mixed planes. This command 
controls an option in the Options Dialog Box, Split/Mixed Plane Page.

T Toggle Transparent Mode. 
See also: To Use Transparent View Mode

UM Sets Design Units to mils.

UMM Sets Design Units to millimeters (metric).

UI Sets Design Units to inches.

X Text outline on/off.

W <n> Changes width to <n>, for example W 5.

Grids Commands

G <x> 
{<y>}

Grid global setting. The second parameter is optional.
Sets the Design and Via grids simultaneously, for example, G 25, G 8.3 or G 
16-2/3, G 25 25.

GD <x> 
{<y>}

Dot grid setting, for example, GD 8-1/3, GD 25 25, or GD 100. The second 
parameter is optional.

GP Polar grid on/off. Use the polar grid for Radial Move, circular component 
arrays, and to create radial drawings.

GP r a Move to a point specified by polar coordinates (radius and angle).

GPR r Move to a point specified by the radius, using the existing angle.

GPA a Move to a point specified by the angle, using the existing radius.

GPRA da Move to a point specified by the current angle (da) value, using the existing 
radius.

GPRR dr Move to a point specified by the current radius (dr), using the existing angle.

GR <xx> Design grid setting, for example, GR 8-1/3, GR 25 25, GR 25.

GV <xx> Via grid setting, for example, GV 8-1/3, GV 25 25, or GV 25.

Table 45-211. Modeless Commands (cont.)

Shortcut 
key

Description
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Tips: 

• - 8 = (eight); - 8-1/3 = (eight and a third); - 8.33 = (eight point 33)

• You can search for, and move the cursor to, a location regardless of the current 
grid. But the Snap to grid settings of the Grids Options restrict you to 
performing any design activity on the grid.

Search Commands

S <s> Search for reference designator/pin <s>, for example SU 1.1 or SU 1.

S <n> 
<n>

Search absolute at <n> <n>, for example S 1000 1000.

SR <n> 
<n>

Search relative X and Y, for example SR -200 100.

SRX <n> Search relative X, for example SRX 300.

SRY <n> Search relative Y, for example SRY 400.

SS <s> Search and Select components by reference designator, for example SS U10. 
You can also search and select more than one component by typing multiple 
entries, for example SS U10 U5 R6.
Tip: Spaces may be important in modeless commands. For example, SS W1 
and S SW1 have different meanings. SS W1 tells PADS Layout to search and 
select W1, while S SW1 tells it to search for SW1.

SS <s>* You can search and select using an asterisk, *. Type SS, a space, the 
character you want to search by, and an asterisk. For example, to search and 
select all components beginning with a C, type SS C*. All components with a 
reference designator starting with C are selected.
Tip: This command is useful for placing parts. For example, you can select 
all resistors using SS R* and then choose Move Sequential from the pop-up 
menu to place the selected parts.

SX <n> Absolute move to <n>, current Y, for example SX 300.

SY <n> Absolute move to <n>, current X, for example SY 400.

XP Search for and select route segments using pixels instead of segment width, 
allowing you to adjust a trace whose corners are less than the width of the 
trace.

Quick Layer View Commands

Z Quick layer view. With no command arguments, Z displays the initial layer 
view.

Table 45-211. Modeless Commands (cont.)

Shortcut 
key

Description
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Z 
{+<layer
>} {-
<layer>}

Add or remove layer from the current set of displayed layers. Examples:
• Z +O makes the outside layers visible, but does not change visibility of 

other layers.
• Z -O makes the outside layers invisible, but does not change visibility of 

other layers.
• Z -2 +O makes invisible layer 2 and makes visible the outside layers.

Z <n-m> View only the range of layers you type. For example, Z 2-4 displays layers 2, 
3, and 4. Do not enclose the range with square brackets.

Z <layer 
n> 
{<layer 
m> ...}

View only the layers you type. For example, Z 2 4 d displays layers 2, 4, and 
the documentation layer.

Z * View all layers.
Restriction: Z supports only the asterisk * regular expression.

Z A View the active layer. If the active layer is changed, it has no effect on the 
display.

Z ADB View the Assembly Drawing Bottom layer.

Z ADT View the Assembly Drawing Top layer.

Z B View only the bottom layer.

Z C
<-C>

View only the current layer. If the active layer is changed, only the new 
current layer is displayed. Unlike Z A, it puts you in a continuous mode 
where all layers are hidden except the active layer. When you change layers, 
the new layer becomes visible and all other layers are hidden. Use Z -C to 
exit the mode.

Z D View all documentation layers.

Z E View all electrical layers.

Z I View all internal layers.

Z O View only the outside layers, that is, the top and bottom layers.

Z PMB View the Paste Mask Bottom.

Z PMT View the Paste Mask Top.

Z SMB View the Solder Mask Bottom.

Z SMT View the Solder Mask Top.

Z SSB View the Silkscreen Bottom.

Z SST View the Silkscreen Top.

Table 45-211. Modeless Commands (cont.)

Shortcut 
key

Description
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Z T View only the top layer.

Z U View unroutes that are visible on all layers. 

Z Z View all layers. 

ZR 
<name>

Restore a quick layer view configuration. For example, ZR L23 restores the 
configuration stored as L23.
Tip: Type ZR and press Enter to see a list of all layer configurations created 
by ZS in this session.
See also: ZS.

ZS 
<name>

Saves the current set of displayed layers as a quick layer view configuration. 
For example, ZS L23 stores the current configuration as L23. The quick layer 
view configuration is available until you exit the program.
See also: ZR.

Angles Commands

AA Any angle.

AD Diagonal angle.

AO Orthogonal angle.

Undo Commands

UN 
[<n>]

Multiple undo command (1-100), <n> is optional. (Ex. UN 2) UN will undo 1 
time.

RE [<n>] Multiple redo command (1-100), <n> is optional. (Ex. RE 2) RE will redo 1 
time.

Design Rule Checking (DRC) Commands

DRP Prevent.

DRW Warn.

DRI Ignore Clearance.

DRO Turn off DRC Mode.

Routing Commands

E Toggle between end via, end no via, and end test point modes.

LD Toggle between horizontal and vertical routing layer direction on the current 
layer.

PL <n> 
<n>

Paired Layer command, where <n> can be layer numbers or layer names. (for 
example, PL 1 2 or PL top bottom).

SH Toggles Shove mode on or off.

Table 45-211. Modeless Commands (cont.)

Shortcut 
key

Description
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Related Topics

Typing Modeless Commands

Shortcut Keys

V Opens the Vias dialog box. 

VA Automatic via and mode selection.

VP Use partial via.

VT 
<name>

Use through hole via. If multiple vias exist, you can also type the name of the 
via to use.

T Toggle Transparent Mode.

Drafting Objects Commands

HC Circle shape draw mode.

HH Path shape draw mode.

HP Polygon shape draw mode.

HR Rectangle shape draw mode.

Other Commands

? Show this help topic.

BMW Opens the Basic Media Wizard dialog box. 
• BMW records session playback media for a problematic PADS Logic, 

PADS Layout, or PADS Router session. It can create playback media 
based on your last PADS session or your current session. This playback 
media can be replayed using the BLT modeless command.

• BMW is also a command line option. 
See also: BMW and BLT 

BMW 
ON

Starts BMW session logging.

BMW 
OFF

Stops BMW session logging.

BLT Basic Log Test. Opens the Log Test Dialog Box. BLT finds and runs BMW 
session playback media. 
See also: BMW and BLT 

F <s> Open file <s>, where <s> is the path and name of the file to open.

Table 45-211. Modeless Commands (cont.)

Shortcut 
key

Description
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Modify Electrical Layer Count Dialog Box
Use the Modify Electrical Layer Count dialog box to increase or decrease the number of 
electrical layers in the design.

Accessing

• Setup menu > Layer Definition > Modify button

Figure 45-229. Modify Electrical Layer Count Dialog Box

Related Topics

Modifying the Number of Electrical PCB Layers

Reassigning Electrical Layers

Reassign Electrical Layers Dialog Box

Layers Setup Dialog Box

Table 45-212. Modify Electrical Layer Count Dialog Box Contents 

Name Description

Current number of 
electrical layers

Lists the current number of electrical layer.

Enter new number of 
electrical layers (must be 
between _ and _)

Type a new number of electrical layers. You can add or delete 
layers. The number must be between the two values above the 
text box.
Restriction: You can’t delete layers that have data on them. 
For example, you want to reduce a 2 layer board to a 4 layer 
board. if you have 4 layers and they all have content, you must 
move the content from the layers to be deleted. The statement 
above the text box will state “must be between 4 and 20” since 
you can’t delete any layers because of data.
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NC Drill Options Dialog Box

NC Drill Options Dialog Box
Use the NC Drill Options dialog box to define NC Drill Output plotting options when adding an 
NC drill document or editing an existing one.

Accessing

• File menu > CAM > Add button > select NC Drill from the Document Type list > 
Drill button > Options button

or

• File menu > CAM > select a document name > Edit button > select NC Drill from the 
Document Type list > Drill button > Options button

Figure 45-230. NC Drill Options Dialog Box

Table 45-213. NC Drill Options Dialog Box contents 

Name Description

Rotation Define how to rotate the drill drawing. Your choices are 0, 90, 
180, or 270 degrees of counterclockwise rotation.

Origin Offset X/Y Specifies how much to move the board so the design origin 
coincides with the drill machine origin. A positive X shift 
moves the board to the right: a positive Y shift moves the 
board up.

Mirror Image Specifies to mirror the image.

Count X/Y Specifies how many times the Pattern is repeated.
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Related Topics

Creating an NC Drill File

Creating CAM Outputs to Manufacture Your PCB

NC Drill Setup Dialog Box
Use the NC Drill Setup dialog box to set Excellon output or Drill Listing parameters.

Accessing

• File menu > CAM > Add button > select NC Drill from the Document Type list > 
Drill button > Device Setup button

or

• File menu > CAM > select a document name > Edit button > > select NC Drill from the 
Document Type list > Drill button > Device Setup button

Distance X/Y Specifies the distance between adjacent patterns; the distances 
should be greater than or equal to the board dimensions to 
avoid any overlap. If all box values are zero, then there is no 
step and repeat.

Through vias Specifies to drill through vias.

Partial Vias Specifies to drill partial vias.
Restriction: Available only if you’ve set up Drill Pairs.

Drill Pair Specifies which layer pair to drill.
Restriction: Available only if you’ve specified to drill partial 
vias.

Plated Pins Specifies to drill plated pins.

Non-Plated Pins Specifies to drill non-plated pins. Non-plated pins are usually 
mounting holes.

Test Points Specifies to plot test point locations.

Generate Listing Creates a listing of the drill hole sizes by location. An 
additional CAM file is produced with a .lst extension when 
you run the NC Drill CAM Document.

Table 45-213. NC Drill Options Dialog Box contents (cont.)

Name Description
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NC Drill Setup Dialog Box

Figure 45-231. Excellon Tab

Figure 45-232. Drill Listing Tab
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Figure 45-233. NC Drill Setup Dialog Box

Table 45-214. NC Drill Setup Dialog Box contents 

Name Description

Output Type Specifies the output file you want: ASCII or EIA-244 
(Electronic Industries Association RS-244 Standard format)

Units Specifies the units to use: Metric or English.
Tip: The Units list on the Excellon tab allows multiple 
selections with predetermined leading and trailing digits.

Type column Displays the format string type.

String column Lists the format string. Double click to edit.
Tips: 
• Default strings on the Excellon tab are different than those 

on the Drill Listing tab.
• See the header of the drill.dat file in the 

<product_name>/Settings folder for more detailed format 
information.

# of Digits area Specifies the number of digits before (leading) and after 
(trailing) the decimal point position. This defines the output 
file coordinate precision.
Exception: The # of Digits fields are unavailable on the 
Excellon tab since the Units list selections contain 
predetermined leading and trailing digits.

Zero Suppress Specifies the zeros to suppress.
• None—retains both leading and trailing zeros.
• Leading—suppresses leading zeros.
• Trailing—suppresses trailing zeros.
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Net Assignment Dialog Box

Related Topics

Creating an NC Drill File

Creating CAM Outputs to Manufacture Your PCB

Net Assignment Dialog Box
Use the Net Assignment dialog box to select nets to associate to copper being used to bridge two 
or more nets. This ensures that when online design rule checking is enabled, the bridge copper 
isn’t flagged as a violation, but all other accidental physical connections between the nets are 
caught.

Accessing

• In the Add Drafting or Drafting Properties dialog box, click the Bridge check box and 
then click the Nets to bridge button.

Coordinate Specifies the coordinate type.
• Absolute—absolute coordinates.
• Incremental—relative coordinates.

Speed/Feed table Controls the drill speed and feed rates. Double-click to modify 
an existing entry. Edit the size range, drill speed (surface feet 
per minute), and feed rate (inches per minute) values in the 
boxes.
Tip: Drilling feed rates can be set between 10 and 500 IPM (4 
and 212 mm/s if metric) in increments of 1 IPM (1 mm/s if 
metric).

Add button Adds a new row at the bottom of the table.

Delete button Removes the selected row from the table.

Verify button Ensures that you have values in the Size Range box which 
satisfy each drill on your board. A prompt tells you whether 
the drill sizes are accurate or if drill size ranges are missing 
from the Size Ranges box.

Table 45-214. NC Drill Setup Dialog Box contents (cont.)

Name Description
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Figure 45-234. Net Assignment Dialog Box

Related Topics

Bridging Nets with Copper

Net Properties Dialog Box
The Net Properties dialog box displays the netname, the pin-to-pin connections in a list, routing 
information, and rules data. You also set route protection for nets in this dialog box.

The Net Properties dialog box remains open until you click OK or Cancel. If you select another 
net while the dialog box is open, the information updates for the selected net.

Table 45-215. Net Assignment Dialog Box Contents

Name Description

Available nets Specifies the nets that are available for adding to the Nets 
to bridge list to associate to the copper bridge. This list is 
filtered by selecting either Copper pour/plane nets or All 
nets.

Nets to bridge Specifies the nets to associate to the copper bridge. The 
copper can bridge these nets with design rules enabled.

Copper pour/plane nets Filters the Available nets list to display only copper pour 
and plane area nets.

All nets Filters the Available nets list to display all the nets in the 
design.
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Net Properties Dialog Box

Tip: Several of the options in this dialog box are unavailable if the net is part of a physical 
design reuse or contains protected routes.

Accessing

· Select a net > Right-click > Properties

Figure 45-235. Net Properties Dialog Box

Table 45-216. Net Properties Dialog Box contents 

Name Description

Net Displays the name of the net.

Connection Lists the connections available in the design.

Layout Data area Lists all layout data about the selected net.

Protect Routes Protects selected routes or traces.
See also: To Protect Routes

Protect Unroutes Protects unrouted connections and the unrouted portions of 
partial routes.
See also: To Protect Unroutes

Rules Data area lists all of the rules that apply to the selected net.

Trace Width Modifies the trace width. Type a new value in the box. This 
option is unavailable if route protection is on.
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Related Topics

Modifying Net Properties

To Assign Colors to Nets

View Nets Dialog Box

Net Properties Dialog Box, Associated Nets
The Net Properties dialog box displays the netname, the pin-to-pin connections in a list, routing 
information, and rules data. You also set route protection for nets in this dialog box.

The Net Properties dialog box remains open until you click OK or Cancel. If you select another 
net while the dialog box is open, the information updates for the selected net.

Restriction: Several of the options in this dialog box are unavailable if the net is part of a 
physical design reuse or contains protected routes.

Accessing

• Select a net > Right-click > Properties

Rules button Opens the Net Rules dialog box, at the proper hierarchy level, 
that applies to the pin pair.
Tip: If rules are defined specifically for the pin pair, the Pin 
Pair Rules dialog box appears; if no rules are set for the pin 
pair or net, the Default Rules dialog box appears.

Table 45-216. Net Properties Dialog Box contents (cont.)

Name Description
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Figure 45-236. Net Properties Dialog Box, Associated Nets

Table 45-217. Net Properties Dialog Box Contents, Associated Nets 

Name Description

Net Displays the name of the net.

Connection Lists the pin pair connections available in the net.
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Layout Data area Displays all layout data about the selected net.
• Unrouted Length—Displays the length of the net that is unrouted.
• Routed Length—Displays the length of the net that is routed.
• Via Count—Displays the number of vias that are used in the net.
• Capacitance (pf)—displays a baseline capacitance value of the net. 

This calculation uses the trace parameters, the board material values 
you set in the Layer Thickness Dialog Box, and requires at least one 
adjacent plane to display values. A maximum of two adjacent planes 
are used in the calculation. If the plane layer is a split/mixed plane 
layer, you must have a plane shape on the layer. The location and 
outline of the shape and cutouts of the plane area are all ignored in the 
calculation.
You can set a Minimum and Maximum Capacitance rule in the 
HiSpeed Rules Dialog Box, but it is only verified when you run Tools 
> Verify Design after you set up a High Speed check to check 
Capacitance. It is not verified by online DRC.

• Impedance (ohm)—displays a baseline impedance value of the net. 
This calculation uses the trace parameters, the board material values 
you set in the Layer Thickness Dialog Box, and requires at least one 
adjacent plane to display values. A maximum of two adjacent planes 
are used in the calculation. If the plane layer is a split/mixed plane 
layer, you must have a plane shape on the layer. The location and 
outline of the shape and cutouts of the plane area are all ignored in the 
calculation.
You can set a Minimum and Maximum Impedance rule in the 
HiSpeed Rules Dialog Box, but it is only verified when you run Tools 
> Verify Design after you set up a High Speed check to check 
Impedance. It is not verified by online DRC.

• Delay (ns)—displays a baseline delay value of the net. This 
calculation uses the trace parameters, the board material values you 
set in the Layer Thickness Dialog Box, and requires at least one 
adjacent plane to display values. A maximum of two adjacent planes 
are used in the calculation. If the plane layer is a split/mixed plane 
layer, you must have a plane shape on the layer. The location and 
outline of the shape and cutouts of the plane area are all ignored in the 
calculation.
You can set a Minimum and Maximum Delay rule in the HiSpeed 
Rules Dialog Box, but it is only verified when you run Tools > Verify 
Design after you set up a High Speed check to check Delay. It is not 
verified by online DRC.

Protect Routes Protects selected routes or traces from being moved. Similar to gluing 
components but you can allow protected traces to be edited by PADS 
Router in the Routing Rules.
See also: To Protect Routes

Table 45-217. Net Properties Dialog Box Contents, Associated Nets (cont.)

Name Description
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Protect Unroutes Protects unrouted connections and the unrouted portions of partial routes. 
If you are in a routing mode, you will not be able to select the unroute to 
begin routing. If you select one of the pins of the pair, you will not be 
able to complete routing of the pin pair. If you attempt to finish the trace 
on the pin pair, you will only see a partial route-completion target instead 
of the full route-completion target.
See also: To Protect Unroutes

Rules Data area Displays some rule information for the selected net.
• Class—If the net is included in a Class rule, the Class name is 

displayed.
• Rule Hierarchy—Displays one of the following from lowest priority 

to highest priority:
• “Default” is shown if the net is using the Default rules.
• “Class” is shown if the net is getting its rules from a Class rule. The 

class name will be shown immediately above.
• “Net” is shown if the net has its own rules.

• Trc/Trc Clearance—Displays the Trace to Trace clearance value 
from the Clearance Rules dialog box. See the Rule Hierarchy above to 
determine if the value is from the Default, Class, or Net level rules. 
Conditional rules are not shown.

• Width—Displays the Recommended Trace Width from the 
Clearance Rules dialog box. See the Rule Hierarchy above to 
determine if the value is from the Default, Class, or Net level rules.

Trace Width Modifies the trace width. Type a new value in the box. You are restricted 
to the range of Trace widths you have specified in the Clearance Rules 
dialog box. This option is unavailable if the Protect Routes checkbox is 
selected. 

Rules button Opens the Net Rules dialog box with the net preselected in order to apply 
Net Level rules.

Name: If one or more nets belonging to a single associated net are selected, 
displays the name of the associated net to which the selected net(s) 
belong. 
If nets belonging to more than one associated net are selected, no 
associated net names are listed.
An associated net’s name is a sorted list of net names separated by 
asterisks (*).

Table 45-217. Net Properties Dialog Box Contents, Associated Nets (cont.)

Name Description
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Related Topics

Modifying Net Properties

To Assign Colors to Nets

View Nets Dialog Box

Net Properties Dialog Box - Design Reuse
Use the Net Properties dialog box to resolve netname conflicts between netnames in a physical 
design reuse and netnames in the design. Only netnames from route and polygon elements in the 
physical design reuse appear in this dialog box.

Net properties are applied to route and polygon elements. For example, assigning a merge status 
for net GND merges all physical design reuse net and polygon objects using net GND with net 
GND in the design.

Associate net Select the checkbox to associate the selected nets.
Tip: You can also set this checkbox (and associate nets) using the 
Associate Nets popup command for selected nets. See Creating 
Associated Nets.
Clear the checkbox to disassociate any selected net that is part of an 
associated net. 
Clear both checkboxes to exclude the selected nets from inclusion in any 
associated net. 

Allow net 
association by 
component

Select the checkbox to allow the selected nets to be included in associated 
nets by:
• Specifying, in the Associated Nets dialog box, the refdes prefix of the 

nets’ , or
• Checking the Associate nets checkbox in the Component Properties 

dialog box.

Clear the checkbox to disable association by component (including by 
refdes prefix).
Tip: This checkbox is also cleared by the Disable Net Association popup 
command for selected nets.
Restriction: Nets that have the Associate net checkbox checked are not 
disabled from association by clearing this check box.

Clear both checkboxes to exclude the selected nets from inclusion in any 
associated net. 

Table 45-217. Net Properties Dialog Box Contents, Associated Nets (cont.)

Name Description
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Net Properties Dialog Box - Design Reuse

Tip: You can't rename and merge a net. For example, if you have GND in the physical design 
reuse and GND1 in the design, there is no available method to rename GND to GND1 and then 
merge. You must add GND and then manually merge the nets using ECO.

Accessing

• Select a reuse with nets > Right-click > Properties > Net Properties button

Figure 45-237. Net Properties - Design Reuse Dialog Box

Table 45-218. Net Properties - Design Reuse Dialog Box contents 

Name Description

Rename in Design 
(Private)

Lists nets in the physical design reuse to rename in the design. 
Nets are renamed using the Rename Preferences settings.
If nets exist that should remain intact, and not be merged with 
nets in the design, place them in this list. These nets are called 
private nets because they are internal to the reuse and are not 
connected to other nets in the design, nor do they have the 
same netname.
If you want the net to be merged with a net in the design, move 
it to the Add/Merge in Design (Public) list.

Add/Merge in Design 
(Public)

Lists nets in the physical design reuse to either add to the 
design (because the net doesn't exist in the design) or to merge 
with a net in the design (because the net does exist in the 
design). These nets are called public nets because they are used 
in both the physical design reuse and the design.
If you want the net to remain separate from the net in the 
design, move it to the Rename in Design list.
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Related Topics

Reusing Designs or Parts of Designs

Net Rules Dialog Box
Use the Net Rules dialog box to define design rules that apply to nets.

Accessing

• Setup menu > Design Rules > Net button

Net Append Options Indicates whether to rename a net using a prefix or a suffix. 
Affixes (prefixes and suffixes) can be up to four characters 
long. Illegal characters are brackets ({ }), asterisk (*), space, 
and period (.). You can, however, leave the box empty, and 
that is considered a valid entry.
The value you type here is checked against the design to ensure 
that duplicate netnames are not created. If duplicates occur, an 
error message appears and you can specify a different affix.
Tip: If you are not in ECO mode when you access this dialog 
box from the Reuse Properties dialog box, the Net Append 
Options are unavailable.

Arrow Buttons Move selected nets between the list boxes. Click the >>> 
button to move selected nets in the Rename in Design (Private) 
list into the Add/Merge in Design (Public) list. Click the <<< 
button to move selected nets in the Add/Merge in Design 
(Public) list into the Rename in Design (Private) list. This is 
useful if you specifically want a net to remain separate from a 
net that exists in the design.
When you access this dialog box from the Reuse Properties 
dialog box, these buttons are unavailable. This prevents you 
from modifying physical design reuse nets. You can however, 
change the suffix and prefix for netnames if you are in ECO 
mode.

Table 45-218. Net Properties - Design Reuse Dialog Box contents (cont.)

Name Description
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Net Rules Dialog Box

Figure 45-238. Net Rules Dialog Box

Related Topics

Creating Net Design Rules

Modifying Net Design Rules

Resetting Net Rules to Default Rules

Table 45-219. Net Rules Dialog Box 

Name Description

Nets list Lists all nets in the design.

Show Nets with rules Specifies to show only nets that have rules.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

HiSpeed Opens the HiSpeed Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule 
button

The picture below each type of rule button identifies which 
rules hierarchy level is used for that rule type. The meaning of 
the picture corresponds to the button in the Hierarchy area of 
the Rules dialog box. For example, if you select a class in the 
Class list and a green polygon appears below the Clearance 
button, then the default values apply to the class.
See also: Non-Default Rules Indicators

Selected Lists the net(s) selected in the Nets list.

Default Removes non-default rules from the selected nets, so that only 
default rules apply.
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Design Rule Hierarchy

Nudge Parts and Unions Dialog Box
Use the Nudge Parts and Unions dialog box to control the nudge process. 

Accessing

• Move a part or a union over another part or union. The dialog box opens.

Requirement: Automatic or Prompt mode must be set in the Nudge area of Tools > 
Options > Design page.

Figure 45-239. Nudge Parts and Union Dialog Box

Related Topics

To Nudge Overlapping Parts

Object Attributes Dialog Box
Use the resizable Object Attributes dialog box to add, modify, or remove attributes of single 
objects or multiple objects of the same type.

Table 45-220. Nudge Parts and Union Dialog Box 

Name Description

Direction Indicates the direction you want to nudge the overlapping part.

Run Performs a nudge.

Skip Does not perform a nudge on the selected part and continues to 
the next overlapping part.

Back Returns to the last skipped part.

Undo Returns parts to their original positions, prior to nudging.
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Object Attributes Dialog Box

Accessing

• Select object(s) > right-click > Attribute

Figure 45-240. Object Attributes Dialog Box

Related Topics

Working with Object Attributes

Table 45-221. Object Attributes Dialog Box 

Name Description

Group Filters the Attributes list. You can choose an attribute group to 
view.

Attributes for Specifies the attribute hierarchy level for which you want to 
assign an attribute. The hierarchy levels change, depending on 
the object you selected in step 1.

Attribute table Lists the attributes assigned to the object.

Edit Makes the selected cell available for editing.

Add Adds a row to the bottom of the list where you can select a new 
attribute for the object.

Delete Removes the selected attribute.
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ODB++ Export Dialog Box
Use the ODB++ Export dialog box to export a design to an ODB++ file.

Accessing

• PADS Layout File menu > Export > select ODB++ from Save as type: list

Figure 45-241. ODB++ Export Dialog Box

Table 45-222. ODB++ Export Dialog Box 

Name Description

Neutralize Nets Renames nets numerically.
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ODB++ Export Dialog Box

Prefer closed shapes Specify how to determine component outlines:
• Select to search for a closed shape to use as the component 

outline, beginning with the layer specified in the 
Component Outline Layer setting. If none is found on the 
Component Outline Layer, it then proceeds to layer 20, 
then layer 0 (all layers), then layer 1 (mounted side). If no 
closed shape is found, it creates a bounding box of all 
shapes found.

• Clear this check box to just create a bounding box of all 
shapes that are found.

Unhatched copper pours Specify what to do with unhatched copper pours and plane 
areas:
• Fill—Flood all copper pours and plane areas before 

translating.
• Discard—Discard unhatched copper pours and plane 

areas.

Non Shape Pins Specify what to do with pins for which no outline is supplied 
or when you do not want to use the supplied pin shape.
• Discard—Do not translate these pins.
• Add empty—Translate these pins as-is (with no outline 

information).
• Use Drill—Use the drill shape as the pin shape.
• Use Stack—Use the pad stack shape as the pin shape.

Specify what to do with pins regardless of whether an outline 
is supplied:
• Force Drill—Use the drill shape instead of the pin shape.
• Force Stack—Use the padstack shape instead of the pin 

shape.
• Force Piece—If the part definition contains pin outlines 

supplied as “pieces”, use these instead of the pin shape.

Component Outline 
Layer

Specify the preferred component outline layer.

Export action Choose an export action:
• Export only—creates the .tgz file that you specified.
• View generated ODB++—creates the .tgz file that you 

specified and loads your ODB++ data into the CAM 
Compare software to view the data.

• Perform CAM Compare—creates the .tgz file that you 
specified and loads both the ODB++ data and your CAM 
documents into the CAM Compare software to allow you 
to compare them.

Tip: When the CAM Compare software is active, press F1 to 
open the CAM Compare help documentation.

Table 45-222. ODB++ Export Dialog Box (cont.)

Name Description
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Related Topics

Exporting ODB++ Files

Options Dialog Box, Design Page
Use the Design page to specify place and route options.

Accessing

• Tools menu > Options > Design

Location of CAM file Specify the location of the CAM documents to use when 
comparing with the ODB++ data.
Restriction: This is only available when you select Perform 
CAM Compare as the Export action.

Table 45-222. ODB++ Export Dialog Box (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41298

Options Dialog Box, Design Page

Figure 45-242. Design Page

Table 45-223. Design Page Contents 

Name Description

Stretch traces during 
component move

Specifies whether to reroute traces, or create an unroute, 
for nets connected to the moved, or pin-swapped part. 
• Select the check box to create new routes between 

tacks at the old pin positions and the new pin positions 
after you complete the move. 

• Clear the check box to create an unroute connection 
after swapping pins or moving a part.

See also: With Stretch Traces During Component Move 
in the Concepts Guide
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Move preference area Specifies which, of various locations on the part being 
moved, should attach to the pointer:
• Move by origin—Pointer attaches to the part origin.
• Move by cursor location—Pointer attaches to the part 

from its current location.
Example: If you start the Move operation with the 
pointer at X=200,Y=500 and the selected part at 
X=0,Y=0, move the pointer to X=1200,Y=1500, the 
part moves to X=1000,Y=1000.

• Move by midpoint—Pointer attaches to the center of 
a rectangle enclosing the part.

Tip: While you are moving the part, you can modify the 
pointer attachment location from the following shortcut 
menus:
• Move in the Layout Editor
• Move Sequential in the Layout Editor
• Move Terminal in the PCB Decal Editor
• Radial Move in the Layout Editor and the PCB Decal 

Editor

Nudge area Specifies how to use nudge to prevent parts from 
overlapping when you finish moving the part or using the 
Tools > Nudge Component command.
• Automatic—Nudge automatically moves apart 

overlapping parts when you finish moving the part.
• Prompt—Opens the Nudge Parts and Unions dialog 

box for each overlapping part when you finish moving 
the parts, enabling you to control the nudge operation.

• Nudge Off—Disables nudge.

Length minimize area Specifies when to recalculate, or minimize, unrouted net 
lengths when moving parts.
• During Move—Recalculate length of unrouted pin 

pairs as you move a part. The closest viable 
connections are displayed in progress.

• After Move—Recalculate length of unrouted pin pairs 
when you finish a move. This option consumes less 
display memory.

• Off—Do not recalculate length of unrouted pin pairs.
Tip: To specify the topology type (which determines 
length recalculation behavior) per net, per class, and so on, 
use the Routing Rules dialog box.

Table 45-223. Design Page Contents (cont.)

Name Description
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Options Dialog Box, Design Page

Group editing area Specifies selection and editing options for multiple object 
operations.
• Keep signal and part names—Maintains signal and 

part names when you insert data using Edit/Paste.
• Include traces not attached—Selects all traces 

passing through the selection rectangle, even if they do 
not connect to any parts within the selection rectangle.

• Keep stitching vias—Prevents the deletion of 
stitching vias, or free vias.
Tip: This option distinguishes between stitching vias 
and regular routing vias. When this check box is 
selected, stitching vias are preserved during the 
following operations:
• ECO delete connection, delete component, 

swapping a pin, swapping all pins, change 
component

• Unroute
For operations related to ECO, this option is respected 
whether they are performed interactively or by an ECO 
import operation. In general, this option is respected 
by any ECO operation that deletes traces and vias.
When the this check box is cleared, stitching vias may 
be deleted during the operations listed above.

Line/trace angle area Specifies angle options when adding or moving a line or 
trace (corner, or pad entry/exit).
• Diagonal—Angle must be 45 degrees or a multiple of 

45 degrees.
• Orthogonal—Angle must be 90 degrees or a multiple 

of 90 degrees.
• Any Angle—No angle restriction.

Table 45-223. Design Page Contents (cont.)

Name Description
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Miters area • Diagonal Miter—Create miters as lines at 45-degree 
angles.

• Arc—Create miters as arcs.
• Auto miter check box—Creates miters automatically 

while adding drafting objects.
• Ratio—Specifies the size of a diagonal miter or the 

radius of an arc miter.
Tips:
• For diagonal miters, the distance from the virtual 

corner to either of the breakpoints is created by the 
Ratio multiplied by the line width. For example, a 
10-mil trace and a ratio of 5 produces a 45-degree 
angle 50 mils apart from the virtual corner. For 
angles less than 90 degrees, the distance becomes 
longer. For angles greater than 90 degrees, the 
distance becomes shorter.

• For arc miters, the radius is set to the ratio 
multiplied by the trace width. For example, a ratio 
of one sets the arc radius equal to the trace width. 
Also, a 10-mil trace and a ratio of 5 produces a 
radius of 50 mils.

• Angle—Specifies the maximum corner at which 
miters are created.

On-line DRC area Specifies the response to design rule errors.
• Prevent Errors—Prevents you from violating design 

rules.
• Warn Errors—Prompts you with a warning when 

you try to violate the design rules, but does not prevent 
you from placing the part.

• Ignore Clearance—Ignores clearance design rules.
Tip: Allows parts to touch but not overlap each other.

• Off—Disables design rule checking. You violate 
design rules.
Tip: If you use the Layout Editor without Design Rule 
Checking (DRC) enabled, use Verify the Design to 
check the design in progress for clearance violations.

See also: Design Rule Checking in the Concepts Guide

Table 45-223. Design Page Contents (cont.)

Name Description
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Options Dialog Box, Die Component Page

Options Dialog Box, Die Component Page
Use the Die Component page to specify die part creation and modifying options.

Restriction: This information applies to only the BGA toolkit.

Accessing

• Tools menu > Options > Die Component

Drill oversize Type a value to globally apply an oversize to plated holes 
for design rule checking. The oversize accounts for drill 
oversizing during the PCB fabrication process.
Restrictions: 
• This value only applies to design rule checking and 

does not apply to the Drill Drawing table, or NC Drill 
outputs. 

• Your PCB fabricator normally oversizes plated holes 
to match the drill size that you specify in the pad 
stacks.

• This value is ignored if Single-sided board is selected 
on the Layers Setup dialog box.

Tip: The oversize is measured from the center of the pad, 
not the perimeter. For example, a 3 mil oversize represents 
1.5 mils in all directions from the center of the pad.
For more information, see the Drill Size and Plated 
settings in the Pad Stacks Properties Dialog Box.

Table 45-223. Design Page Contents (cont.)

Name Description
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Figure 45-243. Die Component Page

Table 45-224.  Die Component Page Contents 

Name Description

Create die data on layers 
area

Specifies on which layers to create new die decal items, 
which are represented as decal drawings. Choose the layer 
for the die outline and pads, the wire bonds, and the 
substrate bond pad guides.

Wire bond editor area

Snap SBP to Guide Enables snap-to-guide mode when moving substrate bond 
pads.

Snap threshold Specifies the distance in current design units at which a 
moved substrate bond pad snaps to the nearest substrate 
bond pad guide.



PADS Layout User’s Guide and Reference Manual, PADS 9.41304

Options Dialog Box, Dimensioning /Alignment and Arrows Page

Related Topics

To Move a Die Component Substrate Bond Pad

To Add Substrate Bond Pads

To Spin a Substrate Bond Pad

To Add a Fanout

To Add Wire Bonds

Options Dialog Box, Dimensioning /Alignment 
and Arrows Page

Use the Dimensioning / Alignment and Arrows page to specify the appearance of dimensioning 
alignment tools and arrows. Options on this page affect the appearance of text, lines, and so on, 
used to show clearances.

Accessing

• Tools menu > Options > Dimensioning / Alignment and Arrows 

Keep SBP focus Automatically rotates the substrate bond pad to match the 
direction of the wire bond.

Show SBP clearance Displays the clearance outline when you move, add, or 
spin substrate bond pads, or when you add fanouts.

Show wire bond length 
angle

Displays the wire bond length and angle when you move, 
add, or spin substrate bond pads, or when you add fanouts 
or wire bonds.

Table 45-224.  Die Component Page Contents (cont.)

Name Description
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Figure 45-244. Dimensioning / Alignment and Arrows page

Table 45-225.  Alignment and Arrow page Contents 

Name Description

Preview type Specifies the way the image is shown in the Preview area. 
You have the choice of:
• Horizontal
• Vertical
• Aligned
• Angular
• Circular

Alignment tool area
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Options Dialog Box, Dimensioning / General Page

Options Dialog Box, Dimensioning / General 
Page

Use the Dimensioning / General page to specify the layers used to display dimensioning text 
and lines, the appearance of extension lines, and how to measure circles. Options on this page 
affect the appearance of text, lines, and so on, used to show clearances.

Accessing

• Tools menu > Options > Dimensioning / General

Specifies the shape of the dimensioning alignment tool 
appears on the screen. Choose any combination of these 
shapes.

Size Specifies the alignment tool shape length or diameter.

Line Width Specifies the alignment tool line width.

Arrows area

Specifies how dimensioning arrows appear on the screen.
Tip: The right-most shape represents datum lines. With 
datum lines, no arrows are drawn and the dimensions are 
placed above the extension line. Datum lines are created 
when using Baseline Dimensioning. 

Arrow Length Specifies the distance between the arrow tip and the end of 
the arrowhead.
Restriction: Unavailable for Datum Lines.

Arrow Size Specifies the width of the arrowhead.
Restriction: Unavailable for Datum Lines.

Tail Length Specifies the minimum length of the arrow tail.
Restriction: Unavailable for Datum Lines.

Line Width Specifies the width of the tail and arrow lines.
Restriction: Unavailable for Datum Lines.

Text Gap Specifies the distance between the tail, which is the line 
extending behind the arrowhead, and the measurement 
text.
Restriction: Unavailable for Datum Lines.

Table 45-225.  Alignment and Arrow page Contents (cont.)

Name Description
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Figure 45-245. Dimensioning / General page

Table 45-226.  Dimensioning / General page contents 

Name Description

Preview type Specifies the way the image is shown in the Preview area. 
You have the choice of:
• Horizontal
• Vertical
• Aligned
• Angular
• Circular
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Options Dialog Box, Dimensioning / Text Page

Options Dialog Box, Dimensioning / Text Page
Use the Dimensioning / Text page to specify the appearance of dimensioning text used to show 
clearances. 

Accessing

• Tools menu > Options > Dimensioning / Text

Layers area Specifies the layers to use for dimensioning text and lines.
Tips:
• Dimensioning items ignore the current layer set in the 

Layer list on the main toolbar, so you must specify 
layers here. 

• Use the Dimension Properties dialog box to reset the 
layer for a selected dimension object or any of its 
dimension elements.

• Items placed on layer 0 appear on all layers.

Extension lines area

Draw 1st Specifies that you want to display an extension line for the 
first point you select.

Draw 2nd Specifies that you want to display an extension line for the 
second point you select.

Pick gap Specifies the distance between the selection point and the 
tip of the extension line.
Tip: All numerical values are in current design units.

Arrow offset Specifies the overhang of the extension line beyond the 
arrowhead.
Tip: All numerical values are in current design units.

Width Specifies the width of the extension line.
Tip: All numerical values are in current design units.

Circle dimension area Specifies the circle measurement method you want.

Table 45-226.  Dimensioning / General page contents (cont.)

Name Description
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Figure 45-246. Dimensioning / Text page

Table 45-227. Dimensioning / Text page contents 

Name Description

Preview type Specifies the way the image is shown in the Preview area. 
You have the following choices:
• Horizontal
• Vertical
• Aligned
• Angular
• Circular

Setting parameters area

Height Specifies the height of text characters.

Line Width Specifies the width of one character.
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Options Dialog Box, Display Page

Options Dialog Box, Display Page
Use the Display page to set the text size of displayed net names and pin numbers, and the 
maximum allowable gap between net names on traces.

Accessing

• Tools menu > Options > Display

Suffix Specifies the suffix characters that follow the 
dimensioning measurement.

Precision area

Linear Specifies linear measurement precision: type the number 
of decimal places, in current design units.

Angular Specifies angular measurement precision: type the number 
of decimal places, in degrees.

Default orientation area Specifies how you want to orient the dimensioning text 
relative to the screen or to the dimensioning arrows.
• Horizontal—Orient text horizontally on the screen, 

regardless of the arrow angle.
• Vertical—Orient text vertically on the screen, 

regardless of the arrow angle.
• Same As Arrows—Orient text parallel to the arrows.

Default position area Specifies to position text outside the extension lines, or 
inside the extension lines if possible.

Displacement area

Manual Position Specifies to position text manually, by attaching the text to 
the pointer when you add the dimension.

Omit Text Specifies to create dimensioning lines and arrows without 
displaying dimensioning text.

Displacement Specifies to position text relative to the arrow axis. You 
have the following choices: 
• Above—Position text above the arrow axis.
• Centered—Position text on the arrow axis.
• Below—Position text below the arrow axis.
• Custom—Position text at the position you specify.

Tip: Zero centers the text, positive numbers place the 
text above the arrow, and negative numbers place the 
text below the arrow. 

Table 45-227. Dimensioning / Text page contents (cont.)

Name Description
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Figure 45-247. Display page

Table 45-228. Display Page Contents

Name Description

Minimum Specifies the minimum size of displayed net names and pin 
numbers, in pixels.

Maximum Specifies the maximum size of displayed net names and pin 
numbers, in pixels.

Maximum gap between 
net names on traces, 
pixels

Specifies the maximum allowable gap between displayed net 
names in traces, in pixels.
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Options Dialog Box, Drafting / Hatch and Flood Page

Tip: The display of net names is controlled by the Net Name column check box, by the color 
tiles on each layer, and the Show net names on Traces, Vias, Pins check boxes in the Display 
Colors Setup Dialog Box. 

Options Dialog Box, Drafting / Hatch and Flood 
Page

Use the Drafting / Hatch and Flood page to view and edit options for copper shapes.

Accessing

• Tools menu > Options > Drafting / Hatch and Flood

Figure 45-248. Drafting / Hatch and Flood page



Options Dialog Box, Drafting / Text and Lines Page

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1313

Options Dialog Box, Drafting / Text and Lines 
Page

Use the Drafting / Text and Lines page to view and edit options for drafting objects.

Table 45-229. Drafting / Hatch and Flood page contents 

Name Description

Hatch View area Specifies the display of the hatching. Choose from:
• Normal—Display hatching
• No Hatch—Remove hatching
• See Through—Display hatching with non-

intersecting lines

Hatch Direction area Specifies the hatch orientation in the workspace. Choose 
from:
• Orthogonal—Hatching consists of diagonal lines
• Diagonal—Hatching consists of vertical and 

horizontal lines
Reverse for keepout check box—Distinguishes keepout 
hatching from all other hatching by reversing the 
orientation. 
Example: If this option is enabled and the hatch 
orientation is Orthogonal, hatching for keepout areas is 
diagonal.

Autohatch on file load Specifies to hatch the copper pours and plane areas when 
you load the file.

Flood area

Min. hatch area Specifies the smallest island area created by flooding in 
squared current design units.
Example: If you do not want to display islands smaller 
than four square design units, type 4 into the box.

Smoothing radius Specifies the radius of copper pour corners in current 
design units

Display mode area • Hatch Outline—Display the copper pour outline and 
hatching

• Pour Outline—Display the copper pour outline with 
no hatching

Tip: If you attempt to flood a copper pour area with a 
Hatch outline, you are warned, “To generate new thermals 
turn off hatch display prior to flooding.” You must change 
the outline to a Pour outline before flooding.
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Options Dialog Box, Drafting / Text and Lines Page

Accessing

• Tools menu > Options > Drafting / Text and Lines

Figure 45-249. Drafting / Text and Lines page

Table 45-230. Drafting / Text and Lines page contents 

Name Description

Default width Specifies the default width to use when adding drafting 
objects.
Tips: 
• To change the width of an existing shape, select the 

shape, right-click, and click Properties.
• To search for and change all shapes of a similar width, 

on the Edit menu, click Find. 
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Prompt for net name at 
completion of copper

Specifies whether you are prompted to assign a net to the 
new copper. 
When you complete drafting a copper shape, the Add 
Drafting dialog box opens automatically. Assign the net to 
the copper by using the Net assignment list to select the 
net from a list, or by using the Assign Net by Click button 
to click on an object in the design with the net name you 
want to assign. 

Board component height 
restriction area

Specifies the height restriction in current design units for 
the top and bottom side layers.
Sets the maximum height for all design components that 
use the Geometry.Height attribute. See also: Restricting 
Heights on Component Layers.
Tips:
• You can set height restrictions for individual 

components by creating a Component keepout with a 
height restriction. See also: Restricting Heights in 
Areas of Component Layers.

• Use On-line DRC to prevent placement of components 
that exceed height restrictions. Use Verify the Design 
to check for violations after placement.

• See also: Attribute Dictionary in the Concepts Guide

Default font area Specifies the default font and style for all newly created 
text strings and labels.
Select <PADS Stroke Font> to use the default stroke font 
installed on your system or choose a font name from the 
list of fonts installed on your system.
Restriction: Type 1 fonts are not supported.
Tips: 
• The font in use is highlighted at the top of the list.
• The fonts listed above the horizontal line are used in 

the design.
• If you select a system font, you can also click one or 

more buttons to specify a font style: B for bold, I for 
italic, or U for underlined.

Table 45-230. Drafting / Text and Lines page contents (cont.)

Name Description
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Options Dialog Box, Drafting / Text and Lines Page

Text area Specify text options for design drafting text.
• Line width—Specifies the text line width in current 

design units.

• Size—Specifies the text height in current design units.

Table 45-230. Drafting / Text and Lines page contents (cont.)

Name Description
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Options Dialog Box, Global / Backups Page
Use the Global / Backups page to specify design data backup options.

Accessing

• Tools menu > Options > Global / Backups

Reference designators Specifies the default width and height for reference 
designator labels, pin numbers, and pin names. The 
PCB Decal Editor Add New Decal Label dialog box and 
the Layout Editor Add New Part Label dialog box use the 
default width value set on this tab.
• Line width—Specifies the reference designator line 

width in current design units.
Restriction: Reference designator width is stored in 
the library, but the pin number is not.

• Size—Specifies the reference designator height in 
current design units.

Tip: If you modify the default width and height, the 
physical appearance of existing pin numbers updates to 
the new values, but the physical appearance of existing 
labels does not change. To change the label, select the 
label, right-click, and click Properties.

Table 45-230. Drafting / Text and Lines page contents (cont.)

Name Description
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Options Dialog Box, Global / Backups Page

Figure 45-250. Global / Backups page

Table 45-231. Global / Backups page Contents 

Name Description

Automatic backups area

Interval (minutes) Specifies the time in minutes between backups.

Number of backups Specifies the quantity (1-9) of different backup files to 
create.
Tip: Backup files are named <design_name>.#, where # is 
a sequential number. For example, Layout1.pcb, 
Layout2.pcb, and so on.

Backup file Opens the Backup File dialog box where you can change 
to folder or name of the backup file.
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Options Dialog Box, Global / File Locations Page
Use the Global / File Locations page to specify default design location options.

Accessing

• Tools menu > Options > Global / File Locations

Figure 45-251. Global / File Locations page

Use design name in backup 
file name

Specifies to use the design name in your backup file name. 
Click to clear if you want to use Layout as the file name.

Create backup files in 
design directory

Specifies to place all of your backup files in the same 
directory as the design. Click to clear if you want your 
backup files in one, common backup directory.

Table 45-231. Global / Backups page Contents (cont.)

Name Description
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Options Dialog Box, Global / General Page

Options Dialog Box, Global / General Page
Use the Global / General page to specify various workspace and design unit options.

Accessing

• Tools menu > Options > Global / General

Figure 45-252. Global / General Page

Table 45-232. Global / File Locations page contents 

Name Description

File Type Specifies the type of file for which to set the location.

Location Specifies the location of the corresponding file type.
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Table 45-233. Global / General Page Contents 

Name Description

Cursor area

Style Specifies the pointer shape. Choose from:
• Normal—Arrow
• Small cross—Small plus sign +
• Large cross—Large plus sign +
• Full screen—Full screen crosshair

Pick radius Specifies the selection accuracy - the maximum distance 
in pixels that the pointer can be from an object and still 
select it. 
Tip: Larger values mean the pointer can select objects 
further away, but this can cause you to select incorrect 
objects.

Diagonal Specifies to rotate the pointer shape diagonally, so that it 
resembles an x instead of a plus sign +.
Tip: This option is unavailable for the Normal pointer 
shape.

Disable double click Specifies to disable double-click operations, such as 
adding vias, opening the Properties of objects, or 
completing a drafting object polygon.

Drag moves area Specifies the behavior when you try to drag objects with 
the pointer. 
• Drag and Attach—Attaches the object to the pointer 

when you click it and begin to drag it. While the object 
is attached to the pointer, release the left button and 
move the object to the new location. Click to finish the 
move. After placement the object remains selected.

• Drag and Drop—Same as Drag and Attach, but the 
move is finished when you release the left button.

• No Drag Moves—Prohibits drag type moves.
Tips:

• Because it is possible to accidentally start a move 
sequence when performing an area select, enable No 
Drag Moves to make area selection in dense areas of 
the design.

• When No Drag Move is enabled, you can move the 
selected object by right-clicking, click Move, move 
the object to the new location, and click to finish the 
move.

Drawing area
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Keep same view on window 
resize

Specifies to maintain the area view of the design when 
you resize the PADS Layout window, by automatically 
zooming in or out.

Active layer comes to front Specifies to display the active layer on top of all other 
layers.
Tip: Specify the active layer in the Layers list on the main 
toolbar.

Minimum display width Specifies the minimum width in current design units of 
lines you want to draw at actual width. Lines smaller than 
this width are drawn only as center lines to save memory 
and redraw time.
Tips:
• Set this value to zero to display all lines at actual 

width.
• Set this to a value larger than the trace width. This 

displays traces as center lines and makes selecting 
small trace segments easier. Use this in combination 
with a reduced Pick radius value for optimal results.

OLE Document Server area

Display OLE objects Specifies to display linked or embedded objects inserted 
in PADS Layout.
Tip: You may want to disable this option to decrease 
redraw times when PADS Layout contains many linked or 
embedded objects.

Update on redraw Specifies to update the linked or embedded object in the 
container application.
Restriction: This option applies only when you are 
modifying the PADS Layout object in a separate window 
and you click the Redraw button in the separate window.
Tip: To increase performance, disable this option.

Draw background Specifies to draw the PADS Layout background color in 
the linked or embedded object.
When this option is disabled, the background of the PADS 
Layout object is transparent and you can see through the 
object at the container application's background.

Table 45-233. Global / General Page Contents (cont.)

Name Description
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Options Dialog Box, Global / Synchronization 
Page

Use the Global / Synchronization page to specify the PADS Layout and PADS Router 
syncronization options

Accessing

• Tools menu > Options > Global / Synchronization

Text encoding area Specifies the language you want.
Text encoding determines how text characters are 
interpreted. Each character in any text string has a unique 
digital signature. Within each system font are graphics 
(for instance, an image of the letter A) associated with 
each digital signature. Most system fonts have multiple 
images for the same character in order to accommodate 
regional differences in font styles. 
Tip: Changing the text encoding option may result in 
blank spaces or non-printing characters.
Example: When you load a design created in Japan with 
Japanese text encoding on an American system, the file 
may have text encoding set to Japanese. If you change it 
from Japanese to English, Japanese kanji characters may 
be interpreted (and displayed) as non-printing characters.
Restriction: The default text encoding cannot be changed. 
It is automatically set by the Regional and Language 
settings of the operating system.

Design units area Specifies the design measurement units.
• Mils— 1/1000 of an inch, accurate to 2 places after the 

decimal
• Metric— 1mm (1/1000 of a meter), accurate to 5 

places after the decimal
• Inches— accurate to 5 places after the decimal

Designs typically contain a mixture of metric and English 
(imperial/inch) components. And depending on the ratio 
of components in your design, you may want to use one 
measurement instead of the other. You can also switch 
design units as often as you like. This is done smoothly 
and efficiently since the accuracy of each unit of measure 
is the same.

Table 45-233. Global / General Page Contents (cont.)

Name Description
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Options Dialog Box, Global / Synchronization Page

Figure 45-253. Global / Synchronization page

Table 45-234. Global /Synchronization page contents 

Name Description

Layout and Router Synchronization area
See also: Synchronization Mode

Enable Specifies to turn Layout and Router Synchronization 
mode on. Click to clear to turn Synchronization mode off.
Warning: You must restart Layout for the change in 
Synchronization mode to take effect.
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Options Dialog Box, Grids Page
Use the Grids page to specify grid options.

Accessing

• Tools menu > Options > Grids

Restore DRC mode on 
return

Specifies, if you return to PADS Layout from PADS 
Router after switching, to change the DRC mode back to 
what you had before you switched: DRC Prevent, Warn, 
or Ignore.
Tips: 
• Switching to PADS Router automatically places your 

design in PADS Layout in DRC Off mode; the DRC 
mode in PADS Router is not affected.

• Depending on the size of your design, restoring the 
DRC mode may take a few minutes; therefore, it is 
recommended to not restore your DRC mode upon 
return.

Warn about switching to 
DRC Off mode

Specifies to show a warning to remind you that 
Synchronization mode puts PADS Layout into DRC Off 
mode.

Table 45-234. Global /Synchronization page contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41326

Options Dialog Box, Grids Page

Figure 45-254. Grids page
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Table 45-235.  Grids page contents 

Name Description

Design grid area Establishes the minimum snap distance for the pointer 
when editing (placing objects, drawing/editing drafting 
objects).
• X—Specifies the distance between grid lines on the X 

axis in current design units.
• Y—Specifies the distance between grid lines on the Y 

axis in current design units.
• Snap to grid—Specifies to snap objects from grid 

point to grid point, instead of freely and smoothly as 
you move or place the object.
Tip: If the Snap to Grid check box is selected, you 
cannot place a part off the grid.

See also: To Set the Design Grid

Via grid area Establishes the minimum distance between vias.
• X—Specifies the distance between grid lines on the X 

axis in current design units.
• Y—Specifies the distance between grid lines on the Y 

axis in current design units.
• Snap to grid—Specifies to snap objects from grid 

point to grid point, instead of freely and smoothly as 
you move or place the object.
Tip: If the Snap to Grid check box is selected, you 
cannot place a via off the grid.

Fanout grid area Controls the placement of substrate bond pads on a die 
and the placement of fanout vias.
Tip: This data is passed to PADS Router.
• X—Specifies the distance between grid lines on the X 

axis in current design units.
• Y—Specifies the distance between grid lines on the Y 

axis in current design units.
• Snap to grid—Specifies to snap objects from grid 

point to grid point, instead of freely and smoothly as 
you move or place the object.

Snap to test point grid Enable snap to test point grid in PADS Router.
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Options Dialog Box, Routing / General Page
Use the Routing / General page to specify routing options.

Accessing

• Tools menu > Options > Routing / General

Display grid area Specifies the visible dot grid.
• X—Specifies the distance between grid lines on the X 

axis in current design units.
• Y—Specifies the distance between grid lines on the Y 

axis in current design units.
Tip: If you want to make the dot grid invisible, set the X 
and Y values to 0.
See also: To Set the Display Grid

Hatch grid area Specifies the distance between hatch lines of copper and 
keepout areas.
• X—Specifies the distance between grid lines on the X 

axis in current design units.
• Y—Specifies the distance between grid lines on the Y 

axis in current design units.
Tip: Copper, copper pour, and plane areas are filled with 
lines on the hatch grid. When the Drafting option Default 
width matches the Copper hatch grid, the result is a solid. 
When the default width less than the grid value, the result 
is a hatch pattern.

Radial Move Setup Opens the Radial Move Setup dialog box to specify the 
polar grid for radial moves. See also: To Set Up a Polar 
Grid.

Table 45-235.  Grids page contents (cont.)

Name Description
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Figure 45-255. Routing / General Page

Table 45-236.  Routing / General page contents 

Name Description

Options area

Generate teardrops Specifies to automatically create teardrops to existing and 
new trace segments that enter or exit a pad or via.

Show guard band If On-line DRC is set to prevent, specifies to display an 
octagon shape at the tip of the current route to illustrate a 
clearance violation.

Highlight current net When you start routing the selected pin pair, specifies to 
highlight the net with a complementary color.
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Show drill holes Specifies to display the inside diameter of all pads. The 
modeless command “DO” toggles this setting. The drill 
hole is given a complementary color.

Show tacks Specifies to display tacks on routes.
Tip: If displayed tacks hinder routing or viewing the 
design, disable this option.

Show protection Specifies to display protected routes as outlines when 
Outline View mode is off, and as normal traces when 
Outline View mode is on.
In the image below, the left-most trace is protected and the 
other traces are not protected. 

Show test points Specifies to display test points.
Tip: When the via or pin is flagged as a test point, an 
arrow is drawn on it in the design:

Lock test points Specifies to prevent moving test points when moving 
components.
Locked test points are not deleted when you do any of the 
following:
• Unroute pin pairs or nets
• Delete trace segments, vias, or jumpers
• Change the layer for a segment

Table 45-236.  Routing / General page contents (cont.)

Name Description
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Show trace length Specifies to display the trace length monitor at the pointer. 
The status bar always reports trace length.
Tips: 
• You can also use the modeless command Ctrl+PageUp 

to toggle the display the trace length monitor.
• Displaying or hiding the trace length monitor with the 

modeless command does not end the current routing 
command, so you can continue to route.

Auto protect traces Specifies to protect traces from smoothing, stretching, 
moving, shoving, or ripup operations.
Tip: This option affects manual routing (Route or Add 
Route command) and dynamic routing.

Any angle pad entry Specifies to allow traces to enter or exit a pad at any angle, 
despite the current Line/trace angle setting on the Design 
options tab.

Layer pair area Specifies the pair of layers to use for routing when 
manually adding vias.
See also: Using the Layer Pair, To Change the Layer 
While Routing
Tips: 
• When you add a via while manually routing, the layer 

automatically switches to the other layer in the layer 
pair.

• If you specify the layer pair as the two layers on which 
you expect to do most of your routing, you can reduce 
the number of times you manually specify layers when 
adding a via.

• If the current layer is not in the layer pair when adding 
a via, the layer automatically switches to the layer 
specified in the First list.

Unrouted path double 
click area

Specifies a routing operation to start when you double-
click unroutes.
• Dynamic Route—Start a dynamic route
• Add Route—Start a manual route

Restriction: These options are unavailable unless On-line 
DRC is set to Prevent Errors in the Design options (or 
using the “DRP” modeless command.

Smoothing control area

Smooth bus route traces Specifies to run smoothing after bus routing.
Tip: This option affects only the Bus Route command, 
and it inhibits the global smoothing pass for all traces of 
the current bus.

Table 45-236.  Routing / General page contents (cont.)

Name Description
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Options Dialog Box, Routing / Teardrops Page
Use the Routing / Teardrops tab to specify the display and physical appearance of teardrops. 
Use the Routing / General page to enable teardrops.

Accessing

• Tools menu > Options > Routing / Teardrops

Smooth pad entry/exit Specifies to have traces that enter a pad at a 90-degree 
angle converted to a 45-degree angle during a trace 
segment smoothing operation.

Centering area Maximum channel width—Limits the number of channels 
in which traces are automatically centered by specifying a 
maximum channel width. Traces in channels larger than 
this width are not eligible for centering.
Tip: This option is used only by PADS Router.

Table 45-236.  Routing / General page contents (cont.)

Name Description
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Figure 45-256. Routing / Teardrops page

Table 45-237. Routing / Teardrops page contents 

Name Description

Parameters area
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Display teardrops Specifies whether to display teardrops. Hiding the teardrops 
could reduce the redraw time. Although you hide the teardrops 
in the design, they will be visible in CAM output.
Tip: You create the teardrops using the Generate teardrops 
check box on the Routing / General page. 
Warnings:
• If you clear this checkbox and hide the teardrops, you will 

not be able to verify any clearance errors created by the 
teardrops. Clearance checking only checks objects that are 
displayed.

• If you flood an area while hiding the teardrops, the flood 
procedure will not account for the teardrops. If you don’t 
flood the shape again prior to generating your CAM 
documents, you will create a CAM document without 
enough clearance around all the teardrops.

Auto adjust Specifies to have PADS Layout attempt to adjust the length of 
teardrops on traces where the trace corner is inside the pad or 
via, or where the segment is too short to contain the specified 
length ratio.
Restriction: You can specify teardrop length and width ratios 
only if you select the Line or Curved teardrop shape.

Opens the Check Teardrop dialog box where you can check the 
design for teardrop errors and report them.
Restriction: The Check button is unavailable unless the 
Generate teardrops check box on the Routing tab is selected.

Shape area

Specifies the detailed physical appearance of teardrops. The 
Preview area shows the current teardrop shape.
• Default—Standard shape.

Restriction: You cannot set the length or width ratio for 
the Default shape.

• Line—Outer teardrop edges are straight.
• Curved—Outer teardrop edges are curved.

Tip: If the board has high-frequency analog circuits or very 
dense connections, you may want to specify either the Line or 
Curved shape.

Table 45-237. Routing / Teardrops page contents (cont.)

Name Description
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Options Dialog Box, Routing / Tune/Diff Pairs 
Page

Use the Routing / Tune/Diff Pairs page to specify options for using accordions in routing to 
length constraints and tuning differential pairs.

Restriction: While you can define these options in either PADS Layout or PADS Router, the 
settings are only used in PADS Router.

Use routing to length constraints to adjust the length of length-controlled traces. This feature 
automatically maintains length-based design rules for nets, classes, pin pairs, groups, and 
differential pairs during autorouting. These settings use the tune pass to adjust or rip up traces 
based on their compliance with minimum and maximum trace length rules. The pass increases 
net and pin pair lengths to satisfy length rules by introducing accordion patterns to the trace.

Tip: You can set length rules in Class, Net, Pin Pair, Differential Pair, and (PADS Router only) 
Matched Length Properties dialog boxes. 

Accessing

• Tools menu > Options > Routing / Tune/Diff Pairs 

Length ratio Specifies the length ratio in percent of pad diameter. 
Restrictions:
• You cannot set a ratio over 1000.
• Not available for the Default shape.

Tip: This option sets the length of the teardrop relative to the 
attached pad. The formula used to calculate the teardrop length 
follows:

teardrop length = (pad diameter) * (length 
ratio in %)

Example: If the length ratio is 200 (200% of the pad diameter) 
and the pad diameter is 60 mils, then the length of the teardrop 
is 120 mils.

Width ratio Specifies the width ratio in percent of pad diameter. 
Restrictions:
• You cannot set a ratio over 100.
• Not available for the Default shape.

Tip: This option sets the width of the teardrop relative to the 
attached pad.

Table 45-237. Routing / Teardrops page contents (cont.)

Name Description
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Options Dialog Box, Routing / Tune/Diff Pairs Page

Figure 45-257. Routing / Tune/Diff Pairs page

Table 45-238. Tune/Diff Pairs page contents 

Name Description

Accordion area

Minimum amplitude Specifies the minimum height (for horizontal accordions) or 
width (for vertical accordions).

Maximum amplitude Specifies the maximum height (for horizontal accordions) or 
width (for vertical accordions).
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Options Dialog Box, Split/Mixed Plane Page
Use the Split/Mixed page to specify options for split and mixed planes. Split/mixed planes use 
the same global thermal attributes as copper pours, but in addition they use custom thermals 
from the pad stacks. All split/mixed plane options are stored in the design file.

Minimum gap Specifies the edge to edge distance between accordions.

The gap is equal to the value of the parameter times the trace-
to-corner clearance. However, if the trace to corner clearance 
equals 0, then the gap is equal to the trace width times the 
value of the gap parameter.

Max hierarchy level Specifies how many steps are used to create the accordion. 
See also: Maximum Hierarchy Level

Max ratio Specifies the miter ratio for accordion corners.

Use arcs in miters Specifies to use an arc instead of a diagonal segment in the 
accordion.

Extra length added 
above required by 
matched length 
tolerance, percent

Specifies how much extra length is added above the required 
matched length group tolerance (in percent of the tolerance).
Example: If you type 0, the tuned net will be <Leader length - 
tolerance> length. If you type 100, the net will get the same 
length as the group leader. The leader net is the net in the 
matched length group that has the longest length.

Ignore length rules when 
required to complete 
traces

Specifies to ignore length rules so you can complete traces.

Differential pairs area

Add diff pair 
correction accordions 
when tuning

Specifies to use an accordion to make differential pairs the 
same length.

Do not create 
correction accordions 
in gap portion

Specifies that you do not want to allow correction accordions 
where two traces go together at the gap.

Create correction 
accordions only when 
length difference is 
grater than the 
matched length 
tolerance

Ensures that correction accordions are not created when the 
differential pair net length difference is less than the tolerance 
of the matched length group.

Table 45-238. Tune/Diff Pairs page contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41338
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Accessing

• Tools menu > Options > Split/Mixed Plan

Figure 45-258. Split/Mixed Plane page
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Table 45-239. Split/Mixed Plane page Contents 

Name Description

Save to PCB file area Specifies whether to save various forms of plane data in 
the design file.
• Plane Polygon Outlines—Saves only the mixed plane 

area polygons in the PADS Layout file. Discards 
generated thermals and antipads.
Tip: Saving only the plane polygon outlines results in 
a smaller PADS Layout file and a faster design load 
time.

• All Plane Data—Saves all data associated with mixed 
planes in the PADS Layout file.

Tip: The fill or hatching of plane areas is never saved in 
the design file.

Prompt to discard plane 
data

Specifies to display the Discarding Plane Data dialog box 
every time you save the design.
Tip: This option is unavailable if the All Plane Data 
option is selected.

Mixed Plane display area Specifies which plane data to display in PADS Layout.
• Plane Polygon Outlines—Displays only the plane 

area polygons.
• Plane Thermal Indicators—Displays the plane area 

polygons, thermal reliefs, and antipads.
• Generated Plane Data—Displays all data associated 

with mixed planes.

Smoothing radius Specifies how much smoothing to apply to sharp corners 
of mixed planes.
Tips: 
• Zero radius results in no smoothing. Larger radius 

values produce smoother and rounder corners.
• The smoothing radius affects only plane area data 

types and is independent of the smoothing radius for 
copper pours. 

Auto separate gap Specifies the plane-to-plane gap used by the Auto 
Separate command and Create Plane Area commands.
Tip: The default value is the Board-to-Trace clearance.

Automatic actions area

Remove isolated copper Remove copper areas on a mixed plane that are not 
connected to nets.
Tip: This option also appears on the Thermals tab. 
Changing this option here also changes the option on the 
Thermals tab.
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Options Dialog Box, Thermals Page
Use the Thermals page to specify options for copper pours automatically generated for existing 
pour outlines.

Restriction: These options only apply to Split/Mixed layer thermals when there are no custom 
thermals in the pad stack. Copper pours never use custom thermals from the pad stack.

Remove violating thermal 
spokes

Removes thermal spokes that cause clearance violations 
on split/mixed plane layers

Update unroute visibility Makes unroutes invisible when a connection is made to 
the split/mixed plane

Update thermal indicator 
visibility

Updates the plane thermal indicator visibility status of 
pads

Remove unused pads Removes unused pads and replace them with antipads.
Tip: CAM planes using custom antipads defined in the 
Pad Stacks require this setting, otherwise the default 
antipad setting will be used instead.

Preserve via pads on start 
and end layers

For partial vias, specifies to not remove the Start pad or 
End pad if the pad is on a plane layer.
Tip: This check box is unavailable if Remove Unused 
Pads is disabled.

Use design rules for 
thermals and antipads

When flooding during a plane connection operation, 
specifies to use the hierarchical Pad to Copper clearance 
rule for thermals and the Drill to Copper clearance rule for 
antipads.
Tips:
• Enabling this option ignores the outer 

width/diameter/size settings for custom thermals and 
the width/diameter/size settings for custom antipads. 
Also, the external outlines of thermals and antipads are 
not displayed.

• This option does not affect custom thermals for which 
the outer width/diameter/size is less than, or equal to, 
the inner width/diameter/size in the flood over 
settings.

Create cutouts around 
embedded planes

Automatically creates cutouts around plane areas if the 
area is placed inside another. 
Tip: The cutout is combined with the external area.

Table 45-239. Split/Mixed Plane page Contents (cont.)

Name Description



Options Dialog Box, Thermals Page

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1341

Accessing

• Tools menu > Options > Thermals

Figure 45-259. Thermals Page

Table 45-240. Thermals page Contents 

Name Description

Thermal Shape/Size Table - Drilled thermal settings are for through hole pad stacks 
and SMT thermals are for surface mount or any non-drilled thermal.

Width Specifies the line width for the thermal relief in current design 
units.
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Options Dialog Box, Thermals Page

Min. Spoke Specifies the minimum number (1-4) of spokes.
Tip: If the pad intersects the boundary of a copper pour, it may 
not be possible to create all four spokes. A warning appears 
when thermals are created with fewer spokes than the 
minimum.

Pad shapes - Round, 
Square, Rectangle, Oval

Specifies the shape of the thermal relief: Round, Square, 
Rectangle, or Oval

Relief Shape • Orthogonal—Creates orthogonal-shaped thermal reliefs.
• Diagonal—Creates diagonal-shaped thermal reliefs.
• Flood Over—Creates thermal reliefs that flood over the 

pad. You can also configure the copper pour or plane area 
to flood over vias.
See also: Flood and Hatch Options dialog box

• No Connect—Creates no thermal reliefs.

Routed pad thermals Specifies that you can place thermals on routed pads or 
connections. Usually thermals are placed only on unrouted 
connections.
Restriction: This Option applies only to copper pours and not 
to split planes.
Tip: Small left-over trace segments attached to a pad prevents 
a pad from receiving thermals if the Routed Pad Thermals 
option is not enabled. Set the Selection Filter to Traces, 
Corners, and Tacks to select and remove trace segments 
attached to the pad.

Show general plane 
indicators

Specifies to display a general plane thermal indicator if a 
connection to a CAM or split/mixed plane exists somewhere 
within a pad stack. The physical appearance of this indicator 
resembles a small x in the center of the pad. Disable this option 
if you do not want to view indicators.
Tips:
• General plane indicators are independent of the current 

layer. For example, the actual indicator may not be on the 
current layer, but on one or more internal layers of the pad 
stack.

• General plane indicators can sometimes be covered during 
editing. Redraw the screen to view all of the indicators. 

Table 45-240. Thermals page Contents (cont.)

Name Description
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Related Topics

Customizing Design Rule Thermals

Flooding Over Pads in a Copper Pour or Plane Area

Options Dialog Box, Via Patterns Page
Use the Via Patterns page of the Options dialog box to set options for the via shielding and via 
stitching operations.

Requirements:

• You must have a design open in order to set Via Patterns options.

• Set Via Patterns options before using the Add Via Shield or Via Stitch commands.

Accessing

• Tools menu > Options > Via Patterns 

Remove isolated copper Specifies to automatically remove isolated copper areas, which 
are areas not connected to nets, during the flood operation of 
regular copper pours
Tip: This option also appears on the Split/Mixed tab. 
Changing this option here also changes the option on the 
Split/Mixed tab.

Remove violating 
thermal spokes

Specifies to automatically remove thermal spokes that cause 
clearance violations on non-plane layers.
Tip: This option also appears on the Split/Mixed tab. 
Changing this option here also changes the option on the 
Split/Mixed tab.

Table 45-240. Thermals page Contents (cont.)

Name Description
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Options Dialog Box, Via Patterns Page

Figure 45-260. Via Patterns page

Table 45-241. Via Patterns page contents 

Name Description

When shielding area—Use these options to specify the via type for vias used for 
shielding. 

Add vias from net Specifies the via type for vias used for shielding. Select the net 
associated with the vias used for shielding.

Via type Specifies the via type for vias used for shielding. 
1. In the Add vias from net list, select a net to display 

available via types.
2. In the Via type list, select the via type to use for shielding. 

(Design rules determine which via types are available for 
the selected net.)
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Shielding spacing area Specify the distance from the shielding vias to the trace or 
shape they are shielding

Requirement: Select the Ignore via grid check box. 
Otherwise, vias snap to the via grid.
Select one of the following:
• Use design rules—Select this option (the default) to have 

design rules determine the distance from vias to the object 
being shielded. The Add Via Shield operation uses Via to 
Trace and Via to Copper clearances to place vias in relation 
to a selected trace or copper.
Tip: Design rules are used to place vias in relation to the 
selected trace or copper; however, that placement can 
violate clearances with other objects—another trace, for 
example. To prevent addition of any via that causes 
clearance errors, set Design Rule Checking (DRC) to 
Prevent Errors. For more information, see DRC and the Via 
Stitching and Shielding Operations.

• Via to edge—Select this option to specify via spacing 
different from the design rules for minimum Via to Trace 
and Via to Copper clearances.
Select this option and type a value in the Specified value 
box. The value can be 0 to 1000 mils. A value of 0 causes 
the vias and the edge of the trace (or shape) to touch.
Tip: To specify a value smaller than the minimum Via to 
Trace or Via to Copper clearances, set DRC to Off. If the 
DRC setting is Prevent Errors, an Add Via Shield operation 
fails and no vias are added.

• Via to ground edge—Specifies the distance from the vias 
to the edge of the copper ground area (for example, a hatch 
outline). Select this option and type a value in the 
Specified value box.
Tip: The via to trace distance equals the value of Via to 
ground edge plus the value of the copper to trace clearance.

Table 45-241. Via Patterns page contents (cont.)

Name Description
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Options Dialog Box, Via Patterns Page

When Stitching Shapes area—Specifies the via type used in stitching a copper shape for 
a given net.

Nets/Via Type list Select the via type used per net for stitching shapes. By default, 
this list is empty. Use the following buttons to modify the list:
• Add—Adds a row at the bottom of the When Stitching 

Shapes table.
• Edit—Makes the selected cell available for editing.
• Remove— Removes a line (Net/Via Type) from the list. 

Pattern area Specifies the stitching mode (Fill or Perimeter) for placing the 
pattern of vias in the shape. You have the following choices:
• Fill—Fills the shape with the pattern (Aligned or 

Staggered).
• Perimeter—Places vias inside the perimeter of the shape.

Tip: To override the Pattern (Fill or Perimeter) setting for a 
selected shape, use the Via Stitch Mode command.
Restriction: By default, the Via Stitch operation does not 
place vias around a void within a shape. For information, 
see Surrounding a Void with Vias.

Via to shape Specifies the distance from the edge of the shape you are 
filling to the edge of the via pattern. The value can be 0 to 1000 
mils. A value of 0 causes the edge of the via and the fill outline 
to touch. for example:

The default value is the same as the default Copper-to-Via 
clearance.

Table 45-241. Via Patterns page contents (cont.)

Name Description
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Fill selected hatch 
outline only

Use this setting when you have a single copper pour or split 
plane polygon that, when flooded, is separated into two or 
more distinct hatch outlines. 
• Select this option to fill only the selected hatch outline with 

the pattern of vias when you use the Via Stitch command. 
(This is the default setting.)

• Clear the check box to fill the main pour or plane outline of 
which the selected hatch outline is a part.

For example:

Use the settings below for both the Add Via Shield and Via Stitch commands.

Via spacing Specifies the distance between vias (center to center) added by 
the Add Via Shield and Via Stitch operations. Type a value of 
0 to 1000 mils; the default is 100 mils.
If you specify a value of 0 or any value that is less than half of 
the diameter of the via, vias touch but do not overlap. For 
example:.

Tips: 
• To use this option, select the Ignore via grid check box.
• To specify a value smaller than via diameter plus same net 

Via to Via clearance, set DRC to Off. If the DRC setting is 
Prevent Errors, an Add Via Shield or Via Stitching 
operation fails. (The operation adds some vias but skips 
those that create violations.)

Glue vias as they are 
added

Specifies to glue each via added by the Add Via Shield and Via 
Stitch operations. Also sets each via’s property to Glued and 
stores the setting in the design database.

Table 45-241. Via Patterns page contents (cont.)

Name Description
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Output Window

Related Topics

Setting Via Shielding Options

Setting Shape Stitching Options

DRC and the Via Stitching and Shielding Operations

Adding a Via Shield

Filling a Shape with a Pattern of Vias

Placing Vias Inside the Perimeter of a Shape

Output Window
Use the Output window for displaying reports and session logs, macro editing and debugging, 
and custom programming and debugging.

Accessing

• Output Window button

The Output window is located in the lower left section of the display window. You can dock or 
float the Output window. You can also open or close the Output window. 

The Output window has three tabs:

• Status Tab - Displays information on the current session.

• Macro Tab - Allows you to run, edit and debug macro scripts.

Related Topics

• Interface

Status Tab
The Status tab displays information about the current session. It specifies the file name of the 
opened PCB file and the name of the test integrity file that is saved. It also reports routing 
statistics and messages when routing a board. If the Status tab is closed, and you get an error 
while autorouting - or performing other tasks - the Output window opens with the status tab 

Ignore via grid Allows the Add Via Shield and Via Stitch operations to ignore 
the via grid setting. (Vias do not snap to the via grid.) Instead, 
the operations place vias according to the settings you 
specified in the Shield spacing area and the Via spacing field.

Table 45-241. Via Patterns page contents (cont.)

Name Description
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active and the error appearing in red. The Output window reappears in its most recent state 
(floating or docked).

Accessing

• Click the Output Window button and then click the Status tab.

Figure 45-261. Status Tab

Related Topics

Macro Tab
You can edit, run, and debug macro scripts in the Macro tab. You can open multiple macros and 
nest macros using the macro editor.

A macro is any combination of commands, keystrokes, and mouse clicks that you record to 
replay as a single action. You can record virtually any set of procedural steps for replay, thereby 
simplifying redundant activities, such as setting preferences and layer/display settings.

Accessing

• Click the Output Window button and then click the Macro tab.

Managing Session Logs

Session Log in the Routing Concepts Guide

Session Log in the PADS Layout Concepts Guide
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Output Window

Figure 45-262. Macro Tab

Related Topics

Creating Macros Debugging Macro Scripts

Managing Macros Accessing Help on the Macro Language

Playing Back Macros Using Command Line Switches with Macros

Macros in the Routing Concepts 
Guide



Pad Entry Rules Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1351

Pad Entry Rules Dialog Box
Use the Pad Entry Rules dialog box to specify how traces enter and exit pads.

Restriction

While you can define these rules in either PADS Layout or PADS Router, the rules are only 
used in PADS Router.

Accessing

• Setup menu > Design Rules > Default button > Pad Entry button

•

Figure 45-263. Pad Entry Rules Dialog Box
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Pad Stacks Properties Dialog Box

Related Topics

Design Rule Hierarchy

Pad Entry Properties in PADS Router

Pad Stacks Properties Dialog Box
Use the Pad Stacks Properties dialog box to establish the size and shape of each pad and drilled 
hole in a given pad stack, including component and via pad stacks. 

Table 45-242. Pad Entry Rules Dialog Box 

Area Description

Pad entry quality Specify the options that PADS Router can use while routing from the 
pad:
• Allow side exit—For rectangular pads only, enable routing to exit 

through the long side of the pad.
• Allow corner exit—For rectangular pads only, enable routing to exit 

through the pad corner or arc.
• Allow any angle exit—For rectangular and round pads, enable 

routing to exit at any angle, not just 45 or 90 degrees.
• Soft first corner rules—For rectangular and round pads, enable 

routing to ignore first corner clearance rules and to exit at an angle 
less than 90 degrees.
Tip: If you select this check box, acid traps may result. On the other 
hand if you clear this check box, lower completion rates and slower 
routing may result. Use DRC in PADS Layout to locate possible acid 
traps. You can ignore first corner clearance rules, because it is a soft 
rule.

Via at SMD Specify to enable PADS Router to place vias on SMD pads while routing.
Restrictions: For pins with associated copper, the via is not placed on the 
SMD pad. Only one via can be placed on an SMD pad.
• Vias at SMD—Place vias on SMD pads while routing.

Tip: Only one via can be placed on an SMD pad.
• Fit inside—Fit the via entirely inside the SMD pad.
• Center—Place the via at the geometric center (not pad origin) of the 

SMD pad.
• Ends—For rectangular or oval pads, place the via at the end of the 

SMD pad. When using square pads, place the via at the midpoints of 
the sides of the pad. Round pads are ignored.

Delete button Removes non-default pad entry rules from the current level of the rules 
hierarchy. 
Restriction: You cannot delete the Default pad entry rules.
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Accessing

• Setup menu > Pad Stacks

The Pad Stacks Properties dialog box controls change depending on what you have selected. 
The three major differences are:

• Figure 45-264: Pad Stacks Properties Dialog Box - Decal Pad Stack

• Figure 45-265: Pad Stacks Properties Dialog Box - Via Pad Stack

• Figure 45-266: Pad Stacks Properties Dialog Box - Thermal Pad Style

Figure 45-264. Pad Stacks Properties Dialog Box - Decal Pad Stack
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Pad Stacks Properties Dialog Box

Figure 45-265. Pad Stacks Properties Dialog Box - Via Pad Stack
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Figure 45-266. Pad Stacks Properties Dialog Box - Thermal Pad Style

Table 45-243. Pad Stack Properties Dialog Box Contents 

Name Description

Pad Stack Type Decal—Accesses component pad stack options.
Via—Makes the Vias area of the dialog box available so 
you can define a via pad stack. Options related to decal or 
pin pad stacks are now unavailable. 
See also: Via Setup

Decal Name Lists the available decal names for decals or vias, 
whichever is selected in the Pad Stack Type area.
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Pad Stacks Properties Dialog Box

Add Via Adds a via to the Decal Name list. 
Restriction: Available only when Via is selected in the 
Pad Stack Type area.
See also: Creating a Through-hole Via, Creating a Partial 
Via

Delete Via Deletes the selected via from the Decal Name list. 
Restrictions:
• Available only when Via is selected in the Pad Stack 

Type area.
• You cannot delete a via if it is already used in the 

design.

Vias Name Assigns a name for a new via. 
Restriction: Available only when Via is selected in the 
Pad Stack Type area.

Through/Partial Through—Sets the current via as a through via, through 
all layers of the board.
Partial—Sets the current via as a partial via, through 
certain layers of the board. Click Partial and click a Start 
Layer and an End Layer.
Restriction: Available only when Via is selected in the 
Pad Stack Type area.

Start Layer Sets the start layer for a partial via.
Restriction: Available only when Via is selected in the 
Pad Stack Type area, and Partial is the type of via.

End Layer Sets the end layer for a partial via.
Restriction: Available only when Via is selected in the 
Pad Stack Type area, and Partial is the type of via.

Pin Number and Plated Specifies the pins to which to apply the pad stack edits. 
Use the Pin, Plated column to select the pin you want to 
edit. The Pin, Plated setup does not apply to via pad 
stacks; all vias are considered plated. You can select one 
or more pins and customize the pad stacks for your 
selection. 
Restriction: Available only when Decal is selected in the 
Pad Stack Type area.
Add—Opens the Add Pin dialog box.
Delete—Removes the selected Pin.

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description
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Shape, Size, and Layer Sets the size and shape of a pad on selected layers.
Inner layers are drawn with a slightly larger pad size 
because they are often used for plane layers, where the pad 
size becomes an insulation area when output as a plane 
plot.
Add—Opens the Add Layer dialog box.
Delete—Removes the selected shape.
In the shape column, the first character is the pad, the 
second is the thermal and the third is the antipad. “N” 
indicates that none has been defined.
See also: Control of Solder Mask and Paste Mask

Use Global Defaults Sets thermal and antipad shapes to those specified in the 
Thermals tab in the Options dialog box.
Restriction: This option is available when the Pad Style 
list is set to Thermal or Antipad. 
See also: Design Rule Versus Pad Stack - Thermals and 
Antipads

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description
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Pad Stacks Properties Dialog Box

Pad Style Specifies the style of pad: normal pad, thermal pad, or 
antipad.
Thermal and Antipad pad styles control the size and shape 
of thermals and antipads used on split/mixed layers and 
CAM negative planes (for RS-274X output). 
See also: Design Rule Versus Pad Stack - Thermals and 
Antipads
Tips:
• Beginning with PADS 9.2, the size, shape and 

orientation of thermals for slotted pads are no longer 
derived from the length, drill size and orientation of 
the slotted hole, but are inherited from the normal pad.

• Set the Inner Diam and Outer Diam values to be the 
same for a solid connection to the plane (flood over). 
The current pad diameter is used as the inner diameter 
with the outer diameter set at the default same-net pad 
to corner rule. For antipads, diameters are initially set 
to follow the current default pad to copper design rule. 
If you select Use Design Rules for Thermals and 
Antipads in the Split/Mixed Plane page of the Options 
dialog box, the outer diameter is ignored and the 
clearance rule is used instead, except when the outer 
diameter is less than the inner diameter. Inner and 
outer diameter options always, however, control flood 
over.

The length of an antipad with a non-zero drill size equals 
the slot length minus the drill size, plus the width.
Restriction: You cannot create antipads using the 
Mounted Side or Opposite side layers. You must add the 
actual layer to the list. When you select a Mounted or 
Opposite Side layer in the Sh: Sz: Layer: list, Antipad is 
unavailable.

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description
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Shape buttons Assigns a pad shape to the layer selected in the Sh: Sz: 
Layers: list. You can assign pad shapes as round, square, 
annular, oval or rectangular, odd.
• Annular lets you specify an inner pad diameter, 

bringing the inner diameter of the pad inside the drill 
outline. A pilot dimple at the center of the copper pad 
appears as an aid to hand fabrication of some 
prototypes.

• Odd is useful for drawn items such as moiré pads or 
registration marks. It is a circular outline only, like an 
antipad, and is usually used for marking areas for 
airgap checking. This setting should not be confused 
with trying to create a custom shaped (odd shaped) 
pad. See Creating a Custom Pad Shape for more 
information.

Pad size relative to drill size Displays inner and outer pad sizes relative to the drill size.

Flood over Specifies that the pad requires no thermal relief and 
should be flooded over, irrespective of any default 
flooding options for a normal pad of this shape.
Restriction: Available only when Pad style is Thermal 
and a pad shape button is selected.

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description
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Pad Stacks Properties Dialog Box

Parameters area The options for sizing the pad shape vary according to the 
shape you choose.
Round—Diameter (if hole is not slotted), Width (if hole is 
slotted). If the pad style is thermal: Inner Diam, Outer 
Diam, Spokes, Spoke Angle, Spoke Width.
Square—Size (if hole is not slotted), Width (if hole is 
slotted), Corner type and Radius. If the pad style is 
thermal: Inner Size, Outer Size, Spokes, Spoke Angle, 
Spoke Width.
Annular—Diameter and Inner Diameter 
Oval—Width, Length, Orientation, and Offset 
Rectangular—Width, Length, Orientation, Offset, Corner 
type and Radius
Odd—Diameter 

Figure 45-267. Radius Examples

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description
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Orientation/Offset Sets the orientation and offset for pads. Used for SMD 
decals and edge finger connectors. Available when you 
click the oval or rectangular shaped button.
For orientation, 90 degrees is perpendicular to the part 
body and 0 is parallel to the part body. You can type any 
degree of rotation. 
By specifying the offset, you can move the rectangular or 
oval pad slightly off its electrical center for two purposes:
• Pads that are concentric on the display, as they are in 

edge fingers, are difficult to select and work with 
during routing. Offsetting one of the layers makes it 
easier to identify the top and bottom layers. 

• To extend the pad out from the component body, 
leaving the electrical centers unmoved.

The maximum amount of offset you can assign is one half 
of the pad's length. If you exceed this limit, the pad fails to 
appear in the Preview dialog box for CAM.

Figure 45-268. Offset Example

Maximum offset = ½ length or (1000/2) = 500

Drill size Specifies the hole size. If the hole is plated, this value 
remains the same. It is the finished hole size.
Drill holes are normally oversized by the fabricator in 
order to achieve the specified drill size value after the hole 
is plated.
See the Drill Oversize setting in the Options Dialog Box, 
Design page.

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description
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Pad Stacks Properties Dialog Box

Plated Sets whether the drill hole is plated with copper.
Normally, pad stacks with a hole are plated. To create a 
nonplated hole with no copper, such as a mounting hole, 
clear this Plated check box. Nonplated holes are drilled to 
true drill diameter, without oversize, and any drill oversize 
does not apply to them.
Tips: 
• The batch clearance checking functions consider the 

added (plated hole) drill oversize value when flagging 
errors. See the Drill Oversize setting in the Options 
Dialog Box, Design page.

• If the board is marked as Single-sided in the Layers 
Setup dialog box, this check box is ignored.

Slotted Enables a slotted hole for the selected pad stack or pin. 
See also: Using Slotted Holes

Slot Length Sets the length of the slotted hole. This option becomes 
available when you select Slotted.

Slot Orientation Sets the orientation of the slotted hole. This option 
becomes available when you select Slotted.
Tip: A custom thermal or antipad for a slotted hole has the 
same orientation as the slot.

Slot Offset Sets the slotted hole offset. Slot offset moves the center of 
the slotted hole relative to the electrical center of the pin–
always in the opposite direction of the pad offset. This 
option becomes available when you select Slotted. 
The maximum amount of offset you can assign is one half 
of the slot's length. If you exceed this limit, the slotted 
hole display is suppressed in the Preview dialog box in 
CAM. 
Tip: A custom thermal or antipad for a slotted hole has the 
same offset as the slot.

Decal Units Shows and sets the current units of the selected decal. 
Restriction: This area is unavailable if you select the Via 
in the Pad Stack Type area or when you use this dialog 
box in the PCB Decal Editor. 
Tip: Switching the decal units can cause errors if 
rounding off occurs.

List Produces a report describing the selected pad stack. 
Pad stack reports show pad stack, slotted hole, and unit 
information. Vias are output in design units. 

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description
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Related Topics

Customizing Pad Stacks of Decal Pins

Flooding Over Pads in a Copper Pour or Plane Area

Flooding Over Vias in a Copper Pour or Plane Area

Pad Stack Report

Pad Stacks

Slotted Hole Offset Versus Pad Offset

Pad Stack Properties for Pin Dialog Box
Use the Pad Stack Properties for Pin dialog box to modify the size and shape of one or more 
selected terminals or slotted holes while in the PCB Decal Editor.

Accessing

• PCB Decal Editor > select a terminal > right-click > Pad Stacks

List All Produces a report describing all pad stacks in all decals in 
the database. 
Pad stack reports show pad stack, slotted hole, and unit 
information. Vias are output in design units. 

Preview Shows pad shape and size for the current options.

Negative Changes the preview area to a negative view.
Restriction: Thermal Pad Style only.

Table 45-243. Pad Stack Properties Dialog Box Contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41364

Pad Stack Properties for Pin Dialog Box

Figure 45-269. Pad Stack Properties for Pin Dialog Box

Table 45-244. Pad Stack Properties for Pin Dialog Box Contents 

Name Description

Pin Number and Plated For Decal pad stacks, you need to specify the pins to 
which to apply the pad stack edits. Use the Pin, Plated 
column to select the pin you want to edit. The Pin, Plated 
setup does not apply to via pad stacks; all vias are 
considered plated.

Shape, Size, and Layer For both via and component pad stacks, you can set the 
size and shape of a pad on selected layers.
Inner layers are drawn with a slightly larger pad size 
because they are often used for plane layers, where the pad 
size becomes an insulation area when output as a plane 
plot. 
See also: Pad Stacks
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Add Opens the Add Layer dialog box.

Delete Removes the selected shape

Assign to all selected pins Modifies the terminals you select in the Pin Name, Plated 
list to match the terminal selected in the workspace. 

Shape buttons Assigns a pad shape to the layer selected in the Size, 
Shape, Layers list. You can set pads as round, square, 
annular, oval or rectangular, odd.
• Annular lets you specify an inner pad diameter, 

bringing the inner diameter of the pad inside the drill 
outline. A pilot dimple at the center of the copper pad 
appears as an aid to hand fabrication of some 
prototypes.

• Odd is useful for drawn items such as moiré pads or 
registration marks. It is a circular outline only, and is 
usually used for marking areas for airgap checking. 
This setting should not be confused with trying to 
create a custom shaped (odd shaped) pad. See Creating 
a Custom Pad Shape for more information.

Parameters area The options for sizing the pad shape vary according to the 
shape you choose.
Round—Diameter (if hole is not slotted), Width (if hole is 
slotted)
Square—Size (if hole is not slotted), Width (if hole is 
slotted), Corner type and Radius
Annular—Diameter and Inner Diameter 
Oval—Width, Length, Orientation, and Offset 
Rectangular—Width, Length, Orientation, Offset, Corner 
Type and Radius
Odd—Diameter 

Figure 45-270. Radius Examples

Table 45-244. Pad Stack Properties for Pin Dialog Box Contents (cont.)

Name Description
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Pad Stack Properties for Pin Dialog Box

Orientation/Offset Sets the orientation and offset for pads. Used for SMD 
decals and edge finger connectors. Available when you 
click the oval or rectangular shaped button.
For orientation, 90 degrees is perpendicular to the part 
body and 0 is parallel to the part body. You can type any 
degree of rotation. 
By specifying the offset, you can move the rectangular or 
oval pad slightly off its electrical center for two purposes:
• Pads that are concentric on the display, as they are in 

edge fingers, are difficult to select and work with 
during routing. Offsetting one of the layers makes it 
easier to identify the top and bottom layers. 

• To extend the pad out from the component body, 
leaving the electrical centers unmoved.

The maximum amount of offset you can assign is one half 
of the pad's length. If you exceed this limit, the pad fails to 
appear in the Preview dialog box for CAM.

Figure 45-271. Offset Example

Maximum offset = ½ length or (1000/2) = 500

Drill size Sets the drill size of the pad.

Table 45-244. Pad Stack Properties for Pin Dialog Box Contents (cont.)

Name Description
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Related Topics

Customizing Pad Stacks of Decal Pins

Pad Stacks

Pads for Die Pin Dialog Box
Use the Pads for Die Pin dialog box to specify which label to use for the die part's substrate 
bond pad.

Restriction: This information applies to only the BGA toolkit.

Plated Sets whether the pad is plated with copper.
Normally, pads with a hole are plated. To create a 
nonplated hole with no copper, such as a mounting hole, 
click to clear Plated. Nonplated holes are drilled to true 
drill diameter, without oversize, and any drill oversize 
does not apply to them.
Tip: The batch clearance checking functions consider the 
added drill oversize value when flagging errors. When 
Plating is cleared, batch clearance checking applies to the 
true drill value.

Slotted Enables a slotted hole for the selected pad stack or pin. 
See also: Using Slotted Holes

Slot Length Sets the length of the slotted hole. This option becomes 
available when you select Slotted.

Slot Orientation Sets the orientation of the slotted hole. This option 
becomes available when you select Slotted.
Tip: A custom thermal or antipad for a slotted hole has the 
same orientation as the slot.

Slot Offset Sets the slotted hole offset. Slot offset moves the center of 
the slotted hole relative to the electrical center of the pin–
always in the opposite direction of the pad offset. This 
option becomes available when you select Slotted. 
The maximum amount of offset you can assign is one half 
of the slot's length. If you exceed this limit, the slotted 
hole display is suppressed in the Preview dialog box in 
CAM. 
Tip: A custom thermal or antipad for a slotted hole has the 
same offset as the slot.

Preview Shows pad shape and size for the current options.

Table 45-244. Pad Stack Properties for Pin Dialog Box Contents (cont.)

Name Description
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PADS Router Link Dialog Box

Accessing

• BGA Toolbar button > Select a BGA Pin > double-click in a BGA Pad cell > Ellipsis 
button

Figure 45-272. Pads for Die Pin Dialog Box

Related Topics

To Display Die Pins

To List All BGA Pin Labels

To List Specific BGA Pin Labels

PADS Router Link Dialog Box
The depends on your Synchronization mode settings. When you are not in Synchronization 
mode, the PADS Router Link sets up autorouting options for PADS Router and passes 
information from PADS Layout to PADS Router. Data is stored in the design file. Using the 
link you can either run PADS Router and automatically open the current design file in the 

Table 45-245. Pads for Die Pin Dialog Box contents 

Name Description

BGA Pad Lists all BGA pin pad labels that are connected to the die part 
pin selected in the Add BGA Pin Labels dialog box. Select the 
pin pad labels to use in the substrate bond pad's label.

Select All button Selects all BGA pin pad labels in the BGA Pad list.

Apply to All Applies the current die pin number and BGA pad setup to all 
die pin numbers that have multiple BGA pin pads.
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foreground, so you can view the autorouter's progress, or you can run PADS Router in the 
background. When you are in Synchronization mode, the PADS Router link sets up autorouting 
options for PADS Router and switch to PADS Router. Using the link you can either run PADS 
Router and automatically open the current design file in the foreground, so you can view the 
autorouter's progress, or you can run PADS Router in the background. 

Accessing

• Tools menu > PADS Router

Figure 45-273. PADS Router Link Dialog Box

Figure 45-274. PADS Router Link Dialog Box - Synchronization Mode
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PADS Router Monitor Dialog Box, Routing Tab

Related Topics

Autorouting Your Design

Synchronization Mode

PADS Router Monitor Dialog Box, Routing Tab
PADS Router Monitor provides dynamic information as the PADS Layout design is translated 
for autorouting.

Accessing

The Routing tab on the PADS Router Monitor dialog box appears when you click Proceed on 
the PADS Router Link dialog box.

Table 45-246. PADS Router Link Dialog Box contents 

Name Description

Action Specifies the action you want to perform. The options are:
• Open PADS Router—Opens PADS Router and loads the 

design file into it. You can make changes to the design file 
in PADS Router (rather than PADS Layout) before routing.
Restriction: Non-Synchronization mode only.

• Switch to PADS Router—Links PADS Router and PADS 
Layout. Any changes you make to the design file in PADS 
Router are reflected in PADS Layout. 
Restriction: Synchronization mode only.

• Autoroute in Background—Opens PADS Router and 
PADS Router Monitor, but runs PADS Router in the 
background. Layout commands are disabled and a wait 
cursor shown until autorouting is completed or the Stop 
button is selected in the Router Monitor. 

• Autoroute in Foreground—If you are not in 
Synchronization mode, opens PADS Router and PADS 
Router Monitor, and runs PADS Router in the foreground 
making it the active program. If you are in Synchronization 
mode, opens PADS Router and runs it in the foreground 
making it the active program.

Setup button Opens the Routing Strategy Dialog Box.

Options Specifies the Options dialog box tab you want to open when 
you click the Setup button.

Setup button Opens the Options dialog box to the tab you specified above.

Proceed Autoroutes the design with the settings you specified.
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Tip: If PADS Router Monitor does not appear on the desktop, look for it on the Windows 
taskbar.

Figure 45-275. Routing Tab

Table 45-247. Routing tab contents 

Name Description

Routing Progress 
Indicator

Displays the autorouting progress.

Close When Finished Specifies to close PADS Router Monitor when autorouting 
completes.
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PADS Router Monitor Dialog Box, Verify Tab

PADS Router Monitor Dialog Box, Verify Tab
PADS Router Monitor provides dynamic information as the PADS Layout design is translated 
for autorouting.

Routing tab Displays the following information about the current routing 
pass:
• Pass—The name of the current routing pass.
• Time—The total time spent in previous passes followed by 

the elapsed time for the current pass.
• Fanouts—The total number of fanouts created in previous 

passes followed by the number of fanouts created during 
the current pass.

• Vias—The total number of vias routed in previous passes 
followed by the number of vias routed during the current 
pass.

• Routed Links—The total number of successfully routed 
links in previous passes followed by the number of links 
routed during the current pass.

• Miters—The total number of miters created in previous 
passes followed by the number of miters created during the 
current pass.

• Test Points—The total number of test points created in 
previous passes followed by the number of test points 
created during the current pass.

• Trace Length—The total length of all successfully routed 
traces in previous passes followed by the total length of all 
traces routed during the current pass.

Load the Resulting File Specifies to open the routed design in a new instance of PADS 
Layout when autorouting completes.
Restriction: This option is available only when you are 
routing in the foreground. When you are routing in the 
background, this check box is checked and unavailable, and 
the routed file is automatically opened in the current Layout 
window.

Exit PADS Router on 
Completion

Specifies to close PADS Router automatically if Close When 
Finished is also checked. 
If Exit PADS Router on Completion is checked, and Close 
when Finished is cleared, both the Monitor and PADS Router 
will remain open until you click the Monitor Stop button.

Stop button Stops the autorouting process and closes the PADS Router 
Monitor. Also closes PADS Router if you clicked Exit PADS 
Router on Completion.

Table 45-247. Routing tab contents (cont.)

Name Description
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Accessing

The Verify tab on the PADS Router Monitor dialog box appears when you click Start on the 
Verify Design dialog box.

Tip: If PADS Router Monitor does not appear on the desktop, look for it on the Windows 
taskbar.

Figure 45-276. Verify Tab

Table 45-248. Verify tab contents 

Name Description

Routing Progress 
Indicator

Displays the autorouting progress.

Close When Finished Specifies to close PADS Router Monitor when autorouting 
completes.

Verify tab Displays the following information about the current routing 
pass:
• Pass—The name of the current routing pass.
• Time—The total time spent in previous passes followed by 

the elapsed time for the current pass.
• Errors—The total number of errors in the previous passes 

followed by the number of errors during the current pass.
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Part Information Dialog Box, Attributes Tab

Part Information Dialog Box, Attributes Tab
Use the Attributes tab in the Part Information dialog box to manage attributes for the selected 
part, and to define default attributes for new parts.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Attributes tab

Figure 45-277. Attributes Tab

PADS Suite Configuration Dialog Box
Use the PADS Suite Configuration dialog box to manage PADS Suite (composite) licenses.

Stop button Stops the autorouting process and closes the PADS Router 
Monitor. Also closes PADS Router if you clicked Exit PADS 
Router on Completion.

Table 45-248. Verify tab contents (cont.)

Name Description
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Accessing

• Help menu > Installed Options > Suite Configuration button

Or

• Optional: Opens on program startup

Figure 45-278. PADS Suite Configuration dialog box

Table 45-249. PADS Suite Configuration dialog box Contents 

Name Description

Control suite license 
checkout and select from 
the following list

Enables the Suite License table for you to control 
checkouts.

Suite Name column Lists the name of the suite for which the license works.

License Feature column Lists the specific features available for each license.

License status column Lists the status of the licenses when you click the Check 
status button.

Check Status button Specifies to check the status of all licenses listed in the 
table and displays the status in the License status column.

Reset List button Specifies to reset the list of suite licenses to only those 
detected in your licensing environment.
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Part Information Dialog Box, Connector Tab

Related Topics

Installed Options Dialog Box

Checking Out Suite Licenses

Part Information Dialog Box, Connector Tab
Use the Connector tab in the Part Information dialog box to assign one or more pin decals, or 
Special Symbols, to a connector. This allows you to use any of the special symbols as alternate 
pins of the connector. Instead of being displayed as a single symbol, the connector is broken up 
into individual pin symbols in the schematic. You can place the pins all together, or wherever 
you like on a single page or even across multiple pages.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Connector tab

Restriction: This tab is unavailable when the Connector check box on the General tab is 
cleared, or when a gate has been assigned to the part on the Gates tab.

Move up button Moves the selected license up one row.

Move down button Moves the selected license down one row.

Select all button Selects all of the listed licenses.

Select none button Deselects all of the listed licenses.

Show this dialog box on 
program startup

Specifies to open the PADS Suite Configuration dialog 
box when PADS Layout starts.

Automatically check license 
status on dialog box startup

Specifies to check the status of the licenses when you 
open the PADS Suite Configuration dialog box.

Copy Selections to area Specifies to copy what you’ve done to PADS Router 
and/or PADS Logic.
Warning: Copying your selections may make the other 
PADS products open in demonstration mode.

Table 45-249. PADS Suite Configuration dialog box Contents (cont.)

Name Description
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Figure 45-279. Connector Tab

Table 45-250. Connector Tab Contents 

Name Description

Picture Displays a picture of the selected Special Symbol.

Attribute table • Special Symbol—The name of a connector pin decal for use 
in the schematic.

• Pin Type—The function of the special symbol.

Opens the Browse for Special Symbols Dialog Box where you 
can browse for a pin decal.

Reset Undoes all changes you made in the Connector tab.

Edit Makes the selected cell available for editing.
Tip: You can also double-click the cell to edit the contents.

Add Adds a new row at the bottom of the table.

Delete Removes the selected row.
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Part Information Dialog Box, Gates Tab

Related Topics

Creating a Connector Part Type

Creating a New Part Type

Part Information Dialog Box, Gates Tab
Use the Gates tab in the Part Information dialog box to assign gate information, such as CAE 
decals and gate swap options to a part.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Gates tab

Check Part Checks for missing or inconsistent information.
Tip: Even if you don't click the Check Part button, when you exit 
the tab, the assigned decals are checked to ensure that they 
contain physical pin numbers for all the gate and signal pins 
defined in the Pins tab.

Save As Opens the Save Part Type to Library dialog box.

Table 45-250. Connector Tab Contents (cont.)

Name Description
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Figure 45-280. Gates Tab

Table 45-251. Gates Tab Contents 

Name Description

Preview area Shows the item selected in the Decal cell.

Reset Undoes all changes you made in the Gates tab.

Edit Makes the selected cell available for editing. Also displays 
the Browse button.

Opens the Assign Decal to Gate Dialog Box.
Tip: This button is available only in the CAE Decal 
columns, and only when the cell is available for editing.

Add Adds a new row with the next Gate letter at the bottom of 
the Gate table.

Delete Removes the selected row from the Gate table.
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Part Information Dialog Box, General Tab

Related Topics

Creating a New Part Type

Part Information Dialog Box, General Tab
Use the General tab in the Part Information dialog box to specify pin count, logic family, and 
various options for a part.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button

Gate table • Gate column—Displays the letter of the gate.
• Pins column—Displays the number of pins for the 

gate. Gate pins are added on the Pins tab.
• Swap column—Displays the swap ID from 0 to 100. 

To uncross connections and facilitate routing, gates 
with the same swap ID (except for 0) can be swapped 
within a part or with another part of the same type.
Tip: Type 0 to disable swapping.

• CAE Decal N column—Displays the CAE Decal 
name. The decal listed for CAE Decal 1 is the default 
decal and is used when you add the part to the 
schematic. Additional decals are alternates. You can 
assign up to four CAE decals to a part.
Tip: Double-click to Type a decal name or click the 
“...” (Browse) button to search for a decal from a 
library

Check Part Checks for missing or inconsistent information.
Tip: Even if you don't click the Check Part button, when 
you exit the tab, the assigned decals are checked to ensure 
that they contain physical pin numbers for all the gate and 
signal pins defined in the Pins tab.

Save As Opens the Save Part Type to Library dialog box.

Table 45-251. Gates Tab Contents (cont.)

Name Description
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Figure 45-281. General Tab

Table 45-252. General Tab Contents 

Name Description

Part Statistics All the statistics in the Part Statistics area are read-only. 
Pin Count lists the total number of pins - gate pins, signal 
pins, and unused pins. If multiple decals are assigned with 
different pin counts, a range of smallest to largest decal 
pin counts is shown.

Logic Family list Specifies the Logic Family (reference designator prefix) 
to use for the part. You can also create a new logic family 
or edit the existing reference designator prefix 
designations by clicking the families button.
Note: Beginning with PADS 9.0, die parts and flip chips 
are no longer identified by their family designations (DIE 
or FLP), but instead by the Special Purpose settings on 
this tab. With this change, you can assign any reference 
designator (logic family) to a die part or flip chip without 
losing the special properties of these parts (such as the 
ability to move the part's substrate bond pads in the 
design).
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Part Information Dialog Box, General Tab

Ref Prefix Displays the prefix for the selected Logic family.

Families Opens the Logic Families Dialog Box, where you can add, 
edit, or delete a logic family.

Define mapping of Part 
Type pin numbers to PCB 
Decal

Activates the Pin Mapping tab, where you map the 
numerical physical pins in the decal to the alphanumeric 
logical pins in the part type.
Restrictions: 
• The check box is unavailable once you add one or 

more alphanumeric decals to the part type. Remove the 
assigned alphanumeric decals to make the check box 
available.

• You must assign a numeric decal to use the Pin 
Mapping tab.

• Only decals with sequential numerical pin numbers 
can be used with pin mapping.

Special Purpose Check this box, then select the appropriate radio button: 
Connector—Select to identify the part as a connector and 
make the Connector tab available. Connectors do not 
require a prefix list or gate definitions.
Restrictions:
• This check box is automatically selected when you 

create or modify connectors. It is unavailable if you 
open a part other than a connector.

• The Gate Decals tab is unavailable when the 
Connector check box is selected.

• Some Pins tab controls not applicable to connector 
parts are disabled.

Die Part—Select to identify the part as a die part. This 
also allows you to move the substrate bond pads in the 
design.
Flip Chip—Select Flip Chip to identify the part as a flip 
chip. This also allows you to move the substrate bond pads 
in the design.
Note: Beginning with PADS 9.0, die parts and flip chips 
are identified by these Special Purpose settings instead of 
by their family designation (DIE or FLP). With this 
change, you can assign any reference designator (logic 
family) to a die part or flip chip.

Table 45-252. General Tab Contents (cont.)

Name Description
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Related Topics

Creating a New Part Type

Part Information Dialog Box, PCB Decals Tab
Use the PCB Decals tab in the Part Information dialog box to specify the decal, or footprint, for 
a part. The decal determines the number of pins in the part.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > PCB Decals tab

ECO registered part Identifies the part as eligible for transfer between the 
design file and the schematic file during forward 
annotation or backward annotation. You can override this 
setting when creating the ECO file. You can specify it 
when generating an .eco file using either the ECO 
Toolbar, or the Compare/ECO dialog box.
Tip: Typically you do not select this check box for non-
electrical parts. For example, if you create a mounting 
hole to add to your design, you would not need the part 
(mounting hole) to pass back to the schematic software 
when you perform a backward annotation of the design.

Prefix list Applies the part information to other parts in the library. 
Use the prefix with wildcards to identify the parts you 
want.
Examples:
• Question mark ? in a prefix acts as a wildcard for one 

character. The prefix “?4” is the equivalent of “54” or 
“74”.

• If you type “\02” as the suffix, the edits are applied to 
all parts ending in 02.

Warning: The contents of the Prefix List box are applied 
when you click OK or Save As on other tabs in the Part 
Information dialog box.

Check Part Checks for missing or inconsistent information.
Tip: Even if you don't click the Check Part button, when 
you exit the tab, the assigned decals are checked to ensure 
that they contain physical pin numbers for all the gate and 
signal pins defined in the Pins tab.

Save As Opens the Save Part Type to Library dialog box.

Table 45-252. General Tab Contents (cont.)

Name Description
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Part Information Dialog Box, PCB Decals Tab

Figure 45-282. PCB Decals Tab

Table 45-253. PCB Decals Tab Contents 

Name Description

Preview area Shows the item selected in the Assigned Decals list.

Reset Undoes all changes you made in the PCB Decals tab.

Library list Lists all your available libraries. Filters the Unassigned 
Decals list to only the selected library.

Filter Narrows down your unassigned decals list. 
Tips:
• You can use wildcards in this box.
• Type * (asterisk) in the Filter box to display all decals.

Pin Count Narrows down your unassigned decals list by displaying 
only the decals with the specified number of pins.
Tip: Delete all numbers in the Pin Count box to display all 
decals. This box is always available as a filter to allow 
decals of differing pin counts to be assigned.

Apply Executes the filter arguments.
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Show only Decals with pin 
numbers matching Part 
Type

Filters out decals that do not have pin numbers matching 
existing gate and signal pins on the Pins tab, or the 
physical pin numbers on the Pin Mapping tab.

Unassigned Decals list Lists all unassigned decals available to assign from the 
selected library.
Tip: Double-click a decal to assign it without needing to 
click the Assign button.

Assign >> Moves the selected decal from the Unassigned Decals list 
to the Assigned Decals list.
Assigned PCB decals can have a different number of pins, 
but you must assign a decal with enough pins for all the 
defined gate pins and signal pins on the Pins tab.
Restriction: Only decals with sequential numerical pin 
numbers can be used with pin mapping.

<< Unassign Moves the selected decal from the Assigned Decals list to 
the Unassigned Decals list.

Table 45-253. PCB Decals Tab Contents (cont.)

Name Description
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Part Information Dialog Box, PCB Decals Tab

Assigned Decals list Lists all assigned decals. Assigned PCB decals can have a 
different number of pins, but you must assign a decal with 
enough pins for all the defined gate pins and signal pins on 
the Pins tab.
You can assign up to 16 PCB decals to a part.
Caution: 
• Decals are switched to alternates using the Component 

Properties dialog box and can be changed outside of 
ECO mode. An .eco file created by the ECO toolbar 
will not contain decal changes to alternates unless you 
select the Output Decal Changes check box in the 
ECO Options. If you haven’t specified to record decal 
changes in the .eco file written by the ECO Toolbar, 
you can use the Compare/ECO dialog box to create an 
.eco file that lists changes to alternate decals.

• If you update a part in the library to have alternate 
decals and you use the Update from Library tool, but 
you don’t select PCB decals to be updated, the updated 
alternates won’t be listed in the Decal list for selection 
in the Component Properties dialog box.

Tips:
• The decal at the top of the list is the default decal and 

is used when you add the part to the design.
• When you assign a decal, the pin numbers from the 

decal are automatically populated into the Pins tab 
table. PCB Decal pin numbers can be alphanumeric or 
numeric and the pin numbers in the PCB Decal must 
match the pin numbers listed in the Pins tab table.

Assign New Opens the Assign New PCB Decal Dialog Box where you 
can type the name for a decal that does not yet exist in a 
library. In order to use this part in a design, you must 
either acquire or create this decal.
Restriction: When you assign a decal that exists, it pre-
populates the Pins tab with pin numbers. When you assign 
a new PCB decal, you must enter the pin numbers 
manually. See Adding a Series of Pins to the Pins Table 
for a procedure to quickly add a series of pins.

Up/Down buttons Moves the selected Decal up or down.
Tip: The decal at the top of the list is the default decal and 
is used when you add the part to the design.

Table 45-253. PCB Decals Tab Contents (cont.)

Name Description
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Related Topics

Creating a New Part Type

Part Information Dialog Box, Pins Tab
Use the Pins tab in the Part Information dialog box to assign gate pins, signal pins, and unused 
pins to the part. Pin numbers added to the Pins tab must match those of the PCB Decal. Use the 
Pin Mapping tab to overlay logical (schematic) alphanumeric pin numbers onto the physical 
numeric PCB decal.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Pins tab

Check Part Checks for missing or inconsistent information.
Tip: Even if you don't click the Check Part button, when 
you exit the tab, the assigned decals are checked to ensure 
that they contain physical pin numbers for all the gate and 
signal pins defined in the Pins tab.

Save As Opens the Save Part Type to Library dialog box.

Table 45-253. PCB Decals Tab Contents (cont.)

Name Description
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Part Information Dialog Box, Pins Tab

Figure 45-283. Pins Tab

Table 45-254. Pins Tab Contents 

Name Description

Pins Table Double-click a column to sort the column by ascending 
order.
Tip: Sorting by pin Sequence number or Pin Group has 
the same effect, it sorts by Pin Group and then by 
sequence number within each gate.
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Pin Group column Select from Gate, Signal Pin, Connector Pin or Unused 
Pin.
• Gate Pins—Assign to gates you’ve added to the part 

on the Gates tab.
• Signal Pins—Assign to implicit pins (pins which are 

not displayed on any gate in the schematic). Typically, 
ground and power pins are the only implicit pins. You 
are not required to use Signal Pins. Instead, you can 
add power and ground pins to a gate or create a 
separate gate for power and/or ground pins. For the 
parts in the libraries shipped with PADS Logic, the 
standard ground signal name is GND. The standard 
power signal name is +5V.

• Connector Pins—Assign to connector pins instead of 
using Gate pins. With a connector, every pin is its own 
gate in order to spread each connector pin throughout 
the schematic as needed, instead of having to create 
gates for each pin. You designate a part type as a 
connector on the General tab.

• Unused Pins—You can assign a pin to be an unused 
pin. An unused pin is a pin that is defined in a PCB 
decal but has no electrical function in the part type. 
The unused pin information is not saved in the part 
type, but is derived automatically based on the number 
of assigned gate and signal pins to the number of pins 
in the assigned PCB decal.

Number column Specifies the pin number for the pin.
Requirement: The pin number must match the PCB 
decal. For example, alphanumeric to alphanumeric.

Name column Specifies the pin signal or function name of the pin.
Requirement: The pin must have a name to be valid.

Type column Specifies the type of pin.
Tip: This column is used with gate pins only.

Swap column Specifies an identical number between pins that can be 
swapped.
Tip: Type 0 to disable swapping.

Table 45-254. Pins Tab Contents (cont.)

Name Description
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Part Information Dialog Box, Pins Tab

Seq. column Specifies the sequence number.
Tip: The sequence number determines the mapping of 
CAE gate pins to PCB decal pins. The sequence is 
automatically shared with alternate CAE decals. For 
example, it shows how pin numbers appear on the CAE 
gate decal; therefore, in Gate A, sequence number 1 could 
be pin 1, but in Gate B, sequence number 1 would be pin 
4.

Reset button Undoes all changes you made in the Pins tab.

Edit button Makes the selected cell available for editing. Press Ctrl or 
Shift and click to select multiple cells from the same 
column, then click Edit to make the same changes to the 
selected cells. The action of the edit button depends on the 
cells you select:
• Pin Group column—Opens the Update Pin Gate 

dialog box.
• Number column—Opens the Renumber Pins dialog 

box.
• Name column—Opens the Update Pin Name dialog 

box.
• Type column—Opens the Update Pin Type dialog 

box.
• Swap column—Opens the Update Pin Swap dialog 

box.
• Seq. column—Not available for multiple cell edits.

Add Pin button Adds a new row below the selected row. If it's the first pin 
to be added it takes the default of belonging to Gate-A. If 
pins already exist, the new pin takes the Pin Group of the 
currently selected pin.
Requirement: You must add a pin number to make the 
pin valid.
Tips: 
• You can add all pins automatically by adding a decal.
• To add a series of pins, click the Add Pins button.
• To import pins using a comma separated value (.csv) 

file, click the Import CSV button.

Table 45-254. Pins Tab Contents (cont.)

Name Description
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Add Pins button Opens the Add Terminals Dialog Box.
Restriction: Total pins for the part can not exceed 32,767 
pins.
Tips: 
• You can add all pins automatically by adding a decal.
• To add a single pin, click the Add Pin button.
• To import pins using a comma separated value (.csv) 

file, click the Import CSV button.

Delete Pins button Removes the selected row.

Renumber button Opens the Renumber Pins Dialog Box.

Copy button Places the selected cell information in the paste buffer. 
Tip: You can also copy from Microsoft Excel.

Paste button Pastes the information from the paste buffer. The selected 
cell in the table is the paste origin. Data is pasted below 
and to the right of the paste origin.
Restriction: When the pasted data includes either Pin 
Group or Pin Number data, extra pin rows are added 
automatically, otherwise the paste will fail if the number 
of rows and columns in the pasted data does not match 
those available in the table below and to the right of the 
paste origin.

Import CSV button Opens the Library Import File dialog box where you select 
the .csv file to import.
Tips:
• The entire contents of the Pins tab table is replaced 

with the data of the CSV file.
• CSV field names must correspond to the column 

headers in the Pins tab table. Only the first two 
characters of the header must match. For example, 
“Pi” for the Pin Group column. Gate or “Ga” are 
acceptable alternatives to the Pin Group header.

• The sample Part_Pins_Template.csv file is located in 
your \PADS Projects\Samples folder.

Check Part button Checks for missing or inconsistent information.
Tip: Even if you don't click the Check Part button, when 
you exit the tab, the assigned decals are checked to ensure 
that they contain physical pin numbers for all the gate and 
signal pins defined in the Pins tab.

Save As button Opens the Save Part Type to Library dialog box where 
you choose your library and type a name for the part.

Table 45-254. Pins Tab Contents (cont.)

Name Description
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Part Information Dialog Box, Pin Mapping Tab

Related Topics

Adding a Series of Pins to the Pins Table

Editing Pins Table Data

Renumbering Pins in the Pins Table

Creating a New Part Type

Part Information Dialog Box, Pin Mapping Tab
Use the Pin Mapping tab in the Part Information dialog box to overlay alphanumeric pin 
numbers onto numeric PCB decal pins. Prior to PADS 2007, alphanumeric pin numbers could 
not be saved in PCB decals.

Accessing

• File menu > Library > select a Library > Parts button > select part > New or Edit 
button > Pin Mapping tab

Requirements:

• On the General tab, select the Define mapping of Part Type pin numbers to PCB 
Decal check box to make the Pin Mapping tab available.

• On the PCB Decals tab, assign a decal with sequential numerical pin numbers to use 
the Pin Mapping tab. The decal determines the number of pins in the part.
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Figure 45-284. Pin Mapping Tab

Table 45-255. Pin Mapping Tab Contents 

Name Description

Decal list Lists the decals available to you for which you can map 
alphanumeric pins.

Reset Undoes all changes you made in the Pin Mapping tab.

Unmapped Pins list Lists all unmapped pins available to map in the Mapping 
table.

Map >> Moves the selected pin from the Unmapped pins list to the 
selected cell in the Mapping table.

<< Unmap Moves the selected decal number from the Mapping table 
to the Unmapped Pins list.

Mapping table • Decal column—The number of the Decal.
• Part Type column—The value of the Attribute.

Edit Makes the selected cell available for editing.
Tip: You can also double-click the cell to edit the 
contents.
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Part Label Properties Dialog Box

Related Topics

Creating a Part Type with Different Schematic and Layout Pin Numbering

Mapping Alphanumeric Pin Numbers to Numeric Decals

Creating a New Part Type

Part Label Properties Dialog Box
Use the Part Label properties dialog box to modify a label and to change the attribute the label 
displays. 

Tip: If you select multiple labels, settings in this dialog box apply to all selected labels.

Copy Map Places the map information into the paste buffer to paste 
into Microsoft Excel where you can make mass edits.
Restriction: Copy Map only works with the whole pin 
mapping table and not selective rows.

Paste Map Pastes the map information from the paste buffer.
Restriction: Paste Map only works with the whole pin 
mapping table and not selective rows.

Preview area Shows the item selected in the Decal list.
You can assign unmapped pins to decal pins by selecting 
the pins in the preview window. Select an alphanumeric in 
the Unmapped Pins list and double-click the pin in the 
decal preview window to map the alphanumeric to the pin. 
The next row in the Unmapped Pins list becomes the next 
selected alphanumeric for mapping.
In the preview window, you can click and drag to define a 
zoom box, or use Shift+click or Shift+right-click to zoom 
in or out by a factor of two. You can zoom in up to 16X 
the original scale. The preview window will only zoom 
out to fit the decal entirely in the view.

Check Part Checks for missing or inconsistent information.
Tip: Even if you don't click the Check Part button, when 
you exit the tab, the assigned decals are checked to ensure 
that they contain physical pin numbers for all the gate and 
signal pins defined in the Pins tab.

Save As Opens the Save Part Type to Library dialog box.

Table 45-255. Pin Mapping Tab Contents (cont.)

Name Description
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Accessing

• Select a part label > Right-click > Properties

Figure 45-285. Part Label Properties Dialog Box

Table 45-256. Part Label Properties Dialog Box Contents 

Name Description

Attribute The attributes available to you. If you are creating labels 
for jumpers, Reference Designator is the only available 
attribute.
Tip: Hidden attributes do not appear in the Attribute list 
unless the attribute was selected for the label before it was 
set as a hidden attribute.
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Part Label Properties Dialog Box

Value for The value of the selected attribute. 
Tips:
• Unavailable if you selected Reference Designator or 

Part Type from the Attribute list, if the attribute is 
read-only, or if you open the Properties dialog box for 
labels of different attribute types. However, if the 
labels you select belong to attributes of the same type, 
you can edit this box.

• If the attributes have different values, the box is blank. 
You can type a new value in the box to apply it to all 
of the selected attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-
registered and PADS Layout is not in ECO mode. 

Show Controls the visibility of the label. 
• None—Turns visibility off.
• Value— Displays only the label value.
• Name and Value—Displays the name and value.
• Full Name and Value—When labeling a  structured 

attribute, displays the full structured name and value.
Tip: Labels are invisible regardless of this setting unless 
you use the Display Colors Setup dialog box to change the 
color of labels to a color different from that of the 
background.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, 

or any combination of styles: B for bold, I for italic, or 
U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the 
component or the jumper. If you clear this check box, the 
label is placed at the X and Y location relative to the 
design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Table 45-256. Part Label Properties Dialog Box Contents (cont.)

Name Description
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Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for 
system fonts
Size (mils): This is font character height and appears for 
stroke fonts. The size refers to the height of the tallest 
characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the 
bottom side of the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to 
ensure proper positioning between objects when text, 
attribute values, size, or width change.
Tips: 
• For vertical justification, click Left, Center, or Right. 

For horizontal justification, choose Up, Center, or 
Down. 

• Optionally, set justification by selecting the text, then 
right-clicking and clicking Justify Horizontally, and 
then clicking Left, Center, or Right; and by right-
clicking and clicking Justify Vertically, and then 
clicking Up, Center, or Down.

Right reading Controls whether labels are readable (from left to right, or 
from bottom to top if the label is rotated). Click the None, 
Orthogonal, or Angled button to indicate the direction of 
reading you want.

Component button Opens the Component Properties dialog box.

Table 45-256. Part Label Properties Dialog Box Contents (cont.)

Name Description
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Part Type List for Decal Dialog Box

Related Topics

Modifying Part Label Properties

Part Type List for Decal Dialog Box
Use the Part Type List for Decal dialog box to check your part for errors. You can check to 
ensure the pins match the pins listed in the Part Type > Pins tab table, or when pin mapping 
exists - on the Part Type > Pin Mapping tab.

Accessing

• Opens automatically when you open a decal in the Decal Editor

• Tools menu > PCB Decal Editor > Tools menu > Part Types

Figure 45-286. Part Type List for Decal Dialog Box

Table 45-257. Part Type List for Decal Dialog Box Contents 

Name Description

Library column Displays the associated part type library.

Part Type column Displays the part type name.

Pin Mapping column Displays whether a pin mapping is defined.

Error Status column • No Errors—No errors exist within the part type.
• Logical Errors—Errors exist within the part type.
• Mismatched Pins—The decal does not contain all the 

pin numbers defined in the part type.
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Related Topics

Checking for Errors Between Part Types and Assigned PCB Decals

PCB Decal Editor
PADS Layout uses components from the parts libraries. Every part in the library has a decal 
associated with a part type in a parts library. Use the PCB Decal Editor to create or edit these 
decals. Many of the drafting operations in the PCB Decal Editor are identical to those in the 
Layout Editor.

When the PCB Decal Editor opens, the open design is stored and the PCB Decal Editor 
interface replaces the Layout Editor. Use the File commands to save information and exit the 
PCB Decal Editor as you would a stand-alone program. When you exit the PCB Decal Editor, 
you return to the open design in PADS Layout.

If during a PCB Decal Editor session you try to change the decal to increased layer mode and 
the current design is in default layer mode, the message “You will not be able to apply decal 
changes to the design. Continue?” appears. Either click Cancel to return to the Layers Setup 
Dialog box without changing the decal to increased layer mode, or press OK to proceed to the 
Increase Maximum Layer Number dialog box. You can save the decal changes to library and 
choose to exit the PCB Decal Editor without applying changes. Then switch the current design 
to increased layer mode and update the decal.

Tips: 

• PADS Layout supports 16 alternate decals per part type. The PCB Decal Editor supports 
up to 65,536 components.

• You can use Dimensioning within the PCB Decal Editor; however, dimensions are 
converted to 2D lines and text when you save the decal.

Recommendation: Place free text and attribute values on the Silkscreen Top layer to avoid 
DRC violations or shorts.

Edit Part Opens the Part Information dialog box.

Show Errors Create and opens a report with details of the errors.

Refresh Updates the dialog box with any fixes you have made.

Check Decal Checks the decal against all associated part types to show 
all mismatched pin number errors.

Table 45-257. Part Type List for Decal Dialog Box Contents (cont.)

Name Description
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PDF Configuration Dialog Box

Accessing

• Tools menu > PCB Decal Editor

Related Topics

Creating a New Decal

PDF Configuration Dialog Box
Use this dialog box to save one or more layers of your design as images in a PDF document. 
You can specify the contents of the document, its format, and its behavior, including the kinds 
of design items readers can search for, and how they are displayed. 

Accessing

• File menu > Create PDF

This dialog box displays its controls in two views--a “document” view and a “page” view.

The document view appears when the root item (a PDF configuration) is selected in the page list 
at the top left of the dialog box. Settings made in the Document view affect all pages in the 
document.



PDF Configuration Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1401

Figure 45-287. PDF Configuration Dialog Box, Document View
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PDF Configuration Dialog Box

The page view appears when a single page is selected in the page list. Its controls affect only the 
selected page. 

Figure 45-288. PDF Configuration Dialog Box, Page View
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Table 45-258. PDF Configuration Dialog Box Controls

Control/Area Description

Page-list Toolbar (Both views)

Add Page button Adds a page at the bottom of the Page list.

Import Configuration button Imports a PDF configuration from a .pdc file.

Export Configuration button Exports the current dialog box settings (that is, the 
current configuration) to a new or existing configuration 
(.pdc) file.
Tip: Use this button to save the current dialog box 
settings and reuse them for other designs.

Delete Page button Deletes the selected page from the page list.

Move Page Up button Moves the selected page up in the Page list.

Move Page Down button Moves the selected page down in the Page list.

Page-list area (Both views)

Select the top of the Page list (the PDF configuration 
name) to display the Document view, where you specify 
options for the PDF document as a whole.
Select any individual page to display the Page view, 
where you specify options for the selected page.
Tip: The Composite page, by default, includes all the 
selected layers. You can modify the layer assignments 
for this page (like all the other pages) with the Add layer 
and Remove layer buttons in the Selected layers area.

Preview area (Both views)

Shows the position of the selected design layer image(s) 
on the PDF page, as follows:
• The grey outer rectangle shows the available image 

area inside the margins and the header and footer.
• The dashed-line box shows the image boundary 

(scaled, if Scale to fit is selected).
• Inside the image boundary, the board outline is 

shown (scaled, if Scale to fit is selected).

Page <page_number>: edit box

Displays the name of the page selected in the page list. 
You can edit the page name here.

Image area (Both views)

Justification Specifies the position of the design layer image(s) on the 
PDF page. Select Bottom Left, Bottom Right, Centered, 
Top Left, Top Right, or Use offset. 
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PDF Configuration Dialog Box

X offset Specifies the distance of the lower left corner of the 
image boundary from the left side of the PDF page 
boundary.

Y offset Specifies the distance of the lower left corner of the 
image boundary from the bottom of the PDF page 
boundary.
Tip: When the PDF Configuration is selected, this 
checkbox may display a greyed-out check mark or a 
small square; these indicate that the settings of the 
individual pages vary.

Scale Specifies the size of the PDF image as a percentage of 
the actual design size. For example:
• 100%—The image is displayed actual size.
• 50%—The image is displayed half-size.
• 200%—The image is displayed double-size.

Scale to fit Specifies that the PDF image should be enlarged or 
reduced to fit within the margins of the PDF sheet.
Tip: When the PDF Configuration is selected, this 
checkbox may display a greyed-out check mark or a 
small square; these indicate that the settings of the 
individual pages vary.

Mirror image Flips the PDF image left/right.
Tip: When the PDF Configuration is selected, this 
checkbox may display a greyed-out check mark or a 
small square; these indicate that the settings of the 
individual pages vary.

Mirror labels Flips standard and attribute labels left/right.
Tip: When the PDF Configuration is selected, this 
checkbox may display a greyed-out check mark or a 
small square; these indicate that the settings of the 
individual pages vary.

Page area (Document view only)

Size Select a PDF page size, or select “Custom” to specify a 
non-standard sheet size.

X Specifies the width of the custom sheet in current design 
units.

Y Specifies the height of the custom sheet in current design 
units.

Orientation area (Document view only)

Table 45-258. PDF Configuration Dialog Box Controls

Control/Area Description
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Specifies the orientation of the design image on the PDF 
sheet(s): Portrait, Landscape, or Best fit.

Color Scheme area (Document view only)

Specifies the color scheme for the PDF: Color (with 
design background color), Color with white background, 
or Black and White.

Bookmarks area (Document view only)

Create bookmarks for Create PDF bookmarks (Table of Contents entries) for 
the items selected (Components, Component pins, Net 
pins)

Highlight selection Specifies that the Acrobat PDF viewer should:
• Highlight an item when it is selected. 
• If the item is located outside the PDF document 

window, pan to move it to the center of the window.

Pan to selection Specifies that the Acrobat PDF viewer should pan to an 
item when it is selected. The item will appear in the 
upper left corner of the PDF document window.

Zoom to selection Specifies that the PDF viewer should pan and zoom to an 
item when it is selected, using the zoom factor set in the 
Zoom factor field. The item will appear in the center of 
the PDF document window.

Zoom factor Sets the factor to be used when zooming to a selected 
item:
• 100% is the maximum; the item will occupy the 

entire window.
• 10% is the minimum; the item will occupy 10% of 

the window area.

Annotations area (Document view only)

Create annotations that will
display part attributes

Creates popup notes that display an item’s attributes 
when the reader left-clicks on the item.

Visible rectangle around
object with annotations

Draws a dotted line rectangle around each annotated 
item.

Fonts area (Document view only)

Replace stroke font for labels
with:

Uses the font selected in the box to display labels that 
use Stroke font in the design.

B, I, and U buttons Applies any or all of Bold, Italic and Underline styles to 
labels converted from Stroke font.

Table 45-258. PDF Configuration Dialog Box Controls

Control/Area Description
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Pen Plotter Advanced Setup Dialog Box

Pen Plotter Advanced Setup Dialog Box
Use the Pen Plotter Advanced Setup dialog box to add a new pen plotter to the Device list of 
available plotters.

Header and Footer area (Document view only)

Specifies optional text for the left, right and center of the 
header and footer. At the bottom of the list, select 
Custom to open the Custom String dialog box and type 
your own custom text.

Assembly Options area (Page view only)

Use assembly variant Includes in the PDF document only components 
belonging to the variant selected in the Name: box. 
The visibility of the following design items is affected:
• Component outlines top
• Component outlines bottom
• RefDes labels
• Part type labels
• Component attribute labels

Board Items area (Page view only)

Includes in the PDF document PCB design items not 
belonging to a specific layer. Select any or all of Board 
outline, Unrouted connections, Through-holes plated, 
and Through-holes non-plated.

Selected Layers area (Page view only)

List box Lists the layers that will be shown on this page of the 
PDF document.

Add Layer button Opens the Layer Selection dialog, where you can edit the 
list of layers assigned to this PDF page.

Remove Layer button Removes the selected layer(s) from the list.

Items on selected layer(s) area (Page view only)

Includes items in this page of the PDF document. Select 
any or all of Through-hole pads, SMD pads, Traces, 2D-
Lines, Vias, Coppers, Hatch outlines, Pour outlines, 
Keepouts, Ref. des. labels, Part type labels, Text, 
Attribute labels, Component outlines top, Component 
outlines bottom, Test points, Partial drills, and Pin 
numbers.

Table 45-258. PDF Configuration Dialog Box Controls

Control/Area Description
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Restriction: You cannot modify the PADS-supplied plotter advanced settings - you only edit 
the data for an existing plotter if it was created originally from this dialog box. The new plotter 
must support one of the two supported interface languages: HPGL or HGML. Other plotter 
languages or formats are not yet supported.

Accessing

• File menu > CAM > Add button > Pen button > Device Setup button > Advanced 
button

or

• File menu > CAM > select a document name > Edit button > Pen button > Device 
Setup button > Advanced button

Figure 45-289. Pen Plotter Advanced Setup Dialog Box

Table 45-259. Pen Plotter Advanced Setup Dialog Box contents 

Name Description

Plotter Device Name Specifies the name of a different pen plotter you want to use.
Restriction: You cannot reuse one of the existing, supplied 
device names.

Device Type Specifies the interface language the plotter uses: HPGL or 
HGML.

Plotter Units area Sets the plotter resolution by providing a scaling ratio. The 
ratio defined is the scale factor to convert from mils (0.001 in) 
to plotter units.
Example: Most Hewlett-Packard plotters have a resolution of 
0.025 mm or 1/40 mm. This means that a distance of one inch 
(1000 mils) is 1016 plotter units (25.4 X 40). So a ratio of 1016 
to 1000 would be defined. The ratio actually used is 254 to 250 
which is the same as 1016 to 1000.

Origin at Center Specifies that the origin of the plotter is at the center of the 
paper. Clear this check box if the origin is in the lower left 
corner or other location.
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Pen Plotter Setup Dialog Box

Related Topics

Pen Plotter Setup Dialog Box

Creating CAM Outputs to Manufacture Your PCB

Pen Plotter Setup Dialog Box
Use the Pen Plotter Setup dialog box to set various pen plot options.

Accessing

• File menu > CAM > Add button > Pen button > Device Setup button

or

• File menu > CAM > select a document name > Edit button > Pen button > Device 
Setup button

Figure 45-290. Pen Plotter Setup Dialog Box

Table 45-260. Pen Plotter Setup Dialog Box contents 

Name Description

Number of pens Specifies the number of pens in your device (1-16).

Pen line width Specifies the line width of your pen in mils.

Rotate axis Reverses the X and Y axes of the design
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Related Topics

Creating CAM Outputs to Manufacture Your PCB

Photo Plotter Advanced Setup Dialog Box
Use the Photo Plotter Advanced Setup dialog box to customize the output of photo plot files.

Accessing

• File menu > CAM > Add button > Photo button > Device Setup button > Advanced 
button

or

• File menu > CAM > select a document name > Edit button > Photo button > Device 
Setup button > Advanced button

Pen colors Specifies the color of each pen. To assign colors, select a color 
tile from the Selected color area and then click a pen number.
Tip: The assigned colors are used to customize CAM 
document objects through the Select Items dialog box.

Selected color Specifies the colors available for your Pen colors.

Plotting Size area Specifies the plotting size you want to use.
Tip: To define a custom size, select Custom (mm) or Custom 
(inches), and then type the X and Y dimensions to use.

Device Specifies the plotter device to use.
Tip: If you can't find your device in the list, click Advanced to 
open the Pen Plotter Advanced Setup Dialog Box and create a 
new device listing.

Advanced Opens the Pen Plotter Advanced Setup dialog box.

Table 45-260. Pen Plotter Setup Dialog Box contents (cont.)

Name Description
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Photo Plotter Advanced Setup Dialog Box

Figure 45-291. Photo Plotter Advanced Setup Dialog Box

Table 45-261. Photo Plotter Advanced Setup Dialog Box contents 

Name Description

Units Sets the CAM file measurement units.
• English—mils
• Metric—millimeters

Leading Specifies the precision of the output file coordinates; the 
number of digits that should lead the decimal point.

Trailing Specifies the precision of the output file coordinates; the 
number of digits that should trail the decimal point.

Coordinates Sets the coordinates for the output file.
• Absolute—referenced to the origin. 
• Incremental—measured relative to the previous 

coordinate. 

Suppress repeated 
coords

Eliminates repeated coordinates from the output file.

Zero suppress Defines how to handle zero suppression in the output file. 
• None—retains leading and training zeros.
• Leadin —suppresses zeros before the decimal point.
• Trailing—suppresses zeros after the decimal point.
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Circular interpolation Defines how to draw arcs and circles: 
• None—Specifies that your photo plotter does not support 

circular interpolation. Arcs and circles are drawn as small 
straight-line segments.

• Quadrant—Specifies that your photo plotter does not 
support full, 360-degree circular interpolation.

• Full—Specifies that your photo plotter supports full, 360-
degree circular interpolation.

Restriction: these options are only available for the RS-274-D 
format. If you select RS-274-X format, these options are 
unavailable and is automatically set to Full. All devices that 
support RS274X support this setting.
Tip: Use RS-274-X output to avoid generating a large number 
of hatch lines in the Gerber output. This also applies to copper 
chamfered paths.

Output format Specifies the output format you want to use. The RS-274-X 
data format has more features and contains embedded aperture 
information while the RS-274-D format is older and uses a 
separate file for aperture information.
Restrictions: When you select RS274X:
• The Circular Interpolation options are unavailable and is 

automatically set to Full. All devices that support RS274X 
support this setting.

• The Aperture Count in the Photo Plotter Setup Dialog box 
is unavailable and is automatically set to 989. All devices 
that support RS274X support this setting.

Tip: The Output Format setting is saved in the devicesn.dat 
file with all other photo plotter data.

Plotting size list Sets the plotting size, select a standard Plotting size from the 
list, or select Custom (Inches) or Custom (mm) and enter the 
X and Y dimensions to define a custom size.

Table 45-261. Photo Plotter Advanced Setup Dialog Box contents (cont.)

Name Description
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Photo Plotter Advanced Setup Dialog Box

Use fill mode (G36, 
G37)

Uses fill mode to draw all filled regions (including solid shapes 
and system font texts) in the design. Fill mode avoids 
generating a large number of hatch lines in the Gerber output. 
This also applies to copper chamfered paths.
Warning: When using fill mode, compare your final RS-274-
X output (whether it is from PADS Layout or a Gerber viewer) 
against output from RS-274-D. Use a Gerber viewer to 
perform the comparison and check for overfilling or missing 
fills.
Tip: When this option is selected, the Use fill mode for solid 
shapes and Use fill mode for system font texts options are 
selected and unavailable.
Note: This option uses G36, G37 pairs to draw filled regions. 
All filled regions for which fill mode is not specified by one of 
these commands are plotted as hatched by strokes, as in 
PowerPCB 1.6 or earlier.

Use fill mode for solid 
shapes

Uses fill mode to draw shapes having the “solid copper” 
property. Fill mode avoids generating a large number of hatch 
lines in the Gerber output. This also applies to copper 
chamfered paths.
Warning: When using fill mode, compare your final RS-274-
X output (whether it is from PADS Layout or a Gerber viewer) 
against output from RS-274-D. Use a Gerber viewer to 
perform the comparison and check for overfilling or missing 
fills.
Restriction: Unavailable when the Use fill mode is selected.
Note: This option uses G36, G37 pairs to draw filled regions. 
All filled regions for which fill mode is not specified by one of 
these commands are plotted as hatched by strokes, as in 
PowerPCB 1.6 or earlier.

Use fill mode for system 
font texts

Uses fill mode to draw system font texts. Fill mode avoids 
generating a large number of hatch lines in the Gerber output. 
This also applies to copper chamfered paths.
Warning: When using fill mode, compare your final RS-274-
X output (whether it is from PADS Layout or a Gerber viewer) 
against output from RS-274-D. Use a Gerber viewer to 
perform the comparison and check for overfilling or missing 
fills.
Restriction: Unavailable when the Use fill mode is selected.
Note: This option uses G36, G37 pairs to draw filled regions. 
All filled regions for which fill mode is not specified by one of 
these commands are plotted as hatched by strokes, as in 
PowerPCB 1.6 or earlier.

Table 45-261. Photo Plotter Advanced Setup Dialog Box contents (cont.)

Name Description
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Related Topics

Creating CAM Outputs to Manufacture Your PCB

RS-274-X Format

Adding or Editing CAM Documents

Photo Plotter Setup Dialog Box
Use the Photo Plotter Setup dialog box to set up photo plotting and send your output to a plotter

Accessing

• File menu > CAM > Add button > Photo button > Device Setup button

or

• File menu > CAM > select a document name > Edit button > Photo button > Device 
Setup button

Figure 45-292. Photo Plotter Setup Dialog Box

Use aperture macros Defines aperture macros for associated pin copper in the RS-
274-X Gerber files. When this option is off, associated coppers 
are hatched coppers, as in RS-274-D output. This prevents the 
reuse of D-codes that are not supported in some software.

Table 45-261. Photo Plotter Advanced Setup Dialog Box contents (cont.)

Name Description
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Photo Plotter Setup Dialog Box

Table 45-262. Photo Plotter Setup Dialog Box contents 

Name Description

D-Code Contains the apertures required for the Photo Plotter. The 
D-Code list can be created automatically or you can maintain it 
manually. The D-Code list contains all defined apertures.
Tip: Before you generate your CAM files, regenerate your list 
of apertures.

Add button Adds a new D-code to the D-Code list.
Tip: Type a value excluding the “D” prefix.

Delete button Removes the selected D-code from the D-Code list.

Augment button Automatically generates D-codes for items in the design file 
that are not in the current list.
Tip: Augment adds oval and rectangular flash apertures for 
orthogonal orientations only.

Regenerate button Clears the current D-code list and automatically adds D-codes 
for all items in the design.
Tip: Regenerate adds oval and rectangular flash apertures for 
orthogonal orientations only.

Flashes Sets a flash aperture.

Lines Sets a line aperture.
Restriction: Unavailable if Same aperture for flashes/lines is 
selected.

Same aperture for 
flashes/lines

Specifies to draw lines and flashed items with the same 
aperture.

Width Specifies a width for square, rectangle, and oval shapes or the 
outer diameter of round and thermal shapes.
Restriction: This box is unavailable if a value is not 
appropriate for the specified shape.

Height Specifies a height for oval and rectangular shapes.
Restriction: This box is unavailable if a value is not 
appropriate for the specified shape.

Inner diam Specifies an inner diameter for annular ring shapes
Restriction: This box is unavailable if a value is not 
appropriate for the specified shape.

Augment on-the-fly Automatically adds apertures as you add information to the 
design.
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Related Topics

Creating CAM Outputs to Manufacture Your PCB

Setting Up the Photo Plotter Output

Adding or Editing CAM Documents

Pin Numbers Dialog Box
Use the Pin Numbers dialog box to interactively renumber the terminals in the design area. 
Selecting pin numbers in the dialog box selects the matching pins in the design area and 
selecting pins in the design area selects the matching pins in the dialog box.

Accessing

• PCB Decal Editor > Setup menu > Pin Numbers

Aperture count Specifies the maximum aperture count.
Restriction: When you click RS-274-X format in the Photo 
Plotter Advanced Setup dialog box, the aperture count is set to 
989 and is unavailable.

Fill width Specifies the width used for shapes to be filled. An example 
shape is a non-orthogonal pad. Larger widths decrease photo 
plot time but provide a less precise approximation of the shape.

Texts fill width Specifies the width used for hatching of system texts. Larger 
widths decrease photo plot time but provide a less precise 
approximation of the text.

Advanced button Opens the Photo Plotter Advanced Setup dialog box

Table 45-262. Photo Plotter Setup Dialog Box contents (cont.)

Name Description
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Pin Pair Properties Dialog Box

Figure 45-293. Pin Numbers Dialog Box

Related Topics

Renumbering Using the Pin Numbers Dialog Box

Pin Pair Properties Dialog Box
The Pin Pairs Properties dialog box displays the netname of which the pin pair is part, the pin-
to-pin connection, routing information, and rules data.

The Pin Pair Properties dialog box remains open until you click OK or Cancel. If you select 
another pin pair while the dialog box is open, the information updates for the selected pin pair.

Table 45-263. Pin Numbers Dialog Box Contents 

Name Description

Number The number of the pin available for renumbering.

Edit Makes the selected pin number available for editing.

Renumber Opens the Renumber Pins dialog box.

Copy Places the selected pin numbers into the paste buffer.

Paste Pastes the pin number information from the paste buffer.
Restriction: Data only pastes into selected cells.
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Tip: Several of the options in this dialog box are unavailable if the pin pair is part of a physical 
design reuse or contains protected routes.

Accessing

• Select a pin pair > Right-click > Properties

Figure 45-294. Pin Pair Properties Dialog Box

Table 45-264. Pin Pair Properties Dialog Box contents 

Name Description

Net Displays the net name of the pin pair.

Connection Displays the component pin connections that define the pin 
pair. For each connection point, the reference designator of the 
component is listed first, followed by a period, then the pin 
number.
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Pin Pair Properties Dialog Box

Layout Data area Displays all layout data about the selected pin pair.
• Coordinates—Display the coordinates of pins that define 

the pin pair.
• Unrouted Length—Displays the length of the pin pair that 

is unrouted.
• Routed Length—Displays the length of the pin pair that is 

routed.
• Via Count—Displays the number of vias that are used in 

the pin pair.
• Impedance (ohm)—displays a baseline impedance value 

of the pin pair. This calculation uses the trace parameters, 
the board material values you set in the Layer Thickness 
Dialog Box, and require at least one adjacent plane to 
display values. A maximum of two adjacent planes are 
used in the calculation. If the plane layer is a split/mixed 
plane layer, you must have a plane shape on the layer. The 
location and outline of the shape and cutouts of the plane 
area are all ignored in the calculation.
You can set a Minimum and Maximum Impedance rule in 
the HiSpeed Rules Dialog Box, but it is only verified when 
you run Tools > Verify Design after you set up a High 
Speed check to check Impedance. It is not verified by 
online DRC.

• Delay (ns)—displays a baseline delay value of the pin pair. 
This calculation uses the trace parameters, the board 
material values you set in the Layer Thickness Dialog Box, 
and require at least one adjacent plane to display values. A 
maximum of two adjacent planes are used in the 
calculation. If the plane layer is a split/mixed plane layer, 
you must have a plane shape on the layer. The location and 
outline of the shape and cutouts of the plane area are all 
ignored in the calculation.
You can set a Minimum and Maximum Delay rule in the 
HiSpeed Rules Dialog Box, but it is only verified when you 
run Tools > Verify Design after you set up a High Speed 
check to check Delay. It is not verified by online DRC.

Protect Routes Protects selected routes or traces from being moved. Similar to 
gluing components but you can allow protected traces to be 
edited by PADS Router in the Routing Rules.
See also: To Protect Routes

Protect Unroutes Protects unrouted connections and the unrouted portions of 
partial routes. Protected unroutes can’t be modified or routed.
See also: To Protect Unroutes

Table 45-264. Pin Pair Properties Dialog Box contents (cont.)

Name Description
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Related Topics

Modifying Pin Pair Properties

Pin Pair Rules Dialog Box
Use the Pin Pair Rules dialog box to define design rules that apply to pin pairs.

Rules Data area Displays some rule information for the selected pin pair.
• Group—If the pin pair is included in a Group rule, the 

Group name is displayed.
• Rule Hierarchy—Displays one of the following from 

lowest priority to highest priority:
• “Default” is shown if the pin pair is using the Default 

rules.
• “Class” is shown if the pin pair is getting its rules from a 

Class rule. Click the Net button to open the Net 
Properties and see the name of the Class to which the net 
belongs.

• “Net” is shown if the pin pair is getting its rules from the 
Net rules.

• “Group” is shown if the pin pair is getting its rules from 
a Group rule. The group name will be shown 
immediately above.

• Pin Pair” is shown if the pin pair has its own rules.
• Trc/Trc Clearance—Displays the Trace to Trace 

clearance value from the Clearance Rules dialog box. See 
the Rule Hierarchy above to determine if the value is from 
the Default, Class, Net, Group or Pin Pair level rules. 
Conditional rules are not shown.

Width—Displays the Recommended Trace Width from the 
Clearance Rules dialog box. See the Rule Hierarchy above to 
determine if the value is from the Default, Class, Net, Group or 
Pin Pair level rules.

Trace Width Modifies the trace width. Type a new value in the box. You are 
restricted to the range of Trace widths you have specified in 
the Clearance Rules dialog box. This option is unavailable if 
the Protect Routes checkbox is selected. 

Rules button Opens the Pin Pair Rules dialog box with the pin pair 
preselected in order to apply Pin Pair level rules.

Net button Opens the Net Properties dialog box of the net to which the pin 
pair belongs.

Table 45-264. Pin Pair Properties Dialog Box contents (cont.)

Name Description
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Pin Pair Rules Dialog Box

Accessing

• Setup menu > Design Rules > Pin Pairs button

Figure 45-295. Pin Pair Rules Dialog Box

Table 45-265. Pin Pair Rules Dialog Box 

Name Description

Connections list Lists all connections in the design.

Show pin pairs with 
rules

Specifies to show only pin pairs that have rules.

From net Specifies to display pin pairs for a specific net.
Tip: Select (All_nets) to display all pin pairs.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

HiSpeed Opens the HiSpeed Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule 
button

The picture below each type of rule button identifies which 
rules hierarchy level is used for that rule type. The meaning of 
the picture corresponds to the button in the Hierarchy area of 
the Rules dialog box. For example, if you select a class in the 
Class list and a green polygon appears below the Clearance 
button, then the default values apply to the class.
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Related Topics

Creating Pin Pair Design Rules

Modifying Pin Pair Design Rules

Resetting Pin Pair Rules to Default Rules

Design Rule Hierarchy

Pin Properties Dialog Box
The Pin Properties dialog box displays the component's reference designator, the pin number, 
pin type, function (pin name), swap identification, netname, and coordinates of the selected pin. 

If you select another pin while the dialog box is open, the dialog box updates with information 
about the selected pin.

Accessing

• Select a pin > Right-click > Properties

Net: Lists the net(s) associated with the pin pair(s) selected in the 
Connections list.

Selected: Lists the pin pair(s) selected in the Connections list.

Default Removes non-default rules from the selected connections, so 
that only default rules apply.

Table 45-265. Pin Pair Rules Dialog Box (cont.)

Name Description
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Pin Properties Dialog Box

Figure 45-296. Pin Properties Dialog Box

Table 45-266. Pin Properties Dialog Box contents 

Name Description

Ref. Des. Displays the reference designator name.

Pin No Displays the numeric or alphanumeric pin number. This is the 
logical pin number if a pin mapping exists in the part type, 
otherwise the physical pin number is displayed.

Decal Pin Displays the decal pin number when pin mapping exists in the 
part type. The physical pin number is shown since the Pin No 
item only displays the logical pin number when there is pin 
mapping.

Pin type Displays the pin type. For example, S is shown for a source 
pin, P is shown for a Power pin.

Function Displays the pin name.

Connection Lists the connection of which the pin pair is a part.

Teardrops Turn off the Teardrops check box to remove teardrops from the 
selected pin. If Generate Teardrops is not turned on in the 
Routing / General page of the Options dialog box, this option 
is unavailable.
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Plane Thermal Determines whether the pin or via is eligible to receive a 
thermal. 
Restriction: This check box is unavailable if the pin is a no-
connect.
The status of a thermal is set individually by pin and via, and 
the thermal indicators will appear on plane layers only. Click 
to clear this check box if you do not want the via or pin to 
connect to any plane.
Once a pin or via is eligible, it is not automatically assigned a 
thermal attribute.
See also: Connecting a Net with a Plane, Setting Pins and Vias 
as Thermals

Test Point Makes the via or pin a test point. 
See also: Performing a Test Point Audit
This is a three-state check box that depends on the state of the 
selected objects. If all of the selected vias or pins are a test 
point, then it is on. If none of the selected vias or pins are a test 
point, then it is off. If some of the selected vias or pins are a 
test point and some are not, then it is undefined. 
You can make all selected vias or pins test points by turning 
Test Point on and choosing Apply. You can remove the test 
point from all selected vias or pins by turning Test Point off 
and choosing Apply. When you click Apply the pad stack is 
automatically checked to see if the via or pin can be a test 
point; for example, you cannot make buried vias test points 
because a probe cannot access a buried via.
Tip: When the via or pin is flagged as a test point, and Show 
Test Points is checked on the Routing / General page of the 
Options dialog box, an arrow is drawn on it in the design:

Table 45-266. Pin Properties Dialog Box contents (cont.)

Name Description
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Place Clusters Setup Dialog Box

Related Topics

Modifying Pin Properties

Place Clusters Setup Dialog Box
Use the Place Clusters Setup dialog box to place the clusters based on connectivity and 
topology. Place Clusters treats all top-level objects with glued members as glued. Place Clusters 
assumes that pin positions of top-level cluster members are located in the center of the top-level 
cluster regardless of the glued member positions.

Accessing

• Tools menu > Cluster Placement > Place Clusters button > Setup button

Top Access Attempts to probe the test point from the top and bottom in 
DFT Audit. The default is bottom; so with Top Access off, 
DFT Audit automatically tries to probe the test point from the 
bottom. 
See also: Performing a Test Point Audit
When you click Apply, the pad stack is automatically checked 
to see if top access is valid; for example, you must assign Top 
Access to partial vias with only top access if you want to use 
the vias as test points.
You can only set the Top Access option if the via or pin is a 
test point (Test Point is on).

Pad Stacks button Opens the Pad Stacks Properties dialog box where you can 
modify the pad stack.
If you make a change to the pad stack and the pin or via is 
locked, the Warning: Test Point Locked dialog box opens.

Component button Opens the Component Properties dialog box where you can 
edit the component location.

Attributes button Opens the Object Attributes dialog box and displays attribute 
information for the selected objects. You can view and modify 
nail diameter and nail number pin attributes for component 
pins, vias, and jumper pins, including test point attributes.

Table 45-266. Pin Properties Dialog Box contents (cont.)

Name Description
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Figure 45-297. Place Clusters Setup Dialog Box

Table 45-267. Place Clusters Setup Dialog Box Contents 

Name Description

Board Outline 
Clearance

Determines how much clusters spread out within the board 
outline. This option works like Percent Part Expansion for 
positioning parts within the board outline.
Tip: Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.

Percent Part 
Expansion

Controls the amount of free space around parts relative to the 
total board area. A setting of 0% places parts as close together 
as possible. Set this value to 100% to place parts as far apart as 
possible.
• Auto—Sets a default value of 75%.
• Manual—Sets a user-defined value.

Tip: Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.

Efforts area Adjusts the pass options in the lower half of this dialog box.
• Recommended—Uses the default values for Number of 

Iterations and Attempts per Iteration.
• High—Doubles the default values for Number of Iterations 

and Attempts per Iteration.
• Let Me Specify—Enables the four Iteration and Swapping 

options so you can specify the values.
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Place Clusters Setup Dialog Box

Related Topics

Using the Cluster Placement Dialog Box

Cluster Placement

Place Clusters Enables placement operations. Clear this option to use only the 
Refine Pass portions of the routine for minor adjustments to 
already placed clusters.

Start Point area • Current Position—Bases automatic placement of clusters 
on the part's current position. This is useful when clusters 
are already located in the board outline; because it tries to 
maintain the current position.

• Random Position—Bases placement of clusters on a 
random position. This option advanced algorithms to place 
clusters that exist outside the board outline.

Display On Screen Displays an outline of each part and its movement throughout 
the automatic placement process.

Adjust Clusters Adjusts placed clusters using different values for number of 
iterations, attempts, swapping, and clearance values set in the 
Efforts area. To activate, click Let Me Specify.

Number of Iterations Specifies the number of placement passes to make. The default 
value accommodates most average designs. Use a lower 
number for small designs and faster processing. Use a higher 
number for large or dense designs.

Attempts per Iteration Within each iteration, attempts are made to position parts, 
minimize net lengths, reduce part overlaps, and keep parts 
inside the board outline. Increase this value to group parts 
closer together and closer to glued parts during an iteration.

Percent from Part 
Swapping

During each iteration, parts, clusters, and unions are either 
swapped with other parts or repositioned to improve 
placement. Use this feature to increase the amount of swapping 
that occurs instead of moving parts.

Component Clearance Determines the distance that clusters spread out within the 
board outline. This option works like the Percent Part 
Expansion option for positioning parts within the board 
outline.

Table 45-267. Place Clusters Setup Dialog Box Contents (cont.)

Name Description
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Place Parts Setup Dialog Box
Use the Place Parts Setup dialog box to control how parts are handled during Automatic 
Placement.

Accessing

• Tools menu > Cluster Placement > Place Clusters button > Setup button

Figure 45-298. Place Parts Setup Dialog Box

Table 45-268. Place Parts Setup Dialog Box Contents 

Name Description

Board Outline 
Clearance

Determines how much clusters spread out within the board 
outline. This option works like Percent Part Expansion for 
positioning parts within the board outline.
Tip: Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.
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Place Parts Setup Dialog Box

Percent Part 
Expansion

Controls the amount of free space around parts relative to the 
total board area. A setting of 0% places parts as close together 
as possible. Set this value to 100% to place parts as far apart as 
possible.
• Auto—Sets a default value of 75%.
• Manual—Sets a user-defined value.

Tip: Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.

Place Parts Enables part placement operations. Clear this option to use 
only the Improve Pass portions of the routine for overlap and 
alignment operations.

Efforts area Adjusts the pass options in the lower half of this dialog box.
• Recommended—Uses the default values for Number of 

Iterations and Attempts per Iteration.
• High—Doubles the default values for Number of Iterations 

and Attempts per Iteration.
• Let Me Specify—Enables the four Iteration and Swapping 

options so you can specify the values.

Start Point area • Current Position—Bases automatic placement of unglued 
parts on the part's current position. This is useful when 
parts are already located in the board outline; because the 
current position is maintained when possible.

• Random Position—Bases placement of parts on a random 
position. This uses advanced placement algorithms to 
create new placements.

Number of Iterations Specifies the number of placement passes to make. The default 
value accommodates most average designs. Use a lower 
number for small designs and faster processing. Use a higher 
number for large or dense designs.

Attempts per Iteration Within each iteration, attempts are made to position parts, 
minimize net lengths, reduce part overlaps, and keep parts 
inside the board outline. Increase this value to group parts 
closer together and closer to glued parts during an iteration.

Percent from Part 
Swapping

During each iteration, parts, clusters, and unions are either 
swapped with other parts or repositioned to improve 
placement. Use this feature to increase the amount of swapping 
that occurs instead of moving parts.

Percent Equivalent 
Swaps

During part swapping, either equivalent or non equivalent 
swaps are made. An equivalent swap would be between two 
parts (or unions) that have the same extents. Setting this value 
to 100% to swap only equivalent parts.

Table 45-268. Place Parts Setup Dialog Box Contents (cont.)

Name Description



Plane Layer Nets Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1429

Related Topics

Using the Cluster Placement Dialog Box

Cluster Placement

Plane Layer Nets Dialog Box
Use the Plane Layer Nets dialog box to assign or unassign nets with plane layers. CAM 
(Negative) planes should only have one net assigned. Split/Mixed may have multiple nets 
assigned. Plane layers contain large copper areas which components can access for ground and 
power. CAM output produces thermal relief connection pads for nets associated with the plane 
layer. 

Accessing

• Setup menu > Layer Definition > select a plane layer > Assign Nets button

Eliminate Overlaps Moves overlapping parts without violating the Percentage Part 
Expansion setting. The Percentage Part Expansion setting is 
lowered if necessary to eliminate overlaps, but will not exceed 
the setting for Minimum Percentage Expansion Allowed.

Minimum Percentage 
Expansion Allowed

Sets the lowest Percentage Part Expansion setting allowed 
during the eliminate overlaps pass.

Align Parts Enables an alignment pass that adjusts neighboring parts to 
improve routability.

Only if No Overlaps Prohibits the alignment pass if overlaps are present.

Display On Screen Displays an outline of each part and its movement throughout 
the automatic placement process.

Table 45-268. Place Parts Setup Dialog Box Contents (cont.)

Name Description
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Plot Options Dialog Box

Figure 45-299. Plane Layer Nets Dialog Box

Related Topics

Setting Up an Outer Layer

Setting Up an Inner Layer

Plot Options Dialog Box
Use the Plot Options dialog box to set plotting options. You can also use this dialog box to gain 
access to the Drill Drawing Options.

Use the Plot Positioning settings to create the best view of your design on the page that you print 
or pen plot. But more importantly, use the Plot Positioning settings to ensure that all the 
documents of the layers of your design align perfectly with one another. The most efficient way 
to correctly align your layers involves using board or global fiducials and using the two-
adjacent-sides types of plot justification.

Table 45-269. Plane Layer Nets Dialog Box Contents 

Name Description

All Nets Lists all nets in the design which you can associate to the 
plane area.

Assigned Nets Lists the nets associated with the plane.

Add >> Adds the net selected in the All Nets list to the Assigned 
Nets list, thus associating the net with the plane.

<< Remove Removes the net selected in the Assigned Nets list to the 
All Nets list, thus breaking the association between the net 
and the plane.
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Use the Preview window to help determine the correct positioning with regard to your output - 
whether a file or a page.

Tip: Jumper pins of SMD jumpers are output on the paste mask layer, similar to SMD 
component output.

Accessing

• File menu > CAM > Add button > Options button

or

• File menu > CAM > select a document name > Edit button > Options button

Exception: If you selected NC Drill as the Document Type, the NC Drill Options dialog box 
opens instead.

Figure 45-300. Plot Options Dialog Box
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Plot Options Dialog Box

Table 45-270. Plot Options Dialog Box contents 

Name Description

Orientation list Sets the orientation angle of the design. Choose from 0, 90, 
180 or 270 degrees rotation.

Justification list Specifies the justification for the plot. Edge style/corner 
justifications use the outermost object and are best used in 
conjunction with board/global fiducials. Choose from:
• Centered—Centers the design within the output media 

boundaries.
• Bottom Left—Aligns output to the bottom left corner of 

the output media.
• Bottom Right—Aligns output to the bottom right corner of 

the output media.
• Top Left—Aligns output to the top left corner of the 

output media.
• Top Right—Align output to the top right corner of the 

output media.
• Offset—Aligns output origin to the x and y offsets.
• Scale to Fit—Scale to Fit automatically adjusts the scaling 

so that the entire output is visible within the output media 
boundaries.

Scaling Defines the plot-size to actual- size ratio. 
Tip: Two to one (2:1) scaling results in a plot that is twice the 
actual size.

X/Y Offset Defines margin offsets which lets you move the design within 
the output media boundaries. The values used for the offset 
place the origin of the design at that point.
Restriction: Unavailable for Centered and Scale to Fit 
justifications.

Mirror Image Specifies to mirror the image.

Mirror Ref. Des. Specifies to mirror reference designators.

Suppress Ref. Des Specifies the reference designators you want to suppress. 
Type the prefixes of all reference designators, a specific 
reference designator, or specify a range of reference 
designators, separated by commas. Use use a tilde to suppress 
a range of designators. Do not add spaces between listings. For 
example,   J,U1,R2~5.

Exclude Pads Specifies to exclude the parts represented by the reference 
designators specified in the Ref. Des. box from the CAM 
document.
Restriction: This check box is only available for Solder Mask 
and Paste Mask outputs.
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Plot Job Name Specifies to plot the .pcb name, time, and date on the plot. 
Restriction: This option is unavailable if the output device is a 
photo plotter.

Plot Window Specifies to plot only the current view in the Layout Editor. 
Clear this option to plot the entire design.
Tip: Pad flashes only appear in the plot output if the flash 
center is within the layout window.

Plot OLE Objects Specifies to plot OLE objects. This option is only available 
when you print the output. You cannot photoplot or pen plot 
OLE objects.
Restriction: You cannot select this option unless the 
orientation is set to zero.
Tip: OLE objects do not appear in the CAM Preview dialog 
box, but they are used in the calculation when the plot location 
is determined.

Filled Lines/Pads Specifies to plot filled lines and pads. Drawing times are faster 
when lines and pads are unfilled.

Over(under)size Pads 
By

Creates global oversized or undersized pads and vias with 
positive or negative values.
See also: Control of Solder Mask and Paste Mask
Restriction: Beginning with PADS2007, the Over(Under)size 
value only applies to electrical layers. To apply the value to all 
layers, see Applying the Over(Under)size Value to All Layers.
Tips: 
• In plane plots, this option also creates clearances. A 

positive value increases the plotted pad size; a negative 
value decreases the plotted pad size.

• You can also use this option to oversize or undersize a pad 
or thermal shape on a plane layer. When defining pads or 
thermals using this option, you cannot define different 
undersize or oversize amounts per pad, but you gain design 
time because you do not have to set size or layer 
requirements in the library or pad stacks.

Generate CAM Plane 
Via Thermals

Creates thermals for vias associated with the plane net. If this 
option is cleared, thermals are not created, and solid 
connections to all plane net associated vias are output. This 
option is available only for CAM plane plots.

Table 45-270. Plot Options Dialog Box contents (cont.)

Name Description
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Plot Options Dialog Box

Related Topics

Creating CAM Outputs to Manufacture Your PCB

Adding or Editing CAM Documents

Use Custom Thermal 
Settings

Specifies to use thermal and aperture settings defined in the 
Pad Stacks Properties dialog box.
If you disable this setting, CAM plane thermals are generated 
according to a set of parameters. See Interpreting CAM Plane 
Thermal Graphics for more information.
Requirement: CAM planes using custom antipads defined in 
the Pad Stacks require that you select the Remove Unused 
Pads check box in the Split/Mixed Planes tab of Options. 
Without this setting enabled, default antipad settings will be 
used instead.
This option is available only for CAM plane plots and only 
when RS-274-X is selected as the photo plotter output format. 
Custom thermals, by default, use the pad size plus the 
clearance to define thermal spokes, whereas default CAM 
plane thermals use the pad size for the outer width of the 
thermal spokes. When brought into CAM350, these shapes are 
too large. Modify these pads accordingly for CAM350.
Restriction: Custom thermals for CAM plane layers do not 
work with the RS-274-D photo plotter output format selected.

Drill Symbols button Opens the Drill Drawing Options dialog box where you can 
define the drill symbols you want to use and set up the drill 
chart.
Restriction: The Drill Symbols button is only available when 
you select the Drill Drawing document type.

Preview area Displays the document. The graphic in the Preview area 
updates as you make changes to the options. The Preview 
window displays the positioning of the design with regard to 
the plot area or printed page. The blue outline shows the board 
outline of your design with respect to the plot area. When 
creating a drill drawing, the preview area will also display the 
position of the Drill Chart (if enabled) with a magenta-colored 
rectangular outline. By default, the drill drawing will be 
positioned with a corner at the design origin. You may need to 
reposition the drill chart to keep from overlapping your design. 
See Creating a Drill Drawing with Drill Table for more 
information.

Table 45-270. Plot Options Dialog Box contents (cont.)

Name Description
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Pour Manager Dialog Box, Flood Tab
Use the Flood tab in the Pour Manager dialog box to fill the area inside copper pour outlines 
with copper, represented by a hatched grid. Flood creates isolation areas around copper, traces, 
and pads that are inside the copper pour outline but are not part of the same net. It also creates 
thermal relief connections around pins that belong to the same net.

Flood floods over instances where a drill size is larger than the pad to which it is assigned. By 
flooding over the drill and pads, the pad remains connected to the plane. So if you flood around 
pads (intending them to get a thermal relief) and these pads have a drill size that is larger than 
the pad size, the pad and drill are entirely flooded over. A connectivity check detects this 
condition. 

Accessing

• Tools menu > Pour Manager > Flood tab

Figure 45-301. Flood tab

Table 45-271. Flood tab contents 

Name Description

Flood Mode Area • Flood All—Floods all copper pour outlines.
• Fast Flood—Floods copper pour that has not previously 

been flooded; in other words, only newly added outlines.

Confirm Flood 
Operations

Enables confirmations for flood operations. When this check 
box is on and you click Start, the “Ok to connect plane(s)?” 
message appears. This message lets you proceed with or cancel 
flood operations.

Start button Starts the flood, hatch, or connection process.

Setup button Opens the Thermals tab of the Options dialog box. Use this tab 
to set the size and shape of thermals.
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Pour Manager Dialog Box, Hatch Tab

Related Topics

Flooding a Copper Pour Area

Pour Manager Dialog Box, Hatch Tab

Pour Manager Dialog Box, Plane Connect Tab

Verify the Design

Pour Manager Dialog Box, Hatch Tab
Use the Hatch tab in the Pour Manager dialog box to fill in the hatch lines of previously flooded 
copper pour areas. You should perform a hatch after manually editing a previously flooded 
copper pour area. Because the hatch lines are not stored, you should also perform a hatch after 
opening a file.

Tip: Unlike the Flood tab, the Hatch command does not create new isolation areas or thermal 
connections. If you’ve moved objects within the pour area or changed thermal settings, you 
need to change the hatch outline to a pour outline and flood the area to generate the new hatch. 
Use the Flood tab instead.

Accessing

• Tools menu > Pour Manager > Hatch tab

Figure 45-302. Hatch tab

Table 45-272. Hatch tab contents 

Name Description

Hatch Mode Area • Hatch All—Restores hatch to areas that are not already 
hatched, to hatch islands that have been edited since the last 
hatch operation, and to all areas when a design is opened. 

• Fast Hatch—Restores only the most recently effected 
hatch outline.
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Related Topics

Hatching a Copper Pour Area

Pour Manager Dialog Box, Flood Tab

Pour Manager Dialog Box, Plane Connect Tab

Verify the Design

Pour Manager Dialog Box, Plane Connect Tab
Use the Plane Connect tab in the Pour Manager dialog box to create connections to a split/mixed 
plane.

Accessing

• Tools menu > Pour Manager > Plane Connect tab

Figure 45-303. Plane Connect tab

Start button Starts the flood, hatch, or connection process.

Setup button Opens the Drafting / Hatch and Flood page of the Options 
dialog box. Use this page to set hatching and flooding options 
for drafting.

Table 45-273. Plane Connect tab contents 

Name Description

Layers list Displays all layers identified as Split/Mixed in the Setup 
Layers dialog box. Click a layer to connect.

Select All button Selects all split/mixed plane layers listed in the Layers list.

Table 45-272. Hatch tab contents (cont.)

Name Description
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Process Indicator Dialog Box, Backward Annotation

Related Topics

Flooding a Plane Area

Pour Manager Dialog Box, Hatch Tab

Pour Manager Dialog Box, Flood Tab

Process Indicator Dialog Box, Backward 
Annotation

Use the Process Indicator dialog box to monitor the annotation progress, display the reports, or 
cancel the annotation process being run by the Backward from PCB process of the DxDesigner 
Link.

Accessing

• Backward Annotation dialog box > click OK.

Confirm Connect 
Operations

Enables confirmations for connect operations. When this check 
box in on and you click start, the “Ok to connect plane(s)?” 
message appears. This message lets you proceed with or cancel 
flood operations. 

Start button Starts the flood, hatch, or connection process.

Setup button Opens the Split/Mixed Plane page of the Options dialog box. 
Use this tab to set the size and shape of thermals.

Table 45-273. Plane Connect tab contents (cont.)

Name Description
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Figure 45-304. Process Indicator Dialog Box, Backward Annotation

Table 45-274. Process Indicator Dialog Box, Backward Annotation Contents

Name Description

Producing original ASCII 
files from DxDesigner

Displays the status of creating all the netlisting files from 
DxDesigner

Producing PADS Layout 
ASCII file for ECOGEN

Displays the status of creating the PADS Layout ASCII 
file used to compare with the schematic netlist to generate 
the .eco file.

Producing ECO file by 
comparing ASCII files

Displays the status of generating the .eco file from 
comparing the ASCII file from both DxDesigner and 
PADS Layout.

Producing PADS Layout 
ASCII file for PCBBCK

Displays the status of generating the .asc file required by 
the DxDesigner backward annotation.

DxDesigner Backward 
Annotation

Displays the status of backward annotating the .eco and 
.asc file into DxDesigner.
Restriction: This Show Report button is only available 
after the process has run. If you’ve chosen to pause before 
this process, you will need to click Continue to finish the 
process.
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Process Indicator Dialog Box, Forward Annotation

Process Indicator Dialog Box, Forward 
Annotation

Use the Process Indicator dialog box to monitor the annotation progress, display the reports, or 
cancel the annotation process being run by the Forward to PCB—Update PCB process of the 
DxDesigner Link.

Accessing

• Forward Annotation dialog box > click OK.

Figure 45-305. Process Indicator Dialog Box, Forward Annotation

Close/Continue button This is a multi-function button. Depending on the state of 
the annotation process, it displays either Close or 
Continue. It displays Close if you click Cancel during the 
annotation process, or if the annotation process is 
complete.
It displays Continue if you’ve decided to pause before the 
final process - backward annotating the .eco and .asc file.

Table 45-274. Process Indicator Dialog Box, Backward Annotation Contents

Name Description
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Process Indicator Dialog Box, Create PCB
Use the Process Indicator dialog box to monitor the annotation progress, display the reports, or 
cancel the annotation process being run by the Forward to PCB—Create PCB process of the 
DxDesigner Link.

Accessing

• Forward Annotation dialog box > click OK.

Table 45-275. Process Indicator Dialog Box, Forward Annotation Contents

Name Description

DxDesigner Forward 
Annotation

Displays the status of creating all the netlisting files from 
DxDesigner

Loading Library Parts to 
PADS Layout

Displays the status of importing the .p file into the library.

Producing PADS Layout 
ASCII file

Displays the status of creating the PADS Layout ASCII 
file used to compare with the schematic netlist to generate 
the .eco file.

Producing ECO file by 
comparison ASCII files

Displays the status of generating the .eco file from 
comparing the ASCII file from both DxDesigner and 
PADS Layout.

Loading ECO file to PADS 
Layout

Displays the status of importing the .eco file into PADS 
Layout.
Restriction: This Show Report button is only available 
after the process has run. If you’ve chosen to pause before 
this process, you will need to click Continue to finish the 
process.

Close/Continue button This is a multi-function button. Depending on the state of 
the annotation process, it displays either Close or 
Continue. It displays Close if you click Cancel during the 
annotation process, or if the annotation process is 
complete.
It displays Continue if you’ve decided to pause before the 
final process - importing the .eco file.
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Process Status Dialog Box

Figure 45-306. Process Indicator Dialog Box, Create PCB

Process Status Dialog Box
Use the Process Status dialog box to monitor the .eco (and .asc) generation progress, display the 
reports, or cancel the process being run by the Compare/ECO process when creating a .eco file.

Accessing

• Compare/ECO dialog box > select Generate ECO File check box > click Run.

Table 45-276. Process Indicator Dialog Box, Create PCB Contents

Name Description

DxDesigner Forward 
Annotation

Displays the status of creating all the netlisting files from 
DxDesigner.

Loading Library Parts to 
PADS Layout

Displays the status of importing the .p file into the library.

Loading ASCII file to 
PADS Layout

Displays the status of importing the .asc file into PADS 
Layout.
Restriction: This Show Report button is only available 
after the process has run. If you’ve chosen to pause before 
this process, you will need to click Continue to finish the 
process.

Close/Continue button This is a multi-function button. Depending on the state of 
the annotation process, it displays either Close or 
Continue. It displays Close if you click Cancel during the 
annotation process, or if the annotation process is 
complete.
It displays Continue if you’ve decided to pause before the 
final process - importing the .asc file.
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Figure 45-307. Process Status Dialog Box

Project Explorer
The Project Explorer shows a hierarchical structure for the objects in your design. It provides 
access to objects and rules. When you update your design, the hierarchical structure is 
automatically updated to reflect the changes you make.

Accessing

• Click the Project Explorer button.

Tip: The Hierarchical structure is available only when a design is open.

Restriction: The Project Explorer is not available in the PCB Decal Editor.

Table 45-277. Process Status Dialog Box Contents

Name Description

Producing ECO file by 
comparing Designs

Displays the status of generating the .eco by comparing 
designs.
Click Show Report to display the .eco file and the .log file.

Producing PADS Layout 
ASCII file for backward 
annotation

Displays the status of exporting the .asc file used in 
backward annotation to DxDesigner.
Restriction: This item is only shown when performing 
back annotation and when you select the Generate ASCII 
File for Back Annotation to Schematic check box.
Click Show Report to display the Layout.err file.
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Project Explorer

Figure 45-308. Project Explorer

Object Types
Objects in the Project Explorer are placed in object groups. Object groups are of two types: 
primary and secondary. 

Restrictions:

• You cannot remove or rename primary object groups.

• Modification of secondary group items is only available in PADS Router.

The following table lists and describes the primary and secondary object groups.

Table 45-278. Object Groups and Subgroups 

Primary Group Product 
Availability

Secondary 
Group

Description

schematic sheets PADS Logic Sheet names Lists all parts on the sheet

Layers PADS 
Layout
PADS 
Router

Electrical layers Lists all electrical layers, 
including plane layers and routing 
layers

General layers Lists all other layers except 
electrical
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Related Topics

Selecting Objects

Zooming to Selection

Components PADS Logic
PADS 
Layout
PADS 
Router

Lists all components and pin 
pairs

Part decals/
PCB decals

PADS Logic
PADS 
Layout
PADS 
Router

Lists all part decals in the design 
or all components that use the 
selected part decal

Nets PADS Logic
PADS 
Layout

Lists all nets in the design

Net objects PADS 
Router

Net classes Lists all nets belonging to net 
classes

Matched length 
net groups

Lists all matched length net 
groups

Nets Lists all nets in the design

Matched length 
pin pair groups

Lists all matched length pin pair 
groups

Pin pair groups Lists all nets belonging to pin pair 
groups (containing pin pair rules)

Conditional rules Lists all nets with conditional 
rules

Differential pairs Lists all differential pairs

Via types PADS 
Router

Lists the via types used in the 
design

CAE decals PADS Logic Lists the CAE decals used in the 
design

PCB decals PADS Logic
PADS 
Layout

Lists the PCB decals used in the 
design

Table 45-278. Object Groups and Subgroups (cont.)

Primary Group Product 
Availability

Secondary 
Group

Description
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Project and Folder Properties Dialog Boxes

Project and Folder Properties Dialog Boxes
Use the Project Properties dialog box and the Folder Properties dialog box to view and edit the 
properties of an Archive Navigator project or folder.

Accessing

• In the Vault view, right-click a project or folder, and click Properties.

Figure 45-309. Project Properties Dialog Box

Table 45-279. Project/Folder Properties Dialog Box Contents

Name Description

Name Specifies the project/folder name.
Tip: Create a name you can search for with the Find in Vault 
tool.

Created The date/time when the project/folder was created

User The user who created the project/folder 

Description Specifies a description attribute for the projec/folder.
Tip: Create a name you can search for with the Find in Vault 
tool.



Project and Folder Properties Dialog Boxes

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1447

Related Topics

Adding a Project Container to the Vault
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Project and Folder Properties Dialog Boxes
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Radial Move Setup Dialog Box
Use the Radial Move Setup dialog box to set up the polar grid origin for radial moves, radial 
move options, and other information related to moving objects radially.

Accessing

• Tools menu > Options > Grids tab > Radial Move Setup button

Figure 45-310. Radial Move Setup Dialog Box

Table 45-280. Radial Move Setup Dialog Box 

Name Description

Polar Grid Origin Area Sets the x-coordinate and y-coordinate for the polar grid origin 
in current design units.

Inner Radius Sets the radius of the inner ring of the polar grid or circular 
array in current design units. You cannot use zero or negative 
values.

Delta Radius Sets the radial distance between neighboring rings of the polar 
grid or circular array in current design units.
For Radial Move, zero sets the Delta Radius equal to the Inner 
Radius. You cannot use negative values.

Auto Rotate Automatically adjusts the orientation of the selected objects on 
the grid.
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Radial Move Setup Dialog Box

Disperse Arranges all of the selected objects on grid sites without 
overlapping. When Disperse is selected, the angular distance 
between neighboring objects is equal to or greater than the 
Delta Angle value. Disperse is useful for initial placing of a 
group of objects on the grid. Also, when Disperse is selected, 
text and reference designators are sorted alphabetically.
In the Decal Editor, Disperse allows intersecting objects. 
Terminals are sorted by increasing pin number.

Use Discrete Radius Sets the mode of radial displacement: smooth or discrete. 
Discrete snaps to points along the polar grid.

Use Discrete Angle Sets the mode of angular displacement: smooth or discrete. 
Discrete snaps to points along the polar grid.

Polar Orientation area Sets the orientation of all selected objects.
• Initial — Retains the individual orientation values of the 

selected objects from their starting positions.
• Let Me Specify — Assigns the same polar orientation to 

the selected objects. Type the orientation in the box.

Sort by Reference 
Designator

Sorts selected items by reference designator when creating or 
modifying an array or during a Radial Move.
When this option is cleared, items are sorted by the order in 
which they were selected.

Start Angle Sets the polar angle, in degrees, of the first grid or circular 
array site. You can type a value between 0.000 and 359.999.

Angle Range Sets the range within which you want to place objects. 360 sets 
a full circle grid or array; smaller values set sector-shaped 
grids or arrays.

Delta Angle Sets the angular distance between neighboring sites within a 
ring.

Sites Per Ring Sets the number of sites for each ring of the grid or array. Type 
a value equal to or greater than 2. You cannot use zero or 
negative values.

Table 45-280. Radial Move Setup Dialog Box (cont.)

Name Description
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Related Topics

To Set Up a Polar Grid

To Use Radial Move

Defining Arrays

Reassign Electrical Layers Dialog Box
Use the Reassign Electrical Layers Dialog box to move data from one electrical layer to 
another.

Accessing

• Setup menu > Layer Definition > Reassign button

Locked Controls the automatic adjustment of Angle Range, Delta 
Angle, and Sites Per Ring for Radial Move. Controls the 
automatic adjustment of Count, Angle, and Angle Range for 
Polar Step and Repeat.
The three settings above, Angle Range, Delta Angle, and Sites 
per Ring, are interdependent; each value depends on the values 
in the other two. Set one of the values and lock it. Set one of 
the unlocked values; the other unlocked value automatically 
updates. For example, if you set Angle Range to 360 and Sites 
Per Ring to 36, Delta Angle updates to 10.

Direction Sets how the sites are placed on the grid or circular array: 
Clockwise or Counterclockwise.

Circular Arrays Lists all circular arrays and unions in the design. If you double-
click an item from the list, the values in that array or union 
appear in the dialog box.
Create and name circular arrays using Create Array. Create and 
name unions using Create Union.
Tip: You can only use this option in the Layout Editor. 

Table 45-280. Radial Move Setup Dialog Box (cont.)

Name Description
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Rename Net Dialog Box

Figure 45-311. Reassign Electrical Layers Dialog Box

Related Topics

To Reassign Electrical Layers

Rename Net Dialog Box
Use the Rename Net dialog box to change the name of a net. This changes the netlist, is 
considered an engineering change and requires ECO mode.

Table 45-281. Reassign Electrical Layers Dialog Box Contents 

Name Description

# of Electrical Layers • Old Layer Number—The layer on which the data 
exists before you reassign the layer.

• Has Data—Indicates whether or not data exists on the 
selected layer.

• New—Displays the new layer number after 
reassignment. If you delete a layer, this column 
displays <delete> in that row.

Old Layer # The number of the old layer selected in the # of Electrical 
Layers list.

New Layer # Displays the layer where the data exists after you reassign 
the layer.

Delete This is enabled when you decrease the number of layers 
and the selected layer has no data. For each layer you 
delete, <delete> appears in that layer's row under the New 
column.
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Restriction

A protected route or physical design reuse element can prevent you from renaming a net in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

Accessing

• select a net > ECO Toolbar > Rename Net

Figure 45-312. Rename Net Dialog Box

Related Topics

Renaming a Net in ECO Mode

Renumber Pins Dialog Box
Use the Renumber Pins dialog box to renumber pins (terminals). You can renumber decal pins 
from the PCB Decal Editor, or part type pins from the Pins tab of the Part Information dialog 
box.

Accessing

• From the PCB Decal Editor:

PCB Decal Editor > select a starting terminal > right-click > Renumber Terminals

• From the Part Information dialog box:

Part Information dialog box > Pins tab > select pin(s) > Renumber button

Table 45-282. Rename Net Dialog Box Contents

Name Description

New Name Type a new name.
Restriction: The maximum netname length is 47 characters.
See also: Illegal Characters in Netnames and Part Names
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Renumber Pins Dialog Box

Figure 45-313. Renumber Pins Dialog Box

Table 45-283. Renumber Pins Dialog Box Contents 

Name Description

Number of pins The number of pins available for renumbering.

Prefix/Suffix For a single pin number, use either Prefix or Suffix box, 
and void the other box. Use both boxes if you want to 
increment one of the values. 
Alphabetic and numeric values can be used in either box.

Pin numbers A preview of pin numbers based on your prefix/suffix 
input.

Increment prefix Sets the prefix as the part of the pin number to increment.

Increment suffix Sets the suffix as the part of the pin number to increment.

Step value Sets the step value. Type a positive or negative number by 
which to increase or decrease the pin number with 
consecutive or stepped values.
Restriction: Step value must be non-zero and be in the 
range -10 to +10. Zero would replicate a single pin 
number and is not allowed.

Verify valid JEDEC pin 
numbering

If using alphanumerics, you can select the Verify valid 
JEDEC pin numbering check box to ensure that legal 
alphanumeric values are used.
Tip: This option only ensures that legal alpha and numeric 
combinations are used. To arrange rows and columns 
according to JEDEC, use the Assign JEDEC Pinning 
option on the Tools Menu.
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Related Topics

Renumbering a Terminal

Report Manager Dialog Box
Use the Report Manager dialog box to generate a report about the parts in a library. You can 
specify the parts and the attributes to include in the report.

Accessing

• File menu > Library > List to File button

Figure 45-314. Report Manager Dialog Box

Table 45-284. Report Manager Dialog Box Contents 

Field or Button Description

Available attributes All attributes of the part types in the selected library.
Click an attribute in the list of select it. (To select additional attributes, 
press CTRL and click each attribute.) Click Include >> to include 
selected attributes in the report.



PADS Layout User’s Guide and Reference Manual, PADS 9.41456

Reports Dialog Box

Related Topics

Creating a Report of the Parts in a Library

Creating a Report of Decals, Lines or Logic Symbols in a Library

Reports Dialog Box
You can use the Reports dialog box to create reports containing properties or netlist information 
for the design. In addition to several predefined report formats, you can create custom report 
formats.

Selected attributes Attributes in the report.
Click an attribute in the list of select it. (To select additional attributes, 
press CTRL and click each attribute.) Click << Exclude to remove 
selected attributes from the report.
The order of attributes in the list is the order of columns in the report. 
Select an attribute and click Up or Down to change the order.

Include >> Includes the selected attributes in the report (moves the attributes to 
the Selected attributes list). Select one or more attributes on the 
Available attributes list and click Include >>.

<< Exclude Excludes the selected attributes from the report (moves the attributes 
from the Selected attributes list back to the Available attributes list).
Select one or more attributes on the Selected attributes list and click
<< Exclude.

Up / Down Moves a selected attribute up or down on the Selected attributes list. 
List order determines the order in which columns appear in the report.

Part Filter Specifies the part types to include in the report.
Type a part type name in the field or use wildcards (*) to specify a 
group of part types. For example:
* Specifies all part types in the library.
+5* Specifies all part types that begin with the characters +5, such as 
+5volt and +5LS07.

Apply Filters the part types.

Parts Lists part types included in the report (as determined by the Part 
Filter).

Run Generates the report and lets you save it either in lst for viewing or 
printing or in csv format for use with MS Excel.

Close Cancels the operation and closes the dialog box.

Table 45-284. Report Manager Dialog Box Contents (cont.)

Field or Button Description
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Accessing

• File Menu > Reports

Figure 45-315. Reports Dialog Box

Related Topics

Creating Reports

Reuse Properties Dialog Box
Use the Reuse Properties dialog box to modify the selected physical design reuse. 

Table 45-285. Reports Dialog Box contents 

Name Description

Path Displays the path to where the reports are located.

Select Report Files for 
Output

Lists the report files (formats) available to you.

Add Opens the Report Format File dialog box where you can 
browse to the format file you want.

Delete Removes the report format from the list and changes the file 
name extension from .fmt to .del.

Use Assembly Variant Specifies to create a report based on an assembly variant 
instead of the base design.

Name list Specifies the variant you want to use.
Restriction: Available only when Use Assembly Variant is 
selected.
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Reuse Properties Dialog Box

Accessing

• Select a reuse > Right-click > Properties

Figure 45-316. Reuse Properties Dialog Box

Table 45-286. Reuse Properties Dialog Box contents 

Name Description

X/Y coordinates Displays the current coordinates of the physical design reuse 
origin. Type new values to move the physical design reuse to a 
new location.

Rotation Displays the current rotation of the physical design reuse. Type 
a new value or use the arrow buttons to change the rotation 
angle.

Glued Sets whether the physical design reuse is glued. Turn on Glued 
to glue the physical design reuse to the board and prevent 
moving the physical design reuse.
If multiple physical design reuses are selected, and some of 
them are glued and others are not, this check box is 
unavailable. You can click Glued to glue all selected physical 
design reuses or click to clear to unglue all selected physical 
design reuses.
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Reuse Name Displays the name of the currently selected physical design 
reuse. Type a new name in the box to rename the physical 
design reuse. The default reuse name is based on the reuse 
type.
The reuse name is checked to ensure it is not already used. If it 
is already used, an error message appears and you can specify 
a different name.
Tip: There is no way to display the reuse name and reuse type 
in the design.

Designator Preferences 
area

• Same or Next Highest—Renames the reference 
designators for component elements and jumpers in the 
physical design reuse. By specifying a renaming method, 
you avoid creating duplicate reference designators between 
the physical design reuse and the design. This renaming 
option adds each component with the reference designator 
defined in the physical design reuse. If the reference 
designator is already used in the design, the next highest 
unused reference designator is assigned. For example, if 
you click this option, and R2 is already used in the design, 
then R1 in the physical design reuse is assigned R1 in the 
design, but R is assigned R3 in the design. Also, R1R1 is 
assigned R1R2 and R1R is assigned R2R. The reuse name 
is checked to ensure it is not already in use. If it is already 
used, an error message appears and you can specify a 
different name.

Table 45-286. Reuse Properties Dialog Box contents (cont.)

Name Description
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Reuse Properties Dialog Box

Designator Preferences 
area (Con’t)

• Start at—Renames the reference designators for 
component elements and jumpers in the physical design 
reuse. By specifying a renaming method, you avoid 
creating duplicate reference designators between the 
physical design reuse and the design. This renaming option 
adds each component with a reference designator starting 
at the number you specify here. The numbering starts at the 
lowest, numbered reference designator. For example, if the 
Start at value is 100, R1 in the physical design reuse is 
assigned R100 in the design. R is also assigned R100 in the 
design, causing duplicate reference designators. In this 
case, an error would occur. Values range from 1 to 9999. 
The value you type here is checked against the design to 
ensure that duplicate reference designators are not created. 
If duplicates occur, an error message appears and you can 
specify a different value.

• Increment by—Renames the reference designators for 
component elements and jumpers in the physical design 
reuse. By specifying a renaming method, you avoid 
creating duplicate reference designators between the 
physical design reuse and the design. This renaming option 
increments the reference designator by the specified 
number. For example, if the Increment by value is 100, the 
R1 in the physical design reuse is assigned R101 in the 
design. Legal characters are 1-9999. The value you type 
here is checked against the design to ensure that duplicate 
reference designators are not created. If duplicates occur, 
an error message appears and you can specify a different 
value.

• Add Suffix—Renames the reference designators for 
component elements and jumpers in the physical design 
reuse. By specifying a renaming method, you avoid 
creating duplicate reference designators between the 
physical design reuse and the design. This renaming option 
adds the specified suffix, up to four characters long, to each 
reference designator. For example, with an A suffix, R1 in 
the physical design reuse is assigned R1A in the design. 
Illegal characters are brackets ({ }), asterisk (*), space, and 
period (.). You can, however, leave the Suffix box empty, 
and that is considered a valid entry. The value you type 
here is checked against the design to ensure that duplicate 
reference designators are not created. If duplicates occur, 
an error message appears and you can specify a different 
value.

Table 45-286. Reuse Properties Dialog Box contents (cont.)

Name Description
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Related Topics

Modifying Physical Design Reuse Properties

Routing Rules Dialog Box
Use the Routing Rules dialog box at any level of the hierarchy to specify the topology type of 
the ratsnest connections, general and autorouting options, and layer and via biasing. You can 
access the Routing Rules dialog box from within PADS Layout or from within the Decal Editor.

•
• When you open the Routing Rules dialog box from the Decal Editor, only options in the 

Vias area are available.

• When you set up Routing rules for pin pairs, groups, components, or decals, the 
following rule settings are unavailable: topology type, copper sharing, maximum 
number of vias.

Accessing

• Setup menu > Design Rules > choose a hierarchy level > Routing button

• Decal Editor > Setup menu > Decal Rules > Routing button

Designator Preferences 
area (Con’t)

• Add Prefix—Renames the reference designators for 
component elements and jumpers in the physical design 
reuse. By specifying a renaming method, you avoid 
creating duplicate reference designators between the 
physical design reuse and the design. This renaming option 
adds the specified prefix, up to four characters long, to each 
reference designator. For example, with an A prefix, R1 in 
the physical design reuse is assigned AR1 in the design. 
Illegal characters are brackets ({ }), asterisk (*), space, and 
period (.). You can, however, leave the Prefix box empty, 
and that is considered a valid entry. The value you type 
here is checked against the design to ensure that duplicate 
reference designators are not created. If duplicates occur, 
an error message appears and you can specify a different 
value.

Net Properties button Opens the Net Properties dialog box where you can resolve 
netname conflicts between netnames in a physical design reuse 
and netnames in the design.

Table 45-286. Reuse Properties Dialog Box contents (cont.)

Name Description
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Routing Rules Dialog Box

Figure 45-317. Routing Rules Dialog Box

Figure 45-318. Vias Section of PCB Decal Editor Routing Rules Dialog Box
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Table 45-287. Routing Rules Dialog Box 

Area Description

Topology type Specifies the topology of the connections (ratsnest) to provide a visual 
pin-to-pin order when routing interactively or moving a part.
Restriction: The Serial source, Parallel source, and Mid-driven settings 
will only function if you have correctly set the pin Type (such as Source, 
Load, Terminator) of the parts.
• Protected—Do not change the order of the connectivity of the 

connections.
Tip: This option disables length minimization.

• Minimized—Order the net by the shortest distance between pins. Net 
reorder or reconnect is permitted.

• Serial source—Order the net in a series order from source pins to 
load pins to a terminator.

• Parallel source—Same as “Serial source” except order the net with 
parallel branches for each source-to-load connection.

• Mid-driven—Divide the net into two branches and order each branch 
in a source to load to terminator order.

See also: Placement and Length Minimization
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Routing Rules Dialog Box

Routing options • Copper sharing—Allow vias or traces to share copper with another 
object.

Restriction: This rule is used only in PADS Router, although you can 
define this rule in PADS Logic, PADS Layout, or PADS Router.

• Priority—Assign a priority from 0 to 100. Nets with higher priority 
are routed first.
Restriction: PADS Router does not use the priority value. This rule 
applies only to SPECCTRA.

• Auto Route—Allow the autorouter to route nets.
• Allow Ripup—Unroute existing traces and reroute the nets.

Tip: Enable this option to ripup traces while DRC Warn or Prevent is 
enabled.

• Allow Shove—Move unprotected traces aside to create room for new 
traces.
Tip: Enable this option to shove traces while DRC Warn or Prevent is 
enabled.
• Allow Shove Protected—Move protected traces aside to make 

room for new traces.

Layer biasing Layers in the Available layers list can not be used for routing and vias can 
not start or end on those layers. Only layers in the Selected layers list can 
be used for routing.
Tip: Double-click a layer to instantly move it to the opposite list, or use 
the Add>> or <<Remove buttons to move one or more layers at a time.

Table 45-287. Routing Rules Dialog Box (cont.)

Area Description
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Tip: To specify default trace widths, use the Clearance Rules dialog box.

Related Topics

Creating Via Routing Rules in the Decal Editor

Design Rule Categories

Design Rule Hierarchy

Routing Strategy Dialog Box
Use the Routing Strategy dialog box to define a strategy for autorouting your design in PADS 
Router. You indicate what passes PADS Router should perform, whether to protect the resulting 
traces, and what intensity to assign to objects.

Vias Vias in the Available vias list can not be used during routing. Only vias in 
the Selected vias list can be used during routing. All other vias are 
restricted vias.
Tips: 
• Double-click a via to instantly move it to the opposite list, or use the 

Add>> or <<Remove buttons to move one or more vias at a time. 
Alternatively, use the Thru>> or Partials>> buttons to move through-
hole vias or partial vias to the Selected vias list.

• This is one of the main criteria for automatic via selection (another is 
the active layer pair). Autoselect allows only vias that begin and end 
on the Layer Pair shown on the Routing tab of the Options dialog box.

Via definition—This button is only available in the PCB Decal Editor 
version of the Routing Rules dialog box. This opens the Setup Via dialog 
box. The Setup Via dialog box does not know about via padstacks in the 
design. Use this dialog box to set up only via names, not the internal 
structure of the pad stacks. These via names should reference the real vias 
in your design, where the internal padstack structure is defined.

Maximum 
number of vias

Restriction: This setting is only used by the autorouter. The 
autorouter considers this to be a hard rule. Interactive routing and design 
verification check this rule. This option is available only when setting 
rules for default, net, and class properties.
• Unlimited Vias—Allow an unlimited number of vias to be used.
• Maximum of—Constrain the number of vias to be used. Type the 

number, 0 to 50000, in the box.
Tip: An insufficient maximum number of vias might increase 
autorouting runtime and reduce completion rates.

Delete button Removes non-default routing rules at the current level of the rules 
hierarchy.
Restriction: You cannot delete the Default Routing rules.

Table 45-287. Routing Rules Dialog Box (cont.)

Area Description
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Routing Strategy Dialog Box

Accessing

• Tools menu > PADS Router > Setup button

Figure 45-319. Routing Strategy Dialog Box
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Table 45-288. Routing Strategy Dialog Box contents 

Name Description

Pass Type Lists the types of passes that PADS Router can make. PADS 
Router uses the following pass types:
• Center pass—Places traces equidistant from component 

pins or vias and each other to evenly distribute any 
available space in the channel.

• Fanout pass—Places vias for inaccessible SMD 
component pins and routes, from the vias to the pins.

• Miters pass—Converts all 90 degree route corners to 
diagonal corners.

• Optimize pass—Analyzes each route and tries to improve 
the quality of the route pattern by removing extra segments, 
reducing via usage, and shortening routed trace lengths. 
This pass includes glossing and smoothing processes.

• Patterns pass—Finds and routes groups of unrouted 
connections that can be completed using typical “c” routing 
patterns, “z” routing patterns, and memory patterns.

• Route pass—The core pass that performs the majority of 
autorouting. During this pass, PADS Router attempts to 
sequentially route each unroute until all connections are 
attempted. The Route pass contains serial, rip up and retry, 
push and shove, and touch and cross processes.

• Test point pass—Analyzes the testability of the design, 
determines which nets require testing, adjusts the routes, 
and inserts test points to improve testability. You can select 
whether to add test points during routing or after routing.
See also: Adding Test Points, Assigning Test Points 
During Autorouting, and Assigning Test Points After 
Autorouting topics in the PADS Router Help for more 
information.

• Tune pass—Adjusts the length of length-controlled traces. 
The pass examines trace lengths for only completely routed 
nets or pin pairs. The pass analyzes the current length of 
each net or pin pair if length rules and length control are 
enabled, based on the following conditions:
• If the cumulative length of the adjacent trace segments is 

within the range of minimum and maximum trace length, 
the tune pass skips the trace and does not adjust it.

• If the trace is longer than the maximum trace length, the 
tune pass rips it up and places it in a queue for routing.

• If the trace length is less than the minimum trace length, 
the tune pass changes the length by adding accordion 
patterns.

Pass Enables or disables the corresponding autorouting pass type.



PADS Layout User’s Guide and Reference Manual, PADS 9.41468

Routing Strategy Dialog Box

Protect Enables or disables the protection of traces and vias completed 
during the corresponding pass type. Protected objects cannot 
be moved or modified. Traces are protected and vias are glued.

Pause Enables or disables a pause at the end of the corresponding 
pass type.
Tip: When you pause autorouting in PADS Router, the pass 
and the point within the pass are stored. When you resume 
autorouting, PADS Router begins where it was paused. Pause 
does not work when routing in background mode.

Intensity Sets the level of rip-up effort and number of subpasses to apply 
to each pass. There are three intensity options:
• Low—Sets low effort, routing as quickly as possible with a 

low completion rate, using maximum vias and trace length. 
Use this setting when you want to complete autorouting 
quickly. The trade-off is your completion percentage.

• Medium—Sets medium effort, routing more slowly with a 
higher completion rate, using fewer vias and shorter traces. 
Use this setting when you want to balance autorouting time 
and completion percentage.

• High—Sets high effort, routing slowly with the highest 
completion rate, using the fewest vias and shortest traces 
possible. Use this setting when you want to complete all 
traces. Your trade-off is the time required to complete 
routing.

Routing Order List Displays the routing order of components, nets, and net classes 
for the selected pass.
This list is empty until you click objects from the Object list 
and click Selected. Set the routing order using the controls in 
the Routing Order area.

Done Displays the status of each routing pass. When a pass 
completes, a check mark appears in this column.

Select by list Lists the objects in the design. Select an object type 
(components, differential pairs, differential pair pin pair 
groups, matched lengths, matched length pin pair groups, nets, 
or net classes) from the list to update the Available area.

Available area Lists all of the available objects of the object type selected in 
the Select by list. Click individual objects to add to the routing 
order.

Default Resets all controls to the default strategy settings.

Table 45-288. Routing Strategy Dialog Box contents (cont.)

Name Description
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Rules Dialog Box
Use the Rules dialog box to assign place and route constraints to the design.

Accessing

• Setup menu > Design Rules

Selected Adds selected objects from the Object list to the Routing Order 
list.
To enable Selected, select a pass type and select an object in 
the Object list.

All Nets Adds all nets not currently in the Routing Order list to the 
Routing Order list. The All Nets entry appears in the Routing 
Order list.
To enable All Nets, select a pass type and select an object in 
the Object list.

Plane Nets Adds nets associated with plane layers to the Routing Order 
list. The Plane Nets entry appears in the Routing Order list.
To enable Plane Nets, select a pass type and select an object in 
the Object list.

Clear button Deletes all items from the Routing Order. To delete only one 
item, click Delete in the Routing Order area.

Routing Order Displays the routing order of components, nets, and net classes 
for the selected pass. This list is empty until you click a pass 
type.
To add an object to the routing order, click the object and click 
Selected.
The following options are available for altering the routing 
order:

• —Deletes selected nets from the Routing Order list. 
Nets are not deleted from the design; they are only 
removed from the routing order.

• —Moves the selected object up one position in the 
routing order.

• —Moves the selected object down one position in the 
routing order.

Table 45-288. Routing Strategy Dialog Box contents (cont.)

Name Description
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Rules Dialog Box

Figure 45-320. Rules Dialog Box

Related Topics

Design Rule Hierarchy

Table 45-289. Rules Dialog Box 

Name Description

Default Opens the Default Rules Dialog Box.

Class Opens the Class Rules Dialog Box.

Net Opens the Net Rules Dialog Box.

Group Opens the Group Rules Dialog Box.

Pin Pairs Opens the Pin Pair Rules Dialog Box.

Decal Opens the Decal Rules Dialog Box.
Restriction: You can define Decal Rules in PADS Layout; 
however, these rules are used in PADS Router only.

Component Opens the Component Rules Dialog Box.
Restriction: You can define Component Rules in PADS 
Layout; however, these rules are used in PADS Router only.

Conditional Rules Opens the Conditional Rule Setup Dialog Box.

Differential Pairs Opens the Differential Pairs Dialog Box.
Restriction: You can define Differential Pairs Rules in PADS 
Layout; however, these rules are used in PADS Router only.

Associated Nets Opens the Associated Net Rules Dialog Box.

Report Opens the Rules Report Dialog Box.
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Rules Report Dialog Box
You use the Rules Report dialog box to create reports containing information about design rules 
for the design.

Accessing

• Setup menu > Design Rules > Report button

Or

• Setup menu > Design Rules > choose a hierarchy level > Report button

Figure 45-321. Rules Report Dialog Box
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Rules Report Dialog Box

Related Topics

Creating a Report of the Design Rules

Table 45-290. Rules Report Dialog Box contents 

Name Description

Rules Type area Specifies the rule types on which you want to report.

Pin Pairs area Specifies the pin pairs on which you want to report.
Tip: Select All pin pairs to report on all of them.

Net Filters the contents of the Pin pair list. 

Groups area Specifies the groups on which you want to report.
Tip: Select All groups to report on all of them.

Components area Specifies the components on which you want to report.
Tip: Select All components to report on all of them.

Nets area Specifies the nets on which you want to report.
Tip: Select All nets to report on all of them.

Classes area Specifies the classes on which you want to report.
Tip: Select All classes to report on all of them.

Decals area Specifies the decals on which you want to report.
Tip: Select All decals to report on all of them.

Default rules Specifies to report the default rules for each enabled rule type 
in the Rules Types area.

Output area • Rule Sets—Report all rules that are different from the 
default rules.

• Rule Values—Report the values of all rules, even if they 
match the default rules values.
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Save CAE Decal to Library Dialog Box
Use the Save CAE Decal to Library dialog box to copy a CAE decal to another name or another 
library.

Accessing

• File menu > Library > select a library > Logic filter type > select a CAE decal > Copy

Figure 45-322. Save CAE Decal to Library Dialog Box

Related Topics

Copying a Library Item

Save Configuration Dialog Box
Use the Save Configuration dialog box to save the color assignments and settings you’ve made 
in the Display Colors Setup dialog box.

Accessing

• Setup menu > Display Colors > Save button

Table 45-291. Save CAE Decal to Library Dialog Box Content

Name Description

Library Select the library for the copied CAE decal.

Name of CAE Decal Type the name for the copied CAE decal.
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Save Configuration Dialog Box in the Decal Wizard Options

Figure 45-323. Save (color) configuration Dialog Box

Related Topics

Display Colors Setup Dialog Box

Display Colors Setup Dialog Box in the Decal Editor

Save Configuration Dialog Box in the Decal 
Wizard Options

Use the Save Configuration dialog box to save the settings you’ve made in the Decal Wizard 
Option dialog box.

Accessing

• Decal Wizard Options dialog box > Save As button

Figure 45-324. Save (Decal Wizard Options) Configuration Dialog Box

Table 45-292. Save configuration Dialog Box Content

Name Description

text box Type the name of the new color configuration. The name will appear in 
the Configuration list in the Display Colors Setup dialog box.
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Save Drafting Item to Library Dialog Box
Use the Save Drafting Item to Library dialog box to copy a line item to another name or another 
library.

Accessing

• File menu > Library > select a library > Drafting filter type > select a line item > Copy

Figure 45-325. Save Drafting Item to Library Dialog Box

Related Topics

Copying a Library Item

Table 45-293. Save (Decal Wizard Options) Configuration Dialog Box Content

Name Description

text box Type the name of the new Decal Wizard Options configuration. The 
name will appear in the Configuration name list in the Decal Wizard 
Options dialog box.

Table 45-294. Save Drafting Item to Library Dialog Box Content

Name Description

Library Select the library for the copied line item.

Name of Item Select the name for the copied line item.
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Save Part Types and Decals to Library Dialog Box

Save Part Types and Decals to Library Dialog 
Box

Use the Save Part Types and Decals to Library dialog box to save modified decals or parts to 
libraries.

Accessing

• Select one or more components in the design> Right-click > Save to Library

Figure 45-326. Save Part Types and Decals to Library Dialog Box

Table 45-295. Save Part Types and Decals to Library Dialog Box Contents 

Name Description

Part Types The list of Part Types available to save to the library.

Decals The list of Decals available to save to the library.

Select All Selects all items in the list above the button.

Select None Deselects all items in the list above the button.

Part Type Library A list of all the libraries available to which to save this 
Part Type.

Decal Library A list of all the libraries available to which to save this 
Decal.
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Related Topics

Saving Modified Decals and Parts to Libraries

Save Part Type to Library Dialog Box
Use the Save Part Type to Library dialog box to copy a Part Type to another name or another 
library.

Accessing

• File menu > Library > select a library > Parts filter type > select a part type > Copy

Figure 45-327. Save Part Type to Library Dialog Box

Related Topics

Copying a Library Item

Save PCB Decal to Library Dialog Box
Use the Save PCB Decal to Library dialog box to copy a PCB decal to another name or another 
library.

Accessing

• File menu > Library > select a library > Decal filter type > select a PCB decal > Copy

Table 45-296. Save Part Type to Library Dialog Box Content

Name Description

Library Select the library for the copied part type.

Name of Part Type Type the name for the copied Part Type.
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Save View Dialog Box

Figure 45-328. Save PCB Decal to Library Dialog Box

Related Topics

Copying a Library Item

Save View Dialog Box
Use the Save View dialog box to save a work area view. You can save up to 9 different views.

Accessing

• View menu > Save View

Figure 45-329. Save View Dialog Box

Table 45-297. Save PCB Decal to Library Dialog Box Content

Name Description

Library Select the library for the copied PCB decal.

Name of PCB Decal Type the name for the copied PCB decal.
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Related Topics

Saving a View

SBP Naming Dialog Box
Use the SBP Naming dialog box to specify the numbers and functions of all newly created 
substrate bond pads, if different from the defaults.

Restriction: This information applies only to the BGA toolkit.

Accessing

• BGA Toolbar button > Wire Bond Wizard button > SBP Naming button

Figure 45-330. SBP Naming Dialog Box

Table 45-298. Save View Dialog Box Contents 

Name Description

View Name The different views available to you.

Preview area Shows the view selected in the View Name list.

Capture Opens the Capture a New View dialog box.

Apply Applies the selected view.

Delete Removes the selected view from the View Name list.
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SBP Properties Dialog Box

Related Topics

To Set SBP Names

SBP Properties Dialog Box
The SBP Properties dialog box displays the pin name, function, position, and dimensions of the 
selected substrate bond pad. In the Wire Bond Editor, with one or more SBPs selected, right-
click and click Properties to edit the SBP Properties.

Restriction: This information applies to only the BGA toolkit.

Note: If you have multiple objects selected, only those properties that are common to all 
selected objects will appear.

Accessing

• BGA Toolbar button > Wire Bond Editor button > Select an SBP > right-click > 
Properties

Table 45-299. SBP Naming Dialog Box contents 

Name Description

CBP column Lists the numbers of the component bond pads.

CBP Function column Lists the function names of the component bond pads.

SBP column Use this column to view and specify the numbers of the 
substrate bond pads listed in the same row.

SBP Function column Use this column to view and specify the functions of the 
substrate bond pads listed in the same row.

Reset button Resets the substrate bond pad numbers and functions to the 
default, which matches them to the component bond pads of 
the same number and function.

Derive from Netlist 
button

Imports substrate bond pad functions from a PADS-ASCII 
format netlist file. Choose the file you want to load from the 
Open File dialog box.
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Figure 45-331. SBP Properties Dialog Box

Table 45-300. SBP Properties Dialog Box contents 

Name Description

Pin Name Assigns a pin name to the currently selected substrate bond 
pad.

Function Defines the function of the currently selected bond pad.

Guide Displays the name of the SBP Guide to which the specified 
SBP is assigned. If the SBP is not assigned to any guide, this 
field is blank.

Wirebond Displays the name of the substrate bond pad and the 
component bond pad that are connected by the wire bond.

Layer list Lists all electrical layers for creating SBPs, allowing you to 
create an SBP on a specific layer.

X and Y Displays the X and Y coordinates of the bond pad. Type new 
values to move the bond pad.

Rotation Assigns a rotation angle, in degrees, for the currently selected 
substrate bond pad.
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Select Assembly Variant Dialog Box

Related Topics

To Edit Substrate Bond Pads

Select Assembly Variant Dialog Box
You can create assembly drawings of your assembly variants by selecting a variant in the Select 
Assembly Variant dialog box.

Accessing

• File menu > CAM > Add button > Select Assembly from the Document Type list > 
Assembly button

or

• File menu > CAM > select a document name > Edit button > Select Assembly from the 
Document Type list > Assembly button

Figure 45-332. Select Assembly Variant Dialog Box

Shape list Assigns a shape to the currently selected bond pad: Rectangle 
or Oval.

Length Assigns a physical length, in current design units, for the 
currently selected bond pad.

Width Assigns a physical width, in current design units, for the 
currently selected bond pad.

CBP button Opens the CBP Properties dialog box for the component bond 
pad connected to the currently selected substrate bond pad. 
This button is unavailable if there is no connected component 
bond pad.

WB button Click WB to open the Wire Bond Properties dialog box for the 
wire bond connected to the currently selected pad. This button 
is unavailable if there is no connected wire bond.

Table 45-300. SBP Properties Dialog Box contents (cont.)

Name Description
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Related Topics

Selecting an Assembly Variant for Assembly Drawings

Defining CAM Documents

Select Graphically Dialog Box
Graphical Selection mode has two modes, Include and Exclude. The default mode is Include 
mode. The pins that are currently included on the Substrate Bond Pads and BGA Pins lists are 
highlighted in the work area.

Restriction: This information applies to only the BGA toolkit.

Accessing

• BGA Toolbar button > Route Wizard button > Select Pads tab > Select Graphically 
button

Figure 45-333. Select Graphically Dialog Box

Table 45-301. Select Assembly Variant Dialog Box contents 

Name Description

Use Assembly Variant Specifies to use an assembly variant as your design input for 
the assembly drawing.
Tip: Clear the check box to use all parts in the database, 
known as the raw database.

Name Specifies the variant you want to use.

Table 45-302. Select Graphically Dialog Box contents 

Name Description

Select Pins to 
Include/Exclude

Places Graphical Selection in Include or Exclude mode.
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Select Items Dialog Box

Related Topics

To Use Graphical Selection Mode

Select Items Dialog Box
When you are adding a CAM document, you can use the Select Items dialog box to define 
which layers and items should appear in a particular document. You can also define colors for 
layers and items.

Accessing

• File menu > CAM > Add button > Layers button

or

• File menu > CAM > select a document name > Edit button > Layers button

Included/Excluded 
BGAs and SBPs

Lists the number of BGA pads and SBP pins currently selected 
for inclusion in or exclusion from processing.

Table 45-302. Select Graphically Dialog Box contents (cont.)

Name Description
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Figure 45-334. Select Items Dialog Box

Table 45-303. Select Items Dialog Box contents 

Name Description

Available list Lists the layers available for display in the output.

Selected list Lists the layers you selected from the Available list.

Add button Moves the layer from the Available list to the Selected list.
Tip: The layers you select are not saved as defaults when you 
click Save As Defaults on the Add Document dialog box. 

Remove button Moves the layer from the Selected list to the Available list.

Other area Specifies the color you want for the Board Outline, 
Connections, Plated Slots, and Non-plated Slots.
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Selection Filter Dialog Box, Layer Tab

Related Topics

Making Design Objects Visible in CAM Documents

Creating CAM Outputs to Manufacture Your PCB

Adding or Editing CAM Documents

Selection Filter Dialog Box, Layer Tab
The Layer Tab displays a list of enabled layers (available for selection). Select layers to expand 
the selection of objects specified in the Object tab. Click the check box accompanying the layer 
name.

Items on Primary area Specifies the color you want for Pads, Traces, Lines, Vias, 
Copper, Keepouts, Reference Designators, Part Types, Text, 
Attributes, Outlines, and Test Points.
Tip: Text that is combined with 2D lines is made visible when 
you select 2D Lines. Combined text is not affected by the Text 
check box.

Pins with Associated 
Copper area

Click Advanced Selection to enable the selection of the object 
check boxes. These options allow for selection of associated 
copper items independently of regular options for pads, vias 
and traces.
• Pads—displays pads with associated copper. 
• Open Copper—displays the open copper that is associated 

to pins.
• Filled Copper—displays the closed copper shapes that are 

associated to pins.

Component outlines area Specifies the color you want for outlines that are Top Mounted 
and Bottom Mounted.

Color by Net Specifies to use the View Nets colors in the output.

Selected Color Provides a palette of grayscales or colors to use for objects 
in the output document. 
Restriction: This feature is only available if you select a 
printer or a plotter as your Output Device. It is not 
available for Photo output.
Tip: Click a color in the palette and then click the box beside a 
design object. You can assign colors to the items in the Other, 
Component outlines, and Items on Primary areas.

Preview Opens the CAM Preview dialog box displaying the colors 
you’ve chosen.

Table 45-303. Select Items Dialog Box contents (cont.)

Name Description
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Tip: By selecting multiple layer names, you can change their selectability in a single step. 

Accessing

• Edit menu > Selection Filter > Layer tab

Figure 45-335. Layer Tab

Table 45-304. Layer Tab Contents 

Name Description

Layers list Specifies the layers on which you want to enable 
selection.

Anything Specifies that you want to select anything in the design.
Exception: Clusters, unions, stitching vias, pin pairs, nets, 
and board outline shapes are not selected. 

Nothing Specifies that you don’t want to select anything in the 
design.
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Selection Filter Dialog Box, Object Tab

Related Topics

Using the Selection Filter

Selection Filter Dialog Box, Object Tab
Use the Selection Filter Object tab to specify which objects you can select. Select a check box to 
enable the object for selection or clear the check box to disable the object for selection.

Accessing

• Edit menu > Selection Filter > Object tab

Figure 45-336. Object Tab
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Related Topics

Using the Selection Filter

Select Vault Dialog Box
Use the Select Vault dialog box to:

• Select an existing vault to open.

• Create a new vault.

Accessing

• Vault view > Select Vault button

Table 45-305. Object Tab Contents 

Name Description

Design Items Specifies the design items you want to be able to select in 
the design.
Tips: 
• When Parts is selected, but Glued Parts is clear, you 

enable the selection of all parts except Glued Parts. 
When both Parts and Glued Parts are selected, you 
enable the selection of both glued and unglued parts. 
Selecting Glued Parts does not modify the jumper 
selection or selection of unions and reuses.

• When Vias is selected, but Stitching is clear, you 
enable the selection of all vias except stitching vias. 
When both Vias and Stitching are selected, you enable 
the selection of both vias and stitching vias.

Drafting Items Specifies the design items you want to be able to select in 
the design.

Anything Specifies that you want to select anything in the design.
Exception: Clusters, unions, stitching vias, pin pairs, nets, 
and board outline shapes are not selected. 

Nothing Specifies that you don’t want to select anything in the 
design.
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Set Start-up File Dialog Box

Figure 45-337. Select Vault Dialog Box

Related Topics

Creating a Vault

Changing Vaults

Set Start-up File Dialog Box
Use the Set Start-up File dialog box to select the startup file to use for new design files. A 
startup file contains global settings such as layer definitions, grids, clearance rules, the attribute 
dictionary, and so on.

The startup file affects only new designs and specifying a new startup file does not affect 
existing designs.

Accessing

• File menu > Set Start-up File

Table 45-306. Select Vault Dialog Box Contents 

Name Description

  Browse button
Opens a Browse for folder dialog box, where you can select a 
vault to open.

Create New Vault button Opens a Browse for folder dialog box, where you can select or 
create a folder to contain the new vault.
Requirement: If you select an existing folder, it must be 
empty.
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Figure 45-338. Set Start-up File Dialog Box

Related Topics

Creating Start-up Files

Specifying the Start-up File

Start-up Files

Setup DXF Drill Size and Symbols Dialog Box
Use the Setup DXF Drill Size and Symbols dialog box to specify drill sizes and symbols in the 
DXF export. You can also substitute 2D line library items for each drill size in the design.

Accessing

• File menu > Export > Select DXF File > Save > Setup

Table 45-307. Set Start-up File Dialog Box Contents 

Name Description

Current Start-up File The name of the start-up file you’re creating.

Start-up designs A list of the design types available.

Description A description of the design type.

Don’t display again Specifies to use the selected type for all new design files.
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Setup DXF Drill Size and Symbols Dialog Box

Figure 45-339. Setup DXF Drill Size and Symbols Dialog Box

Related Topics

Specifying DXF Drill Sizes and Symbols

Table 45-308. Setup DXF Drill Size and Symbols Dialog Box Contents 

Name Description

Drill Size Library 
Equivalent

A list of the items using a 2D-line library item to draw a 
specific drill size instead of using the default drill symbol.

Drill Size Specifies the drill size of the drill hole for the item 
selected in the Drill Size Library Equivalent list.

Library Equivalent Specifies the 2D-line library item equivalent for the item 
selected in the Drill Size Library Equivalent list.

Add Adds a row at the bottom of the Drill Size Library 
Equivalent list.

Delete Removes the selected row from the Drill Size Library 
Equivalent list.

System Units The units of the symbols.

Symbol Size Specifies the length/width of the drill hole.
Tip: By default, drill holes appear in the DXF file as plus 
signs (+). 

Line Width Specifies the line size used to draw the plus sign.
Tip: By default, drill holes appear in the DXF file as plus 
signs (+). 
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Setup SPECCTRA Finish Dialog Box
Use the Setup SPECCTRA Finish dialog box to specify output file locations and to set 
instructions for the SPECCTRA router regarding actions performed when routing is completed, 
such as running the mitering pass, running re-cornering, and insertion of test points.

Accessing

• File menu > Export > select SPECCTRA Files > Save > in the SPECCTRA Link, 
click DO File button > Finish button

Figure 45-340. Setup SPECCTRA Finish Dialog Box

Table 45-309. Setup SPECCTRA Finish Dialog Box contents 

Name Description

Wire File Specifies the location of the wires file.
Tip: Click Browse to locate the file.

Route File Specifies the location of the route file.
Tip: Click Browse to locate the file.
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Setup SPECCTRA Startup Dialog Box

Related Topics

SPECCTRA Output File Location and Router Settings

Setup SPECCTRA Startup Dialog Box
Use the Setup SPECCTRA Startup dialog box to include a line referencing previously entered 
routes, saved in Wires or Best Save files, in your .do file. SPECCTRA refers to these files upon 
startup. You can also include the name of the status file and parameters for Via at SMD, Seed 
Via, and Seed Via minimum distance.

For details on these files and functions see the SPECCTRA Design Language Reference PDF 
file spdlr.pdf in the SPECCTRA group.

Session File Specifies the location of the session file.
Tip: Click Browse to locate the file.

Test Points area Specifies the options you want for test points installed by 
SPECCTRA.
See also: Passing DFT Audit Settings to SPECCTRA, 
“Testpoint” topic in the SPECCTRA Help

Miter area Specifies the miter conversion type: Normal, Diagonal, Round.

Recorner area Specifies the recornering options: Normal, Diagonal, Round.

Delete Conflicts Specifies to remove crossover and clearance violations

Critic Specifies to eliminate notches and remove extra bends.

Spread Specifies to add extra space if there is room. Type the value of 
the spread in the Extra box.

Report area Specifies the type of data you want to include in the report: 
Class, Class to Class, Conflicts, Corners, Crosstalk, Group, 
Group Set, Keepouts, Length, No fanout, Padstack, Pairs, 
Regions, Status, Testpoints, Unconnect, Vias.

Report File Name Specifies the name of the report.
Tip: Click browse to locate the file.

Clear selections button Clears all box entries, check boxes, and radio button selections 
you have made.

Table 45-309. Setup SPECCTRA Finish Dialog Box contents (cont.)

Name Description
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Accessing

• File menu > Export > select SPECCTRA Files > Save > in the SPECCTRA Link, type 
a name or browse to the file you want in the DO File Name box > Do File button > 
Startup button

Figure 45-341. Setup SPECCTRA Startup Dialog Box

Table 45-310. Setup SPECCTRA Startup Dialog Box contents 

Name Description

Wires File Specifies the wires file.
Tip: Click Browse to locate the file.

Status File Specifies the status file.
Tip: Click Browse to locate the file.

Best Save Specifies the best save file.
Tip: Click Browse to locate the file.

Vias at SMD area Specifies whether to allow vias at SMD: On or Off.

Grid area Specifies whether the via is on a grid point: On or Off.

Fit area Specifies whether the via fits within the pad: On or Off.

Seed Via Specifies to break up two-pin connections that are larger than a 
certain length. Type the length value in the Distance box.

Force Specifies to force the break up of two-pin connections as 
indicated above.

Clear Selections button Clears all selections made.
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Setup Via Dialog Box

Related Topics

Setting up SPECCTRA .do File Startup Options

Setup Via Dialog Box
Use the Setup Via dialog box to add new via names to the Available Vias list. The Setup Via 
dialog box does not know about via padstacks in the design. These via names should reference 
the real via names in your design, where the internal padstack structure is defined.

Accessing

• PCB Decal Editor > Setup menu > Design Rules > Routing button > Via definition 
button

Figure 45-342. Setup Via Dialog Box

Table 45-311. Setup Via Dialog Box Contents

Name Description

Vias list Lists the vias defined and available for the Vias section of 
the Routing Rules dialog box. Select a name in the list to 
rename or delete the via.

Name box Type a new name in the dialog box and then click Add to 
add it to the list. 
Use the Name box to rename vias in the Vias list.

Add button Type a new name in the Name list and then click Add to 
add the via name to the Vias list. 
Restriction: The button is unavailable until you type a 
name in the Name box.

Rename button With a via name selected in the Vias list, type a new name 
in the Name field and click Rename to edit the name of 
the via within the Vias list.
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Related Topics

Routing Rules Dialog Box

Creating Via Routing Rules in the Decal Editor

Show Attributes Dialog Box
Use the Show Attributes dialog box to select attributes to list in the multi-column list of the 
Attribute Manager.

Accessing

• Edit menu > Attribute Manager > Show button

Figure 45-343. Show Attributes Dialog Box

Delete button With a via name selected in the Vias list, click Delete to 
delete the name of the via.

Table 45-311. Setup Via Dialog Box Contents

Name Description
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Show Attributes Dialog Box

Related Topics

Using the Attribute Manager

Showing Attributes in the Attribute Manager

Table 45-312. Show Attributes Dialog Box 

Name Description

Group Filters the Attributes list. You can choose an attribute group to 
view.

Attributes list Specifies the attributes you want to view in the Attribute 
Manager dialog box.

Summary Creates summaries of every value of an attribute assigned to a 
particular objects type. In other words, summaries will appear 
at the bottom of attribute columns. 
• Sum—Shows the total of the attribute values. The 

summary applies to the attribute you select in the Attributes 
list. The summary displays in the Attribute Manager dialog 
box.

• Max—Shows the maximum value used by the attribute. 
The summary applies to the attribute you select in the 
Attributes list box. The summary displays in the Attribute 
Manager dialog box. To create a summary that is the range 
of attribute values, click both the Min and Max check 
boxes.

• Min—Shows the minimum value used by the attribute. 
The summary applies to the attribute you select in the 
Attributes list box. The summary displays in the Attribute 
Manager dialog box. To create a summary that is the range 
of attribute values, click both the Min and Max check 
boxes.

• Average—Shows the average of the attribute values. The 
average is the sum of all attribute values divided by the 
number of values assigned. The summary applies to the 
attribute you select in the Attributes list. The summary 
displays in the Attribute Manager dialog box.

Restriction: Summaries are only available for Number, 
Decimal Number, and Measure attribute types. 

Select All Selects all check boxes in the Attributes list.

Unselect All Clears all check boxes in the Attributes list.
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SPECCTRA DO File Dialog Box
The .do file is an editable batch script file, which controls SPECCTRA operation. You can add 
or edit command lines in a .do file. When you start the editor, the .do file you specify in the 
SPECCTRA Link dialog box is read for editing.

Accessing

• File menu > Export > select SPECCTRA Files > Save > in the SPECCTRA Link, type 
a name or browse to the file you want in the DO File Name box > Do File button

Figure 45-344. SPECCTRA DO File Dialog Box
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SPECCTRA DO File Dialog Box

Table 45-313. SPECCTRA DO File Dialog Box contents 

Name Description

Setup area The contents of the Setup area change according to the options 
you select in the Setup area. 
• Order -change the original net ordering and control 

whether nets are routed in daisy-chain or starburst fashion.
See also: “Order” and “Choosing Starburst or Daisy-Chain 
Wiring” topics in the SPECCTRA Help

• Action - control wire rerouting, net routing, and the 
availability of connections, vias, and layers for autorouting.
See also: “Protect/Unprotect”,” “Fix/Unfix,” and 
“Select/Unselect” topics in the SPECCTRA Help

• Cost - control routing costs and override the autorouter 
internal cost table.
See also: “Cost,” “Limit,” “Tax,” and “Using Standard 
Autorouting Commands” topics in the SPECCTRA Help

• If you click Cost in the Cost area and Layer in the All area, 
options in the Type area appear.
See also: “Type,” “Length,” “Way (Cost),” and “Way 
(Limit)” topics in the SPECCTRA Help

• Test Point Rule - control passing DFT Audit test point 
placement options to SPECCTRA for its test point 
placement routine.
See also: Passing DFT Audit Settings to SPECCTRA and 
the “Testpoint” and “Testpoint Antennas” topics in the 
SPECCTRA Help.

All area Limits actions to certain selected objects. The content of this 
area changes depending on the options you select in the Setup 
area.

Only area Limits actions to certain selected objects.
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Test Points area Available only when Test Points is selected.
• Insert Test Points—Allows insertion of test points and 

makes the options in the Test Points area available.
• Allow Points at Pins—Allows placement of test points on 

component pins.
There is no equivalent in DFT Audit; test points are always 
allowed on pins.

• Allow Antennas—Allows antennas. Set a length.
There is no equivalent in DFT Audit.

• Max Length—Sets the length restriction for antennas. The 
default maximum length is negative one (-1), no length 
restriction.

• Center to Center—The distance 
between the centers of test points. 

• Center to Comp Edge—
The distance between the 
center of the test point and 
the component outline.

• Image Outline 
Clearance—The clearance 
between the component 
outline and the test point 
carrier (via or component 
pin). If the Image Outline 
Clearance is negative, a zero (0) is set. 

• Test Side—Searches the specified side for test point 
placement.

• Use Via—Uses vias as test points.
• Grid X, Y—The test point grid.

See also: Options Dialog Box, Grids page

Routing area Set fanout rules: direction, pin type, and maximum length. Set 
the Bus direction, and enter the number of passes for each 
type.

Clear selections button Clears all of the settings for the area.

Smart Route button Specifies to autoroute your design based on how your design is 
converging. 
See also: the SPECCTRA Help.

Apply to Editor button Specifies to write the commands from this area to the .do file.

Editor area The contents of the .do file. Command appear here when you 
click the Apply to Editor button.

Table 45-313. SPECCTRA DO File Dialog Box contents (cont.)

Name Description
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SPECCTRA Link Dialog Box

Related Topics

Creating or Editing a .do File

SPECCTRA Link Dialog Box
When you start SPECCTRA from within PADS Layout, the SPECCTRA Link dialog box 
enables you to load in and out of SPECCTRA automatically.

Alternative: If you start SPECCTRA independently of PADS Layout, use the Stand-alone 
SPECCTRA Link dialog box to load in and out of SPECCTRA manually.

Accessing

• File menu > Export > select SPECCTRA Files > Save

or

• Use Windows Explorer to navigate to your ...\SDD_HOME\Programs directory, and 
double-click pads2sp.exe

Figure 45-345. SPECCTRA Link Dialog Box - from Layout

Continue button Starts the conversion and loading process.

Save As button Specifies that you want to save the .do file with a specific 
name and location.

Startup button Opens the Setup SPECCTRA Startup dialog box.

Finish button Opens the Setup SPECCTRA Finish dialog box.

Table 45-313. SPECCTRA DO File Dialog Box contents (cont.)

Name Description



SPECCTRA Options Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1503

Figure 45-346. SPECCTRA Link Dialog Box - Stand-alone

Related Topics

Loading In and Out of SPECCTRA Automatically

SPECCTRA Options Dialog Box
The Options dialog box appears when you click the Options button on the SPECCTRA Link 
dialog box, the TO SPECCTRA dialog box (stand-alone), or the FROM SPECCTRA dialog 
box (stand-alone). 

Table 45-314. SPECCTRA Link Dialog Box contents 

Name Description

DO File Name Specifies the DO file you want to use.
Tip: Click Browse to locate the file.
Restriction: From Layout only.

Continue button Loads the design into SPECCTRA and the router runs in batch 
mode.

Setup button Opens the SPECCTRA Setup dialog box.

DO File button Opens the SPECCTRA DO File dialog box.
Restriction: From Layout only.

Options button Opens the Options dialog box.
Restriction: From Layout only.

To SPECCTRA button Opens the To SPECCTRA dialog box.
Restriction: Stand alone only.

From SPECCTRA 
button

Opens the From SPECCTRA dialog box.
Restriction: Stand alone only.
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SPECCTRA Options Dialog Box

This dialog box controls options for sending via keepout information, passing advanced rules to 
SPECCTRA, setting a mode for trace arc translation, and returning the unused pins net from 
SPECCTRA. 

See also: Unused Pins Net

Accessing

• File menu > Export > select SPECCTRA Files > Save > in the SPECCTRA Link, 
click the Options button

Figure 45-347. Specctra Options Dialog Box

Table 45-315. Specctra Options Dialog Box contents 

Name Description

Layer Containing Via 
Keepout Shapes list

Specifies the layer that contains the via keepout areas, and that 
you want to send them from your decals to SPECCTRA.

Pass Default Advanced 
Rules

Specifies to pass default Selected Layer and Selected Via rules 
to SPECCTRA.
These rules require the Advanced Rules option in 
SPECCTRA. Turn this option on if you have this SPECCTRA 
option; otherwise, leave this option off.
See also: PADS Layout to SPECCTRA Rules Conversion
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Related Topics

Setting SPECCTRA Options

SPECCTRA Setup Dialog Box
Use the SPECCTRA Setup dialog box to set SPECCTRA automatic startup information.

Accessing

• File menu > Export > select SPECCTRA Files > Save > in the SPECCTRA Link, 
click the Setup button

Trace Arc Translation 
area

Specifies the mode to perform trace arc translation.
• To Single Segment—Replaces each trace arc with a single 

segment. This is the default mode.
• To Multiple Segments—Replaces a trace arc with 

multiple segments. The original trace arc is divided into 
smaller arcs (equal to approximately 5 degrees) and then 
each smaller arc is replaced by a single segment. The result 
is a polyline of multiple segments instead of the arc.

• To Quarter Arcs (QARCs)—Breaks existing arcs into 
quarter arcs and other segments. (Quarter arcs are arcs 
whose start and end points are exactly 0–90, 90–180, 180–
270, and 270–360 degrees.) The quarter arcs are translated 
to the SPECCTRA QARC structure. The remaining parts 
of arcs are translated to polylines. 

Return Options area Specifies to return unused pin and fanout information to PADS 
Layout. Type the name of the net in the PADS Layout design 
that will contain the unused pins. Provide a new name if you 
do not want to use the default. 
Clear this option to ignore unused pin and fanout information 
when returning to PADS Layout.
Tip: SPECCTRA names the unused pins net 
+UNUSED_PINS+ while previous versions named it 
*UNUSED_PINS*. The SPECCTRA Translator interprets 
both names.
The maximum netname length in PADS Layout is 47 
characters. You can use any alphanumeric characters except 
for brackets{ }, asterisks *, or spaces.

Table 45-315. Specctra Options Dialog Box contents (cont.)

Name Description
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SPECCTRA Setup Dialog Box

Figure 45-348. SPECCTRA Setup Dialog Box

Table 45-316. SPECCTRA Setup Dialog Box contents 

Name Description

Executable Specifies the executable needed to run SPECCTRA.

Password/Server Specifies the password file needed to run SPECCTRA.
Tip: For teal key node-locked or floating licensing, point to 
your license server in the standard port@host format. For 
example, 7508@myserver.

Message Output Specifies the SPECCTRA message output file.

Status Specifies the SPECCTRA status file.

Color Mapping Specifies the SPECCTRA color mapping file.

No Graphics Specifies to disable the SPECCTRA graphic display and make 
SPECCTRA run faster.

Quit After Do Specifies to close SPECCTRA after it processes the .do file 
commands.

No Preroutes Specifies to delete all prerouted traces before entering 
SPECCTRA.

Don’t Strip Orphan 
Shapes

Specifies to ignore copper without net assignments, which 
have no net association in SPECCTRA.

Simplify Polygons Specifies to convert one-inch square, or smaller, polygons to 
simple rectangles.
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Related Topics

Setting the SPECCTRA Automatic Startup Information

Start-up File Output Dialog Box
Use the Start-up File Output dialog box to create a startup file that contains global settings such 
as layer definitions, grids, clearance rules, the attribute dictionary, and so on. You can create 
different startup files and specify which one to use when creating a new design file. This 
capability enables you to save setup time when creating a new design by reusing global settings 
that you saved in the startup file.

Accessing

• File menu > Save As Start-up File.

Figure 45-349. Start-up File Output Dialog Box

Licensing Type area Select the licensing type you want: Floating, Node-locked with 
Flexid Key, or Node-locked with SSI key.

Launch PADS Layout 
session

Specifies to reload the routed design back into PADS Layout 
after it processes the .do file commands.

Table 45-316. SPECCTRA Setup Dialog Box contents (cont.)

Name Description
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Start-up File Output Dialog Box

Related Topics

Creating Start-up Files

Specifying the Start-up File

Start-up Files

Table 45-317. Start-up File Output Dialog Box Contents 

Name Description

Filename The name of this startup file.

Select All Selects all check boxes in the Sections list.

Unselect All Deselects all check boxes in the Sections list.

Sections The items available to you to include in the startup file.
• PCB Parameters—Global information, such as 

colors, layer definitions, and grids
• Vias—Via information, such as default via type, 

jumpers, padstack definitions and locations
• Layer Data—Layer information specified in the 

Layers Setup dialog box, such as number of layers, 
layer names, routing direction for the layer, electrical 
type, and associations

• Rules—Rules information, such as clearance, routing, 
and high-speed

• CAM—CAM information related to the plot file 
configurations

• Attributes—Attribute information, such as the 
attribute dictionary, all attributes assigned to objects in 
the design, and attribute status (read only, system, 
ECO registered, or hidden). Values in the attribute 
hierarchy are not saved. 

Format Sets the format for this startup file.

Units Sets the units you want to use for this startup file.
Tip: Current units provide more information than Basic 
units, such as grid positions.

Startup File Description A place to type a brief description of the global settings 
you are saving. The description appears when you select 
the startup file in the Set Start-up File dialog box, and 
should help remind you of the settings in the startup file.
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Status Dialog Box
Use the Status window to view selection information, and gain access to frequently used 
Options settings.

Accessing

• Ctrl+Alt+S

Figure 45-350. Status Dialog Box

Table 45-318. Status Dialog Box Contents

Name Description

Information area (blank 
area in figure)

Displays information about the currently selected object.

Snap To Grid Toggles the Snap to grid check box of the Design grid in 
the Grids Options.

Line/Trace Angle Toggles the Line/trace angle of the Design Options.

On-line DRC Toggles the On-line DRC setting of the Design Options.
Restriction: If the On-line DRC is set to Off, this button 
is unavailable and you must enable it from the Options 
dialog box.

Nudge Toggles the Nudge setting of the Design Options.
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Step and Repeat Dialog Box

Step and Repeat Dialog Box
You can define complex, repetitive array patterns of objects in the PCB Decal Editor using the 
Step and Repeat dialog box. You can select multiple or single items for replication. Step and 
Repeat also automatically increments text and pin numbers. 

Three types of Step and Repeat array replications are available:

Accessing

1. In the PCB Decal Editor, click the Drafting toolbar button.

2. Click the Select button.

3. Select one or more terminals, 2D line items, text items, copper items, copper cut outs, or 
keepouts.

4. Right-click and click Step and Repeat. The Step and Repeat dialog box appears.

Linear Tab
Use the Linear tab in the Step and Repeat dialog box to create planar arrays. 

See also: Incrementing Texts and Pin Numbering, Using Step and Repeat

Layer Pair Toggles the Layer pair setting of the Routing Options.

Postage Stamp Displays a miniature of the current view.

Linear Tab For planar replication, in the horizontal and vertical directions.

Polar Tab For angular replication, rotation around the decal origin. This is 
useful for creating polar arrays of terminals.

Radial Tab For radial replication, along the radial direction starting from the 
decal’s origin. This is useful for creating polar arrays of 
terminals.

Table 45-318. Status Dialog Box Contents

Name Description
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Figure 45-351. Step and Repeat Dialog Box Linear Tab

Polar Tab
Use the Polar tab in the Step and Repeat dialog box to create angular, or circular, arrays. 

See also: Incrementing Texts and Pin Numbering, Using Step and Repeat

Table 45-319. Linear Tab Contents 

Comman
d

Description

Direction Sets the direction of the replication in the array: Up, Down, Left, or 
Right.

Count Sets the number of replications in the array.

Distance Sets the distance in the array: X distance in current units when the Linear 
Direction is Left or Right; Y distance in current units when the Linear 
Direction is Up or Down. Negative values reverse the direction.
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Step and Repeat Dialog Box

Figure 45-352. Step and Repeat Dialog Box Polar Tab

Table 45-320. Step and Repeat Polar Tab Contents 

Command Description

Direction Sets the direction of replication in the array: Counterclockwise or 
Clockwise.

Locked area Controls the automatic adjustment of Angle Range, Delta Angle, and 
Sites Per Ring for Radial Move. Controls the automatic adjustment of 
Count, Angle, and Angle Range for Polar Step and Repeat.
These three settings are interdependent; each value depends on the values 
in the other two. Set one of the values and lock it. Set one of the unlocked 
values; the other unlocked value automatically updates. For example, if 
you set Angle Range to 360 and Sites Per Ring to 36, Delta Angle 
updates to 10.

Count Sets the number of replications in the array.

Angle Specifies the angle of the replication in the array. Negative values reverse 
the direction. You can type angle values with .001 degree precision. 
When you perform an angular replication on a terminal with noncircular 
pads, the pad stacks are copied and the pad stack offset value is 
maintained.
Restrictions:
• When you try to rotate a text item or a terminal with a noncircular pad 

with .001 degree precision, replication angles are rounded to the 
nearest whole degree value.

• When replicating square-shaped pads, PADS Layout converts them to 
rectangular-shaped pads during angular replication.

Angle Range Sets the range within which you want to place objects. 360 sets a full 
circle grid or array; smaller values set sector-shaped grids or arrays.
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Radial Tab
Use the Radial tab in the Step and Repeat dialog box to create radial arrays. 

See also: Incrementing Texts and Pin Numbering, Using Step and Repeat

Figure 45-353. Step and Repeat Dialog Box Radial Tab

Table 45-321. Radial Tab Contents 

Comman
d

Description

Direction Sets the direction of replication in the array; away from the PCB Decal 
Editor origin (Away From Origin) or towards the PCB Decal Editor 
origin (Towards Origin).

Count Sets the number of replications in the array.

Distance Specifies the linear distance, or the distance along the radius, between 
neighboring copies of each replicated object. Negative values reverse the 
direction.
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Step and Repeat Dialog Box

Incrementing Texts and Pin Numbering

Figure 45-354. Step and Repeat Dialog Box - Texts

Figure 45-355. Step and Repeat Dialog Box - Pin Numbering

Table 45-322. Texts Area Contents 

Command Description

Prefix/Suffix For a single text string, use either Prefix or Suffix box, and void the other 
box. Use both boxes if you want to increment one of the values. 
A preview of the texts based on your input is displayed below the boxes.
Alphabetic and numeric values can be used in either box.

Increment 
prefix/ 
Increment 
suffix

Choose to increment the value of either the Prefix or Suffix box.

Step value Type a positive or negative number by which to increase or decrease the 
Text string with consecutive or stepped values. You can use a value of 
zero to repeat the exact same text and prevent the text string from 
incrementing.
Restriction: Step value must be in the range -10 to +10.
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Synchronize Die Part Dialog Box
Use the Synchronize Die Part dialog box to update die part data in PADS Layout with die part 
data from Library IQ. You can also use the Synchronize Die Part dialog box to update die part 
data in Library IQ with die part data from PADS Layout.

Restriction: This information applies to only the BGA toolkit.

Note: Beginning with PADS 9.0, dies and flip chips are identified by the Special Purpose 
settings in the Part Type rather than by the DIE and FLP logic families. With this change, any 
reference designator (logic family) can be assigned to a die or flip chip. If you are exporting to 
LIQ, and you have dies or flip chips of a family other than DIE or FLP in your design, 
remember that all parts lose their family designation when exported to LIQ, and are assigned 
either the DIE or FLP family when imported back into PADS Layout; so the original family 
designation (and reference designator) of these parts is lost in the export/import process.

Accessing

• BGA Toolbar button > Synchronize Die Parts button

Table 45-323. Pin Numbering Area Contents 

Command Description

Prefix/Suffix For a single pin number, use either Prefix or Suffix box, and void the 
other box. Use both boxes if you want to increment one of the values. 
A preview of the pin numbers based on your input is displayed below the 
boxes. For example, A1 or 1A.
Alphabetic and numeric values can be used in either box.

Increment 
prefix/ 
Increment 
suffix

Choose to increment the value of either the Prefix or Suffix box.

Step value Type a positive or negative number by which to increase or decrease the 
pin number with consecutive or stepped values.
Restriction: Step value must non-zero and be in the range -10 to +10. 
Zero would replicate a single pin number and is not allowed.

Use JEDEC 
pin 
numbering

If using alphanumerics, you can select the Use JEDEC pin numbering 
check box to ensure that legal alphanumeric values are used.
Tip: This option only ensures that legal alpha and numeric combinations 
are used. To arrange rows and columns according to JEDEC, use the 
Assign JEDEC Pinning option on the Tools Menu.
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Synchronize Die Part Dialog Box

Figure 45-356. Synchronize Die Parts Dialog Box

Table 45-324. Synchronize Die Parts Dialog Box contents 

Name Description

Preview area Displays the Library IQ die part selected in the Die Part list.

File The die part filename

Modified The last modification date

Chip Bond Pads The number of chip bond pads in the die part

Substrate Bond Pads The number of substrate bond pads in the die part

Wire Bonds The number of wire bonds in the die part

Flip Chip The Flip Chip identification for the die part

File The die part filename

Modified The last modification date

Chip Bond Pads The number of chip bond pads in the die part

Die Part Lists all Library IQ die parts in the current folder.
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Related Topics

To Synchronize Die Parts with LIQ

Look in Displays the die part search folder.
Tip: Click Browse to look for a folder.

Apply button Sets the die part search folder.

Update LIQ button Updates die part data in Library IQ with die part data from the 
design.

Update Design button Updates die part data in the design with die part data from 
Library IQ.

Export LIQ button Saves die part data files to the default \My Documents\PADS 
Projects folder. The .liq extension is automatically added to the 
saved file.

Design area • Part Type—Lists all die part components in the design by 
part type.

• Component—Lists all die part components in the design 
by reference designator.

Die Outline and Pads Sets the layer on which the die outline and pads appear. Select 
a layer from the list.

Wire Bonds Sets the layer on which the wire bonds appear. Select a layer 
from the list.

Update Names of 
Attached Nets

The name of the net is updated when the following conditions 
occur:
• The net has the same name as the updated pin name.
• There are no other component pins in the net with a pin 

name matching the netname.
• The new netname doesn't duplicate netnames in the design.

The graphic on the left shows a die part with pin names and 
netnames. If the previously described conditions are met when 
you update die parts, the graphic on the right occurs. This only 
occurs when this option is selected.

Table 45-324. Synchronize Die Parts Dialog Box contents (cont.)

Name Description
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Synchronize Die Part Dialog Box

To Update Die Parts in Library IQ
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Tack or Trace Corner Properties Dialog Box
Use the Tack or Trace Corner Properties dialog box to obtain information on and to modify a 
selected trace corner or tack.

Accessing

• Select a trace corner > right-click > Properties.

Figure 45-357. Tack Properties Dialog Box

Table 45-325. Tack Properties Dialog Box contents 

Name Description

Net Displays the name of the net.

Connection Lists the connections available in the design.

X/Y The X and Y location of the tack. Type in these fields to 
change the location.

Project Status Shows whether the net (to which the tack belongs) is protected.

Layer Displays the layer on which the tack is located.

Trc/Trc Clearance Displays the trace to trace clearance for this tack.

Rule Hierarchy Displays the rule hierarchy for this tack.

Pin Pair button Opens the Pin Pair Properties dialog box.

Net button Opens the Net Properties dialog box.

Rules button Opens the Pin Pair Rules dialog box.



PADS Layout User’s Guide and Reference Manual, PADS 9.41520

Teardrop Properties on Traces Dialog Box

Related Topics

Modifying Trace Corner or Tack Properties

Teardrop Properties on Traces Dialog Box
Use the Teardrop Properties on Traces dialog box to modify the teardrop shape, length ratio, 
and width ratio for any selected teardrop, teardrops on all layers, or all teardrops. You can also 
remove an individual teardrop from a design.

Accessing

• Select the trace to which the teardrop is attached > Right-click > Properties

Figure 45-358. Teardrop Properties on Traces Dialog Box

Table 45-326. Teardrop Properties on Traces Dialog Box contents 

Name Description

Auto Adjust Use Auto Adjust to set a custom length and width ratio. With 
Auto Adjust selected, PADS Layout attempts to adjust the 
length of the teardrop on traces where the trace corner is inside 
the pad or via or the segment is too short to contain the 
specified length ratio.
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Related Topics

Modifying Teardrop Properties

Using Teardrops

Action area • Add—Adds a teardrop to the selected trace or to the setting 
in the Apply To area. Once you add a teardrop, you can 
modify its settings by choosing Modify.
When you add teardrops to several traces, those traces 
already containing teardrops retain the existing teardrops 
with their original settings.

• Mod—Modifies the teardrop on the selected trace and 
applies changes to what you click in the Apply to area. 

• Del—Deletes teardrops from the selected trace and applies 
changes to the setting in the Apply To area.

Apply to area Applies changes in the Teardrop Properties dialog box to 
teardrops within the Selection, the Layer, or All teardrops.

Default button Uses the standard teardrop shape from previous PADS Layout 
(that is, PowerPCB) versions. You cannot set a length or width 
ratio with a Default-shaped teardrop.

Line button Uses a line-shaped teardrop. You can set a length and width 
ratio for this teardrop. You may want to use line- or curved-
shaped teardrops on high-frequency analog boards or very 
dense boards for smoother connections.

Curved button Uses a curved-shaped teardrop. You can set a length and width 
ratio for this teardrop. You may want to use curved- or line-
shaped teardrops on high-frequency analog boards or very 
dense boards for smoother connections.

Length ratio Sets the length of the teardrop relative to the pad to which it is 
attached. You cannot set a ratio over 1000. The formula to 
calculate the length ratio is:
(pad diameter) * (length ratio in %) = length of the teardrop
For example, if the length ratio is 200 (200% of the pad 
diameter) and the pad diameter is 60 mils, then the length of 
the teardrop is 120 mils.

Width ratio Sets the width of the teardrop relative to the pad to which it is 
attached. You cannot set a ratio over 100.

Preview Shows the currently configured teardrop. 

Table 45-326. Teardrop Properties on Traces Dialog Box contents (cont.)

Name Description
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Templates Dialog Box

Templates Dialog Box
When you are creating an archive, you can use an archive configuration template to set all the 
fields in the Add Archive to Vault dialog box. 

Use the Templates dialog box to select a template for creating a new archive, to create a new 
template, or to edit an existing template. 

An archive template specifies:

• The schematic project (.prj) file

• Zero or more layout project (.pcb) files

• Zero or more additional files to archive

• A name and text description to identify the archive in the vault (optional)

Tip: When specifying filenames in the Templates dialog box, you can enter the variable 
“<projectname>”; this variable will be replaced by the name of the Vault Project when you use 
the template. For example, if you enter “<projectname>.pcb” in the Layout project files field, 
when you use this template to archive the Processor project, “Processor.pcb” will appear in the 
Add Archive to Vault dialog box; but when you use it to archive the Timer project, “Timer.pcb” 
will appear.

Accessing

• Working Folder view > Add Archive to Vault button > click Select, New, or Edit 
from the Templates drop-down list
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Figure 45-359. Templates Dialog Box

Table 45-327. Templates Dialog Box Contents 

Name Description

Templates list Lists templates available for the current project.

  New (Insert) 
button

Adds a new item to the list.
(Appears only when editing or creating a template.)

  Copy button
Copies the settings of the selected template.
(Appears only when editing or creating a template.)
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Terminal Number Properties Dialog Box

Terminal Number Properties Dialog Box
Use the Terminal Number Properties dialog box to modify the properties of the terminal’s 
number.

Accessing

• PCB Decal Editor > select a terminal number > right-click > Properties

  Delete button
Deletes the selected list item.
(Appears only when editing or creating a template.)

  Import button
Opens a dialog box where you can select a previously exported 
template file to add to the list of available templates.
(Appears only when editing or creating a template.)

  Export button
Opens a dialog box where you can name, and select a location 
in which to save, the selected template.
(Appears only when editing or creating a template.)

  Browse button
Opens a browser dialog box where you can select a file or 
folder to add to the template.
(Appears only when editing or creating a template.)

Schematic project file 
(.prj)

Specifies the DxDesigner .prj file to be saved by the template.
Tip: If you enter the variable “<projectname>” in this field, it 
will be replaced in the Add Archive to Vault dialog box with 
the name of the project you are archiving.

Layout project files 
(.pcb)

Specifies the PADS Layout .pcb file(s) to be saved by the 
template.
Tip: If you enter the variable “<projectname>” in this field, it 
will be replaced in the Add Archive to Vault dialog box with 
the name of the project you are archiving.

Additional files and 
folders

Specifies other files and folders to be saved by the template.
Tip: If you enter the variable “<projectname>” in this field, it 
will be replaced in the Add Archive to Vault dialog box with 
the name of the project you are archiving.

Name Specifies a name for the template.

Description Specifies a description of the template.

Save Saves the new or edited template to the vault.
(Appears only when editing or creating a template.)

Select Specifies to use the selected template for the new archive.
(Appears only when selecting a template.)

Table 45-327. Templates Dialog Box Contents (cont.)

Name Description
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Figure 45-360. Terminal Number Properties Dialog Box

Related Topics

Modifying Terminal Number Properties

Terminal Properties Dialog Box
Use the Terminal Properties dialog box to modify terminal properties:

Accessing

• PCB Decal Editor > select a terminal > right-click > Properties

Figure 45-361. Terminal Properties Dialog Box

Table 45-328. Terminal Number Properties Dialog Box Contents 

Name Description

X, Y The X,Y coordinates of the selected terminal number.

Pin No The pin number of the selected terminal number
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Text Properties Dialog Box

Related Topics

Modifying Terminal Properties

Text Properties Dialog Box
Use the Text Properties dialog box to modify free text. You can change the font, font style, layer 
assignment, orientation, rotation, size, line width, if it is mirrored, and justification. You can 
also access the parent object if the text string is combined with a drafting object.

Restriction: Text can only be added one line at a time into the design. See the following topic 
for a tip on saving multiple lines of text to the library for reuse, Creating Reusable Fabrication 
Notes.

Accessing

• Select a union > Right-click > Properties

Table 45-329. Terminal Properties Dialog Box Contents 

Name Description

X, Y The X,Y coordinates of the selected terminal.

Pin No The pin number of the selected terminal

Pad stack Opens the Pad Stack Properties for Pin dialog box.

Associated copper Clear the check box to disassociate copper from the 
terminal. 
Restriction: The check box is only used to disassociate 
copper. For instructions on associating copper, see 
Associating Copper with Terminals.



Text Properties Dialog Box

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1527

Figure 45-362. Text Properties Dialog Box

Table 45-330. Text Properties Dialog Box contents 

Name Description

Text The text string you want to use.
Tip: There is a maximum of 128 characters per text string.

Font The fonts available to you. 
Tips: 
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, or 

any combination of styles: B for bold, I for italic, or U for 
underlined.

Layer The layers available to you on which to place the text.

X,Y Lists the X and Y location of the text. Type new values to 
change the location.

Rotation Specifies the rotation angle of the text.
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Text Properties Dialog Box

Related Topics

Modifying Text Properties

Size Specifies the size of the font. 
Size (pts): This is font size in points and appears for system 
fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom 
side of the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to 
ensure proper positioning between objects when text, attribute 
values, size, or width change.
Tips: 
• For vertical justification, click Left, Center, or Right. For 

horizontal justification, choose Up, Center, or Down. 
• Optionally, set justification by selecting the text, then right-

clicking and clicking Justify Horizontally, and then 
clicking Left, Center, or Right; and by right-clicking and 
clicking Justify Vertically, and then clicking Up, Center, 
or Down.

Parent Opens the Drafting Properties dialog box for the parent object 
if a text string is combined with a drafting object.

Clearance Specifies clearance values between the text and objects around 
it.

Table 45-330. Text Properties Dialog Box contents (cont.)

Name Description
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To SPECCTRA Dialog Box
Use the To SPECCTRA dialog box to translate a .pcb design file into a SPECCTRA design file.

Accessing

• Use Windows Explorer to navigate to your ...\SDD_HOME\Programs directory, and 
double-click pads2sp.exe > To SPECCTRA button

Figure 45-363. To SPECCTRA Dialog Box

Table 45-331. To SPECCTRA Dialog Box contents 

Name Description

PCB File Specifies the file to send to SPECCTRA.
Tip: Click Browse to locate the file.

Design File Specifies the design file (.dsn) that SPECCTRA inputs.
Tip: Click Browse to locate the file.

Do File Specifies the .do file to send to SPECCTRA. The .do file is the 
script file that controls SPECCTRA operation.
Tip: Click Browse to locate the file.

Did File Specifies the output file (.did) that SPECCTRA creates. This 
file serves as an input .do file in a subsequent SPECCTRA 
session.
Tip: Click Browse to locate the file.

Startup SPECCTRA Specifies to start SPECCTRA after the batch conversion is 
complete.

DO File button Opens the SPECCTRA DO File dialog box.
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Trace Copy Dialog Box

Related Topics

Translating Design Data from PADS Layout to SPECCTRA

Trace Copy Dialog Box
The Trace Copy dialog boxes appear when you perform a group operation that causes an illegal 
trace installation. These dialog boxes may appear when you move, rotate, or paste a group.

The dialog boxes describe the error with the trace and allow you to manage the error on the fly.

Figure 45-364. Trace Copy Dialog Box

Options button Opens the Options dialog box.

Table 45-332. Trace Copy Dialog Box contents 

Name Description

Unroute button Creates an unroute instead of installing the trace.

Ignore button Ignores the error and installs the trace. You are responsible for 
manually correcting the error.

Don't display this 
message again check 
box

Applies the action you click in this dialog box to all subsequent 
traces and prevents this dialog box from appearing again.

Table 45-331. To SPECCTRA Dialog Box contents (cont.)

Name Description
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Trace Loop Created Dialog Box
Use the Trace Loop Created dialog box to delete a trace loop, cycle through which trace in the 
loop you want to delete, or keep the loop.

Accessing

• Automatically opens when you create a trace loop.

Figure 45-365. Trace Loop Created Dialog Box

Trace Properties Dialog Box
Use the Trace Properties dialog box to edit connection information, coordinate locations for 
both corners, segment length, and layer information. You can modify the trace width and 
beginning or ending coordinates on routed traces. 

Accessing

• Select a trace > right-click > Properties.

Table 45-333. Trace Loop Created Dialog Box contents 

Name Description

OK Specifies to delete the loop that was created.

Cycle Specifies to cycle through the traces in the loop to determine 
which one you want to delete.

Create loop Specifies to not delete the loop you just created.
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Trace Properties Dialog Box

Figure 45-366. Trace Properties Dialog Box

Table 45-334. Trace Properties Dialog Box contents 

Name Description

Net Displays the name of the net to which this trace belongs.

Connection Lists where the trace is connected.

X1/Y1 The X and Y starting location of the trace. Type in these fields 
to change the location.

X2/Y2 The X and Y ending location of the trace. Type in these fields 
to change the location. 

Width Specifies the width of the trace. 
Restriction: You cannot enter a value that isn’t within the 
minimum and maximum trace width settings in the Clearance 
Rules. If you enter an illegal value, you get the error message, 
“Wrong width value.”

Length Displays the routed length of the trace.

Protect Status Shows whether the net (to which the trace or trace corner 
belongs) is protected.

Layer Lists the layer on which the trace or trace corner is located. 
You can also change the layer on which the trace resides.
See also: Modifying Trace Segment Properties
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Related Topics

Modifying Trace Segment Properties

Union Properties Dialog Box
Use the Union Properties dialog box to obtain information on and to modify a selected union. 

Accessing

• Select a union > Right-click > Properties

Figure 45-367. Union Properties Dialog Box

Trc/Trc Clearance Displays the trace to trace clearance for this trace.

Rule Hierarchy Displays which rules are apply to the trace.

Pin Pair button Opens the Pin Pair Properties dialog box.

Net button Opens the Net Properties dialog box.

Rules button Opens the Pin Pair Rules dialog box.

TearDrop button Opens the Teardrop Properties on Traces dialog box.

Table 45-334. Trace Properties Dialog Box contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41534

Update from Library Dialog Box

Related Topics

Managing Unions

Update from Library Dialog Box
Use the Update from Library dialog box:

• To update a design with part types and decals from the library, or 

• To compare part types and decals in a design with those in the library.

Tip: To update only selected components, select them before opening the dialog box.

Accessing

• Tools menu > Update from Library

Table 45-335. Union Properties Dialog Box contents 

Name Description

Name Name of the currently selected union. To rename the union 
type a new name. 

X/Y Coordinates Current coordinates of the union. To move the union to a new 
location type new values.

Rotation Current rotation of the union. For a different rotation angle 
type new values.

Layer list Layer on which the union members exist. To flip the union 
click a different layer.

Glued Prevents the union from moving through manual or automatic 
placement processes.

Members Individual parts that are members of the selected union.

Base list Identifies the part used to determine the XY location of the 
union.

Skip while Building 
Cluster

Ignores the union or cluster during Grow Incremental and 
Grow Automatic operations.

Cluster Info Opens the Cluster Information Properties dialog box. 
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Figure 45-368. Update from Library Dialog Box
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Update from Library Dialog Box

Table 45-336. Update from Library Dialog Box Settings

Control Description

Generate comparison report Select to compare library and design items and generate a 
report file. No changes are made to the design.

Update design from library Select to compare library and design items, update the 
design from the library, and generate a report file.

Include items with identical 
timestamps

Select this check box to include in the compare/update 
items whose timestamps are the same in the library and 
design. 
Clear it to exclude these items from the compare/update.
Tip: It is possible for items with identical timestamps to 
have different content in the library and design. For 
example, if you export a design to an ascii file, manually 
edit a part type in the ascii file, and import the design back 
into PADS Layout, the timestamp of the part type will be 
unchanged, but the content will be different.

Part types Select this check box to include part types in the 
comparison/update. 

PCB decals Select this check box to include PCB decals in the 
comparison/update. 
Select this check box to update design components with 
the alternate decals information from the PCB Decals tab 
of the Part Information dialog box.

Decal rules Select this check box to include decal rules in the 
comparison/update.

Attributes and labels Select this check box to include part type attributes and 
decal attributes and labels in the comparison/update. Clear 
it to exclude them.
Tip: A decal’s standard Name and Part labels—not just 
attribute labels—are included in the comparison/update.

Update item in design even 
if library item is older

Select this check box to update a design item even when 
its timestamp is newer than the library item’s timestamp. 
Clear it to prevent replacing a design item with an older 
library item.

Update item even if 
timestamps are identical

Select this check box to update a design item even when 
its timestamp is identical to the library item’s timestamp.
Tip: If this check box is not set, design items with 
identical timestamps will not be updated, even if their 
content is different.
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Preserve alternative decals 
not found in library

Use this check box to specify what you want to do with 
alternative decals in a design part type that do not exist in 
the corresponding library part type:

• Select the check box to preserve the alternative decals 
in the design part type.

• Clear the check box to remove them from the design 
part type (that is, leave only the alternative decals that 
exist in the library version). 

Preserve decal rules not 
found in library

Use this check box to specify what you want to do with 
decal rule sets that are found in the design version of a 
decal, but not in the library version:

• Select the check box to preserve these rule sets in the 
design decal.

• Clear it to remove them from the design decal.

Preserve design attributes 
not found in library

Use this check box to specify what you want to do with 
attributes that are found in the design but not in the 
library:

• Select the check box to keep these attributes in the 
design item.

• Clear it to remove them from the design item.

Add new attributes not 
found in design

Use this check box to specify what you want to do with 
attributes that are found in the library but not in the design.

• Select the check box to add these attributes to the 
design item.

• Clear it to preserve the design item as it is (that is, do 
not add them to the design item.

Update common attributes Use this check box to specify what you want to do with 
attributes found in both the design and the library.

• Select the check box to update the design attribute 
with the library attribute’s values.

• Clear it to preserve the design attribute’s values (that 
is, do not update them).

Table 45-336. Update from Library Dialog Box Settings

Control Description
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Update Pin Gate Dialog Box

Related Topics

Updating a Design from the Library

Update Pin Gate Dialog Box
Use the Update Pin Gate dialog box to update the Pin Group column of selected pins in the Pins 
table on the Pins tab of the Part Information dialog box.

Accessing

• File menu > Library > select a Library > Parts button > New > Pins tab > select cells in 
the Pin Group column > Edit button

or

Visibility
Location
Label properties

Select the attribute properties you want to preserve in the 
design:
• Visibility—Specifies whether and how an attribute 

associated with a label is displayed (none, value, name 
and value, full name and value).

• Location—Specifies label x,y coordinates, layer, and 
rotation.

• Label properties—Includes font, justification and right 
reading settings.

Summary and details
Summary only

See How to Read the Update Report.

Hide identical results Select this check box to see only the differences between 
library and design items in the Detailed Comparison Data 
section of the report.
Clear it to see all comparison data.

Hide graphics comparison 
details

Select this check box to exclude graphical data of 
drawings, coppers, associated coppers and decal outlines 
from the report. Clear it to include graphical data.

Remove selected items Click this button to remove items currently selected in the 
Design Items lists.
Tip: The items appearing in these lists are determined as 
follows: If one or more design components are selected 
when Update from Library is started, only the part types 
and decals of the selected components appear in the lists. 
If no components are selected, the part types and decals of 
all design components appear in the lists.

Table 45-336. Update from Library Dialog Box Settings

Control Description
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• File menu > Library > select a Library > Parts button > select a part > Edit button > 
Pins tab > select cells in the Pin Group column > Edit button

Figure 45-369. Update Pin Gate Dialog Box

Update Pin Name Dialog Box
Use the Update Pin Name dialog box to update the Name column of selected pins in the Pins 
table on the Pins tab of the Part Information dialog box.

Accessing

• File menu > Library > select a Library > Parts button > New > Pins tab > select cells in 
the Name column > Edit button

or

• File menu > Library > select a Library > Parts button > select a part > Edit button > 
Pins tab > select cells in the Name column > Edit button

Table 45-337. Update Pin Gate Dialog Box contents 

Name Description

Pin Gate list Specifies the setting to assign selected pins in the pins table.
Possible settings include:
Gate-n—assign to gate pins. This selection is only available if 
you’ve added gates on the Gates tab.
Signal pin—assign to implicit pins (not shown on the 
schematic)
Unused pin—assign to unused pins
Connector pin—assign to connector pins. This selection is 
only available if the part is set as a Special Purpose > 
Connector on the General tab.
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Update Pin Swap Dialog Box

Figure 45-370. Update Pin Name Dialog Box

Update Pin Swap Dialog Box
Use the Update Pin Swap dialog box to update the Swap column of selected pins in the Pins 
table on the Pins tab of the Part Information dialog box.

Accessing

• File menu > Library > select a Library > Parts button > New > Pins tab > select cells in 
the Swap column > Edit button

or

• File menu > Library > select a Library > Parts button > select a part > Edit button > 
Pins tab > select cells in the Swap column > Edit button

Figure 45-371. Update Pin Swap Dialog Box

Table 45-338. Update Pin Name Dialog Box contents 

Name Description

Pin Name box Specifies the name to assign selected pins in the pins table.
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Update Pin Type Dialog Box
Use the Update Pin Type dialog box to update the Type column of selected pins in the Pins table 
on the Pins tab of the Part Information dialog box.

Accessing

• File menu > Library > select a Library > Parts button > New > Pins tab > select cells in 
the Type column > Edit button

or

• File menu > Library > select a Library > Parts button > select a part > Edit button > 
Pins tab > select cells in the Type column > Edit button

Figure 45-372. Update Pin Type Dialog Box

Table 45-339. Update Pin Swap Dialog Box contents 

Name Description

Pin Swap box Specifies the swap number to assign selected pins in the pins 
table.
Pins with the same swap number can have their connections 
swapped in the design using the Swap Pin or Auto Swap Pin 
features on the ECO toolbar.

Table 45-340. Update Pin Type Dialog Box contents 

Name Description

Pin Type list Specifies the type to assign selected pins in the pins table.
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Variant/Substitute Dialog Box

Variant/Substitute Dialog Box
The Variant/Substitute dialog box appears when you choose to substitute a component in an 
assembly variant. When you substitute a component, the substitution is referred to as the active 
component. The original component that you substituted is referred to as the default. The 
default component is what exists in the base option and the raw database.

Accessing

1. Tools menu > Assembly Variants

2. There are several ways to begin substituting a component:

• Click an Assembly Variant in which you want to substitute the component from the 
Variant Name list, select the component name to change, and click Substituted in 
the Status area. 

Or

• Select a component in the multicolumn list, and click Substitute in the Status area.

Or

• Click Substitute from the Verb Mode list, and select a component in the Layout 
Editor. 

Figure 45-373. Variant/Substitute Dialog Box
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Related Topics

Substitute a Component for Assembly Variants

Verify Design Dialog Box
You can check for individual or all design errors using the Verify Design dialog box. Check for 
the following types of errors: clearance, connectivity, high speed, number of vias, plane 
connection, test point, fabrication, wire bond. It does not check reference designator, part type, 
or attribute labels for clearance violations.

Accessing

• Tools menu > Verify Design

Table 45-341. Variant/Substitute Dialog Box contents 

Name Description

Current Displays the state before you click Substituted.

New Displays the state after you click Substituted.

Show difference Specifies to display only the differing values of the Default and 
Active component in the Variant table.

Browse Opens the Get Part Type from Library dialog box.

Variant Displays the name of the selected variant.

Variant table Displays the attributes (Value) of the component you are 
substituting, its Default value, and its Active value (the 
substitution).

Preview Opens the Preview for dialog box where you can see the 
substitutions you’ve made.
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Verify Design Dialog Box

Figure 45-374. Verify Design Dialog Box

Table 45-342. Verify Design Dialog Box contents 

Name Description

Location list Lists the error for the type of check you selected in the Check 
area.

Explanation list Displays the reason for the error selected in the Location list.

Clear Errors button Clears the Error Markers.
Important: This does not clear the actual errors.

Disable Panning Prevents the design area from panning to the error you select in 
the Location list.

Display summary 
prompt

Specifies to display the error-summary prompt window. The 
prompt window appears after the check has run and lists the 
total number of errors found.
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Check area Specifies the type of check you want to run, set up, view, or 
specify a report for.
• Clearance—Performs clearance checking on only the 

visible area of the design. 
See also: Clearance Checking Setup Dialog Box
Tip: When clearance checking against the board outline, 
the edge of the object is checked against the centerline of 
the board outline.

• Connectivity—Performs connectivity checking on the 
entire design.
Tips: 
• The connectivity check also detects instances where a 

drill size is larger than the pad it is assigned to.
• Connectivity checking recognizes copper as a valid 

conductor, like a trace.
For troubleshooting errors, see Connectivity Errors.

• High Speed—Performs high-speed checking on the entire 
design. 
See also: Electrodynamic Check Dialog Box
Traces on high-speed printed circuit boards can act like 
transmission lines that “broadcast” interference to adjacent 
conductors. Using the high-speed rules module, you can 
use Rules to set clearances on a net class, net, or pin to pin 
connection basis; then use high-speed checking to report on 
properties such as impedance, delay, track length, daisy 
chaining, and parallel routing. These issues cause 
interference and create costly problems in prototyping. You 
can run these checks against the entire board or against 
specific nets.

• Maximum Via Count—Performs maximum via count 
checking on the entire design.

• Plane—Performs plane checking on the entire design. 
Checks whether a pad exists in the connecting pad stack for 
the plane layer. For a pad size to exist it must be more than 
0 or the drill size must exceed the pad size. For links to 
SMD pads, Plane checks whether the pad-to-via connection 
connects to the plane. 
See also: Mixed Plane Setup Dialog Box
Tip: To view Plane clearance or connectivity errors after 
performing a Plane check, return to the Verify Design 
dialog box and click Clearance or Connectivity.

Table 45-342. Verify Design Dialog Box contents (cont.)

Name Description



PADS Layout User’s Guide and Reference Manual, PADS 9.41546

Verify Design Dialog Box

Check area (con’t) • Test Points—Performs test point checking on the entire 
design. Test Points checks for probe clearances, minimum 
via/pad sizes for probing, SMD pin probing, test points on 
component pin on the component side, test point count per 
net settings and nail diameter settings, and compares the 
settings against the setting you make in the DFT Audit 
program. 
See also: Performing a Test Point Audit
Tip: Test point checking is the same whether you enable 
the checking on the Verify Design dialog box or on the 
Latium Checking Setup dialog box. If you plan to perform 
Latium Design Verification, you can eliminate an extra 
design transfer between PADS Layout and PADS Router 
by running test point checking along with the other Latium 
checks.

• Fabrication—Performs DFF error checking on designs by 
either using CAM documents in PADS Layout or by using 
errors that are backward annotated from CAM350.
Requirement: You need the CAM350 Link license option 
to use this. On the Help menu, click Installed Options and 
on the Options tab, check if the option is available in your 
license.
See also: Fabrication Checking Setup Dialog Box, Back-
annotating CAM350 Files

• Latium Design Verification—Performs clearance 
checking on only the visible area of the design. Any 
Latium rule errors found appear in the Location list. The 
design is passed to PADS Router to perform the verify 
design check, and is passed back to PADS Layout when the 
process is complete. If you used PADS Router to work on 
your design, it might contain advanced rules (differential 
pairs, vias at SMD, matched length traces) which only 
PADS Router can check. 
The Latium Design Verification:
a. Saves the current PADS Layout database to a temporary 

file
b. Starts PADS Router (if not already running)
c. Starts the PADS Router Monitor in Verify Design Mode
d. Loads the saved PADS Layout design into PADS Router
e. Executes the selected checking operations
f. Saves the file in PADS Router
g. Re-loads the PADS Router file into PADS Layout

• Wire Bonds—Performs clearance checking on the entire 
design. Checks wire bond length, width, angle, and the 
clearance between wire bonds and substrate bond pads for 
all die parts in the design.
Tip: Rules for individual die parts are set using the Wire 
Bond Rules dialog box when in the Wire Bond Editor.

Table 45-342. Verify Design Dialog Box contents (cont.)

Name Description
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Related Topics

Verifying the Design (contains error troubleshooting)

Via Properties Dialog Box
The Via Properties dialog box displays the netname to which the via belongs, the via name, 
coordinates, and where the via is connected. 

Start button Runs the check with your specified options.

Setup button Opens the setup dialog box for the check you have selected.
• Clearance—Clearance Checking Setup dialog box
• Connectivity—Connectivity Checking Setup dialog box
• High Speed—Electrodynamic Check dialog box
• Maximum Via Count—Unavailable
• Plane—Mixed Plane Setup dialog box
• Test Points—Unavailable
• Fabrication—Fabrication Checking Setup dialog box
• Latium Design Verification—Latium Checking Setup 

dialog box
• Wire Bonds—Wire Bond Checking Setup dialog box

View Report button Opens the report in a text editor for the check you have 
selected. These reports are saved in the \PADS Projects folder 
by default.
• Clearance—clear.lst
• Connectivity—connect.lst
• High Speed—hispeed.lst
• Maximum Via Count—viacount.lst
• Plane—chtie.lst
• Test Points—testpt.lst
• Fabrication—DFF.lst
• Latium Design Verification—latium.lst
• Wire Bonds—diecheck.lst

Report File button Specifies where you want to save your report file. You can set 
a different location and name for each type of check.

Preview button After you run a Fabrication check that reports errors, you can 
preview the CAM layer document associated with the error. 
The Preview button is available only when fabrication 
checking is enabled and lists errors.

Errors Displays the number of errors for the type of check you ran 
after you click Start.

Table 45-342. Verify Design Dialog Box contents (cont.)

Name Description
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Via Properties Dialog Box

Accessing

• Select a via > right-click > Properties

Figure 45-375. Via Properties Dialog Box

Table 45-343. Via Properties Dialog Box contents 

Name Description

Net Displays the name of the net to which this via belongs.

Connection Lists where the via is connected.

X/Y The X and Y location of the via. Type in these fields to change 
the location.
Restriction: These fields are not available when the Stitching 
check box is selected.

Via Name Lists the via type. You can click a different type from the list 
and apply it. 
Tip: If Lock Test Point in the Routing / General page of the 
Options dialog box is on, you cannot reassign a via type. If you 
reassign a via type that is a locked test point, the Warning: Test 
Point Locked dialog box appears.

Trc/Trc Clearance Displays the trace to trace clearance for this via.

Rule Hierarchy Displays which rules are apply to the via.
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Glued Glues the via so you cannot move it. If you try to move the via, 
a message will appear notifying you that the via is glued. You 
can override the glue setting.
You can fix a via's location on the fabrication board by turning 
on the Glued check box in the Via Properties dialog box. The 
points of a bed of nails test apparatus are matched to the test 
point locations, which can be vias. So if you redesign and 
remanufacture the board, the glued test points prevent the vias 
from moving in the new design, thus preventing costly 
retooling of the test equipment.

Test Point Makes the via or pin a test point. 
This is a three-state check box that depends on the state of the 
selected objects. If all of the selected vias or pins are a test 
point, then it is on. If none of the selected vias or pins are a test 
point, then it is off. If some of the selected vias or pins are a 
test point and some are not, then it is undefined. 
You can make all selected vias or pins test points by turning 
Test Point on and choosing Apply. You can remove the test 
point from all selected vias or pins by turning Test Point off 
and choosing Apply. When you click Apply the pad stack is 
automatically checked to see if the via or pin can be a test 
point; for example, you cannot make buried vias test points 
because a probe cannot access a buried via.
Tip: When the via or pin is flagged as a test point, and Show 
Test Points is checked on the Routing / General page of the 
Options dialog box, an arrow is drawn on it in the design:

Plane Thermal Determines whether the pin or via is eligible to receive a 
thermal. The status of a thermal is set individually by pin and 
via, and the thermal indicators will appear on plane layers 
only. Click to clear this check box if you do not want the via or 
pin to connect to any plane.
Once a pin or via is eligible, it is not automatically assigned a 
thermal attribute.
See also: Connecting a Net with a Plane, Setting Pins and Vias 
as Thermals

Stitching Determines that this is a stitching via. Vias that are not added 
during the process of routing a trace are marked as stitching 
vias. These vias are treated differently from regular vias 
(which can be ripped up or shoved by the dynamic router).

Table 45-343. Via Properties Dialog Box contents (cont.)

Name Description
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Vias Dialog Box

Related Topics

Modifying Via Properties

Vias Dialog Box
Use the Vias dialog box to determine what kind of via to install when you change layers during 
routing. When you choose a via type, that type is used with the Add Vias and Add Vias to Guide 
commands. You can also change the via type during routing.

Accessing

• Type v > press Enter

Top Access Attempts to probe the test point from the top and bottom in 
DFT Audit. The default is bottom; so with Top Access off, 
DFT Audit automatically tries to probe the test point from the 
bottom. 
See also: Performing a Test Point Audit
When you click Apply, the pad stack is automatically checked 
to see if top access is valid; for example, you must assign Top 
Access to partial vias with only top access if you want to use 
the vias as test points.
You can only set the Top Access option if the via or pin is a 
test point (Test Point is on).

Pin Pair button Opens the Pin Pair Properties dialog box.

Net button Opens the Net Properties dialog box.

Rules button Opens the Pin Pair Rules dialog box.

Pad Stack button Opens the Pad Stacks Properties dialog box.

Attributes button Opens the Object Attributes dialog box.

Table 45-343. Via Properties Dialog Box contents (cont.)

Name Description
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Figure 45-376. Vias Dialog Box

Table 45-344. Vias Dialog Box contents 

Name Description

Via Mode area • Automatic—PADS Layout chooses from all vias, through 
or partial, that can handle the particular layer change. If 
PADS Layout finds partial vias dedicated to the layer 
change, it chooses from them. If PADS Layout can't find a 
dedicated partial via, it selects any through vias for a 
through or partial layer change even if the via is not one 
that is specifically selected in the Via list. It then checks the 
Routing Rules dialog box for vias that are allowed for the 
net you are routing. If more than one via still passes, PADS 
Layout installs the one with the smallest drill diameter or 
smaller pad size. Automatic allows only vias that begin and 
end on the Layer Pair shown on the Routing / General page 
of the Options dialog box.
To use automatic via mode, the layer pair for routing and 
the layer pair for the partial via definition need to match. 
For example, if you have a partial via set up for layers 1 
through 4, and the layer pair for routing is set for layers 1 
through 8, automatic mode will not insert a via.

• Partial—The automatic via selection still occurs, but it is 
limited to the partial vias only.

• Through—The list of through vias becomes active. Click 
the via you want to use as the default and click Apply. This 
is the via which is installed every time you change between 
layer pairs.

Via List Lists through hole vias available in the design; partial vias are 
not listed.
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View Clearance Dialog Box

Related Topics

Setting a Via Type

To Change the Via Type While Routing

View Clearance Dialog Box
Use the View Clearance dialog box to find the minimum clearance between two items.

Accessing

• View menu > Clearance > click the button for the type of clearance > select two items 
in the design

Figure 45-377. View Clearance Dialog Box

Table 45-345. View Clearance Dialog Box contents 

Name Description

Selected Items Displays information about selected nets and items. The 
clearance button you select determines valid selections
Tip: Jumper outlines, text, and teardrops are not valid item 
types for clearance.

Min Clearance Calculates and displays the minimum clearance between the 
selected items, the selected net and its closest item, or between 
the selected nets.

Pan to Minimum 
Clearance Marker

Pans the view so the minimum clearance marker is in the 
center of the main workspace. This is available only for Net to 
Item and Net to Net.
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Related Topics

To View the Clearance Between Items

To View the Clearance Between a Net and an Item

To View the Clearance Between Nets

View Nets Dialog Box
Use the View Nets dialog box to:

• Selectively hide or display connections.

• Hide or show routed or unrouted paths by netname.

Tip: If View Nets hides unrouted connections, neither Verify Design nor Find can see them. 
Make sure View Nets does not disable any nets or traces you want to search for.

Accessing

• View menu > Nets

Item to Item button Finds the minimum clearance between two selected items. 
Supported item types are board outlines, pads, vias, jumpers, 
traces, 2D lines, copper, copper pour, and component outlines.
Tip: Jumper outlines, text, and teardrops are not valid item 
types for clearance.
Clearances are measured on the current layer. When one or 
both selected items are not on the current layer, the clearance is 
measured to the centerline of the item that is not on the current 
layer.

Net to Item button Finds the minimum clearance between a selected net and the 
closest item. Items include: pads, vias, jumpers, traces, 2D 
lines, copper, copper pour, and component outlines.

Net to Net button Finds the minimum clearance between two selected nets.

Options button Opens the Dimensioning / General page of the Options dialog 
box where you can control the extension lines and arrows used 
to show minimum clearance.
Tip: To modify the appearance of the text, lines, arrows, and 
so on, used to show clearances, use the Dimensioning / 
General page on the Options dialog box.

Table 45-345. View Clearance Dialog Box contents (cont.)

Name Description
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View Nets Dialog Box

Figure 45-378. View Nets Dialog Box

Table 45-346. View Nets Dialog Box contents 

Name Description

Net list Lists all of the nets available in the design.

View list Lists all of the nets for which you want to set view properties.

Add/Remove buttons Add moves selected net names into the View List box where 
you can highlight net names and set view details for them. Use 
Ctrl for multiple selections. Click Remove to move the net 
from the View List to the Net List.

Select By list Click a command from this list box to change the available 
nets in the Net List and View List boxes.
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Related Topics

Modifying Net Properties

To Assign Colors to Nets

Using the Net Properties Dialog Box

Color by Net area Sets a color to a selected net in the View Nets list. When you 
assign a color to a net, pads, unroutes, and vias on all layers, as 
well as traces optionally appear in that color, making it easier 
to identify nets when splitting planes. When you split planes, 
you can assign color to the critical signals and then create 
correct copper pours with greater ease. All net color 
assignments are saved with the design.
Use Color by Net to:
• Assign color to a net class or a class with rules.
• Assign power and ground colors and turn off the visibility 

of their unroutes. Pins appear in the color you set. This aids 
in the placement of capacitors and resistors; you don't need 
to view the power and ground unroutes.

• Assign color for critical nets so their static unroutes are 
clearly visible during placement.

Color Traces by Net Shows traces, for nets in the View List box, using the assigned 
color. Traces, pins, copper pours, and unroutes appear in the 
assigned color.

Traces Plus the 
Following Unroutes 
check box

Enables filtering of the unrouted connections, where you can 
set the commands in the View Unroutes Details area.

View Unroute Details 
area

The Unroute Details area options are:
• All—Displays all unroutes.
• All Except Connected Plane Nets—Displays all unroutes 

except for those on plane nets whose connection to the 
plane have been satisfied.
This option does not display unroutes to stitching vias that 
are embedded in copper pour, split mixed planes, or CAM 
planes.

• Unrouted Pin Pairs—Displays only unroutes on fully 
unrouted pin pairs.

• None—Displays no unroutes.

Table 45-346. View Nets Dialog Box contents (cont.)

Name Description
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Warning: Test Point Locked Dialog Box

Warning: Test Point Locked Dialog Box
This warning dialog box performs different functions depending on whether you are modifying 
vias, pins, or routes.

Accessing

To access the Warning dialog box, modify any of the following:

• A cluster that contains test points

• Vias, pins, or jumper pins that are locked test points

• Routes that are connected to locked test points

Figure 45-379. Warning Dialog Box

Related Topics

Warning: Test Point Locked Dialog Box

Wire Bond Checking Setup Dialog Box
Use the Wire Bond Checking Setup dialog box to specify which wire bond rules to check during 
a Wire Bonds verification.

Accessing

• Tools menu > Verify Design > Wire Bonds check > Setup button

Table 45-347. Warning Dialog Box contents 

Name Description

Disable Lock Test 
Points

Turns the Lock Test Points check box off in the Routing / 
General page of the Options dialog box

OK button Applies the change and maintains the test point status.
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Figure 45-380. Wire Bond Checking Setup Dialog Box

Related Topics

Setting Up Wire Bond Checking

Wire Bond Properties Dialog Box
In the Wire Bond Editor, with one or more wire bonds selected, right-click and click Properties 
to edit the Wire Bond properties.

Restriction: This information applies to only the BGA toolkit.

Note: If you have multiple objects selected, properties that are not common to all selected 
objects will not appear.

Table 45-348. Wire Bond Checking Setup Dialog Box contents 

Name Description

Wire Bond to Wire 
Bond Clearance

Assigns the clearance required, in current units, between 
adjacent wire bonds. All checking is done edge to edge.

Wire Bond to 
Substrate Bond Pad 
Clearance

Assigns the clearance required, in current units, between wire 
bonds and adjacent substrate bond pads. All checking is done 
edge to edge.

Minimum Length Assigns the minimum length, in current units, for all wire 
bonds in the die part.

Maximum Length Assigns the maximum length, in current units, for all wire 
bonds in the die part.

Maximum Angle Assigns the maximum angle, in degrees, at which you can 
place wire bonds in the die part.
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Wire Bond Properties Dialog Box

Accessing

• BGA Toolbar button > Wire Bond Editor button > Select a wire bond > right-click > 
Properties

Figure 45-381. Wire Bond Properties Dialog Box

Table 45-349. Wire Bond Properties Dialog Box contents 

Name Description

CBP Offset Specifies the X and Y values, with respect to the CBP 
orientation, at which to offset the wire bond from the center of 
the component bond pad.

SBP Offset Specifies the X and Y values, with respect to the SBP 
orientation, at which to offset the wire bond from the center of 
the substrate bond pad.

Width Type a width for the wire bond. The valid range is from 0 
through 250 mils. If you enter 0, the display line has a width of 
0.01 mil.

Length Displays the length, in current design units, of the currently 
selected wire bond.

Angle Displays the angle, in degrees, of the currently selected wire 
bond.
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Wire Bond Rules Dialog Box
Use the Wire Bond Rules dialog box to define rules that apply to wire bonds in the die part. All 
checking is done edge to edge.

Restriction: This information applies only to the BGA toolkit.

Accessing

• BGA Toolbar button > Wire Bond Wizard button > Wire Bond Rules button

Figure 45-382. Wire Bond Rules Dialog Box

Rules Data Displays the current wire bond rules information taken from 
the Wire Bond Rules dialog box.

CBP button Opens the CBP Properties dialog box for the component bond 
pad connected to the currently selected substrate bond pad. 
This button is unavailable if there is no connected component 
bond pad.

SBP button Opens the SBP Properties dialog box for the substrate bond 
pad connected to the currently selected component bond pad. 
This button is unavailable if there is no connected substrate 
bond pad.

WB Rules button Opens the Wire Bond Rules dialog box.

Table 45-349. Wire Bond Properties Dialog Box contents (cont.)

Name Description
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Related Topics

Checking Wire Bond Rules

Wire Bond Wizard Dialog Box
Use the Wire Bond Wizard dialog box to do the following:

• Define the SBP rings.

• Set rules.

Table 45-350. Wire Bond Rules Dialog Box contents 

Name Description

WB to WB Clearance Assigns the clearance required, in current units, between 
adjacent wire bonds. The rule is not checked unless you select 
it and enter a value. All checking is done edge to edge.
Tip: Unchecked rules appear in the wire bond report as “Not 
Set.”

WB to SBP Clearance Assigns the clearance required, in current units, between wire 
bonds and adjacent substrate bond pads. The rule is not 
checked unless you select it and enter a value. All checking is 
done edge to edge.

Min Length Assigns the minimum length, in current units, for all wire 
bonds in the die part. The rule is not checked unless you select 
it and enter a value.
Tip: Unchecked rules appear in the wire bond report as “Not 
Set.”

Max Length Assigns the maximum length, in current units, for all wire 
bonds in the die part. The rule is not checked unless you select 
it and enter a value.
Tip: Unchecked rules appear in the wire bond report as “Not 
Set.”

Max Angle Assigns the maximum angle, in degrees, at which you can 
place wire bonds in the die part. The rule is not checked unless 
you select it and enter a value.
Tip: Unchecked rules appear in the wire bond report as “Not 
Set.”

Import button Imports wire bond rules saved in the Wire Bond Wizard dialog 
box from the Wire Bond Wizard Setup file, and assigns the 
values as rules for the currently open die part when you click 
OK in the Wire Bond Rules dialog box.
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• Assign the component bond pads to rings.

• Define the wire bond fanout geometry.

• Create a wire bond fanout.

The Die Wizard has 4 tabs:

• Guide

• Fanout Prefs

• Strategy

• CBPs

Accessing

• BGA Toolbar button > Wire Bond Wizard button > select die part

Figure 45-383. Wire Bond Wizard Dialog Box
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Table 45-351. Wire Bond Wizard Dialog Box contents 

Name Description

Die Component Displays the selected Die Component.

SBP Rings list Lists all currently defined SBP rings. Select an SBP ring or 
rings to view, edit, or define.
You can also add new rings, delete rings, and rename rings.

Add button Opens the Add SBP Ring dialog box, where you can insert a 
new SBP ring for the die.

Delete button Deletes the selected SBP ring. This also unassigns all 
component bond pads assigned to this ring and deletes SBPs 
and wire bonds, but only if the CBPs are assigned to a single 
SBP ring. If a CBP is assigned to two or more SBP rings, and 
one of the rings is deleted, the CBP remains assigned to the 
remaining ring, and the corresponding SBPs and WBs are kept.

Rename button Opens the Rename SBP Ring dialog box, where you can 
rename the currently selected SBP ring.

tabs • Guide
• Fanout Prefs
• Strategy
• CBPs

Save Setup button Saves Wire Bond Wizard dialog box settings from the current 
design to use in another design. The settings are stored in a text 
file with a .wbw extension.
Use Load Setup to open .wbw files and apply the settings to 
other designs.

Load Setup button Loads the settings from the text setup file and uses them in the 
current design. The settings are stored in a text file with a .wbw 
extension.
Use Save Setup to save .wbw files to use them in another 
design.

SBP to SBP Clearance 
Rules

Displays the default value for the SBP–to–SBP clearance rule, 
represented by SMD-to-SMD default clearance rules set on the 
Clearance Rules dialog box.

Design Rules button Opens the Rules dialog box, where you can change the value 
for the SMD-to-SMD default clearance rule settings affecting 
the SBP-to-SBP clearance. From the Rules dialog box, click 
Default, then Clearance.

Wire Bonds area Displays the settings for all wire bond rules for the currently 
selected die component.
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Wire Bond Rules button Opens the Wire Bond Rules dialog box, where you can specify 
the wire-bond-to-wire-bond clearance, wire-bond-to-substrate-
bond-pad-clearance, wire bond minimum and maximum 
lengths, and wire bond maximum angle.

Assign CBPs button Opens the Assign CBPs to Rings dialog box, where you can 
assign component bond pads to one or more rings.

SBP Naming button Opens the SBP Properties dialog box, where you can specify 
substrate bond pad numbers and substrate bond pad function 
names for newly created substrate bond pads.

Generate Fanout for area Select component bond pads for fanout processing.
• Sides—Select the SBP ring side or sides to process. Wire 

Bond Wizard processes all component bond pads assigned 
to the selected side or sides of the SBP rings.

• Selected CBPs—Select component bond pads in the layout 
window. 

Allow Gaps Allows gaps when placing wire bonds in the wire bond fanout. 
Otherwise, Wire Bond Wizard evenly distributes all wire bond 
fanouts into a compact group.

Fit to Guide Fits the substrate bond pads along the SBP guide using the 
preferred spacing values for the SBP rings. Otherwise, Wire 
Bond Wizard uses a smaller value, up to the minimum spacing 
allowed by the rules.

Preview Fanout button Displays a wire bond fanout preview using the current settings. 
You can repeatedly view and modify the fanout until it 
satisfies the wire bond rules.
If you change any of the settings that affect the fanout pattern, 
the fanout changes to Preview of CBP Assignment mode.

Report Generates a report containing created object and wire bond 
rule violations.

Error Markers Generates and displays error markers in the fanout preview.

Create Fanout button Creates the new fanout and saves its settings in the design. 
This also generates a report that lists created objects and wire 
bond rule violations.

Table 45-351. Wire Bond Wizard Dialog Box contents (cont.)

Name Description
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Figure 45-384. Wire Bond Wizard, Guide tab

Table 45-352. Guide tab contents 

Name Description

Size area Defines the size of the SBP guide:
• Distance from Die—Click to enter X and Y values for the 

distance of the substrate bond pad guide box from the die 
outline.

• Size—Click to set an absolute size for the guide box.

Shape list Defines the shape of the SBP guide. Available selections are: 
rectangle, rounded rectangle, arced, and tent. If you select 
arced or tent, you can also select a height.

By Side Creates a substrate bond pad guide with mixed shapes.

Shape by Side area Defines a shape for each side of the SBP guide.
To define a shape for a side, click Enable. In the Shape 
column, select a shape type for that side. When you select the 
arced or tent shape, select a height in the Height column.
You can create the SBP guide with one or more sides missing. 
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Figure 45-385. Wire Bond Wizard, Fanout Prefs tab

Table 45-353. Fanout Prefs contents 

Name Description

Shape Select a shape for the substrate bond pads to create in the 
fanout of the currently selected SBP rings. Choices are 
Rectangle and Oval.

Length Select a length for the substrate bond pads to create in the 
fanout of the currently selected SBP rings.

Width Select a width for the substrate bond pads to create in the 
fanout of the currently selected SBP rings.

Layer Select an electrical layer for the substrate bond pads of the 
currently selected SBP rings.

Focus area Select the area on which you want the focus: Ortho, CBP, 
Center. or X/Y location.

Width Select a width for the wire bond for the fanout of the currently 
selected SBP rings.

Offset Select an offset for the wire bond for the fanout of the currently 
selected SBP rings.
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Figure 45-386. Wire Bond Wizard, Strategy tab

Table 45-354. Strategy tab contents 

Name Description

SBP to SBP for This 
Ring

Displays the substrate-bond-pad-to-substrate-bond-pad 
clearance value for the layer to create the substrate bond pads 
for the selected rings. The clearance value for this ring may be 
different from the default SBP–to–SBP clearance if specific 
design rules are used for the layer specified on the Fanout Prefs 
tab. The layer is specific to the substrate bond pads of this ring.
The SBP–to–SBP clearance rule is represented by SMD-to-
SMD clearance rules set on the Clearance Rules dialog box.

SBP to SBP Spacing Defines the preferred spacing from substrate bond pad to 
substrate bond pad for the selected ring. The value must be 
equal to or larger than the current SBP–to–SBP rule, 
represented by SMD-to-SMD clearance rules set on the 
Clearance Rules dialog box.

WB to SBP Spacing Defines the preferred spacing from wire bonds to substrate 
bond pads for the selected rings. The value must be equal to or 
larger than the WB–to–SBP rule set on the Wire Bond Rules 
dialog box.
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Figure 45-387. Wire Bond Wizard, CBPs tab

Force Preferred 
Spacing

Prevents automatic switching to the smallest allowed spacing 
when fitting the substrate bond pads of the selected rings along 
the substrate bond pad guide.
If Fit to Guide is selected, you can affect the spacing of the 
wire bonds of the selected rings by clearing the Force Preferred 
Spacing option.

Create Nets from Pin 
Function

Incorporates all new substrate bond pads with the same 
function name into the net of the same function name. If this 
net does not already exist, Wire Bond Wizard creates it.

Ignore SBP to SPB 
Clearance

Ignores the SBP to SBP Clearance rules.

Table 45-355. CBPs tab contents 

Name Description

CBP column Lists the numbers of all component bond pads assigned to the 
selected ring.

CBP Function column Lists the functions of all component bond pads assigned to the 
selected ring.

SBP Function Lists the functions of all substrate bond pads assigned to the 
selected ring. 

Table 45-354. Strategy tab contents (cont.)

Name Description
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Related Topics

To Create a Wire Bond Fanout

BGA Operations

Working Folder Browser Dialog Box
Use the Working Folder Browser dialog box to add project files to the Schematic project file, 
Layout project file, and Additional files and folders lists in the Add Archive to Vault and 
Templates dialog boxes.

Tip: Some files are automatically saved with a selected .prj or .pcb file; these files are not 
displayed in the browser file tree. For example, when you select a .prj file, its associated 
database folder is not displayed for you to select, because it is always saved with the .prj file.

Accessing

• In the Add Archive to Vault dialog box, click the Browse button .

Select All button Selects all component bond pads in the CBP list to assign to 
the currently selected rings.

Invert Selected button Inverts all selections currently in the list. If one item is 
currently selected, this button will deselect that one item and 
select all other items instead.

Show Only CBPs for 
Selected Sides

Displays only component bond pads specified in the Generate 
Fanout for area of the Wire Bond Wizard dialog box. If you do 
not select this option, the list displays all component bond 
pads, no matter what the current settings are in the Generate 
Fanout for area.

Unassign button Removes the assignments of the selected component bond 
pads from their rings and returns those component bond pads 
to the list of unassigned component bond pads, if the CBPs 
belong to a single SBP ring. Otherwise the CBPs still belong to 
the remaining rings to which they were assigned. 

Reassign To Opens the Reassign CBPs to Rings dialog box, where you can 
select a ring or rings in the list to reassign component bond 
pads. 

Table 45-355. CBPs tab contents (cont.)

Name Description
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Figure 45-388. Working Folder Browser Dialog Box
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Working Folder Browser Dialog Box
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Chapter 46
PADS Layout Automation Server

Welcome to the Automation Server Help
This help file describes the Automation Server features contained in PADS Layout, and 
includes:

• OLE Background, a short description of OLE and Automation.

• The Automation Server Object Hierarchy

• PADS Layout Automation Samples showing how to get started with writing 
Automation clients, in Microsoft Visual Basic, Microsoft Visual C++, and Microsoft 
Excel

Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. 
Mentor Graphics provides these samples as a courtesy to its users. Freeware is provided 
as is and Mentor Graphics makes no warranties with respect to freeware, either express 
or implied, including any implied warranties of merchantability or fitness for a 
particular purpose.

• PADS Layout Automation Server Reference, listing and detailing each Automation 
object, property, method, and event in the Automation Server.

OLE Background
“The fundamental question OLE addresses: How can a system be designed such that binary 
components from different vendors—written in different parts of the world at different times 
and using different programming languages—are guaranteed to interoperate?”

                                                        Dr. Dobbs's Journal, January 1995.

Technically, OLE stands for Object Linking and Embedding, but that is now an insufficient 
title. Today, OLE is a continuously growing set of features (including Object Linking and 
Embedding, Automation, Compound Documents, Visual Editing, ActiveX, DCOM, and so on) 
based on Microsoft's version of a framework allowing heterogeneous applications to 
communicate with each other.

Automation is a feature of OLE that defines a protocol for applications to share their data and 
functionality with any other application using that same protocol. Automation involves a server 
and a client. A server is the entity that makes available some data and functionality. A client, 
also called the controller, is the entity that uses the server's data and functionality. Different 
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people at different organizations can author servers and clients at different times, using different 
development tools and languages. The only required commonality is that they use the same 
Automation communication protocol. PADS Layout is an Automation server because it makes 
some data (the database) and some functionality (such as opening design files and selecting 
objects) available to other applications. A client, such as Microsoft Excel, can access PADS 
Layout data and functionality using the Automation protocol.

The Automation implementation allows third party companies and users to:

• Integrate their products.

• Expand the PADS Layout set of functionality.

• Customize existing features.

• Automate tasks using standard scripting languages.

In addition, this can be done independently from release cycles.

Sample 5 demonstrates exactly these benefits, as it integrates PADS Layout and Excel and 
expands the Report command with clean, customizable Excel reports; giving the end-user a 
tightly integrated and customizable Excel report solution.

The Automation Server Object Hierarchy
Tip: The CBP, SBP, and Wirebond objects are for the Advanced Packaging Toolkit only and 
are only applicable if the object is a die part (Component.IsDiePart).
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Figure 46-1. The Automation Server Object Hierarchy

(Click on an item to view its properties, methods and events.)
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PADS Layout Automation Samples

Samples Summary
To make it easy for you to develop Automation clients designed for PADS Layout, or to 
integrate existing applications, several samples of this technology that you can use and modify 
are available. These samples are in the C:\PADS Projects\Samples\Scripts\Layout\samples 
folder. These samples include:

• Sample 1 details the basics of creating an Automation client for the PADS Layout 
server. This sample demonstrates how to connect to an existing or new instance, how to 
disconnect from it, and how to access simple data. 

• Sample 2 extends Sample 1 by adding events, which notify clients when the state of 
PADS Layout changes.

• Sample 3 extends Sample 2 by adding access to the PADS Layout database.

• Sample 4 extends Sample 3 by adding a full-duplex cross-probing feature between the 
client and PADS Layout. Sample 4 also adds detailed database information retrieval.

• Sample 5 is a full-featured custom plug-in that generates custom “intelligent reports” of 
the current design in various formats, such as Microsoft Excel spreadsheets, Microsoft 
Word tables, and HTML pages. Intelligent reports are dynamically linked to the original 
PADS Layout data, allowing users to modify component data (such as set position, 
mounting layer, and glued status) from the generated report.

This sample demonstrates that the Automation Server allows users and third party 
vendors to develop their own plug-ins, which may dynamically link data with the open 
design. You can easily extend this sample to include dynamic data links with other 
applications, such as Microsoft Access and Visual FoxPro.

• Sample 6 is a Visual C++ application that displays all PADS Layout geometric objects, 
accessible through the Automation interface.

Tips:

• You need to install the appropriate development tool on your system to run these 
samples. In other words, to run the Visual Basic version of any of these samples, you 
need Visual Basic on your system, or to run the Visual C++ version of any of these 
samples, you need Visual C++ on your system.

• If you encounter difficulty with one of the samples or with your own client application, 
see Troubleshooting Samples.

• If you want to create wrapper classes for PADS Layout objects, you can use your Visual 
C++ development tool to create them.
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Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Troubleshooting Samples
If a sample doesn't work as described, check the following:

• Make sure that only one instance of PADS Layout is running. By definition, a server is 
unique. Several instances of the same server may create confusion for clients.

• Exiting and restarting PADS Layout may help in some cases because these programs 
self-register as Automation servers upon start up. To make sure that you don't have 
another instance of PADS Layout running in the background, use the Task Manager.

• Make sure you disconnect all clients from PADS Layout before exiting the client 
application.

• If the above doesn't help, restart your system.

Creating Wrapper Classes for PADS Layout Objects
You can use your Visual C++ development tool to automatically create wrapper classes for 
PADS Layout objects from the PADS Layout type library. The PADS Layout type library is 
included into PADS Layout resources, so you can import the type library from the PADS 
Layout application file, powerpcb.exe.

The instructions in this topic apply to Microsoft Visual C++, version 6.0. If you use another 
Visual C++ development tool, refer to its documentation for information about importing type 
libraries.

To create wrapper classes for PADS Layout objects:

1. In Microsoft Visual C++, open a project.

2. On the View menu, click ClassWizard. The MFC ClassWizard dialog box opens.

3. Click Add Class and then, from the list that appears, select From a type library. The 
Import from Type Library dialog box opens.

4. Set the filter to All Files, browse to 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\powerpcb.exe, and 
then click Open. The Confirm Classes dialog box opens.

5. Select the classes you want to use and click OK.

Result: Microsoft Visual C++ creates the .h and .cpp files containing the wrapper classes.
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Sample 1 - Creating an Automation Client
This topic discusses the goal and specification for Sample 1.

Goal

To introduce the basics of writing an Automation client application using the Sax Basic Engine, 
Microsoft Visual C++ 5.0 (with MFC), Microsoft Visual Basic 5.0, and Microsoft Excel 97. 
One sample is provided for each of these applications. 

Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Each version of this sample demonstrates, in the respective programming language, how to:

• Prepare the communication between your client and the Automation Server.

• Prepare a pointer to the top level Automation object.

• Connect and disconnect from PADS Layout, regardless of whether it is running or not.

• Access simple data from PADS Layout.

Tip: The source code for this sample is in the C:\PADS 
Projects\Samples\Scripts\samples\sample1 folder. The code is well commented, and you may 
use it when developing your own client application.

Specification

Sample 1 is a simple dialog box, which can connect and disconnect at run time from the server. 
It can connect to an existing running instance or a new instance of PADS Layout. Once 
connected, the client retrieves the name of the open design file.

An example of the Visual Basic version of Sample 1 appears below. The Visual C++ version of 
this sample looks almost identical. The Basic scripting version does not have the Connect and 
Disconnect buttons because the Sax Basic Engine is already connected to PADS Layout. The 
Excel 97 version is different because Excel is primarily an application, not a development 
environment. The Excel version of this sample outputs information in an Excel worksheet. 

Requirement: To run Sample 1 clients, start PADS Layout and open a design file. If you don't 
start PADS Layout first, Sample 1 automatically starts the server, but it will not be visible and 
will not load a design file.

Make sure you copy the OLE samples from the distribution CD to your hard drive before 
running any of the samples.

Warning: Never exit a client application without first disconnecting from the server to which it 
is connected.
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Sample 2 - Adding Notifications
This topic discusses the goal and specification for Sample 2.

Goal

To add client notifications, also called client callbacks, to Sample 1 so that Sample 1 can be 
notified when something changes in PADS Layout. Sample 2 is implemented in PADS Layout 
Sax Basic Engine, Microsoft Visual C++ 5.0 (and MFC), Microsoft Visual Basic 5.0, and 
Microsoft Excel 97.

Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Tip: The source code for this sample is in the C:\PADS 
Projects\Samples\Scripts\Layout\samples\sample2 folder. The code is well commented, and 
you may use it when developing your own client application.

Specification

Sample 2 is based on Sample 1 source code and functionality. This sample adds the ability to 
retrieve two more data types from the PADS Layout server: the total number of components in 
the current design and the number of selected components. Moreover, Sample 2 automatically 
refreshes these values (name of the design file, component count, and selected component 
count) to match values in the PADS Layout server at all times by responding to notifications 
about design file and selection change.

To test Sample 2, run PADS Layout, open a design file, and connect the Sample 2 client to 
PADS Layout. If you load another file or change the selection, Sample 2 refreshes its values 
automatically.

Requirement: To run Sample 2 clients, start PADS Layout and open a design file. If you don't 
start PADS Layout first, Sample 2 automatically starts the server, but PADS Layout will not be 
visible and will not load a design file.

Make sure you copy the OLE samples from the distribution CD to your hard drive before 
running any of the samples.

Warning: Never exit a client application without first disconnecting from the server to which it 
is connected.

Sample 3 - Adding Database Access
This topic discusses the goal and specification for Sample 3.
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Goal

To demonstrate access to the PADS Layout database.

Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Tip: The source code for this sample is in the C:\PADS 
Projects\Samples\Scripts\Layout\samples\sample3 folder. The code is well commented, and 
you may use it when developing your own client application.

Specification

Sample 3 is based on Sample 2 source code. Sample 3 adds a list box that contains the list of all 
components in the current design. This list should automatically update when a new file is 
opened. This is the Basic version of Sample 3. To test Sample 3, run PADS Layout, open a 
design file, and connect the Sample 3 client to PADS Layout. If you open another file or change 
the selection, Sample 3 refreshes its values automatically.

Requirement: To run Sample 3 clients, start PADS Layout and open a design file. If you don't 
start PADS Layout first, Sample 3 automatically starts the server, but PADS Layout will not be 
visible and will not load a design file.

Make sure you copy the OLE samples from the distribution CD to your hard drive before 
running any of the samples.

Warning: Never exit a client application without first disconnecting from the server to which it 
is connected.

Sample 4 - Adding Cross-Probing
This topic discusses the goal and specification for Sample 4.

Goal

Sample 4 extends the access to the PADS Layout database components and retrieves detailed 
information about each component. It also adds full-duplex selection cross-probing and 
demonstrates the server locking mechanism to improve Automation performance.

Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.
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Tip: The source code for this sample is in the C:\PADS 
Projects\Samples\Scripts\Layout\samples\sample4 folder. The code is well commented, and 
you may use it when developing your own client application.

Specification

Sample 4 is based on Sample 3 source code. Sample 4 must allow selection and cross-probing 
between the client and the server. In other words, the list of selected objects must match the list 
of selected items in the Sample 4 list box at all times and vice-versa. Selection and cross-
probing must support multiple selection. If a user double-clicks an item in the list box, a dialog 
box must show extended information about that selected object. The performance of the access 
of PADS Layout OLE methods will be improved using the server locking mechanism.

To test Sample 4, run PADS Layout, open a design file, and connect the Sample 4 client to 
PADS Layout. If you load another file or change the selection, Sample 4 refreshes its values 
automatically; matching the selected components at all times. Similarly, a user selection change 
in the Sample 4 client changes the selection list.

Requirement: To run Sample 3 clients, start PADS Layout and open a design file. If you don't 
start PADS Layout first, Sample 4 automatically starts the server, but PADS Layout will not be 
visible and will not load a design file.

Make sure you copy the OLE samples from the distribution CD to your hard drive before 
running any of the samples.

Warning: Never exit a client application without first disconnecting from the server to which it 
is connected.

Sample 5 - A PADS Layout Custom Reports Command
This topic discusses the goal, specification, additional features, and implementation for Sample 
5.

Goal

This sample provides custom reports with output formats such as text files, Microsoft Excel 
spreadsheets, Microsoft Word documents, and HTML pages.

Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Tip: The source code for this sample is in the C:\PADS 
Projects\Samples\Scripts\Layout\samples\sample5 folder. The code is well commented, and 
you may use it when developing your own client application. This sample includes Basic files, 
main source code, an Excel file, report generation macros, and a PADS Layout macro file that 
“plugs” the sample into PADS Layout.
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Specification

This sample generates customizable part list reports of the open design and/or any Assembly 
Options in that file. You can choose the format of the reports: text files, CSV files, Microsoft 
Excel spreadsheets, Microsoft Word documents (as tables), or HTML pages (for any Web 
browser). Each format requires that you install the appropriate application on your system. In 
other words, to generate Excel reports, you must install Excel on your system.

The data that the report outputs is configurable from the dialog box in the sample. You can 
easily select the part properties to output one by one, configure the order in which to output the 
properties, and group the report by any part property. Component properties available include 
reference designator, part type, decal, part type logic, part type description, number of 
attributes, SMD flag, number of pins, location, placed flag, orientation, mounting layer, and 
glued flag.

You can dynamically link the Excel reports with PADS Layout; you can link each piece of data 
in the Excel report with its equivalent in PADS Layout. This allows selection and cross-probing 
between the Excel report and PADS Layout, and also allows changing the following part 
properties from the Excel report:

• Part decal. The list of compatible decals for that part appears in a list within the Excel 
cell.

• Location of the part.

• Orientation of the part.

• Mounting layer of the part. The list of valid layers appears in a list within the Excel cell.

• Glued flag.

• Installed flag, if the report is from an Assembly Option in the design.

Additional Features

This sample includes many other useful features:

• Real-time refreshing of the dialog box when PADS Layout opens or saves the design 
file. This ensures that the dialog box is always in sync with the program.

• The ability to open a design file from the dialog box. This avoids you having to switch 
back and forth between PADS Layout and the dialog box when generating reports for 
many PCBs.

• The ability to save and load the report configurations to and from the system registry.

• The ability to reset default settings with a single button, to return to a “clean” 
configuration.

• A history of opened designs saved in the registry, up to ten, allowing quick report 
generation of a previously opened design file.
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• Automatic suggestions for report file names.

• The ability to report all or only selected parts. This helps when generating a report on 
only one part in the PCB design.

The following examples are screen captures of custom reports, generated by this sample, in 
Notepad, Microsoft Excel (dynamically linked), Microsoft Word, and Microsoft Internet 
Explorer 4.0:

Figure 46-2. Report in Notepad Format

Figure 46-3. Report in Microsoft Excel Format
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Figure 46-4. Report in Microsoft Word Format

Figure 46-5. Report in Microsoft Internet Explorer 4.0 Format

Implementation

This sample was developed with Microsoft Visual Basic 5.0. Dynamic Excel reports include 
some Visual Basic for Application (VBA) code in the Excel report file itself. The code is 
modularized to make it easy to implement other report formats, such as Microsoft Access, 
Visual FoxPro, and so on.

Sample 6 - Accessing Database Objects through the Automation 
Interface

This topic discusses the goal and specification for Sample 6.

Goal

To demonstrate access to shapes in the PADS Layout database through the Automation 
interface.
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Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Tip: The source code for this sample is in the C:\PADS 
Projects\Samples\Scripts\Layout\samples\sample6 folder. The code is well commented, and 
you may use it when developing your own client application. This sample includes source code 
for Visual C++ v6.0.

Specification

Sample 6 is a Visual C++ application that displays all geometric objects, accessible through the 
Automation interface.

To test Sample 6, open a design in PADS Layout, then build and run a sample executable. The 
sample retrieves data from the design and draws it in its window. To refresh the view, on the 
View menu, click Redraw.

PADS Layout Automation Server Reference
The Automation Server Object Hierarchy strictly follows Microsoft standards. The Application 
Object, the root-level object, identifies the application and provides a way for Automation 
clients to bind to and navigate the application's exposed objects, methods, and properties. The 
Document Object handles all document-centered operations. The View Object handles all view-
centered operations.

All PADS Layout database objects, including the Drawing, Label, NetClass, Text, Component, 
PartType, Net, Pin, Via, Jumper, Connection, and RouteSegment objects, are accessed either 
directly through the Document object or through the Objects collection object. The Objects 
collection object provides a convenient way of working with a set of data objects rather than on 
a per object basis.

All Automation objects implement their interface based on the Microsoft IDispatch interface.
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Automation Objects

The AntiPad Object
This object represents an antipad in the padstack definition.

AntiPad Properties
AntiPad.Application

AntiPad.CornerRadius

AntiPad.CornerType

AntiPad.Length

AntiPad.Name

AntiPad.ObjectType

• The AntiPad Object

• The Application Object

• The AssemblyOptions Collection 
Object

• The Attribute Object

• The Attributes Collection Object

• The CBP Object

• The Circle Object

• The Component Object

• The Connection Object

• The Decal Object

• The Document Object

• The Drawing Object

• The Error Object

• The ErrorConflict Object

• The Jumper Object

• The Label Object

• The Layer Object

• The Library Object

• The LibraryItem Object

• The Measure Object

• The Net Object

• The NetClass Object

• The Objects Collection Object

• The Pad Object

• The PadStackLayer Object

• The PartType Object

• The Pin Object

• The Polyline Object

• The RouteSegment Object

• The SBP Object

• The Text Object

• The ThermalPad Object

• The Via Object

• The View Object

• The Wirebond Object
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AntiPad.Offset

AntiPad.Orientation

AntiPad.PadStackLayer

AntiPad.Parent

AntiPad.Shape

AntiPad.Size

The Application Object
The Application object is the root-level object in the Automation Server object hierarchy, and 
represents the entire application. This object is usually the first object an Automation client 
connects to, before accessing an object, property, or method.

Application Properties
Application.ActiveDocument

Application.Application

Application.DefaultFilePath

Application.FullName

Application.Libraries

Application.Name

Application.ObjectType

Application.Parent

Application.Preference

Application.ProgressBar

Application.StatusBarText

Application.Version

Application.Visible

Application Methods
Application.CreateLibrary

Application.ExportLibraryItems

Application.GetConfigParamInt

Application.GetConfigParamString

Application.GetLibraryItems
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Application.LockServer

Application.Measure

Application.OpenDocument Method

Application.OpenDocumentNoLock Method

Application.OpenTempDocument Method

Application.Quit Method

Application.RunMacro

Application.UnlockServer

Application Events
Application.OpenDocument Event

Application.ProgressChange

Application.Quit Event

The AssemblyOptions Collection Object
The AssemblyOptions collection object is the collection of all the assembly options in the open 
design. This object is usually retrieved using the Document.AssemblyOptions property.

AssemblyOptions Properties
AssemblyOptions.Application

AssemblyOptions.Count

AssemblyOptions.Item

AssemblyOptions.ItemType

AssemblyOptions.Next

AssemblyOptions.ObjectType

AssemblyOptions.Parent

AssemblyOptions.ParentObject

AssemblyOptions Methods
AssemblyOptions.Add

AssemblyOptions.Delete

AssemblyOptions.Merge

AssemblyOptions.Remove



PADS Layout Automation Server
PADS Layout Automation Server Reference

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1587

AssemblyOptions.Reset

AssemblyOptions.Select

AssemblyOptions.Sort

The AssociatedNet Object
The AssociatedNet object represents an associated net existing in the PCB design currently 
open.

AssociatedNet Properties
AssociatedNet.Name

AssociatedNet.Nets

AssociatedNet.ObjectType

AssociatedNet.Parent

AssociatedNet.Selected

The Attribute Object
The Attribute object represents an attribute of a physical object, such as a Component or Net 
object. This object is usually retrieved from the The Attributes Collection Object.

Attribute Properties
Attribute.Application

Attribute.Name

Attribute.ObjectType

Attribute.Parent

Attribute.Value

Attribute.Measure

The Attributes Collection Object
The Attributes collection object is a collection of physical object attributes, such as attributes of 
a Document (using the Document.Attributes property), a Component (using the 
Component.Attributes property), or a Pin (using the Pin.Attributes property).

Attributes Collection Properties
Attributes.Application
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Attributes.Count

Attributes.Item

Attributes.ItemType

Attributes.Next

Attributes.ObjectType

Attributes.Parent

Attributes.Application

Attributes Methods
Attributes.Add

Attributes.Delete

Attributes.Merge

Attributes.Remove

Attributes.Reset

Attributes.Select

Attributes.Sort

The CBP Object
The CBP object represents the physical component bond pad of a die part. You can retrieve the 
CBP object, or collection of CBP objects, only from The Component Object, which represents a 
die part (Component.IsDiePart returns True), or from other die part constituents (such as SBP or 
Wirebond).

CBP objects are not selectable. 

You cannot retrieve the collection of all CBP objects from a document using 
Document.GetObjects (ppcbObjectTypeCBP). This method returns an empty collection. Also, 
Document.GetObjects (ppcbObjectTypeAll) does not return CBP, SBP, or Wirebond objects. 
You can get only collections of CBPs, SBPs, or Wirebonds using the Component object 
methods, if the component is a die parT (Component.IsDiePart).

CBP Properties
CBP.Application

CBP.Edge

CBP.Function

CBP.Layer
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CBP.Length

CBP.Name

CBP.ObjectType

CBP.Parent

CBP.PositionX

CBP.PositionY

CBP.SBPs

CBP.Shape

CBP.Width

CBP.Wirebonds

CBP Methods
CBP.Component

The Circle Object
The Circle object represents a physical circle in the open design.

Circle Properties
Circle.Application

Circle.CenterX

Circle.CenterY

Circle.Geometry

Circle.Layer

Circle.LineWidth

Circle.ObjectType

Circle.OutlineType

Circle.Parent

Circle.Radius

Circle.ShapeType

The Component Object
The Component object represents a physical component, in the currently open design.
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Component Properties
Component.Application

Component.Attributes

Component.CBPs

Component.CenterX

Component.CenterY

Component.Decal

Component.DecalAttributes

Component.DecalCompatibleList

Component.DieHeight

Component.DieLength

Component.DieWidth

Component.Glued

Component.Installed

Component.IsDiePart

Component.IsSMD

Component.Labels

Component.Layer

Component.Name

Component.ObjectType

Component.Orientation

Component.Parent

Component.PartType

Component.PartTypeAttributes

Component.PartTypeECORegistered

Component.PartTypeLogic

Component.PartTypeObject

Component.Pins

Component.Placed

Component.PositionX

Component.PositionY

Component.SBPs
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Component.Selected

Component.Substituted

Component.WireBondRulesAngleMaximum

Component.WireBondRulesClearanceWireToPad

Component.WireBondRulesClearanceWireToWire

Component.WireBondRulesLengthMaximum

Component.WireBondRulesLengthMinimum

Component.Wirebonds

Component Methods
Component.AddLabel

Component.Move

Component.MoveCenterr

The Connection Object
The Connection object represents a physical connection, also called a pin pair, in the open 
design.

Connection Properties
Connection.Application

Connection.Length

Connection.Name

Connection.Net

Connection.ObjectType

Connection.Parent

Connection.Pins

Connection.RouteSegments

Connection.Selected

Connection.Vias

The Decal Object
The Decal object represents a decal, in the currently open design.
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Decal Properties
Decal.Application

Decal.Attributes

Decal.Components

Decal.LibraryTimeStamp

Decal.Name

Decal.ObjectType

Decal.Parent

Decal.Selected

Decal.TimeStamp

The Document Object
The Document object represents a currently open PCB design file. This object is usually 
retrieved using the Application.ActiveDocument property.

Document Properties
Document.ActiveView

Document.Application

Document.AssemblyOptions

Document.AssociatedNets

Document.Attributes

Document.BoardOutlineSurface

Document.Componentss

Document.Connections

Document.Drawings

Document.ElectricalLayerCount

Document.Errors

Document.FullName

Document.GridX

Document.GridY

Document.Jumpers

Document.LayerCount
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Document.LayerEnabled

Document.LayerName

Document.Layers

Document.LayerType

Document.MaxRealValue

Document.MinRealValue

Document.Name

Document.NetClasses

Document.Nets

Document.ObjectType

Document.OriginX

Document.OriginX

Document.OriginY

Document.Parent

Document.PartTypes

Document.Path

Document.Pins

Document.Preference

Document.RouteSegments

Document.Saved

Document.Texts

Document.Unit

Document.Vias

Document Methods
Document.Activate

Document.AddText

Document.CheckASCII

Document.ExportASCII

Document.ExportECOFile

Document.ExportNetList

Document.ExportRules
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Document.GetColor

Document.GetObjects

Document.GetVisibility

Document.ImportECOFile

Document.ImportNetList

Document.IntegrityTest

Document.Save Method

Document.SaveAs

Document.SaveAsNoLock

Document.SaveNoLock

Document.SaveAsTemp

Document.SaveTemp

Document.SelectObjects

Document.SetColor

Document.SetVisibility

Document Events
Document.PositionsChange

Document.Save Event

Document.SecurityLimit Event

Document.SelectionChange Event

The Drawing Object
The Drawing object represents a physical drawing object or a copper in the open design.

Drawing Properties
Drawing.Application

Drawing.DrawingType

Drawing.Geometry

Drawing.Name

Drawing.Net

Drawing.ObjectType
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Drawing.Parent

Drawing.PositionX

Drawing.PositionY

Drawing.Selected

Drawing.Texts

The Error Object
The Error object represents a design error.

Error Properties
Error.ActualValue

Error.Application

Error.Conflicts

Error.Description

Error.ErrorClass

Error.ErrorType

Error.HasActualValue

Error.HasRequiredValue

Error.IsClearanceError

Error.IsConnectivityError

Error.IsHighSpeedError

Error.IsIgnoredFlag

Error.IsInvisibleFlag

Error.IsLatiumError

Error.IsMiscError

Error.IsTestPointError

Error.LayerNumber

Error.Name

Error.ObjectType

Error.Parent

Error.PositionX

Error.PositionY
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Error.RequiredValueMax

Error.RequiredValueMin

The ErrorConflict Object
The Error object represents an error conflict in the Error Object.

ErrorConflict Properties
ErrorConflict.Application

ErrorConflict.ConflictObject

ErrorConflict.ConflictObjectDesc

ErrorConflict.ConflictObjectType

ErrorConflict.Name

ErrorConflict.ObjectType

ErrorConflict.Parent

The Jumper Object
The Jumper object represents a physical jumper that exists in the open design.

Jumper Properties
Jumper.Application

Jumper.Installed

Jumper.Length

Jumper.Name

Jumper.Net

Jumper.ObjectType

Jumper.Orientation

Jumper.Parent

Jumper.Points

Jumper.Selected

The Label Object
The Label object represents a physical label object in the open design.
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Label Properties
Label.Application

Label.Attribute

Label.Component

Label.Display

Label.Name

Label.ObjectType

Label.Parent

Label.RightReading

Label.Selected

Label.Text

Label.Type

Label Methods

Label.Delete

The Layer Object
This object represents a design layer.

Layer Properties

Layer.Application

Layer.CopperThickness

Layer.Enabled

Layer.Name

Layer.Number

Layer.ObjectType

Layer.Parent

Layer.PlaneType

Layer.RoutingDirection

Layer.Type

Layer.Visible

Layer Methods

Layer.GetColor
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Layer.GetDielectricConstant

Layer.GetDielectricThickness

Layer.GetDielectricType

Layer.SetColor

Layer.SetDielectricConstant

Layer.SetDielectricThickness

Layer.SetDielectricType

The Library Object
The Library object represents a library included in the PADS Layout library list. The library 
corresponds to the set of four library files, with extensions .pt07, .pd07, .ln07, and .ld07.

Library Properties
Library.Application

Library.FullName

Library.Name

Library.ObjectType

Library.Parent

Library.Path

Library Methods
Library.GetLibraryItems

Library.ImportLibraryItems

Library.ImportLibraryItems2

The LibraryItem Object
The LibraryItem object represents a physical item in a particular part library.

LibraryItem Properties
LibraryItem.Application

LibraryItem.Library

LibraryItem.Name

LibraryItem.ObjectType
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LibraryItem.Parent

LibraryItem.Type

The Measure Object
The Measure object provides access to the internal PADS Layout unit parser. The Measure 
object can be either constructed from Application object (see Application.Measure method) or 
obtained from the object (see Attribute.Measure property). From the measure object, you can 
extract information about real value and unit. 

Measure Properties
Measure.Application

Measure.Name

Measure.Number

Measure.Normalize

Measure.ObjectType

Measure.Parent

Measure.Prefix

Measure.Text

Measure.Unit

Measure.Value

The Net Object
The Net object represents a physical net in the open design.

Net Properties
Net.Application

Net.AssociatedNet

Net.Attributes

Net.Connections

Net.Drawings

Net.Length

Net.Name

Net.NetClass
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Net.NetClassAttributes

Net.ObjectType

Net.Parent

Net.Pins

Net.Power

Net.Selected

Net.Vias

The NetClass Object
The NetClass object represents a netclass object in the open design.

NetClass Properties
NetClass.Application

NetClass.Attributes

NetClass.Name

NetClass.Name

NetClass.ObjectType

NetClass.Parent

The Objects Collection Object
The Objects collection object is a collection of homogeneous or heterogeneous database 
objects, such as Component objects, Jumper objects, Net objects, Pin objects, Via objects, 
Connection objects, and RouteSegment objects, in the open design. This object is usually 
retrieved using the Document.GetObjects method or using database object specific properties 
such as Document.Components, Document.Nets, Document.Vias, Document.Jumpers, 
Document.Connections, and Document.RouteSegments.

Objects Properties
Objects.Application

Objects.Count

Objects.Item

Objects.ItemType

Objects.Next

Objects.ObjectType
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Objects.Parent

Objects.ParentObject

Objects Methods
Objects.Add

Objects.Merge

Objects.Remove

Objects.Reset

Objects.Select

Objects.Sort

The Pad Object
This object represents a pad in the padstack definition.

Pad Properties
Pad.Application

Pad.CornerRadius

Pad.CornerType

Pad.Diameter

Pad.InnerDiameter

Pad.Length

Pad.Name

Pad.ObjectType

Pad.Offset

Pad.Orientation

Pad.PadStackLayer

Pad.Parent

Pad.Shape

Pad.Width

The PadStackLayer Object
The PadStackLayer object represents a layer in the padstack definition.
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PadStackLayer Properties
PadStackLayer.AntiPad

PadStackLayer.Application

PadStackLayer.Name

PadStackLayer.Number

PadStackLayer.ObjectType

PadStackLayer.Pad

PadStackLayer.Parent

PadStackLayer.Pin

PadStackLayer.ThermalPad

PadStackLayer.Via

The Pin Object
The Pin object represents a physical pin in the open design.

Pin Properties
Pin.Application

Pin.Attributes

Pin.Component

Pin.DrillSize

Pin.ElectricalType

Pin.FunctionName

Pin.Glued

Pin.Highlighted

Pin.IsSMD

Pin.Name

Pin.Net

Pin.Number

Pin.ObjectType

Pin.PadStackLayers

Pin.Parent

Pin.PlaneThermal
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Pin.Plated

Pin.PositionX

Pin.PositionY

Pin.Selected

Pin.SlotLength

Pin.SlotOffset

Pin.SlotOrientation

Pin.Plated

Pin.TestPoint

The PartType Object
The PartType object represents a part type (package) of a physical component in the PCB 
design currently open in PADS Layout.

PartType Properties
PartType.Application

PartType.Attributes

PartType.Components

PartType.ECORegistered

PartType.Logic

PartType.Name

PartType.ObjectType

PartType.Parent

PartType.Selected

The Polyline Object
The Polyline object represents a physical polyline object in the open design.

Polyline Properties
Polyline.Application

Polyline.CenterX

Polyline.CenterY

Polyline.Geometry
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Polyline.Layer

Polyline.LineWidthh

Polyline.ObjectType

Polyline.OutlineType

Polyline.Parent

Polyline.Points

Polyline.Radius

Polyline.ShapeType

The RouteSegment Object
The RouteSegment object represents a physical route segment, also called a route, in the open 
design.

RouteSegment Properties
RouteSegment.Application

RouteSegment.Layer

RouteSegment.Length

RouteSegment.Name

RouteSegment.Net

RouteSegment.ObjectType

RouteSegment.Parent

RouteSegment.Points

RouteSegment.SegmentType

RouteSegment.Selected

RouteSegment.Width

The SBP Object
The SBP object represents the physical substrate bond pad of a die part. You can retrieve the 
SBP object, or collection of SBP objects, only from the Component object, which represents a 
die part (Component.IsDiePart returns True), or from other die part constituents (such as CBP 
or Wirebond).

SBP objects are not selectable. 
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You cannot retrieve the collection of all SBP objects from a document using 
Document.GetObjects (ppcbObjectTypeSBP). This method returns an empty collection. Also, 
Document.GetObjects (ppcbObjectTypeAll) does not return CBP, SBP, or Wirebond objects. 
You can get only collections of CBPs, SBPs, or Wirebonds using the Component object 
methods, if the component is a die part (Component.IsDiePart).

SBP Properties
SBP.Application

SBP.CBPs

SBP.Component

SBP.Function

SBP.Layer

SBP.Length

SBP.Name

SBP.ObjectType

SBP.Orientation

SBP.Parent

SBP.Position X

SBP.PositionY

SBP.Shape

SBP.Tier

SBP.Width

SBP.Wirebonds

The Text Object
The Text object represents free text, or text associated with a 2D line in the open design.

Text Properties
Text.Application

Text.Drawing

Text.Height/Label.Height

Text.HorzJustification/Label.HorzJustification

Text.Layer/Label.Layer

Text.LineWidth/Label.LineWidth
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Text.Mirror/Label.Mirror

Text.Name

Text.ObjectType

Text.Orientation/Label.Orientation

Text.Parent

Text.PositionX/Label.PositionX

Text.PositionY/Label.PositionY

Text.Selected

Text.Text

Text.VertJustification/Label.VertJustification

Text Methods
Text.Delete

The ThermalPad Object
This object represents a thermal pad in the padstack definition.

ThermalPad Properties
ThermalPad.Application

ThermalPad.CornerRadius

ThermalPad.CornerType

ThermalPad.InnerLength

ThermalPad.InnerSize

ThermalPad.ObjectType

ThermalPad.Offset

ThermalPad.Orientation

ThermalPad.OuterSize

ThermalPad.PadStackLayer

ThermalPad.Parent

ThermalPad.Shape

ThermalPad.SpokeAngle

ThermalPad.Spokes
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ThermalPad.SpokeWidth

The Via Object
The Via object represents a physical via in the open design.

Via Properties
Via.Application

Via.Attributes

Via.DrillSize

Via.EndLayer

Via.Glued

Via.Highlighted

Via.Name

Via.Net

Via.ObjectType

Via.PadStackLayers

Via.Parent

Via.PlaneThermal

Via.Plated

Via.PositionX

Via.PositionY

Via.Selected

Via.StartLayer

Via.TestPoint

Via.Type

The View Object
The View object represents the current view window, showing the open design. This object is 
usually retrieved using the Document.ActiveView property.

View Properties
View.Application

View.BottomRightX
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View.BottomRightY

View.CenterX

View.CenterY

View.Name

View.ObjectType

View.Parent

View.PointerX

View.PointerY

View.TopLeftX

View.TopLeftY

View.Zoom

View Methods
View.Pan

View.Refresh

View.SetExtents

View.SetExtentsToAll

View.SetExtentsToBoard

View.SetExtentsToSelection

View.SetScale

View Events
View.Change

The Wirebond Object
The Wirebond object represents the physical bond wire of a die part. You can retrieve the 
Wirebond object, or collection of Wirebond objects, only from the Component object, which 
represents a die part (Component.IsDiePart), or from other die part constituents (such as CBP or 
SBP).

Wirebond objects are not selectable. 

You cannot retrieve the collection of all Wirebond objects from a document using 
Document.GetObjects (ppcbObjectTypeWirebond). This method returns an empty collection. 
Also, Document.GetObjects (ppcbObjectTypeAll) does not return CBP, SBP, or Wirebond 
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objects. You can get only collections of CBPs, SBPs, or Wirebonds using the Component object 
methods, if the component is a die part (Component.IsDiePart).

Wirebond Properties
Wirebond.Angle

Wirebond.Application

Wirebond.Component

Wirebond.EndOffsetX

Wirebond.EndOffsetY

Wirebond.EndPad

Wirebond.EndX

Wirebond.EndY

Wirebond.Name

Wirebond.ObjectType

Wirebond.Parent

Wirebond.StartOffsetX

Wirebond.StartOffsetY

Wirebond.StartPad

Wirebond.StartX

Wirebond.StartY

Constants
PPcbAntiPadShape

PPcbASCIISections

PPcbASCIIVersion

PPcbAttrFlags

PPcbBondPadEdge

PPcbBondPadShape

PPcbDesignObject

PPcbDielectricLayer

PPcbDielectricType

PPcbDocumentColor
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PPcbDrawingType

PPcbDRCMode

PPcbGridType

PPcbHorizontalJustification

PPcbLabelType

PPcbLabelDisplayMode

PPcbLayerColor

PPcbLayerType

PPcbLibraryItemType

PPcbMeasureFormat

PPcbNudgeMode

PPcbObjectType

PPcbOriginType

PPcbOutlineType

PPcbPadCornerType

PPcbPadShape

PPcbPadStackLayerType

PPcbPinElectricalType

PPcbPlaneType

PPcbRightReadingStatus

PPcbRoutingDirection

PPcbSegmentType

PPcbShapeType

PPcbTestPointType

PPcbThermalPadShape

PPcbUnit

PPcbVerticalJustification

PPcbAntiPadShape
ppcbAntiPadShapeRound= 8

ppcbAntiPadShapeSquare= 9
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PPcbASCIISections
Possible ASCII section values are:

ppcbASCIISectionPCB  = &H00000001

ppcbASCIISectionReuse  = &H00000002

ppcbASCIISectionText  = &H00000004

ppcbASCIISectionLines  = &H00000008

ppcbASCIISectionClusters = &H00000010

ppcbASCIISectionVias  = &H00000020

ppcbASCIISectionDecals  = &H00000040

ppcbASCIISectionPartTypes = &H00000080

ppcbASCIISectionParts  = &H00000100

ppcbASCIISectionJumpers = &H00000200

ppcbASCIISectionConnections = &H00000400

ppcbASCIISectionRoutes  = &H00000800

ppcbASCIISectionTeardrops = &H00001000

ppcbASCIISectionMisc  = &H00002000

ppcbASCIISectionRules  = &H00004000

ppcbASCIISectionCAM  = &H00008000

ppcbASCIISectionPour  = &H00010000

ppcbASCIISectionAssemblyOptions= &H00020000

ppcbASCIISectionTestPoints = &H00040000

ppcbASCIISectionAttributes = &H00080000

ppcbASCIISectionAll  = &HFFFFFFFF

PPcbASCIIVersion
Possible ASCII version values are:

ppcbASCIIVerCurrent = 0

ppcbASCIIVer1_1 = 2

ppcbASCIIVer1_5 = 3

ppcbASCIIVer2_0 = 4

ppcbASCIIVer2_1 = 5
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ppcbASCIIVer2_5 = 6

ppcbASCIIVer3_0 = 7

ppcbASCIIVer4_0 = 8

PPcbAttrFlags
Possible attribute flags values are:

ppcbAttrNone = &H00000001

ppcbAttrPart = &H00000002

ppcbAttrNet = &H00000004

ppcbAttrPin = &H00000008

ppcbAttrVia = &H00000010

ppcbAttrPCB = &H00000020

ppcbAttrPartType = &H00000040

ppcbAttrDecal = &H00000080

ppcbAttrNetClass = &H00000100

ppcbAttrAll = &HFFFFFFFF

PPcbBondPadEdge
Restriction: This information applies to only the BGA toolkit.

Possible bond pad edge values are:

ppcbBondPadEdgeUnknown = 0

ppcbBondPadEdgeLeft = 1

ppcbBondPadShapeTop = 2

ppcbBondPadShapeRight = 3

ppcbBondPadShapeBottom = 4

PPcbBondPadShape
Restriction: This information applies to only the BGA toolkit.

Possible bond pad shape values are:

ppcbBondPadShapeUnknown = 0

ppcbBondPadShapeRectangle = 1

ppcbBondPadShapeOval = 2
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PPcbDesignObject
ppcbDesignObjectTrace = 0

ppcbDesignObjectVia = 1

ppcbDesignObjectPad = 2

ppcbDesignObjectCopper = 3

ppcbDesignObjectLine = 4

ppcbDesignObjectText = 5

ppcbDesignObjectError = 6

ppcbDesignObjectOutlineTop = 7

ppcbDesignObjectOutlineBottom = 8

ppcbDesignObjectRefDes = 9

ppcbDesignObjectPartType = 10

ppcbDesignObjectAttribute = 11

ppcbDesignObjectKeepout = 12

ppcbDesignObjectPinNumber = 13

PPcbDielectricLayer
ppcbDielectricLayerAbove = 0

ppcbDielectricLayerBelow = 1

PPcbDielectricType
ppcbDielectricTypeCoating = 0

ppcbDielectricTypeSubstrate = 1

ppcbDielectricTypePrepreg = 2

PPcbDocumentColor
ppcbDocumentColorBackground = 0

ppcbDocumentColorSelection = 1

ppcbDocumentColorHighlight = 2

ppcbDocumentColorBoardOutline = 3

ppcbDocumentColorConnection = 4
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PPcbDrawingType
Possible drawing type values are:

ppcbDrw2Dline = 0

ppcbDrwBoard = 1

ppcbDrwCopper = 3

ppcbDrwCopperPour = 6

ppcbDrwCopperHatch = 7

ppcbDrwCopperThermal = 8

ppcbDrwKeepout = 9

PPcbDRCMode
Possible Design Rules Checking (DRC) mode values are:

ppcbDRCNone = 0

ppcbDRCOff = 1

ppcbDRCWarn = 2

ppcbDRCIgnoreClearance = 3

ppcbDRCPrevent = 4

PPcbErrorClass
Possible Error Class values are:

ppcbErrorClassClearanceError = 0

ppcbErrorClassConnectivityError = 0x20

ppcbErrorClassHighSpeedError = 0x40

ppcbErrorClassMiscError = 0x60

ppcbErrorClassTestPointError = 0x80

ppcbErrorClassDfmError = 0xa0

ppcbErrorClassBgaError = 0xc0

ppcbErrorClassViaCountError = 0xe0

PPcbErrorType
Possible Error Type values are:
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ppcbErrorTypePadToPadError = 0 | 0

ppcbErrorTypePadToTrackError = 0 | 0x1

ppcbErrorTypeTrackToTrackError = 0 | 0x2

ppcbErrorTypeCopperPourError = 0 | 0x3

ppcbErrorTypeDrillHoleError = 0 | 0x4

ppcbErrorTypeDrillToDrillError = 0 | 0x5

ppcbErrorTypeTraceWidthError = 0 | 0x6

ppcbErrorTypePlacementKeepoutError = 0 | 0x7

ppcbErrorTypeHeightKeepoutError = 0 | 0x8

ppcbErrorTypeDrillKeepoutError = 0 | 0x9

ppcbErrorTypeTraceKeepoutError = 0 | 0xa

ppcbErrorTypePourKeepoutError = 0 | 0xb

ppcbErrorTypeViaKeepoutError = 0 | 0xc

ppcbErrorTypeTestPointKeepoutError = 0 | 0xd

ppcbErrorTypeBoardOutlineError  = 0 | 0xe

ppcbErrorTypeSameNetPadToPadError = 0 | 0xf

ppcbErrorTypeSameNetPadToTrackError = 0 | 0x10

ppcbErrorTypeBodyToBodyError  = 0 | 0x11

ppcbErrorTypeConnectivityError  = 0x20 | 0

ppcbErrorTypeConnectivityDrillError = 0x20 | 0x1

ppcbErrorTypeConnectivityPlaneError = 0x20 | 0x2

ppcbErrorTypeDrillLayerPairingError = 0x20 | 0x3

ppcbErrorTypeDrillToPlaneShortError = 0x20 | 0x4

ppcbErrorTypeEDC_CapacitanceError = 0x40 | 0

ppcbErrorTypeEDC_LengthError  = 0x40 | 0x1

ppcbErrorTypeEDC_DelayError  = 0x40 | 0x2

ppcbErrorTypeEDC_MinImpedanceError = 0x40 | 0x3

ppcbErrorTypeEDC_MaxImpedanceError = 0x40 | 0x4

ppcbErrorTypeEDC_LoopError  = 0x40 | 0x5

ppcbErrorTypeEDC_StubError  = 0x40 | 0x6

ppcbErrorTypeEDC_ParallelismError = 0x40 | 0x7

ppcbErrorTypeTiePlaneError   = 0x60 | 0
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ppcbErrorTypeTearDropGenError  = 0x60 | 0x1

ppcbErrorTypeLatiumMarkerError  = 0x60 | 0x2

ppcbErrorTypeBLZ_ViaAtSMDFitInsideError = 0x60 | 0x3

ppcbErrorTypeBLZ_ViaAtSMDCenterError = 0x60 | 0x4

ppcbErrorTypeBLZ_ViaAtSMDEndError = 0x60 | 0x5

ppcbErrorTypeBLZ_ViaAtSMDCenterOutError = 0x60 | 0x6

ppcbErrorTypeBLZ_ViaAtSMDTooManyError = 0x60 | 0x7

ppcbErrorTypeBLZ_GapBadError  = 0x60 | 0x8

ppcbErrorTypeBLZ_GapViolationError = 0x60 | 0x9

ppcbErrorTypeBLZ_GapObstacleSizeError = 0x60 | 0xa

ppcbErrorTypeBLZ_GapObstacleCountError = 0x60 | 0xb

ppcbErrorTypeBLZ_GapIrregularLengthError = 0x60 | 0xc

ppcbErrorTypeBLZ_GapControlledPercentError = 0x60 | 0xd

ppcbErrorTypeBLZ_LengthToleranceError = 0x60 | 0xe

ppcbErrorTypeBLZ_ProfileCornerError = 0x60 | 0xf

ppcbErrorTypeTestPointGenError  = 0x80 | 0

ppcbErrorTypeTestPointProbeToProbeError = 0x80 | 0x1

ppcbErrorTypeTestPointProbeToComponentError = 0x80 | 0x2

ppcbErrorTypeTestPointProbeToBoardError = 0x80 | 0x3

ppcbErrorTypeTestPointProbeToKeepoutError = 0x80 | 0x4

ppcbErrorTypeTestPointNailCountError = 0x80 | 0x5

ppcbErrorTypeBLZ_ProbeNotComponentError = 0x80 | 0x6

ppcbErrorTypeBLZ_ProbeOnSMDPinError = 0x80 | 0x7

ppcbErrorTypeBLZ_ProbeGridError = 0x80 | 0x8

ppcbErrorTypeBLZ_ProbeNailDiameterError = 0x80 | 0x9

ppcbErrorTypeBLZ_ProbeToPadError = 0x80 | 0xa

ppcbErrorTypeBLZ_ProbeToTraceError = 0x80 | 0xb

ppcbErrorTypeDFMGenError = 0xa0

ppcbErrorTypeDFMAcidTrapError = 0xa0 | 0x1

ppcbErrorTypeDFMSliverError = 0xa0 | 0x2

ppcbErrorTypeDFMSolderBridgeError = 0xa0 | 0x3

ppcbErrorTypeDFMStarvedThermalError = 0xa0 | 0x4
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ppcbErrorTypeDFMLayerCompareError = 0xa0 | 0x5

ppcbErrorTypeDFMDrillError = 0xa0 | 0x6

ppcbErrorTypeDFFGenError = 0xa0 | 0x7

ppcbErrorTypeDFFAcidTrapError = 0xa0 | 0x8

ppcbErrorTypeDFFSliverError = 0xa0 | 0x9

ppcbErrorTypeDFFSolderBridgeError = 0xa0 | 0xa

ppcbErrorTypeDFFStarvedThermalError = 0xa0 | 0xb

ppcbErrorTypeDFFLayerCompareError = 0xa0 | 0xc

ppcbErrorTypeDFFDrillError = 0xa0 | 0xd

ppcbErrorTypeDFFDrillToMaskError = 0xa0 | 0xe

ppcbErrorTypeDFFPadToMaskError = 0xa0 | 0xf

ppcbErrorTypeDFFDrillToPadError = 0xa0 | 0x10

ppcbErrorTypeDFFTraceWidthError = 0xa0 | 0x11

ppcbErrorTypeDFFPadSizeError = 0xa0 | 0x12

ppcbErrorTypeBGA_GenError = 0xc0

ppcbErrorTypeBGA_WBRMinLengthError = 0xc0 | 0x1

ppcbErrorTypeBGA_WBRMaxLengthError = 0xc0 | 0x2

ppcbErrorTypeBGA_WBRMaxAngleError = 0xc0 | 0x3

ppcbErrorTypeBGA_WBRWBToWBError = 0xc0 | 0x4

ppcbErrorTypeBGA_WBRWBToSBPError = 0xc0 | 0x5

ppcbErrorTypeViaCountError = 0xe0

PPcbErrorValueType
Possible Error Value Type values are:

ppcbErrorValueTypeMeasure = 0

ppcbErrorValueTypeInt = 1

ppcbErrorValueTypeDouble = 2

PPcbGridType
Possible grid type values are:

ppcbGridNone = 0  None.

ppcbGridDesign = 1 PADS Layout design grid.
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ppcbGridVia = 2  PADS Layout via grid.

ppcbGridDisplay = 3 PADS Layout display grid.

ppcbGridAll = 9999 All PADS Layout grids.

PPcbHorizontalJustification
Possible horizontal justification values are:

ppcbJustifyLeft = 0

ppcbJustifyHCenter = 1

ppcbJustifyRight = 2

PPcbLabelType
Possible label type values are:

ppcbLabelTypeRefDesignator = 0

ppcbLabelTypePartType = 1

ppcbLabelTypeAttribute = 2

PPcbLabelDisplayMode
Possible label display mode values are:

ppcbLabelDisplayNone = 0

ppcbLabelDisplayValue = 1

ppcbLabelDisplayNameAndValue = 2

ppcbLabelDisplayFullNameAndValue = 3

PPcbLayerColor
ppcbLayerColorTrace = 0

ppcbLayerColorVia = 1

ppcbLayerColorPad = 2

ppcbLayerColorCopper = 3

ppcbLayerColorLine = 4

ppcbLayerColorText = 5

ppcbLayerColorError = 6

ppcbLayerColorOutlineTop = 7
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ppcbLayerColorOutlineBottom = 8

ppcbLayerColorRefDes = 9

ppcbLayerColorPartType = 10

ppcbLayerColorAttribute = 11

ppcbLayerColorKeepout = 12,

ppcbLayerColorPinNumber = 13

PPcbLayerType
Possible layer type values are:

ppcbLayerUnknown = 0

ppcbLayerComponent = 1

ppcbLayerRouting = 2

ppcbLayerDrill = 3

ppcbLayerSilkscreen = 4

ppcbLayerPasteMask = 5

ppcbLayerSolderMask = 6

ppcbLayerAssembly = 7

ppcbLayerGeneral = 8

ppcbLayerAll = 9999

PPcbLibraryItemType
Possible library item type values are:

ppcbLibraryItemTypePartType = 0

ppcbLibraryItemTypeDecal = 1

ppcbLibraryItemTypeLogicDrawing = 2

ppcbLibraryItemTypeDrawing = 3

ppcbLibraryItemTypeAll = 9999

PPcbMeasureFormat
Possible PADS Layout measure format values are:

ppcbMeasureFormatStandard = 0

ppcbMeasureFormatCurrent = 1
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ppcbMeasureFormatShort = 2

ppcbMeasureFormatLong = 3

PPcbNudgeMode
Possible nudge mode values are:

ppcbNudgeNone = 0

ppcbNudgeOff = 1

ppcbNudgeWarn = 2

ppcbNudgeAuto = 3

PPcbObjectType
Possible database object type values are:

Tip: ppcbObjectTypeCBP, ppcbObjectTypeSBP, and ppcbObjectTypeWirebond are available 
in the Advanced Packaging Toolkit only.

ppcbObjectTypeUnknown = 0
The server may return this value to indicate an invalid object. The client may use this value 
when trying to work with empty object collections.

ppcbObjectTypeComponent = 1

ppcbObjectTypeNet = 2

ppcbObjectTypePin = 3

ppcbObjectTypeVia = 4

ppcbObjectTypeConnection = 5

ppcbObjectTypeRouteSegment = 6

ppcbObjectTypeJumper = 7

ppcbObjectTypePartType = 8

ppcbObjectTypeCBP = 9

ppcbObjectTypeSBP = 10

ppcbObjectTypeWirebond = 11

ppcbObjectTypeNetClass = 12

ppcbObjectTypeDrawing = 13

ppcbObjectTypeText = 14

ppcbObjectTypeLabel = 15
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ppcbObjectTypePolyline = 16

ppcbObjectTypeCircle = 17

ppcbObjectTypeLibrary = 18

ppcbObjectTypeLibraryItem = 19

ppcbObjectTypeApplication = 20

ppcbObjectTypeAttribute = 21

ppcbObjectTypeAttributeType = 22

ppcbObjectTypeDocument = 23

ppcbObjectTypeMeasure = 24

ppcbObjectTypeView = 25

ppcbObjectTypeAssemblyOptions = 26

ppcbObjectTypeAttributes = 27

ppcbObjectTypeAttributeTypes = 28

ppcbObjectTypeObjects = 29

ppcbObjectTypePadStackLayer = 31

ppcbObjectTypePad = 32

ppcbObjectTypeThermalPad = 33

ppcbObjectTypeAntiPad = 34

ppcbObjectTypeLayer = 35

ppcbObjectTypeError = 36

ppcbObjectTypeErrorConflict = 37

ppcbObjectTypeAssociatedNet = 38

ppcbObjectTypeAll = 9999

All PADS Layout Automation database object types, including the Component, Net, Pin, Via, 
Connections, and RouteSegment objects, but not the CBP, SBP, and Wirebond objects.

This specifically means that if you use the Document.GetObjects (ppcbObjectTypeAll) method, 
the collection of objects returned does not include any CBP, SBP, or Wirebond objects.

PPcbOriginType
Possible origin type values are:

ppcbOriginTypeDesign = 0

ppcbOriginTypeParent = 1
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PPcbOutlineType
Possible outline type values are:

ppcbOutlineTypeCenter = 0

ppcbOutlineTypeOuter = 1

ppcbOutlineTypeInner = 2

PPcbPadCornerType
ppcbPadCornerType90Degree = 0

ppcbPadCornerTypeChamfered = 1

ppcbPadCornerTypeRounded = 2

PPcbPadShape
ppcbPadShapeOvalFinger = 0

ppcbPadShapeRectangularFinger = 1

ppcbPadShapeRound = 2

ppcbPadShapeSquare = 3

ppcbPadShapeAnnular = 4

ppcbPadShapeOdd = 5

PPcbPadStackLayerType
ppcbPadStackLayerTypeMounted = -2

ppcbPadStackLayerTypeInner = -1

ppcbPadStackLayerTypeOpposite = 0

PPcbPinElectricalType
Possible gate electrical type values are:

ppcbElectricalTypeUnknown = 0

ppcbElectricalTypeSource = 1

ppcbElectricalTypeBidirectional = 2

ppcbElectricalTypeOpenCollector = 3

ppcbElectricalTypeOrTieableSource = 4

ppcbElectricalTypeTristate = 5
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ppcbElectricalTypeLoad = 6

ppcbElectricalTypeTerminator = 7

ppcbElectricalTypePower = 8

ppcbElectricalTypeGround = 9

PPcbPlaneType
ppcbPlaneTypeNoPlane = 0

ppcbPlaneTypeCAMPlane = 1

ppcbPlaneTypeSplitMixedPlane = 2

PPcbRightReadingStatus
Possible right-reading status values are:

ppcbRightReadingNone = 0

ppcbRightReadingOrthogonal = 1

ppcbRightReadingAngled = 2

PPcbRoutingDirection
ppcbRoutingDirectionHorizontal = 0

ppcbRoutingDirectionVertical = 1

ppcbRoutingDirectionAny = 2

ppcbRoutingDirectionDiagonal45 = 3

ppcbRoutingDirectionDiagonal135 = 4

PPcbSegmentType
Possible segment type values are:

ppcbSegmentUnknown = 0

ppcbSegmentLine = 1

ppcbSegmentArc = 2

PPcbShapeType
Possible shape type values are:

ppcbShapeTypeOpen = 0



PADS Layout User’s Guide and Reference Manual, PADS 9.41624

PADS Layout Automation Server
PADS Layout Automation Server Reference

ppcbShapeTypeHollow = 1

ppcbShapeTypeFilled = 2

ppcbShapeTypeVoid = 3

PPcbTestPointType
Possible test point type values are:

ppcbTestPointNone = 0  No test point.

ppcbTestPointTopLayer = 1 Test point on top layer.

ppcbTestPointBottomLayer = 2 Test point on bottom layer.

PPcbThermalPadShape
ppcbThermalPadShapeRound = 6

ppcbThermalPadShapeSquare = 7

PPcbUnit
Possible unit type values are:

ppcbUnitCurrent = 0 Current unit in use in PADS Layout.

ppcbUnitDatabase = 1 Internal PADS Layout database unit.

ppcbUnitMils = 2  Mils unit (1/1000 of an inch).

ppcbUnitInch = 3  Inch unit.

ppcbUnitMetric = 4 Metric unit (1/1000 of a meter).

PPcbVerticalJustification
Possible vertical justification values are:

ppcbJustifyTop = 0

ppcbJustifyVCenter = 1

ppcbJustifyBottom = 2
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AntiPad.Application
This property returns the application object.

Prototype

Application as Application

Argument

None
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AntiPad.CornerRadius
This property returns the Anti Pad corner radius.

Prototype

CornerRadius as Double
      CornerRadius (unit as PPcbUnit)  as Double

Argument

unit - [Optional] Unit in which the value is returned.
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AntiPad.CornerType
This property returns the Anti Pad corner type.

Prototype

CornerType as PPcbPadCornerType

Argument

None
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AntiPad.Length
This property returns the Anti Pad length.

Prototype

Length as Double
      Length (unit as PPcbUnit)  as Double

Argument

unit - [Optional] Unit in which the value is returned.
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AntiPad.Name
This property returns the name of this anti pad.

Prototype

Name as String

Argument

None
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AntiPad.ObjectType
This property returns the type of the object - ppcbObjectTypeAntiPad.

Prototype

ObjectType as PPcbObjectType

Argument

None
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AntiPad.Offset
This property returns the Anti Pad offset.

Prototype

Offset as Double
      Offset  (unit as PPcbUnit)  as Double

Argument

unit - [Optional] Unit in which the value is returned.
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AntiPad.Orientation
This property returns the Anti Pad orientation.

Prototype

Orientation as Double

Argument

None



PADS Layout Automation Server
AntiPad.PadStackLayer

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1633

AntiPad.PadStackLayer
This property returns the PadStackLayer Object to which this anti pad belongs to.

Prototype

PadStackLayer as PadStackLayer

Argument

None
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AntiPad.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Argument

None
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AntiPad.Shape
This property returns the anti pad shape.

Prototype

Shape as PPcbAntiPadShape

Argument

None
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AntiPad.Size
This property returns the anti pad's size. For shape ppcbAntiPadShapeRound it returns 
diameter.

Prototype

Size (unit as PPcbUnit) as Double 

Argument

unit [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.



PADS Layout Automation Server
Application.ActiveDocument

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1637

Application.ActiveDocument
This property returns the active document.

Prototype

ActiveDocument As Document 

Arguments

None

Comments

The active document represents the open design.

Sample

The following sample code retrieves the name of the open design using the Document.Name 
property. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "You are working with " & ActiveDocument.Name 
End Sub

See Also

Application.OpenDocument Method, Document.Name



PADS Layout User’s Guide and Reference Manual, PADS 9.41638

PADS Layout Automation Server
Application.Application

Application.Application
This property returns the Application object.

Prototype

Application As Application 

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an Application object and all Automation objects have an application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.
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Application.DefaultFilePath
This property sets or returns the path that the program uses to open design files.

Prototype

DefaultFilePath As String

Arguments

None

Comments

This property checks the FileDir folder entry in the powerpcb.ini file. When you set this 
property to a new value, the .ini file entry also changes.

For example, “C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs” is the 
default path when you install using the default installation settings.

Sample

The following sample code changes the default file path and notifies the client of this change. 
See “Running Code Samples” for more information on running this sample.

Sub Main
oldPath = DefaultFilePath 
DefaultFilePath = "C:\TEMP" 
MsgBox "The default file path used to be " & oldPath & " and it was just 
changed to " & DefaultFilePath 
End Sub



PADS Layout User’s Guide and Reference Manual, PADS 9.41640

PADS Layout Automation Server
Application.FullName

Application.FullName
This property returns the file name of the application, including its path.

Prototype

FullName As String

Arguments

None

Comments

For example, this function can return the string ” 
C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\powerpcb.exe.”

Sample

The following sample code displays the common name and the actual .exe name of the 
program. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "Hi, my name is " & Name & " and I am located in " & FullName 
End Sub

See Also

Application.Name, Application.Version
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Application.Libraries
This property returns a collection of available libraries, or a specific library.

Prototype

Libraries as Collection

Libraries(Name as String) as Library

Arguments

Comments

None

Sample

The following sample code displays the number of available libraries. See “Running Code 
Samples” for more information on running this sample.

Sub Main
MsgBox "Number of libraries: " & Libraries.Count 
End Sub

name Name of the library to retrieve. Should not include wildcards.
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Application.Name
This property returns the name of the application.

Prototype

Name As String

Arguments

None

Comments

In PADS Layout this property returns the string “PowerPCB.”

This property is the default property for the Application object.

Sample

The following sample code displays the common name, the version, and the actual .exe name 
for the program, depending on which application you are running. See “Running Code 
Samples” for more information on running this sample.

Sub Main
MsgBox "Hi, my name is " & Name & " version " & Version & " and I am 
located in " & FullName 
End Sub

See Also

Application.FullName, Application.Version
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Application.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None
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Application.Parent
This property returns the parent of the object.

Prototype

Parent As Application 

Arguments

None

Comments

None
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Application.Preference
This property sets or returns a preference.

Prototype

Preference(name As String) As Variant 

Argument

Comments

The following are possible name argument values:

This property generates an exception if the name argument is not a valid document preference.

Sample

The following sample code demonstrates how to use this property. See “Running Code 
Samples” for more information on running this sample.

Sub Main
' Set the DRC mode to "Prevent" 
ActiveDocument.Preference("DRC") = ppcbDRCPrevent 
' Set the Nudge mode to "Automatic" 
ActiveDocument.Preference("Nudge") = ppcbNudgeAuto 
End Sub

name Name of the preference.

DRC Sets or returns the DRC mode of the open design. The DRC 
mode values are of type PPcbDRCMode.

Nudge Sets or returns the Nudge mode of the open design. The Nudge 
mode values are of type .

ModifyUnionMember Sets or returns the ability (True/False) to move an individual 
component when that component belongs to a union.
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Application.ProgressBar
This property sets or returns current value of the status bar, as a percentage.

Prototype

ProgressBar As Integer

Arguments

None

Comments

This property allows you to retrieve the current status of long batch processes that are running, 
or to display the status of long Basic scripts.

Set the value greater than 0 or less than 100 to deactivate the status bar.

Use this property with Application.StatusBarText.

Sample

The following sample demonstrates this property. See “Running Code Samples” for more 
information on running this sample.

Sub Main
 StatusBarText = "My Batch Process ..." 'show progress text
 For i = 0 to 100
  ProgressBar = i
 Next
 ProgressBar = -1 'deactivate progress bar
 StatusBarText = "" 'hide progress text
End Sub

See Also

Application.ProgressChange 
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Application.StatusBarText
This property sets or returns the text in the status bar.

Prototype

StatusBarText As String

Arguments

None

Comments

To set the status bar text to nothing, set this property to an empty string (" ").

Sample

The following sample displays a message on the status bar. See “Running Code Samples” for 
more information on running this sample.

Sub Main
StatusBarText = "Wow! I can even print my own messages in here!" 
End Sub
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Application.Version
This property returns the version.

Prototype

Version As String

Arguments

None

Comments

This property returns the application version as a string with the following format: 
<major>.<minor>, for example “4.0”.

Sample

The following sample displays the application name and version. See “Running Code Samples” 
for more information on running this sample.

Sub Main
MsgBox "Hi, my name is " & Name & " version " & Version 
End Sub

See Also

Application.Name, Application.FullName
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Application.Visible
This property sets or returns whether the program is visible.

Prototype

Visible As Boolean

Arguments

None

Comments

This property is usually used in the following cases:

• When an Automation client starts the Automation server using an asynchronous OLE 
Automation call, such as the Visual Basic function CreateObject. The Automation 
server always starts as invisible (this is a client/server rule). You can use this property to 
make the program visible.

• When a client attempts to shut down the program (see Application.Quit Method) by 
making PADS Layout invisible, disconnecting from it, and letting the server shut down 
appropriately.

• When a client needs to make the server window the active window, so it appears on top 
of other application windows. 

Sample

The following sample makes the program invisible, waits a second, and then makes it visible 
again. See “Running Code Samples” for more information on running this sample.

Sub Main
Visible = False 
Wait 1 
Visible = True 
End Sub
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AssemblyOptions.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.

This property identifies the object as an Automation object. All Automation server applications 
have an Application object and all Automation objects have an Application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.
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AssemblyOptions.Count
This property returns the number of Assembly Options.

Prototype

Count As Long

Arguments

None

Comments

None
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AssemblyOptions.Item
This property returns an Assembly Option, given its index or its name.

Prototype

Item(index As Long) As Document

Item(name As String) As Document

Arguments

Comments

This is the default member of the AssemblyOptions collection object.

This property generates an exception if the index or name argument is not valid.

index Index (in the collection) of the Assembly Option to retrieve.

name Name of the Assembly Option to retrieve.
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AssemblyOptions.ItemType
This property returns the type of an object given its index.

Prototype

ItemType(index As long) As PPcbObjectType

ItemType(name As String) As PPcbObjectType

Arguments

Comments

This property generates an exception if the index argument is not valid.

See Also

AssemblyOptions.Item

index Index of the object in the collection to query.

name Name of the object to retrieve.
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AssemblyOptions.Next
This property returns the index of the next object of a specified type after the specified index.

Prototype

Next(index As long, type As PPcbObjectType) As Long

Arguments

Comments

This property generates an exception if the index argument is not valid.

If Index = zero (0), then this function returns the index of the first item of the given type. If an 
item is not found, then the return value is zero (0).

index Index of the object in the collection to query.

type Type of the object to query.
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AssemblyOptions.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None
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AssemblyOptions.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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AssemblyOptions.ParentObject
This property returns the parent object of the collection.

Prototype

ParentObject as Object

Arguments

None

Comments

If a collection has ParentObject, it means the collection is “active.” Addition or deletion of an 
item to or from the collection modifies the parent object as well. Otherwise, only the collection 
is affected.
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AssociatedNet.Name
This property returns the name of the associated net. For example, this property returns the 
string ?$$$1*$$$2? for associated net $$$1*$$$2.

This property is the default property for the AssociatedNet object.

Prototype

Name as String

Arguments

None
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AssociatedNet.Nets
This property returns the collection of all nets belonging to the associated net. 

Prototype

Nets as Objects
Nets (name as String) as Net

Arguments

name     Optional
              Name of an existing net

Return Values

When an existing net name is passed to this property, it returns the net object with that name. If 
the net name is not specified, this property returns the collection of all nets in Objects.
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AssociatedNet.ObjectType
This property returns the type of the object. All application database objects in the Automation 
server implement this property to compensate for the lack of a Visual Basic equivalent for the 
Visual C++ QueryInterface function. 

Prototype

ObjectType as BlazeObjectType

Arguments

None

Return Values

This property always returns blazeObjectTypeAssociatedNet.
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AssociatedNet.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Arguments

None
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AssociatedNet.Selected
This property sets or determines whether the associated net is selected or not. You can also 
select an application database object using the Document.SelectObjects and Objects.Select 
methods.

Prototype

Selected as Boolean

Arguments

None

Sample

The following sample code selects associated net $$$1*$$$2 only, assuming it exists in the 
open design. For more information about running this sample code, see Running Code Samples.

Sub Main
   ActiveDocument.SelectObjects(,,False)
   ActiveDocument.AssociatedNets("$$$1*$$$2").Selected = True
End Sub

See also: Document.SelectionChange Event, Document.SelectObjects, Objects.Select
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Attribute.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.

This property identifies the object as a PADS Layout Automation object. All Automation server 
applications have an Application object and all Automation objects have an Application 
property. This property is usually used in Automation client applications that handle large 
volumes of objects from different sources, such as different Automation server applications, to 
quickly identify the application to which the object belongs.
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Attribute.Name
This property returns the name of the attribute.

Prototype

Name As String

Arguments

None

Comments

None

Sample

The following sample code lists all attributes in the open design and places that list in a custom 
dialog box. This sample uses the UserDialog Editor in the Sax Basic Engine in PADS Layout. 
See the Sax Basic Editor On-line Help for more information. See “Running Code Samples” for 
more information on running this sample.

Dim ListAttrs$(10000)
Sub Main
index = 0 
For Each nextAttr In ActiveDocument.Attributes 
ListAttrs$(index) = nextAttr.Name 
index = index + 1 
Next nextAttr 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
 Begin Dialog UserDialog 180,238,"Attributes" ' %GRID:10,7,1,1
  ListBox 10,7,160,203,ListAttrs(),.ListBox1
  OKButton 10,210,160,21
 End Dialog
Dim dlg As UserDialog 
Dialog dlg 
End Sub

See Also

Attribute.Value
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Attribute.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None
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Attribute.Parent
This property returns the parent of the object.

Prototype

Parent As Object

Arguments

None

Comments

This is a Microsoft-required property.
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Attribute.Value
This property sets or returns the value of the attribute.

Prototype

Value As Variant

Arguments

None

Comments

The value of an attribute may be of type Boolean, Byte, Single, Integer, PortInt, Long, Double, 
String, or Measure object.

This property generates an exception if a type mismatch exists between the value type and the 
type of the attribute.

If a value is not defined, an empty string is returned.

Sample 1

The following sample code changes the Cost attribute of all LED components to US$3.99, in 
the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each nextComp In ActiveDocument.Components 
If nextComp.PartType = "LED" Then 
' Ignore exceptions generated when that attribute does not exist 
On Error Resume Next 
nextComp.Attributes("PRICE").Value = 3.99 
End If 
Next nextComp
End Sub

Sample 2

The following sample code adds attributes of different types to the level of PCB design and then 
changes their values. See “Running Code Samples” for more information on running this 
sample.

Sub Main
'Create new file to access some predefined attribute types such as List or 
Measure OpenDocument"" 
'Add attributes of different types to PCB design  
With Active Document 
'Free text type 
.Attributes.Add "Description","Free Text Value" 
'Yes/No type 
.Attributes.Add "PowerGround", "True" 
'Number type 
.Attributes.Add "Some Number", 100 



PADS Layout User’s Guide and Reference Manual, PADS 9.41668

PADS Layout Automation Server
Attribute.Value

'Decimal Number type 
.Attributes.Add "Some Decimal Number", 0.45 
'Measure type (in volts) 
.Attributes.Add "Voltage", Measure("5V)" 
'list type (only values from predefined set allowed) 
.Attributes.Add "HyperLynx.Signal Type", "Clock" 
End With 
'Modify PCB attributes of different types  
With ActiveDocument 
'Free text type 
.Attributes("Description").Value = "Another Free Text Value" 
'Yes/No type 
.Attributes("PowerGround").Value = False 
'Number type 
.Attributes("Some Number").Value = 200 
'Decimal Number type 
.Attributes("Some Decimal Number").Value = 0.25 
'Measure type (in volts) 
.Attributes("Voltage").Value = Measure("2.5V") 
'list type (only values from predefined set allowed) 
.Attributes("HyperLynx.Signal Type").Value = "Data" 
End With 
End Sub

See Also

Attribute.Name
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Attributes.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.

This property identifies the object as a PADS Layout Automation object. All Automation server 
applications have an Application object and all Automation objects have an Application 
property. This property is usually used in Automation client applications that handle large 
volumes of objects from different sources, such as different Automation server applications, to 
quickly identify the application to which the object belongs.
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Attributes.Count
This property returns the number of attributes.

Prototype

Count As Long

Arguments

None

Comments

None
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Attributes.Item
This property returns an attribute, given its index or its name.

Prototype

Item(index As Long) As Attribute

Item(name As String) As Attribute

Arguments

Comments

This is the default member of the Attributes collection object.

This property generates an exception if the index or name argument is not valid.

index Index (in the collection) of the attribute to retrieve.

name Name of the attribute to retrieve.
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Attributes.ItemType
This property returns the type of an object given its index.

Prototype

ItemType(index As long) As PPcbObjectType

ItemType(name As String) As PPcbObjectType

Arguments

Comments

This property generates an exception if the index argument is not valid.

See Also

Attributes.Item

index Index of the object in the collection to query.

name Name of the object to retrieve.
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Attributes.Next
This property returns the index of the next object of a specified type after the specified index.

Prototype

Next(index As long, type As PPcbObjectType) As Long

Arguments

Comments

This property generates an exception if the index argument is not valid.

If Index = zero (0), then this function returns the index of the first item of the given type. If an 
item is not found, then the return value is zero (0).

index Index of the object in the collection to query.

type Type of the object to query.
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Attributes.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None
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Attributes.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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Attributes.ParentObject
This property returns the parent object of the collection.

Prototype

ParentObject as Object

Arguments

None

Comments

If a collection has ParentObject, it means the collection is “active.” Addition or deletion of an 
item to or from the collection modifies the parent object as well. Otherwise, only the collection 
is affected.
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CBP.Application
This property returns the Application object.

Restriction: This information applies to only the BGA toolkit.

Prototype

Application As Application 

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an Application object and all Automation objects have an application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.

This is a Microsoft-required property.
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CBP.Component
This method returns the component object of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Component As Component

Arguments

None

Comments

None

Sample

The following sample code represents a subroutine that depends on the CBP object passed as an 
argument. The code retrieves the name of the component and the name of the decal to which the 
CBP belongs. See “Running Code Samples” for more information on running this sample.

Sub QueryCBP(aCBP As CBP)
MsgBox "Component Bond Pad" & aCBP.Name &  
"belongs to component" & aCBP.Component.Name &  
"(" & aCBP.Component.Decal &")" 
End Sub
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CBP.Edge
This property returns the edge of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Edge As PPcbBondPadEdge

Arguments

None

Comments

None

Sample

The following sample code displays information about the edge of each CBP in each die in the 
open design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
Select Case aCBP.Edge 
Case ppcbBondPadEdgeUnknown 
MsgBox aCBP.Name & " Edge: Unknown" 
Case ppcbBondPadEdgeLeft  
MsgBox aCBP.Name & " Edge: Left" 
Case ppcbBondPadEdgeTop  
MsgBox aCBP.Name & " Edge: Top" 
Case ppcbBondPadEdgeRight  
MsgBox aCBP.Name & " Edge: Right" 
Case ppcbBondPadEdgeBottom  
MsgBox aCBP.Name & " Edge: Bottom" 
Case Else  
MsgBox aCBP.Name & " Edge: Unknown" 
End Select  
Next 
End If 
Next 
End Sub
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CBP.Function
This property returns the signal name of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Function As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the signal name of each CBP in each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox aCBP.Name & " Function: " & aCBP.Function 
Next 
End If 
Next 
End Sub
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CBP.Layer
This property returns the LIQ layer of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Layer As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the layer on which each CBP in each die in the open design 
is mounted. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox aCBP.Name & " Layer: " & aCBP.Layer 
Next 
End If 
Next 
End Sub
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CBP.Length
This property returns the length of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Length([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the length of each CBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox aCBP.Name & " Length: " & Format (aCBP.Length, "#.###") 
Next 
End If 
Next 
End Sub

See Also

CBP.Width 

unit [Optional] Unit in which the length value is returned.
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CBP.Name
This default property returns the name of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Name As String

Arguments

None

Comments

This is a Microsoft-required property.

Sample

The following sample code retrieves the name of each CBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox aCBP.Name 
Next 
End If 
Next 
End Sub
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CBP.ObjectType
This property returns the type of the object.

Restriction: This information applies to only the BGA toolkit.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

This property always returns ppcbObjectTypeCBP.

This property is generally used to identify the kind of database objects in a heterogeneous 
Objects collection or when implementing a generic routine that depends on the type of the 
database object passed as the argument.

All database objects in the Automation server implement this property to compensate for the 
lack of a Visual Basic equivalent for the Visual C++ QueryInterface function.

Sample

See “Running Code Samples” for more information on running this sample.

Sub DoSomethingToDieObject(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeCBP 
' Do something specific to CBP objects 
Case ppcbObjectTypeSBP 
' Do something specific to SBP objects 
Case ppcbObjectTypeWirebond 
' Do something specific to Wirebond objects 
Case Else 
MsgBox "Not a Die object" 
End Select 
End Sub
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CBP.Parent
This property returns the parent of the object.

Restriction: This information applies to only the BGA toolkit.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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CBP.PositionX
This property returns the x-coordinate of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

PositionX([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the location of each CBP in each die in the open design, in 
current units. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox aCBP.Name & ": (" & aCBP.PositionX & ", " & aCBP.PositionY & ")" 
Next 
End If 
Next 
End Main

See Also

CBP.PositionY 

unit [Optional] Unit in which the x-coordinate is returned.
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CBP.PositionY
This property returns the y-coordinate of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

PositionY([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Arguments

Comments

None

Sample

The following sample code retrieves the location of each CBP in each die in the open design, in 
current units. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox aCBP.Name & ": (" & aCBP.PositionX & ", " & aCBP.PositionY & ")" 
Next 
End If 
Next 
End Sub

See Also

CBP.PositionX 

unit [Optional] Unit in which the y-coordinate is returned.
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CBP.SBPs
This property returns the collection of SBPs linked to this CBP object.

Restriction: This information applies to only the BGA toolkit.

Prototype

SBPs As Objects 

Arguments

None

Comments

None

Sample

The following sample retrieves the number of SBPs linked to each CBP in each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox "Number of SBPs linked to " & aCBP.Name & ": " & aCBP.SBPs.Count 
Next 
End If 
Next 
End Main

See Also

CBP.Wirebonds 
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CBP.Shape
This property returns the shape of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Shape As PPcbBondPadShape

Arguments

None

Comments

None

Sample

The following sample retrieves the shape of each CBP on each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
Select Case aCBP.Shape 
Case ppcbBondPadShapeUnknown 
MsgBox aCBP.Name & " Shape: Unknown" 
Case ppcbBondPadShapeRectangle  
MsgBox aCBP.Name & " Shape: Rect" 
Case ppcbBondPadShapeOval  
MsgBox aCBP.Name & " Shape: Oval" 
Case Else  
MsgBox aCBP.Name & " Shape: Unknown" 
End Select 
Next 
End If 
Next 
End Sub
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CBP.Width
This property returns the width of the CBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Width([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample retrieves the width of each CBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox aCBP.Name & " Width: " & Format (aCBP.Width, "#.###") 
Next 
End If 
Next 
End Sub

See Also

CBP.Length 

unit [Optional] Unit in which the width value is returned.
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CBP.Wirebonds
This property returns the collection of bond wires attached to the CBP object.

Restriction: This information applies to only the BGA toolkit.

Prototype

Wirebonds As Objects 

Arguments

None

Comments

None

Sample

The following sample retrieves the number of bond wires connected to each CBP in each die in 
the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP in comp.CBPs 
MsgBox "Number of WBs connected to " & aCBP.Name & ":" & 
aCBP.Wirebonds.Count 
Next 
End If 
Next 
End Sub

See Also

CBP.SBPs 
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Circle.Application
This property returns the Application object.

Prototype

Application as Application 

Arguments

None

Comments

This is a Microsoft-required property.
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Circle.CenterX
This property returns the x-coordinate of the circle's center.

Prototype

CenterX (Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Sample

The following sample code shows the position of the selected circle. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
If geom.ObjectType = ppcbObjectTypeCircle Then 
MsgBox "Position: (" & geom.CenterX & ", " & geom.CenterY & ")" 
End If 
Next geom 
Next drw  
End Sub

unit [Optional] Unit in which the center X value is returned. This optional 
argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Circle.CenterY
This property returns the y-coordinate of the circle's center.

Prototype

CenterY (Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Sample

The following sample code shows the position of the selected circle. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
If geom.ObjectType = ppcbObjectTypeCircle Then 
MsgBox "Position: (" & geom.CenterX & ", " & geom.CenterY & ")" 
End If 
Next geom 
Next drw  
End Sub

unit [Optional] Unit in which the center Y value is returned. This optional 
argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Circle.Geometry
This property returns a collection of objects, currently polylines, texts, or circles, representing 
this object's child geometry objects.

Prototype

Geometry as Collection

Arguments

None

Comments

None

Sample

The following sample code shows the number of child objects. See “Running Code Samples” 
for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
MsgBox "Child object count: " & geom.Geometry.Count 
Next geom 
Next drw  
End Sub
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Circle.Layer
This property returns the layer number of the object.

Prototype

Layer as Long

Arguments

None

Comments

None

Sample

The following sample code shows the layer number of the selected circle. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
MsgBox "Layer number: " & geom.Layer 
Next geom 
Next drw  
End Sub
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Circle.LineWidth
This property returns the line width of the circle.

Prototype

LineWidth (Unit as PPcbUnit) as Double

Argument

Comments

None

Sample

The following sample code shows the line width of the selected circle. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
MsgBox "LineWidth: " & geom.LineWidth 
Next geom 
Next drw  
End Sub

unit [Optional] Unit in which the line width value is returned. This optional 
argument is ppcbUnitCurrent by default.
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Circle.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following sample code tests the ObjectType property. See “Running Code Samples” for 
more information on running this sample.

Sub Main
For Each drw In ActiveDocument.Drawings 
For Each geom In drw.Geometry 
type = geom.ObjectType  
If type <> ppcbObjectTypePolyline And type <> ppcbObjectTypeCircle Then 
MsgBox "Test failed" 
End If 
Next geom 
Next drw  
End Sub
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Circle.OutlineType
This property returns the outline type of the circle.

Prototype

OutlineType as PPcbOutlineType 

Arguments

None

Comments

None

Sample

The following sample code shows the outline type of the selected circle. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
Select Case geom.OutlineType 
Case ppcbOutLineTypeCenter 
s = "Center line" 
Case ppcbOutLineTypeOuter 
s = "Outer line" 
Case ppcbOutLineTypeInner 
s = "Inner line" 
End Select 
MsgBox "Outline type: " & s 
Next geom 
Next drw  
End Sub
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Circle.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Arguments

None

Comments

This is a Microsoft-required property.
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Circle.Radius
This property returns the value of the radius of the circle.

Prototype

Radius (Unit as PPcbUnit) as Double

Argument

Comments

None

Sample

The following sample code shows the radius of the selected circle. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
If geom.ObjectType = ppcbObjectTypeCircle Then 
MsgBox "Radius: " & geom.Radius 
End If  
Next geom 
Next drw  
End Sub

Unit [Optional] Unit in which the radius value is returned. This optional 
argument is ppcbUnitCurrent by default.
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Circle.ShapeType
This property returns the shape type of the circle. The value of PPcbShapeOpen is not 
applicable.

Prototype

ShapeType as PPcbShapeType 

Arguments

None

Comments

None

Sample

The following sample code shows the shape type of the selected circle. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
Select Case geom.ShapeType 
Case ppcbShapeTypeOpen 
s = "Open" 
Case ppcbShapeTypeHollow 
s = "Hollow" 
Case ppcbShapeTypeFilled 
s = "Filled" 
Case ppcbShapeTypeVoid 
s = "Void" 
End Select 
MsgBox "Shape type: " & s & " shape" 
Next geom 
Next drw  
End Sub
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Component.Application
This property returns the application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an automation object. All Automation server applications 
have an application object and all automation objects have an application property. This 
property is usually used in automation client applications that handle large volumes of objects 
from different sources, such as different automation server applications, to quickly identify the 
application to which the object belongs.
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Component.Attributes
This property returns the collection of all attributes of the component.

Prototype

Attributes As Attributes 

Attributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that component Attribute 
object. Otherwise, it returns the collection of all component attributes in an Attributes collection 
object.

Sample

The following sample code retrieves the number of attributes on component U1, assuming it 
exists in the open design, using the Attributes.Count property. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set attrs = ActiveDocument.Components("U1").Attributes 
MsgBox "There are " & attrs.Count & " attribute(s) in component U1." 
End Sub

name Name of an existing component attribute.
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Component.CBPs
This property returns the CBP collection of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

CBPs As Objects 

Arguments

None

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code iterates through all CBPs in each die in the open design and prints 
the names of the CBPs. See “Running Code Samples” for more information on running this 
sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aCBP In comp.CBPs 
Debug.Print aCBP.Name 
Next aCBP 
End If 
Next 
End Sub
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Component.CenterX
This property returns the x-coordinate of the center of the component.

Prototype

CenterX (Unit as PPcbUnit) as Double

Argument

Comments

None

Sample

The following sample code displays coordinates of the center of a component. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeComponent,,True) 
For Each comp In selected 
Dim msg as String 
Msg = "Component center: (" & comp.CenterX & ", " & comp.CenterY & ")" 
MsgBox msg 
Exit For 
Next comp 
End Sub

unit [Optional] Unit in which the CenterX value is returned. This optional 
argument is ppcbUnitCurrent by default.
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Component.CenterY
This property returns the y-coordinate of the center of the component.

Prototype

CenterY (Unit as PPcbUnit) as Double

Argument

Comments

None

Sample

The following sample code displays coordinates of the center of the selected component. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeComponent,,True) 
For Each comp In selected 
Dim msg as String 
Msg = "Component center: (" & comp.CenterX & ", " & comp.CenterY & ")" 
MsgBox msg 
Exit For 
Next comp 
End Sub

unit [Optional] Unit in which the CenterY value is returned. This optional 
argument is ppcbUnitCurrent by default.
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Component.Decal
This property sets or returns the decal of the component.

Prototype

Decal As String

Arguments

None

Comments

This property can only set a decal that is in the list of component-compatible decals, which is 
returned by the Component.DecalCompatibleList property.

This property generates an exception if the decal to set is invalid, or if the change cannot occur 
because of violations to the current DRC setting, the Nudge setting, locked test point status, or 
existing rules.

Sample

The following sample code retrieves the current decal of component C1, assuming it exists in 
the open design, along with the list of compatible decals to which it can be changed. See 
“Running Code Samples” for more information on running this sample.

Sub Main
decalList = ActiveDocument.Components("C1").DecalCompatibleList 
decalListString = "" 
For index = LBound(decalList) To UBound(decalList) 
If index = 1 Then 
decalListString = decalList(index) 
Else 
decalListString = decalListString & " or " & decalList(index) 
End If 
Next index 
MsgBox "C1 decal is " & ActiveDocument.Components("C1").Decal & " and can 
be changed to : " & decalListString 
End Sub

See Also

Component.DecalCompatibleList
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Component.DecalAttributes
This property returns the collection of all attributes assigned to the component decal.

Prototype

DecalAttributes As Attributes 

DecalAttributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that decal Attribute object. 
Otherwise, it returns the collection of all decal attributes in an Attributes collection object.

Sample

The following sample code retrieves the number of attributes assigned to the decal for 
component U1, assuming it exists in the open design, using the Attributes.Count property. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set attrs = ActiveDocument.Components("U1").DecalAttributes 
MsgBox "There are " & attrs.Count & " attribute(s) in decal " & 
ActiveDocument.Components("U1").Decal 
End Sub

name Name of an existing decal attribute.
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Component.DecalCompatibleList
This property returns the list of compatible decals of the component.

Prototype

DecalCompatibleList As Variant

Arguments

None

Comments

Use this property to identify all compatible decals for the component before changing the 
component decal using the Component.Decal property.

Sample

The following sample code retrieves the current decal for component C1, assuming it exists in 
the open design, along with the list of compatible decals to which it can be changed. See 
“Running Code Samples” for more information on running this sample.

Sub Main
decalList = ActiveDocument.Components("C1").DecalCompatibleList 
decalListString = "" 
For index = LBound(decalList) To UBound(decalList) 
If index = 1 Then 
decalListString = decalList(index) 
Else 
decalListString = decalListString & " or " & decalList(index) 
End If 
Next index 
MsgBox "C1 decal is " & ActiveDocument.Components("C1").Decal & " and can 
be changed to : " & decalListString 
End Sub

See Also

Component.Decal
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Component.DieHeight
This property returns the height of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

DieHeight([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the height of each die in the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "DieHeight (" & comp.Name & "): " & Format (comp.DieHeight, 
"#.###") 
End If 
Next 
End Sub

unit [Optional] Unit in which the die height value is returned. This optional 
argument is ppcbUnitCurrent by default.
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Component.DieLength
This property returns the length of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

DieLength([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the length of each die in the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "DieLength (" & comp.Name & "): " & Format (comp.DieLength, 
"#.###") 
End If 
Next 
End Sub

unit [Optional] Unit in which the die length value is returned. This optional 
argument is ppcbUnitCurrent by default.



PADS Layout Automation Server
Component.DieWidth

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1713

Component.DieWidth
This property returns the width of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

DieWidth([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the width of each die in the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "DieWidth (" & comp.Name & "): " & Format (comp.DieWidth, "#.###") 
End If 
Next 
End Sub

unit [Optional] Unit in which the die width value is returned. This optional 
argument is ppcbUnitCurrent by default.
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Component.Glued
This property sets or returns whether the component is glued.

Prototype

Glued As Boolean

Arguments

None

Comments

None

Sample

The following sample code glues all components in the open design. See “Running Code 
Samples” for more information on running this sample.

Sub Main
For Each nextComp In ActiveDocument.Components 
nextComp.Glued = True 
Next nextComp 
End Sub



PADS Layout Automation Server
Component.Installed

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1715

Component.Installed
This property sets or returns whether the component is installed in the current assembly option.

Prototype

Installed As Boolean

Arguments

None

Comments

This property is useful only when the parent of the component is an Assembly Option. If the 
parent of the component is not an Assembly Option, this property always returns True and 
cannot be set to a different value.

Sample

The following sample code creates a new Assembly Option named EmptyAssOpt in the open 
design, and then uninstalls all components in that newly created Assembly Option. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set newAssOpt = ActiveDocument.AssemblyOptions.Add("EmptyAssOpt") 
For Each nextComp In newAssOpt.Components 
nextComp.Installed = False 
Next nextComp 
End Sub

See Also

Component.Substituted
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Component.IsDiePart
This property returns whether the component is a die.

Prototype

IsDiePart As Boolean

Arguments

None

Comments

In PADS Layout, this property always returns FALSE.

Sample

The following sample code retrieves the name of each die presented in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox comp.Name 
End If 
Next 
End Sub
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Component.IsSMD
This property returns whether the component is SMD.

Prototype

IsSMD As Boolean

Arguments

None

Comments

This function returns whether this component is 100% SMD, meaning that all its pins are SMD 
pins.

Sample

The following sample code retrieves the number of SMD components in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
nbSMDComponents = 0 
For Each nextComp In ActiveDocument.Components 
If nextComp.IsSMD = True Then nbSMDComponents = nbSMDComponents + 1 
Next nextComp 
MsgBox "There are " & nbSMDComponents & " SMD components, out of " & 
ActiveDocument.Components.Count 
End Sub
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Component.Labels
This property returns a collection of all labels associated with the component.

Prototype

Labels as Collection

Labels (Name as String) as Label

Argument

Comments

None

Sample

The following sample code displays a message box showing the name of the first label in the 
selected component. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set selected = ActiveDocument.GetObjects(pcbObjectTypeComponent,,True) 
For Each comp In selected 
For Each label In comp.Labels 
MsgBox "The first component label is " & label.Text 
Exit For 
Next label 
Exit For 
Next comp 
End Sub

name Name of the label to retrieve (optional).
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Component.Layer
This property sets or returns the mounting layer of the component.

Prototype

Layer As Long

Arguments

None

Comments

This property can only be set to a component layer(PPcbLayerType). Use the 
Document.LayerType property to identify all valid component layers in the open design.

Use the Document.LayerName property to identify the layer name that matches the returned 
layer number.

This property generates an exception if the layer to set is invalid or is not a component layer.

Sample

The following sample code mounts component U1, assuming it exists in the open design, on the 
opposite component layer. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set compU1 = ActiveDocument.Components("U1") 
For index=1 To Document.LayerCount 
If Document.LayerType(index) = ppcbLayerComponent And index <> 
compU1.layer Then  
compU1.layer = index 
Exit For 
End If 
Next index 
End Sub

See Also

Document.LayerCount, Document.LayerName, Document.LayerType
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Component.Name
This property returns the name of the component.

Prototype

Name As String

Arguments

None

Comments

For example, this property returns the string “U1” for component U1.

This property is the default property for the Component object.

Sample

The following sample code lists all components in the open design and places that list in a 
custom dialog box. When a component is selected in the list box, the sample selects that 
component in PADS Layout. 

This sample uses the UserDialog Editor in the Sax Basic Engine in PADS Layout. See 
“Running Code Samples” for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListComps$(10000)
Sub Main
index = 0
For Each nextComp In ActiveDocument.Components 
ListComps$(index) = nextComp.Name 
index = index + 1 
Next nextComp 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Components",.CallbackFunc ' 
%GRID:10,7,1,1 
ListBox 10,7,160,203,ListComps(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened in the dialog; it is used to easily process user 
actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
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ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
ActiveDocument.SelectObjects(ppcbObjectTypeComponent, 
ListComps(SuppValue%)) 
End If 
End Select 
End Function
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Component.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypeComponent. 

All PADS Layout database objects in the PADS Layout Automation server implement this 
property to compensate for the lack of a Basic equivalent for the Visual C++ QueryInterface 
function.

This property is generally used:

• To identify the kind of PADS Layout database objects in a heterogeneous Objects 
collection.

• When implementing a generic routine that depends on the type of the PADS Layout 
database object passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypeVia 
' Do something specific to via objects 
Case ppcbObjectTypeConnection 
' Do something specific to connection objects 
Case ppcbObjectTypeRouteSegment 
' Do something specific to route segment objects 
Case ppcbObjectTypeJumper 
' Do something specific to jumper objects 
Case Else 
MsgBox "Not a PADS Layout database object" 
End Select 
End Sub
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Component.Orientation
This property sets or returns the orientation of the component.

Prototype

Orientation As Double

Arguments

None

Comments

The proper completion of this method depends on the items listed below. To force a component 
rotation, you must first disable the following:

• Glued status, which is set using the Component.Glued property.

• DRC mode, which is set using the Document.Preference property.

• Nudge mode, which is set using the Document.Preference property.

• ModifyUnionMember mode, which is set using the Document.Preference property.

This method generates an exception if a PADS Layout security failure occurs during 
processing.

Sample

The following sample code rotates U1 to 45 degrees, assuming U1 exists in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.Components("U1").Orientation = 45 
End Sub

See Also

Document.PositionsChange 
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Component.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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Component.PartType
This property sets or returns the part type of the component.

Prototype

PartType As String

Arguments

None

Comments

This property can be set to a new value only when the parent of the component is an Assembly 
Option. If the parent is an Assembly Option, this property substitutes the component in the 
current Assembly Option with a new part type. The new part type must have a decal compatible 
with the default decal.

This property generates an exception if the parent of the component is not an Assembly Option 
or if the part type is invalid.

Sample

The following sample code retrieves the part type of component U1, assuming it exists in the 
open design. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "The part type of U1 is " & 
ActiveDocument.Components("U1").PartType 
End Sub

See Also

Component.Substituted, Component.PartTypeObject
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Component.PartTypeAttributes
This property returns the collection of all attributes for the component part type.

Prototype

PartTypeAttributes As Attributes 

PartTypeAttributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that part type Attribute 
object. If the attribute name does not exist, this property returns the collection of all part type 
attributes in an Attributes collection object.

Sample

The following sample code retrieves the number of attributes assigned to the part type for 
component U1, assuming it exists in the open design, using the Attributes.Count property. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set attrs = ActiveDocument.Components("U1").PartTypeAttributes 
MsgBox "There are " & attrs.Count & " attribute(s) in decal " & 
ActiveDocument.Components("U1").PartType 
End Sub

name Name of an existing part type attribute.
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Component.PartTypeECORegistered
This property sets or returns the part type ECO registration status.

Prototype

PartTypeECORegistered As Boolean

Arguments

None

Comments

Beginning with PowerPCB v3.5 this property becomes obsolete. Use PartType.ECORegistered 
instead.

See Also

PartType.ECORegistered
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Component.PartTypeLogic
This property returns the logic type of the part type for the component.

Prototype

PartTypeLogic As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the logic type of the part type for component U1, assuming 
it exists in the open design. See “Running Code Samples” for more information on running this 
sample.

Sub Main
MsgBox "The Logic type of U1 is " & 
ActiveDocument.Components("U1").PartTypeLogic 
End Sub
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Component.PartTypeObject
This property returns the part type object of this component.

Prototype

PartTypeObject As PartType 

Arguments

None

Comments

None

Sample

The following sample code retrieves the part type object for component U1, assuming it exists 
in the open schematic. See “Running Code Samples” for more information on running this 
sample.

Sub Main
MsgBox "The part type of U1 is " & 
ActiveDocument.Components("U1").PartTypeObject.Name 
End Sub

See Also

Component.PartType
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Component.Pins
This property returns the collection of all pins in the component.

Prototype

Pins As Objects 

Pins(name As String) As Pin 

Argument

Comments

When an existing pin name is passed to this property, it returns that Pin object. If the pin name 
does not exist, this property returns the collection of all pins of the component in an Objects 
collection object.

Sample

The following sample code retrieves the number of pins in component U1, assuming it exists in 
the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "U1 has " & ActiveDocument.Components("U1").Pins.Count & " pins." 
End Sub

name Name of an existing pin.
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Component.Placed
This property returns whether the component is placed.

Prototype

Placed As Boolean

Arguments

None

Comments

A component is considered placed if all its pins are inside the board outline, but outside a board 
cut out.

Sample

The following sample code determines whether component U1 is placed or not, assuming U1 
exists in the open design. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Select Case ActiveDocument.Components("U1").Placed 
Case True 
MsgBox "Component U1 is placed"  
Case False 
MsgBox "Component U1 is not placed"  
End Select 
End Sub
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Component.PositionX
This property returns the x-coordinate of the component.

Prototype

PositionX([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the location of component U1, assuming it exists in the 
open design, in current design units. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set compU1 = ActiveDocument.Components("U1") 
MsgBox "U1 position is = (" & compU1.PositionX & ", " & compU1.PositionY & 
")" 
End Sub

See Also

Component.PositionY, Component.Move

unit [Optional] Unit in which the x-coordinate is returned.
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Component.PositionY
This property returns the y-coordinate of the component.

Prototype

PositionY([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the location of component U1, assuming it exists in the 
open design, in current design units. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set compU1 = ActiveDocument.Components("U1") 
MsgBox "U1 position is = (" & compU1.PositionX & ", " & compU1.PositionY & 
")" 
End Sub

See Also

Component.PositionX, Component.Move

unit [Optional] Unit in which the y-coordinate is returned.
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Component.SBPs
This property returns the die's SBP collection.

Restriction: This information applies to only the BGA toolkit.

Prototype

SBPs As Objects

Arguments

None

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code iterates through SBPs for each die component in the open design 
and prints the names of the SBPs. See “Running Code Samples” for more information on 
running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP In comp.SBPs 
Debug.Print aSBP.Name 
Next 
End If 
Next 
End Sub



PADS Layout Automation Server
Component.Selected

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1735

Component.Selected
This property sets or returns whether the component is selected.

Prototype

Selected As Boolean

Arguments

None

Comments

You can also select a PADS Layout database object using the Document.SelectObjects and 
Objects.Select methods.

Sample

The following sample code selects component U1 only, assuming it exists in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.Components("U1").Selected = True 
End Sub

See Also

Document.SelectionChange Event 



PADS Layout User’s Guide and Reference Manual, PADS 9.41736

PADS Layout Automation Server
Component.Substituted

Component.Substituted
This property returns whether the component is substituted in the current Assembly Option.

Prototype

Substituted As String

Arguments

None

Comments

This property is useful only when the parent of the component is an Assembly Option. If the 
parent of the component is not an Assembly Option, this property always returns False.

To substitute a component in an Assembly Option, use the Component.PartType property.

Sample

The following sample code retrieves the number of substituted components in the MyAssOpt 
Assembly Option, assuming it exists in the open design. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set myAssOpt = ActiveDocument.AssemblyOptions("MyAssOpt") 
nbSubstComp = 0 
For Each nextComp In myAssOpt.Components 
 If nextComp.Substituted = True Then nbSubstComp = nbSubstComp + 1 
Next nextComp 
MsgBox "There are " & nbSubstComp & " substituted components in " & 
myAssOpt.Name 
End Sub

See Also

Component.PartType, Component.Installed
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Component.WireBondRulesAngleMaximum
This property returns the bond wire maximum angle rule of the die, in degrees.

Restriction: This information applies to only the BGA toolkit.

Prototype

WireBondRulesAngleMaximum As Double

Arguments

None

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the maximum angle rule for each die in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "MaxAngleRule: " & Format (comp.WireBondRulesAngleMaximum, 
"#.###") 
End If 
Next 
End Sub
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Component.WireBondRulesClearanceWireToPad
This property returns the bond wire-to-pad clearance rule of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

WireBondRulesClearanceWireToPad([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the wire-to-pad clearance rule for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "WireToPad: " & Format (comp.WireBondRulesClearanceWireToPad, 
"#.###") 
End If 
Next 
End Sub

unit [Optional] Unit in which the clearance value is returned.
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Component.WireBondRulesClearanceWireToWire
This property returns the bond wire-to-wire clearance rule of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

WireBondRulesClearanceWireToWire([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the wire-to-wire clearance rule for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
'For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "WireToWire: " & Format 
(comp.WireBondRulesClearanceWireToWire,"#.###") 
End If 
Next 
End Sub

unit [Optional] Unit in which the clearance value is returned.
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Component.WireBondRulesLengthMaximum
This property returns the bond wire maximum length rule of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

WireBondRulesLengthMaximum([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the maximum length rule for each die in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "MaxLengthRule: " & Format (comp.WireBondRulesLengthMaximum, 
"#.###") 
End If 
Next 
End Sub

unit [Optional] Unit in which the length value is returned.
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Component.WireBondRulesLengthMinimum
This property returns the bond wire minimum length rule of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

WireBondRulesLengthMinimum([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

This property generates an exception if Component.IsDiePart is False.

Sample

The following sample code retrieves the minimum length rule for each die in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
MsgBox "MinLengthRule: " & Format (comp.WireBondRulesLengthMinimum, 
"#.###") 
End If 
Next 
End Sub

unit [Optional] Unit in which the length value is returned.
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Component.Wirebonds
This property returns the bond wire collection of the die.

Restriction: This information applies to only the BGA toolkit.

Prototype

Wirebonds As Objects

Arguments

None

Comments

None

Sample

The following sample code iterates through all bond wires in each die component in the open 
design and prints the bond wire names. See “Running Code Samples” for more information on 
running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each nWB In comp.Wirebonds 
Debug.Print nWB.Name 
Next 
End If 
Next 
End Sub
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Connection.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an Application object and all Automation objects have an Application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.
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Connection.Length
This property returns the length of the connection.

Prototype

Length([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the length of the first connection found in the open design, 
assuming at least one connection exists. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set firstConn = ActiveDocument.Connections(1) 
MsgBox "Connection " & firstConn.Name & " has a length of " & 
firstConn.Net.Length 
End Sub

unit [Optional] Unit in which the length value is returned.
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Connection.Name
This property returns the name of the connection.

Prototype

Name As String

Arguments

None

Comments

This property is the default property for the Connection object.

Sample

The following sample code lists all connections in the open design by name and then places that 
list in a custom dialog box. When a connection is selected in the list box, the sample selects that 
connection.

This sample uses the UserDialog Editor in the Sax Basic Engine. See “Running Code Samples” 
for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListConns$(10000)
Sub Main
index = 0 
For Each nextConn In ActiveDocument.Connections 
ListConns$(index) = nextConn.Name 
index = index + 1 
Next nextConn 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Connections",.CallbackFunc ' 
%GRID:10,7,1,1 
ListBox 10,7,160,203,ListConns(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened 
' in the dialog; it is used to easily process user actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
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ActiveDocument.SelectObjects(ppcbObjectTypeConnection, 
ListConns(SuppValue%)) 
End If 
End Select 
End Function
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Connection.Net
This property returns the net connected to the connection.

Prototype

Net As Net

Arguments

None

Comments

None

Sample

The following sample code retrieves the net connected to the first connection found in the open 
design, assuming at least one connection exists. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set firstConn = ActiveDocument.Connections(1) 
MsgBox "Connection " & firstConn.Name & " is connected to net " & 
firstConn.Net.Name 
End Sub
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Connection.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypeConnection. 

All database objects in the PADS Layout Automation server implement this property to 
compensate for the lack of a Visual Basic equivalent for the Visual C++ QueryInterface 
function.

This property is generally used:

• To identify the kind of database objects in a heterogeneous Objects collection.

• When implementing a generic routine that depends on the type of the database object 
passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypeVia 
' Do something specific to via objects 
Case ppcbObjectTypeConnection 
' Do something specific to connection objects 
Case ppcbObjectTypeRouteSegment 
' Do something specific to route segment objects 
Case ppcbObjectTypeJumper 
' Do something specific to jumper objects 
Case Else 
MsgBox "Not a PADS Layout database object" 
End Select 
End Sub
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Connection.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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Connection.Pins
This property returns the collection of all pins in the connection.

Prototype

Pins As Objects 

Pins(name As String) As Pin 

Argument

Comments

When an existing pin name is passed to this property, it returns that Pin object. If the pin name 
does not exist, this property returns the collection of all pins of the connection in an Objects 
collection object.

Sample

The following sample code retrieves the number of pins in the first connection found in the 
open design, assuming at least one connection exists. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set firstConn = ActiveDocument.Connections(1) 
MsgBox "Connection " & firstConn.Name & " connects " & 
firstConn.Pins.Count & " pins." 
End Sub

name Name of an existing pin.
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Connection.RouteSegments
This property returns the collection of all trace segments in the connection.

Prototype

RouteSegments As Objects 

RouteSegments(name As String) As RouteSegment 

Argument

Comments

When an existing trace segment name is passed to this property, it returns that RouteSegment 
object. If the trace segment name does not exist, this property returns the collection of all route 
segments in the connection in an Objects collection object.

Sample

The following sample code retrieves the number of trace segments in the first connection found 
in the open design, assuming at least one connection exists. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set firstConn = ActiveDocument.Connections(1) 
MsgBox "Connection " & firstConn.Name & " includes " & 
firstConn.RouteSegments.Count & " route segments." 
End Sub

name Name of an existing trace segment.
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Connection.Selected
This property sets or returns whether the connection is selected.

Prototype

Selected As Boolean

Arguments

None

Comments

None

Sample

The following sample code selects the first connection found in the open design, assuming at 
least one connection exists. See “Running Code Samples” for more information on running this 
sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.Connections(1).Selected = True 
End Sub

See Also

Document.SelectionChange Event 
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Connection.Vias
This property returns the collection of all vias in the connection.

Prototype

Vias As Objects 

Vias(name As String) As Via 

Argument

Comments

When an existing via name is passed to this property, it returns that Via object. If the via name 
does not exist, this property returns the collection of all vias in the collection in an Objects 
collection object.

Sample

The following sample code retrieves the number of vias in the first connection found in the open 
design, assuming at least one connection exists. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set firstConn = ActiveDocument.Connections(1) 
MsgBox "Connection " & firstConn.Name & " includes " & 
firstConn.Vias.Count & " vias." 
End Sub

name Name of an existing via.
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Decal.Application
This property returns the application object.

Prototype

Application as Application

Argument

None
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Decal.Attributes
This property returns the Decals's collection of attributes.

Prototype

Attributes (name As String) As Attribute

Argument

name Name of an existing decal attribute.



PADS Layout User’s Guide and Reference Manual, PADS 9.41756

PADS Layout Automation Server
Decal.Components

Decal.Components
This property returns the collection of Components objects of this decal.

Prototype

Components (name As String) As Component

Argument

name Name of an existing component.
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Decal.LibraryTimeStamp
This property returns the Decal's library timestamp.

Prototype

TimeStamp as Date

Argument

None
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Decal.Name
This property returns the Decal's name.

Prototype

Name as String

Argument

None
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Decal.ObjectType
This property returns the type of this database object: a decal.

Prototype

ObjectType as PPcbObjectType

Argument

None



PADS Layout User’s Guide and Reference Manual, PADS 9.41760

PADS Layout Automation Server
Decal.Parent

Decal.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Argument

None
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Decal.Selected
This property sets or returns the Decal's selection status.

Prototype

Selected as Boolean

Argument

None
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Decal.TimeStamp
This property returns the Decal's timestamp.

Prototype

TimeStamp as Date

Argument

None
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Document.ActiveView
This property returns the active view.

Prototype

ActiveView As View 

Arguments

None

Comments

The active view represents the main view of the open design.

Sample

The following sample code pans the current view to the origin of the open design using the 
View.Pan method. See “Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ActiveView.Pan(0,0) 
End Sub
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Document.Application
This property returns the Application object.

Prototype

Application As Application 

Arguments

None

Comments

This property identifies the object as a PADS Layout Automation object. All Automation server 
applications have an Application object and all Automation objects have an Application 
property. This property is usually used in Automation client applications that handle large 
volumes of objects from different sources, such as different Automation server applications, to 
quickly identify the application to which the object belongs.
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Document.AssemblyOptions
This property returns the collection of all assembly options.

Prototype

AssemblyOptions As AssemblyOptions

AssemblyOptions(name As String) As Document

Argument

Comments

When an existing assembly option name is passed to this property, it returns that assembly 
option object, packaged as a Document object. If the Assembly Option name does not exist, this 
property returns the collection of all assembly options existing in the open design, packaged as 
an AssemblyOptions collection object.

The Document.Name property of an assembly option document is in the following format: 
Assembly Option Name:PCB Design File Name, for example WithoutU1:PWRDEMOA.PCB. 

Tip: Assembly options are always packaged as Document objects.

Sample 1

The following sample code retrieves the number of assembly options in the open design using 
the AssemblyOptions.Count property. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set assopts = ActiveDocument.AssemblyOptions 
MsgBox "There are " & assopts.Count & " assembly option(s) in " & 
ActiveDocument.Name 
End Sub

Sample 2

The following sample code retrieves the number of uninstalled and substituted components in 
the assembly option named MyAssOpt, assuming it exists in the open design, using the 
Component.Installed and Component.Substituted properties. See “Running Code Samples” for 
more information on running this sample.

Sub Main
nbUninstalled = 0 
nbSubstituted = 0 
For Each nextComp In ActiveDocument.AssemblyOptions("MyAssOpt") 
If nextComp.Installed = False Then nbUninstalled = nbUninstalled + 1 
If nextComp.Substituted = True Then nbSubstituted = nbSubstituted + 1 
Next nextComp 

name Name of an existing assembly option.
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MsgBox "There are " & nbUninstalled & " uninstalled and " & nbSubstituted 
& " substituted components in assembly option MyAssOpt." 
End Sub
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Document.AssociatedNets
This property returns the collection of all associated nets.

Prototype

AssociatedNets as Objects
AssociatedNets (name as String) as AssociatedNet

Arguments

Name   Optional
            Name of an existing associated net

Return Values

When an existing associated net name is passed to this property, it returns the associated net 
object with that name. If the associated net name is not specified, this property returns the 
collection of all associated nets in Objects.
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Document.Attributes
This property returns the collection of all attributes of the document.

Prototype

Attributes As Attributes 

Attributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that document Attribute 
object. If the attribute name does not exist, this property returns the collection of all document 
attributes in an Attributes collection object.

Sample 1

The following sample code retrieves the number of document attributes in the open design 
using the Attributes.Count property. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set attrs = ActiveDocument.Attributes 
MsgBox "There are " & attrs.Count & " document attribute(s) in " & 
ActiveDocument.Name 
End Sub

Sample 2

The following sample code retrieves the value of the document attribute DEADLINE, assuming 
it exists in the open design, using the Attribute.Value property. See “Running Code Samples” 
for more information on running this sample.

Sub Main
MsgBox "DEADLINE = " & ActiveDocument.Attributes("DEADLINE").Value 
End Sub

name Name of an existing document attribute.
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Document.BoardOutlineSurface
This property returns the surface of the document board outline.

Prototype

BoardOutlineSurface([unit As PPcbUnit]) As Double

Argument

Comments

The board outline surface is calculated disregarding board outline cut outs or holes.

Sample

The following sample code retrieves the board outline surface of the open design. See “Running 
Code Samples” for more information on running this sample.

Function UnitName(unit As Long) As String
Select Case unit 
Case ppcbUnitMils 
UnitName = "mils" 
Case ppcbUnitInch 
UnitName = "inches" 
Case ppcbUnitMetric 
UnitName = "mm" 
Case Else 
UnitName = "unknown" 
End Select 
End Function

Sub Main
MsgBox "The board outline surface is " & 
ActiveDocument.BoardOutlineSurface & " square " & 
UnitName(ActiveDocument.unit) 
End Sub

unit [Optional] Unit in which the board outline surface value is returned.
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Document.Components
This property returns the collection of all components.

Prototype

Components As Objects 

Components(name As String) As Component 

Argument

Comments

When an existing component name is passed to this property, it returns that Component object. 
If the component name does not exist, this property returns the collection of all components in 
an Objects collection object.

Sample 1

The following sample code retrieves the number of components in the open design using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set comps = ActiveDocument.Components 
MsgBox "There are " & comps.Count & " component(s) in " & 
ActiveDocument.Name 
End Sub

Sample 2

The following sample code retrieves the number of pins in component U1, assuming it exists in 
the open design, using the Component.Pins and Objects.Count properties. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set compU1 = ActiveDocument.Components("U1") 
MsgBox "Component " & compU1.Name & " has " & compU1.Pins.Count & " 
pin(s)." 
End Sub

See Also

Document.GetObjects 

name Name of an existing component.



PADS Layout Automation Server
Document.Connections

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1771

Document.Connections
This property returns the collection of all connections.

Prototype

Connections As Objects

Connections(name As String) As Connection 

Argument

Comments

When an existing connection name is passed to this property, it returns that Connection object. 
If the connection name does not exist, this property returns the collection of all connections in 
an Objects collection object.

Sample 1

The following sample code retrieves the number of connections in the open design using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set conns = ActiveDocument.Connections 
MsgBox "There are " & conns.Count & " connection(s) in " & 
ActiveDocument.Name 
End Sub

Sample 2

The following sample code retrieves the sum of the length (routed and unrouted) of all 
connections in the open design using the Connection.Length property. See “Running Code 
Samples” for more information on running this sample.

Sub Main
totalLength = 0.0 
For Each nextConn In ActiveDocument.Connections 
totalLength = totalLength + nextConn.Length 
Next nextConn 
MsgBox "The sum of all connection length of " & ActiveDocument.Name & " is 
" & totalLength 
End Sub

See Also

Document.GetObjects 

name Name of an existing connection.
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Document.Drawings
This property returns the collection of drawings in the document or a specific drawing.

Prototype

Drawings as Collection

Drawings (Name as String) as Drawing

Argument

Comments

None

Sample

See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "Number of Drawings: " & ActiveDocument.Drawings.Count 
End Sub

name Name of the drawing to retrieve (optional).
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Document.ElectricalLayerCount
This property returns the number of electrical layers in the design.

Prototype

ElectricalLayerCount as Boolean

Arguments

None

Comments

None

Sample

This sample shows the number of electrical layers in the design. See “Running Code Samples” 
for more information on running this sample.

Sub Main
MsgBox "El. layer count: " & ActiveDocument.ElectricalLayerCount 
End Sub
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Document.Errors
This property returns the number of electrical layers in the design.

Prototype

Errors as Objects

Errors (errorNumber as Integer) as Error

ArgumentsArguments

Comments

When the error number is passed to this property, it returns that Error Object. If the number is 
not specified, this property returns the collection of all errors in an Objects collection object.

errorNumber error number
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Document.FullName
This property returns the file name of the document, including its path.

Prototype

FullName As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the name and location of the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
MsgBox "Hi, you are using " & ActiveDocument.FullName & " located in " & 
ActiveDocument.Path 
End Sub

See Also

Document.Name, Document.Path
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Document.GridX
This property sets or returns the X grid of the document.

Prototype

GridX([type As PPcbGridType = ppcbGridDesign], [unit As PPcbUnit]) As Double

Arguments

Comments

None

Sample

The following sample code sets the display grid of the open design to the same value as the 
routing grid. See “Running Code Samples” for more information on running this sample.

Sub Main
curGridX = ActiveDocument.GridX 
curGridY = ActiveDocument.GridY 
ActiveDocument.GridX(ppcbGridDisplay) = curGridX 
ActiveDocument.GridY(ppcbGridDisplay) = curGridY 
End Sub

See Also

Document.GridY

type [Optional] Type of grid to set or return.

unit [Optional] Unit in which the grid value is set or returned.
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Document.GridY
This property sets or returns the Y grid of the document.

Prototype

GridY([type As PPcbGridType = ppcbGridDesign], [unit As PPcbUnit]) As Double

Arguments

Comments

None

Sample

The following sample code sets the display grid of the open design to the same value as the 
routing grid. See “Running Code Samples” for more information on running this sample.

Sub Main
curGridX = ActiveDocument.GridX 
curGridY = ActiveDocument.GridY 
ActiveDocument.GridX(ppcbGridDisplay) = curGridX 
ActiveDocument.GridY(ppcbGridDisplay) = curGridY 
End Sub

See Also

Document.GridX

type [Optional] Type of grid to set or return.

unit [Optional] Unit in which the grid value is set or returned.
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Document.Jumpers
This property returns the collection of all jumpers.

Prototype

Jumpers As Objects 

Jumpers(name As String) As Jumper 

Argument

Comments

When an existing jumper name is passed to this property, it returns that Jumper object. If the 
jumper name does not exist, this property returns the collection of all jumpers in an Objects 
collection object.

Sample 1

The following sample code retrieves the number of jumpers in the open design using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set jmps = ActiveDocument.Jumpers 
MsgBox "There are " & jmps.Count & " jumpers(s) in " & 
ActiveDocument.Name 
End Sub

Sample 2

The following sample code retrieves the sum of the length of all jumpers in the open design 
using the Jumper.Length property. See “Running Code Samples” for more information on 
running this sample.

Sub Main
totalLength = 0.0 
For Each nextJmp In ActiveDocument.Jumpers 
totalLength = totalLength + nextJmp.Length 
Next nextJmp 
MsgBox "The sum of all jumper length of " & ActiveDocument.Name & " is " & 
totalLength 
End Sub

See Also

Document.GetObjects 

name Name of an existing jumper.
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Document.LayerCount
This property returns the total number of layers in the document.

Prototype

LayerCount As Long

Arguments

None

Comments

Layer 0 is not considered a valid layer in the Automation server.

Sample

The following sample code retrieves the total number of layers in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
MsgBox ActiveDocument.LayerCount & " layers in this PCB design." 
End Sub

See Also

Document.LayerType
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Document.LayerEnabled
This property returns the enabled status of a layer.

Prototype

LayerEnabled(layer as Long) as Boolean

Argument

Comments

None

Sample

This sample shows the enabled status of layer 17 in the design. See “Running Code Samples” 
for more information on running this sample.

Sub Main
MsgBox "Is layer 17 enabled? " & ActiveDocument.LayerEnabled(17) 
End Sub

name Number of layer (required).
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Document.LayerName
This property returns the layer name of a layer number.

Prototype

LayerName(layer As Long) As String

Argument

Comments

Layer 0 is not considered a valid layer in the Automation server.

This property generates an exception if the layer argument is not a valid layer number.

Sample

The following sample code retrieves the name of layer 2 in the open design. See “Running Code 
Samples” for more information on running this sample.

Sub Main
MsgBox ActiveDocument.LayerName(2) & " is layer 2." 
End Sub

layer Layer
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Document.Layers
This property returns the collection of all layers in the design.

Prototype

Layers as Objects

Layers(layerNumber as Integer) as Layer

Layers(layerName as String) as Layer

Argument

Return Values

When a layer number/name is passed to this property, it returns that Layer Object. If the 
number/name is not specified, this property returns the collection of all layers in an Objects 
collection object.

Sample

doc = Application.ActiveDocument

msg = ""
For Each layer In doc.Layers

  msg = msg & layer.Number & ", " & layer.Name & ", " 
            & layer.Type & ", " & layer.PlaneType & ", " 
            & layer.RoutingDirection & ", " & layer.Visible & ", " 
            & layer.Enabled & ", " 
            & layer.GetColor(ppcbLayerColorPad) & ", " 
            & layer.CopperThickness & ", " 
            & layer.GetDielectricThickness(ppcbDielectricLayerAbove) 
            & ", "
            & layer.GetDielectricConstant(ppcbDielectricLayerBelow)
  msg = msg & chr(13)

Next layer

MsgBox msg

layer = doc.Layers(1)
curr_pad_color = layer.GetColor(ppcbLayerColorPad)
layer.SetColor(ppcbLayerColorPad, 10)

MsgBox "Press any key"

layer.Visible = false

MsgBox "Press any key"

layerNumber Number of the layer

layerName Name of the layer
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layer.Visible = true

MsgBox "Press any key"

layer.SetColor(ppcbLayerColorPad, curr_pad_color)
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Document.LayerType
This property returns the type of a given layer number.

Prototype

LayerType(layer As Long) As PPcbLayerType 

Argument

Comments

Layer 0 is not considered a valid layer in the Automation server.

This property generates an exception if the layer argument is not a valid layer number.

Sample

The following sample code retrieves the type of layer 2 in the open design. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Dim strType As String
Select Case ActiveDocument.LayerType(2) 
Case ppcbLayerComponent 
strType = "Component layer" 
Case ppcbLayerRouting 
strType = "Routing layer" 
Case ppcbLayerDrill 
strType = "Drill layer" 
Case ppcbLayerSilkscreen 
strType = "Silkscreen layer" 
Case ppcbLayerPasteMask 
strType = "Paste mask layer" 
Case ppcbLayerSolderMask 
strType = "Solder mask layer" 
Case ppcbLayerAssembly 
strType = "Assembly layer" 
Case ppcbLayerGeneral 
strType = "General layer" 
Case Else 
strType = "Unknown layer type" 
End Select 
MsgBox "Layer 2 is a " & strType 
End Sub

See Also

Document.LayerCount

layer Layer
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Document.MaxRealValue
This property Returns the maximum real value in the system.

Prototype

MaxRealValue as double

Arguments

None
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Document.MinRealValue
This property Returns the minimum real value in the system.

Prototype

MinRealValue as double

Arguments

None
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Document.Name
This property returns the name of the document. For example, if the current design file is 
\PADS Projects\Samples\pwrdemoa.pcb, this function returns the string “pwrdemoa.pcb”.

Prototype

Name As String

Arguments

None

Comments

This property is the default property for the Document object.

Sample

The following sample code retrieves the name and location of the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
MsgBox "Hi, you are using " & ActiveDocument.Name & " located in " & 
ActiveDocument.Path 
End Sub

See Also

Document.FullName, Document.Path
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Document.NetClasses
This property returns the collection of net classes in the document or in a specific net class.

Prototype

NetClasses as Collection

NetClasses (Name as String) as NetClass

Argument

Comments

None

Sample

This sample shows the total number of net classes in the design. See “Running Code Samples” 
for more information on running this sample.

Sub Main
MsgBox "Number of Net Classes: " & ActiveDocument.NetClasses.Count 
End Sub

name Name of the net class to retrieve.
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Document.Nets
This property returns the collection of all nets.

Prototype

Nets As Objects  

Nets(name As String) As Net 

Argument

Comments

When an existing net name is passed to this property, it returns that Net object. If the net name 
does not exist, this property returns the collection of all nets in an Objects collection object.

Sample 1

The following sample code retrieves the number of nets in the open design using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set nets = ActiveDocument.Nets 
MsgBox "There are " & nets.Count & " net(s) in " & ActiveDocument.Name 
End Sub

Sample 2

The following sample code retrieves the number of pins connected to net VCC, assuming it 
exists in the open design, using the Net.Pins and Objects.Count properties. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set netVCC = ActiveDocument.Nets("VCC") 
MsgBox "Net " & netVCC.Name & " connects " & netVCC.Pins.Count & " 
pin(s)." 
End Sub

See Also

Document.GetObjects 

name Name of an existing net.
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Document.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None



PADS Layout Automation Server
Document.OriginX

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1791

Document.OriginX
This property returns the x origin of the document.

Prototype

OriginX([unit As PPcbUnit]) As Double

Argument

Comments

If the unit passed as an argument is different from the server database unit type, the return value 
is 0.0. The origin of the document in mils, millimeters, or inches is 0.0 by definition.

Sample

The following sample code retrieves the origin of the open design. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set doc = ActiveDocument 
MsgBox "Origin = (" & doc.OriginX(ppcbUnitDatabase) & ", " & 
doc.OriginY(ppcbUnitDatabase) & ")" 
End Sub

See Also

Document.OriginY

unit [Optional] Unit in which the x origin is returned.
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Document.OriginY
This property returns the y origin of the document.

Prototype

OriginY([unit As PPcbUnit]) As Double

Argument

Comments

If the unit passed as an argument is different from the server database unit type, the return value 
is 0.0. The origin of the document in mils, millimeters, or inches is 0.0 by definition.

Sample

The following sample code retrieves the origin of the open design. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set doc = ActiveDocument 
MsgBox "Origin = (" & doc.OriginX(ppcbUnitDatabase) & ", " & 
doc.OriginY(ppcbUnitDatabase) & ")" 
End Sub

See Also

Document.OriginX

unit [Optional] Unit in which the y origin is returned.
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Document.Parent
This property returns the parent of the object.

Prototype

Parent As Application 

Arguments

None

Comments

None
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Document.PartTypes
This property returns the collection of all part types.

Prototype

PartTypes As Objects  

PartTypes(name As String) As PartType 

Argument

Comments

When an existing part type name is passed to this property, it returns that PartType object. 
Otherwise, this property returns the collection of all part types in an Objects collection object.

Sample

The following sample code retrieves the number of part types in the open schematic using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set pkgs = ActiveDocument.PartTypes 
MsgBox "There are " & pkgs.Count & " part type(s) in " & 
ActiveDocument.Name 
End Sub

See Also

Document.GetObjects 

name Name of an existing part type.
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Document.Path
This property returns the path of the document.

Prototype

Path As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the name and path of the open design. See “Running Code 
Samples” for more information on running this sample.

Sub Main
MsgBox "Hi, you are using " & ActiveDocument.Name & " located in " & 
ActiveDocument.Path 
End Sub

See Also

Document.FullName, Document.Name
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Document.Pins
This property returns the collection of all pins.

Prototype

Pins As Objects  

Pins(name As String) As Pin 

Argument

Comments

When an existing pin name is passed to this property, it returns that Pin object. If the pin name 
does not exist, this property returns the collection of all pins in an Objects collection object.

Sample 1

The following sample code retrieves the number of pins in the open design using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set pins = ActiveDocument.Pins 
MsgBox "There are " & pins.Count & " pin(s) in " & ActiveDocument.Name 
End Sub

Sample 2

The following sample code retrieves the drill size of pin U1.1, assuming it exists in the open 
design, using the Pin.DrillSize property. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set pinU1_1= ActiveDocument.Pins("U1.1") 
MsgBox "Pin " & pinU1_1.Name & "'s drill size is " & pinU1_1.DrillSize 
End Sub

See Also

Document.GetObjects 

name Name of an existing pin.
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Document.Preference
This property sets or returns a document preference.

Prototype

Preference(name As String) AsVariant 

Argument

Comments

The following are possible name argument values:

This property generates an exception if the name argument is not a valid document preference.

Sample

The following sample code demonstrates how to use this property. See “Running Code 
Samples” for more information on running this sample.

Sub Main
' Set the DRC mode to "Prevent" 
ActiveDocument.Preference("DRC") = ppcbDRCPrevent 
' Set the Nudge mode to "Automatic" 
ActiveDocument.Preference("Nudge") = ppcbNudgeAuto 
End Sub

name Name of the preference.

DRC Sets or returns the DRC mode of the open design. The DRC 
mode values are of type PPcbDRCMode.

Nudge Sets or returns the Nudge mode of the open design. The Nudge 
mode values are of type PPcbNudgeMode.

ModifyUnionMember Sets or returns the ability (True/False) to move an individual 
component when that component belongs to a union.
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Document.RouteSegments
This property returns the collection of all trace segments.

Prototype

RouteSegments As Objects  

RouteSegments(name As String) As RouteSegment 

Argument

When an existing trace segment name is passed to this property, it returns that RouteSegment or 
Net. If the trace segment name does not exist, this property returns the collection of all trace 
segments in an Objects collection object.

Comments

None

Sample

The following sample code retrieves the number of trace segments in the open design using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set rtesegs = ActiveDocument.RouteSegments 
MsgBox "There are " & rtesegs.Count & " route segment(s) in " & 
ActiveDocument.Name 
End Sub

See Also

Document.GetObjects 

name Name of an existing trace segment.
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Document.Saved
This property sets or returns whether the document is saved.

Prototype

Saved As Boolean

Arguments

None

Comments

This property is usually used before opening a new design, using the 
Application.OpenDocument Method method, to ensure that the message Save old file before 
reloading? does not appear.

Sample

The following sample code sets the saved status of the open design to True and then opens 
PWRDEMOA.PCB, assuming that it exists in the folder specified by the 
Application.DefaultFilePath property. It then retrieves the name of the opened design file. See 
“Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.Saved = True 
OpenDocument(DefaultFilePath & "\PWRDEMOA.PCB") 
MsgBox ActiveDocument.FullName & " has just been opened." 
End Sub

See Also

Document.Save Method, Document.SaveAs
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Document.Texts
This property returns the collection of free texts in the document.

Prototype

Texts as Collection

Texts (Name as String) as Text

Argument

Comments

None

Sample

This sample shows the total number of texts in the design. See “Running Code Samples” for 
more information on running this sample.

Sub Main
MsgBox "Number of Texts: " & ActiveDocument.Texts.Count 
End Sub

name Name of the text to retrieve (optional).
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Document.Unit
This property sets or returns the system unit used in the document.

Prototype

Unit As PPcbUnit 

Arguments

None

Sample

The following sample code sets the unit in the open design to metric. See “Running Code 
Samples” for more information on running this sample.

Sub Main
ActiveDocument.Unit = ppcbUnitMetric 
End Sub
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Document.Vias
This property returns the collection of all vias.

Prototype

Vias As Objects  

Vias(name As String) As Via 

Argument

Comments

When an existing via name is passed to this property, it returns that Via object. If the via name 
does not exist, this property returns the collection of all vias in an Objects collection object.

Sample

The following sample code retrieves the number of vias in the open design using the 
Objects.Count property. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set vias = ActiveDocument.Vias 
MsgBox "There are " & vias.Count & " via(s) in " & ActiveDocument.Name 
End Sub

See Also

Document.GetObjects 

name Name of an existing via.
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Drawing.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.

Sample

Not required.
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Drawing.DrawingType
This property returns the type of the open drawing.

Prototype

DrawingType as PPcbDrawingType 

Arguments

None

Comments

None

Sample

The following sample function displays the name and type of the drawing. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,, TRUE) 
For Each drw In selected 
Select Case drw.DrawingType 
Case ppcbDrw2Dline 
Msgbox "Type: 2D Line" 
Case ppcbDrwBoard 
Msgbox "Type: Board Outline" 
Case ppcbDrwCopper 
Msgbox "Type: Copper" 
Case ppcbDrwCopperPour
Msgbox "Type: CopperPour" 
Case ppcbDrwCopperHatch
Msgbox "Type: CopperHatch" 
Case ppcbDrwCopperThermal 
Msgbox "Type: CopperThermal" 
Case ppcbDrwKeepout 
Msgbox "Type: Keepout" 
End Select 
Next drw 
End Sub
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Drawing.Geometry
This property returns a collection of objects, currently polylines, text, or circles, representing 
the geometry of the drawing.

Prototype

Geometry as Collection

Arguments

None

Comments

None

Sample

The following sample shows the number of polylines in the selected drawing. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
I = 0 
Dim geom as Object 
For Each geom in drw.Geometry 
If geom.ObjectType = ppcbObjectTypePolyline Then I = I + 1 
Next geom 
MsgBox "Drawing contains " & I & " polylines" 
Exit For 
Next drw 
End Sub
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Drawing.Name
This default property returns the name of the drawing.

Prototype

Name as String

Arguments

None

Comments

None

Sample

The following example displays a message box showing the name of the first drawing in the 
active document. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each drw In ActiveDocument.Drawings 
MsgBox "The first drawing's name is " & drw.Name 
Exit For 
Next drw 
End Sub
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Drawing.Net
This property returns a net with which the drawing is associated.

Prototype

Net as Net

Arguments

None

Comments

None

Sample

The following sample function displays the name of the parent object in the selected drawing. 
See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
If drw.Net Is Nothing Then 
Msgbox "No Net" 
Else 
Msgbox "Net: " & drw.Net.Name 
End If 
Next drw 
End Sub
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Drawing.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following example shows the number of selected drawings. See “Running Code Samples” 
for more information on running this sample.

Sub Main
Set sel = ActiveDocument.GetObjects(,,TRUE) 
n = 0 
For Each obj In sel 
If obj.ObjectType = ppcbObjectTypeDrawing Then n = n + 1 
Next obj 
MsgBox n & " drawing(s) selected" 
End Sub
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Drawing.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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Drawing.PositionX
This property returns the X coordinate of the origin of the drawing.

Prototype

PositionX(Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Sample

The following sample function displays selected drawing positions. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing, ,TRUE) 
For Each drw In selected 
Msgbox "Position: (" & drw.PositionX & ", " & drw.PositionY & ") "
Next drw
End Sub

unit [Optional] Unit in which the result is to be expressed. This optional 
argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Drawing.PositionY
This property returns the Y coordinate of the origin of the drawing.

Prototype

PositionY(Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Sample

The following sample function displays the positions of the selected drawing objects. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing, ,TRUE) 
For Each drw In selected 
Msgbox "Position: (" & drw.PositionX & ", " & drw.Position.Y & ") "
Next drw
End Sub

unit [Optional] Unit in which the result is to be expressed. This optional 
argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Drawing.Selected
This property sets or returns whether the component is selected.

Prototype

Selected as Boolean

Arguments

None

Comments

None

Sample

The following sample function displays a message showing whether or not the first drawing is 
selected. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each drw In ActiveDocument.Drawings 
Msgbox "Is Drawing " & drw.Name & " selected? " & drw.Selected 
Exit For 
Next drw 
End Sub
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Drawing.Texts
This property returns a collection of text objects associated with the drawing, or a specific text 
object, referenced by its name.

Prototype

Texts as Collection

Texts (Name as String) as Text

Argument

Comments

None

Sample

The following sample function returns the number of texts associated with the selected drawing. 
See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
MsgBox "Number of associated texts: " & drw.Texts.Count 
Next drw 
End Sub

name Text object name.
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Error.ActualValue
This property returns the actual value of the Error Object.

Prototype

Conflicts as Objects

Conflicts(conflictNumber as Integer) as ErrorConflict

Arguments

Sample

The following sample code displays information about all of the errors’ actual value in PADS 
Layout. See “Running Code Samples” for more information on running this sample.

' Display information about all errors' actual value in Layout
doc = Application.ActiveDocument
MsgBox "Total number of errors: " & doc.Errors.Count

For Each theErr In doc.Errors
' Error actual value information text
info = "Actual value N/A"
If theErr.HasActualValue Then

info = " Actual value: " & theErr.ActualValue
info = info & " [default unit]; "
If (theErr.ValueType = ppcbErrorValueTypeMeasure) Then

info = info & theErr.ActualValue(ppcbUnitCurrent)
info = info & " [current unit]; "
info = info & theErr.ActualValue(ppcbUnitDatabase)
info = info & " [database unit]; "
info = info & theErr.ActualValue(ppcbUnitMils) 
info = info & " [mils]; " 
info = info & theErr.ActualValue(ppcbUnitInch) 
info = info & " [inch]; " 
info = info & theErr.ActualValue(ppcbUnitMetric) 
info = info & " [millimeter]"

End If
End If
MsgBox info
' Next error

Next

unit [Optional] Unit in which the actual value is returned.
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Error.Application
This property returns the Application object.

Prototype

Application as Application

Arguments

None
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Error.Conflicts
This property returns the collection of all error conflicts in the Error Object.

Prototype

Conflicts as Objects

Conflicts(conflictNumber as Integer) as ErrorConflict

Arguments

Comments

When the conflict number is passed to this property, it returns that ErrorConflict Object. If the 
number is not specified, this property returns the collection of all error conflicts in an Objects 
collection object.

conflictNumber Conflict number
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Error.Description
This property returns the description of the Error Object.

Prototype

Description as String

Arguments

None
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Error.ErrorClass
This property returns the error class of the Error Object.

Prototype

ErrorClass as PPcbErrorClass

Arguments

None
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Error.ErrorType
This property returns the error type of the Error Object.

Prototype

ErrorType as PPcbErrorType

Arguments

None
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Error.HasActualValue
This property returns if the actual value of the Error Object exists.

Prototype

HasActualValue as Boolean

Arguments

None
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Error.HasRequiredValue
This property returns if the required value of the Error Object exists.

Prototype

HasRequiredValue as Boolean

Arguments

None
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Error.IsClearanceError
This property returns if the error is a clearance error.

Prototype

IsClearanceError as Boolean

Arguments

None
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Error.IsConnectivityError
This property returns if the error is a connectivity error.

Prototype

IsConnectivityError as Boolean

Arguments

None
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Error.IsHighSpeedError
This property returns if the error is a high speed error.

Prototype

IsHighSpeedError as Boolean

Arguments

None
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Error.IsIgnoredFlag
This property returns if the error is flagged as ignored.

Prototype

IsIgnoredFlag as Boolean

Arguments

None
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Error.IsInvisibleFlag
This property returns if the error is flagged as invisible.

Prototype

IsInvisibleFlag as Boolean

Arguments

None
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Error.IsLatiumError
This property returns if the error is a latium error.

Prototype

IsLatiumError as Boolean

Arguments

None
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Error.IsMiscError
This property returns if the error is a miscellaneous error.

Prototype

IsMiscError as Boolean

Arguments

None
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Error.IsTestPointError
This property returns if the error is a Test Point error.

Prototype

IsTestPointError as Boolean

Arguments

None
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Error.LayerNumber
This property returns the layer number of this Error Object.

Prototype

LayerNumber as int

Arguments

None
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Error.Name
This property returns the name of this error.

Prototype

Name As String

Arguments

None
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Error.ObjectType
This property returns the type of this object - ppcbObjectTypeError.

Prototype

ObjectType as PPcbObjectType

Arguments

None
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Error.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None
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Error.PositionX
This property returns the X-coordinate of the Error Object.

Prototype

PositionX as Double

PositionX(unit as PPcbUnit) as Double

Arguments

unit [Optional Argument] Unit in which the X-coordinate is returned.
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Error.PositionY
This property returns the Y-coordinate of the Error Object.

Prototype

PositionY as Double

PositionY(unit as PPcbUnit) as Double

Arguments

unit [Optional Argument] Unit in which the Y-coordinate is returned.
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Error.RequiredValueMax
Returns the required maximum value of the Error Object. If this value equals the maximum real 
value (see Document.MaxRealValue) it means infinity.

Prototype

RequiredValueMax as Double

RequiredValueMax (unit as PPcbUnit) as Double

Arguments

unit [Optional Argument] Unit in which the required maximum value is 
returned.



PADS Layout Automation Server
Error.RequiredValueMin

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1837

Error.RequiredValueMin
Returns the required minimum value of the Error Object. If this value equals the minimum real 
value (see Document.MinRealValue) it means minus infinity.

Prototype

RequiredValueMin as Double

RequiredValueMin (unit as PPcbUnit) as Double

Arguments

unit [Optional Argument] Unit in which the required minimum value is 
returned.



PADS Layout User’s Guide and Reference Manual, PADS 9.41838

PADS Layout Automation Server
ErrorConflict.Application

ErrorConflict.Application
This property returns the Application object.

Prototype

Application as Application

Arguments

None
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ErrorConflict.ConflictObject
Returns the conflicting object.

Prototype

ConflictObject as Object

Argument

None



PADS Layout User’s Guide and Reference Manual, PADS 9.41840

PADS Layout Automation Server
ErrorConflict.ConflictObjectDesc

ErrorConflict.ConflictObjectDesc
Returns the description of the conflicting object.

Prototype

ConflictObjectDesc as String

Argument

None
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ErrorConflict.ConflictObjectType
Returns the type of the conflicting object.

Prototype

ConflictObjectType as PPcbObjectType

Argument

None



PADS Layout User’s Guide and Reference Manual, PADS 9.41842

PADS Layout Automation Server
ErrorConflict.Name

ErrorConflict.Name
This property returns the name of this error conflict.

Prototype

Name as String

Argument

None
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ErrorConflict.ObjectType
Returns the type of the object - ppcbObjectTypeErrorConflict.

Prototype

ObjectType as PPcbObjectType

Argument

None
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ErrorConflict.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Arguments

None
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Jumper.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an automation object. All automation server applications 
have an application object and all automation objects have an application property. This 
property is usually used in automation client applications that handle large volumes of objects 
from different sources, such as different automation server applications, to quickly identify the 
application to which the object belongs.
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Jumper.Installed
This property sets or returns whether the component is installed in the current assembly option.

Prototype

Installed As Boolean

Arguments

None

Comments

This property is useful only when the parent of the component is an Assembly Option. If the 
parent of the component is not an Assembly Option, this property always returns True and 
cannot be set to a different value.

Sample

The following sample code creates a new Assembly Option named EmptyAssOpt in the open 
design, and then uninstalls all components in that newly created Assembly Option. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set newAssOpt = ActiveDocument.AssemblyOptions.Add("EmptyAssOpt") 
For Each nextComp In newAssOpt.Components 
nextComp.Installed = False 
Next nextComp 
End Sub
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Jumper.Length
This property returns the length of the jumper.

Prototype

Length([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the length of jumper JMP1, assuming it exists in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
Set jmp1 = ActiveDocument.Jumpers("JMP1") 
MsgBox "Jumper " & jmp1.name & " has a length of " & jmp1.Length 
End Sub

unit [Optional] Unit in which the length value is returned.
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Jumper.Name
This property returns the name of the jumper.

Prototype

Name As String

Arguments

None

Comments

This property is the default property for the Jumper object.

Sample

The following sample code lists all jumpers in the open design and then places that list in a 
custom dialog box. When a jumper is selected in the list box, the sample selects that jumper.

This sample uses the User Dialog Editor in the Sax Basic Engine in PADS Layout. See 
“Running Code Samples” for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListJmps$(10000)
Sub Main
index = 0
For Each nextJmp In ActiveDocument.Jumpers 
ListJmps$(index) = nextJmp.Name 
index = index + 1 
Next nextJmp 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Jumpers",.CallbackFunc ' %GRID:10,7,1,1 
ListBox 10,7,160,203,ListJmps(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened 
' in the dialog; it is used to easily process user actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
ActiveDocument.SelectObjects(ppcbObjectTypeJumper, ListJmps(SuppValue%)) 
End If 
End Select 
End Function
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Jumper.Net
This property returns the net connected to the jumper.

Prototype

Net As Net

Arguments

None

Comments

None

Sample

The following sample code identifies the net connected to jumper JMP1, assuming it exists in 
the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
Set jmp1 = ActiveDocument.Jumpers("JMP1") 
MsgBox "Jumper " & jmp1.name & " is connected to net " & jmp1.Net.Name 
End Sub
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Jumper.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypeJumper. 

All PADS Layout database objects in the PADS Layout Automation server implement this 
property to compensate for the lack of a Visual Basic equivalent for the Visual C++ 
QueryInterface function.

This property is generally used:

• To identify the kind of PADS Layout database objects in a heterogeneous Objects 
collection.

• When implementing a generic routine that depends on the type of the PADS Layout 
database object passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypeVia 
' Do something specific to via objects 
Case ppcbObjectTypeConnection 
' Do something specific to connection objects 
Case ppcbObjectTypeRouteSegment 
' Do something specific to route segment objects 
Case ppcbObjectTypeJumper 
' Do something specific to jumper objects 
Case Else 
MsgBox "Not a PADS Layout database object" 
End Select 
End Sub
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Jumper.Orientation
This property returns the orientation of the jumper.

Prototype

Orientation As Double

Arguments

None

Comments

None

Sample

The following sample code retrieves the orientation of jumper JMP1, assuming it exists in the 
open design. See “Running Code Samples” for more information on running this sample.

Sub Main
Set jmp1 = ActiveDocument.Jumpers("JMP1") 
MsgBox "Jumper " & jmp1.name & " has an orientation of " & 
jmp1.Orientation & " degrees." 
End Sub
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Jumper.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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Jumper.Points
This property returns the array of points defining the jumper.

Prototype

Points([unit As PPcbUnit]) AsVariant

Argument

Comments

None

unit [Optional] Unit in which the point 
coordinate values are returned.
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Jumper.Selected
This property sets or returns whether the jumper is selected.

Prototype

Selected As Boolean

Arguments

None

Comments

You can also select a PADS Layout database object using the Document.SelectObjects and 
Objects.Select methods.

Sample

The following sample code selects jumper JMP1, assuming it exists in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.Jumpers("JMP1").Selected = True 
End Sub

See Also

Document.SelectionChange Event 
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Label.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.

Sample

Not required.
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Label.Attribute
This property returns an attribute with which the label is associated.

Prototype

Attribute as Attributes

Arguments

None

Comments

None

Sample

The following sample routine displays the name of an attribute with which the label is 
associated, if any. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,,TRUE) 
For Each lab In selected 
If Not lab.Attribute Is Nothing Then 
MsgBox "The label is associated with attribute " & lab. Attribute.Name 
Else 
MsgBox "The label is not associated with any attribute" 
End If 
Next lab 
End Sub
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Label.Component
This property returns a component with which the label is associated.

Prototype

Component as Component

Arguments

None

Comments

None

Sample

The following sample routine displays the name of a component with which the selected label is 
associated, if any. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,,TRUE) 
For Each lab In selected 
If Not lab.Component Is Nothing Then
MsgBox "The label is associated with component " & lab.Component.Name
Else
MsgBox "The label is not associated with any component"
End If
Next lab
End Sub
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Label.Display
This property returns or sets the label display mode.

Prototype

Display as PPcbLabelDisplayMode 

Arguments

None

Comments

None

Sample

The following sample shows the display type of the selected label. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,,TRUE) 
For Each label In selected 
Select Case label.Display 
Case ppcbLabelDisplayNone  
MsgBox "Label shows nothing"
Case ppcbLabelDisplayValue
MsgBox "Label shows attribute value"
Case ppcbLabelDisplayNameAndValue
MsgBox "Label shows attribute name and value"
Case ppcbLabelDisplayFullNameAndValue 
MsgBox "Label shows attribute full name and value"
End Select 
Next label 
End Sub
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Label.Name
This default property returns the name of the Label object.

Prototype

Name as String

Arguments

None

Comments

None

Sample

The following example displays a message box showing the name of the selected label in the 
active document. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,,TRUE) 
For Each label In selected 
MsgBox "Selected label name: " & label.Name 
Next label 
End Sub
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Label.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following example shows the number of selected labels. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(,,TRUE) 
n = 0 
For Each obj In selected 
If obj.ObjectType = ppcbObjectTypeLabel Then n = n + 1 
Next obj 
MsgBox n & " label(s) selected" 
End Sub
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Label.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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Label.RightReading
This property returns or sets the right-to-left reading status of the label.

Prototype

RightReading as PPcbRightReadingStatus 

Arguments

None

Comments

None

Sample

This sample switches the selected label to Orthogonal Right-Reading mode. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,,TRUE) 
For Each lab In selected 
Select Case lab.RightReading  
Case ppcbRightReadingNone 
s = "None" 
Case ppcbRightReadingOrthogonal 
s = "Orthogonal" 
Case ppcbRightReadingAngled 
s = "Angled" 
End Select 
MsgBox "Selected label Right Reading mode: " & s 
lab.RightReading = ppcbRightReadingOrthogonal  
Next lab 
End Sub
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Label.Selected
This property sets or returns whether the Label object is selected.

Prototype

Selected as Boolean

Arguments

None

Comments

None

Sample

The following sample displays messages indicating whether the label is selected for all labels of 
the first component, then selects the labels. See “Running Code Samples” for more information 
on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
For Each label In comp.Labels 
Msgbox "Is Label " & label.Text & " selected ?" & label.Selected 
label.Selected = True 
Next label 
Exit For 
Next comp 
End Sub
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Label.Text
This property returns the displayed string for the Label object.

Prototype

Text as String

Arguments

None

Comments

None

Sample

This sample shows the text of the selected labels. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected 
MsgBox "Selected label: " & label.Text 
Next label 
End Sub
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Label.Type
This property returns the type of label.

Prototype

LabelType as PPcbLabelType 

Arguments

None

Comments

None

Sample

The following sample displays the type of the selected label. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,,TRUE) 
For Each label In selected 
Select Case label.LabelType 
Case ppcbLabelTypeRefDesignator 
MsgBox "Label type: Ref Designator" 
Case ppcbLabelTypePartType 
MsgBox "Label type: Part Type" 
Case ppcbLabelTypeAttribute 
MsgBox "Label type: Attribute" 
End Select 
Next label 
End Sub
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Layer.Application
This property returns the application object.

Prototype

Application as Application

Argument

None
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Layer.CopperThickness
This property sets or returns the layer copper thickness.

Prototype

CopperThickness (unit as PPcbUnit) as Double

Argument

unit [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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Layer.Enabled
This property sets or returns the layer enabled property.

Prototype

Enabled as Boolean

Argument

None
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Layer.Name
This property sets or returns the name of this layer.

Prototype

Name as String

Argument

None
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Layer.Number
This property returns the layer number.

Prototype

Number as Integer

Argument

None
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Layer.ObjectType
This property returns the type of the object - ppcbObjectTypeLayer.

Prototype

ObjectType as PPcbObjectType

Argument

None
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Layer.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Argument

None
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Layer.PlaneType
This property sets or returns the layer plane type.

Prototype

PlaneType as PPcbPlaneType

Argument

None
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Layer.RoutingDirection
This property sets or returns the layer routing direction.

Prototype

RoutingDirection as PPcbRoutingDirection

Argument

None
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Layer.Type
This property sets or returns the layer type.

Prototype

Type as PPcbLayerType

Argument

None



PADS Layout User’s Guide and Reference Manual, PADS 9.41876

PADS Layout Automation Server
Layer.Visible

Layer.Visible
This property sets or returns the layer visibility.

Prototype

Visible as Boolean

Argument

None
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Library.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.

Sample

Not required.
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Library.FullName
This property returns the full name of library files, including path and name.

Prototype

FullName As String

Arguments

None

Comments

None

Sample

The following example displays a message box showing the name of the first available library. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each lib In Libraries 
MsgBox "The full name of the first available library is " & lib.FullName 
Exit For 
Next lib 
End Sub
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Library.Name
This default property returns the name of the library.

Prototype

Name As String

Arguments

None

Comments

This is a Microsoft-required property.

Sample

The following example displays a message box showing the name of the first available library. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each lib In Libraries 
MsgBox "The name of the first available library is " & lib.Name 
Exit For 
Next lib 
End Sub
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Library.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following example tests the ObjectType property. See “Running Code Samples” for more 
information on running this sample.

Sub Main
For Each lib In Libraries 
If lib.ObjectType <> ppcbObjectTypeLibrary Then 
MsgBox "Test failed" 
End If 
Next lib  
End Sub
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Library.Parent
This property returns the parent of this object.

Prototype

Parent As Application

Arguments

None

Comments

This is a Microsoft-required property.
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Library.Path
This property returns the path to the library.

Prototype

Path As String

Arguments

None

Comments

None

Sample

The following example displays a message box showing the name of the first available library. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each lib In Libraries 
MsgBox "The path to the first available library is " & lib.Path 
Exit For 
Next lib 
End Sub
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LibraryItem.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.
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LibraryItem.Library
This property returns the library the library item belongs to.

Prototype

Library As Object

Arguments

None

Comments

None

Sample

The following sample code displays the name of the library an item belongs to. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set items = GetLibraryItems() 
For Each item In items 
MsgBox "The item " & item & " belongs to " & item.Library & " library" 
Exit For 
Next item  
End Sub
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LibraryItem.Name
This default property returns the name of the library item.

Prototype

Name As String

Arguments

None

Comments

This is a Microsoft-required property.

Sample

The following example displays a message box showing the name of the first item in the 
available libraries. See “Running Code Samples” for more information on running this sample.

Sub Main
Set items = GetLibraryItems() 
For Each item In items 
MsgBox "The first item name is " & item.Name 
Exit For 
Next item  
End Sub
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LibraryItem.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following example tests the ObjectType property. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set items = GetLibraryItems() 
For Each item In items 
If item.ObjectType <> ppcbObjectTypeLibraryItem Then 
MsgBox "Test failed" 
End If 
Next item  
End Sub 
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LibraryItem.Parent
This property returns the parent of this object.

Prototype

Parent As Application

Arguments

None

Comments

This is a Microsoft-required property. The parent property of a LibraryItem object always 
returns the application.



PADS Layout User’s Guide and Reference Manual, PADS 9.41888

PADS Layout Automation Server
LibraryItem.Type

LibraryItem.Type
This property returns the type of the library item object.

Prototype

Type as PPcbLibraryItemType 

Arguments

None

Comments

None

Sample

This sample displays the type of a library item. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set items = GetLibraryItems() 
For Each item In items 
Select Case item.Type 
Case ppcbLibraryItemTypePartType 
MsgBox "Item type: PartType" 
Case ppcbLibraryItemType 
MsgBox "Item type: Decal" 
Case ppcbLibraryItemType 
MsgBox "Item type: LogicDrawing" 
Case ppcbLibraryItemType 
MsgBox "Item type: Drawing" 
End Select 
Exit For 
Next item  
End Sub
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Measure.Application
This property returns the Measure object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an automation object. All automation server applications 
have an application object and all automation objects have an application property. This 
property is usually used in large automation client applications that handle large volumes of 
objects from different sources, such as different automation server applications, to quickly 
identify the application to which the object belongs.



PADS Layout User’s Guide and Reference Manual, PADS 9.41890

PADS Layout Automation Server
Measure.Name

Measure.Name
This property returns the name of the quantity represented by the measure. For example 
“Capacitance” for measure “10pF”, “Voltage” for “5V”.

Prototype

Name As String

Arguments

None

Sample 1

The following sample code retrieves the quantity name of “10pF” measure (the Capacitance). 
See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox Measure("10pF").Quantity ' displays Capacitance 
End Sub

Sample 2

The following sample code retrieves the quantity name of “10k” measure (the Resistance).

Sub Main
MsgBox Measure("10k").Name ' displays Resistance 
End Sub 

Sample 3

The following sample code retrieves the quantity name of “12V” measure (the Voltage).

Sub Main
MsgBox Measure("12V").Name ' displays Voltage
End Sub

See Also

Measure.Value
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Measure.Number
This property returns the number to combine with a prefix and unit.

Prototype

Number As Double

Arguments

None

Comments

This property returns the left numeric part of the measurement. You can format this number 
before output using standard methods available in the programming language you use for 
creating a client. Use this property with Measure.Prefix and Measure.Unit.

Sample

The following sample code retrieves a formatted measurement (to a hundredth of a decimal 
point) using standard Basic formatting. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set Cap = Measure (1.12345e-12, "F")  
MsgBox Format(Cap.Number, "#.###") & Cap.Prefix & Cap.Unit 
End Sub

See Also

Measure.Unit, Measure.Prefix
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Measure.Normalize
This property normalizes the text value of the measure and returns a new text.

Prototype

Normalize As String

Arguments

None

Comments

This property selects the appropriate unit prefix and appends a unit if it is missing. For example, 
it converts a time measurement from “5e-9” to “5ns.”

Sample

The following sample code normalizes a capacitance measure. See “Running Code Samples” 
for more information on running this sample.

Sub Main
Set Cap = Measure(2e-10, "F") 
MsgBox Cap.Normalize ' shows 200pF  
End Sub

See Also

Measure.Text
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Measure.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None
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Measure.Parent
This property returns the PADS Layout Application object.

Prototype

Parent As Application

Arguments

None

Comments

None 
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Measure.Prefix
This property returns the unit prefix to combine with a number and unit.

Prototype

Prefix([format As PPcbMeasureFormat = ppcbMeasureFormatStandard]) As String

Argument

Comments

This property returns the prefix currently used in the measurement. Use this property with 
Measure.Number and Measure.Unit.

Possible format values:

Sample

See the example for Measure.Number

See Also

Measure.Number, Measure.Unit 

format [Optional] Indicates the format of the prefix.

ppcbMeasureFormatStandard To return a standard prefix representation (for example, 
p for Pico or k for Kilo).

ppcbMeasureFormatCurrent To return a prefix in the format currently used in the 
Measure value.

ppcbMeasureFormatShort To return a short prefix (for example, p for Pico or k for 
Kilo).

ppcbMeasureFormatLong To return a long unit name (for example, Pico, Kilo, or 
Mega).
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Measure.Text
This property sets or returns the exact text value of the measure.

Prototype

Text As String

Arguments

None

Comments

This property defines a custom format of a measurement. The text value consists of a number 
followed by an optional prefix and unit. The text value always matches the Attribute.Value 
property if an attribute represents a measure.

Sample

The following sample code demonstrates the difference between Measure.Text, Measure.Value, 
and Attribute.Value properties. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set C1 = ActiveDocument.Components("C1") 
Set Cap = Measure("500pF") 
C1.Attributes.Add "Capacitance", Cap
MsgBox Cap 'displays 0.0000000005 (the default Value property)
MsgBox Cap.Value 'displays 0.0000000005 
MsgBox Cap.Text 'displays 500pF 
MsgBox C1.Attributes("Capacitance") 'displays 500pF 
MsgBox C1.Attributes("Capacitance").Value 'displays 500pF (long form)
End Sub

See Also

Measure.Value
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Measure.Unit
This property returns the unit name of the measure.

Prototype

Unit([format As PPcbMeasureFormat = ppcbMeasureFormatStandard]) As String

Argument

Comments

This property returns the name of the physical unit without a prefix.

Possible Format values:

Sample

See the example for Measure.Number.

See Also

Measure.Number, Measure.Prefix

format [Optional] Indicates the format of the unit representation.

ppcbMeasureFormatStandard To return a standard unit representation (for example, F 
for Capacitance).

ppcbMeasureFormatCurrent To return the unit in the format currently used in this 
Measure value.

ppcbMeasureFormatShort To return a short unit name (for example F for 
Capacitance).

ppcbMeasureFormatLong To return a long unit name (for example Farad for 
Capacitance).
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Measure.Value
This property sets or returns the value of the measure.

Prototype

Value As Double

Arguments

None

Comments

This property returns a floating-point number for a measure, taking into account the unit prefix. 
For example, 10000 for 10K or 2e-10 for 200pF.

This is a default property, so it can be omitted in Basic scripts.

If you set a new Value, then Measure is automatically normalized. See also: Measure.Normalize

Sample

The following sample code demonstrates how to work with measures. See “Running Code 
Samples” for more information on running this sample.

Sub Main
'1 – Compare two existing measure attributes (.Value call may be omitted)
Set U1_Val = 
ActiveDocument.Components("U1").Attributes("Value").Measure.Value
Set U2_Val = 
ActiveDocument.Components("U2").Attributes("Value").Measure.Value
Set U1_Quantity = 
ActiveDocument.Components("U1").Attributes("Value").Measure.Name
Set U2_Quantity = 
ActiveDocument.Components("U2").Attributes("Value").Measure.Name
If U1_Quantity <> U2_Quantity then
MsgBox "Cannot compare values with different physical units" 
ElseIf U1_Val < U2_Val then
MsgBox "U1 value is less than U2 value" 
ElseIf U1_Val > U2_Val then
MsgBox "U1 value is greater than U2 value" 
Else
MsgBox "U1 value is equal to U2 value" 
End If
'2 - Check that the Resistor's Value is in range between 100K and 10M
Set R1_Val = ActiveDocument.Components("R1").Attributes("Value").Measure
If R1_Val >= Measure("100k") And R1_Val <= Measure("10M") And R1_Val.Name 
= "Resistence" Then
MsgBox "Resistor Is In Range [100k, 10M] 
End If
'3 – Calculate total thermal dessipation for all parts
'make sure attribute exists for all parts
For Each part In ActiveDocument.Components
If part.Attributes("Thermal.Dissipation") Is Nothing Then 
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Part.Attributes.Add "Thermal.Dissipation", Measure("10mW") 
End If 
Next
Dim Total As Measure 'declare Total as Measure object explicitly!
Set Total = Measure("0mW") 'create Measure to accamulate the total
For Each part In ActiveDocument.Components
Total = Total + part.Attributes("Thermal.Dissipation").Measure 
Next
MsgBox "Total Thermal Dissipation = " & Total.Text
End Sub

See Also

Measure.Text, Measure.Name 
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Net.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an Automation object. All automation server applications 
have an application object and all automation objects have an application property. This 
property is usually used in automation client applications that handle large volumes of objects 
from different sources, such as different automation server applications, to quickly identify the 
application to which the object belongs.
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Net.AssociatedNet
This property returns the associated net which the net belongs to.

Prototype

AssociatedNet as AssociatedNet

Arguments

None

Returns

This property returns Nothing if the net doesn’t belong to any associated net.
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Net.Attributes
This property returns the collection of all attributes assigned to the net.

Prototype

Attributes As Attributes 

Attributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that net Attribute object. If 
the attribute name does not exist, this property returns the collection of all net attributes in an 
Attributes collection object.

Sample

The following sample code retrieves the number of attributes assigned to net VCC, assuming it 
exists in the open design, using the Attributes.Count property. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set attrs = ActiveDocument.Nets("VCC").Attributes 
MsgBox "There are " & attrs.Count & " attribute(s) in net VCC." 
End Sub

name Name of an existing net attribute.
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Net.Connections
This property returns the collection of all connections on the net.

Prototype

Connections As Objects  

Connections(name As String) As Connection 

Argument

Comments

When an existing connection name is passed to this property, it returns that Connection object. 
If the connection name does not exist, this property returns the collection of all connections of 
the net in an Objects collection object.

Sample

The following sample code retrieves the number of connections in net VCC, assuming it exists 
in the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "VCC has " & ActiveDocument.Nets("VCC").Connections.Count & " 
connections." 
End Sub

name Name of an existing connection.
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Net.Drawings
This property returns the collection of coppers and copper pours belonging to the net object, or 
a specific copper or copper pour.

Prototype

Drawings as Collection

Drawings (Name as String) as Drawing

Argument

Comments

None

Sample

The following sample code displays the number of drawings associated with a net. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each net In ActiveDocument.Nets 
If net.Drawings.Count > 0 Then 
MsgBox "Net " & net.Name & " has " & net.Drawings.Count & " drawings" 
Exit For 
End If 
Next net 
End Sub

name Name of the drawing.
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Net.Length
This property returns the length of the net.

Prototype

Length([bRouted As Boolean = False], [unit As PPcbUnit]) As Double

Arguments

Comments

None

Sample

The following sample code retrieves the routed, unrouted, and total length of net VCC, 
assuming it exists in the open design. See “Running Code Samples” for more information on 
running this sample.

Sub Main
lenTotal = Format$(ActiveDocument.Nets("VCC").Length, "Fixed") 
lenRouted = Format$(ActiveDocument.Nets("VCC").Length(True), "Fixed") 
MsgBox "VCC's total length is (in current unit) " & lenTotal & " including 
" & lenRouted & " routed and " & lenTotal-lenRouted & " unrouted." 
End Sub

bRouted [Optional] True to retrieve the routed length only. False to retrieve the 
total length, including unrouted parts approximated using the Manhattan 
method.

unit [Optional] Unit in which the length is returned.
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Net.Name
This property returns the name of the net. For example, this property returns the string “GND” 
for net GND.

This property is the default property for the Net object.

Prototype

Name As String

Arguments

None

Sample

The following sample code lists all nets in the open design and then places that list in a custom 
dialog box. When a net is selected in the list box, the sample selects that net.

This sample uses the UserDialog Editor in the Sax Basic Engine in PADS Layout. See 
“Running Code Samples” for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListNets$(10000)
Sub Main
index = 0 
For Each nextNet In ActiveDocument.Nets 
ListNets$(index) = nextNet.Name 
index = index + 1 
Next nextNet 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Nets",.CallbackFunc ' %GRID:10,7,1,1 
ListBox 10,7,160,203,ListNets(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened 
' in the dialog; it is used to easily process user actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
ActiveDocument.SelectObjects(ppcbObjectTypeNet, ListNets(SuppValue%)) 
End If 
End Select 
End Function
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Net.NetClass
This property returns the net object's net class.

Prototype

NetClass as NetClass

Arguments

None

Comments

None

Sample

The following sample code displays the name of the net class a net belongs to, if any. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each net In ActiveDocument.Nets 
If Not net.NetClass Is Nothing Then 
MsgBox "Net " & net.Name & " belongs to class " & net.NetClass.Name 
Exit For 
End If 
Next net 
End Sub
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Net.NetClassAttributes
This property returns the collection of all attributes assigned to the net class.

Prototype

NetClassAttributes As Attributes 

NetClassAttributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that net class Attribute 
object. If the attribute name does not exist, this property returns the collection of all net class 
attributes in an Attributes collection object.

Sample

The following sample code retrieves the number of attributes assigned to the net class of net 
VCC, assuming it exists in the open design, using the Attributes.Count property. See NetClass 
Attributes for more information on running this sample.

Sub Main
Set attrs = ActiveDocument.Nets("VCC").NetClassAttributes 
MsgBox "There are " & attrs.Count & " attribute(s) in net class " & 
ActiveDocument.Nets("VCC").Name 
End Sub

name Name of an existing net class attribute.
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Net.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypeNet. 

All database objects in the Automation server implement this property to compensate for the 
lack of a Visual Basic equivalent for the Visual C++ QueryInterface function.

This property is generally used:

• To identify the kind of database objects in a heterogeneous Objects collection.

• When implementing a generic routine that depends on the type of the database object 
passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypeVia 
' Do something specific to via objects 
Case ppcbObjectTypeConnection 
' Do something specific to connection objects 
Case ppcbObjectTypeRouteSegment 
' Do something specific to route segment objects 
Case ppcbObjectTypeJumper 
' Do something specific to jumper objects 
Case Else 
MsgBox "Not a PADS Layout database object" 
End Select 
End Sub
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Net.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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Net.Pins
This property returns the collection of all pins connected to the net.

Prototype

Pins As Objects  

Pins(name As String) As Pin 

Argument

Comments

When an existing pin name is passed to this property, it returns that Pin object. If the pin name 
does not exist, this property returns the collection of all pins connected to the net in an Objects 
collection object.

Sample

The following sample code retrieves the number of pins connected to net VCC, assuming it 
exists in the open design. See “Running Code Samples” for more information on running this 
sample.

Sub Main
MsgBox "VCC connects " & ActiveDocument.Nets("VCC").Pins.Count & " pins." 
End Sub

name Name of an existing pin.
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Net.Power
This property returns whether the net is a power net.

Prototype

Power As Boolean

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of power nets in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
nbPowerNets = 0 
For Each nextNet In ActiveDocument.Nets 
If nextNet.Power = True Then nbPowerNets = nbPowerNets +1 
Next nextNet 
MsgBox "There are " & nbPowerNets & " power nets (out of " & 
ActiveDocument.Nets.Count & ") in " & ActiveDocument.Name 
End Sub
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Net.Selected
This property sets or returns whether the net is selected.

Prototype

Selected As Boolean

Arguments

None

Comments

You can also select a database object using the Document.SelectObjects and Objects.Select 
methods.

Sample

The following sample code selects net VCC only, assuming it exists in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.Nets("VCC").Selected = True 
End Sub

See Also

Document.SelectionChange Event 
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Net.Vias
This property returns the collection of all vias connected to the net.

Prototype

Vias As Objects  

Vias(name As String) As Via 

Argument

Comments

When an existing via name is passed to this property, it returns that Via object. If the via name 
does not exist, this property returns the collection of all vias connected to the net in an Objects 
collection object.

Sample

The following sample code retrieves the number of vias connected to net VCC, assuming it 
exists in the open design. See “Running Code Samples” for more information on running this 
sample.

Sub Main
MsgBox "VCC connects " & ActiveDocument.Nets("VCC").Vias.Count & " vias." 
End Sub

name Name of an existing via.
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NetClass.Application
This property returns the Application object.

Prototype

Application as Application

Arguments

None

Comments

This is a Microsoft-required property.
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NetClass.Attributes
This property returns a collection of attributes of the net class, or a specific attribute, referenced 
by its name.

Prototype

Attributes as Attributes

Attributes (Name as String) as Attribute

Argument

Comments

None

Sample

The following sample code displays a message box showing the number of the attribute for a 
net class. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each class In ActiveDocument.NetClasses 
Set attrs = class.Attributes 
MsgBox "There are " & attrs.Count & " attribute(s) for net class " & 
class.Name 
Exit For 
Next class 
End Sub

name Name of the attribute to retrieve.
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NetClass.Name
This default property returns the name of the net class.

Prototype

Name as String

Arguments

None

Comments

This is a Microsoft-required property.

Sample

The following sample code displays a message box showing the number of nets in the first net 
class in the active document. See “Running Code Samples” for more information on running 
this sample.

Sub Main
For Each class In ActiveDocument.NetClasses 
MsgBox "Net Class " & class.Name & " includes " & class.Nets.Count & " 
nets" 
Exit For 
Next class 
End Sub
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NetClass.Nets
This property returns the collection of all nets of the net class, or a specific net of the net class, 
referenced by its name.

Prototype

Nets as Collection

Nets (Name as String) as Net

Argument

Comments

None

Sample

The following sample code retrieves the number of nets in a net class, assuming it exists in the 
open design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each class In ActiveDocument.NetClasses 
MsgBox "Net Class " & class.Name & " includes " & class.Nets.Count & " 
nets" 
Exit For 
Next class 
End Sub

name Name of the net to retrieve.
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NetClass.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following sample code finds a net class starting with “A.” See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set objs = ActiveDocument.GetObjects(, "A*") 
For Each obj In objs 
If obj.ObjectType = ppcbObjectTypeNetClass Then 
MsgBox obj.Name & " is a net class" 
Exit For  
End If 
Next obj 
End Sub
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NetClass.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Arguments

None

Comments

This is a Microsoft-required property.
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Objects.Application
This property returns the Application object.

Prototype

Application As Application 

Arguments

None

Comments

This is a Microsoft-required property.

This property identifies the object as an Automation object. All Automation server applications 
have an Application object and all Automation objects have an Application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.
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Objects.Count
This property returns the number of objects in the collection.

Prototype

Count As Long

Arguments

None

Comments

None
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Objects.Item
This property returns the object given its index or its name.

Prototype

Item(index As Long) As Object

Item(name As String) As Object

Arguments

Comments

This is the default member of the Objects collection object.

This property generates an exception if the index passed to this function is negative or out of 
range, or if the index or name argument is not valid.

Sample

The following sample code shows two different methods for iterating through all database 
objects in the open design, using Component objects here as an example. The second method is 
preferred because it is cleaner and faster. See “Running Code Samples” for more information on 
running this sample.

' Method 1: Use the Object.Item property
Sub Main
Set comps = ActiveDocument.Components 
For I=1 To comps.Count 
Set thisComp = comps.Item(I) 
' Do something with the component thisComp 
Next I 
End Sub
' Method 2: Do not use the Object.Item property (preferred method)
Sub Main
For Each nextComp in ActiveDocument.Components 
' Do something with the component nextComp 
Next nextComp 
End Sub

See Also

Objects.ItemType

index Index (in the collection) of the object to retrieve.

name Name of the object to retrieve.
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Objects.ItemType
This property returns the type of an object given its index.

Prototype

ItemType(index As long) As PPcbObjectType

ItemType(name As String) As PPcbObjectType

Arguments

Comments

This property generates an exception if the index argument is not valid.

See Also

Objects.Item

index Index of the object in the collection to query.

name Name of the object to retrieve.
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Objects.Next
This property returns the index of the next object of a specified type after the specified index.

Prototype

Next(index As long, type As PPcbObjectType) As Long

Arguments

Comments

This property generates an exception if the index argument is not valid.

If Index = zero (0), then this function returns the index of the first item of the given type. If an 
item is not found, then the return value is zero (0).

index Index of the object in the collection to query.

type Type of the object to query.
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Objects.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None
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Objects.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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Objects.ParentObject
This property returns the parent object of the collection.

Prototype

ParentObject as Object

Arguments

None

Comments

If a collection has ParentObject, it means the collection is “active.” Addition or deletion of an 
item to or from the collection modifies the parent object as well. Otherwise, only the collection 
is affected.
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Pad.Application
This property returns the application object.

Prototype

Application as Application

Argument

None
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Pad.CornerRadius
This property returns the pad's corner radius. This property should be used for the following pad 
shapes: ppcbPadShapeSquare, ppcbPadShapeRectangularFinger.

Prototype

CornerRadius (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default
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Pad.CornerType
This property returns the pad's corner type. This property should be used for the following pad 
shapes: ppcbPadShapeSquare, ppcbPadShapeRectangularFinger.

Prototype

CornerType as PPcbPadCornerType

Argument

None
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Pad.Diameter
This property returns the pad's diameter. This property should be used for the following pad 
shapes: ppcbPadShapeRound, ppcbPadShapeAnnular, ppcbPadShapeOdd.

Prototype

Diameter (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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Pad.InnerDiameter
This property returns the pad's inner diameter. This property should be used for the following 
pad shapes: ppcbPadShapeAnnular.

Prototype

InnerDiameter (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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Pad.Length
This property returns the pad's length. This property should be used for the following pad 
shapes: ppcbPadShapeOvalFinger, ppcbPadShapeRectangularFinger.

Prototype

Length (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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Pad.Name
This property returns the name of this pad.

Prototype

Name as String

Argument

None
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Pad.ObjectType
This propertry returns the type of the object - ppcbObjectTypePad.

Prototype

ObjectType as PPcbObjectType

Argument

None
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Pad.Offset
This property returns the pad's offset. This property should be used for the following pad 
shapes: ppcbPadShapeOvalFinger, ppcbPadShapeRectangularFinger.

Prototype

Offset (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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Pad.Orientation
This property returns the pad's orientation. This property should be used for the following pad 
shapes: ppcbPadShapeOvalFinger, ppcbPadShapeRectangularFinger.

Prototype

Orientation as Double 

Argument

None
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Pad.PadStackLayer
This property returns the PadStackLayer Object to which this pad belongs to.

Prototype

PadStackLayer as PadStackLayer

Argument

None
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Pad.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Argument

None
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Pad.Shape
This property returns the pad shape.

Prototype

Shape as PPcbPadShape

Argument

None



PADS Layout User’s Guide and Reference Manual, PADS 9.41942

PADS Layout Automation Server
Pad.Width

Pad.Width
This property returns the pad's width. This property should be used for the following pad 
shapes: ppcbPadShapeOvalFinger, ppcbPadShapeRectangularFinger, ppcbPadShapeSquare.

Prototype

Width (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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PadStackLayer.AntiPad
This property returns the AntiPad Object assigned to this padstack layer or Nothing if the 
antipad is not defined.

Prototype

AntiPad as AntiPad

Argument

None
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PadStackLayer.Application
This property returns the application object.

Prototype

Application as Application

Argument

None
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PadStackLayer.Name
This property returns the name of this padstack layer.

Prototype

Name as String

Argument

None
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PadStackLayer.Number
This property returns the number of this padstack layer. Values -2, -1, 0 correspond to 
PPcbPadStackLayerType.

Prototype

Number as Integer

Argument

None
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PadStackLayer.ObjectType
This property returns the type of the object - ppcbObjectTypePadStackLayer.

Prototype

ObjectType as PPcbObjectType

Argument

None
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PadStackLayer.Pad
This property returns the Pad Object assigned to this padstack layer.

Prototype

Pad as Pad

Argument

None
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PadStackLayer.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Argument

None
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PadStackLayer.Pin
This property returns the Pin Object to which this padstack layer belongs to. If padstack layer 
belongs to via then Nothing is returned.

Prototype

Pin as Pin

Argument

None



PADS Layout Automation Server
PadStackLayer.ThermalPad

PADS Layout User’s Guide and Reference Manual, PADS 9.4 1951

PadStackLayer.ThermalPad
This property returns the ThermalPad Object assigned to this padstack layer or Nothing if 
thermal pad is not defined.

Prototype

ThermalPad as ThermalPad

Argument

None
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PadStackLayer.Via
This property returns the Via Object to which this padstack layer belongs to. If padstack layer 
belongs to pin then Nothing is returned.

Prototype

Via as Via

Argument

None
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PartType.Application
This property returns the PADS Layout Application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as a PADS Layout automation object. All automation server 
applications have an application object and all automation objects have an application property. 
This property is usually used in large automation client applications that handle large volumes 
of objects from different sources, such as different automation server applications, to quickly 
identify the application to which the object belongs.
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PartType.Attributes
This property returns the collection of all attributes of the part type.

Prototype

Attributes As Attributes 

Attributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that part type Attribute 
object. Otherwise, it returns the collection of all part type attributes in an Attributes collection 
object.

Sample

The following sample code retrieves the number of attributes on part type 7400, assuming it 
exists in the open design, using the Attributes.Count property. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set attrs = ActiveDocument.PartTypes("7400").Attributes 
MsgBox "There are " & attrs.Count & " attribute(s) in part type 7400." 
End Sub

name Name of an existing part type attribute.
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PartType.Components
Returns object collection of all components of this part type.

Prototype

Components As Objects 

Components(name As String) As Component 

Argument

Comments

When an existing pin name is passed to this property, it returns that Component object. 
Otherwise, it returns the collection of all components of the part type as an Objects collection 
object.

Sample

The following sample displays total number of 7400 parts.

Sub Main
MsgBox Str(ActiveDocument.PartTypes("7400").Components.Count) 
End Sub

name Name of an existing component.
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PartType.ECORegistered
This property sets or returns the part type ECO registration status.

Prototype

ECORegistered As Boolean

Arguments

None

Comments

This property replaces Component.PartTypeECORegistered 
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PartType.Logic
This property returns the logic family of the part type.

Prototype

Logic As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the logic family of the part type 7400, assuming it exists in 
the open schematic. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "The Logic family of 7400 is " & 
ActiveDocument.PartTypes("7400").Logic 
End Sub
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PartType.Name
This property returns the name of the part type. For example, this property returns the string 
“7402” for part type 7402.

Prototype

Name As String

Arguments

None

Comments

This property is the default property for the Component object.

Sample

The following sample code retrieves all part types in the open schematic and places that list in a 
custom dialog list box. When a part type is selected in the list box, the sample selects all parts of 
that part type in PADS Layout. This sample uses the UserDialog Editor in the Sax Basic Engine 
in PADS Layout. See” Running Code Samples” for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListPkgs$(10000)
Sub Main
index = 0 
For Each nextPkg In ActiveDocument.PartTypes 
ListPkgs$(index) = nextPkg.Name 
index = index + 1 
Next nextPkg 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Part Types",.CallbackFunc ' 
%GRID:10,7,1,1 
ListBox 10,7,160,203,ListPkgs(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened 
' in the dialog; it is used to easily process user actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
'get part by name 
Set pkg = ActiveDocument.PartTypes(ListPkgs(SuppValue%)) 
'select part 
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pkg.Selected = True 
'activate sheet where first gate of the part is located 
pkg.Components(1).Gates(1).Sheet.Activate 
End If 
End Select 
End Function
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PartType.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypePartType. 

All PADS Layout database objects in the PADS Layout Automation server implement this 
property to compensate for the lack of Visual Basic equivalent for the Visual C++® 
QueryInterface function.

This property is generally used:

To identify the kind of PADS Layout database objects in a heterogeneous Objects collection.

When implementing a generic routine that depends on the type of the PADS Layout database 
object passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypePartType
' Do something specific to part type objects 
Case Else 
' Do something about other PADS Layout objects 
End Select 
End Sub
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PartType.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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PartType.Selected
This property sets or returns whether the components of the part type are selected.

Prototype

Selected As Boolean

Arguments

None

Comments

The part type is considered selected when one or more components of this part type are selected. 
You can also select a PADS Layout database object using the Document.SelectObjects or 
Objects.Select methods.

Sample

The following sample code selects part type 7400 only, assuming it exists in the open 
schematic, and activates the sheet on which it resides. See “Running Code Samples” for more 
information on running this sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.PartTypes("7400").Selected = True 
End Sub

See Also

Document.SelectionChange Event 
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Pin.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an automation object. All automation server applications 
have an application object and all automation objects have an application property. This 
property is usually used in automation client applications that handle large volumes of objects 
from different sources, such as different automation server applications, to quickly identify the 
application to which the object belongs.
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Pin.Attributes
This property returns the collection of all attributes of the pin.

Prototype

Attributes As Attributes 

Attributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that pin Attribute object. If 
the attribute name does not exist, this property returns the collection of all pin attributes in an 
Attributes collection object.

Sample

The following sample code retrieves the number of attributes assigned to pin U1.1, assuming it 
exists in the open design, using the Attributes.Count property. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set attrs = ActiveDocument.Pins("U1.1").Attributes 
MsgBox "There are " & attrs.Count & " attribute(s) in pin U1.1." 
End Sub

name Name of an existing pin attribute.
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Pin.Component
This property returns the component owning the pin.

Prototype

Component As Component

Arguments

None

Comments

None

Sample

The following sample code retrieves the component to which pin U1.1 belongs, assuming U1.1 
exists in the open design. See “Running Code Samples” for more information on running this 
sample.

Sub Main
MsgBox "Pin U1.1 belongs to component " & 
ActiveDocument.Pins("U1.1").Component.Name 
End Sub
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Pin.DrillSize
This property returns the drill size of the pin.

Prototype

DrillSize([unit As PPcbUnit]) As Double

Argument

Comments

This property returns 0.0 for SMD pins.

Sample

The following sample code retrieves the drill size of pin U1.1, assuming U1.1 exists in the open 
design. See “Running Code Samples” or more information on running this sample.

Sub Main
MsgBox "Pin U1.1 drill size is " & ActiveDocument.Pins("U1.1").DrillSize 
End Sub

See Also

Pin.IsSMD

unit [Optional] Unit in which the drill size value is returned.
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Pin.ElectricalType
This property returns the gate type of the pin.

Prototype

ElectricalType As PPcbPinElectricalType

Arguments

None

Comments

None

Sample

The following sample code retrieves the electrical type of pin U1, assuming U1 exists in the 
open design. See “Running Code Samples” for more information on running this sample.

Function ElectricalTypeName(theType As Long) As String
Select Case theType 
Case ppcbElectricalTypeUnknown 
ElectricalTypeName = "unknown" 
Case ppcbElectricalTypeSource 
ElectricalTypeName = "source" 
Case ppcbElectricalTypeBidirectional 
ElectricalTypeName = "bidirectional" 
Case ppcbElectricalTypeOpenCollector 
ElectricalTypeName = "open collector" 
Case ppcbElectricalTypeOrTieableSource 
ElectricalTypeName = "tiable source" 
Case ppcbElectricalTypeTristate 
ElectricalTypeName = "tristate" 
Case ppcbElectricalTypeLoad 
ElectricalTypeName = "load" 
Case ppcbElectricalTypeTerminator 
ElectricalTypeName = "terminator" 
Case ppcbElectricalTypePower 
ElectricalTypeName = "power" 
Case ppcbElectricalTypeGround 
ElectricalTypeName = "ground" 
Case Else 
ElectricalTypeName = "unknown" 
End Select 
End Function
Sub Main
MsgBox "Pin U1.1 electrical type is " & 
ElectricalTypeName(ActiveDocument.Pins("U1.1").ElectricalType) 
End Sub
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Pin.FunctionName
This property returns the function name of the pin.

Prototype

FunctionName As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the function name of pin U1, assuming U1 exists in the 
open design. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "Pin U1.1 function name is " & 
ActiveDocument.Pins("U1.1").FunctionName 
End Sub
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Pin.Glued
This property sets or returns whether the pin is glued.

Prototype

Glued As Boolean

Arguments

None

Comments

None

Sample

The following sample code glues all pins in the open design. See “Running Code Samples” for 
more information on running this sample.

Sub Main
For Each nextPin In ActiveDocument.Pins 
nextPin.Glued = True 
Next nextPin 
End Sub
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Pin.Highlighted
This property returns whether the pin is highlighted.

Prototype

Highlighted as Boolean

Argument

None
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Pin.IsSMD
This property returns whether the pin is SMD.

Prototype

IsSMD As Boolean

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of SMD pins in the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
nbSMDPins = 0 
For Each nextPin In ActiveDocument.Pins 
If nextPin.IsSMD = True Then nbSMDPins = nbSMDPins +1 
Next nextPin 
MsgBox "There are " & nbSMDPins & " SMD pins (out of " & 
ActiveDocument.Pins.Count & ") in " & ActiveDocument.Name 
End Sub

See Also

Pin.DrillSize
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Pin.Name
This property returns the name of the pin.

Prototype

Name As String

Arguments

None

Comments

For example, this property returns the string “U1.1” for pin U1.1.

This property is the default property for the Pin object.

Sample

The following sample code lists all pins in the open design by name and then places that list in a 
custom dialog box. When a pin is selected in the list box, the sample selects that pin. 

This sample uses the UserDialog Editor in the Sax Basic Engine in PADS Layout. See 
“Running Code Samples” for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListPins$(10000)
Sub Main
index = 0 
For Each nextPin In ActiveDocument.Pins 
ListPins$(index) = nextPin.Name 
index = index + 1 
Next nextPin 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Pins",.CallbackFunc ' %GRID:10,7,1,1 
ListBox 10,7,160,203,ListPins(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened 
' in the dialog; it is used to easily process user actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
ActiveDocument.SelectObjects(ppcbObjectTypePin, ListPins(SuppValue%)) 
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End If 
End Select 
End Function
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Pin.Net
This property returns the net connected to the pin.

Prototype

Net As Net

Arguments

None

Comments

This property returns nothing if the pin is not connected.

Sample

The following sample code identifies the net connected to pin U1.1, assuming U1.1 exists in the 
open design. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "Pin U1.1 is connected to net " & 
ActiveDocument.Pins("U1.1").Net.Name 
End Sub
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Pin.Number
This property returns the number of the pin.

Prototype

Number As Long

Arguments

None

Comments

None

Sample

The following sample code retrieves the pin number of pin U1.1, assuming U1.1 exists in the 
open design. See “Running Code Samples” for more information on running this sample.

Sub Main
MsgBox "Pin U1.1 is pin number " & ActiveDocument.Pins("U1.1").Number & " 
in component " & ActiveDocument.Pins("U1.1").Component.Name 
End Sub



PADS Layout User’s Guide and Reference Manual, PADS 9.41976

PADS Layout Automation Server
Pin.ObjectType

Pin.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypePin. 

All database objects in the automation server implement this property to compensate for the 
lack of a Visual Basic equivalent for the Visual C++ QueryInterface function.

This property is generally used:

• To identify the kind of database objects in a heterogeneous Objects collection.

• When implementing a generic routine that depends on the type of the database object 
passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypeVia 
' Do something specific to via objects 
Case ppcbObjectTypeConnection 
' Do something specific to connection objects 
Case ppcbObjectTypeRouteSegment 
' Do something specific to route segment objects 
Case ppcbObjectTypeJumper 
' Do something specific to jumper objects 
Case Else 
MsgBox "Not a PADS Layout database object" 
End Select 
End Sub
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Pin.PadStackLayers
This property returns the collection of all padstack layers for this pin.

Prototype

PadStackLayers as Objects

PadStackLayers(layerName as String) as PadStackLayer

Argument

Return Values

When a layer name is passed to this property, it returns that PadStackLayer Object. If the name 
is not specified, this property returns the collection of all padstack layers in an Objects 
collection object.

Sample

For Each comp In Application.ActiveDocument.Components
  For Each pin In comp.Pins 
    For Each layer in pin.PadStackLayers

      MsgBox layer.Number & ", " & layer.Name

      pad = layer.Pad
      MsgBox pad.Name & ", " & pad.Shape & ", " & pad.Diameter & ", " 
             & pad.InnerDiameter & ", " & pad.Width & ", " 
             & pad.Length & ", " & pad.offset & ", " 
             & pad.Orientation & ", " & pad.CornerType & ", " 
             & pad.CornerRadius
      
      thermalpad = layer.ThermalPad
      If thermalpad Is Nothing Then
        MsgBox "Thermal pad not defined on this layer"
      Else
        MsgBox thermalpad.Name & ", " & thermalpad.Shape & ", " 
               & thermalpad.InnerSize & ", " 
               & thermalpad.OuterSize & ", " & thermalpad.Spokes & ", " 
               & thermalpad.SpokeAngle  & ", " & thermalpad.SpokeWidth
      End If

      antipad = layer.AntiPad
      If antipad Is Nothing Then
        MsgBox "Anti pad not defined on this layer"
      Else
        MsgBox antipad.Name & ", " & antipad.Shape & ", " 
               & antipad.Size
      End If

    Next layer       
  Next pin

layerName Name of padstack layer
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Pin.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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Pin.PlaneThermal
This property returns whether the pin has a plane thermal.

Prototype

PlaneThermal As Boolean

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of plane thermal pins in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
nbPTPins = 0 
For Each nextPin In ActiveDocument.Pins 
If nextPin.PlaneThermal = True Then nbPTPins = nbPTPins +1 
Next nextPin 
MsgBox "There are " & nbPTPins & " plane thermal pins (out of " & 
ActiveDocument.Pins.Count & ") in " & ActiveDocument.Name 
End Sub
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Pin.Plated
This property returns whether the pin is plated.

Prototype

Plated As Boolean

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of non-SMD, nonplated pins in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
nbPlatedPins = 0 
For Each nextPin In ActiveDocument.Pins 
If nextPin.Plated = False And nextPin.IsSMD = False Then nbPlatedPins = 
nbPlatedPins +1 
Next nextPin 
MsgBox "There are " & nbPlatedPins & " non-SMD non-plated pins (out of " & 
ActiveDocument.Pins.Count & ") in " & ActiveDocument.Name 
End Sub
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Pin.PositionX
This property returns the x-coordinate of the pin.

Prototype

PositionX([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the location of pin U1.1, assuming U1.1 exists in the open 
design, in current design units. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set pinU1_1 = ActiveDocument.Pins("U1.1") 
MsgBox "U1.1 position is = (" & pinU1_1.PositionX & ", " & 
pinU1_1.PositionY & ")" 
End Sub

See Also

Pin.PositionY

unit [Optional] Unit in which the x-coordinate is returned.
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Pin.PositionY
This property returns the y-coordinate of the pin.

Prototype

PositionY([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the location of the pin U1.1, assuming U1.1 exists in the 
open design, in current design units. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set pinU1_1 = ActiveDocument.Pins("U1.1") 
MsgBox "U1.1 position is = (" & pinU1_1.PositionX & ", " & 
pinU1_1.PositionY & ")" 
End Sub

See Also

Pin.PositionX

unit [Optional] Unit in which the y-coordinate is returned.
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Pin.Selected
This property sets or returns whether the pin is selected.

Prototype

Selected As Boolean

Arguments

None

Comments

You can also select a PADS Layout database object using the Document.SelectObjects and 
Objects.Select methods.

Sample

The following sample code selects pin U1.1 only, assuming U1.1 exists in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.Pins("U1.1").Selected = True 
End Sub

See Also

Document.SelectionChange Event
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Pin.SlotLength
This property returns the slot length of the pin.

Prototype

SlotLength (Unit as PPcbUnit) as Double

Argument

Comments

If a pin is not slotted, it returns zero. The property could be used to check if a pin has a slot or 
round drill.

Sample

The following sample code displays the slot length of the selected pin. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypePin,,True) 
For Each pin In selected 
MsgBox "Slot length:" & pin.SlotLength 
Exit For 
Next pin 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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Pin.SlotOffset
This property returns the slot offset of the pin.

Prototype

SlotOffset (Unit as PPcbUnit) as Double

Argument

Comments

If pin is not slotted, it returns zero.

Sample

The following sample code displays the slot length of the selected pin. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypePin,,True) 
For Each pin In selected 
MsgBox "Slot offset:" & pin.SlotOffset 
Exit For 
Next pin 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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Pin.SlotOrientation
This property returns the slot orientation of the pin, in degrees.

Prototype

SlotOffset as Double

Arguments

None

Comments

If pin is not slotted, it returns zero.

Sample

The following sample code displays the slot orientation of the selected pin. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypePin,,True) 
For Each pin In selected 
MsgBox "Slot orientation:" & pin.SlotOrientation 
Exit For 
Next pin 
End Sub
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Pin.TestPoint
This property sets or returns whether the pin is a test point.

Prototype

TestPoint As PPcbTestPointType 

Arguments

None

Comments

None

Sample

The following sample code removes all test points from the open design and adds one top layer 
test point per net, arbitrarily choosing a pin on the net for the test point. See “Running Code 
Samples” for more information on running this sample.

Sub Main
' Remove all test points 
For Each nextPin In ActiveDocument.Pins 
nextPin.TestPoint = ppcbTestPointNone 
Next nextPin 
' Add one top layer test point per net 
For Each nextNet In ActiveDocument.Nets 
Set arbitPin = nextNet.Pins.Item(0) 
arbitPin.TestPoint = ppcbTestPointTopLayer 
Next nextNet 
End Sub
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Polyline.Application
This property returns the Application object.

Prototype

Application as Application

Arguments

None

Comments

This is a Microsoft-required property.
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Polyline.CenterX
This property returns a center x-coordinate for an arc in the polyline.

Prototype

CenterX (Corner as Long, Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Sample

The following sample code displays center coordinates of the selected polyline. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,True) 
For Each drw In selected 
Dim geom As Object 
For Each geom In drw.Geometry 
If geom.ObjectType = ppcbObjectTypePolyline Then 
p = geom.Points 
n = UBound(p, 1) 
For i = 1 To n 
If p(i, 3) <> 0 Then 
m = "Arc " & i & " : (" & p(i, 1) & ", " & p(i, 2) & ") " 
m = m & "Center: ("& geom.CenterX(i) & ", " & geom.CenterY(i) & ")" 
MsgBox m 
End If 
Next i 
Exit For 
End If 
Next geom 
Exit For 
Next drw  
End Sub

corner Starting corner for the arc.

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.

Origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Polyline.CenterY
This property returns a center y-coordinate for an arc in the polyline.

Prototype

CenterY (Corner as Long, Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Sample

The following sample code displays center coordinates of the selected polyline. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,True) 
For Each drw In selected 
Dim geom As Object 
For Each geom In drw.Geometry 
If geom.ObjectType = ppcbObjectTypePolyline Then 
p = geom.Points 
n = UBound(p, 1) 
For i = 1 To n 
If p(i, 3) <> 0 Then 
m = "Arc " & i & " : (" & p(i, 1) & ", " & p(i, 2) & ") " 
m = m & "Center: ("& geom.CenterX(i) & ", " & geom.CenterY(i) & ")" 
MsgBox m 
End If 
Next i 
Exit For 
End If 
Next geom 
Exit For 
Next drw  
End Sub

corner Starting corner for the arc.

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Polyline.Geometry
This property returns a collection of objects, currently, polylines or circles, representing this 
object's child geometry objects.

Prototype

Geometry as Collection

Arguments

None

Comments

None

Sample

The following sample code shows the number of child objects. See “Running Code Samples” 
for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
For Each geom In drw.Geometry 
MsgBox "Child object count: " & geom.Geometry.Count 
Next geom 
Next drw  
End Sub
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Polyline.Layer
This property returns the layer number of the object

Prototype

Layer as Long

Arguments

None

Comments

None

Sample

The following sample code shows the layer number of the selected polyline. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
MsgBox "Layer number: " & geom.Layer 
Next geom 
Next drw  
End Sub
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Polyline.LineWidth
This property returns the width of the polyline.

Prototype

LineWidth (Unit as PPcbUnit) as Double

Argument

Comments

None

Sample

The following sample code shows the line width of the selected polyline. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
For Each geom In drw.Geometry 
MsgBox "Line width: " & geom.LineWidth 
Next geom 
Next drw  
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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Polyline.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following sample code tests the ObjectType property. See “Running Code Samples” for 
more information on running this sample.

Sub Main
For Each drw In ActiveDocument.Drawings 
For Each geom In drw.Geometry 
t = geom.ObjectType  
If t <> pcbObjectTypePolyline And t <> ppcbObjectTypeCircle Then 
MsgBox "Test failed" 
End If 
Next geom 
Next drw  
End Sub
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Polyline.OutlineType
This property returns the outline type of the polyline.

Prototype

OutlineType as PPcbOutlineType 

Arguments

None

Comments

None

Sample

The following sample code shows the outline type of the selected polyline. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
Select Case geom.OutlineType 
Case ppcbOutLineTypeCenter 
s = "Center line" 
Case ppcbOutLineTypeOuter 
s = "Outer line" 
Case ppcbOutLineTypeInner 
s = "Inner line" 
End Select 
MsgBox "Outline type: " & s 
Next geom 
Next drw  
End Sub
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Polyline.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Arguments

None

Comments

This is a Microsoft-required property.
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Polyline.Points
This property returns coordinates of the polyline points.

Prototype

Points (Unit as PPcbUnit, Origin as PPcbOriginType) as Variant

Arguments

Return Values

A two-dimensional array of coordinates representing ends of the polyline's segments. Points (n, 
1) are the X coordinate and points (n, 2) are the Y coordinate. Points (n, 3) contain the arc angle, 
if the point n and point n + 1 are connected with an arc, or zero. The angle is positive if the arc 
has counterclockwise direction, and negative when the arc has clockwise direction. The angle is 
measured in degrees.

Comments

For shape types Hollow, Filled, and Void, the last point duplicates the first one. For example, 
points array dimensions of a filled rectangle object (5, 3). The angle for the last point is always 
0.

Sample

The following sample code displays the corner coordinates of the selected polyline. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,True) 
For Each drw In selected  
  For Each geom In drw.Geometry 
  If geom.ObjectType = ppcbObjectTypePolyline Then
  p = geom.Points 

  n = UBound(p, 1) 

  For i = 1 To n - 1 
   If p(i, 3) = 0 Then 
   m = "Segment " & i 
   m = m & " From (" & p(i, 1) & ", " & p(i, 2) & ")"
   m = m & " To (" & p(i + 1, 1) & ", " & p(i + 1, 2) & ")"
   Else 
   m = "Arc " & i
   m = m & " From (" & p(i, 1) & ", " & p(i, 2) & ")"
   m = m & " To (" & p(i + 1, 1) & ", " & p(i + 1, 2) & ")"
   m = m & " Angle: " & p(i, 3) 

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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   End If 
   MsgBox m 
   Next i 
  Exit For
End If 
 Next geom
 Exit For
Next drw  
End Sub
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Polyline.Radius
This property returns a radius for an arc in the polyline.

Prototype

Radius (Corner as Long, Unit as PPcbUnit) as Double

Arguments

Comments

None

Sample

The following sample code displays the arc radii of the selected polyline. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,True) 
For Each drw In selected 
Dim geom As Object 
For Each geom In drw.Geometry 
If geom.ObjectType = ppcbObjectTypePolyline Then 
p = geom.Points 
n = UBound(p, 1) 
For i = 1 To n 
If p(i, 3) <> 0 Then 
m = "Arc " & i & " : (" & p(i, 1) & ", " & p(i, 2) & ") " 
m = m & "Radius: " & geom.Radius(i) 
MsgBox m 
End If 
Next i 
Exit For 
End If 
Next geom 
Exit For 
Next drw  
End Sub

corner Starting corner for the arc.

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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Polyline.ShapeType
This property returns the shape type of the polyline.

Prototype

ShapeType as PPcbShapeType 

Arguments

None

Comments

None

Sample

The following sample code shows the shape type of the selected polyline. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeDrawing,,TRUE) 
For Each drw In selected 
Dim geom as Object 
For Each geom In drw.Geometry 
Select Case geom.ShapeType 
Case ppcbShapeTypeOpen 
s = "Open" 
Case ppcbShapeTypeHollow 
s = "Hollow" 
Case ppcbShapeTypeFilled 
s = "Filled" 
Case ppcbShapeTypeVoid 
s = "Void" 
End Select 
MsgBox "Polyline type: " & s & " shape" 
Next geom 
Next drw  
End Sub
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RouteSegment.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an Application object and all Automation objects have an Application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.
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RouteSegment.Layer
This property returns the mounting layer of the trace segment.

Prototype

Layer As Long

Arguments

None

Comments

None

Sample

The following sample code retrieves the layer on which the first routed trace segment found in 
the open design exists, assuming at least one trace segment exists. See “Running Code 
Samples” for more information on running this sample.

Sub Main
Set firstRteSeg = ActiveDocument.RouteSegments(1) 
MsgBox "Route segment " & firstRteSeg.Name & " is on layer " & 
firstRteSeg.Layer 
End Sub
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RouteSegment.Length
This property returns the length of the trace segment.

Prototype

Length([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the length of the first trace segment found in the open 
design, assuming at least one trace segment exists. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set firstRteSeg = ActiveDocument.RouteSegments(1) 
MsgBox "Route segment " & firstRteSeg.Name & " length is " & 
firstRteSeg.Length 
End Sub

unit [Optional] Unit in which the length value is returned.
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RouteSegment.Name
This property returns the name of the trace segment.

Prototype

Name As String

Arguments

None

Comments

This property is the default property for the RouteSegment object.

Sample

The following sample code lists all trace segments in the open design by name and then places 
that list in a custom dialog box. When a trace segment is selected in the list box, the sample 
selects that trace segment.

This sample uses the UserDialog Editor in the Sax Basic Engine. See “Running Code Samples” 
for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListRteSegs$(10000)
Sub Main
index = 0 
For Each nextRteSeg In ActiveDocument.RouteSegments 
ListRteSegs$(index) = nextRteSeg.Name 
index = index + 1 
Next nextRteSeg 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Route Segments",.CallbackFunc ' 
%GRID:10,7,1,1 
ListBox 10,7,160,203,ListRteSegs(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened 
' in the dialog; it is used to easily process user actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
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ActiveDocument.SelectObjects(ppcbObjectTypeRouteSegment, 
ListRteSegs(SuppValue%)) 
End If 
End Select 
End Function
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RouteSegment.Net
This property returns the net connected to the trace segment.

Prototype

Net As Net

Arguments

None

Comments

None

Sample

The following sample code retrieves the net of the first trace segment found in the open design, 
assuming at least one trace segment exists. See “Running Code Samples” for more information 
on running this sample.

Sub Main
Set firstRteSeg = ActiveDocument.RouteSegments(1) 
MsgBox "Route segment " & firstRteSeg.Name & " is connected on net " & 
firstRteSeg.Net.Name 
End Sub
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RouteSegment.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypeRouteSegment. 

All database objects in the Automation server implement this property to compensate for the 
lack of a Visual Basic equivalent for the Visual C++ QueryInterface function.

This property is generally used:

• To identify the kind of PADS Layout database objects in a heterogeneous Objects 
collection.

• When implementing a generic routine that behavior depends on the type of database 
object passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypeVia 
' Do something specific to via objects 
Case ppcbObjectTypeConnection 
' Do something specific to connection objects 
Case ppcbObjectTypeRouteSegment 
' Do something specific to route segment objects 
Case ppcbObjectTypeJumper 
' Do something specific to jumper objects 
Case Else 
MsgBox "Not a PADS Layout database object" 
End Select 
End Sub
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RouteSegment.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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RouteSegment.Points
This property returns the array of points defining the trace segment.

Prototype

Points([unit As PPcbUnit]) AsVariant

Argument

Comments

None

unit [Optional] Unit in which the point coordinate values are returned.
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RouteSegment.SegmentType
This property returns the type of the trace segment.

Prototype

SegmentType As PPcbSegmentType

Arguments

None

Comments

None

Sample

The following sample code retrieves the segment type of the first trace segment found in the 
open design, assuming at least one trace segment exists. See “Running Code Samples” for more 
information on running this sample.

Function SegmentTypeName(theType As Long) As String
Select Case theType 
Case ppcbSegmentUnknown 
SegmentTypeName = "unknown" 
Case ppcbSegmentLine 
SegmentTypeName = "line" 
Case ppcbSegmentArc 
SegmentTypeName = "arc" 
Case Else 
SegmentTypeName = "unknown" 
End Select 
End Function
Sub Main
Set firstRteSeg = ActiveDocument.RouteSegments(1) 
MsgBox "Route segment " & firstRteSeg.Name & " is of type " & 
SegmentTypeName(firstRteSeg.SegmentType) 
End Sub
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RouteSegment.Selected
This property sets or returns whether the trace segment is selected.

Prototype

Selected As Boolean

Arguments

None

Comments

None

Sample

The following sample code selects the first trace segment found in the open design, assuming at 
least one trace segment exists. See “Running Code Samples” for more information on running 
this sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.RouteSegments(1).Selected = True 
End Sub

See Also

Document.SelectionChange Event
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RouteSegment.Width
This property returns the width of the trace segment or the width of draw lines used to fill 
copper items such a split planes or copper pours.

Prototype

Width([unit As PPcbUnit]) As Double

Arguments

Comments

None

Sample

The following sample code retrieves the width of the first trace segment found in the open 
design, assuming at least one trace segment exists. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set firstRteSeg = ActiveDocument.RouteSegments(1) 
MsgBox "Route segment " & firstRteSeg.Name & " width is " & 
firstRteSeg.Width 
End Sub

Argument Description

unit [Optional] Unit in which the width 
value is returned.
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SBP.Application
This property returns the Application object.

Restriction: This information applies to only the BGA toolkit.

Prototype

Application As Application 

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an application object and all Automation objects have an application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.

This is a Microsoft-required property.
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SBP.CBPs
This property returns the collection of CBPs linked to the SBP object.

Restriction: This information applies to only the BGA toolkit.

Prototype

CBPs As Objects

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of CBPs connected to each SBP in each die in 
the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox "Number of CBPs linked to " & aSBP.Name & ": " & aSBP.CBPs.Count 
Next 
End If 
Next 
End Sub

See Also

SBP.Wirebonds 
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SBP.Component
This property returns the Component object of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Component As Component

Arguments

None

Comments

None

Sample

The following sample code represents a subroutine that depends on the SBP object passed as an 
argument. The code retrieves the name of the component and the name of the decal to which the 
SBP belongs. See “Running Code Samples” for more information on running this sample.

Sub QuerySBP(aSBP As SBP)
MsgBox "Substrate Bond Pad" & aSBP.Name &  
"belongs to component" & aSBP.Component.Name &  
"(" & aSBP.Component.Decal &")" 
End Sub
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SBP.Function
This property returns the function of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Function As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the function of each SBP in each die in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & " Function: " & aSBP.Function 
Next 
End If 
Next 
End Sub
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SBP.Layer
This property returns the LIQ layer of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Layer As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the layer of each SBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & " Layer: " & aSBP.Layer 
Next 
End If 
Next 
End Sub
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SBP.Length
This property returns the length of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Length([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the length of each SBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & " Length: " & Format (aSBP.Length, "#.###") 
Next 
End If 
Next 
End Sub

See Also

SBP.Width 

unit [Optional] Unit in which the length value is returned.



PADS Layout User’s Guide and Reference Manual, PADS 9.42020

PADS Layout Automation Server
SBP.Name

SBP.Name
This default property returns the name of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Name As String

Arguments

None

Comments

This is a Microsoft-required property.

Sample

The following sample code retrieves the name of each SBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name 
Next 
End If 
Next 
End Sub
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SBP.ObjectType
This property returns the type of the object.

Restriction: This information applies to only the BGA toolkit.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

This property always returns ppcbObjectTypeSBP.

This property is generally used to identify the kind of database objects in a heterogeneous 
Objects collection or when implementing a generic routine that depends on the type of the 
database object passed as argument.

All database objects in the Automation server implement this property to compensate for the 
lack of an equivalent for the Visual C++ QueryInterface function.

Sample

See “Running Code Samples” for more information on running this sample.

Sub DoSomethingToDieObject(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeCBP 
' Do something specific to CBP objects 
Case ppcbObjectTypeSBP 
' Do something specific to SBP objects 
Case ppcbObjectTypeWirebond 
' Do something specific to Wirebond objects 
Case Else 
MsgBox "Not a Die object" 
End Select 
End Sub
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SBP.Orientation
This property returns SBP orientation, in degrees.

Restriction: This information applies to only the BGA toolkit.

Prototype

Orientation As Double

Arguments

None

Comments

None

Sample

The following sample code retrieves the orientation of each SBP in each die in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & " Orientation: " & Format (aSBP.Orientation, "#.###") 
Next 
End If 
Next 
End Sub
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SBP.Parent
The property returns the parent of the object.

Restriction: This information applies to only the BGA toolkit.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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SBP.Position X
This property returns the x-coordinate of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

PositionX([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the position of each SBP in each die in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & ": (" & aSBP.PositionX & ", " & aSBP.PositionY & ")" 
Next 
End If 
Next 
End Sub

See Also

SBP.PositionY 

unit [Optional] Unit in which the x-coordinate is returned.
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SBP.PositionY
This property returns the y-coordinate of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

PositionY([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the position of each SBP in each die in the open design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & ": (" & aSBP.PositionX & ", " & aSBP.PositionY & ")" 
Next 
End If 
Next 
End Sub

See Also

SBP.Position X 

unit [Optional] Unit in which the y-coordinate is returned.
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SBP.Shape
This property returns the shape of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Shape As PPcbBondPadShape

Arguments

None

Comments

None

Sample

The following sample code retrieves the shape of each SBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
Select Case aSBP.Shape 
Case ppcbBondPadShapeUnknown 
MsgBox aSBP.Name & " Shape: Unknown" 
Case ppcbBondPadShapeRectangle   
MsgBox aSBP.Name & " Shape: Rect" 
Case ppcbBondPadShapeOval  
MsgBox aSBP.Name & " Shape: Oval" 
Case Else  
MsgBox aSBP.Name & " Shape: Unknown" 
End Select  
Next 
End If 
Next 
End Sub
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SBP.Tier
This property returns the LIQ tier in which the SBP is placed.

Restriction: This information applies to only the BGA toolkit.

Prototype

Tier As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the tier for each SBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & " Tier: " & aSBP.Tier 
Next 
End If 
Next 
End Sub
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SBP.Width
This property returns the width of the SBP.

Restriction: This information applies to only the BGA toolkit.

Prototype

Width([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the width of each SBP in each die in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox aSBP.Name & " Width: " & Format (aSBP.Width (ppcbUnitInch), 
"#.###") 
Next 
End If 
Next 
End Sub

See Also

SBP.Length 

unit [Optional] Unit in which the width value is returned.
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SBP.Wirebonds
This property returns the collection of bond wires attached to the SBP object.

Restriction: This information applies to only the BGA toolkit.

Prototype

Wirebonds As Objects

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of bond wires connected to each SBP in each 
die in the open design. See “Running Code Samples” for more information on running this 
sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aSBP in comp.SBPs 
MsgBox "Number of WBs connected to " & aSBP.Name & ":" & 
aSBP.Wirebonds.Count 
Next 
End If 
Next 
End Sub

See Also

SBP.CBPs 
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Text.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This is a Microsoft-required property.
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Text.Drawing
This property returns a drawing with which the text is associated.

Prototype

Drawing as Drawing

Arguments

None

Comments

None

Sample

The following sample function displays the name of a drawing with which the text is associated. 
See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText, , TRUE) 
For Each txt In selected 
Dim drw as Drawing 
Set drw = txt.Drawing 
If Not drw Is Nothing Then 
s = "The " & txt.Name & " text" 
MsgBox s & " is associated with " &drw.Name & " drawing" 
End If 
Next txt 
End Sub
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Text.Height/Label.Height
This property returns or sets text or label height.

Prototype

Height (Unit as PPcbUnit) as Double

Argument

Comments

None

Samples

The following example shows the height of a selected text object, and then sets the height to 100 
mils. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
MsgBox "Selected text height: " & text.Height 
text.Height(ppcbUnitMils) = 100 
Next text 
End Sub

The following example shows the height of selected label object, and then sets height to 100 
mils. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
MsgBox "Selected label height: " & label.Height 
label.Height(ppcbUnitMils) = 100 
Next label 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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Text.HorzJustification/Label.HorzJustification
This property returns or sets the horizontal justification type of the text or label object.

Prototype

HorzJustification as PPcbHorizontalJustification 

Arguments

None

Comments

None

Samples

The following example shows the horizontal justification setting of the selected text object, and 
then sets the justification to center. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
Select Case text.HorzJustification 
Case ppcbJustifyLeft 
MsgBox "Horizontal justification: Left" 
Case pcbJustifyHCenter 
MsgBox "Horizontal justification: Center" 
Case pcbJustifyRight 
MsgBox "Horizontal justification: Right" 
End Select 
text.HorzJustification = ppcbJustifyHCenter 
Next text 
End Sub

The following example shows the horizontal justification setting of the selected label object, 
and then sets the justification to center. See “Running Code Samples” for more information on 
running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
Select Case label.HorzJustification 
Case ppcbJustifyLeft 
MsgBox "Horizontal justification: Left" 
Case ppcbJustifyHCenter 
MsgBox "Horizontal justification: Center" 
Case ppcbJustifyRight 
MsgBox "Horizontal justification: Right" 
End Select 
label.HorzJustification = ppcbJustifyHCenter 
Next label 
End Sub
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Text.Layer/Label.Layer
This property returns or sets the layer number of the text or label.

Prototype

Layer as Long

Arguments

None

Comments

None

Samples

The following example shows the layer number of the selected text object, and then sets the 
layer to 1. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
MsgBox "Selected text layer number: " & text.Layer 
text.Layer = 1 
Next text 
End Sub

The following example shows the layer number of the selected label object, and then sets the 
layer to 1. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
MsgBox "Selected label layer number: " & label.Layer 
label.Layer = 1 
Next label 
End Sub
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Text.LineWidth/Label.LineWidth
This property returns or sets the line width of the text or label.

Prototype

LineWidth (Unit as PPcbUnit) as Double

Argument

Comments

None

Samples

The following example shows the line width of the selected text objects, and then sets the width 
to 10 mils. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected 
MsgBox "Selected text line width: " & text.LineWidth 
text.LineWidth(ppcbUnitMils) = 10 
Next text 
End Sub

The following example shows the line width of the selected label objects, and then sets the 
width to 10 mils. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected 
MsgBox "Selected label line width: " & label.LineWidth 
label.LineWidth(ppcbUnitMils) = 10 
Next label 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is  ppcbUnitCurrent by default.
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Text.Mirror/Label.Mirror
This property returns or sets the mirrored state of the text or label.

Prototype

Mirror(Origin as PPcbOriginType) as Boolean

Argument

Comments

None

Samples

The following example shows whether the selected text object is mirrored, and then mirrors the 
text. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
MsgBox "Is selected text mirrored? " & text.Mirror 
text.Mirror = True 
Next text 
End Sub

The following example shows whether the selected label object is mirrored, and then mirrors 
the label. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
MsgBox "Is selected label mirrored? " & label.Mirror 
label.Mirror = True 
Next label 
End Sub

origin Shows whether the mirror status is relative to the object's parent or to the 
design (optional). The default value is ppcbOriginTypeDesign.
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Text.Name
This default property returns the name of the Text object.

Prototype

Name as String

Arguments

None

Comments

None

Sample

The following example displays a message box showing the name of the first free text in the 
active document. See “Running Code Samples” for more information on running this sample.

Sub Main
Set text = ActiveDocument.Texts(1) 
MsgBox "The first free text's name is " & text.Name 
End Sub
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Text.ObjectType
This property returns the type of object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None

Sample

The following sample shows the number of selected texts. See “Running Code Samples” for 
more information on running this sample.

Sub Main
Set sel = ActiveDocument.GetObjects(,,TRUE) 
n = 0 
For Each obj In sel 
If obj.ObjectType = ppcbObjectTypeText Then n = n + 1 
Next obj 
MsgBox n & " text(s) selected" 
End Sub
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Text.Orientation/Label.Orientation
This property returns or sets the rotation angle of the text or label.

Prototype

Orientation(Origin as PPcbOriginType) as Double

Argument

Comments

None

Samples

The following example shows the orientation of the selected text object, and then sets the 
orientation to 90 degrees. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
MsgBox "Selected text orientation: " & text.Orientation 
text.Orientation = 90 
Next text 
End Sub

The following example shows the orientation of the selected label object, and then sets the 
orientation to 90 degrees. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
MsgBox "Selected label orientation: " & label.Orientation 
label.Orientation = 90 
Next label 
End Sub

origin Shows whether the orientation value is relative to the object's parent or 
to the design (optional). The default value is ppcbOriginTypeDesign.
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Text.Parent
This property returns the parent of this object.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.

Sample

Not required.
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Text.PositionX/Label.PositionX
This property returns or sets the x-coordinate of the origin of the Text or Label object.

Prototype

PositionX (Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Samples

The following example shows the position of a selected text object, and then sets the position to 
(200, 200) mil. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
MsgBox "Selected text position: (" & text.PositionX & ", " & 
text.PositionX & ")" 
text.PositionX(ppcbUnitMils) = 200 
text.PositionY(ppcbUnitMils) = 200 
Next text 
End Sub

The following example shows the position of a selected label object, and then sets the position 
to (200, 200) mil. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
MsgBox "Selected label position: (" & label.PositionX & ", " & 
label.PositionX & ")" 
label.PositionX(ppcbUnitMils) = 200 
label.PositionY(ppcbUnitMils) = 200 
Next label 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is pcpbOriginTypeDesign.
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Text.PositionY/Label.PositionY
This property returns or sets the y-coordinate of the origin of the text or label object.

Prototype

PositionY(Unit as PPcbUnit, Origin as PPcbOriginType) as Double

Arguments

Comments

None

Samples

The following example shows the position of the selected text object, and then sets position to 
(200, 200) mil. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
MsgBox "Selected text position: (" & text.PositionX & ", " & 
text.PositionX & ")" 
text.PositionX(ppcbUnitMils) = 200 
text.PositionY(ppcbUnitMils) = 200 
Next text 
End Sub

The following example shows the position of the selected label object, and then sets position to 
(200, 200) mil. See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
MsgBox "Selected label position: (" & label.PositionX & ", " & 
label.PositionX & ")" 
label.PositionX(ppcbUnitMils) = 200 
label.PositionY(ppcbUnitMils) = 200 
Next label 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is  ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Text.Selected
This property sets or returns whether the text object is selected.

Prototype

Selected as Boolean

Arguments

None

Comments

None

Sample

The following sample displays a message indicating whether the first text is selected, then 
selects the text. See “Running Code Samples” for more information on running this sample.

Sub Main 
For Each txt In ActiveDocument.Texts 
Msgbox "Is Text " & txt.Text & " selected ? " & txt.Selected 
txt.Selected = True 
Exit For 
Next txt 
End Sub
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Text.Text
This property returns or sets contents of the text object.

Prototype

Text as String

Arguments

None

Comments

None

Sample

This sample shows the text string in the selected text object and then sets the string to “Hello!” 
See “Running Code Samples” for more information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected 
MsgBox "Selected text: " & text.Text 
text.Text = "Hello !"  
Next text 
End Sub
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Text.VertJustification/Label.VertJustification
This property returns or sets the vertical justification type of the text or label object.

Prototype

VertJustification as PPcbVerticalJustification 

Arguments

None

Comments

None

Samples

The following example shows the vertical justification setting of the selected text object, then 
sets the justification to center. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected  
Select Case text.VertJustification 
Case ppcbJustifyBottom 
MsgBox "Vertical justification: Bottom" 
Case ppcbJustifyVCenter 
MsgBox "Vertical justification: Center" 
Case ppcbJustifyTop 
MsgBox "Vertical justification: Top" 
End Select 
text.VertJustification = ppcbJustifyVCenter 
Next Text 
End Sub

The following example shows the vertical justification setting of the selected label object, then 
sets the justification to center. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,, TRUE) 
For Each label In selected  
Select Case label.VertJustification 
Case ppcbJustifyBottom 
MsgBox "Vertical justification: Bottom" 
Case ppcbJustifyVCenter 
MsgBox "Vertical justification: Center" 
Case ppcbJustifyTop 
MsgBox "Vertical justification: Top" 
End Select 
label.VertJustification = ppcbJustifyVCenter 
Next Label 
End Sub
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ThermalPad.Application
This property returns the application object.

Prototype

Application as Application

Argument

None



PADS Layout Automation Server
ThermalPad.CornerRadius

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2047

ThermalPad.CornerRadius
This property returns the Thermal Pad corner radius.

Prototype

CornerRadius as Double
      CornerRadius (unit as PPcbUnit)  as Double

Argument

unit - [Optional] Unit in which the value is returned.
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ThermalPad.CornerType
This property returns the Thermal Pad corner type.

Prototype

CornerType as PPcbPadCornerType

Argument

None



PADS Layout Automation Server
ThermalPad.InnerLength

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2049

ThermalPad.InnerLength
This property returns the Thermal Pad inner length.

Prototype

InnerLength as Double
      InnerLength (unit as PPcbUnit)  as Double

Argument

unit - [Optional] Unit in which the value is returned.
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ThermalPad.InnerSize
This property returns the thermal pad's inner size. For shape ppcbThermalPadShapeRound it 
returns inner diameter.

Prototype

InnerSize (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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ThermalPad.Name
This property returns the name of this thermal pad.

Prototype

Name as String

Argument

None
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ThermalPad.ObjectType
This property returns the type of the object - ppcbObjectTypeThermalPad.

Prototype

ObjectType as PPcbObjectType

Argument

None
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ThermalPad.Offset
This property returns the Thermal Pad offset.

Prototype

Offset as Double
      Offset  (unit as PPcbUnit)  as Double

Argument

unit - [Optional] Unit in which the value is returned.
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ThermalPad.Orientation
This property returns the Thermal Pad orientation.

Prototype

      Orientation as Double

Argument

      None
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ThermalPad.OuterSize
This property returns the thermal pad's outer size. For shape ppcbThermalPadShapeRound it 
returns outer diameter.

Prototype

OuterSize (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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ThermalPad.PadStackLayer
This property returns the PadStackLayer Object to which this thermal pad belongs to.

Prototype

PadStackLayer as PadStackLayer

Argument

None
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ThermalPad.Parent
This property returns the parent of the object.

Prototype

Parent as Document

Argument

None
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ThermalPad.Shape
This property returns the thermal pad shape.

Prototype

Shape as PPcbThermalPadShape

Argument

None
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ThermalPad.SpokeAngle
This property returns the thermal pad's spoke angle.

Prototype

SpokeAngle as Double 

Argument

None
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ThermalPad.Spokes
This property returns the thermal pad's number of spokes.

Prototype

Spokes as Integer 

Argument

None
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ThermalPad.SpokeWidth
This property returns the thermal pad's spoke width.

Prototype

SpokeWitdth (unit as PPcbUnit) as Double 

Argument

unit - [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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Via.Application
This property returns the Application object.

Prototype

Application As Application

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an application object and all Automation objects have an application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.
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Via.Attributes
This property returns the collection of all attributes of the via.

Prototype

Attributes As Attributes 

Attributes(name As String) As Attribute 

Argument

Comments

When an existing attribute name is passed to this property, it returns that via Attribute object. If 
the attribute name does not exist, this property returns the collection of all via attributes in an 
Attributes collection object.

Sample

The following sample code retrieves the number of attributes assigned to the first via found in 
the open design, assuming at least one via exists, using the Attributes.Count property. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox "There are " & firstVia.Attributes.Count & " attribute(s) in via " 
& firstVia.Name 
End Sub

name Name of an existing via attribute.
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Via.DrillSize
This property returns the drill size of the via.

Prototype

DrillSize([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the drill size of the first via found in the open design, 
assuming at least one via exists. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox firstVia.Name & " has a drill of " & firstVia.DrillSize 
End Sub

unit [Optional] Unit in which the drill size value is returned.
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Via.EndLayer
This property returns the end layer of the via.

Prototype

EndLayer As Long

Arguments

None

Comments

None

Sample

The following sample code retrieves the first/end layer of the first via found in the open design, 
assuming at least one via exists. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox firstVia.Name & " starts on layer " & firstVia.StartLayer & " and 
ends on layer " & firstVia.EndLayer 
End Sub

See Also

Via.StartLayer
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Via.Glued
This property sets or returns whether the via is glued.

Prototype

Glued As Boolean

Arguments

None

Comments

None

Sample

The following sample code glues all vias in the open design. See “Running Code Samples” for 
more information on running this sample.

Sub Main
For Each nextVia In ActiveDocument.Vias 
nextVia.Glued = True 
Next nextVia 
End Sub
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Via.Highlighted
This property returns whether the via is highlighted.

Prototype

Highlighted as Boolean

Argument

None
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Via.Name
This property returns the name of the via.

Prototype

Name As String

Arguments

None

Comments

This property is the default property for the Via object.

Sample

The following sample code lists all vias in the open design by name and then places that list in a 
custom dialog box. When a via is selected in the list box, the sample selects that via in PADS 
Layout.

This sample uses the User Dialog Editor in the Sax Basic Engine in PADS Layout. See 
“Running Code Samples” for more information on running this sample.

See also: Sax Basic Editor On Line Help 
(C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs\sbe5_000.hlp)

Dim ListVias$(10000)
Sub Main
index = 0
For Each nextVia In ActiveDocument.Vias 
ListVias$(index) = nextVia.Name 
index = index + 1 
Next nextVia 
' This piece of code is automatically generated by the Basic Dialog Editor 
in PADS Layout. 
Begin Dialog UserDialog 180,238,"Vias",.CallbackFunc ' %GRID:10,7,1,1 
ListBox 10,7,160,203,ListVias(),.ListBox1 
OKButton 10,210,160,21 
End Dialog 
Dim dlg As UserDialog 
Dialog dlg 
End Sub
' The following function is automatically called by the system when 
something has happened 
' in the dialog; it is used to easily process user actions.
Function CallbackFunc%(DlgItem$, Action%, SuppValue%)
Select Case Action% 
Case 2 ' Value changing or button pressed 
If DlgItem$ = "ListBox1" Then 
ActiveDocument.SelectObjects(ppcbObjectTypeAll, , False) 
ActiveDocument.SelectObjects(ppcbObjectTypeVia, ListVias(SuppValue%)) 
End If 
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End Select 
End Function
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Via.Net
This property returns the net attached to the via.

Prototype

Net As Net

Arguments

None

Comments

None

Sample

The following sample code retrieves the net connected to the first via found in the open design, 
assuming at least one via exists. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox firstVia.Name & " is connected to net " & firstVia.Net.Name 
End Sub
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Via.ObjectType
This property returns the type of the object.

Prototype

ObjectType As PPcbObjectType

Arguments

None

Comments

This property returns ppcbObjectTypeVia. 

All PADS Layout database objects in the PADS Layout Automation server implement this 
property to compensate for the lack of a Visual Basic equivalent for the Visual C++ 
QueryInterface function.

This property is generally used:

• To identify the kind of PADS Layout database objects in a heterogeneous Objects 
collection.

• When implementing a generic routine that depends on the type of the PADS Layout 
database object passed as argument. For example:

Sub DoSomething(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeComponent 
' Do something specific to component objects 
Case ppcbObjectTypeNet 
' Do something specific to net objects 
Case ppcbObjectTypePin 
' Do something specific to pin objects 
Case ppcbObjectTypeVia 
' Do something specific to via objects 
Case ppcbObjectTypeConnection 
' Do something specific to connection objects 
Case ppcbObjectTypeRouteSegment 
' Do something specific to route segment objects 
Case ppcbObjectTypeJumper 
' Do something specific to jumper objects 
Case Else 
MsgBox "Not a PADS Layout database object" 
End Select 
End Sub
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Via.PadStackLayers
This property returns the collection of all padstack layers for this via.

Prototype

PadStackLayers as Objects

PadStackLayers(layerName as String) as PadStackLayer

Argument

Return Values

When a layer name is passed to this property, it returns that PadStackLayer Object. If the name 
is not specified, this property returns the collection of all padstack layers in an Objects 
collection object.

Sample

For Each via In Application.ActiveDocument.Vias
  For Each layer in via.PadStackLayers

    MsgBox layer.Number & ", " & layer.Name

    pad = layer.Pad
    MsgBox pad.Name & ", " & pad.Shape & ", " & pad.Diameter & ", " 
           & pad.InnerDiameter & ", " & pad.Width & ", " 
           & pad.Length & ", " & pad.offset & ", " 
           & pad.Orientation & ", " & pad.CornerType & ", " 
           & pad.CornerRadius
      
    thermalpad = layer.ThermalPad
    If thermalpad Is Nothing Then
      MsgBox "Thermal pad not defined on this layer"
    Else
      MsgBox thermalpad.Name & ", " & thermalpad.Shape & ", " 
             & thermalpad.InnerSize & ", " 
             & thermalpad.OuterSize & ", " & thermalpad.Spokes & ", " 
             & thermalpad.SpokeAngle  & ", " & thermalpad.SpokeWidth
    End If

    antipad = layer.AntiPad
    If antipad Is Nothing Then
      MsgBox "Anti pad not defined on this layer"
    Else
      MsgBox antipad.Name & ", " & antipad.Shape & ", " 
             & antipad.Size
     End If

  Next layer       
Next via

layerName Name of padstack layer
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Via.Parent
This property returns the parent of the object.

Prototype

Parent As Document

Arguments

None

Comments

None
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Via.PlaneThermal
This property returns whether the via has a plane thermal.

Prototype

PlaneThermal As Boolean

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of plane thermal vias in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
nbPTVias = 0 
For Each nextVia In ActiveDocument.Vias 
If nextVia.PlaneThermal = True Then nbPTVias = nbPTVias +1 
Next nextVia 
MsgBox "There are " & nbPTVias & " plane thermal vias (out of " & 
ActiveDocument.Vias.Count & ") in " & ActiveDocument.Name 
End Sub
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Via.Plated
This property returns whether the via is plated.

Prototype

Plated As Boolean

Arguments

None

Comments

None

Sample

The following sample code retrieves the number of nonplated vias in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
nbPlatedVias = 0 
For Each nextVia In ActiveDocument.Vias 
If nextVia.Plated = False Then nbPlatedVias = nbPlatedVias +1 
Next nextVia 
MsgBox "There are " & nbPlatedVias & " non-plated pins (out of " & 
ActiveDocument.Vias.Count & ") in " & ActiveDocument.Name 
End Sub
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Via.PositionX
This property returns the x-coordinate of the via.

Prototype

PositionX([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the location of the first via found in the open design, 
assuming at least one via exists, in current design units. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox firstVia.Name & " position is (" & firstVia.PositionX & ", " & 
firstVia.PositionY & ")" 
End Sub

See Also

Via.PositionY

unit [Optional] Unit in which the x-coordinate is returned.
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Via.PositionY
This property returns the y-coordinate of the via.

Prototype

PositionY([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the location of the first via found in the open design, 
assuming at least one via exists, in current design units. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox firstVia.Name & " position is (" & firstVia.PositionX & ", " & 
firstVia.PositionY & ")" 
End Sub

See Also

Via.PositionX

unit [Optional] Unit in which the y-coordinate is returned.
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Via.Selected
This property sets or returns whether the via is selected.

Prototype

Selected As Boolean

Arguments

None

Comments

None

Sample

The following sample code selects the first via found in the open design, assuming at least one 
via exists. See “Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.SelectObjects(,,False) 
ActiveDocument.Vias(1).Selected = True 
End Sub

See Also

Document.SelectionChange Event 
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Via.StartLayer
This property returns the start layer of the via.

Prototype

StartLayer As Long

Arguments

None

Comments

None

Sample

The following sample code retrieves the first/end layer of the first via found in the open design, 
assuming at least one via exists. See “Running Code Samples” for more information on running 
this sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox firstVia.Name & " starts on layer " & firstVia.StartLayer & " and 
ends on layer " & firstVia.EndLayer 
End Sub

See Also

Via.EndLayer
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Via.Stitching
This property sets or returns the via’s stitching status.

Prototype

Stitching As Boolean

Arguments

None

Comments

None

Sample

The following sample code selects all stitching vias in the open design. See “Running Code 
Samples” for more information on running this sample. 

Sub Main
For Each nextVia In ActiveDocument.Vias 
If nextVia.Stitching Then
nextVia.Selected = True
End If
Next nextVia 
End Sub
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Via.TestPoint
This property sets or returns whether the via is a test point.

Prototype

TestPoint As PPcbTestPointType 

Arguments

None

Comments

None

Sample

The following sample code removes all via test points from the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
For Each nextVia In ActiveDocument.Vias 
nextVia.TestPoint = ppcbTestPointNone 
Next nextVia 
End Sub
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Via.Type
This property returns the type of the via.

Prototype

Type As String

Arguments

None

Comments

None

Sample

The following sample code retrieves the type of the first via found in the open design, assuming 
at least one via exists. See “Running Code Samples” for more information on running this 
sample.

Sub Main
Set firstVia = ActiveDocument.Vias(1) 
MsgBox firstVia.Name & " type is " & firstVia.Type 
End Sub
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View.Application
This property returns the Application object.

Prototype

Application As Application 

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an application object and all Automation objects have an application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications), to quickly identify the 
application to which the object belongs.
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View.BottomRightX
This property returns the x-coordinate of the lower right corner of the view.

Prototype

BottomRightX([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the coordinates of the current view in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
x0 = Format$(ActiveDocument.ActiveView.TopLeftX, "Fixed") 
y0 = Format$(ActiveDocument.ActiveView.TopLeftY, "Fixed") 
x1 = Format$(ActiveDocument.ActiveView.BottomRightX, "Fixed") 
y1 = Format$(ActiveDocument.ActiveView.BottomRightY, "Fixed") 
MsgBox "View is (" & x0 & ", " & y0 & ") - (" & x1 & ", " & y1 & ") 
End Sub

See Also

View.BottomRightY,View.TopLeftX,View.TopLeftY 

unit [Optional] Unit in which the lower right x-coordinate is returned.



PADS Layout Automation Server
View.BottomRightY

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2085

View.BottomRightY
This property returns the y-coordinate of the lower right corner of the view.

Prototype

BottomRightY([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the coordinates of the current view in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
x0 = Format$(ActiveDocument.ActiveView.TopLeftX, "Fixed") 
y0 = Format$(ActiveDocument.ActiveView.TopLeftY, "Fixed") 
x1 = Format$(ActiveDocument.ActiveView.BottomRightX, "Fixed") 
y1 = Format$(ActiveDocument.ActiveView.BottomRightY, "Fixed") 
MsgBox "View is (" & x0 & ", " & y0 & ") - (" & x1 & ", " & y1 & ") 
End Sub

See Also

View.BottomRightX, View.TopLeftX,View.TopLeftY 

unit [Optional] Unit in which the lower right y-coordinate is returned.
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View.CenterX
This property returns the x-coordinate of center of the view.

Prototype

CenterX (Unit as PPcbUnit) as Double

Argument

Comments

None

Sample

The following sample code displays the current view's center and zoom level. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set v = ActiveDocument.ActiveView 
Dim msg as String 
msg = "View parameters:" & Chr(13) & Chr(10) 
msg = msg & "Center: (" & v.CenterX & ", " & v.CenterY & ")" & Chr(13) & 
Chr(10) 
MsgBox msg & "Zoom: " & v.Zoom 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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View.CenterY
This property returns the y-coordinate of center of the view.

Prototype

CenterY(Unit as PPcbUnit) as Double

Argument

Comments

None

Sample

The following sample code displays the current view's center and zoom level. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set v = ActiveDocument.ActiveView 
Msg = "View parameters:" & Chr(13) & Chr(10) 
Msg = Msg & "Center: (" & v.CenterX & ", " & v.CenterY & ")" & Chr(13) & 
Chr(10) 
MsgBox msg & "Zoom: " & v.Zoom 
End Sub

unit [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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View.Name
This property returns the name of the view. For example, in PADS Layout, this function returns 
the string “Current View.”

Prototype

Name As String

Arguments

None

Comments

This property is the default property for the view object.

Sample

The following sample code retrieves the name of the current view. See “Running Code 
Samples” for more information on running this sample.

Sub Main
MsgBox ActiveDocument.ActiveView.Name 
End Sub
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View.ObjectType
This property returns the type of this object.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

None
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View.Parent
This property returns the parent of the object.

Prototype

Parent As Document 

Arguments

None

Comments

None
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View.PointerX
This property returns the pointer's X position.

Prototype

PointerX (unit as PPcbUnit) as Double 

Argument

Sample

' load preview.pcb
Application.ModelessCommand("s")
DlgModelessCmd.Command = "s C8"
DlgModelessCmd.OnOk()

doc = Application.ActiveDocument
view = doc.ActiveView
MsgBox view.PointerX & ", " & view.PointerY

unit [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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View.PointerY
This property returns the pointer's Y position.

Prototype

PointerY (unit as PPcbUnit) as Double 

Argument

Sample

' load preview.pcb
Application.ModelessCommand("s")
DlgModelessCmd.Command = "s C8"
DlgModelessCmd.OnOk()

doc = Application.ActiveDocument
view = doc.ActiveView
MsgBox view.PointerX & ", " & view.PointerY

unit [Optional] Unit in which the value is returned. This optional argument is 
ppcbUnitCurrent by default.
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View.TopLeftX
This property returns the x-coordinate of the upper left corner of the view.

Prototype

TopLeftX([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the coordinates of the current view in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
x0 = Format$(ActiveDocument.ActiveView.TopLeftX, "Fixed") 
y0 = Format$(ActiveDocument.ActiveView.TopLeftY, "Fixed") 
x1 = Format$(ActiveDocument.ActiveView.BottomRightX, "Fixed") 
y1 = Format$(ActiveDocument.ActiveView.BottomRightY, "Fixed") 
MsgBox "View is (" & x0 & ", " & y0 & ") - (" & x1 & ", " & y1 & ") 
End Sub

See Also

View.BottomRightX,View.BottomRightY,View.TopLeftY

unit [Optional] Unit in which the upper left x-coordinate is returned.
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View.TopLeftY
This property returns the y-coordinate of the upper left corner of the view.

Prototype

TopLeftY([unit As PPcbUnit]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the coordinates of the current view in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
x0 = Format$(ActiveDocument.ActiveView.TopLeftX, "Fixed") 
y0 = Format$(ActiveDocument.ActiveView.TopLeftY, "Fixed") 
x1 = Format$(ActiveDocument.ActiveView.BottomRightX, "Fixed") 
y1 = Format$(ActiveDocument.ActiveView.BottomRightY, "Fixed") 
MsgBox "View is (" & x0 & ", " & y0 & ") - (" & x1 & ", " & y1 & ") 
End Sub

See Also

View.BottomRightX,View.BottomRightY,View.TopLeftX,

unit [Optional] Unit in which the upper left y-coordinate is returned.
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View.Zoom
This property returns the current zoom factor.

Prototype

Zoom as Double

Arguments

None

Comments

The zoom factor is 1 when the view is zoomed out as far as possible. When zooming in, the 
zoom factor grows in proportion to the size of object.

Sample

The following sample code displays the current view's center and zoom factor. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set v = ActiveDocument.ActiveView 
msg = "View parameters:" & Chr(13) & Chr(10) 
msg = msg & "Center: (" & v.CenterX & ", " & v.CenterY & ")" & Chr(13) & 
Chr(10) 
MsgBox msg & "Zoom: " & v.Zoom 
End Sub
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Wirebond.Angle
This property returns the angle between the wire bond and the edge of the die, in degrees.

Restriction: This information applies to only the BGA toolkit.

Prototype

Angle As Double

Arguments

None

Comments

None

Sample

The following sample code retrieves the angle between the bond wire and the edge of the die for 
each wire bond in the die, in the open design. See “Running Code Samples” for more 
information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & ": Angle: " & Format (aWB.Angle, "#.###") 
Next 
End If 
Next 
End Sub
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Wirebond.Application
This property returns the Application object.

Restriction: This information applies to only the BGA toolkit.

Prototype

Application As Application 

Arguments

None

Comments

This property identifies the object as an Automation object. All Automation server applications 
have an Application object and all Automation objects have an Application property. This 
property is usually used in Automation client applications that handle large volumes of objects 
from different sources, such as different Automation server applications, to quickly identify the 
application to which the object belongs.

This is a Microsoft-required property.
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Wirebond.Component
This property returns the component object of the wire bond.

Restriction: This information applies to only the BGA toolkit.

Prototype

Component As Component

Arguments

None

Comments

None

Sample

The following sample code represents a subroutine that depends on the Wirebond object passed 
as an argument. The code retrieves the name of the component and the name of the decal to 
which the wire bond belongs. See “Running Code Samples” for more information on running 
this sample.

Sub QueryWB(aWB As Wirebond)
MsgBox "Bond Wire" & aWB.Name &  
"belongs to component" & aWP.Component.Name &  
"(" & aWP.Component.Decal &")" 
End Sub
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Wirebond.EndOffsetX
This property returns the x offset of the endpoint of the bond wire from the center of the end 
pad.

Restriction: This information applies to only the BGA toolkit.

Prototype

EndOffsetX([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the end offset of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & ": (" & aWB.EndOffsetX & ", " & aWB.EndOffsetY & ")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.EndOffsetY,Wirebond.EndPad,Wirebond.StartOffsetX,Wirebond.StartOffsetY 

unit [Optional] Unit in which the X offset value is returned.
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Wirebond.EndOffsetY
This property returns the y offset of the endpoint of the bond wire from the center of the end 
pad.

Restriction: This information applies to only the BGA toolkit.

Prototype

EndOffsetY([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the end offset of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & ": (" & aWB.EndOffsetX & ", " & aWB.EndOffsetY & ")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.EndOffsetX,Wirebond.EndPad,Wirebond.StartOffsetX,Wirebond.StartOffsetY 

unit [Optional] Unit in which the Y offset value is returned.
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Wirebond.EndPad
This property returns the end pad to which the bond wire is attached.

Restriction: This information applies to only the BGA toolkit.

Prototype

EndPad As Object

Arguments

None

Comments

This property can return either the CBP or SBP object.

Sample

The following sample code retrieves the names of the end pads of each bond wire for each die in 
the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.StartPad.Name & " - " & aWB.EndPad.Name 
Next 
End If 
Next 
End Sub

See Also

Wirebond.StartPad, Wirebond.StartOffsetX, Wirebond.StartOffsetY 
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Wirebond.EndX
This property returns the x-coordinate for the end of the bond wire.

Restriction: This information applies to only the BGA toolkit.

Prototype

EndX([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the end position of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & " End: (" & aWB.EndX & ", " & aWB.EndY & ")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.EndY,Wirebond.EndPad, Wirebond.StartX, Wirebond.StartY 

unit [Optional] Unit in which the x-coordinate value is returned.
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Wirebond.EndY
This property returns the y-coordinate for the end of the bond wire.

Restriction: This information applies to only the BGA toolkit.

Prototype

EndY([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the end position of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & " End: (" & aWB.EndX & ", " & aWB.EndY & ")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.EndX,Wirebond.EndPad, Wirebond.StartX, Wirebond.StartY 

unit [Optional] Unit in which the y-coordinate value is returned.
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Wirebond.Name
This default property returns the name of the bond wire.

Restriction: This information applies to only the BGA toolkit.

Prototype

Name As String

Arguments

None

Comments

This is a Microsoft-required property.

Sample

The following sample code retrieves the name of each SBP and CBP to which the bond wire is 
attached. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name 
Next 
End If 
Next 
End Sub
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Wirebond.ObjectType
This property returns the object type of the bond wire.

Restriction: This information applies to only the BGA toolkit.

Prototype

ObjectType As PPcbObjectType 

Arguments

None

Comments

This property returns PPcbObjectTypeWirebond.

This property is generally used to identify the kind of database objects in a heterogeneous 
Objects collection or when implementing a generic routine that depends on the type of the 
database object passed as argument.

All database objects in the Automation server implement this property to compensate for the 
lack of an equivalent for the Visual C++ QueryInterface function.

Sample

See “Running Code Samples” for more information on running this sample.

Sub DoSomethingToDieObject(dbObject As Object)
Select Case dbObject.ObjectType 
Case ppcbObjectTypeCBP 
' Do something specific to CBP objects 
Case ppcbObjectTypeSBP 
' Do something specific to SBP objects 
Case ppcbObjectTypeWirebond 
' Do something specific to Wirebond objects 
Case Else 
MsgBox "Not a Die object" 
End Select 
End Sub
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Wirebond.Parent
This property returns the parent object of the bond wire.

Restriction: This information applies to only the BGA toolkit.

Prototype

Parent As Document

Arguments

None

Comments

This is a Microsoft-required property.
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Wirebond.StartOffsetX
This property returns the x offset of the start point of the bond wire from the center of the start 
pad.

Restriction: This information applies to only the BGA toolkit.

Prototype

StartOffsetX([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the start offset of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & ": (" & aWB.StartOffsetX & ", " & aWB.StartOffsetY & 
")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.StartOffsetY,Wirebond.StartPad,Wirebond.EndOffsetX,Wirebond.EndOffsetY 

unit [Optional] Unit in which the x offset value is returned.
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Wirebond.StartOffsetY
This property returns the y offset of the start point of the bond wire from the center of the start 
pad.

Restriction: This information applies to only the BGA toolkit.

Prototype

StartOffsetY([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the start offset of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & ": (" & aWB.StartOffsetX & ", " & aWB.StartOffsetY & 
")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.StartOffsetX,Wirebond.StartPad,Wirebond.EndOffsetX,Wirebond.EndOffsetY 

unit [Optional] Unit in which the y offset value is returned.
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Wirebond.StartPad
This property returns the start pad to which the bond wire is attached.

Restriction: This information applies to only the BGA toolkit.

Prototype

StartPad As Object

Arguments

None

Comments

This property can return either the CBP or the SBP object.

Sample

The following sample code retrieves the names of the end pads of each bond wire for each die in 
the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.StartPad.Name & " - " & aWB.EndPad.Name 
Next 
End If 
Next 
End Sub

See Also

Wirebond.EndPad,Wirebond.EndOffsetX,Wirebond.EndOffsetY 
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Wirebond.StartX
This property returns the x-coordinate for the start of the bond wire.

Restriction: This information applies to only the BGA toolkit.

Prototype

StartX([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the start position of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & " Start: (" & aWB.StartX & ", " & aWB.StartY & ")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.StartY, Wirebond.StartPad,Wirebond.EndX, Wirebond.EndY

unit [Optional] Unit in which the x-coordinate value is returned.
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Wirebond.StartY
This property returns the y-coordinate for the start of the bond wire.

Restriction: This information applies to only the BGA toolkit.

Prototype

StartY([unit As PPcbUnit = ppcbUnitCurrent]) As Double

Argument

Comments

None

Sample

The following sample code retrieves the start position of each bond wire for each die in the open 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
For Each comp In ActiveDocument.Components 
If comp.IsDiePart Then 
For Each aWB in comp.Wirebonds 
MsgBox aWB.Name & " Start: (" & aWB.StartX & ", " & aWB.StartY & ")" 
Next 
End If 
Next 
End Sub

See Also

Wirebond.StartX, Wirebond.StartPad, Wirebond.EndX, Wirebond.EndY 

Optional Argument
An optional argument is an argument to a property or a method that can be omitted because a 
default value is used when the optional argument is not specified. The default value is the value 
that is statistically used most, or one that is most representative for the argument.

For example if the method M([arg1], [arg2]) has both arg1 and arg2 arguments set as optional, 
you can call the method M in four different ways: 

M() The default values of both arg1 and arg2 are passed.

M(<value1>) Arg1 <value1> and arg2 default value are passed.

M(, <value2>) Arg1 default value and arg2 <value2> are passed.

unit [Optional] Unit in which the y-coordinate value is returned.
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M(<value1>, <value2>)
Both arg1 <value1> and arg2 <value2> are passed.

Variant
A Variant is a data type which can contain or represent any kind of data, such as a Boolean 
value, an Integer value, a Long value, a Double value, a String value, or an Array.

The Variant data type is used in Automation in two different situations:

• When the argument of a property or method is data that can be represented as different 
values and value types. For example, a specific object in a collection of objects is 
referenced by its index in the collection (a Long value) or its name (a String value).

• When the argument or the return value of a property or a method is a complex type that 
is not explicitly defined. For example, an array of points is represented as a Variant.

Exception
An Automation exception is a special notification from the server that signals the Automation 
client of an error. For example, if a Basic script is trying to delete an attribute that doesn't exist, 
the program generates an exception. When the script receives the exception, the following 
occurs:

• If an exception handler is implemented using the On Error Basic statement, then the 
flow of execution of the client code is rerouted to the exception handler.

• If an exception handler is not implemented, then the client's default handler is called. In 
all Basic interpreters, the default handler is a break point at the line that generated the 
exception.

Methods
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Application.CreateLibrary
This method creates a new library.

Prototype

Creates new Library

CreateLibrary(Name as String, overwrite as Boolean) as Library

Argument

Return Values

Created library object or null when failed.

Comments

None

name Name of the library to create. Should not include wildcards.

overwrite Should be overwritten if it exists.
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Application.ExportLibraryItems
This method generates a PADS format ASCII file from the library items.

Prototype

ExportLibraryItems(Filename as String, Items as Collection)

Arguments

Return Values

None

Comments

Up to four files can be generated.

Sample

The following sample code exports library items, beginning with the letter 'R', from a library to 
a specified file. See “Running Code Samples” for more information on running this sample.

Sub Main
Set coll = GetLibraryItems(, "R*") 
ExportLibraryItems("C:\sample", coll) 
End Sub

filename Name of the file to which to export the library item. Do not specify a file 
name extension.

items Optional collection of items to export. If omitted, all items from the 
collection are exported.
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Application.GetConfigParamInt
This method retrieves the integer value from the specified parameter and section in the 
powerpcb.ini file.

Prototype

GetConfigParamInt(

sectionName as String,

paramName as String,

defaultValue as Integer) as Integer

Argument

Return Values

The parameter value or default value.

Sample

MsgBox Application.GetConfigParamString(
"directories", " FileDir", " C:\PADS Projects\")

MsgBox Application.GetConfigParamInt(
"general", " Display_Start_up_File_Dialog", 0)

sectionName Name of the section containing the parameter name.

paramName Name of the parameter whose associated integer value is to be retrieved.

defaultValue If parameter name cannot be found, the default value is returned
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Application.GetConfigParamString
This method retrieves the string from the specified parameter and section in the powerpcb.ini 
file.

Prototype

GetConfigParamString(

sectionName as String,

paramName as String,

defaultValue as String) as String

Argument

Return Values

The parameter value or default value.

Sample

MsgBox Application.GetConfigParamString(
"directories", " FileDir", " C:\PADS Projects\")

MsgBox Application.GetConfigParamInt(
"general", " Display_Start_up_File_Dialog", 0)

sectionName Name of the section containing the parameter name.

paramName Name of the parameter whose associated string is to be retrieved.

defaultValue If parameter name cannot be found, the default value is returned
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Application.GetLibraryItems
This method returns a collection of library items in all available libraries, a collection of all 
items of a given type, or a specific item.

Prototype

GetLibraryItems (Type as PPcbLibraryItemType, Name as String) as LibraryItem

Arguments

Comments

None

Sample

The following sample code displays the number of available library items. See “Running Code 
Samples” for more information on running this sample.

Sub Main
MsgBox "Number of library items: " & GetLibraryItems().Count 
End Sub

type Type of items (optional) to retrieve. Default value is 
ppcbLibraryItemTypeAll.

name Name of the item to retrieve (optional). May include wildcards, ranges, 
and lists.
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Application.LockServer
This method locks the Automation server.

Prototype

LockServer()

Arguments

None

Return Values

None

Comments

To speed OLE call processing, use this function when your client makes many OLE calls to the 
server.

Warning: Never forget to unlock a locked server. Do not keep the server locked for more than 
a few minutes.

The server locking mechanism speeds up processing by a factor of 2X to 8X the access time of 
the OLE server method or property calls. The server locking mechanism is dangerous because it 
disables many internal background tasks in the server, such as memory cleanup and visual 
updates. These server tasks must be performed regularly, but are disabled so that OLE incoming 
calls can be processed quickly.

Do not keep the server locked for more than a few minutes.

Sample

The following sample code shows how to use this method. See “Running Code Samples” for 
more information on running this sample.

Sub Main
LockServer 
' Do something lengthy, which makes many calls to the PADS Layout 
Automation server 
UnlockServer 
End Sub

See Also

Application.UnlockServer
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Application.Measure
This method creates and returns a measure value object.

Prototype

Measure(Value As Variant, [DefaultUnit As String = ""]) As Measure

Arguments

Comments

This property parses string value such as “100pF” and creates a special object from which you 
can extract additional information such as real value, unit name, quantity name, and so on.

If the Value parameter contains unit information then DefaultUnit parameter is ignored.

If the Value parameter does not contain unit information and DefaultUnit is empty then a new 
Measure of Size/Dimension is created, and Value parameter will be interpreted by default as a 
number in current PADS Layout design units (mils). 

If the parser cannot recognize measure in the Value parameter it creates a dummy Measure 
object with the Measure.Value property equal to 0.0 and Measure.Text property equal to the 
Value parameter.

Notice that there is a difference between Measure (“100”, “pF”) and Measure (“100pF”). 
Though both versions represent the same physical measure 100pF, the first one stores exact text 
representation without units.

Sample

The following sample adds a measure. See “Running Code Samples” for more information on 
running this sample.

Sub Main 
Set M1 = Measure("500pF") 
MsgBox M1.Text 'displays 500pF 
End Sub

See Also

Attribute.Measure

value String or number representing a measure value including optional prefix 
and optional physical unit.

defaultunit Optional string that contains default prefix and/or physical unit.
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Application.OpenDocument Method
This method opens a design file.

Prototype

OpenDocument(filename As String) As Document 

Argument

Return Values

If the function succeeds, the return value is the newly opened Document.

If the function fails, the return value is current document.

Comments

If filename does not contain the full path to the file, the program uses the path specified by the 
Application.DefaultFilePath property to locate the file.

If filename is an empty string, a new blank design file is created. 

If the file specified by filename cannot be found or cannot be opened, the return value is current 
document.

This method does not check if the currently opened file was saved or not. It is the client's 
responsibility to use the Document.Saved property to check if the open design needs to be 
saved.

This method generates an exception if a security failure occurs during processing.

Sample

The following sample code opens PWRDEMOA.PCB, assuming that it exists in the folder 
specified in the Application.DefaultFilePath property. The sample then displays the name of the 
newly opened file. See “Running Code Samples” for more information on running this sample.

Sub Main
OpenDocument(DefaultFilePath & "\PWRDEMOA.PCB") 
MsgBox ActiveDocument.FullName & " has just been opened." 
End Sub

See Also

Application.ActiveDocument, Application.DefaultFilePath, Document.Name, 
Document.Saved, Application.OpenDocument Event

filename Name of the file to open.
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Application.OpenDocumentNoLock Method
This method opens a design file without file locking.

Prototype

OpenDocumentNoLock(filename As String) As Document 

Argument

Return Values

If the function succeeds, the return value is the newly opened Document.

If the function fails, the return value is current document.

filename Name of the file to open.
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Application.OpenTempDocument Method
This method works in the same way as OpenDocumentNoLock but additionally doesn’t add the 
filename to the MRU (Most Recently Used) list. This method is mainly intended for macro 
tests.

Prototype

OpenTempDocument(filename As String) As Document 

Argument

Return Values

If the function succeeds, the return value is the newly opened Document.

If the function fails, the return value is current document.

filename Name of the file to open.
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Application.Quit Method
Warning: Do not use this method.

This method shuts down the program.

Prototype

Quit()

Arguments

None

Return Values

None

Comments

Microsoft requires that all Automation Application objects implement this method; however, 
calling this method violates some important client/server rules:

• A server cannot shut down until all clients disconnect from it. Since it is, by definition, 
not possible for a client to call the Quit method (or any other server method) after it 
disconnects from the server, it is not possible for a client to shut down a server.

• A client cannot know if other clients are connected to the server. It, therefore, should not 
shut down a server.

• A server has its own shutdown management process: when the last client disconnects 
from the server, the server automatically shuts down only if its Graphical User Interface 
(GUI) is not active (not visible). Otherwise, the server remains active.

To force a shutdown, an Automation client needs to make the program invisible using the 
Application.Visible property, and then disconnect from it. If no other clients are connected to 
PADS Layout at that time, the program automatically shuts down. If an Automation client is a 
Visual Basic script running in the Sax Basic Engine, it can never successfully shut down the 
Automation server.

See Also

Application.Quit Event
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Application.RunMacro
This method runs a macro.

Prototype

RunMacro(filename As String, macroname As String)

Arguments

Return Values

None

Comments

If filename does not contain the full path to the file, the program uses the path specified by the 
Application.DefaultFilePath property to locate the file. 

If filename is Empty, or is an empty string, the current default macro file is used.

If macroname is Empty, or not a valid macro name, nothing is performed.

This method generates an exception if a security failure occurs during processing.

Sample

The following sample code runs the macro MACRO1, recorded in the macro file 
MACROS.MCR, assuming that the macro exists in the folder specified by the 
Application.DefaultFilePath property. See “Running Code Samples” for more information on 
running this sample.

Sub Main
RunMacro(DefaultFilePath & "\MACROS.MCR", "MACRO1") 
End Sub

filename Name of the macro file to use.

macroname Name of the macro to run.
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Application.UnlockServer
This method unlocks the Automation server.

Prototype

UnlockServer()

Arguments

None

Return Values

None

Sample

The following sample code shows how to use this method. See “Running Code Samples” for 
more information on running this sample.

Sub Main
LockServer 
' Do something lengthy, which makes many calls to the PADS Layout 
Automation server 
UnlockServer 
End Sub

See Also

Application.LockServer
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AssemblyOptions.Add
This method adds a new Assembly option.

Prototype

Add(name As String) As Document

Argument

Return Values

The new Assembly Option packaged as a Document object.

Comments

This property generates an exception if the name argument is already an existing Assembly 
Option or if it is not a valid Assembly Option name.

See Also

AssemblyOptions.Delete

name Name of the new assembly option to add.
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AssemblyOptions.Delete
This method deletes an Assembly Option.

Prototype

Delete(index As Long)

Delete(name As String)

Arguments

Return Values

None

Comments

This property generates an exception if:

• The name argument is not an existing Assembly Option.

• The name argument is not a valid Assembly Option to delete.

• The index argument is greater than the number of existing Assembly Options.

Sample

The following sample code deletes all Assembly Options from the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
Set assopts = ActiveDocument.AssemblyOptions 
For index=assopts.Count To 1 Step -1 
assopts.Delete(index) 
Next index 
End Sub

See Also

AssemblyOptions.Add

index Index (in the collection) of the Assembly Option to delete.

name Name of the Assembly Option to delete.
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AssemblyOptions.Merge
This method merges two object collections.

Prototype

Merge(objects As Objects)

Argument

Return Values

None

Comments

This method adds all objects in the objects collection object to the current object collection.

objects The collection with objects to merge with the current object collection.
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AssemblyOptions.Remove
This method removes an object from the collection.

Prototype

Remove(index As Long)

Remove(name As String)

Arguments

Return Values

None

Comments

This property generates an exception if the index argument is not valid.

See Also

AssemblyOptions.Add

index Index of the object to remove.

name Name of the object to remove.
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AssemblyOptions.Reset
This method resets the object collection.

Prototype

Reset()

Arguments

None

Return Values

None

Comments

None

See Also

AssemblyOptions.Remove
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AssemblyOptions.Select
This method selects or deselects all objects in the collection.

Prototype

Select([bSelect As Boolean = True])

Argument

Return Values

None

Comments

None

bSelect [Optional] True to select. False to deselect.
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AssemblyOptions.Sort
This method sorts objects in the collection by object name.

Prototype

Sort()

Arguments

None

Return Values

None

Comments

None
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Attributes.Add
This method adds a new attribute.

Prototype

Add(name As String, [value AsVariant]) As Attribute

Arguments

Return Values

The new attribute packaged as an Attribute object.

Comments

This property generates an exception if the name argument is already an existing attribute or if it 
is not a valid attribute name.

See Also

Attributes.Delete, Attribute.Measure, Application.Measure

name Name of the new attribute.

value Optional value of the new attribute. The attribute may be of type 
Boolean, Byte, Single, Integer, PortInt, Long, Double, String, and 
Measure object.
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Attributes.Delete
This method deletes an attribute.

Prototype

Delete(index As Long)

Delete(name As String)

Arguments

Return Values

None

Comments

This property generates an exception in the following cases:

• If the name argument is not an existing attribute 

• If the name argument is not a valid attribute to be deleted

• If the index argument is higher than the number of existing attributes

Sample

The following sample code deletes the Cost attribute of all components in the open design. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each nextComp In ActiveDocument.Components 
' Avoid exceptions generated when that attribute does not exist 
  If Not nextComp.Attributes("Cost") Is Nothing
    nextComp.Attributes.Delete("Cost")
  End If
Next nextComp 
End Sub

See Also

Attributes.Add

index Index (in the collection) of the attribute to delete.

name Name of the attribute to delete.
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Attributes.Merge
This method merges two object collections.

Prototype

Merge(objects As Objects)

Argument

Return Values

None

Comments

This method adds all objects in the objects collection object to the current object collection.

objects The collection with objects to merge with the current object collection.
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Attributes.Remove
This method removes an object from the collection.

Prototype

Remove(index As Long)

Remove(name As String)

Arguments

Return Values

None

Comments

This property generates an exception if the index argument is not valid.

See Also

Attributes.Add

index Index of the object to remove.

name Name of the object to remove.
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Attributes.Reset
This method resets the object collection.

Prototype

Reset()

Arguments

None

Return Values

None

Comments

None

See Also

Attributes.Remove
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Attribute.Measure
This property returns the measure value object.

Prototype

Measure As Measure 

Arguments

None

Comments

This property parses an attribute string value such as “100pF” and creates a special object from 
which you can extract additional information such as real value, unit name, quantity name, and 
so on.

If the internal parser cannot recognize a measure value object in the attribute it creates a dummy 
Measure object with the Measure.Value property equal to 0.0 and Measure.Text property equal 
to Attribute.Value property.

Sample

The following sample shows a quantity name of the capacitor's Value attribute (Capacitance) of 
part C1 assuming that it exists in the open schematic. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set C1 = ActiveDocument.Components("C1") 
MsgBox C1.Attributes("Value").Measure.Quantity 'shows "Capacitance" 
End Sub

See Also

Application.Measure
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Attributes.Select
This method selects or deselects all objects in the collection.

Prototype

Select([bSelect As Boolean = True])

Argument

Return Values

None

Comments

None

bSelect [Optional] True to select. False to deselect.
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Attributes.Sort
This method sorts objects in the collection by object name.

Prototype

Sort()

Arguments

None

Return Values

None

Comments

None
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Component.AddLabel
This method adds a new label to the component.

Prototype

AddLabel (Type as PPcbLabelType, Attribute as Object, Layer as Long, PositionX as Double, 
PositionY as Double, Height as Double, LineWidth as Double, Units as PPcbUnit, Orientation 
as Double, Mirror as Boolean) as Label

Arguments

Return Values

Returns the newly added label object.

Comments

None

Sample

The following sample code adds a reference designator to a U1 component at a position (200 
mils, 200 mils) relative to the component's origin. See “Running Code Samples” for more 
information on running this sample.

type Type of new label (optional). Default value is 
ppcbLabelTypeRefDesignator.

attribute Attribute object to which the label is linked (optional).

layer Number of layer on which to place the new label (optional). The default 
is the component layer.

positionX x-coordinate of the new object relative to the component's origin 
(optional). Default is 0.

positionY y-coordinate of the new object relative to the component's origin 
(optional). Default is 0.

height Height of the label (optional). If omitted, the value specified in the 
Tools/Options/Drafting tab/Reference Designators frame. The Height 
edit box is used.

linewidth Line width of the label. If omitted, the value specified in the 
Tools/Options/Drafting tab/Reference Designators frame. The Width 
edit box is used.

units [Optional] Unit in which PositionX, PositionY, Height, and LineWidth 
are returned. Default is ppcbUnitCurrent.

orientation Orientation of the label (optional). The default is 0.

mirror True if the label is mirrored (optional). The default is False.
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Sub Main
Dim c as Component 
Set c = Document.Components("U1") 
c.AddLabel(ppcbLabelTypeRefDesignator, , , 200, 200, , , ppcbUnitMils) 
End Sub
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Component.Move
This method moves the component to a new location.

Prototype

Move(x As Double, y As Double, [unit As PPcbUnit])

Arguments

Return Values

None

Comments

The proper completion of this method depends on the items listed below. To force a component 
move, you must first disable the following:

• Glued status, which is set using the Component.Glued property.

• DRC mode, which is set using the Document.Preference property.

• Nudge mode, which is set using the Document.Preference property.

• ModifyUnionMember mode, which is set using the Document.Preference property.

In addition, a component cannot be moved if it belongs to a physical design reuse component or 
if it is attached to protected traces.

This property generates an exception if any of the above constraints are violated or if a security 
failure occurs during processing.

Sample 1

The following sample code moves all components to the origin of the open design, after 
ungluing them and disabling all automatic DRC and Nudge checking options. See “Running 
Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.Preference("DRC") = ppcbDRCOff 
ActiveDocument.Preference("Nudge") = ppcbNudgeOff 
For Each nextComp In ActiveDocument.Components 
nextComp.Glued = False 
nextComp.Move(0,0) 
Next nextComp 
End Sub

x x-coordinate of the new component position.

y y-coordinate of the new component position.

unit [Optional] Unit in which the x and y coordinates are expressed. This 
optional argument is ppcbUnitCurrent by default.
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Sample 2

The following sample code places all components, in the open design, in a circle centered on the 
design origin, with a 5000 mils radius. See “Running Code Samples” for more information on 
running this sample.

Sub Main
ActiveDocument.Preference("DRC") = ppcbDRCOff 
ActiveDocument.Preference("Nudge") = ppcbNudgeOff 
angleInc = 2*3.14159/ActiveDocument.Components.Count 
counter = 0 
For Each nextComp In ActiveDocument.Components 
nextComp.Glued = False 
nextComp.Move(5000.0*Cos(counter*angleInc), 5000.0*Sin(counter*angleInc), 
ppcbUnitMils) 
counter = counter+1 
Next nextComp 
End Sub

See Also

Document.Preference, Component.PositionX, Component.PositionY, 
Document.PositionsChange 
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Component.MoveCenter
This method moves the component so that the specified point becomes the component's center.

Prototype

MoveCenter (x as Double, y as Double, unit as PPcbUnit, Origin as PPcbOriginType)

Arguments

Return Values

None

Comments

This method moves the component by x and y coordinates simultaneously, as opposed to 
assigning values to CenterX and CenterY properties.

Sample

The following sample code moves component U1 to the point with coordinates (3200 mils, 
1500 mils). See “Running Code Samples” for more information on running this sample.

Sub Main
Dim c as Component 
Set c = Document.Components("U1") 
c.MoveCenter(3200, 1500, pcbUnitMils) 
End Sub

x x-coordinate of new center.

y y-coordinate of new center.

unit [Optional] Unit in which the x and y coordinates are expressed. This 
optional argument is ppcbUnitCurrent by default.

origin [Optional]Type of reference point from which the result is counted. The 
default value is ppcbOriginTypeDesign.
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Document.Activate
This method activates the window associated with a document.

Prototype

Activate()

Arguments

None

Return Values

None

Comments

This is a Microsoft requirement. However, because PADS Layout is an SDI (Single Document 
Interface) server application, this function has no effect.
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Document.AddText
This method adds new text to the document.

Prototype

AddText (Text as String, Layer as Long, PositionX as Double, PositionY as Double, Height as 
Double, LineWidth as Double, Units as PPcbUnit, Orientation as Double, Mirror as Boolean) as 
Text

Arguments

Return Values

Returns the newly added text object.

Comments

None

Sample

This sample adds the text “Hello!” to the design. See “Running Code Samples” for more 
information on running this sample.

Sub Main
ActiveDocument.AddText("Hello !", 1, 200, 200, , , pcbUnitMils) 
End Sub

text Contents of the new text object (required).

layer Number of layer on which to place the new text (optional). The default is 
1.

positionX x-coordinate of the new object (optional). The default is 0.

positionY y-coordinate of the new object (optional). The default is 0.

height Height of the text (optional). If omitted, the value specified in the 
Tools/Options/Drafting tab/Text frame/Height option is used.

linewidth Line width of the text. If omitted, the value specified in the 
Tools/Options/Drafting tab/Text frame/Width option is used.

units [Optional] Unit in which the unit of measurement is returned. This 
optional argument is ppcbUnitCurrent by default.

orientation Orientation of the text (optional). The default is 0.

mirror True if the text is mirrored (optional). The default is False.
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Document.CheckASCII
This method compares the given PADS Layout format netlist with current PADS Layout format 
netlist.

Prototype

CheckASCII(name As String, [ignorenet As String]) As Long

Arguments

Return Values

If the function succeeds, the return value is nonzero. If the function fails, the return value is zero 
(0).

Comments

The function fails if the specified file name does not exist or its format is incorrect.

This method generates an exception if a PADS Layout security failure occurs during 
processing.

Sample

The following sample code compares the specified netlist (padsnet.asc) with the current netlist 
in the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.CheckASCII(DefaultFilePath & "\padsnet.asc")  
End Sub

name: Name of an existing netlist file to compare against.

ignorenet: [Optional] Ignore the specified net.
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Document.ExportASCII
This method generates a PADS Layout-format ASCII file from the current design.

Prototype

ExportASCII(name As String, [sections As PPcbASCIISections = ppcbASCIISectionAll], [ver 
As PPcbASCIIVersion], [expandAttrs As PPcbAttrFlags = ppcbAttrNone]) As Long

Arguments

Return Values

If the function succeeds, the return value is nonzero.

If the function fails, the return value is zero (0).

Comments

This method is an advanced version of Document.ExportNetList, extended by the sections 
argument.

If the specified file name does not exist the function creates a new file. If the file name does 
exist, this method overwrites the existing file.

This property generates an exception if the ver argument is not a valid PADS Layout ASCII 
version number.

Sample

The following sample code creates an ASCII file with the specified name padsnet.asc, 
containing only part and connection sections. See “Running Code Samples” for more 
information on running this sample.

Sub Main
ActiveDocument.ExportASCII(DefaultFilePath & "\padsnet.asc", 
ppcbASCIISectionParts Or ppcbASCIISectionConnections)  
End Sub

See Also

Document.ImportNetList, Document.ExportNetList

name Name of the file to which to export the netlist.

sections [Optional] Sections of ASCII file to output (all by default).

ver [Optional] Version in which to export (for backward compatibility).

expandAttrs [Optional] Attribute expansion options (none by default).
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Document.ExportECOFile
This method generates an .eco file with the specified file name.

Prototype

ExportECOFile(name As String) As Long

Argument

Return Values

If the function succeeds, the return value is nonzero.

If the function fails, the return value is zero (0).

Comments

The function fails if the .eco file does not currently exist. To create an ECO file, the function has 
to exit .eco mode and clear the undo buffer .

Sample

The following sample code creates an ECO file with the specified name pcb2eco.eco. See 
“Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ExportECOFile(DefaultFilePath & "\pcb2eco.eco")  
End Sub

See Also

Document.ImportECOFile

name Name of the new file to which to copy.
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Document.ExportNetList
This method generates a PADS Layout format netlist from the current design.

Prototype

ExportNetList(name As String, [ver As PPcbASCIIVersion]) As Long

Arguments

Return Values

If the function succeeds, the return value is nonzero.

If the function fails, the return value is zero (0).

Comments

If the specified file name does not exist the function creates new file. If the file name does exist, 
this method overwrites the existing file.

This property generates an exception if the ver argument is not a valid PADS Layout ASCII 
version number.

Sample

The following sample code creates a netlist file with the specified name padsnet.asc. See 
“Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ExportNetList(DefaultFilePath & "\padsnet.asc")  
End Sub

See Also

Document.ImportNetList

name Name of the file to which to export the netlist.

ver [Optional] Version in which to export (for backward compatibility).
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Document.ExportRules
This method generates an ASCII file with rules from the current design.

Prototype

ExportRules(name As String, [ver As PPcbASCIIVersion]) As Long

Arguments

Return Values

If the function succeeds, the return value is nonzero.

If the function fails, the return value is zero (0).

Comments

If the specified file name does not exist, the function creates a new file. If the file name does 
exist, this method overwrites the existing file.

This property generates an exception if the ver argument is not a valid PADS Layout ASCII 
version number.

Sample

The following sample code creates a rules file with the specified name padsnet.rul. See 
“Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ExportRules(DefaultFilePath & "\padsnet.rul")  
End Sub

name Name of the file to which to export rules.

ver [Optional] Version in which to export (for backward compatibility).
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Document.GetColor
This method returns the color of the specified document element.

Prototype

GetColor(colorType as PPcbDocumentColor) as Integer

Argument

Return Values

The index of the color in the palette.

Sample

doc = Application.ActiveDocument

msg = ""
msg = msg & doc.GetColor(ppcbDocumentColorBackground) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorSelection) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorHighlight) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorBoardOutline) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorConnection)

MsgBox msg

curr_bkg_color = doc.GetColor(ppcbDocumentColorBackground)
doc.SetColor(ppcbDocumentColorBackground, 2)

MsgBox "Press any key"

doc.SetColor(ppcbDocumentColorBackground, curr_bkg_color)

colorType Specifies the document element
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Document.GetObjects
This method returns a collection of PADS Layout database objects.

Prototype

GetObjects([type As PPcbObjectType = ppcbObjectTypeAll], [value As String], [selected As 
Boolean = False]) As Objects 

Arguments

All arguments to this method are optional, which means that it can be called with no argument 
at all, or with any combination of arguments. See the samples below for more information.

Name argument supports wildcarding (“U*”), lists of items delimited by comma (“U1, U2, 
R1”), ranges specified by two object names and the dash character (“U1 - U10, U12, R1 - 
R20”). Dash must be surrounded by spaces since the dash is a legal symbol in an object name. 
Only one wildcard per name is allowed and you cannot specify wildcards in a range. You can 
pass name such as “U*, R*, C1 – C100” but you cannot pass name such as “U*1*” or “C1* - 
C10*”.

Return Values

The returned object is an Objects collection object. If no objects satisfy the request, the returned 
collection is empty.

Comments

To get all objects of the same type, use the corresponding object Document property instead of 
this method. For example, to get all connections in the open design, use Document.Connections 
instead of Document.GetObjects (ppcbObjectTypeConnection).

This method does not support all of the object types defined in PPcbObjectType.  The method 
will generate an exception if the type argument is not one of the following values:

ppcbObjectTypeAssociatedNet

ppcbObjectTypeComponent

ppcbObjectTypeNet

ppcbObjectTypePin

ppcbObjectTypeVia

type [Optional] Type of PADS Layout database object to get.

value [Optional] Value or name of the object(s) to get.

selected [Optional] True to get selected objects only. False to get all objects.
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ppcbObjectTypeConnection

ppcbObjectTypeRouteSegment

ppcbObjectTypeJumper

ppcbObjectTypePartType

ppcbObjectTypeCBP

ppcbObjectTypeSBP

ppcbObjectTypeWirebond

ppcbObjectTypeNetClass

ppcbObjectTypeDrawing

ppcbObjectTypeText

ppcbObjectTypeLabel

ppcbObjectTypeAll

Sample

The following sample code shows different ways to use this method, displaying the number of 
objects retrieved for each way, using the Objects.Count property. See “Running Code Samples” 
for more information on running this sample.

Sub Main
Dim objs As Object 
' Ex1: Get all objects of all types 
Set objs = ActiveDocument.GetObjects 
MsgBox "Ex1: " & objs.Count & " objects." 
' Ex2: Get all selected objects of all types 
Set objs = ActiveDocument.GetObjects(,,True) 
MsgBox "Ex2: " & objs.Count & " selected objects." 
' Ex3: Get all net objects 
Set objs = ActiveDocument.GetObjects(ppcbObjectTypeNet) 
MsgBox "Ex3: " & objs.Count & " net objects." 
' Ex4: Get all net objects of name "VCC" (there is at least 1 of course) 
Set objs = ActiveDocument.GetObjects(ppcbObjectTypeNet, "VCC") 
MsgBox "Ex4: " & objs.Count & " VCC net objects." 
' Ex5: Get all part objects which names begin with U
Set objs = ActiveDocument.GetObjects(ppcbObjectTypeComponent, "U*") 
MsgBox "Ex3: " & objs.Count & " U* part objects." 
End Sub
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See Also

Document.SelectObjects, Document.Components, Document.Jumpers, Document.Connections, 
Document.Nets, Document.Pins, Document.RouteSegments, Document.Vias, 
Document.PartTypes
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Document.GetVisibility
This method returns the visibility of the specified design object type.

Prototype

GetVisibility(objectType as PPcbDesignObject) as Boolean

Argument

Return Values

TRUE if visible, FALSE if hidden.

Sample

doc = Application.ActiveDocument

If doc.GetVisibility(ppcbDesignObjectPad) = true Then
MsgBox "Pads are visible"

Else
MsgBox "Pads are invisible"

End If

doc.SetVisibility(ppcbDesignObjectTrace, false)

MsgBox "Press any key"

doc.SetVisibility(ppcbDesignObjectTrace, true)

objectType Specifies design object type.
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Document.ImportECOFile
This method imports an .eco file.

Prototype

ImportECOFile(name As String) As Long

Argument

Return Values

If the function succeeds, the return value is nonzero.

If the function fails, the return value is zero (0).

Comments

The function fails if the specified file name does not exist or its format is incorrect.

This method generates an exception if a PADS Layout security failure occurs during 
processing.

Sample

The following sample code imports the specified .eco file, pcb2eco.eco, into the current design. 
See “Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ImportECOFile(DefaultFilePath & "\pcb2eco.eco")  
End Sub

See Also

Document.ExportECOFile 

name Name of an existing .eco file to import.
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Document.ImportNetList
This method imports a PADS Layout format netlist file.

Prototype

ImportNetList(name As String) As Long

Argument

Return Values

If the function succeeds, the return value is nonzero.

If the function fails, the return value is zero (0).

Comments

The function fails if the specified file name does not exist or its format is incorrect.

This method generates an exception if a PADS Layout security failure occurs during 
processing.

Sample

The following sample code imports the specified netlist file, padsnet.asc, into the current 
design. See “Running Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ImportNetList(DefaultFilePath & "\padsnet.asc")  
End Sub

See Also

Document.ExportNetList

name Name of an existing netlist file to import.
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Document.IntegrityTest
This method runs the integrity test.  

Prototype

IntegrityTest() as Boolean

Argument

None

Return Values

TRUE if the test passed without errors, FALSE in other cases.
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Document.Save Method
This method saves the document.

Prototype

Save

Arguments

None

Return Values

None

Comments

This method generates an exception if a PADS Layout security failure occurs during 
processing.

Sample

The following sample code saves, if needed, the open design. See “Running Code Samples” for 
more information on running this sample.

Sub Main
If ActiveDocument.Saved = False Then ActiveDocument.Save 
End Sub

See Also

Document.SaveAs, Document.Saved, Document.Save Event
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Document.SaveAs
This method saves the document with a new name.

Prototype

Save(name As String)

Argument

Return Values

None

Comments

This method generates an exception if a PADS Layout security failure occurs during 
processing.

Sample

The following sample code creates a custom backup of the open design. If the PCB design file 
name is XXX.PCB, the backup file is saved in the same folder with the name XXX (Backup on 
12-28-2001 4h40).PCB. See “Running Code Samples” for more information on running this 
sample.

Sub Main
curDesignName = ActiveDocument.FullName 
theDate = Month(Date) & "-" & Day(Date) & "-" & Year(Date) & " at " & 
Hour(Now) & "h" & Minute(Now) 
bakDesignName = Left$(curDesignName, Len(curDesignName)-4) & " (Backup on 
" & theDate & ").pcb" 
ActiveDocument.SaveAs(bakDesignName) 
OpenDocument(curDesignName) 
End Sub

See Also

Document.Save Method, Document.Saved, Document.Save Event

name New name for the file.
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Document.SaveAsNoLock
This method saves the document with a new name and releases the file lock. 

Prototype

SaveAsNoLock(filename as String)

Argument

Return Values

This method generates an exception if a PADS Layout security failure occurs during 
processing.

filename New name for the file
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Document.SaveNoLock
This method saves the document and releases the file lock. 

Prototype

SaveNoLock

Argument

None

Return Values

This method generates an exception if a PADS Layout security failure occurs during 
processing.
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Document.SaveAsTemp
This method works in the same way as SaveAsNoLock but additionally it doesn't add the 
filename to the MRU (Most Recently Used) list. This method is mainly intended for macro 
tests.  

Prototype

SaveAsTemp(filename as String)

Argument

Return Values

This method generates an exception if a PADS Layout security failure occurs during 
processing.

filename New name for the file
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Document.SaveTemp
This method works in the same way as SaveNoLock but additionally it doesn't add the filename 
to the MRU (Most Recently Used) list. This method is mainly intended for macro tests. 

Prototype

SaveTemp

Argument

None

Return Values

This method generates an exception if a PADS Layout security failure occurs during 
processing.
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Document.SelectObjects
This method selects or deselects PADS Layout database objects.

Prototype

SelectObjects([type As PPcbObjectType = ppcbObjectTypeAll], [value As String], [select As 
Boolean = True])

Arguments

All arguments for this method are optional, which means that it can be called with no argument 
at all, or with any combination of arguments. See the samples below for more information.

Name argument supports wildcarding (“U*”), lists of items delimited by comma (“U1, U2, 
R1”), ranges specified by two object names and the dash character (“U1 - U10, U12, R1 - 
R20”). Dash must be surrounded by spaces since the dash is a legal symbol in an object name. 
Only one wildcard per name is allowed and you cannot specify wildcards in a range. You can 
pass name such as “U*, R*, C1 – C100” but you cannot pass name such as “U*1*” or “C1* - 
C10*”.

Return Values

None

Comments

This property generates an exception if the type argument is not a valid PADS Layout database 
object type.

Sample

The following sample code shows different ways to use this method, displaying the number of 
objects selected for each way, using the Document.GetObjectsmethod and the Objects.Count 
property. See “Running Code Samples” for more information on running this sample.

Sub Main
Dim objs As Object 
' Ex1: Select all objects of all types 
ActiveDocument.SelectObjects 
Set objs = ActiveDocument.GetObjects(,,True) 
MsgBox "Ex1: " & objs.Count & " selected objects (all)." 
' Ex2: Unselelect all objects of all types 
ActiveDocument.SelectObjects(,,False) 
Set objs = ActiveDocument.GetObjects(,,True) 
MsgBox "Ex2: " & objs.Count & " selected objects (none)." 
' Ex3: Select all net objects 

type [Optional] Type of database object to select/deselect.

value [Optional] Value or name of the objects to select/deselect.

select [Optional] True to select. False to deselect.
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ActiveDocument.SelectObjects(ppcbObjectTypeNet) 
Set objs = ActiveDocument.GetObjects(,,True) 
MsgBox "Ex3: " & objs.Count & " selected objects (all nets)." 
' Ex4: Unselect net VCC
ActiveDocument.SelectObjects(ppcbObjectTypeNet, "VCC", False)
Set objs = ActiveDocument.GetObjects(,,True) 
MsgBox "Ex4: " & objs.Count & " selected objects (all nets except VCC)." 
' Ex5: Select only part objects which names begin with U
ActiveDocument.SelectObjects(,,False)
 ActiveDocument.SelectObjects(ppcbObjectTypeComponent, "U*") 
Set objs = ActiveDocument.GetObjects(,,True)
MsgBox "Ex5: " & objs.Count & " selected U* part objects." 
End Sub

See Also

Document.GetObjects, Document.SelectionChange Event 
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Document.SetColor
This method sets the color for the specified document element.

Prototype

SetColor(colorType as PPcbDocumentColor, colorIndex as Integer)

Argument

Sample

doc = Application.ActiveDocument

msg = ""
msg = msg & doc.GetColor(ppcbDocumentColorBackground) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorSelection) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorHighlight) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorBoardOutline) & ", "
msg = msg & doc.GetColor(ppcbDocumentColorConnection)

MsgBox msg

curr_bkg_color = doc.GetColor(ppcbDocumentColorBackground)
doc.SetColor(ppcbDocumentColorBackground, 2)

MsgBox "Press any key"

doc.SetColor(ppcbDocumentColorBackground, curr_bkg_color)

colorType Specifies document element

colorIndex Index of the color in the palette. Must be between 0 and 31
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Document.SetVisibility
This method sets visibility for the specified design object type.

Prototype

SetVisibility(objectType as PPcbDesignObject, objectVisibility as Boolean)

Argument

Sample

doc = Application.ActiveDocument

If doc.GetVisibility(ppcbDesignObjectPad) = true Then
MsgBox "Pads are visible"

Else
MsgBox "Pads are invisible"

End If

doc.SetVisibility(ppcbDesignObjectTrace, false)

MsgBox "Press any key"

doc.SetVisibility(ppcbDesignObjectTrace, true)

objectType Specifies design object type.

objectVisibility TRUE if visible, FALSE if hidden.
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Label.Delete
This method deletes the Label object.

Prototype

Delete as Boolean

Arguments

None

Return Value

Returns True if the object was successfully deleted. Returns False if the object cannot be 
deleted.

Comments

None

Sample

The following sample deletes selected labels. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeLabel,,TRUE) 
For Each label In selected 
If label.Delete() = False Then 
MsgBox "Cannot delete the label!" 
Else 
MsgBox "The label was deleted successfully!" 
End If 
Next label 
End Sub
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Layer.GetColor
This method returns color of the specified layer element.

Prototype

GetColor(colorType as PPcbLayerColor) as Integer

Argument

Return Values

Index of the color in the palette.

colorType Specifies layer element.
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Layer.GetDielectricConstant
This method returns the layer dielectric constant.

Prototype

GetDielectricConstant(dielectricLayer as PPcbDielectricLayer) as Double

Argument

Return Values

The dielectric constant.

dielectricLayer Specifies dielectric layer relevant to this electrical layer.
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Layer.GetDielectricThickness
This method gets the layer dielectric thickness.

Prototype

GetDielectricThickness (

dielectricLayer as PPcbDielectricLayer, 

unit as PPcbUnit) as Double

Argument

Return Values

The dielectric thickness.

dielectricLayer Specifies dielectric layer relevant to this electrical layer.

unit  [Optional] Unit in which value is returned. This optional 
argument is ppcbUnitCurrent by default.
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Layer.GetDielectricType
This method returns the layer dielectric type.

Prototype

GetDielectricType(dielectricLayer as PPcbDielectricLayer) as PPcbDielectricType

Argument

Return Values

The dielectric type.

dielectricLayer Specifies dielectric layer relevant to this electrical layer.
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Layer.SetColor
This method sets color for the specified layer element.

Prototype

SetColor(colorType as PPcbLayerColor, colorIndex as Integer)

Argument

colorType Specifies layer element.

colorIndex Index of the color in the palette. Must be between 0 and 31.
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Layer.SetDielectricConstant
This method sets the layer dielectric constant.

Prototype

SetDielectricConstant(

dielectricLayer as PPcbDielectricLayer, 

dielectricConstant as Double)

Argument

dielectricLayer Specifies dielectric layer relevant to this electrical layer.

dielectricConstant Specifies dielectric constant.
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Layer.SetDielectricThickness
This method sets the layer dielectric thickness.

Prototype

SetDielectricThickness (

dielectricLayer as PPcbDielectricLayer, 

dielectricThickness as Double,

unit as PPcbUnit)

Argument

dielectricLayer Specifies dielectric layer relevant to this electrical layer.

dielectricThickness Specifies dielectric thickness.

unit [Optional] Unit in which value is passed to this method. This 
optional argument is ppcbUnitCurrent by default.
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Layer.SetDielectricType
This method sets the layer dielectric type.

Prototype

SetDielectricType (

dielectricLayer as PPcbDielectricLayer, 

dielectricType as PPcbDielectricType)

Argument

dielectricLayer Specifies dielectric layer relevant to this 
electrical layer.

dielectricType Specifies dielectric type. 
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Library.GetLibraryItems
This method returns either the object collection of all items in this library or a specified item.

Prototype

GetLibraryItems (Type as PPcbLibraryItemType, Name as String) As Collection

Arguments

Comments

None

Sample

This sample displays the number of items in a library. See “Running Code Samples” for more 
information on running this sample.

Sub Main
For Each lib In Libraries 
count = lib.GetLibraryItems(ppcbLibraryItemTypeDecal, "DIP*").Count 
MsgBox "Library " & lib.Name & " has " & count & " DIP decals" 
Exit For 
Next lib 
End Sub

name Name of LibraryItem objects to retrieve (optional). May contain 
wildcards, lists, and ranges. If omitted, matches any name.

type Parameter specifying the type of the objects to retrieve (optional). It is 
ppcbLibraryItemTypeAll by default.
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Library.ImportLibraryItems
This method reads library items from PowerPCB-format or PADS Layout-format ASCII files.

Prototype

ImportLibraryItems (Filename as String) as Collection

Arguments

Return Values

Returns the collection of imported items.

Comments

None

Sample

This sample imports library items from a file, and displays the number of imported items. See 
“Running Code Samples” for more information on running this sample.

Sub Main
For Each lib In Libraries 
Set coll = lib.ImportLibraryItems("C:\sample") 
MsgBox coll.Count & " items are successfully imported" 
Exit For 
Next lib 
End Sub

name Name of the file from which to import library items.

return value Returns the collection of imported items.
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Library.ImportLibraryItems2
This method reads library items from PowerPCB-format or PADS Layout-format ASCII files.

Prototype

ImportLibraryItems2 (Filename as String, ImportOption as PcbImportLibMode) as Collection

Arguments

Return Values

Returns the collection of just imported items.

Comments

If ImportOption is pcbImportLibModePrompt, then the Application object fires the 
OverwriteLibraryItemPrompt event. The client application must process this event to specify 
whether the existing library item should be overwritten.

Filename Name of the file from which to import library items.

ImportOption specifies the preference for overwriting existing items.
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Objects.Add
This method adds an object to the collection.

Prototype

Add(obj As object)

Argument

Return Values

None

Comments

This property generates an exception if the object argument is not a database object.

See Also

Objects.Remove

obj Object to add to the collection. It must be a database object, such as 
Component, Net, Jumper, Pin, Via, Connection, or RouteSegment.
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Objects.Merge
This method merges two object collections.

Prototype

Merge(objects As Objects)

Argument

Return Values

None

Comments

This method adds all objects in the objects collection object to the current object collection.

objects The collection with objects to merge with the current object collection.
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Objects.Remove
This method removes an object from the collection.

Prototype

Remove(index As Long)

Remove(name As String)

Arguments

Return Values

None

Comments

This property generates an exception if the index argument is not valid.

See Also

Objects.Add

index Index of the object to remove.

name Name of the object to remove.
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Objects.Reset
This method resets the object collection.

Prototype

Reset()

Arguments

None

Return Values

None

Comments

None

See Also

Objects.Remove
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Objects.Select
This method selects or deselects all objects in the collection.

Prototype

Select([bSelect As Boolean = True])

Argument

Return Values

None

Comments

None

bSelect [Optional] True to select. False to deselect.
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Objects.Sort
This method sorts objects in the collection by object name.

Prototype

Sort()

Arguments

None

Return Values

None

Comments

None
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Text.Delete
This method deletes the Text object.

Prototype

Delete as Boolean

Arguments

None

Comments

None

Sample

The following sample deletes the selected text. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set selected = ActiveDocument.GetObjects(ppcbObjectTypeText,, TRUE) 
For Each text In selected 
If text.Delete() = False Then 
MsgBox "Cannot delete the text!" 
Else 
MsgBox "The text was deleted successfully!" 
End If 
Next text 
End Sub
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View.Pan
This method pans the view to a specified location.

Prototype

Pan(x As Double, y As Double, [unit As PPcbUnit])

Arguments

Return Values

None

Comments

None

Sample

The following sample code centers the view to the location of component U1, assuming it exists 
in the open design. See “Running Code Samples” for more information on running this sample.

Sub Main
x = ActiveDocument.Components("U1").PositionX 
y = ActiveDocument.Components("U1").PositionY 
ActiveDocument.ActiveView.Pan(x,y) 
End Sub

See Also

View.Change 

x x-coordinate of the point to which to pan.

y y-coordinate of the point to which to pan.

unit [Optional] Unit in which the X and Y values are given.
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View.Refresh
This method refreshes the view.

Prototype

Refresh

Arguments

None

Return Values

None

Comments

None

Sample

The following sample code redraws the view. See “Running Code Samples” for more 
information on running this sample.

Sub Main
ActiveDocument.ActiveView.Refresh 
End Sub



PADS Layout User’s Guide and Reference Manual, PADS 9.42192

PADS Layout Automation Server
View.SetExtents

View.SetExtents
This method sets the view extents.

Prototype

SetExtents(tlx As Double, tly As Double, brx As Double, bry As Double, [unit As PPcbUnit])

Arguments

Return Values

None

Comments

None

Sample

The following sample code sets the view to the extents of all pins connected to net VCC, 
assuming it exists in the open design. See “Running Code Samples” for more information on 
running this sample.

Sub Main
xMin = 100000000.0 
yMin = 100000000.0 
xMax = -100000000.0 
yMax = -100000000.0 

For Each nextPin In ActiveDocument.Nets("VCC").Pins
If nextPin.PositionX < xMin Then xMin = nextPin.PositionX 
If nextPin.PositionX > xMax Then xMax = nextPin.PositionX 
If nextPin.PositionY < yMin Then yMin = nextPin.PositionY 
If nextPin.PositionY > yMax Then yMax = nextPin.PositionY 
Next nextPin 
ActiveDocument.ActiveView.SetExtents(xMin, yMin, xMax, yMax) 
End Sub

See Also

View.Change,View.SetExtentsToAll,View.SetExtentsToBoard

tlx x-coordinate of the top left corner of the new view.

tly y-coordinate of the top left corner of the new view.

brx x-coordinate of the bottom right corner of the new view.

bry y-coordinate of the bottom right corner of the new view.

unit [Optional] Unit in which the tlx, tly, brx, and bry values are given.
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View.SetExtentsToAll
This method sets the view extents to all objects in the design.

Prototype

SetExtentsToAll()

Arguments

None

Return Values

None

Comments

None

Sample

The following sample code sets the view extents to all objects in the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ActiveView.SetExtentsToAll 
End Sub

See Also

View.SetExtents,View.SetExtentsToBoard,View.Change



PADS Layout User’s Guide and Reference Manual, PADS 9.42194

PADS Layout Automation Server
View.SetExtentsToBoard

View.SetExtentsToBoard
This method sets the view extents to the design board extents.

Prototype

SetExtentsToBoard()

Arguments

None

Return Values

None

Comments

None

Sample

The following sample code sets the view extents to the board of the open design. See “Running 
Code Samples” for more information on running this sample.

Sub Main
ActiveDocument.ActiveView.SetExtentsToBoard 
End Sub

See Also

View.Change,View.SetExtents, View.SetExtentsToAll
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View.SetExtentsToSelection
This method sets the current zoom level and view center to show all currently selected objects.

Prototype

SetExtentsToSelection

Arguments

None

Comments

None

Sample

The following sample code sets view parameters so that C1 and C2 components are shown. See 
“Running Code Samples” for more information on running this sample.

Sub Main
Set v = ActiveDocument.ActiveView 
ActiveDocument.SelectObjects ppcbObjectTypeAll, "*", False 
ActiveDocument.Components("C1").Selected = True 
ActiveDocument.Components("C2").Selected = True 
v.SetExtentsToSelection 
End Sub
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View.SetScale
This method sets the current zoom level and view center.

Prototype

SetScale (Zoom as Double, CenterX as Double, CenterY as Double, Units as PPcbUnit)

Arguments

Return Values

None

Comments

None

Sample

The following sample code zooms in the view. See “Running Code Samples” for more 
information on running this sample.

Sub Main
Set v = ActiveDocument.ActiveView 
v.SetScale( v.Zoom * 2 ) 
End Sub

Events

zoom A new zoom level. Required.

centerX x-coordinate of new view center.
Optional, if omitted, current Center x-coordinate is used.

centerY y-coordinate of new view center.
Optional, if omitted, current Center y-coordinate is used.

units [Optional] Unit in which the result is to be represented. This optional 
argument is ppcbUnitCurrent by default.
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Application.OpenDocument Event
This event occurs after the program opens a new document.

Prototype

Application_OpenDocument()

Arguments

None

Return Values

None

Comments

None

See Also

Application.OpenDocument Method
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Application.ProgressChange
This event occurs after the status bar value is changed.

Prototype

Application_ProgressChange

Arguments

None

Return Values

None

Comments

None
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Application.Quit Event
This event occurs before the program exits.

Prototype

Application_Quit()

Arguments

None

Return Values

None

Comments

This event occurs before the program exits.
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Document.SecurityLimit Event
This event occurs when the database security limits are reached.

Prototype

Document_SecurityLimit ()

Arguments

None

Return Values

None 

Comments

None
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Document.PositionsChange
This event occurs after the position of a component is changed.

Prototype

Document_PositionsChange()

Arguments

None

Comments

None

See Also

Component.Move, Component.Orientation
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Document.Save Event
This event occurs after the document is saved.

Prototype

Document_Save()

Arguments

None

Return Values

None

Comments

None

See Also

Document.Save Method, Document.SaveAs
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Document.SelectionChange Event
This event occurs when the current selection changes.

Prototype

Document_SelectionChange()

Arguments

None

Comments

None

See Also

Document.SelectObjects, Objects.Select
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View.Change
This event occurs when the current view changes.

Prototype

View_Change()

Arguments

None

Comments

None

See Also

View.Pan,View.SetExtents,View.SetExtentsToBoard,View.SetExtentsToAll 

Samples

Running Code Samples
Many topics in this help file provide code samples to illustrate how to use an Automation 
property, method, or event. You can run code samples either in PADS Layout or outside of 
PADS Layout. 

The code sample is always in the following form:

Sub Main
 ' Do something
End Sub

For more information on running code samples, see “Troubleshooting the Code Samples” and 
“Enhancing Sample Code” .

Disclaimer: The code samples in PADS Layout Automation Server Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Running Code Samples in PADS Layout

To use the code sample:

1. Select the sample, including the Sub Main and End Sub statements.

2. Copy the sample to the Clipboard using Edit/Copy. 
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3. Choose Tools/Basic Scripting/Script Editor. The Sax Basic Engine dialog box appears. 

4. Paste the code sample into the Sax Basic editor using Edit/Paste.

5. Click the Start button on the toolbar in the Sax Basic Editor dialog box to run the 
sample. 

Figure 46-6 shows the code sample for the Application.ActiveDocument property pasted into 
the Basic Engine dialog box.

Figure 46-6. Code Sample in Basic Engine Dialog Box

Running Code Samples Outside of PADS Layout

To use the code sample with other Basic scriptable applications (also called host applications) 
such as Visual Basic, Microsoft Excel, Microsoft Word:

1. Import the Automation server references into the host application. For example, to use 
Excel as the host application:

2. Choose Tools/Macro/Visual Basic Editor.

3. Choose Tools/References. The References dialog box appears. 

4. In the list box, select PADS Layout <latest_version> Type Library.

5. Paste the code sample in the editor of the host application. To do this in Excel:

6. Choose View/Code.
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7. Choose Edit/Paste.

8. Add code to the beginning of the code sample to connect the host application to PADS 
Layout using the Basic GetObject function.

9. Add the object returned by the Basic GetObject function to the beginning of each 
Automation method and property in the sample code.

10. Add code to the end of the sample to disconnect the application from the program.

Figure 46-7 shows the code sample for the Application.ActiveDocument property pasted and 
modified in Microsoft Excel's Visual Basic Editor. See the host application help for more 
information.

Figure 46-7. Code Sample in Excel Visual Basic Editor

Enhancing Sample Code
The code samples in the Automation Server Help are reduced to the minimum number of lines 
necessary to quickly illustrate how to use Automation properties and methods. You can use 
these code samples as a base for developing your own PADS Layout features. The following list 
provides ideas for possible enhancements:

• Add strict type checking, using the Option Explicit declaration at the beginning of the 
code and declare all variables using the Dim Basic keyword. This ensures that the 
program can interpret your variables properly and can generate compiling errors when a 
problem exists.

• Add error checking using the On Error Basic keyword. Error checking improves how 
code reacts to a run-time error.

• Display information in custom dialog boxes using the UserDialog Basic keyword, 
instead of displaying in simple dialog boxes created using the MsgBox keyword.

Disclaimer: The code samples in the Automation Server On-line Help are freeware. Mentor 
Graphics provides these samples as a courtesy to its users. Freeware is provided as is and 
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Mentor Graphics makes no warranties with respect to freeware, either express or implied, 
including any implied warranties of merchantability or fitness for a particular purpose.

Troubleshooting the Code Samples
If a code sample does not run correctly, check the following:

• Make sure a design is open.

Almost all code samples require a design file to be open when you run the sample.

• Check for any assumptions the samples make about the design files.

For example, some code samples assume that component U1 exists, others assume that the 
Assembly Option MyAssOpt exists, and others assume that at least one Assembly Option 
exists. 

These assumptions are clearly stated in the text preceding each sample. If these assumptions are 
not true, the sample code will not run properly. You can adapt the sample to your design file.

• If you modified the sample code to run outside of the program, make sure that you 
properly applied all required changes to the code, as described in “Running Code 
Samples” .

Common mistakes include forgetting to import references and forgetting to prefix Automation 
constants.

Disclaimer: The code samples in the Automation Server Help are freeware. Mentor Graphics 
provides these samples as a courtesy to its users. Freeware is provided as is and Mentor 
Graphics makes no warranties with respect to freeware, either express or implied, including any 
implied warranties of merchantability or fitness for a particular purpose.

RGL Replacement

Replacing RGL Format Files
PADS Layout includes Automation Server support for all Report Generation Language (RGL) 
keywords. Examples for each RGL format file (.fmt) are included with the OLE samples as 
Basic scripts. You can customize these new report format files to fit your output requirements. 
The files, located in the C:\PADS Projects\Samples\Scripts\Layout\RGL_Samples folder, were 
created using the Sax Basic Engine. The file name extension used for these files is .bas. You can 
load these scripts into the Tools/Basic Scripts menu using the Basic Scripts dialog box. 

The RGL replacement scripts described below (*.bas) include references to rgl.bas. This file is a 
library file that contains functions the .bas scripts need to operate. The .bas scripts must refer to 
rgl.bas (within the script) to run. 
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RGL keywords are replaced with Basic functions and subroutines.

See also: Automation for RGL Top Level Keywords, Automation for RGL SubLevel 
Keywords, Automation for RGL Field Keywords, New Automation Functions for RGL

Script Names and Report Types

To help you determine the type of output each program provides, Table 46-1 identifies the Sax 
Basic script name and type of report it generates. 

Automation for RGL Top Level Keywords
Table 46-2 and Table 46-3 list the Automation methods and functions that replace RGL top 
level keywords. Also see “Replacing RGL Format Files,” “Automation for RGL SubLevel 
Keywords,” “Automation for RGL Field Keywords,,” and “New Automation Functions for 
RGL.

Table 46-1. Sax Basic Script Names and Report Type

RGL Report Sax Basic File (.bas) Description

Netlist without pin info Net List without pin 
info.bas

Reports signals by netname 
without pin information.

Netlist with pin info Net List with pin info.bas Reports signals by netname 
with pin information.

Parts List 1 Part List 1.bas Reports parts by reference 
designator.

Parts List 2 Part List 2.bas Reports reference 
designators by part type.

Test points report Test points report.bas Reports test point locations 
and netname.

Jumper List Jumper List.bas Reports jumper locations 
and netnames.

PowerPCB Format Netlist PowerPCB V2.0 Format 
Netlist.bas, PowerPCB 
V3.0 Format Netlist.bas

Reports a PowerPCB 
format netlist. 

DFT Extended Test Point DFT Extended test point 
report.bas

Reports test points by nets, 
nets without test points, and 
number of test points per 
net.

Table 46-2. Top Level Keywords Replaced by Direct Automation Methods

RGL Keywords Method Description 

JOBNM ActiveDocument.Name Returns the JOB NAME.
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COMPCNT ActiveDocument.Compone
nts.Count 

Returns the total number of 
components.

SIGCNT ActiveDocument.Nets.Coun
t

Returns the total signal 
count.

BOARDSZ ActiveDocument.BoardOutl
ineSurface 

Returns the board size in 
current units.

Table 46-3. Top Level Keywords Replaced by Functions and Subroutines in 
RGL.BAS

RGL Keywords Automation Function Description 

TIME Function GetTime() As 
String

Returns the current date and 
time in the format “ddd 
mmm dd hh:mm:ss yyyy.”

LAYERCNT Function LayerCnt(doc As 
Object)

Returns the total number of 
component and routing 
layers.

PKGCNT Function PkgCnt(doc As 
Object) As Integer

Returns the total number of 
packages in use on the PCB.

SYMCNT Function SymCnt(doc As 
Object) As Integer

Returns the total number of 
decals in use on the PCB.

EQUIV_IC Function EquivalentIC(doc 
As Object) As Double

Uses the total number of 
pins on all components on 
the board divided by 14.

BD_DENSITY Function BdDensity(doc As 
Object) As Double

Calculates the board density 
by using the surface area of 
the PCB divided by the 
Equivalent IC value.

PSIGCNT Function PSigCnt(doc As 
Object) As Integer

Returns the total number of 
Power Nets on the PCB.

SSIGCNT Function SSigCnt(doc As 
Object) As Integer

Returns the total number of 
signal nets on the PCB, 
excluding power nets.

TOPCOMPCNT Function TopCompCnt(doc 
As Object) As Integer

Returns the total number of 
components on the top side 
of the PCB.

BOTCOMPCNT Function 
BottomCompCnt(doc As 
Object) As Integer

Returns the total number of 
components on the bottom 
side of the PCB.

Table 46-2. Top Level Keywords Replaced by Direct Automation Methods
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Automation for RGL SubLevel Keywords
Table 46-4 and Table 46-5 list the Automation methods and functions that replace RGL 
sublevel keywords. Also see the “Automation for RGL Field Keywords.”

Lower level keywords are indented.

Also see “Replacing RGL Format Files,” “Automation for RGL Top Level Keywords,” 
“Automation for RGL Field Keywords,” “New Automation Functions for RGL”

PADCNT Function PadCnt(doc As 
Object) As Integer

Returns the total number of 
pads (drilled and undrilled) 
on the PCB.

DRPADCNT Function DrPadCnt(doc As 
Object) As Integer

Returns the total number of 
drilled pads on the PCB 
(Drill size > 0).

NDPADCNT Function NDPadCnt(doc As 
Object) As Integer

Returns the total number of 
surface mount pads (drill 
size = 0).

Table 46-4. Sublevel Keywords Replaced by Direct Automation Methods

RGL Keywords Description 

SIGNALS Search within signals.
' Iterate through all net of document doc like this
For Each nextNet In doc.Nets
… ' Do Something with that Net nextNet
Next nextNet

SIGNAME Net.Name
Name of signals.

PINS Search within pins.
' Iterate through all pins of net nextNet like this
For Each nextPin In nextNet.Pins
… ' Do Something with that Pin nextPin
Next nextPin

COMPNAME Pin.Component.Name
Component name

PINNUM Pin.Number
Pin number

Table 46-3. Top Level Keywords Replaced by Functions and Subroutines in 
RGL.BAS



PADS Layout Automation Server
RGL Replacement

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2211

CONNECTIONS Search connections.
' Iterate through all connections of document doc like this
For Each nextConn In doc.Connections
… ' Do Something with that Connection nextConn
Next nextConn

SIGNAME Connection.Net.Name
Name of signal(s)

COMP1 Connection.Pins(1).Component.Name
Reference designator of connection end one

PIN1 Connection.Pins(1).Number
Pin number of connection end one

COMP2 Connection.Pins(2).Component.Name
Reference designator of connection end two

PIN2 Connection.Pins(2).Number
Pin number of connection end two

ROUTSEGS Search within routes.
' Iterate through all route segs of conn. nextConn like this
For Each nextSeg In nextConn.RouteSegments
… ' Do Something with that route segment nextSeg
Next nextSeg

END1 First end point of segment
Points = RouteSegment.Points '! First, assign to variant !
Points(1)

END2 Second end point of segment
Points = RouteSegment.Points '! First, assign to variant !
Points(2)

WIDTH RouteSegment.Width 
Width of a trace segment

LAYER RouteSegment.Layer
Layer number of a trace segment

VIAS Search within Vias
' Iterate through all vias of connection nextConn like this
For Each nextVia In nextConn.Vias
… ' Do Something with that via nextVia
Next nextVia

LOCX Via.PositionX
X Coordinate of VIA

LOCY Via.PositionY
Y Coordinate of via.

Table 46-4. Sublevel Keywords Replaced by Direct Automation Methods
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VIANAME Via.Type
Via name

PACKAGE (in RGL.BAS: see PKGCNT)

PKGNAME Package name
' Use the Component.PartType property

PKGDSCR Component.Attributes(“DESCRIPTION”).Value
Package description

COMPONENTS Search within packages.
' Iterate through all components of document doc like this
For Each nextComp In doc.Components
… ' Do Something with that Component nextComp
Next nextComp

COMPNAME Component.Name 
Component name

SYMNAME Component.Decal
Symbol name

PKGTYPE Component.PartType
Package name

ANGLE Component.Orientation
Component placement angle

LOCX X Component.PositionX
Coordinate of placement

LOCY Y Component.PositionY
Coordinate of placement

TESTPOINTS (in RGL.BAS)

TPNAME Pin.Name ' for pin test points
Via.Type ' for via test points
Test point name. The test point name for component pins 
is the standard pin name, such as U1.2. The test point 
name for vias is the via type name, such as 
STANDARDVIA.

SIGNAME Pin.Net ' for pin test points
Via.Net ' for via test points
Signal (net) name. If the test point is on an unused 
component pin, the name *NONE* is returned.

LOCX X Pin.PositionX ' for pin test points
Via.PositionX ' for via test points 
Coordinate for test point

Table 46-4. Sublevel Keywords Replaced by Direct Automation Methods
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LOCY Y Pin.PositionY ' for pin test points
Via.PositionY ' for via test points
Coordinate for test point

TESTSIDE Pin.TestPoint ' for pin test points
Via.TestPoint ' for via test points
Testing side for the test point: TOP or BOTTOM

Table 46-5. Sublevel Keywords Replaced by Functions and Subroutines in 
RGL.BAS

RGL Keywords Description 

SIGNALS Search within signals. (Direct automation method)

SIGNAME Name of signals. (Direct automation method)

PINS Search within pins. (Direct automation method)

PINTYP Function PinType(Pin As Object) As String
Returns a string value that identifies the type on 
pin, if it has been assigned by the user: 
Source="S", Bidirectional="B", 
OpenCollector="C", OrTieableSource="O", 
Tristate="T", Load="L", Terminator="Z", 
Power="P", Ground="G", Undefined="U"

TPASSIGNED Function TPAssigned(Net As Object) As Boolean
Returns a true/false value if a net has a test point 
on it.

TESTPOINTCNT Function TPCnt(Net As Object) As Integer
Returns the total number of test points on all nets.

TESTPINCNT Function TPPinCnt(Net As Object) As Integer
Returns the total number of pins assigned as test 
points.

TESTVIACNT Function TPViaCnt(Net As Object) As Integer
Returns the total number of vias as test points.

PACKAGE Sub GetPackageList(doc As Object, ByRef 
pkgList() As Package, Optional bSort As Boolean 
= False
Returns a list of all the packages on the PCB. 
Optional parameter to specify whether to sort the 
list.

TESTPOINTS Function TestPoints(doc As Object) As objects
Returns a list of test points on component pins, 
vias, and unused pins.

Table 46-4. Sublevel Keywords Replaced by Direct Automation Methods
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Automation for RGL Field Keywords
Table 46-6 lists the RGL field keywords that are replaced by functions and subroutines in 
RGL.bas. 

Also see “Replacing RGL Format Files,” “Automation for RGL Top Level Keywords,” 
“Automation for RGL SubLevel Keywords,” and “New Automation Functions for RGL.”

New Automation Functions for RGL
Table 46-6 lists the new functions and subroutines in RGL.bas to support RGL replacement.

Table 46-6. Field Keywords Replaced by Functions and Subroutines in 
RGL.BAS

RGL Keywords Automation Function Description

MAXCOLS Sub MaxCols(cols As 
Integer)

Calculates the maximum 
number of columns in a 
report.

BETWEEN Sub Between(Optional 
betweenCol As Integer = 0)

Calculates the space 
required between different 
columns of data.

BETWEEN Sub End_Between() Calculates the space 
required between different 
columns of data.

COLUMNS ,LEADING Sub Columns(ParamArray 
formatParam())

Outputs the columns of a 
report in a table format.

COLUMNS, LEADING Sub End_Columns() Outputs the last column of 
data in a report.

DELIMITER Not needed 

Table 46-7. New Functions and Subroutines in RGL.BAS to Support RGL 
Replacement

Automation Function Description

Function Format2(value As Double) As String Returns floating point 
numbers as a string to 5 
decimal places.

Function NetPinsSortedByConnection(aNet As Object) As objects Returns a list of pin pairs 
sorted alphabetically.

Function OpenReport(file As String) As Integer Opens an output stream to a 
filename that you supply.
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See Also

Replacing RGL Format Files, Automation for RGL Top Level Keywords, Automation for RGL 
SubLevel Keywords, Automation for RGL Field Keywords

Sub CloseReport() Closes the currently open 
output stream.

Sub Out(ParamArray formatParam()) Outputs the formatted data 
to the open stream.

Table 46-7. New Functions and Subroutines in RGL.BAS to Support RGL 
Replacement

Automation Function Description
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Chapter 47
The Macro Language

The macro language of this program is similar to standard Visual Basic Script (VBScript) 
language. It supports most of the VBScript features including the following:

• Variables and arrays of variables

• The full set of standard arithmetic and Boolean Expressions

• Functions and subroutines

• Statements

• Operators

• Objects, properties, and methods

• Automation Support for internal and external automation objects

• Internal Macro Objects

Variables
The macro engine of this program supports variables, which can either be Null or contain values 
of the following types:

• Numeric

• Logical

• String

• Object

Value types are converted to each other according to these rules, see Table 47-1. 

Table 47-1. & Operator Arguments 

From...To... Logical Numeric String

Null False 0 Empty string

Logical None 0 if False, 1 if True 0 if False, 1 if True

Numeric False if 0, True 
if not 0

None String representation of 
the numeric value
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Numeric
The Numeric value represents a floating-point number.

Note: The Numeric and String value types are interchangeable; they automatically convert into 
one another upon assignment.

Logical
The Logical value can be True or False.

String
The String value represents a character string.

Note: The Numeric and String value types are interchangeable; they automatically convert into 
one another upon assignment.

Related Topics

Str function

Double
Represents numeric value.

The double and string types are interchangeable; that is, they automatically convert into one 
another upon assignment.

String Converted to 
Numeric first

If the beginning of 
the string can be 
interpreted as a 
number, then the 
value of the number 
is used. Otherwise it 
is 0.

None

Table 47-1. & Operator Arguments (cont.)

From...To... Logical Numeric String
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Object
Objects represent complex entities that are handled through an interface consisting of methods 
and properties. Objects are different from Numeric and String value types.

Objects may be of two types: 

• Macro objects: Internal objects that are handled using the macro engine vocabularies, 
and may or may not have the Automation interface.

• Automation objects: Internal or external objects that are handled using Automation. 

Syntax

The syntax for both object types is the same:

Object.Method arg1, ..., argn
var = Object.Method( arg1, ..., argn )

Expressions
The macro engine of this program uses either of the following expressions:

• Numeric: Any expression that can be evaluated as a number. Elements of a numeric 
expression can include any combination of keywords, variables, constants, and 
operators that result in a number.

• String: Any expression that evaluates a sequence of adjacent characters. Elements of a 
string expression can include a string, a string literal, or a string variable.
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Operators
The Macro engine of this program uses the following operators:

• & Operator

• * Operator

• + Operator

• / Operator

• - Operator

• ^ Operator

• = Operator

• And Operator

• Comparison Operators

• Mod Operator

• Not Operator

• Or Operator

• Xor Operator
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& Operator
Forces string concatenation of two expressions.

Syntax

result = expression1 & expression2

Arguments

The & operator has these arguments:

Example

S = "abc" & "123"

result Required
Any numeric variable

expression1 Required
Any expression
When the expression is not a string, it is converted to a string.

expression2 Required
Any expression
When the expression is not a string, it is converted to a string.
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* Operator
Multiplies two numbers.

Syntax

result = number1 * number2

Arguments

The * operator has these arguments::

Example

X = y * z

result Required
Any numeric variable

number1 Required
Any expression. If the expression value is not numeric, it is 
converted to a numeric value.

number2 Required
Any expression. If the expression value is not numeric, it is 
converted to a numeric value.
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+ Operator
Sums two numbers.

Syntax

result = expression1 + expression2

Arguments

The + operator syntax has these arguments:

Note: When you use the + operator, you may not be able to determine whether addition or string 
concatenation will occur. To force string concatenation, use the & operator instead. This will 
eliminate ambiguity and provide self-documenting code.

Table 47-2 describes the behavior of the + operator for the three combinations of types. 

Example

X = y + z

result Required
Any numeric variable

expression1 Required
Any expression

expression2 Required
Any expression

Table 47-2. + Operator Behavior 

Arguments Action

Both expressions are numeric Add

Both expressions are string Concatenate

One expression is numeric and the other is a string Add
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/ Operator
Divides one number by a second number and returns a floating-point result.

Syntax

result = number1 / number2

Arguments

The / operator has these arguments:

Example

x = y/z

result Required
Any numeric variable

number1 Required
Any expression. If the expression value is not numeric, it is 
converted to a numeric value.

number2 Required
Any expression. If the expression value is not numeric, it is 
converted to a numeric value.
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- Operator
Finds the difference between two numbers or indicates the negative value of a numeric 
expression.

Syntax 1

result = number1 - number2

The - operator is the arithmetic subtraction operator, which finds the difference between two 
numbers.

Syntax 2

-number

The - operator is the unary negation operator which indicates the negative value of an 
expression.

Arguments

The - operator has these arguments:

Example 1

x = y - z

Example 2

-x

result Required
Any numeric variable

number1 Required
Any expression. If the expression value is not numeric, it is 
converted to a numeric value. 

number2 Required
Any expression. If the expression value is not numeric, it is 
converted to a numeric value. 
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= Operator
Assigns a value to a variable or property.

Syntax

variable = value

Arguments

The = operator has these arguments:

Example

a = 1

variable Can only be a variable or a writable property.
Can be a simple scalar variable or an element of an array.

Value Any numeric expression, string expression, literal, or 
constant
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^ Operator
Raises a number to the power of an exponent.

Syntax

result = number ^ exponent

Arguments

The ^ operator has these arguments:

When more than one exponentiation is performed in a single expression, the ^ operator is 
evaluated as it is encountered from left to right.

Example

x = y ^ z

result Required
Any numeric variable

number Required
Any expression

exponent Required
Any numeric expression
A number can be negative only if the exponent is an integer.
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And Operator
Performs a logical conjunction of two expressions.

Syntax

result = expression1 And expression2

Arguments

The And operator has these arguments:

Table 47-3 illustrates how the result is determine. 

Example

a = b And c

result Required
Any numeric variable

expression1 Required
Any expression. If the expression value is not logical, it is 
converted to a logical value.

expression2 Required
Any expression. If the expression value is not logical, it is 
converted to a logical value.

Table 47-3. And Operator Results 

If expression1 is And expression2 is The result is

True True True

True False False

False True False

False False False
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Comparison Operators
Compare expressions.

Syntax

result = expression1 comparisonoperator expression2

Arguments

Comparison operators have these arguments:

Table 47-4 lists the comparison operators and the conditions that determine whether result is 
True, False, or Null.

Example

b = 1 > 2

result Required
Any variable

expression1 Required
Any expression

expression2 Required
Any expression

comparisonoperator Required
Can be any comparison operator. For more information, 
see Table 47-4 below.

Table 47-4. Comparison Operators and Results

Comparison Operator True if False if

< (Less than) expression1 < expression2 expression1 >= expression2

<= (Less than or equal to) expression1 <= expression2 expression1 > expression2

> (Greater than) expression1 > expression2 expression1 <= expression2

>= (Greater than or equal to) expression1 >= expression2 expression1 < expression2

= (Equal to) expression1 = expression2 expression1 <> expression2

<> (Not equal to) expression1 <> expression2 expression1 = expression2
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Mod Operator
Divides one number by a second number and returns only the remainder. The modulus 
(remainder) operator rounds floating-point numbers to integers.

Syntax

result = number1 Mod number2

Arguments

The Mod operator has these arguments:

Example

x = y Mod z

result Required
Any numeric variable

number1 Required
Any numeric expression

number2 Required
Any numeric expression
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Not Operator
Performs a logical negation on an expression.

Syntax

result = Not expression

Arguments

The Not operator has these arguments:

Table 47-5 illustrates how result is determined:

Example

x = Not y

result Required
Any numeric variable

expression Required
Any expression. If the expression value is not logical, it is 
converted to a logical value. 

Table 47-5. Not Operator Results

If expression is Then result is

True False

False True
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Or Operator
Performs a logical disjunction on two expressions.

Syntax

result = expression1 Or expression2

Arguments

The Or operator has these arguments:

Table 47-6 illustrates how result is determined:

Example

x = y Or z

result Required
Any numeric variable

expression1 Required
Any expression. If the expression value is not logical, it is 
converted to a logical value.

expression2 Required
Any expression. If the expression value is not logical, it is 
converted to a logical value.

Table 47-6. Or Operator Results

If expression1 is And expression2 is Then result is

True True True

True False True

False True True

False False False
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Xor Operator
Performs a logical exclusion on two expressions.

Syntax

[result =] expression1 Xor expression2

Arguments

The Xor operator has these arguments:

Table 47-7 illustrates how result is determined::

Example

x = y Xor z

Statements
The macro engine of this program supports the following VBScript and other statements:

• Call

• Close

• Dim

• Do...Loop

• For-Next

result Optional
Any numeric variable

expression1 Required
Any expression. If the expression value is not logical, it is 
converted to a logical value.

expression2 Required
Any expression. If the expression value is not logical, it is 
converted to a logical value.

Table 47-7. Xor Operator Results

If expression1 is And expression2 is Then result is

True True False

True False True

False True True

False False False
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• Function 

• If...Then...Else statement

• Input #

• Modal

• Open

• Print #

• ReDim

• Set

• Sub 

• While...Wend

• Width # 
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Call
Transfers control to a sub procedure or function procedure.

Syntax

[Call] name [argumentlist]

When you specify the Call keyword to call a procedure that requires arguments, you must 
enclose argumentlist in parentheses. See example below.

Arguments 

The Call statement has these arguments:

Example

Call MyProc(0)

Related Topics

Statements

Call Optional keyword
You are not required to use the Call keyword when calling a procedure. 
If you omit the Call keyword, you must also omit the parentheses around 
argumentlist. If you use either the Call syntax to call any intrinsic or 
user-defined function, the function's return value is discarded.

name Required
Name of the procedure to call

argumentlist Optional
Comma-delimited list of variables, arrays, or expressions to    pass to the 
procedure.
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Close 
Concludes input/output (I/O) to a file opened using the Open statement.

When you close files that were opened for Output or Append, the final buffer of output is 
written to the operating system buffer for that file; All buffer space associated with the closed 
file is released; and the association of a file with its file number ends.

Syntax

Close [filenumberlist]

Arguments

The Close statement has this argument:

If you omit filenumberlist, all active files opened by the Open statement are closed.

Example

close #1

Related Topics

Statements

filenumberlist Optional
Can be one or more file numbers using the following syntax, where 
filenumber is any valid file number:

[[#]filenumber] [, [#]filenumber] . . .



The Macro Language
Dim

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2237

Dim
Declares variables and allocates storage space. 

Syntax

Dim varname[([subscripts])] [,varname[([subscripts])]] . . .

Arguments

The Dim statement has these arguments:

You can also use the Dim statement, with empty parentheses, to declare a dynamic array. After 
declaring a dynamic array, use the ReDim statement to define the number of dimensions and 
elements in the array.

Example

Dim x(10), y(20)

Related Topics

Statements

varname Required
The variable name follows standard variable-naming 
conventions

subscripts Optional
Dimensions of an array variable
The subscripts argument uses the following syntax:

[lower To] upper [, [lower To] upper] . . .

When not explicitly stated, the lower bound is zero.
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Do...Loop
Repeats a block of statements while a condition is True or until a condition becomes True.

Syntax 1

Do [{While | Until} condition]
[statements]
[Exit Do]
[statements]
Loop

Syntax 2

Do
[statements]
[Exit Do]
[statements]
Loop [{While | Until} condition]

Arguments

The Do Loop statement has these arguments:

You may place any number of Exit Do statements anywhere in the Do…Loop statement as an 
alternative way to exit a Do Loop statement. Exit Do is often used after evaluating some 
condition, in which case the Exit Do statement transfers control to the statement immediately 
following the Loop.

When used within nested Do Loop statements, Exit Do transfers control to the loop that is 
nested one level above the loop where Exit Do occurs.

Example

Do while i < 10
i = i + 1 
loop

Related Topics

Statements

condition Optional
One or more of the following two types of expressions:

A numeric expression that evaluates to True or False
A string expression that evaluates to True or False

When condition is Null, condition is treated as False.

statements One or more statements that are repeated while, or until, 
condition is True
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For-Next
Repeats a group of statements a specified number of times.

Syntax

For counter = start To end [Step step]
[statements]
[Exit For]
[statements]
Next [counter]

Arguments

The For-Next statement has these arguments:

The step argument can be either positive or negative. The value of step determines loop 
processing as described in Table 47-8.

After all statements in the loop execute, step is added to counter. At this point, either the 
statements in the loop execute again (based on the same test that caused the loop to execute 
initially), or the loop is exited and execution continues with the statement following the Next 
statement.

counter Required
Numeric variable used as a loop counter. Counter cannot be a 
Boolean element or an array element.

start Required
Initial value of counter

end Required
Final value of counter

step Optional
The number by which counter is incremented each time 
control passes through the loop.
If not specified, step defaults to one.

statements Optional
One or more statements between For and Next that are 
executed the counter-specified number of times

Table 47-8. For-Next Statement Loop Counter

Value Loop executes if

Positive or zero counter <= end

Negative counter >= end
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You can place any number of Exit For statements anywhere in the loop as alternative ways to 
exit. Exit For is often used after evaluating a condition to transfer control to the statement 
immediately following Next.

You can nest For-Next statements by placing one For-Next statement within another. Give each 
statement a unique variable name as its counter. The following construct is correct:

For A = 1 To 10
  For B = 2 To 20
  For C = 3 To 30
  ...
  Next C
  Next B
Next A

Example

for i = 0 to 10 step 2
s = sti
next i

Related Topics

Statements
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Function
Declares the name, arguments, and code that form the body of a Function procedure.

Like a sub procedure, a function procedure is a separate procedure that can take arguments, 
perform a series of statements, and change the values of its arguments. However, unlike a sub 
procedure, a function procedure can be used on the right side of an expression in the same way 
you use any intrinsic function, such as Sqr, Cos, or Chr, when you want to use the value 
returned by the function. 

There are two categories of variables you can use in function procedures:

• Explicitly declared variables within the procedure: These variables are always local 
to the procedure and use the Dim statement or the equivalent. The values of local 
variables in a function are not preserved between calls to the procedure.

• Not explicitly declared variables within the procedure: These variables are also 
local, unless they are explicitly declared at some higher level outside the procedure.

Syntax

Function name [(arglist)]
[statements]
[name = expression]
[Exit Function] 
[statements]
[name = expression]
End Function

The Exit Function statement causes an immediate exit from a function procedure. Program 
execution continues with the statement that follows the statement that called the function 
procedure. You can add any number of Exit Function statements in a function procedure.

Arguments

The Function statement has these arguments:

name Required
Name of the function procedure
Follows standard variable-naming conventions.
To return a value from a function, assign a value to the 
function name. You can assign values to function names 
anywhere in the procedure. If no value is assigned to name, 
the procedure returns an empty value. 

arglist Optional
List of variables representing arguments that are passed to 
the function procedure when the procedure is called.   
Use commas to separate multiple variables. 
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The arglist argument has the following syntax: 

[ByVal | ByRef] varname[( )] 

Table 47-9 describes the arglist syntax elements:

You cannot define a function procedure inside any other procedure such as a sub procedure or 
another function procedure. 

For specific information about calling a function procedure, see the Call statement.

Example

The following example shows how to assign a return value to a function named Example. In this 
case, False is assigned to the name to indicate that a certain condition is not met. 

Function Example()
    ...
' Value not found. Return False.
    If ConditionNotMet Then
Example = False
        Exit Function 
    End If
    ...
Example = True
End Function

Related Topics

Statements

statements Optional
Any group of statements to execute within the body of the 
function procedure.

expression Return value of the function procedure.

Table 47-9. Function Statement arglist Syntax

Part Description

ByVal Indicates that the argument is passed by value.

ByRef Indicates that the argument is passed by reference.

Varname Name of the variable representing the argument.
Follows standard variable naming conventions.
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If...Then...Else statement
May execute a group of statements, based on the value of an expression.

Syntax

If condition Then [statements] [Else [elsestatements]]

Block Syntax

If condition Then
[statements]
[ElseIf condition-n Then
[elseifstatements]] ...
[Else
[elsestatements]]
End If

Arguments

The If...Then...Else statement has these arguments::

You can use the single-line syntax for short, simple tests. For more structure and flexibility use 
the block syntax. The block syntax can also be easier to read, maintain, and debug.

With the single-line syntax, you can execute multiple statements as the result of an If...Then 
decision. All statements must be on the same line and separated by colons, as in the following 
statement:

If A > 10 Then A = A + 1 : B = B + A : C = C + B

condition Required
Any expression. If the expression is not Logical, it is 
converted to Logical.

statements Optional in block form; required in single-line form that has 
no Else clause
One or more statements separated by colons; executed when 
condition is True.

condition-n Optional
Any logical expression. If the expression is not Logical, it is 
converted into a Logical expression.

elseifstatements Optional
One or more statements executed when associated condition-
n is True

elsestatements Optional
One or more statements executed when no previous 
condition or when condition-n is True
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A block If statement must be the first statement on a line. The Else, ElseIf, and End If parts of 
the statement can be preceded by only a line number or a line label. The block If statement must 
end with an End If statement.

To determine whether or not a statement is a block If statement, examine what follows the Then 
keyword. If anything other than a comment appears after Then on the same line, the statement is 
treated as a single-line If statement.

The Else and ElseIf clauses are both optional. You can have as many ElseIf clauses as you want 
in a block If statement, but none can appear after an Else clause. Block If statements can be 
nested.

During the execution of a block If statement, condition is tested. When condition is True, the 
statements following Then are executed. When condition is False, any ElseIf condition is 
evaluated in turn. When a True condition is found, the statements immediately following the 
associated Then are executed. If none of the ElseIf conditions are True (or if there are no ElseIf 
clauses), the statements following Else are executed. After executing the statements following 
Then or Else, execution continues with the statement following End If.

Examples

If x < y then x = y

and

If x < y then
x = y
End if

Related Topics

Statements
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Input #
Reads data from an open text file and assigns the data to variables. Use this statement only with 
files opened in Input mode. When read, string or numeric data is assigned to variables without 
modification.

Syntax

Input #filenumber, varlist

Arguments

The Input # statement has these arguments:

Related Topics

Statements

filenumber Required
Can be any valid file number

varlist Required
Can be a comma-delimited list of variables that are assigned 
values read from the file. This cannot be an array or object 
variable. However, you may use variables that describe an 
element of an array.
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Modal
Opens access to a variable.

While a modal dialog is open in a PADS macro, access to all variables outside the open dialog is 
blocked—only controls within the open dialog are accessible. To make a variable accessible in 
the context of any open modal dialog, declare it “modal” at the beginning of the macro file.

Syntax

modal variablename

Arguments

The modal keyword has these arguments:

Example

modal docname

variablename Required
The name of the variable you want to make accessible.
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Open
Enables input and output to a file.

You must open a file before performing any I/O operation on it. Open allocates an I/O buffer for 
the file and determines the mode of access to use with the buffer. If the file is already opened by 
another process and the specified type of access is not allowed, the Open operation fails and an 
error occurs.

Syntax

Open pathname For mode [Access access] [lock] As [#]filenumber 
[Len=reclength]

Arguments

The Open statement has these arguments:

If the file specified by pathname does not exist, it is created when a file is opened for Append, 
Binary, Output, or Random access modes.

Example

Open "C:\data.txt" for read as #1

Related Topics

Statements

pathname Required
String expression that specifies a filename. May also include 
folder and drive names.

mode Required
Keyword specifying the file access mode: Append, Binary, 
Input, Output, or Random. If mode is unspecified, the file is 
opened for Random access.

access Optional
Keyword specifying the operations permitted on the open 
file: Read, Write, or Read Write

lock Optional
Keyword specifying the operations restricted on the open file 
by other processes: Shared, Lock Read, Lock Write, and 
Lock Read Write
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Print #
Writes formatted data to a sequential file.

Syntax

Print # filenumber, [outputlist]

Arguments

The Print # statement has these arguments:

If you omit outputlist and include only a list separator after filenumber, a blank line prints to the 
file.

You can separate multiple expressions with either a space or a semicolon. A space has the same 
effect as a semicolon.

Example

print #1, a, b, c

outputlist has the following syntax:

[{Spc(n) | Tab[(n)]}] [expression] [charpos]

Table 47-10 describes the outputlist syntax elements:

filenumber Required
Any valid file number

outputlist Optional
An expression or list of expressions to print. Nothing is 
written to the file when outputlist is empty. However, when 
outputlist is Null, Null is written to the file.

Table 47-10. Print # Statement outputlist Syntax

Setting Description

Spc(n) Inserts space characters in the output, where n is the number of spaces to 
insert.

Tab(n) Positions the insertion point at an absolute column number, where n is the 
column number.
Use Tab with no argument to position the insertion point at the beginning 
of the next print zone.
Because Print # writes an image of the data to the file, you must delimit 
the data so it prints correctly. If you use Tab with no arguments to move 
the print position to the next print zone, Print # also writes the spaces 
between print fields to the file.
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Data written with Print # is usually read from a file with Input #.

Example

Print #1, a, Spc(3), b

Related Topics

Statements

expression Numeric or string expressions to print. You can separate multiple 
expressions with either a space or a semicolon.

charpos Specifies the insertion point for the next character.
If you omit charpos, the next character prints on the next line.
Use a semicolon to position the insertion point immediately after the last 
displayed character.

Table 47-10. Print # Statement outputlist Syntax
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ReDim
Reallocates storage space for dynamic array variables.

Use ReDim to size a dynamic array that has already been declared using the Dim statement with 
empty parentheses (without dimension subscripts). You can use ReDim repeatedly to change 
the number of elements and dimensions in an array.

Note: If you re-declare a dimension for an array variable whose size was explicitly specified in 
a Dim statement, an error occurs.

Syntax

ReDim [Preserve] varname(subscripts) [, varname(subscripts)] . . .

Arguments

The ReDim statement has these arguments:

Note: If you make an array smaller than it was, any data in the eliminated elements is lost.

When using Preserve you can resize only the last array dimension and you cannot change the 
number of dimensions. For example, if your array has only one dimension, you can resize that 
dimension because it is the last and only dimension. 

However, if your array has two or more dimensions, you can change the size of only the last 
dimension while preserving the contents of the array. The following example shows how you 
can increase the size of the last dimension of a dynamic array without erasing existing data 
contained in the array:

ReDim X(10, 10, 10)
. . .
ReDim Preserve X(10, 10, 15)

Preserve Optional
Keyword used to preserve the data in an existing array when 
you change the size of the last dimension

varname Required
Name of the variable; follows standard variable-naming 
conventions

subscripts Required
Dimensions of an array variable
The subscripts argument uses the following syntax:

[lower To] upper [,[lower To] upper] . . .

When not explicitly stated, lower bound is zero.
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When you use Preserve you can change the size of the array only by changing the upper bound. 
Changing the lower bound causes an error.

Example

ReDim x(150)

Related Topics

Statements
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Set
Assigns an object reference to a variable or property.

Syntax

Set objectvar = {objectexpression | Nothing}

Arguments

The Set statement has these arguments:

To be valid, objectvar must be of the same object type as the object being assigned to it.

The Dim and ReDim statements declare only the variable name, which refers to an object. No 
actual object is referred to unless the Set statement assigns a specific object.

When you use Set to assign an object reference to a variable, a reference to the object is created 
- not a copy of the object. More than one object variable can refer to the same object. Because 
such variables are references to the object rather than copies of the object, any change in the 
object is reflected in all variables that refer to it.

Example

Set obj = application

Related Topics

Statements

objectvar Required
Name of the variable, or property; follows standard variable-
naming conventions

objectexpression Required
Expression, which consists of the name of an object, another 
declared variable of the same object type, or a function or 
method that returns an object of the same object type

Nothing Optional
Discontinues association of objectvar with any specific 
object. Assigning Nothing to objectvar releases all the 
system and memory resources associated with the previously 
referenced object when no other variable refers to it.
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Sub
Declares the name, arguments, and code that form the body of a sub procedure.

Like a function procedure, a sub procedure is a separate procedure that can take arguments, 
perform a series of statements, and change the value of its arguments. However, unlike a 
function procedure, which returns a value, a sub procedure cannot be used in an expression.

There are two categories of variables you can use in sub statements:

• Explicitly declared variables within the procedure: These variables are always local 
to the procedure and use the Dim statement or the equivalent. The value of local 
variables in a Sub procedure is not preserved between calls to the procedure.

• Not explicitly declared variables within the procedure: These variables are also 
local, unless they are explicitly declared at some higher level outside the procedure.

Syntax

Sub name [(arglist)] 
[statements]
[Exit Sub]
[statements]
End Sub 

Arguments

The Sub statement has these arguments:

Example

The arglist argument has the following syntax: 

[ByVal | ByRef] varname[( )]

name Required
The Sub procedure name 
Follows standard variable-naming conventions.

arglist Optional
List of variables representing arguments that are passed to 
the sub procedure when the sub procedure is called. 
Use commas to separate multiple variables.

statements Any group of statements to execute within the body of the 
sub procedure.
The Exit Sub statement causes an immediate exit from a sub 
procedure. Program execution continues with the statement 
following the statement that called the sub procedure. Any 
number of Exit Sub statements can appear anywhere in a sub 
procedure.



PADS Layout User’s Guide and Reference Manual, PADS 9.42254

The Macro Language
Sub

Table 47-11 describes the arglist syntax elements::

Note: You cannot define a sub procedure inside any other procedure such as a function or 
another sub procedure. 

For specific information about calling sub procedures, see the Call statement.

Related Topics

Statements

Table 47-11. Sub Statement arglist Syntax

Part Description

ByVal Indicates that the argument is passed by value.

ByRef Indicates that the argument is passed by reference.

varname Name of the variable representing the argument.
Follows standard variable-naming conventions.
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While...Wend
Executes a series of statements as long as a given condition is True.

Syntax

While condition
[statements]
Wend

Arguments

The While Wend statement has these arguments:

If condition is True, all statements are executed until the Wend statement is encountered. 
Control then returns to the While statement and condition is again checked. If condition is still 
True, the process is repeated. If condition is not True, execution resumes with the statement 
following the Wend statement.

You can nest While…Wend statements to any level. Each Wend matches the most recent While 
statement.

Example

While i < 10
i = i + 1
Wend

Related Topics

Statements

condition Required
Any expression. If the expression is not Logical, it is 
converted to a Logical type.

statements Optional
One or more statements executed while condition is True
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Width #
Assigns an output line width to a file opened using the Open statement.

Syntax

Width #filenumber, width

Arguments

The Width # statement has these arguments:

Example

Width #2, 100

Related Topics

Statements

Functions
The macro engine of this program currently supports the following embedded functions:

• Asc

• Atn

• Chr

• Command

• Cos

• CreateObject

• CurDir

• Dir

• DoEvents

• Environ

filenumber Required
Any valid file number

width Required
Numeric expression in the range 0 to 255, inclusive. 
Indicates how many characters appear on a line before a new 
line starts. If width equals 0, there is no limit to the length of 
a line. The default value for width is 0.
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• Environ

• Eof

• Exp

• GetObject

• GetTmpFileName

• InStr

• InStrRev 

• Left 

• Len 

• Mid 

• MkDir

• MoveFile

• MsgBox

• Right 

• Sin

• Spc

• Str

• Tab

• Val
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Asc
This function returns an integer representing the character code that corresponds to the first 
letter in a string.

Syntax

Asc(string)

Arguments

The Atn function has this argument:

Example

i = Asc("abc")

string Required
Any valid string expression
If the string contains no characters, a run-time error occurs.
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Atn
This function returns a Double specifying the arctangent of a number.

The range of the result is - pi/2 to pi/2 radians. To convert degrees to radians, multiply degrees 
by pi/180. To convert radians to degrees, multiply radians by 180/pi.

The Atn function takes the ratio of two sides of a right triangle and returns the corresponding 
angle in radians. The ratio is the length of the side opposite the angle divided by the length of 
the side adjacent to the angle.

Atn is the inverse trigonometric function of Tan, which takes an angle as its argument and 
returns the ratio of two sides of a right triangle. Do not confuse Atn with cotangent, which is the 
inverse of a tangent (1/tangent).

Syntax

Atn(number)

Arguments

The Atn function has this argument:

Example

f = Atn(2)

number Required
Any expression. If the expression is not Logical, it is converted to a 
Logical type.
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Chr
This function returns a string containing the character associated with the specified character 
code.

Syntax

Chr(charcode)

Arguments

The Chr function has this argument:

Example

c = chr(64)

charcode Required
A long that identifies a character. Values from 0 to 31 are standard, 
nonprintable ASCII codes. For example, Chr(10) returns a linefeed 
character. The normal range for charcode is 0 to 255, inclusive.
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Command
This function returns the command line used to start the program, including the path to the 
executable file and any subsequent arguments.

Syntax

Command

When you launch the program from the command line, the command line is available to Macro 
scripts.

Example

Assuming that the program is launched by the following command:

BlazeRouter log:logfile.log preview.pcb

The Command function returns:

"C:\Program Files\Mentor Graphics\PADS\<latest 
release>\Programs\BlazeRouter.exe log:logfile.log preview.pcb"
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Cos
This function returns a Double specifying the cosine of an angle.

The Cos function takes an angle and returns the ratio of the length of the side adjacent to the 
angle divided by the length of the hypotenuse. The result lies in the range -1 to 1. To convert 
degrees to radians, multiply degrees by pi/180. To convert radians to degrees, multiply radians 
by 180/pi.

Syntax

Cos(number)

Arguments

The Cos function has this argument

Example

x = Cos(1.57)

number Required
A double or any valid numeric expression expressing an 
angle in radians
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CreateObject
This function creates and returns a reference to an ActiveX object.

Syntax

CreateObject(class,[servername])

Arguments

The CreateObject function syntax has these arguments:

The class argument uses the syntax appname.objecttype and has these elements:

To create an ActiveX object, assign the object returned by CreateObject to an object variable.

Use CreateObject when there is no current instance of the object. If an instance of the object is 
already running, a new instance is started, and an object of the specified type is created. To use 
the current instance, or to start the application and have it load a file, use the GetObject 
function.

If an object has registered itself as a single-instance object, only one instance of the object is 
created, no matter how many times CreateObject is executed.

Example

set obj = CreateObject("PowerPCB.Application")

class Required
String
The application name and the class of the object to create

servername Optional
String
The name of the network server where the object will be 
created
If the remote server does not exist or is unavailable, a run-
time error occurs.

appname Required
String
The name of the application providing the object

objecttype Required
String
The type or class of object to create
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CurDir
This function returns a variant string representing the current path.

Syntax

CurDir [(drive)]

Argument

The CurDir function has this argument:

Example

s = CurDir("d:")

drive Optional
Any string expression that specifies an existing drive. If no drive is 
specified or if drive is a zero-length string (" "), CurDir returns the path 
for the current drive.
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Dir
This function returns a string representing the name of a file or folder that matches a specified 
pattern, file attribute, or drive volume label.

Syntax

Dir(pathname)

Arguments

The Dir function has this argument:

Dir supports the use of multiple character (*) and single character (?) wildcards to specify 
multiple files.

Examples

To get the first file in the c: drive root:

Dir("C:\*.*")

To get the next file in the same path:

Dir

To start another search in C:\PADS Projects\Samples:

Dir("C:\PADS Projects\Samples\*.*")

pathname Optional
String expression that specifies a file name. May also include folder and 
drive names.
A zero-length string ("") is returned if pathname is not found.
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DoEvents
This function passes control to the operating system. The operating system returns control after 
it finishes processing the events in its queue.

Syntax

DoEvents()

DoEvents may be useful if the macro is performing long calculations. Inserting DoEvents calls 
every second or more may prevent the accumulation of unprocessed events in the queue. 
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Environ
This function returns the string associated with an operating system environment variable.

Syntax

Environ [(envstring)]

Arguments

The Environ function has this argument:

If envstring can't be found in the environment-string table, a zero-length string ("") is returned.

Environ returns the text assigned to the specified envstring; that is, the text which follows the 
equal sign (=) in the environment-string table for that environment variable.

Example

s = Environ ("path")

Envstring Optional
String expression containing the name of an environment variable
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Eof
This function returns an integer, which represents the Boolean value True when the end of a file 
opened for random or sequential input has been reached.

Use the Eof function to avoid the error generated by attempting to get input after the end of a 
file.

Table 47-12 lists the Eof function returned values:

Syntax

Eof [(filenumber)]

Arguments

The Eof function has this argument:

Example

If Eof (1) then .... 

Table 47-12. Eof Function Returned Values

Condition Eof function returns

Before end of file is reached False

After end of file is reached True

File opened for random access and Get statement is able to read 
an entire record

False

File opened for random access and Get statement is not able to 
read an entire record

True

File opened for binary access and Get statement is able to read an 
entire record

False

File opened for binary access and Get statement is not able to read 
an entire record

True

File opened for output True

filenumber Optional
An integer containing any valid file number
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Exp
This function returns a Double specifying e (the base of natural logarithms) raised to a power. 
The constant e is approximately 2.718282.

Note: The Exp function complements the Log function and may be referred to as the 
antilogarithm.

Syntax

Exp(number)

Arguments

The Exp function has this argument:

Example

x = exp(y)

number Required
A double or any valid numeric expression. When the value of number 
exceeds 709.782712893, an error occurs. 
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GetObject
This function returns a reference to an object provided by an ActiveX component.

Syntax

GetObject([pathname] [, class])

Arguments

The GetObject function has these arguments:

The class argument uses the syntax appname.objecttype, which has these elements:

Use the GetObject function to access an ActiveX object from a file and assign the object to an 
object variable. Use the Set statement to assign the object returned by the GetObject function to 
the object variable.

Example

obj = GetObject(, "PowerPCB.Application")

pathname Optional
Variant string
The full path (folder, and drive) and name of the file 
containing the object to retrieve. If pathname is omitted, 
class is required.

class Optional
Variant string
A string representing the class of the object

appname Required
Variant string
The name of the application providing the object

objecttype Required
Variant string
Type or class of object to create
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GetTmpFileName
This function returns a string specifying a new file name guaranteed to be unique in the folder 
identified by the string argument.

Syntax

GetTmpFileName(string)

Arguments

The GetTmpFileName function has this argument:

Example

s = GetTmpFileName("d:\tmp")

string Required
A string expression
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InStr
This function returns the position of the first occurrence of one string within another string.

Syntax

InStr([start, ]string1, string2)

Arguments

The InStr function has these arguments:

Return Values

Example

i = InStr(1,"cbc","c")

start Optional
Numeric expression that sets the starting position for each 
search
When start is omitted, the search begins at the first character 
position.

string1 Required
String expression to search

string2 Required
String expression to find

Table 47-13. InStr Function Return Values

If InStr returns

string1 is zero-length 0

string2 is zero-length start

string2 is not found 0

string2 is found within string1 position at which a match is found

start > string 0
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InStrRev
This function returns the position of an occurrence of one string within another, from the end of 
the string.

Syntax

InStrRev(string1, string2, [start])

Arguments

The InStrRev function has these arguments:

Return Values

Example:

The following sample code returns "4."

InStrRev("abcdbc", "bc")

string1 Required
String expression being searched

string2 Required
String expression to find

start Optional
Numeric expression that sets the starting position for each 
search
If omitted, the search begins at the last character position.

Table 47-14. InStrRev Function Return Values

If InStrRev returns

string1 is zero-length 0

string2 is zero-length Start

string2 is not found 0

string2 is found within string1 Position at which match is found

start > Len(string2) 0
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Left
This function returns a specified number of characters from the left side of a string.

Syntax

Left(string, length)

Arguments

The Left function has these arguments:

Example

The following sample code returns "ab."

Left("abcd", 2)

string Required
A string expression from which the characters from the left 
side are returned

length A numeric expression indicating the number of characters to 
return
If length is 0, Left returns a zero-length string (" "). If length 
is greater than or equal to the number of characters in the 
string, Left returns the entire string.
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Len
This function returns the number of characters in a string (the length of the string).

Syntax

Len(string)

Arguments

The Len function has this argument:

Example

The following sample code returns 4.

Len("abcd")

string Required
Any valid string expression
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Mid
This function returns a specified number of characters from a string.

Syntax

Mid (string, start, [length])

Arguments

The Mid function has these arguments:

Example

The following sample code returns "cd."

Mid("abcdbc", 3, 2)

string Required
A string expression from which the characters are returned

start Required
The character position in string at which the part to return 
begins. If start is greater than the number of characters in 
string, Mid returns a zero-length string (" ").

length Optional
The number of characters to return. If omitted, when there 
are less characters in the string (including the character at 
start), than length, Mid returns all of the characters from the 
start position to the end of the string.
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MkDir
This function creates a new folder.

Syntax

MkDir (path)

Arguments

The MkDir function has this argument:

Example

MkDir ("D:\newdir")

path Required
A string expression that identifies the folder to create. The path may 
include the drive. When no drive is specified, MkDir creates the new 
folder on the current drive.
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MoveFile
This function moves the file identified by path1 argument to the location specified in path2.

Syntax

MoveFile(path1, path2)

Arguments

The MoveFile function has these arguments:

Example

MoveFile("C:\data.bin","D:\")

path1 Required
A string expression

path2 Required
A string expression
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MsgBox
This function displays a message in a dialog box, waits for the user to click a button, and returns 
an integer indicating which button the user clicked.

Syntax

MsgBox(prompt [, buttons] [, title])

Arguments

The MsgBox function has these arguments:

Settings

The buttons argument settings are:

prompt Required
String expression displays as the message in the dialog box
The maximum length of prompt is 1024 characters, 
depending on the width of the characters used. If prompt 
consists of more than one line, you can separate the lines 
using a carriage return character (Chr(13)), a linefeed 
character (Chr(10)), or carriage return - linefeed character 
combination (Chr(13) & Chr(10)) between each line.

buttons Optional
Numeric expression which is the sum of values specifying 
the number and type of buttons to display, the icon style to 
use, and the identity of the default button.
The default value for buttons is 0.

title Optional
String expression that displays in the title bar of the dialog 
box.
The default value for title is the application name.

Table 47-15. MsgBox buttons Settings

Constant Value Description

mbOKOnly 0 Display OK button only.

mbOKCancel 1 Display OK and Cancel* 
buttons.

mbAbortRetryIgnore 2 Display Abort, Retry, and 
Ignore buttons.

mbYesNoCancel 3 Display Yes, No, and 
Cancel* buttons.

mbYesNo 4 Display Yes and No 
buttons.
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• The first group of values (0-5) describes the number and type of buttons to display in the 
dialog box

• The second group of values (16, 32, 48, 64) describes the icon style

• The third group of values (0, 256, 512) shows which button is the default. 

When adding numbers to create a final value for the buttons argument, use only one number 
from each group.

Return Values

*If the dialog box displays a Cancel button, pressing Esc has the same effect as clicking Cancel.

Example

MsgBox("Hello",mbOK, "This is a message box")

mbRetryCancel 5 Display Retry and Cancel* 
buttons.

mbCritical 16 Display Critical Message 
icon.

mbQuestion 32 Display Warning Query 
icon.

mbExclamation 48 Display Warning Message 
icon.

mbInformation 64 Display Information 
Message icon.

mbDefaultButton1 0 First button is default.

mbDefaultButton2 256 Second button is default.

mbDefaultButton3 512 Third button is default.

Table 47-16. MsgBox Return Values

Constant Value Description

mbOK 1 OK

mbCancel 2 Cancel*

mbAbort 3 Abort

mbRetry 4 Retry

mbIgnore 5 Ignore

mbYes 6 Yes

mbNo 7 No

Table 47-15. MsgBox buttons Settings
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Right
This function returns a specified number of characters from the right side of a string.

Syntax

Right(string, length)

Arguments

The Right function has these arguments:

Example

The following sample code returns "dbc."

Right("abcdbc", 3)

string Required
A string expression from which the characters on the right 
side are returned

length A numeric expression indicating how many characters to 
return
If length is 0, Right returns a zero-length string (" "). If length 
is greater than or equal to the number of characters in the 
string, Right returns the entire string.



PADS Layout User’s Guide and Reference Manual, PADS 9.42282

The Macro Language
Sin

Sin
This function returns a Double specifying the sine of an angle.

The Sin function takes an angle and returns the ratio of two sides of a right triangle. The ratio is 
the length of the side opposite the angle divided by the length of the hypotenuse.

The result lies in the range -1 to 1.

To convert degrees to radians, multiply degrees by pi/180. To convert radians to degrees, 
multiply radians by 180/pi.

Syntax

Sin(number)

Arguments

The Sin function has this argument:

Example

x = sin(y)

number Required
Any expression that expresses an angle in radians. If the expression is 
not numeric, it is converted to a Numeric type.
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Spc
This function is used with the Print # statement or the Print method to position output.

Syntax

Spc(n)

Arguments

The Spc function has this argument:

If n is less than the output line width, the next print position immediately follows the number of 
spaces printed. If n is greater than the output line width, Spc calculates the next print position 
using the formula:

currentprintposition + (n Mod width)

For example, if the current print position is 24, the output line width is 80, and you specify 
Spc(90), the next print will start at position 34 (current print position + the remainder of 90/80). 
If the difference between the current print position and the output line width is less than n (or n 
Mod width), the Spc function skips to the beginning of the next line and generates spaces equal 
to n - (width - currentprintposition).

Example

Spc(3)

n Required
The number of spaces to insert before displaying or printing the next 
expression in a list
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Str
This function returns a string representation of a number.

Syntax

Str(number)

Arguments

The Str function has the following argument:

When numbers are converted to strings, a leading space is always reserved for the sign of 
number. If number is positive, the returned string contains a leading space and the plus sign is 
implied.

Example

x = Str(324)

number Required
Any expression. If the expression is not numeric, it is converted to a 
Numeric type.
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Tab
This function is used with the Print # statement or the Print method to position output.

Syntax

Tab[(n)]

Arguments

The Tab function has this argument:

If n is omitted, Tab moves the insertion point to the beginning of the next print zone. This 
allows you to use Tab instead of a comma whenever you use the comma as a decimal separator.

If the current print position on the current line is greater than n, Tab skips to the nth column on 
the next output line. If n is less than 1, Tab moves the print position to column 1. If n is greater 
than the output line width, Tab calculates the next print position using the formula:

n Mod width

For example, if width is 80 and you specify Tab(90), the next print will start at column 10 (the 
remainder of 90/80). If n is less than the current print position, printing begins on the next line at 
the calculated print position. If the calculated print position is greater than the current print 
position, printing begins at the calculated print position on the same line.

The leftmost print position on an output line is always 1. When you use theb statement to print 
to files, the rightmost print position is the current width of the output file, which you can set 
using the Width # statement.

Example

Tab(2)

n Optional
The column number to move to before displaying or printing the next 
expression in a list
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Val
This function returns the numbers contained in a string as a numeric value of the appropriate 
type.

Syntax

Val(string)

Argument

The Val function has this argument:

The Val function stops reading the string at the first character it can't recognize as part of a 
number. However, the function recognizes the radix prefixes &O (for octal) and &H (for 
hexadecimal). Blanks, tabs, and linefeed characters are stripped from the argument. The Val 
function recognizes only the period (.) as a valid decimal separator.

Example

i=Val("123")

Automation Support
The macro engine in the program supports Automation through its automation objects. After an 
object is created using CreateObject( ) or connected to using GetObject( ), the object's methods 
may be called using the usual syntax.

Object.Method arg1, ..., argn
var = Object.Method( arg1, ..., argn )
var = Object.Property
Object.Property = expression

Related Topics

CreateObject

GetObject

Dialog Box Controls
The macro language of this program uses the following dialog box controls:

• CheckBox

• CheckListBox

string Required
Any valid string expression
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• ComboBox

• EditBox

• GridControl

• ListBox

• PushButton

• RadioBox

• SliderControl

• SpinButton

• TabControl

• TreeItem

• TreeView
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CheckBox
This control represents a check box on a dialog box. You can reference a particular check box 
using the Control method of a dialog box. The CheckBox object uses the State and Property 
methods.

State

This method sets the state of the check box.

Syntax

checkbox.State(iState)

Arguments

State has this argument:

iState may have one of the following values:

Value Property

This method returns or sets the state of the check box control.

Syntax

checkbox.Value[=iState]

Arguments

The Value Property has this argument:

iState may have one of the following values::

iState Required
A numeric expression, representing the check box state to set

Table 47-17. CheckBox.State istate Values

Value Description

0, or False Unchecked

1, or True Checked

2 Indeterminate

iState Required
A numeric expression, representing the check box state to set

Table 47-18. CheckBox.Value istate Values

Value Description



The Macro Language
CheckBox

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2289

0, or False Unchecked

1, or True Checked

2 Indeterminate

Table 47-18. CheckBox.Value istate Values
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CheckListBox
This control represents a check list box on a dialog box.

State

This method sets the selection state of the check list box.

Syntax

CheckListBox.State(string)

Arguments

The State method has this argument:

SetCheck

This method sets the check state of the check list box.

Syntax

CheckListBox.SetCheck(string)

Arguments

The SetCheck method has this argument:

ListCount Property

This method returns the number of items in the check list box.

Syntax

CheckListBox.ListCount

SelCount Property

This method returns the number of selected items in the check list box.

Syntax

CheckListBox.SelCount

string Required
Any valid string expression, containing the list of items to select

string Required
A string expression, containing the list of the items to check. All the 
items that do not appear in the list are not checked.
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Selected Property

This method returns or sets the selection status of an item in the check list box. This property is 
an array of Boolean values with the same number of items as the List property.

Syntax

CheckListBox.Selected(index)[=boolean]

Check Property

This method returns or sets the checked status of an item in a check list box. This property is an 
array of Boolean values with the same number of items as the list property.

Syntax

CheckListBox.Check(index)[=boolean]

Text Property

This method returns the text of the item currently selected in the check list box.

Syntax

CheckListBox.Text
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ComboBox
This control represents a combo box on a dialog box.

Select

This method sets the selection state of the combo box.

Syntax

ComboBox.Select(string)

Arguments

The Select method has this argument:

Example

ActiveLayer.Select("Top")

Edit

This method sets the edit state of the combo box.

Syntax

ComboBox.Edit(string)

The Edit method has this argument:

Text Property

This method returns or sets the combo box text.

Syntax

ComboBox.Text[=string]

Arguments

The Text method has this argument:

string Required
A string expression, containing a string to select in the combo box

string Required
A string expression, containing a string to insert into the edit box of the 
combo box

string Required
A string expression, containing the text to set into the combo box
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List Property

This method returns or sets the items contained in the combo box list. This list is a string array 
in which each element is a list item.

Syntax

ComboBox.List(index)

SelStart Property

This method returns or sets the starting point of the selected text. If no text is selected, this 
method indicates the position of the insertion point.

Syntax

ComboBox.SelStart[=index]

SelLength Property

This method returns or sets the number of characters selected.

Syntax

ComboBox.SelLength[=number]

SelText Property

This method returns or sets the string containing the currently selected text. If no characters are 
selected, this method returns a zero length string ("").

Syntax

ComboBox.SelText[=string]

Arguments

The argument is a string expression, containing the text to set into the edit box.
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EditBox
This control represents an edit box on a dialog box. You can use the Control method of a dialog 
box to reference a particular edit box.

State

This method sets the state of the edit box.

Syntax

EditBox.State(string)

Arguments

State has this argument:

Text Property

This method returns or sets the edit box text.

Syntax

EditBox.Text[=string]

The string argument is a string expression, containing the text to set into the edit box.

SelStart Property

This method returns or sets the starting point of selected text. If no text is selected this method 
indicates the position of the insertion point.

Syntax

EditBox.SelStart[=index]

SelLength Property

This method returns or sets the number of characters selected.

Syntax

EditBox.SelLength[=number]

SelText Property

This method returns or sets the string containing the currently selected text. If no characters are 
selected this method returns a zero length string ("").

string Required
A string expression of the text to display in the edit box
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Syntax

EditBox.SelText[=string]

Arguments

The SelText method has this argument:

string A string expression, containing the text to set into the edit box
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GridControl
This control represents a grid control on a dialog box. You can use the control method to 
reference a particular grid control.
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ListBox
This control represents a list box on a dialog box.

State

This method sets the selection state of the list box.

Syntax

ListBox.State(string)

Arguments

The State method has this argument:

List Property

This method returns the items contained in a dialog box list portion. The list is a string array in 
which each element is a list item.

Syntax

ListBox.List

ListCount Property

This method returns the number of items in the list box.

Syntax

ListBox.ListCount

SelCount Property

This method returns the number of selected items in a list box.

Syntax

ListBox.SelCount

Selected Property

This method returns or sets the selection status of an item in a list box. This property is an array 
of Boolean values with the same number of items as the list property.

string Required
A string expression, containing the item numbers to select. All the items 
that do not appear in the list are not selected.
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Syntax

ListBox.Selected(index) [=boolean]

Text Property

This method returns the currently selected (focused) item's text in a list box.

Syntax

ListBox.Text
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PushButton
This control represents a push button (also called a command button) on a dialog box.

Click

This method emulates pressing a push button.

Syntax

button.Click()

Example

dlg.control("OK").click()
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RadioBox
This control represents an option button on a dialog box.

State

This method checks the state of the option button.

Syntax

RadioBox.State(iState)

Arguments

The State method has this argument:

Value Property

This method returns or checks the state of the option button.

Syntax

RadioBox.Value[=iState]

Arguments

Value Property has this argument:

iState Required
A numeric expression, representing the position of an option button to 
check. -1 means that no button is selected.

iState Required
A numeric expression, representing the position of an option button to 
check. -1 means that no button is selected.
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SliderControl
This control represents a slider control on a dialog box.

State

This method sets the state of the slider.

Syntax

SliderControl.State(iState)

Arguments

State has this argument:

Value Property

This method returns or sets the current slider position.

Syntax

Slider.Value[=val]

Arguments

Value Property has this argument:

iState Required
A numeric expression

val Required
A numeric expression
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SpinButton
This control represents a spin button on a dialog box.

State

This method sets the state of the spin button.

Syntax

SpinButton.State(iState)

Arguments

State has this argument:

iState Required
A numeric expression
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TabControl
This control represents a tab on a dialog box.

State

This method sets the selection state of the tab.

Syntax

TabControl.State(iState)

Arguments

State has this argument:

Example

dlg.Control("Tab").State(3)

Value Property

This method returns or sets the current tab position.

Syntax

TabControl.Value[=tab]

Arguments

Value Property has this argument:

iState Required
A numeric expression, which represents the position of a tab.

tab Required
Either a numeric expression representing the tab position or a string 
expression representing the tab caption
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TreeItem
This control represents a tree item on a dialog box.

Select

This method sets the selection state of the tree item.

Syntax

TreeItem.Select(flag)

Arguments

The Select method has this argument:

flag may have one of the following values:

Example

item.Select(true)

Expand

This method sets the expand state of the tree item.

Syntax

TreeItem.Expand(flag)

Arguments

Expand has this argument:

flag may have one of the following values:

flag Required
A numeric expression

Table 47-19. TreeItem.Select flag Values

Value Description

0, or False Unselect

1, or True Select

flag Required
A numeric expression

Table 47-20. TreeItem.Expand flag Values

Value Description
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Example

item.Expand(true)

Focus

This method sets the tree item focus to the item.

Syntax

TreeItem.Focus()

Example

item.Focus(1)

0, or False Collapse

1, or True Expand

Table 47-20. TreeItem.Expand flag Values
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TreeView
This control represents a Tree View on a dialog box.

Item

This method returns a TreeItem object.

Syntax

TreeView.Item(itemname)

Arguments

Item has this argument:

Example

item = tree.Item("Net Objects\Nets\end")

BeginDrag

This method emulates dragging selected items off the tree.

Syntax

TreeView.BeginDrag(itemname)

Arguments

BeginDrag has this argument:

Copy

This method copies the selected item to the Clipboard.

Syntax

TreeView.Copy(itemname)

Arguments

Copy has this argument:

itemname Required
A string expression representing the name of the item

itemname Required
A string expression representing the name of the item to drag

itemname Required
A string expression representing the name of the item to copy
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Drop

This method emulates dropping the dragged items onto an item.

Syntax

TreeView.Drop(itemname)

Arguments

The Drop method has this argument:

Example

tree.Drop("Net Objects\Net classes")

Paste

This method pastes the contents of the Clipboard into the selected branch.

Syntax

TreeView.Paste(itemname)

Arguments

Paste has this argument:

CreateNewItem

This method creates a new item in the selected branch. This method returns a TreeItem object 
that corresponds to the created item.

Syntax

TreeView.CreateNewItem(itemname)

Arguments

CreateNewItem has this argument:

itemname Required
A string expression representing the name of the item onto which to drop 
the dragged items 

itemname Required
A string expression representing the name of the item to paste

itemname Required
A string expression representing the name of the item to create
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Internal Macro Objects
The Internal Macro Objects of this program include the following:

• Application Object

• Dialog Objects

• Document Object

• HelpContents Object 

• HelpContentsItem Object 

• HelpPane Object 

• Main View Object

Application Object
This object represents applications of the program. The object has the following methods:

• CreateNewDocument

• ExecuteCommand

• Help

• HelpContents

• HelpPane

• OpenCustomizeDialog

• OpenDocument

• OpenOptionsDialog

• OpenPropertiesDialog

• Quit

• RunMacro

Related Topics

Internal Macro Objects
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CreateNewDocument
This method creates an empty document.

Syntax

Application.CreateNewDocument
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ExecuteCommand
This method executes one of the commands of the program.

Syntax

Application.ExecuteCommand(command, [arg1,...])

Argument

The ExecuteCommand method has these arguments:

Example1

Application.ExecuteCommand("ID_VIEW_BOARD")

Example2

Application.ExecuteCommand("Open", "C:\PADS Projects\preview.pcb")

command Required
A string expression representing a PADS product command

arg1,... Optional
Represents optional arguments that are passed to command 
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Help
This method invokes the Help.

Syntax

Application.Help()
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HelpContents
This method returns the Help contents in the Help Contents window.

Syntax

Application.HelpContents

Example

Set var = Application.HelpContents
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HelpPane
This method returns the Help window.

Syntax

Application.HelpPane

Example

Set var = Application.HelpPane
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OpenCustomizeDialog
This method opens the Customize modal dialog box.

Syntax

Application.OpenCustomizeDialog()
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OpenDocument
This method opens an existing document identified by the path argument.

Syntax

Application.OpenDocument(path)

Argument

The OpenDocument method has this argument:

Example

Application.OpenDocument("C:\PADS Projects\preview.pcb") 

path Required
A string expression containing the path of the document to open
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OpenOptionsDialog
This method opens the Options modeless dialog box.

Syntax

Application.OpenOptionsDialog()
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OpenPropertiesDialog
This method opens the Properties modeless dialog box.

Syntax

Application.OpenPropertiesDialog()
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Quit
This method exits the application.

Syntax

Application.Quit()
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RunMacro
This method executes one of the program commands.

Syntax

Application.RunMacro(path[, function [, arg1, ...]])

Arguments

The RunMacro method has these arguments:

Example

Application.RunMacro("C:\PADS Projects\mymacro.mcr")

Var = Application.RunMacro(“C:\PADS Projects\mymacro.mcr”, myfunction”, 1, 
2, 3)

Dialog Objects
A dialog object represents a dialog box. This object has the following methods:

• Control

• Focus

• HelpPane

• OpenHelpPane

• CloseHelpPane

• ShowHelpFor

Related Topics

Internal Macro Objects

path Required
A string expression containing the file path of the macro to run

function Optional 
Name of a function or a sub in the macro file to be called. 
If the function is specified, RunMacro returns what the function returns. 
If the function is not specified, or it is a sub, which returns nothing, 
RunMacro returns nothing.

arg1,... Optional
Arguments that are passed onto function



PADS Layout User’s Guide and Reference Manual, PADS 9.42320

The Macro Language
Focus

Focus
This method sets focus to a dialog box control.

Syntax

Dialog.Focus(controlname)

Arguments

The Focus method has this argument:

Related Topics

Control

controlname Required
A string expression representing the name of the control
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Control
This method returns a dialog box control.

Syntax

Dialog.Control(controlname)

Arguments

Control has this argument:

Example

This example returns the OK button.

set obj = dlg.Control("OK")

Related Topics

Focus

controlname Required
A string expression representing the name of the control
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CloseHelpPane
This method closes the open help pane in a dialog box.

Syntax

Dialog.CloseHelpPane

Example

Dialog.CloseHelpPane
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OpenHelpPane
This method displays the help pane for the dialog box.

Syntax

Dialog.OpenHelpPane

Example

Dialog.OpenHelpPane
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ShowHelpFor
This method displays help for the specified control.

Syntax

Dialog.ShowHelpFor(controlname)

Arguments

The ShowHelpFor method has this argument:

Example

This example displays Help for the Apply button.

Dialog.ShowHelpFor("Apply")

Document Object
The Document object represents any currently loaded design. This object has the following 
methods:

• Print

• PrintSetup

• RepeatLastAction

• Save

• SaveAs

Related Topics

Internal Macro Objects

controlname Required
The name of the control
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Print
This method prints the document.

Syntax

Document.Print()
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PrintSetup
This method opens the Print Setup dialog box.

Syntax

Document.PrintSetup()
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RepeatLastAction
This method repeats the last action performed during the current session.

Syntax

Document.RepeatLastAction()
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Save
This method saves the document, if it has been modified.

Syntax

Document.Save()
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SaveAs
This method saves the document to a user-defined name or path location.

Syntax

Document.SaveAs(path)

The SaveAs method has this argument:

HelpContents Object
The HelpContents object represents the Help Contents window.

Item

The Item property finds the location of the Help contents item in the contents tree. 

Syntax

Application.HelpContents.Item (path)

Example

Set item = Application.HelpContents.Item("File Operations\To Restore 
Files")

Related Topics

Internal Macro Objects

HelpContentsItem Object
This object finds the name of the Help Contents item. The HelpContentsItem object has the 
following properties and one method (Select):

• Location

• Name

• Select

• SubItem

• SubItemCount

path Required
A string expression representing the path to which to save the document
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SaveAs

Related Topics

Internal Macro Objects
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Location
This property returns the location of the item.

Syntax

Item.Location

Example

In this example, the item_loc variable is assigned a value of "its:C:\Program Files\Mentor 
Graphics\PADS\<latest_release>
\Documentation\Router\BlazeRouter.chm::
/fileops/To_Restore_Files.htm".

Set item = Application.HelpContents.Item("File Operations\To Restore 
Files")
item_loc = item.Location
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Name
This property returns the name of the item.

Syntax

Item.Name

Example

In this example, the item_name variable is assigned the value of "To Restore Files."

Set item = Application.HelpContents.Item("File Operations\To Restore 
Files")
item_name = item.Name
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Select
This method selects the item.

Syntax

Item.Select

Example

Set item = Application.HelpContents.Item("File Operations").SubItem(3)
item.Select
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SubItem
This property returns a sub item of the item by its position. The required integer pos argument is 
the zero-based serial number of a sub item in the tree branch that the item represents.

Syntax

Item.SubItem(pos)

Example

In this example, the item_name variable is assigned value of "To Restore Files".

Set item = Application.HelpContents.Item("File Operations").SubItem(3)
item_name = item.Name
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SubItemCount
This property returns the number of sub items within the item.

Syntax

Item.SubItemCount

Example

In this example, the count variable is assigned a value of 10.

Set item = Application.HelpContents.Item("File Operations")
count = item.SubItemCount

HelpPane Object
This object represents the Help window.

Document

The Document property displays the HTML document in the Help window.  This property uses 
the Document Object Model (DOM). For the full description of the HTMLDocument interface, 
see the Microsoft Software Developer’s Network (MSDN) documentation.

The following are the most useful properties that the Macro engine uses:

Related Topics

Internal Macro Objects

Main View Object
The MainView object represents the main view of the program. This object uses the following 
methods:

• ActiveLayer

• ToggleFullScreen

• MouseDown

• MouseEndDrag

title Sets or retrieves the title of the document. This property displays the 
document title in the title bar of the document window. Also, it identifies 
the contents of the document.

URL Sets or retrieves the Uniform Resource Locator (URL) for the current 
document.
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• MouseMove

• MouseStartDrag

• MouseUp

• Print

• PrintPreview

Related Topics

Internal Macro Objects
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ActiveLayer
This method displays the Active Layer combo box.

Syntax

MainView.ActiveLayer

Example

set layerCombo = MainView.ActiveLayer
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ToggleFullScreen
This method turns the Full Screen mode on.

Syntax

MainView.ToggleFullScreen()



The Macro Language
MouseDown

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2339

MouseDown
This method emulates pressing a mouse button.

Syntax

MainView.MouseDown(x, y, button)

Arguments

The MouseDown method has these arguments:

The button argument may contain one or more of the following values and modifiers:

x Required
Any numeric expression
X-coordinate of pointer

y Required
Any numeric expression
Y-coordinate of pointer

button Required
String expression
Pressed button, if any

Table 47-21. MainView.MouseDown button Values

Value Description

L Left mouse button pressed

M Middle mouse button pressed

R Right mouse button pressed

C Ctrl button pressed (modifier)

S Shift button pressed (modifier)

A Alt button pressed (modifier)
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MouseEndDrag
This method emulates ending a mouse drag operation.

Syntax

MainView.MouseEndDrag(x, y, button)

Arguments

The Mouse End Drag method has these arguments:

The button argument may contain one or more of the following values and modifiers:

x Required
Any numeric expression
X-coordinate of pointer

y Required
Any numeric expression
Y-coordinate of pointer

button Required
String expression
Pressed button, if any

Table 47-22. MainView.MouseEndDrag button Values

Value Description

L Left mouse button pressed

M Middle mouse button pressed

R Right mouse button pressed

C Ctrl button pressed (modifier)

S Shift button pressed (modifier)

A Alt button pressed (modifier)
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MouseMove
This method emulates moving the mouse.

Syntax

MainView.MouseMove(x, y, button)

Arguments

The Mouse Move method has these arguments:

The button argument may contain one or more of the following values and modifiers:

Examples

MainView.MouseMove(300,350,"+L")
or
MainView.MouseMove(300,350,"*L")

x Required
Any numeric expression
X-coordinate of pointer

y Required
Any numeric expression
Y-coordinate of pointer

button Required
String expression
* indicates relative mode
+ indicates origin plus 
relative mode
Pressed button, if any

Table 47-23. MainView.MouseMove button Values

Value Description

L Left mouse button pressed

M Middle mouse button pressed

R Right mouse button pressed

C Ctrl button pressed (modifier)

S Shift button pressed (modifier)

A Alt button pressed (modifier)
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MouseStartDrag
This method emulates starting a mouse drag operation.

Syntax

MainView.MouseStartDrag(x, y, button)

Arguments

The MouseStartDrag method has these arguments:

The button argument may contain one or more of the following values and modifiers:

x Required
Any numeric expression
X-coordinate of pointer

y Required
Any numeric expression
Y-coordinate of pointer

button Required
String expression
Pressed button, if any

Table 47-24. MainView.MouseStartDrag button Values

Value Description

L Left mouse button pressed

M Middle mouse button pressed

R Right mouse button pressed

C Ctrl button pressed (modifier)

S Shift button pressed (modifier)

A Alt button pressed (modifier)
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MouseUp
This method emulates releasing a mouse button.

Syntax

MainView.MouseUp(x, y, button)

The MouseUp method has these arguments:

The button argument may contain one or more of the following values and modifiers:

x Required
Any numeric expression
X-coordinate of pointer

y Required
Any numeric expression
Y-coordinate of pointer

button Required
String expression
Pressed button, if any

Table 47-25. MainView.MouseUp button Values

Value Description

L Left mouse button pressed

M Middle mouse button pressed

R Right mouse button pressed

C Ctrl button pressed (modifier)

S Shift button pressed (modifier)

A Alt button pressed (modifier)
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Print
This method prints the current view.

Syntax

MainView.Print()
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PrintPreview
This method turns the Print Preview mode on.

Syntax

MainView.PrintPreview()
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Chapter 48
The Format for Rules in the ECO File

This chapter covers the syntax used in the ECO file when design rules are created or modified 
during ECO Operations. You can pass these rule entries from schematic capture systems that 
have rules capabilities or to schematic capture systems that have rules capabilities as part of the 
back annotation process. You can also Import the rules into other PCB designs.

Tip: When importing the ECO file into an existing design, rules entries are only applied to nets 
with the same name. Any nets that aren't found create an error report. Before importing, open 
the design and rename the target connections.

Heading information for the Rules section of the ECO file are illustrated in the Example ECO 
file. 

• The Formatting for Design Rules in the ECO File 

• The Formatting for General Clearance Rules in the ECO File 

• The Formatting for Conditional Clearance Rules in the ECO File

• The Formatting for General High-Speed Rules in the ECO File 

• The Formatting for Conditional High-Speed Rules in the ECO File 

• The Formatting for General Routing Rules in the ECO File 

• The Formatting for Differential Pairs Rules in the ECO File

• The Formatting for Net Classes Rules in the ECO File 

• The Formatting for Pin Pair Group Rules in the ECO File 

• Example ECO File

The Formatting for Design Rules in the ECO File
Apply design rules at five hierarchical levels. The lowest level, called the default level, applies 
rules to all objects on the PCB not otherwise specified.

Table 48-1 lists the design rule hierarchical levels. 

Table 48-1. Design Rules Hierarchical Levels 

Hierarchical Level Design Rule Object

Default HIERARCHY_OBJECT PCB:PCB
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General Design Rules

Design rules often apply to a list of objects. For each object, the ECO file contains the notation:

HIERARCHY_OBJECT <type>:<name> 

For example, if a rule applies to nets DATA0 through DATA3, the ECO file lists the nets this 
way:

HIERARCHY_OBJECT NET:DATA0
HIERARCHY_OBJECT NET:DATA1
HIERARCHY_OBJECT NET:DATA2
HIERARCHY_OBJECT NET:DATA3

Conditional Design Rules

Conditional rules apply from one object against another object. The ECO file uses the format:

<from_type>:<from_name> <against_type>:<against_name> [<layer_name>]

to refer to the from and against objects and the layer name for Conditional Rules. The brackets 
around the layer name indicate it is an optional argument.

For example:

NET:GND CLS:Clock_Nets

In the above example, the rule applies throughout all layers of the design. When the rule applies 
only to a single layer named TOP, the ECO file lists the objects this way:

NET:GND CLS:Clock_Nets TOP

Conditional clearance and conditional high-speed rules are supported. Conditional routing rules 
do not exist.

The Formatting for Conditional Clearance Rules in the ECO File
When you can create or modify a conditional clearance rule, the ECO file lists the change using 
the following format: 

Net HIERARCHY_OBJECT NET:<net_name>

Class HIERARCHY_OBJECT CLS:<class_name>

Pin Pair HIERARCHY_OBJECT 
CON:<pin_pair_name>

Group HIERARCHY_OBJECT GRP:<group_name>

Table 48-1. Design Rules Hierarchical Levels (cont.)

Hierarchical Level Design Rule Object
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*CREATE_CONDITIONAL_RULES* CLEARANCE
(or MODIFY_CONDITIONAL_RULES* CLEARANCE) 
<from_type>:<from_name> <against_type>:<against_name> [<layer_name>]
TRACK_TO_TRACK <value>
VIA_TO_TRACK <value>
VIA_TO_VIA <value>
PAD_TO_TRACK <value>
PAD_TO_VIA <value>
PAD_TO_PAD <value>
SMD_TO_TRACK <value>
SMD_TO_VIA <value>
SMD_TO_PAD <value>
SMD_TO_SMD <value>
COPPER_TO_TRACK <value>
COPPER_TO_VIA <value>
COPPER_TO_PAD <value>
COPPER_TO_SMD <value>
TEXT_TO_TRACK <value>
TEXT_TO_VIA <value>
TEXT_TO_PAD <value>
TEXT_TO_SMD <value>

When you delete a conditional clearance rule, the ECO file lists the change using the following 
format.

*DELETE_CONDITIONAL_RULES* CLEARANCE
<from_type>:<from_name> <against_type>:<against_name> [<layer_name>]

The Formatting for Conditional High-Speed Rules in the ECO File
When you create or modify a conditional high-speed rule, the ECO file lists the change using 
the following format:

*CREATE_CONDITIONAL_RULES* HIGH_SPEED
(or MODIFY_CONDITIONAL_RULES* HIGH_SPEED) 
<from_type>:<from_name> <against_type>:<against_name> [<layer_name>]
PARALLEL_LENGTH <value>
PARALLEL_GAP <value>
TANDEM_LENGTH <value>
TANDEM_GAP <value>

When you delete a conditional high speed rule, the ECO file lists the change using the following 
format:

*DELETE_CONDITIONAL_RULES* HIGH_SPEED
from_type>:<from_name> <against_type>:<against_name> [<layer_name>]

The Formatting for Differential Pairs Rules in the ECO File
When you create a Differential Pair or modify an existing one, the ECO file lists the change 
using the following format:

*CREATE_DIFFERENTIAL_PAIR* <object1> <object2>



PADS Layout User’s Guide and Reference Manual, PADS 9.42350

The Format for Rules in the ECO File

GAP <value>
MIN_LENGTH <value>
MAX_LENGTH <value>
*MODIFY_DIFFERENTIAL_PAIR* <object1> <object2>
GAP <value>
MIN_LENGTH <value>
MAX_LENGTH <value>
*DELETE_DIFFERENTIAL_PAIR* <object1> <object2>

The Formatting for General Clearance Rules in the ECO File
When you create or modify a clearance rule, the ECO file lists the change using this format:

*CREATE_GENERAL_RULES*CLEARANCE
(or *MODIFY_GENERAL_RULES* CLEARANCE)
HIERARCHY_OBJECT <type>:<name>
MIN_TRACK_WIDTH <value>
REC_TRACK_WIDTH <value>
MAX_TRACK_WIDTH <value>
TRACK_TO_TRACK <value>
VIA_TO_TRACK <value>
VIA_TO_VIA <value>
PAD_TO_TRACK <value>
PAD_TO_VIA <value>
PAD_TO_PAD <value>
SMD_TO_TRACK <value>
SMD_TO_VIA <value>
SMD_TO_PAD <value>
SMD_TO_SMD <value>
COPPER_TO_TRACK <value>
COPPER_TO_VIA <value>
COPPER_TO_PAD <value>
COPPER_TO_SMD <value>
TEXT_TO_TRACK <value>
TEXT_TO_VIA <value>
TEXT_TO_PAD <value>
TEXT_TO_SMD <value>
OUTLINE_TO_TRACK <value>
OUTLINE_TO_VIA <value>
OUTLINE_TO_PAD <value>
OUTLINE_TO_SMD <value>
DRILL_TO_TRACK <value>
DRILL_TO_VIA <value>
DRILL_TO_PAD <value>
DRILL_TO_SMD <value>
SAME_NET_SMD_TO_VIA <value>
SAME_NET_SMD_TO_CRN <value>
SAME_NET_VIA_TO_VIA <value>
SAME_NET_PAD_TO_CRN <value>
DRILL_TO_DRILL <value>
BODY_TO_BODY <value>

When you delete a general clearance rule, the ECO file lists the change using the following 
format:

*DELETE_GENERAL_RULES* CLEARANCE
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HIERARCHY_OBJECT <type>:<name> 

The Formatting for General High-Speed Rules in the ECO File
When you create or modify a high-speed rule, the ECO file lists the change using the following 
format:

*CREATE_GENERAL_RULES* HIGH_SPEED
(or *MODIFY_GENERAL_RULES* HIGH_SPEED) 
HIERARCHY_OBJECT <type>:<name>
MIN_LENGTH <value>
MAX_LENGTH <value>
STUB_LENGTH <value>
PARALLEL_LENGTH <value>
PARALLEL_GAP <value>
TANDEM_LENGTH <value>
TANDEM_GAP <value>
MIN_DELAY <value>
MAX_DELAY <value>
MIN_CAPACITANCE <value>
MAX_CAPACITANCE <value>
MIN_IMPEDANCE <value>
MAX_IMPEDANCE <value>
AGGRESSOR < ON | OFF>
SHIELD < ON | OFF > <gap_value> <net_name>
MATCH_LENGTH < ON | OFF > <tolerance_value>

When you delete a general high-speed rule, the ECO file list the change using the following 
format:

*DELETE_GENERAL_RULES* HIGH_SPEED
HIERARCHY_OBJECT <type>:<name>

The Formatting for General Routing Rules in the ECO File
When you create or modify a routing rule, the ECO file lists the change using the following 
format:

*CREATE_GENERAL_RULES* ROUTING
(or *MODIFY_GENERAL_RULES* ROUTING) 
HIERARCHY_OBJECT <type>:<name>
LENGTH_MINIMIZATION_TYPE <NONE | TOTAL |HORIZONTAL|VERTICAL
SERIAL | PARALLEL | MID_DRIVEN >
DISPLAY_RATSNEST < ON | OFF >
COPPER_SHARE < ON | OFF >
AUTO_ROUTE < ON | OFF >
ALLOW_RIPUP < ON | OFF >
ALLOW_SHOVE < ON | OFF >
ROUTE_PRIORITY < ON | OFF >
VALID_LAYERS <layerName>...
VALID_VIA_TYPES <via_name>...

To delete general routing rules in the ECO file, use the following format. Do not supply 
parameters when deleting General Routing Rules.
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*DELETE_GENERAL_RULES* ROUTING 
HIERARCHY_OBJECT <type>:<name>

The Formatting for Net Classes Rules in the ECO File
When you create, rename, or delete net classes, the ECO file lists the change using the 
following formats:

*CLASS* <classname>
<net_name>. . .<net_name>
*RENCLASS* <old_class_name> <new_class_name>
*DELCLASS* <class_name>

When you add nets to an existing class, the ECO file lists the change using the same format as 
the one for creating new class:

*CLASS* <existing_classname>
<net_name_to_add>
. . . 
<net_name_to_add>

When you remove nets from an existing class, the ECO file lists the change using the following 
format:

*EXCNET* <classname>
<net_name_to_exclude>
. . .
<net_name_to_exclude>

The Formatting for Pin Pair Group Rules in the ECO File
When you create, rename, or delete a pin pair group, the ECO file lists the change using the 
following format: 

*GROUP* <group_name>
<pin_pair_name>. . .<pin_pair_name>
*RENGROUP* <old_group_name> <new_group_name>
*DELGROUP* <group_name>

When you add pin pairs to an existing group, the ECO file lists the change using same format as 
the one for creating new group:

*GROUP* <existing_group_name>
<pin-pair_to_add>
. . . 
<pin-pair_to_add>

When you remove pin pairs from an existing group, the ECO file lists the change using the 
following format:

*EXCCON* <group_name>
<pin-pair_to_exclude>
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. . .
<pin-pair_to_exclude>
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Example ECO File
*PADS-ECO-MILS*
*PADS-ECO* ENGINEERING CHANGE ORDER REPORT
*REMARK* -- DEMOA.PCB -- Mon Jan 03 12:00:00 2000
*REMARK* Create a net class containing 3 nets
*CLASS* CLASS1$$$1879$$$1906$$$1928
*REMARK* Rename it to CLASS2
*RENCLASS*CLASS1 CLASS2
*REMARK* And delete it
*DELCLASS* CLASS2
*REMARK* Create a pin pair group containing 5 pin pairs
*GROUP* GROUP1U2.2 U1.2 U3.2 U2.2 U3.2 U4.2 U1.5 U2.5 U4.5 U1.5
*REMARK* Rename it to GROUP2
*RENGROUP*GROUP1 GROUP2
*REMARK* And delete it
*DELGROUP* GROUP1
*REMARK* Create default clearance rules for the board
*MODIFY_GENERAL_RULES* CLEARANCE
HIERARCHY_OBJECT PCB:PCB
MIN_TRACK_WIDTH 10
REC_TRACK_WIDTH 10
MAX_TRACK_WIDTH 12
TRACK_TO_TRACK 12
VIA_TO_TRACK 12
VIA_TO_VIA 12
PAD_TO_TRACK 12
PAD_TO_VIA 12
PAD_TO_PAD 12
SMD_TO_TRACK 12
SMD_TO_VIA 12
SMD_TO_PAD 12
SMD_TO_SMD 12
COPPER_TO_TRACK 12
COPPER_TO_VIA 12
COPPER_TO_PAD 12
COPPER_TO_SMD 12
TEXT_TO_TRACK 12
TEXT_TO_VIA 12
TEXT_TO_PAD 12
TEXT_TO_SMD 12
OUTLINE_TO_TRACK 12
OUTLINE_TO_VIA 12
OUTLINE_TO_PAD 12
OUTLINE_TO_SMD 12
DRILL_TO_TRACK 12
DRILL_TO_VIA 12
DRILL_TO_PAD 12
DRILL_TO_SMD 12
SAME_NET_SMD_TO_VIA 12
SAME_NET_SMD_TO_CRN 12
SAME_NET_VIA_TO_VIA 12
SAME_NET_PAD_TO_CRN 12
DRILL_TO_DRILL 12
BODY_TO_BODY 12
*REMARK* Create routing rules for net class CLASS1
*CREATE_GENERAL_RULES* ROUTINGHIERARCHY_OBJECT CLS:CLASS1
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LENGTH_MINIMIZATION_TYPE VERTICAL
DISPLAY_RATSNEST OFF
COPPER_SHARE OFF
AUTO_ROUTE OFF
ALLOW_RIPUP OFF
ALLOW_SHOVE OFF
ROUTE_PRIORITY 3
VALID_LAYERS Top Bottom
VALID_VIA_TYPE STANDARDVIA
*REMARK* Create high speed rules for net $$$1963.Assign GND as a
*REMARK* shield net. (GND must first be assigned to a plane layer)
*CREATE_GENERAL_RULES* HIGH_SPEED
HIERARCHY_OBJECT NET:$$$1963
MIN_LENGTH 0
MAX_LENGTH 50000
STUB_LENGTH 1000
MIN_DELAY 0.000000
MAX_DELAY 10.000000
MIN_IMPEDANCE 50.000000
MAX_IMPEDANCE 150.000000
MIN_CAPACITANCE 0.000000
MAX_CAPACITANCE 10.000000
PARALLEL_LENGTH 1000
PARALLEL_GAP 200
TANDEM_LENGTH 1000
TANDEM_GAP 200
AGGRESSOR OFF
SHIELD OFF 200 GND 
MATCH_LENGTH OFF 200
*REMARK* Create high speed rules for pin pair group GROUP1
*CREATE_GENERAL_RULES* HIGH_SPEEDHIERARCHY_OBJECT GRP:GROUP1
MIN_LENGTH 0
MAX_LENGTH 50000
STUB_LENGTH 1000
MIN_DELAY  0.000000
MAX_DELAY 10.000000
MIN_IMPEDANCE 50.000000
MAX_IMPEDANCE 150.000000
PARALLEL_LENGTH 1000
PARALLEL_GAP 200
TANDEM_LENGTH 1000
TANDEM_GAP 200
AGGRESSOR OFF
*REMARK* Create routing rules for pin pair CON:U4.6-U1.6
*CREATE_GENERAL_RULES* ROUTINGHIERARCHY_OBJECT CON:U4.6-U1.6
AUTO_ROUTE OFF

ALLOW_RIPUP OFF

ALLOW_SHOVE OFF
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ROUTE_PRIORITY 3
*REMARK* Create conditional clearance rules for net $$$1928
*REMARK* against net $$$1951 on all layers.
*CREATE_CONDITIONAL_RULES* CLEARANCENET:$$$1928 NET:$$$1951
TRACK_TO_TRACK 12
VIA_TO_TRACK 12
VIA_TO_VIA 12
PAD_TO_TRACK 12
PAD_TO_VIA 12
PAD_TO_PAD 12
SMD_TO_TRACK 12
SMD_TO_VIA 12
SMD_TO_PAD 12
SMD_TO_SMD 12
COPPER_TO_TRACK 12
COPPER_TO_VIA 12
COPPER_TO_PAD 12
COPPER_TO_SMD 12
TEXT_TO_TRACK 12
TEXT_TO_VIA 12
TEXT_TO_PAD 12
TEXT_TO_SMD 12
*REMARK* Create conditional high speed rules for net $$$2008
*REMARK* against net $$$2016 on all layers.
*CREATE_CONDITIONAL_RULES* HIGH_SPEEDNET:$$$2008 NET:$$$2016
PARALLEL_LENGTH 1000
PARALLEL_GAP 200
TANDEM_LENGTH 1000
TANDEM_GAP 200
*REMARK* Create conditional clearance rules for pin pair net U4.6-U1.6
*REMARK* against pin pair U2.6-U1.6. Applies only on layer BOTTOM.
*CREATE_CONDITIONAL_RULES* CLEARANCECON:U4.6-U1.6 CON:U2.6-U1.6 BOTTOM
TRACK_TO_TRACK 12
VIA_TO_TRACK 12
VIA_TO_VIA 12
PAD_TO_TRACK 12
PAD_TO_VIA 12
PAD_TO_PAD 12
SMD_TO_TRACK 12
SMD_TO_VIA 12
SMD_TO_PAD 12
SMD_TO_SMD 12
COPPER_TO_TRACK 12
COPPER_TO_VIA 12
COPPER_TO_PAD 12
COPPER_TO_SMD 12
TEXT_TO_TRACK 12
TEXT_TO_VIA 12
TEXT_TO_PAD 12
TEXT_TO_SMD 12
*REMARK* Delete the conditional clearance rules for pin pair net U4.6-U1.6
*REMARK* against pin pair U2.6-U1.6 on layer BOTTOM.
*DELETE_CONDITIONAL_RULES* CLEARANCECON:U4.6-U1.6 CON:U2.6-U1.6 Bottom
*REMARK* Create a differential pair of nets $$$1906 and $$$2008
*CREATE_DIFFERENTIAL_PAIR* NET:$$$1906 NET:$$$2008
GAP 10
MIN_LENGTH 10
MAX_LENGTH 100
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*REMARK* Create differential pair of pin pairs U2.8-U1.8 and U4.6-U1.6
*CREATE_DIFFERENTIAL_PAIR* CON:U2.8-U1.8 CON:U4.6-U1.6
GAP 10
MIN_LENGTH 10
MAX_LENGTH 100
*END*
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— A —

absolute coordinates
Coordinates of a location based upon their distance from the origin (coordinates 0,0) of the 
design area. 

accelerator keys
Key sequences used to invoke commands and change system settings without using the mouse. 
Accelerator keys are called shortcut keys in the PADS product documentation.

accessible nets
Nets for which you can define test points. DFT Audit analyzes all nets. If DFT Audit determines 
that test probes can access them, the nets are accessible (also called adaptable).

accordion
A trace pattern resembling a signal wave that adds length to traces. The trace patterns are 
contiguous and do not include layer changes.

accordion gap
The gap of an accordion sets the pitch between chords. The gap is a user-definable number 
multiplied by the same net trace-to-corner clearance.

Tip: If the same-net trace-to-corner distance equals zero, then Trace Width is used for the gap 
calculation.

See also: accordion, amplitude, pair routing gap 
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acid trap
An acid trap is a location where acid gets trapped in an area due to the surface tension of the 
etching. This acid causes over-etching, which hurts yield.

active component
The active substituted component in an assembly variant. Active means that this substitution of 
the component is used in the current variant. 

See also: default.asc 

active layer
The design layer to which new information is added. You select the active layer by choosing the 
layer in the Layer list on the standard toolbar. You can also do this by using the L modeless 
command.

ACTM#
The 16-digit number found on your security key.

adaptable nets
See accessible nets 

adhesive
A substance used to attach the bodies of devices to a PC board.

aggressor nets
When using the Electrodynamic Checking program (EDC), a net or pin pair that is considered a 
source of interference.

align
To reposition placed parts to match the alignment of another part.

alignment tool
A small, temporary marker at each location where dimensioning occurs.

alpha pins
Pins with descriptive letters that are substituted for pin numbers. For example, GND for the 
ground pin. Alphanumeric pin assignments are made in the Library Manager's part type editor.

alphanumeric pins
Pins with alphanumeric pin numbers. An alphanumeric name consists of a prefix and suffix. The 
prefix or the suffix can contain either alpha letters or numeric numbers. For example, A1, 1A, or 
even DATA07 (consists of the prefix “DATA” and the suffix “07”). 

amplitude
The amplitude of an accordion sets the accordion height (for horizontal accordions) or accordion 
width (for vertical accordions). The amplitude is a user-definable number, multiplied by the 
same net trace-to-corner clearance. 
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Tip: If the same-net trace-to-corner distance equals zero, then Trace Width is used for the 
amplitude calculation.

See also: accordion, gap (accordion) 

analog circuit
A design composed of discrete components such as capacitors, resistors, and diodes.

angstrom
1/10,000 of a micrometer (10-4um).

annotation (forward and backward)
Forward annotation refers to the process of updating the design file to match the schematic file. 
Backward annotation refers to updating the schematic file to match the design file.

annular pad
A pad shape that enables you to specify an inside and an outside diameter. This creates a donut 
shape because the inner hole was used to center the drill bit when boards were hand-drilled on a 
drill press. Though obsolete, the annular pad is still offered for special circumstances. 

antipad
For plane layers, a slightly oversized pad diameter that plots as a clearance for through-hole pins 
that should not connect to the plane.

any-angle coupling trace
Part of a route that connects SBP fanouts to serpentine routes.

aperture
A uniquely shaped window or hole that is attached to an aperture wheel on a photoplotting 
machine. 

aperture table
A table that matches the line widths necessary to print your design with the plotter setup. PADS 
Layout can prepare the table automatically, or you can prepare it manually.

Artwork for printed circuit manufacturing is created by exposing clear film to light that is passed 
though the aperture. Although the aperture wheel has been made obsolete by laser plotters, an 
aperture table is still necessary to drive laser plotters.
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apl.dcr
A setup file for Novell network security.

application-specific integrated circuit
An IC designed to meet a specific customer requirement.

area select
A method for selecting an object or a group of objects. If you enable area select by clicking Filter 
on the Edit menu, a selection rectangle is created and all items within the rectangle are selected.

array
A group of items, such as bonding pads, that are arranged in rows and columns.

artwork
Clear film with darkened areas representing pads and connecting traces, and used for 
manufacturing a printed circuit board. Each layer of a design has its own unique artwork, such as 
silkscreen and solder mask.

.asc
The file extension used to identify a proprietary PADS-format ASCII file. 

ASCII format
A translation format that uses ASCII text to define the PCB design. ASCII format is widely used 
to list the parts and connections in a design, to import and export design items, and to check the 
design for binary corruption. 

ASIC
An acronym for application-specific integrated circuit. 

assembly drawing
A final design document that provides the part name, type, and orientation for each device on a 
printed circuit board. An assembly drawing is used for assembly of the final product. 

assembly variant
A specific manufacturing configuration of a PCB. Assembly variants specify which components 
are used, which are not used, and which are substituted with a different decal part type. Several 
assembly variants can exist for a single PCB. 

associated net
A series of nets connected by one or more components. Length, differential pair and matched 
length rules can be applied to an associated net as though it were a single net.

associating component
A component through which an associated net passes.

associating copper
Copper combined with the terminals in the PCB Decal Editor.
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attribute groups
A group of structured attributes. For example, the DFT group includes the following attributes: 

1. DFT.Nail Count Per Net
DFT.Nail Number 
DFT.Nail Diameter 

attributes
Attributes contain information you have associated with an object in your design. Attributes 
contain the types of part information that can be included in the parts library description and 
exported to a parts list. Examples are part manufacturer, package type, order number, and so on.

Auto Dimensioning tab
The tab on the Options dialog box that determines the appearance of newly created dimensions. 

automation
A way for heterogeneous applications to communicate with each other. PADS products make 
some data, such as the database in use, and some functionality, such as opening files or selecting 
objects, available to other applications. 

autorouter pass types
Pass types are part of an autorouting strategy that determines how the autorouter routes a design. 

Table Glossary-1. Pass Types 

Pass Description

Center Places traces equidistant from component pins or vias and each other to evenly 
distribute any available space in the channel. 

Fanout Places vias for inaccessible SMD component pins and routes from the vias to 
the pins.

Miters Converts all route corners of a specified angle to diagonal corners.

Optimize Analyzes each trace and tries to improve the quality of the route pattern by 
removing extra segments, reducing via usage, and shortening trace lengths.

Patterns Searches for groups of unrouted connections that can be completed using 
typical C routing patterns, Z routing patterns, and memory patterns and then 
routes them.

Route Sequentially routes each unroute until all connections are attempted.

Test Point Analyzes the testability of the design, determines which nets require testing, 
adjusts the routes, and inserts test points to improve testability.

Tune Adjusts the length of length-controlled traces. The Tune pass tunes all routed 
traces with length rules, and automatically adjusts length-controlled traces to 
meet design rules.
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axial lead
A connection pin that protrudes straight out from the component body and bends at 90 degrees 
for insertion into the PC board. An axial lead is usually associated with discrete components such 
as resistors, capacitors, or diodes.

— B —

back-annotate
Update a schematic file to match its design file.

ball bonding
A bonding technique that provides increased contact between a gold wire and a chip bond pad. 
This method uses thermal compression to melt gold wire to form a ball. 

ball grid array
A packaging method that uses a substrate to interconnect one or more die to an array of solder 
alloy spheres.

base option
The Base Option, in Assembly Variants, contains all of the common components in all of the 
existing  variants; in other words, it contains a filtered database. If you uninstall or substitute 
components in a variant, they are removed from the Base Option. Therefore, the Base Option, 
because it contains only installed options, is also a subset of the raw database. You can use the 
Base Option to view all of the items in all of the variants, or the base of all variants. 

The Base Option always exists; you cannot delete it. 

base part
When making a union, the part type of the first selected part. Base parts can either be left in 
position and joined by secondary parts, or repositioned to imitate the first selected prototype part. 

baseline dimensioning
A type of dimensioning in which a series of dimensions have a common start point, such as 
datum dimensioning.

basic units
A basic unit is the smallest unit of measurement in a PADS database. All values in the database 
are stored in binary format basic unit and are converted to the current user units (mils, mm, or 
inches) for screen display. If you need to reimport the information to .pcb format, export in basic 
units. 

Conversions are: 

1. 1 mil=38100 basic units 

2. 1 millimeter = 1500000 basic units

BGA
An acronym for ball grid array.
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BGA fanout
A single-segment fanout that connects BGA array pads to BGA vias. This single-segment fanout 
always ends in a via.

BGA/PGA decals
A full matrix decal for BGAs and PGAs, including staggered array patterns.

biased pin pair
A layer biased pin pair is any pin pair with a design rule specifying a layer bias to one or more, 
but not all, electrical routing layers.

blind via
A via that connects an outer layer to one or more inner layers, without passing through all other 
layers of a printed circuit board.

bmp
An image file that can be pasted into documents or other programs such as Microsoft Word. 
PADS products use the Copy Bitmap command to capture these as screen images. 

board markings
Designers usually include identification information on a board. These may include the board 
part number, the assembly part number, the company name, the product name, the revision level, 
the serial number, the copyright notice, an anti-static symbol, warning messages, UL labels, test 
labels and many other types of information. This information may be in ink on the silkscreen 
layers, in copper on the top and/or bottom layer or some combination of the two. These are 
typically referred to as board markings.

Tips: 

• Add text to an electrical layer and it will be created in copper. Add text to a Fabrication, 
Assembly, and Documentation Layer and it will be created during the silkscreen 
process.

• Use the Text command to add board markings to your design.

See also: Adding Free Text

board outline
The actual shape of the printed circuit board, defined by line segments and arcs. The board 
outline is entered on layer 0 and displayed on all layers.

bonding pads
Metallization areas placed around the perimeter of the integrated circuit die, to which aluminum 
or gold wires connect the die to the component package. 

bounding rectangle
The smallest rectangle that encloses all nontext graphics on all layers. 

breakpoint marker
A small brown dot in the Output window gutter that indicates a breakpoint in a script or macro.
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bumped chip
A die or chip that has been specifically processed with buffer metals over the I/O pads, followed 
by an addition of solder or gold bumps to provide bonding areas for direct chip attachment onto a 
substrate. 

buried via
A via that only connects two inner layers.

bus
A series of connections that share a common use, such as memory array or data array, and are 
usually routed parallel to each other. 

bus routing
Routing two or more pin pairs simultaneously and in close proximity to each other in neat, 
flowing patterns.

— C —

C routing pattern
A collection of routes that form a pattern resembling the letter C.  

CAD
An acronym for Computer-Aided Design or Computer-Aided Drafting.

CAE
An acronym for Computer-Aided Engineering.

CAE Decal
The graphical representation of schematic symbols in PADS products.

CAM
An acronym for Computer-Aided Manufacturing.

CAM document
A combination of plot type and output device you create and save with the design. For example, 
you can include "Silkscreen Top, Photoplot" and "Silkscreen Top, Laser Printer" on your CAM 
Documents List and run them selectively when needed. 
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CAMDir
The powerpcb.ini file entry that enables you to specify the CAM master folder for creating CAM 
output.

capacitance
The ratio of charge within a trace that is a factor of the trace length and signal delay.

CBGA
An acronym for ceramic ball grid array.

CBP
An acronym for chip bond pad.

center pass
An autorouting pass that places traces equidistant from component pins or vias and each other to 
evenly distribute any available space in the channel.

CGA
An acronym for column grid array.

chamfered
A rectangle with the square corners cut off in order to create beveled edges on the corners.

chamfered path
A solid filled copper that, like a trace, acts as a conductor connecting pins and vias similar to a 
trace. But unlike a trace, which is created with a round aperture producing rounded outside 
corners, chamfered path copper allows for sharp specific outlines with a filled interior. When 
creating a chamfered path, you set options to create shapes with square or chamfered corners. 
The copper created by chamfered path has a Solid Copper property which overrides the Copper 
Hatch Grid and Drafting Line Width settings to make it a solid fill. Clearance rules for the 
chamfered path copper are also changed to match the clearance rules of a trace.

checking
Verifying the design meets previously defined rules, such as clearance and connectivity. 

chip
An integrated circuit without packaging. A chip is also called a die. 

chip bond pad
Interconnect areas on the die on which wire bonds are connected to the substrate.

chip carrier
A square or rectangular IC package, with I/O connections on four sides.

chip on board
The packaging configuration in which a chip is bonded directly to a circuit board or substrate.
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Chip Scale Package
A packaging configuration in which the dimension of the substrate is 1.2 times larger than the 
die. 

chord
Half of an accordion.

See also: accordion,amplitude, gap (accordion) 

clam shell fixing
A test fixture that tests both the top and bottom side of the PCB.

class
A collection of nets with a common set of design rules.

clearance
The measured space between routed objects such as trace-to-trace, trace-to-pad, or pad-to-pad.

closed cluster
Clusters that you cannot delete or replace during automatic cluster creation. 

cluster
In Cluster Placement, a group of parts that must be placed close to each other. 

CMOS
An acronym for Complementary Metal Oxide Semiconductor.

COB
An acronym for Chip On Board.

coefficient of thermal expansion
A quantity used to determine the length change of a material due to temperature change. Thermal 
expansion differences between the die and substrate must be considered for quality assurance.

collapse
To relocate the members of a cluster from their current placement to the center of the cluster.

column grid array
Similar to a ball grid array, but columns are used to improve the stresses of different thermal 
expansion between the board and the component.
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Com port
Abbreviation for communications port. This port provides a connection between your computer 
and peripheral devices, such as plotters, modems, and other computers.

combine
Joining lines, or lines and text, together as one selectable object.

component side
The top or front side of a printed circuit board where devices are normally mounted.

composite fanout
A fanout from a pin that is common to two subnets. Often created by autorouting operations.

Composite fanouts provide access to component pins that may otherwise be inaccessible.

See also: fanout, subnets

composite rule trace
A trace that is attached to a pin (typically an SMD) shared by two subnets. This type of trace is 
typically created by autorouting operations.

See also: composite fanout, subnets

conditional rules
Rules placed on a signal that apply only if the signal is routed near another specified signal. 
Conditional rules are also known as against rules. 

conductor
A material that causes heat or electrical current flow. For printed circuit design, a conductor is a 
piece of metal that connects pins of components together.

connected islands
A maximum set of subnet items already connected by a trace, copper unroute, or jumper.

See also: subnets, subnet 

connections
Points of connectivity, such as a pin pair or a net.

connector
A unique component used to connect a portion of a printed circuit board with other devices.

container application
An application that can incorporate embedded or linked items into its own documents. The 
documents managed by a container application must be able to store and display both OLE 
components, and data created by the application itself. A container application must also allow 
users to insert new items or edit existing items. 

When you insert objects into a PADS product, the PADS product is the container application. 
When you insert a PADS file into another application, the other application is the container 
application. 
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controlled gap area
The part of the differential pair where the traces are drawn routed in parallel and separated by the 
pair routing gap. The controlled gap zone area starts at the gathering point and ends at the split 
point.

See also: gathering point, pair routing gap, split point 

controlled gap length
For a differential pair, the ratio of the controlled gap area routing length to the overall routing 
length, in percentage.

See also: differential pairs

controlled length net
A net that has length rules, or contains pin pairs that have length rules. 

The following high-speed rules are net length rules: 

• Minimum/maximum length

• Matched length

• Differential pairs 

converting database
The process that converts a non-native file, such as an .asc file or a .dxf file, to a PADS native 
format, or .pcb, file. 

copper connectivity
Means unroutes are always connected to a copper at some point in the copper outline. A copper 
outline can include arcs. The following graphic illustrates how copper connects to a net.

See also: coppers, overlapping coppers 

copper pour
The process which draws a copper area with insulation areas around traces and pins that pass 
through the copper, but are not attached or connected to the copper. 
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coppers
Polygons on an electrical layer representing an area of the PCB to fill with metal. 

When a copper is assigned to a net, it is joined to the net with a trace or via. Coppers are 
obstacles to net objects unless the copper and the net belong to the same net.

See also: overlapping coppers, copper connectivity

copy route
The duplication of a trace or series of traces, using copy and paste.

corner
Point where a trace or line changes direction. The Selection Filter enables or disables picking 
geometric or route corners. 

cost
Reduces usage of a layer. The higher the cost, the less a layer is used for routing. 

cross-probing
Uses a link between PADS programs to reflect, in one PADS application, selections made in 
another PADS application.

cross-reference file
A file that maps design objects between two environments, such as PADS Layout and 
DxDesigner. 

CSP
An acronym for chip scale package.

CTE
An acronym for coefficient of thermal expansion. It is also referred to as TCE. 

cutouts
A closed polygon in a copper, copper pour, or board outline. In a copper or copper pour, a cutout 
results in a void area.

See also: overlapping cutouts

cycle picking
To sequentially select objects in the vicinity of the selection point using the Tab key.

— D —

dangling route
Dangling routes are stubs or spurs off of traces that are not tied to any pin by a ratsnest. See also 
partial route.

database units
The use of mils, metric, or inches within a design.
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datum dimensioning
A style of dimensioning in which all dimensions are measured from a common starting point. 
The origin extension line is marked as zero, with each dimension reflecting the measurement 
from that point.

See also: Creating Baseline Dimensions

D-codes
Specific numbers assigned to photoplot machine apertures for program identification. D-CODES 
are included in the aperture table.

decal
The physical representation, or footprint, of a part.

decal copper
Open, closed, or associated copper produced within the physical representation of a component.

decal text
Documentation text produced within the physical representation of a component.

default component
The original component, before being replaced in the current assembly variant. The default 
component is always in the raw database, but not necessarily in the Base Option.

See also: active component 

default layer mode
A layer mode in which a design can consist of up to 30 electrical layers, or a combination of 
electrical and nonelectrical layers. You change from default layer mode to increased layer mode 
by clicking the Max Layers button in the Layers Setup dialog box.

default.asc
The ASCII file accessed for new file creation. This file provides startup design information such 
as grid sizes, default colors, or other information.

default.cam
A file usually found in the C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs 
folder that contains default apertures, speed and feed settings, and drill symbols for CAM output. 
This file must exist in the same folder as specified by the UserDir variable in the powerpcb.ini 
file.

See also: increased layer mode

defaults
Conditions or options that are set when the PADS product starts.

delay
The time it takes for a signal to travel through a trace.
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delete
To remove information from a design.

design area
The actual work area where a design is created.

design on the fly
To use ECO Operations to create a new design without first providing a netlist or parts list from 
schematic software. This can also be called design.

Design page
The Options page that controls design conditions, general routing conditions, and certain display 
and part movement method settings.

design rules
Established spacing and general routing constraints for electrical properties, or conductors, 
which are verified by clicking Verify Design from the Tools menu.

devicesn.dat
A file usually found in the C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs 
folder that contains CAM printer and plotter driver data. This file must exist in the same folder 
specified by the UserDir powerpcb.ini variable.

DFM
An acronym for Design for Manufacturing.

DFT Audit
DFT Audit analyzes every net for accessibility (adaptability) and creates a board report that 
identifies all inaccessible (non-adaptable) nets.

dice
The plural of die.

die
A single square or rectangular piece of semiconductor material into which a specific electrical 
circuit has been fabricated. 

die bonding
To attach the semiconductor die to the package substrate with epoxy adhesives, gold eutectic, or 
solder alloy. It is also referred to as Die Attachment.

die flag
Metal shapes placed under a die for thermal management and/or electrical connection; also 
referred to as a flower pattern.

die side of CBP
The side of the die on which the CBP lies. Usually the die side of the CBP is the same as its 
fanout side, but in some cases more complex patterns of wire bond fanout may mean that the two 
sides are not the same.
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Die Wizard
This feature creates die part definitions parametrically or imports the die description using 
GDSII or formatted ASCII files. The Die Wizard replaces Component IQ by providing die 
capture directly in the Advanced Packaging Toolkit layout editor. This eliminates the need to 
transfer .ciq files.

dielectric
A non-conductor of current; an insulator.

dielectric constant
A value given for manufacturing materials, such as FR-4, to describe electrical characteristics.

differential pairs
A group of two nets or two pin pairs routed side-by-side and separated by the pair routing gap for 
as much of the overall length as practical. A differential pair typically transmits two electrical 
signals that are driven 180 degrees out of phase from each other.

See also: pair routing gap 

DIP
An acronym for Dual In-line Package.

DisableCaching
A powerpcb.ini file entry that, when set at 1, shuts off graphics optimization and, when set at 0, 
enables graphics optimization.

discrete device
A device that contains one circuit element. For example, a resistor or toggle switch.

disperse
A command that is active on several levels of Cluster Placement. When selected, it clears the 
board of all parts or clusters that are not glued down, and arranges them around the outside of the 
board outline according to decal type.

dispersion routes
Partial routes, ending in vias, which tie surface mount components to plane layers.

do file
The SPECCTRA router ASCII setup file that contains user-defined router commands to initiate 
batch routing.

dock
To take an isolated application dataset and pull the changes within the dataset into the main 
design project. Any conflicts with the merged data must be manually resolved.

documentation layers
Layers higher than the electrical layers in a PADS Layout database that contain text and lines to 
illustrate assembly, annotation, and provide instructions for manufacturing.
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double-click
Two mouse clicks, in immediate succession, that usually initiate an edit action or complete the 
current action.

double-sided board
A printed circuit board made up of two routing layers, and which has no internal layers.

double-sided die
A die that has substrate bond pads on one side, and a BGA grid array on the other side. The two 
sides are connected through vias.

See also: single-sided die

drafting operations
Any operation that involves adding nonelectrical information, not associated with placement or 
routing, to a design.

Drafting tab
A Options tab that controls text settings, default line width, reference designator settings, and 
hatch setup.

drawn pads
Photoplot pads, usually finger pads, that are produced by opening the aperture and moving the 
board, with the aperture remaining open, to produce a pad shape.

DRC
An acronym for Design Rules Check.

drill chart
A diagram, produced on a drill drawing, that shows drill symbols matched with drill hole sizes. 
This is also referred to as a drill legend.

drill oversize
A factor applied to plated through holes for DRC purposes to account for drill oversizing during 
the PCB fabrication process.

drill pairs
Primarily for buried and blind vias, drill pairs define which layers are to be drilled and plated 
together during the fabrication process.

drill symbols
Unique symbols on a drill drawing plot that represent the various drill hole locations and sizes.

drill.dat
A user-definable ASCII file that determines settings for NC Drill output format options. This file 
must exist in the same folder specified by the UserDir variable in the powerpcb.ini.
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DXF
An acronym for Data eXchange Format, a standard ASCII format for sharing graphics database 
files between different environments.

dxfset.dat
A file that contains the information for drill size and library name equivalents in basic units for 
the DXF Setup dialog box.

dynamic route
To create a route using the Dynamic Route tool, which automatically creates turns and pushes 
other routes aside in order to complete the connection.

— E —

ecad hint.map
A user-defined text file that you create, edit, and maintain. This file enables the replacement of 
approximated parts from PADS Layout, with geometrically accurate components previously 
modeled in Pro/ENGINEER. This file must exist in either the current working folder or in the 
Pro/ENGINEER software loadpoint\text folder.

ECO
An acronym for Engineering Change Order. This refers to a file with netlist changes that needs to 
be annotated to update either the schematic or layout that has become out of sync with the new 
design changes.

ECO mode
A mode that PADS Layout enters when the ECO toolbar is open. Changes that affect the 
connection list or parts list can be recorded in a file for backward annotation.

See also: ECO

ECO Options
The setup choices available for the ECO output file in the ECO Options dialog box.

ECO registration of attributes
Only ECO-registered attributes, set on the Objects tab of the Attribute Properties dialog box, can 
be added, deleted, or changed during the ECO process. Via attributes are not registered attributes 
and cannot be added, deleted, or changed during the ECO process.

You can modify ECO-registered attributes only in ECO mode.

Non-ECO-registered attributes are never recorded in an .eco file during ECO operations.

To compare ECO-registered attributes, use the Compare Only ECO Registered Attributes option 
on the Comparison tab in the Compare/ECO Tools dialog box.

EDA
An acronym for Electronic Design Automation.

EDC
An acronym for Electrodynamic Checking.
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edge
One side of a polygon.

edge die
The two or three rows of dice along the outer circumference of a wafer.

edges
The Selection Filter preference that enables or disables selection of geometric segments.

editing
Any action that modifies a design.

electrical layers
Layers enabled for routing that are checked by DRC.

embedded objects
An object, including all of its data and the information needed to manage the object, that is 
contained within the framework of, and is a part of, the container application document.

See also: linked objects

EnableMacroLanguage
The powerpcb.ini file entry that, when equal to one, enables loading of all macro parameters on 
startup and, when equal to zero, disables loading of macro parameters upon startup.

end component
A component having at least one pin which is a final pin of an associated net.

end no via
The mode initiated in the routing shortcut menus that, while routing, ends a partial route without 
a via.

end via
The mode initiated in the routing shortcut menus that, while routing, ends a partial route with a 
via.

end zone
The part of the differential pair between the split point and destination pins.

Tip: The labels in the above graphic correspond to routing that starts at the left-hand set of pins 
and ends at the right-hand set of pins. The label positions are reversed if the routing starts at the 
right-hand set of pins.

See also: differential pairs, split point 
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ending layer
The finishing layer for a drill pair or via definition. Enter information about ending layer in the 
Pad Stacks Properties dialog box.

engineering change order (ECO) operations
Any processes that modify the connection list or parts list.

entry angle
The angle at which a route enters a pad.

Esc
To use the Escape or Cancel keys to stop a current action.

estimated total length
The trace length monitor calculates estimated length as the combined total of routed length (Rt), 
plus the routed length for the entire net—including overlapping segments— (Nt), plus the 
unrouted length (U1) of the trace being routed. 

Tip: Overlapping segments are counted only once.

See also: routed length, unrouted length

eutectic solder
A tin/lead alloy (63% tin, 37% lead) that melts at optimum temperatures.

export
The translation command used to convert a design file into PADS-format ASCII or DXF.

extended rules
Clearance, routing, and high-speed rules consisting of classes (one or more nets), groups (one or 
more pin pairs), individual pin pairs, decals, components and differential pairs. Without the 
Extended Rules option, you can assign rules on the net level only.

extension lines
Lines extending from the points being measured.



Glossary

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2379

extents
The limits of the x and y coordinate area that is occupied by all items within a design. This 
includes information external to the board outline, such as dimensions or fabrication notes.

— F —

Fabless
A semiconductor company that subcontracts wafer manufacturing because it does not have its 
own wafer manufacturing facility.

fabrication
With semiconductor manufacturing, the front-end process of making devices in semiconductor 
wafers only, not the package assembly or back-end stages.

fanout
A segment of trace or copper shape added to SMD pads to facilitate routing. A fanout typically 
consists of one or more trace segments connecting a component pad to a via, allowing the signal 
on an outer layer to connect to one or more internal signal layers or planes. A specialized 
repeated pattern is often necessary to break out multiple pads on the same component far enough 
from the component to allow easy routing.

Use fanouts to:

• allow on-grid access by autorouters that cannot handle off-grid pads.

• make routing easier, and ensure connections are made.

• connect SMD pins to an inner plane layer using vias.

• connect an SMD pad to an inner signal layer where more routing space is available.

fanout pass
An autorouting pass that places vias for inaccessible SMD component pins and routes, from the 
vias to the pins.

fanout side of CBP
The side of the SBP Guide to which the CBP should be wire bonded. Usually the fanout side of 
the CBP is the same as its die side, but in some cases more complex patterns of wire bond fanout 
may mean that the two sides are not the same.

FCBGA
An acronym for flip chip ball grid array.

feature size
The smallest line width or spacing between lines or features on a semiconductor die.

feed-through hole
A drilled and plated hole that passes conductivity from one layer to another. This is also called a 
via.
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fiducials
Fiducials are alignment marks, a type of target, used for calibration before placing objects.

There are at least three types of fiducials:

• Panel fiducials—used to align an entire panel of boards. 

• Board fiducials—used to align components on a specific board (on or off a panel). 
Fiducials are (typically) round solid targets placed near three corners of each board on 
each side of the board that will receive components. The pick and place system scans the 
board for these targets (shiny circles approximately .040" in diameter) and uses them to 
align the machine before it starts placing parts. 

• Component fiducials—used for close tolerance placement of high pin-count 
components with fine pitch leads. The footprint (PCB decal) of a fine pitch component 
will typically contain two component fiducials at opposite corners of the footprint. This 
allows the pick and place machine to align the fine pitch component exactly on the 
footprint.

field upgrade
Programming options on your security key by entering in a key unlock code using plicense.exe 
or equivalent.

file sharing
Multiple users accessing the same file or files through a network.

file.dir
The powerpcb.ini file entry that specifies the default location of your design files.

filter
A settings dialog box within that controls which types of objects can be selected.

find
The PADS command that locates, and optionally selects, an object or group of objects in the 
database.

finger pad
One of many long pads placed in a series to represent an edge connector.

flashed pads
Pads produced on a photoplotter by opening the aperture momentarily, without moving the 
board, to produce a pad shape.

flat pack
A component package where the leads extend away from the component and remain on a parallel 
plane with the base of the component.

flip
The command that moves the selected items to the opposite side of the board.
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flip chip
An IC designed for face-down mounting by means of controlled-collapse solder pillars on a 
device's I/O bonding pads.

floating license
A method of licensing where a central security server manages a pool of licenses for use by a 
large number of clients.

floating toolbars
Toolbars you can undock from the sides of the application window and place anywhere on 
screen.

flood
To fill a previously defined copper pour area. 

flower pattern
Metal shapes placed under a die for thermal management and/or electrical connection; also 
referred to as a die flag.

A ceramic, surface-mounted hermetic package.

FlushUndoBeyondSize
The powerpcb.ini file entry that determines the maximum size of the undo buffer before PADS 
Layout removes previous commands from the undo buffer to make room for the current 
command. If adding the current command causes the undo buffer to exceed this maximum size, 
PADS Layout removes previous commands until the undo buffer can store the current command.

follow route
The connections or pin pairs that are part of the bus routing, and which are routed following the 
guide route's path.

footprint
The arrangement of pads for a given part decal. For example, the footprint of a fourteen DIP is 
two rows of seven pads, spaced 100 mils in the Y direction, and 300 mils in the X direction.

forward-annotate
Update a design file using data from a schematic.

FR-4
An acronym for Fire Retardant Number Four, an epoxy-resin substrate material used in laminate 
applications.

free copper
Open or closed copper that is not associated to other copper or pads.

free disk space
The physical amount of space available on your hard drive that is available for use by programs.
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— G —

gap (accordion)
The gap of an accordion sets the pitch between chords. The gap is a user-definable number 
multiplied by the same net trace-to-corner clearance.

Tip: If the same-net trace-to-corner distance equals zero, then Trace Width is used for the gap 
calculation.

See also: accordion, amplitude, pair routing gap 

gate
An element of an electronic circuit whereby one or more signals are input, with one output being 
dependent on the state of the input(s) and the type of logic used to interpret the input.

Pin swapping involves exchanging like inputs

Gate swapping involves exchanging the entire element for a like element.

gate array
An IC consisting of a regular arrangement of gates that are interconnected to provide custom 
functions.

gathering point
The point near the source pins where differential pair traces can start to be routed together at the 
pair routing gap.

Tip: The labels in the above graphic correspond to routing that starts at the left-hand set of pins 
and ends at the right-hand set of pins. The label positions are reversed if the routing starts at the 
right-hand set of pins.

See also: differential pairs 

GDI memory
Memory reserved for Windows devices and graphics.
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Gerber
The language used to drive a photoplot machine. This language is an ASCII file with instructions 
for selecting an aperture, moving the light source, and turning the light source on and off.

Global tab
A Options tab that includes settings that affect an entire design, such as units of measurement 
and pointer size.

Glue
Anchors component(s) in their current location so they cannot be moved

grab bars
The two vertical or horizontal bars to the left or top of the window.

graphics cache
The PADS setting used to optimize graphics. This is handled by the DisableCaching entry in the 
powerpcb.ini and powerlogic.ini files.

green dot
The status indicator located in the upper left corner of the workspace. It is green when the system 
is idle or ready for operation. It is red when the workspace cannot receive user input, such as 
when producing CAM drawings.

grid
A division of the workspace into measurement steps to facilitate accurate spacing between 
placed parts and routed lines. Also refers to the display; small white dots locating the 
measurement steps

ground plane
A design layer completely filled with copper, except for clearances around nonconnected pads 
and vias.

group
A collection of pin pairs that share common design rules.

grow
An cluster placement feature that adds additional parts to an existing cluster.

guard band
A shape that attaches to the end of a trace during routing operations to denote an online design 
rule error.

gui
An acronym for Graphical User Interface. The GUI includes such things as menus and 
commands that allow for interaction between the user and the software program.

guide route
A route segment that is used for the first connection and that is the lead for laying down two or 
more pin pairs simultaneously in neat flowing patterns.
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hard rule
A rule that is always followed. See also: soft rule, and Hard and Soft Rules in the PADS Router 
Concepts Guide.

hard breakout
Use of associated copper within a surface mount decal to simulate a dispersion route. The 
disadvantage to this method is that routing channels will possibly be blocked.

hatch
A copper fill pattern that uses horizontal and vertical lines at a specified width and spacing.

hatch outline
The outline of a copper pour shape after it has been flooded to differentiate it from the pour 
outline as originally drawn. When you draw the pour outline and then flood the shape, the outline 
often changes to accommodate the design rules. You can toggle between the pour outline and the 
hatch outline using the shortcut modeless command PO, or switch between these two Display 
modes in the Drafting Options.

HDI
An acronym for High Density Interconnect.

heat sink
An assembly that serves to dissipate, carry away, or radiate heat into the surrounding 
atmosphere.

high density interconnect
A class of packaging involving boards, substrates, and components using extremely small trace 
and spacing dimensions.

highlight
A user-defined color, usually white, used to denote that an object is selected.

high-speed checking
Using the Electrodynamic Checking utility. A simulator-type check that finds traces that may run 
parallel to each other close enough, and for a long enough distance, to cause cross talk.

hole plating
A fabrication process where solder flows through a drilled hole to connect the pads on either side 
of the hole, to provide connectivity between two or more layers.

HPGL
An acronym for Hewlett Packard Graphics Language, a standard pen plotter interface language.

— I —

IC (Integrated Circuit)
An acronym for Integrated Circuit.
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IDF
Intermediate Data Format. An industry standard format used for exchanging data between 
electrical and mechanical design systems.

IMAPS
An acronym for International Microelectronics and Packaging Society.

impedance
Resistance to the flow of current in a trace. Measured in ohms.

in circuit testing
An exhaustive and thorough test of a PCB in final production that tests nets and unused pins for 
such things as correct voltage, correct parts, or bridging. Test point placement is critical for in 
circuit testing.

inaccessible nets
Nets for which you cannot define test points. DFT Audit analyzes all nets. If DFT Audit 
determines that test probes cannot access them, the nets are inaccessible (also called non-
adaptable). 

increased layer mode
A layer mode in which a design can consist of more than the default of 30 layers up to a 
maximum of 250 layers. The maximum number of electrical layers is 64, and the maximum 
number of non-electrical layers is 186.

See also: delay

INI file
An ASCII file, with the .ini file name extension, that contains startup parameters.

An INI file for Windows might contain the following information: graphics drivers, mouse 
drivers, fonts, and so on.

An INI file for programs might contain the following information: folder structure, display 
colors, default editors, and so on.

inner layers
Design layers other than those on the top or bottom of a printer circuit board. Inner layers may be 
routing layers, plane layers, or a combination of both.

installed options
PADS product features that you have bought and installed as part of the software package.

instruction pointer
A small yellow arrow in the Output window gutter that indicates the current line in a script or 
macro.

insulator
A material used to inhibit heat or electrical properties, such as current flow.
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integrity check
A database check runs whenever a .job, .dxf, or .asc file loads. You can also initiate an integrity 
check while you are working by typing the "I" modeless command, then pressing Enter.

intensity
A value assigned to objects such as vias to weigh decisions made during the autorouting process 
in PADS Router. The higher the intensity, the less the item is used. For example, set a high 
intensity for via usage to minimize the amount of vias added to the design.

interconnect
A conductive connection between two or more circuit elements.

IPC
An acronym for Interprocess Communications within the PADS product.

irregular trace length
Sections or segments of differential pair traces not routed at the pair routing gap.

See also: differential pairs

islands
Small, isolated sections of copper pour that are not attached to anything.

— J —

JEDEC
An acronym for Joint Electron Device Engineering Council.

Joint Electron Device Engineering Council
JEDEC is the semiconductor engineering standardization body of the Electronic Industries 
Alliance, a trade association that represents all areas of the electronics industry.

jumper
A physical part used to cross over traces on most one layer PCB designs. Jumpers can be 0 Ohm 
resistors or wires stretched between jumper pads.

— K —

keepout areas
Areas that automatically ban objects. Depending on the keepout Properties, these areas may be 
set to prevent: placement of components, components that exceed a specified height, component 
drill holes, traces and copper, copper pours and plane areas, vias and jumpers, and test points.

keyview.exe
An executable file used to list the options programmed into your key. When you run 
keyview.exe, it creates a file named keyview.txt that contains a listing of your key options.
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label
A label is a display instance of a component or jumper attribute. If you want to make an attribute 
visible in the design, you must instantiate it as a label associated with a component or jumper. 
You can do this in the Design Editor or the Decal Editor. You can have multiple labels based on 
the same attribute. An attribute has two parts—a name, and a value. A label of an attribute can 
have one of four visibility settings—None, Value, Name and Value, and Full Name and Value.

Latium rules
Latium rules are for advanced functionality in PADS Router. Some constraints that you can set 
in Layout are only used by PADS Router. For examples, see the Tune/Diff Pairs options, Fanout 
Rules, Pad Entry Rules.
The Latium checks include:

• component clearance rules

• component routing rules

• differential pair rules

• via at SMD rules

layer biased net
A layer biased net is any net with a design rule specifying a layer bias to one or more, but not all, 
electrical routing layers

layer pair
The assignment of two routing layers to switch between using the Layer Toggle command. On 
two layer boards, the toggle is automatically set between 1 (top) and 2 (bottom).

layer toggle
To switch between layer pairs while routing.

layers
A standard CAD database feature that separates graphical information into sheets of similar 
information such as dimensions, construction lines, or text. For PCB applications, this allows the 
various fabrication layers to be created and output separately.

layout-driven design
A PCB design process in which no schematic is created, and both the logical (netlist) and 
physical conformations of the board are defined in a layout tool. Also, a design created using this 
process. See also: schematic-driven design.

Layout.rep
The error report file that is created by the database integrity test and which is written to the 
\PADS Projects folder.

LCC
An acronym for Leadless Chip Carrier.
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lead frame
A sheet metal framework that is etched to form an array of metal traces.

lead pitch
The sum of the lead width and lead spacing.

lead spacing
The distance between a component's adjacent leads.

Leadless Chip Carrier
(LCC) Ceramic IC package with no physical lead. There are only pads on the bottom of the 
package around the edges.

length matching
A same-length requirement where the entered value represents a minimum/maximum length 
tolerance for nets belonging to the same class.

length minimization
A routing feature that configures unroutes to the shortest available distances, or in a specific 
topology, to facilitate high speed routing.

LGA
An acronym for land grid array.

LibDir
The powerpcb.ini file entry that specifies the location of your library files.

libraries
The collection of part types, part decals, and drawn items included with a PADS product or 
created by the user.

Library Manager
The PADS feature that provides access to, and allows for modifying, the library of parts.

linked objects
When an object is linked, a presentation of the object and link to the source is contained within 
the framework of, and is a part of, the container application document. The object is linked to its 
source, and the source continues to physically reside wherever it was initially created. Therefore, 
the file that contains the object is smaller than if the object were and embedded object. See also: 
embedded objects.

Whenever you open the file that contains the linked object, the object checks the source to see if 
it changed since you last saved the file. If the source changed, then the linked object 
automatically updates.

LogCompressionMode
A powerpcb.ini file entry that controls recorded mouse movements in a log file. When set to one, 
the default, recording of compressed mouse movement is enabled. When set to zero, recording of 
all mouse movement is enabled.
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logic family
The assignment of an electrical type by name, such as CAP (capacitor) or RES (resistor), to 
indicate the appropriate reference designator prefix such as C or R. 

LOGMode
A powerpcb.ini file entry for online macro recording to a log file. When set to 0, the default, 
recording is disabled. When set to one, macro recording is enabled, and the next.log file is 
created.

loop
A pin pair that contains a route that branches off the original route, then branches back into the 
same route to form a loop.

loop routing
Used to create a loop in an existing route.

LPT port
A parallel printer port, usually referred to as LPT1 or LPT2.

— M —

macro
Internal objects that are handled using the macro engine vocabularies, and may or may not have 
the automation interface.

Manhattan distance (delta x + delta y)
Used to approximate unrouted net length for BoardSim. Add a percentage multiplier to account 
for indirect routing paths.

masking
The inhibiting of electrical interference between two traces on different layers due to separation 
by a ground or power plane.

material condition
There are three material conditions when creating component decals. They are Maximum 
(providing the most robust solder joint), Nominal (providing a general purpose solder joint) and 
Minimum (providing the least possible solder joint for very dense designs). 

MCM
An acronym for multichip module.



Glossary

2390 PADS Layout User’s Guide and Reference Manual, PADS 9.4

memory pattern
A collection of routes between memory devices that form a distinctly repeatable pattern. 

menufile.dat
The file containing the structure and text of all lists and shortcut menus. The menufile.dat file 
must be located in the same folder as powerpcb.exe.

micrometer
One-millionth (10-6) of a meter; about 40 millionths of an inch. Micrometer is synonymous with 
micron.

micron
A term used for micrometer. One-millionth (10^-6) of a meter; 25.4 microns = 1 mil.

minimum geometry
The smallest line width or spacing between lines or features on a semiconductor die.

miter
A diagonal segment or arc that replaces a corner.

miters pass
An autorouting pass that converts all 90 degree route corners to diagonal corners.

mixed plane layer
A plane layer that contains obstacles other than pads, such as routes, copper, or text.

modeless command
A command invoked through the keyboard. Commands include display options, design settings, 
and mouse click substitutions.

See also: chamfered

modify
To change information for a selected object.

moiré
Target-shaped objects located in the corners of finished artwork that are used to properly align 
each layer to others for design verification and fabrication.
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monolithic device
A device whose circuitry is completely contained on a single die or chip.

mounted side
The side of the printed circuit board, either front or back, on which components are mounted.

mounting holes
Many (but not all) boards have mounting holes. Mounting holes are typically located around the 
perimeter of a board (most often in the corners). They are drilled holes, used to mount a printed 
circuit board to the finished product (for example, a mother board mounted to the computer 
casing), or used to attach bolt-on components to the printed circuit board (for example, stiffeners 
and ejector tabs).

There are two types of mounting holes: plated and non-plated. Plated mounting holes have 
copper inside the hole and usually have a large annular ring of copper on both sides of the board 
connected by this copper cylinder (plating) inside the hole. These holes are typically connected 
to the GROUND bus or plane on the board and provide a method for grounding the board 
circuitry to the enclosure (for shielding purposes). The mounting hole ring diameter is usually 
slightly larger than the diameter of the head of the screw that will be used to fasten the board to 
the mounting device within the enclosure. Non-plated mounting holes are used for the same 
purpose, the only difference being that they are not internally plated and do not have a copper 
ring, therefore they are not used for grounding the board to the enclosure.

Tips:

• Plated mounting holes cannot be used as tooling holes as the thickness of the copper 
plating can vary and violate the close tolerance required by a tooling hole. Non-plated 
mounting holes can sometimes work double duty as tooling holes because there is no 
internal plating, therefore the tolerance of the hole size can be more closely controlled 
and fit within the requirements of a tooling hole.

• Use the Decal Editor and the Pad Stacks dialog box to create tooling holes. Save the 
single-terminal object as a part to the library for reuse.

See also: Creating Terminals, Editing Pad Stacks

multichip module
A package with multiple dice that is 20% or more silicon, has 100 or more I/O on a substrate, and 
four or more layers.

multilayer PC board
A design that contains routing and/or plane layers, in addition to those on the front and back side.

— N —

nail diameter
The diameter of the test probe. 
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NC drill
An abbreviation for numerical control drill. This technology involves producing an output file 
containing the x-y location and drill size for each hole, then feeding this information into a 
machine for automated hole drilling.

negative
A photographically produced reverse image of a plane layer. This allows cleared areas, or 
airgaps, to be created using normal drawing techniques. When reversed, all areas not drawn for 
clearance become the actual planes.

nested embedding
Nested embedding occurs when you insert an object using OLE into another object. For example, 
inserting a PADS Logic schematic into your PADS Layout Design or inserting a Microsoft Word 
document into a schematic.

nested macros
Macros called from other macros.

net
All pin pairs composing one individual signal. Nets contain at least one subnet, but may contain 
more than one.

See also: subnets

net class
A collection of nets with a common set of design rules.

net length rules
Rules that control a net's or pin pair's routing length. 

The following high-speed rules are examples of net length rules: minimum/maximum length, 
matched length, and differential pairs. 

The phrase controlled length net refers to nets that have length rules, or nets with pin pairs that 
have length rules. 

net name
A specific name given to a net to describe its function; for example, GND, PWR, or DATA0.

Tip: The maximum net name length is 47 characters. You can use any alphanumeric characters 
except { } * and space.

netlist
A point-to-point connection list for each signal in a design, providing the reference designator 
(part name) and pin number.

netlist file
A PADS ASCII file containing all of the nets in a design, including all component pins that make 
up the nets. The file may also contain a list of all parts in a design, and/or the settings that control 
the substrate bond pad numbers and functions for newly created substrate bond pads.
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netlist.fmt
The ASCII setup file for the report format that produces a netlist without pin information.

network security
Use of one security key, programmed with multiple options, for network use with one or more 
systems at a time.

next.ini
A file produced in the C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs folder 
when the powerpcb.ini entry LOGMode is equal to one. The next.ini file is a copy of your 
powerpcb.ini file at the time next.log is written.

next.log
A file produced in the C:\MentorGraphics\<latest_release>PADS\SDD_HOME\Programs folder 
when the powerpcb.ini entry LOGMode is equal to one. The next.log file records all activities 
within a PADS Layout session so that they can be replayed to reproduce a series of steps or used 
to illustrate a problem.

NLM
A type of file used by a Novell network. For example, the ssisrvr.nlm file is the PADS Layout 
network security NLM.

node
A point along a trace where traces join other traces (T junction), where traces transition to other 
layers, or where traces end at pins, vias, or floating end points. Specifically, a node can be any 
pin, via, copper, trace junction, virtual point, or trace end. 

See also: virtual point

node-locked
A license for a specific Host ID.

non ECO registered parts
These parts are found in the schematic and layout design. Parts not selected as an ECO 
Registered Part on the General tab of the Part Information dialog box are non ECO registered 
parts.

• A schematic non ECO registered part is required in the schematic but has no place in the 
layout of the circuit board. For example, a chip socket shown in the schematic for 
inventory tracking in the bill of materials.
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• A layout non ECO registered part is required in the layout design but has no place in the 
schematic. For example, a plated and grounded mounting hole.

non electrical parts
Parts with no pins. For example, a mounting screw shown in the schematic for inventory tracking 
in the bill of materials.

non plated holes
Pads that are not reflowed with solder, usually reserved for mounting holes. Nonplated holes are 
not drilled with an oversize to accommodate the solder flow. 

To determine plating status, in PADS Layout, use the Pad Stacks Properties dialog box. In PADS 
Router, use the Pad Stack tab in the Pin Properties dialog box.

nrus.exe
A program used with Novell network security used to track the total number of network security 
options, the available network security options, and the network security options in use.

nudge
A placement feature that relocates parts in order to make room for new parts being placed. 
Movement is based on previously defined clearance rules. 

— O —

object
One discrete item in the design. For example, an object may be a route segment, a part, a drawing 
line, or a via.

object mode
Start a command by selecting one or more objects and then selecting the command to perform on 
them.

See also: verb mode

obstacles
Objects that block routing. Obstacles can be protected pins, vias, traces, keepouts, board outlines, 
and hatch outlines.

Exception: Although hatch outlines are obstacles, when you interactively route, autoroute, or 
edit traces, hatch outlines are removed from the design so routing can complete.

Visible copper pour hatch outlines, copper pour outlines, and plane area outlines are not 
obstacles to interactive routing, autorouting, or route editing.

odd pad shape
A pad that requires a special aperture, or plot sequence, to create. In PADS Layout, in the Pad 
Stacks Properties dialog box, the odd shape setting should not be confused with trying to create a 
custom shaped pad which is accomplished by drawing copper in the decal and associating it to 
the pad.
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offline plot
A plot that is sent to a file before it is copied to a printer or plotter for processing.

offset
The distance by which rectangular or oval pads are moved away from the electrical center of the 
pad stack.

offset pads
Rectangular or oval pads moved off the electrical center of the pad stack to facilitate 
identification/selection, or for a special design consideration.

one pin nets
A net that contains only one pin. Also called single pin net. In PADS products, a net must have a 
minimum of two pins.

online DRC
A PADS feature that actively checks established-design rules during routing or placement 
operations.

online plot
A plot sent directly to a printer or plot.

open cluster
Clusters that you can delete or replace during automatic cluster creation.

optimization
Rearranging placed parts and/or swapping pins and gates on parts in order to minimize trace 
lengths and reduce the number of vias required for routing.

optimize pass
An autorouting pass that analyzes each route and tries to improve the quality of the route pattern 
by removing extra segments, reducing via usage, and shortening routed trace lengths. This pass 
includes glossing and smoothing processes.

overlapping coppers
Overlapping coppers are combined into one copper area, with possible cutouts. 

See also: coppers, copper connectivity 
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overlapping cutouts
Overlapping cutouts are combined into one cutout area. 

See also: cutouts

overlapping segments
Multiple trace segments stacked on top of one another on one layer.

— P —

package
The protective container for an electronic component with terminals to provide electrical access 
to the die components inside.

pad entry
The point where a trace entering or exiting a pin first crosses the edge of a pad.

pad entry angle
The command in PADS Layout and Router that establishes the angle at which a trace enters a 
pad. This may be orthogonal (90 degrees), diagonal (45 degrees), or any angle.

pad function
The die signal name to which the component bond pad is connected.

pad number
The number of the component bond pad.

pad oversize
On plane layers, pads that are larger than normal, to generate proper clearances when the image 
of the pad is printed in a negative format.

Note: Pad oversize is measured from the center of the pad, not the perimeter. For example, if you 
have a 3 mil oversize, the measurement is actually1.5 mils in each direction from the center of 
the pad.

pad stacks
The combination of pads, drills, and pastes, for example, on a pin or via, for each layer of a 
design, stacked directly on top of one another.
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pagesfile_sys
The Windows NT swap file that allows virtual memory to be written to disk.

pair routing gap
The fixed edge-to-edge clearance between the traces in the controlled gap area for a differential 
pair.

See also: controlled gap area, differential pairs 

paired layer
The start and end layers used by the layer toggle command when changing layers while routing. 
It defines the default layers to use when you make layer changes.

palette
A user-definable color chart in the Display Colors dialog box.

pan
Up and down or side-to-side movement of the screen without zoom or redraw. Use the scroll bars 
or postage stamp to pan.

panning
Moving the view horizontally or vertically without changing the size of the design on your 
screen.

parallel port
A printer port, usually referred to as LPT1 or LPT2.

parallelism
Traces on the same layer that are checked for running parallel to each other.

The traces are subject to crosstalk if they run parallel to each other too long and the gap between 
them is too short.

parasitic
An undesirable stray capacitance, inductive coupling, resistance leakage, or undesired transistor 
actions.

parent object
The object to which individual design elements, such as lines, arcs, or corners, belong.

part decal
The physical representation of a part, or footprint, assigned to the part type.
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part list
An output listing of all parts belonging to the same design. This normally includes the reference 
designation, part name, and part type, and total number of each type.

part name
The text for each part that indicates the reference designator.

part outline width
The line width of 2D line shapes, created in the PCB Decal Editor, that represent silkscreen or 
documentation data within a part decal. The shapes do not include text, reference designators, or 
copper with the decal.

partial route
Partial routes are uncompleted routes where the ratsnest flightline is still visible. This occurs 
when you click End while routing or bus routing, or when you delete a trace segment. See also 
dangling route.

partial via
A via that does not travel through all of the board's electrical layers. The blind via and buried via 
are both types of partial vias.

parts1.fmt
An ASCII part list format file for the report file generator that consists of a reference designator, 
part type, and logic type.

parts2.fmt
An ASCII part list format file for the report file generator that consists of a part type, reference 
designator, and part description.

paste
A substance used to attach each pin of a surface mount device to a PC board.

paste mask
An artwork layer with a paste location for all pads of surface mount components.

patterns pass
An autorouting pass that searches for, and routes, groups of unrouted connections that can be 
completed using a typical C routing pattern, Z routing pattern, and memory pattern.

PBGA
An acronym for plastic ball grid array.

PDF configuration
A set of PDF Configuration dialog box control settings. A PDF configuration can be saved as a 
.pdc file and reused to create PDF documents for multiple designs.

PGA
An acronym for pin grid array.



Glossary

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2399

photoplotting
Using a machine to create printed circuit board fabrication artwork. The machine creates artwork 
by exposing clear film to light or by rasterizing an image onto clear film.

physical design reuse
A collection of design objects that you want to reuse, which are associated with one another. The 
collection of objects can be saved to a file.

physical design reuse elements
The objects that compose the reuse. They can include components, routes, vias, text items, and 
other elements.

pick and place
An automatic printed circuit board assembly machine, driven by outputting the part type, 
location, and orientation of suitable parts from a design.

pin
The through-hole or surface mount terminal that represents a connection to a part. Pins are also 
referred to as pads in pad stacks.

pin array/pin grid array
A package with pins distributed over much or all of the bottom surface of the package in rows 
and columns.

For more information, see Pin Wizards Dialog Box, BGA/PGA Tab.

See also: pin types

pin number
Within a component, the numeric or alphanumeric designation that distinguishes pins from each 
other.

In the Status bar, pins are identified using the following format:
Pin:[Component name].[Pin number].[Pin type]

For example:
Pin:Y1.N.Nonelectrical

See also: pin types

pin pair
The combination of a trace or unroute, and the pins on either side. A net can contain one or more 
pin pairs.

pin pair group
A collection of pin pairs that share common design rules.

pin type
A designation that indicates the electrical characteristics of the pin such as Source (S), Load (L), 
Terminator (Z), and Undefined (U). For example, U1.1.S may appear on the status bar.
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pin types
Pins and pin pairs can be identified by one of the following pin types:

• Source

• Bidirectional

• Open Collector

• Or-Tieable Source

• Tristate

• Load

• Terminator

• Power

• Ground

• Nonelectrical

Pin types make up the last portion of the pin identifier in the Status bar. For example:

Pin:U10.C.Open Collector

See also: pin number

placement check prints
Generate a CAM Assembly drawing to make a placement check print.

After the PCB Designer receives a schematic and a netlist from an Engineer, they (typically) 
place the components onto the board in a manner that best suits the routing of the board. 
Sometimes, the placement better suits the intentions of the Board Designer than the Engineer, so 
before routing proceeds, the Engineer will request to see a set of Placement Check Prints. 
Placement Check Prints show the placement of all components on both sides of the board, so  the 
Engineer can review the locations and confirm the Designer has correctly placed the 
components. These Placement Check Prints typically require agreement from both the Designer 
and the Engineer before routing can proceed.

placement operations
Operations where parts are relocated or added to a design in order to optimize an existing 
placement.

plane hatch outline
The outline of a plane shape after it has been flooded to differentiate it from the plane pour 
outline as originally drawn or the plane indicators outline. When you draw the plane pour outline 
and then flood the shape, the outline often changes to accommodate the design rules. You can 
switch plane display modes using the shortcut modeless commands SPD, SPI, and SPO. Or, 
switch between the Mixed plane display modes in the Split/Mixed Plane Options.
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plane indicators outline
The outline of a plane shape after it has been flooded and then changed to Plane thermal 
indicators display mode to differentiate it from the plane pour outline as originally drawn or the 
plane hatch outline after it has been flooded. When you enable this display mode, the active layer 
must be set to the plane layer in order to see the thermal indicators.Setting the active layer to a 
CAM plane layer also displays the thermals of the CAM plane. You can switch plane display 
modes using the shortcut modeless commands SPD, SPI, and SPO. Or, switch between the 
Mixed plane display modes in the Split/Mixed Plane Options.
Restriction: After you change active layers, you will need to redraw the view to see the new 
layer’s thermal indicators if you do not have the Active layer comes to front option enabled.

plane layers
A design layer where the entire surface is covered by copper, except for information not 
connected to the plane.

plane nets
Nets assigned to plane layers.

plane pour outline
The outline of a plane shape after it has been drawn to differentiate it from the plane hatch 
outline after it has been flooded or the plane indicators outline. You can switch plane display 
modes using the shortcut modeless commands SPD, SPI, and SPO. Or, switch between the 
Mixed plane display modes in the Split/Mixed Plane Options.

plastic ball grid array
A surface mount package with an array of solder sphere-shaped interconnects arranged across 
the bottom surface of the package substrate.

plastic leaded chip carrier
A common surface mount package with leads on all four sides, used as a socket for devices that 
cannot withstand the heat of the reflow process, and/or to allow for easy component replacement.

plated holes
Drilled holes that have copper covering the inside surface of the hole, and which are connected to 
a pad on each side. Plated holes pass connectivity from one layer to others.

plating tail
A route that connects BGA vias to a plating bar or bus bar.

PLCC
An acronym for plastic leaded chip carrier.

plicense.exe
The program used to verify and program your security key during a field upgrade process.

polar decal
A single-radius, circular pattern decal with through-hole pins.
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polar SMD decal
A single-radius, circular pattern decal with SMD rectangular or finger pads.

polygon
A closed shape consisting of three or more line segments.

positive
An image of a plane layer where cleared areas, or airgaps, are created using normal drawing 
techniques. When reversed to create a negative, all areas not drawn for clearance become the 
actual planes.

pour outline
The outline of a copper pour shape after it has been drawn to differentiate it from the hatch 
outline after it has been flooded. You can toggle between the pour outline and the hatch outline 
using the shortcut modeless command PO, or switch between these two Display modes in the 
Drafting Options.

power plane
The plane layer where power supplied to the printed circuit board is dispersed to the proper pins 
of each component requiring a power source.

powerpcb.ini
The PADS Layout initialization file for default settings.

powerpcb.mdb
The PADS Layout message file that contains error messages, prompts, and other miscellaneous 
text strings. This file must be located in the same folder as powerpcb.exe.

powerpcb.reg
A file that defines all Registry keys required for the proper registration of PADS Layout OLE 
components. In addition, other programs acting as clients access the PADS Layout Automation 
Server through this Registry file. 

The installation program automatically creates this file and saves it in the same folder as 
powerpcb.exe. If errors occur in the Registry, or if this file is corrupted, you can restore the 
contents of the file.

preferred routing direction
In the main GUI combo box, the Horizontal [H] or Vertical [V] designation next to a routing 
layer name. This designation indicates optimal direction for routing completion and can be set by 
the user or the system. 

prepreg
A resin pre-impregnated sheet used to bond substrate laminate-pair layers together when a 
multilayer board is pressed together.

preset files
Library IQ files that allow you to save the preference settings you have established for a die 
design and use them in other designs. The Bond Pad Preferences files have a .pre file extension.
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preview of CBP assignments
A preview that displays the substrate bond pads and wire bonds created when component bond 
pads are assigned to rings. This preview appears in the work area when the Assign CBPs to 
Rings dialog box is active.

preview of SBP guides
A real-time preview that displays any changes made to the number, geometry, or location of SBP 
guides. This preview appears in the work area when the Wire Bond Wizard dialog box is active.

well as in the design in which you place the reuse.

See also: private nets

primary objects
Primary object groups in the Object View tab of the Project Explorer contain non-removable 
design elements shown in a high-level object hierarchy. Primary objects are:

1. layers

2. components

3. part decals

4. net objects (including nets and pin pairs)

5. via types

private nets
Nets that are contained completely within a physical design reuse.

See also: public nets

probing
The testing of individual IC dice using very fine probes to temporarily connect each to a test 
computer, in order to verify operation.

properties
A set of dialog boxes used to view or edit information about the selected object.

protect
Glues the routes and attached vias and prevents the autorouter from modifying them in any way.

protected routes
Traces that are placed in a protected state by Route Protection. This means that they cannot be 
moved or modified.

protected traces
Traces placed in a protected state (cannot be moved, or modified).

protected unroutes
Unrouted connections, or the unrouted portion of a partial route, that are placed in a protected 
state by the Route Protection feature. This means that they cannot be routed, moved, or modified.
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public nets
Nets that are partially contained within a physical design reuse. Public nets exist in the reuse, as 
preferred routing direction

In the main GUI combo box, the Horizontal [H] or Vertical [V] designation next to a routing 
layer name. This designation indicates optimal direction for routing completion and can be set by 
the user or the system. 

pulling an arc
Creating an arc from an existing line segment, where the diameter is derived from the line length.

— Q —

QFP
An acronym for quad flat package - a surface mount IC with leads on each four sides.

quad
A square-shaped IC with pads on each of its four sides.

Quick Filter Settings
The shortcut menu selections available when no items are selected. These choices set the 
selection filter for commonly used tasks, allow quick access to the Find command, and Select All 
items as specified by the Selection Filter.

quick measure command
The Q modeless command which attaches a measurement line to the pointer and displays dx, dy 
and hypotenuse information, depending on pointer movement.

— R —

radial lead
A discrete part with pins that protrude straight down and do not extend beyond the perimeter of 
the component body. An example of this is a capacitor.

RAM
An acronym for Random Access Memory. The volatile (on chip rather than on disk) memory 
area available to the system for program operation.

range select
To select a series of geometric or route segments by first clicking on the start segment, then 
pressing and holding Shift and right-clicking on the end segment.

ratsnest
A term used to describe the display of all of the unrouted connections in a design. Also known as 
air lines or unroutes.
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raw database
The raw database contains all components in the open database, regardless of assembly variants. 
When created, new assembly variants are based on the raw database, meaning that until you 
uninstall or substitute, a new assembly variant includes every component in the raw database.

read-only attribute
An attribute whose value cannot be changed in PADS product dialog boxes. You can, however, 
modify attribute properties and the Attribute Dictionary entry, and can modify the attribute value 
in the library.

real width
To display traces at their specified width, as opposed to displaying them as one pixel centerlines. 

real-time redraw
A feature that enables active regeneration of objects in the display any time the screen is 
redrawn. When you disable real-time redraw, regeneration occurs in the background, and the 
display is refreshed all at once after the background regeneration process is completed. Screen 
regeneration is quickest when real-time redraw is disabled.

record locking
Allowing two or more users to access the same library component at one time. However, only 
one user has access to save the component.

recover
Resolving an installation or operational issue, or salvaging a corrupt database by executing a 
specified series of steps.

redo
Repeats actions which have been undone.

redraw
Refreshes the display of the current screen image and the cursor.

reference designator
An identification assigned to each of a design's parts in order to distinguish them from other parts 
of the same type when placed on the printed circuit board. A reference designator is usually in 
the form of a letter that represents the part type, followed by a number. For example, C2 may 
represent the second capacitor in the design. PADS Layout permits you to renumber the 
reference designators in one of several specific patterns allowing you to quickly find a part 
among thousands on the manufactured board. The reshuffled numbers that are rearranged in 
PADS Layout are backward annotated to the schematic software to keep the designs 
synchronized.

relative coordinates
Coordinates that are based on a start point instead of the system origin.

rename
To assign a different name to a part or net.
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reroute
Specifying that a trace, or a portion of a trace, follow a path different than the one currently being 
taken.

restricted layer
Layers that are either disabled for routing or have been disallowed by layer biasing rules. When a 
layer is restricted, routing is not permitted on the layer. Layers can be restricted for specific 
objects, such as a net or a pin pair.

restricted via
A via that is not permitted for use in the Routing Rules of PADS Layout or Via Biasing 
properties in PADS Router at any level of the rule hierarchy.

reuse
See preview of CBP assignments.

reuse definition
The master copy of the physical design reuse that is saved to a file. The saved version of the 
physical design reuse is the version you should use in other designs. All resulting instances of the 
physical design reuse are based on this file.

reuse type
A name that identifies the type of reuse being created. A reuse type is equivalent to a library part 
type.

ring geometry
The shape of the die flag ring. The following shapes, or ring geometries, are supported: 
rectangle, rounded rectangle, chamfered rectangle, and arced shape.

romansim.fnt
The default file that contains definitions for the graphics for the PADS stroke font, used to 
display text in PADS products when system fonts are not in use.

rotate
The command that rotates by 90 degrees a component or object around its axis or selection point.

route
To create a metal etch trace of a specified width between pads.

route-completion target
This crosshair or bullseye symbol appears when routing from one pin of a pin pair to another pin 
or when rerouting a trace segment. 

The partial target appears when you are overtop of an electrically compatible pin, but you have 
settings that are preventing you from routing to it - for example, the unroute of the pin pair you 
are routing is protected (you have selected the Protect Unroutes check box in the Pin Pair 



Glossary

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2407

Properties).

route loops
A pin pair that contains a route that branches off the original route, then branches back into the 
same route to form a loop.

route pass
The autorouting pass that is the core pass that performs the majority of autorouting. During this 
pass, PADS Router attempts to sequentially route each unroute until all connections are 
attempted. The Route pass contains serial, rip up and retry, push and shove, and touch and cross 
processes.

routed length
The trace length monitor calculates routed length as the cumulative length of the trace. This 
value always starts at zero unless you start routing from the end point of a partially routed trace, 
in which case the routed length includes the partially routed trace length. If the trace has 
branches, then the length is calculated from the branch point.

See also: estimated total length, unrouted length

routes
A series of traces that represents routed connectivity.

routing angle
The angle applied to adjacent segments as new corners are added to traces. For example, an 
orthogonal routing angle means adjacent segments will be created at 90-degree angles to each 
other. 

routing order
The order in which the autorouter routes components, nets, and net classes. 

routing pass types
There are several pass types, each of which is designed to complete a specific task. Each pass 
may use more than one algorithm and may also perform a number of subpasses.
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The following pass types are supported:

routing strategy
The collective information PADS Router uses to autoroute a design. This information includes 
which pass types PADS Router should perform, whether to protect the resulting traces, and what 
intensity to assign to objects.

ru.cfg
A configuration file used by the nrus.exe program for Novell network security support.

rule values
The values of any item, regardless of its default rules or rules set assignments.

rules
An established set of conditions for a given net or design.

rules set
A specific set of user-assigned nondefault rules such as pin pair, groups, or classes.

— S —

same net checking 
Checks clearances between objects along the same net, as specified in the Clearance Rules dialog 
box. Object to object checking includes:

• Pad edge to pad edge.

• Pad edge to inside corner of trace. 

• SMD edge to pad edge.

• center pass

• fanout

• miters pass

• optimize pass

• patterns pass

• route pass

• test point

• tune pass
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• SMD edge to inside corner of trace. 

This check prevents solder bridging during board manufacturing caused by acute angles between 
conductive objects such as the acute angle between pad and trace shown below.

same net rules
Specifying conditional settings, such as spacing, for connections belonging to the same signal 
name or net, rather than against other nets.

SBP
An acronym for Substrate Bond Pad.

SBP fanout
A single-segment fanout that connects SBPs to any-angle coupling traces.

SBP guide
The virtual snap line along which substrate bond pads are aligned during wire bond fanout 
generation. Each SBP guide determines the alignment of the substrate bond pads that are 
associated with the SBP ring aligned with this SBP guide.

SBP ring
A set of substrate bond pads aligned along an SBP guide. A substrate bond pad belongs to the 
ring on which it is aligned. In creating a wire bond fanout, you assign each component bond pad 
to a specific SBP ring.

schematic-driven design
The “standard” PCB design process, in which a netlist is first created in a schematic tool, and 
then passed to a layout tool, where the parts are laid out on the board and the connections routed. 
See also: layout-driven design

scribe line or saw line
The separation between adjacent dies on the wafer. This path is used as the cutting area in sawing 
a wafer into the individual dies.

search
To locate specified information. One search method is to use the Find command.

secondary objects
Secondary object groups break primary objects into a more detailed hierarchy. You can add 
individual items to and remove individual items from secondary groups. Secondary objects 
include:
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1. net class

2. pin pair group

3. conditional rule

4. matched length net group

5. matched length pin pair group

6. differential pair

seed
A part used by Cluster Placement, during cluster building, to search outward for other parts to 
add to the cluster.

segment
A single drafting line, path, or trace, defined by a beginning x/y coordinate and an ending x/y 
coordinate.

segmentation fault
The termination of a PADS product due to a system crash or illegal instruction executed.

Select All
The Edit menu command that lets you select all items of a type specified in the Selection Filter. 
This option is also accessible from the shortcut menu when nothing is selected.

select mode
Point to the object and click the left mouse button. Select the command to perform on the object.

selecting
To highlight an object for editing, moving, viewing properties, or deleting.

selection filter
The dialog box inhibiting or enabling the selection of specific items.

serpentine route
A route that connects an any-angle coupling trace and a BGA pad, forming a snake-like pattern 
as it travels through the BGA.

session log
Information on the current session that appears in the Status tab of the Output window.

shape
The Selection Filter setting that enables or disables selection of an entire geometric object, not 
just its individual segments.

shared libraries
Libraries that can be accessed by more than one user across a network.
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shielding
Specifying that one net be routed around another to provide protection from interference.

shortcut keys
A key sequence that starts a command directly from the keyboard and without navigating 
through menus.

shortcut menu
A menu listing the possible actions to perform, based on the selected object.

shoulder
The part of the differential pair trace between the source pin and the gathering point, or between 
the split point and the destination pin.

See also: differential pairs, gathering point, split point

signal
Voltage or current that is transferred between component pins by an electrical conductor.

signal pins
Pins that have a signal net, such as GND, assigned by the schematic capture program PADS 
Logic during part type creation.

silkscreen
An artwork layer containing the reference designator and component outline of all parts, used for 
the final board fabrication process.

single-sided board
A design where all pads, routing, and parts are placed on one side of the board.

single-sided die
A die that has substrate bond pads and a BGA grid array on the same side of the die.

See also: documentation layers

sizing handles
Small, black squares that appear at the corners and along the sides of a rectangular area that 
surrounds a selected nontext object.

sketch route
A PADS Layout command that reroutes existing traces by allowing you to draw a new route path 
using the pointer.

slice
Another term for wafer.
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slotted holes
Oval holes in a printed circuit board, which may be plated or non-plated.

SMD
An acronym for Surface Mounted Device: the pin of a component that is attached to the PCB 
only on an outer surface and does not require drilled holes for component mounting.

smoothing
A command that automatically removes unneeded corners and segments and centers trace 
patterns between route obstacles.

SMT
An acronym for Surface Mount Technology.

snap modes
Various modes, available during dimensioning, that force the pointer to pick points based on of 
the following parameters: intersection, any point on a line, any point in space, entire segments, 
the center point of an arc, and so on.

soft rule
A rule that is ignored if it alone prevents route completion. See also: hard rule, and Hard and 
Soft Rules, in the PADS Router Concepts Guide.

SOIC
An acronym for Small-Outline Integrated Circuit.

solder
A metal alloy used to attach each pin of a device to a printed circuit board.

solder dam
A small amount of solder mask used to limit molten solder from spreading further onto 
solderable conductors, in an area where solder mask is purposefully absent.

solder mask
The artwork layer for a nonconductive material that covers the entire board, except for pad 
locations. The solder mask provides a protective covering and prevents shorts during wave and 
reflow solder processes.

solder mask reliefs
Some components have large areas that need to dissipate heat. Others have large metallized areas 
(that are not pins) that need to be soldered to the board. In order to expose the copper area 
beneath these parts for soldering, the solder mask layer must have a cutout representing these 
areas. These cutouts are called solder mask reliefs. When the distance between pads of a fine 
pitch component is too small, the webs or fingers of solder mask between pads can break and 
wander on the board surface. To prevent this, a solder mask relief is applied to entire pad areas of 
a component. This is commonly called gang relief.
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solder side
The back or bottom side of a printed circuit board. Solder side is named for the post assembly 
process, where the board is run through a special bath to solder all pins.

source
A pin type that indicates a signal radiating from the pin.

SPECCTRA
The product name for the Cadence Design Systems autorouter.

special symbols
Alternate decals that you specify as connectors. You can associate a logical pin type with each 
alternate to provide a graphical indication of the connector pin function in a schematic.

spider bonding
A method of connecting an integrated circuit die to its package leads. A lead frame is placed over 
the chip and all connections are made by just one operation of a bonding machine. TAB methods 
use this approach to interconnection.

spin
The PADS command that rotates a component or object around its axis or selection point.

split
The command that creates a new corner at the pick point of the selected trace, allowing it to be 
rerouted.

split plane
A solid copper plane layer divided into two or more sections in order to isolate electrical signals 
from each other.

split point
The point near the destination pins where differential pair traces are no longer routed together 
and where the traces are routed individually to completion.

See also: differential pairs, pair routing gap 

ssiact.exe
A program used to recommend set statement settings to properly adjust port access times for a 
security key.

stackup
The metal and dielectric layers used to implement the body of a printed circuit board. A signal 
metal layer carries signal traces. A plane metal layer is tied to a DC voltage. A dielectric layer is 
made from non-conducting material and separates two metal layers or coats the board surface.
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start zone
The part of the differential pair between the source pins and gathering point.

See also: differential pairs, gathering point 

starting layer
The first layer in a drill pair or via definition.

step-by-step mode
A mode in which the debugger runs a single line of code at a time.

stitching vias
Any SMD via, through-hole via, or partial via added to nets (on traces or within plane areas) in a 
repetitive manner. You can add these vias, also called free vias, for various purposes, including 
current and thermal needs. For example, you can place stitching vias in a plane area to provide 
conduction between two plane areas. You must assign stitching vias to a net, but they do not 
have to have traces attached to them.

strategy
A set of options that defines how a board should be autorouted. 

strong
Places cluster members as close together as possible during placement operations. The minimum 
distance for placement is the same as the distance for part clearances in Design Rules.

structured attributes
Attributes that are related to each other by the prefix in their name. For example, the DFT 
attributes such as DFT.Nail Count Per Net, DFT.Nail Number, and DFT.Nail Diameter are 
structured attributes. Together, these structured attributes make an attribute group.

stub
A trace that enters another to create a T-junction. Stub lengths can be checked by the EDC 
program.

submicron
Dimensions smaller than one micron.

subnet
A collection of all traces and vias connecting two pins. Subnets are joined only through their 
common component pins and not through other nodes, such as a trace junctions, vias, or virtual 
points. 
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Subnets help to avoid errors or confusion caused when pin pairs of a net have unique, rather than 
common, design rules. 

See also: node, subnet, connected islands, virtual point 

One subnet in a net

subnets
If a net has at least one pin pair with a unique design rule, such as a trace width difference, the 
net is automatically divided into subnets. If two pin pairs having the same rules are separated by 
at least one pin pair with different rules, the pin pairs are considered separate subnets. Therefore, 
subnets are islands of pin pairs that form an unbroken fragment within the net, where each 
fragment has uniform rules.

See also: subnet, connected islands 

Multiple subnets in a net

substrate
A material between copper laminate layers that comprise a laminate pair, or a laminate set in the 
case of completed multilayer boards.

substrate bond pads
Copper areas on the substrate to which a die's wire bonds are connected.

surface mount device
Pads are glued to the board rather than inserted.

swap file
The file created when a program runs out of RAM memory and writes memory to disk.

swapping
A placement optimization process that exchanges pins, gates, or entire parts.

The product .ini file entry that specifies the path for the PADS product configuration files.
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system attribute
An attribute that is set by, used by, and critical to a PADS product, an external program, or 
Automation script (such as Sax Basic). You cannot modify the properties of a system attribute or 
modify the Attribute Dictionary entry for a system attribute.

system toolbars
System toolbars are specific to the PADS programs. They feature several system toolbars, such 
as standard, routing, selection filter.

SystemDir
The product .ini file entry that specifies the path for the PADS product configuration files.

— T —

T junction
A trace that branches into another.

TAB
An acronym for source.

tacks
Small, diamond-shaped objects that anchor traces to their current location. Tacks are 
automatically generated under certain conditions and may also be manually added to a selected 
trace.

tandem traces
Traces on different layers that are checked for running parallel to each other.

The traces are subject to crosstalk if they run parallel to each other too long and the gap between 
them is too short.

Tape Automated Bonding (TAB)
A packaging method where silicon chips are joined to patterned metal traces, or leads, on 
polymer tape to form inner lead bonds which are attached to the next level of the assembly, 
typically a substrate or board.

Tape Ball Grid Array (TBGA)
A TAB packaging method in which tape automated bonding leads are replaced by a ball grid 
array.

TBGA
An acronym for Tape Ball Grid Array (TBGA).

teardrop
A triangle shape that provides a smooth transition from a trace to a pad.

terminal
The electrical center of a pin, as defined in the part decal.
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terminator
A pin type for high-speed circuit configurations that indicates a terminating resistor to match 
impedance of the trace. Terminators are used to reduce signal reflections that cause poor circuit 
performance.

test point
A test point is a group of objects that serve as a contact between the electrical element of the 
board and the probe of the testing device. A test point can also be a point on a node of a net, 
component pin, or via. Test points can also be a point on an unused component pin, such as a 
component pin that is not incorporated into any net.

When the via or pin is flagged as a test point, and Show Test Points is checked on the Routing tab 
of the Options dialog box, a down arrow symbol is drawn on the via or pad in the design:

test point pass
This autorouting pass analyzes the testability of the design, determines which nets require 
testing, adjusts the routes, and inserts test points to improve testability. You can select whether to 
add test points during routing or after routing. 

See also: The "To Assign Test Points During Routing," "To Assign Test Points After Routing," 
and "Using Automatic Test Point Placement" topics in the PADS Router Help for more 
information.

testpnts.fmt
An ASCII file containing information about test points, including the test point name, the signal 
name, and the x/y coordinates. The report file generator creates this file.

thermal
A multi-spoke connection of a through hole pin pad, via, or surface mount pad to a plane area or 
copper pour area.

thermal compression bonding
A method of wire bonding that does not use an intermediary metal or melting, but rather the flow 
of materials resulting from the combination of heat and pressure. It is also referred to as 
thermocompression bonding.

thermal relief
A spoke-shaped pattern that connects a via or pin, in the same net as the copper pour, to the 
surrounding copper. Thermal reliefs provide good pin soldering by preventing heat from 
dissipating throughout the plane layer.

thick-film process
A hybrid microelectronic process where conductors, insulators, and passive components are 
screened from special pastes onto the substrate.
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thin-film process
The use of deposited films of conductive or insulating material, which may be patterned to form 
electronic components and conductors on a substrate or used as insulation material between 
successive layers of components.

through holes
Although there are non-plated through holes, this term is used interchangeably with plated 
through holes. It indicates that the hole has internal plating. There are two basic types of 
components that can be placed on a circuit board: Surface Mount Technology (SMT) where the 
parts are soldered to the surface of the board, and through hole (TH) components, where the 
components have wire leads that are soldered into plated holes that go through the board 
(sometime written as thru-holes).

through-hole via
A via that passes through all electrical layers of the PCB design (as opposed to a partial via). 

This is sometimes also called a through via.

tooling holes
Every board requires at least two tooling holes that the blank board manufacturer uses for layer 
alignment purposes during the manufacturing process. If you don't include them in the design, 
the manufacturer will add them to the board. Tooling holes are typically .125" non-plated holes 
with a tolerance of +/-.002". If the board is so small that the tooling holes won't fit, the 
manufacturer will add them to an area outside of the board outline. (These would typically get 
removed after final assembly.) There are two types of tooling holes: board tooling holes and 
panel tooling holes. Most boards are manufactured by stepping and repeating the single board 
image onto a larger panel so that multiple boards can be processed on a single panel. So, the 
board tooling holes are used for alignment purposes for individual boards, while the panel 
tooling holes are used for alignment of the entire panel during the manufacturing and assembly 
processes.

Tip: Use the Decal Editor and the Pad Stacks dialog box to create tooling holes. Save the single-
terminal object as a part to the library for reuse.

See also: Creating Terminals, Editing Pad Stacks

ToolTips
ToolTips appear below buttons and provide a command name or description for the buttons. 

topology
The pattern of the trace and the order in which to connect pins in a net. 

total length
The current routed length plus the total Manhattan length for remaining unroutes of the 
associated net or pin pair. 

Total length is reported for pin pairs when all the following are true: length rules are defined for 
the pin pair, the associated net is a high-speed net, and copper sharing is disabled. 



Glossary

PADS Layout User’s Guide and Reference Manual, PADS 9.4 2419

If pin pair rules are reported, the estimated total length of the pin pair is shown; otherwise, total 
length for nets is reported. 

trace
A line segment that represents physical etch. A trace can appear as a single pixel line or as a 
double line to indicate its actual width.

trace corner
The vertex at which two trace segments are joined. A trace corner can also be the end point of a 
partially routed trace. The trace segments may be in line. 

trace paths
A continuous sequence of trace segments in the same trace on the same layer. Paths start and end 
at nodes, and cannot pass through a node.

trace segment
One section of a trace. A trace segment has one starting point and one ending point. A trace 
segment can be arced.

Trace segments are contiguous when they are joined end to end, in one continuous path, and 
belong to the same trace.

transparent layers
The mode that displays layers in a see-through mode so you can view multiple objects stacked 
upon each another. This is the modeless command T.
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TrueLayer
The default mode of operation in PADS Layout whereby an object on a documentation layer 
moves with a component if the component is moved from one side of the board to the other. For 
example, when you place a component on the top layer of the board, the reference designator of 
that component is visible on the Silkscreen Top layer (the documentation layer associated with 
the top layer of the board). Moving the component to the bottom side of the board automatically 
moves the reference designator for the component to the Silkscreen bottom layer.

TrueLayer also correctly plots paste masks of documentation-level pad shapes in CAM. The 
layer that the definitions move to is set in the Component Layer Associations dialog box. 

By default, TrueLayer mode is enabled. To disable it, use the /NTL command-line switch. See 
Start-up Options.

TTL
Acronym for Transistor-Transistor Logic.

tune pass
This autorouting pass adjusts the length of length-controlled traces. The pass examines trace 
lengths for only completely routed nets or pin pairs. The pass analyzes the current length of each 
net or pin pair if length rules and length control are enabled, based on the following conditions:

• If the cumulative length of the adjacent trace segments is within the range of minimum 
and maximum trace length, the tune pass skips the trace and does not adjust it.

• If the trace is longer than the maximum trace length, the tune pass rips it up and places it 
in a queue for routing.

• If the trace length is less than the minimum trace length, the tune pass changes the length 
by adding accordion patterns.

— U —

ultrasonic bonding
A wire bonding technique that uses ultrasonic energy and pressure to form the bond without heat.

underfill
Material injected under the die to ensure interconnect reliability against cross-reference file 
mismatch between the die and the substrate in a flip chip configuration.

undo
A command that allows you to remove the effects of the last command invoked.

undock
To isolate an application dataset from the main design project so it can be edited regardless of the 
network or the physical location of the dataset. The isolated dataset has no dependence on the 
main design project.
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UndoMemorySize
The powerpcb.ini file entry that limits the maximum size of the buffer that is used to store ECO 
operations for Undo.

unions
Parts assigned to each other in fixed relative positions using Cluster Placement. These positions 
are maintained whenever a union is moved in Cluster Placement. A common example is the 
relationship between bypass capacitors and ICs.

units of measure
A commonly used set of measurements.

unroute
To convert a trace back into a connection.

unrouted length
The trace length monitor calculates unrouted length as the distance from the end point of the 
current trace segment (attached to the pointer) to its destination.

The unroute length calculation depends on the current routing angle: 

The unrouted length is recalculated as the unroute dynamically reconnects to connection points. 
The routing angle also effects this calculation. 

See also: routed length, estimated total length

unroutes
Thin, straight segments joining pins or coppers to indicate connectivity. Also called a link.

unused pins
Pins that are not connected to a net.

UserDir
An .ini file setting that specifies the path for PADS product configuration files.

— V —

verb mode
Start a command by attaching a command to the pointer and then selecting objects to which you 
apply the command.

Routing mode: The calculation:

Orthogonal Manhattan Length

Diagonal  The length of the shortest diagonal path between unroute ends 

Any Angle Point-to-point distance 
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You can enter verb mode by selecting a command when no objects are selected. A small V 
attaches to the pointer to show that the selected command is active. The command remains 
attached to the pointer until you cancel verb mode.

See also: object mode

vertex
A single point in the work area, defined by x and y coordinates.

via
A drilled and plated hole that passes conductivity from one layer to another.

via pair
A pair of vias used to change the routing layer for a differential pair when routing the controlled 
gap area.

See also: via, differential pairs

victim net
Nets that are interfered with by those tagged as aggressor nets during High-Speed or 
Electrodynamic Checking.

virtual memory
Writing memory areas to disk in the form of a swap file when RAM is filled. The size of the 
swap file is based on the free disk space or the limits imposed by the operating system.

virtual point
A point along a trace segment that identifies a change in design rules, usually between trace rules 
and component rules. Virtual points are inserted into nets automatically when necessary, usually 
during autorouting operations. You cannot create, position, or otherwise edit a virtual point.

See also: subnets

Visual Basic
Visual Basic is a simple scripting language developed by the Microsoft Corporation in the late 
1980s to provide users with a unified language in Windows 95 and Windows NT. More and 
more Windows applications like PADS Logic include Visual Basic capabilities, such as Word 
and Excel, to allow users to customize these applications using a standard scripting language.

visual editing
Visual Editing occurs when the source application for a linked or embedded OLE object opens 
within the container application. 

— W —

wafer
A thin disk of semiconductor material (usually silicon) on which many separate chips can be 
fabricated.
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wafer sort
The electrical testing of each die on the wafer while still in wafer form.

WB
An acronym for wire bond.

wedge bonding
A form of thermal compression wire bonding where the bond shapes the wire into a wedge 
shape.

width
The thickness of a trace or line.

wire bond
Fine wires, usually aluminum or gold, connecting the bonding pads on a die to the component 
package.

Wire Bond Editor
The Wire Bond Editor opens (explodes) a selected die part, so you can move, add, delete, and 
edit individual component bond pads and wire bonds in addition to substrate bond pads. You can 
also edit the die size.

wire bond fanout
A pattern of wires (typically gold) that arc out from component bond pads to substrate bond pads 
to provide connectivity between the die pins and the substrate package pins.

Wire Bond Wizard
A BGA toolbox feature that creates and places substrate bond pads and generates an automatic 
wire bond fanout between component bond pads and substrate bond pads.

wire bonder
The machine that connects wires between the chip bond pads and the substrate bond pads.

wire bonding
The process of electrically connecting a chip to the next level package with fine wires. The wires 
are either gold or aluminum.

workspace
The actual work area where a design is created.

— X —
There are no terms in this section.

— Y —

yield
The ratio of the number of acceptable units to the maximum number possible.
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— Z —

Z routing pattern
A collection of routes that form a pattern resembling the letter Z. 

zoom
Modifying the view to make objects appear larger or smaller. Zooming in or out affects the 
amount of what can be viewed in the work area.

See also: protect 



2425

A B F GDC E H I J K L M N O P Q R S T U V XW Y Z

PADS Layout User’s Guide and Reference Manual, PADS 9.4

Index- operator, 2225

— Symbols —
^ operator, 2227
.do file, 856, 858, 1494, 1499

editor, 856, 1499
starting up, 858, 1494

.hyp file, 961
* operator, 2222
/ operator, 2224
/NTL switch, 508
&amp\, 2221, 2246
+ operator, 2223

— A —
Activate method, 2146
ActiveDocument property, 1637
ActiveLayer, 2337
ActiveLayer combo box, 2337
ActiveView property, 1763
ActiveX component, 2270
ActiveX object, 2263
ActualValue property, 1814
Add CBP dialog box, 880
Add Die Parts dialog box, 881
Add method, 2126, 2133, 2183
Add New Decal Label dialog box, 887
Add New Part Label dialog box, 525, 891
Add or Edit Document dialog box, 797, 874
Add SBP dialog box, 898
adding, 227, 543, 544

attributes to objects, 427, 439, 445, 932, 
934, 1293

attributes to parts, 1374
BGA pin labels, 227, 871
CBPs - component bond pads, 228
components to a design, 687
connections between pin pairs, 685
connections in BGA, 228
corner to a trace segment, 648

corners to a bus, 608
die parts to BGA from Library IQ, 229
documents, 797, 874
drafting items to a library, 564
drafting objects, 543, 544, 545
drill hole information, 361
drill pairs, 391
existing reuses, 534, 535
fanouts, 229
keepouts, 192, 497
logic families, 1258
nets to classes, 980
new part labels, 525, 891
partial vias, 393
parts in BGA, 230
parts to unions, 515
pin pairs, 685
pin pairs to groups, 1208
plated or non-plated drill size, 803, 1139
reuses, 533
routes in BGA, 231
SBPs - substrate bond pads, 230
special symbols, 1376
stitching vias, 649
terminals, 182, 900
test points, 651
text, 546, 883
through-hole vias, 392
via pad stacks, 392, 393
vias to a bus, 608
vias to an existing trace, 649
wire bonds, 227

AddLabel property, 2141
AddText method, 2147
adjusting focus for a substrate bond pad, 231
advanced chip packaging, 1088

Die Flag wizard, 1088
Wire Bond wizard, 1560

Align Parts dialog box, 901
aligned dimensioning, 758

Index
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alignment, 510
allocating storage space, 2237
allow selection, 336
Alphanumeric Pins tab - Part Information 

dialog box, 1392
And operator, 2228
Angle property, 2096
angular dimensioning, 758
annotation

DxDesigner Link
setting preferences for, 1149

antilogarithm, 2269
application object, 1585, 2117

ActiveDocument property, 1637
Application property, 1638
CreateLibrary property, 2113
DefaultFilePath property, 1639
ExportLibraryItems method, 2114
FullName property, 1640
GetLibraryItems method, 2117
Libraries property, 1641
LockServer method, 2118
Measure method, 2119
Name property, 1642
ObjectType property, 1643
OpenDocument event, 2197
OpenDocument method, 2120
Parent property, 1644
Preference property, 1645
ProgressBar property, 1646
ProgressChange event, 2198
Quit event, 2199
Quit method, 2123
RunMacro method, 2124
StatusBarText property, 1647
UnlockServer method, 2125
Version property, 1648
Visible property, 1649

Application object methods, 2308
CreateNewDocument, 2309
ExecuteCommand, 2310
Help, 2311
HelpContents, 2312
OpenCustomizeDialog, 2314
OpenDocument, 2315

OpenOptionsDialog, 2316
OpenPropertiesDialog, 2317
Quit, 2318
RunMacro, 2319

Application property, 1638, 1645, 1650, 1663, 
1669, 1677, 1692, 1703, 1743, 1764, 
1803, 1815, 1838, 1845, 1855, 1877, 
1883, 1889, 1900, 1915, 1921, 1953, 
1963, 1989, 2002, 2030, 2062, 2083, 
2097

arcs, 632
converting trace corners to, 644
dimensioning, 758
in routes, 632
pulling from a drafting segment, 558
stretching, 645

arctangent, 2259
arithmetic subtraction operator, 2225
array components, 509
Asc, 2258
ASCII, 352

checking test points with, 721
export, 353, 916
file format, 269
import, 352

ASCII Output dialog box, 353, 916
Assembly Options dialog box, 808, 919
assemblyoptions object, 1586

Add method, 2126
Application property, 1650
Count property, 1651
Delete method, 2127
Item property, 1652
ItemType property, 1653
Merge method, 2128
Next property, 1654
ObjectType property, 1655
Parent property, 1656
ParentObject property, 1657
Remove method, 2129
Reset method, 2130
Select method, 2131
Sort method, 2132

AssemblyOptions property, 1765
Assign CBPs to Rings dialog box, 920
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Assign Color to All Layers dialog box, 922
Assign Decal to Gate dialog box, 217, 924
assigning, 577

attributes to multiple object types, 439, 934
attributes to objects of the same type, 445, 

1293, 1295
CBPs to rings, 232
colors to nets, 614
copper to a net, 585
decals to parts, 1383
JEDEC pinning to a decal, 169
nets to CAM planes, 1429
nets to split/mixed planes, 592
plane thermal attributes, 599
signal names to pins, 1387
unique netnames for copper shapes, 577

assigning value, 2226
associating, 175, 1006

component and documentation layers, 1006
copper with terminals, 175
nets to a plane area, 592

Atn, 2259
Attribute Manager dialog box, 439, 934

hiding columns in, 439, 934
showing columns in, 439, 934

attribute object, 1587
Application property, 1663
Measure property, 2138
Name property, 1664
ObjectType property, 1665
Parent property, 1666
Value property, 1667

Attribute Properties dialog box, 429
Attribute property, 1856
attributes, 451

assigning to objects, 439, 445, 934, 1293, 
1295

assigning to the part type, 1374
attribute level backward annotation, 331
Attribute List dialog box, 439, 934
Attribute Properties dialog box, 429
automatically loading, 427, 932
creating, 190
customize units for, 451
deleting, 427, 439, 932, 934

dictionary, 427, 932
editing, 528, 1394
labels in the Decal Editor, 188
loading from library, 427, 932
modifying, 187, 436, 528, 935, 1374, 1394
Object Attributes dialog box, 445, 1293, 

1295
properties - setting, 429
property types, 429, 433, 435, 937
removing, 427, 439, 445, 932, 934, 1293, 

1295
renaming library attributes, 150, 1261
setting default attributes, 450
Show Attributes dialog box, 444, 1497
summaries, 439, 934
updating, 427, 932

attributes object, 1587
Add method, 2133
Application property, 1669
Count property, 1670
Delete method, 2134
Item property, 1671
ItemType property, 1672
Merge method, 2135
Next property, 1673
ObjectType property, 1674
Parent property, 1675
ParentObject property, 1676
Remove method, 2136
Reset method, 2137
Select method, 2139
Sort method, 2140

Attributes property, 1704, 1768, 1902, 1916, 
1954, 1964, 2063

Attributes tab - Part Information dialog box, 
1374

augment, 803, 818, 1139, 1413
button in CAM drill drawing options, 803, 

1139
button in photo plotter setup, 818, 1413
on-the-fly for photo plotter, 818, 1413

auto separate, 596
AutoCAD support, 1164
autodimensioning, 758

aligned, 758
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angles, 758
arcs and circles, 758
automatic orientation, 758
baseline, 762
chained dimensions, 762
deleting, 768
edge preference, 763
horizontally, 758
leader lines, 758
moving, 766
off-angle rotations, 758
query/modify, 769, 914, 970, 1120, 1122, 

1182, 1252, 1267
selecting the parent dimensioning object, 

766
snap mode, 764
vertically, 758

automatic
ECL terminator swapping, 699
gate swapping, 702
part renumbering, 689
pin swapping, 704

automation replacements for RGL, 2207
automation server, 1583

application object, 1585
assemblyoptions collection object, 1586
attribute object, 1587
attributes collection object, 1587
CBP object, 1588
circle object, 1589
component object, 1589
connection object, 1591
document object, 1592
drawing object, 1594
Error object, 1595, 1596
introduction, 1571
jumper object, 1596
label object, 1596
library object, 1598
libraryitem object, 1598
measure object, 1599
net object, 1599
netclass object, 1600
new functions to replace RGL, 2214
object hierarchy, 1572

objects collection object, 1600
overview, 1583
parttype object, 1603
pin object, 1602
polyline object, 1603
replacements for RGL field keywords, 

2214
replacements for RGL top level keywords, 

2208
RGL sublevel keyword replacements, 2210
routesegment object, 1604
SBP object, 1604
text object, 1605
via object, 1607
view object, 1607
wirebond object, 1608

auto-orient dimensioning, 758
autorenumbering, 689
autorouter - dynamic, 608

— B —
backing up the last added connection, 262
backup files, 421

creating, 421
backups, 421
backward annotate from PADS-Layout, 328

attribute level, 331
gate level, 332
net level, 332
part level, 331
pin level, 333

backward annotation, 311
CAM350 files to PowerPCB, 741
overview, 311

Backward Annotation dialog box, 945
baseline dimensioning, 762
basic, 1576, 1577, 1578, 1579, 1582
Basic language, 832
Basic scripting

adding a script to a menu, 947
Basic Scripts dialog box, 947
running a script, 947

Basic scripts, 2207
editor for, 946
using to replace RGL, 2207

Basic tab, 946
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begin drag, 2306
BGA, 273, 949

Add Die Parts dialog box, 881
adding connections, 228
adding die parts, 229
adding parts, 230
adding pin labels, 227, 871
adding routes, 231
BGA Route Wizard dialog box, 949
BGA/PGA wizard tab - Pin Wizards dialog 

box, 1045
connection report, 239
decals, 254, 1045
deleting connections, 252
deleting nets, 252
design workflow, 234
dynamic route editor, 273
editing a decal, 254
moving component substrate bond pads, 

261
Pads for Die Pin dialog box, 1367
parts - adding, 230
pin labels - adding, 227, 871
renaming nets, 263
Route Wizard dialog box, 949
routes - adding, 231
routing - interactive, 233, 267
Select Graphically dialog box, 1483
swapping pins, 268
Synchronize Die Part dialog box, 1515
synchronizing die parts, 268

BGA Route Wizard, 273
BlazeRouter Monitor dialog box, 1370, 1372
board cut out, 344

moving, 346
board extents - zooming to, 336
board outline, 343

reusing, 346
board, single-sided, 384
BoardOutlineSurface property, 1769
BoardSim dialog box, 961
BottomRightX property, 2084
BottomRightY property, 2085
breaking a physical design reuse, 541
Bring to front, 585

Browse for Part Types with Alphanumerics 
dialog box, 1225

Browse For Special Symbols dialog box, 223, 
963

Browse Library Attributes dialog box, 964
building clusters, 965
Bus Router, 608

adding corners to a bus, 608
adding vias to a bus, 608
controlling the guide route, 608
cycle via pattern, 608
end via mode, 617
ending a bus with tacks, 608
examples of, 608
manual bus route mode, 608
shortcut menu, 608
using the, 608
via type, 616, 1550

— C —
CADSTAR

importing, 364
Call statement, 2235
CAM

advanced pen plotter setup, 1406
advanced photoplotter setup, 1409
CAM350 Link, 729
defining drill symbols, 803, 1139
defining NC drill options, 1278
documents, 792, 1074
NC drill setup, 1279
pad clearances, 1430
pen plotter setup, 1408
photoplotter setup, 818, 1413
plot options, 1430
previewing output, 813, 969
printing, 815, 816
reference designators, 679, 680, 681
RS-274-X setup, 1409
selecting layers and items for output, 800, 

1484
Selections Preview dialog box, 814

CAM Plus, 820, 966
CAM Plus assembly machine interface, 

820, 966
CAM Preview dialog box, 814
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CAM350 Link
backward annotation, 741

CBP object, 1588
Application property, 1677
Component property, 1678
Edge property, 1679
Function property, 1680
Layer property, 1681
Length property, 1682
Name property, 1683
ObjectType property, 1684
Parent property, 1685
PositionX property, 1686
PositionY property, 1687
Shape property, 1689
SPBs property, 1688
Width property, 1690
Wirebonds property, 1691

CBP tab, 1091, 1100, 1107
CBPs, 228

adding, 228
editing, 254
moving, 260

CBPs property, 1705, 2015
CenterX property, 1693, 1706, 1990, 2086
CenterY property, 1694, 1707, 1991, 2087
cfg file, 1144
chained dimensions, 762
Change event, 2204
changing

die outlines, 240
part types, 690
the start end of a trace connection, 630
trace widths while routing, 634
via type while routing, 633

character code, 2260
Asc, 2258
Chr, 2260

Check Teardrops dialog box, 621, 979
CheckASCII method, 2148
CheckBox, 2288
checking, 83, 85, 87, 742, 885, 1221, 1223

fabrication, 745, 1184
for software updates, 98, 978
high-speed, 742, 885

installed options, 83, 1223
isolated stitching vias, 743, 1020
Latium design, 743, 1243
license files, 85, 87, 1221
teardrops, 621, 979
wire bond rules, 232

CheckListBox, 2290
Chr, 2260
circle object, 1589

Application property, 1692
CenterX property, 1693
CenterY property, 1694
Geometry property, 1695
Layer property, 1696
LineWidth property, 1697
ObjectType property, 1698
OutlineType property, 1699
Parent property, 1700
Radius property, 1701
ShapeType property, 1702

circular array, 505
Class Rules dialog box, 459, 980
classes, 459, 980
clearance, 571, 572

after routing, 664
clearance rules, 985
conditional rules, 2348
general rules, 2350
setting, 742, 982
viewing, 571, 572

Close, 2236
Close statement, 2236
cluster placement

automatic cluster placement, 521, 990
build clusters setup, 965
place clusters setups, 1424
place parts setup, 1427
Query/Modify Cluster Information dialog 

box, 988
unions, 515

clusters
Query/Modify Clusters dialog box, 994

code samples, 2207
enhancing, 2206
running, 2204
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troubleshooting, 2207
color, 415, 1125

by net, 1553
changing the background color of an OLE 

object, 838
making objects visible, 415
objects

making invisible, 416
palette, 415
printing, 815
saving, 418
setting, 1125

colors, 413
setting for objects, 414
setting for pin numbers, 414

combining line and text objects, 559
ComboBox, 2292
command, 2261
command line, 2261
comparing designs, 301
comparing expressions, 2229
comparing test points, 721
comparison operators, 2229
component arrays, 509

creating, 509
modifying, 509
Planar Array tab - Create Array dialog box, 

1026
component bond pads, 228

adding, 228
copying, 232
editing, 254
moving, 260

component object, 1589
Addlabel property, 2141
Application property, 1703
Attributes property, 1704
CBPs property, 1705
CenterX property, 1706
CenterY property, 1707
Decal property, 1708
DecalAttributes property, 1709
DecalCompatibleList property, 1710
DieHeight property, 1711
DieLength property, 1712

DieWidth property, 1713
ECORegistered property, 1727
Glued property, 1714
Installed property, 1715
ISDiePart property, 1716
ISSMD property, 1717
Labels property, 1718
Layer property, 1719
Move method, 2143
MoveCenter method, 2145
Name property, 1720
ObjectType property, 1722
Orientation property, 1723
Parent property, 1724
PartType property, 1725
PartTypeAttributes property, 1726
PartTypeLogic property, 1728
PartTypeObject property, 1729
Pins property, 1730
Placed property, 1731
PositionX property, 1732
PositionY property, 1733
SBPs property, 1734
Selected property, 1735
Substituted property, 1736
WirebondRulesAngleMaximum property, 

1737
WirebondRulesClearanceWireToPad 

property, 1738
WirebondRulesClearanceWireToWire 

property, 1739
WirebondRulesLengthMaximum property, 

1740
WirebondRulesLengthMinimum property, 

1741
Wirebonds property, 1742

Component Placement tab - DxDesigner Link, 
1148

Component property, 1678, 1857, 1965, 2016, 
2098

Component Rules dialog box, 1015
components, 514

defining rules for, 1015
flipping, 508
modifying, 514
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placement process, 501
Components property, 1770, 1955
concatenation, 2223
conditional rules, 1017

clearance rules, 2348
creating, 1017
high-speed rules, 2349

ConflictObject property, 1839
ConflictObjectDesc property, 1840
ConflictObjectType property, 1841
Conflicts property, 1816
connection function - canceling, 232
connection object, 1591

Application property, 1743
Length property, 1744
Name property, 1745
Net property, 1747
ObjectType property, 1748
Parent property, 1749
Pins property, 1750
RouteSegments property, 1751
Selected property, 1752
Vias property, 1753

connections, 685
adding, 228, 685
assigning copper to a net, 585
deleting, 252, 694
generating, 256
nets with planes, 654
renaming nets, 699

Connections property, 1771, 1903
Connector tab - Part Information dialog box, 

1376
constant e, 2269
constants, 1611, 1612, 1614, 1617, 1618, 1619, 

1620, 1621, 1622, 1623, 1624
PPcbASCIISections, 1611
PPcbASCIIVersion, 1611
PPcbAttrFlags, 1612
PPcbBondPadEdge, 1612
PPcbBondPadShape, 1612
PPcbDrawingType, 1614
PPcbDRCMode, 1614
PPcbErrorClass, 1614
PPcbErrorType, 1614

PPcbErrorValueType, 1617
PPcbGridType, 1617
PPcbHorizontalJustification, 1618
PPcbLabelDisplayMode, 1618
PPcbLabelType, 1618
PPcbLayerType, 1619
PPcbLibraryItemType, 1619
PPcbMeasureFormat, 1619
PPcbNudgeMode, 1620
PPcbObjectType, 1620
PPcbOriginType, 1621
PPcbOutlineType, 1622
PPcbPinElectricalType, 1622
PPcbRightReadingStatus, 1623
PPcbSegmentType, 1623
PPcbShapeType, 1623
PPcbTestPointType, 1624
PPcbUnit, 1624
PPcbVerticalJustification, 1624

continuity checking - plane connection, 755
Control, 2321
controlling, 373

net display, 1553
selections, 373, 374
thermals display, 593

converting, 601
existing designs to split plane designs, 601
trace corners to arcs, 644

copper operations, 577
assigning to a net, 585
assigning unique netnames, 577
associating with terminals, 175
creating cut outs, 578, 584
query/modify drafting objects, 552, 1134
shielding copper with vias, 661
via stitching, 675, 676

copper pour operations
Flood tab - Pour Manager dialog box, 1435
Hatch tab - Pour Manager dialog box, 1436
modifying settings, 1195
Plane Connect tab - Pour Manager dialog 

box, 1437
setting highest and lowest flood priority, 

585
copy and paste operations, 569
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component bond pads, 232
copy as bitmap, 569
existing parts, 693
existing reuses, 535
objects, 569
OLE objects, 837, 838
physical design reuses, 535
routes in BGA Toolkit, 233, 267
setting the origin for, 566
substrate bond pads, 233
trace patterns, 641

copy as bitmap, 569
corners, 648

adding to a bus, 608
adding to trace segments, 648

Cos, 2262
cosine, 2262
Count property, 1651, 1670, 1922
CreateLibrary property, 2113
CreateNewDocument, 2309
CreateObject, 2263
Creating

macros, 107
scripts, 825

creating, 211, 277
a netlist, 321
arcs, 632
attribute labels, 188
attributes, 427, 439, 932, 934
backup files, 421
BGA/PGA decals, 1045
board outlines, 343
chained dimensions, 762
classes, 885
copies of existing parts in ECO mode, 693
copper pour areas, 583
cut outs, 344, 578, 584, 598
design rules, 929, 1213, 1469
die flags and rings, 235
dies, 236, 237, 238, 269, 1030
embedded planes, 597
groups, 559, 896
keepouts, 192, 497
miters, 632
new files, 277

physical design reuses, 531
placeholder labels, 190
plane areas, 589, 590
reports, 717, 1456
route loops, 642
slotted holes, 182
test point ASCII files, 722
unions, 515
wire bond connection report, 239
wire bond fanouts, 239

creating a .do file, 856, 1499
creating objects, 2263
Creating Terminals, 2391, 2418
creating wrapper classes, 1575
cross-probing, 279

between DxDesigner and PADS Layout, 
279, 300

between PADS Logic and PADS Layout, 
279

CurDir, 2264
current path, 2264
current routing width, 565
customize modal dialog box, 2314
customizing

menus, 119
shortcut keys, 125
toolbars, 116

customizing attribute units, 451
cut out

moving, 346
cut outs, 598

board cut outs, 344
copper cut outs, 578, 584
plane, 598

cutting objects, 569
cycle picking, 374
cycle via pattern, 608
cycling, 374

cycle picking, 374
substrate bond pads, 240
through wire bonds, 240

— D —
database, 845

error checking, 844, 845
integrity, 845, 847
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Debugging, 110, 831
Decal Editor, 1206, 1399, 1461

adding terminals, 182, 900
adding vias for routing rules, 1461
associating copper with terminals, 175
autodimensioning in, 1399
creating attribute labels in, 188
creating BGA/PGA, 1045
creating placeholder labels, 190
defining antipads in, 178
defining thermals in, 178
deleting terminals, 174
die part decals - modifying, 254
modifying keepouts in, 193
moving the decal name, 174
opening a decal in, 1206
Query/Modify Decal Label dialog box, 

190, 1039
Query/Modify Terminal Numbers dialog 

box, 170, 1524
renumber terminals, 172, 1453
step and repeat, 1510
swap terminal numbers, 171

Decal Editor Decal Rules dialog box, 1461
Decal labels

Query/Modify, 190, 1039
Decal property, 1708
Decal Rules dialog box, 1043
DecalAttributes property, 1709
DecalCompatibleList property, 1710
Decals

listing, 157
decals, 224, 1043, 1383, 1476

assigning alternates to gates, 1383
defining rules for, 1043
saving to the library, 224, 1476

declares variables, 2237
default, 280, 1507

attributes - setting, 450
design rules, 1073
start-up settings, 280, 1507

DefaultFilePath property, 1639
defining, 792, 1074

die outlines, 240, 241, 242
functions for pads, 245, 247

NC drill options, 1278
number of CBPs, 248
numbering of CBPs, 250
plot options, 1430
preferences for die components, 248
sets of CBPs, 243
thermals and antipads in the Decal Editor, 

178
wire bond rules, 251

defining a document, 792, 1074
Delete method, 2127, 2134, 2171, 2189
deleting, 117, 558

attributes, 427, 439, 932, 934
bond pads, 252
connections, 252, 694
corners, 652
dangling routes, 647
decal assignments, 1383
differential pair, 493, 1117
dimensions, 768
drafting segments, 558
drill drawing entry in table, 803, 1139
groups, 1208
library attributes, 150, 1261
loops, 639
miters from paths, 653
net classes, 980
nets, 252, 696
nets from a class, 980
OLE objects, 839
parts, 694
physical design reuses, 541
pin pairs from a group, 1208
routes from pin pairs, 654
stitching vias, 649
terminals, 174
trace segments, 643
unions and members, 515
via pad stacks, 394
vias, 653
wire bonds, 253

Derive SBP Function from Netlist dialog box, 
1080

deriving net names from pin functions, 253
Description property, 1817
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design extents - zooming to, 336
design rules, 232, 251, 257

class, 459, 980
clearance, 985
clearance and checking after routing, 664
component, 1015
conditional rules, 1017
creating classes, 459, 980
creating groups, 1208
decal, 1043
default, 1073
differential pairs, 493, 1117
displaying, 495
fanout, 1187
group, 1208
high speed, 1211
in ECO, 2347
net, 464, 1291
pad entry, 1351
pin pair, 1419
reporting, 494, 1471
routing, 1461
Rules dialog box, 1471
setup, 929, 1213, 1469
verifying, 735, 1543
wire bonds, 232, 251, 257

Design tab - Options dialog box, 1297
design verification, 735, 1543

Clearance Check Setup dialog box, 742, 
982

EDC, 748, 1179
error markers, 735, 1543
Fabrication Checking Setup dialog box, 

745, 1184
full plane check setup, 753, 1268
using, 735, 1543
viewing the errors, 735, 1543

DFT Audit, 726
placing test points, 724, 1083
probing top side only, 726
process flow, 722
setting test point assignment eligibility, 

725, 1082
setting test point properties, 724, 1086
test point audit, 723

test point checking with ASCII, 721
dialog box control, 2321
dialog box message, 2279
dialog objects, 2319

CloseHelpPane, 2322
Control, 2321
Focus, 2320
OpenHelpPane, 2323
ShowHelpFor, 2324

Die Component tab - Preferences dialog box, 
1302

Die Flag Wizard dialog box, 1088
die parts, 229

adding, 229, 881
editing, 274
importing from Library IQ, 229
Synchronize Die Part dialog box, 1515
synchronizing, 268
update Library IQ, 271
updating in BGAs, 268

die pins, 253
die preview colors, 265, 1116
die size, 255

Edit Die Size dialog box, 1178
editing, 255, 1178

Die Wizard Preview Colors dialog box, 1116
Die Wizard-Create from GDSII File dialog box

CBP tab, 1091
Die Wizard-Create from Text File dialog box

CBP tab, 1100
Die Wizard-Create Parametrically dialog box

CBP tab, 1107
DieHeight property, 1711
DieLength property, 1712
DieWidth property, 1713
difference, 2225
differential pairs, 493, 1117

defining new pairs, 493, 1117
deleting, 493, 1117
rules for, 493, 1117
working with, 2349

Dim, 2237
dimensions, 757

aligned, 758
an angle, 758
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arcs and circles, 758
horizontally, 758
scaling, 758
vertically, 758
with automatic orientation, 758
with off-angle rotation, 758

DIP Wizard tab - Pin Wizards dialog box, 1050
Dir, 2265
directory, 2265
disabling layers, 387, 600
disabling nonelectrical layers, 1181
discarding plane data, 1123
display

making objects invisible in, 416
making pin numbers visible in, 417, 418

display colors
setup of, 414

Display Colors Setup dialog box, 1125
Display property, 1858
display-formatted data, 2248
displaying, 615

connections, 600
display colors setup, 1125
nets, 1553
setting the display grid, 422

Displaying a document, 2335
displaying layers, 387
divide, 2224, 2230
dividing numbers, 2224, 2230
Do...Loop statement, 2238
document, 2324
document object, 1592

Activate method, 2146
ActiveView property, 1763
AddText method, 2147
Application property, 1764
AssemblyOptions property, 1765
Attributes property, 1768
BoardOutlineSurface property, 1769
CheckASCII method, 2148
Components property, 1770
Connections property, 1771
Drawings property, 1772
ElectricalLayerCount property, 1773
Errors property, 1774

ExportASCII method, 2149
ExportNetList method, 2151
ExportRules method, 2152
FullName property, 1775
GetObjects method, 2154
GridX property, 1776
GridY property, 1777
ImportECOFile method, 2158
ImportNetList method, 2159
Jumpers property, 1778
LayerCount property, 1779
LayerEnabled property, 1780
LayerName property, 1781
LayerType property, 1784
MaxRealValue property, 1785
MinRealValue property, 1786
Name property, 1787
NetClasses property, 1788
Nets property, 1789
ObjectType property, 1790
OriginX property, 1791
OriginY property, 1792
Parent property, 1793
PartTypes property, 1794
Path property, 1795
Pins property, 1796
PositionsChange event, 2201
Preference property, 1797
RouteSegments property, 1798
Save event, 2202
Save method, 2161
SaveAs method, 2162
Saved property, 1799
SecurityLimit event, 2200
SelectionChange event, 2203
SelectObjects method, 2167
Texts property, 1800
Unit property, 1801
Vias property, 1802

Document tab - DxDesigner Link, 1144
Document.ExportECOFile method, 2150
Document.ObjectType property, 1790
documents - CAM, 792, 1074
DoEvents, 2266
double, 2218
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down arrow on pin, 2417
down arrow on via, 2417
drafting operations, 545

adding drafting items to a library, 564
adding objects, 543, 544, 545
adding text, 546, 883
creating a board cut out, 344
creating a board outline, 343
creating and flooding a copper pour area, 

583
deleting segments, 558
Drafting / Hatch and Flood Page, 1312
Drafting / Text and Lines Page, 1313
Drafting Objects Properties dialog box, 

552, 1134
modify drafting corners, 552, 1131
modify drafting edges, 552, 1132
modifying copper pour and plane settings, 

1195
moving drafting objects, 551
moving miters, 557
pulling an arc from a drafting segment, 558
saving a drafting item to a library, 564
setting flood priorities, 585

drag and attach, 504
drag and drop, 504
drawing object, 1594

Application property, 1803
DrawingType property, 1804
Geometry property, 1805
Name property, 1806
Net property, 1807
ObjectType property, 1808
Parent property, 1809
PositionX property, 1810
PositionY property, 1811
Selected property, 1812
Texts property, 1813

Drawing property, 2031
Drawings property, 1772, 1904
DrawingType property, 1804
DRE, 606
drill chart - defining, 803, 1139
Drill Drawing Options dialog box, 803, 1139
drill pairs, 391

drill pairs setup, 1143
drill sizes and symbols for DXF, 1491
DrillSize property, 1966, 2064
drop, 2306
DxDesigner, 311
DxDesigner Link, 301

annotation preferences for, 1149
Backward Annotation dialog box, 945
comparing designs, 301
connecting to DxDesigner, 1144
Document tab, 1144
Forward Annotation dialog box, 1199

DxDesigner Link dialog box, 1149
library tab, 1147
placement tab, 1148
preferences tab, 1149
selection tab, 1152
setting up cross-probing, 1152

DXF, 1164
drill sizes and symbols, 1491
exporting, 1156
importing, 1164

DXF Export dialog box, 1156
DXF Import dialog box, 1164
Dynamic Route Editor (DRE), 606

in BGAs, 273

— E —
e (the base of natural logarithms), 2269
ECL terminator - automatic swapping, 699
ECO

backward from PCB, 328
ECO operations, 311

adding components from a library, 687
adding pin pairs, 685
automatic ECL terminator swapping, 699
automatic part renumbering, 689
backward annotation, 311
changing part types, 690
creating copies of existing parts, 693
deleting connections, 694
deleting nets, 696
deleting parts, 694
example file, 2354
Get Part Type from Library dialog box, 

1204
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preferences, 1171
renaming nets, 699
rules format, 2347
swapping gates, 700, 701, 702
swapping pins, 703, 704
updating a schematic from PADS Layout, 

311
ECOGEN, 711

in DOS, 711
ECORegistered property, 1727
EDC Checking, 748, 1179

saving and retrieving high speed settings, 
748, 1179

setting parameters, 750, 1174
edge preference, 763
Edge property, 1679
Edit, 2292
Edit Die Size dialog box, 1178
EditBox, 2294
editing, 274, 371

attribute labels, 528, 1394
attribute values, 427, 439, 932, 934
attributes, 427, 439, 445, 932, 934, 1293, 

1295
basics of, 371
CBPs - component bond pads, 254
classes of nets, 980
component pad stacks, 179
decals in BGAs, 254
die parts, 274
die sizes, 255, 1178
documents, 797, 874
groups of pin pairs, 1208
in-place visual editing, 840
library parts, 1380
logic families, 1258
OLE links, 839
OLE objects, 837, 840
pad stacks, 180, 181
physical design reuse definitions, 539
routes, 637
SBPs - substrate bond pads, 255
summaries, 439, 444, 934, 1497
via pad stacks, 394
wire bonds, 256

electrical layers - modifying, 384, 1451
ElectricalLayerCount property, 1773
ElectricalType property, 1967
Electrodynamic Check dialog box, 748, 1179
electrodynamic checking, 748, 1179
embedded planes, 597
empty document, 2309
Enable/Disable Layers dialog box, 1181
enabling layers, 387, 1181
end of file, 2268
End Via Mode, 617
ending, 635

bus connections, 608
guide routes, 608
traces, 635

EndLayer property, 2065
EndOffsetX property, 2099
EndOffsetY property, 2100
EndPad property, 2101
EndX property, 2102
EndY property, 2103
Environ, 2267
environment variable, 2267
EOF, 2268
equal to, 2229
error markers, 735, 1543
error messages

from pasting a group, 1530
recovering from database problems, 844

Error object, 1595, 1596
error object

ActualValue property, 1814
Application property, 1815
Conflicts property, 1816
Description property, 1817
ErrorClass property, 1818
ErrorType property, 1819
HasActualValue property, 1820
HasRequiredValue property, 1821
IsClearanceError property, 1822
IsConnectivityError property, 1823, 1829
IsHighSpeedError property, 1824
IsIgnoredFlag property, 1825
IsInvisibleFlag property, 1826
IsLatiumError property, 1827
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IsMiscError property, 1828
LayerNumber property, 1830
Name property, 1831
ObjectType property, 1832
Parent property, 1833
PositionX property, 1834
PositionY property, 1835
RequiredValueMax property, 1836
RequiredValueMin property, 1837

ErrorClass property, 1818
ErrorConflict object

Application property, 1838
ConflictObject property, 1839
ConflictObjectDesc property, 1840
ConflictObjectType property, 1841
Name property, 1842
ObjectType property, 1843
Parent property, 1844

errors, 735, 1543
viewing, 735, 1543

Errors property, 1774
ErrorType property, 1819
Events (Automation), 2197

Application.OpenDocument, 2197
Application.ProgressChange, 2198
Application.Quit, 2199
Document.PositionsChange, 2201
Document.Save, 2202
Document.SecurityLimit, 2200
Document.SelectionChange, 2203
View.Change, 2204

examples, 2354
bus routing examples, 608
ECO file, 2354

execute statements, 2255
ExecuteCommand, 2310
Exit Do statement, 2238
Exit For statement, 2239
exiting Set Origin mode, 502
exiting the application, 2318
Exp, 2269
expand, 2304
exploding combined objects, 560
exponent, 2227
exponentiation, 2227

ExportASCII method, 2149
ExportECOFile method, 2150
exporting, 311, 349, 350

.liq files, 268
ASCII, 353, 916
changes to schematic, 311
DXF, 1156
IDF, 359, 1216
ODB++, 1295
OLE files, 355
to mechanical design systems, 359, 1216

ExportLibraryItems method, 2114
ExportNetList method, 2151
ExportRules method, 2152
expressions, 158, 2219
extension lines, 758, 766

— F —
Fabrication Checking Setup dialog box, 745, 

1184
Fanout Rules dialog box, 1187
fanout workflow, 275
fatal database errors, 844
file I/O, 2247
file input/output, 2247
files, 284

creating, 277
exporting, 349, 350
formats, 269
importing, 349, 350
opening, 281
saving, 284, 841

filtering with wildcards, 158
Find commands, 1190

commands for find by, 376
find by pour area and isolated pour, 376
find by test points, 376
find by thermal type, 376
Find dialog box, 1190
using during placement, 503

Find dialog box, 1190
finding, 376, 378, 379

by attribute, 376
by isolated pour, 379
by keepout, 376
by physical design reuse, 378
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by pour area, 379
by test point type, 378
specific nets, 614
thermal attributes, 379

flip side, 508
Flood tab - Pour Manager dialog box, 1435
flooding

copper pour areas, 583
Flood tab - Pour Manager dialog box, 1435
flood-over pads for split/mixed planes, 600
Pad Stacks, 600
setting priorities, 585
split/mixed plane, 600

flow, 95
Focus, 2320

TreeItem, 2304
folder, 2265

Dir, 2265
MkDir, 2277

For-Next statement, 2239
Forward Annotation dialog box, 1199
free vias, 649
full screen mode, 2338
FullName property, 1640, 1775, 1878
FullScreen, 2338
Function property, 1680, 2017
FunctionName property, 1968

— G —
gate level backward annotation, 332
gates, 217, 700, 701, 924, 1378

assigning alternate decals to, 217, 924, 
1378

automatic swapping, 702
manual swapping, 700, 701

Gates tab - Part Information dialog box, 1378
general clearance rules, 2350
General tab - Part Information dialog box, 1380
generating reports, 717, 1456
Geometry property, 1695, 1805
Gerber, 1409
Get Drafting Item From Library dialog box, 

1203
Get Part Type from Library dialog box, 1204
GetLibraryItems method, 2180
GetObject, 2270

CreateObject, 2263
GetObjects method, 2154
GetTmpFileName, 2271
Global page - Options dialog box, 1317
Glued property, 1714, 1969, 2066
Graphical Selection mode, 275
gray-scales in printing, 815
greater than, 2229
greater than or equal to, 2229
GridControl, 2296
grids, 422
Grids tab - Preferences dialog box, 1325
GridX property, 1776
GridY property, 1777
group operations, 1208

combining line and text objects, 559
defining, 1208
deleting, 1208
error messages from pasting a group, 1530
exploding, 560
flipping, 508
rules report, 717, 1456
uncombining, 560

groups, 1208
GUI controls

editing basics, 371
modeless commands, 102, 1269
Outline View mode, 381
start-up default settings, 280, 1507
trace width area, 565
Transparent View mode, 380

— H —
HasActualValue property, 1820
HasRequiredValue property, 1821
Hatch tab - Pour Manager dialog box, 1436
Height property, 2032
Help, 2311

on Basic language, 832
Help Contents item, 2329
Help window, 2335
HelpContents Object, 2329
HelpContentsItem Object, 2329
HelpPane, 2313
HelpPane Object, 2335
hiding layers, 387
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hiding reference designators, 681
hierarchy of attributes - modifying, 436, 935
high speed checking, 748, 1179

conditional rules, 2349
general rules, 2351
High Speed Rules dialog box, 1211
retrieving settings, 748, 1179
saving settings, 748, 1179
setting parameters, 750, 1174

highlighting objects, 380
holes - slotted, 181
horizontal dimensioning, 758
HorzJustification property, 2033
HyperLynx, 961

— I —
I/O, 2236
IDF, 358, 1219

exporting, 359, 360, 1216
IDF Export dialog box, 359, 1216
IDF Import dialog box, 358, 1219
importing, 358, 1219
part height information, 361

If...Then...Else statement, 2243
illegal netnames, 705
illegal part names, 705
ImportECOFile method, 2158
importing, 349

ASCII files, 352
CADSTAR files, 364
die parts from Library IQ, 229
DXF files, 1164
IDF files, 358, 1219
OLE files, 354
OrCAD files, 365
P-CAD files, 363
Protel files, 362, 363
SBP functions, 257

ImportLibraryItems method, 2181
ImportLibraryItems2 method, 2182
ImportNetList method, 2159
increasing maximum layer number, 383
input/output, 2236
Insert Object dialog box, 835
Installed Options dialog box, 83, 85, 1221, 

1223

License File tab, 85, 1221
Options tab, 83, 1223

Installed property, 1715, 1846
InStr, 2272
InStrRev function, 2273
intensity, 663
internal macro objects, 2308
introduction to automation, 1571
IsClearanceError property, 1822
IsConnectivityError property, 1823, 1829
IsDiePart property, 1716
IsHighSpeedError property, 1824
IsIgnoredFlag property, 1825
IsInvisibleFlag property, 1826
IsLatiumError property, 1827
IsMiscError property, 1828
isolated stitching vias

checking for, 743, 1020
selection of, 375

IsSMD property, 1717, 1971
Item property, 1652, 1671, 1923
item, method, 2306
Item.Location, 2331
Item.Name, 2332
Item.Select, 2333
item-to-item clearance, 571
ItemType property, 1653, 1672, 1924

— J —
JEDEC Array Pinning dialog box, 1225
JEDEC pinning - assigning to a decal, 169
jumper object, 1596

Application property, 1845
Installed property, 1846
Length property, 1847
Name property, 1848
Net property, 1849
ObjectType property, 1850
Orientation property, 1851
Parent property, 1852
Points property, 1853
Selected property, 1854

jumpers, 624
Jumpers dialog box, 626, 1235
modifying, 628, 629
Query/Modify Jumper dialog box, 1232
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Query/Modify Jumper Name dialog box, 
1226

Query/Modify Jumper Pin dialog box, 1230
using, 624

Jumpers property, 1778

— K —
keepouts, 192, 497, 855

creating, 192, 497
modifying, 192, 193, 497
overview, 192, 497
passing to SPECCTRA, 855

— L —
label object, 1596

Application property, 1855
Attribute property, 1856
Component property, 1857
Delete method, 2171
Display property, 1858
Height property, 2032
HorzJustification property, 2033
Layer property, 2034
LineWidth property, 2035
Mirror property, 2036
Name property, 1859
ObjectType property, 1860
Orientation property, 2039
Parent property, 1861
PositionX property, 2041
PositionY property, 2042
RightReading property, 1862
Selected property, 1863
Text property, 1864
Type property, 1865
VertJustification property, 2045

labels, 549
adding new part labels, 525, 891
creating, 188, 190
modifying, 530
moving, 549
predefining a label position, 190

Labels property, 1718
Latium checking dialog box, 743, 1243
layer associations, 1006

between component and documentation 
layers, 1006

Layer property, 1681, 1696, 1719, 1993, 2003, 
2018, 2034

Layer Thickness dialog box, 388, 1245
LayerCount property, 1779
LayerEnabled property, 1780
LayerName property, 1781
LayerNumber property, 1830
layers, 383, 389, 1181, 1247, 1461

assigning colors to objects, 418
assigning layer thickness, 388, 1245
associations, 1006
changing while routing, 633
disabling, 387, 1181
displaying, 387
enabling, 387, 1181
hiding, 387
increasing electrical layers, 384
increasing maximum layer number, 383
Layers Setup dialog box, 1247
reassigning electrical layers, 389, 1451
restrict nets and pin pairs, 1461
selecting a starting layer for a trace, 631
selecting for CAM output, 800, 1484
setting up, 383
unrestricting, 1461

Layers Setup dialog box, 1247
LayerType property, 1784
leader lines, 758
Left function, 2274
Len function, 2275
length minimization, 502
Length property, 1682, 1744, 1847, 1905, 

2004, 2019
less than, 2229
less than or equal to, 2229
libraries, 224, 1254, 1476

attributes, 150, 1261
creating, 1254
editing, 1254
exporting and importing, 153
library list, 147, 1253
reporting parts in, 155
saving part types and decals to, 224, 1476
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search options, 147, 1253
search order, 147, 1253

Libraries property, 1641
Library Manager, 147, 150, 153, 1253, 1254, 

1261
adding attributes, 964
adding components, 687
adding drafting items, 564
adding new attributes, 150, 1261
assigning decals to gates, 217, 924
connectors, 1376
deleting attributes, 150, 1261
editing general part properties, 1380
editing logic families, 1258
editing parts, 1254
get part type from library, 1204
Library Manager dialog box, 1254
loading attributes from library, 427, 932
managing attributes, 150, 1261
modifying alphanumeric pins, 1392
modifying gate settings, 1378
modifying part attributes, 1374
modifying PCB Decals, 1383
modifying the library list order, 147, 1253
Part Information dialog box, 211, 216
renaming library attributes, 150, 1261
Report Manager, 155
save part types and decals to library, 224, 

1476
library object, 1598

Application property, 1877
FullName property, 1878
GetLibraryItems method, 2180
ImportLibraryItems method, 2181
ImportLibraryItems2 method, 2182
Name property, 1879
ObjectType property, 1880
Parent property, 1881
Path property, 1882

Library property, 1884
Library tab - DxDesigner Link, 1147
libraryitem object, 1598

Application property, 1883
Library property, 1884
Name property, 1885

ObjectType property, 1886
Parent property, 1887
Type property, 1888

license files, 85, 87, 1221
line and text objects - combining, 559
linear step and repeat, 1510
Lines

listing, 157
LineWidth property, 1697, 1994, 2035
linking and embedding, 835

objects in PADS Layout, 835
list box, 2297
list property, 2292

ComboBox, 2292
List box, 2297

ListBox, 2297
ListCount property, 2290

CheckListBox, 2290
ListBox, 2297

listing all BGA pin labels, 257
listing specific BGA pin labels, 258
loading, 850, 851, 1502

automatic, 850, 1502
manual, 851

loading attributes from library, 427, 932
Location, 2331
LockServer method, 2118
Logic Family dialog box, 1258
Logic symbols

listing, 157
logical conjunction, 2228
logical disjunction, 2232
logical exclusion, 2233
logical negation, 2231
loops, 639

trace, 1531
loops in routing - creating, 642

— M —
macro language introduction, 112
Macro tab, Output window, 1349
Macros, 108

creating, 107
debugging, 110
managing, 108
playing back, 110
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macros
creating commands from

commands
creating from macro files, 129

creating shortcut keys for, 128
MainView, 2335
make like reuse, 536, 537, 538
Make Reuse dialog box, 1259
making objects visible, 415
Manage Library Attributes dialog box, 150, 

1261
Managing

macros, 108
scripts, 828
session logs, 104

Manual Bus Route mode, 608
manual routing, 606
maximum layer number, 383
maximum number of vias, 1461
MaxRealValue property, 1785
Measure method, 2119
measure object, 1599

Application property, 1889
Name property, 1890
Normalize method, 1892
Number property, 1891
Object Type property, 1893
Parent property, 1894
Prefix property, 1895
Text property, 1896
Unit property, 1897
Value property, 1898

Measure property, 2138
measurement

quick measure dynamic ruler, 1271
using quick measure, 381

mechanical design systems, 359, 1216
exporting to, 359, 1216
importing from, 358, 1219

menu items
creating, 119

menus
creating commands for, 119
customizing, 129
removing items from, 124

Merge method, 2128, 2184
message, 2279
Methods (automation), 2117, 2180

Application.ExportLibraryItems, 2114
Application.GetLibraryItems, 2117
Application.LockServer, 2118
Application.Measure, 2119
Application.OpenDocument, 2120
Application.Quit, 2123
Application.RunMacro, 2124
Application.UnlockServer, 2125
AssemblyOptions.Add, 2126
AssemblyOptions.Delete, 2127
AssemblyOptions.Merge, 2128
AssemblyOptions.Remove, 2129
AssemblyOptions.Reset, 2130
AssemblyOptions.Select, 2131
AssemblyOptions.Sort, 2132
Attributes.Add, 2133
Attributes.Delete, 2134
Attributes.Merge, 2135
Attributes.Remove, 2136
Attributes.Reset, 2137
Attributes.Select, 2139
Attributes.Sort, 2140
Component.Move, 2143
Component.MoveCenter, 2145
Document.Activate, 2146
Document.AddText, 2147
Document.CheckASCII, 2148
Document.ExportASCII, 2149
Document.ExportECOFile, 2150
Document.ExportNetList, 2151
Document.ExportRules, 2152
Document.GetObjects, 2154
Document.ImportECOFile, 2158
Document.ImportNetList, 2159
Document.Save, 2161
Document.SaveAs, 2162
Document.SelectObjects, 2167
Label.Delete, 2171
Library.GetLibraryItems, 2180
Library.ImportLibraryItems, 2181
Library.ImportLibraryItems2, 2182
Object.Reset, 2186
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Objects.Add, 2183
Objects.Merge, 2184
Objects.Select, 2187
Objects.Sort, 2188
Text.Delete, 2189
View.Pan, 2190
View.Refresh, 2191
View.SetExtents, 2192
View.SetExtentsToAll, 2193
View.SetExtentsToBoard, 2194
View.SetScale, 2196

Mid function, 2276
MinRealValue property, 1786
Mirror property, 2036
mirroring text, 549
miters, 632

creating, 632
deleting from paths, 653
in routes, 632
moving, 557
stretching, 645

MkDir, 2277
Mod, 2230
modeless commands, 102, 1269
modifying, 528, 1394

arrays, 509
attribute hierarchy, 436, 439, 934, 935
attributes, 187, 1374
CBPs, 258, 259
die outlines, 240
electrical layer count, 384
keepouts, 193
labels, 528, 1394
library list order, 147, 1253
nets, 657
physical design reuse, 539
pin pairs, 657
routes, 637
signal names, 1387
teardrops, 620, 1520
unions, 515

modifying pour and plane areas, 1195
modulus operator, 2230
mouse, 335

using to pan, 335

using to zoom, 337
wheel, 335, 338

mouse button press, 2339
mouse button release, 2343
mouse down, 2339
mouse drag operation, 2341

MouseEndDrag, 2340
MouseStartDrag, 2342

mouse end drag, 2340
mouse move, 2341
mouse movement, 2341
mouse start drag, 2342
mouse up, 2343
MouseDown, 2339
MouseEndDrag, 2340
MouseMove, 2341
MouseStartDrag, 2342
MouseUp, 2343
move file, 2278
Move method, 2143
MoveCenter method, 2145
MoveFile, 2278
moving, 503

board cut out, 346
bond pads, 260
component arrays, 509
components, 503
corners, 646
decal names, 174
die component substrate bond pads, 261
dimension arrows, 766
dimension objects, 766
dimension text, 766
drafting objects, 551
extension lines, 766
labels, 549
leader segments, 766
miters, 557
OLE objects, 838
overlapping parts, 512
physical design reuses, 542
radially, 505
reference designators, 680
sequentially, 503, 506
tacks or vias, 647
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text, 549
trace segments, 642
vias or tacks, 647
with drag and attach, 504
with drag and drop, 504

MsgBox, 2279
multiply, 2222

— N —
Name, 2332
Name property, 1642, 1664, 1683, 1720, 1745, 

1787, 1806, 1831, 1842, 1848, 1859, 
1879, 1885, 1890, 1906, 1917, 1958, 
1972, 2005, 2020, 2037, 2068, 2088, 
2104

NC Drill device setup, 1279
NC Drill options, 1278
negative value, 2225
net classes in ECO, 980, 2352
net level backward annotation, 332
net object, 1599

Application property, 1900
Attributes property, 1902
Connections property, 1903
Drawings property, 1904
Length property, 1905
Name property, 1906
NetClass property, 1907
NetClassAttributes property, 1908
ObjectType property, 1909
Parent property, 1910
Pins property, 1911
Power property, 1912
Selected property, 1913
Vias property, 1914

Net Properties dialog box, 1289
Net property, 1747, 1807, 1849, 1974, 2007, 

2070
Net Rules dialog box, 1291
netclass object, 1600

Application property, 1915
Attributes property, 1916
Name property, 1917
Nets property, 1918
ObjectType property, 1919
Parent property, 1920

NetClass property, 1907
NetClassAttributes property, 1908
NetClasses property, 1788
netlist, 321

creating a new, 321
netname unassignment, 389
nets, 263, 614, 705

adding to a class, 980
allow vias by net, 464, 1291
assigning color to, 614
assigning copper to, 585
associating to a plane, 592
connecting with a plane, 654
creating a class, 459, 980
defining rules, 464, 1291
deleting, 252, 696, 980
determining which vias are allowed, 1461
displaying, 1553
ending a trace on a different net, 635
illegal characters in names, 705
modifying, 657, 1283
renaming, 263, 539, 699
restricting to certain layers, 1461
selecting classes from, 459, 980
selecting pin pairs from, 1208
shielding with vias, 661

Nets property, 1789, 1918
net-to-item clearance, 572
net-to-net clearance, 571
new directory, 2277
new filename, 2271
new files, 277

creating, 277
Set Start-up File dialog box, 281, 1490

new folder, 2277
Next property, 1654, 1673, 1925
nonelectrical layers, 1181
non-plated drill size, 803, 1139
Normalize property, 1892
not equal to, 2229
Not operator, 2231
nudge, 1293

Nudge dialog box, 1293
nudging, 512
outline checking, 742, 982
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number of layers, 384
Number property, 1891, 1975
numeric expression, 2219
numeric value, 2218

— O —
object, 2219
Object Attributes dialog box, 445, 1293, 1295
object hierarchy, 1572
Object mode, 371
object reference, 2252
objects, 380, 415, 569, 570

applying a value from one to all others of 
the same type, 439, 445, 934, 1293, 
1295

colors of, 414
copying, 569
cutting, 569
display of, 416
highlighting, 380
making invisible, 416
making visible, 415
pasting, 570
spinning, 511

objects object, 1600
Add method, 2183
Application property, 1921
Count property, 1922
Item property, 1923
ItemType property, 1924
Merge method, 2184
Next property, 1925
ObjectType property, 1926
Parent property, 1927
ParentObject property, 1928
Remove method, 2185
Reset method, 2186
Select method, 2187
Sort method, 2188

Objects tab - Attribute Properties dialog box, 
436, 935

ObjectType property, 1643, 1655, 1665, 1674, 
1684, 1698, 1722, 1748, 1808, 1832, 
1843, 1850, 1860, 1880, 1886, 1909, 
1919, 1926, 1960, 1976, 1995, 2008, 
2021, 2038, 2071, 2089, 2105

offset pads, 1352
OLE, 837, 1571

changing the background color, 838
copying objects, 837
deleting objects, 839
editing links, 839
editing OLE objects, 837, 840
importing and exporting OLE objects, 354, 

355
linking and embedding, 835
moving objects, 838
OLE automation, 1571
OLE background, 1571
pasting objects, 838
saving objects, 841
selecting objects, 836
visual editing, 840

Open statement, 2236, 2247
OpenCustomizeDialog, 2314
OpenDocument, 2315

Application, 2308
OpenDocument event, 2197
OpenDocument method, 2120
opening, 281

decals, 1206
files, 281

OpenOptionsDialog, 2316
OpenPropertiesDialog, 2317
operator, 2220, 2221, 2246

- operator, 2225
^ operator, 2227
* operator, 2222
/ operator, 2224
&amp\, 2221, 2246
+ operator, 2223
= operator, 2226
And operator, 2228
comparison operators, 2229
Mod operator, 2230
Not operator, 2231
Or operator, 2232
Xor operator, 2233

options - licensing, 83, 85, 1221, 1223
Options modeless dialog box, 2316
Options/Substitute dialog box, 807, 1542
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Or operator, 2232
OrCAD

importing, 365
Orientation property, 1723, 1851, 2022, 2039
origin, 566
OriginX property, 1791
OriginY property, 1792
Outline mode, 660
Outline View mode, 381
outlines, 513

changing part outline width, 513
checking - nudge, 742, 982

OutlineType property, 1699, 1996
output .do file settings, 849, 1493
Output window

Macro tab, 1349
Status tab, 905, 1348

— P —
packaging file, 1144
pad entry angle, 641
Pad Entry Rules dialog box, 1351
pad stacks, 1363

allow vias by net, 464, 1291
deleting, 394
editing, 179, 180, 394
for vias, 391, 392, 393
in the Decal Editor, 1363
making changes locally versus at the decal 

level, 181
Query/Modify Pad Stacks dialog box, 1352

Pads for Die Pin dialog box, 1367
PADS Router link, 662, 1368, 1370, 1372

monitor, 1370, 1372
overview, 662, 1368
Routing Strategy dialog box, 1465

PADS Router, switching to, 99
PADS-Designer (see DxDesigner Link), 301
Pan method, 2190
panning, 335

using the mouse, 335
using the wheel, 335

parameters, 750, 854, 1174, 1505

Parent property, 1644, 1656, 1666, 1675, 1685, 
1700, 1724, 1749, 1793, 1809, 1833, 
1844, 1852, 1861, 1881, 1887, 1894, 
1910, 1920, 1961, 1979, 1997, 2009, 
2023, 2040, 2073, 2090, 2106

ParentObject property, 1657, 1676, 1928
part editor, 147, 1253
Part Editor operations

updating pins from library, 199, 1538
Part Information dialog box, 211, 216

Alphanumeric Pins tab, 1392
Attributes tab, 1374
Connector tab, 1376
Gates tab, 1378
General tab, 1380
PCB Decals tab, 1383
Signal Pins tab, 1387

part labels, 525, 891
part level backward annotation, 331
Part Operations

adding components from a library, 687
adding parts in BGA Toolkit, 230
automatic part renumbering, 689
changing part type, 690
copying existing parts, 693
creating component arrays, 509
deleting parts, 694
editing component pad stacks, 179
modifying part types, 690
Query/Modify Pin dialog box, 1421
query/modify pin pairs, 657, 1416
Query/Modify Terminal Numbers dialog 

box, 170, 1524
Query/Modify Terminals dialog box, 169, 

1525
renaming in a reuse, 539
saving to the library, 224, 1476
swapping pins, 512

part outlines - setting, 360
part type

modifying, 216
new, 211

part types
creating, 211
modifying, 211
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partial vias, 393
parts, 705

aligning, 510
automatically renumbering, 689
illegal characters in names, 705
moving overlapping, 512
swapping, 512

parttype object, 1603
Application property, 1953
Attributes property, 1954
Components property, 1955
ECO Registered property, 1956
Logic property, 1957
Name property, 1958
ObjectType property, 1960
Parent property, 1961
Selected property, 1962

PartType property, 1725
PartTypeAttributes property, 1726
PartTypeECO Registered property, 1956
PartTypeLogic property, 1728, 1957
PartTypeObject property, 1729
PartTypes property, 1794
Passing control to the operating system, 2266
passing keepouts (to SPECCTRA), 855
passing maximum number of vias (to 

SPECCTRA), 849
pasting, 569

copy as bitmap, 569
paste buffer, 566
pasting objects, 570, 838

Path property, 1795, 1882
pathname, 2265
P-CAD

importing, 363
PCB Back, 311
PCB Decals tab - Part Information dialog box, 

1383
pen plotter, 1408

advanced setup, 1406
basic setup, 1408

PGA decals - creating, 1045
photo plotter, 818, 1413

advanced setup, 1409
aperture setup, 818, 1413

physical design reuse, 533
adding, 533, 535
breaking, 541
creating, 531
deleting, 541
editing the definition, 539
make like reuse, 537, 538, 1259
modifying, 539, 1457
moving, 542
Net Properties dialog box, 1289
reporting content of, 542
saving, 540
selecting, 538
setting the origin of, 540

pin
down arrow, 2417

pin labels, 227, 871
pin level backward annotation, 333
pin numbers

making visible or invisible, 417, 418
setting color of, 414

pin object, 1602, 1986
Application property, 1963
Attributes property, 1964
Component property, 1965
DrillSize property, 1966
ElectricalType property, 1967
FunctionName property, 1968
Glued property, 1969
ISSMD property, 1971
Name property, 1972
Net property, 1974
Number property, 1975
ObjectType property, 1976
Parent property, 1979
PlaneThermal property, 1980
Plated property, 1981
PositionX property, 1982
PositionY property, 1983
Selected property, 1984
SlotLength property, 1985
SlotOffset property, 1986
SlotOrientation property, 1987
TestPoint property, 1988

pin pairs, 2352
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adding, 1208
adding connections between, 685
deleting from a group, 1208
modifying, 657, 1416
restricting to certain layers, 1461
rules, 495, 1419
working with groups of, 2352

Pin wizards
BGA/PGA wizard, 1045
DIP wizard, 1050
Polar wizard, 1056
QUAD wizard, 1061

pin-pairs
shielding with vias, 661

pins, 1421
deleting, 694
manual swapping, 703, 704
modifying, 657, 1387, 1421
renaming, 1392
swapping, 268, 704

Pins property, 1730, 1750, 1796, 1911
Placed property, 1731
placeholder labels, 190

creating, 190
placement

component arrays, 509
component placement process, 501
move with drag and attach, 504
move with drag and drop, 504
moving components, 503
moving reference designators, 680
radial move, 505
rotating objects, 511
setup, 1427
spinning objects, 511
swapping parts, 512
using find during placement, 503

Placing Test Points, 724, 1083
Planar Array tab - Create Array dialog box, 

1026
plane area keepouts - creating, 192, 497
plane checking, 753, 1268

full plane check, 753, 1268
mixed plane setup, 753, 1268

Plane Connect tab - Pour Manager dialog box, 
1437

plane connection - checking for continuity, 755
plane data - discarding, 600, 1123
Plane Layer Nets dialog box, 1429
plane layer parameters, 750, 1174
planes, 590

associating a net with, 592
auto separate, 596
connecting to a net, 654
connecting to SMD pads, 654
creating, 589, 590
creating cutouts, 598
creating embedded, 597
displaying connections for connected pads, 

600
modifying settings, 1195
splitting, 596

PlaneThermal property, 1980, 2074
plated drill size, 803, 1139
Plated property, 1981, 2075
Plot Options dialog box, 1430
Points property, 1853, 1998, 2010
polar grid setup, 505
polar step and repeat, 1511
Polar Wizard tab - Pin Wizards dialog box, 

1056
polyline object, 1603, 1992

Application property, 1989
CenterX property, 1990
CenterY property, 1991
Geometry property, 1992
Layer property, 1993
LineWidth property, 1994
ObjectType property, 1995
OutlineType property, 1996
Parent property, 1997
Points property, 1998
Radius property, 2000
ShapeType property, 2001

position output, 2283
PositionsChange event, 2201
PositionX property, 1686, 1732, 1810, 1834, 

1982, 2024, 2041, 2076
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PositionY property, 1687, 1733, 1811, 1835, 
1983, 2025, 2042, 2077

PostScript printing, 816
Pour Manager dialog box

Flood tab, 1435
Hatch tab, 1436
Plane Connect tab, 1437

poured copper and plane area keepouts - 
creating, 192, 497

power of an exponent, 2227
Power property, 1912
PPcbASCIISections, 1611
PPcbASCIIVersion, 1611
PPcbAttrFlags, 1612
PPcbBondPadEdge, 1612
PPcbBondPadShape, 1612
PPcbDrawingType, 1614
PPcbDRCMode, 1614
PPcbErrorClass, 1614
PPcbErrorType, 1614
PPcbErrorValueType, 1617
PPcbGridType, 1617
PPcbHorizontalJustification, 1618
PPcbLabelDisplayMode, 1618
PPcbLabelType, 1618
PPcbLayerType, 1619
PPcbLibraryItemType, 1619, 1621
PPcbMeasureFormat, 1619
PPcbNudgeMode, 1620
PPcbObjectType, 1620
PPcbOutlineType, 1622
PPcbPinElectricalType, 1622
PPcbRightReadingStatus, 1623
PPcbSegmentType, 1623
PPcbShapeType, 1623
PPcbTestPointType, 1624
PPcbUnit, 1624
PPcbVerticalJustification, 1624
Preference property, 1797
preferences

die component, 1302
drafting, 1312, 1313
ECO, 1171
global, 1317
grids, 1325

place and route, 1297
routing, 1328
split/mixed plane, 1337
teardrops, 1332
thermals, 1335, 1340

Preferences tab
DxDesigner Link, 1149

Prefix property, 1895
Print, 2344

Print Document, 2325
print current view, 2344
print document, 2325
print preview mode, 2345
Print Setup dialog box, 2326
Print statement, 2248
printing

PostScript printing, 816
to a Windows printer, 815

PrintPreview, 2345
PrintSetup, 2326

document, 2324
private nets, 1289
ProgressBar property, 1646
ProgressChange event, 2198
Properties (automation), 1696, 1800

Application.ActiveDocument, 1637
Application.Application, 1638
Application.CreateLibrary, 2113
Application.DefaultFilePath, 1639
Application.FullName, 1640
Application.Libraries, 1641
Application.Name, 1642
Application.ObjectType, 1643
Application.Parent, 1644
Application.ProgressBar, 1646
Application.StatusBarText, 1647
Application.Version, 1648
Application.Visible, 1649
AssemblyOptions.Application, 1650
AssemblyOptions.Count, 1651
AssemblyOptions.Item, 1652
AssemblyOptions.ItemType, 1653
AssemblyOptions.Next, 1654
AssemblyOptions.ObjectType, 1655
AssemblyOptions.Parent, 1656
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AssemblyOptions.ParentObject, 1657
Attribute.Application, 1663
Attribute.Measure, 2138
Attribute.Name, 1664
Attribute.ObjectType, 1665
Attribute.Parent, 1666
Attribute.Unit, 1897
Attribute.Value, 1667
Attributes.Application, 1669
Attributes.Count, 1670
Attributes.Item, 1671
Attributes.ItemType, 1672
Attributes.Next, 1673
Attributes.ObjectType, 1674
Attributes.Parent, 1675
Attributes.ParentObject, 1676
CBP.Application, 1677
CBP.Component, 1678
CBP.Edge, 1679
CBP.Function, 1680
CBP.Layer, 1681
CBP.Length, 1682
CBP.Name, 1683
CBP.ObjectType, 1684
CBP.Parent, 1685
CBP.PositionX, 1686
CBP.PositionY, 1687
CBP.SBPs, 1688
CBP.Shape, 1689
CBP.Width, 1690
CBP.Wirebonds, 1691
Circle.Application, 1692
Circle.CenterX, 1693
Circle.CenterY, 1694
Circle.Geometry, 1695
Circle.Layer, 1696
Circle.LineWidth, 1697
Circle.ObjectType, 1698
Circle.OutlineType, 1699
Circle.Parent, 1700
Circle.Radius, 1701
Circle.ShapeType, 1702
Component.AddLabel, 2141
Component.Application, 1703
Component.Attributes, 1704

Component.CenterX, 1706
Component.CenterY, 1707
Component.Decal, 1708
Component.DecalAttributes, 1709
Component.DecalCompatibleList, 1710
Component.DieHeight, 1711
Component.DieLength, 1712
Component.DieWidth, 1713
Component.ECORegistered, 1727
Component.Glued, 1714
Component.Installed, 1715
Component.ISDiePart, 1716
Component.ISSMD, 1717
Component.Labels, 1718
Component.Layer, 1719
Component.Name, 1720
Component.ObjectType, 1722
Component.Orientation, 1723
Component.Parent, 1724
Component.PartType, 1725
Component.PartTypeAttributes, 1726
Component.PartTypeLogic, 1728
Component.PartTypeObject, 1729
Component.Pins, 1730
Component.Placed, 1731
Component.PositionY, 1733
Component.PostionX, 1732
Component.SBPs, 1734
Component.Selected, 1735
Component.Substituted, 1736
Component.WirebondRulesAngleMaximu

m, 1737
Component.WirebondRulesClearanceWire

ToPad, 1738
Component.WirebondRulesClearanceWire

ToWire, 1739
Component.WirebondRulesLengthMaxim

um, 1740
Component.WirebondRulesLengthMinimu

m, 1741
Component.Wirebonds, 1742
Connection.Application, 1743
Connection.Length, 1744
Connection.Name, 1745
Connection.Net, 1747
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Connection.ObjectType, 1748
Connection.Parent, 1749
Connection.Pins, 1750
Connection.RouteSegments, 1751
Connection.Selected, 1752
Connection.Vias, 1753
Document.ActiveView, 1763
Document.Application, 1764
Document.AssemblyOptions, 1765
Document.Attributes, 1768
Document.BoardOutlineSurface, 1769
Document.Components, 1770
Document.Connections, 1771
Document.Drawings, 1772
Document.ElectricalLayerCount, 1773
Document.Errors, 1774
Document.FullName, 1775
Document.GridX, 1776
Document.GridY, 1777
Document.Jumpers, 1778
Document.LayerCount, 1779
Document.LayerEnabled, 1780
Document.LayerName, 1781
Document.LayerType, 1784
Document.MaxRealValue, 1785
Document.MinRealValue, 1786
Document.Name, 1787
Document.NetClasses, 1788
Document.Nets, 1789
Document.ObjectType, 1790
Document.OriginX, 1791
Document.OriginY, 1792
Document.Parent, 1793
Document.PartTypes, 1794
Document.Path, 1795
Document.Pins, 1796
Document.Preference, 1797
Document.RouteSegments, 1798
Document.Saved, 1799
Document.Texts, 1800
Document.Unit, 1801
Document.Vias, 1802
Drawing.Application, 1803
Drawing.DrawingType, 1804
Drawing.Geometry, 1805

Drawing.Name, 1806
Drawing.Net, 1807
Drawing.ObjectType, 1808
Drawing.Parent, 1809
Drawing.PositionX, 1810
Drawing.Positiony, 1811
Drawing.Selected, 1812
Drawing.Texts, 1813
Error.ActualValue, 1814
Error.Application, 1815
Error.Conflicts, 1816
Error.Description, 1817
Error.ErrorClass, 1818
Error.ErrorType, 1819
Error.HasActualValue, 1820
Error.HasRequiredValue, 1821
Error.IsClearanceError, 1822
Error.IsConnectivityError, 1823, 1829
Error.IsHighSpeedError, 1824
Error.IsIgnoredFlag, 1825
Error.IsInvisibleFlag, 1826
Error.IsLatiumError, 1827
Error.IsMiscError, 1828
Error.LayerNumber, 1830
Error.Name, 1831
Error.ObjectType, 1832
Error.Parent, 1833
Error.PositionX, 1834
Error.PositionY, 1835
Error.RequiredValueMax, 1836
Error.RequiredValueMin, 1837
ErrorConflict.Application, 1838
ErrorConflict.ConflictObject, 1839
ErrorConflict.ConflictObjectDesc, 1840
ErrorConflict.ConflictObjectType, 1841
ErrorConflict.Name, 1842
ErrorConflict.ObjectType, 1843
ErrorConflict.Parent, 1844
Jumper.Application, 1845
Jumper.Installed, 1846
Jumper.Length, 1847
Jumper.Name, 1848
Jumper.Net, 1849
Jumper.ObjectType, 1850
Jumper.Orientation, 1851
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Jumper.Parent, 1852
Jumper.Points, 1853
Jumper.Selected, 1854
Label.Application, 1855
Label.Attribute, 1856
Label.Component, 1857
Label.Display, 1858
Label.Height, 2032
Label.HorzJustification, 2033
Label.Layer, 2034
Label.LineWidth, 2035
Label.Mirror, 2036
Label.Name, 1859
Label.ObjectType, 1860
Label.Orientation, 2039
Label.Parent, 1861
Label.PositionX, 2041
Label.PositionY, 2042
Label.RightReading, 1862
Label.Selected, 1863
Label.Text, 1864
Label.Type, 1865
Label.VertJustification, 2045
Library.Application, 1877
Library.FullName, 1878
Library.Name, 1879
Library.ObjectType, 1880
Library.Parent, 1881
Library.Path, 1882
LibraryItem.Application, 1883
LibraryItem.Library, 1884
LibraryItem.Name, 1885
LibraryItem.ObjectType, 1886
LibraryItem.Parent, 1887
LibraryItem.Type, 1888
Measure.Application, 1889
Measure.Name, 1890
Measure.Normalize, 1892
Measure.Number, 1891
Measure.Parent, 1894
Measure.Prefix, 1895
Measure.Text, 1896
Measure.Value, 1898
Net.Application, 1900
Net.Attributes, 1902

Net.Connections, 1903
Net.Drawings, 1904
Net.Length, 1905
Net.Name, 1906
Net.NetClass, 1907
Net.NetClassAttributes, 1908
Net.ObjectType, 1909
Net.Parent, 1910
Net.Pins, 1911
Net.Power, 1912
Net.Selected, 1913
Net.Vias, 1914
Netclass.Application, 1915
Netclass.Attributes, 1916
Netclass.Name, 1917
Netclass.Nets, 1918
Netclass.ObjectType, 1919
Netclass.Parent, 1920
Object.Objecttype, 1926
Object.Parent, 1927
Objects.Application, 1921
Objects.Count, 1922
Objects.Item, 1923
Objects.ItemType, 1924
Objects.Next, 1925
Objects.ParentObject, 1928
PartType.Application, 1953
PartType.Attributes, 1954
PartType.Components, 1955
PartType.Name, 1958
PartType.ObjectType, 1960
PartType.Parent, 1961
PartType.Selected, 1962
Pin.Application, 1963
Pin.Component, 1965
Pin.DrillSize, 1966
Pin.ElectricalType, 1967
Pin.FunctionName, 1968
Pin.Glued, 1969
Pin.ISSMD, 1971
Pin.Name, 1972
Pin.Net, 1974
Pin.Number, 1975
Pin.ObjectType, 1976
Pin.Parent, 1979
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Pin.PlaneThermal, 1980
Pin.Plated, 1981
Pin.PositionX, 1982
Pin.PositionY, 1983
Pin.Selected, 1984
Pin.SlotLength, 1985
Pin.SlotOffset, 1986
Pin.SlotOrientation, 1987
Pin.TestPoint, 1988
Polyline.Application, 1989
Polyline.CenterX, 1990
Polyline.CenterY, 1991
Polyline.Geometry, 1992
Polyline.Layer, 1993
Polyline.LineWidth, 1994
Polyline.ObjectType, 1995
Polyline.OutlineType, 1996
Polyline.Parent, 1997
Polyline.Points, 1998
Polyline.Radius, 2000
Polyline.ShapeType, 2001
RouteSegment.Application, 2002
RouteSegment.Layer, 2003
RouteSegment.Length, 2004
RouteSegment.Name, 2005
RouteSegment.Net, 2007
RouteSegment.ObjectType, 2008
RouteSegment.Parent, 2009
RouteSegment.Points, 2010
RouteSegment.SegmentType, 2011
RouteSegment.Selected, 2012
Routesegment.Width, 2013
SBP.Application, 2014
SBP.CBPs, 2015
SBP.Component, 2016
SBP.Function, 2017
SBP.Layer, 2018
SBP.Length, 2019
SBP.Name, 2020
SBP.ObjectType, 2021
SBP.Orientation, 2022
SBP.Parent, 2023
SBP.PositionX, 2024
SBP.PositionY, 2025
SBP.Shape, 2026

SBP.Tier, 2027
SBP.Width, 2028
SBP.Wirebonds, 2029
Text.Application, 2030
Text.Drawing, 2031
Text.Height, 2032
Text.HorzJustification, 2033
Text.Layer, 2034
Text.LineWidth, 2035
Text.Mirror, 2036
Text.Name, 2037
Text.ObjectType, 2038
Text.Orientation, 2039
Text.Parent, 2040
Text.PositionX, 2041
Text.PositionY, 2042
Text.Selected, 2043
Text.Text, 2044
Text.VertJustification, 2045
Via.Application, 2062
Via.Attributes, 2063
Via.DrillSize, 2064
Via.EndLayer, 2065
Via.Glued, 2066
Via.Name, 2068
Via.Net, 2070
Via.ObjectType, 2071
Via.Parent, 2073
Via.PlaneThermal, 2074
Via.Plated, 2075
Via.PositionX, 2076
Via.PositionY, 2077
Via.Selected, 2078
Via.StartLayer, 2079
Via.TestPoint, 2081
Via.Type, 2082
View.Application, 2083
View.BottomRightX, 2084
View.BottomRightY, 2085
View.CenterX, 2086
View.CenterY, 2087
View.Name, 2088
View.ObjectType, 2089
View.Parent, 2090
View.TopLeftX, 2093
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View.TopLeftY, 2094
View.Zoom, 2095
Wirebond.Angle, 2096
Wirebond.Application, 2097
Wirebond.Component, 2098
Wirebond.EndOffsetX, 2099
Wirebond.EndOffsetY, 2100
Wirebond.EndPad, 2101
Wirebond.Endx, 2102
Wirebond.Endy, 2103
Wirebond.Name, 2104
Wirebond.ObjectType, 2105
Wirebond.Parent, 2106
Wirebond.Startad, 2109
Wirebond.StartOffsetX, 2107
Wirebond.StartOffsetY, 2108
Wirebond.StartX, 2110
Wirebond.StartY, 2111

Properties modeless dialog box, 2317
protect

while autorouting, 663
Protel

importing, 362
importing and exporting, 363

public nets, 1289
pulling an arc from a drafting segment/corner, 

558
push button, 2299
PushButton, 2299
pxr file, 1144

— Q —
QUAD Wizard tab - Pin Wizards dialog box, 

1061
query/modify, 1363

drafting corners, 552, 1131
drafting edges, 552
drafting objects, 552, 1134
information on routed traces, 659
labels, 528, 530, 1394
nets, 657
pad stack for pin, 1363
physical design reuse, 539
pin pairs, 657
pins, 657
tack, 658, 1519

teardrops, 620, 1520
text, 548, 1526
trace corner, 658, 1519
trace segments, 659
vias, 659

Query/Modify dialog boxes
clusters, 988, 994
component bond pads, 974
drafting objects, 1132
jumpers, 1226, 1230, 1232
keepouts, 552, 1134
nets, 1283
pad stacks, 1352
pin pairs, 1416
pins, 1421
reuses, 1457
substrate bond pads, 1480
traces, 1531
unions, 1533
vias, 1547
wire bonds, 1557

Query/Modify Part Label dialog box, 528, 
1394

Quit, 2318
Quit event, 2199
Quit method, 2123

— R —
radial move, 505

polar grid setup, 505
Radial Move Setup dialog box, 1449

radial step and repeat, 1513
Radial tab - Step and Repeat dialog box, 1513
radio box, 2300
RadioBox, 2300
Radius property, 1701, 2000
reassigning electrical layers, 389, 1451
recovering from database problems, 844

overview, 844
restoring data if differences exist, 846

ReDim statement, 2250
reference designators

hiding, 681
on assembly drawing layers, 679
on silkscreen layers, 680

Refresh method, 2191
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regenerate, 803, 818, 1139, 1413
button in CAM drill drawing options, 803, 

1139
button in photo plotter setup, 818, 1413

registration file, 847
registry, 1575
Remove method, 2129, 2136, 2185
removing the last added connection, 262
renaming

classes, 980
nets, 263, 699
nets and components in a Reuse, 539
pins, 1392

renumbering terminals, 172, 1453
repeating the last action, 2327
RepeatLastAction, 2327
Report Manager, 1455
reports, 717, 1456

BGA connection, 239
content of physical design reuse, 542
creating, 717, 1456
rules, 494, 1471
selection, 375
wire bond rules, 270

RequiredValueMax property, 1836
RequiredValueMin property, 1837
rerouting, 639
Reset method, 2130, 2137, 2186
resetting the measurement text, 769
restoring data, 846
Retrieving Uniform Resource Locator, 2335
reu files, 531
reusing

board outline, 346
RGL, 2214

automation replacement, 2207
automation replacements for RGL field 

keywords, 2214
automation replacements for RGL top level 

keywords, 2208
automation replacements for sublevel 

keywords, 2210
replacement automation functions, 2214

Right function, 2281
RightReading property, 1862

rotating, 511
bond pads, 263
objects, 511

route editing - after routing, 637
adding corners, 648
adding routes, 231
adding test points, 651
adding vias, 649
changing pad entry angles, 641
changing the width of existing traces, 644
checking the plane connection for 

continuity, 755
clearance and checking, 664
connecting a net with a plane, 654
connecting SMD pads to planes, 654
converting to arcs, 644
copying and pasting trace patterns, 641
deleting corners, 652
deleting dangling routes, 647
deleting routes from pin pairs, 654
deleting trace segments, 643
deleting vias, 653
ending a trace on a different net, 635
gluing vias, 653
monitoring trace length, 630
moving corners, 646
moving tacks or vias, 647
moving trace segments, 642
protecting routes, 637
rerouting, 639
route loops, 642
smoothing trace segments, 640
splitting traces, 648
stretching arcs or miters, 645
unrouting segments, 643

route editing - during routing
changing layers, 633
changing the start end of a connection, 630
changing trace widths, 634
changing via types, 633
creating arcs, 632
creating miters, 632
monitoring trace length, 630
using the layer pair to change layers, 618

route protection, 637
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routes, 637
unroutes, 637

routesegment object, 1604
Application property, 2002
Layer property, 2003
Length property, 2004
Name property, 2005
Net property, 2007
ObjectType property, 2008
Parent property, 2009
Points property, 2010
SegmentType property, 2011
Selected property, 2012
Width property, 2013

RouteSegments property, 1751, 1798
routing, 605

autorouting order, 663
dynamically, 606
maunally, 606
passes, 663
pausing, 663
strategy, 663

routing - interactive routing modes, 606
BGA Route Wizard, 273
dynamic autorouter, 608
dynamic route editor, 273, 606
monitoring trace length, 630

routing rules, 1461
editing, 1461
general, 2351

routing setup, 613
display control for connections, 615
outline view mode, 381
protecting unroutes, 637
selecting a starting layer for a trace, 631
selecting routing objects, 613
transparent view mode, 380
width, 565

Routing Strategy dialog box, 1465
Routing tab - Preferences dialog box, 1328
RS-274-X, 1409

photoplotter advanced setup, 1409
ruler

quick measure dynamic ruler, 1271
using quick measure, 381

rules, 495
class, 459, 980
clearance, 985
component, 1015
conditional, 1017
decal, 1043
default, 1073
differential pairs, 493, 1117
displaying, 495
fanout, 1187
format used by ECO, 2347
group, 1208
high speed, 1211
net, 464, 1291
pad entry, 1351
pin pair, 1419
reporting, 494, 1471
routing, 1461

RunMacro method, 2124
running the code samples, 2207

enhancing the samples, 2206
troubleshooting, 2207

— S —
sample, 1574, 1575, 1576, 1577, 1578, 1579, 

1582
sample code, 2204

enhancing, 2206
running, 2204
troubleshooting, 2207

sample1, 1574, 1576
sample2, 1574, 1577
sample3, 1574, 1577
sample4, 1574, 1578
sample5, 1574, 1579
sample6, 1582
Save, 2328
Save As Defaults button, 797, 803, 874, 1139
save document, 2328
save document to new location, 2329
Save event, 2202
Save method, 2161
SaveAs, 2329
SaveAs method, 2162
Saved property, 1799
saving, 224, 1476
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and restoring views, 343, 1478
as, 284
color assignments, 418
drafting items, 564, 1203
files, 284
OLE objects, 841
part types and decals, 224, 1476
physical design reuses, 540
start-up files, 280, 1507

Saving the CAM Document Configurations, 
792, 1074

SBP object, 1604
Application property, 2014
CBPs property, 2015
Component property, 2016
Function property, 2017
Layer property, 2018
Length property, 2019
Name property, 2020
ObjectType property, 2021
Orientation property, 2022
Parent property, 2023
PositionX property, 2024
PositionY property, 2025
Shape property, 2026
Tier property, 2027
Width property, 2028
Wirebonds property, 2029

SBP Properties dialog box, 1479
SBPs, 230

adding, 230
editing, 255
moving, 260

SBPs property, 1688, 1734
Scripts, 828

creating, 825
debugging, 831
managing, 828
running, 827

search order for libraries, 147, 1253
security, 83, 85, 1221, 1223

checking options in and out, 83, 1223
viewing the license file, 85, 1221

SecurityLimit event, 2200
SegmentType property, 2011

SelCount property, 2290
CheckListBox, 2290
ListBox, 2297

Select, 2292, 2333
ComboBox, 2292
TreeItem, 2304

Select Assembly Option dialog box, 812, 1482
Select Items dialog box, 800, 1484
Select method, 2131, 2139, 2187
select mode, 371
Selected property, 1735, 1752, 1812, 1854, 

1863, 1913, 1962, 1984, 2012, 2043, 
2078, 2290, 2297

CheckListBox, 2290
ListBox, 2297

selecting, 371
component bond pads, 264, 269
cycle picking, 374
die components, 264, 265
isolated stitching vias, 375
items, 371
multiple objects, 373
objects, 373
OLE objects, 836
parent dimensioning objects, 766
physical design reuses, 538
routing objects, 613
Select Graphically dialog box, 1483
selection filter, 373
single objects, 373
stitching vias, 374
substrate bond pads, 264, 270
unions, 515
using the Selection Filter Layer tab, 373
using the Selection Filter Object tab, 373
wire bonds, 264

Selecting Attributes to List in the Attribute 
Manager, 439, 934

Selecting Comparison Options, 997
Selecting Design Files and Output Options, 

1002
selecting objects

zooming to, 336
Selecting Update Options, 1003
selection, 371
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modes, 371
Selection Actions tab - DxDesigner Link, 1152
Selection Filter dialog box, 373

Layer tab, 1486
Object tab, 1488

selection report, 375
SelectionChange event, 2203
Selections Preview dialog box, 814
SelectObjects method, 2167
SelLength property, 2292

ComboBox, 2292
EditBox, 2294

SelStart property, 2292
ComboBox, 2292
EditBox, 2294

SelText property, 2292
ComboBox, 2292
EditBox, 2294

Send to back, 585
Session logs, 104
set check, 2290
Set statement, 2252
set up, 854, 1505
SetCheck, 2290
SetExtents method, 2192
SetExtentsToAll method, 2193
SetExtentsToBoard method, 2194
SetExtentsToSelection method, 2195
SetScale method, 2196
setting

attribute properties, 429
color palette, 415
colors, 413
copper pour flood priority, 585
default attributes, 450
default location for text, 766
die outlines, 241
die preview colors, 265
display colors, 414, 1125
origin of objects, 502, 540, 566
pad pitch for a substrate bond pads, 266
parameters, 750, 1174
pour and plane area preferences, 1195
SBP properties, 266

Setting Test Point Assignment Eligibility, 725, 
1082

Setting Test Point Properties, 724, 1086
setting up cross-probing, 1152
Shape property, 1689, 2026
ShapeType property, 1702, 2001
shortcut icon, 95
shortcut keys

assigning macros to, 128
creating, 125
use of expressions in, 127

shortcut menus
customizing, 118

shoving parts, 1293
Show Attributes dialog box, 444, 1497
signal parameters, 750, 1174
Signal Pins tab - Part Information dialog box, 

1387
Sin, 2282
sine, 2282
single-sided board, 384
sizing objects, 839
sizing OLE objects, 839
Sketch Route, 639
SliderControl, 2301
SlotLength property, 1985
SlotOffset property, 1986
SlotOrientation property, 1987
slotted holes, 181

creating in pins, 182
slotted pins, 181

creating in pins, 182
SMD pads, 179

connecting to planes, 654
editing component pad stacks, 179

smoothing controls, 640
Snap mode, 764
software

checking for updates, 98, 978
Sort method, 2132, 2140, 2188
space, 2283
Spc, 2283
SPECCTRA router instructions, 849, 1493
SPECCTRA Translator, 856, 1499

.do file editor, 856, 1499
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and keepouts, 855
automatic load in and out, 850, 1502
manual load in and out, 851

SpinButton, 2302
spinning objects, 266, 511
Split/Mixed Plane tab - Preferences dialog box, 

1337
split/mixed planes, 589

assigning a net to, 592
assigning plane thermal attributes, 599
associating a net with, 592
auto separate, 596
checking split planes, 753, 1268
converting older designs to split plane 

designs, 601
creating, 589, 590
creating cutouts, 598
creating embedded planes, 597
displaying connections, 600
modifying settings, 1195
splitting a plane, 596

split/mixed planes in SPECCTRA
defining after routing in SPECCTRA, 861
defining before routing in SPECCTRA, 

860
splitting a trace, 648
splitting nets, 694
Stand-alone SPECCTRA Link dialog box, 851
start end - changing, 630
starting

Wire Bond Editor, 267
StartLayer property, 2079
StartOffsetX property, 2107
StartOffsetY property, 2108
StartPad property, 2109
start-up files, 280, 1507

creating, 280, 1507
Set Start-up File dialog box, 281, 1490
specifying, 281, 1490
Start-up File Output dialog box, 280, 1507

start-up options, 95
StartX property, 2110
StartY property, 2111
state, 2290

CheckBox, 2288

CheckListBox, 2290
EditBox, 2294
ListBox, 2297
RadioBox, 2300
SliderControl, 2301
SpinButton, 2302
Tab control, 2303
TreeItem, 2304

statements, 2233
Call, 2235
Close, 2236
Dim, 2237
Do...Loop, 2238
For-Next, 2239
Function, 2241
If...Then...Else, 2243
Input, 2245
Open, 2247
Print, 2248
ReDim, 2250
Set, 2252
Sub, 2253
While...Wend, 2255
Width#, 2256

Status tab, Output window, 905, 1348
StatusBarText property, 1647
step and repeat, 1510

copied routes, 267
Linear tab, 1510
Polar tab, 1511
Radial tab, 1513
using, 1510

stitching
using vias for, 675, 676

stitching vias, 649
adding, 649
deleting, 649
inside the perimeter of a shape, 676
selection of, 374

stp files, 280, 1507
Str, 2284
strategy for routing, 663
strategy setting for autorouting, 1465
stretching, 645
string, 2284
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str, 2284
string expression, 2219

string concatenation, 2221, 2246
string expression, 2219
SubItem, 2334
SubItemCount, 2335
subnet errors, 735, 1543
Substituted property, 1736
substrate bond pads, 230

adding, 230
copying, 233
editing, 255
moving, 260, 261

subtraction operator, 2225
sum, 2223
summaries of attributes, 439, 444, 934, 1497
swapping, 512

ECL terminators, 699
gates, 700, 701, 702
parts, 512
pins, 268, 703, 704
terminal numbers, 171
undo last swap, 704

Switching, to PADS Router, 99
Synchronize Die Part dialog box, 1515
synchronizing die parts, 268

— T —
Tab, 2285
TabControl, 2303
tacks, 623

adding, 623
ending a bus with, 608
moving, 647

teardrops
Check Teardrops dialog box, 621, 979
checking, 621, 979
modifying, 620, 1520

Teardrops tab - Preferences dialog box, 1332
temporary filename, 2271
terminals, 182, 900

adding, 182, 900
associating copper with, 175
deleting, 174
Query/Modify Terminal Numbers dialog 

box, 170, 1524

Query/Modify Terminals dialog box, 169, 
1525

renumber, 172, 1453
swap numbers, 171

terminators - ECL automatic swapping, 699
test points, 651

adding, 651
and glued vias, 653
auditing, 723
checking with ASCII, 721
comparing, 721
locked test points warnings, 843, 1556
setting assignment eligibility, 725, 1082
setting properties, 724, 1086

TestPoint property, 1988, 2081
text and line objects - combining, 559
text object, 1605

Application property, 2030
Delete method, 2189
Drawing property, 2031
Height property, 2032
HorzJustification property, 2033
Layer property, 2034
LineWidth property, 2035
Mirror property, 2036
Name property, 2037
ObjectType property, 2038
Orientation property, 2039
Parent property, 2040
PositionX property, 2041
PositionY property, 2042
Selected property, 2043
Text property, 2044
VertJustification property, 2045

text operations, 546, 883
adding, 546, 883
mirroring text, 549
modifying, 548, 1526
moving, 549

Text property, 1864, 1896, 2044
text property, 2290

CheckListBox, 2290
ComboBox, 2292
EditBox, 2294
ListBox, 2297
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Texts property, 1800, 1813
The PartType Object, 1583
The Via Object, 1583
thermal generation - controlling the display, 

593
thermal/antipad - defining, 178
thermals display, 593
Thermals tab - Preferences dialog box, 1335, 

1340
through-hole vias, 392
Tier property, 2027
toolbars, 117

creation of, 116
removing buttons from, 124
renaming, 118
resetting, 118
showing or hiding, 117

TopLeftX property, 2093
TopLeftY property, 2094
trace connection - changing the start end, 630
Trace Copy dialog box, 1530
trace corners - converting to arcs, 644
trace length monitor, 630

turning off, 630
turning on, 630
using, 630

trace loops, 1531
trace segments, 659
trace width - modifying, 634, 644
traces

loops, 1531
transfering control, 2235
translating design data, 852, 853, 1200, 1529

from PADS Layout to SPECCTRA, 852, 
1529

from SPECCTRA to PADS Layout, 853, 
1200

Transparent View mode, 380
TreeItem, 2304
TreeView, 2306
troubleshooting, 844, 1575

code samples, 2207
fatal database error, 844, 845
recovering from database problems, 844
restoring data, 846

TrueLayer
and CAM, 1006
and layer associations, 1006

Type property, 1865, 1888, 2082

— U —
unary negation operator, 2225
unassigning a netname, 389
uncombining drafting objects, 560
undo last swap, 704
unions, 515

modifying, 509
Unit property, 1801, 1897
units - customize for attributes, 451
UnlockServer method, 2125
unroutes - protecting, 637
unrouting segments, 643
updates

checking for new, 98, 978
updating

pins from library, 199, 1538

— V —
Val, 2286
value, 2286
Value property, 1667, 1898
value property, 2300, 2301, 2303

RadioBox, 2300
SliderControl, 2301
TabControl, 2303

variables
Logical, 2218
Numeric, 2218
Object, 2219
String, 2218

Verb mode, 371, 372
verify design, 735, 1543

Clearance Check Setup dialog box, 742, 
982

EDC, 735, 1543
error markers, 735, 1543
Fabrication Checking Setup dialog box, 

745, 1184
full plane check setup, 753, 1268
Mixed Plane Setup dialog box, 753, 1268
plane checking, 755
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rules, 735, 1543
using, 735, 1543
viewing the errors, 735, 1543

version
checking for updates, 98, 978

Version property, 1648
vertical dimensioning, 758
VertJustification property, 2045
via

down arrow, 2417
via object, 1607

Application property, 2062
Attributes property, 2063
DrillSize property, 2064
EndLayer property, 2065
Glued property, 2066
Name property, 2068
Net property, 2070
ObjectType property, 2071
Parent property, 2073
PlaneThermal property, 2074
Plated property, 2075
PositionX property, 2076
PositionY property, 2077
Selected property, 2078
StartLayer property, 2079
TestPoint property, 2081
Type property, 2082

via shield, 661
via stitching

filling a shape, 675
via stitching vias

surrounding a void with, 677
via types, 616, 1550

changing while routing, 633
restricting, 1461
setting, 616, 1550
unrestricting, 1461

vias, 394, 649, 1461, 1753
adding to a bus, 608
allowing by net, 464, 1291
cycle pattern for bus routing, 608
deleting, 653
editing via pad stacks, 394
for routing rules, 1461

free, 649
gluing, 653
isolated stitching vias, 375, 743, 1020
modifying, 659, 1547
moving, 647
partial, 393
stitching, 374, 649
surrounding a void with, 677
through-hole, 392

Vias property, 1753, 1802, 1914
vias-passing maximum number of, 849
View Clearance dialog box, 1552
View Nets dialog box, 1553
view object, 1607

Application property, 2083
BottomRightX property, 2084
BottomRightY property, 2085
CenterX property, 2086
Change event, 2204
Name property, 2088
objectType property, 2089
Pan method, 2190
Parent property, 2090
Refresh method, 2191
SetExtents method, 2192
SetExtentsToAll method, 2193
SetExtentsToBoard method, 2194
SetExtentsToSelection method, 2195
SetScale method, 2196
TopLeftX property, 2093
TopLeftY property, 2094
Zoom property, 2095

ViewDraw (see DxDesigner Link), 301
viewing, 381, 571, 572

by color, 614
by netname, 615
clearances, 571, 572
nets, 495
outline view mode, 381
pin pairs, 495
protected routes, 660
redrawing, 342
restoring, 343
saving, 343, 1478
specific view areas, 342
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transparent view mode, 380
viewing the license file, 85, 1221
Visible property, 1649
Visual C++, 1576, 1577, 1578, 1579, 1582

— W —
welcome, 1571
wheel (on mouse), 335

using to pan, 335
using to zoom, 338

While, 2255
While Wend statement, 2255
While...Wend statement, 2255
Width #, 2285
Width # statement, 2256
Width property, 1690, 2013, 2028
wildcards, 158
Wire Bond Checking Setup dialog box, 755, 

1556
Wire Bond Editor, 274
Wire Bond Rules dialog box, 1559
wire bonds, 227

adding, 227
checking, 755, 1556
editing, 256
fanout workflow, 275
reports, 270
rules, 232, 251

wirebond object, 1608
Angle property, 2096
Application property, 2097
Component property, 2098
EndOffsetX property, 2099
EndOffsetY property, 2100
EndPad property, 2101
EndX property, 2102
EndY property, 2103
Name property, 2104
ObjectType property, 2105
Parent property, 2106
StartOffsetX property, 2107
StartOffsetY property, 2108
StartPad property, 2109
StartX property, 2110
StartY property, 2111

WireBondRulesAngleMaximum property, 
1737

WireBondRulesClearanceWireToPad 
property, 1738

WireBondRulesClearanceWireToWire 
property, 1739

WireBondRulesLengthMaximum property, 
1740

WireBondRulesLengthMinimum property, 
1741

workflow - wire bond fanout, 275
wrapper classes, 1575

— X —
Xor operator, 2233

— Z —
Zoom property, 2095
zooming, 115, 336

in the object view tab, 336
to board extents, 336
to design extents, 336
to selection, 336
using the mouse, 337
using the wheel, 338
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Third-Party Information

This section provides information on open source and third-party software that may be included in the PADS Layout product.

• This software application may include JPEG Image Compression version 6b third-party software, which is distributed on
an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied.  JPEG Image Compression
version 6b may be subject to the following copyrights:

© 1991-1998, Thomas G. Lane.  All Rights Reserved.

In plain English:

1. We don't promise that this software works.  (But if you find any bugs, please let us know!)
2. You can use this software for whatever you want.  You don't have to pay us.
3. You may not pretend that you wrote this software.  If you use it in a program, you must acknowledge somewhere in
your documentation that you've used the IJG code.

In legalese:

The authors make NO WARRANTY or representation, either express or implied, with respect to this software, its quality,
accuracy, merchantability, or fitness for a particular purpose.  This software is provided "AS IS", and you, its user, assume
the entire risk as to its quality and accuracy.

This software is copyright © 1991-1998, Thomas G. Lane.
All Rights Reserved except as specified below.

Permission is hereby granted to use, copy, modify, and distribute this software (or portions thereof) for any purpose,
without fee, subject to these conditions:
(1) If any part of the source code for this software is distributed, then this README file must be included, with this
copyright and no-warranty notice unaltered; and any additions, deletions, or changes to the original files must be clearly
indicated in accompanying documentation.
(2) If only executable code is distributed, then the accompanying documentation must state that "this software is based in
part on the work of the Independent JPEG Group".
(3) Permission for use of this software is granted only if the user accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library.  If you
use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity relating to
this software or products derived from it.  This software may be referred to only as "the Independent JPEG Group's
software".

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all
warranty or liability claims are assumed by the product vendor.

© 1991 by the Massachusetts Institute of Technology

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the name of M.I.T. not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission. M.I.T. makes no representations
about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

• This software application may include zlib version 1.2.3 third-party software.  Zlib version 1.2.3 is distributed under the
terms of the zlib license and is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express
or implied.  See the license for the specific language governingrights and limitations under the license.  You can view a
copy of the license at: <install_folder>/docs/legal/zlib_libpng.pdf. Zlib version 1.2.3 may be subject to the following
copyrights:



© 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for
any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you
use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org
Mark Adler madler@alumni.caltech.edu

• This software application may include Boost version 1.38.0 third-party software.  Boost version 1.38.0 is distributed
under the terms of the Boost Software License version 1.0 and is distributed on an "AS IS" basis, WITHOUT
WARRANTY OF ANY KIND, either express or implied.  See the license for the specific language governingrights and
limitations under the license.  You can view a copy of the license at: <install_folder>/docs/legal/ boost_1.0.pdf.   Portions
of this software may be subject to the Boost Artistic License.  You can view a copy of the Boost Artistic License at:
<install_folder>/docs/legal/ boost_artistic_2000.pdf.    Boost version 1.38.0 may be subject to the following copyrights:

© 2002-2003, Trustees of Indiana University.
© 2000-2001, University of Notre Dame.
All rights reserved.

Indiana University has the exclusive rights to license this product under the following license.

Software License, Version 1.0

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

* All redistributions of source code must retain the above copyright notice, the list of authors in the original source
code, this list of conditions and the disclaimer listed in this license;

* All redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
disclaimer listed in this license in the documentation and/or other materials provided with the distribution;

* Any documentation included with all redistributions must include the following acknowledgement:

"This product includes software developed at the University of Notre Dame and the Pervasive Technology Labs
at Indiana University. For technical information contact Andrew Lumsdaine at the Pervasive Technology Labs at
Indiana University.  For administrative and license questions contact the Advanced Research and Technology
Institute at 351 West 10th Street. Indianapolis, Indiana 46202, phone 317-278-4100, fax 317-274-5902."

Alternatively, this acknowledgement may appear in the software itself, and wherever such third-party
acknowledgments normally appear.

* The name Indiana University, the University of Notre Dame or "Caramel" shall not be used to endorse or promote
products derived from this software without prior written permission from Indiana University.  For written
permission, please contact Indiana University Advanced Research & Technology Institute.

* Products derived from this software may not be called "Caramel", nor may Indiana University, the University of
Notre Dame or "Caramel" appear in their name, without prior written permission of Indiana University Advanced
Research & Technology Institute.

Indiana University provides no reassurances that the source code provided does not infringe the patent or any other
intellectual property rights of any other entity.  Indiana University disclaims any liability to any recipient for claims
brought by any other entity based on infringement of intellectual property rights or otherwise.  



LICENSEE UNDERSTANDS THAT SOFTWARE IS PROVIDED "AS IS" FOR WHICH NO WARRANTIES AS TO
CAPABILITIES OR ACCURACY ARE MADE. INDIANA UNIVERSITY GIVES NO WARRANTIES AND MAKES
NO REPRESENTATION THAT SOFTWARE IS FREE OF INFRINGEMENT OF THIRD PARTY PATENT,
COPYRIGHT, OR OTHER PROPRIETARY RIGHTS. INDIANA UNIVERSITY MAKES NO WARRANTIES THAT
SOFTWARE IS FREE FROM "BUGS", "VIRUSES", "TROJAN HORSES", "TRAP DOORS", "WORMS", OR OTHER
HARMFUL CODE.  LICENSEE ASSUMES THE ENTIRE RISK AS TO THE PERFORMANCE OF SOFTWARE
AND/OR ASSOCIATED MATERIALS, AND TO THE PERFORMANCE AND VALIDITY OF INFORMATION
GENERATED USING SOFTWARE.

© 2001-2003 William E. Kempf

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  William E. Kempf makes no representations about the suitability
of this software for any purpose. It is provided "as is" without express or implied warranty.

© 1994, 2002 Hewlett-Packard Company

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  Hewlett-Packard Company makes no representations about the
suitability of this software for any purpose.  It is provided "as is" without express or implied warranty.

© 1996, 1997, 1998, 1999 Silicon Graphics Computer Systems, Inc.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  Silicon Graphics makes no representations about the suitability of
this software for any purpose.  It is provided "as is" without express or implied warranty.

The Loki Library
© 2001 by Andrei Alexandrescu
This code accompanies the book:
Alexandrescu, Andrei. "Modern C++ Design: Generic Programming and Design Patterns Applied". 
© 2001. Addison-Wesley
Permission to use, copy, modify, distribute and sell this software for any purpose is hereby granted without fee, provided
that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in
supporting documentation. The author or Addison-Welsey Longman make no representations about the suitability of this
software for any purpose. It is provided "as is" without express or implied warranty.

© 2002-2003 David Moore, William E. Kempf

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  William E. Kempf makes no representations about the suitability
of this software for any purpose. It is provided "as is" without express or implied warranty.

© 2001 Ronald Garcia

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appears in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  Ronald Garcia makes no representations about the suitability of
this software for any purpose.  It is provided "as is" without express or implied warranty.

© 2001 Jeremy Siek 

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appears in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  Silicon Graphics makes no representations about the suitability of
this software for any purpose.  It is provided "as is" without express or implied warranty.

© 2002 CrystalClear Software, Inc.



Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation. CrystalClear Software makes no representations about the
suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

© 1998, 2002-2006 Kiyoshi Matsui <kmatsui@t3.rim.or.jp>
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

©  2000 Jeremy Siek, Lie-Quan Lee, and Andrew Lumsdaine

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appears in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  We make no representations about the suitability of this software
for any purpose.  It is provided "as is" without express or implied warranty. 

© 2005 JongSoo Park

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appears in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  Jeremy Siek makes no representations about the suitability of this
software for any purpose.  It is provided "as is" without express or implied warranty.

© 2006 Michael Drexl 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appears in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  Michael Drexl makes no representations about the suitability of
this software for any purpose.  It is provided "as is" without express or implied warranty. 

© 1991 Massachusetts Institute of Technology

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the name of M.I.T. not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.  M.I.T. makes no representations
about the suitability of this software for any purpose.  It is provided "as is" without express or implied warranty.

©  2001, 2002 Indiana University
© 2000, 2001 University of Notre Dame du Lac
© 2000 Jeremy Siek, Lie-Quan Lee, Andrew Lumsdaine
© 1996-1999 Silicon Graphics Computer Systems, Inc.
© 1994 Hewlett-Packard Company



This product includes software developed at the University of Notre Dame and the Pervasive Technology Labs at Indiana
University. For technical information contact Andrew Lumsdaine at the Pervasive Technology Labs at Indiana
University.  For administrative and license questions contact the Advanced Research and Technology Institute at 351
West 10th Street. Indianapolis, Indiana 46202, phone 317-278-4100, fax 317-274-5902.

Some concepts based on versions from the MTL draft manual and Boost Graph and Property Map documentation, the SGI
Standard Template Library documentation and the Hewlett-Packard STL, under the following license: 

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appears in all copies and that both that copyright notice and this
permission notice appear in supporting documentation.  Silicon Graphics makes no representations about the suitability of
this software for any purpose.  It is provided "as is" without express or implied warranty.

Fri Aug 15 16:29:47 EDT 1997
Harwell-Boeing File I/O in C V. 1.0
National Institute of Standards and Technology, MD.
K.A. Remington

NOTICE
Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is
hereby granted provided that the above copyright notice appear in all copies and that both the copyright notice and this
permission notice appear in supporting documentation.

Neither the Author nor the Institution (National Institute of Standards and Technology) make any representations about
the suitability of this software for any purpose. This software is provided "as is" without expressed or implied warranty.

• This software application may include ActivePerl version 5.8.8.822 (“ActivePerl”) third-party software.  ActivePerl is
subject to the terms of the ActivePerl Community License, version 2.1 and is distributed on an "AS IS" basis, WITHOUT
WARRANTY OF ANY KIND, either express or implied.  See the license for the specific language governing rights and
l im i t a t i ons unde r t he l i c ense .  You can v i ew a copy o f t he l i c ense a t :
<your_Mentor_Graphics_documentation_directory>/legal/activeperl_community_ 2.1.pdf.  Portions of this software
may be subject to either (1) the GNU General Public License v 2.1 or later, (2) the Perl Artistic License, 1997, or (3) the
Perl Artistic License 2.0, at our election.  In all instances, we elect the Perl Artistic License option, either the 1997
version, or the 2.0 version, as allowed by the individual copyright holders.  Portions of this software may be subject to the
Pe r l Ar t i s t i c L i cense , 1997 .  You can v i ew a copy o f t h i s L i cense a t :
<your_Mentor_Graphics_documentation_directory>/legal/ perl_artistic_1997.pdf.  Portions of this software may be
sub j ec t t o t he Pe r l Ar t i s t i c L i cense 2 .0 .  You can v i ew a copy o f t h i s L i cense a t :
<your_Mentor_Graphics_documentation_directory>/legal/ perl_artistic_2.0.pdf.  ActivePerl may be subject to the
following copyrights:

© 1989, 1993 The Regents of the University of California.  All rights reserved.

This code is derived from software contributed to Berkeley by Guido van Rossum.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,



PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

© 1987 by Digital Equipment Corporation, Maynard, Massachusetts, and the Massachusetts Institute of Technology,
Cambridge, Massachusetts.  All Rights Reserved

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is
hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the names of Digital or MIT not be used in advertising or
publicity pertaining to distribution of the software without specific, written prior permission.  

DIGITAL DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL DIGITAL BE LIABLE FOR
ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

© 1985, 1986, 1987, 1989, 1991 by the Massachusetts Institute of Technology

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is
hereby granted, provided  that the above copyright notice appear in all copies and that both that  copyright notice and this
permission notice appear in supporting  documentation, and that the name of M.I.T. not be used in advertising or publicity
pertaining to distribution of the software without specific,  written prior permission. M.I.T. makes no representations
about the  suitability of this software for any purpose.  It is provided "as is" without express or implied warranty.

• This software application may include SVN version 1.6.15 third-party software.  SVN version 1.6.15 is distributed under
the terms of the GNU Library General Public License v2.0 and is distributed on an "AS IS" basis, WITHOUT
WARRANTY OF ANY KIND, either express or implied.  See the license for the specific language governingrights and
l im i t a t i ons unde r t he l i c ense .  You can v i ew a copy o f t he l i c ense a t :
<your_Mentor_Graphics_documentation_directory>/legal/gnu_library_gpl_2.0.pdf.  Portions of this software may be
sub j ec t t o t he Apache L i cense ve r s i on 2 .0 .  You can v i ew a copy o f t he l i c ense a t :
<your_Mentor_Graphics_documentation_directory>/legal/apache_2.0.pdf.  To obtain a copy of the SVN version 1.6.15
source code, send a request to request_sourcecode@mentor.com.  SVN version 1.6.15 may be subject to the following
copyrights:

©1990-2005 Sleepycat Software.  All rights reserved.

 Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

 3. Redistributions in any form must be accompanied by information on how to obtain complete source code for the DB
software and any accompanying software that uses the DB software.  The source code must either be included in the
distribution or be available for no more than the cost of distribution plus a nominal fee, and must be freely redistributable
under reasonable conditions.  For an executable file, complete source code means the source code for all modules it
contains.  It does not include source code for modules or files that typically accompany the major components of the
operating system on which the executable file runs.

 THIS SOFTWARE IS PROVIDED BY SLEEPYCAT SOFTWARE ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT, ARE DISCLAIMED.  IN NO EVENT
SHALL SLEEPYCAT SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)



HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

© 1990, 1993, 1994, 1995 The Regents of the University of California.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

 3. Neither the name of the University nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

©1995, 1996 The President and Fellows of Harvard University.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

 3. Neither the name of the University nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY HARVARD AND ITS CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT
SHALL HARVARD OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

©1998-2003 Carnegie Mellon University.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.



3. The name "Carnegie Mellon University" must not be used to endorse or promote products derived from this software
without prior written permission. For permission or any other legal details, please contact  

Office of Technology Transfer
Carnegie Mellon University
5000 Forbes Avenue
Pittsburgh, PA  15213-3890
(412) 268-4387, fax: (412) 268-7395
tech-transfer@andrew.cmu.edu

4. Redistributions of any form whatsoever must retain the following acknowledgment:  "This product includes software
developed by Computing Services at Carnegie Mellon University (http://www.cmu.edu/computing/)."

CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
CARNEGIE MELLON UNIVERSITY BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

© 2000-2009 CollabNet.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment:
"This product includes software developed by CollabNet (http://www.Collab.Net/)." Alternately, this acknowledgment
may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The hosted project names must not be used to endorse or promote products derived from this software without prior
written permission. For written permission, please contact info@collab.net.

5. Products derived from this software may not use the "Tigris" name nor may "Tigris" appear in their names without prior
written permission of CollabNet.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL COLLABNET OR ITS CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

© 1998-2008 The OpenSSL Project.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.



3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from
this software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without
prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software
developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY  EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL
PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

© 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared to.  The
following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the
SSL code.  The SSL documentation included with this distribution is covered by the same copyright terms except that the
holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.

 If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used.
This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the
package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement:
"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can
be left out if the rouines from the library being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must
include an acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT



(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed.  i.e.
this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

• This software application may include BOOST version 1.46.0 third-party software. BOOST version 1.46.0is distributed
under the terms of the BOOST Software License version 1.0 and is distributed on an "AS IS" basis, WITHOUT
WARRANTY OF ANY KIND, either express or implied. See the license for the specific language governingrights and
l im i t a t i ons unde r the l i c ense . You can v i ew a copy o f the l i c ense a t :
<your_Mentor_Graphics_documentation_directory>/legal/boost_1.0.pdf.



End-User License Agreement
The latest version of the End-User License Agreement is available on-line at:

www.mentor.com/eula

END-USER LICENSE AGREEMENT (“Agreement”)

This is a legal agreement concerning the use of Software (as defined in Section 2) and hardware (collectively “Products”)
between the company acquiring the Products (“Customer”), and the Mentor Graphics entity that issued the
corresponding quotation or, if no quotation was issued, the applicable local Mentor Graphics entity (“Mentor
Graphics”). Except for license agreements related to the subject matter of this license agreement which are physically
signed by Customer and an authorized representative of Mentor Graphics, this Agreement and the applicable quotation
contain the parties' entire understanding relating to the subject matter and supersede all prior or contemporaneous
agreements. If Customer does not agree to these terms and conditions, promptly return or, in the case of Software
received electronically, certify destruction of Software and all accompanying items within five days after receipt of
Software and receive a full refund of any license fee paid. 

1. ORDERS, FEES AND PAYMENT. 

1.1. To the extent Customer (or if agreed by Mentor Graphics, Customer’s appointed third party buying agent) places and
Mentor Graphics accepts purchase orders pursuant to this Agreement (“Order(s)”), each Order will constitute a contract
between Customer and Mentor Graphics, which shall be governed solely and exclusively by the terms and conditions of
this Agreement, any applicable addenda and the applicable quotation, whether or not these documents are referenced on the
Order. Any additional or conflicting terms and conditions appearing on an Order will not be effective unless agreed in
writing by an authorized representative of Customer and Mentor Graphics.

1.2. Amounts invoiced will be paid, in the currency specified on the applicable invoice, within 30 days from the date of such
invoice. Any past due invoices will be subject to the imposition of interest charges in the amount of one and one-half
percent per month or the applicable legal rate currently in effect, whichever is lower. Prices do not include freight,
insurance, customs duties, taxes or other similar charges, which Mentor Graphics will state separately in the applicable
invoice(s). Unless timely provided with a valid certificate of exemption or other evidence that items are not taxable, Mentor
Graphics will invoice Customer for all applicable taxes including, but not limited to, VAT, GST, sales tax and service tax.
Customer will make all payments free and clear of, and without reduction for, any withholding or other taxes; any such
taxes imposed on payments by Customer hereunder will be Customer’s sole responsibility. If Customer appoints a third
party to place purchase orders and/or make payments on Customer’s behalf, Customer shall be liable for payment under
Orders placed by such third party in the event of default.

1.3. All Products are delivered FCA factory (Incoterms 2000), freight prepaid and invoiced to Customer, except Software
delivered electronically, which shall be deemed delivered when made available to Customer for download. Mentor
Graphics retains a security interest in all Products delivered under this Agreement, to secure payment of the purchase price
of such Products, and Customer agrees to sign any documents that Mentor Graphics determines to be necessary or
convenient for use in filing or perfecting such security interest. Mentor Graphics’ delivery of Software by electronic means
is subject to Customer’s provision of both a primary and an alternate e-mail address.

2. GRANT OF LICENSE. The software installed, downloaded, or otherwise acquired by Customer under this Agreement,
including any updates, modifications, revisions, copies, documentation and design data (“Software”) are copyrighted, trade
secret and confidential information of Mentor Graphics or its licensors, who maintain exclusive title to all Software and retain
all rights not expressly granted by this Agreement. Mentor Graphics grants to Customer, subject to payment of applicable
license fees, a nontransferable, nonexclusive license to use Software solely: (a) in machine-readable, object-code form (except
as provided in Subsection 5.2); (b) for Customer’s internal business purposes; (c) for the term of the license; and (d) on the
computer hardware and at the site authorized by Mentor Graphics. A site is restricted to a one-half mile (800 meter) radius.
Customer may have Software temporarily used by an employee for telecommuting purposes from locations other than a
Customer office, such as the employee's residence, an airport or hotel, provided that such employee's primary place of
employment is the site where the Software is authorized for use. Mentor Graphics’ standard policies and programs, which vary
depending on Software, license fees paid or services purchased, apply to the following: (a) relocation of Software; (b) use of
Software, which may be limited, for example, to execution of a single session by a single user on the authorized hardware or for
a restricted period of time (such limitations may be technically implemented through the use of authorization codes or similar
devices); and (c) support services provided, including eligibility to receive telephone support, updates, modifications, and
revisions. For the avoidance of doubt, if Customer requests any change or enhancement to Software, whether in the course of
receiving support or consulting services, evaluating Software, performing beta testing or otherwise, any inventions, product

 IMPORTANT INFORMATION 

USE OF ALL SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS.  CAREFULLY READ THIS LICENSE 
AGREEMENT BEFORE USING THE PRODUCTS.  USE OF SOFTWARE INDICATES CUSTOMER’S 

COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND CONDITIONS SET FORTH IN 
THIS AGREEMENT.  ANY ADDITIONAL OR DIFFERENT PURCHASE ORDER TERMS AND CONDITIONS 

SHALL NOT APPLY.

http://www.mentor.com/eula


improvements, modifications or developments made by Mentor Graphics (at Mentor Graphics’ sole discretion) will be the
exclusive property of Mentor Graphics.

3. ESC SOFTWARE. If Customer purchases a license to use development or prototyping tools of Mentor Graphics’ Embedded
Software Channel (“ESC”), Mentor Graphics grants to Customer a nontransferable, nonexclusive license to reproduce and
distribute executable files created using ESC compilers, including the ESC run-time libraries distributed with ESC C and C++
compiler Software that are linked into a composite program as an integral part of Customer’s compiled computer program,
provided that Customer distributes these files only in conjunction with Customer’s compiled computer program. Mentor
Graphics does NOT grant Customer any right to duplicate, incorporate or embed copies of Mentor Graphics’ real-time operating
systems or other embedded software products into Customer’s products or applications without first signing or otherwise
agreeing to a separate agreement with Mentor Graphics for such purpose.

4. BETA CODE. 

4.1. Portions or all of certain Software may contain code for experimental testing and evaluation (“Beta Code”), which may not
be used without Mentor Graphics’ explicit authorization. Upon Mentor Graphics’ authorization, Mentor Graphics grants to
Customer a temporary, nontransferable, nonexclusive license for experimental use to test and evaluate the Beta Code
without charge for a limited period of time specified by Mentor Graphics. This grant and Customer’s use of the Beta Code
shall not be construed as marketing or offering to sell a license to the Beta Code, which Mentor Graphics may choose not to
release commercially in any form.

4.2. If Mentor Graphics authorizes Customer to use the Beta Code, Customer agrees to evaluate and test the Beta Code under
normal conditions as directed by Mentor Graphics. Customer will contact Mentor Graphics periodically during Customer’s
use of the Beta Code to discuss any malfunctions or suggested improvements. Upon completion of Customer’s evaluation
and testing, Customer will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths,
weaknesses and recommended improvements.

4.3. Customer agrees to maintain Beta Code in confidence and shall restrict access to the Beta Code, including the methods and
concepts utilized therein, solely to those employees and Customer location(s) authorized by Mentor Graphics to perform
beta testing. Customer agrees that any written evaluations and all inventions, product improvements, modifications or
developments that Mentor Graphics conceived or made during or subsequent to this Agreement, including those based
partly or wholly on Customer’s feedback, will be the exclusive property of Mentor Graphics. Mentor Graphics will have
exclusive rights, title and interest in all such property. The provisions of this Subsection 4.3 shall survive termination of
this Agreement.

5. RESTRICTIONS ON USE. 

5.1. Customer may copy Software only as reasonably necessary to support the authorized use. Each copy must include all
notices and legends embedded in Software and affixed to its medium and container as received from Mentor Graphics. All
copies shall remain the property of Mentor Graphics or its licensors. Customer shall maintain a record of the number and
primary location of all copies of Software, including copies merged with other software, and shall make those records
available to Mentor Graphics upon request. Customer shall not make Products available in any form to any person other
than Customer’s employees and on-site contractors, excluding Mentor Graphics competitors, whose job performance
requires access and who are under obligations of confidentiality. Customer shall take appropriate action to protect the
confidentiality of Products and ensure that any person permitted access does not disclose or use it except as permitted by
this Agreement. Customer shall give Mentor Graphics written notice of any unauthorized disclosure or use of the Products
as soon as Customer learns or becomes aware of such unauthorized disclosure or use. Except as otherwise permitted for
purposes of interoperability as specified by applicable and mandatory local law, Customer shall not reverse-assemble,
reverse-compile, reverse-engineer or in any way derive any source code from Software. Log files, data files, rule files and
script files generated by or for the Software (collectively “Files”), including without limitation files containing Standard
Verification Rule Format (“SVRF”) and Tcl Verification Format (“TVF”) which are Mentor Graphics’ proprietary
syntaxes for expressing process rules, constitute or include confidential information of Mentor Graphics. Customer may
share Files with third parties, excluding Mentor Graphics competitors, provided that the confidentiality of such Files is
protected by written agreement at least as well as Customer protects other information of a similar nature or importance,
but in any case with at least reasonable care. Customer may use Files containing SVRF or TVF only with Mentor Graphics
products. Under no circumstances shall Customer use Software or Files or allow their use for the purpose of developing,
enhancing or marketing any product that is in any way competitive with Software, or disclose to any third party the results
of, or information pertaining to, any benchmark.

5.2. If any Software or portions thereof are provided in source code form, Customer will use the source code only to correct
software errors and enhance or modify the Software for the authorized use. Customer shall not disclose or permit disclosure
of source code, in whole or in part, including any of its methods or concepts, to anyone except Customer’s employees or
contractors, excluding Mentor Graphics competitors, with a need to know. Customer shall not copy or compile source code
in any manner except to support this authorized use.

5.3. Customer may not assign this Agreement or the rights and duties under it, or relocate, sublicense or otherwise transfer the
Products, whether by operation of law or otherwise (“Attempted Transfer”), without Mentor Graphics’ prior written
consent and payment of Mentor Graphics’ then-current applicable relocation and/or transfer fees. Any Attempted Transfer
without Mentor Graphics’ prior written consent shall be a material breach of this Agreement and may, at Mentor Graphics’
option, result in the immediate termination of the Agreement and/or the licenses granted under this Agreement. The terms
of this Agreement, including without limitation the licensing and assignment provisions, shall be binding upon Customer’s
permitted successors in interest and assigns.



5.4. The provisions of this Section 5 shall survive the termination of this Agreement.

6. SUPPORT SERVICES. To the extent Customer purchases support services, Mentor Graphics will provide Customer updates
and technical support for the Products, at the Customer site(s) for which support is purchased, in accordance with Mentor
Graphics’ then current End-User Support Terms located at http://supportnet.mentor.com/about/legal/.

7. AUTOMATIC CHECK FOR UPDATES; PRIVACY. Technological measures in Software may communicate with servers
of Mentor Graphics or its contractors for the purpose of checking for and notifying the user of updates and to ensure that the
Software in use is licensed in compliance with this Agreement. Mentor Graphics will not collect any personally identifiable data
in this process and will not disclose any data collected to any third party without the prior written consent of Customer, except to
Mentor Graphics’ outside attorneys or as may be required by a court of competent jurisdiction.

8. LIMITED WARRANTY. 

8.1. Mentor Graphics warrants that during the warranty period its standard, generally supported Products, when properly
installed, will substantially conform to the functional specifications set forth in the applicable user manual. Mentor
Graphics does not warrant that Products will meet Customer’s requirements or that operation of Products will be
uninterrupted or error free. The warranty period is 90 days starting on the 15th day after delivery or upon installation,
whichever first occurs. Customer must notify Mentor Graphics in writing of any nonconformity within the warranty period.
For the avoidance of doubt, this warranty applies only to the initial shipment of Software under an Order and does not
renew or reset, for example, with the delivery of (a) Software updates or (b) authorization codes or alternate Software under
a transaction involving Software re-mix. This warranty shall not be valid if Products have been subject to misuse,
unauthorized modification or improper installation. MENTOR GRAPHICS’ ENTIRE LIABILITY AND CUSTOMER’S
EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS’ OPTION, EITHER (A) REFUND OF THE PRICE
PAID UPON RETURN OF THE PRODUCTS TO MENTOR GRAPHICS OR (B) MODIFICATION OR
REPLACEMENT OF THE PRODUCTS THAT DO NOT MEET THIS LIMITED WARRANTY, PROVIDED
CUSTOMER HAS OTHERWISE COMPLIED WITH THIS AGREEMENT. MENTOR GRAPHICS MAKES NO
WARRANTIES WITH RESPECT TO: (A) SERVICES; (B) PRODUCTS PROVIDED AT NO CHARGE; OR (C) BETA
CODE; ALL OF WHICH ARE PROVIDED “AS IS.”

8.2. THE WARRANTIES SET FORTH IN THIS SECTION 8 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS NOR
ITS LICENSORS MAKE ANY OTHER WARRANTIES EXPRESS, IMPLIED OR STATUTORY, WITH RESPECT TO
PRODUCTS PROVIDED UNDER THIS AGREEMENT. MENTOR GRAPHICS AND ITS LICENSORS
SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

9. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY WOULD BE
VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR GRAPHICS OR ITS
LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING
LOST PROFITS OR SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY, EVEN
IF MENTOR GRAPHICS OR ITS LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN
NO EVENT SHALL MENTOR GRAPHICS’ OR ITS LICENSORS’ LIABILITY UNDER THIS AGREEMENT EXCEED
THE AMOUNT RECEIVED FROM CUSTOMER FOR THE HARDWARE, SOFTWARE LICENSE OR SERVICE GIVING
RISE TO THE CLAIM. IN THE CASE WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS LICENSORS
SHALL HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER. THE PROVISIONS OF THIS SECTION 9 SHALL
SURVIVE THE TERMINATION OF THIS AGREEMENT.

10. HAZARDOUS APPLICATIONS. CUSTOMER ACKNOWLEDGES IT IS SOLELY RESPONSIBLE FOR TESTING ITS
PRODUCTS USED IN APPLICATIONS WHERE THE FAILURE OR INACCURACY OF ITS PRODUCTS MIGHT
RESULT IN DEATH OR PERSONAL INJURY (“HAZARDOUS APPLICATIONS”). NEITHER MENTOR GRAPHICS
NOR ITS LICENSORS SHALL BE LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH
THE USE OF MENTOR GRAPHICS PRODUCTS IN OR FOR HAZARDOUS APPLICATIONS. THE PROVISIONS OF
THIS SECTION 10 SHALL SURVIVE THE TERMINATION OF THIS AGREEMENT.

11. INDEMNIFICATION. CUSTOMER AGREES TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS AND
ITS LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE OR LIABILITY, INCLUDING
ATTORNEYS’ FEES, ARISING OUT OF OR IN CONNECTION WITH THE USE OF PRODUCTS AS DESCRIBED IN
SECTION 10. THE PROVISIONS OF THIS SECTION 11 SHALL SURVIVE THE TERMINATION OF THIS
AGREEMENT.

12. INFRINGEMENT. 

12.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against Customer in the United States,
Canada, Japan, or member state of the European Union which alleges that any standard, generally supported Product
acquired by Customer hereunder infringes a patent or copyright or misappropriates a trade secret in such jurisdiction.
Mentor Graphics will pay costs and damages finally awarded against Customer that are attributable to the action. Customer
understands and agrees that as conditions to Mentor Graphics’ obligations under this section Customer must: (a) notify
Mentor Graphics promptly in writing of the action; (b) provide Mentor Graphics all reasonable information and assistance
to settle or defend the action; and (c) grant Mentor Graphics sole authority and control of the defense or settlement of the
action.

http://supportnet.mentor.com/about/legal/


12.2. If a claim is made under Subsection 12.1 Mentor Graphics may, at its option and expense, (a) replace or modify the Product
so that it becomes noninfringing; (b) procure for Customer the right to continue using the Product; or (c) require the return
of the Product and refund to Customer any purchase price or license fee paid, less a reasonable allowance for use.

12.3. Mentor Graphics has no liability to Customer if the action is based upon: (a) the combination of Software or hardware with
any product not furnished by Mentor Graphics; (b) the modification of the Product other than by Mentor Graphics; (c) the
use of other than a current unaltered release of Software; (d) the use of the Product as part of an infringing process; (e) a
product that Customer makes, uses, or sells; (f) any Beta Code or Product provided at no charge; (g) any software provided
by Mentor Graphics’ licensors who do not provide such indemnification to Mentor Graphics’ customers; or
(h) infringement by Customer that is deemed willful. In the case of (h), Customer shall reimburse Mentor Graphics for its
reasonable attorney fees and other costs related to the action.

12.4. THIS SECTION 12 IS SUBJECT TO SECTION 9 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS FOR DEFENSE, SETTLEMENT AND DAMAGES, AND CUSTOMER’S SOLE
AND EXCLUSIVE REMEDY, WITH RESPECT TO ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT
OR TRADE SECRET MISAPPROPRIATION BY ANY PRODUCT PROVIDED UNDER THIS AGREEMENT.

13. TERMINATION AND EFFECT OF TERMINATION. If a Software license was provided for limited term use, such license
will automatically terminate at the end of the authorized term.

13.1. Mentor Graphics may terminate this Agreement and/or any license granted under this Agreement immediately upon written
notice if Customer: (a) exceeds the scope of the license or otherwise fails to comply with the licensing or confidentiality
provisions of this Agreement, or (b) becomes insolvent, files a bankruptcy petition, institutes proceedings for liquidation or
winding up or enters into an agreement to assign its assets for the benefit of creditors. For any other material breach of any
provision of this Agreement, Mentor Graphics may terminate this Agreement and/or any license granted under this
Agreement upon 30 days written notice if Customer fails to cure the breach within the 30 day notice period. Termination of
this Agreement or any license granted hereunder will not affect Customer’s obligation to pay for Products shipped or
licenses granted prior to the termination, which amounts shall be payable immediately upon the date of termination.

13.2. Upon termination of this Agreement, the rights and obligations of the parties shall cease except as expressly set forth in this
Agreement. Upon termination, Customer shall ensure that all use of the affected Products ceases, and shall return hardware
and either return to Mentor Graphics or destroy Software in Customer’s possession, including all copies and
documentation, and certify in writing to Mentor Graphics within ten business days of the termination date that Customer no
longer possesses any of the affected Products or copies of Software in any form.

14. EXPORT. The Products provided hereunder are subject to regulation by local laws and United States government agencies,
which prohibit export or diversion of certain products and information about the products to certain countries and certain
persons. Customer agrees that it will not export Products in any manner without first obtaining all necessary approval from
appropriate local and United States government agencies.

15. U.S. GOVERNMENT LICENSE RIGHTS. Software was developed entirely at private expense. All Software is commercial
computer software within the meaning of the applicable acquisition regulations. Accordingly, pursuant to US FAR 48 CFR
12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the Software by or for the U.S. Government or a U.S.
Government subcontractor is subject solely to the terms and conditions set forth in this Agreement, except for provisions which
are contrary to applicable mandatory federal laws.

16. THIRD PARTY BENEFICIARY. Mentor Graphics Corporation, Mentor Graphics (Ireland) Limited, Microsoft Corporation
and other licensors may be third party beneficiaries of this Agreement with the right to enforce the obligations set forth herein.

17. REVIEW OF LICENSE USAGE. Customer will monitor the access to and use of Software. With prior written notice and
during Customer’s normal business hours, Mentor Graphics may engage an internationally recognized accounting firm to
review Customer’s software monitoring system and records deemed relevant by the internationally recognized accounting firm
to confirm Customer’s compliance with the terms of this Agreement or U.S. or other local export laws. Such review may include
FLEXlm or FLEXnet (or successor product) report log files that Customer shall capture and provide at Mentor Graphics’
request. Customer shall make records available in electronic format and shall fully cooperate with data gathering to support the
license review. Mentor Graphics shall bear the expense of any such review unless a material non-compliance is revealed. Mentor
Graphics shall treat as confidential information all information gained as a result of any request or review and shall only use or
disclose such information as required by law or to enforce its rights under this Agreement. The provisions of this Section 17
shall survive the termination of this Agreement.

18. CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. The owners of certain Mentor Graphics
intellectual property licensed under this Agreement are located in Ireland and the United States. To promote consistency around
the world, disputes shall be resolved as follows: excluding conflict of laws rules, this Agreement shall be governed by and
construed under the laws of the State of Oregon, USA, if Customer is located in North or South America, and the laws of Ireland
if Customer is located outside of North or South America. All disputes arising out of or in relation to this Agreement shall be
submitted to the exclusive jurisdiction of the courts of Portland, Oregon when the laws of Oregon apply, or Dublin, Ireland when
the laws of Ireland apply. Notwithstanding the foregoing, all disputes in Asia arising out of or in relation to this Agreement shall
be resolved by arbitration in Singapore before a single arbitrator to be appointed by the chairman of the Singapore International
Arbitration Centre (“SIAC”) to be conducted in the English language, in accordance with the Arbitration Rules of the SIAC in
effect at the time of the dispute, which rules are deemed to be incorporated by reference in this section. This section shall not



restrict Mentor Graphics’ right to bring an action against Customer in the jurisdiction where Customer’s place of business is
located. The United Nations Convention on Contracts for the International Sale of Goods does not apply to this Agreement.

19. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid,
unenforceable or illegal, such provision shall be severed from this Agreement and the remaining provisions will remain in full
force and effect.

20. MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter and supersedes all
prior or contemporaneous agreements, including but not limited to any purchase order terms and conditions. Some Software
may contain code distributed under a third party license agreement that may provide additional rights to Customer. Please see
the applicable Software documentation for details. This Agreement may only be modified in writing by authorized
representatives of the parties. Waiver of terms or excuse of breach must be in writing and shall not constitute subsequent
consent, waiver or excuse.
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